THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

All printed copies and duplicate soft copies of this document are considered uncontrolled. See the current online version for the latest version.

Cisco has more than 200 offices worldwide. Addresses and phone numbers are listed on the Cisco website at www.cisco.com/go/offices.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1721R)

© 2015–2019 Cisco Systems, Inc. All rights reserved.
CONTENTS

CHAPTER 1

Getting Started With Firepower  1

Introduction to Managed Devices  1

7000 and 8000 Series Managed Devices  2

NGIPSv  2

Cisco ASA with FirePOWER Services  2

Network Management Capabilities by Classic Device Model  3

Introduction to the Firepower Management Center  4

Firepower Management Center Capabilities  5

Appliances Delivered with Version 6.0  5

Firepower System Components  7

Redundancy and Resource Sharing  7

Network Traffic Management for 7000 & 8000 Series Devices  7

Multitenancy  8

Discovery and Identity  9

Access Control  9

SSL Inspection  9

Intrusion Detection and Prevention  10

Cisco Advanced Malware Protection and File Control  10

Application Programming Interfaces  11

Firepower Online Help, How To, and Documentation  12

Top-Level Documentation Listing Pages for Firepower Management Center Deployments  12

License Statements in the Documentation  14

Supported Devices Statements in the Documentation  14

Access Statements in the Documentation  14

Firepower System IP Address Conventions  14
# Contents

## PART I

**Your User Account**  
15

## CHAPTER 2

**Logging into the Firepower System**  
17  
  - Firepower System User Accounts  
  17  
  - User Interfaces in Firepower Management Center Deployments  
  19  
    - Web Interface Considerations  
    20  
    - Session Timeout  
    21  
  - Logging Into the Firepower Management Center Web Interface  
  21  
  - Logging Into the Web Interface of a 7000 or 8000 Series Device  
  22  
  - Logging Into the Firepower Management Center with CAC Credentials  
  23  
  - Logging Into a 7000 or 8000 Series Device with CAC Credentials  
  23  
  - Logging Into the Command Line Interface  
  24  
  - Viewing Basic System Information in the Web Interface  
  25  
  - Switching Domains on the Firepower Management Center  
  25  
  - Logging Out of a Firepower System Web Interface  
  26

## CHAPTER 3

**Specifying User Preferences**  
29  
  - User Preferences Introduction  
  29  
  - Changing Your Password  
  29  
  - Changing an Expired Password  
  30  
  - Specifying Your Home Page  
  30  
  - Configuring Event View Settings  
  31  
    - Event View Preferences  
    31  
    - File Download Preferences  
    33  
    - Default Time Windows  
    33  
    - Default Workflows  
    35  
    - Setting Your Default Time Zone  
    35  
    - Specifying Your Default Dashboard  
    36

## PART II

**Firepower System Management**  
37

## CHAPTER 4

**Firepower System User Management**  
39
User Roles 39
   Predefined User Roles 40
   Custom User Roles 41
      Example: Custom User Roles and Access Control 42
User Account Privileges 42
   Overview Menu 42
   Analysis Menu 44
   Policies Menu 48
   Devices Menu 51
   Object Manager Menu 52
   Cisco AMP 52
   Deploy Configuration to Devices 52
   System Menu 52
   Help Menu 55
Managing User Roles 55
   Activating and Deactivating User Roles 56
   Creating Custom User Roles 57
   Copying User Roles 57
   Editing Custom User Roles 58
User Role Escalation 59
   Setting the Escalation Target Role 59
   Configuring a Custom User Role for Escalation 60
   Escalating Your User Role 60
User Accounts 61
   Managing User Accounts 61
   Creating a User Account 62
   Editing a User Account 62
   Assigning User Roles in Multiple Domains 63
   Converting a User from Internal to External Authentication 64
   User Account Login Options 64
   Command Line Access Levels 66
Firepower System User Authentication 67
   Internal Authentication 68
   External Authentication 69
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP Authentication</td>
<td>70</td>
</tr>
<tr>
<td>Required Information for Creating LDAP Authentication Objects</td>
<td>70</td>
</tr>
<tr>
<td>CAC Authentication</td>
<td>71</td>
</tr>
<tr>
<td>Configuring CAC Authentication</td>
<td>72</td>
</tr>
<tr>
<td>Creating Basic LDAP Authentication Objects</td>
<td>73</td>
</tr>
<tr>
<td>Creating Advanced LDAP Authentication Objects</td>
<td>76</td>
</tr>
<tr>
<td>LDAP Authentication Server Fields</td>
<td>79</td>
</tr>
<tr>
<td>Identifying the LDAP Authentication Server</td>
<td>80</td>
</tr>
<tr>
<td>LDAP-Specific Fields</td>
<td>81</td>
</tr>
<tr>
<td>Configuring LDAP-Specific Parameters</td>
<td>84</td>
</tr>
<tr>
<td>LDAP Group Fields</td>
<td>86</td>
</tr>
<tr>
<td>Configuring Access Rights by Group</td>
<td>87</td>
</tr>
<tr>
<td>LDAP Shell Access Fields</td>
<td>88</td>
</tr>
<tr>
<td>Configuring LDAP Shell Access</td>
<td>89</td>
</tr>
<tr>
<td>Testing LDAP Authentication Connections</td>
<td>90</td>
</tr>
<tr>
<td>Troubleshooting LDAP Authentication Connections</td>
<td>91</td>
</tr>
<tr>
<td>RADIUS Authentication</td>
<td>93</td>
</tr>
<tr>
<td>Creating RADIUS Authentication Objects</td>
<td>93</td>
</tr>
<tr>
<td>Configuring RADIUS Connection Settings</td>
<td>96</td>
</tr>
<tr>
<td>Configuring RADIUS User Roles</td>
<td>98</td>
</tr>
<tr>
<td>Configuring RADIUS Shell Access</td>
<td>99</td>
</tr>
<tr>
<td>Defining Custom RADIUS Attributes</td>
<td>100</td>
</tr>
<tr>
<td>Testing RADIUS Authentication Connections</td>
<td>101</td>
</tr>
<tr>
<td>Single Sign-on (SSO)</td>
<td>102</td>
</tr>
<tr>
<td>Configuring SSO</td>
<td>103</td>
</tr>
</tbody>
</table>

## CHAPTER 5

**Licensing the Firepower System** 105

About Firepower Licenses 105

License Requirements for Firepower Management Center 105

Evaluation License Caveats 106

Licensing for All Devices: Classic Licenses 106

Product License Registration Portal 106

Service Subscriptions for Firepower Features (Classic Licensing) 106

Classic License Types and Restrictions 107
<table>
<thead>
<tr>
<th>Chapter 10: FMC Database Purge</th>
<th>171</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purging Data from the FMC Database</td>
<td>171</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 11: Device Management Basics</th>
<th>173</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Device Management</td>
<td>173</td>
</tr>
<tr>
<td>About the Firepower Management Center</td>
<td>173</td>
</tr>
<tr>
<td>What Can Be Managed by a Firepower Management Center?</td>
<td>174</td>
</tr>
<tr>
<td>Beyond Policies and Events</td>
<td>174</td>
</tr>
<tr>
<td>NAT Environments</td>
<td>175</td>
</tr>
<tr>
<td>The Device Management Page</td>
<td>177</td>
</tr>
<tr>
<td>Filtering Managed Devices</td>
<td>177</td>
</tr>
<tr>
<td>Remote Management Configuration</td>
<td>178</td>
</tr>
<tr>
<td>Add Devices to the Firepower Management Center</td>
<td>178</td>
</tr>
<tr>
<td>Deleting Devices from the Firepower Management Center</td>
<td>180</td>
</tr>
<tr>
<td>Device Configuration Settings</td>
<td>181</td>
</tr>
<tr>
<td>General Device Settings</td>
<td>181</td>
</tr>
<tr>
<td>Device License Settings</td>
<td>181</td>
</tr>
<tr>
<td>Device System Settings</td>
<td>181</td>
</tr>
<tr>
<td>Device Health Settings</td>
<td>182</td>
</tr>
<tr>
<td>Device Management Settings</td>
<td>182</td>
</tr>
<tr>
<td>Advanced Device Settings</td>
<td>183</td>
</tr>
</tbody>
</table>
PART III  
System Monitoring  195

CHAPTER 12  
Dashboards  197

About Dashboards  197
Firepower System Dashboard Widgets  198
  Widget Availability  198
Dashboard Widget Availability by User Role  199
Predefined Dashboard Widgets  200
  The Appliance Information Widget  200
  The Appliance Status Widget  201
  The Correlation Events Widget  201
  The Current Interface Status Widget  201
  The Current Sessions Widget  202
  The Custom Analysis Widget  202
  The Disk Usage Widget  206
  The Interface Traffic Widget  207
  The Intrusion Events Widget  207
  The Network Compliance Widget  208
  The Product Licensing Widget  208
  The Product Updates Widget  209
Managing Dashboards 210
Adding a Dashboard Tab 211
Adding Widgets to a Dashboard 212
Configuring Widget Preferences 213
Creating Custom Dashboards 213
Custom Dashboard Options 213
Customizing the Widget Display 215
Editing Dashboards Options 215
Modifying Dashboard Time Settings 216
Renaming a Dashboard Tab 217
Viewing Dashboards 217

CHAPTER 13

Health Monitoring 219
About Health Monitoring 219
Health Modules 220
Configuring Health Monitoring 225
Health Policies 225
Default Health Policy 225
Creating Health Policies 226
Applying Health Policies 227
Editing Health Policies 228
Deleting Health Policies 228
The Health Monitor Blacklist 229
Blacklisting Appliances 230
Blacklisting Health Policy Modules 230
Health Monitor Alerts 231
Health Monitor Alert Information 231
Creating Health Monitor Alerts 232
Editing Health Monitor Alerts 233
Deleting Health Monitor Alerts 233
CHAPTER 14

Monitoring the System 247

System Statistics 247

System Statistics Availability by Appliance 247
The Host Statistics Section 248
The Disk Usage Section 248
The Processes Section 248
Process Status Fields 248
System Daemons 250
Executables and System Utilities 252
The SFDataCorrelator Process Statistics Section 254
The Intrusion Event Information Section 255
Viewing System Statistics 256

System Messages 256

Message Types 257
Message Management 258
Managing System Messages 259
Viewing Deployment Messages 260
CHAPTER 18
Reusable Objects 317
  Introduction to Reusable Objects 317
  The Object Manager 319
    Editing Objects 319
  Filtering Objects or Object Groups 320
  Sorting Objects 321
  Object Groups 321
    Grouping Reusable Objects 321
  Object Overrides 323
    Managing Object Overrides 324
    Allowing Object Overrides 324
    Adding Object Overrides 325
    Editing Object Overrides 325
  Network Objects 326
    Creating Network Objects 326
  Port Objects 327
    Creating Port Objects 328
  Application Filters 328
  VLAN Tag Objects 328
    Creating VLAN Tag Objects 329
  URL Objects 329
    Creating URL Objects 330
  Geolocation Objects 331
    Creating Geolocation Objects 331
  Security Zones 331
    Creating Security Zone Objects 332
  Variable Sets 333
    Variable Sets in Intrusion Policies 334
  Variables 334
    Predefined Default Variables 335
    Network Variables 337
PART V

Configuration Basics 377

CHAPTER 19

Classic Device Management Basics 379

Remote Management Configuration 379
  Configuring Remote Management on a Managed Device 380
  Editing Remote Management on a Managed Device 380
  Changing the Management Port 381

Interface Configuration Settings 382
  The Physical Hardware View 382
  Interface Icons 382
  Using the Physical Hardware View 383
  Configuring Sensing Interfaces 384
  Configuring HA Link Interfaces 385
  Disabling Interfaces 386
### IPS Device Deployments and Configuration

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to IPS Device Deployment and Configuration</td>
<td>391</td>
</tr>
<tr>
<td>Passive IPS Deployments</td>
<td>391</td>
</tr>
<tr>
<td>Passive Interfaces on the Firepower System</td>
<td>391</td>
</tr>
<tr>
<td>Configuring Passive Interfaces</td>
<td>392</td>
</tr>
<tr>
<td>Inline IPS Deployments</td>
<td>393</td>
</tr>
<tr>
<td>Inline Interfaces on the Firepower System</td>
<td>394</td>
</tr>
<tr>
<td>Configuring Inline Interfaces</td>
<td>395</td>
</tr>
<tr>
<td>Inline Sets on the Firepower System</td>
<td>396</td>
</tr>
<tr>
<td>Viewing Inline Sets</td>
<td>397</td>
</tr>
<tr>
<td>Adding Inline Sets</td>
<td>397</td>
</tr>
<tr>
<td>Advanced Inline Set Options</td>
<td>399</td>
</tr>
<tr>
<td>Configuring Advanced Inline Set Options</td>
<td>400</td>
</tr>
<tr>
<td>Deleting Inline Sets</td>
<td>401</td>
</tr>
</tbody>
</table>

### High Availability and Scalability

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7000 and 8000 Series Device High Availability</td>
<td>405</td>
</tr>
<tr>
<td>About 7000 and 8000 Series Device High Availability</td>
<td>405</td>
</tr>
<tr>
<td>Device High Availability Requirements</td>
<td>406</td>
</tr>
<tr>
<td>Device High Availability Failover and Maintenance Mode</td>
<td>406</td>
</tr>
<tr>
<td>Configuration Deployment and Upgrade Behavior for High-Availability Pairs</td>
<td>407</td>
</tr>
<tr>
<td>Deployment Types and Device High Availability</td>
<td>407</td>
</tr>
<tr>
<td>Device High Availability Configuration</td>
<td>409</td>
</tr>
<tr>
<td>Establishing Device High Availability</td>
<td>409</td>
</tr>
<tr>
<td>Editing Device High Availability</td>
<td>410</td>
</tr>
<tr>
<td>Configuring Individual Devices in a High-Availability Pair</td>
<td>411</td>
</tr>
<tr>
<td>Configuring Individual Device Stacks in a High-Availability Pair</td>
<td>411</td>
</tr>
<tr>
<td>Configuring Interfaces on a Device in a High-Availability Pair</td>
<td>412</td>
</tr>
<tr>
<td>Switching the Active Peer in a Device High-Availability Pair</td>
<td>413</td>
</tr>
</tbody>
</table>
Server Certificate Upload  440
Uploading Server Certificates  440
Requiring Valid User Certificates  441
External Database Access Settings  442
Enabling External Access to the Database  442
Database Event Limits  443
Configuring Database Event Limits  443
Database Event Limits  444
Management Interfaces  445
About Management Interfaces  445
Management Interfaces on the Firepower Management Center  446
Management Interfaces on Managed Devices  446
Management Interface Support  447
Network Routes on Management Interfaces  448
Management and Event Traffic Channel Examples  448
Configure Management Interfaces  449
Configure Firepower Management Center Management Interfaces  450
Configure Classic Device Management Interfaces at the Web Interface  452
Configure Classic Device Management Interfaces at the CLI  455
System Shut Down and Restart  459
Shutting Down and Restarting the System  460
Remote Storage Management  461
Configuring Local Storage  461
Configuring NFS for Remote Storage  462
Configuring SMB for Remote Storage  463
Configuring SSH for Remote Storage  463
Remote Storage Management Advanced Options  464
Change Reconciliation  465
Configuring Change Reconciliation  465
Change Reconciliation Options  466
Policy Change Comments  466
Configuring Comments to Track Policy Changes  466
The Access List  467
Configuring the Access List for Your System  468
Audit Logs 469
  Configure the Audit Log for External Streaming 469
Dashboard Settings 470
  Enabling Custom Analysis Widgets for Dashboards 471
DNS Cache 471
  Configuring DNS Cache Properties 471
Email Notifications 472
  Configuring a Mail Relay Host and Notification Address 472
Language Selection 473
  Specifying a Different Language 473
Login Banners 474
  Adding a Custom Login Banner 474
SNMP Polling 475
  Configuring SNMP Polling 475
STIG Compliance 477
  Enabling STIG Compliance 477
Time and Time Synchronization 478
  Synchronize Time Using a Network NTP Server 478
  Synchronize Time Without Access to a Network NTP Server 479
  About Changing Time Synchronization Settings 480
  View Current System Time, Source, and NTP Server Connection Status 480
    NTP Server Status 481
Session Timeouts 482
  Configuring Session Timeouts 482
Vulnerability Mapping 483
  Mapping Vulnerabilities for Servers 484
Remote Console Access Management 484
  Configuring Remote Console Settings on the System 484
    Lights-Out Management User Access Configuration 485
      Enabling Lights-Out Management User Access 486
    Serial Over LAN Connection Configuration 486
      Configuring Serial Over LAN with IPMItool 488
      Configuring Serial Over LAN with IPMIutil 488
    Lights-Out Management Overview 488
CHAPTER 24
Platform Settings Policies for Managed Devices 493
Introduction to Platform Settings 493
Managing Platform Settings Policies 494
Creating a Platform Settings Policy 494
Setting Target Devices for a Platform Settings Policy 495

CHAPTER 25
Platform Settings for Classic Devices 497
Introduction to Firepower Platform Settings 497
Configuring Firepower Platform Settings 497
The Access List 498
Configuring the Access List for Your System 499
Audit Logs on Classic Devices 500
Configuring the Audit Log for External Streaming from Classic Devices 500
External Authentication Settings 501
Enabling External Authentication to Classic Devices 502
Language Selection 503
Specifying a Different Language 503
Login Banners 504
Adding a Custom Login Banner 504
Session Timeouts 505
Configuring Session Timeouts 505
SNMP Polling 506
Configuring SNMP Polling 507
STIG Compliance 508
Enabling STIG Compliance 508
Time and Time Synchronization (Classic Devices) 509
Synchronizing Time on Classic Devices 510
View Current System Time, Source, and NTP Server Connection Status for NGIPS Devices 511
NTP Server Status 511
<table>
<thead>
<tr>
<th>PART VIII</th>
<th>Network Address Translation (NAT) 513</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAPTER 26</td>
<td>NAT Policy Management 515</td>
</tr>
<tr>
<td></td>
<td>Managing NAT Policies 515</td>
</tr>
<tr>
<td></td>
<td>Creating NAT Policies 516</td>
</tr>
<tr>
<td></td>
<td>Configuring NAT Policies 517</td>
</tr>
<tr>
<td></td>
<td>Configuring NAT Policy Targets 518</td>
</tr>
<tr>
<td></td>
<td>Copying NAT Policies 519</td>
</tr>
<tr>
<td>CHAPTER 27</td>
<td>NAT for 7000 and 8000 Series Devices 521</td>
</tr>
<tr>
<td></td>
<td>NAT Policy Configuration 521</td>
</tr>
<tr>
<td></td>
<td>NAT Policies Configuration Guidelines 522</td>
</tr>
<tr>
<td></td>
<td>Rule Organization in a NAT Policy 522</td>
</tr>
<tr>
<td></td>
<td>Organizing NAT Rules 523</td>
</tr>
<tr>
<td></td>
<td>NAT Rule Warnings and Errors 524</td>
</tr>
<tr>
<td></td>
<td>Showing and Hiding NAT Rule Warnings 524</td>
</tr>
<tr>
<td></td>
<td>NAT Policy Rules Options 524</td>
</tr>
<tr>
<td></td>
<td>Creating and Editing NAT Rules 525</td>
</tr>
<tr>
<td></td>
<td>NAT Rule Types 526</td>
</tr>
<tr>
<td></td>
<td>NAT Rule Condition Types 528</td>
</tr>
<tr>
<td></td>
<td>NAT Rule Conditions and Condition Mechanics 528</td>
</tr>
<tr>
<td></td>
<td>NAT Rule Conditions 529</td>
</tr>
<tr>
<td></td>
<td>Adding Conditions to NAT Rules 529</td>
</tr>
<tr>
<td></td>
<td>Literal Conditions in NAT Rules 531</td>
</tr>
<tr>
<td></td>
<td>Objects in NAT Rule Conditions 531</td>
</tr>
<tr>
<td></td>
<td>Zone Conditions in NAT Rules 531</td>
</tr>
<tr>
<td></td>
<td>Adding Zone Conditions to NAT Rules 532</td>
</tr>
<tr>
<td></td>
<td>Source Network Conditions in Dynamic NAT Rules 533</td>
</tr>
<tr>
<td></td>
<td>Adding Network Conditions to a Dynamic NAT Rule 534</td>
</tr>
<tr>
<td></td>
<td>Destination Network Conditions in NAT Rules 535</td>
</tr>
<tr>
<td></td>
<td>Adding Destination Network Conditions to NAT Rules 536</td>
</tr>
<tr>
<td></td>
<td>Port Conditions in NAT Rules 537</td>
</tr>
<tr>
<td></td>
<td>Adding Port Conditions to NAT Rules 537</td>
</tr>
</tbody>
</table>
Adding Interfaces for RIP Configuration 565
Configuring Authentication Settings for RIP Configuration 566
Configuring Advanced Settings for RIP Configuration 567
Adding Import Filters for RIP Configuration 568
Adding Export Filters for RIP Configuration 569

OSPF Configuration 570
OSPF Routing Areas 570
OSPF Area Interfaces 571
Adding OSPF Area Interfaces 573
Adding OSPF Area Vlinks 574
Adding Import Filters for OSPF Configuration 575
Adding Export Filters for OSPF Configuration 576

Virtual Router Filters 577
Viewing Virtual Router Filters 578
Setting Up Virtual Router Filters 579
Adding Virtual Router Authentication Profiles 580
Viewing Virtual Router Statistics 581
Deleting Virtual Routers 581

CHAPTER 30

Aggregate Interfaces and LACP 583
About Aggregate Interfaces 583
LAG Configuration 584
Aggregate Switched Interfaces 584
Aggregate Routed Interfaces 585
Logical Aggregate Interfaces 585
Load-Balancing Algorithms 586
Link Selection Policies 587
Link Aggregation Control Protocol (LACP) 588
LACP 588
Adding Aggregate Switched Interfaces 589
Adding Aggregate Routed Interfaces 591
Adding Logical Aggregate Interfaces 594
Viewing Aggregate Interface Statistics 595
Deleting Aggregate Interfaces 595
CHAPTER 31

Hybrid Interfaces 597

About Hybrid Interfaces 597
Logical Hybrid Interfaces 597
Adding Logical Hybrid Interfaces 598
Deleting Logical Hybrid Interfaces 600

CHAPTER 32

Gateway VPNs 601

Gateway VPN Basics 601
IPsec 601
IKE 602
VPN Deployments 602
Point-to-Point VPN Deployments 602
Star VPN Deployments 603
Mesh VPN Deployments 604
VPN Deployment Management 604
VPN Deployment Options 605
Point-to-Point VPN Deployment Options 605
Star VPN Deployment Options 606
Mesh VPN Deployment Options 608
Advanced VPN Deployment Options 609
Managing VPN Deployments 610
Configuring Point-to-Point VPN Deployments 611
Configuring Star VPN Deployments 611
Configuring Mesh VPN Deployments 612
Configuring Advanced VPN Deployment Settings 613
Editing VPN Deployments 614
VPN Deployment Status 615
Viewing VPN Status 615
VPN Statistics and Logs 616
Viewing VPN Statistics and Logs 617

PART X

Access Control 619
## CHAPTER 33: Getting Started with Access Control Policies

**Introduction to Access Control** 621  
**Access Control Policy Components** 622  
**Access Control Policy Default Action** 623  
**Access Control Policy Inheritance** 625  
**Managing Access Control Policies** 626  
**Creating a Basic Access Control Policy** 627  
**Editing an Access Control Policy** 629  
**Managing Access Control Policy Inheritance** 630  
**Choosing a Base Access Control Policy** 631  
**Inheriting Access Control Policy Settings from the Base Policy** 632  
**Locking Settings in Descendant Access Control Policies** 632  
**Requiring an Access Control Policy in a Domain** 633  
**Setting Target Devices for an Access Control Policy** 634  
**Access Control Policy Advanced Settings** 634  
**Associating Other Policies with Access Control** 636

## CHAPTER 34: Access Control Rules

**Introduction to Access Control Rules** 639  
**Recommendations for Application Control** 641  
**Access Control Rule Management** 642  
**Access Control Rule Components** 643  
**Access Control Rule Order** 644  
**Adding an Access Control Rule Category** 645  
**Creating and Editing Access Control Rules** 646  
**Enabling and Disabling Access Control Rules** 647  
**Positioning an Access Control Rule** 648  
**Access Control Rule Actions** 648  
**Access Control Rule Monitor Action** 649  
**Access Control Rule Trust Action** 649  
**Access Control Rule Blocking Actions** 649  
**Access Control Rule Interactive Blocking Actions** 650  
**Access Control Rule Allow Action** 651
CHAPTER 35

Access Control Using Intrusion and File Policies 653

About Deep Inspection 653
Access Control Traffic Handling 654
File and Intrusion Inspection Order 655
Access Control Rule Configuration to Perform Malware Protection 656
  Configuring an Access Control Rule to Perform Malware Protection 657
Access Control Rule Configuration to Perform Intrusion Prevention 658
  Access Control Rule Configuration and Intrusion Policies 659
  Configuring an Access Control Rule to Perform Intrusion Prevention 659

CHAPTER 36

URL Filtering 661

URL Filtering Overview 661
About URL Filtering with Category and Reputation 661
Guidelines and Limitations for URL Filtering 662
  Filtering HTTPS Traffic 664
How to Configure URL Filtering with Category and Reputation 665
  Enable URL Filtering Using Category and Reputation 665
    URL Filtering Options 666
  Configuring URL Conditions 667
    Rules with URL Conditions 669
    URL Rule Order 669
  Manual URL Filtering 669

CHAPTER 37

HTTP Response Pages and Interactive Blocking 671

About HTTP Response Pages 671
  Limitations to HTTP Response Pages 671
Choosing HTTP Response Pages 672
Interactive Blocking with HTTP Response Pages 673
  Configuring Interactive Blocking 673
  Setting the User Bypass Timeout for a Blocked Website 674
Create Basic SSL Policies 733
Set Default Handling for Undecryptable Traffic 733
Editing an SSL Policy 735

**Get Started with TLS/SSL Rules** 737

TLS/SSL Rules Overview 737
TLS/SSL Rule Guidelines and Limitations 737
  Guideline for Using TLS/SSL Decryption 738
TLS/SSL Rule Unsupported Features 738
TLS/SSL Do Not Decrypt Guidelines 738
TLS/SSL Decrypt - Resign Guidelines 739
TLS/SSL Decrypt - Known Key Guidelines 740
TLS/SSL Block Guidelines 741
TLS/SSL Certificate Pinning Guidelines 741
TLS/SSL Heartbeat Guidelines 742
TLS/SSL Anonymous Cipher Suite Limitation 742
TLS/SSL Normalizer Guidelines 742
Other TLS/SSL Rule Guidelines 742
Encrypted Traffic Inspection Configuration 743
Creating and Modifying TLS/SSL Rules 744
  Adding a TLS/SSL Rule to a Rule Category 745
Positioning a TLS/SSL Rule by Number 745
TLS/SSL Rule Search 746
  Searching TLS/SSL Rules 746
Enabling and Disabling TLS/SSL Rules 746
  Moving a TLS/SSL Rule 747
    Adding a New TLS/SSL Rule Category 747
TLS/SSL Rule Conditions 748
  TLS/SSL Rule Condition Types 749
TLS/SSL Rule Actions 750
  TLS/SSL Rule Monitor Action 750
TLS/SSL Rule Do Not Decrypt Action 751
TLS/SSL Rule Blocking Actions 751
TLS/SSL Rule Decrypt Actions 752
Configuring TLS/SSL Rule Actions 752
Configuring a Decrypt - Resign Action 753
Configuring a Decrypt - Known Key Action 753
TLS/SSL Rules Management 754

CHAPTER 44
Decryption Tuning Using TLS/SSL Rules 755
TLS/SSL Rule Conditions Overview 755
Network-Based TLS/SSL Rule Conditions 756
Network Zone TLS/SSL Rule Conditions 756
Controlling Encrypted Traffic by Network Zone 757
Network or Geolocation TLS/SSL Rule Conditions 758
Controlling Encrypted Traffic by Network or Geolocation 758
VLAN TLS/SSL Rule Conditions 759
Controlling Encrypted VLAN Traffic 760
Port TLS/SSL Rule Conditions 761
Controlling Encrypted Traffic by Port 761
User-Based TLS/SSL Rule Conditions 762
Controlling Encrypted Traffic Based on User 763
Reputation-Based TLS/SSL Rule Conditions 763
Selected Applications and Filters in TLS/SSL Rules 764
Application Filters in TLS/SSL Rules 764
Available Applications in TLS/SSL Rules 765
Application-Based TLS/SSL Rule Condition Requirements 766
Adding an Application Condition to a TLS/SSL Rule 767
Limitations to Encrypted Application Control 768
Reputation-Based URL Blocking in Encrypted Traffic 768
Block Encrypted Traffic Based on URL Reputation 769
Server Certificate-Based TLS/SSL Rule Conditions 770
Certificate Distinguished Name TLS/SSL Rule Conditions 771
Controlling Encrypted Traffic by Certificate Distinguished Name 771
Certificate TLS/SSL Rule Conditions 772
Controlling Encrypted Traffic by Certificate 773
Certificate Status TLS/SSL Rule Conditions 774
Trusting External Certificate Authorities 777
Troubleshoot TLS/SSL Rules 785
About TLS/SSL Pinning 785
Troubleshoot TLS/SSL Pinning 785
Verify TLS/SSL Cipher Suites 787

Advanced Malware Protection (AMP) and File Control 789

File Policies and Advanced Malware Protection 791
About File Policies and Advanced Malware Protection 791
Malware Protection Methods 791
Spero Analysis 792
AMP Cloud Lookup 792
Local Malware Analysis 792
Cached Disposition Longevity 792
Dynamic Analysis 793
Which Files Are Eligible for Dynamic Analysis? 793
Block All Files by Type 794
Comparison of Malware Protection Methods 794
License Requirements for File and Malware Policies 795
How to Configure Malware Protection 796
Plan and Deploy Products and Licenses for Malware Protection 796
Configure Policies to Detect and Handle Malware 797
Arrange Ongoing Maintenance and Monitoring of Malware Protection 798
Cloud Connections for Malware Protection 799
AMP Cloud Connection Configurations 800
Requirements and Guidelines for AMP Cloud Connections 800
Choose an AMP Cloud 800
Cisco AMP Private Cloud 801
Managing Connections to the AMP Cloud (Public or Private) 802
Change AMP Options 803
Dynamic Analysis Connections 804
  Requirements for Dynamic Analysis 804
  Viewing the Default Dynamic Analysis Connection 804
Dynamic Analysis On-Premises Appliance (Cisco Threat Grid) 805
  Maintain Your System: Update File Types Eligible for Dynamic Analysis 806
Cisco Security Intelligence Clouds 806
File Policies and File Rules 807
  File Policy and File Rule Guidelines and Limitations 807
    File Rule Configuration Guidelines and Limitations 807
    File Detection Notes and Limitations 807
    File Blocking Notes and Limitations 808
    File Policy General Guidelines and Limitations 808
  File Policies 809
    Managing File Policies 809
    Creating a File Policy 810
    Advanced and Archive File Inspection Options 811
    Editing a File Policy 814
  File Rules 815
    File Rule Components 815
    File Rule Actions 816
    Creating File Rules 819
Retrospective Disposition Changes 821
(Optional) Malware Protection with AMP for Endpoints 821
  Comparison of Malware Protection: Firepower vs. AMP for Endpoints 822
  About Integrating Firepower with AMP for Endpoints 822
  Benefits of Integrating Firepower and AMP for Endpoints 823
  AMP for Endpoints and AMP Private Cloud 823
  Integrate Firepower and AMP for Endpoints 823
History for the File and Malware Chapter 825

CHAPTER 47

File and Malware Inspection Performance and Storage Tuning 827
  File and Malware Inspection Performance and Storage Options 827
Tuning File and Malware Inspection Performance and Storage 829

PART XIII  Intrusion Detection and Prevention 831

CHAPTER 48  An Overview of Network Analysis and Intrusion Policies 833

Network Analysis and Intrusion Policy Basics 833
How Policies Examine Traffic For Intrusions 834
Decoding, Normalizing, and Preprocessing: Network Analysis Policies 835
Access Control Rules: Intrusion Policy Selection 836
Intrusion Inspection: Intrusion Policies, Rules, and Variable Sets 836
Intrusion Event Generation 838
System-Provided and Custom Network Analysis and Intrusion Policies 838
System-Provided Network Analysis and Intrusion Policies 839
Benefits of Custom Network Analysis and Intrusion Policies 841
Benefits of Custom Network Analysis Policies 841
Benefits of Custom Intrusion Policies 842
Limitations of Custom Policies 843
The Navigation Panel: Network Analysis and Intrusion Policies 845
Conflicts and Changes: Network Analysis and Intrusion Policies 846
Exiting a Network Analysis or Intrusion Policy 847

CHAPTER 49  Layers in Intrusion and Network Analysis Policies 849
Layer Basics 849
The Layer Stack 849
The Base Layer 850
System-Provided Base Policies 850
Custom Base Policies 851
The Effect of Rule Updates on Base Policies 851
Changing the Base Policy 852
The Firepower Recommendations Layer 853
Layer Management 854
Shared Layers 855
Managing Layers 856
Navigating Layers 857
Intrusion Rules in Layers  857
  Configuring Intrusion Rules in Layers  859
  Removing Rule Settings from Multiple Layers  859
  Accepting Rule Changes from a Custom Base Policy  861
Preprocessors and Advanced Settings in Layers  862
  Configuring Preprocessors and Advanced Settings in Layers  862

CHAPTER 50
Getting Started with Intrusion Policies  865
  Intrusion Policy Basics  865
  Managing Intrusion Policies  866
  Custom Intrusion Policy Creation  867
    Creating a Custom Intrusion Policy  868
  Editing Intrusion Policies  868
    Intrusion Policy Changes  869
  Drop Behavior in an Inline Deployment  870
    Setting Drop Behavior in an Inline Deployment  870
  Drop Behavior in a Dual System Deployment  871
  Intrusion Policy Advanced Settings  871
  Optimizing Performance for Intrusion Detection and Prevention  872

CHAPTER 51
Tuning Intrusion Policies Using Rules  873
  Intrusion Rule Tuning Basics  873
  Intrusion Rule Types  873
  Viewing Intrusion Rules in an Intrusion Policy  874
    Intrusion Rules Page Columns  875
  Intrusion Rule Details  876
  Viewing Intrusion Rule Details  877
    Setting a Threshold for an Intrusion Rule  877
    Setting Suppression for an Intrusion Rule  878
    Setting a Dynamic Rule State from the Rule Details Page  879
  Setting an SNMP Alert for an Intrusion Rule  880
  Adding a Comment to an Intrusion Rule  880
  Intrusion Rule Filters in an Intrusion Policy  881
  Intrusion Rule Filters Notes  881
Contents

System-Provided Sensitive Data Types 910
Configuring Sensitive Data Detection 911
Monitored Application Protocols and Sensitive Data 912
Selecting Application Protocols to Monitor 913
Special Case: Sensitive Data Detection in FTP Traffic 914
Custom Sensitive Data Types 914
   Data Patterns in Custom Sensitive Data Types 915
   Configuring Custom Sensitive Data Types 917
   Editing Custom Sensitive Data Types 918

CHAPTER 54
Globally Limiting Intrusion Event Logging 921
   Global Rule Thresholding Basics 921
   Global Rule Thresholding Options 922
   Configuring Global Thresholds 924
   Disabling the Global Threshold 925

CHAPTER 55
The Intrusion Rules Editor 927
   An Introduction to Intrusion Rule Editing 927
   Rule Anatomy 928
      The Intrusion Rule Header 929
         Intrusion Rule Header Action 929
         Intrusion Rule Header Protocol 930
         Intrusion Rule Header Direction 930
         Intrusion Rule Header Source and Destination IP Addresses 931
         Intrusion Rule Header Source and Destination Ports 933
   Intrusion Event Details 934
      Adding a Custom Classification 938
      Defining an Event Priority 939
      Defining an Event Reference 939
   Custom Rule Creation 940
      Writing New Rules 941
      Modifying Existing Rules 942
      Viewing Rule Documentation 943
      Adding Comments to Intrusion Rules 944
Deleting Custom Rules 945
Searching for Rules 945
Search Criteria for Intrusion Rules 946
Rule Filtering on the Intrusion Rules Editor Page 947
Filtering Guidelines 947
Keyword Filtering 948
Character String Filtering 949
Combination Keyword and Character String Filtering 949
Filtering Rules 949
Keywords and Arguments in Intrusion Rules 950
The content and protected_content Keywords 950
Basic content and protected_content Keyword Arguments 952
content and protected_content Keyword Search Locations 953
Overview: HTTP content and protected_content Keyword Arguments 955
Overview: content Keyword Fast Pattern Matcher 959
The replace Keyword 961
The byte_jump Keyword 963
The byte_test Keyword 965
The byte_extract Keyword 967
Overview: The pcre Keyword 969
pcre Syntax 970
pcre Modifier Options 972
pcre Example Keyword Values 974
The metadata Keyword 976
Service Metadata 978
Metadata Search Guidelines 983
IP Header Values 984
ICMP Header Values 986
TCP Header Values and Stream Size 987
The stream_reassembly Keyword 991
SSL Keywords 991
The appid Keyword 993
Application Layer Protocol Values 994
The RPC Keyword 994
Intrusion Prevention Performance Tuning 1037
About Intrusion Prevention Performance Tuning 1037
Limiting Pattern Matching for Intrusions 1038
Regular Expression Limits Overrides for Intrusion Rules 1038
Overriding Regular Expression Limits for Intrusion Rules 1039
Per Packet Intrusion Event Generation Limits 1040
CHAPTER 59  Application Layer Preprocessors  1067

Introduction to Application Layer Preprocessors  1067

The DCE/RPC Preprocessor  1067

  Connectionless and Connection-Oriented DCE/RPC Traffic  1068

  DCE/RPC Target-Based Policies  1069

    RPC over HTTP Transport  1070

  DCE/RPC Global Options  1071

  DCE/RPC Target-Based Policy Options  1072

  Traffic-Associated DCE/RPC Rules  1076

  Configuring the DCE/RPC Preprocessor  1077

The DNS Preprocessor  1078

  DNS Preprocessor Options  1080

  Configuring the DNS Preprocessor  1081

The FTP/Telnet Decoder  1082

  Global FTP and Telnet Options  1082

  Telnet Options  1083

  Server-Level FTP Options  1083

    FTP Command Validation Statements  1086

  Client-Level FTP Options  1087

  Configuring the FTP/Telnet Decoder  1088

The HTTP Inspect Preprocessor  1089

  Global HTTP Normalization Options  1090

  Server-Level HTTP Normalization Options  1091

    Server-Level HTTP Normalization Encoding Options  1098

  Configuring The HTTP Inspect Preprocessor  1102

  Additional HTTP Inspect Preprocessor Rules  1103

The Sun RPC Preprocessor  1103

  Sun RPC Preprocessor Options  1104

  Configuring the Sun RPC Preprocessor  1104

The SIP Preprocessor  1105

  SIP Preprocessor Options  1106

  Configuring the SIP Preprocessor  1108

  Additional SIP Preprocessor Rules  1109
CHAPTER 61  Transport & Network Layer Preprocessors  1139

Introduction to Transport and Network Layer Preprocessors  1139
Advanced Transport/Network Preprocessor Settings  1139
Ignored VLAN Headers  1139
Active Responses in Intrusion Drop Rules  1140
Advanced Transport/Network Preprocessor Options  1141
Configuring Advanced Transport/Network Preprocessor Settings  1142
Checksum Verification  1142
Checksum Verification Options  1142
Verifying Checksums  1143
The Inline Normalization Preprocessor  1144
Inline Normalization Options  1144
Configuring Inline Normalization  1149
The IP Defragmentation Preprocessor  1150
IP Fragmentation Exploits  1150
Target-Based Defragmentation Policies  1151
IP Defragmentation Options  1151
Configuring IP Defragmentation  1154
The Packet Decoder  1155
Packet Decoder Options  1155
Configuring Packet Decoding  1158
TCP Stream Preprocessing  1159
State-Related TCP Exploits  1159
Target-Based TCP Policies  1159
TCP Stream Reassembly  1160
TCP Stream Preprocessing Options  1161
Configuring TCP Stream Preprocessing  1168
UDP Stream Preprocessing  1169
UDP Stream Preprocessing Options  1170
Configuring UDP Stream Preprocessing  1170

CHAPTER 62  Detecting Specific Threats  1173

Introduction to Specific Threat Detection  1173
Netflow Data in the Firepower System 1203
Requirements for Using NetFlow Data 1203
Differences between NetFlow and Managed Device Data 1204

About User Identity 1206
Identity Terminology 1207
Identity Deployments 1208
The User Activity Database 1208
The Users Database 1208

Firepower System Host and User Limits 1209
Firepower System Host Limit 1209
Firepower System User Limit 1210

Host Identity Sources 1213
Overview: Host Data Collection 1213
Determining Which Host Operating Systems the System Can Detect 1214
Identifying Host Operating Systems 1214
Custom Fingerprinting 1214
Managing Fingerprints 1215
Activating and Deactivating Fingerprints 1216
Editing an Active Fingerprint 1217
Editing an Inactive Fingerprint 1217
Creating a Custom Fingerprint for Clients 1218
Creating a Custom Fingerprint for Servers 1220

Host Input Data 1223
Requirements for Using Third-Party Data 1223
Third-Party Product Mappings 1224
Mapping Third-Party Products 1224
Mapping Third-Party Product Fixes 1226
Mapping Third-Party Vulnerabilities 1227
Custom Product Mappings 1228
Creating Custom Product Mappings 1228
Editing Custom Product Mapping Lists 1229
Activating and Deactivating Custom Product Mappings 1230
eStreamer Server Streaming 1230
CHAPTER 68

Network Discovery Policies 1299
  Overview: Network Discovery Policies 1299
  Network Discovery Customization 1300
    Configuring the Network Discovery Policy 1300
  Network Discovery Rules 1301
    Configuring Network Discovery Rules 1302
      Actions and Discovered Assets 1302
      Monitored Networks 1303
      Port Exclusions 1306
      Zones in Network Discovery Rules 1308
    The Traffic-Based Detection Identity Source 1308
  Configuring Advanced Network Discovery Options 1311
    Network Discovery General Settings 1312
      Configuring Network Discovery General Settings 1313
    Network Discovery Identity Conflict Settings 1313
      Configuring Network Discovery Identity Conflict Resolution 1314
    Network Discovery Vulnerability Impact Assessment Options 1314
      Enabling Network Discovery Vulnerability Impact Assessment 1315
  Indications of Compromise 1315
    Enabling Indications of Compromise Rules 1316
  Adding NetFlow Exporters to a Network Discovery Policy 1317
    Network Discovery Data Storage Settings 1318
      Configuring Network Discovery Data Storage 1319
    Configuring Network Discovery Event Logging 1319
    Adding Network Discovery OS and Server Identity Sources 1320
  Troubleshooting Your Network Discovery Strategy 1321

CHAPTER 69

Realms and Identity Policies 1323
  About Realms and Identity Policies 1323
    About Realms 1323
      Realms and Trusted Domains 1325
      Supported Servers for Realms 1325
    Supported Server Object Class and Attribute Names 1326
CHAPTER 73 Remediations 1411

Introduction to Remediations 1411
Cisco IOS Null Route Remediations 1412
Configuring Remediations for Cisco IOS Routers 1412
Nmap Scan Remediations 1418
Set Attribute Value Remediations 1418
Configuring Set Attribute Remediations 1418
Managing Remediation Modules 1420
Managing Remediation Instances 1420
Managing Instances for a Single Remediation Module 1421

PART XVII Reporting and Alerting 1423

CHAPTER 74 Working with Reports 1425

Introduction to Reports 1425
Report Templates 1426
Report Template Fields 1426
Report Template Creation 1427
Creating a Custom Report Template 1428
Creating a Report Template from an Existing Template 1429
Creating a Report Template from an Event View 1429
Creating a Report Template by Importing a Dashboard or Workflow 1430
Data Source Options on Import Report Sections 1431
Report Template Configuration 1431
Setting the Table and Data Format for a Report Template Section 1432
Specifying the Search or Filter for a Report Template Section 1433
Setting the Search Fields that Appear in Table Format Sections 1433
Adding a Text Section to a Report Template 1434
Adding a Page Break to a Report Template 1434
Global Time Windows and Report Template Sections 1435
Setting the Global Time Window for a Report Template and Its Sections 1435
Setting the Local Time Window for Report Template Sections 1436
Renaming a Report Template Section 1436
Previewing a Report Template Section 1436
Searches in Report Template Sections 1437
Searching in Report Template Sections 1437
Input Parameters 1438
Predefined Input Parameters 1438
User-Defined Input Parameters 1439
Creating User-Defined Input Parameters 1440
Editing User-Defined Input Parameters 1440
Constraining a Search with User-Defined Input Parameters 1441
Document Attributes in a Report Template 1441
Editing Document Attributes in a Report Template 1442
Customizing a Cover Page 1442
Managing Report Template Logos 1443
Adding a New Logo 1443
Changing the Logo for a Report Template 1444
Deleting a Logo 1444
Managing Report Templates 1445
Editing Report Templates 1445
Exporting Report Templates 1446
Generating Reports 1447
Report Generation Options 1448
Distributing Reports by Email at Generation Time 1448
About Working with Generated Reports 1449
Viewing Reports 1449
Downloading Reports 1450
Storing Reports Remotely 1450
Moving Reports to Remote Storage 1451
Deleting Reports 1452
**CHAPTER 75**

External Alerting with Alert Responses 1453

- Firepower Management Center Alert Responses 1453
- Configurations Supporting Alert Responses 1454
- Creating an SNMP Alert Response 1454
- Creating a Syslog Alert Response 1455
  - Syslog Alert Facilities 1456
  - Syslog Severity Levels 1457
- Creating an Email Alert Response 1458
- Configuring Impact Flag Alerting 1459
- Configuring Discovery Event Alerting 1459
- Configuring AMP for Networks Alerting 1460

**CHAPTER 76**

External Alerting for Intrusion Events 1461

- About External Alerting for Intrusion Events 1461
- Configuring SNMP Alerting for Intrusion Events 1462
  - Intrusion SNMP Alert Options 1462
- Configuring Syslog Alerting for Intrusion Events 1463
  - Facilities and Priorities for Intrusion Syslog Alerts 1464
- Configuring Email Alerting for Intrusion Events 1465
  - Intrusion Email Alert Options 1466

**PART XVIII**

Event and Asset Analysis Tools 1469

**CHAPTER 77**

Using the Context Explorer 1471

- About the Context Explorer 1471
  - Differences Between the Dashboard and the Context Explorer 1472
  - The Traffic and Intrusion Event Counts Time Graph 1472
- The Indications of Compromise Section 1473
  - The Hosts by Indication Graph 1473
  - The Indications by Host Graph 1473
- The Network Information Section 1473
  - The Operating Systems Graph 1473
  - The Traffic by Source IP Graph 1474
The Traffic by Source User Graph  1474
The Connections by Access Control Action Graph  1474
The Traffic by Destination IP Graph  1475
The Traffic by Ingress/Egress Security Zone Graph  1475

The Application Information Section  1475
  Focusing the Application Information Section  1476
  The Traffic by Risk/Business Relevance and Application Graph  1476
  The Intrusion Events by Risk/Business Relevance and Application Graph  1476
  The Hosts by Risk/Business Relevance and Application Graph  1477
  The Application Details List  1477

The Security Intelligence Section  1477
  The Security Intelligence Traffic by Category Graph  1478
  The Security Intelligence Traffic by Source IP Graph  1478
  The Security Intelligence Traffic by Destination IP Graph  1478

The Intrusion Information Section  1479
  The Intrusion Events by Impact Graph  1479
  The Top Attackers Graph  1479
  The Top Users Graph  1479
  The Intrusion Events by Priority Graph  1479
  The Top Targets Graph  1479
  The Top Ingress/Egress Security Zones Graph  1480
  The Intrusion Event Details List  1480

The Files Information Section  1480
  The Top File Types Graph  1480
  The Top File Names Graph  1481
  The Files by Disposition Graph  1481
  The Top Hosts Sending Files Graph  1481
  The Top Hosts Receiving Files Graph  1481
  The Top Malware Detections Graph  1482

The Geolocation Information Section  1482
  The Connections by Initiator/Responder Country Graph  1482
  The Intrusion Events by Source/Destination Country Graph  1482
  The File Events by Sending/Receiving Country Graph  1483

The URL Information Section  1483
The Traffic by URL Graph 1483
The Traffic by URL Category Graph 1484
The Traffic by URL Reputation Graph 1484
Refreshing the Context Explorer 1484
Setting the Context Explorer Time Range 1485
Minimizing and Maximizing Context Explorer Sections 1485
Drilling Down on Context Explorer Data 1486
Filters in the Context Explorer 1487
Data Type Field Options 1488
Creating a Filter from the Add Filter Window 1490
Creating a Quick Filter from the Context Menu 1491
Saving Filtered Context Explorer Views 1491
Viewing Filter Data 1492
Deleting a Filter 1492

CHAPTER 78
Using the Network Map 1493
The Network Map 1493
The Hosts Network Map 1494
The Network Devices Network Map 1494
The Mobile Devices Network Map 1495
The Indications of Compromise Network Map 1496
The Application Protocols Network Map 1496
The Vulnerabilities Network Map 1497
The Host Attributes Network Map 1498
Viewing Network Maps 1498
Custom Network Topologies 1499
Creating Custom Topologies 1499
Importing Networks from the Network Discovery Policy 1500
Manually Adding Networks to Your Custom Topology 1501
Activating and Deactivating Custom Topologies 1501
Editing Custom Topologies 1502

CHAPTER 79
Incidents 1503
About Incident Handling 1503
Definition of an Incident 1503
Common Incident Handling Processes 1504
Incident Types in the Firepower System 1506
Creating Custom Incident Types 1506
Creating an Incident 1507
Editing an Incident 1508
Generating Incident Reports 1508

PART XIX

Workflows 1511

CHAPTER 80

Workflows 1513
Overview: Workflows 1513
Predefined Workflows 1513
  Predefined Intrusion Event Workflows 1514
  Predefined Malware Workflows 1515
  Predefined File Workflows 1516
  Predefined Captured File Workflows 1516
  Predefined Connection Data Workflows 1516
  Predefined Security Intelligence Workflows 1518
  Predefined Host Workflows 1518
  Predefined Indications of Compromise Workflows 1519
  Predefined Applications Workflows 1519
  Predefined Application Details Workflows 1520
  Predefined Servers Workflows 1520
  Predefined Host Attributes Workflows 1521
  The Predefined Discovery Events Workflow 1521
  Predefined User Workflows 1521
  Predefined Vulnerabilities Workflows 1521
  Predefined Third-Party Vulnerabilities Workflows 1522
  Predefined Correlation and White List Workflows 1522
  Predefined System Workflows 1522
Custom Table Workflows 1523
Using Workflows 1523
  Workflow Access by User Role 1525
Workflow Selection 1525
Workflow Pages 1527
Workflow Page Navigation Tools 1528
Workflow Page Traversal Tools 1528
File Trajectory Icons 1529
Host Profile Icons 1529
Threat Score Icons 1530
The Workflow Toolbar 1530
Using Drill-Down Pages 1531
Using Table View Pages 1531
Geolocation 1532
Geolocation Detail Information 1533
Connection Event Graphs 1534
Using Connection Event Graphs 1534
Event Time Constraints 1540
Per-Session Time Window Customization for Events 1541
The Default Time Window for Events 1544
Event View Constraints 1547
Constraining Events 1548
Compound Event View Constraints 1548
Using Compound Event View Constraints 1549
Inter-Workflow Navigation 1549
Bookmarks 1550
Creating Bookmarks 1551
Viewing Bookmarks 1551

CHAPTER 81

Searching for Events 1553
Event Searches 1553
Search Constraints 1553
General Search Constraints 1554
Wildcards and Symbols in Searches 1554
Objects and Application Filters in Searches 1555
Time Constraints in Searches 1555
IP Addresses in Searches 1556
Intrusion Event Performance Statistics Graph Types 1662
Viewing Intrusion Event Graphs 1666

CHAPTER 87
File/Malware Events and Network File Trajectory 1669
About File/Malware Events and Network File Trajectory 1669
File and Malware Events 1670
  File and Malware Event Types 1670
    File Events 1670
    Malware Events 1670
    Retrospective Malware Events 1671
    Malware Events Generated by AMP for Endpoints 1671
Using File and Malware Event Workflows 1673
File and Malware Event Fields 1674
  Malware Event Sub-Types 1682
    Information Available in File and Malware Event Fields 1683
View Details About Analyzed Files 1685
  File Composition Report 1685
  View File Details in AMP Private Cloud 1686
  Threat Scores and Dynamic Analysis Summary Reports 1686
Using Captured File Workflows 1687
  Captured File Fields 1688
  Stored Files Download 1691
Manually Submit Files for Analysis 1692
Network File Trajectory 1693
  Recently Detected Malware and Analyzed Trajectories 1693
  Network File Trajectory Detailed View 1693
    Network File Trajectory Summary Information 1694
    Network File Trajectory Map and Related Events List 1695
  Using a Network File Trajectory 1696
Work with Event Data in the AMP for Endpoints Console 1698

CHAPTER 88
Using Host Profiles 1699
Host Profiles 1699
  Viewing Host Profiles 1701
Basic Host Information in the Host Profile  1701
Operating Systems in the Host Profile  1703
  Viewing Operating System Identities  1705
  Setting the Current Operating System Identity  1705
  Operating System Identity Conflicts  1706
    Making a Conflicting Operating System Identity Current  1706
    Resolving an Operating System Identity Conflict  1707
Servers in the Host Profile  1708
  Server Details in the Host Profile  1709
  Viewing Server Details  1710
  Editing Server Identities  1711
  Resolving Server Identity Conflicts  1712
Web Applications in the Host Profile  1712
  Deleting Web Applications from the Host Profile  1713
Host Protocols in the Host Profile  1714
  Deleting a Protocol From the Host Profile  1714
Indications of Compromise in the Host Profile  1715
VLAN Tags in the Host Profile  1715
User History in the Host Profile  1715
Host Attributes in the Host Profile  1716
  Predefined Host Attributes  1716
  White List Host Attributes  1716
  User-Defined Host Attributes  1717
  Creating Text- or URL-Based Host Attributes  1718
  Creating Integer-Based Host Attributes  1718
  Creating List-Based Host Attributes  1719
  Setting Host Attribute Values  1719
White List Violations in the Host Profile  1720
  Creating Shared White List Host Profiles  1720
Malware Detections in the Host Profile  1721
Vulnerabilities in the Host Profile  1722
  Downloading Patches for Vulnerabilities  1723
  Deactivating Vulnerabilities for Individual Hosts  1723
  Deactivating Individual Vulnerabilities  1724
Scan Results in the Host Profile 1725
Scanning a Host from the Host Profile 1725

CHAPTER 89

Working with Discovery Events 1727
Discovery and Identity Data in Discovery Events 1727
Viewing Discovery Event Statistics 1728
The Statistics Summary Section 1729
The Event Breakdown Section 1730
The Protocol Breakdown Section 1730
The Application Protocol Breakdown Section 1730
The OS Breakdown Section 1730
Viewing Discovery Performance Graphs 1731
Discovery Performance Graph Types 1731
Using Discovery and Identity Workflows 1732
Discovery and Host Input Events 1734
Discovery Event Types 1734
Host Input Event Types 1738
Viewing Discovery and Host Input Events 1740
Discovery Event Fields 1740
Host Data 1742
Viewing Host Data 1742
Host Data Fields 1743
Creating a Traffic Profile for Selected Hosts 1746
Creating a Compliance White List Based on Selected Hosts 1747
Host Attribute Data 1747
Viewing Host Attributes 1748
Host Attribute Data Fields 1748
Setting Host Attributes for Selected Hosts 1749
Indications of Compromise Data 1750
View and Work with Indications of Compromise Data 1750
Indications of Compromise Data Fields 1751
Editing Indication of Compromise Rule States for a Single Host 1752
Viewing Source Events for Indication of Compromise Tags 1753
Resolving Indication of Compromise Tags 1753
Contents

Server Data 1754
  Viewing Server Data 1754
  Server Data Fields 1755
Application and Application Details Data 1757
  Viewing Application Data 1757
  Application Data Fields 1758
  Viewing Application Detail Data 1759
  Application Detail Data Fields 1760
Vulnerability Data 1762
  Vulnerability Data Fields 1762
  Vulnerability Deactivation 1764
  Viewing Vulnerability Data 1765
  Viewing Vulnerability Details 1766
  Deactivating Multiple Vulnerabilities 1766
Third-Party Vulnerability Data 1767
  Viewing Third-Party Vulnerability Data 1767
  Third-Party Vulnerability Data Fields 1768
Users and User Activity Data 1769
  User-Related Fields 1769
  User Data 1772
  User Activity Data 1774
  User Profile and Host History 1777

CHAPTER 90

Correlation and Compliance Events 1779
  Viewing Correlation Events 1779
  Correlation Event Fields 1780
Using Compliance White List Workflows 1783
  Viewing White List Events 1784
  White List Event Fields 1784
  Viewing White List Violations 1786
  White List Violation Fields 1786
Remediation Status Events 1788
  Viewing Remediation Status Events 1788
  Remediation Status Table Fields 1789
alarms 1812
arp-tables 1812
audit-log 1812
bypass 1813
high-availability Commands 1813
    config 1813
    high-availability ha-statistics 1814
cpu 1814
database Commands 1815
    processes 1815
    slow-query-log 1815
device-settings 1816
disk 1816
disk-manager 1816
dns 1817
fan-status 1817
fastpath-rules 1818
gui 1818
hostname 1818
hosts 1819
hyperthreading 1819
inline-sets 1819
interfaces 1820
ifconfig 1820
lcd 1821
link-aggregation Commands 1821
    configuration 1821
    statistics 1821
link-state 1822
log-ips-connection 1822
managers 1823
memory 1823
model 1823
mpls-depth 1824
config by virtual router 1837
status 1837
status by virtual router 1838
counters 1838
counters by virtual router 1838

Classic Device CLI Configuration Commands 1839
bypass 1839
high-availability 1839
gui 1840
lcd 1840
log-ips-connections 1840

manager Commands 1841
add 1841
delete 1841
mpls-depth 1842

network Commands 1842
dns searchdomains 1842
dns servers 1843
hostname 1843
http-proxy 1843
http-proxy-disable 1844
ipv4 delete 1844
ipv4 dhcp 1844
ipv4 manual 1845
ipv6 delete 1845
ipv6 dhcp 1846
ipv6 manual 1846
ipv6 router 1846
management-interface disable 1847
management-interface disable-event-channel 1847
management-interface disable-management-channel 1848
management-interface enable 1848
management-interface enable-event-channel 1849
management-interface enable-management-channel 1849
management-interface tcpport 1850
management-port 1850
static-routes ipv4 add 1850
static-routes ipv4 delete 1850
static-routes ipv6 add 1851
static-routes ipv6 delete 1851
password 1852
stacking disable 1852
user Commands 1853
  access 1853
  add 1853
  aging 1853
  delete 1854
  disable 1854
  enable 1854
  forcereset 1855
  maxfailedlogins 1855
  minpasswdlen 1855
  password 1856
  strengthcheck 1856
unlock 1856
vmware-tools 1857
Classic Device CLI System Commands 1857
access-control Commands 1857
  archive 1858
  clear-rule-counts 1858
  rollback 1858
disable-http-user-cert 1858
file Commands 1859
  copy 1859
  delete 1859
  list 1860
  secure-copy 1860
  generate-troubleshoot 1860
ldapsearch 1861
lockdown-sensor 1862
nat rollback 1862
reboot 1863
restart 1863
shutdown 1863
CHAPTER 1

Getting Started With Firepower

Cisco Firepower is an integrated suite of network security and traffic management products, deployed either on purpose-built platforms or as a software solution. The system is designed to help you handle network traffic in a way that complies with your organization’s security policy—your guidelines for protecting your network.

In a typical deployment, multiple traffic-sensing managed devices installed on network segments monitor traffic for analysis and report to a manager:

- Firepower Management Center
- Adaptive Security Device Manager (ASDM)

Managers provide a centralized management console with graphical user interface that you can use to perform administrative, management, analysis, and reporting tasks.

This guide focuses on the Firepower Management Center managing appliance. For information about ASA with FirePOWER Services managed via ASDM, see the guide for that management method.

- ASA with FirePOWER Services Local Management Configuration Guide
  - Introduction to Managed Devices, on page 1
  - Introduction to the Firepower Management Center, on page 4
  - Appliances Delivered with Version 6.0, on page 5
  - Firepower System Components, on page 7
  - Firepower Online Help, How To, and Documentation, on page 12
  - Firepower System IP Address Conventions, on page 14

Introduction to Managed Devices

Managed devices installed on network segments monitor traffic for analysis. Deployed passively, managed devices gather detailed information about your organization’s assets: hosts, operating systems, applications, users, sent files (including malware), vulnerabilities, and so on. The Firepower System correlates this information for your analysis so you can monitor the websites your users visit and the applications they use, assess traffic patterns, and receive notifications of intrusions and other attacks.

Deployed inline, the system can affect the flow of traffic using access control, which allows you to specify, in a granular fashion, how to handle the traffic entering, exiting, and traversing your network. The data that you collect about your network traffic and all the information you glean from it can be used to filter and control that traffic based on:
• Simple, easily-determined transport and network layer characteristics: source and destination, port, protocol, and so on
• The latest contextual information on the traffic, including characteristics such as reputation, risk, business relevance, application used, or URL visited
• Microsoft Active Directory and LDAP users in your organization; you can grant different levels of access to different users
• Characteristics of encrypted traffic; you can also decrypt this traffic for further analysis
• Whether unencrypted or decrypted traffic contains a prohibited file, detected malware, or intrusion event

Note
For the system to affect traffic, you must deploy relevant configurations to managed devices using routed, switched, or transparent interfaces, or inline interface pairs.

Each type of traffic inspection and control occurs where it makes the most sense for maximum flexibility and performance. For example, reputation-based blacklisting, because it uses simple source and destination data, can block prohibited traffic early in the process. In contrast, detecting and blocking intrusions and exploits is a last-line defense.

Network management features on 7000 and 8000 Series devices allow them to serve in switched and routed environments, perform network address translation (NAT), and to build secure virtual private network (VPN) tunnels between virtual routers you configure. You can also configure bypass interfaces, aggregated interfaces, 8000 Series fastpath rules, and strict TCP enforcement.

7000 and 8000 Series Managed Devices

Cisco Firepower 7000 and 8000 Series appliances are physical devices purpose-built for the Firepower System. 7000 and 8000 Series devices have a range of throughputs, but share most of the same capabilities. In general, 8000 Series devices are more powerful than 7000 Series; they also support additional features such as 8000 Series fastpath rules, link aggregation, and stacking.

NGIPSv

You can deploy NGIPSv (a 64-bit virtual device as an ESXi host) using the VMware vSphere Hypervisor or vCloud Director environment. You can also enable VMware Tools on all supported ESXi versions.

By default, NGIPSv uses e1000 (1 Gbit/s) interfaces. You can also use the VMware vSphere Client to replace the default sensing and management interfaces with vmxnet3 (10 Gbit/s) interfaces.

Regardless of license, NGIPSv does not support any of the system’s hardware-based features: redundancy and resource sharing, switching, routing, and so on.

Cisco ASA with FirePOWER Services

Cisco ASA with FirePOWER Services (or an ASA FirePOWER module) functions similarly to NGIPSv. In an ASA FirePOWER deployment, the ASA device provides the first-line system policy and passes traffic to the Firepower System for discovery and access control.
Regardless of the licenses installed and applied, ASA FirePOWER does not support any of the following Firepower System features:

- ASA FirePOWER does not support the Firepower System 7000 and 8000 Series hardware-based features: device high availability, stacking, switching, routing, VPN, NAT, and so on. However, the ASA platform does provide these features, which you can configure using the ASA CLI and ASDM. See the ASA documentation for more information.

- You cannot use the Firepower Management Center web interface to configure ASA FirePOWER interfaces. The Firepower Management Center does not display ASA interfaces when the ASA FirePOWER is deployed in SPAN port mode.

- You cannot use the Firepower Management Center to shut down, restart, or otherwise manage ASA FirePOWER processes.

ASA FirePOWER has a software and a command line interface (CLI) unique to the ASA platform. You use these ASA-specific tools to install the system and to perform other platform-specific administrative tasks.

Note

If you edit an ASA FirePOWER and switch from multiple context mode to single context mode (or vice versa), the device renames all of its interfaces. You must reconfigure all Firepower System security zones, correlation rules, and related configurations to use the updated ASA FirePOWER interface names.

**Network Management Capabilities by Classic Device Model**

Firepower System Classic devices have varying throughputs and capabilities, which depend on model and license. The following table matches the network management capabilities of the system with 7000 and 8000 Series devices, and the licenses you must enable. All models of Classic device can perform access control.

<table>
<thead>
<tr>
<th>Feature or Capability</th>
<th>7000 &amp; 8000 Series</th>
<th>ASA FirePOWER</th>
<th>NGIPSv</th>
<th>Classic License</th>
</tr>
</thead>
<tbody>
<tr>
<td>traffic channels</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>Any</td>
</tr>
<tr>
<td>multiple management interfaces</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>Any</td>
</tr>
<tr>
<td>link aggregation</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>Any</td>
</tr>
<tr>
<td>Firepower System web interface</td>
<td>limited</td>
<td>no</td>
<td>no</td>
<td>Any</td>
</tr>
<tr>
<td>restricted (auxiliary) command line interface (CLI)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>Any</td>
</tr>
<tr>
<td>external authentication</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>Any</td>
</tr>
<tr>
<td>connect to an eStreamer client</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>Any</td>
</tr>
<tr>
<td>Feature or Capability</td>
<td>7000 &amp; 8000 Series</td>
<td>ASA FirePOWER</td>
<td>NGIPSv</td>
<td>Classic License</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------</td>
<td>---------------</td>
<td>--------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Automatic Application Bypass</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>Any</td>
</tr>
<tr>
<td>tap mode</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>Any</td>
</tr>
<tr>
<td>8000 Series fastpath rules</td>
<td>8000 Series</td>
<td>no</td>
<td>no</td>
<td>Any</td>
</tr>
<tr>
<td>strict TCP enforcement</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>Protection</td>
</tr>
<tr>
<td>bypass mode for inline sets</td>
<td>NetMod/SFP dependent</td>
<td>no</td>
<td>no</td>
<td>Protection</td>
</tr>
<tr>
<td>malware storage pack</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>Malware</td>
</tr>
<tr>
<td>switching, routing, switched and routed aggregate interfaces</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>Control</td>
</tr>
<tr>
<td>NAT policies</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>Control</td>
</tr>
<tr>
<td>device stacking</td>
<td>8140 82xx Family 83xx Family</td>
<td>no</td>
<td>no</td>
<td>Any</td>
</tr>
<tr>
<td>device high availability</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>Control</td>
</tr>
<tr>
<td>device stack high availability</td>
<td>8140 82xx Family 83xx Family</td>
<td>no</td>
<td>no</td>
<td>Control</td>
</tr>
<tr>
<td>VPN</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>VPN</td>
</tr>
</tbody>
</table>

**Related Topics**

[Firepower Management Center Capabilities](#), on page 5

## Introduction to the Firepower Management Center

A Firepower Management Center is a fault-tolerant, purpose-built network appliance that provides a centralized management console and database repository for your Firepower System deployment. You can also deploy 64-bit virtual Firepower Management Centers using the VMware vSphere and the KVM (Kernel-based Virtual Machine) hypervisor environments, and also through Amazon Web Services (AWS) cloud platform. Firepower Management Centers have a range of device management, event storage, host monitoring, and user monitoring capabilities. Any Firepower Management Center can manage any type of Firepower System device.

Firepower Management Centers aggregate and correlate network traffic information and performance data, assessing the impact of events on particular hosts. You can monitor the information that your devices report, and assess and control the overall activity that occurs on your network. Firepower Management Centers also control the network management features on your devices: switching, routing, NAT, VPN, and so on.

Key features of the Firepower Management Center include:
Firepower Management Center Capabilities

When running this version, all Firepower Management Centers have similar capabilities, with the primary differences being capacity and speed. Firepower Management Center models vary in terms of how many devices they can manage, how many events they can store, and how many hosts and users they can monitor.

Configuration of features available in the Firepower Management Center web interface may be limited by the license and model of the device you are managing.

The MC4000 introduces Cisco’s Unified Computing System (UCS) platform into the Firepower System. The MC4000 does not support Cisco functionality that uses tools on the baseboard management controller (BMC), such as the UCS Manager or the Cisco Integrated Management Controller (CIMC).

Related Topics
- Network Management Capabilities by Classic Device Model, on page 3
- About Device Management, on page 173
- Configuring Database Event Limits, on page 443

Appliances Delivered with Version 6.0

Table 2: Version 6.0 Firepower System FMCs and Devices

<table>
<thead>
<tr>
<th>Models/Family</th>
<th>Series/Grouping</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70xx Family:</td>
<td>Firepower 7000 Series, FirePOWER Software, classic devices</td>
<td>device</td>
</tr>
<tr>
<td>• Firepower 7010, 7020, 7030, 7050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>71xx Family:</td>
<td>Firepower 7000 Series, FirePOWER Software, classic devices</td>
<td>device</td>
</tr>
<tr>
<td>• Firepower 7110, 7120</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Firepower 7115, 7125</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• AMP7150</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Models/Family</td>
<td>Series/Grouping</td>
<td>Type</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>81xx Family:</td>
<td>Firepower 8120, 8130, 8140</td>
<td>device</td>
</tr>
<tr>
<td></td>
<td>• AMP8050</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• AMP8150</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Firepower 8000 Series, FirePOWER Software, classic devices</td>
<td></td>
</tr>
<tr>
<td>82xx Family:</td>
<td>Firepower 8250</td>
<td>device</td>
</tr>
<tr>
<td></td>
<td>• Firepower 8250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Firepower 8260, 8270, 8290</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Firepower 8000 Series, FirePOWER Software, classic devices</td>
<td></td>
</tr>
<tr>
<td>83xx Family:</td>
<td>Firepower 8350</td>
<td>device</td>
</tr>
<tr>
<td></td>
<td>• Firepower 8350</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Firepower 8360, 8370, 8390</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• AMP8350</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• AMP8360/8370/8390</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Firepower 8000 Series, FirePOWER Software, classic devices</td>
<td></td>
</tr>
<tr>
<td>NGIPSv 64-bit virtual devices</td>
<td>classic devices</td>
<td>device</td>
</tr>
<tr>
<td>ASA FirePOWER for the ASA 5585-X</td>
<td>ASA with FirePOWER Services</td>
<td>ASA FirePOWER hardware module</td>
</tr>
<tr>
<td>ASA FirePOWER for the ASA 5000-X Series</td>
<td>ASA with FirePOWER Services</td>
<td>ASA FirePOWER software module</td>
</tr>
<tr>
<td></td>
<td>• ASA 5506-X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ASA 5506H-X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ASA 5506W-X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ASA 5508-X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ASA 5512-X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ASA 5515-X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ASA 5516-X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ASA 5525-X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ASA 5545-X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ASA 5555-X</td>
<td></td>
</tr>
<tr>
<td>Firepower Management Centers:</td>
<td>FMCs</td>
<td>FMC</td>
</tr>
<tr>
<td></td>
<td>• MC750, MC1500, MC3500</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MC2000, MC4000</td>
<td></td>
</tr>
</tbody>
</table>
Firepower System Components

The topics that follow describe some of the key capabilities of the Firepower System that contribute to your organization’s security, acceptable use policy, and traffic management strategy.

Many Firepower System features are appliance model, license, and user role dependent. This documentation includes information about which Firepower System licenses and devices are required for each feature, and which user roles have permission to complete each procedure.

Redundancy and Resource Sharing

The redundancy and resource-sharing features of the Firepower System allow you to ensure continuity of operations and to combine the processing resources of multiple 7000 and 8000 Series devices.

Device Stacking

Device stacking allows you to increase the amount of traffic inspected on a network segment by connecting two to four devices in a stacked configuration. When you establish a stacked configuration, you combine the resources of each stacked device into a single, shared configuration.

7000 and 8000 Series Device High Availability

7000 and 8000 Series device high availability allows you to establish redundancy of networking functionality and configuration data between two or more 7000 or 8000 Series devices or stacks. Configuring two or more peer devices or stacks into a high-availability pair results in a single logical system for policy applies, system updates, and registration. With device high availability, the system can fail over either manually or automatically.

In most cases, you can achieve Layer 3 redundancy without configuring a high-availability pair by using SFRP. SFRP allows devices to act as redundant gateways for specified IP addresses. With network redundancy, you can configure two or more devices or stacks to provide identical network connections, ensuring connectivity for other hosts on the network.

Network Traffic Management for 7000 & 8000 Series Devices

The Firepower System’s network traffic management features allow 7000 and 8000 Series devices to act as part of your organization’s network infrastructure. You can configure 7000 and 8000 Series devices to serve in a switched, routed, or hybrid (switched and routed) environment; to perform network address translation (NAT); and to build secure virtual private network (VPN) tunnels.
Switching

You can configure the Firepower System in a Layer 2 deployment so that it provides packet switching between two or more network segments. In a Layer 2 deployment, you configure switched interfaces and virtual switches on 7000 and 8000 Series devices to operate as standalone broadcast domains. A virtual switch uses the MAC address from a host to determine where to send packets. You can also group multiple physical interfaces into a single logical link that provides packet switching between two endpoints in your network. The endpoints can be two 7000 and 8000 Series devices, or a managed device connected to a third-party access switch.

Routing

You can configure the Firepower System in a Layer 3 deployment so that it routes traffic between two or more interfaces. In a Layer 3 deployment, you configure routed interfaces and virtual routers on 7000 and 8000 Series devices to receive and forward traffic. The system routes packets by making packet forwarding decisions according to the destination IP address. Routers obtain the destination from the outgoing interface based on the forwarding criteria, and access control rules designate the security policies to apply.

When you configure virtual routers, you can define static routes. In addition, you can configure Routing Information Protocol (RIP) and Open Shortest Path First (OSPF) dynamic routing protocols. You can also configure a combination of static routes and RIP or static routes and OSPF. You can set up DHCP relay for each virtual router you configure.

If you use both virtual switches and virtual routers in your deployment, you can configure associated hybrid interfaces to bridge traffic between them. These utilities analyze traffic to determine its type and the appropriate response (route, switch, or otherwise). You can also group multiple physical interfaces into a single logical link that routes traffic between two endpoints in your network. The endpoints can be two 7000 and 8000 Series devices, or a managed device connected to a third-party router.

NAT

In a Layer 3 deployment, you can configure network address translation (NAT) using 7000 and 8000 Series devices. You can expose an internal server to an external network, or allow an internal host or server to connect to an external application. You can also configure NAT to hide private network addresses from an external network by using a block of IP addresses, or by using a limited block of IP addresses and port translation.

VPN

A virtual private network (VPN) is a network connection that establishes a secure tunnel between endpoints via a public source, like the Internet or other network. You can configure the Firepower System to build secure VPN tunnels between the virtual routers of 7000 and 8000 Series devices.

Multitenancy

The domains feature allows you to implement multitenancy within a Firepower System deployment, by segmenting user access to managed devices, configurations, and events.

In addition to any restrictions imposed by your user role, your current domain level can also limit your ability to modify configurations. The system limits most management tasks, like system software updates, to the Global domain.
Discovery and Identity

Cisco’s discovery and identity technology collects information about hosts, operating systems, applications, users, files, networks, geolocation information, and vulnerabilities, in order to provide you with a complete view of your network:

- **Network discovery** policies monitor traffic on your network and collect host, application, and non-authoritative user data.
- **Identity** policies associate users on your network with a realm and an authentication method in order to collect authoritative user data.

You configure **realms** alongside your identity policies in order to establish connections to LDAP or AD servers and to perform user data downloads.

You can use certain types of discovery and identity data to build a comprehensive map of your network assets, perform forensic analysis, behavioral profiling, access control, and mitigate and respond to the vulnerabilities and exploits to which your organization is susceptible.

You can also use the Firepower Management Center’s web interface to view and analyze the data collected by the system.

Access Control

Access control is a policy-based feature that allows you to specify, inspect, and log the traffic that can traverse your network. An **access control policy** determines how the system handles traffic on your network.

The simplest access control policy directs its target devices to handle all traffic using its **default action**. You can set this default action to block or trust all traffic without further inspection, or to inspect traffic for intrusions and discovery data.

A more complex access control policy can blacklist traffic based on IP, URL, and DNS Security Intelligence data, as well as use **access control rules** to exert granular control over network traffic logging and handling. These rules can be simple or complex, matching and inspecting traffic using multiple criteria; you can control traffic by security zone, network or geographical location, VLAN, port, application, requested URL, and user. Advanced access control options include decryption, preprocessing, and performance.

Each access control rule also has an **action**, which determines whether you monitor, trust, block, or allow matching traffic. When you allow traffic, you can specify that the system first inspect it with intrusion or file policies to block any exploits, malware, or prohibited files before they reach your assets or exit your network.

SSL Inspection

SSL inspection is a policy-based feature that allows you to handle encrypted traffic without decryption, or decrypt encrypted traffic for further access control inspection. You can choose to block a source of untrusted encrypted traffic without decrypting or further analyzing the traffic, or you can choose to not decrypt encrypted traffic and inspect it with access control instead.

For further insight into encrypted traffic, you can use public key certificates and paired private keys you upload to the system to decrypt encrypted traffic traversing your network, then inspect the decrypted traffic with access control as if it was never encrypted. If the system does not block the decrypted traffic post-analysis, it reencrypts the traffic before passing it to the destination host. The system can log details about encrypted connections as it acts on them.
Intrusion Detection and Prevention

Intrusion detection and prevention is the system’s last line of defense before traffic is allowed to its destination. *Intrusion policies* are defined sets of intrusion detection and prevention configurations invoked by your access control policy. Using *intrusion rules* and other settings, these policies inspect traffic for security violations and, in inline deployments, can block or alter malicious traffic.

Cisco delivers several intrusion policies with the Firepower System. By using system-provided policies you can take advantage of the experience of the Cisco Talos Security Intelligence and Research Group (Talos). For these policies, Talos sets intrusion and preprocessor rule states (enabled or disabled), as well as provides the initial configurations for other advanced settings. An enabled rule causes the system to generate intrusion events for (and optionally block) traffic matching the rule.

If the system-provided policies do not fully address the security needs of your organization, custom policies can improve the performance of the system in your environment and can provide a focused view of the malicious traffic and policy violations occurring on your network. By creating and tuning custom policies you can configure, at a very granular level, how the system processes and inspects the traffic on your network for intrusions.

Cisco Advanced Malware Protection and File Control

To help you identify and mitigate the effects of malware, the Firepower System’s file control, network file trajectory, and Advanced Malware Protection (AMP) components can detect, track, capture, analyze, and optionally block the transmission of files (including malware files and nested files inside archive files) in network traffic.

**File Control**

*File control* allows managed devices to detect and block your users from uploading (sending) or downloading (receiving) files of specific types over specific application protocols. You configure file control as part of your overall access control configuration; file policies associated with access control rules inspect network traffic that meets rule conditions.

**AMP for Firepower**

AMP for Firepower is a network-based AMP solution, which allows the system to inspect network traffic for malware in several types of files. Appliances can store detected files for further analysis, either to their hard drive or (for some models) a malware storage pack.

You can analyze files locally on your device using *local malware analysis* to preclassify malware. Regardless of whether you store a detected file, you can submit it to the AMP cloud for a simple known-disposition lookup using the file’s SHA-256 hash value. You can also submit files to the Cisco Threat Grid cloud for *dynamic analysis*, which produces a threat score. Using this contextual information, you can configure the system to block or allow specific files.

You configure AMP for Firepower as part of your overall access control configuration; file policies associated with access control rules inspect network traffic that meets rule conditions.

**AMP for Endpoints Integration**

AMP for Endpoints is an enterprise-class endpoint-based AMP solution. Individual users install lightweight connectors on their computers and mobile devices that communicate with the AMP cloud. The Firepower
Management Center can then import records of scans, malware detections, and quarantines, as well as indications of compromise (IOC), and can display trajectories for detected threats.

Use the AMP for Endpoints management console to configure your AMP for Endpoints deployment. The console helps you quickly identify and quarantine malware. You can identify outbreaks when they occur, track their trajectories, understand their effects, and learn how to successfully recover. You can also use AMP for Endpoints to create custom protections, block execution of certain applications based on group policy, and create custom whitelists.

**Network File Trajectory**

The network file trajectory feature allows you to track a file’s transmission path across a network. The system uses SHA-256 hash values to track files; so, to track a file, the system must either:

- Calculate the file’s SHA-256 hash value and query the AMP cloud using that value
- Receive endpoint-based threat and quarantine data about that file, using the Firepower Management Center’s integration with your organization’s AMP for Endpoints deployment

Each file has an associated trajectory map, which contains a visual display of the file’s transfers over time and additional information about the file.

**Cisco AMP Private Cloud Virtual Appliance**

If your organization’s security policy does not allow the system to connect directly to the AMP cloud, whether for AMP for Firepower or AMP for Endpoints, you can configure a Cisco AMP Private Cloud Virtual Appliance (AMPv).

AMPv is a virtual machine that acts as a compressed, on-premises version of, or anonymized proxy to, the AMP cloud. Data and actions that usually involve a direct connection to the AMP cloud (such as events from AMP for Endpoints, file disposition lookups, retrospective events, and so on) are instead handled by a local connection to AMPv. With AMPv, no endpoint event data is shared over an external connection.

**Cisco AMP Threat Grid On-Premises Appliance**

If your organization has privacy or security concerns with submitting files to the public Cisco Threat Grid cloud, you can deploy an on-premises Cisco Threat Grid appliance. Like the public cloud, the on-premises appliance runs eligible files in a sandbox environment, and returns a threat score and dynamic analysis report to the Firepower System. However, the on-premises appliance does not communicate with the public cloud, or any other system external to your network.

**Application Programming Interfaces**

There are several ways to interact with the system using application programming interfaces (APIs).

**eStreamer**

The Event Streamer (eStreamer) allows you to stream several kinds of event data from a Firepower Management Center to a custom-developed client application. After you create a client application, you can connect it to the eStreamer server on the Firepower Management Center, start the eStreamer service, and begin exchanging data.

eStreamer integration requires custom programming, but allows you to request specific data from an appliance. If, for example, you display network host data within one of your network management applications, you
could write a program to retrieve host criticality or vulnerability data from the Firepower Management Center and add that information to your display.

External Database Access
The database access feature allows you to query several database tables on a Firepower Management Center, using a third-party client that supports JDBC SSL connections.

You can use an industry-standard reporting tool such as Crystal Reports, Actuate BIRT, or JasperSoft iReport to design and submit queries. Or, you can configure your own custom application to query Cisco data. For example, you could build a servlet to report intrusion and discovery event data periodically or refresh an alert dashboard.

Host Input
The host input feature allows you to augment discovery data by importing data from third-party sources using scripts or command-line import files.

The web interface also provides some host input functionality; you can modify operating system or application protocol identities, validate or invalidate vulnerabilities, and delete various items from network maps, including clients and server ports.

Remediation
The system includes an API that allows you to create remediations that your Firepower Management Center can automatically launch when conditions on your network violate an associated correlation policy or compliance white list. Remediations can automatically mitigate attacks when you are not immediately available to address them, and ensure that your system remains compliant with your organization’s security policy. In addition to remediations that you create, the Firepower Management Center ships with several predefined remediation modules.

Firepower Online Help, How To, and Documentation

You can reach the online help from the web interface:

• By clicking the context-sensitive help link on each page
• By choosing Help > Online


Top-Level Documentation Listing Pages for Firepower Management Center Deployments

The following documents may be helpful when configuring Firepower Management Center deployments, Version 6.0+.
Some of the linked documents are not applicable to Firepower Management Center deployments. For example, some links on hardware pages are unrelated to Firepower. To avoid confusion, pay careful attention to document titles. Also, some documents cover multiple products and therefore may appear on multiple product pages.

**Firepower Management Center**

- Firepower Management Center hardware appliances:
  

- Firepower Management Center Virtual appliances:
  


**NGIPS (Next Generation Intrusion Prevention System) devices**

- ASA with FirePOWER Services:
  
  - ASA 5500-X with FirePOWER Services:
    


  - ISA 3000 with FirePOWER Services:
    

- Firepower 8000 series:
  

- Firepower 7000 series:
  

- AMP for Networks:
  

- NGIPSv (virtual device):
  
License Statements in the Documentation

The License statement at the beginning of a section indicates which Classic or Smart license you must assign to a managed device in the Firepower System to enable the feature described in the section. Release 6.0 only supports devices that use Classic licenses.

Because licensed capabilities are often additive, the license statement provides only the highest required license for each feature.

An “or” statement in a License statement indicates that you must assign a particular license to the managed device to enable the feature described in the section, but an additional license can add functionality. For example, within a file policy, some file rule actions require that you assign a Protection license to the device while others require that you assign a Malware license.

For more information about licenses, see About Firepower Licenses, on page 105.

Related Topics
- Network Management Capabilities by Classic Device Model, on page 3
- About Firepower Licenses, on page 105

Supported Devices Statements in the Documentation

The Supported Devices statement at the beginning of a chapter or topic indicates that a feature is supported only on the specified device series, family, or model. For example, stacking is supported only on 8000 Series devices.

For more information on platforms supported by this release, see the release notes.

Access Statements in the Documentation

The Access statement at the beginning of each procedure in this documentation indicates the predefined user roles required to perform the procedure. Any of the listed roles can perform the procedure.

Users with custom roles may have permission sets that differ from those of the predefined roles. When a predefined role is used to indicate access requirements for a procedure, a custom role with similar permissions also has access. Some users with custom roles may use slightly different menu paths to reach configuration pages. For example, users who have a custom role with only intrusion policy privileges access the network analysis policy via the intrusion policy instead of the standard path through the access control policy.

For more information about user roles, see Predefined User Roles, on page 40 and Custom User Roles, on page 41.

Firepower System IP Address Conventions

You can use IPv4 Classless Inter-Domain Routing (CIDR) notation and the similar IPv6 prefix length notation to define address blocks in many places in the Firepower System.

When you use CIDR or prefix length notation to specify a block of IP addresses, the Firepower System uses only the portion of the network IP address specified by the mask or prefix length. For example, if you type 10.1.2.3/8, the Firepower System uses 10.0.0.0/8.

In other words, although Cisco recommends the standard method of using a network IP address on the bit boundary when using CIDR or prefix length notation, the Firepower System does not require it.
PART I

Your User Account

• Logging into the Firepower System, on page 17
• Specifying User Preferences, on page 29
CHAPTER 2

Logging into the Firepower System

The following topics describe how to log into the Firepower System:

- Firepower System User Accounts, on page 17
- User Interfaces in Firepower Management Center Deployments, on page 19
- Logging Into the Firepower Management Center Web Interface, on page 21
- Logging Into the Web Interface of a 7000 or 8000 Series Device, on page 22
- Logging Into the Firepower Management Center with CAC Credentials, on page 23
- Logging Into a 7000 or 8000 Series Device with CAC Credentials, on page 23
- Logging Into the Command Line Interface, on page 24
- Viewing Basic System Information in the Web Interface, on page 25
- Switching Domains on the Firepower Management Center, on page 25
- Logging Out of a Firepower System Web Interface, on page 26
- The Context Menu, on page 26

Firepower System User Accounts

You must provide a username and password to obtain local access to the web interface, shell, or CLI on an appliance. The features you can access on login are controlled by the privileges granted to your user account. Some appliances can be configured to use external authorization, storing user credentials on an external LDAP or RADIUS server.

Because the system audits user activity based on user accounts, make sure that users log into the system with the correct account.

On all devices, users with CLI or shell access can obtain root privileges in the shell, which can present a security risk. For system security reasons, we strongly recommend:

- If you establish external authentication, make sure that you restrict the list of users with shell access appropriately.
- When granting CLI access privileges, restrict the list of users with Config level access.
- Do not establish shell users in addition to the pre-defined admin on any Firepower device.
We strongly recommend that you do not access Firepower devices using the shell or CLI expert mode, unless directed by Cisco TAC.

Different devices support different types of user accounts, each with different capabilities.

**Firepower Management Centers**

Firepower Management Centers support the following user account types:

- A pre-defined *admin* account for web interface access, which has the administrator role and can be managed through the web interface.
- A pre-defined *admin* account for shell access, which can obtain root privileges.
- Custom user accounts, which *admin* users and users with the administrator role can create and manage.

**Caution**

For system security reasons, Cisco strongly recommends that you not establish additional shell users on the Firepower Management Center. If you accept that risk, you can use external authentication to grant any user shell access to the Firepower Management Center. You cannot enable shell access for internal web interface users.

**7000 & 8000 Series Devices**

7000 & 8000 Series devices support the following user account types:

- A pre-defined *admin* account which can be used for all forms of access to the device.
- Custom user accounts, which *admin* users and users with the administrator role can create and manage.

The 7000 & 8000 Series supports external authentication for users.

**NGIPSv Devices**

NGIPSv devices support the following user account types:

- A pre-defined *admin* account which can be used for all forms of access to the device.
- Custom user accounts, which *admin* users and users with Config access can create and manage.

The NGIPSv does not support external authentication for users.

**ASA FirePOWER Devices**

The ASA FirePOWER module supports the following user account types:

- A pre-defined *admin* account.
- Custom user accounts, which *admin* users and users with Configu access can create and manage.

The ASA FirePOWER module does not support external authentication for users. Accessing ASA devices via the ASA CLI and ASDM is described in the *Cisco ASA Series General Operations CLI Configuration Guide* and the *Cisco ASA Series General Operations ASDM Configuration Guide*. 
User Interfaces in Firepower Management Center Deployments

Depending on device type, you can access Firepower appliances using a web-based GUI, auxiliary CLI, or the Linux shell. In a Firepower Management Center deployment, you perform most configuration tasks from the Firepower Management Center's GUI. Only a few tasks require that you access the device directly.

For information on browser requirements, see the Firepower Release Notes.

<table>
<thead>
<tr>
<th>Appliance</th>
<th>Web-Based GUI</th>
<th>Auxiliary CLI</th>
<th>Linux Shell</th>
</tr>
</thead>
</table>
| Firepower Management Center | • Supported for predefined admin user and custom user accounts  
• Can be used for administrative, management, and analysis tasks | None                                                                                               | • Supported for predefined admin user and custom external user accounts  
• Accessible using an SSH, serial, or keyboard and monitor connection  
• Should be used only for administration and troubleshooting directed by Cisco TAC |
| 7000 & 8000 Series devices | • Supported for predefined admin user and custom user accounts  
• Can be used for initial setup, basic analysis, and configuration tasks only | • Supported for predefined admin user and custom user accounts  
• Accessible using an SSH, serial, or keyboard and monitor connection  
• Can be used for setup and troubleshooting directed by Cisco TAC | • Supported for predefined admin user and custom user accounts  
• Accessible by CLI users with Config access using the expert command  
• Should be used only for administration and troubleshooting directed by Cisco TAC |
| NGIPSv                    | None                                                                           | • Supported for predefined admin user and custom user accounts  
• Accessible using an SSH connection or VM console  
• Can be used for setup and troubleshooting directed by Cisco TAC | • Supported for predefined admin user and custom user accounts  
• Accessible by CLI users with Config access using the expert command  
• Should be used only for administration and troubleshooting directed by Cisco TAC |
Web Interface Considerations

Your User Account

<table>
<thead>
<tr>
<th>Appliance</th>
<th>Web-Based GUI</th>
<th>Auxiliary CLI</th>
<th>Linux Shell</th>
</tr>
</thead>
</table>
| ASA FirePOWER module      | None          | • Supported for predefined **admin** user and custom user accounts  
• Accessible using an SSH connection. Also accessible using keyboard and monitor connection for ASA-5585-X (hardware module), or console port for ASA 5512-X through ASA 5555-X and ASA 5506-X through 5516-X (software modules)  
• Can be used for configuration and management tasks | None         |

**Related Topics**  
Managing User Accounts, on page 61

**Web Interface Considerations**

- If your organization uses Common Access Cards (CACs) for authentication, you can use your CAC credentials to obtain access to the web interface of an appliance.

- The first time you visit the appliance home page during a web session, you can view information about your last login session for that appliance. You can see the following information about your last login:
  - the day of the week, month, date, and year of the login  
  - the appliance-local time of the login in 24-hour notation  
  - the host and domain name last used to access the appliance

- The menus and menu options listed at the top of the default home page are based on the privileges for your user account. However, the links on the default home page include options that span the range of user account privileges. If you click a link that requires different privileges from those granted to your account, the system displays a warning message and logs the activity.

- Some processes that take a significant amount of time may cause your web browser to display a message that a script has become unresponsive. If this occurs, make sure you allow the script to continue until it finishes.

**Related Topics**  
Specifying Your Home Page, on page 30
Session Timeout

By default, the Firepower System automatically logs you out of a session after 1 hour of inactivity, unless you are otherwise configured to be exempt from session timeout.

Users with the Administrator role can change the session timeout interval for an appliance via the following settings:

<table>
<thead>
<tr>
<th>Appliance</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firepower Management Center</td>
<td>System &gt; Configuration &gt; Shell Timeout</td>
</tr>
<tr>
<td>7000 &amp; 8000 Series devices</td>
<td>Devices &gt; Platform Settings &gt; Shell Timeout</td>
</tr>
</tbody>
</table>

Related Topics

Configuring Session Timeouts, on page 482

Logging Into the Firepower Management Center Web Interface

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>FMC</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

Users are restricted to a single active session. If you try to log in with a user account that already has an active session, the system prompts you to terminate the other session or log in as a different user.

Before you begin

• If you do not have access to the web interface, contact your system administrator to modify your account privileges, or log in as a user with Administrator access and modify the privileges for the account.

• Create user accounts as described in Creating a User Account, on page 62.

Procedure

Step 1 Direct your browser to https://hostname/, where hostname corresponds to the host name of the Firepower Management Center.

Step 2 In the Username and Password fields, enter your user name and password. Pay attention to the following guidelines:

• User names are not case-sensitive.

• In a multidomain deployment, prepend the user name with the domain where your user account was created. You are not required to prepend any ancestor domains. For example, if your user account was created in SubdomainB, which has an ancestor DomainA, enter your user name in the following format: SubdomainB\username

• If your organization uses SecurID® tokens when logging in, append the token to your SecurID PIN and use that as your password to log in. For example, if your PIN is 1111 and the SecurID token is 222222,
Step 3

Click **Login**.

**Related Topics**

*Session Timeout*, on page 21

---

## Logging Into the Web Interface of a 7000 or 8000 Series Device

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>N/A</td>
<td>Any</td>
</tr>
</tbody>
</table>

Users are restricted to a single active session. If you try to log in with a user account that already has an active session, the system prompts you to terminate the other session or log in as a different user.

### Before you begin

- If you do not have access to the web interface, contact your system administrator to modify your account privileges, or log in as a user with Administrator access and modify the privileges for the account.
- Complete the initial setup process and create user accounts as described in the Firepower getting started guide appropriate to the device, and *Creating a User Account*, on page 62.

### Procedure

**Step 1**

Direct your browser to `https://hostname/`, where `hostname` corresponds to the host name of the managed device you want to access.

**Step 2**

In the **Username** and **Password** fields, enter your user name and password. Pay attention to the following guidelines:

- User names are *not* case-sensitive.
- If your organization uses SecurID® tokens when logging in, append the token to your SecurID PIN and use that as your password to log in. For example, if your PIN is 1111 and the SecurID token is 222222, enter 1111222222. You must have already generated your SecurID PIN before you can log into the Firepower System.

**Step 3**

Click **Login**.

**Related Topics**

*Session Timeout*, on page 21
Logging Into the Firepower Management Center with CAC Credentials

<table>
<thead>
<tr>
<th>Access</th>
<th>Supported Domains</th>
<th>Supported Devices</th>
<th>Classic License</th>
<th>Smart License</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Any</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Users are restricted to a single active session.

⚠️ **Caution**

Do not remove a CAC during an active browsing session. If you remove or replace a CAC during a session, your web browser terminates the session and the system logs you out of the web interface.

**Before you begin**

- If you do not have access to the web interface, contact your system administrator to modify your account privileges, or log in as a user with Administrator access and modify the privileges for the account.
- Create user accounts as described in the Creating a User Account, on page 62.
- Configure CAC authentication and authorization as described in Configuring CAC Authentication, on page 72.

**Procedure**

**Step 1** Insert a CAC as instructed by your organization.

**Step 2** Direct your browser to `https://hostname/`, where `hostname` corresponds to the host name of the Firepower Management Center.

**Step 3** If prompted, enter the PIN associated with the CAC you inserted in step 1.

**Step 4** If prompted, choose the appropriate certificate from the drop-down list.

**Step 5** Click **Continue**.

**Related Topics**

- CAC Authentication, on page 71
- Session Timeout, on page 21

Logging Into a 7000 or 8000 Series Device with CAC Credentials

<table>
<thead>
<tr>
<th>Access</th>
<th>Supported Domains</th>
<th>Supported Devices</th>
<th>Classic License</th>
<th>Smart License</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>N/A</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Users are restricted to a single active session.
Caution
Do not remove a CAC during an active browsing session. If you remove or replace a CAC during a session, your web browser terminates the session and the system logs you out of the web interface.

Before you begin
- If you do not have access to the web interface, contact your system administrator to modify your account privileges, or log in as a user with Administrator access and modify the privileges for the account.
- Create user accounts as described in Creating a User Account, on page 62.
- Configure CAC authentication and authorization as described in Configuring CAC Authentication, on page 72.

Procedure

Step 1
Insert a CAC as instructed by your organization.

Step 2
Direct your browser to https://hostname/, where hostname corresponds to the host name of the appliance you want to access.

Step 3
If prompted, enter the PIN associated with the CAC you inserted in step 1.

Step 4
If prompted, choose the appropriate certificate from the drop-down list.

Step 5
Click Continue.

Related Topics
CAC Authentication, on page 71
Session Timeout, on page 21

Logging Into the Command Line Interface

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>7000 &amp; 8000 Series ASA FirePOWER NGIPSv</td>
<td>N/A</td>
<td>CLI Basic Configuration</td>
</tr>
</tbody>
</table>

You can log directly into the command line interface on Classic managed devices (7000 & 8000 Series, NGIPSv, and ASA FirePOWER).

Before you begin
Complete the initial setup process using the default admin user for the initial login.
- For the 7000 & 8000 Series devices, create user accounts at the web interface as described in Creating a User Account, on page 62.
• For all devices, create additional user accounts that can log into the CLI using the `configure user add` command.

**Procedure**

**Step 1** Use SSH to connect to the hostname or IP address of the management interface. Alternatively, you can connect to the console port.

**Step 2** At the `login as:` command prompt, enter your user name and press Enter.

**Step 3** At the `Password:` prompt, enter your password and press Enter.

If your organization uses SecurID® tokens when logging in, append the token to your SecurID PIN and use that as your password to log in. For example, if your PIN is 1111 and the SecurID token is 222222, enter 1111222222. You must have already generated your SecurID PIN before you can log into the Firepower System.

**Step 4** At the CLI prompt, use any of the commands allowed by your level of command line access.

---

### Viewing Basic System Information in the Web Interface

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

The About page displays information about your appliance, including the model, serial number, and version information for various components of the Firepower System. It also includes Cisco copyright information.

**Procedure**

**Step 1** Click Help in the toolbar at the top of the page.

**Step 2** Choose About.

---

### Switching Domains on the Firepower Management Center

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Device</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>FMC</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

In a multidomain deployment, user role privileges determine which domains a user can access and which privileges the user has within each of those domains. You can associate a single user account with multiple domains and assign different privileges for that user in each domain. For example, you can assign a user read-only privileges in the Global domain, but Administrator privileges in a descendant domain.

Users associated with multiple domains can switch between domains within the same web interface session.
Under your username in the toolbar, the system displays a tree of available domains. The tree:

- Displays ancestor domains, but may disable access to them based on the privileges assigned to your user account.
- Hides any other domain your user account cannot access, including sibling and descendant domains.

When you switch to a domain, the system displays:

- Data that is relevant to that domain only.
- Menu options determined by the user role assigned to you for that domain.

**Procedure**

From the drop-down list under your user name, choose the domain you want to access.

---

### Logging Out of a Firepower System Web Interface

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

When you are no longer actively using a Firepower System web interface, Cisco recommends that you log out, even if you are only stepping away from your web browser for a short period of time. Logging out ends your web session and ensures that no one can use the interface with your credentials.

**Procedure**

From the drop-down list under your user name, choose **Logout**.

**Related Topics**

- [Session Timeout](#), on page 21

### The Context Menu

Certain pages in the Firepower System web interface support a right-click (most common) or left-click context menu that you can use as a shortcut for accessing other features in the Firepower System. The contents of the context menu depend where you access it—not only the page but also the specific data.

For example:

- IP address hotspots provide information about the host associated with that address, including any available whois and host profile information.
• SHA-256 hash value hotspots allow you to add a file’s SHA-256 hash value to the clean list or custom detection list, or view the entire hash value for copying.

On pages or locations that do not support the Firepower System context menu, the normal context menu for your browser appears.

Policy Editors

Many policy editors contain hotspots over each rule. You can insert new rules and categories; cut, copy, and paste rules; set the rule state; and edit the rule.

Intrusion Rules Editor

The intrusion rules editor contains hotspots over each intrusion rule. You can edit the rule, set the rule state, configure thresholding and suppression options, and view rule documentation.

Event Viewer

Event pages (the drill-down pages and table views available under the Analysis menu) contain hotspots over each event, IP address, URL, DNS query, and certain files’ SHA-256 hash values. While viewing most event types, you can:

• View related information in the Context Explorer.

• Drill down into event information in a new window.

• View the full text in places where an event field contains text too long to fully display in the event view, such as a file’s SHA-256 hash value, a vulnerability description, or a URL.

While viewing connection events, you can add items to the default Security Intelligence whitelists and blacklists:

• An IP address, from an IP address hotspot.

• A URL or domain name, from a URL hotspot.

• A DNS query, from a DNS query hotspot.

While viewing captured files, file events, and malware events, you can:

• Add a file to or remove a file from the clean list or custom detection list.

• Download a copy of the file.

• View nested files inside an archive file.

• Download the parent archive file for a nested file.

• View the file composition.

• Submit the file for local malware and dynamic analysis.

While viewing intrusion events, you can perform similar tasks to those in the intrusion rules editor or an intrusion policy:

• Edit the triggering rule.

• Set the rule state, including disabling the rule.

• Configure thresholding and suppression options.
• View rule documentation.

**Intrusion Event Packet View**

Intrusion event packet views contain IP address hotspots. The packet view uses a left-click context menu.

**Dashboard**

Many dashboard widgets contain hotspots to view related information in the Context Explorer. Dashboard widgets can also contain IP address and SHA-256 hash value hotspots.

**Context Explorer**

The Context Explorer contains hotspots over its charts, tables, and graphs. If you want to examine data from graphs or lists in more detail than the Context Explorer allows, you can drill down to the table views of the relevant data. You can also view related host, user, application, file, and intrusion rule information.

The Context Explorer uses a left-click context menu, which also contains filtering and other options unique to the Context Explorer.

**Related Topics**

*Security Intelligence Lists and Feeds*, on page 349
Specifying User Preferences

The following topics describe how to specify user preferences:

- User Preferences Introduction, on page 29
- Changing Your Password, on page 29
- Changing an Expired Password, on page 30
- Specifying Your Home Page, on page 30
- Configuring Event View Settings, on page 31
- Setting Your Default Time Zone, on page 35
- Specifying Your Default Dashboard, on page 36

User Preferences Introduction

You can configure the preferences that are tied to a single user account, such as the home page, account password, time zone, dashboard, and event viewing preferences.

Depending on your user role, you can specify certain preferences for your user account, including passwords, event viewing preferences, time zone settings, and home page preferences.

In a multidomain deployment, user preferences apply to all domains where your account has access. When specifying home page and dashboard preferences, keep in mind that certain pages and dashboard widgets are constrained by domain.

Changing Your Password

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

All user accounts are protected with a password. You can change your password at any time, and depending on the settings for your user account, you may have to change your password periodically.

If password strength checking is enabled, passwords must be at least eight alphanumeric characters of mixed case and must include at least one numeric character. Passwords cannot be a word that appears in a dictionary or include consecutive repeating characters.

If you are an LDAP or a RADIUS user, you cannot change your password through the web interface.
Procedure

**Step 1**  From the drop-down list under your user name, choose User Preferences.

**Step 2**  Enter your Current Password, and click Change.

**Step 3**  In the New Password and Confirm fields, enter your new password.

**Step 4**  Click Change.

### Changing an Expired Password

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

Depending on the settings for your user account, your password may expire. Note that the password expiration time period is set when your account is created and cannot be changed. If your password has expired, the Password Expiration Warning page appears.

**Procedure**

On the Password Expiration Warning page, you have two choices:

- Click Change Password to change your password now. If you have zero warning days left, you must change your password.

  **Tip**  If password strength checking is enabled, passwords must be at least eight alphanumeric characters of mixed case and must include at least one numeric character. Passwords cannot be a word that appears in a dictionary or include consecutive repeating characters.

- Click Skip to change your password later.

### Specifying Your Home Page

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any except External Database user</td>
</tr>
</tbody>
</table>

You can specify a page within the web interface as your home page for the appliance. The default home page is the Summary Dashboard (Overview > Dashboards), except for user accounts with no dashboard access.

In a multidomain deployment, the home page you choose applies to all domains where your user account has access. When choosing a home page for an account that frequently accesses multiple domains, keep in mind that certain pages are constrained to the Global domain.
Procedure

**Step 1** From the drop-down list under your username, choose *User Preferences*.

**Step 2** Click *HomePage*.

**Step 3** Choose the page you want to use as your home page from the drop-down list.

The options in the drop-down list are based on the access privileges for your user account. For more information, see User Account Privileges, on page 42.

**Step 4** Click *Save*.

---

**Configuring Event View Settings**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Device</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>feature dependent</td>
</tr>
</tbody>
</table>

Use the Event View Settings page to configure characteristics of event views on the Firepower Management Center. Note that some event view configurations are available only for specific user roles. Users with the External Database User role can view parts of the event view settings user interface, but changing those settings has no meaningful result.

**Procedure**

**Step 1** From the drop-down list under your user name, choose *User Preferences*.

**Step 2** Click *Event View Settings*.

**Step 3** In the *Event Preferences* section, configure the basic characteristics of event views; see Event View Preferences, on page 31.

**Step 4** In the *File Preferences* section, configure file download preferences; see File Download Preferences, on page 33.

**Step 5** In the *Default Time Windows* section, configure the default time window or windows; see Default Time Windows, on page 33.

**Step 6** In the *Default Workflow* sections, configure default workflows; see Default Workflows, on page 35.

**Step 7** Click *Save*.

---

**Event View Preferences**

Use the Event Preferences section of the Event View Settings page to configure basic characteristics of event views in the Firepower System. This section is available for all user roles, although it has little to no significance for users who cannot view events.

The following fields appear in the Event Preferences section:
• The **Confirm “All” Actions** field controls whether the appliance forces you to confirm actions that affect all events in an event view.

For example, if this setting is enabled and you click **Delete All** on an event view, you must confirm that you want to delete all the events that meet the current constraints (including events not displayed on the current page) before the appliance will delete them from the database.

• The **Resolve IP Addresses** field allows the appliance, whenever possible, to display host names instead of IP addresses in event views.

Note that an event view may be slow to display if it contains a large number of IP addresses and you have enabled this option. Note also that for this setting to take effect, you must use management interfaces configuration to establish a DNS server in the system settings.

• The **Expand Packet View** field allows you to configure how the packet view for intrusion events appears. By default, the appliance displays a collapsed version of the packet view:

  • **None** - collapse all subsections of the Packet Information section of the packet view
  • **Packet Text** - expand only the Packet Text subsection
  • **Packet Bytes** - expand only the Packet Bytes subsection
  • **All** - expand all sections

Regardless of the default setting, you can always manually expand the sections in the packet view to view detailed information about a captured packet.

• The **Rows Per Page** field controls how many rows of events per page you want to appear in drill-down pages and table views.

• The **Refresh Interval** field sets the refresh interval for event views in minutes. Entering 0 enables the refresh option. Note that this interval does not apply to dashboards.

• The **Statistics Refresh Interval** controls the refresh interval for event summary pages such as the Intrusion Event Statistics and Discovery Statistics pages. Entering 0 disables the refresh option. Note that this interval does not apply to dashboards.

• The **Deactivate Rules** field controls which links appear on the packet view of intrusion events generated by standard text rules:

  • **All Policies** - a single link that deactivates the standard text rule in all the locally defined custom intrusion policies

  • **Current Policy** - a single link that deactivates the standard text rule in only the currently deployed intrusion policy. Note that you cannot deactivate rules in the default policies.

  • **Ask** - links for each of these options

To see these links on the packet view, your user account must have either Administrator or Intrusion Admin access.

**Related Topics**

[Management Interfaces](#), on page 445
File Download Preferences

Use the File Preferences section of the Event View Settings page to configure basic characteristics of local file downloads. This section is only available to users with the Administrator, Security Analyst, or Security Analyst (Read Only) user roles.

Note that if your appliance does not support downloading captured files, these options are disabled.

The following fields appear in the File Preferences section:

- The **Confirm ‘Download File’ Actions** check box controls whether a File Download pop-up window appears each time you download a file, displaying a warning and prompting you to continue or cancel.

  **Caution** Cisco strongly recommends you do **not** download malware, as it can cause adverse consequences. Exercise caution when downloading any file, as it may contain malware. Ensure you have taken any necessary precautions to secure the download destination before downloading files.

  Note that you can disable this option any time you download a file.

- When you download a captured file, the system creates a password-protected .zip archive containing the file. The **Zip File Password** field defines the password you want to use to restrict access to the .zip file. If you leave this field blank, the system creates archive files without passwords.

- The **Show Zip File Password** check box toggles displaying plain text or obfuscated characters in the **Zip File Password** field. When this field is cleared, the **Zip File Password** displays obfuscated characters.

Default Time Windows

The time window, sometimes called the time range, imposes a time constraint on the events in any event view. Use the Default Time Windows section of the Event View Settings page to control the default behavior of the time window.

User role access to this section is as follows:

- Administrators and Maintenance Users can access the full section.

- Security Analysts and Security Analysts (Read Only) can access all options except **Audit Log Time Window**.

- Access Admins, Discovery Admins, External Database Users, Intrusion Admins, Network Admins, and Security Approvers can access only the **Events Time Window** option.

Note that, regardless of the default time window setting, you can always manually change the time window for individual event views during your event analysis. Also, keep in mind that time window settings are valid for only the current session. When you log out and then log back in, time windows are reset to the defaults you configured on this page.

There are three types of events for which you can set the default time window:

- The **Events Time Window** sets a single default time window for most events that can be constrained by time.

- The **Audit Log Time Window** sets the default time window for the audit log.
• The Health Monitoring Time Window sets the default time window for health events.

You can only set time windows for event types your user account can access. All user types can set event time windows. Administrators, Maintenance Users, and Security Analysts can set health monitoring time windows. Administrators and Maintenance Users can set audit log time windows.

Note that because not all event views can be constrained by time, time window settings have no effect on event views that display hosts, host attributes, applications, clients, vulnerabilities, user identity, or white list violations.

You can either use Multiple time windows, one for each of these types of events, or you can use a Single time window that applies to all events. If you use a single time window, the settings for the three types of time window disappear and a new Global Time Window setting appears.

There are three types of time window:

• static, which displays all the events generated from a specific start time to a specific end time

• expanding, which displays all the events generated from a specific start time to the present; as time moves forward, the time window expands and new events are added to the event view

• sliding, which displays all the events generated from a specific start time (for example, one day ago) to the present; as time moves forward, the time window “slides” so that you see only the events for the range you configured (in this example, for the last day)

The maximum time range for all time windows is from midnight on January 1, 1970 (UTC) to 3:14:07 AM on January 19, 2038 (UTC).

The following options appear in the Time Window Settings drop-down list:

• The Show the Last - Sliding option allows you configure a sliding default time window of the length you specify.

The appliance displays all the events generated from a specific start time (for example, 1 hour ago) to the present. As you change event views, the time window “slides” so that you always see events from the last hour.

• The Show the Last - Static/Expanding option allows you to configure either a static or expanding default time window of the length you specify.

For static time windows, enable the Use End Time check box. The appliance displays all the events generated from a specific start time (for example, 1 hour ago) to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.

For expanding time windows, disable the Use End Time check box. The appliance displays all the events generated from a specific start time (for example, 1 hour ago) to the present. As you change event views, the time window expands to the present time.

• The Current Day - Static/Expanding option allows you to configure either a static or expanding default time window for the current day. The current day begins at midnight, based on the time zone setting for your current session.

For static time windows, enable the Use End Time check box. The appliance displays all the events generated from midnight to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.
For **expanding** time windows, disable the **Use End Time** check box. The appliance displays all the events generated from midnight to the present. As you change event views, the time window expands to the present time. Note that if your analysis continues for over 24 hours before you log out, this time window can be more than 24 hours.

- The **Current Week - Static/Expanding** option allows you to configure either a static or expanding default time window for the current week. The current week begins at midnight on the previous Sunday, based on the time zone setting for your current session.

For **static** time windows, enable the **Use End Time** check box. The appliance displays all the events generated from midnight to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.

For **expanding** time windows, disable the **Use End Time** check box. The appliance displays all the events generated from midnight Sunday to the present. As you change event views, the time window expands to the present time. Note that if your analysis continues for over 1 week before you log out, this time window can be more than 1 week.

### Default Workflows

A workflow is a series of pages displaying data that analysts use to evaluate events. For each event type, the appliance ships with at least one predefined workflow. For example, as a Security Analyst, depending on the type of analysis you are performing, you can choose among ten different intrusion event workflows, each of which presents intrusion event data in a different way.

The appliance is configured with a default workflow for each event type. For example, the Events by Priority and Classification workflow is the default for intrusion events. This means whenever you view intrusion events (including reviewed intrusion events), the appliance displays the Events by Priority and Classification workflow.

You can, however, change the default workflow for each event type. The default workflows you are able to configure depend on your user role. For example, intrusion event analysts cannot set default discovery event workflows.

### Setting Your Default Time Zone

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

Your Firepower Management Center and its managed devices are heavily dependent on accurate time. The system clock is a system facility that maintains the time of the Firepower System. The system clock is set to Universal Coordinated Time (UTC), which is the primary time standard by which the world regulates clocks and time.

You can change the time zone used to display events from the standard UTC time that the appliance uses. When you configure a time zone, it applies only to your user account and is in effect until you make further changes to the time zone.
Restriction

The Time Zone function (in User Preferences) assumes that the default system clock is set to UTC time. DO NOT ATTEMPT TO CHANGE THE SYSTEM TIME. Be advised that changing the system time from UTC is NOT supported, and doing so will require you to reimage the device to recover from an unsupported state.

Procedure

Step 1
From the drop-down list under your user name, choose User Preferences.

Step 2
Click the Time Zone Preference tab.

Step 3
From the left list box, choose the continent or area that contains the time zone you want to use.

Step 4
From the right list box, choose the zone (city name) that corresponds with the time zone you want to use.

Step 5
Click Save.

Specifying Your Default Dashboard

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst</td>
</tr>
</tbody>
</table>

The default dashboard appears when you choose Overview > Dashboards. Unless changed, the default dashboard for all users is the Summary dashboard.

In a multidomain deployment, the default dashboard you choose applies to all domains where your user account has access. When choosing a dashboard for an account that frequently accesses multiple domains, keep in mind that certain dashboard widgets are constrained by domain.

Procedure

Step 1
From the drop-down list under your user name, choose User Preferences.

Step 2
Click Dashboard Settings.

Step 3
Choose the dashboard you want to use as your default from the drop-down list. If you choose None, when you select Overview > Dashboards, you can then choose a dashboard to view.

Step 4
Click Save.

Related Topics

Viewing Dashboards, on page 217
PART II

Firepower System Management

• Firepower System User Management, on page 39
• Licensing the Firepower System, on page 105
• System Software Updates, on page 119
• Backup and Restore, on page 135
• Configuration Import and Export, on page 145
• Task Scheduling, on page 151
• FMC Database Purge, on page 171
• Device Management Basics, on page 173
Firepower System User Management

The following topics describe how a user with Administrator access can manage user accounts in the Firepower System:

- User Roles, on page 39
- User Accounts, on page 61
- Firepower System User Authentication, on page 67
- LDAP Authentication, on page 70
- RADIUS Authentication, on page 93
- Single Sign-on (SSO), on page 102

User Roles

The Firepower System lets you allocate user privileges based on the user’s role. For example, you can grant analysts predefined roles such as Security Analyst and Discovery Admin and reserve the Administrator role for the security administrator managing the Firepower System. You can also create custom user roles with access privileges tailored to your organization’s needs.

In the platform settings policy for a managed device, you set a default access role for all users from that device who are externally authenticated. After an externally authenticated user logs in for the first time, you can add or remove access rights for that user on the User Management page. If you do not modify the user’s rights, the user has only the rights granted by default. Because you create internally authenticated users manually, you set the access rights when you create them.

If you configured management of access rights through LDAP groups, the access rights for users are based on their membership in LDAP groups. They receive the default access rights for the group that they belong to that has the highest level of access. If they do not belong to any groups and you have configured group access, they receive the default user access rights configured in the authentication object for the LDAP server. If you configure group access, those settings override the default access setting in the platform settings policy.

Similarly, if you assign a user to specific user role lists in a RADIUS authentication object, the user receives all assigned roles, unless one or more of those roles are mutually incompatible. If a user is on the lists for two mutually incompatible roles, the user receives the role that has the highest level of access. If the user does not belong to any lists and you have configured a default access role in the authentication object, the user receives that role. If you configure default access in the authentication object, those settings override the default access setting in the platform settings policy.

In a multidomain deployment, you can assign users roles in multiple domains. For example, you can assign a user read-only privileges in the Global domain, but Administrator privileges in a subdomain.
Predefined User Roles

The Firepower System includes ten predefined user roles that provide a range of access privilege sets to meet the needs of your organization. Note that 7000 and 8000 Series devices have access to only three of the ten predefined user roles: Administrator, Maintenance User, and Security Analyst.

Although you cannot edit predefined user roles, you can use their access privilege sets as the basis for custom user roles. In addition, you cannot configure them to escalate to another user role.

The following table briefly describes the predefined roles available to you.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Admin</td>
<td>Provides access to access control policy and associated features in the Policies menu. Access Admins cannot deploy policies.</td>
</tr>
<tr>
<td>Administrator</td>
<td>Administrators have access to all functionality; their sessions present a higher security risk if compromised, so you cannot make them exempt from login session timeouts. You should limit use of the Administrator role for security reasons.</td>
</tr>
<tr>
<td>Discovery Admin</td>
<td>Provides access to network discovery, application detection, and correlation features in the Policies menu. Discovery Admins cannot deploy policies.</td>
</tr>
<tr>
<td>External Database User</td>
<td>Provides read-only access to the Firepower System database using an application that supports JDBC SSL connections. For the third-party application to authenticate to the Firepower System appliance, you must enable database access in the system settings. On the web interface, External Database Users have access only to online help-related options in the Help menu. Because this role’s function does not involve the web interface, access is provided only for ease of support and password changes.</td>
</tr>
<tr>
<td>Intrusion Admin</td>
<td>Provides access to all intrusion policy, intrusion rule, and network analysis policy features in the Policies and Objects menus. Intrusion Admins cannot deploy policies.</td>
</tr>
<tr>
<td>Maintenance User</td>
<td>Provides access to monitoring and maintenance features. Maintenance Users have access to maintenance-related options in the Health and System menus.</td>
</tr>
<tr>
<td>Network Admin</td>
<td>Provides access to access control, SSL inspection, DNS policy, and identity policy features in the Policies menu, as well as device configuration features in the Devices menus. Network Admins can deploy configuration changes to devices.</td>
</tr>
<tr>
<td>Security Analyst</td>
<td>Provides access to security event analysis features, and read-only access to health events, in the Overview, Analysis, Health, and System menus.</td>
</tr>
<tr>
<td>Security Analyst (Read Only)</td>
<td>Provides read-only access to security event analysis features and health event features in the Overview, Analysis, Health, and System menus.</td>
</tr>
</tbody>
</table>
Security Approver

Provides limited access to access control and associated policies and network discovery policies in the Policies menu. Security Approvers can view and deploy these policies, but cannot make policy changes.

Externally authenticated users, if assigned no other roles, have minimum access rights based on the settings in LDAP or RADIUS authentication objects and in platform settings. You can assign additional rights to these users, but to remove or change minimum access rights, you must perform the following tasks:

- Move the user from one list to another in the authentication object or change the user's attribute value or group membership on the external authentication server.
- Update platform settings.
- Use the User Management page to remove the access from that user account.

**Related Topics**

User Account Privileges, on page 42

**Custom User Roles**

In addition to the predefined user roles, you can also create custom user roles with specialized access privileges. Custom user roles can have any set of menu-based and system permissions, and may be completely original or based on a predefined user role. Like predefined user roles, custom roles can serve as the default role for externally authenticated users. Unlike predefined roles, you can modify and delete custom roles.

Selectable permissions are hierarchical, and are based on the Firepower System menu layout. Permissions are expandable if they have sub-pages or if they have more fine-grained permissions available beyond simple page access. In that case, the parent permission grants page view access and the children granular access to related features of that page. Permissions that contain the word “Manage” grant the ability to edit and delete information that other users create.

**Tip**

For pages or features not included in the menu structure, privileges are granted by parent or related pages. For example, the Modify Intrusion Policy privilege also allows you to modify network analysis policies.

You can apply restricted searches to a custom user role. These constrain the data a user may see in the event viewer. You can configure a restricted search by first creating a private saved search and selecting it from the Restricted Search drop-down menu under the appropriate menu-based permission.

When you configure a custom user role on a Firepower Management Center, all menu-based permissions are available for you to grant. When you configure a custom user role on a managed device, only some permissions are available — those relevant to device functions.

The selectable options under System Permissions allow you to create a user role that can make queries to the external database or escalate to the permissions of a target user role.

Optionally, instead of creating a new custom user role, you can export a custom user role from another appliance, then import it onto your appliance. You can then edit the imported role to suit your needs before you apply it.

**Related Topics**

User Account Privileges, on page 42

External Database Access Settings, on page 442
Example: Custom User Roles and Access Control

You can create custom user roles for access control-related features to designate whether Firepower System users can view and modify access control and associated policies.

The following table lists custom roles that you could create and user permissions granted for each example. The table lists the privileges required for each custom role. In this example, Policy Approvers can view (but not modify) access control and intrusion policies. They can also deploy configuration changes to devices.

Table 3: Example Access Control Custom Roles

<table>
<thead>
<tr>
<th>Custom Role Permission</th>
<th>Example: Access Control Editor</th>
<th>Example: Intrusion &amp; Network Analysis Editor</th>
<th>Example: Policy Approver</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Access Control Policy</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Access Control Policy</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Intrusion Policy</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Intrusion Policy</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Deploy Configuration to Devices</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
</tbody>
</table>

User Account Privileges

The following sections provide a list of the configurable user permissions in the Firepower System and the predefined user roles that can access them. Not all permissions are available on managed devices; permissions available only on the Firepower Management Center are marked accordingly.

Overview Menu

The following table lists, in order, the user role privileges required to access each option in the Overview menu and whether the user role has access to the sub-permissions within. The Security Approver, Discovery Admin, Intrusion Admin, Access Admin, Network Admin, and External Database User roles have no permissions in the Overview menu.

Table 4: Overview Menu

<table>
<thead>
<tr>
<th>Permission</th>
<th>Admin</th>
<th>Maint User</th>
<th>Security Analyst</th>
<th>Security Analyst (RO)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboards</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Manage Dashboards</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Appliance Information Widget</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Appliance Status Widget (FMC only)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Permission</td>
<td>Admin</td>
<td>Maint User</td>
<td>Security Analyst</td>
<td>Security Analyst (RO)</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------</td>
<td>------------</td>
<td>------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Correlation Events Widget</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Current Interface Status Widget</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Current Sessions Widget</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Custom Analysis Widget</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Disk Usage Widget</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Interface Traffic Widget</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Intrusion Events Widget</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Network Correlation Widget</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Product Licensing Widget</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Product Updates Widget</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>RSS Feed Widget</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>System Load Widget</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>System Time Widget</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>White List Events Widget</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Reporting (FMC only)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Manage Report Templates (FMC only)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Summary</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Intrusion Event Statistics (FMC only)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Intrusion Event Performance</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Intrusion Event Graphs (FMC only)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Discovery Statistics (FMC only)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
### Analysis Menu

The following table lists, in order, the user role privileges required to access each option in the Analysis menu and whether the user role has access to the sub-permissions within. Permissions that appear multiple times under different headings will be listed on the table only where they first appear, except to indicate submenu headings. The Security Approver, Intrusion Admin, Access Admin, Network Admin, and External Database User roles have no permissions in the Analysis menu. The Analysis menu is only available on the Firepower Management Center.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Admin</th>
<th>Maint User</th>
<th>Security Analyst</th>
<th>Security Analyst (RO)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery Performance (FMC only)</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Connection Summary (FMC only)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

**Table 5: Analysis Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Admin</th>
<th>Discovery Admin</th>
<th>Maint User</th>
<th>Security Analyst</th>
<th>Security Analyst (RO)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context Explorer</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Connection Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Connection Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Connection Summary Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Connection Summary Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Security Intelligence Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Security Intelligence Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Intrusion</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Intrusion Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Intrusion Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>View Local Rules</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Reviewed Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Clipboard</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Menu</td>
<td>Admin</td>
<td>Discovery Admin</td>
<td>Maint User</td>
<td>Security Analyst</td>
<td>Security Analyst (RO)</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------</td>
<td>----------------</td>
<td>------------</td>
<td>------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Incidents</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Incidents</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Files</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Malware Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Malware Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>File Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify File Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Captured Files</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Captured Files</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>File Trajectory</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>File Download</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Dynamic File Analysis</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Hosts</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Network Map</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Hosts</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Hosts</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Indications of Compromise</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Indications of Compromise</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Servers</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Servers</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Vulnerabilities</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Vulnerabilities</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Host Attributes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Menu</td>
<td>Admin</td>
<td>Discovery Admin</td>
<td>Maint User</td>
<td>Security Analyst</td>
<td>Security Analyst (RO)</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------</td>
<td>----------------</td>
<td>------------</td>
<td>------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Modify Host Attributes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Applications</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Application Details</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Application Details</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Host Attribute Management</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Discovery Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Discovery Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Users</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>User Activity</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify User Activity Events</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Users</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Users</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Vulnerabilities</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Third-party Vulnerabilities</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Third-party Vulnerabilities</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Correlation</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Correlation Events</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Correlation Events</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>White List Events</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify White List Events</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>White List Violations</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Remediation Status</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Menu</td>
<td>Admin</td>
<td>Discovery Admin</td>
<td>Maint User</td>
<td>Security Analyst</td>
<td>Security Analyst (RO)</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------</td>
<td>-----------------</td>
<td>------------</td>
<td>------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Modify Remediation Status</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Custom Workflows</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Manage Custom Workflows</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Custom Tables</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Manage Custom Tables</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td><strong>Search</strong></td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Manage Search</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td><strong>Bookmarks</strong></td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Manage Bookmarks</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Application Statistics</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Geolocation Statistics</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>User Statistics</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>URL Category Statistics</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>URL Reputation Statistics</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>DNS Queries by Record Types</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Statistics</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Intrusion Event Statistics by Application</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Intrusion Event Statistics by User</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Security Intelligence Category Statistics</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
Policies Menu

The following table lists, in order, the user role privileges required to access each option in the Policies menu and whether the user roles has access to the sub-permissions within. The External Database User, Maintenance User, Security Analyst, and Security Analyst (Read Only) roles have no permissions in the Policies menu. The Policies menu is only available on the Firepower Management Center.

Note that the Intrusion Policy and Modify Intrusion Policy privileges also allow you to create and modify network analysis policies.

Table 6: Policies Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Access Admin</th>
<th>Admin</th>
<th>Discovery Admin</th>
<th>Intrusion Admin</th>
<th>Network Admin</th>
<th>Security Approver</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Access Control Policy</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Access Control Policy</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Modify Administrator Rules</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Modify Root Rules</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Intrusion Policy</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Intrusion Policy</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Malware &amp; File Policy</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Malware &amp; File Policy</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Menu</td>
<td>Access Admin</td>
<td>Admin</td>
<td>Discovery Admin</td>
<td>Intrusion Admin</td>
<td>Network Admin</td>
<td>Security Approver</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------</td>
<td>-------</td>
<td>----------------</td>
<td>----------------</td>
<td>---------------</td>
<td>------------------</td>
</tr>
<tr>
<td>DNS Policy</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify DNS Policy</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Identity Policy</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Modify Identity Policy</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Modify Administrator Rules</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Modify Root Rules</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>SSL Policy</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify SSL Policy</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Modify Administrator Rules</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Modify Root Rules</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Network Discovery</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Custom Fingerprinting</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Custom Fingerprinting</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Custom Topology</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Custom Topology</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Network Discovery</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Application Detectors</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Menu</td>
<td>Access Admin</td>
<td>Admin</td>
<td>Discovery Admin</td>
<td>Intrusion Admin</td>
<td>Network Admin</td>
<td>Security Approver</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------</td>
<td>-------</td>
<td>----------------</td>
<td>-----------------</td>
<td>---------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Modify Application Detectors</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>User 3rd Party Mappings</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify User 3rd Party Mappings</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Custom Product Mappings</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Custom Product Mappings</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Correlation</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Policy Management</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Policy Management</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Rule Management</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Rule Management</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>White List</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify White List</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Traffic Profiles</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Traffic Profiles</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Actions</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Alerts</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Impact Flag Alerts</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Impact Flag Alerts</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Menu</td>
<td>Access Admin</td>
<td>Admin</td>
<td>Discovery Admin</td>
<td>Intrusion Admin</td>
<td>Network Admin</td>
<td>Security Approver</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------</td>
<td>-------</td>
<td>-----------------</td>
<td>-----------------</td>
<td>---------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Discovery Event Alerts</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Discovery Event Alerts</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Email</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Email</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Alerts</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Scanners</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Scan Results</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Scan Results</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Scanners</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Groups</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Groups</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modules</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Modules</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Instances</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Instances</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

**Devices Menu**

The Devices menu table lists, in order, the user role privileges required to access each option in the Devices menu and the sub-permissions within. The Discovery Admin, External Database User, Intrusion Admin, Maintenance User, Security Analyst, and Security Analyst (Read Only) have no permissions in the Devices menu. The Devices menu is only available on the Firepower Management Center.

**Table 7: Devices Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Access Admin</th>
<th>Admin</th>
<th>Network Admin</th>
<th>Security Approver</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Management</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Devices</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>NAT</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
The **Object Manager menu** table lists, in order, the user role privileges required to access each option in the **Object Manager menu** and the sub-permission within. The Discovery Admin, Security Approver, Maintenance User, External Database User, Security Analyst, and Security Analyst (Read Only) have no permissions in the **Object Manager menu**. The **Object Manager menu** is available only on the **Firepower Management Center**.

**Table 8: Object Manager Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Access Admin</th>
<th>Admin</th>
<th>Intrusion Admin</th>
<th>Network Admin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Manager</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Rule Editor</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Modify Rule Editor</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>NAT List</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Object Manager</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

**Cisco AMP**

The Cisco AMP permission is available only to the Administrator user role. This permission is available only on the **Firepower Management Center**.

**Deploy Configuration to Devices**

The Deploy Configuration to Devices permission is available to the Administrator, Network Admin, and Security Approver roles. This permission is available only on the **Firepower Management Center**.

**System Menu**

The following table lists, in order, the user role privileges required to access each option in the **System menu** and whether the user role has access to the sub-permissions within. The External Database User role has no permissions in the **System Menu**.
### Table 9: System Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Access Admin</th>
<th>Admin</th>
<th>Discovery Admin</th>
<th>Intrusion Admin</th>
<th>Maint User</th>
<th>Network Admin</th>
<th>Security Approver</th>
<th>Security Analyst</th>
<th>Security Analyst (RO)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Domains</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Integration</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Cisco CSI</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Identity Realms</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>(FMC only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Identity Realms (FMC only)</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Identity Sources</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>(FMC only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Identity Sources (FMC only)</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>eStreamer</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Host Input Client</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>(FMC only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Management</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Users</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>User Roles</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>External Authentication (FMC only)</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Updates</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Rule Updates (FMC only)</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Menu</td>
<td>Access Admin</td>
<td>Admin</td>
<td>Discovery Admin</td>
<td>Intrusion Admin</td>
<td>Maint User</td>
<td>Network Admin</td>
<td>Security Approver</td>
<td>Security Analyst</td>
<td>Security Analyst (RO)</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------</td>
<td>-----------------</td>
<td>-----------------</td>
<td>-----------------</td>
<td>------------</td>
<td>---------------</td>
<td>-------------------</td>
<td>------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Rule Update Import Log (FMC only)</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Licenses</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Classic Licenses</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Health (FMC only)</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Health Policy (FMC only)</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Modify Health Policy (FMC only)</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Apply Health Policy (FMC only)</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Health Events (FMC only)</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Modify Health Events (FMC only)</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Monitoring</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Audit</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Modify Audit Log</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Syslog</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Statistics</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Tools</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
</tbody>
</table>
### Managing User Roles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Each Firepower System user is associated with a user access role or roles. These user roles are assigned permissions that determine access to menus and other options in the system. For example, an analyst needs access to event data to analyze the security of your network, but might not require access to administrative functions for the Firepower System itself. You can grant Security Analyst access to analysts while reserving the Administrator role for the user or users managing the Firepower System.

The Firepower System includes ten predefined user roles designed for a variety of administrators and analysts. These predefined user roles have a set of predetermined access privileges.

You can also create custom user roles with more granular access privileges.

You can also restrict the data that a user role can view in the event viewer by applying a restricted search to that role. To create a custom role with restricted access, you must choose the tables you want to restrict from the Menu Based Permissions list, then choose private saved searches from the Restrictive Search drop-down lists.
You cannot delete predefined user roles, but you can delete custom roles that are no longer necessary. If you want to disable a custom role without removing it entirely, you can deactivate it instead. Note that you cannot delete your own user role or a role that is set as a default user role in a platform settings policy.

**Procedure**

| Step 1 | Choose **System** > **Users**. |
| Step 2 | Click the **User Roles** tab. |
| Step 3 | Manage user roles: |
|        | • Activate — Activate or deactivate a predefined user role as described in Activating and Deactivating User Roles, on page 56. |
|        | • Create — Create custom user roles as described in Creating Custom User Roles, on page 57. |
|        | • Copy — Copy an existing user role to create a new custom user role as described in Copying User Roles, on page 57. |
|        | • Edit — Edit a custom user role as described in Editing Custom User Roles, on page 58. |
|        | • Delete — Click the delete icon ( ) next to the custom role you want to delete. If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration. |
|        | • **Note** If a deleted role is the only role assigned to a given user, that user can log in and access the User Preferences menu, but is otherwise unable to access the Firepower System. |

### Activating and Deactivating User Roles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You cannot delete predefined user roles, but you can deactivate them. Deactivating a role removes that role and all associated permissions from any user who is assigned that role.

In a multidomain deployment, the system displays custom user roles created in the current domain, which you can edit. It also displays custom user roles created in ancestor domains, which you cannot edit. To view and edit custom user roles in a lower domain, switch to that domain.

**Caution** If a deactivated role is the only role assigned to a given user, that user can log in and access the User Preferences menu, but is otherwise unable to access the Firepower System.

**Procedure**

| Step 1 | Choose **System** > **Users**. |
Step 2  Click the User Roles tab.
Step 3  Click the slider next to the user role you want to activate or deactivate.

If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

If you deactivate, then reactivate, a role with Lights-Out Management while a user with that role is logged in, or restore a user or user role from a backup during that user’s login session, that user must log back into the web interface to regain access to IPMI tool commands.

### Creating Custom User Roles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose System > Users.
**Step 2** Click the User Roles tab.
**Step 3** Click Create UserRole.
**Step 4** In the Name field, enter a name for the new user role. User role names are case sensitive.
**Step 5** Optionally, add a Description.
**Step 6** Choose menu-based permissions for the new role.

When you choose a permission, all of its children are chosen, and the multi-value permissions use the first value. If you clear a high-level permission, all of its children are cleared also. If you choose a permission but not its children, it appears in italic text.

Copying a predefined user role to use as the base for your custom role preselects the permissions associated with that predefined role.

**Step 7** Optionally, set database access permissions for the new role by checking or unchecking the External Database Access checkbox.
**Step 8** Optionally, on Firepower Management Centers, set escalation permissions for the new user role as described in Configuring a Custom User Role for Escalation, on page 60.
**Step 9** Click Save.

### Copying User Roles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can copy an existing role to use as the basis for a new custom role. This preselects the existing role’s permissions in the User Role Editor so you can model one role on another.
You can copy any existing role, including predefined user roles and custom user roles inherited from ancestor domains.

**Procedure**

**Step 1** Choose System > Users.

**Step 2** Click the User Roles tab.

**Step 3** Click the copy icon (copy) next to the user role you want to copy.

**Step 4** Enter a new Name.

The system creates a default name for the new user role by combining the name of the original user role and the (copy) suffix.

**Step 5** Enter a new Description.

The system retains the description of the original user role if you do not overwrite it.

**Step 6** Optionally, modify the menu-based permissions inherited from the original user role.

When you choose a permission, all of its children are chosen, and the multi-value permissions use the first value. If you clear a high-level permission, all of its children are cleared also. If you choose a permission but not its children, the permission appears in italic text.

**Step 7** Optionally, set the database access permissions for the new role by checking or unchecking the External Database Access checkbox.

**Step 8** Optionally, set escalation permissions for the new user role as described in Configuring a Custom UserRole for Escalation, on page 60.

**Step 9** Click Save.

### Editing Custom User Roles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You cannot edit predefined user roles.

In a multidomain deployment, the system displays custom user roles created in the current domain, which you can edit. It also displays custom user roles created in ancestor domains, which you cannot edit. To view and edit custom user roles in a lower domain, switch to that domain.

**Procedure**

**Step 1** Choose System > Users.

**Step 2** Click the User Roles tab.

**Step 3** Click the edit icon (edit) next to the custom user role you want to modify. If a view icon (view) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
Step 4 Modify the Name and Description fields. User role names are case sensitive.

Step 5 Choose menu-based permissions for the user role.

When you choose a permission, all of its children are chosen, and the multi-value permissions use the first value. If you clear a high-level permission, all of its children are cleared also. If you choose a permission but not its children, the permission appears in italic text.

Step 6 Optionally, set the database access permissions for the role by checking or unchecking the External Database Access checkbox.

Step 7 Optionally, on Firepower Management Centers, set escalation permissions for the user role as described in Configuring a Custom User Role for Escalation, on page 60.

Step 8 Click Save.

User Role Escalation

You can give custom user roles the permission, with a password, to temporarily gain the privileges of another, targeted user role in addition to those of the base role. This allows you to easily substitute one user for another during an absence, or to more closely track the use of advanced user privileges.

For example, a user whose base role has very limited privileges may escalate to the Administrator role to perform administrative actions. You can configure this feature so that users can use their own passwords, or so they use the password of another user that you specify. The second option allows you to easily manage one escalation password for all applicable users.

Note that only one user role at a time can be the escalation target role. You can use a custom or predefined user role. Each escalation lasts for the duration of a login session and is recorded in the audit log.

Setting the Escalation Target Role

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can assign any of your user roles, predefined or custom, to act as the system-wide escalation target role. This is the role to which any other role may escalate, if it has the ability.

Procedure

Step 1 Choose System > Users.
Step 2 Click User Roles.
Step 3 Click Configure Permission Escalation.
Step 4 Choose a user role from the drop-down list.
Step 5 Click OK to save your changes.

Note Changing the escalation target role is effective immediately. Users in escalated sessions now have the permissions of the new escalation target.
Configuring a Custom User Role for Escalation

Consider the needs of your organization when you configure the escalation password for a custom role. If you want to easily manage many escalating users, you may want to choose another user whose password serves as the escalation password. If you change that user’s password or deactivate that user, all escalating users who require that password are affected. This allows you to manage user role escalation more efficiently, especially if you choose an externally authenticated user that you can manage centrally.

**Procedure**

**Step 1**

Begin configuring your custom user role as described in Creating Custom User Roles, on page 57.

**Step 2**

In System Permissions, choose the **Set this role to escalate to:** check box.

The current escalation target role is listed beside the check box.

**Step 3**

Choose the password that this role uses to escalate. You have two options:

- If you want users with this role to use their own passwords when they escalate, choose **Authenticate with the assigned user’s password.**
- If you want users with this role to use the password of another user, choose **Authenticate with the specified user’s password** and enter that username.

**Note**

When authenticating with another user’s password, you can enter any username, even that of a deactivated or nonexistent user. Deactivating the user whose password is used for escalation makes escalation impossible for users with the role that requires it. You can use this feature to quickly remove escalation powers if necessary.

**Step 4**

Click **Save.**

Users with this role can now escalate to the target user role.

---

**Escalating Your User Role**

When a user has an assigned custom user role with permission to escalate, that user may escalate to the target role’s permissions at any time. Note that escalation has no effect on user preferences.

**Before you begin**

- Confirm that a system administrator configured the escalation target role or custom user role for escalation as described in Setting the Escalation Target Role, on page 59 or Configuring a Custom User Role for Escalation, on page 60.

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Device</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>
Procedure

Step 1  From the drop-down list under your username, choose Escalate Permissions.

Step 2  Enter the authentication password.

Step 3  Click Escalate. You now have all permissions of the escalation target role in addition to your current role.

Note  Escalation lasts for the remainder of your login session. To return to the privileges of your base role only, you must log out, then begin a new session.

User Accounts

The admin account and optional, custom user accounts on a Firepower Management Center or Firepower 7000 and 8000 Series device allow users to log into these. For internally-authenticated users, accounts must be created manually. For externally-authenticated users, accounts are created automatically.

Related Topics
  Firepower System User Accounts
  Firepower System User Interfaces

Managing User Accounts

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  Choose System > Users.

Step 2  Manage user accounts:
  • Activate/Deactivate — Click the slider next to a user to reactivate a deactivated user, or to disable an active user account without deleting it. Only internally authenticated users can be activated and deactivated.
  • Create — Create a new user account; see Creating a User Account, on page 62.
  • Edit — Edit an existing user account; see Editing a User Account, on page 62.
  • Delete — If you want to delete a user, click the delete icon (ο). You can delete user accounts from the system at any time, with the exception of the admin account, which cannot be deleted.

Related Topics
  Lights-Out Management User Access Configuration, on page 485
  Predefined User Roles, on page 40
  Custom User Roles, on page 41
Creating a User Account

When you set up a new user account, you can control which parts of the system the account can access. You can set password expiration and strength settings for the user account during creation. For a local account on a 7000 or 8000 Series device, you can also configure the level of command line access the user will have.

In a multidomain deployment, you can create user accounts in any domain in which you have been assigned Admin access. You can also create accounts in a higher-level domain and assign the users lower-level access only. For example, you might want a single user to be an administrator of two domains, but deny them access to the ancestor domain. This kind of user account can only be modified by switching to a subdomain in which access is assigned.

Procedure

**Step 1** Choose System > Users.
**Step 2** Click Create User.
**Step 3** Enter a User Name.
**Step 4** Modify the login options; see User Account Login Options, on page 64.
**Step 5** Enter values in Password and Confirm Password.

The values you construct must be based on the password options you set earlier.

**Step 6** If you are creating a user account on a 7000 or 8000 Series device, assign the appropriate level of Command-Line Interface Access as described in Command Line Access Levels, on page 66.

**Step 7** Assign user roles:
- Check or uncheck the check box next to the user role(s) you want to assign the user.
- In a multidomain deployment, if you are adding a user account to a domain with descendant domains, click the Add Domains button that displays instead of the user role check boxes. Continue as described in Assigning User Roles in Multiple Domains, on page 63.

**Note** User roles determine the user's access rights. For more information, see Managing User Roles, on page 55.

**Step 8** Click Save.

Editing a User Account

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>
After adding user accounts to the system, you can modify access privileges, account options, or passwords at any time. Note that password management options do not apply to users who authenticate to an external directory server. You manage those settings on the external server. However, you must configure access rights for all accounts, including those that are externally authenticated.

**Note**

For externally authenticated users, you cannot remove the minimum access rights through the Firepower System user management page for users assigned an access role because of LDAP group or RADIUS list membership or attribute values. You can, however, assign additional rights. When you modify the access rights for an externally authenticated user, the Authentication Method column on the User Management page provides a status of **External - Locally Modified**.

If you change the authentication for a user from externally authenticated to internally authenticated, you must supply a new password for the user.

**Procedure**

**Step 1** Choose **System > Users**.

**Step 2** Click the edit icon (edit) next to the user you want to modify.

**Step 3** Modify settings described in **Creating a User Account**, on page 62.

**Step 4** Click **Save**.

### Assigning User Roles in Multiple Domains

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can assign users roles in ancestor and descendant domains. For example, you can assign a user read-only privileges in the Global domain, but Admin privileges in a descendant domain.

**Procedure**

**Step 1** In the user account editor, click **Add Domain**.

**Step 2** Choose a domain from the **Domain** drop-down list.

**Step 3** Check the user roles you want to assign the user.

**Step 4** Click **Save**.
Converting a User from Internal to External Authentication

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you convert a user from internal to external authentication, the user account retains the permissions already present in that account. The existing permissions override any permissions associated with the associated authentication object group or the default user role set in the platform settings policy.

Before you begin

- A user record with the same user name must be present on the external authentication server.

Procedure

**Step 1**
Enable LDAP (with or without CAC) or RADIUS authentication. For more information, see LDAP Authentication, on page 70 or RADIUS Authentication, on page 93.

**Step 2**
Instruct the user to log in with the password stored for that user on the external server.

User Account Login Options

The following table describes some of the options you can use to regulate passwords and account access for Firepower System users.

- Password management options do not apply to users who authenticate to an external directory server. You manage those settings on the external authentication server. After you enable Use External Authentication Method, the system removes password management options from the display.

- If you enable STIG compliance or Lights-Out Management (LOM) on an appliance, different password restrictions apply. For more information on STIG compliance, see Enabling STIG Compliance, on page 477.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use External Authentication Method</td>
<td>Select this check box if you want this user’s credentials to be externally authenticated. If you enable this option, the password management options are no longer displayed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>• For users to authenticate to an external directory server, you must also create an authentication object for the server you want to use, and deploy a platform settings policy with authentication enabled.</td>
</tr>
<tr>
<td></td>
<td>• Note that for externally authenticated users, if the authentication object for the server is disabled, the Authentication Method column in the Users list displays External (Disabled).</td>
</tr>
<tr>
<td></td>
<td>• If you select this option for the user and the external authentication server is unavailable, that user can log into the web interface but cannot access any functionality.</td>
</tr>
<tr>
<td>Maximum Number of Failed Logins</td>
<td>Enter an integer, without spaces, that determines the maximum number of times each user can try to log in after a failed login attempt before the account is locked. The default setting is five tries; use 0 to allow an unlimited number of failed logins.</td>
</tr>
<tr>
<td>Minimum Password Length</td>
<td>Enter an integer, without spaces, that determines the minimum required length, in characters, of a user’s password. The default setting is 8. A value of 0 indicates that no minimum length is required.</td>
</tr>
<tr>
<td></td>
<td>If you enable the Check Password Strength option, and set a value for Minimum Password Length that exceeds 8 characters, the higher value applies.</td>
</tr>
<tr>
<td>Days Until Password Expiration</td>
<td>Enter the number of days after which the user’s password expires. The default setting is 0, which indicates that the password never expires. If you set this option, the Password Lifetime column of the Users list indicates the days remaining on each user’s password.</td>
</tr>
<tr>
<td>Days Before Password Expiration Warning</td>
<td>Enter the number of warning days users have to change their password before their password actually expires. The default setting is 0 days.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>The number of warning days must be less than the number of days before the password expires.</td>
</tr>
<tr>
<td>Force Password Reset on Login</td>
<td>Select this option to force users to change their passwords the next time they log in.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Check Password Strength | Select this option to require strong passwords. A strong password must be at least eight alphanumeric characters of mixed case and must include at least one numeric character and one special character. It cannot be a word that appears in a dictionary or include consecutive repeating characters.
Exempt from Browser Session Timeout | Select this option if you do not want a user’s login sessions to terminate due to inactivity. Users with the Administrator role cannot be made exempt.

Command Line Access Levels

You can use the local web interface on a 7000 or 8000 Series device to assign command line interface access to local device users. Note that you can also assign command line access for users on an NGIPSv, but you use commands from the command line interface.

The commands a user can run depend on the level of access you assign to the user. Possible values for the Command-Line Interface Access setting include:

**None**

The user cannot log into the appliance on the command line. Any session the user starts will close when the user provides credentials. The access level defaults to **None** on user creation.

**Configuration**

The user can access any of the command line options. Exercise caution in assigning this level of access to users.

**Caution**

Command line access granted to externally authenticated users defaults to the **Configuration** level of command line access, granting rights to all command line utilities.

**Basic**

A specific set of commands can be run by the user, listed below.

**Table 11: Basic Command Line Commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>configure password</td>
<td>interfaces</td>
</tr>
<tr>
<td>end</td>
<td>lcd</td>
</tr>
<tr>
<td>exit</td>
<td>link-state</td>
</tr>
<tr>
<td>help</td>
<td>log-ips-connection</td>
</tr>
<tr>
<td>history</td>
<td>managers</td>
</tr>
<tr>
<td>logout</td>
<td>memory</td>
</tr>
<tr>
<td>?</td>
<td>model</td>
</tr>
</tbody>
</table>
Firepower System User Authentication

When a user logs into the web interface on a Firepower Management Center or a managed device, the appliance looks for a match for the user name and password in the local list of users. This process is called authentication.

There are two types of authentication:

- **internal authentication** — The system checks the list in the local database for the user.
- **external authentication** — The system checks the list in the local database for the user and, if the user is not present on that list, queries an external authentication server for its user list.

The authentication process is illustrated below.
When you create a user account, you specify either internal or external authentication for that user.

**Internal Authentication**

In internal authentication, user credentials are verified against records in the internal Firepower System database. This is the default authentication type.

You set the access rights for internal authentication users when you create the user's account.

---

**Note**

When an internally authenticated user is converted to external authentication, you cannot revert to internal authentication.
External Authentication

In external authentication, the Firepower Management Center or managed device retrieves user credentials from a repository on an external server. External servers can be either a Lightweight Directory Access Protocol (LDAP) directory server or a Remote Authentication Dial In User Service (RADIUS) authentication server.

You enable external authentication using a platform settings policy and settings in individual user accounts. Note the following guidelines:

- You can use multiple external authentication objects to authenticate users to access the Firepower Management Center web interface. In other words, if you have five external authentication objects, users from any of them can be authenticated to access the web interface.

- You can use only one external authentication object for shell access to the Firepower Management Center. If you have more than one external authentication object set up, users can authenticate using only the first object in the list.

When the user logs into an appliance for the first time, the appliance associates the external credentials with a set of permissions by creating a local user record. The user is assigned permissions based on either:

- the group or access list they belong to
- the default user access role you set in the platform settings policy for the appliance

If permissions are granted through group or list membership, they cannot be modified. However, if they are assigned by default user role, you can modify them in the user account, and the modifications you make override the default settings. For example:

- If the default role for externally authenticated user accounts is set to a specific access role, users can log into the appliance using their external account credentials without any additional configuration by the system administrator.

- If an account is externally authenticated and by default receives no access privileges, users can log in but cannot access any functionality. You (or your system administrator) can then change the permissions to grant the appropriate access to user functionality.

You cannot manage passwords for externally authenticated users or deactivate externally authenticated users through the Firepower System interface. For externally authenticated users, you cannot remove the minimum access rights through the Firepower System user management page for users assigned an access role because of LDAP group or RADIUS list membership or attribute values. On the Edit User page for an externally authenticated user, rights granted because of settings on an external authentication server are marked with a status of Externally Modified.

You can, however, assign additional rights. When you modify the access rights for an externally authenticated user, the Authentication Method column on the User Management page provides a status of External - Locally Modified.

Related Topics
- LDAP Authentication, on page 70
- RADIUS Authentication, on page 93
LDAP Authentication

LDAP, or the Lightweight Directory Access Protocol, allows you to set up a directory on your network that organizes objects, such as user credentials, in a centralized location. Multiple applications can then access those credentials and the information used to describe them. If you ever need to change a user's credentials, you can change them in one place.

You must create LDAP authentication objects on a Firepower Management Center, but you can use the external authentication object on any managed devices that have a web interface (that is, on 7000 and 8000 Series devices) by deploying a platform settings policy where the object is enabled to the device. When you deploy the policy, the object is copied to the device.

**Note**
Before enabling external authentication on 7000 and 8000 Series devices, remove any internally-authenticated shell or CLI users that have the same user name as externally-authenticated users included in your shell access filter.

Note that you can use LDAP naming standards for address specification and for filter and attribute syntax in your authentication object. For more information, see the RFCs listed in the Lightweight Directory Access Protocol (v3): Technical Specification, RFC 3377. Examples of syntax are provided throughout this procedure. Note that when you set up an authentication object to connect to a Microsoft Active Directory Server, you can use the address specification syntax documented in the Internet RFC 822 (Standard for the Format of ARPA Internet Text Messages) specification when referencing a user name that contains a domain. For example, to refer to a user object, you might type JoeSmith@security.example.com rather than the equivalent user distinguished name of cn=JoeSmith,ou=security, dc=example,dc=com when using Microsoft Active Directory Server.

**Note**
Currently, the Firepower System supports LDAP external authentication on LDAP servers running Microsoft Active Directory on Windows Server 2008, Oracle Directory Server Enterprise Edition 7.0 on Windows Server 2008, or OpenLDAP on Linux. However, the Firepower System does not support external authentication for NGIPSv or ASA FirePOWER devices.

**Required Information for Creating LDAP Authentication Objects**

Before you configure a connection to your LDAP server, you should collect the information that you need to create the LDAP authentication object.

**Note**
You must have TCP/IP access from your local appliance to the authentication server where you want to connect.

You need the following, at minimum, to create a basic authentication object:

- the server name or IP address for the server where you plan to connect
- the server type of the server where you plan to connect
• the user name and password for a user account with sufficient privileges to browse the LDAP tree; Cisco recommends that you use a domain admin user account for this purpose

• if there is a firewall between the appliance and the LDAP server, an entry in the firewall to allow outgoing connections

• if possible, the base distinguished name for the server directory where the user names reside

Tip

You can use a third-party LDAP client to browse the LDAP tree and see base DN and attribute descriptions. You can also use that client to confirm that your selected user can browse the base DN you select. Ask your LDAP administrator to recommend an approved LDAP client for your LDAP server.

Depending on how you plan to customize your advanced LDAP authentication object configuration, you might also need the information in the following table.

Table 12: Additional LDAP Configuration Information

<table>
<thead>
<tr>
<th>To...</th>
<th>You need...</th>
</tr>
</thead>
<tbody>
<tr>
<td>connect over a port other than 389</td>
<td>the port number</td>
</tr>
<tr>
<td>connect via an encrypted connection</td>
<td>the certificate for the connection</td>
</tr>
<tr>
<td>filter the users who can access your appliance based on an attribute value</td>
<td>the attribute-value pair to filter by</td>
</tr>
<tr>
<td>use an attribute as a UI access attribute rather than checking the user distinguished name</td>
<td>the name of the attribute</td>
</tr>
<tr>
<td>use an attribute as a shell login attribute rather than checking the user distinguished name</td>
<td>the name of the attribute</td>
</tr>
<tr>
<td>filter the users who can access your appliance via the shell based on an attribute value</td>
<td>the attribute-value pair to filter by</td>
</tr>
<tr>
<td>associate groups with specific user roles</td>
<td>the distinguished name of each group, as well as the group member attribute if the groups are static groups or the group member URL attribute if the groups are dynamic groups</td>
</tr>
<tr>
<td>use CACs for authentication and authorization</td>
<td>your CAC, a server certificate signed by the same CA that issued your CAC, and the certificate chain for both certificates</td>
</tr>
</tbody>
</table>

CAC Authentication

If your organization uses Common Access Cards (CACs), you can configure LDAP authentication to authenticate users logging into the web interface and authorize access to specific functionality based on group membership or default access rights. With CAC authentication and authorization configured, users have the option to log in directly without providing a separate username and password for the appliance.
You must have a valid user certificate present in your browser (in this case, a certificate passed to your browser via your CAC) to enable user certificates as part of the CAC configuration process. After you configure CAC authentication and authorization, users on your network must maintain the CAC connection for the duration of their browsing session. If you remove or replace a CAC during a session, your web browser terminates the session and the system logs you out of the web interface.

CAC-authenticated users are identified in the system by their electronic data interchange personal identifier (EDIPI) numbers. After users log in using their CAC credentials for the first time, you can manually add or remove access privileges for those users on the User Management page. If you did not preconfigure a user’s privileges using group-controlled access roles, the user has only the privileges granted by default in the platform settings policy.

The system purges manually configured access privileges when it purges CAC-authenticated users from the User Management page after 24 hours of inactivity. The users are restored to the page after each subsequent login, but you must reconfigure any manual changes to their access privileges.

**Configuring CAC Authentication**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>7000 and 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Before users on your network can log into Firepower Management Centers and 7000 and 8000 Series devices using their CAC credentials, a user with appropriate permissions must complete the multi-step configuration process for CAC authentication and authorization.

**Before you begin**

- Gather the information described in Required Information for Creating LDAP Authentication Objects, on page 70.

**Procedure**

- **Step 1** Insert a CAC as directed by your organization.
- **Step 2** Direct your browser to https://hostname/, where hostname corresponds to the host name of your Firepower Management Center.
- **Step 3** If prompted, enter the PIN associated with the CAC you inserted in step 1.
- **Step 4** If prompted, choose the appropriate certificate from the drop-down list.
- **Step 5** On the Login page, in the Username and Password fields, log in as a user with Administrator privileges. User names are case sensitive.
  
  **Tip** You cannot log in using your CAC credentials until you have fully configured CAC authentication and authorization.
Step 6 Navigate to System > Users and click the External Authentication tab.

Step 7 Create an LDAP authentication object exclusively for CAC authentication and authorization, following the procedure in and Creating Advanced LDAP Authentication Objects, on page 76. You must configure the following:

- the User Name Template in the advanced options of the LDAP-Specific Parameters section.
- the UI Access Attribute in the Attribute Mapping section.
- the distinguished names for existing LDAP groups in the Group Controlled Access Roles section, if you want to preconfigure access rights through LDAP group membership.

Tip Note that you cannot configure both CAC authentication and shell access in the same authentication object. If you also want to authorize users for shell access, create and enable separate authentication objects.

Step 8 Click Save.

Step 9 Enable external authentication and CAC authentication as described in Enabling External Authentication to Classic Devices, on page 502.

Caution Your changes do not take effect until you deploy the configuration changes.

Step 10 Navigate to System > Configuration and click HTTPS Certificate.

Step 11 Import a HTTPS server certificate, if necessary, following the procedure outlined in Uploading Server Certificates, on page 440.

Note The same certificate authority (CA) must issue the HTTPS server certificate and the user certificates on the CACs you plan to use for authentication and authorization.

Step 12 Under HTTPS User Certificate Settings, choose Enable User Certificates. For more information, see Requiring Valid User Certificates, on page 441.

What to do next

- After the user logs in for the first time, you can manually add or remove the user's access rights. If you do not modify the rights, the user has only the rights granted by default. For more information, see Editing a User Account, on page 62.

Related Topics

- LDAP Group Fields, on page 86
- LDAP-Specific Fields, on page 81
- Logging Into a 7000 or 8000 Series Device with CAC Credentials, on page 23
- Logging Into the Firepower Management Center with CAC Credentials, on page 23

Creating Basic LDAP Authentication Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>
You can set up an LDAP authentication object where you customize many of the values. However, if you just want to authenticate all the users in a particular directory, you can create a basic authentication object with the base DN for that directory. If you set defaults to those for your server type and supply authentication credentials for the account used to retrieve user data from the server, you can quickly create an authentication object. Follow the procedure below to do so.

If you prefer to consider and possibly customize each authentication setting when creating the authentication object (to grant shell access, for example), use the advanced procedure to create the object. You should also use the advanced procedure if you plan to encrypt your connection to the server, set user timeouts, customize the user name template, or assign Firepower System user roles based on LDAP group membership.

In a multidomain deployment, external authentication objects are only available in the domain in which they are created.

**Before you begin**

- Gather the information described in [Required Information for Creating LDAP Authentication Objects](#), on page 70.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Choose <strong>System</strong> &gt; <strong>Users</strong>.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Click the <strong>External Authentication</strong> tab.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Click <strong>Add External Authentication Object</strong>.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>Choose <strong>LDAP</strong> from the <strong>Authentication Method</strong> drop-down list.</td>
</tr>
</tbody>
</table>
| **Step 5** | Provide a **Name**, **Description**, **Server Type**, and **Primary Server Host Name/IP Address** as described in [Identifying the LDAP Authentication Server](#), on page 80.  
*Tip* If you click Set Defaults, the system populates the **UserName Template**, **UI Access Attribute**, **Shell Access Attribute**, **Group Member Attribute**, and **Group Member URL Attribute** fields with default values. |
| **Step 6** | Choose **Fetch DNs** to specify a base distinguished name and, optionally, provide a **Base Filter** as described in [Configuring LDAP-Specific Parameters](#), on page 84. |
| **Step 7** | Enter a distinguished name as the **User Name** and the **Password** for a user who has sufficient credentials to browse the LDAP server as described in [Configuring LDAP-Specific Parameters](#), on page 84. |
| **Step 8** | Re-enter the password in the **Confirm Password** field. |
| **Step 9** | Test the connection as described in [Testing LDAP Authentication Connections](#), on page 90. |
| **Step 10** | Click **Save**. |
Example

The following figures illustrate a basic configuration of an LDAP login authentication object for a Microsoft Active Directory Server. The LDAP server in this example has an IP address of 10.11.3.4. The connection uses port 389 for access.

This example shows a connection using a base distinguished name of OU=security, DC=it, DC=example, DC=com for the security organization in the information technology domain of the Example company.

**External Authentication Object**

- **Authentication Method**: LDAP
- **CAC**: Use for CAC authentication and authorization
- **Name**: Basic Configuration Example
- **Description**: 
- **Server Type**: MS Active Directory

**Primary Server**

- **Host Name/IP Address**: 
- **Port**: 389

**Backup Server (Optional)**

- **Host Name/IP Address**: 
- **Port**: 389

**LDAP-Specific Parameters**

- **Base DN**: ou=security, DC=it, DC=example, DC=com
- **Base Filter**: ()
- **User Name**: CN=admin, DC=example, DC=com
- **Password**: ********
- **Confirm Password**: ********

**Attribute Mapping**

- **UI Access Attribute**: SAPAccountName
- **Shell Access Attribute**: SAPAccountName

**Group Controlled Access Roles (Optional)**

**Shell Access Filter**

- **Shell Access Filter**: Same as Base Filter

**Additional Test Parameters**

- **User Name**: 
- **Password**: 

*Required Field
However, because this server is a Microsoft Active Directory server, it uses the \texttt{sAMAccountName} attribute to store user names rather than the \texttt{uid} attribute. Choosing the MS Active Directory server type and clicking \textbf{Set Defaults} sets the UI Access Attribute to \texttt{sAMAccountName}. As a result, the Firepower System checks the \texttt{sAMAccountName} attribute for each object for matching user names when a user attempts to log into the Firepower System.

In addition, a Shell Access Attribute of \texttt{sAMAccountName} causes each \texttt{sAMAccountName} attribute to be checked for all objects in the directory for matches when a user logs into a shell or CLI account on the appliance.

Note that because no base filter is applied to this server, the Firepower System checks attributes for all objects in the directory indicated by the base distinguished name. Connections to the server time out after the default time period (or the timeout period set on the LDAP server).

\textbf{What to do next}

- If you want to enable LDAP authentication, enable the authentication object as described in Enabling External Authentication to Classic Devices, on page 502.
- If you want to refine the list of users retrieved, see Troubleshooting LDAP Authentication Connections, on page 91 for more information.

\section*{Creating Advanced LDAP Authentication Objects}

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you create a basic authentication object, you define basic settings that let you connect to an authentication server. When you create an advanced authentication object, you define basic settings and you also choose the directory context and search criteria you want to use to retrieve user data from the server. Optionally, you can configure shell access authentication.

Although you can use the default settings for your server type to quickly set up an LDAP configuration, you can also customize advanced settings to control whether the appliance makes an encrypted connection to the LDAP server, the timeout for the connection, and which attributes the server checks for user information.

For the LDAP-specific parameters, you can use LDAP naming standards and filter and attribute syntax. For more information, see the RFCs listed in the Lightweight Directory Access Protocol (v3): Technical Specification, RFC 3377. Examples of syntax are provided throughout this procedure. Note that when you set up an authentication object to connect to a Microsoft Active Directory Server, you can use the address specification syntax documented in the Internet RFC 822 (Standard for the Format of ARPA Internet Text Messages) specification when referencing a user name that contains a domain. For example, to refer to a user object, you might enter \texttt{JoeSmith@security.example.com} rather than the equivalent user distinguished name of \texttt{cn=JoeSmith,ou=security, dc=example,dc=com} when using Microsoft Active Directory Server.

\section*{Note}

If you are configuring an LDAP authentication object for use with CAC authentication, do not remove the CAC inserted in your computer. You must have a CAC inserted at all times after enabling user certificates.
In a multidomain deployment, external authentication objects are only available in the domain in which they are created.

**Before you begin**

- Gather the information described in Required Information for Creating LDAP Authentication Objects, on page 70.
- Remove any internally-authenticated shell users that have the same username as externally-authenticated users included in your shell access filter.

**Procedure**

**Step 1** Choose System > Users.

**Step 2** Click the External Authentication tab.

**Step 3** Click Add External Authentication Object.

**Step 4** Identify the authentication server as described in Identifying the LDAP Authentication Server, on page 80.

**Step 5** Configure authentication settings as described in Configuring LDAP-Specific Parameters, on page 84.

**Step 6** Optionally, configure LDAP groups to use as the basis for default access role assignments as described in Configuring Access Rights by Group, on page 87.

**Tip** If you plan to use this object for CAC authentication and authorization, Cisco recommends configuring LDAP groups to manage access role assignments.

**Step 7** Optionally, configure authentication settings for shell access as described in Configuring LDAP Shell Access, on page 89.

**Step 8** Test your configuration as described in Testing LDAP Authentication Connections, on page 90.

**Step 9** Click Save.

**Example**

This example illustrates an advanced configuration of an LDAP login authentication object for a Microsoft Active Directory Server. The LDAP server in this example has an IP address of 10.11.3.4. The connection uses port 636 for access.

This example shows a connection using a base distinguished name of `OU=security,DC=it,DC=example,DC=com` for the security organization in the information technology department.
domain of the Example company. However, note that this server has a base filter of (cn=*smith). The filter restricts the users retrieved from the server to those with a common name ending in smith.

The connection to the server is encrypted using SSL and a certificate named `certificate.pem` is used for the connection. In addition, connections to the server time out after 60 seconds because of the Timeout setting.

Because this server is a Microsoft Active Directory server, it uses the `sAMAccountName` attribute to store user names rather than the `uid` attribute. Note that the configuration includes a UI Access Attribute of `sAMAccountName`. As a result, the Firepower System checks the `sAMAccountName` attribute for each object for matching user names when a user attempts to log into the Firepower System.

In addition, a Shell Access Attribute of `sAMAccountName` causes each `sAMAccountName` attribute to be checked for all objects in the directory for matches when a user logs into a shell account on the appliance.

This example also has group settings in place. The Maintenance User role is automatically assigned to all members of the group with a member group attribute and the base domain name of `CN=SFmaintenance,DC=it,DC=example,DC=com`. 

<table>
<thead>
<tr>
<th>LDAP-Specific Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base DN *</td>
</tr>
<tr>
<td>Base Filter</td>
</tr>
<tr>
<td>(CN=*smith)</td>
</tr>
<tr>
<td>User Name *</td>
</tr>
<tr>
<td>(CN=admin,DC=example,DC=com)</td>
</tr>
<tr>
<td>Password *</td>
</tr>
<tr>
<td>************</td>
</tr>
<tr>
<td>Confirm Password *</td>
</tr>
<tr>
<td>***********************</td>
</tr>
<tr>
<td>Show Advanced Options</td>
</tr>
<tr>
<td>✗</td>
</tr>
<tr>
<td>Encryption</td>
</tr>
<tr>
<td>SSL</td>
</tr>
<tr>
<td>SSL Certificate Upload Path</td>
</tr>
<tr>
<td>certificate.pem</td>
</tr>
<tr>
<td>User Name Template</td>
</tr>
<tr>
<td>%s</td>
</tr>
<tr>
<td>Timeout (Seconds)</td>
</tr>
<tr>
<td>60</td>
</tr>
<tr>
<td>Attribute Mapping</td>
</tr>
<tr>
<td>UI Access Attribute *</td>
</tr>
<tr>
<td>sAMAccountName</td>
</tr>
<tr>
<td>Shell Access Attribute *</td>
</tr>
<tr>
<td>sAMAccountName</td>
</tr>
</tbody>
</table>
The shell access filter is set to be the same as the base filter, so the same users can access the appliance through the shell or CLI as through the web interface.

What to do next

• If you want to enable LDAP authentication, enable the authentication object in Enabling External Authentication to Classic Devices, on page 502.

LDAP Authentication Server Fields

CAC
Select this checkbox if you want to use CAC for authentication and authorization.

Name
A name for the authentication server.

Description
A description for the authentication server.
Server Type

The type of LDAP server you plan to connect to. You have the following options when selecting a type:

- If you are connecting to a Microsoft Active Directory server, select **MS Active Directory**.
- If you are connecting to a Sun Java Systems Directory Server or Oracle Directory Server, select **Oracle Directory**.
- If you are connecting to an OpenLDAP server, select **OpenLDAP**.
- If you are connecting to a LDAP server other than those listed above and want to clear default settings, select **Other**.

**Tip**

If you click Set Defaults, the system populates the **UserName Template**, **UI Access Attribute**, **Shell Access Attribute**, **Group Member Attribute**, and **Group Member URL Attribute** fields with default values.

Primary Server Host Name/IP Address

The IP address or host name for the primary server where you want to obtain authentication data.

**Note**

If you are using a certificate to connect via TLS or SSL, the host name in the certificate must match the host name used in this field. In addition, IPv6 addresses are not supported for encrypted connections.

Primary Server Port

The port used by the primary authentication server.

Backup Server Host Name/IP Address

The IP address or host name for the backup server where you want to obtain authentication data.

Backup Server Port

The port used by the backup authentication server.

Identifying the LDAP Authentication Server

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you create an authentication object, you first specify the primary and backup server and server port where you want the managed device or Firepower Management Center to connect for authentication.

**Note**

If you are configuring an LDAP authentication object for use with CAC authentication, do not remove the CAC inserted in your computer. You must have a CAC inserted at all times after enabling user certificates.
In a multidomain deployment, external authentication objects are only available in the domain in which they are created.

**Procedure**

**Step 1**  Choose **System > Users**.

**Step 2**  Click the **External Authentication** tab.

**Step 3**  Click **Add External Authentication Object**.

**Step 4**  Choose **LDAP** from the **Authentication Method** drop-down list.

**Step 5**  Optionally, check the check box for **CAC** if you plan to use this authentication object for CAC authentication and authorization.

*Note*  You must follow the procedure in Configuring CAC Authentication, on page 72 to fully configure CAC authentication and authorization.

**Step 6**  Enter a name and description for the authentication server in the **Name** and **Description** fields.

**Step 7**  Choose a **Server Type** from the drop-down list as described in LDAP Authentication Server Fields, on page 79. Optionally, click **Set Defaults**.

**Step 8**  Enter a **Primary Server Host Name/IP Address**.

*Note*  If you are using a certificate to connect via TLS or SSL, the host name in the certificate must match the host name used in this field. In addition, IPv6 addresses are not supported for encrypted connections.

**Step 9**  Optionally, enter a **Primary Server Port**.

**Step 10**  Optionally, enter a **Backup Server Host Name/IP Address**.

**Step 11**  Optionally, enter a **Backup Server Port**.

**What to do next**

- Continue creating your LDAP authentication object as described in Creating Advanced LDAP Authentication Objects, on page 76.

**LDAP-Specific Fields**

The following table describes each of the LDAP-specific parameters.
### LDAP-Specific Parameters

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base DN</td>
<td>Supplies the base distinguished name of the directory where the appliance searches for user information on the LDAP server. Typically, the base DN has a basic structure indicating the company domain and operational unit. Note that after you identify a primary server, you can automatically retrieve a list of available base DNs from the server and select the appropriate base DN.</td>
<td>The Security organization of the Example company might have a base DN of ou=security, dc=example,dc=com</td>
</tr>
<tr>
<td>Base Filter</td>
<td>Focuses your search by only retrieving objects in the base DN that have the specific attribute-value pair set in the filter. The base filter is an attribute type, a comparison operator, and the attribute value you want to use as a filter enclosed in parentheses.</td>
<td>To filter for only users with a common name starting with F, use the filter (cn=F*).</td>
</tr>
<tr>
<td>User Name/ Password</td>
<td>Allows the local appliance to access the user objects. Supplies user credentials for a user with appropriate rights to the authentication objects you want to retrieve. The distinguished name for the user you specify must be unique to the directory information tree for the LDAP server. Server user names associated with a Microsoft Active Directory Server cannot end with the $ character.</td>
<td>The user name for the admin user in the Security organization of the Example company might have a user name of cn=admin, ou=security, dc=example,dc=com</td>
</tr>
<tr>
<td>Encryption</td>
<td>Determines whether and how the communications are encrypted. You can choose no encryption, Transport Layer Security (TLS), or Secure Sockets Layer (SSL) encryption. Note that if you are using a certificate to authenticate when connecting via TLS or SSL, the name of the LDAP server in the certificate must match the User Name you supply. If you change the encryption method after specifying the port, the port resets to the default value for the selected server type.</td>
<td>If you enter 10.10.10.250 in the external authentication settings and computer1.example.com in the certificate, the connection fails, even if computer1.example.com has an IP address of 10.10.10.250. Changing the name of the server in the external authentication settings to computer1.example.com causes the connection to succeed.</td>
</tr>
<tr>
<td>SSL Certificate Upload Path</td>
<td>Indicates the path on your local computer to the certificate to be used for encryption.</td>
<td>c:/server.crt</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Examples</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Name Template</td>
<td>Indicates how user names entered on login should be formatted, by mapping the string conversion character (%s) to the value of the UI Access Attribute for the user. The user name template is the format for the distinguished name used for authentication. When a user enters a user name into the login page, the appliance substitutes the name for the string conversion character and uses the resulting distinguished name to search for the user credentials. If you want to use this object for CAC authentication and authorization, you must enter a User Name Template.</td>
<td>%<a href="mailto:s@security.example.com">s@security.example.com</a>, %<a href="mailto:s@mail.com">s@mail.com</a>, %s@mil, %<a href="mailto:s@smil.mil">s@smil.mil</a>,</td>
</tr>
<tr>
<td>Timeout</td>
<td>Sets a timeout for the connection attempt to the primary server, so the connection rolls over to the backup server. If the number of seconds indicated in this field (or the timeout on the LDAP server) elapses without a response from the primary authentication server, the appliance then queries the backup server. However, if LDAP is running on the port of the primary LDAP server and for some reason refuses to service the request, the failover to the backup server does not occur.</td>
<td>If the primary server has LDAP disabled, the appliance queries the backup server.</td>
</tr>
</tbody>
</table>
### Configuring LDAP-Specific Parameters

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI Access Attribute</td>
<td>Tells the local appliance to match the value of a specific attribute rather than the value of the user distinguished name. You can use any attribute, if the value of the attribute is a valid user name for the Firepower System web interface. If one of the objects has a matching user name and password, the user login request is authenticated. Selecting a server type and setting defaults prepopulates the UI Access Attribute with a value typically appropriate for that type of server. If you leave this field blank, the local appliance checks the user distinguished name value for each user record on the LDAP server to see if it matches the user name. If you want to use this object for CAC authentication and authorization, you must enter a value that corresponds with your <strong>User Name Template</strong> value.</td>
<td>sAMAccountName, userPrincipalName, mail</td>
</tr>
</tbody>
</table>

The settings in the LDAP-specific parameters section determine the area of the LDAP directory where the appliance searches for user names, and control details of how the appliance connects to the LDAP server. Valid user names are unique, and can include underscores (_), periods (.), hyphens (-), and alphanumeric characters.

In addition for most LDAP-specific settings, you can use LDAP naming standards and filter and attribute syntax. For more information, see the RFCs listed in the Lightweight Directory Access Protocol (v3): Technical Specification, RFC 3377. Examples of syntax are provided throughout this procedure. Note that when you set up an authentication object to connect to a Microsoft Active Directory Access Protocol, you can use the address specification syntax documented in the Internet RFC 822 (Standard for the Format of ARPA Internet Text Messages) specification when referencing a user name that contains a domain. For example, to refer to a user object, you might enter `JoeSmith@security.example.com` rather than the equivalent user distinguished name of `cn=JoeSmith,ou=security, dc=example,dc=com` when using Microsoft Active Directory Server.

**Note**

If you are configuring an LDAP authentication object for use with CAC authentication, do **not** remove the CAC inserted in your computer. You **must** have a CAC inserted at all times after enabling user certificates.
Procedure

Step 1  In the **LDAP-Specific Parameters** section of the Create External Authentication Object page, you have two options for setting the base DN:

- Click **Fetch DN**, and choose the appropriate base distinguished name from the drop-down list.
- Enter the base distinguished name for the LDAP directory you want to access in the **Base DN** field. For example, to authenticate names in the Security organization at the Example company, enter `ou=security,dc=example,dc=com`.

Step 2  Optionally, enter a **Base Filter**.

**Example:**

For example, if the user objects in a directory tree have a `physicalDeliveryOfficeName` attribute and users in the New York office have an attribute value of `NewYork` for that attribute, to retrieve only users in the New York office, enter `(physicalDeliveryOfficeName=NewYork)`.

Step 3  Enter a distinguished name as the **UserName** and the **Password** for a user who has sufficient credentials to browse the LDAP server.

**Example:**

For example, if you are connecting to an OpenLDAP server where user objects have a `uid` attribute and the object for the administrator in the Security division at your example company has a `uid` value of `NetworkAdmin`, you might enter `uid=NetworkAdmin,ou=security,dc=example,dc=com`.

**Caution**  If you are connecting to a Microsoft Active Directory Server, you cannot provide a server user name that ends with the `$` character.

Step 4  Re-enter the password in the **Confirm Password** field.

Step 5  After you configure the basic LDAP-specific parameters, you have several options:

- To access advanced options, click the arrow next to **Show Advanced Options** and continue with the next step.
- If you want to configure user default roles based on LDAP group membership, continue with Configuring Access Rights by Group, on page 87.
- If you are not using LDAP groups for authentication, continue with Configuring LDAP Shell Access, on page 89.

Step 6  Optionally, choose an **Encryption** mode for your LDAP connection.

**Note**  Note that if you change the encryption method after specifying a port, you reset the port to the default value for that method. For none or TLS, the port uses the default value of 389. If you choose SSL encryption, the port uses the default of 636.

Step 7  If you choose TLS or SSL encryption and you want to use a certificate to authenticate, **Browse** to the location of a valid TLS or SSL certificate.

**Note**  If you previously uploaded a certificate and want to replace it, upload the new certificate and redeploy the configuration to your appliances to copy over the new certificate.

Step 8  Optionally, provide a **User Name Template** that corresponds with your **UI Access Attribute**.

**Example:**
For example, to authenticate all users who work in the Security organization of our example company by
connecting to an OpenLDAP server where the UI access attribute is `uid`, you might enter `uid=%s,ou=security,dc=example,dc=com` in the **User Name Template** field. For a Microsoft Active Directory
server, you could enter `%s@security.example.com`.

**Note** If you want to use CAC credentials for authentication and authorization, you **must** enter a value in
the **User Name Template** field.

**Step 9**
Optionally, in the **Timeout** field, enter the number of seconds that should elapse before rolling over to the
backup connection.

**Step 10**
Optionally, to retrieve users based on an attribute instead of the Base DN and Base Filter, you have two
options:

- Click **Fetch Attrs** to retrieve a list of available attributes, and choose the appropriate attribute.
- Enter a **UI Access Attribute**. For example, on a Microsoft Active Directory Server, you may want to
use the UI Access Attribute to retrieve users, because there may not be a `uid` attribute on Active Directory
Server user objects. Instead, you can search the `userPrincipalName` attribute by typing
`userPrincipalName` in the **UI Access Attribute** field.

**Note** If you want to use CAC credentials for authentication and authorization, you **must** enter a value in
the **UI Access Attribute** field.

---

**What to do next**

- Continue creating your LDAP authentication object as described in *Creating Advanced LDAP
  Authentication Objects*, on page 76.

**LDAP Group Fields**

Any group you reference must exist on the LDAP server. You can reference static LDAP groups or dynamic
LDAP groups. Static LDAP groups are groups where membership is determined by group object attributes
that point to specific users, and dynamic LDAP groups are groups where membership is determined by creating
an LDAP search that retrieves group users based on user object attributes. Group access rights for a role only
affect users who are members of the group.

The access rights granted when a user logs into the Firepower System depend on the LDAP configuration:

- If no group access rights are configured for your LDAP server, when a new user logs in, the Firepower
  System authenticates the user against the LDAP server and then grants user rights based on the default
  minimum access role set in the platform settings policy.
- If you configure any group settings, new users belonging to specified groups inherit the minimum access
  setting for the groups where they are members.
- If a new user does not belong to any specified groups, the user is assigned the default minimum access
  role specified in the Group Controlled Access Roles section of the authentication object.
- If a user belongs to more than one configured group, the user receives the access role for the group with
  the highest access as a minimum access role.

You cannot use the Firepower System user management page to remove the minimum access rights for users
assigned an access role because of LDAP group membership. You can, however, assign additional rights.
When you modify the access rights for an externally authenticated user, the Authentication Method column on the User Management page provides a status of **External - Locally Modified**.

**Note**
If you use a dynamic group, the LDAP query is used exactly as it is configured on the LDAP server. For this reason, the Firepower System limits the number of recursions of a search to four to prevent search syntax errors from causing infinite loops. If a user’s group membership is not established in those recursions, the default access role defined in the Group Controlled Access Roles section is granted to the user.

**Firepower System User Roles**
The distinguished names for the LDAP groups that contain users who should be assigned each user role.

**Default User Role**
The default minimum access role for users that do not belong to any of the specified groups.

**Group Member Attribute**
The LDAP attribute that contains the LDAP search string in a static group.

**Group Member URL Attribute**
The LDAP attribute that designates membership in a dynamic group.

### Configuring Access Rights by Group

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If you prefer to base default access rights on a user’s membership in an LDAP group, you can specify distinguished names for existing groups on your LDAP server for each of the access roles used by your Firepower System. When you do so, you can configure a default access setting for those users detected by LDAP that do not belong to any specified groups. When a user logs in, the Firepower System dynamically checks the LDAP server and assigns default access rights according to the user’s current group membership.

If you do not configure a user’s privileges using group-controlled access roles, a user has only the privileges granted by default in the platform settings policy.

If you plan to use an object for CAC authentication and authorization, Cisco recommends configuring LDAP groups to manage access role assignments for CAC-authenticated users.

**Note**
If you are configuring an LDAP authentication object for use with CAC authentication, do **not** remove the CAC inserted in your computer. You **must** have a CAC inserted at all times after enabling user certificates.

**Before you begin**

- Confirm that the group you plan to reference exists on the LDAP server.
Procedure

**Step 1**  
On the Create External Authentication Object page, click the down arrow next to **Group Controlled Access Roles**.

**Step 2**  
Optionally, in the DN fields that correspond to Firepower System user roles, enter the distinguished name for the LDAP groups that contain users who should be assigned to those roles.

**Example:**
For example, you might enter the following in the **Administrator** field to authenticate names in the information technology organization at the *Example company*:

```
cn=itgroup,ou=groups, dc=example,dc=com
```

**Step 3**  
Choose a **Default User Role**.

**Step 4**  
If you use static groups, enter a **Group Member Attribute**.

**Example:**
For example, if the `member` attribute is used to indicate membership in the static group you reference for default Security Analyst access, enter `member`.

**Step 5**  
If you use dynamic groups, enter a **Group Member URL Attribute**.

**Example:**
For example, if the `memberURL` attribute contains the LDAP search that retrieves members for the dynamic group you specified for default Admin access, enter `memberURL`.

---

**What to do next**

- Continue creating your LDAP authentication object as described in **Creating Advanced LDAP Authentication Objects**, on page 76.

---

**LDAP Shell Access Fields**

With the exception of the admin account, shell access is controlled entirely through the shell access attribute you set. The shell access filter you set determines which set of users on the LDAP server can log into the shell.

Note that a home directory for each shell user is created on login, and when an LDAP shell access user account is disabled (by disabling the LDAP connection), the directory remains, but the user shell is set to `/bin/false` in `/etc/password` to disable the shell. If the user then is re-enabled, the shell is reset, using the same home directory.

Shell users can log in using user names with lowercase, uppercase, or mixed case letters. Login authentication for the shell is case sensitive.

**Shell Access Attribute**

The access attribute you want to use for filtering. You can use any attribute if the value of the attribute is a valid user name for shell access.

If you leave this field blank, the user distinguished name is used for shell access authentication.
Selecting a server type and setting defaults prepopulates this field with an attribute typically appropriate for that type of server.

**Tip**

### Shell Access Filter

The attribute value you want to use to retrieve administrative user entries for shell access. The filter is an attribute name, a comparison operator, and the attribute value.

The **Same as Base Filter** check box allows you to search more efficiently if all users qualified in the base DN are also qualified for shell access privileges. Normally, the LDAP query to retrieve users combines the base filter with the shell access filter. If the shell access filter was the same as the base filter, the same query runs twice, which is unnecessarily time-consuming. You can use the **Same as Base Filter** option to run the query only once for both purposes.

If you leave this field blank, you prevent LDAP authentication of shell access.

### Configuring LDAP Shell Access

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can use the LDAP server to authenticate accounts for shell access on your managed device or Firepower Management Center. Specify a search filter that retrieves entries for users you want to grant shell access.

You **cannot** configure CAC authentication and authorization and shell access in the same authentication object. Instead, create and enable separate authentication objects.

The authentication object for shell access must be the first authentication object on the Firepower Management Center.

Cisco does not support external authentication for NGIPSv devices or ASA FirePOWER devices. In addition, IPv6 is not supported for shell access authentication.

**Caution**

On all appliances, users with shell access (whether obtained through external authentication or through using the CLI `expert` command) have `sudoers` privileges in the shell, which can present a security risk. If you establish external authentication, make sure that you restrict the list of users with shell access appropriately. Similarly, when granting CLI access privileges, restrict the list of users with **Configuration** level access. Cisco strongly recommends that you do not establish additional shell users on the Firepower Management Center.

You **cannot** configure CAC authentication and authorization and shell access in the same authentication object. Checking the **CAC** check box disables the shell access configuration options on the page. Instead, create and enable separate authentication objects.

**Before you begin**

- Remove any internally-authenticated CLI or shell users that have the same user name as externally-authenticated users included in your shell access filter.
Procedure

**Step 1**
On the Create External Authentication Object page, if you want to use a shell access attribute other than the user distinguished type a **Shell Access Attribute**.

**Example:**
For example, on a Microsoft Active Directory Server, use the `sAMAccountName` shell access attribute to retrieve shell access users by typing `sAMAccountName` in the **Shell Access Attribute** field.

**Step 2**
Set a shell access account filter. You have multiple options:

- To retrieve administrative user entries based on attribute value, enter the attribute name, a comparison operator, and the attribute value you want to use as a filter, enclosed in parentheses, in the **Shell Access Filter** field. For example, if all network administrators have a `manager` attribute which has an attribute value of `shell`, you can set a base filter of `(manager=shell)`.
- To use the same filter you specified when configuring authentication settings, choose **Same as Base Filter**.
- To prevent LDAP authentication of shell access, leave the field blank.

**What to do next**

- Continue creating your LDAP authentication object as described in Creating Advanced LDAP Authentication Objects, on page 76.

**Testing LDAP Authentication Connections**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

After you configure LDAP server and authentication settings, you can specify user credentials for a user who should be able to authenticate to test those settings.

For the **User Name**, you can enter the value for the `uid` attribute for the user you want to test with. If you are connecting to a Microsoft Active Directory Server and supplied a UI access attribute in place of `uid`, use the value for that attribute as the user name. You can also specify a fully qualified distinguished name for the user.

Use the **Password** for the same user.

The test output lists valid and invalid user names. Valid user names are unique, and can include underscores (_), periods (_), hyphens (-), and alphanumeric characters.

Note that testing the connection to servers with more than 1000 users only returns 1000 users because of web interface page size limitations.

**Tip**
If you mistype the name or password of the test user, the test fails even if the server configuration is correct. Test the server configuration without the additional test parameters first. If that succeeds supply a user name and password to test with the specific user.
Procedure

Step 1  On the Add External Authentication Object page, enter a **User Name** and **Password**.

**Example:**
For example, to test to see if you can retrieve the *JSmith* user credentials at the Example company, enter *JSmith* and *password*.

Step 2  Click **Test**. You have two options:

- If the test succeeds, the test output appears at the bottom of the page. Click **Save**.
- If the test fails, see **Troubleshooting LDAP Authentication Connections, on page 91** for suggestions for troubleshooting the connection.

What to do next

- If you want to enable LDAP authentication, enable the authentication object as described in **Enabling External Authentication to Classic Devices, on page 502**.

**Troubleshooting LDAP Authentication Connections**

If you create an LDAP authentication object and it either does not succeed in connecting to the server you select, or does not retrieve the list of users you want, you can tune the settings in the object.

If the connection fails when you test it, try the following suggestions to troubleshoot your configuration:

- Use the messages displayed at the top of the screen and in the test output to determine which areas of the object are causing the issue.

- Check that the user name and password you used for the object are valid:
  - Check that the user has the rights to browse to the directory indicated in your base distinguished name by connecting to the LDAP server using a third-party LDAP browser.
  - Check that the user name is unique to the directory information tree for the LDAP server.
  - If you see an LDAP bind error 49 in the test output, the user binding for the user failed. Try authenticating to the server through a third-party application to see if the binding fails through that connection as well.

- Check that you have correctly identified the server:
  - Check that the server IP address or host name is correct.
  - Check that you have TCP/IP access from your local appliance to the authentication server where you want to connect.
  - Check that access to the server is not blocked by a firewall and that the port you have configured in the object is open.
  - If you are using a certificate to connect via TLS or SSL, the host name in the certificate must match the host name used for the server.
• Check that you have not used an IPv6 address for the server connection if you are authenticating shell access.

• If you used server type defaults, check that you have the correct server type and click Set Defaults again to reset the default values.

• If you typed in your base distinguished name, click Fetch DNs to retrieve all the available base distinguished names on the server, and select the name from the list.

• If you are using any filters, access attributes, or advanced settings, check that each is valid and typed correctly.

• If you are using any filters, access attributes, or advanced settings, try removing each setting and testing the object without it.

• If you are using a base filter or a shell access filter, make sure that the filter is enclosed in parentheses and that you are using a valid comparison operator.

• To test a more restricted base filter, try setting it to the base distinguished name for the user to retrieve just that user.

• If you are using an encrypted connection:
  • Check that the name of the LDAP server in the certificate matches the host name that you use to connect.
  • Check that you have not used an IPv6 address with an encrypted server connection.

• If you are using a test user, make sure that the user name and password are typed correctly.

• If you are using a test user, remove the user credentials and test the object.

• Test the query you are using by connecting to the LDAP server via the command line on the appliance you want to connect from using this syntax:

```
ldapsearch -x -b 'base_distinguished_name'
-h LDAPserver_ip_address -p port -v -D
'user_distinguished_name' -W 'base_filter'
```

For example, if you are trying to connect to the security domain on myrtle.example.com using the domainadmin@myrtle.example.com user and a base filter of (cn=*)
, you could test the connection using this statement:

```
ldapsearch -x -b 'CN=security,DC=myrtle,DC=example,DC=com'
-h myrtle.example.com -p 389 -v -D
'domainadmin@myrtle.example.com' -W '(cn=*)'
```

If you can test your connection successfully but authentication does not work after you deploy a platform settings policy, check that authentication and the object you want to use are both enabled in the platform settings policy that is applied to the appliance.

If you connect successfully but want to adjust the list of users retrieved by your connection, you can add or change a base filter or shell access filter or use a more restrictive or less restrictive base DN.
RADIUS Authentication

The Remote Authentication Dial In User Service (RADIUS) is an authentication protocol used to authenticate, authorize, and account for user access to network resources. You can create an authentication object for any RADIUS server that conforms to RFC 2865.

When a user authenticated on a RADIUS server logs in for the first time, the user receives the roles specified for that user in the authentication object. If the user is not listed for any of the user roles, they receive the default access role you selected in the authentication object. If no default access role is selected in the authentication object, they receive the default access role set in the platform settings policy. You can modify a user’s roles, if needed, unless the settings are granted through the user lists in the authentication object. Note that when a user authenticated on a RADIUS server using attribute matching attempts to log in for the first time, the login is rejected as the user account is created. The user must log in a second time.

Note

Before enabling external authentication on 7000 or 8000 Series devices, remove any internally-authenticated CLI users that have the same user name as externally-authenticated users included in your shell access filter.

The Firepower System implementation of RADIUS supports the use of SecurID® tokens. When you configure authentication by a server using SecurID, users authenticated against that server append the SecurID token to the end of their SecurID PIN and use that as their password when they log into a Cisco system. As long as SecurID is configured correctly to authenticate users outside the Firepower System, those users can log into a Firepower Management Center or 7000 or 8000 Series device using their PIN plus the SecurID token without any additional configuration.

Creating RADIUS Authentication Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you create a RADIUS authentication object, you define settings that let you connect to an authentication server. You also grant user roles to specific and default users. If your RADIUS server returns custom attributes for any users you plan to authenticate, you must define those custom attributes. Optionally, you can also configure CLI or shell access authentication.

In a multidomain deployment, external authentication objects are only available in the domain in which they are created.

Before you begin

- Confirm that you have TCP/IP access from your local appliance to the authentication server where you want to connect.

Procedure

Step 1  Choose System > Users.
Step 2   Click the **External Authentication** tab.

Step 3   Click **Add External Authentication Object**.

Step 4   Choose **RADIUS** from the **Authentication Method** drop-down list.

Step 5   Identify the authentication server as described in Configuring RADIUS Connection Settings, on page 96.

Step 6   Configure user roles as described in Configuring RADIUS User Roles, on page 98.

Step 7   Optionally, configure shell access as described in Configuring RADIUS Shell Access, on page 99.

Step 8   Optionally, define custom attributes as described in Defining Custom RADIUS Attributes, on page 100.

Step 9   Test your configuration as described in Testing RADIUS Authentication Connections, on page 101.

Example

The following figure illustrates a sample RADIUS login authentication object for a server running FreeRADIUS with an IP address of 10.10.10.98. Note that the connection uses port 1812 for access, and note that connections to the server time out after 30 seconds of disuse, then retry three times before attempting to connect to a backup authentication server.

This example illustrates important aspects of RADIUS user role configuration:

- Users *ewharton* and *gaand* are granted administrative access to appliances where this authentication object is enabled.
- The user *cbronte* is granted Maintenance User access to appliances where this authentication object is enabled.
- The user *jausten* is granted Security Analyst access to appliances where this authentication object is enabled.
- The user *ewharton* can log into the appliance using a shell account.

The following graphic depicts the role configuration for the example:
You can use an attribute-value pair to identify users who should receive a particular user role. If the attribute you use is a custom attribute, you must define the custom attribute.

The following figure illustrates the role configuration and custom attribute definition in a sample RADIUS login authentication object for the same FreeRADIUS server as in the previous example.

In this example, however, the `MS-RAS-Version` custom attribute is returned for one or more of the users because a Microsoft remote access server is in use. Note the `MS-RAS-Version` custom attribute is a string. In this example, all users logging in to RADIUS through a Microsoft v. 5.00 remote access server should receive the Security Analyst (Read Only) role, so you enter the attribute-value pair of `MS-RAS-Version=MSRASV5.00` in the Security Analyst (Read Only) field.
Configuring RADIUS Connection Settings

What to do next

- If you want to enable RADIUS authentication, enable the authentication object as described in Enabling External Authentication to Classic Devices, on page 502.

### Configuring RADIUS Connection Settings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you create a RADIUS authentication object, you first specify the primary and backup server and server port where you want the local appliance (managed device or Firepower Management Center) to connect for authentication.
For RADIUS to function correctly, you must open its authentication and accounting ports (by default, 1812 and 1813) on your firewall.

If you specify a backup authentication server, you can set a timeout for the connection attempt to the primary server. If the number of seconds indicated in the Timeout field (or the timeout on the LDAP server) elapses without a response from the primary authentication server, the appliance then re-queries the primary server.

After the appliance re-queries the primary authentication server the number of times indicated by the Retries field and the number of seconds indicated in the Timeout field again elapses without a response from the primary authentication server, the appliance then rolls over to the backup server.

If, for example, the primary server has RADIUS disabled, the appliance queries the backup server. If RADIUS is running on the port of the primary RADIUS server and for some reason refuses to service the request (due to misconfiguration or other issues), however, the failover to the backup server does not occur.

**Procedure**

**Step 1** Choose System > Users.

**Step 2** Click the External Authentication tab.

**Step 3** Click Create External > Authentication Object.

**Step 4** Choose RADIUS from the Authentication Method drop-down list.

**Step 5** Enter a Name and Description for the authentication server.

**Step 6** Enter the IP address or host name for the primary RADIUS server where you want to obtain authentication data in the Primary Server Host Name/IP Address field.

**Note** IPv6 addresses are not supported for shell authentication. To allow shell authentication when using an IPv6 address for your primary RADIUS server, set up an authentication object using an IPv4 address for the server and use that IPv4 object as the first authentication object on the Firepower Management Center.

**Step 7** Optionally, modify the port used by the primary RADIUS authentication server in the Primary Server Port field.

**Note** If your authentication port and accounting port numbers are not sequential, leave this field blank. The system then determines RADIUS port numbers from the radius and radacct data in your appliance’s /etc/services file.

**Step 8** Enter the RADIUS Secret Key for the primary RADIUS authentication server.

**Step 9** Optionally, enter the IP address or host name for the backup RADIUS authentication server where you want to obtain authentication data in the Backup Server Host Name/IP Address field.

**Step 10** If you set a backup server, modify the Backup Server Port, RADIUS Secret Key, and Timeout and enter the number of times the primary server connection should be tried before rolling over to the backup connection in the Retries field.
If your authentication port and accounting port numbers are not sequential, leave this field blank. The system then determines RADIUS port numbers from the `radius` and `radacct` data in your appliance’s `/etc/services` file.

### What to do next

- Continue creating your RADIUS authentication object as described in Creating RADIUS Authentication Objects, on page 93.

### Configuring RADIUS User Roles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

When a user logs in, the Firepower System checks the RADIUS server and grants access rights depending on the RADIUS configuration:

- If specific access rights are not configured for a user and a default access role is not specified, when a new user logs in, the Firepower System authenticates the user against the RADIUS server and then grants user rights based on the default access role (or roles) set in the platform settings policy.

- If a new user is not specified on any lists and default access roles are specified in the Default User Role list of the authentication object, the user is assigned those access roles.

- If you add a user to the list for one or more specific role, that user receives all assigned access roles.

You can also use attribute-value pairs, rather than user names, to identify users who should receive a particular user role. For example, if you know all users who should be Security Analysts have the value `Analyst` for their `User-Category` attribute, you can enter `User-Category=Analyst` in the Security Analyst List field to grant that role to those users.

You can assign a default user role (or roles) to be assigned to any users that are authenticated externally but not listed for a specific role. You can specify multiple roles in the Default User Role list.

You cannot remove the minimum access rights for users assigned an access role because of RADIUS user list membership through the Firepower System user management page. You can, however, assign additional rights.

#### Caution

If you want to change the minimum access setting for a user, you must not only move the user from one list to another in the RADIUS Specific Parameters section or change the user’s attribute on the RADIUS server, you must redeploy the configuration to the managed device and remove the assigned user right on the user management page.

#### Before you begin

- Define custom attributes if you plan to use them to set user role membership, as described in Defining Custom RADIUS Attributes, on page 100.
Procedure

Step 1

On the Create External Authentication Object page, in the fields that correspond to Firepower System user roles, enter the name of each user or identifying attribute-value pair that should be assigned to those roles. Separate usernames and attribute-value pairs with commas.

Example:

For example, to grant the Administrator role to the users jsmith and jdoe, enter jsmith, jdoe in the Administrator field. As another example, to grant the Maintenance User role to all users with a User-Category value of Maintenance, enter User-Category=Maintenance in the Maintenance User field.

Step 2

Choose the default minimum access role for users that do not belong to any of the specified groups from the Default User Role list.

What to do next

• Continue creating your RADIUS authentication object as described in Creating RADIUS Authentication Objects, on page 93.

Configuring RADIUS Shell Access

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can also use the RADIUS server to authenticate accounts for CLI or shell access on your local appliance (managed device or Firepower Management Center). Specify user names for users you want to grant CLI or shell access.

Note

IPv6 addresses are not supported for shell authentication. If you configure a primary RADIUS server with an IPv6 address and also configure administrative shell access, the shell access settings are ignored. To allow shell authentication when using an IPv6 address for your primary RADIUS server, set up another authentication object using an IPv4 address for the server and use that object as the first authentication object on the Firepower Management Center.

With the exception of the admin account, the shell access list you set on the RADIUS authentication object entirely controls CLI or shell access on the appliance. CLI or shell users are configured as local users on the appliance when you deploy the platform settings policy. Note that when a user authenticated on a RADIUS server using attribute matching attempts to log in for the first time, the login is rejected as the user account is created. The user must log in a second time.

Note that a home directory for each CLI or shell user is created on login, and when an RADIUS shell access user account is disabled (by disabling the RADIUS connection), the directory remains, but the user shell is set to /bin/false in /etc/password to disable the shell. If the user then is re-enabled, the shell is reset, using the same home directory.

CLI or shell users can log in using user names with lowercase, uppercase, or mixed case letters. Login authentication for the CLI or shell is case sensitive.
On all appliances, users with shell access (whether obtained through external authentication or through using the CLI `expert` command) have `sudoers` privileges in the shell, which can present a security risk. If you establish external authentication, make sure that you restrict the list of users with shell access appropriately. Similarly, when granting CLI access privileges, restrict the list of users with `Configuration` level access. Cisco strongly recommends that you do not establish additional shell users on the Firepower Management Center.

### Procedure

On the Create External Authentication Object page, enter the user names, separated by commas, in the **Administrator Shell Access User List** field.

**Note**  
If you choose not to specify a shell access filter, a warning displays when you save the authentication object to confirm that you meant to leave the filter blank.

### What to do next

- Continue creating your RADIUS authentication object as described in Creating RADIUS Authentication Objects, on page 93.

### Defining Custom RADIUS Attributes

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If your RADIUS server returns values for attributes not included in the `dictionary` file in `/etc/radiusclient/` and you plan to use those attributes to set user roles for users with those attributes, you need to define those attributes in the login authentication object. You can locate the attributes returned for a user by looking at the user’s profile on your RADIUS server.

When you define an attribute, you provide the name of the attribute, which consists of alphanumeric characters. Note that words in an attribute name should be separated by dashes rather than spaces. You also provide the attribute ID, which should be an integer and should not conflict with any existing attribute IDs in the `etc/radiusclient/dictionary` file. You also specify the type of attribute: string, IP address, integer, or date.

When you create a RADIUS authentication object, a new dictionary file for that object is created on the appliance in the `/var/sf/userauth` directory. Any custom attributes you add to the authentication object are added to the dictionary file.

In a multidomain deployment, external authentication objects are only available in the domain in which they are created.
**Procedure**

Step 1  On the Add External Authentication Object page, click the arrow to expand the Define Custom RADIUS Attributes section.

Step 2  Enter an attribute name in the **AttributeName** field.

Step 3  Enter the attribute ID, in integer form, in the **Attribute ID** field.

Step 4  Choose the type of attribute from the **Attribute Type** drop-down list.

Step 5  Click **Add** to add the custom attribute to the authentication object.

**Tip** You can remove a custom attribute from an authentication object by clicking **Delete** next to the attribute.

**Example**

If a RADIUS server is used on a network with a Cisco router, you might want to use the **Ascend-Assign-IP-Pool** attribute to grant a specific role to all users logging in from a specific IP address pool. **Ascend-Assign-IP-Pool** is an integer attribute that defines the address pool where the user is allowed to log in, with the integer indicating the number of the assigned IP address pool.

To declare that custom attribute, you create a custom attribute with an attribute name of **Ascend-IP-Pool-Definition**, an attribute ID of 218, and an attribute type of integer.

You could then enter **Ascend-Assign-IP-Pool-2** in the **Security Analyst (Read Only)** field to grant read-only security analyst rights to all users with an **Ascend-IP-Pool-Definition** attribute value of 2.

**What to do next**

- Continue creating your RADIUS authentication object as described in **Creating RADIUS Authentication Objects**, on page 93.

**Testing RADIUS Authentication Connections**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

After you configure RADIUS connection, user role, and custom attribute settings, you can specify user credentials for a user who should be able to authenticate to test those settings.

For the user name, you can enter the user name for the user you want to test with.

Note that testing the connection to servers with more than 1000 users only returns 1000 users because of UI page size limitations.
If you mistype the name or password of the test user, the test fails even if the server configuration is correct. To verify that the server configuration is correct, click **Test** without entering user information in the **Additional Test Parameters** field first. If that succeeds, supply a user name and password to test with the specific user.

### Procedure

**Step 1**

On the Add External Authentication Object page, in the **User Name** and **Password** fields, enter the user name and password for the user whose credentials should be used to validate access to the RADIUS server.

**Example:**

For example, to test to see if you can retrieve the **jsmith** user credentials at our example company, enter **jsmith**.

**Step 2**

Choose **Show Details**, and click **Test**.

**Step 3**

If the test succeeds, click **Save**.

### What to do next

- If you want to enable RADIUS authentication, enable the authentication object as described in **Enabling External Authentication to Classic Devices**, on page 502.

### Single Sign-on (SSO)

Single sign-on (SSO) enables integration between Cisco Security Manager (CSM) Version 4.7 or higher and the Firepower Management Center, which allows you to access the Firepower Management Center from CSM without additional authentication to log in. When managing an ASA FirePOWER module, you may want to modify the policies deployed to the module. You can select the managing Firepower Management Center in CSM and launch it in a web browser.

If you have access based on your user role, the system navigates you to the Device tab of the Device Management page for the device you cross-launched from in CSM. Otherwise, the system navigates you to the Summary Dashboard page (**Overview > Dashboards**), except for user accounts with no dashboard access, which use the Welcome page.

The system disables SSO when STIG compliance is enabled for the Firepower Management Center.

**Note**

You cannot login with single sign-on if your organization uses CACs for authentication.

### Related Topics

- **STIG Compliance**, on page 477
Configuring SSO

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>ASA FirePOWER</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You must set up a one-way, encrypted authentication path from CSM to the Firepower Management Center before you configure Single sign-on.

In NAT environments, the Firepower Management Center and CSM must reside on the same side of the NAT boundary. You must provide specific criteria to enable communications between CSM and the Firepower Management Center.

Note

You cannot login with single sign-on if your organization uses CACs for authentication.

Procedure

Step 1
From CSM, generate an SSO shared encryption key that identifies the connection. See your CSM documentation for more information.

Step 2
From the Firepower Management Center, choose **System > Users**.

Step 3
Choose **CSM Single Sign-on**.

Step 4
Enter the **CSM hostname** or **IP address** and the server **Port**.

Step 5
Enter the **Shared key** that you generated from CSM.

Step 6
Optionally, if you want to use the Firepower Management Center’s proxy server to communicate with CSM, choose the **Use Proxy For Connection** check box.

Step 7
Click **Submit**.

Step 8
Click **Confirm Certificate** to save the Certificate.
You can now log in from CSM to the Firepower Management Center without an additional login.

Related Topics

Configure Management Interfaces, on page 449
Licensing the Firepower System

The following topics explain how to license the Firepower System.

- About Firepower Licenses, on page 105
- License Requirements for Firepower Management Center, on page 105
- Evaluation License Caveats, on page 106
- Licensing for All Devices: Classic Licenses, on page 106
- Assign Licenses to Managed Devices from the Device Management Page, on page 114
- Firepower License and Service Subscription Expiration, on page 115
- Additional Information about Firepower Licensing, on page 116

About Firepower Licenses

Your Firepower products (Firepower Management Center and managed devices) include licenses for basic operation, but some features require separate licensing or service subscriptions, as described in this chapter.

A "right-to-use" license does not expire, but service subscriptions require periodic renewal.

The type of license your products require depends on the software you use, not on the hardware it runs on.

License Requirements for Firepower Management Center

Firepower Management Center allows you to assign licenses to managed devices and manage licenses for the system.

**Hardware FMC**

A hardware Firepower Management Center does not require purchase of additional licenses or service subscriptions in order to manage devices.

**Virtual FMC**

Firepower Management Center Virtual has additional licensing requirements. Contact your authorized representative for details.
Evaluation License Caveats

Not all functionality is available with an evaluation license, functionality under an evaluation license may be partial, and transition from evaluation licensing to standard licensing may not be seamless. Review information about evaluation license caveats in information about particular features in this Licensing chapter and in the chapters related to deploying each feature.

Licensing for All Devices: Classic Licenses

7000 and 8000 Series devices, NGIPSv devices, and ASA FirePOWER modules require Classic licenses. These devices are frequently referred to in this documentation as Classic devices.

Important

If you are running Firepower hardware but not Firepower software, see licensing information for the software product you are using. This documentation is not applicable.

Classic licenses require a product authorization key (PAK) to activate and are device-specific. Classic licensing is sometimes also referred to as "traditional licensing."

Product License Registration Portal

When you purchase one or more Classic licenses for Firepower features, you manage them in the Cisco Product License Registration Portal:

http://www.cisco.com/web/go/license

For more information on using this portal, see:


Service Subscriptions for Firepower Features (Classic Licensing)

Some features require a service subscription.

A service subscription enables a specific Firepower feature on a managed device for a set length of time. Service subscriptions can be purchased in one-, three-, or five-year terms. If a subscription expires, Cisco notifies you that you must renew the subscription. If a subscription expires for a Classic device, you might not be able to use the related features, depending on the feature type.

Table 14: Service Subscriptions and Corresponding Classic Licenses

<table>
<thead>
<tr>
<th>Subscription You Purchase</th>
<th>Classic Licenses You Assign in Firepower System</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA</td>
<td>Control + Protection (a.k.a. &quot;Threat &amp; Apps,&quot; required for system updates)</td>
</tr>
<tr>
<td>TAC</td>
<td>Control + Protection + URL Filtering</td>
</tr>
<tr>
<td>TAM</td>
<td>Control + Protection + Malware</td>
</tr>
</tbody>
</table>
Your purchase of a managed device that uses Classic licenses automatically includes Control and Protection licenses. These licenses are perpetual, but you must also purchase a TA service subscription to enable system updates. Service subscriptions for additional features are optional.

### Classic License Types and Restrictions

This section describes the types of Classic licenses available in a Firepower System deployment. The licenses you can enable on a device depend on its model, version, and the other licenses enabled.

Licenses are model-specific for 7000 and 8000 Series devices, NGIPSv devices, and ASA FirePOWER modules. You cannot enable a license on a managed device unless the license exactly matches the device’s model. For example, you cannot use a Firepower 8250 Malware license (FP8250-TAM-LIC=) to enable Malware capabilities on an 8140 device; you must purchase a Firepower 8140 Malware license (FP8140-TAM-LIC=).

For NGIPSv or ASA FirePOWER, the Control license allows you to perform user and application control, but these devices do not support switching, routing, stacking, or 7000 and 8000 Series device high availability.

There are a few ways you may lose access to licensed features in the Firepower System:

- You can remove Classic licenses from the Firepower Management Center, which affects all of its managed devices.
- You can disable licensed capabilities on specific managed devices.

Though there are some exceptions, you cannot use the features associated with an expired or deleted license. The following table summarizes Classic licenses in the Firepower System.

#### Table 15: Firepower System Classic Licenses

<table>
<thead>
<tr>
<th>Subscription You Purchase</th>
<th>Classic Licenses You Assign in Firepower System</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAMC</td>
<td>Control + Protection + URL Filtering + Malware</td>
</tr>
<tr>
<td>URL</td>
<td>URL Filtering (add-on where TA is already present)</td>
</tr>
<tr>
<td>AMP</td>
<td>Malware (add-on where TA is already present)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>License You Assign in Firepower System</th>
<th>Service Subscription You Purchase</th>
<th>Platforms</th>
<th>Granted Capabilities</th>
<th>Also Requires</th>
<th>Expire Capable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>TA, TAC, TAM, or TAMC</td>
<td>7000 and 8000 Series</td>
<td>host, application, and user discovery decrypting and inspecting SSL- and TLS-encrypted traffic</td>
<td>none</td>
<td>depends on license</td>
</tr>
<tr>
<td></td>
<td>ASA FirePOWER NGIPSv</td>
<td>ASAFirePOWER NGIPSv</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>License You Assign in Firepower System</td>
<td>Service Subscription You Purchase</td>
<td>Platforms</td>
<td>Granted Capabilities</td>
<td>Also Requires</td>
<td>Expire Capable?</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-----------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Protection</td>
<td>TA (included with device)</td>
<td>7000 and 8000 Series</td>
<td>intrusion detection and prevention file control Security Intelligence filtering</td>
<td>none</td>
<td>no</td>
</tr>
<tr>
<td>Control</td>
<td>none (included with device)</td>
<td>7000 and 8000 Series</td>
<td>user and application control switching and routing 7000 and 8000 Series device high availability 7000 and 8000 Series network address translation (NAT) Protection</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Malware</td>
<td>TAM, TAMC, or AMP</td>
<td>7000 and 8000 Series</td>
<td>AMP for Networks (network-based Advanced Malware Protection) File storage Protection</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>URL Filtering</td>
<td>TAC, TAMC, or URL</td>
<td>7000 and 8000 Series</td>
<td>category and reputation-based URL filtering Protection</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>VPN</td>
<td>none (contact Sales for more information)</td>
<td>7000 and 8000 Series</td>
<td>deploying virtual private networks Control</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

**Protection Licenses**

A Protection license allows you to perform intrusion detection and prevention, file control, and Security Intelligence filtering:

- *Intrusion detection and prevention* allows you to analyze network traffic for intrusions and exploits and, optionally, drop offending packets.

- *File control* allows you to detect and, optionally, block users from uploading (sending) or downloading (receiving) files of specific types over specific application protocols. *AMP for Networks*, which requires a Malware license, allows you to inspect and block a restricted set of those file types based on their dispositions.

- *Security Intelligence filtering* allows you to blacklist—deny traffic to and from—specific IP addresses, URLs, and DNS domain names, before the traffic is subjected to analysis by access control rules. Dynamic
feeds allow you to immediately blacklist connections based on the latest intelligence. Optionally, you can use a “monitor-only” setting for Security Intelligence filtering.

A Protection license (along with a Control license) is automatically included in the purchase of any Classic managed device. This license is perpetual, but you must also purchase a TA subscription to enable system updates.

Although you can configure an access control policy to perform Protection-related inspection without a license, you cannot deploy the policy until you first add a Protection license to the Firepower Management Center, then enable it on the devices targeted by the policy.

If you delete your Protection license from the Firepower Management Center or disable Protection on managed devices, the Firepower Management Center stops acknowledging intrusion and file events from the affected devices. As a consequence, correlation rules that use those events as a trigger criteria stop firing. Additionally, the Firepower Management Center will not contact the internet for either Cisco-provided or third-party Security Intelligence information. You cannot re-deploy existing policies until you re-enable Protection.

Because a Protection license is required for URL Filtering, Malware, and Control licenses, deleting or disabling a Protection license has the same effect as deleting or disabling your URL Filtering, Malware, or Control license.

**Control Licenses**

A Control license allows you to implement user and application control by adding user and application conditions to access control rules. For 7000 and 8000 Series devices only, this license also allows you to configure switching and routing (including DHCP relay and NAT) and device high-availability pairs. To enable a Control license on a managed device, you must also enable a Protection license. A Control license is automatically included (along with a Protection license) in the purchase of any Classic managed device. This license is perpetual, but you must also purchase a TA subscription to enable system updates.

If you do not enable a Control license for a Classic managed device, you can add user and application conditions to rules in an access control policy, but you cannot deploy the policy to the device. If you do not enable a Control license for 7000 or 8000 Series devices specifically, you also cannot:

- create switched, routed, or hybrid interfaces
- create NAT entries
- configure DHCP relay for virtual routers
- deploy a device configuration that includes switch or routing to the device
- establish high availability between devices

---

**Note**

Although you can create virtual switches and routers without a Control license, they are not useful without switched and routed interfaces to populate them.

If you delete a Control license from the Firepower Management Center or disable Control on individual devices, the affected devices do **not** stop performing switching or routing, nor do device high-availability pairs break. You can continue to edit and delete existing configurations, but you cannot deploy those changes to the affected devices. You cannot add new switched, routed, or hybrid interfaces, nor can you add new NAT entries, configure DHCP relay, or establish 7000 or 8000 Series device high-availability. Finally, you cannot re-deploy existing access control policies if they include rules with user or application conditions.
URL Filtering Licenses for Classic Devices

URL filtering allows you to write access control rules that determine the traffic that can traverse your network based on URLs requested by monitored hosts, correlated with information about those URLs. To enable a URL Filtering license, you must also enable a Protection license. You can purchase a URL Filtering license for Classic devices as a services subscription combined with Threat & Apps (TAC) or Threat & Apps and Malware (TAMC) subscriptions, or as an add-on subscription (URL) for a system where Threat & Apps (TA) is already enabled.

Tip
Without a URL Filtering license, you can specify individual URLs or groups of URLs to allow or block. This gives you granular, custom control over web traffic, but does not allow you to use URL category and reputation data to filter network traffic.

Although you can add category and reputation-based URL conditions to access control rules without a URL Filtering license, the Firepower Management Center will not download URL information. You cannot deploy the access control policy until you first add a URL Filtering license to the Firepower Management Center, then enable it on the devices targeted by the policy.

You may lose access to URL filtering if you delete the license from the Firepower Management Center or disable URL Filtering on managed devices. Also, URL Filtering licenses may expire. If your license expires or if you delete or disable it, access control rules with URL conditions immediately stop filtering URLs, and your Firepower Management Center can no longer download updates to URL data. You cannot re-deploy existing access control policies if they include rules with category and reputation-based URL conditions.

Malware Licenses for Classic Devices

A Malware license allows you to perform Cisco Advanced Malware Protection (AMP) with AMP for Networks and Cisco Threat Grid. You can use managed devices to detect and block malware in files transmitted over your network. To enable a Malware license, you must also enable Protection. You can purchase a Malware license as a subscription combined with Threat & Apps (TAM) or Threat & Apps and URL Filtering (TAMC) subscriptions, or as an add-on subscription (AMP) for a system where Threat & Apps (TA) is already enabled.

Note
7000 and 8000 Series managed devices with Malware licenses enabled attempt to connect periodically to the AMP cloud even if you have not configured dynamic analysis. Because of this, the device’s Interface Traffic dashboard widget shows transmitted traffic; this is expected behavior.

You configure AMP for Networks as part of a file policy, which you then associate with one or more access control rules. File policies can detect your users uploading or downloading files of specific types over specific application protocols. AMP for Networks allows you to use local malware analysis and file preclassification to inspect a restricted set of those file types for malware. You can also download and submit specific file types to the Cisco Threat Grid cloud for dynamic and Spero analysis to determine whether they contain malware. For these files, you can view the network file trajectory, which details the path the file has taken through your network. The Malware license also allows you to add specific files to a file list and enable the file list within a file policy, allowing those files to be automatically allowed or blocked on detection.

Before you can deploy an access control policy that includes AMP for Networks configurations, you must add a Malware license, then enable it on the devices targeted by the policy. If you later disable the license on the devices, you cannot re-deploy the existing access control policy to those devices.
If you delete all your Malware licenses or they all expire, the system stops querying the AMP cloud, and also stops acknowledging retrospective events sent from the AMP cloud. You cannot re-deploy existing access control policies if they include AMP for Networks configurations. Note that for a very brief time after a Malware license expires or is deleted, the system can use existing cached file dispositions. After the time window expires, the system assigns a disposition of *Unavailable* to those files.

A Malware license is required only if you deploy AMP for Networks and Cisco Threat Grid. Without a Malware license, the Firepower Management Center can receive AMP for Endpoints malware events and indications of compromise (IOC) from the AMP cloud.

See also important information at License Requirements for File and Malware Policies, on page 795.

**VPN Licenses**

VPN allows you to establish secure tunnels between endpoints via a public source, such as the Internet or other network. You can configure the Firepower System to build secure VPN tunnels between the virtual routers of 7000 and 8000 Series devices. To enable VPN, you must also enable Protection and Control licenses. To purchase a VPN license, contact Sales.

Without a VPN license, you cannot configure a VPN deployment with your 7000 and 8000 Series devices. Although you can create deployments, they are not useful without at least one VPN-enabled routed interface to populate them.

If you delete your VPN license from the Firepower Management Center or disable VPN on individual devices, the affected devices do not break the current VPN deployments. Although you can edit and delete existing deployments, you cannot deploy your changes to the affected devices.

**Classic Licenses in Device Stacks and High-Availability Pairs**

Individual devices must have equivalent licenses before they can be stacked or configured into 7000 or 8000 Series device high-availability pairs. After you stack devices, you can change the licenses for the entire stack. However, you cannot change the enabled licenses on a 7000 or 8000 Series device high-availability pair.

See also About Device Stacks, on page 421 and Device High Availability Requirements, on page 406.

**View Your Classic Licenses**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Classic</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Procedure**

Do one of the following, depending on your needs:

<table>
<thead>
<tr>
<th>To View</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Classic licenses that you have added to the Firepower Management Center and details including their type, status, usage, expiration dates, and the managed devices to which they are applied.</td>
<td>Choose System &gt; Licenses &gt; Classic Licenses. The summary shows the number of licenses you have purchased, followed by the number of licenses that are in used in parentheses.</td>
</tr>
</tbody>
</table>
Identify the License Key

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Classic</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

The license key uniquely identifies the Firepower Management Center in the Cisco License Registration Portal. It is composed of a product code (for example, 66) and the MAC address of the management port (eth0) of the Firepower Management Center; for example, 66:00:00:77:FF:CC:88.

You will use the license key in the Cisco License Registration Portal to obtain the license text required to add licenses to the Firepower Management Center.

**Procedure**

**Step 1** Choose System > Licenses > Classic Licenses.

**Step 2** Click Add New License.

**Step 3** Note the value in the License Key field at the top of the Add Feature License dialog.

**What to do next**

- Add a license to the Firepower Management Center; see Generate a Classic License and Add It to the Firepower Management Center, on page 113.

This procedure includes the process of generating the actual license text using the license key.
### Generate a Classic License and Add It to the Firepower Management Center

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Classic</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Note**

If you add licenses after a backup has completed, these licenses will not be removed or overwritten if this backup is restored. To prevent a conflict on restore, remove those licenses before restoring the backup, noting where the licenses were used, and add and reconfigure them after restoring the backup. If a conflict occurs, contact Support.

**Tip**

You can also request licenses on the **Licenses** tab after you log into the Support Site.

### Before you begin

- Make sure you have the product activation key (PAK) from the Software Claim Certificate that Cisco provided when you purchased the license. If you have a legacy, pre-Cisco license, contact Support.

- Identify the license key for the Firepower Management Center; see [Identify the License Key](#), on page 112.

### Procedure

**Step 1** Choose **System > Licenses > Classic Licenses**.

**Step 2** Click **Add New License**.

**Step 3** Continue as appropriate:

- If you have already obtained the license text, skip to Step 8.
- If you still need to obtain the license text, go to the next step.

**Step 4** Click **Get License** to open the Cisco License Registration Portal.

**Note** If you cannot access the Internet using your current computer, switch to a computer that can, and browse to [http://cisco.com/go/license](http://cisco.com/go/license).

**Step 5** Generate a license from the PAK in the License Registration Portal. For more information, see [https://www.cisco.com/web/fw/tools/swift/xui/html/help.html](https://www.cisco.com/web/fw/tools/swift/xui/html/help.html).

This step requires the PAK you received during the purchase process, as well as the license key for the Firepower Management Center.

**Step 6** Copy the license text from either the License Registration Portal display, or the email the License Registration Portal sends you.

**Important** The licensing text block in the portal or email message may include more than one license. Each license is bounded by a BEGIN LICENSE line and an END LICENSE line. Make sure that you copy and paste only one license at a time.
Step 7 Return to the Add Feature License page in the Firepower Management Center’s web interface.

Step 8 Paste the license text into the License field.

Step 9 Click Verify License.

If the license is invalid, make sure that you correctly copied the license text.

Step 10 Click Submit License.

What to do next

• Assign the license to a managed device; see Assign Licenses to Managed Devices from the Device Management Page, on page 114. You must assign licenses to your managed devices before you can use licensed features on those devices.

Assign Licenses to Managed Devices from the Device Management Page

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
</tbody>
</table>

Although there are some exceptions, you cannot use the features associated with a license if you disable it on a managed device.

Before you begin

• Add your devices to the Firepower Management Center. See Add Devices to the Firepower Management Center, on page 178.

Procedure

Step 1 Choose Devices > Device Management.

Step 2 Next to the device where you want to assign or disable a license, click the edit icon (-pencil).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3 Click the Device tab.

Step 4 Next to the License section, click the edit icon (-pencil).

Step 5 Check or clear the appropriate check boxes to assign or disable licenses for the device.

Step 6 Click Save.
Firepower License and Service Subscription Expiration

License Expiration vs. Service Subscription Expiration

Q. Do Firepower feature licenses expire?

Classic Licensing

Q. How can I tell if my Classic licenses/service subscriptions are expired or about to expire?
A. On the Firepower Management Center, choose System > Licenses > Classic Licenses.

On this page, a table summarizes the Classic licenses you have added to this Firepower Management Center.

You can determine whether the service subscription for the license is currently in compliance based on the Status field.

You can determine when the service subscription will expire (or when it expired) by the date in the Expires field.

You can also obtain this information by reviewing your license information in the Cisco Product License Registration Portal.

Q. What does this mean: 'IPS Term Subscription is still required for IPS’?
A. This message merely informs you that Protect and Control functionality requires not only a right-to-use license (which never expires), but also one or more associated service subscriptions, which must be renewed periodically. If the service subscriptions you want to use are current and will not expire soon, no action is required. To determine the status of your service subscriptions, see How can I tell if my Classic licenses/service subscriptions are expired or about to expire?, on page ?.

Q. What happens if my Classic license/subscription expires?
A. If a service subscription supporting a Classic license expires, Cisco notifies you that you must renew the subscription; see Subscription Renewals.

You might not be able to use the related features, depending on the feature type:
Table 16: Expiration Impact for Classic Licenses/Subscriptions

<table>
<thead>
<tr>
<th>Classic License</th>
<th>Possible Supporting Subscriptions</th>
<th>Expiration Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control</td>
<td>TA, TAC, TAM, TAMC</td>
<td>You can continue to use existing Firepower functionality, but you cannot download VDB updates, including application signature updates.</td>
</tr>
<tr>
<td>Protection</td>
<td>TA, TAC, TAM, TAMC</td>
<td>You can continue to perform intrusion inspection, but you cannot download intrusion rule updates.</td>
</tr>
</tbody>
</table>
| URL Filtering   | URL, TAC, TAMC                    | • Access control rules with URL conditions immediately stop filtering URLs.  
• Other policies (such as SSL policies) that filter traffic based on URL category and reputation immediately stop doing so.  
• The Firepower Management Center can no longer download updates to URL data.  
• You cannot re-deploy existing policies that perform URL category and reputation filtering. |
| Malware         | AMP, TAM, TAMC                    | • For a very brief time, the system can use existing cached file dispositions. After the time window expires, the system assigns a disposition of Unavailable to those files.  
• The system stops querying the AMP cloud, and stops acknowledging retrospective events sent from the AMP cloud.  
• You cannot re-deploy existing access control policies if they include AMP for Firepower configurations. |

Subscription Renewals

Q. How do I renew an expiring Classic license?
A. To renew an expiring Classic license, simply purchase a new PAK key and follow the same process as for implementing a new subscription.

Q. Can I renew a Firepower service subscription from the Firepower Management Center?
A. No. To renew a Firepower service subscription, purchase a new subscription using either the Cisco Commerce Workspace or the Cisco Service Contract Center.

Additional Information about Firepower Licensing

For additional information to help resolve common licensing questions, see the following documents:
• The *Frequently Asked Questions (FAQ) about Firepower Licensing* document at:

• The *Cisco Firepower System Feature Licenses* document at:
CHAPTER 6

System Software Updates

The following topics explain how to update Firepower deployments:

- About Firepower Updates, on page 119
- Guidelines and Limitations for Firepower Updates, on page 120
- Upgrade Firepower System Software, on page 120
- Update the Vulnerability Database (VDB) Manually, on page 121
- Update the Geolocation Database (GeoDB), on page 122
- Update Intrusion Rules, on page 124
- Maintain Your Air-Gapped Deployment, on page 134

About Firepower Updates

Cisco distributes several types of upgrades and updates for Firepower deployments. Unless otherwise documented in the release notes or advisory text, updating does not modify configurations. Note that you cannot uninstall major upgrades, nor can you return to previous versions of the VDB, GeoDB, or SRU.

Table 17: Firepower Upgrades and Updates

<table>
<thead>
<tr>
<th>Update Type</th>
<th>Description</th>
<th>Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major upgrade</td>
<td>Includes new features and functionality, and may entail large-scale changes to the product. Can be freshly installed or restored, but not uninstalled. For devices where you upgrade the operating system separately, likely to have a companion operating system upgrade. May require you to re-accept the Cisco End User License Agreement (EULA)</td>
<td>Global only</td>
</tr>
<tr>
<td>Minor upgrade (patch)</td>
<td>Contains a limited range of fixes. Can be uninstalled, but not freshly installed or restored. You must restore to a major version, then upgrade to the minor version.</td>
<td>Global only</td>
</tr>
<tr>
<td>Vulnerability Database (VDB)</td>
<td>Updates detection of vulnerabilities, operating systems, applications, clients, and file types eligible for dynamic analysis.</td>
<td>Global only</td>
</tr>
</tbody>
</table>
### Guidelines and Limitations for Firepower Updates

#### Before You Update

Before you update any component of your Firepower deployment (including the VDB, GeoDB, or SRU) you must read the release notes or advisory text that accompanies the update. These provide critical and release-specific information, including compatibility, prerequisites, new capabilities, behavior changes, and warnings.

For details on how to prepare for and complete a successful system software upgrade of a Firepower Management Center deployment, see the Cisco Firepower Management Center Upgrade Guide.

#### Bandwidth Guidelines

Updates can require large data transfers from the Firepower Management Center to managed devices. Before you begin, make sure your management network has sufficient bandwidth to successfully perform the transfer. See the Troubleshooting Tech Note at https://www.cisco.com/c/en/us/support/docs/security/firepower-management-center/212043-Guidelines-for-Downloading-Data-from-the.html.

### Upgrade Firepower System Software

Upgrading a Firepower Management Center deployment can be complex process. Careful planning and preparation can help you avoid missteps. You should consider planning and preparation as much a part of the upgrade process as actually performing the mechanical steps that invoke the upgrade scripts.

The first step in the process is to assess your deployment and create an upgrade path—a detailed plan for which appliances you will upgrade, what components you will upgrade, and in what order. Your upgrade path should:

- Maintain manager-device compatibility.
- Include operating system and hosting environment upgrades where necessary.
- Include other tasks such as backups, package downloads, bandwidth and disk space checks, pre- and post-upgrade configuration changes, and so on.
- Identify potential interruptions in traffic flow and inspection.

<table>
<thead>
<tr>
<th>Update Type</th>
<th>Description</th>
<th>Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intrusion rules (SRUs)</td>
<td>Provides new and updated intrusion rules and preprocessor rules, modified states for existing rules, and modified default intrusion policy settings. May also delete rules, provide new rule categories and default variables, and modify default variable values.</td>
<td>Cisco-provided: Global only Local imports: Any</td>
</tr>
<tr>
<td>Geolocation database (GeoDB)</td>
<td>Updates information on physical locations, connection types, and so on, that can be associated with detected routable IP addresses. You must install the GeoDB to view geolocation details or perform geolocation-based access control.</td>
<td>Global only</td>
</tr>
</tbody>
</table>
For details on how to prepare for and complete a successful upgrade of a Firepower Management Center deployment, see Cisco Firepower Management Center Upgrade Guide.

**Update the Vulnerability Database (VDB) Manually**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

The Cisco vulnerability database (VDB) is a database of known vulnerabilities to which hosts may be susceptible, as well as fingerprints for operating systems, clients, and applications. The system uses the VDB to help determine whether a particular host increases your risk of compromise.

The Cisco Talos Security Intelligence and Research Group (Talos) issues periodic updates to the VDB. The time it takes to update the VDB and its associated mappings on the Firepower Management Center depends on the number of hosts in your network map. As a rule of thumb, divide the number of hosts by 1000 to determine the approximate number of minutes to perform the update.

If the Firepower Management Center cannot access the internet, or you want to manually upload the VDB update to the Firepower Management Center, use this procedure. To automate VDB updates, use task scheduling (System > Tools > Scheduling). For details, see Vulnerability Database Update Automation, on page 163.

---

**Important**

If you do not schedule automatic VDB updates, you should regularly check for these updates. Updates occur no more than once daily and are posted to the appropriate child pages of https://www.cisco.com/go/firepower-software.

---

**Caution**

Installing a vulnerability database (VDB) update immediately restarts the Snort process on all managed devices. Additionally, the first deploy after installing the VDB might cause a Snort restart depending on the VDB content. In either scenario, the restart interrupts traffic inspection. Whether traffic drops during the interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

---

**Before you begin**

- Consider the update's effect on traffic flow and inspection due to Snort restarts. We recommend performing updates in a maintenance window.

---

**Procedure**

**Step 1** Choose System > Updates, then click the Product Updates tab.

**Step 2** Choose how you want to upload the VDB update to the Firepower Management Center.
- Download directly from Cisco.com—Click Download Updates. If it can access the Cisco Support & Download site, the Firepower Management Center downloads the latest VDB. Note that the Firepower
Management Center also downloads a package for each patch and hotfix (but not major release) associated with the version your appliances are currently running.

- **Upload manually**—Click **Upload Update**, then **Choose File**. Browse to the update you downloaded earlier, and click **Upload**.

VDB updates appear on the same page as Firepower software upgrade and uninstaller packages.

**Step 3**

Install the update.

a) Click the Install icon next to the Vulnerability and Fingerprint Database update.
b) Choose the Firepower Management Center.
c) Click **Install**.

**Step 4**

(Optional) Monitor update progress in the Message Center.

Do not perform tasks related to mapped vulnerabilities until the update completes. Even if the Message Center shows no progress for several minutes or indicates that the update has failed, do not restart the update. Instead, contact Cisco TAC.

After the update completes and Snort restarts, the system uses the new vulnerability information. However, you must deploy before updated application detectors and operating system fingerprints can take effect.

**Step 5**

(Optional) Monitor update progress in the Message Center.

Do not perform tasks related to mapped vulnerabilities until the update completes. Even if the Message Center shows no progress for several minutes or indicates that the update has failed, do not restart the update. Instead, contact Cisco TAC.

After the update completes and Snort restarts, the system uses the new vulnerability information. However, you must deploy before updated application detectors and operating system fingerprints can take effect.

**Step 6**

Verify update success.

Choose **Help > About** to view the current VDB version.

**What to do next**

Deploy configuration changes; see **Deploy Configuration Changes, on page 277**.

### Update the Geolocation Database (GeoDB)

The Cisco Geolocation Database (GeoDB) is a database of geographical data (such as country, city, coordinates) and connection-related data (such as Internet service provider, domain name, connection type) associated with routable IP addresses. When your system detects GeoDB information that matches a detected IP address, you can view the geolocation information associated with that IP address. You must install the GeoDB on your system to view any geolocation details other than country or continent. Cisco issues periodic updates to the GeoDB.

To update the GeoDB, use the Geolocation Updates page (**System > Updates > Geolocation Updates**) on the Firepower Management Center. When you upload GeoDB updates you obtained from Support or from your appliance, they appear on this page.
Note

Download the update directly from the Support Site, either manually or by clicking Download and install geolocation update from the Support Site on the Geolocation Updates page. If you transfer an update file by email, it may become corrupted.

Time needed to update the GeoDB depends on your appliance; the installation usually takes 30 to 40 minutes. Although a GeoDB update does not interrupt any other system functions (including the ongoing collection of geolocation information), the update does consume system resources while it completes. Consider this when planning your updates.

The GeoDB update overrides any previous versions of the GeoDB and is effective immediately. When you update the GeoDB, the Firepower Management Center automatically updates the related data on its managed devices. It may take a few minutes for a GeoDB update to take effect throughout your deployment. You do not need to re-deploy after you update.

### Manually Update the GeoDB (Internet Connection)

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can import a new GeoDB update by automatically connecting to the Support Site only if the appliance has Internet access.

#### Procedure

**Step 1** Choose System > Updates.

**Step 2** Click the Geolocation Updates tab.

**Step 3** Choose Download and install geolocation update from the Support Site.

**Step 4** Click Import.

The system queues a Geolocation Update task, which checks for the latest updates on the Cisco Support Site (http://www.cisco.com/cisco/web/support/index.html).

**Step 5** Optionally, monitor the task status; see Viewing Task Messages, on page 261.

**Step 6** After the update finishes, return to the Geolocation Updates page or choose Help > About to confirm that the GeoDB build number matches the update you installed.

### Manually Update the GeoDB (No Internet Connection)

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If your Firepower Management Center does not have Internet access, you can download the GeoDB update from the Cisco Support Site to a local machine on your network, then manually upload it to your Firepower Management Center.
Procedure

Step 1   Manually download the update from the Cisco Support Site (http://www.cisco.com/cisco/web/support/index.html).

Step 2   Choose System > Updates.

Step 3   Click the Geolocation Updates tab.

Step 4   Choose Upload and install geolocation update.

Step 5   Browse to the update you downloaded, and click Upload.

Step 6   Click Import.

Step 7   Optionally, monitor the task status; see Viewing Task Messages, on page 261.

Step 8   After the update finishes, return to the Geolocation Updates page or choose Help > About to confirm that the GeoDB build number matches the update you installed.

Schedule GeoDB Updates

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If the Firepower Management Center has internet access, we recommend you schedule weekly GeoDB updates.

Before you begin

Make sure the Firepower Management Center can access the internet.

Procedure

Step 1   Choose System > Updates, then click the Geolocation Updates tab.

Step 2   Under Recurring Geolocation Updates, check Enable Recurring Weekly Updates.

Step 3   Specify the Update Start Time.

Step 4   Click Save.

Update Intrusion Rules

As new vulnerabilities become known, the Cisco Talos Security Intelligence and Research Group (Talos) releases intrusion rule updates that you can import onto your Firepower Management Center, and then implement by deploying the changed configuration to your managed devices. These updates affect intrusion rules, preprocessor rules, and the policies that use the rules.

Intrusion rule updates are cumulative, and Cisco recommends you always import the latest update. You cannot import an intrusion rule update that either matches or predates the version of the currently installed rules.

An intrusion rule update may provide the following:
• **New and modified rules and rule states**—Rule updates provide new and updated intrusion and preprocessor rules. For new rules, the rule state may be different in each system-provided intrusion policy. For example, a new rule may be enabled in the Security over Connectivity intrusion policy and disabled in the Connectivity over Security intrusion policy. Rule updates may also change the default state of existing rules, or delete existing rules entirely.

• **New rule categories**—Rule updates may include new rule categories, which are always added.

• **Modified preprocessor and advanced settings**—Rule updates may change the advanced settings in the system-provided intrusion policies and the preprocessor settings in system-provided network analysis policies. They can also update default values for the advanced preprocessing and performance options in your access control policies.

• **New and modified variables**—Rule updates may modify default values for existing default variables, but do not override your changes. New variables are always added.

In a multidomain deployment, you can import local intrusion rules in any domain, but you can import intrusion rule updates from Talos in the Global domain only.

---

**Caution**

The first deploy after importing an intrusion rule update restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during the interruption or passes without further inspection depends on how the target device handles traffic. For more information, see **Snort® Restart Traffic Behavior, on page 280**.

---

**Understanding When Intrusion Rule Updates Modify Policies**

Intrusion rule updates can affect both system-provided and custom network analysis policies, as well as all access control policies:

• **system provided**—Changes to system-provided network analysis and intrusion policies, as well as any changes to advanced access control settings, automatically take effect when you re-deploy the policies after the update.

• **custom**—Because every custom network analysis and intrusion policy uses a system-provided policy as its base, or as the eventual base in a policy chain, rule updates can affect custom network analysis and intrusion policies. However, you can prevent rule updates from automatically making those changes. This allows you to update system-provided base policies manually, on a schedule independent of rule update imports. Regardless of your choice (implemented on a per-custom-policy basis), updates to system-provided policies do **not** override any settings you customized.

Note that importing a rule update discards all cached changes to network analysis and intrusion policies. For your convenience, the Rule Updates page lists policies with cached changes and the users who made those changes.

**Deploying Intrusion Rule Updates**

For changes made by an intrusion rule update to take effect, you must redeploy configurations. When importing a rule update, you can configure the system to automatically redeploy to affected devices. This approach is especially useful if you allow the intrusion rule update to modify system-provided base intrusion policies.

**Recurring Intrusion Rule Updates**

You can import rule updates on a daily, weekly, or monthly basis, using the Rule Updates page.
Applicable subtasks in the intrusion rule update import occur in the following order: download, install, base policy update, and configuration deploy. When one subtask completes, the next subtask begins.

At the scheduled time, the system installs the rule update and deploys the changed configuration as you specified in the previous step. You can log off or use the web interface to perform other tasks before or during the import. When accessed during an import, the Rule Update Log displays a red status icon ( ), and you can view messages as they occur in the Rule Update Log detailed view. Depending on the rule update size and content, several minutes may pass before status messages appear.

Importing Local Intrusion Rules

A local intrusion rule is a custom standard text rule that you import from a local machine as a plain text file with ASCII or UTF-8 encoding. You can create local rules using the instructions in the Snort users manual, which is available at http://www.snort.org.

In a multidomain deployment, you can import local intrusion rules in any domain. You can view local intrusion rules imported in the current domain and ancestor domains.

Update Intrusion Rules One-Time Manually

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Import a new intrusion rule update manually if your Firepower Management Center does not have Internet access.

Caution

The first deploy after importing an intrusion rule update restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during the interruption or passes without further inspection depends on how the target device handles traffic. For more information, see Snort® Restart Traffic Behavior, on page 280.

Procedure

Step 1 Manually download the update from the Cisco Support Site (http://www.cisco.com/cisco/web/support/index.html).

Step 2 Choose System > Updates, then click the Rule Updates tab.

Step 3 If you want to move all user-defined rules that you have created or imported to the deleted folder, you must click Delete All Local Rules in the toolbar, then click OK.

Step 4 Choose Rule Update or text rule file to upload and install and click Browse to navigate to and choose the rule update file.

Step 5 If you want to automatically re-deploy policies to your managed devices after the update completes, choose Reapply all policies after the rule update import completes.

Step 6 Click Import. The system installs the rule update and displays the Rule Update Log detailed view.

Note Contact Support if you receive an error message while installing the rule update.
Update Intrusion Rules One-Time Automatically

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

To import a new intrusion rule update automatically, your appliance must have Internet access to connect to the Support Site.

⚠️ Caution

The first deploy after importing an intrusion rule update restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during the interruption or passes without further inspection depends on how the target device handles traffic. For more information, see Snort® Restart Traffic Behavior, on page 280.

Before you begin

- Ensure the Firepower Management Center has internet access; see Security, Internet Access, and Communication Ports, on page 1801.

Procedure

Step 1  Choose System > Updates.
Step 2  Click the Rule Updates tab.
Step 3  If you want to move all user-defined rules that you have created or imported to the deleted folder, click Delete All Local Rules in the toolbar, then click OK.
Step 4  Choose Download new Rule Update from the Support Site.
Step 5  If you want to automatically re-deploy the changed configuration to managed devices after the update completes, check the Reapply all policies after the rule update import completes check box.
Step 6  Click Import.

The system installs the rule update and displays the Rule Update Log detailed view.

Caution  Contact Support if you receive an error message while installing the rule update.

Configure Recurring Intrusion Rule Updates

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

⚠️ Caution

The first deploy after importing an intrusion rule update restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during the interruption or passes without further inspection depends on how the target device handles traffic. For more information, see Snort® Restart Traffic Behavior, on page 280.
Guidelines for Importing Local Intrusion Rules

Guidelines for Importing Local Intrusion Rules

- The rules importer requires that all custom rules are imported in a plain text file encoded in ASCII or UTF-8.
- The text file name can include alphanumeric characters, spaces, and no special characters other than underscore (_), period (.), and dash (-).
- The system imports local rules preceded with a single pound character (#), but they are flagged as deleted.
- The system imports local rules preceded with a single pound character (#), and does not import local rules preceded with two pound characters (##).
- Rules cannot contain any escape characters.
- You do not have to specify a Generator ID (GID) when importing a local rule. If you do, specify only GID 1 for a standard text rule.
- When importing a rule for the first time, do not specify a Snort ID (SID) or revision number. This avoids collisions with SIDs of other rules, including deleted rules. The system will automatically assign the rule the next available custom rule SID of 1000000 or greater, and a revision number of 1.
- If you must import rules with SIDs, the SIDs must be unique numbers between 1,000,000 and 9,999,999.
In a multidomain deployment, the system assigns SIDs to imported rules from a shared pool used by all domains on the Firepower Management Center. If multiple administrators are importing local rules at the same time, SIDs within an individual domain might appear to be non-sequential, because the system assigned the intervening numbers in the sequence to another domain.

- When importing an updated version of a local rule you have previously imported, or when reinstating a local rule you have deleted, you must include the SID assigned by the system and a revision number greater than the current revision number. You can determine the revision number for a current or deleted rule by editing the rule.

  **Note**
  The system automatically increments the revision number when you delete a local rule; this is a device that allows you to reinstate local rules. All deleted local rules are moved from the local rule category to the deleted rule category.

- The import fails if a rule contains any of the following:
  - A SID greater than 2147483647.
  - A list of source or destination ports that is longer than 64 characters.

- Policy validation fails if you enable an imported local rule that uses the deprecated threshold keyword in combination with the intrusion event thresholding feature in an intrusion policy.

- All imported local rules are automatically saved in the local rule category.

- The system always sets local rules that you import to the disabled rule state. You must manually set the state of local rules before you can use them in your intrusion policy.

**Import Local Intrusion Rules**

- Make sure your local rule file follows the guidelines described in Guidelines for Importing Local Intrusion Rules, on page 128.

- Make sure your process for importing local intrusion rules complies with your security policies.

- Consider the import's effect on traffic flow and inspection due to bandwidth constraints and Snort restarts. We recommend scheduling rule updates during maintenance windows.

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Use this procedure to import local intrusion rules. Imported intrusion rules appear in the local rule category in a disabled state.

**Procedure**

**Step 1** Choose System > Updates, then click the Rule Updates tab.

**Step 2** (Optional) Delete existing local rules.
Click **Delete All Local Rules**, then confirm that you want to move all created and imported intrusion rules to the deleted folder.

**Step 3** Under **One-Time Rule Update/Rules Import**, choose **Rule update or text rule file...**, then click **Choose File** and browse to your local rule file.

**Step 4** Click **Import**.

**Step 5** Monitor import progress in the Message Center.

To display the Message Center, click the System Status icon on the menu bar. Even if the Message Center shows no progress for several minutes or indicates that the import has failed, do not restart the import. Instead, contact Cisco TAC.

---

**What to do next**

- Edit intrusion policies and enable the rules you imported.
- Deploy configuration changes; see **Deploy Configuration Changes, on page 277**.

---

**Rule Update Log**

The Firepower Management Center generates a record for each rule update and local rule file that you import. Each record includes a time stamp, the name of the user who imported the file, and a status icon indicating whether the import succeeded or failed. You can maintain a list of all rule updates and local rule files that you import, delete any record from the list, and access detailed records for all imported rules and rule update components.

The Rule Update Import Log detailed view lists a detailed record for each object imported in a rule update or local rule file. You can also create a custom workflow or report from the records listed that includes only the information that matches your specific needs.

---

**Intrusion Rule Update Log Table**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>The name of the import file. If the import fails, a brief statement of the reason for the failure appears under the file name.</td>
</tr>
<tr>
<td>Time</td>
<td>The time and date that the import started.</td>
</tr>
<tr>
<td>User ID</td>
<td>The user name of the user that triggered the import.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Status</td>
<td>Whether the import:</td>
</tr>
<tr>
<td></td>
<td>• succeeded (✔️)</td>
</tr>
<tr>
<td></td>
<td>• failed or is currently in progress (❌)</td>
</tr>
<tr>
<td></td>
<td>The red status icon indicating an unsuccessful or incomplete import appears on the Rule Update Log page during the import and is replaced by the green icon only when the import has successfully completed.</td>
</tr>
</tbody>
</table>

**Tip**
You can view import details as they appear while an intrusion rule update import is in progress.

### Viewing the Intrusion Rule Update Log

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose System > Updates.

**Tip** You can also click Import Rules on the intrusion rules editor page (Objects > Intrusion Rules).

**Step 2** Click the Rule Updates tab.

**Step 3** Click Rule Update Log.

**Step 4** You have two options:

- **View details** — To view details for each object imported in a rule update or local rule file, click view icon (🔍) next to the file you want to view; see Viewing Details of the Intrusion Rule Update Import Log, on page 133.
- **Delete** — To delete an import file record from the import log, including detailed records for all objects included with the file, click the delete icon (🗑️) next to the import file name.

**Note** Deleting the file from the log does not delete any object imported in the import file, but only deletes the import log records.
Fields in an Intrusion Rule Update Log

**Tip**
You search the entire Rule Update Import Log database even when you initiate a search by clicking **Search** on the toolbar from the Rule Update Import Log detailed view with only the records for a single import file displayed. Make sure you set your time constraints to include all objects you want to include in the search.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action</strong></td>
<td>An indication that one of the following has occurred for the object type:</td>
</tr>
<tr>
<td></td>
<td>• new (for a rule, this is the first time the rule has been stored on this appliance)</td>
</tr>
<tr>
<td></td>
<td>• changed (for a rule update component or rule, the rule update component has been modified, or the rule has a higher revision number and the same GID and SID)</td>
</tr>
<tr>
<td></td>
<td>• collision (for a rule update component or rule, import was skipped because its revision conflicts with an existing component or rule on the appliance)</td>
</tr>
<tr>
<td></td>
<td>• deleted (for rules, the rule has been deleted from the rule update)</td>
</tr>
<tr>
<td></td>
<td>• enabled (for a rule update edit, a preprocessor, rule, or other feature has been enabled in a default policy provided with the system)</td>
</tr>
<tr>
<td></td>
<td>• disabled (for rules, the rule has been disabled in a default policy provided with the system)</td>
</tr>
<tr>
<td></td>
<td>• drop (for rules, the rule has been set to Drop and Generate Events in a default policy provided with the system)</td>
</tr>
<tr>
<td></td>
<td>• error (for a rule update or local rule file, the import failed)</td>
</tr>
<tr>
<td></td>
<td>• apply (the <strong>Reapply all policies after the rule update import completes</strong> option was enabled for the import)</td>
</tr>
<tr>
<td><strong>Default Action</strong></td>
<td>The default action defined by the rule update. When the imported object type is rule, the default action is Pass, Alert, or Drop. For all other imported object types, there is no default action.</td>
</tr>
<tr>
<td><strong>Details</strong></td>
<td>A string unique to the component or rule. For rules, the GID, SID, and previous revision number for a changed rule, displayed as previously (GID:SID:Rev). This field is blank for a rule that has not changed.</td>
</tr>
<tr>
<td><strong>Domain</strong></td>
<td>The domain whose intrusion policies can use the updated rule. Intrusion policies in descendant domains can also use the rule. This field is only present in a multidomain deployment.</td>
</tr>
<tr>
<td><strong>GID</strong></td>
<td>The generator ID for a rule. For example, 1 (standard text rule) or 3 (shared object rule).</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>The name of the imported object, which for rules corresponds to the rule Message field, and for rule update components is the component name.</td>
</tr>
<tr>
<td><strong>Policy</strong></td>
<td>For imported rules, this field displays All. This means that the rule was imported successfully, and can be enabled in all appropriate default intrusion policies. For other types of imported objects, this field is blank.</td>
</tr>
<tr>
<td><strong>Rev</strong></td>
<td>The revision number for a rule.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Rule Update** | The rule update file name.
**SID** | The SID for a rule.
**Time** | The time and date the import began.

**Type**
The type of imported object, which can be one of the following:

- **rule update component** (an imported component such as a rule pack or policy pack)
- **rule** (for rules, a new or updated rule; note that in Version 5.0.1 this value replaced the *update* value, which is deprecated)
- **policy apply** (the *Reapply all policies after the rule update import completes* option was enabled for the import)

**Count**
The count (1) for each record. The Count field appears in a table view when the table is constrained, and the Rule Update Log detailed view is constrained by default to rule update records. This field is not searchable.

---

### Viewing Details of the Intrusion Rule Update Import Log

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

1. **Step 1** Choose *System* > *Updates*.
2. **Step 2** Click the *Rule Updates* tab.
3. **Step 3** Click *Rule Update Log*.
4. **Step 4** Click the view icon (🔍) next to the file whose detailed records you want to view.
5. **Step 5** You can take any of the following actions:
   - **Bookmark** — To bookmark the current page, click *Bookmark This Page*.
   - **Edit Search** — To open a search page prepopulated with the current single constraint, choose *Edit Search* or *Save Search* next to Search Constraints.
   - **Manage bookmarks** — To navigate to the bookmark management page, click *Report Designer*.
   - **Report** — To generate a report based on the data in the current view, click *Report Designer*.
   - **Search** — To search the entire Rule Update Import Log database for rule update import records, click *Search*.
   - **Sort** — To sort and constain records on the current workflow page, see *Using Drill-Down Pages, on page 1531* for more information.
• Switch workflows — To temporarily use a different workflow, click (switch workflows).

Maintain Your Air-Gapped Deployment

If your Firepower system is not connected to the internet, essential updates will not occur automatically. You must manually obtain and install these updates. See the following information:

• Update the Vulnerability Database (VDB) Manually, on page 121
• Update Intrusion Rules One-Time Manually, on page 126
• Manually Update the GeoDB (No Internet Connection), on page 123
• The Firepower Management Center Software Upgrade Guide at
Backup and Restore

About Backup and Restore

The ability to recover from a disaster is an essential part of any system maintenance plan. As part of your disaster recovery plan, we recommend that you perform periodic backups.

You can use the FMC to back up itself and the 7000/8000 series devices it manages. You can also use the 7000/8000 series local GUI to back up an individual device.

Note

Especially before you upgrade, we strongly recommend you back up to a remote location and verify transfer success. When you upgrade an appliance, it purges locally stored backups. For more information, see Remote Storage Management, on page 461.

The following table summarizes Firepower backup capabilities.
### Table 20: Firepower Backup Capabilities

<table>
<thead>
<tr>
<th>Platform</th>
<th>Backed Up Data</th>
<th>Save Backup To</th>
</tr>
</thead>
</table>
| Firepower Management Center | Any of:  
• Configurations  
• Events (does not include captured file data) | FMC  
or  
Remote storage  
In a multidomain deployment you cannot back up only events. You must also back up configurations. |
| 7000/8000 series         | Configurations                                                                 | If backed up on the FMC GUI, save to the device and optionally the FMC, or save to remote storage.  
If backed up on the device GUI, save to the device only. |
| NGIPSv                   | Not supported.  
If you need to replace one of these devices, you must manually recreate device-specific configurations.  
However, backing up the FMC does back up policies and other configurations that you deploy to managed devices, as well as events already transmitted from the devices to the FMC. |
| ASA FirePOWER            |                                                                                 |                                     |

### Guidelines and Limitations for Backup and Restore

Note the following guidelines and limitations for backup and restore on the Firepower Management Center and the 7000 & 8000 Series device:

- The backup file must not be manually modified for the restore and upgrade process to function properly. You must ensure there is no unauthorized access to the backup file.

- While the system collects backup data, there may be a temporary pause in data correlation, and the system may prevent you from changing configurations related to the backup.

- You can restore a backup onto a replacement appliance or device only if the two appliances or devices are the same model and are running the same version of the Firepower System software.

- On Firepower Management Centers, the backup and restore functions are available only in the Global domain. You can use the export and import functions as substitutes for backup and restore within the scope of a subdomain.

- Cisco recommends that you backup your Firepower Management Center if you make any modifications to Specific or Permanent License Reservation.

- Do not use the backup and restore process to copy configurations between appliances or devices. A backup file contains information that uniquely identifies an appliance, and cannot be shared.
• After you restore a Firepower Management Center, you must apply the latest intrusion rule update.

• Private keys associated with PKI objects are encrypted with a randomly generated key when stored on the appliance. If you perform a backup that contains private keys associated with PKI objects, the private keys are decrypted before being included in the unencrypted backup file. Store the backup file in a secure location.

• If you restore a backup that contains private keys associated with PKI objects, the system encrypts the keys with a randomly generated key before storing them on the appliance.

• If you restore a backup that includes a file policy with either a clean list or custom detection list enabled, the system merges any existing file lists(s) with the file lists(s) being restored.

• If you perform a backup, then delete reviewed intrusion events, then restore using that backup, the system restores the deleted intrusion events but does not restore their reviewed status. You view those restored intrusion events under Intrusion Events, not under Reviewed Events.

• If you restore a backup that contains intrusion event data on an appliance that already contains that data, duplicate events are created. To avoid this, restore intrusion event backups only on appliances without prior intrusion event data.

**Back up the Firepower Management Center**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

Use this procedure to back up the Firepower Management Center.

**Before you begin**

Ensure the FMC has enough disk space; backups may fail if the backup process uses more than 90% of available disk space. If necessary, delete old backup files, transfer old backup files off the appliance, or use remote storage; see Remote Storage Management, on page 461.

**Procedure**

**Step 1** Select System > Tools > Backup/Restore.

**Step 2** Click Firepower Management Backup.

**Step 3** Type a Name.

**Step 4** Choose what to back up:

• To archive the configuration, select Back Up Configuration. In a multidomain deployment, you cannot disable this option.

• To archive the entire event database, select Back Up Events.

**Step 5** If you want to be notified when the backup is complete, select the Email check box and type your email address in the accompanying text box.
To receive email notifications, you must configure a relay host as described in Configuring a Mail Relay Host and Notification Address, on page 472.

**Step 6** To use secure copy (SCP) to copy the backup archive to a different machine, select the **Copy when complete** check box, then type the following information in the accompanying text boxes:

- In the **Host** field, the hostname or IP address of the machine where you want to copy the backup
- In the **Path** field, the path to the directory where you want to copy the backup
- In the **User** field, the user name you want to use to log into the remote machine
- In the **Password** field, the password for that user name. If you prefer to access your remote machine with an SSH public key instead of a password, you must copy the contents of the **SSH Public Key** field to the specified user’s `authorized_keys` file on that machine.

With this option cleared, the system stores temporary files used during the backup on the remote server; temporary files are **not** stored on the remote server when this option is selected. Cisco recommends that you periodically save backups to a remote location so the appliance can be restored in case of system failure.

**Step 7** You have the following options:

- To save the backup file to the appliance, click **Start Backup**. The backup file is saved in the `/var/sf/backup` directory.
- To save this configuration as a backup profile that you can use later, click **Save As New**.

---

**What to do next**

Store the backup file in a secure location if it contains PKI object data, as the private keys are stored unencrypted within the backup.

---

**Back up 7000 & 8000 Series Devices Remotely**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

Use this procedure to perform a remote device backup with the Firepower Management Center.

**Before you begin**

Ensure you have enough disk space. Backups may fail if the backup process uses more than 90% of available disk space. If necessary, delete or transfer old backup files, or use remote storage; see Remote Storage Management, on page 461.

**Procedure**

**Step 1** Select **System > Tools > Backup/Restore**.
Step 2  Click Managed Device Backup.
Step 3  Choose one or more Managed Devices.
Step 4  To back up event data that has not yet been sent to the FMC, select Include All Unified Files.
Step 5  Specify where you want to save backup files by enabling or disabling Retrieve to Management Center.
   • Enabled: Saves device backups to the device, and also copies the file to the FMC.
   • Disabled (default): Saves device backups on the device only.

If you configured remote backup storage, backup files are saved remotely and this option has no effect.

Step 6  Click Start Backup.

What to do next
Locate the backup file using the following information:
• The backup file is saved in the /var/sf/backup directory on the device. If you choose to save a copy of the backup file on the Firepower Management Center, it is saved in the /var/sf/remote-backup directory on the FMC.

Note
If the backup contains PKI object data, store the backup in a secure location, as the private keys are stored unencrypted within the backup.

---

**Back up 7000 & 8000 Series Devices Locally**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>N/A</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You must perform this procedure using the 7000 or 8000 Series device's local web interface.

**Before you begin**
Ensure your appliance has enough disk space; backups may fail if the backup process uses more than 90% of available disk space. If necessary, delete old backup files, or transfer old backup files off the appliance.

**Procedure**

Step 1  Select System > Tools > Backup/Restore.
Step 2  Click Device Backup.
Step 3  In the Name field, type a name for the backup file.
Step 4  If you want to be notified when the backup is complete, select the Email check box and type your email address in the accompanying text box.
To receive email notifications, you must configure a relay host as described in Configuring a Mail Relay Host and Notification Address, on page 472.

**Step 5** If you want to use secure copy (SCP) to copy the backup archive to a different machine, select the **Copy when complete** check box, then type the following information in the accompanying text boxes:

- In the **Host** field, the hostname or IP address of the machine where you want to copy the backup.
- In the **Path** field, the path to the directory where you want to copy the backup.
- In the **User** field, the user name you want to use to log into the remote machine.
- In the **Password** field, the password for that user name. If you prefer to access your remote machine with an SSH public key instead of a password, you must copy the contents of the SSH Public Key field to the specified user's authorized_keys file on that machine.

With this option cleared, the system stores temporary files used during the backup on the remote server; temporary files are not stored on the remote server when this option is selected. Cisco recommends that you periodically save backups to a remote location so the appliance can be restored in case of system failure.

**Step 6** You have the following options:

- To save the backup file to the appliance, click **Start Backup**. The backup file is saved in the /var/sf/backup directory.
- To save this configuration as a backup profile that you can use later, click **Save As New**.

---

**What to do next**

Store the backup file in a secure location if it contains PKI object data, as the private keys are stored unencrypted within the backup.

---

**Create Backup Profiles**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You must perform this procedure using the device's web user interface or the Firepower Management Center web interface, as applicable.

You can create backup profiles that contain the settings that you want to use for different types of backups. You can later select one of these profiles when you back up the files on your appliance.

**Tip** When you create a backup file for a Firepower Management Center using a new file name, the system automatically creates a backup profile with that name.
Procedure

Step 1 Select System > Tools > Backup/Restore.
Step 2 Click the Backup Profiles tab.
Step 3 Click Create Profile.
Step 4 Type a name for the backup profile.
Step 5 Configure the backup profile.

See Back up the Firepower Management Center, on page 137 for information on your options.
Step 6 Click Save As New to save the backup profile.

Upload a Backup File

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7000 &amp; 8000 Series</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can upload a backup file from your local host to a Firepower Management Center, 7000 Series device or a 8000 Series device using the Firepower Management Center web interface or the device's local web interface respectively.

If your backup file contains PKI objects, on upload the system re-encrypts private keys associated with internal CA and internal certificate objects with a randomly generated key.

Before you begin
- Download a backup file to your local host using the download function as described in The Backup Management Page, on page 142.
- Copy backups larger than 4GB from your local host via SCP to a remote host and retrieve it from there to your Firepower Management Center, as web browsers do not support uploading files that large. See Remote Storage Management, on page 461 for more information.

Procedure

Step 1 Select System > Tools > Backup/Restore.
Step 2 Click Upload Backup.
Step 3 Click Browse, then navigate to and select the backup file you want to upload.
Step 4 Click Upload Backup.
Step 5 Click Backup Management to return to the Backup Management page.
The Backup Management Page

You can access the **Backup Management** page on the Firepower Management Center web interface at **System > Tools > Backup/Restore > Backup Management**.

If your backup file contains PKI objects, on upload the system re-encrypts private keys associated with internal CA and internal certificate objects with a randomly generated key.

If you use local storage, backup files are saved to `/var/sf/backup`, which is listed with the amount of disk space used in the `/var` partition at the bottom of the Backup Management page. On Firepower Management Centers, select **Remote Storage** at the top of the Backup Management page to configure remote storage options; then, to enable remote storage, select the **Enable Remote Storage for Backups** check box on the Backup Management page. If you use remote storage, the protocol, backup system, and backup directory are listed at the bottom of the page.

The following table describes each column and button on the Backup Management page.

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Information</td>
<td>The originating appliance name, type, and version</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>you can only restore a backup to an identical appliance type and version.</td>
</tr>
<tr>
<td>Date Created</td>
<td>The date and time that the backup file was created</td>
</tr>
<tr>
<td>File Name</td>
<td>The full name of the backup file</td>
</tr>
<tr>
<td>VDB Version</td>
<td>The build of the vulnerability database (VDB) running on the appliance at the time of backup.</td>
</tr>
<tr>
<td>Location</td>
<td>The location of the backup file</td>
</tr>
<tr>
<td>Size (MB)</td>
<td>The size of the backup file, in megabytes</td>
</tr>
<tr>
<td>Events?</td>
<td>“Yes” indicates the backup includes event data</td>
</tr>
<tr>
<td>View</td>
<td>Click the name of the backup file to view a list of the files included in the compressed backup file.</td>
</tr>
<tr>
<td>Restore</td>
<td>Click with the backup file selected to restore it on the appliance. If your VDB version does not match the VDB version in the backup file, this option is disabled. For more information, see Restore from Backup: FMC and 7000/8000 Series, on page 143</td>
</tr>
<tr>
<td>Download</td>
<td>Click with the backup file selected to save it to your local computer.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click with the backup file selected to delete it.</td>
</tr>
</tbody>
</table>
Functionality | Description
--- | ---
Move | On a Firepower Management Center, when you have a previously created local backup selected, click to send the backup to the designated remote backup location.

### Restore from Backup: FMC and 7000/8000 Series

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You can restore a Firepower Management Center, 7000 Series device or 8000 Series device from backup files using the **Backup Management** page on the Firepower Management Center web interface or the device's web interface.

⚠️ **Caution**

This action overwrites all configuration files and, on the managed device, all event data.

✏️ **Note**

If you add licenses after a backup has completed, these licenses will not be removed or overwritten if this backup is restored. To prevent a conflict on restore, remove those licenses before restoring the backup, noting where the licenses were used, and add and reconfigure them after restoring the backup. If a conflict occurs, contact Support.

**Before you begin**

- Confirm that the VDB version in the backup file matches the current VDB version on your appliance. See [Viewing Dashboards](#) on page 217 for more information.

- Remove any licenses added to your appliance after a backup has completed before restoring the backup to avoid a conflict on restore. See [About Firepower Licenses](#) on page 105 for more information.

- Confirm the appliance does not have the same intrusion event data as stored in the backup, because restoring the backup under such conditions creates duplicate events. See [About Intrusion Events](#) on page 1621 for more information.

**Procedure**

1. **Step 1** Select System > Tools > Backup/Restore.
2. **Step 2** Click on the backup file to view its contents. Details include file owner, file permissions, file size, and date.
3. **Step 3** Select System > Tools > Backup/Restore to return to the Backup Management page.
4. **Step 4** Select the backup file that you want to restore.
Step 5  Click Restore.

Note If the VDB version in the backup does not match the VDB version currently installed on your appliance, the Restore button is grayed out.

Step 6  To restore files, select either or both of the following options:

- **Restore Configuration Data**
  
  Note When you restore the configuration of a managed device from a backup file, any device configuration changes you made from the device’s managing Firepower Management Center will also be restored. Restoring a backup file will overwrite changes you made after you created that backup file.

- **Restore Event Data** (FMC only)

Step 7  Click Restore.

Step 8  (Optional) Wait for the system to reboot automatically.

The system reboots automatically only if the backup contains configuration data.

---

**What to do next**

- Import the latest Cisco Rule Update; see Update Intrusion Rules One-Time Manually, on page 126. If you re-deploy policies as part of the import, you do not need to deploy configuration changes (below).

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

- Add and reconfigure any licenses you removed from your appliance before restoring the backup.

- Contact Support if your appliance shows a license conflict on restore.
CHAPTER 8

Configuration Import and Export

The following topics explain how to use the Import/Export feature:

- About Configuration Import/Export, on page 145
- Exporting Configurations, on page 147
- Importing Configurations, on page 148

About Configuration Import/Export

You can use the Import/Export feature to copy configurations between appliances. Import/Export is not a backup tool, but can simplify the process of adding new appliances to your deployment.

You can export a single configuration, or you can export a set of configurations (of the same type or of different types) with a single action. When you later import the package onto another appliance, you can choose which configurations in the package to import.

An exported package contains revision information for that configuration, which determines whether you can import that configuration onto another appliance. When the appliances are compatible but the package includes a duplicate configuration, the system offers resolution options.

Note

The importing and exporting appliances must be running the same version of the Firepower System. For access control and its subpolicies (including intrusion policies), the intrusion rule update version must also match. If the versions do not match, the import fails. You cannot use the Import/Export feature to update intrusion rules. Instead, download and apply the latest rule update version.

Configurations that Support Import/Export

Import/Export is supported for the following configurations:

- Access control policies and the policies they invoke: network analysis, intrusion, SSL, file
- Intrusion policies, independently of access control
- Platform settings
- Health policies
- Alert responses
• Application detectors (both user-defined and those provided by Cisco Professional Services)
• Dashboards
• Custom tables
• Custom workflows
• Saved searches
• Custom user roles
• Report templates
• Third-party product and vulnerability mappings

Special Considerations for Configuration Import/Export

When you export a configuration, the system also exports other required configurations. For example, exporting an access control policy also exports any subpolicies it invokes, objects and object groups it uses, ancestor policies (in a multidomain deployment), and so on. As another example, if you export a platform settings policy with external authentication enabled, the authentication object is exported as well. There are some exceptions, however:

• System-provided databases and feeds—The system does not export URL filtering category and reputation data, Cisco Intelligence Feed data, or the geolocation database (GeoDB). Make sure all the appliances in your deployment obtain up-to-date information from Cisco.

• Global Security Intelligence lists—The system exports Global Security Intelligence blacklists and whitelists associated with exported configurations. (In a multidomain deployment, this occurs regardless of your current domain. The system does not export descendant domain lists.) The export process converts these blacklists and whitelists to user-created lists, then uses those new lists in the imported configurations. This ensures that imported lists do not conflict with existing Global blacklists and whitelists. To use Global lists on the importing Firepower Management Center in your imported configurations, add them manually.

• Intrusion policy shared layers—The export process breaks intrusion policy shared layers. The previously shared layer is included in the package, and imported intrusion policies do not contain shared layers.

• Intrusion policy default variable set—The export package includes a default variable set with custom variables and system-provided variables with user-defined values. The import process updates the default variable set on the importing Firepower Management Center with the imported values. However, the import process does not delete custom variables not present in the export package. The import process also does not revert user-defined values on the importing Firepower Management Center, for values not set in the export package. Therefore, an imported intrusion policy may behave differently than expected if the importing Firepower Management Center has differently configured default variables.

• Custom user objects—If you have created custom user groups or objects in your Firepower Management Center and if such a custom user object is a part of any rule in your access control policy, note that the export file (.sfo) does not carry the user object information and therefore while importing such a policy, any reference to such custom user objects will be removed and will not be imported to the destination Firepower Management Center. To avoid detection issues due to the missing user group, add the customized user objects manually to the new Firepower Management Center and re-configure the access control policy after import.
When you import objects and object groups:

- The import process imports objects and groups as new. You cannot replace existing objects and groups.
- If the names of imported objects match existing objects on the importing Firepower Management Center, the system appends autogenerated numbers to the imported object and group names to make them unique.
- You must map any security zones used in the imported configurations to matching-type zones managed by the importing Firepower Management Center.
- If you export a configuration that uses PKI objects containing private keys, the system decrypts the private keys before export. On import, the system encrypts the keys with a randomly generated key.

## Exporting Configurations

### Table: Exporting Configurations

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Depending on the number of configurations being exported and the number of objects those configurations reference, the export process may take several minutes.

### Tip

Many list pages in the Firepower System include an export icon (Export) next to list items. Where this icon is present, you can use it as a quick alternative to the export procedure that follows.

### Before you begin

- Confirm that the importing and exporting appliances are running the same version of the Firepower System. For access control and its subpolicies (including intrusion policies), the intrusion rule update version must also match.

### Procedure

**Step 1** Choose **System > Tools > Import/Export**.

Click the collapse (·) and expand (·) icons to collapse and expand the list of available configurations.

**Step 2** Check the configurations you want to export and click **Export**.

**Step 3** Follow your web browser’s prompts to save the exported package to your computer.
Importing Configurations

**Before you begin**

- Confirm that the importing and exporting appliances are running the same version of the Firepower System. For access control and its subpolicies (including intrusion policies), the intrusion rule update version must also match.

- Create security zones on an importing Firepower Management Center whose types match the zone types in an access control policy to be imported. For information, see Security Zones, on page 331.

**Procedure**

**Step 1** On the importing appliance, choose System > Tools > Import/Export.

**Step 2** Click Upload Package.

**Step 3** Enter the path to the exported package or browse to its location, then click Upload.

**Step 4** If there are no version mismatches or other issues, choose the configurations you want to import, then click Import.

If you do not need to perform any conflict resolution or security zone mapping, the import completes and a success message appears. Skip the rest of this procedure.

**Step 5** If prompted, on the Access Control Import Resolution page, map security zones used in the imported configurations to zones with matching interface types managed by the importing Firepower Management Center.

**Step 6** Click Import.

**Step 7** If prompted, on the Import Resolution page, expand each configuration and choose the appropriate option as described in Import Conflict Resolution, on page 148.

**Step 8** Click Import.

**Import Conflict Resolution**

When you attempt to import a configuration, the system determines whether a configuration of the same name and type already exists on the appliance. In a multidomain deployment, the system also determines whether a configuration is a duplicate of a configuration defined in the current domain or any of its ancestor or descendant domains. (You cannot view configurations in descendant domains, but if a configuration with a duplicate name exists in a descendant domain, the system notifies you of the conflict.) When an import includes a duplicate configuration, the system offers resolution options suitable to your deployment from among the following:

---

### Table: Access and Supported Domains

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Depending on the number of configurations being imported and the number of objects those configurations reference, the import process may take several minutes.
**Keep existing**

The system does not import that configuration.

**Replace existing**

The system overwrites the current configuration with the configuration selected for import.

**Keep newest**

The system imports the selected configuration only if its timestamp is more recent than the timestamp on the current configuration on the appliance.

**Import as new**

The system imports the selected duplicate configuration, appending a system-generated number to the name to make it unique. (You can change this name before completing the import process.) The original configuration on the appliance remains unchanged.

The resolution options the system offers depends on whether your deployment uses domains, and whether the imported configuration is a duplicate of a configuration defined in the current domain, or a configuration defined in an ancestor or descendant of the current domain. The following table lists when the system does or does not present a resolution option.

<table>
<thead>
<tr>
<th>Resolution Option</th>
<th>Firepower Management Center</th>
<th>Managed Device</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Duplicate in current domain</td>
<td>Duplicate in ancestor or descendant domain</td>
</tr>
<tr>
<td>Keep existing</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Replace existing</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Keep newest</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Import as new</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

When you import an access control policy with a file policy that uses clean or custom detection file lists and a file list presents a duplicate name conflict, the system offers conflict resolution options as described in the table above, but the action the system performs on the policies and file lists varies as described in the table below:

<table>
<thead>
<tr>
<th>Resolution Option</th>
<th>System Action</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Access control policy and its associated file policy are imported as new and the file lists are merged</td>
<td>Existing access control policy and its associated file policy and file lists remain unchanged</td>
</tr>
<tr>
<td>Keep existing</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Replace existing</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Import as new</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
### Import Conflict Resolution

<table>
<thead>
<tr>
<th>Resolution Option</th>
<th>System Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access control policy and its associated file policy are imported as new and the file lists are merged</td>
<td>Existing access control policy and its associated file policy and file lists remain unchanged</td>
</tr>
<tr>
<td>Keep newest and access control policy being imported is the newest</td>
<td>Yes</td>
</tr>
<tr>
<td>Keep newest and existing access control policy is the newest</td>
<td>No</td>
</tr>
</tbody>
</table>

If you modify an imported configuration on an appliance, and later re-import that configuration to the same appliance, you must choose which version of the configuration to keep.
Task Scheduling

The following topics explain how to schedule tasks:

- About Task Scheduling, on page 151
- Configuring a Recurring Task, on page 151
- Scheduled Task Review, on page 167

About Task Scheduling

You can schedule many different types of administrative tasks to run at designated times, either once or on a recurring basis.

Note

Some tasks (such as those involving automated software updates or that require pushing updates to managed devices) may place a significant load on networks with low bandwidths. You should schedule tasks like these to run during periods of low network use.

Configuring a Recurring Task

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Task dependent</td>
<td>Task dependent</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You set the frequency for a recurring task using the same process for all types of tasks.

Note that the time displayed on most pages on the web interface is the local time, which is determined by using the time zone you specify in your local configuration. Further, the Firepower Management Center automatically adjusts its local time display for daylight saving time (DST), where appropriate. However, recurring tasks that span the transition dates from DST to standard time and back do not adjust for the transition. That is, if you create a task scheduled for 2:00 AM during standard time, it will run at 3:00 AM during DST. Similarly, if you create a task scheduled for 2:00 AM during DST, it will run at 1:00 AM during standard time.
Procedure

Step 1  Select System > Tools > Scheduling.
Step 2  Click Add Task.
Step 3  From the Job Type drop-down list, select the type of task that you want to schedule.
Step 4  Click the Recurring radio button next to the Schedule task to run option.
Step 5  In the Start On field, specify the date when you want to start your recurring task.
Step 6  In the Repeat Every field, specify how often you want the task to recur.
   You can either type a number or click the up icon (▲) and the down (▼) icon to specify the interval. For example, type 2 and click the Days radio button to run the task every two days.
Step 7  In the Run At field, specify the time when you want to start your recurring task.
Step 8  For a task to be run on a weekly or monthly basis, select the days when you want to run the task in the Repeat On field.
Step 9  Select the remaining options for the type of task you are creating:
   • Backup - Schedule backup jobs as described in Automating Firepower Management Center Backups, on page 153.
   • Download CRL - Schedule certificate revocation list downloads as described in Configuring Certificate Revocation List Downloads, on page 154.
   • Deploy Policies - Schedule policy deployment as described in Automating Policy Deployment, on page 155.
   • Nmap Scan - Schedule Nmap scans as described in Scheduling an Nmap Scan, on page 156.
   • Report - Schedule report generation as described in Automating Report Generation, on page 157
   • Firepower Recommended Rules - Schedule automatic update of Firepower recommended rules as described in Automating Firepower Recommendations, on page 159
   • Download Latest Update - Schedule software or VDB update downloads as described in Automating Software Downloads, on page 161 or Automating VDB Update Downloads, on page 164.
   • Install Latest Update - Schedule installation of software or VDB updates on a Firepower Management Center or managed device as described in Automating Software Installs, on page 162 or Automating VDB Update Installs, on page 165
   • Push Latest Update - Schedule push of software updates to managed devices as described in Automating Software Pushes, on page 162.
   • Update URL Filtering Database - Scheduling automatic update of URL filtering data as described in Automating URL Filtering Updates Using a Scheduled Task, on page 166

Backup Automation

You can use the scheduler on the Firepower Management Center to automate its own backups.
You cannot schedule a device backup from the FMC. However, you can use the FMC to perform on-demand backups of 7000/8000 series devices. You can also use the 7000/8000 series local GUI to schedule backups of an individual device. For more information, see Backup and Restore, on page 135.

Related Topics
Requirements for Backup and Restore

Automating Firepower Management Center Backups

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

Use this procedure to automate backups of the Firepower Management Center.

Before you begin
Create a backup profile. See Create Backup Profiles, on page 140.

Procedure

**Step 1** Select System > Tools > Scheduling.

**Step 2** Click Add Task.

**Step 3** From the Job Type list, select Backup.

**Step 4** Specify how you want to schedule the backup, Once or Recurring:

- For one-time tasks, use the drop-down lists to specify the start date and time.
- For recurring tasks, see Configuring a Recurring Task, on page 151 for details.

**Step 5** Type a name In the Job Name field.

**Step 6** From the Backup Profile list, select the appropriate backup profile.

**Step 7** Optionally, type a Comment.

The comment field appears in the Task Details section of the schedule calendar page. Keep comments brief.

**Step 8** If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the Email Status To: field. You must have a valid email relay server configured to send status messages.

**Step 9** Click Save.

Related Topics
Configuring a Mail Relay Host and Notification Address, on page 472

Automating 7000 & 8000 Series Device Backups

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>N/A</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>
Use this procedure to schedule backups of an 7000 or 8000 Series device from the device's local web interface.

**Before you begin**
Create a backup profile. See *Create Backup Profiles, on page 140*

**Procedure**

**Step 1**  
On the device's web interface, select *System > Tools > Scheduling.*

**Step 2**  
Click *Add Task.*

**Step 3**  
From the *Job Type* list, select *Backup.*

**Step 4**  
Specify how you want to schedule the backup, *Once* or *Recurring:*

- For one-time tasks, use the drop-down lists to specify the start date and time.
- For recurring tasks, see *Configuring a Recurring Task, on page 151* for details.

**Step 5**  
Type a name in the *Job Name* field.

**Step 6**  
From the *Backup Profile* list, select the appropriate backup profile.

**Step 7**  
Optionally, type a *Comment.*

The comment field appears in the Task Details section of the schedule calendar page. Keep comments brief.

**Step 8**  
If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the *Email Status To:* field. You must have a valid email relay server configured to send status messages.

**Step 9**  
Click *Save.*

**Related Topics**
*Configuring a Mail Relay Host and Notification Address, on page 472*

### Configuring Certificate Revocation List Downloads

You must perform this procedure using the local web interface for the Firepower Management Center or the 7000 or 8000 Series device. In a multidomain deployment, this task is only supported in the Global domain for the Firepower Management Center.

The system automatically creates the Download CRL task when you enable downloading a certificate revocation list (CRL) in the local configuration on an appliance where you enable user certificates or audit log certificates for the appliance. You can use the scheduler to edit the task to set the frequency of the update.

**Before you begin**

- Enable and configure user certificates and set a CRL download URL. See *Requiring Valid User Certificates, on page 441* for more information.
Procedure

Step 1 Select System > Tools > Scheduling.
Step 2 Click Add Task.
Step 3 From the Job Type list, select Download CRL.
Step 4 Specify how you want to schedule the CRL download, Once or Recurring:
   - For one-time tasks, use the drop-down lists to specify the start date and time.
   - For recurring tasks, see Configuring a Recurring Task, on page 151 for details.

Step 5 Type a name In the Job Name field.
Step 6 If you want to comment on the task, type a comment in the Comment field.
   The comment field appears in the Task Details section of the schedule calendar page; keep comments brief.
Step 7 If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the Email Status To: field. You must have a valid email relay server configured on the Firepower Management Center to send status messages.
Step 8 Click Save.

Related Topics
   Configuring a Mail Relay Host and Notification Address, on page 472

Automating Policy Deployment

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

After modifying configuration settings in the FMC, you must deploy those changes to the affected devices. In a multidomain deployment, you can schedule policy deployments only for your current domain.

Caution

When you deploy, resource demands may result in a small number of packets dropping without inspection. Additionally, deploying some configurations restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 and Configurations that Restart the Snort Process When Deployed or Activated, on page 281.

Procedure

Step 1 Select System > Tools > Scheduling.
Step 2 Click Add Task.
Step 3 From the Job Type list, select Deploy Policies.
Step 4 Specify how you want to schedule the task, **Once** or **Recurring**:

- For one-time tasks, use the drop-down lists to specify the start date and time.
- For recurring tasks, see [Configuring a Recurring Task, on page 151](#) for details.

Step 5 Type a name in the **Job Name** field.

Step 6 In the **Device** field, select a device where you want to deploy policies.

Step 7 If you want to comment on the task, type a comment in the **Comment** field.

Step 8 If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the **Email Status To:** field. You must have a valid email relay server configured to send status messages.

Step 9 Click **Save**.

**Related Topics**

- [Configuring a Mail Relay Host and Notification Address](#), on page 472
- [Out-of-Date Policies](#), on page 286

### Nmap Scan Automation

You can schedule regular Nmap scans of targets on your network. Automated scans allow you to refresh information previously supplied by an Nmap scan. Because the Firepower System cannot update Nmap-supplied data, you need to rescan periodically to keep that data up to date. You can also schedule scans to automatically test for unidentified applications or servers on hosts in your network.

Note that a Discovery Administrator can also use an Nmap scan as a remediation. For example, when an operating system conflict occurs on a host, that conflict may trigger an Nmap scan. Running the scan obtains updated operating system information for the host, which resolves the conflict.

If you have not used the Nmap scanning capability before, you configure Nmap scanning before defining a scheduled scan.

**Related Topics**

- [Nmap Scanning](#), on page 1233

### Scheduling an Nmap Scan

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

After Nmap replaces a host’s operating system, applications, or servers detected by the system with the results from an Nmap scan, the system no longer updates the information replaced by Nmap for the host. Nmap-supplied service and operating system data remains static until you run another Nmap scan. If you plan to scan a host using Nmap, you may want to set up regularly scheduled scans to keep Nmap-supplied operating systems, applications, or servers up to date. If the host is deleted from the network map and re-added, any Nmap scan results are discarded and the system resumes monitoring of all operating system and service data for the host.
In a multidomain deployment:

- You can schedule scans only for your current domain
- The remediation and Nmap targets you select must exist at your current domain or an ancestor domain.
- Choosing to perform an Nmap scan on a non-leaf domain scans the same targets in each descendant of that domain.

**Procedure**

1. **Step 1** Select **System > Tools > Scheduling**.
2. **Step 2** Click **Add Task**.
3. **Step 3** From the **Job Type** list, select **Nmap Scan**.
4. **Step 4** Specify how you want to schedule the task, **Once** or **Recurring**:
   - For one-time tasks, use the drop-down lists to specify the start date and time.
   - For recurring tasks, see **Configuring a Recurring Task, on page 151** for details.
5. **Step 5** Type a name in the **Job Name** field.
6. **Step 6** In the **Nmap Remediation** field, select an Nmap remediation.
7. **Step 7** In the **Nmap Target** field, select the scan target.
8. **Step 8** In the **Domain** field, select the domain whose network map you want to augment.
9. **Step 9** If you want to comment on the task, type a comment in the **Comment** field.
   
   **Tip** The comment field appears in the Task Details section of the calendar schedule page; keep comments brief.
10. **Step 10** If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the **Email Status To:** field. You must have a valid email relay server configured to send status messages.
11. **Step 11** Click **Save**.

**Related Topics**

- **Configuring a Mail Relay Host and Notification Address**, on page 472

## Automating Report Generation

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You can automate reports so that they run at regular intervals.

In a multidomain deployment, you can schedule reports only for your current domain.
Before you begin

• Create a report template. See Report Templates, on page 1426 for more information.

• If you want to distribute email reports using the scheduler, configure a mail relay host and specify report recipients and message information. See Configuring a Mail Relay Host and Notification Address, on page 472 and Distributing Reports by Email at Generation Time, on page 1448.

• (Optional) Set or change the file name, output format, time window, or email distribution settings of the scheduled report. See Specify Report Generation Settings for a Scheduled Report, on page 158.

Procedure

| Step 1 | Select System > Tools > Scheduling. |
| Step 2 | Click Add Task. |
| Step 3 | From the Job Type list, select Report. |
| Step 4 | Specify how you want to schedule the task, Once or Recurring: |
| | • For one-time tasks, use the drop-down lists to specify the start date and time. |
| | • For recurring tasks, see Configuring a Recurring Task, on page 151 for details. |
| Step 5 | Type a name in the Job Name field. |
| Step 6 | In the Report Template field, select a report template. |
| Step 7 | If you want to comment on the task, type a comment in the Comment field. The comment field appears in the Tasks Details section of the schedule calendar page; keep comments brief. |
| Step 8 | If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the Email Status To: field. You must have a valid email relay server configured to send status messages. Note Configuring this option does not distribute the reports. |
| Step 9 | If you do not want to receive report email attachments when reports have no data (for example, when no events of a certain type occurred during the report period), select the If report is empty, still attach to email check box. |
| Step 10 | Click Save. |

Specify Report Generation Settings for a Scheduled Report

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

To specify or change the file name, output format, time window, or email distribution settings of a scheduled report:
**Procedure**

**Step 1** Select Overview > Reporting > Report Templates.

**Step 2** Click Edit for the report template to change.

**Step 3** Click Generate.

**Note** If you want to change report generation settings without generating the report now, you must click Generate from the template configuration page. Changes will not be saved if you click Generate from the template list view unless you generate the report.

**Step 4** Modify settings.

**Step 5** To save the new settings without generating the report, click Cancel.

To save the new settings and generate the report, click Generate and skip the rest of the steps in this procedure.

**Step 6** Click Save.

**Step 7** If you see a prompt to save even though you haven’t made changes, click OK.

---

**Automating Firepower Recommendations**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You can automatically generate rule state recommendations based on network discovery data for your network using the most recently saved configuration settings in a custom intrusion policy.

---

**Note**

If the system automatically generates scheduled recommendations for an intrusion policy with unsaved changes, you must discard your changes in that policy and commit the policy if you want the policy to reflect the automatically generated recommendations.

When the task runs, the system automatically generates recommended rule states, and modifies the states of intrusion rules based on the configuration of your policy. Modified rule states take effect the next time you deploy your intrusion policy.

In a multidomain deployment, you can automate recommendations for intrusion policies at the current domain level. The system builds a separate network map for each leaf domain. In a multidomain deployment, if you enable this feature in an intrusion policy in an ancestor domain, the system generates recommendations using data from all descendant leaf domains. This can enable intrusion rules tailored to assets that may not exist in all leaf domains, which can affect performance.

**Before you begin**

- Configure Firepower recommended rules in an intrusion policy as described in Generating and Applying Firepower Recommendations, on page 904

- If you want to email task status messages, configure a valid email relay server.
Procedure

**Step 1** Choose System > Tools > Scheduling.

**Step 2** Click Add Task.

**Step 3** From the Job Type list, choose Firepower Recommended Rules.

**Step 4** Specify how you want to schedule the task, Once or Recurring:
- For one-time tasks, use the drop-down lists to specify the start date and time.
- For recurring tasks, see Configuring a Recurring Task, on page 151 for details.

**Step 5** Enter a name in the Job Name field.

**Step 6** Next to Policies, choose one or more intrusion policies where you want to generate recommendations. Check the All Policies check box to choose all intrusion policies.

**Step 7** (Optional) Enter a comment in the Comment field.

Keep comments brief. Comments appear in the Task Details section of the schedule calendar page.

**Step 8** (Optional) To email task status messages, type an email address (or multiple email addresses separated by commas) in the Email Status To: field.

**Step 9** Click Save.

---

**Related Topics**
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846
- About Firepower Recommended Rules, on page 901
- Configuring a Mail Relay Host and Notification Address, on page 472

---

**Software Update Automation**

You can automatically download and apply most patches and feature releases to the Firepower System.

The tasks you must schedule to install software updates vary depending on whether you are updating the FMC or are using a FMC to update managed devices.

---

**Note**
Cisco strongly recommends that you use your FMCs to update the devices they manage.

- To update the FMC, schedule the software installation using the Install Latest Update task.
- To use a FMC to automate software updates for its managed devices, you must schedule two tasks:
  - Push (copy) the update to managed devices using the Push Latest Update task.
  - Install the update on managed devices using the Install Latest Update task.

When scheduling updates to managed devices, schedule the push and install tasks to happen in succession; you must first push the update to the device before you can install it. Allow enough time between tasks for the process to complete; schedule tasks at least 30 minutes apart. If you schedule a task to install an update and the update has not finished copying from the FMC to the device, the installation task will not
succeed. However, if the scheduled installation task repeats daily, it will install the pushed update when it runs the next day.

---

**Note**

You must manually upload and install updates in two situations. First, you cannot schedule major updates to the Firepower System. Second, you cannot schedule updates for or pushes from FMC that cannot access the Support Site. If your FMC is not directly connected to the Internet, you should use management interfaces configuration to set up a proxy to allow it to download updates from the Support Site.

Note that a task scheduled to install an update on a device group will install the pushed update to each device within the device group simultaneously. Allow enough time for the scheduled task to complete for each device within the device group.

If you want to have more control over this process, you can use the **Once** option to download and install updates during off-peak hours after you learn that an update has been released.

**Related Topics**
- Management Interfaces, on page 445
- About Firepower Updates, on page 119

---

### Automating Software Downloads

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You can create a scheduled task that automatically downloads the latest software updates from Cisco. You can use this task to schedule download of updates you plan to install manually.

**Procedure**

**Step 1** Select **System > Tools > Scheduling**.

**Step 2** Click **Add Task**.

**Step 3** From the **Job Type** list, select **Download Latest Update**.

**Step 4** Specify how you want to schedule the task, **Once** or **Recurring**:

- For one-time tasks, use the drop-down lists to specify the start date and time.
- For recurring tasks, see **Configuring a Recurring Task**, on page 151 for details.

**Step 5** Type a name in the **Job Name** field.

**Step 6** Next to **Update Items**, check the **Software** check box.

**Step 7** If you want to comment on the task, type a comment in the **Comment** field.

The comment field appears in the Task Details section of the schedule calendar page; keep comments brief.

**Step 8** If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the **Email Status To** field. You must have a valid email relay server configured to send status messages.
Automating Software Pushes

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

If you want to automate the installation of software updates on managed devices, you must push the updates to the devices before installing.

When you create the task to push software updates to managed devices, make sure you allow enough time between the push task and a scheduled install task for the updates to be copied to the device.

Procedure

Step 1 Select System > Tools > Scheduling.
Step 2 Click Add Task.
Step 3 From the Job Type list, select Push Latest Update.
Step 4 Specify how you want to schedule the task, Once or Recurring:
  • For one-time tasks, use the drop-down lists to specify the start date and time.
  • For recurring tasks, see Configuring a Recurring Task, on page 151 for details.
Step 5 Type a name in the Job Name field.
Step 6 From the Device drop-down list, select the device that you want to update.
Step 7 If you want to comment on the task, type a comment in the Comment field.
  The comment field appears in the Task Details section of the schedule calendar page; keep comments brief.
Step 8 If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the Email Status To: field. You must have a valid email relay server configured to send status messages.
Step 9 Click Save.

Related Topics
Configuring a Mail Relay Host and Notification Address, on page 472

Automating Software Installs

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>
Make sure you allow enough time between the task that pushes the update to a managed device and the task that installs the update.

⚠️ Caution
Depending on the update being installed, the appliance may reboot after the software is installed.

**Procedure**

**Step 1** Select System > Tools > Scheduling.

**Step 2** Click Add Task.

**Step 3** From the Job Type list, select Install Latest Update.

**Step 4** Specify how you want to schedule the task, **Once** or **Recurring**:
- For one-time tasks, use the drop-down lists to specify the start date and time.
- For recurring tasks, see Configuring a Recurring Task, on page 151 for details.

**Step 5** Type a name in the **Job Name** field.

**Step 6** From the Device drop-down list, select the appliance (including the Firepower Management Center) where you want to install the update.

**Step 7** Next to **Update Items**, check the **Software** check box.

**Step 8** If you want to comment on the task, type a comment in the **Comment** field.

The comment field appears in the Task Details section of the schedule calendar page; keep comments brief.

**Step 9** If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the **Email Status To:** field. You must have a valid email relay server configured to send status messages.

**Step 10** Click Save.

**Related Topics**
- Configuring a Mail Relay Host and Notification Address, on page 472

**Vulnerability Database Update Automation**

Cisco uses vulnerability database (VDB) updates to expand the list of network assets, traffic, and vulnerabilities that the Firepower System recognizes. You can use the scheduling feature to update the VDB, thereby ensuring that you are using the most up-to-date information to evaluate the hosts on your network.

When automating VDB updates, you must automate two separate steps:
- Downloading the VDB update.
- Installing the VDB update.
Installing a vulnerability database (VDB) update *immediately* restarts the Snort process on all managed devices. Additionally, the first deploy after installing the VDB *might* cause a Snort restart depending on the VDB content. In either scenario, the restart interrupts traffic inspection. Whether traffic drops during the interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Allow enough time between tasks for the process to complete. For example, if you schedule a task to install an update and the update has not fully downloaded, the installation task will not succeed. However, if the scheduled installation task repeats daily, it will install the downloaded VDB update when the task runs the next day.

**Note:**

- You cannot schedule updates for appliances that cannot access the Support Site. If your FMC is not directly connected to the Internet, you should use management interfaces configuration to set up a proxy to allow it to download updates from the Support Site.

- If you want to have more control over this process, you can use the *Once* option to download and install VDB updates during off-peak hours after you learn that an update has been released.

- In multidomain deployments, you can only schedule VDB updates for the Global domain. The changes take effect when you redeploy policies.

**Related Topics**

Management Interfaces, on page 445

**Automating VDB Update Downloads**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

**Procedure**

1. **Step 1** Select System > Tools > Scheduling.
2. **Step 2** Click Add Task.
3. **Step 3** From the Job Type list, select Download Latest Update.
4. **Step 4** Specify how you want to schedule the task, *Once* or *Recurring*:
   - For one-time tasks, use the drop-down lists to specify the start date and time.
   - For recurring tasks, see Configuring a Recurring Task, on page 151 for details.
5. **Step 5** Type a name in the Job Name field.
6. **Step 6** Next to Update Items, check the Vulnerability Database check box.
7. **Step 7** If you want to comment on the task, type a comment in the Comment field.

The comment field appears in the Task Details section of the calendar schedule page; keep comments brief.
Step 8 If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the **Email Status To:** field. You must have a valid email relay server configured to send status messages.

Step 9 Click **Save**.

---

**Related Topics**

- Configuring a Mail Relay Host and Notification Address, on page 472

---

### Automating VDB Update Installs

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

Allow enough time between the task that downloads the VDB update and the task that installs the update.

**Caution**

- Installing a vulnerability database (VDB) update *immediately* restarts the Snort process on all managed devices. Additionally, the first deploy after installing the VDB *might* cause a Snort restart depending on the VDB content. In either scenario, the restart interrupts traffic inspection. Whether traffic drops during the interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

---

### Procedure

**Step 1** Select **System > Tools > Scheduling**.

**Step 2** Click **Add Task**.

**Step 3** From the **Job Type** list, select **Install Latest Update**.

**Step 4** Specify how you want to schedule the task, **Once** or **Recurring**:

- For one-time tasks, use the drop-down lists to specify the start date and time.
- For recurring tasks, see Configuring a Recurring Task, on page 151 for details.

**Step 5** Type a name in the **Job Name** field.

**Step 6** From the **Device** drop-down list, select the FMC.

**Step 7** Next to **Update Items**, check the **Vulnerability Database** check box.

**Step 8** If you want to comment on the task, type a comment in the **Comment** field.

---

**Tip**

The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.

**Step 9** If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the **Email Status To:** field. You must have a valid email relay server configured to send status messages.

**Step 10** Click **Save**.
In order to ensure that threat data for URL filtering is current, the system must obtain data updates from the Cisco Collective Security Intelligence (CSI) cloud.

By default, when you enable URL filtering, automatic updates are enabled. However, if you need to control when these updates occur, use the procedure described in this topic instead of the default update mechanism.

Although daily updates tend to be small, if it has been more than five days since your last update, new URL filtering data may take up to 20 minutes to download, depending on your bandwidth. Then, it may take up to 30 minutes to perform the update itself.

**Before you begin**

- Ensure the Firepower Management Center has internet access; see Security, Internet Access, and Communication Ports, on page 1801.
- Ensure that URL filtering is enabled. See Enable URL Filtering Using Category and Reputation, on page 665 for more information.
- Verify that **Enable Automatic Updates** is not selected on the **Cisco CSI** tab under the **System > Integration** menu.

**Procedure**

1. Select **System > Tools > Scheduling**.
2. Click **Add Task**.
3. From the **Job Type** list, select **Update URL Filtering Database**.
4. Specify how you want to schedule the update, **Once** or **Recurring**:
   - For one-time tasks, use the drop-down lists to specify the start date and time.
   - For recurring tasks, see Configuring a Recurring Task, on page 151 for details.
5. Type a name in the **Job Name** field.
6. If you want to comment on the task, type a comment in the **Comment** field.
   
   The comment field appears in the Task Details section of the schedule calendar page; keep comments brief.
7. If you want to email task status messages, type an email address (or multiple email addresses separated by commas) in the **Email Status To** field. You must have a valid email relay server configured to send status messages.
**Scheduled Task Review**

After adding scheduled tasks, you can view them and evaluate their status. The View Options section of the page allows you to view scheduled tasks using a calendar and a list of scheduled tasks.

The Calendar view option allows you to view which scheduled tasks occur on which day.

The Task List shows a list of tasks along with their status. The task list appears below the calendar when you open the calendar. In addition, you can view it by selecting a date or task from the calendar.

You can edit a scheduled task that you previously created. This feature is especially useful if you want to test a scheduled task once to make sure that the parameters are correct. Later, after the task completes successfully, you can change it to a recurring task.

There are two types of deletions you can perform from the Schedule View page. You can delete a specific one-time task that has not yet run or you can delete every instance of a recurring task. If you delete an instance of a recurring task, all instances of the task are deleted. If you delete a task that is scheduled to run once, only that task is deleted.

**Task List Details**

Table 22: Task List Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the scheduled task and the comment associated with it.</td>
</tr>
<tr>
<td>Type</td>
<td>Displays the type of scheduled task.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Displays the scheduled start date and time.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Displays how often the task is run.</td>
</tr>
<tr>
<td>Last Run Time</td>
<td>Displays the actual start date and time.</td>
</tr>
<tr>
<td></td>
<td>For a recurring task, this applies to the most recent execution.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Last Run Status</td>
<td>Describes the current status for a scheduled task:</td>
</tr>
<tr>
<td></td>
<td>• A check mark icon (✔️) indicates that the task ran successfully.</td>
</tr>
<tr>
<td></td>
<td>• A question mark icon (❓) indicates that the task is in an unknown state.</td>
</tr>
<tr>
<td></td>
<td>• An exclamation mark icon (❗️) indicates that the task failed.</td>
</tr>
<tr>
<td></td>
<td>For a recurring task, this applies to the most recent execution.</td>
</tr>
<tr>
<td>Next Run Time</td>
<td>Displays the next execution time for a recurring task.</td>
</tr>
<tr>
<td></td>
<td>Displays N/A for a one-time task.</td>
</tr>
<tr>
<td>Creator</td>
<td>Displays the name of the user that created the scheduled task.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edits the scheduled task.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the scheduled task.</td>
</tr>
</tbody>
</table>

**Viewing Scheduled Tasks on the Calendar**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can view scheduled tasks only for your current domain.

**Procedure**

**Step 1** Select **System > Tools > Scheduling**.

**Step 2** You can perform the following tasks using the calendar view:

- Click the double left arrow icon (⪤) to move back one year.
- Click the single left arrow icon (_left) to move back one month.
- Click the single right arrow icon ( ) to move forward one month.
- Click the double right arrow icon ( ) to move forward one year.
- Click **Today** to return to the current month and year.
• Click **Add Task** to schedule a new task.
• Click a date to view all scheduled tasks for the specific date in a task list table below the calendar.
• Click a specific task on a date to view the task in a task list table below the calendar.

## Editing Scheduled Tasks

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can edit scheduled tasks only for your current domain.

### Procedure

### Step 1
Select **System > Tools > Scheduling**.

### Step 2
On the calendar, click either the task that you want to edit or the day on which the task appears.

### Step 3
In the **Task Details** table, click the edit icon (✏️) next to the task you want to edit.

### Step 4
Edit the task.

### Step 5
Click **Save**.

## Deleting Scheduled Tasks

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can delete scheduled tasks only for your current domain.

### Procedure

### Step 1
Select **System > Tools > Scheduling**.

### Step 2
In the calendar, click the task you want to delete. For a recurring task, click an instance of the task.

### Step 3
In the **Task Details** table, click the delete icon (🗑️), then confirm your choice.
FMC Database Purge

The following topic describes how to purge discovery data from the FMC:

- Purging Data from the FMC Database, on page 171

Purging Data from the FMC Database

<table>
<thead>
<tr>
<th></th>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Security Analyst</td>
</tr>
</tbody>
</table>

You can use the database purge page to purge discovery, identity, connection, and Security Intelligence data files from the FMC databases. Note that when you purge a database, the appropriate process is restarted.

Caution

Purging a database removes the data you specify from the Firepower Management Center. After the data is deleted, it cannot be recovered.

Procedure

Step 1
Choose System > Tools > Data Purge.

Step 2
Under Network Discovery, perform any or all of the following:

- Check the Network Discovery Events check box to remove all network discovery events from the database.
- Check the Hosts check box to remove all hosts and Indications of Compromise flags from the database.
- Check the User Activity check box to remove all user activity events from the database.
- Check the User Identities check box to remove all user login and user history data from the database.

Step 3
Under Connections, perform any or all of the following:

- Check the Connection Events check box to remove all connection data from the database.
• Check the **Connection Summary Events** check box to remove all connection summary data from the database.

• Check the **Security Intelligence Events** check box to remove all Security Intelligence data from the database.

**Note** Checking the **Connection Events** check box does not remove Security Intelligence events. Connections with Security Intelligence data will still appear in the Security Intelligence event page (available under the Analysis > Connections menu). Correspondingly, checking the **Security Intelligence Events** check box does not remove connection events with associated Security Intelligence data.

**Step 4** Click **Purge Selected Events**.

The items are purged and the appropriate processes are restarted.
Device Management Basics

The following topics describe how to manage devices in the Firepower System:

- About Device Management, on page 173
- The Device Management Page, on page 177
- Remote Management Configuration, on page 178
- Add Devices to the Firepower Management Center, on page 178
- Deleting Devices from the Firepower Management Center, on page 180
- Device Configuration Settings, on page 181
- The Interfaces Table View, on page 190
- Device Group Management, on page 192

About Device Management

Use the Firepower Management Center to manage your devices.

About the Firepower Management Center

You can use the Firepower Management Center to manage the full range of devices that are a part of the Firepower System. When you manage a device, you set up a two-way, SSL-encrypted communication channel between the Firepower Management Center and the device. The Firepower Management Center uses this channel to send information to the device about how you want to analyze and manage your network traffic to the device. As the device evaluates the traffic, it generates events and sends them to the Firepower Management Center using the same channel.

By using the Firepower Management Center to manage devices, you can:

- configure policies for all your devices from a single location, making it easier to change configurations
- install various types of software updates on devices
- push health policies to your managed devices and monitor their health status from the Firepower Management Center

The Firepower Management Center aggregates and correlates intrusion events, network discovery information, and device performance data, allowing you to monitor the information that your devices are reporting in relation to one another, and to assess the overall activity occurring on your network.
You can use a Firepower Management Center to manage nearly every aspect of a device’s behavior.

**Note**


## What Can Be Managed by a Firepower Management Center?

You can use the Firepower Management Center as a central management point in a Firepower System deployment to manage the following devices:

- 7000 and 8000 Series devices
- ASA FirePOWER modules
- NGIPSv devices

When you manage a device, information is transmitted between the Firepower Management Center and the device over a secure, SSL-encrypted TCP tunnel.

The following illustration lists what is transmitted between a Firepower Management Center and its managed devices. Note that the types of events and policies that are sent between the appliances are based on the device type.

### Beyond Policies and Events

In addition to deploying policies to devices and receiving events from them, you can also perform other device-related tasks on the Firepower Management Center.

**Backing Up a Device**

You **cannot** create or restore backup files for NGIPSv devices or ASA FirePOWER modules.

When you perform a backup of a physical managed device from the device itself, you back up the device configuration **only**. To back up configuration data and, optionally, unified files, perform a backup of the device using the managing Firepower Management Center.

To back up event data, perform a backup of the managing Firepower Management Center.
### Updating Devices

From time to time, Cisco releases updates to the Firepower System, including:

- intrusion rule updates, which may contain new and updated intrusion rules
- vulnerability database (VDB) updates
- geolocation updates
- software patches and updates

You can use the Firepower Management Center to install an update on the devices it manages.

### NAT Environments

Network address translation (NAT) is a method of transmitting and receiving network traffic through a router that involves reassigning the source or destination IP address. The most common use for NAT is to allow private networks to communicate with the internet. Static NAT performs a 1:1 translation, which does not pose a problem for FMC communication with devices, but port address translation (PAT) is more common. PAT lets you use a single public IP address and unique ports to access the public network; these ports are dynamically assigned as needed, so you cannot initiate a connection to a device behind a PAT router.

Normally, you need both IP addresses (along with a registration key) for both routing purposes and for authentication: the FMC specifies the device IP address when you add a device (see Add Devices to the Firepower Management Center, on page 178), and the device specifies the FMC IP address (see the getting started guide for your model; or see Management Interfaces, on page 445 to change settings after initial setup). However, if you only know one of the IP addresses, which is the minimum requirement for routing purposes, then you must also specify a unique NAT ID on both sides of the connection to establish trust for the initial communication and to look up the correct registration key. The FMC and device use the registration key and NAT ID (instead of IP addresses) to authenticate and authorize for initial registration.

For example, you add a device to the FMC, and you do not know the device IP address (for example, the device is behind a PAT router), so you specify only the NAT ID and the registration key on the FMC; leave the IP address blank. On the device, you specify the FMC IP address, the same NAT ID, and the same registration key. The device registers to the FMC's IP address. At this point, the FMC uses the NAT ID instead of IP address to authenticate the device.

Although the use of a NAT ID is most common for NAT environments, you might choose to use the NAT ID to simplify adding many devices to the FMC. On the FMC, specify a unique NAT ID for each device you want to add while leaving the IP address blank, and then on each device, specify both the FMC IP address and the NAT ID. Note: The NAT ID must be unique per device.

The following example shows three devices behind a PAT IP address. In this case, specify a unique NAT ID per device on both the FMC and the devices, and specify the FMC IP address on the devices.
The following example shows the FMC behind a PAT IP address. In this case, specify a unique NAT ID per device on both the FMC and the devices, and specify the device IP addresses on the FMC.
The Device Management Page

The Device Management page provides you with a range of information and options that you can use to manage your registered devices, 7000 and 8000 Series device high availability pairs, and device groups. The page displays a list of all the devices currently registered on the Firepower Management Center.

You can use the View by drop-down list to sort and view the device list by any of the following categories: group, license, model, or access control policy. In a multidomain deployment, you can also sort and view by domain, which is the default display category in that deployment. Devices must belong to a leaf domain.

You can expand and collapse the list of devices in any of the device categories. By default, the device list is expanded.

See the following table for more information about the device list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The display name used for the device in Firepower Management Center. The status icon to the left of the name indicates its current health status.</td>
</tr>
<tr>
<td>Group</td>
<td>The group to which you assigned the managed devices.</td>
</tr>
<tr>
<td>Model</td>
<td>The model of the managed devices.</td>
</tr>
<tr>
<td>License Type</td>
<td>The licenses that are enabled on the managed device.</td>
</tr>
<tr>
<td>Access Control Policy</td>
<td>A link to the currently deployed access control policy. If the system identifies the access control policy as out-of-date, it displays a warning icon (⚠️) next to the link.</td>
</tr>
</tbody>
</table>

Related Topics
- About Firepower Licenses, on page 105
- About Health Monitoring, on page 219
- Managing Access Control Policies, on page 626

Filtering Managed Devices

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/N Network Admin</td>
</tr>
</tbody>
</table>

When your Firepower Management Center manages a large volume of devices, you can narrow the results on the Device Management page to make it easier find a particular device.
Procedure

Step 1  Choose Devices > Device Management.

Step 2  In the Device Name field, enter a full or partial device name, host name or IP address to narrow the device list.

Step 3  To clear the filter, clear the Device Name field.

Remote Management Configuration

Before you can manage a Firepower System device, you must set up a two-way, SSL-encrypted communication channel between the device and the Firepower Management Center. The appliances use the channel to share configuration and event information. High availability peers also use the channel, which is by default on port 8305/tcp.

Note

This documentation explains how to configure remote management of a 7000 or 8000 Series device using its local web interface, before you register the device to the FMC. For information on configuring remote management for other models, see the appropriate quick start guide.

To enable communications between two appliances, you must provide a way for the appliances to recognize each other. There are three criteria the Firepower System uses when allowing communications:

- the hostname or IP address of the appliance with which you are trying to establish communication.
  
  In NAT environments, even if the other appliance does not have a routable address, you must provide a hostname or an IP address either when you are configuring remote management, or when you are adding the managed appliance.

- a self-generated alphanumeric registration key up to 37 characters in length that identifies the connection.

- an optional unique alphanumeric NAT ID that can help the Firepower System establish communications in a NAT environment.

  The NAT ID must be unique among all NAT IDs used to register managed appliances.

Add Devices to the Firepower Management Center

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Use this procedure to add a single device to the Firepower Management Center. If you plan to link devices for redundancy or performance, you must still use this procedure, keeping in mind the following points:

- 8000 Series stacks—Use this procedure to add each device to the Firepower Management Center, then establish the stack; see Establishing Device Stacks, on page 424.
7000 and 8000 Series high availability—Use this procedure to add each device to the Firepower Management Center, then establish high availability; see Establishing Device High Availability, on page 409. For high availability stacks, first stack the devices, then establish high availability between the stacks.

Before you begin

- Set up the device to be managed by the Firepower Management Center. For 7000 and 8000 Series devices, see Configuring Remote Management on a Managed Device, on page 380. For information on configuring remote management for other models, see the appropriate quick start guide.
- If you registered a Firepower Management Center and a device using IPv4 and want to convert them to IPv6, you must delete and reregister the device.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose <strong>Devices</strong> &gt; <strong>Device Management</strong>.</td>
</tr>
<tr>
<td>Step 2</td>
<td>From the <strong>Add</strong> drop-down menu, choose <strong>Add Device</strong>.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the <strong>Host</strong> field, enter the IP address or the hostname of the device you want to add. The hostname of the device is the fully qualified domain name or the name that resolves through the local DNS to a valid IP address. Use a hostname rather than an IP address if your network uses DHCP to assign IP addresses. In a NAT environment, you may not need to specify the IP address or hostname of the device, if you already specified the IP address or hostname of the Firepower Management Center when you configured the device to be managed by the Firepower Management Center. For more information, see NAT Environments, on page 175.</td>
</tr>
<tr>
<td>Step 4</td>
<td>In the <strong>Display Name</strong> field, enter a name for the device as you want it to display in the Firepower Management Center.</td>
</tr>
<tr>
<td>Step 5</td>
<td>In the <strong>Registration Key</strong> field, enter the same registration key that you used when you configured the device to be managed by the Firepower Management Center. The registration key is a one-time-use shared secret.</td>
</tr>
<tr>
<td>Step 6</td>
<td>In a multidomain deployment, regardless of your current domain, assign the device to a leaf <strong>Domain</strong>. If your current domain is a leaf domain, the device is automatically added to the current domain. If your current domain is not a leaf domain, post-registration, you must switch to the leaf domain to configure the device.</td>
</tr>
<tr>
<td>Step 7</td>
<td>(Optional) Add the device to a device <strong>Group</strong>.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Choose an initial <strong>Access Control Policy</strong> to deploy to the device upon registration, or create a new policy. If the device is incompatible with the policy you choose, deploying will fail. This incompatibility could occur for multiple reasons, including licensing mismatches, model restrictions, passive vs inline issues, and other misconfigurations. After you resolve the issue that caused the failure, manually deploy configurations to the device.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Choose licenses to apply to the device. For Classic devices, note that:</td>
</tr>
</tbody>
</table>

- Control, Malware, and URL Filtering licenses require a Protection license.
• VPN licenses require a 7000 or 8000 Series device.

• Control licenses are supported on NGIPSv and ASA FirePOWER devices, but do not allow you to configure 8000 Series fastpath rules, switching, routing, stacking, or device high availability.

**Step 10**
If you used a NAT ID during device setup, expand the **Advanced** section and enter the same NAT ID in the **Unique NAT ID** field.

**Step 11**
Check the **Transfer Packets** check box to allow the device to transfer packets to the Firepower Management Center.

This option is enabled by default. When events like IPS or Snort are triggered with this option enabled, the device sends event metadata information and packet data to the Firepower Management Center for inspection. If you disable it, only event information will be sent to the Firepower Management Center but packet data is not sent.

**Step 12**
Click **Register**.

It may take up to two minutes for the Firepower Management Center to verify the device’s heartbeat and establish communication.

**Related Topics**
- Creating a Basic Access Control Policy, on page 627

### Deleting Devices from the Firepower Management Center

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

If you no longer want to manage a device, you can delete it from the Firepower Management Center. Deleting a device:

• Severs all communication between the Firepower Management Center and the device.

• Removes the device from the Device Management page.

• Returns the device to local time management if the device is configured via the platform settings policy to receive time from the Firepower Management Center via NTP.

To manage the device later, re-add it to the Firepower Management Center.

**Note**
When a device is deleted and then re-added, the Firepower Management Center web interface prompts you to re-apply your access control policies. However, there is no option to re-apply the NAT and VPN policies during registration. Any previously applied NAT or VPN configuration will be removed during registration and must be re-applied after registration is complete.
Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Devices &gt; Device Management.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Next to the device you want to delete, click the delete icon (🗑️).</td>
</tr>
<tr>
<td>Step 3</td>
<td>Confirm that you want to delete the device.</td>
</tr>
</tbody>
</table>

Device Configuration Settings

The Device page of the appliance editor displays detailed device configuration and information. It also allows you to make changes to some parts of device configuration, such as enabling and disabling licenses, shutting down and restarting a device, modifying management, and configuring advanced options.

General Device Settings

The General section of the Device tab displays the settings described in the table below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The display name of the device on the Firepower Management Center.</td>
</tr>
<tr>
<td>Transfer Packets</td>
<td>This displays whether or not the managed device sends packet data with the events to the Firepower Management Center.</td>
</tr>
<tr>
<td>Compliance Mode</td>
<td>This displays the security certifications compliance for a device. Valid values are CC, UCAPL and None.</td>
</tr>
</tbody>
</table>

Device License Settings

The License section of the Device tab displays the licenses enabled for the device.

Related Topics

About Firepower Licenses, on page 105

Device System Settings

The System section of the Device tab displays a read-only table of system information, as described in the following table.
Table 25: System Section Table Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>The model name and number for the managed device.</td>
</tr>
<tr>
<td>Serial</td>
<td>The serial number of the chassis of the managed device.</td>
</tr>
<tr>
<td>Time</td>
<td>The current system time of the device.</td>
</tr>
<tr>
<td>Version</td>
<td>The version of the software currently installed on the managed device.</td>
</tr>
<tr>
<td>Policy</td>
<td>A link to the platform settings policy currently deployed to the managed device.</td>
</tr>
</tbody>
</table>

You can also shut down or restart the device.

Device Health Settings

The Health section of the Device tab displays the information described in the table below.

Table 26: Health Section Table Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>An icon that represents the current health status of the device. Clicking the icon displays the Health Monitor for the appliance.</td>
</tr>
<tr>
<td>Policy</td>
<td>A link to a read-only version of the health policy currently deployed at the device.</td>
</tr>
<tr>
<td>Blacklist</td>
<td>A link to the Health Blacklist page, where you can enable and disable health blacklist modules.</td>
</tr>
</tbody>
</table>

Related Topics
- Viewing Appliance Health Monitors, on page 236
- Editing Health Policies, on page 228
- Blacklisting Health Policy Modules, on page 230

Device Management Settings

The Management section of the Device tab displays the fields described in the table below.
Table 27: Management Section Table Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The IP address or host name of the device. The host name is fully qualified domain name or the name that resolves through the local DNS to a valid IP address (that is, the host name).</td>
</tr>
<tr>
<td>Status</td>
<td>An icon indicating the status of the communication channel between the Firepower Management Center and the managed device. You can hover over the status icon to view the last time the Firepower Management Center contacted the device.</td>
</tr>
</tbody>
</table>

Advanced Device Settings

The Advanced section of the Device tab displays a table of advanced configuration settings, as described below. You can use the Advanced section to edit any of these settings.

Table 28: Advanced Section Table Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Supported Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Bypass</td>
<td>The state of Automatic Application Bypass on the device.</td>
<td>7000 &amp; 8000 Series, NGIPSv, ASA FirePOWER</td>
</tr>
<tr>
<td>Bypass Threshold</td>
<td>The Automatic Application Bypass threshold, in milliseconds.</td>
<td>7000 &amp; 8000 Series, NGIPSv, ASA FirePOWER</td>
</tr>
<tr>
<td>Inspect Local Router Traffic</td>
<td>Whether the device inspects traffic received on routed interfaces that is destined for itself, such as ICMP, DHCP, and OSPF traffic.</td>
<td>7000 &amp; 8000 Series</td>
</tr>
<tr>
<td>Fast-Path Rules</td>
<td>The number of 8000 Series fastpath rules that have been created on the device.</td>
<td>8000 Series</td>
</tr>
</tbody>
</table>

Viewing Device Information

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, ancestor domains can view information about all devices in descendant domains. You must be in a leaf domain to edit a device.
Editing Device Management Settings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

If you edit the hostname or IP address of a device after you add it to the FMC (using the device’s CLI, for example), you need to use the procedure below to manually update the hostname or IP address on the managing FMC.

Procedure

Step 1 Choose Devices > Device Management.

Step 2 Next to the device where you want to modify management options, click the edit icon (📝).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3 Click the Device tab, and see the Management area.

Tip For stacked devices, you modify management options on an individual device on the Device page of the appliance editor.

Step 4 Edit the Host IP address or hostname by clicking the edit icon (📝).
In the Management dialog box, modify the name or IP address in the Host field, and click Save.

Step 5
(Optional) Disable remote management.

Click the slider (.ot) to enable or disable management of the device. Disabling management blocks the connection between the Firepower Management Center and the device, but does not delete the device from the Firepower Management Center. If you no longer want to manage a device, see Deleting Devices from the Firepower Management Center, on page 180.

What to do next
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Editing General Device Settings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Choose Devices > Device Management.
Step 2 Next to the device you want to modify, click the edit icon (ot).
   In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.
Step 3 Click Device.
Step 4 In the General section, click the edit icon (ot).
Step 5 Enter a Name for the managed device.
   Tip For stacked devices, you edit the assigned device name for the stack on the Stack page of the appliance editor. You can edit the assigned device name for an individual device on the Devices page of the appliance editor.

Step 6 Change the Transfer Packets setting:
   - Check the check box to allow packet data to be stored with events on the Firepower Management Center.
   - Clear the check box to prevent the managed device from sending packet data with the events.

Step 7 Click Force Deploy to force deployment of current policies and device configuration to the device.
Step 8  
Click **Save**.

What to do next  
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Enabling and Disabling Device Licenses

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can enable licenses on your device if you have available licenses on your Firepower Management Center.

Procedure

Step 1  
Choose **Devices > Device Management**.

Step 2  
Next to the device where you want to enable or disable licenses, click the edit icon (تعديل).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3  
Click the **Device** tab.

**Tip**  
For stacked devices, you enable or disable the licenses for the stack on the Stack page of the appliance editor.

Step 4  
In the **License** section, click the edit icon (تعديل).

Step 5  
Check or clear the check box next to the license you want to enable or disable for the managed device.

Step 6  
Click **Save**.

What to do next  
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

About Firepower Licenses, on page 105

Editing Advanced Device Settings

You can configure Application Bypass, Local Router Traffic Inspection, and Fast-Path Rules.
Configuring Automatic Application Bypass

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>7000 &amp; 8000 Series, NGIPSv, ASA FirePOWER</td>
<td>Leaf only</td>
<td>Admin Network Admin</td>
</tr>
</tbody>
</table>

The Automatic Application Bypass (AAB) feature limits the time allowed to process packets through an interface and allows packets to bypass detection if the time is exceeded. The feature functions with any deployment; however, it is most valuable in inline deployments.

You balance packet processing delays with your network’s tolerance for packet latency. When a malfunction within Snort or a device misconfiguration causes traffic processing time to exceed a specified threshold, AAB causes Snort to restart within ten minutes of the failure, and generates troubleshoot data that can be analyzed to investigate the cause of the excessive processing time.

Typically, you use Rule Latency Thresholding in the intrusion policy to fast-path packets after the latency threshold value is exceeded. Rule Latency Thresholding does not shut down the engine or generate troubleshoot data.

If detection is bypassed, the device generates a health monitoring alert.

By default the AAB is disabled; to enable AAB follow the steps described.

⚠️ Caution

AAB activates when an excessive amount of time is spent processing a single packet. AAB activation partially restarts the Snort process, which temporarily interrupts the inspection of a few packets. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Procedure

Step 1
Choose Devices > Device Management.

Step 2
Next to the device where you want to edit advanced device settings, click the edit icon ( ).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3
Click the Device tab (or the Stack tab for stacked devices), then click the edit icon ( ) in the Advanced section.

Step 4
Check Automatic Application Bypass.

Step 5
Enter a Bypass Threshold from 250 ms to 60,000 ms. The default setting is 3000 milliseconds (ms).

Step 6
Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Inspecting Local Router Traffic

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

If locally-bound traffic matches a Monitor rule in a Layer 3 deployment, that traffic may bypass inspection. To ensure inspection of the traffic, enable Inspect Local Router Traffic.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device where you want to edit advanced device settings, click the edit icon (-pencil).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Device tab (or the Stack tab for stacked devices), then click the edit icon (-pencil) in the Advanced section.

**Step 4** Check Inspect Local Router Traffic to inspect exception traffic when a 7000 or 8000 Series device is deployed as a router.

**Step 5** Click Save.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Configuring Fastpath Rules (8000 Series)

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

As a form of early traffic handling, 8000 Series fastpath rules can send traffic directly through an 8000 Series device without further inspection or logging. (In a passive deployment, 8000 Series fastpath rules simply stop analysis.) Each 8000 Series fastpath rule applies to a specific security zone or inline interface set. Because 8000 Series fastpath rules function at the hardware level, you can use only the following simple, outer-header criteria to fastpath traffic:

- initiator and responder IP address or address block
- protocol, and for TCP and UDP, initiator and responder port
- VLAN ID

By default, 8000 Series fastpath rules affect connections from specified initiators to specified responders. To fastpath all connections that meets the rule's criteria, regardless of which host is the initiator and which is the responder, you can make the rule bidirectional.
When you specify a port other than *Any* for TCP or UDP traffic, only the first fragment in matching fragmented traffic is fastpathed. All other fragments are forwarded for further inspection. This is because the 8000 Series only fastpaths fragmented traffic when the IP header in each fragment contains all the IP header information needed to match the fastpath rule, and subsequent fragments do not contain the field that identifies the port.

**Procedure**

**Step 1** Choose **Devices > Device Management**.

**Step 2** Next to the 8000 Series device where you want to configure the rule, click the edit icon (-pencil).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the **Device** tab (or the **Stack** tab for stacked devices), then click the edit icon (-pencil) in the Advanced section.

**Step 4** Click **New IPv4 Rule** or **New IPv6 Rule**.

**Step 5** From the **Domain** drop-down list, choose an inline set or passive security zone.

**Step 6** Configure the traffic you want to fastpath. Traffic must meet all the conditions to be fastpathed.

- Initiator and Responder (required)—Enter IP addresses or address blocks for initiators and responders.
- Protocol—Choose a protocol, or choose *All*.
- Initiator Port and Responder Port—for TCP and UDP traffic, enter initiator and responder ports. Leave the fields blank or enter *Any* to match all TCP or UDP traffic. You can enter a comma-separated list of ports, but you cannot enter port ranges.
- VLAN—Enter a VLAN ID. Leave the field blank or enter *Any* to match all traffic regardless of VLAN tag.

**Step 7** (Optional) Make the rule **Bidirectional**.

**Step 8** Click **Save**, then **Save** again.

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes, on page 277**.

**Managing System Shut Down**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Any</em></td>
<td><em>Any</em></td>
<td><em>Any except ASA FirePOWER</em></td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>
You cannot shut down or restart the ASA FirePOWER with the Firepower System user interface. See the ASA documentation for more information on how to shut down the respective devices.

Procedure

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device that you want to restart, click the edit icon (✏).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Device tab.

**Tip** For stacked devices, you shut down or restart an individual device on the Devices page of the appliance editor.

**Step 4** To shut down the device, click the shut down device icon (⟳) in the System section.

**Step 5** When prompted, confirm that you want to shut down the device.

**Step 6** To restart the device, click the restart device icon (⟳).

**Step 7** When prompted, confirm that you want to restart the device.

**The Interfaces Table View**

The interfaces table view is located below the hardware view and lists all the available interfaces you have on a device. The table includes an expandable navigation tree you can use to view all configured interfaces. You can click the arrow icon next to an interface to collapse or expand the interface to hide or view its subcomponents. The interfaces table view also provides summarized information about each interface, as described in the following table.

**Classic Devices Interfaces**

Note that only 8000 Series devices display the MAC Address and IP Address columns. See the table below for more information.
### Table 29: Classic Devices Interfaces Table View Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name         | Each interface type is represented by a unique icon that indicates its type and link state (if applicable). You can hover your pointer over | Each interface type is represented by a unique icon that indicates its type and link state (if applicable). You can hover your pointer over the name or the icon to view the interface type, speed, and duplex mode (if applicable) in a tooltip. The interface icons are described in Interface Icons, on page 382. The icons use a badging convention to indicate the current link state of the interface, which may be one of three states:  
- error ( ),  
- fault ( ),  
- not available ( )  
Logical interfaces have the same link state as their parent physical interface. ASA FirePOWER modules do not display link state. Note that disabled interfaces are represented by semi-transparent icons.  
Interface names, which appear to the right of the icons, are auto-generated with the exception of hybrid and ASA FirePOWER interfaces, which are user-defined. Note that for ASA FirePOWER interfaces, the system displays only interfaces that are enabled, named, and have link.  
Physical interfaces display the name of the physical interface. Logical interfaces display the name of the physical interface and the assigned VLAN tag.  
ASA FirePOWER interfaces display the name of the security context and the name of the interface if there are multiple security contexts. If there is only one security context, the system displays only the name of the interface. |
| Security Zone | The security zone where the interface is assigned. To add or edit a security zone, click the edit icon ( ).                                                                 |
| Used by      | The inline set, virtual switch, or virtual router where the interface is assigned. ASA FirePOWER modules do not display the Used by column.        |
## Device Group Management

The Firepower Management Center allows you to group devices so you can easily deploy policies and install updates on multiple devices. You can expand and collapse the list of devices in the group. The list appears collapsed by default.

In a multidomain deployment, you can create device groups within a leaf domain only. When you configure a Firepower Management Center for multitenancy, existing device groups are removed; you can re-add them at the leaf domain level.

## Adding Device Groups

### Access Supported Domains Supported Devices Classic License Smart License

<table>
<thead>
<tr>
<th>Access</th>
<th>Admin/Network Admin</th>
<th>Leaf only</th>
<th>Any</th>
<th>Any</th>
<th>Any</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Devices &gt; Device Management.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step 2</td>
<td>From the Add drop-down menu, choose Add Group.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step 3</td>
<td>Enter a Name.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step 4</td>
<td>Under Available Devices, choose one or more devices to add to the device group. Use Ctrl or Shift while clicking to choose multiple devices.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step 5</td>
<td>Click Add to include the devices you chose in the device group.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Device groups enable you to easily assign policies and install updates on multiple devices.

If you add the primary device in a stack or a high-availability pair to a group, both devices are added to the group. If you unstack the devices or break the high-availability pair, both devices remain in that group.

**Firepower System Management**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAC Address</td>
<td>The MAC address displayed for the interface when it is enabled for switched and routed features. For NGIPSv devices, the MAC address is displayed so that you can match the network adapters configured on your device to the interfaces that appear on the Interfaces page. ASA FirePOWER modules do not display MAC addresses.</td>
</tr>
<tr>
<td>IP Addresses</td>
<td>IP addresses assigned to the interface. Hover your pointer over an IP address to view whether it is active or inactive. Inactive IP addresses are grayed out. ASA FirePOWER modules do not display IP addresses.</td>
</tr>
</tbody>
</table>
Step 6  Click **OK** to add the device group.

## Editing Device Groups

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can change the set of devices that reside in any device group. You must remove an appliance from its current group before you can add it to a new group.

Moving an appliance to a new group does not change its policy to the policy previously assigned to the group. You must assign the group's policy to the new device.

If you add the primary device in a stack or a device high-availability pair to a group, both devices are added to the group. If you unstack the devices or break the high-availability pair, both devices remain in that group.

In a multidomain deployment, you can only edit device groups in the domain where they were created.

**Procedure**

**Step 1** Choose **Devices > Device Management**.

**Step 2** Next to the device group you want to edit, click the edit icon (موظف).

**Step 3** Optionally, in the **Name** field, enter a new name for the group.

**Step 4** Under **Available Devices**, choose one or more devices to add to the device group. Use Ctrl or Shift while clicking to choose multiple devices.

**Step 5** Click **Add** to include the devices you chose in the device group.

**Step 6** Optionally, to remove a device from the device group, click the delete icon (حذف) next to the device you want to remove.

**Step 7** Click **OK** to save the changes to the device group.
PART III

System Monitoring

• Dashboards, on page 197
• Health Monitoring, on page 219
• Monitoring the System, on page 247
Dashboards

The following topics describe how to use dashboards in the Firepower System:

- About Dashboards, on page 197
- Firepower System Dashboard Widgets, on page 198
- Managing Dashboards, on page 210

About Dashboards

Firepower System dashboards provide you with at-a-glance views of current system status, including data about the events collected and generated by the system. You can also use dashboards to see information about the status and overall health of the appliances in your deployment. Keep in mind that the information the dashboard provides depends on how you license, configure, and deploy the system.

Tip

The dashboard is a complex, highly customizable monitoring feature that provides exhaustive data. For a broad, brief, and colorful picture of your monitored network, use the Context Explorer. Dashboards are available on the Firepower Management Center and 7000 & 8000 Series devices.

A dashboard uses tabs to display widgets: small, self-contained components that provide insight into different aspects of the system. For example, the predefined Appliance Information widget tells you the appliance name, model, and currently running version of the Firepower System software. The system constrains widgets by the dashboard time range, which you can change to reflect a period as short as the last hour or as long as the last year.

The system is delivered with several predefined dashboards, which you can use and modify. If your user role has access to dashboards (Administrator, Maintenance User, Security Analyst, Security Analyst [Read Only], and custom roles with the Dashboards permission), by default your home page is the predefined Summary Dashboard. However, you can configure a different default home page, including non-dashboards. You can also change the default dashboard. Note that if your user role cannot access dashboards, your default home page is relevant to the role; for example, a Discovery Admin sees the Network Discovery page.

You can also use predefined dashboards as the base for custom dashboards, which you can either share or restrict as private. Unless you have Administrator access, you cannot view or modify private dashboards created by other users.
Some drill-down pages and table views of events include a Dashboard toolbar link that you can click to view a relevant predefined dashboard. If you delete a predefined dashboard or tab, the associated toolbar links do not function.

In a multidomain deployment, you cannot view dashboards from ancestor domains; however, you can create new dashboards that are copies of the higher-level dashboards.

Firepower System Dashboard Widgets

A dashboard has one or more tabs, each of which can display one or more widgets in a three-column layout. The Firepower System is delivered with many predefined dashboard widgets, each of which provides insight into a different aspect of the Firepower System. Widgets are grouped into three categories:

- **Analysis & Reporting widgets** display data about the events collected and generated by the Firepower System.
- **Miscellaneous widgets** display neither event data nor operations data. Currently, the only widget in this category displays an RSS feed.
- **Operations widgets** display information about the status and overall health of the Firepower System.

The dashboard widgets that you can view depend on:

- the type of appliance you are using
- your user role
- your current domain (in a multidomain deployment)

In addition, each dashboard has a set of preferences that determines its behavior.

You can minimize and maximize widgets, add and remove widgets from tabs, as well as rearrange the widgets on a tab.

Note

For widgets that display event counts over a time range, the total number of events may not reflect the number of events for which detailed data is available in the tables on pages under the Analysis menu. This occurs because the system sometimes prunes older event details to manage disk space usage. To minimize the occurrence of event detail pruning, you can fine-tune event logging to log only those events most important to your deployment.

Widget Availability

The dashboard widgets that you can view depend on the type of appliance you are using, your user role, and your current domain (in a multidomain deployment).

In a multidomain deployment, if you do not see a widget that you expect to see, switch to the Global domain. See Switching Domains on the Firepower Management Center, on page 25.

Note that:
• An *invalid* widget is one that you cannot view because you are using the wrong type of appliance.
• An *unauthorized* widget is one that you cannot view because your user account does not have the necessary privileges.

For example, the Appliance Status widget is available only on the FMC for users with Administrator, Maintenance User, Security Analyst, or Security Analyst (Read Only) account privileges.

Although you cannot add an unauthorized or invalid widget to a dashboard, an imported dashboard may contain unauthorized or invalid widgets. For example, such widgets can be present if the imported dashboard:

• Was created by a user with different access privileges, or
• Belongs to an ancestor domain.

Unavailable widgets are disabled and display error messages that indicate why you cannot view them.

Individual widgets also display error messages when those widgets have timed out or are otherwise experiencing problems.

---

**Note**

You can delete or minimize unauthorized and invalid widgets, as well as widgets that display no data, keeping in mind that modifying a widget on a shared dashboard modifies it for all users of the appliance.

---

**Dashboard Widget Availability by User Role**

The following table lists the user account privileges required to view each widget. Only user accounts with Administrator, Maintenance User, Security Analyst, or Security Analyst (Read Only) access can use dashboards.

Users with custom roles may have access to any combination of widgets, or none at all, as their user roles permit.

**Table 30: User Roles and Dashboard Widget Availability**

<table>
<thead>
<tr>
<th>Widget</th>
<th>Administrator</th>
<th>Maintenance User</th>
<th>Security Analyst</th>
<th>Security Analyst (RO)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appliance Information</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Appliance Status</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Correlation Events</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Current Interface Status</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Current Sessions</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Custom Analysis</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Disk Usage</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Interface Traffic</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
### Predefined Dashboard Widgets

The Firepower System is delivered with several predefined widgets that, when used on dashboards, can provide you with at-a-glance views of current system status. These views include:

- data about the events collected and generated by the system
- information about the status and overall health of the appliances in your deployment

**Note**

The dashboard widgets you can view depend on the type of appliance you are using, your user role, and your current domain in a multidomain deployment.

### The Appliance Information Widget

The Appliance Information widget provides a snapshot of the appliance. It appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard. The widget provides:

- the name, IPv4 address, IPv6 address, and model of the appliance
- the versions of the Firepower System software, operating system, Snort, rule update, rule pack, module pack, vulnerability database (VDB), and geolocation update installed on the appliances with dashboards, except for virtual Firepower Management Centers
- for managed appliances, the name and status of the communications link with the managing appliance

You can configure the widget to display more or less information by modifying the widget preferences to display a simple or an advanced view; the preferences also control how often the widget updates.

---

<table>
<thead>
<tr>
<th>Widget</th>
<th>Administrator</th>
<th>Maintenance User</th>
<th>Security Analyst</th>
<th>Security Analyst (RO)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intrusion Events</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Network Compliance</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Product Licensing</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Product Updates</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>RSS Feed</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>System Load</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>System Time</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>White List Events</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
**The Appliance Status Widget**

The Appliance Status widget indicates the health of the appliance and of any appliances it is managing. Note that because the Firepower Management Center does not automatically apply a health policy to managed devices, you must manually apply a health policy to devices or their status appears as Disabled. This widget appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard.

You can configure the widget to display appliance status as a pie chart or in a table by modifying the widget preferences.

The preferences also control how often the widget updates.

You can click a section on the pie chart or one of the numbers on the appliance status table to go to the Health Monitor page and view the compiled health status of the appliance and of any appliances it is managing.

**The Correlation Events Widget**

The Correlation Events widget shows the average number of correlation events per second, by priority, over the dashboard time range. It appears by default on the Correlation tab of the Detailed Dashboard.

You can configure the widget to display correlation events of different priorities by modifying the widget preferences, as well as to choose a linear (incremental) or logarithmic (factor of ten) scale.

Check one or more Priorities check boxes to display separate graphs for events of specific priorities, including events that do not have a priority. Choose Show All to display an additional graph for all correlation events, regardless of priority. The preferences also control how often the widget updates.

You can click a graph to view correlation events of a specific priority, or click the All graph to view all correlation events. In either case, the events are constrained by the dashboard time range; accessing correlation events via the dashboard changes the events (or global) time window for the appliance.

**The Current Interface Status Widget**

The Current Interface Status widget shows the status of all interfaces on the appliance, enabled or unused. On a Firepower Management Center, you can display the management (eth0, eth1, and so on) interfaces. On a managed device, you can choose to show only sensing (s1p1 and so on) interfaces or both management and sensing interfaces. Interfaces are grouped by type: management, inline, passive, switched, routed, stacked, and unused.

For each interface, the widget provides:

- the name of the interface
- the link state of the interface
- the link mode (for example, 100Mb full duplex, or 10Mb half duplex) of the interface
- the type of interface, that is, copper or fiber
- the amount of data received (Rx) and transmitted (Tx) by the interface

The color of the ball representing link state indicates the current status, as follows:

- green: link is up and at full speed
- yellow: link is up but not at full speed
- red: link is not up
The Current Sessions Widget

The Current Sessions widget shows which users are currently logged into the appliance, the IP address associated with the machine where the session originated, and the last time each user accessed a page on the appliance (based on the local time for the appliance). The user that represents you, that is, the user currently viewing the widget, is marked with a user icon (user) and rendered in bold type. Sessions are pruned from this widget’s data within one hour of logoff or inactivity. This widget appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard.

On the Current Sessions widget, you can:

- click any user name to manage user accounts on the User Management page.
- click the host icon (host) or compromised host icon (compromised host) next to any IP address to view the host profile for the associated machine.
- click any IP address or access time to view the audit log constrained by that IP address and by the time that the user associated with that IP address logged on to the web interface.

The widget preferences control how often the widget updates.

The Custom Analysis Widget

The Custom Analysis widget is a highly customizable widget that allows you to display detailed information on the events collected and generated by the Firepower System.

The widget is delivered with multiple presets that provide quick access to information about your deployment. The predefined dashboards make extensive use of these presets. You can use these presets or create a custom configuration. At a minimum, a custom configuration specifies the data you are interested in (table and field), and an aggregation method for that data. You can also set other display-related preferences, including whether you want to show events as relative occurrences (bar graph) or over time (line graph).

The widget displays the last time it updated, based on local time. The widget updates with a frequency that depends on the dashboard time range. For example, if you set the dashboard time range to an hour, the widget updates every five minutes. On the other hand, if you set the dashboard time range to a year, the widget updates once a week. To determine when the dashboard will update next, hover your pointer over the Last updated notice in the bottom left corner of the widget.

Note

A red-shaded Custom Analysis widget indicates that its use is harming system performance. If the widget continues to stay red over time, remove the widget. You can also disable all Custom Analysis widgets from the Dashboard settings in your system configuration (System > Configuration > Dashboard).
Displaying Relative Occurrences of Events (Bar Graphs)

For bar graphs in the Custom Analysis widget, the colored bars in the widget background show the relative number of occurrences of each event. Read the bars from right to left.

The direction icon (⇩) indicates and controls the sort order of the display. A downward-pointing icon indicates descending order; an upward-pointing icon indicates ascending order. To change the sort order, click the icon.

Next to each event, the widget can display one of three icons to indicate any changes from the most recent results:

- The new event icon (❖) signifies that the event is new to the results.
- The up arrow icon (⬆️) indicates that the event has moved up in the standings since the last time the widget updated. A number indicating how many places the event has moved up appears next to the icon.
- The down arrow icon (⬇️) indicates that the event has moved down in the standings since the last time the widget updated. A number indicating how many places the event has moved down appears next to the icon.

Displaying Events Over Time (Line Graphs)

If you want information on events or other collected data over time, you can configure the Custom Analysis widget to display a line graph, such as one that displays the total number of intrusion events generated in your deployment over time.

Limitations to the Custom Analysis Widget

A Custom Analysis widget may indicate that you are unauthorized to view the data that is configured to display. For example, Maintenance Users are not authorized to view discovery events. As another example, the widget does not display information related to unlicensed features. However, you (and any other users who share the dashboard) can modify the widget preferences to display data that you can see, or even delete the widget. If you want to make sure that this does not happen, save the dashboard as private.

When viewing user data, the system displays only authoritative users.

When viewing URL category information, the system does not display uncategorized URLs.

When viewing intrusion events aggregated by Count, the count includes reviewed events for intrusion events; if you view the count in tables on pages under the Analysis menus, the count will not include reviewed events.

---

**Note**

In a multidomain deployment, the system builds a separate network map for each leaf domain. As a result, a leaf domain can contain an IP address that is unique within its network, but identical to an IP address in another leaf domain. When you view Custom Analysis widgets in an ancestor domain, multiple instances of that repeated IP address can be displayed. At first glance, they might appear to be duplicate entries. However, if you drill down to the host profile information for each IP address, the system shows that they belong to different leaf domains.
**Example: Custom Configuration**

You can configure the Custom Analysis widget to display a list of recent intrusion events by configuring the widget to display data from the **Intrusion Events** table. Choosing the **Classification** field and aggregating this data by **Count** tells you how many events of each type were generated.

On the other hand, aggregating by **Unique Events** tells you how many unique intrusion events of each type have occurred (for example, how many detections of network trojans, potential violations of corporate policy, attempted denial-of-service attacks, and so on).

You can further constrain the widget using a saved search, either one of the predefined searches delivered with your appliance or a custom search that you created. For example, constraining the first example (intrusion events using the **Classification** field, aggregated by **Count**) using the **Dropped Events** search tells you how many intrusion events of each type were dropped.

**Related Topics**

- **Modifying Dashboard Time Settings**, on page 216

**Custom Analysis Widget Preferences**

The following table describes the preferences you can set in the Custom Analysis widget.

Different preferences appear depending on how you configure the widget. For example, a different set of preferences appears if you configure the widget to show relative occurrences of events (a bar graph) vs a graph over time (a line graph). Some preferences, such as Filter, only appear if you choose a specific table from which to display data.

**Table 31: Custom Analysis Widget Preferences**

<table>
<thead>
<tr>
<th>Preference</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>If you do not specify a title for the widget, the system uses the configured event type as the title.</td>
</tr>
<tr>
<td>Preset</td>
<td>Custom Analysis presets provide quick access to information about your deployment. The predefined dashboards make extensive use of these presets. You can use these presets or you can create a custom configuration.</td>
</tr>
<tr>
<td>Table (required)</td>
<td>The table of events or assets that contains the data the widget displays.</td>
</tr>
<tr>
<td>Field (required)</td>
<td>The specific field of the event type you want to display. To show data over time (line graphs), choose <strong>Time</strong>. To show relative occurrences of events (bar graphs), choose another option.</td>
</tr>
<tr>
<td>Aggregate (required)</td>
<td>The aggregation method configures how the widget groups the data it displays. For most event types, the default option is <strong>Count</strong>.</td>
</tr>
<tr>
<td>Filter</td>
<td>You can use application filters to constrain data from the Application Statistics and Intrusion Event Statistics by Application tables.</td>
</tr>
</tbody>
</table>
Details

You can use a saved search to constrain the data that the widget displays. You do not have to specify a search, although some presets use predefined searches.

Only you can access searches that you have saved as private. If you configure the widget on a shared dashboard and constrain its events using a private search, the widget resets to not using the search when another user logs in. This affects your view of the widget as well. If you want to make sure that this does not happen, save the dashboard as private.

Only fields that constrain connection summaries can constrain Custom Analysis dashboard widgets based on connection events. Invalid saved searches are dimmed.

If you constrain a Custom Analysis widget using a saved search, then edit the search, the widget does not reflect your changes until the next time it updates.

Preference | Details
--- | ---
Search | You can use a saved search to constrain the data that the widget displays. You do not have to specify a search, although some presets use predefined searches.

Only you can access searches that you have saved as private. If you configure the widget on a shared dashboard and constrain its events using a private search, the widget resets to not using the search when another user logs in. This affects your view of the widget as well. If you want to make sure that this does not happen, save the dashboard as private.

Only fields that constrain connection summaries can constrain Custom Analysis dashboard widgets based on connection events. Invalid saved searches are dimmed.

If you constrain a Custom Analysis widget using a saved search, then edit the search, the widget does not reflect your changes until the next time it updates.

Show | Choose whether you want to display the most (Top) or the least (Bottom) frequently occurring events.

Show Movers | Choose whether you want to display the icons that indicate changes from the most recent results.

Time Zone | Choose the time zone you want to use to display results.

Color | You can change the color of the bars in the widget's bar graph.

Related Topics

Configuring Widget Preferences, on page 213

Viewing Associated Events from the Custom Analysis Widget

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>

From a Custom Analysis widget, you can invoke an event view (workflow) that provides detailed information about the events displayed in the widget. The events appear in the default workflow for that event type, constrained by the dashboard time range. This also changes the appropriate time window on the Firepower Management Center, depending on how many time windows you configured and on the event type.

For example:

- If you configure multiple time windows, then access health events from a Custom Analysis widget, the events appear in the default health events workflow, and the health monitoring time window changes to the dashboard time range.
• If you configure a single time window and then access any type of event from the Custom Analysis widget, the events appear in the default workflow for that event type, and the global time window changes to the dashboard time range.

Procedure

You have the following choices:

• On any Custom Analysis widget, click the view all icon ( ) in the lower right corner of the widget to view all associated events, constrained by the widget preferences.
• On a Custom Analysis widget showing relative occurrences of events (bar graph), click any event to view associated events constrained by the widget preferences, as well as by that event.

The Disk Usage Widget

The Disk Usage widget displays the percentage of space used on the hard drive, based on disk usage category. It also indicates the percentage of space used on and capacity of each partition of the appliance’s hard drive. The Disk Usage widget displays the same information for the malware storage pack if installed in the device, or if the Firepower Management Center manages a device containing a malware storage pack. This widget appears by default on the Status tabs of the Default Dashboard and the Summary Dashboard.

The By Category stacked bar displays each disk usage category as a proportion of the total available disk space used. The following table describes the available categories.

Table 32: Disk Usage Categories

<table>
<thead>
<tr>
<th>Disk Usage Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events</td>
<td>all events logged by the system</td>
</tr>
<tr>
<td>Files</td>
<td>all files stored by the system</td>
</tr>
<tr>
<td>Backups</td>
<td>all backup files</td>
</tr>
<tr>
<td>Updates</td>
<td>all files related to updates, such as rule updates and system updates</td>
</tr>
<tr>
<td>Other</td>
<td>system troubleshooting files and other miscellaneous files</td>
</tr>
<tr>
<td>Free</td>
<td>free space remaining on the appliance</td>
</tr>
</tbody>
</table>

You can hover your pointer over a disk usage category in the By Category stacked bar to view the percentage of available disk space used by that category, the actual storage space on the disk, and the total disk space available for that category. Note that if you have a malware storage pack installed, the total disk space available for the Files category is the available disk space on the malware storage pack.

You can configure the widget to display only the By Category stacked bar, or you can show the stacked bar plus the admin (/), /Volume, and /boot partition usage, as well as the /var/storage partition if the malware storage pack is installed, by modifying the widget preferences.
The widget preferences also control how often the widget updates, as well as whether it displays the current disk usage or collected disk usage statistics over the dashboard time range.

**The Interface Traffic Widget**

The Interface Traffic widget shows the rate of traffic received (Rx) and transmitted (Tx) on the appliance’s management interface. For 7000 & 8000 Series devices, the widget also shows information on the sensing interfaces. The widget does not appear by default on any of the predefined dashboards.

Outbound (transmitted) traffic includes flow control packets. Because of this, passive sensing interfaces on 7000 & 8000 Series devices may show transmitted traffic; this is expected behavior. Devices with Malware licenses enabled periodically attempt to connect to the AMP cloud even if you have not configured dynamic analysis. Because of this, these devices show transmitted traffic; this is also expected behavior.

The widget preferences control how often the widget updates. On 7000 & 8000 Series devices, the preferences also control whether the widget displays the traffic rate for unused interfaces (by default, the widget only displays the traffic rate for active interfaces).

**The Intrusion Events Widget**

The Intrusion Events widget shows the intrusion events that occurred over the dashboard time range, organized by priority. This includes statistics on intrusion events with dropped packets and different impacts. This widget appears by default on the Intrusion Events tab of the Summary Dashboard.

In the widget preferences, you can choose:

- **Event Flags** to display separate graphs for events with dropped packets, would have dropped packets, or specific impacts. Choose **All** to display an additional graph for all intrusion events, regardless of impact or rule state.

  For explanations of the icons, see Working with Intrusion Events, on page 1621. The arrow (if any) that appears above the impact level numbers describes the inline result and is defined as follows:

<table>
<thead>
<tr>
<th>This Icon</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>A black down arrow</td>
<td>The system dropped the packet that triggered the rule</td>
</tr>
<tr>
<td>A gray down arrow</td>
<td>IPS would have dropped the packet if you enabled the Drop when Inline intrusion policy option (in an inline deployment), or if a Drop and Generate rule generated the event while the system was pruning</td>
</tr>
<tr>
<td>No icon (blank)</td>
<td>The triggered rule was not set to Drop and Generate Events</td>
</tr>
</tbody>
</table>

In a passive deployment, the system does not drop packets, including when an inline interface is in tap mode, regardless of the rule state or the inline drop behavior of the intrusion policy.

- **Show** to specify Average Events Per Second (EPS) or Total Events.
- **Vertical Scale** to specify Linear (incremental) or Logarithmic (factor of ten) scale.
- How often the widget updates.

On the widget, you can:
The Network Compliance Widget

The Network Compliance widget summarizes your hosts’ compliance with the white lists you configured. By default, the widget displays a pie chart that shows the number of hosts that are compliant, non-compliant, and that have not been evaluated, for all compliance white lists in active correlation policies. This widget appears by default on the Correlation tab of the Detailed Dashboard.

You can configure the widget to display network compliance either for all white lists or for a specific white list by modifying the widget preferences.

If you choose to display network compliance for all white lists, the widget considers a host to be non-compliant if it is not compliant with any white list in an active correlation policy.

You can also use the widget preferences to specify which of three different styles you want to use to display network compliance.

The **Network Compliance** style (the default) displays a pie chart that shows the number of hosts that are compliant, non-compliant, and that have not been evaluated. You can click the pie chart to view the host violation count, which lists the hosts that violate at least one white list.

The **Network Compliance over Time (%)** style displays a stacked area graph showing the relative proportion of hosts that are compliant, non-compliant, and that have not yet been evaluated, over the dashboard time range.

The **Network Compliance over Time** style displays a line graph that shows the number of hosts that are compliant, non-compliant, and that have not yet been evaluated, over the dashboard time range.

The preferences control how often the widget updates. You can check the **Show Not Evaluated** box to hide events which have not been evaluated.

The Product Licensing Widget

The Product Licensing widget shows the device and feature licenses currently installed on the Firepower Management Center. It also indicates the number of items licensed and the number of remaining licensed items allowed. It does not appear by default on any of the predefined dashboards.

The top section of the widget displays all device and feature licenses installed on the Firepower Management Center, including temporary licenses, while the Expiring Licenses section displays only temporary and expired licenses.

The bars in the widget background show the percentage of each type of license that is being used; you should read the bars from right to left. Expired licenses are marked with a strikethrough.
You can configure the widget to display either the features that are currently licensed, or all the features that you can license, by modifying the widget preferences. The preferences also control how often the widget updates.

You can click any of the license types to go to the License page of the local configuration and add or delete feature licenses.

The Product Updates Widget

The Product Updates widget provides you with a summary of the software currently installed on the appliance as well as information on updates that you have downloaded, but not yet installed. This widget appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard.

Because the widget uses scheduled tasks to determine the latest version, it displays Unknown until you configure a scheduled task to download, push or install updates.

You can configure the widget to hide the latest versions by modifying the widget preferences. The preferences also control how often the widget updates.

The widget also provides you with links to pages where you can update the software. You can:

- Manually update an appliance by clicking the current version.
- Create a scheduled task to download an update by clicking the latest version.

The RSS Feed Widget

The RSS Feed widget adds an RSS feed to a dashboard. By default, the widget shows a feed of Cisco security news. It appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard.

You can also configure the widget to display a preconfigured feed of company news, the Snort.org blog, or the Cisco Threat Research blog, or you can create a custom connection to any other RSS feed by specifying its URL in the widget preferences.

Feeds update every 24 hours (although you can manually update the feed), and the widget displays the last time the feed was updated based on the local time of the appliance. Keep in mind that the appliance must have access to the web site (for the two preconfigured feeds) or to any custom feed you configure.

When you configure the widget, you can also choose how many stories from the feed you want to show in the widget, as well as whether you want to show descriptions of the stories along with the headlines; keep in mind that not all RSS feeds use descriptions.

On the RSS Feed widget, you can:

- click one of the stories in the feed to view the story
- click the more link to go to the feed’s web site
- click the update icon (📢) to manually update the feed

The System Load Widget

The System Load widget shows the CPU usage (for each CPU), memory (RAM) usage, and system load (also called the load average, measured by the number of processes waiting to execute) on the appliance, both currently and over the dashboard time range. It appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard.
You can configure the widget to show or hide the load average by modifying the widget preferences. The preferences also control how often the widget updates.

**The System Time Widget**

The System Time widget shows the local system time, uptime, and boot time for the appliance. It appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard.

You can configure the widget to hide the boot time by modifying the widget preferences. The preferences also control how often the widget synchronizes with the appliance’s clock.

**The White List Events Widget**

The White List Events widget shows the average events per second by priority, over the dashboard time range. It appears by default on the Correlation tab of the Default Dashboard.

You can configure the widget to display white list events of different priorities by modifying the widget preferences.

In the widget preferences, you can:

- choose one or more **Priorities** check boxes to display separate graphs for events of specific priorities, including events that do not have a priority
- choose **Show All** to display an additional graph for all white list events, regardless of priority
- choose **Vertical Scale** to choose **Linear** (incremental) or **Logarithmic** (factor of ten) scale

The preferences also control how often the widget updates.

You can click a graph to view white list events of a specific priority, or click the **All** graph to view all white list events. In either case, the events are constrained by the dashboard time range; accessing white list events via the dashboard changes the events (or global) time window for the Firepower Management Center.

**Managing Dashboards**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose **Overview > Dashboards**, and then choose the dashboard you want to modify from the menu.

**Step 2** Manage your dashboards:

- **Create Dashboards** — Create a custom dashboard; see *Creating Custom Dashboards*, on page 213.
- **Delete Dashboards** — To delete a dashboard, click the delete icon (🗑️) next to the dashboard you want to delete. If you delete your default dashboard, you must define a new default or the appliance prompts you to choose a dashboard every time you attempt to view a dashboard.
- **Edit Options** — Edit custom dashboard options; see *Editing Dashboards Options*, on page 215.
• Modify Time Constraints — Modify the time display or pause/unpause the dashboard as described in Modifying Dashboard Time Settings, on page 216.

Step 3
Manage dashboard tabs:

• Add Tabs — Add a tab to a dashboard; see Adding a Dashboard Tab, on page 211.

• Delete Tabs — To delete a dashboard tab, click the close icon (×) in the top right corner of the tab, and confirm by clicking OK. You cannot delete the last tab from a dashboard; each dashboard must have at least one tab.

• Rename Tabs — Rename a tab in a dashboard; see Renaming a Dashboard Tab, on page 217.

Note You cannot change the order of dashboard tabs.

Step 4
Manage dashboard widgets:

• Add Widgets — Add widgets to a dashboard; see Adding Widgets to a Dashboard, on page 212.

• Configure Preferences — Configure widget preferences; see Configuring Widget Preferences, on page 213.

• Customize Display — Customize the widget display; see Customizing the Widget Display, on page 215.

• View Events — View associated events from the Custom Analysis Widget; see Viewing Associated Events from the Custom Analysis Widget, on page 205.

Tip Every configuration of the Custom Analysis widget in the Cisco predefined dashboards corresponds to a system preset for that widget. If you change or delete one of these widgets, you can restore it by creating a new Custom Analysis widget based on the appropriate preset.

---

### Adding a Dashboard Tab

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** View the dashboard you want to modify; see Viewing Dashboards, on page 217.

**Step 2** Click the add icon (+) next to the last existing tab.

**Step 3** Enter a name for the tab.

**Step 4** Click OK.
Adding Widgets to a Dashboard

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>

Each tab can display one or more widgets in a three-column layout. When adding a widget to a dashboard, you choose the tab to which you want to add the widget. The system automatically adds it to the column with the fewest widgets. If all columns have an equal number of widgets, the new widget is added to the leftmost column. You can add a maximum of 15 widgets to a dashboard tab.

Tip

After you add widgets, you can move them to any location on the tab. You cannot, however, move widgets from tab to tab.

The dashboard widgets you can view depend on the type of appliance you are using, your user role, and your current domain (in a multidomain deployment). Keep in mind that because not all user roles have access to all dashboard widgets, users with fewer permissions viewing a dashboard created by a user with more permissions may not be able to use all of the widgets on the dashboard. Although the unauthorized widgets still appear on the dashboard, they are disabled.

**Procedure**

**Step 1** View the dashboard where you want to add a widget; see Viewing Dashboards, on page 217.

**Step 2** Click the tab where you want to add the widget.

**Step 3** Click **Add Widgets**. You can view the widgets in each category by clicking on the category name, or you can view all widgets by clicking **All Categories**.

**Step 4** Click **Add** next to the widgets you want to add. The Add Widgets page indicates how many widgets of each type are on the tab, including the widget you want to add.

Tip

To add multiple widgets of the same type (for example, you may want to add multiple RSS Feed widgets, or multiple Custom Analysis widgets), click **Add** again.

**Step 5** When you are finished adding widgets, click **Done** to return to the dashboard.

**What to do next**

- If you added a Custom Analysis widget, configure the widget preferences; see Configuring Widget Preferences, on page 213.

**Related Topics**

Widget Availability, on page 198
Configuring Widget Preferences

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>

Each widget has a set of preferences that determines its behavior.

**Procedure**

**Step 1**
On the title bar of the widget whose preferences you want to change, click the show preferences icon (✓).

**Step 2**
Make changes as needed.

**Step 3**
On the widget title bar, click the hide preferences icon (✗) to hide the preferences section.

Creating Custom Dashboards

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>

Tip

Instead of creating a new dashboard, you can export a dashboard from another appliance, then import it onto your appliance. You can then edit the imported dashboard to suit your needs.

**Procedure**

**Step 1**
Choose Overview > Dashboards > Management.

**Step 2**
Click Create Dashboard.

**Step 3**
Modify the custom dashboard options as described in Custom Dashboard Options, on page 213.

**Step 4**
Click Save.

Custom Dashboard Options

The table below describes options you can use when creating or editing custom dashboards.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Dashboard</td>
<td>When you create a custom dashboard, you can choose to base it on any existing dashboard, whether user-created or system-defined. This option makes a copy of the preexisting dashboard, which you can modify to suit your needs. Optionally, you can create a blank new dashboard by choosing None. This option is available only when you create a new dashboard. In a multidomain deployment, you can copy any non-private dashboards from ancestor domains.</td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the custom dashboard.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the custom dashboard.</td>
</tr>
<tr>
<td>Change Tabs Every</td>
<td>Specifies (in minutes) how often the dashboard should cycle through its tabs. Unless you pause the dashboard or your dashboard has only one tab, this setting advances your view to the next tab at the interval you specify. To disable tab cycling, enter 0 in the Change Tabs Every field.</td>
</tr>
<tr>
<td>Refresh Page Every</td>
<td>Specifies (in minutes) how often the current dashboard tab should refresh with new data. This value must be greater than the Change Tabs Every setting. Unless you pause the dashboard, this setting will refresh the entire dashboard at the interval you specify. To disable the periodic page refresh, enter 0 in the Refresh Page Every field. Determines how often the entire dashboard page automatically refreshes. Refreshing the entire dashboard allows you to see any preference or layout changes that were made to a shared dashboard by another user, or that you made to a private dashboard on another computer, since the last time the dashboard refreshed. A frequent refresh can be useful, for example, in a networks operations center (NOC) where a dashboard is displayed at all times. If you make changes to the dashboard at a local computer, the dashboard in the NOC automatically refreshes at the interval you specify, and no manual refresh is required. Note that you do not need to refresh the entire dashboard to see data updates; individual widgets update according to their preferences.</td>
</tr>
<tr>
<td>Note</td>
<td>This setting is separate from the update interval available on many individual widgets; although refreshing the dashboard page resets the update interval on individual widgets, widgets will update according to their individual preferences even if you disable the Refresh Page Every setting.</td>
</tr>
</tbody>
</table>
### Customizing the Widget Display

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save As Private</td>
<td>Determines whether the custom dashboard can be viewed and modified by all users of the appliance or is associated with your user account and reserved solely for your own use. Keep in mind that any user with dashboard access, regardless of role, can modify shared dashboards. If you want to make sure that only you can modify a particular dashboard, save it as private.</td>
</tr>
</tbody>
</table>

### Customizing the Widget Display

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>

You can minimize and maximize widgets, as well as rearrange the widgets on a tab.

**Procedure**

**Step 1** View a dashboard; see Viewing Dashboards, on page 217.

**Step 2** Customize the widget display:

- To rearrange a widget on a tab, click the title bar of the widget you want to move, then drag it to its new location.
  
  **Note** You cannot move widgets from tab to tab. If you want a widget to appear on a different tab, you must delete it from the existing tab and add it to the new tab.

- To minimize or maximize a widget on the dashboard, click the minimize (−) or maximize icon () in a widget’s title bar.

- To delete a widget if you no longer want to view it on a tab, click the close icon (×) in the title bar of the widget.

### Editing Dashboards Options

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>
Modifying Dashboard Time Settings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>

You can change the time range to reflect a period as short as the last hour (the default) or as long as the last year. When you change the time range, the widgets that can be constrained by time automatically update to reflect the new time range.

Note that not all widgets can be constrained by time. For example, the dashboard time range has no effect on the Appliance Information widget, which provides information that includes the appliance name, model, and current version of the Firepower System software.

Keep in mind that for enterprise deployments of the Firepower System, changing the time range to a long period may not be useful for widgets like the Custom Analysis widget, depending on how often newer events replace older events.

You can also pause a dashboard, which allows you to examine the data provided by the widgets without the display changing and interrupting your analysis. Pausing a dashboard has the following effects:

- Individual widgets stop updating, regardless of any Update Every widget preference.
- Dashboard tabs stop cycling, regardless of the Cycle Tabs Every setting in the dashboard properties.
- Dashboard pages stop refreshing, regardless of the Refresh Page Every setting in the dashboard properties.
- Changing the time range has no effect.

When you are finished with your analysis, you can unpause the dashboard. Unpausing the dashboard causes all appropriate widgets on the page to update to reflect the current time range. In addition, dashboard tabs resume cycling and the dashboard page resumes refreshing according to the settings you specified in the dashboard properties.

If you experience connectivity problems or other issues that interrupt the flow of system information to the dashboard, the dashboard automatically pauses and an error notice appears until the problem is resolved.

Note: Your session normally logs you out after 1 hour of inactivity (or another configured interval), regardless of whether the dashboard is paused. If you plan to passively monitor the dashboard for long periods of time, consider exempting some users from session timeout, or changing the system timeout settings.
Procedure

Step 1 View the dashboard where you want to add a widget; see Viewing Dashboards, on page 217.
Step 2 Optionally, to change the dashboard time range, choose a time range from the Show the Last drop-down list.
Step 3 Optionally, pause or unpause the dashboard on the time range control, using the pause (ⅰ) or play icon (▶).

Renaming a Dashboard Tab

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>

Procedure

Step 1 View the dashboard you want to modify; see Viewing Dashboards, on page 217.
Step 2 Click the tab title you want to rename.
Step 3 Type a name for the tab.
Step 4 Click OK.

Viewing Dashboards

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Maint</td>
</tr>
</tbody>
</table>

By default, the home page for your appliance displays the default dashboard. If you do not have a default dashboard defined, the home page shows the Dashboard Management page, where you can choose a dashboard to view.

Procedure

At any time, you can do one of the following:

• To view the default dashboard for your appliance, choose Overview > Dashboards.
• To view a specific dashboard, choose Overview > Dashboards, and choose the dashboard from the menu.
• To view all available dashboards, choose **Overview > Dashboards > Management**. You can then choose the view icon (🔍) next to an individual dashboard to view it.
Health Monitoring

The following topics describe how to use health monitoring in the Firepower System:

- About Health Monitoring, on page 219
- Health Policies, on page 225
- The Health Monitor Blacklist, on page 229
- Health Monitor Alerts, on page 231
- Using the Health Monitor, on page 234
- Viewing Appliance Health Monitors, on page 236
- Health Event Views, on page 240
- History for Health Monitoring, on page 245

About Health Monitoring

The health monitor on the Firepower Management Center tracks a variety of health indicators to ensure that the hardware and software in the Firepower System are working correctly. You can use the health monitor to check the status of critical functionality across your Firepower System deployment.

You can use the health monitor to create a collection of tests, referred to as a health policy, and apply the health policy to one or more appliances. The tests, referred to as health modules, are scripts that test for criteria you specify. You can modify a health policy by enabling or disabling tests or by changing test settings, and you can delete health policies that you no longer need. You can also suppress messages from selected appliances by blacklisting them.

The tests in a health policy run automatically at the interval you configure. You can also run all tests, or a specific test, on demand. The health monitor collects health events based on the test conditions configured.
All Appliances automatically report their hardware status via the Hardware Alarms health module. The Firepower Management Center also automatically reports status using the modules configured in the default health policy. Some health modules, such as the Appliance Heartbeat module, run on the Firepower Management Center and report the status of the Firepower Management Center's managed devices. Some health modules do not provide managed device status unless you apply a health policy configured with those modules to a device.

You can use the health monitor to access health status information for the entire system, for a particular appliance, or, in a multidomain deployment, a particular domain. Pie charts and status tables on the Health Monitor page provide a visual summary of the status of all appliances on your network, including the Firepower Management Center. Individual appliance health monitors let you drill down into health details for a specific appliance.

Fully customizable event views allow you to quickly and easily analyze the health status events gathered by the health monitor. These event views allow you to search and view event data and to access other information that may be related to the events you are investigating. For example, if you want to see all the occurrences of CPU usage with a certain percentage, you can search for the CPU usage module and enter the percentage value.

You can also configure email, SNMP, or syslog alerting in response to health events. A health alert is an association between a standard alert and a health status level. For example, if you need to make sure an appliance never fails due to hardware overload, you can set up an email alert. You can then create a health alert that triggers that email alert whenever CPU, disk, or memory usage reaches the Warning level you configure in the health policy applied to that appliance. You can set alerting thresholds to minimize the number of repeating alerts you receive.

You can also generate troubleshooting files for an appliance if you are asked to do so by Support.

Because health monitoring is an administrative activity, only users with administrator user role privileges can access system health data.

### Health Modules

*Health modules, or health tests, test for the criteria you specify in a health policy.*

<table>
<thead>
<tr>
<th>Module</th>
<th>Appliances</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMP for Endpoints</td>
<td>FMC</td>
<td>The module alerts if the Firepower Management Center cannot connect to the AMP cloud or Cisco AMP Private Cloud after an initial successful connection, or if the private cloud cannot contact the public AMP cloud. It also alerts if you deregister an AMP cloud connection using the AMP for Endpoints management console.</td>
</tr>
</tbody>
</table>

---

**Note**

You can use the health monitor to access health status information for the entire system, for a particular appliance, or, in a multidomain deployment, a particular domain. Pie charts and status tables on the Health Monitor page provide a visual summary of the status of all appliances on your network, including the Firepower Management Center. Individual appliance health monitors let you drill down into health details for a specific appliance.
<table>
<thead>
<tr>
<th>Module</th>
<th>Appliances</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMP for Firepower Status</td>
<td>FMC</td>
<td>This module alerts if:</td>
</tr>
<tr>
<td>(AMP for Networks Status)</td>
<td></td>
<td>• The Firepower Management Center cannot contact the AMP cloud (public or private) or the Cisco Threat Grid public cloud or on-premises appliance, or the AMP private cloud cannot contact the public AMP cloud.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The encryption keys used for the connection are invalid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A device cannot contact the Cisco Threat Grid cloud or an Cisco Threat Grid on-premises appliance to submit files for dynamic analysis.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• An excessive number of files are detected in network traffic based on the file policy configuration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If your Firepower Management Center loses connectivity to the Internet, the system may take up to 30 minutes to generate an AMP for Firepower Status health alert.</td>
</tr>
<tr>
<td>Appliance Heartbeat</td>
<td>Any</td>
<td>This module determines if an appliance heartbeat is being heard from the appliance and alerts based on the appliance heartbeat status.</td>
</tr>
<tr>
<td>Automatic Application Bypass Status</td>
<td>7000 &amp; 8000 Series</td>
<td>This module determines if an appliance has been bypassed because it did not respond within the number of seconds set in the bypass threshold, and alerts when a bypass occurs.</td>
</tr>
<tr>
<td>Classic License Monitor</td>
<td>FMC</td>
<td>This module determines if sufficient Classic licenses for Control, Protection, URL Filtering, Malware, and VPN remain. It also alerts when devices in a stack have mismatched license sets. It alerts based on a warning level automatically configured for the module. You cannot change the configuration of this module.</td>
</tr>
<tr>
<td>CPU Usage</td>
<td>Any</td>
<td>This module checks that the CPU on the appliance is not overloaded and alerts when CPU usage exceeds the percentages configured for the module.</td>
</tr>
<tr>
<td>Card Reset</td>
<td>Any</td>
<td>This module checks for network cards which have restarted due to hardware failure and alerts when a reset occurs.</td>
</tr>
<tr>
<td>Disk Status</td>
<td>Any</td>
<td>This module examines performance of the hard disk, and malware storage pack (if installed) on the appliance. This module generates a Warning (yellow) health alert when the hard disk and RAID controller (if installed) are in danger of failing, or if an additional hard drive is installed that is not a malware storage pack. This module generates an Alert (red) health alert when an installed malware storage pack cannot be detected.</td>
</tr>
</tbody>
</table>
## Module | Appliances | Description
--- | --- | ---
Disk Usage | Any | This module compares disk usage on the appliance’s hard drive and malware storage pack to the limits configured for the module and alerts when usage exceeds the percentages configured for the module. This module also alerts when the system excessively deletes files in monitored disk usage categories, or when disk usage excluding those categories reaches excessive levels, based on module thresholds. Use the Disk Usage health status module to monitor disk usage for the / and /volume partitions on the appliance and track draining frequency. Although the disk usage module lists the /boot partition as a monitored partition, the size of the partition is static so the module does not alert on the boot partition.

FireSIGHT Host Limit | FMC | This module determines if the number of hosts the Firepower Management Center can monitor is approaching the limit and alerts based on the warning level configured for the module. For more information, see Firepower System Host Limit, on page 1209.

Hardware Alarms | 7000 & 8000 Series | This module determines if hardware needs to be replaced on a physical managed device and alerts based on the hardware status. The module also reports on the status of hardware-related daemons and on the status of 7000 and 8000 Series devices in high-availability deployments.

Health Monitor Process | Any | This module monitors the status of the health monitor itself and alerts if the number of minutes since the last health event received by the Firepower Management Center exceeds the Warning or Critical limits.

Inline Link Mismatch Alarms | Any managed device except ASA FirePOWER | This module monitors the ports associated with inline sets and alerts if the two interfaces of an inline pair negotiate different speeds.

Intrusion and File Event Rate | Any managed device | This module compares the number of intrusion events per second to the limits configured for this module and alerts if the limits are exceeded. If the Intrusion and File Event Rate is zero, the intrusion process may be down or the managed device may not be sending events. Select Analysis > Intrusions > Events to check if events are being received from the device.

Typically, the event rate for a network segment averages 20 events per second. For a network segment with this average rate, Events per second (Critical) should be set to 50 and Events per second (Warning) should be set to 30. To determine limits for your system, find the Events/Sec value on the Statistics page for your device (System > Monitoring > Statistics), then calculate the limits using these formulas:

- Events per second (Critical) = Events/Sec * 2.5
- Events per second (Warning) = Events/Sec * 1.5

The maximum number of events you can set for either limit is 999, and the Critical limit must be higher than the Warning limit.
<table>
<thead>
<tr>
<th>Module</th>
<th>Appliances</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Status</td>
<td>Any</td>
<td>This module determines if the device currently collects traffic and alerts based on the traffic status of physical interfaces and aggregate interfaces. For physical interfaces, the information includes interface name, link state, and bandwidth. For aggregate interfaces, the information includes interface name, number of active links, and total aggregate bandwidth. For ASA FirePOWER, interfaces labeled DataPlaneInterface{x}, where x is a numerical value, are internal interfaces (not user-defined) and involve packet flow within the system.</td>
</tr>
<tr>
<td>Link State Propagation</td>
<td>Any except NGIPSv, ASA FirePOWER, Firepower 9300</td>
<td>This module determines when a link in a paired inline set fails and triggers the link state propagation mode. If a link state propagates to the pair, the status classification for that module changes to Critical and the state reads: <strong>Module Link State Propagation: ethx_ethy is Triggered</strong> where x and y are the paired interface numbers.</td>
</tr>
<tr>
<td>Local Malware Analysis</td>
<td>Any</td>
<td>This module alerts if a device is configured for local malware analysis and fails to download local malware analysis engine signature updates from the AMP cloud.</td>
</tr>
<tr>
<td>Memory Usage</td>
<td>Any</td>
<td>This module compares memory usage on the appliance to the limits configured for the module and alerts when usage exceeds the levels configured for the module. For appliances with more than 4GB of memory, the preset alert thresholds are based on a formula that accounts for proportions of available memory likely to cause system problems. On &gt;4GB appliances, because the interval between Warning and Critical thresholds may be very narrow, Cisco recommends that you manually set the <strong>Warning Threshold %</strong> value to 50. This will further ensure that you receive memory alerts for your appliance in time to address the issue. Complex access control policies and rules can command significant resources and negatively affect performance. Some lower-end ASA devices with FirePOWER Services Software may generate intermittent memory usage warnings, as the device’s memory allocation is being used to the fullest extent possible.</td>
</tr>
<tr>
<td>Power Supply</td>
<td>Physical FMCs, 7000 &amp; 8000 Series</td>
<td>This module determines if power supplies on the device require replacement and alerts based on the power supply status. <strong>Note</strong> If an 8000 Series managed device experiences a power failure, it may take up to 20 minutes to generate an alert.</td>
</tr>
<tr>
<td>Module</td>
<td>Appliances</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Process Status</td>
<td>Any</td>
<td>This module determines if processes on the appliance exit or terminate outside of the process manager. If a process is deliberately exited outside of the process manager, the module status changes to Warning and the health event message indicates which process exited, until the module runs again and the process has restarted. If a process terminates abnormally or crashes outside of the process manager, the module status changes to Critical and the health event message indicates the terminated process, until the module runs again and the process has restarted.</td>
</tr>
<tr>
<td>Reconfiguring Detection</td>
<td>Any managed device</td>
<td>This module alerts if a device reconfiguration has failed.</td>
</tr>
<tr>
<td>RRD Server Process</td>
<td>FMC</td>
<td>This module determines if the round robin data server that stores time series data is running properly. The module will alert if the RRD server has restarted since the last time it updated; it will enter Critical or Warning status if the number of consecutive updates with an RRD server restart reaches the numbers specified in the module configuration.</td>
</tr>
<tr>
<td>Security Intelligence</td>
<td>FMC and some managed devices</td>
<td>This module alerts if Security Intelligence is in use and:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The Firepower Management Center cannot update a feed, or feed data is corrupt or contains no recognizable IP addresses.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- A managed device had a problem receiving updated Security Intelligence data from the Firepower Management Center.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- A managed device cannot load all of the Security Intelligence data provided to it by the Firepower Management Center due to memory issues; see Troubleshooting Memory Use, on page 680.</td>
</tr>
<tr>
<td>Time Series Data Monitor</td>
<td>FMC</td>
<td>This module tracks the presence of corrupt files in the directory where time series data (such as correlation event counts) are stored and alerts when files are flagged as corrupt and removed.</td>
</tr>
<tr>
<td>Time Synchronization Status</td>
<td>Any</td>
<td>This module tracks the synchronization of a device clock that obtains time using NTP with the clock on the NTP server and alerts if the difference in the clocks is more than ten seconds.</td>
</tr>
<tr>
<td>URL Filtering Monitor</td>
<td>FMCs</td>
<td>This module alerts if the Firepower Management Center fails to:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Communicate with, or retrieve a URL threat intelligence data update from, Cisco Collective Security Intelligence (CSI).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Push URL threat data to its managed devices.</td>
</tr>
<tr>
<td>User Agent Status Monitor</td>
<td>FMC</td>
<td>This module alerts when heartbeats are not detected for any User Agents connected to the Firepower Management Center.</td>
</tr>
<tr>
<td>VPN Status</td>
<td>FMC</td>
<td>This module alerts when one or more VPN tunnels between Firepower System devices are down.</td>
</tr>
</tbody>
</table>
Configuring Health Monitoring

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Determine which health modules you want to monitor as discussed in Health Modules, on page 220. You can set up specific policies for each kind of appliance you have in your Firepower System, enabling only the appropriate tests for that appliance.

**Tip** To quickly enable health monitoring without customizing the monitoring behavior, you can apply the default policy provided for that purpose.

**Step 2** Apply a health policy to each appliance where you want to track health status as discussed in Creating Health Policies, on page 226.

**Step 3** (Optional.) Configure health monitor alerts as discussed in Creating Health Monitor Alerts, on page 232. You can set up email, syslog, or SNMP alerts that trigger when the health status level reaches a particular severity level for specific health modules.

**Health Policies**

A health policy contains configured health test criteria for several modules. You can control which health modules run against each of your appliances and configure the specific limits used in the tests run by each module.

When you configure a health policy, you decide whether to enable each health module for that policy. You also select the criteria that control which health status each enabled module reports each time it assesses the health of a process.

You can create one health policy that can be applied to every appliance in your system, customize each health policy to the specific appliance where you plan to apply it, or use the default health policy provided for you. In a multidomain deployment, administrators in ancestor domains can apply health policies to devices in descendant domains, which descendant domains can use or replace with customized local policies.

**Default Health Policy**

The health monitor on the Firepower Management Center provides a default health policy to allow you to quickly implement health monitoring for your appliances. In the default health policy, most of the health modules available on the running platform are automatically enabled. The default health policy is automatically applied to the Firepower Management Center. Additionally, the default health policy is applied to a managed device when you add the device to the Firepower Management Center. You cannot edit the default health policy, but you can copy it to create custom policies based on its configuration.
Creating Health Policies

If you want to customize a health policy to use with your appliances, you can create a new policy. The settings in the policy initially populate with the settings from the health policy you choose as a basis for the new policy. You can enable or disable modules within the policy and change the alerting criteria for each module as needed.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain. Administrators in ancestor domains can apply health policies to devices in descendant domains, which descendant domains can use or replace with customized local policies.

**Procedure**

**Step 1** Choose System > Health > Policy.

**Step 2** Click Create Policy.

**Step 3** Choose the existing policy that you want to use as the basis for the new policy from the Copy Policy drop-down list.

**Step 4** Enter a name for the policy.

**Step 5** Enter a description for the policy.

**Step 6** Choose Save to save the policy information.

**Step 7** Choose the module you want to use.

**Step 8** Choose On for the Enabled option to enable use of the module for health status testing.

**Step 9** Where appropriate, set the Critical and Warning criteria.

**Step 10** Configure any additional settings for the module. Repeat steps 7-10 for each module.

**Step 11** You have three choices:

- To save your changes to this module and return to the Health Policy page, click Save Policy and Exit.
- To return to the Health Policy page without saving any of your settings for this module, click Cancel.
- To temporarily save your changes to this module and switch to another module’s settings to modify, choose the other module from the list at the left of the page. If you click Save Policy and Exit when you are done, all changes you made will be saved; if you click Cancel, you discard all changes.

**What to do next**

- Apply the health policy to each appliance as described in Applying Health Policies, on page 227. This applies your changes and updates the policy status for all affected policies.
Applying Health Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

When you apply a health policy to an appliance, the health tests for all the modules you enabled in the policy automatically monitor the health of the processes and hardware on the appliance. Health tests then continue to run at the intervals you configured in the policy, collecting health data for the appliance and forwarding that data to the Firepower Management Center.

If you enable a module in a health policy and then apply the policy to an appliance that does not require that health test, the health monitor reports the status for that health module as disabled.

If you apply a policy with all modules disabled to an appliance, it removes all applied health policies from the appliance so no health policy is applied.

When you apply a different policy to an appliance that already has a policy applied, expect some latency in the display of new data based on the newly applied tests.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain. Administrators in ancestor domains can apply health policies to devices in descendant domains, which descendant domains can use or replace with customized local policies.

Procedure

**Step 1** Choose System > Health > Policy.
**Step 2** Click the apply icon (✓) next to the policy you want to apply.

**Tip**
The status icon (✓) next to the Health Policy column indicates the current health status for the appliance. The status icon (✗) next to the System Policy column indicates the communication status between the Firepower Management Center and the device. Note that you can remove the currently applied policy by clicking the remove icon (✗).

**Step 3** Choose the appliances where you want to apply the health policy.
**Step 4** Click Apply to apply the policy to the appliances you chose.

What to do next

- Optionally, monitor the task status; see Viewing Task Messages, on page 261.

Monitoring of the appliance starts as soon as the policy is successfully applied.
Editing Health Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain. Administrators in ancestor domains can apply health policies to devices in descendant domains, which descendant domains can use or replace with customized local policies.

Procedure

**Step 1** Choose **System > Health > Policy**.

**Step 2** Click the edit icon (✏️) next to the policy you want to modify.

**Step 3** Edit the **Policy Name** or **Policy Description** fields as desired.

**Step 4** Click the health module you want to modify.

**Step 5** Modify settings as described in Health Modules, on page 220.

**Step 6** You have three options:

- To save your changes to this module and return to the Health Policy page, click **Save Policy and Exit**.
- To return to the Health Policy page without saving any of your settings for this module, click **Cancel**.
- To temporarily save your changes to this module and switch to another module’s settings to modify, choose the other module from the list at the left of the page. If you click **Save Policy and Exit** when you are done, all changes you made will be saved; if you click **Cancel**, you discard all changes.

What to do next

- Reapply the health policy as described in Applying Health Policies, on page 227. This applies your changes and updates the policy status for all affected policies.

Deleting Health Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You can delete health policies that you no longer need. If you delete a policy that is still applied to an appliance, the policy settings remain in effect until you apply a different policy. In addition, if you delete a health policy that is applied to a device, any health monitoring alerts in effect for the device remain active until you disable the underlying associated alert response.

In a multidomain deployment, you can only delete health policies created in the current domain.
To stop health monitoring for an appliance, create a health policy with all modules disabled and apply it to the appliance.

### Procedure

**Step 1**  
Choose **System > Health > Policy**.

**Step 2**  
Click the delete icon (🗑️) next to the policy you want to delete. A message appears, indicating if the deletion was successful.

---

## The Health Monitor Blacklist

In the course of normal network maintenance, you disable appliances or make them temporarily unavailable. Because those outages are deliberate, you do not want the health status from those appliances to affect the summary health status on your Firepower Management Center.

You can use the health monitor blacklist feature to disable health monitoring status reporting on an appliance or module. For example, if you know that a segment of your network will be unavailable, you can temporarily disable health monitoring for a managed device on that segment to prevent the health status on the Firepower Management Center from displaying a warning or critical state because of the lapsed connection to the device.

When you disable health monitoring status, health events are still generated, but they have a disabled status and do not affect the health status for the health monitor. If you remove the appliance or module from the blacklist, the events that were generated during the blacklisting continue to show a status of disabled.

To temporarily disable health events from an appliance, go to the blacklist configuration page and add an appliance to the blacklist. After the setting takes effect, the system no longer includes the blacklisted appliance when calculating the overall health status. The Health Monitor Appliance Status Summary lists the appliance as disabled.

At times it may be more practical to just blacklist an individual health monitoring module on an appliance. For example, when you reach the host limit on a Firepower Management Center, you can blacklist the FireSIGHT Host Limit status messages.

Note that on the main Health Monitor page you can distinguish between appliances that are blacklisted if you expand to view the list of appliances with a particular status by clicking the arrow in that status row.

A blacklist icon (🗑️) and a notation are visible after you expand the view for a blacklisted or partially blacklisted appliance.

---

**Note**  
On a Firepower Management Center, Health Monitor blacklist settings are local configuration settings. Therefore, if you blacklist a device, then delete it and later re-register it with the Firepower Management Center, the blacklist settings remain persistent. The newly re-registered device remains blacklisted.
In a multidomain deployment, administrators in ancestor domains can blacklist an appliance or health module in descendant domains. However, administrators in the descendant domains can override the ancestor configuration and clear the blacklist for devices in their domain.

### Blacklisting Appliances

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You can blacklist appliances individually or by group, model, or associated health policy.

After the blacklist settings take effect, the appliance shows as disabled in the Health Monitor Appliance Module Summary and Device Management page. Health events for the appliance have a status of disabled.

If you need to set the events and health status for an individual appliance to disabled, you can blacklist the appliance. After the blacklist settings take effect, the appliance shows as disabled in the Health Monitor Appliance Module Summary, and health events for the appliance have a status of disabled.

In a multidomain deployment, blacklisting an appliance in an ancestor domain blacklists it for all descendant domains. Descendant domains can override this inherited configuration and clear the blacklisting. You can only blacklist the Firepower Management Center at the Global level.

### Procedure

**Step 1** Choose **System > Health > Blacklist**.

**Step 2** Use the drop-down list on the right to sort the list by appliance group, model, or by policy.

**Tip** The status icon next to the Health Policy column (✓) indicates the current health status for the appliance. The status icon next to the System Policy column (✓) indicates the communication status between the Firepower Management Center and the device.

**Step 3** You have two choices:

- To blacklist all appliances in a group, model, or policy category, check the check box for the category, then click **Blacklist Selected Devices**.
- To clear blacklisting from all appliances in a group, model, or policy category, check the check box for the category, then click **Clear Blacklist on Selected Devices**.

### Blacklisting Health Policy Modules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You can blacklist individual health policy modules on appliances. You may want to do this to prevent events from the module from changing the status for the appliance to warning or critical.
After the blacklist settings take effect, the appliance shows as **Partially Blacklisted** or **All Modules Blacklisted** on the Blacklist page and in the Appliance Health Monitor Module Status Summary, but only in expanded views on the main Appliance Status Summary page.

**Tip**
Make sure that you keep track of individually blacklisted modules so you can reactivate them when you need them. You may miss necessary warning or critical messages if you accidentally leave a module disabled.

In a multidomain deployment, administrators in ancestor domains can blacklist health modules in descendant domains. However, administrators in descendant domains can override this ancestor configuration and clear the blacklisting for policies applied in their domains. You can only blacklist Firepower Management Center health modules at the Global level.

**Procedure**

**Step 1**  Choose **System > Health > Blacklist**.

**Step 2**  Click the edit icon (📝) next to the appliance you want to modify.

**Step 3**  Check the check boxes next to the health policy modules you want to blacklist. Certain modules are applicable to specific devices only; for more information, see **Health Modules, on page 220**.

**Step 4**  Click Save.

**Health Monitor Alerts**

You can set up alerts to notify you through email, through SNMP, or through the system log when the status changes for the modules in a health policy. You can associate an existing alert response with health event levels to trigger and alert when health events of a particular level occur.

For example, if you are concerned that your appliances may run out of hard disk space, you can automatically send an email to a system administrator when the remaining disk space reaches the warning level. If the hard drive continues to fill, you can send a second email when the hard drive reaches the critical level.

In a multidomain deployment, you can view and modify health monitor alerts created in the current domain only.

**Health Monitor Alert Information**

The alerts generated by the health monitor contain the following information:

- **Severity**, which indicates the severity level of the alert.
- **Module**, which specifies the health module whose test results triggered the alert.
- **Description**, which includes the health test results that triggered the alert.

The table below describes these severity levels.
### Table 36: Alert Severities

<table>
<thead>
<tr>
<th>Severity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>The health test results met the criteria to trigger a Critical alert status.</td>
</tr>
<tr>
<td>Warning</td>
<td>The health test results met the criteria to trigger a Warning alert status.</td>
</tr>
<tr>
<td>Normal</td>
<td>The health test results met the criteria to trigger a Normal alert status.</td>
</tr>
<tr>
<td>Error</td>
<td>The health test did not run.</td>
</tr>
<tr>
<td>Recovered</td>
<td>The health test results met the criteria to return to a normal alert status, following a Critical or Warning alert status.</td>
</tr>
</tbody>
</table>

### Creating Health Monitor Alerts

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you create a health monitor alert, you create an association between a severity level, a health module, and an alert response. You can use an existing alert or configure a new one specifically to report on system health. When the severity level occurs for the selected module, the alert triggers.

If you create or update a threshold in a way that duplicates an existing threshold, you are notified of the conflict. When duplicate thresholds exist, the health monitor uses the threshold that generates the fewest alerts and ignores the others. The timeout value for the threshold must be between 5 and 4,294,967,295 minutes.

In a multidomain deployment, you can view and modify health monitor alerts created in the current domain only.

**Before you begin**

- Configure an alert response that governs the Firepower Management Center's communication with the SNMP, syslog, or email server where you send the health alert; see Firepower Management Center Alert Responses, on page 1453.

**Procedure**

1. **Step 1** Choose System > Health > Monitor Alerts.
2. **Step 2** Enter a name for the health alert in the Health Alert Name field.
3. **Step 3** From the Severity list, choose the severity level you want to use to trigger the alert.
4. **Step 4** From the Module list, choose the health policy modules for which you want the alert to apply.
5. **Step 5** From the Alert list, choose the alert response that you want to trigger when the specified severity level is reached.
Step 6  Optionally, in the **Threshold Timeout** field, enter the number of minutes that should elapse before each threshold period ends and the threshold count resets.

Even if the policy run time interval value is less than the threshold timeout value, the interval between two reported health events from a given module is always greater. For example, if you change the threshold timeout to 8 minutes and the policy run time interval is 5 minutes, there is a 10-minute interval (5 x 2) between reported events.

Step 7  Click **Save** to save the health alert.

### Editing Health Monitor Alerts

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can edit existing health monitor alerts to change the severity level, health module, or alert response associated with the health monitor alert.

In a multidomain deployment, you can view and modify health monitor alerts created in the current domain only.

**Procedure**

**Step 1**  Choose **System > Health > Monitor Alerts**.

**Step 2**  Choose the alert you want to modify from the **Active Health Alerts** list.

**Step 3**  Click **Load** to load the configured settings for the alert you chose.

**Step 4**  Modify settings as needed.

**Step 5**  Click **Save** to save the modified health alert.
A message indicates if the alert configuration was successfully saved.

### Deleting Health Monitor Alerts

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can view and modify health monitor alerts created in the current domain only.

**Procedure**

**Step 1**  Choose **System > Health > Monitor Alerts**.
Step 2  Choose the active health alerts you want to delete, then click **Delete**.

---

**What to do next**

- Disable or delete the underlying alert response to ensure that alerting does not continue; see *Firepower Management Center Alert Responses, on page 1453.*

---

**Using the Health Monitor**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Security Analyst</td>
</tr>
</tbody>
</table>

The health monitor provides the compiled health status for all devices managed by the Firepower Management Center, plus the Firepower Management Center. The health monitor is composed of:

- The status table — Provides a count of the managed appliances for this Firepower Management Center by overall health status.
- The pie chart — Indicates the percentage of appliances currently in each health status category.
- The appliance list — Provides details on the health of the managed devices.

In a multidomain deployment, the health monitor in an ancestor domain displays data from all descendant domains. In the descendant domains, it displays data from the current domain only.

**Procedure**

**Step 1**  Choose **System** > **Health** > **Monitor**.

**Step 2**  Choose the appropriate status in the **Status** column of the table or the appropriate portion of the pie chart to the list appliances with that status.

**Tip**  If the arrow in the row for a status level points down, the appliance list for that status shows in the lower table. If the arrow points right, the appliance list is hidden.

**Step 3**  You have the following choices:

- View appliance health monitors; see *Viewing Appliance Health Monitors, on page 236.*
- Create health policies; see *Creating Health Policies, on page 226.*
- Create health monitor alerts; see *Creating Health Monitor Alerts, on page 232.*

---

**Health Monitor Status Categories**

Available status categories are listed by severity in the table below.
<table>
<thead>
<tr>
<th>Status Level</th>
<th>Status Icon</th>
<th>Status Color in Pie Chart</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td><img src="Black" alt="x" /></td>
<td>Black</td>
<td>Indicates that at least one health monitoring module has failed on the appliance and has not been successfully re-run since the failure occurred. Contact your technical support representative to obtain an update to the health monitoring module.</td>
</tr>
<tr>
<td>Critical</td>
<td><img src="Red" alt="critical" /></td>
<td>Red</td>
<td>Indicates that the critical limits have been exceeded for at least one health module on the appliance and the problem has not been corrected.</td>
</tr>
<tr>
<td>Warning</td>
<td><img src="Yellow" alt="warning" /></td>
<td>Yellow</td>
<td>Indicates that warning limits have been exceeded for at least one health module on the appliance and the problem has not been corrected.</td>
</tr>
<tr>
<td>Normal</td>
<td><img src="Green" alt="normal" /></td>
<td>Green</td>
<td>Indicates that all health modules on the appliance are running within the limits configured in the health policy applied to the appliance.</td>
</tr>
<tr>
<td>Recovered</td>
<td><img src="Green" alt="recovered" /></td>
<td>Green</td>
<td>Indicates that all health modules on the appliance are running within the limits configured in the health policy applied to the appliance, including modules that were in a Critical or Warning state.</td>
</tr>
<tr>
<td>Disabled</td>
<td><img src="Blue" alt="disabled" /></td>
<td>Blue</td>
<td>Indicates that an appliance is disabled or blacklisted, that the appliance does not have a health policy applied to it, or that the appliance is currently unreachable.</td>
</tr>
</tbody>
</table>
Viewing Appliance Health Monitors

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst</td>
</tr>
</tbody>
</table>

The Appliance Health Monitor provides a detailed view of the health status of an appliance.

In a multidomain deployment, you can view the health status of appliances in descendant domains.

Tip

Your session normally logs you out after 1 hour of inactivity (or another configured interval). If you plan to passively monitor health status for long periods of time, consider exempting some users from session timeout, or changing the system timeout settings. See User Account Login Options, on page 64 and Configuring Session Timeouts, on page 482 for more information.

Procedure

Step 1
Choose System > Health > Monitor.

Step 2
Expand the appliance list. To show appliances with a particular status, click the arrow in that status row. Alternatively, in the Appliance Status Summary graph, click the color for the appliance status category you want to view.

Tip
If the arrow in the row for a status level points down, the appliance list for that status shows in the lower table. If the arrow points right, the appliance list is hidden.

Step 3
In the Appliance column of the appliance list, click the name of the appliance for which you want to view details.

Step 4
Optionally, in the Module Status Summary graph, click the color for the event status category you want to view.

The Alert Detail list toggles the display to show or hide events.

Running All Modules for an Appliance

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst</td>
</tr>
</tbody>
</table>

Health module tests run automatically at the policy run time interval you configure when you create a health policy. However, you can also run all health module tests on demand to collect up-to-date health information for the appliance.
In a multidomain deployment, you can run health module tests for appliances in the current domain and in any descendant domains.

**Procedure**

**Step 1** View the health monitor for the appliance; see Viewing Appliance Health Monitors, on page 236.

**Step 2** Click Run All Modules. The status bar indicates the progress of the tests, then the Health Monitor Appliance page refreshes.

**Note** When you manually run health modules, the first refresh that automatically occurs may not reflect the data from the manually run tests. If the value has not changed for a module that you just manually ran, wait a few seconds, then refresh the page by clicking the device name. You can also wait for the page to refresh again automatically.

### Running a Specific Health Module

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Security Analyst</td>
</tr>
</tbody>
</table>

Health module tests run automatically at the policy run time interval you configure when you create a health policy. However, you can also run a health module test on demand to collect up-to-date health information for that module.

In a multidomain deployment, you can run health module tests for appliances in the current domain and in any descendant domains.

**Procedure**

**Step 1** View the health monitor for the appliance; see Viewing Appliance Health Monitors, on page 236.

**Step 2** In the Module Status Summary graph, click the color for the health alert status category you want to view.

**Step 3** In the Alert Detail row for the alert for which you want to view a list of events, click Run.

The status bar indicates the progress of the test, then the Health Monitor Appliance page refreshes.

**Note** When you manually run health modules, the first refresh that automatically occurs may not reflect the data from the manually run tests. If the value has not changed for a module that you just manually ran, wait a few seconds, then refresh the page by clicking the device name. You can also wait for the page to refresh automatically again.
Generating Health Module Alert Graphs

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Security Analyst</td>
</tr>
</tbody>
</table>

You can graph the results over a period of time of a particular health test for a specific appliance.

**Procedure**

**Step 1** View the health monitor for the appliance; see Viewing Appliance Health Monitors, on page 236.

**Step 2** In the Module Status Summary graph of the Health Monitor Appliance page, click the color for the health alert status category you want to view.

**Step 3** In the Alert Detail row for the alert for which you want to view a list of events, click Graph.

**Tip** If no events appear, you may need to adjust the time range.

Health Monitor Reports for Troubleshooting

In some cases, if you have a problem with your appliance, Support may ask you to generate troubleshooting files to help them diagnose the problem. You can select any of the options listed in the table below to customize the troubleshooting data that the health monitor reports.

Note that some options overlap in terms of the data they report, but the troubleshooting files will not contain redundant copies, regardless of what options you select.

**Table 38: Selectable Troubleshoot Options**

<table>
<thead>
<tr>
<th>This option...</th>
<th>Reports...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snort Performance and Configuration</td>
<td>data and configuration settings related to Snort on the appliance</td>
</tr>
<tr>
<td>Hardware Performance and Logs</td>
<td>data and logs related to the performance of the appliance hardware</td>
</tr>
<tr>
<td>System Configuration, Policy, and Logs</td>
<td>configuration settings, data, and logs related to the current system</td>
</tr>
<tr>
<td></td>
<td>configuration of the appliance</td>
</tr>
<tr>
<td>Detection Configuration, Policy, and Logs</td>
<td>configuration settings, data, and logs related to detection on the</td>
</tr>
<tr>
<td></td>
<td>appliance</td>
</tr>
<tr>
<td>Interface and Network Related Data</td>
<td>configuration settings, data, and logs related to inline sets and network</td>
</tr>
<tr>
<td></td>
<td>configuration of the appliance</td>
</tr>
<tr>
<td>Discovery, Awareness, VDB Data, and Logs</td>
<td>configuration settings, data, and logs related to the current</td>
</tr>
<tr>
<td></td>
<td>discovery and awareness configuration on the appliance</td>
</tr>
<tr>
<td>Upgrade Data and Logs</td>
<td>data and logs related to prior upgrades of the appliance</td>
</tr>
</tbody>
</table>
Generating Appliance Troubleshooting Files

<table>
<thead>
<tr>
<th>This option...</th>
<th>Reports...</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Database Data</td>
<td>all database-related data that is included in a troubleshoot report</td>
</tr>
<tr>
<td>All Log Data</td>
<td>all logs collected by the appliance database</td>
</tr>
<tr>
<td>Network Map Information</td>
<td>current network topology data</td>
</tr>
</tbody>
</table>

You can generate customized troubleshooting files that you can send to Support.

In a multidomain deployment, you can generate troubleshooting files for devices in descendant domains.

Caution
Generating troubleshooting files for lower-memory devices can trigger Automatic Application Bypass (AAB) when AAB is enabled. At a minimum, triggering AAB restarts the Snort process, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information. In some such cases, triggering AAB can render the device temporarily inoperable. If inoperability persists, contact Cisco Technical Assistance Center (TAC), who can propose a solution appropriate to your deployment. Susceptible devices include Firepower 7010, 7020, and 7030; ASA 5506-X, 5508-X, 5516-X, 5512-X, 5515-X, and 5525-X; NGIPSv.

Procedure

Step 1 View the health monitor for the appliance; see Viewing Appliance Health Monitors, on page 236.
Step 2 Click Generate Troubleshooting Files.
Step 3 Choose All Data to generate all possible troubleshooting data, or check individual check boxes to customize your report.
Step 4 Click OK.

What to do next

- Optionally, monitor the task status; see Viewing Task Messages, on page 261.
- Download the troubleshooting files as described in Downloading Troubleshooting Files, on page 240.
Downloading Troubleshooting Files

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can download troubleshooting files for devices in descendant domains.

**Procedure**

**Step 1** View task messages in the Message Center; see Viewing Task Messages, on page 261.
**Step 2** Find the task that corresponds to the troubleshooting files you generated.
**Step 3** After the appliance generates the troubleshooting files and the task status changes to **Completed**, click **Click to retrieve generated files**.
**Step 4** Follow your browser’s prompts to download the files.
**Note** For managed devices, the system renames the file by prepending the device name to the file name.
**Step 5** Follow the directions from Support to send the troubleshooting files to Cisco.

Health Event Views

The Health Event View page allows you to view health events logged by the health monitor on the Firepower Management Center logs health events. The fully customizable event views allow you to quickly and easily analyze the health status events gathered by the health monitor. You can search event data to easily access other information that may be related to the events you are investigating. If you understand what conditions each health module tests for, you can more effectively configure alerting for health events.

You can perform many of the standard event view functions on the health event view pages.

Viewing Health Events

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst</td>
</tr>
</tbody>
</table>

The Table View of Health Events page provides a list of all health events on the specified appliance.

When you access health events from the Health Monitor page on your Firepower Management Center, you retrieve all health events for all managed appliances.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.
You can bookmark this view to allow you to return to the page in the health events workflow containing the Health Events table of events. The bookmarked view retrieves events within the time range you are currently viewing, but you can then modify the time range to update the table with more recent information if needed.

**Procedure**

Choose System > Health > Events.

**Tip** If you are using a custom workflow that does not include the table view of health events, click (switch workflow). On the Select Workflow page, click Health Events.

**Note** If no events appear, you may need to adjust the time range.

## Viewing Health Events by Module and Appliance

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** View the health monitor for the appliance; see Viewing Appliance Health Monitors, on page 236.

**Step 2** In the Module Status Summary graph, click the color for the event status category you want to view.

The Alert Detail list toggles the display to show or hide events.

**Step 3** In the Alert Detail row for the alert for which you want to view a list of events, click Events.

The Health Events page appears, containing results for a query with the name of the appliance and the name of the specified health alert module as constraints. If no events appear, you may need to adjust the time range.

**Step 4** If you want to view all health events for the specified appliance, expand Search Constraints, and click the Module Name constraint to remove it.

## Viewing the Health Events Table

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst</td>
</tr>
</tbody>
</table>
In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose **System > Health > Events**.

**Step 2** You have the following choices:

- **Bookmark** — To bookmark the current page so that you can quickly return to it, click **Bookmark This Page**, provide a name for the bookmark, and click **Save**.
- **Change Workflow** — To choose another health events workflow, click **(switch workflow)**.
- **Delete Events** — To delete health events, check the check box next to the events you want to delete, and click **Delete**. To delete all the events in the current constrained view, click **Delete All**, then confirm you want to delete all the events.
- **Generate Reports** — Generate a report based on data in the table view — click **Report Designer**.
- **Modify** — Modify the time and date range for events listed in the Health table view. Note that events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.
- **Navigate** — Navigate through event view pages.
- **Navigate Bookmark** — To navigate to the bookmark management page, click **View Bookmarks** from any event view.
- **Navigate Other** — Navigate to other event tables to view associated events.
- **Sort** — Sort the events that appear, change what columns display in the table of events, or constrain the events that appear
- **View All** — To view event details for all events in the view, click **View All**.
- **View Details** — To view the details associated with a single health event, click the down arrow link on the left side of the event.
- **View Multiple** — To view event details for multiple health events, choose the check box next to the rows that correspond with the events you want to view details for and then click **View**.
- **View Status** — To view all events of a particular status, click the status icon in the Status column for an event with that status.

**Hardware Alert Details for 7000 and 8000 Series Devices**

*Note* The 8350 hardware platform has six fans, which display as FAN2 through FAN7. This is expected behavior. If you receive a hardware alert related to FAN1 or fan numbering in general on the 8350 platform, you can disregard the alert.
### Table 39: Conditions Monitored for 7000 and 8000 Series Devices

<table>
<thead>
<tr>
<th>Condition Monitored</th>
<th>Causes of Yellow or Red Error Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device high availability status</td>
<td>If 7000 or 8000 Series devices in a high-availability pair are no longer communicating with each other (due, for example, to a cabling problem), the Hardware Alarms module changes to red.</td>
</tr>
<tr>
<td>ftwo daemon status</td>
<td>If the ftwo daemon goes down, health status for the Hardware Alarms module changes to red and message details include a reference to the daemon.</td>
</tr>
<tr>
<td>NFE cards detected</td>
<td>Indicates the number of NFE cards detected on the system. If this value does not match the appliance’s expected NFE count, the Hardware Alarms module changes to red.</td>
</tr>
<tr>
<td>NFE hardware status</td>
<td>If one or more NFE cards are not communicating, the Hardware Alarms module changes to red and the applicable card appears in the message details.</td>
</tr>
<tr>
<td>NFE heartbeat</td>
<td>If the system detects no NFE heartbeat, the Hardware Alarms module changes to red and message details include a reference to the relevant card(s).</td>
</tr>
<tr>
<td>NFE internal link status</td>
<td>If the link between the NMSB and NFE card(s) goes down, the Hardware Alarms module changes to red and message details include a reference to the relevant ports.</td>
</tr>
<tr>
<td>NFE Message daemon</td>
<td>If the NFE Message daemon goes down, health status for the Hardware Alarms module changes to red and the message details include a reference to the daemon (and, if applicable, the NFE card number).</td>
</tr>
</tbody>
</table>
| NFE temperature                        | If NFE temperature exceeds 97 degrees Celsius, health status for the Hardware Alarms module changes to yellow and message details include a reference to the NFE temperature (and, if applicable, the NFE card number).  
If NFE temperature exceeds 102 degrees Celsius, health status for the Hardware Alarms module changes to red and message details include a reference to the NFE temperature. (and, if applicable, the NFE card number). |
| NFE temperature status                 | Indicates the current temperature status of the given NFE card. The Hardware Alarms module indicates green for OK, yellow for Warning, and red for Critical (and, if applicable, the NFE card number). |
### The Health Events Table

The Health Monitor modules you choose to enable in your health policy run various tests to determine appliance health status. When the health status meets criteria that you specify, a health event is generated.

The table below describes the fields that can be viewed and searched in the health events table.

**Table 40: Health Event Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Name</td>
<td>Specify the name of the module which generated the health events you want to view. For example, to view events that measure CPU performance, type <code>CPU</code>. The search should retrieve applicable CPU Usage and CPU temperature events.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Test Name</td>
<td>The name of the health module that generated the event.</td>
</tr>
<tr>
<td>Time</td>
<td>The timestamp for the health event.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the health module that generated the event. For example, health events generated when a process was unable to execute are labeled &quot;Unable to Execute.&quot;</td>
</tr>
<tr>
<td>Value</td>
<td>The value (number of units) of the result obtained by the health test that generated the event.</td>
</tr>
<tr>
<td>Units</td>
<td>The units descriptor for the result. You can use the asterisk (*) to create wildcard searches.</td>
</tr>
<tr>
<td>Status</td>
<td>The status (Critical, Yellow, Green, or Disabled) reported for the appliance.</td>
</tr>
<tr>
<td>Domain</td>
<td>For health events reported by managed devices, the domain of the device that reported the health event. For health events reported by the Firepower Management Center, Global. This field is only present in a multidomain deployment.</td>
</tr>
<tr>
<td>Device</td>
<td>The appliance where the health event was reported.</td>
</tr>
</tbody>
</table>

**History for Health Monitoring**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Version</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health monitoring</td>
<td></td>
<td>Feature introduced before Version 6.0.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New screens: Menu options under System &gt; Health</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Supported platforms: Firepower Management Center and managed devices.</td>
</tr>
</tbody>
</table>
CHAPTER 14

Monitoring the System

The following topics describe how to monitor the Firepower System:

- System Statistics, on page 247
- System Messages, on page 256
- Managing System Messages, on page 259

System Statistics

The Statistics page in the Firepower System web interface lists the current status of general appliance statistics, including disk usage and system processes, Data Correlator statistics, and intrusion event information.

You view system statistics on both the Firepower Management Center and 7000 & 8000 Series devices.

System Statistics Availability by Appliance

System statistics are available in the web interface as follows:

<table>
<thead>
<tr>
<th>Type of Statistics</th>
<th>Statistics Page Section</th>
<th>FMC</th>
<th>7000 &amp; 8000 Series Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>host statistics</td>
<td>The Host Statistics Section, on page 248</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>system status and disk space usage</td>
<td>The Disk Usage Section, on page 248</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>system process status</td>
<td>The Processes Section, on page 248</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Data Correlator statistics</td>
<td>The SFDDataCorrelator Process Statistics Section, on page 254</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>intrusion event statistics</td>
<td>The Intrusion Event Information Section, on page 255</td>
<td>yes</td>
<td>no</td>
</tr>
</tbody>
</table>
The Host Statistics Section

The following table describes the host statistics listed on the Statistics page.

*Table 41: Host Statistics*

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>The current time on the system.</td>
</tr>
<tr>
<td>Uptime</td>
<td>The number of days (if applicable), hours, and minutes since the system was last started.</td>
</tr>
<tr>
<td>Memory Usage</td>
<td>The percentage of system memory that is being used.</td>
</tr>
<tr>
<td>Load Average</td>
<td>The average number of processes in the CPU queue for the past 1 minute, 5 minutes, and 15 minutes.</td>
</tr>
<tr>
<td>Disk Usage</td>
<td>The percentage of the disk that is being used. Click the arrow to view more detailed host statistics.</td>
</tr>
<tr>
<td>Processes</td>
<td>A summary of the processes running on the system.</td>
</tr>
</tbody>
</table>

The Disk Usage Section

The Disk Usage section of the Statistics page provides a quick synopsis of disk usage, both by category and by partition status. If you have a malware storage pack installed on a device, you can also check its partition status. You can monitor this page from time to time to ensure that enough disk space is available for system processes and the database.

**Tip**

On the Firepower Management Center, you can also use the health monitor to monitor disk usage and alert on low disk space conditions.

The Processes Section

The Processes section of the Statistics page allows you to see the processes that are currently running on an appliance. It provides general process information and specific information for each running process. You can use the Firepower Management Center’s web interface to view the process status for any managed device.

Note that there are two different types of processes that run on an appliance: daemons and executable files. Daemons always run, and executable files are run when required.

Process Status Fields

When you expand the Processes section of the Statistics page, you can also view the following:

**Cpu(s)**

Lists the following CPU usage information:
- user process usage percentage
- system process usage percentage
- nice usage percentage (CPU usage of processes that have a negative nice value, indicating a higher priority). Nice values indicate the scheduled priority for system processes and can range between -20 (highest priority) and 19 (lowest priority).
- idle usage percentage

**Mem**

Lists the following memory usage information:
- total number of kilobytes in memory
- total number of used kilobytes in memory
- total number of free kilobytes in memory
- total number of buffered kilobytes in memory

**Swap**

Lists the following swap usage information:
- total number of kilobytes in swap
- total number of used kilobytes in swap
- total number of free kilobytes in swap
- total number of cached kilobytes in swap

The following table describes each column that appears in the Processes section.

**Table 42: Process List Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pid</td>
<td>The process ID number</td>
</tr>
<tr>
<td>Username</td>
<td>The name of the user or group running the process</td>
</tr>
<tr>
<td>Pri</td>
<td>The process priority</td>
</tr>
<tr>
<td>Nice</td>
<td>The <code>nice</code> value, which is a value that indicates the scheduling priority of a process. Values range between -20 (highest priority) and 19 (lowest priority)</td>
</tr>
<tr>
<td>Size</td>
<td>The memory size used by the process (in kilobytes unless the value is followed by <code>m</code>, which indicates megabytes)</td>
</tr>
<tr>
<td>Res</td>
<td>The amount of resident paging files in memory (in kilobytes unless the value is followed by <code>m</code>, which indicates megabytes)</td>
</tr>
</tbody>
</table>
The process state:

- **D** — process is in uninterruptible sleep (usually Input/Output)
- **N** — process has a positive nice value
- **R** — process is runnable (on queue to run)
- **S** — process is in sleep mode
- **T** — process is being traced or stopped
- **W** — process is paging
- **X** — process is dead
- **Z** — process is defunct
- **<** — process has a negative nice value

The amount of time (in hours:minutes:seconds) that the process has been running

The percentage of CPU that the process is using

The executable name of the process

**System Daemons**

Daemons continually run on an appliance. They ensure that services are available and spawn processes when required. The following table lists daemons that you may see on the Process Status page and provides a brief description of their functionality.

The table below is not an exhaustive list of all processes that may run on an appliance.

<table>
<thead>
<tr>
<th>Daemon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>crond</td>
<td>Manages the execution of scheduled commands (cron jobs)</td>
</tr>
<tr>
<td>dhcpclient</td>
<td>Manages dynamic host IP addressing</td>
</tr>
<tr>
<td>fpcollect</td>
<td>Manages the collection of client and server fingerprints</td>
</tr>
<tr>
<td>Daemon</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>httpd</td>
<td>Manages the HTTP (Apache web server) process</td>
</tr>
<tr>
<td>httpsd</td>
<td>Manages the HTTPS (Apache web server with SSL) service, and checks for working SSL and valid certificate authentication; runs in the background to provide secure web access to the appliance</td>
</tr>
<tr>
<td>keventd</td>
<td>Manages Linux kernel event notification messages</td>
</tr>
<tr>
<td>klogd</td>
<td>Manages the interception and logging of Linux kernel messages</td>
</tr>
<tr>
<td>kswapd</td>
<td>Manages Linux kernel swap memory</td>
</tr>
<tr>
<td>kupdated</td>
<td>Manages the Linux kernel update process, which performs disk synchronization</td>
</tr>
<tr>
<td>mysqlld</td>
<td>Manages database processes</td>
</tr>
<tr>
<td>ntpd</td>
<td>Manages the Network Time Protocol (NTP) process</td>
</tr>
<tr>
<td>pm</td>
<td>Manages all Firepower System processes, starts required processes, restarts any process that fails unexpectedly</td>
</tr>
<tr>
<td>reportd</td>
<td>Manages reports</td>
</tr>
<tr>
<td>safe_mysqld</td>
<td>Manages safe mode operation of the database; restarts the database daemon if an error occurs and logs runtime information to a file</td>
</tr>
<tr>
<td>SFDataCorrelator</td>
<td>Manages data transmission</td>
</tr>
<tr>
<td>sfstreamer (FMC only)</td>
<td>Manages connections to third-party client applications that use the Event Streamer</td>
</tr>
<tr>
<td>sfmgr</td>
<td>Provides the RPC service for remotely managing and configuring an appliance using an sftunnel connection to the appliance</td>
</tr>
<tr>
<td>SFRemediateD (FMC only)</td>
<td>Manages remediation responses</td>
</tr>
<tr>
<td>sftimeserviced (FMC only)</td>
<td>Forwards time synchronization messages to managed devices</td>
</tr>
<tr>
<td>sfmbservice</td>
<td>Provides access to the sfmb message broker process running on a remote appliance, using an sftunnel connection to the appliance. Currently used only by health monitoring to send health events and alerts from a managed device to a Firepower Management Center.</td>
</tr>
</tbody>
</table>
**Daemon**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sftroughd</td>
</tr>
<tr>
<td>sftunnel</td>
</tr>
<tr>
<td>sshd</td>
</tr>
<tr>
<td>syslogd</td>
</tr>
</tbody>
</table>

**Executables and System Utilities**

There are a number of executables on the system that run when executed by other processes or through user action. The following table describes the executables that you may see on the Process Status page.

**Table 44: System Executables and Utilities**

<table>
<thead>
<tr>
<th>Executable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>awk</td>
<td>Utility that executes programs written in the awk programming language</td>
</tr>
<tr>
<td>bash</td>
<td>GNU Bourne-Again Shell</td>
</tr>
<tr>
<td>cat</td>
<td>Utility that reads files and writes content to standard output</td>
</tr>
<tr>
<td>chown</td>
<td>Utility that changes user and group file permissions</td>
</tr>
<tr>
<td>chsh</td>
<td>Utility that changes the default login shell</td>
</tr>
<tr>
<td>SFDataCorrelator (FMC only)</td>
<td>Analyzes binary files created by the system to generate events, connection data, and network maps</td>
</tr>
<tr>
<td>cp</td>
<td>Utility that copies files</td>
</tr>
<tr>
<td>df</td>
<td>Utility that lists the amount of free space on the appliance</td>
</tr>
<tr>
<td>echo</td>
<td>Utility that writes content to standard output</td>
</tr>
<tr>
<td>egrep</td>
<td>Utility that searches files and folders for specified input; supports extended set of regular expressions not supported in standard grep</td>
</tr>
<tr>
<td>find</td>
<td>Utility that recursively searches directories for specified input</td>
</tr>
<tr>
<td>Executable</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>grep</td>
<td>Utility that searches files and directories for specified input</td>
</tr>
<tr>
<td>halt</td>
<td>Utility that stops the server</td>
</tr>
<tr>
<td>httpsdctl</td>
<td>Handles secure Apache Web processes</td>
</tr>
<tr>
<td>hwclock</td>
<td>Utility that allows access to the hardware clock</td>
</tr>
<tr>
<td>ifconfig</td>
<td>Indicates the network configuration executable. Ensures that the MAC address stays constant</td>
</tr>
<tr>
<td>iptables</td>
<td>Handles access restriction based on changes made to the Access Configuration page.</td>
</tr>
<tr>
<td>iptables-restore</td>
<td>Handles iptables file restoration</td>
</tr>
<tr>
<td>iptables-save</td>
<td>Handles saved changes to the iptables</td>
</tr>
<tr>
<td>kill</td>
<td>Utility that can be used to end a session and process</td>
</tr>
<tr>
<td>killall</td>
<td>Utility that can be used to end all sessions and processes</td>
</tr>
<tr>
<td>ksh</td>
<td>Public domain version of the Korn shell</td>
</tr>
<tr>
<td>logger</td>
<td>Utility that provides a way to access the syslog daemon from the command line</td>
</tr>
<tr>
<td>md5sum</td>
<td>Utility that prints checksums and block counts for specified files</td>
</tr>
<tr>
<td>mv</td>
<td>Utility that moves (renames) files</td>
</tr>
<tr>
<td>myisamchk</td>
<td>Indicates database table checking and repairing</td>
</tr>
<tr>
<td>mysql</td>
<td>Indicates a database process; multiple instances may appear</td>
</tr>
<tr>
<td>openssl</td>
<td>Indicates authentication certificate creation</td>
</tr>
<tr>
<td>perl</td>
<td>Indicates a perl process</td>
</tr>
<tr>
<td>ps</td>
<td>Utility that writes process information to standard output</td>
</tr>
<tr>
<td>sed</td>
<td>Utility used to edit one or more text files</td>
</tr>
<tr>
<td>sfheartbeat</td>
<td>Identifies a heartbeat broadcast, indicating that the appliance is active; heartbeat used to maintain contact between a device and Firepower Management Center</td>
</tr>
</tbody>
</table>
## The SFDataCorrelator Process Statistics Section

On a Firepower Management Center, you can view statistics about the Data Correlator and network discovery processes for the current day. As the managed devices perform data acquisition, decoding, and analysis, the network discovery process correlates the data with the fingerprint and vulnerability databases, then produces binary files that are processed by the Data Correlator running on the Firepower Management Center. The Data Correlator analyzes the information from the binary files, generates events, and creates network maps.

The statistics that appear for network discovery and the Data Correlator are averages for the current day, using statistics gathered between 12:00 AM and 11:59 PM for each device.

The following table describes the statistics displayed for the Data Correlator process.

<table>
<thead>
<tr>
<th>Executable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sfmb</td>
<td>Indicates a message broker process; handles communication between Firepower Management Centers and device.</td>
</tr>
<tr>
<td>sh</td>
<td>Public domain version of the Korn shell</td>
</tr>
<tr>
<td>shutdown</td>
<td>Utility that shuts down the appliance</td>
</tr>
<tr>
<td>sleep</td>
<td>Utility that suspends a process for a specified number of seconds</td>
</tr>
<tr>
<td>smtpclient</td>
<td>Mail client that handles email transmission when email event notification functionality is enabled</td>
</tr>
<tr>
<td>snmptrap</td>
<td>Forwards SNMP trap data to the SNMP trap server specified when SNMP notification functionality is enabled</td>
</tr>
<tr>
<td>snort</td>
<td>Indicates that Snort is running</td>
</tr>
<tr>
<td>ssh</td>
<td>Indicates a Secure Shell (SSH) connection to the appliance</td>
</tr>
<tr>
<td>sudo</td>
<td>Indicates a sudo process, which allows users other than admin to run executables</td>
</tr>
<tr>
<td>top</td>
<td>Utility that displays information about the top CPU processes</td>
</tr>
<tr>
<td>touch</td>
<td>Utility that can be used to change the access and modification times of specified files</td>
</tr>
<tr>
<td>vim</td>
<td>Utility used to edit text files</td>
</tr>
<tr>
<td>wc</td>
<td>Utility that performs line, word, and byte counts on specified files</td>
</tr>
</tbody>
</table>

**Related Topics**

- Configuring the Access List for Your System, on page 468

---

**The SFDataCorrelator Process Statistics Section**

On a Firepower Management Center, you can view statistics about the Data Correlator and network discovery processes for the current day. As the managed devices perform data acquisition, decoding, and analysis, the network discovery process correlates the data with the fingerprint and vulnerability databases, then produces binary files that are processed by the Data Correlator running on the Firepower Management Center. The Data Correlator analyzes the information from the binary files, generates events, and creates network maps.

The statistics that appear for network discovery and the Data Correlator are averages for the current day, using statistics gathered between 12:00 AM and 11:59 PM for each device.

The following table describes the statistics displayed for the Data Correlator process.
Table 45: Data Correlator Process Statistics

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events/Sec</td>
<td>Number of discovery events that the Data Correlator receives and processes per second</td>
</tr>
<tr>
<td>Connections/Sec</td>
<td>Number of connections that the Data Correlator receives and processes per second</td>
</tr>
<tr>
<td>CPU Usage — User (%)</td>
<td>Average percentage of CPU time spent on user processes for the current day</td>
</tr>
<tr>
<td>CPU Usage — System (%)</td>
<td>Average percentage of CPU time spent on system processes for the current day</td>
</tr>
<tr>
<td>VmSize (KB)</td>
<td>Average size of memory allocated to the Data Correlator for the current day, in kilobytes</td>
</tr>
<tr>
<td>VmRSS (KB)</td>
<td>Average amount of memory used by the Data Correlator for the current day, in kilobytes</td>
</tr>
</tbody>
</table>

The Intrusion Event Information Section

On both the Firepower Management Center and managed devices, you can view summary information about intrusion events on the Statistics page. This information includes the date and time of the last intrusion event, the total number of events that have occurred in the past hour and the past day, and the total number of events in the database.

Note

The information in the Intrusion Event Information section of the Statistics page is based on intrusion events stored on the managed device rather than those sent to the Firepower Management Center. No intrusion event information is listed on this page if the managed device cannot (or is configured not to) store intrusion events locally.

The following table describes the statistics displayed in the Intrusion Event Information section of the Statistics page.

Table 46: Intrusion Event Information

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Alert Was</td>
<td>The date and time that the last event occurred</td>
</tr>
<tr>
<td>Total Events Last Hour</td>
<td>The total number of events that occurred in the past hour</td>
</tr>
<tr>
<td>Total Events Last Day</td>
<td>The total number of events that occurred in the past twenty-four hours</td>
</tr>
<tr>
<td>Total Events in Database</td>
<td>The total number of events in the events database</td>
</tr>
</tbody>
</table>
Viewing System Statistics

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Threat (for intrusion event data)</td>
<td>Any Protection (for intrusion event data)</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

On the Firepower Management Center, the web interface displays statistics for that appliance and any devices it manages. On 7000 and 8000 Series devices, the system displays statistics for that device only.

Procedure

Step 1 Choose System > Monitoring > Statistics.
Step 2 On the Firepower Management Center: Choose a device from the Select Device(s) list, and click Select Devices.
Step 3 View available statistics; see System Statistics Availability by Appliance, on page 247.
Step 4 In the Disk Usage section, you can:
  • Hover your pointer over a disk usage category in the By Category stacked bar to view (in order):
    • the percentage of available disk space used by that category
    • the actual storage space on the disk
    • the total disk space available for that category
  • Click the down arrow next to By Partition to expand it. If you have a malware storage pack installed, the /var/storage partition usage is displayed.
Step 5 Optionally, click the arrow next to Processes to view the information described in Process Status Fields, on page 248.

System Messages

When you need to track down problems occurring in the Firepower System, the Message Center is the place to start your investigation. This feature allows you to view the messages that the Firepower System continually generates about system activities and status.

To open the Message Center, click on the System Status icon, located to the immediate right of the Deploy button in the main menu. This icon can take one of the following forms, depending on the system status:

• 🔄 — Indicates one or more errors and any number of warnings are present on the system.

• 🔴 — Indicates one or more warnings and no errors are present on the system.

• ✅ — Indicates no warnings or errors are present on the system.
If a number is displayed with the icon, it indicates the total current number of error or warning messages. To close the Message Center, click anywhere outside of it within the Firepower System web interface. In addition to the Message Center, the web interface displays pop-up notifications in immediate response to your activities and ongoing system activities. Some pop-up notifications automatically disappear after five seconds, while others are "sticky," meaning they display until you explicitly dismiss them by clicking their dismissal icons (×). Click the Dismiss link at the top of the notifications list to dismiss all notifications at once.

Tip
Hovering your cursor over a non-sticky pop-up notification causes it to be sticky.

The system determines which messages it displays to users in pop-up notifications and the Message Center based on their licenses, domains, and access roles.

Message Types

The Message Center displays messages reporting system activities and status organized into three different tabs:

Deployments

This tab displays current status related to configuration deployment for each appliance in your system, grouped by domain. The Firepower System reports the following deployment status values on this tab:

- Running (spinning ⏳) — The configuration is in the process of deploying.
- Success (✓) — The configuration has successfully been deployed.
- Warning (⚠) — Warning deployment statuses contribute to the message count displayed with the warning System Status icon (⚠).
- Failure (❌) — The configuration has failed to deploy; see Out-of-Date Policies, on page 286. Failed deployments contribute to the message count displayed with the error System Status icon (⚠).

Health

This tab displays current health status information for each appliance in your system, grouped by domain. Health status is generated by health modules as described in About Health Monitoring, on page 219. The Firepower System reports the following health status values on this tab:

- Warning (⚠) — Indicates that warning limits have been exceeded for a health module on an appliance and the problem has not been corrected. The Health Monitoring page indicates these conditions with a yellow triangle icon (⚠). Warning statuses contribute to the message count displayed with the warning System Status icon (⚠).
- Critical (❌) — Indicates that critical limits have been exceeded for a health module on an appliance and the problem has not been corrected. The Health Monitoring page indicates these conditions with a ❌ icon. Critical statuses contribute to the message count displayed with the error System Status icon (❌).
• Error (✗) — Indicates that a health monitoring module has failed on an appliance and has not been successfully re-run since the failure occurred. The Health Monitoring page indicates these conditions with a ✗ icon. Error statuses contribute to the message count displayed with the error System Status icon (¹).

You can click on links in the Health tab to view related detailed information on the Health Monitoring page. If there are no current health status conditions, the Health tab displays no messages.

Tasks

In the Firepower System, you can perform certain tasks (such as configuration backups or update installation) that can require some time to complete. This tab displays the status of these long-running tasks, and can include tasks initiated by you or, if you have appropriate access, other users of the system. The tab presents messages in reverse chronological order based on the most recent update time for each message. Some task status messages include links to more detailed information about the task in question.

The Firepower System reports the following task status values on this tab:

• Waiting (⋮) — Indicates a task that is waiting to run until another in-progress task is complete. This message type displays an updating progress bar.

• Running (spinning ⌱) — Indicates a task that is in-progress. This message type displays an updating progress bar.

• Retrying (⟳) — Indicates a task that is automatically retrying. Note that not all tasks are permitted to try again. This message type displays an updating progress bar.

• Success (✔) — Indicates a task that has completed successfully.

• Failure (.getSelection) — Indicates a task that did not complete successfully. Failed tasks contribute to the message count displayed with the error System Status icon (¹).

• Stopped or Suspended (☐) — Indicates a task that was interrupted due to a system update. Stopped tasks cannot be resumed. After normal operations are restored, start the task again.

• Skipped — A process in progress prevented the task from starting. Try again to start the task.

New messages appear in this tab as new tasks are started. As tasks complete (status success, failure, or stopped), this tab continues to display messages with final status indicated until you remove them. Cisco recommends you remove messages to reduce clutter in the Tasks tab as well as the message database.

Message Management

From the Message Center you can:

• Configure pop-up notification behavior (choosing whether to display them).

• Display additional task status messages from the system database (if any are available that have not been removed).

• Remove individual task status messages. (This affects all users who can view the removed messages.)

• Remove task status messages in bulk. (This affects all users who can view the removed messages.)
Cisco recommends that you periodically remove accumulated task status messages from the Task tab to reduce clutter in the display as well as the database. When the number of messages in the database approaches 100,000, the system automatically deletes task status messages that you have removed.

Managing System Messages

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td></td>
</tr>
</tbody>
</table>

Deployment: Admin/custom user role with **Deploy Configuration to Devices** permission

Health: Admin/custom user role with **Health** permission

Tasks initiated by others: Admin/custom user role with **View Other Users' Tasks** permission

Tasks you have initiated: Any

Procedure

**Step 1**
Click on the System Status icon to display the Message Center.

**Step 2**
You have the following choices:

- Click on the **Deployments** tab to view messages related to configuration deployments. See Viewing Deployment Messages, on page 260.
- Click on the **Health** tab to view messages related to the health of your Firepower Management Center and the devices registered to it. See Viewing Health Messages, on page 260.
- Click on the Tasks tab to view or manage messages related to long-running tasks. See Viewing Task Messages, on page 261 or Managing Task Messages, on page 262.
- Click on the cog icon (⚙️) in the upper right corner of the Message Center to configure pop-up notification behavior. See Configuring Notification Behavior, on page 262.
Viewing Deployment Messages

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/user role with Deploy Configuration to Devices permission</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Click on the System Status icon to display the Message Center.

**Step 2** Click on the Deployments tab.

**Step 3** You have the following choices:

- Click on total to view all current deployment statuses.
- Click on a status value to view only messages with that deployment status.
- Hover your cursor over the time elapsed indicator for a message (e.g., 1m 5s) to view the elapsed time, and start and stop times for the deployment.

Related Topics

[Deploy Configuration Changes](#), on page 277

---

Viewing Health Messages

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/user role with Health permission</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Click on the System Status icon to display the Message Center.

**Step 2** Click on the Health tab.

**Step 3** You have the following choices:

- Click on total to view all current health statuses.
- Click on a status value to view only messages with that status.
- Hover your cursor over the relative time indicator for a message (e.g., 3 day(s) ago) to view the time of the most recent update for that message.
- To view detailed health status information for a particular message, click on the message.
To view complete health status on the Health Monitoring page, click on Health Monitor at the bottom of the tab.

Related Topics

About Health Monitoring, on page 219

Viewing Task Messages

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Tasks initiated by others: Admin/custom user role with View Other Users' Tasks permission Tasks you have initiated: Any</td>
</tr>
</tbody>
</table>

Procedure

Step 1  Click on the System Status icon to display the Message Center.
Step 2  Click on the Tasks tab.
Step 3  You have the following choices:

• Click on total to view all current task statuses.
• Click on a status value to view only messages for tasks with that status.

Note   Messages for stopped tasks appear only in the total list of task status messages. You cannot filter on stopped tasks.

• Hover your cursor over the relative time indicator for a message (e.g., 3 day(s) ago) to view the time of the most recent update for that message.
• Click on any link within a message to view more information about the task.
• If more task status messages are available for display, click on Fetch more messages at the bottom of the message list to retrieve them.
Managing Task Messages

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>
|               |                 |                   |                   | **Tasks initiated by others:** Admin/custom user role with **View Other Users' Tasks** permission
|               |                 |                   |                   | **Tasks you have initiated:** Any |

Procedure

**Step 1** Click on the System Status icon to display the Message Center.

**Step 2** Click on the Tasks tab.

**Step 3** You have the following choices:

- If more task status messages are available for display, click on **Fetch more messages** at the bottom of the message list to retrieve them.
- To remove a single message for a completed task (status stopped, success, or failure), click on the remove icon (×) next to the message.
- To remove all messages for all tasks that have completed (status stopped, success, or failure), filter the messages on **total** and click on **Remove all completed tasks**.
- To remove all messages for all tasks that have completed successfully, filter the messages on **success**, and click on **Remove all successful tasks**.
- To remove all messages for all tasks that have failed, filter the messages on **failure**, and click on **Remove all failed tasks**.

Configuring Notification Behavior

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

**Note**
This setting affects all pop-up notifications and persists between login sessions.

Procedure

**Step 1** Click on the System Status icon to display the Message Center.
Step 2  Click on the cog icon (⚙️) in the upper right corner of the Message Center.
Step 3  To enable or disable pop-up notification display, click the **Show notifications** slider.
Step 4  Click on the cog icon (⚙️) again to hide the slider.
Step 5  Click on the System Status icon again to close the Message Center.
PART IV

Deployment Management

• Domain Management, on page 267
• Policy Management, on page 275
• Rule Management: Common Characteristics, on page 289
• Reusable Objects, on page 317
CHAPTER 15

Domain Management

The following topics describe how to manage multitenancy using domains:

- Introduction to Multitenancy Using Domains, on page 267
- Managing Domains, on page 270
- Creating New Domains, on page 271
- Moving Data Between Domains, on page 272
- Moving Devices Between Domains, on page 273

Introduction to Multitenancy Using Domains

The Firepower System allows you to implement multitenancy using domains. Domains segment user access to managed devices, configurations, and events. You can create up to 50 subdomains under a top-level Global domain, in two or three levels.

When you log into the Firepower Management Center, you log into a single domain, called the current domain. Depending on your user account, you may be able to switch to other domains.

In addition to any restrictions imposed by your user role, your current domain level can also limit your ability to modify various Firepower System configurations. The system limits most management tasks, like system software updates, to the Global domain.

The system limits other tasks to leaf domains, which are domains with no subdomains. For example, you must associate each managed device with a leaf domain, and perform device management tasks from the context of that leaf domain.

Tip

Each task topic in this guide has a Supported Domains value that indicates the domain levels where you can perform the task.

Each leaf domain builds its own network map, based on the discovery data collected by that leaf domain’s devices. Events reported by a managed device (connection, intrusion, malware, and so on) are also associated with the device's leaf domain.
One Domain Level: Global

If you do not configure multitenancy, all devices, configurations, and events belong to the Global domain, which in this scenario is also a leaf domain. Except for domain management, the system hides domain-specific configurations and analysis options until you add subdomains.

Two Domain Levels: Global and Second-Level

In a two-level multidomain deployment, the Global domain has direct descendant domains only. For example, a managed security service provider (MSSP) can use a single Firepower Management Center to manage network security for multiple customers:

- Administrators at the MSSP can log into the Global domain to manage all customers’ deployments.
- Administrators for each customer can log into second-level named subdomains to manage only the devices, configurations, and events applicable to their organizations. These local administrators cannot view or affect the deployments of other customers of the MSSP.

Three Domain Levels: Global, Second-Level, and Third-Level

In a three-level multidomain deployment, the Global domain has subdomains, at least one of which has its own subdomain. To extend the previous example, consider a scenario where an MSSP customer—already restricted to a subdomain—wants to further segment its deployment. This customer wants to separately manage two classes of device: devices placed on network edges and devices placed internally:

- Administrators for the customer can log into a second-level subdomain to manage the customer’s entire deployment.
- Administrators for the customer’s edge network can log into a third-level (leaf) domain to manage only the devices, configurations, and events applicable to devices deployed on the network edge. Similarly, administrators for the customer’s internal network can log into a different third-level domain to manage internal devices, configurations, and events. Edge and internal administrators cannot view each other’s deployment.

Domains Terminology

This documentation uses the following terms when describing domains and multidomain deployments:

**Global Domain**

In a multidomain deployment, the top-level domain. If you do not configure multitenancy, all devices, configurations, and events belong to the Global domain. Administrators in the Global domain can manage the entire Firepower System deployment.

**Subdomain**

A second or third-level domain.

**Second-level domain**

A child of the Global domain. Second-level domains can be leaf domains, or they can have subdomains.

**Third-level domain**

A child of a second-level domain. Third-level domains are always leaf domains.
**Leaf domain**
A domain with no subdomains. Each device must belong to a leaf domain.

**Descendant domain**
A domain descending from the current domain in the hierarchy.

**Child domain**
A domain’s direct descendant.

**Ancestor domain**
A domain from which the current domain descends.

**Parent domain**
A domain’s direct ancestor.

**Sibling domain**
A domain with the same parent.

**Current domain**
The domain you are logged into now. The system displays the name of the current domain before your user name at the top right of the web interface. Unless your user role is restricted, you can edit configurations in the current domain.

---

**Domain Properties**

To modify a domain's properties, you must have Administrator access in that domain's parent domain.

**Name and Description**
Each domain must have a unique name within its hierarchy. A description is optional.

**Parent Domain**
Second- and third-level domains have a parent domain. You cannot change a domain's parent after you create the domain.

**Devices**
Only leaf domains may contain devices. In other words, a domain may contain subdomains or devices, but not both. You cannot save a deployment where a non-leaf domain directly controls a device.

In the domain editor, the web interface displays available and selected devices according to their current place in your domain hierarchy.

**Host Limit**
The number of hosts a Firepower Management Center can monitor, and therefore store in network maps, depends on its model. In a multidomain deployment, leaf domains share the available pool of monitored hosts, but have separate network maps.

To ensure that each leaf domain can populate its network map, you can set host limits at each subdomain level. If you set a domain's host limit to 0, the domain shares in the general pool.

Setting the host limit has a different effect at each domain level:
• Leaf — For a leaf domain, a host limit is a simple limit on the number of hosts the leaf domain can monitor.

• Second Level — For a second-level domain that manages third-level leaf domains, a host limit represents the total number of hosts that the leaf domains can monitor. The leaf domains share the pool of available hosts.

• Global — For the Global domain, the host limit is equal to the total number of hosts a Firepower Management Center can monitor. You cannot change it.

The sum of subdomains’ host limits can add up to more than their parent domain's host limit. For example, if the Global domain host limit is 150,000, you can configure multiple subdomains each with a host limit of 100,000. Any of those domains, but not all, can monitor 100,000 hosts.

The network discovery policy controls what happens when you detect a new host after you reach the host limit; you can drop the new host, or replace the host that has been inactive for the longest time. Because each leaf domain has its own network discovery policy, each leaf domain governs its own behavior when the system discovers a new host.

If you reduce the host limit for a domain and its network map contains more hosts than the new limit, the system deletes the hosts that have been inactive the longest.

**Related Topics**
- [Firepower System Host Limit](#), on page 1209
- [Network Discovery Data Storage Settings](#), on page 1318

## Managing Domains

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Device</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

To modify a domain's properties, you must have Administrator access in that domain's parent domain.

**Procedure**

**Step 1** Choose **System > Domains**.

**Step 2** Manage your domains:
- Add — Click **Add Domain**, or click the **Add Subdomain** icon next to the parent domain; see [Creating New Domains](#), on page 271.
- Edit — Click the edit icon (📝) next to the domain you want to modify; see **Domain Properties**, on page 269.
- Delete — Click the delete icon (🗑️) next to the empty domain you want to delete, then confirm your choice. Move devices from domains you want to delete by editing their destination domain.

**Step 3** When you are done making changes to the domain structure and all devices are associated with leaf domains, click **Save** to implement your changes.

**Step 4** If prompted, make additional changes:
• If you changed a leaf domain to a parent domain, move or delete the old network map; see Moving Data Between Domains, on page 272.
• If you moved devices between domains and must assign new policies and security zones, see Moving Devices Between Domains, on page 273.

What to do next
• Configure user roles and policies (access control, network discovery, and so on) for any new domains. Update device properties as needed.
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Creating New Domains

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Device</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global &amp; second-level</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can create up to 50 subdomains under a top-level Global domain, in two or three levels. You must assign all devices to a leaf domain before you can implement the domain configuration. When you add a subdomain to a leaf domain, the domain stops being a leaf domain and you must reassign its devices.

Procedure

Step 1 In a Global or a second-level domain, choose System > Domains.
Step 2 Click Add Domain, or click the Add Subdomain icon next to the parent domain.
Step 3 Enter a Name and Description.
Step 4 Choose a Parent Domain.
Step 5 On the Devices tab, choose the Available Devices to add to the domain, then click Add to Domain or drag and drop into the list of Selected Devices.
Step 6 Optionally, click the Advanced tab to limit the number of hosts the new domain may monitor; see Domain Properties, on page 269.
Step 7 Click Save to return to the domain management page. The system warns you if any devices are assigned to non-leaf domains. Click Create New Domain to create a new domain for those devices. Click Keep Unassigned if you plan to move the devices to existing domains.
Step 8 When you are done making changes to the domain structure and all devices are associated with leaf domains, click Save to implement your changes.
Step 9 If prompted, make additional changes:
• If you changed a leaf domain to a parent domain, move or delete the old network map; see Moving Data Between Domains, on page 272.
• If you moved devices between domains and must assign new policies and security zones, see Moving Devices Between Domains, on page 273.

What to do next
• Configure user roles and policies (access control, network discovery, and so on) for any new domains. Update device properties as needed.
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Moving Data Between Domains

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Device</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Because events and network maps are associated with leaf domains, when you change a leaf domain to a parent domain, you have two choices:
• Move the network map and associated events to a new leaf domain.
• Delete the network map but retain the events. In this case, the events remain associated with the parent domain until the system prunes events as needed or as configured. Or, you can delete old events manually.

Before you begin
Implement a domain configuration where a former leaf domain is now a parent domain; see Managing Domains, on page 270.

Procedure

Step 1
For each former leaf domain that is now a parent domain:
• Choose a new Leaf Domain to inherit the Parent Domain's events and network map.
• Choose None to delete the parent domain's network map, but retain old events.

Step 2
Click Save.

What to do next
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Moving Devices Between Domains

Moving a device between domains can affect the configurations and policies applied to the device. The system automatically keeps and updates what it can, and deletes what it cannot.

If you assign a Remote Access VPN policy to a device, you cannot move the same device from one domain to another domain.

When you move a device, the system can prompt you to choose the following new, essential configurations:

- **Access Control Policy** — If the access control policy assigned to a moved device is not valid or accessible in the new domain, choose a new policy. Every device must have an assigned access control policy.
- **Health Policy** — If the health policy applied to a moved device is inaccessible in the new domain, you can choose a new health policy.
- **Security Zones** — If the interfaces on the moved devices belong to a security zone that is inaccessible in the new domain, you can choose a new zone.

If devices require a policy update but you do not need to move interfaces between zones, the system displays a message stating that zone configurations are up to date. For example, if a device's interfaces belong to a security zone configured in a common ancestor domain, you do not need to update zone configurations when you move devices from subdomain to subdomain.

**Before you begin**

- Implement a domain configuration where you moved a device from domain to domain and now must assign new policies and security zones; see Managing Domains, on page 270.

**Procedure**

**Step 1**

In the Move Devices dialog box, under Select Device(s) to Configure, check the device you want to configure. Check multiple devices to assign the same health and access control policies.

**Step 2**

Choose an Access Control Policy to apply to the device, or choose New Policy to create a new policy.

**Step 3**

Choose a Health Policy to apply to the device, or choose None to leave the device without a health policy.

**Step 4**

If prompted to assign interfaces to new zones, choose a New Security Zone for each listed interface, or choose None to assign it later.

**Step 5**

After you configure all affected devices, click Save to save policy and zone assignments.

**Step 6**

Click Save to implement the domain configuration.
What to do next

• Update other configurations on the moved device that were affected by the move.
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.
CHAPTER 16

Policy Management

The following topics describe how to manage various policies on the Firepower Management Center:

- Policy Deployment, on page 275
- Policy Comparison, on page 284
- Policy Reports, on page 285
- Out-of-Date Policies, on page 286
- Performance Considerations for Limited Deployments, on page 287

Policy Deployment

After you configure your deployment, and any time you change that configuration, you must deploy the changes to affected devices. You can view deployment status in the Message Center.

Deploying updates the following components:

- Device and interface configurations
- Device-related policies: NAT, VPN, platform settings
- Access control and related policies: DNS, file, identity, intrusion, network analysis, SSL
- Network discovery policy
- Intrusion rule updates
- Configurations and objects associated with any of these elements

You can configure the system to deploy automatically by scheduling a deploy task or by setting the system to deploy when importing intrusion rule updates. Automating policy deployment is especially useful if you allow intrusion rule updates to modify system-provided base policies for intrusion and network analysis. Intrusion rule updates can also modify default values for the advanced preprocessing and performance options in your access control policies.

In a multidomain deployment, you can deploy changes for any domain where your user account belongs:

- Switch to an ancestor domain to deploy changes to all subdomains at the same time.
- Switch to a leaf domain to deploy changes to only that domain.
Guidelines for Deploying Configuration Changes

Inline vs Passive Deployments
Do not apply inline configurations to devices deployed passively, and vice versa.

Time to Deploy and Memory Limitations
The time it takes to deploy depends on multiple factors, including (but not limited to):

• The configurations you send to the device. For example, if you dramatically increase the number of Security Intelligence entries you block, deploy can take longer.

• Device model and memory. On lower-memory devices, deploying can take longer. For example, it can take up to five minutes to deploy to a Firepower 7010, 7020, or 7030 device.

Do not exceed the capability of your devices. If you exceed the maximum number rules or policies supported by a target device, the system displays a warning. The maximum depends on a number of factors—not only memory and the number of processors on the device, but also on policy and rule complexity. For information on optimizing policies and rules, see Rule Performance Guidelines, on page 311.

Interruptions to Traffic Flow and Inspection During Deploy
When you deploy, resource demands may result in a small number of packets dropping without inspection. Additionally, deploying some configurations restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 and Configurations that Restart the Snort Process When Deployed or Activated, on page 281.

Caution
We strongly recommend you deploy in a maintenance window or at a time when interruptions will have the least impact.

Auto-Enabling Application Detectors
If you are performing application control but disable required detectors, the system automatically enables the appropriate system-provided detectors upon policy deploy. If none exist, the system enables the most recently modified user-defined detector for the application.

Asset Rediscovery with Network Discovery Policy Changes
When you deploy changes to a network discovery policy, the system deletes and then redisCOVERs MAC address, TTL, and hops information from the network map for the hosts in your monitored networks. Also, the affected managed devices discard any discovery data that has not yet been sent to the Firepower Management Center.

Related Topics
Snort® Restart Scenarios, on page 279
Deploy Configuration Changes

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Approver</td>
</tr>
</tbody>
</table>

After you change configurations, deploy to the affected devices. We strongly recommend you deploy in a maintenance window or at a time when any interruptions to traffic flow and inspection will have the least impact.

⚠️ Caution

When you deploy, resource demands may result in a small number of packets dropping without inspection. Additionally, deploying some configurations restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 and Configurations that Restart the Snort Process When Deployed or Activated, on page 281.

Before you begin

- Review the guidelines described in Guidelines for Deploying Configuration Changes, on page 276.
- Be sure all managed devices use the same revision of the Security Zones object. If you have edited security zone objects: Do not deploy configuration changes to any device until you edit the zone setting for interfaces on all devices you want to sync. You must deploy to all managed devices at the same time. See Synchronizing Security Zone Object Revisions, on page 388.

Procedure

Step 1

On the Firepower Management Center menu bar, click Deploy.

The Deploy Policies dialog lists devices with out-of-date configurations. The Version at the top of the dialog specifies when you last made configuration changes. The Current Version column in the device table specifies when you last deployed changes to each device.

Step 2

Identify and choose the devices where you want to deploy configuration changes.

- Sort—Sort the device list by clicking a column heading.
- Expand—Click the plus icon (🔍) to expand a device listing to view the configuration changes to be deployed. The system marks out-of-date policies with an index (🔍) icon.
- Filter—Filter the device list. Click the arrow in the upper-right corner of any column heading in the display, enter text in the Filters text box, and press Enter. Check or uncheck the check box to activate or deactivate the filter.
- Arrange—Place the mouse on a column heading to drag and drop the column in your preferred order.

Step 3

Click Deploy.

Step 4

If the system identifies errors or warnings in the changes to be deployed, you have the following choices:
What to do next

- (Optional) Monitor deployment status; see Viewing Deployment Messages, on page 260.
- If deploy fails, see Guidelines for Deploying Configuration Changes, on page 276.

Related Topics

Snort® Restart Scenarios, on page 279

Redeploy Existing Configurations to a Device

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Network Admin/Network Admin/Security Approver</td>
</tr>
</tbody>
</table>

You can force-deploy existing (unchanged) configurations to a single managed device. We strongly recommend you deploy in a maintenance window or at a time when any interruptions to traffic flow and inspection will have the least impact.

Caution

When you deploy, resource demands may result in a small number of packets dropping without inspection. Additionally, deploying some configurations restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 and Configurations that Restart the Snort Process When Deployed or Activated, on page 281.

Before you begin

Review the guidelines described in Guidelines for Deploying Configuration Changes, on page 276.

Procedure

Step 1  Choose Devices > Device Management.

Step 2  Click the edit icon (✏️) next to the device where you want to force deployment.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3  Click the Device tab.

Step 4  Click the edit icon (✏️) next to the General section heading.
Step 5
Click the Force Deploy arrow ( ).

Step 6
Click Deploy.

The system identifies any errors or warnings with the configurations you are deploying. You can click Proceed to continue without resolving warning conditions. However, you cannot proceed if the system identifies an error.

What to do next
• (Optional) Monitor deployment status; see Viewing Deployment Messages, on page 260.
• If deploy fails, see Guidelines for Deploying Configuration Changes, on page 276.

Related Topics
Snort® Restart Scenarios, on page 279

Snort® Restart Scenarios

When the traffic inspection engine referred to as the Snort process on a managed device restarts, inspection is interrupted until the process resumes. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information. Additionally, resource demands may result in a small number of packets dropping without inspection when you deploy, regardless of whether the Snort process restarts.

Any of the scenarios in the following table cause the Snort process to restart.

<table>
<thead>
<tr>
<th>Restart Scenario</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deploying a specific configuration that requires the Snort process to restart.</td>
<td>Configurations that Restart the Snort Process When Deployed or Activated, on page 281</td>
</tr>
<tr>
<td>Modifying a configuration that immediately restarts the Snort process.</td>
<td>Changes that Immediately Restart the Snort Process, on page 283</td>
</tr>
<tr>
<td>Traffic-activation of the currently deployed Automatic Application Bypass (AAB) configuration.</td>
<td>Configuring Automatic Application Bypass, on page 187</td>
</tr>
</tbody>
</table>

Related Topics
Access Control Policy Advanced Settings, on page 634
Configurations that Restart the Snort Process When Deployed or Activated, on page 281

Inspect Traffic During Policy Apply

Inspect traffic during policy apply is an advanced access control policy general setting that allows managed devices to inspect traffic while deploying configuration changes; this is the case unless a configuration that you deploy requires the Snort process to restart. You can configure this option as follows:

• Enabled — Traffic is inspected during the deployment unless certain configurations require the Snort process to restart.
When the configurations you deploy do not require a Snort restart, the system initially uses the currently deployed access control policy to inspect traffic, and switches during deployment to the access control policy you are deploying.

- **Disabled** — Traffic is not inspected during the deployment. The Snort process always restarts when you deploy.

The following graphic illustrates how Snort restarts can occur when you enable or disable **Inspect traffic during policy apply**.

![Snort Restart Traffic Behavior Diagram]

**Caution**

When you deploy, resource demands may result in a small number of packets dropping without inspection. Additionally, deploying some configurations restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See **Snort® Restart Traffic Behavior**, on page 280 and **Configurations that Restart the Snort Process When Deployed or Activated**, on page 281.

### Snort® Restart Traffic Behavior

The following tables explain how different devices handle traffic when the Snort process restarts.

#### Table 48: 7000 and 8000, NGIPSv Restart Traffic Effects

<table>
<thead>
<tr>
<th>Interface Configuration</th>
<th>Restart Traffic Behavior</th>
</tr>
</thead>
</table>
| inline: **Failsafe** enabled or disabled | passed without inspection  
A few packets might drop if **Failsafe** is disabled and Snort is busy but not down. |
| inline: tap mode         | egress packet immediately, copy bypasses Snort |
| passive                 | uninterrupted, not inspected |
| routed, switched        | dropped |
| (7000 and 8000 Series only) | |
### Table 49: ASA FirePOWER Restart Traffic Effects

<table>
<thead>
<tr>
<th>Interface Configuration</th>
<th>Restart Traffic Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>routed or transparent with fail-open</td>
<td>passed without inspection</td>
</tr>
<tr>
<td>routed or transparent with fail-close</td>
<td>dropped</td>
</tr>
</tbody>
</table>

In addition to traffic handling when the Snort process is down while it restarts, traffic can also pass without inspection or drop when the Snort process is busy, depending on the configuration of the Failsafe option. See Inline Sets on the Firepower System, on page 396.

#### Note
When the Snort process is busy but not down during configuration deployment, some packets may drop on routed, switched, or transparent interfaces if the total CPU load exceeds 50 percent.

### Configurations that Restart the Snort Process When Deployed or Activated

Deploying any of the following configurations except AAB restarts the Snort process as described. Deploying AAB does not cause a restart, but excessive packet latency activates the currently deployed AAB configuration, causing a partial restart of the Snort process.

#### Access Control Policy

- Add the first or remove the last URL category/reputation condition in an access control rule.
- Change the total number of active intrusion policies by adding an intrusion policy that is not currently used, or by removing the last instance of an intrusion policy. You can use an intrusion policy in an access control rule, as the default action, or as the default intrusion policy.

#### Access Control Policy Advanced Settings

- Deploy when **Inspect Traffic During Policy Apply** is disabled.
- Configure a non-default value under Files and Malware Settings.
- Add or remove an SSL policy.
- Enable or disable adaptive profiles.
- Enable or disable the **Log Session/Protocol Distribution** troubleshooting option.

#### Security Intelligence

Add or delete multiple Security Intelligence whitelist or blacklist networks or network objects. Changes can be to custom or system-provided lists, and whether the Snort process restarts can vary by device, depending on the memory available for inspection.
SSL Policy

• Add the first or remove the last category/reputation condition in an SSL rule.

File Policy

Deploy the first or last of any one of the following configurations; note that while otherwise deploying these file policy configurations does not cause a restart, deploying non-file-policy configurations can cause restarts.

• Enable or disable Inspect Archives.

• Take either of the following actions:
  • Enable or disable Inspect Archives when the deployed access control policy includes at least one file policy.
  • Add the first or remove the last file policy rule when Inspect Archives is enabled (note that at least one rule is required for Inspect Archives to be meaningful).

• Select Detect Files or Block Files in a file rule.

• Enable or disable Store files in a Detect Files or Block Files rule.

• Add the first or remove the last active file rule that combines the Malware Cloud Lookup or Block Malware rule action with an analysis option (Spero Analysis or MSEXE, Dynamic Analysis, or Local Malware Analysis) or a store files option (Malware, Unknown, Clean, or Custom).

Note that access control rules that deploy these file policy configurations to security zones or tunnel zones cause a restart only when your configuration meets the following conditions:

• Source or destination security zones in your access control rule must match the security zones associated with interfaces on the target devices.

• Unless the destination zone in your access control rule is any, a source tunnel zone in the rule must match a tunnel zone assigned to a tunnel rule in the prefilter policy.

Identity Policy

• When SSL decryption is disabled (that is, when the access control policy does not include an SSL policy), add the first or remove the last active authentication rule.

An active authentication rule has either an Active Authentication rule action, or a Passive Authentication rule action with Use active authentication if passive authentication cannot identify user selected.

Network Analysis Policy

• Change the total number of network analysis policies by adding a network analysis policy that is not currently used, or by removing the last instance of a network analysis policy. You can use a network analysis policy with network analysis rules or as the default network analysis policy.

• Change the value for the IMAP, POP, or SMTP preprocessor Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth.
Network Discovery

- Enable or disable non-authoritative, traffic-based user detection over the HTTP, FTP, or MDNS protocols, using the network discovery policy.

Device Management

- Routing—Add a routed interface pair or virtual router to a 7000 or 8000 Series device.
- VPN—Add or remove a VPN on a 7000 or 8000 Series device.

⚠️ Caution

The system does not warn you that the Snort process restarts when you add or remove a VPN on a 7000 or 8000 Series device.

- MTU—Change the highest MTU value among all non-management interfaces on a device.
- Classic device high availability—Change a high-availability state sharing option.
- Automatic Application Bypass (AAB)—The currently deployed AAB configuration activates when a malfunction of the Snort process or a device misconfiguration causes a single packet to use an excessive amount of processing time. The result is a partial restart of the Snort process to alleviate extremely high latency or prevent a complete traffic stall. This partial restart causes a few packets to pass without inspection, or drop, depending on how the device handles traffic.

Updates

- System update—Deploy configurations the first time after a software update that includes a new version of the Snort binary or data acquisition library (DAQ).
- VDB—Deploy configurations the first time after installing a vulnerability database (VDB).
- Intrusion rule update—Deploying configurations the first time after importing an intrusion rule update (also known as a Snort Rule Update).

⚠️ Caution

Intrusion rule updates are cumulative. Any shared object rule that is added or modified since your last update causes a restart when you deploy, even if the current update has no shared object rule changes.

Related Topics

Deploy Configuration Changes, on page 277
Snort® Restart Scenarios, on page 279

Changes that Immediately Restart the Snort Process

The following changes immediately restart the Snort process without going through the deploy process. How the restart affects traffic depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

- Take any of the following actions involving applications or application detectors:
• Activate or deactivate a system or custom application detector.
• Delete an activated custom detector.
• **Save and Reactivate** an activated custom detector.
• Create a user-defined application.

The Snort process restarts on all managed devices.

• Install a vulnerability database (VDB) update.
• Restart the Snort process in the 7000 or 8000 Series user interface (**System > Configuration > Process**)—The system prompts you for confirmation and allows you to cancel.

### Policy Comparison

To review policy changes for compliance with your organization's standards or to optimize system performance, you can examine the differences between two policies or between a saved policy and the running configuration.

You can compare the following policy types:

- DNS
- File
- Health
- Identity
- Intrusion
- Network Analysis
- SSL

The comparison view displays both policies in a side-by-side format. Differences between the two policies are highlighted:

- Blue indicates that the highlighted setting is different in the two policies, and the difference is noted in red text.
- Green indicates that the highlighted setting appears in one policy but not the other.

### Comparing Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>feature dependent</td>
<td>feature dependent</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1**  Access the management page for the policy you want to compare:
• DNS—Policies > Access Control > DNS
• File—Policies > Access Control > Malware & File
• Health—System > Health > Policy
• Identity—Policies > Access Control > Identity
• Intrusion—Policies > Access Control > Intrusion
• Network Analysis—Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy

Note If your custom user role limits access to the first path listed here, use the second path to access the policy.

• SSL—Policies > Access Control > SSL

Step 2 Click Compare Policies.
Step 3 From the Compare Against drop-down list, choose the type of comparison you want to make:
  • To compare two different policies, choose Other Policy.
  • To compare two revisions of the same policy, choose Other Revision.
  • To compare another policy to the currently active policy, choose Running Configuration.

Step 4 Depending on the comparison type you choose, you have the following choices:
  • If you are comparing two different policies, choose the policies you want to compare from the Policy A and Policy B drop-down lists.
  • If you are comparing the running configuration to another policy, choose the second policy from the Policy B drop-down list.

Step 5 Click OK.
Step 6 Review the comparison results:
  • Comparison Viewer—To use the comparison viewer to navigate individually through policy differences, click Previous or Next above the title bar.
  • Comparison Report—To generate a PDF report that lists the differences between the two policies, click Comparison Report.

Policy Reports

For most policies, you can generate two kinds of reports. A report on a single policy provides details on the policy's current saved configuration, while a comparison report lists only the differences between two policies. You can generate a single-policy report for all policy types except health.

Note Intrusion policy reports combine the settings in the base policy with the settings of the policy layers, and make no distinction between which settings originated in the base policy or policy layer.
Generating Current Policy Reports

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>feature dependent</td>
<td>feature dependent</td>
</tr>
</tbody>
</table>

Procedure

**Step 1**
Access the management page for the policy for which you want to generate a report:

- Access Control—Policies > Access Control
- DNS—Policies > Access Control > DNS
- File—Policies > Access Control > Malware & File
- Health—System > Health > Policy
- Identity—Policies > Access Control > Identity
- Intrusion—Policies > Access Control > Intrusion
- NAT for 7000 & 8000 Series devices—Devices > NAT
- Network Analysis—Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy

**Note**
If your custom user role limits access to the first path listed here, use the second path to access the policy.

- SSL—Policies > Access Control > SSL

**Step 2**
Click the report icon ( ) next to the policy for which you want to generate a report.

Out-of-Date Policies

The Firepower System marks out-of-date policies with red status text that indicates how many of its targeted devices need a policy update. To clear this status, you must re-deploy the policy to the devices.

Configuration changes that require a policy re-deploy include:

- Modifying an access control policy: any changes to access control rules, the default action, policy targets, Security Intelligence filtering, advanced options including preprocessing, and so on.

- Modifying any of the policies that the access control policy invokes: the SSL policy, network analysis policies, intrusion policies, file policies, identity policies, or DNS policies.

- Changing any reusable object or configuration used in an access control policy or policies it invokes:
  - network, port, VLAN tag, URL, and geolocation objects
  - Security Intelligence lists and feeds
  - application filters or detectors
  - intrusion policy variable sets
  - file lists
• decryption-related objects and security zones

• Updating the system software, intrusion rules, or the vulnerability database (VDB).

Keep in mind that you can change some of these configurations from multiple places in the web interface. For example, you can modify security zones using the object manager (Objects > Object Management), but modifying an interface type in a device’s configuration (Devices > Device Management) can also change a zone and require a policy re-deploy.

Note that the following updates do not require policy re-deploy:

• automatic updates to Security Intelligence feeds and additions to the Security Intelligence global blacklist or whitelist using the context menu

• automatic updates to URL filtering data

• scheduled geolocation database (GeoDB) updates

Performance Considerations for Limited Deployments

Host, application, and user discovery data allow the system to create a complete, up-to-the-minute profile of your network. The system can also act as an intrusion detection and prevention system (IPS), analyzing network traffic for intrusions and exploits and, optionally, dropping offending packets.

Combining discovery and IPS gives context to your network activity and allows you to take advantage of many features, including:

• impact flags and indications of compromise, which can tell you which of your hosts are vulnerable to a particular exploit, attack, or piece of malware

• adaptive profiles and Firepower recommendations, which allow you to examine traffic differently depending on the destination host

• correlation, which allows you to respond to intrusions (and other events) differently depending on the affected host

However, if your organization is interested in performing only IPS, or only discovery, there are a few configurations that can optimize the performance of the system.

Discovery Without Intrusion Prevention

The discovery feature allows you to monitor network traffic and determine the number and types of hosts (including network devices) on your network, as well as the operating systems, active applications, and open ports on those hosts. You can also configure managed devices to monitor user activity on your network. You can use discovery data to perform traffic profiling, assess network compliance, and respond to policy violations.

In a basic deployment (discovery and simple, network-based access control only), you can improve a device’s performance by following a few important guidelines when configuring its access control policy.

Note

You must use an access control policy, even if it simply allows all traffic. The network discovery policy can only examine traffic that the access control policy allows to pass.
First, make sure your access control policy does not require complex processing and uses only simple, network-based criteria to handle network traffic. You must implement all of the following guidelines; misconfiguring any one of these options eliminates the performance benefit:

- **Do not** use the Security Intelligence feature. Remove any populated global whitelist or blacklist from the policy’s Security Intelligence configuration.

- **Do not** include access control rules with Monitor or Interactive Block actions. Use only Allow, Trust, and Block rules. Keep in mind that allowed traffic can be inspected by discovery; trusted and blocked traffic cannot.

- **Do not** include access control rules with application, user, URL, ISE attribute, or geolocation-based network conditions. Use only simple network-based conditions: zone, IP address, VLAN tag, and port.

- **Do not** include access control rules that perform file, malware, or intrusion inspection. In other words, do not associate a file policy or intrusion policy with any access control rule.

- Make sure that the default intrusion policy for the access control policy is set to **No Rules Active**.

- Select **Network Discovery Only** as the policy’s default action. **Do not** choose a default action for the policy that performs intrusion inspection.

In conjunction with the access control policy, you can configure and deploy the network discovery policy, which specifies the network segments, ports, and zones that the system examines for discovery data, as well as whether hosts, applications, and users are discovered on the segments, ports, and zones.

**Related Topics**
- [The Default Intrusion Policy](#), on page 1051

## Intrusion Prevention Without Discovery

Disabling discovery if you don't need it (for example, in an IPS-only deployment) can improve performance. To disable discovery you must implement all of these changes:

- **Delete** all rules from your network discovery policy.

- **Use only** simple network-based conditions to perform access control: zone, IP address, VLAN tag, and port.

  **Do not** perform any kind of, application, user, URL, or geolocation control. Although you can disable storage of discovery data, the system still must collect and examine it to implement those features.

After you deploy, new discovery halts on target devices. The system gradually deletes information in the network map according to your timeout preferences. Or, you can purge all discovery data immediately.
Rule Management: Common Characteristics

The following topics describe how to manage common characteristics of rules in various policies on the Firepower Management Center:

- **Introduction to Rules**, on page 289
- **Rule Condition Types**, on page 290
- **Searching for Rules**, on page 309
- **Filtering Rules by Device**, on page 310
- **Rule and Other Policy Warnings**, on page 310
- **Rule Performance Guidelines**, on page 311

**Introduction to Rules**

Rules in various policies exert granular control over network traffic. The system evaluates traffic against rules in the order that you specify, using a first-match algorithm.

Although these rules may include other configurations that are not consistent across policies, they share many basic characteristics and configuration mechanics, including:

- **Conditions**—Rule conditions specify the traffic that each rule handles. You can configure each rule with multiple conditions. Traffic must match all conditions to match the rule.

- **Action**—A rule's action determines how the system handles matching traffic. Note that even if a rule does not have an **Action** list you can choose from, the rule still has an associated action. For example, a custom network analysis rule uses a network analysis policy as its "action."

- **Position**—A rule's position determines its evaluation order. When using a policy to evaluate traffic, the system matches traffic to rules in the order you specify. Usually, the system handles traffic according to the first rule where all the rule’s conditions match the traffic. (Monitor rules, which track and log but do not affect traffic flow, are an exception.) Proper rule order reduces the resources required to process network traffic, and prevents rule preemption.

- **Category**—To organize some rule types, you can create custom rule categories in each parent policy.

- **Logging**—For many rules, logging settings govern whether and how the system logs connections handled by the rule. Some rules (such as identity and network analysis rules) do not include logging settings because the rules neither determine the final disposition of connections, nor are they specifically designed to log connections.
• Comments—For some rule types, each time you save changes, you can add comments. For example, you might summarize the overall configuration for the benefit of other users, or note when you change a rule and the reason for the change.

A right-click menu in many policy editors provides shortcuts to many rule management options, including editing, deleting, moving, enabling, and disabling.

Rules with Shared Characteristics
This chapter documents many common aspects of the following rules and configurations. For information on non-shared configurations, see:

• Access control rules—Access Control Rules, on page 639
• SSL rules—Creating and Modifying TLS/SSL Rules, on page 744
• DNS rules—Creating and Editing DNS Rules, on page 687
• Identity rules—Create an Identity Rule, on page 1337
• Network analysis rules—Configuring Network Analysis Rules, on page 1055
• Intelligent Application Bypass (IAB)—Intelligent Application Bypass, on page 695
• Application filters—Application Filters, on page 328

Rules without Shared Characteristics
Rules whose configurations are not documented in this chapter include:

• Intrusion rules—Tuning Intrusion Policies Using Rules, on page 873
• File rules—File Rules, on page 815
• Correlation rules—Configuring Correlation Rules, on page 1365
• NAT rules (Classic)—NAT for 7000 and 8000 Series Devices, on page 521
• 8000 Series fastpath rules—Configuring Fastpath Rules (8000 Series), on page 188

Rule Condition Types
The following table describes the common rule conditions documented in this chapter, and lists the configurations where they are used.
<table>
<thead>
<tr>
<th>Condition</th>
<th>Controls Traffic By...</th>
<th>Supported Rules/Configurations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Zone Conditions, on page 293</td>
<td>Source and destination security zones</td>
<td>Access control rules, SSL rules, DNS rules, Identity rules, Network analysis rules</td>
</tr>
<tr>
<td>Network Conditions, on page 294</td>
<td>Source and destination IP address, and where supported, geographical location</td>
<td>Access control rules, SSL rules, DNS rules, Identity rules, Network analysis rules</td>
</tr>
<tr>
<td>VLAN Conditions, on page 296</td>
<td>VLAN tag</td>
<td>Access control rules, SSL rules, DNS rules, Identity rules, Network analysis rules</td>
</tr>
<tr>
<td>Port and ICMP Code Conditions, on page 296</td>
<td>Source and destination ports, protocols, and ICMP codes</td>
<td>Access control rules, SSL rules, Identity rules</td>
</tr>
<tr>
<td>Application Conditions (Application Control), on page 298</td>
<td>Application or application characteristic (type, risk, business relevance, category, and tags)</td>
<td>Access control rules, SSL rules, Identity rules, Application filters, Intelligent Application Bypass (IAB)</td>
</tr>
<tr>
<td>URL Conditions (URL Filtering), on page 305</td>
<td>URL, and where supported, URL characteristic (category and reputation)</td>
<td>Access control rules, SSL rules</td>
</tr>
<tr>
<td>User, Realm, and ISE Attribute Conditions (User Control), on page 305</td>
<td>Logged-in authoritative user of a host, or that user's realm, group, or ISE attributes</td>
<td>Access control rules, SSL rules (no ISE attributes)</td>
</tr>
</tbody>
</table>
Rule Condition Mechanics

Rule conditions specify the traffic that each rule handles. You can configure each rule with multiple conditions, and traffic must match all conditions to match the rule. The available condition types depend on the rule type.

In rule editors, each condition type has its own tab page. Build conditions by choosing the traffic characteristics you want to match. In general, choose criteria from one or two lists of available items on the left, then add or combine those criteria into one or two lists of selected items on the right. For example, in URL conditions in access control rules, you can combine URL category and reputation criteria to create a single group of websites to block.

To help you build conditions, you can match traffic using various system-provided and custom configurations, including realms, ISE attributes, and various types of objects and object groups. Often, you can manually specify rule criteria.

Leave matching criteria empty whenever possible, especially those for security zones, network objects, and port objects. When you specify multiple criteria, the system must match against every combination of the contents of the criteria you specify.

---

**Note**

Failure to set up your access control rules properly can have unexpected results, including traffic being allowed that should be blocked. In general, application control rules should be lower in your access control list because it takes longer for those rules to match than rules based on IP address, for example.

Access control rules that use specific conditions (such as networks and IP addresses) should be ordered before rules that use general conditions (such as applications). If you're familiar with the Open Systems Interconnect (OSI) model, use similar numbering in concept. Rules with conditions for layers 1, 2, and 3 (physical, data link, and network) should be ordered first in your access control rules. Conditions for layers 5, 6, and 7 (session, presentation, and application) should be ordered later in your access control rules. For more information about the OSI model, see this Wikipedia article.

---

**Source and Destination Criteria**

Where a rule involves source and destination criteria (zones, networks, ports), usually you can use either or both criteria as constraints. If you use both, matching traffic must originate from one of the specified source zones, networks, or ports and leave through one of the destination zones, networks, or ports.

**Items per Condition**

You can add up to 50 items to each condition. For rules with source and destination criteria, you can use up to 50 of each. Traffic that matches any of the selected items matches the condition.

**Simple Rule Mechanics**

In rule editors, you have the following general choices. For detailed instructions on building conditions, see the topics for each condition type.

- **Choose Item**—Click an item or check its check box. Often you can use Ctrl or Shift to choose multiple items, or right-click to Select All.

- **Search**—Enter criteria in the search field. The list updates as you type. The system searches item names and, for objects and object groups, their values. Click reload (✓) or clear (✗) to clear the search.
• Add Predefined Item—After you choose one or more available items, click an Add button or drag and drop. The system prevents you from adding invalid items: duplicates, invalid combinations, and so on.

• Add Manual Item—Click the field under the Selected items list, enter a valid value, and click Add. When you add ports, you may also choose a protocol from the drop-down list.

• Create Object—Click the add icon ( ) to create a new, reusable object that you can immediately use in the condition you are building, then manage in the object manager. When using this method to add application filters on the fly, you cannot save a filter that includes another user-created filter.

• Delete—Click the delete icon ( ) for an item, or choose one or more items and right-click to Delete Selected.

Security Zone Conditions

Security zones segment your network to help you manage and classify traffic flow by grouping interfaces across multiple devices.

Zone rule conditions control traffic by its source and destination security zones. If you add both source and destination zones to a zone condition, matching traffic must originate from an interface in one of the source zones and leave through an interface in one of the destination zones.

Just as all interfaces in a zone must be of the same type (all inline, passive, switched, routed, or ASA FirePOWER), all zones used in a zone condition must be of the same type. Because devices deployed passively do not transmit traffic, you cannot use a zone with passive interfaces as a destination zone.

Leave matching criteria empty whenever possible, especially those for security zones, network objects, and port objects. When you specify multiple criteria, the system must match against every combination of the contents of the criteria you specify.

Tip
Constraining rules by zone is one of the best ways to improve system performance. If a rule does not apply to traffic through any of device’s interfaces, that rule does not affect that device's performance.

Security Zone Conditions and Multitenancy

In a multidomain deployment, a zone created in an ancestor domain can contain interfaces that reside on devices in different domains. When you configure a zone condition in an descendant domain, your configurations apply to only the interfaces you can see.

Rules with Security Zone Conditions

The following rules support security zone conditions:

• Access control
• SSL
• DNS (source zone constraints only)
• Identity
• Network analysis
**Example: Access Control Using Security Zones**

Consider a deployment where you want hosts to have unrestricted access to the internet, but you nevertheless want to protect them by inspecting incoming traffic for intrusions and malware.

First, create two security zones: Internal and External. Then, assign interface pairs on one or more devices to those zones, with one interface in each pair in the Internal zone and one in the External zone. Hosts connected to the network on the Internal side represent your protected assets.

---

**Note**

You are not required to group all internal (or external) interfaces into a single zone. Choose the grouping that makes sense for your deployment and security policies.

Then, configure an access control rule with a destination zone condition set to Internal. This simple rule matches traffic that leaves the device from any interface in the Internal zone. To inspect matching traffic for intrusions and malware, choose a rule action of **Allow**, then associate the rule with an intrusion and a file policy.

---

**Network Conditions**

Network rule conditions control traffic by its source and destination IP address, using inner headers. Tunnel rules, which use outer headers, have tunnel endpoint conditions instead of network conditions.

You can use predefined objects to build network conditions, or manually specify individual IP addresses or address blocks.

---

**Note**

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Leave matching criteria empty whenever possible, especially those for security zones, network objects, and port objects. When you specify multiple criteria, the system must match against every combination of the contents of the criteria you specify.

**Geolocation in Network Conditions**

Some rules can match traffic using the geographical location of the source or destination. If a rule type supports geolocation, you can mix network and geolocation criteria. To ensure you are using up-to-date geolocation data to filter your traffic, Cisco strongly recommends you regularly update the geolocation database (GeoDB).

**Rules with Network Conditions**

<table>
<thead>
<tr>
<th>Rule Type</th>
<th>Supports Geolocation Constraints?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access control</td>
<td>yes</td>
</tr>
<tr>
<td>SSL</td>
<td>yes</td>
</tr>
</tbody>
</table>
### Rule Type vs. Geolocation Constraints

<table>
<thead>
<tr>
<th>Rule Type</th>
<th>Supports Geolocation Constraints?</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNS (source networks only)</td>
<td>no</td>
</tr>
<tr>
<td>Identity</td>
<td>yes</td>
</tr>
<tr>
<td>Network analysis</td>
<td>no</td>
</tr>
</tbody>
</table>

---

### Configuring Network Conditions

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

#### Procedure

**Step 1**  
In the rule editor, click the **Networks** tab.

**Step 2**  
Find and choose the predefined networks you want to add from the **Available Networks** list.  
If the rule supports geolocation, you can mix network and geolocation criteria in the same rule:  
- Networks—Click the **Networks** sub-tab to choose networks.  
- Geolocation—Click the **Geolocation** sub-tab to choose geolocation objects.

**Step 3**  
Click **Add to Source** or **Add to Destination**, or drag and drop.

**Step 4**  
Add networks that you want to specify manually. Enter a source or destination IP address or address block, then click **Add**.

**Note**  
The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

**Step 5**  
Save or continue editing the rule.

---

**Example: Network Condition in an Access Control Rule**

The following graphic shows the network condition for an access control rule that blocks connections originating from your internal network and attempting to access resources either in North Korea or on 93.184.216.119 (example.com).
In this example, a network object group called Private Networks (that comprises the IPv4 and IPv6 Private Networks network objects, not shown) represents your internal networks. The example also manually specifies the example.com IP address, and uses a system-provided North Korea geolocation object to represent North Korea IP addresses.

**What to do next**

- Deploy configuration changes; see [Deploy Configuration Changes, on page 277](#).

---

**VLAN Conditions**

VLAN rule conditions control VLAN-tagged traffic, including QinQ (stacked VLAN) traffic. The system uses the innermost VLAN tag to filter VLAN traffic.

You can use predefined objects to build VLAN conditions, or manually enter any VLAN tag from 1 to 4094. Use a hyphen to specify a range of VLAN tags.

You can specify a maximum of 50 VLAN conditions.

---

**Note**

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal VLAN tags to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

---

**Rules with VLAN Conditions**

The following rule types support VLAN conditions:

- Access control
- SSL
- DNS
- Identity
- Network analysis

---

**Port and ICMP Code Conditions**

Port conditions allow you to control traffic by its source and destination ports. Depending on the rule type, “port” can represent any of the following:

- **TCP and UDP**—You can control TCP and UDP traffic based on the transport layer protocol. The system represents this configuration using the protocol number in parentheses, plus an optional associated port or port range. For example: TCP(6)/22.

- **ICMP**—You can control ICMP and ICMPv6 (IPv6-ICMP) traffic based on its internet layer protocol plus an optional type and code. For example: ICMP(1):3:3.

- **No port**—You can control traffic using other protocols that do not use ports.
Leave matching criteria empty whenever possible, especially those for security zones, network objects, and port objects. When you specify multiple criteria, the system must match against every combination of the contents of the criteria you specify.

**Using Source and Destination Port Constraints**

If you add both source and destination port constraints, you can only add ports that share a single transport protocol (TCP or UDP). For example, if you add DNS over TCP as a source port, you can add Yahoo Messenger Voice Chat (TCP) as a destination port but not Yahoo Messenger Voice Chat (UDP).

If you add only source ports or only destination ports, you can add ports that use different transport protocols. For example, you can add both DNS over TCP and DNS over UDP as source port conditions in a single access control rule.

**Matching Non-TCP Traffic with Port Conditions**

Although you can configure port conditions to match non-TCP traffic, there are some restrictions:

- **Access control rules**—You can match GRE-encapsulated traffic with an access control rule by using the GRE (47) protocol as a destination port condition. To a GRE-constrained rule, you can add only network-based conditions: zone, IP address, port, and VLAN tag. Also, the system uses outer headers to match all traffic in access control policies with GRE-constrained rules.

- **SSL rules**—SSL rules support TCP port conditions only.

- **Identity rules**—The system cannot enforce active authentication on non-TCP traffic. If an identity rule action is Active Authentication or if you check the option to **Use active authentication if passive authentication cannot identify user**, use TCP ports constraints only. If the identity rule action is Passive Authentication or No Authentication, you can create port conditions based on non-TCP traffic.

---

**Caution**

Adding the first or removing the last active authentication rule when SSL decryption is disabled (that is, when the access control policy does not include an SSL policy) restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See [Snort® Restart Traffic Behavior](#) on page 280 for more information.

Note that an active authentication rule has either an **Active Authentication** rule action, or a **Passive Authentication** rule action with **Use active authentication if passive authentication cannot identify user** selected.

- **IMCP echo**—A destination ICMP port with the type set to 0 or a destination ICMPv6 port with the type set to 129 only matches unsolicited echo replies. ICMP echo replies sent in response to ICMP echo requests are ignored. For a rule to match on any ICMP echo, use ICMP type 8 or ICMPv6 type 128.

**Rules with Port Conditions**

The following rules support port conditions:

- Access control

- SSL (supports TCP traffic only)
• Identity (active authentication supports TCP traffic only)

Configuring Port Conditions

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1
In the rule editor, click the **Ports** tab.

Step 2
Find and choose the predefined ports you want to add from the **Available Ports** list.

Step 3
Click **Add to Source** or **Add to Destination**, or drag and drop.

Step 4
Add any source or destination ports that you want to specify manually:

- **Source**—Choose a **Protocol**, enter a single **Port** from 0 to 65535, and click **Add**.
- **Destination (non-ICMP)**—Choose or enter a **Protocol**. If you do not want to specify a protocol, or if you choose TCP or UDP, enter a single **Port** from 0 to 65535. Click **Add**.
- **Destination (ICMP)**—Choose ICMP or IPv6-ICMP from the **Protocol** drop down list, then choose a **Type** and related **Code** in the pop-up window that appears. For more information on ICMP types and codes, see the Internet Assigned Numbers Authority (IANA) website.

Step 5
Save or continue editing the rule.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Application Conditions (Application Control)

When the system analyzes IP traffic, it can identify and classify the commonly used applications on your network. This discovery-based **application awareness** is the basis for **application control**—the ability to control application traffic.

System-provided **application filters** help you perform application control by organizing applications according to basic characteristics: type, risk, business relevance, category, and tags. You can create reusable user-defined filters based on combinations of the system-provided filters, or on custom combinations of applications.

At least one detector must be enabled for each application rule condition in the policy. If no detector is enabled for an application, the system automatically enables all system-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application. For more information about application detectors, see Application Detector Fundamentals, on page 1258.

You can use both application filters and individually specified applications to ensure complete coverage. However, understand the following note before you order your access control rules.
Failure to set up your access control rules properly can have unexpected results, including traffic being allowed that should be blocked. In general, application control rules should be lower in your access control list because it takes longer for those rules to match than rules based on IP address, for example.

Access control rules that use specific conditions (such as networks and IP addresses) should be ordered before rules that use general conditions (such as applications). If you're familiar with the Open Systems Interconnect (OSI) model, use similar numbering in concept. Rules with conditions for layers 1, 2, and 3 (physical, data link, and network) should be ordered first in your access control rules. Conditions for layers 5, 6, and 7 (session, presentation, and application) should be ordered later in your access control rules. For more information about the OSI model, see this Wikipedia article.

Benefits of Application Filters

Application filters help you quickly configure application control. For example, you can easily use system-provided filters to create an access control rule that identifies and blocks all high risk, low business relevance applications. If a user attempts to use one of those applications, the system blocks the session.

Using application filters simplifies policy creation and administration. It assures you that the system controls application traffic as expected. Because Cisco frequently updates and adds application detectors via system and vulnerability database (VDB) updates, you can ensure that the system uses up-to-date detectors to monitor application traffic. You can also create your own detectors and assign characteristics to the applications they detect, automatically adding them to existing filters.

Configurations with Application Conditions

The configurations in the following table help you perform application control. The table also shows how you can constrain application control, depending on the configuration.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Type, Risk, Relevance, Category</th>
<th>Tags</th>
<th>User-Defined Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access control rules</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>SSL rules</td>
<td>yes</td>
<td>no; automatically constrained to encrypted application traffic by the SSL Protocol tag</td>
<td>no</td>
</tr>
<tr>
<td>Identity rules (to exempt applications from active authentication)</td>
<td>yes</td>
<td>no; automatically constrained by the User-Agent Exclusion tag</td>
<td>no</td>
</tr>
<tr>
<td>User-defined application filter in the object manager</td>
<td>yes</td>
<td>yes</td>
<td>no; you cannot nest user-defined filters</td>
</tr>
<tr>
<td>Intelligent Application Bypass (IAB)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

Related Topics

Overview: Application Detection, on page 1257
Configuring Application Conditions and Filters

To build an application condition or filter, choose the applications whose traffic you want to control from a list of available applications. Optionally (and recommended), constrain the available applications using filters. You can use filters and individually specified applications in the same condition.

Before you begin

- Adaptive profiling must be enabled as described in Configuring Adaptive Profiles, on page 1195 for access control rules to perform application control.

Procedure

Step 1

Invoke the rule or configuration editor:

- Access control, SSL rule condition—In the rule editor, click the Applications tab.
- Identity rule condition—In the rule editor, click the Realms & Settings tab and enable active authentication; see Create an Identity Rule, on page 1337.
- Application filter—On the Application Filters page of the object manager, add or edit an application filter. Provide a unique Name for the filter.
- Intelligent Application Bypass (IAB)—In the access control policy editor, click the Advanced tab, edit IAB settings, then click Bypassable Applications and Filters.

Step 2

Find and choose the applications you want to add from the Available Applications list.

To constrain the applications displayed in Available Applications, choose one or more Application Filters or search for individual applications.

Tip

Click the information icon ( ) next to an application to display summary information and internet search links. The unlock icon ( ) marks applications that the system can identify only in decrypted traffic.

When you choose filters, singly or in combination, the Available Applications list updates to display only the applications that meet your criteria. You can choose system-provided filters in combination, but not user-defined filters.

- Multiple filters for the same characteristic (risk, business relevance, and so on)—Application traffic must match only one of the filters. For example, if you choose both the medium and high-risk filters, the Available Applications list displays all medium and high-risk applications.
- Filters for different application characteristics—Application traffic must match both filter types. For example, if you choose both the high-risk and low business relevance filters, the Available Applications list displays only applications that meet both criteria.

Step 3

Click Add to Rule, or drag and drop.
Tip: Before you add more filters and applications, click **Clear Filters** to clear your current choices.

The web interface lists filters added to a condition above and separately from individually added applications. Save or continue editing the rule or configuration.

---

### Example: Application Condition in an Access Control Rule

The following graphic shows the application condition for an access control rule that blocks a user-defined application filter for MyCompany, all applications with high risk and low business relevance, gaming applications, and some individually selected applications.

---

### Application Characteristics

The system characterizes each application that it detects using the criteria described in the following table. Use these characteristics as application filters.

#### Table 50: Application Characteristics

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Application protocols represent communications between hosts. Clients represent software running on a host. Web applications represent the content or requested URL for HTTP traffic.</td>
<td>HTTP and SSH are application protocols. Web browsers and email clients are clients. MPEG video and Facebook are web applications.</td>
</tr>
<tr>
<td><strong>Risk</strong></td>
<td>The likelihood that the application is being used for purposes that might be against your organization’s security policy.</td>
<td>Peer-to-peer applications tend to have a very high risk.</td>
</tr>
<tr>
<td>Characteristic</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Business Relevance</td>
<td>The likelihood that the application is being used within the context of your organization’s business operations, as opposed to recreationally.</td>
<td>Gaming applications tend to have a very low business relevance.</td>
</tr>
<tr>
<td>Category</td>
<td>A general classification for the application that describes its most essential function. Each application belongs to at least one category.</td>
<td>Facebook is in the social networking category.</td>
</tr>
<tr>
<td>Tag</td>
<td>Additional information about the application. Applications can have any number of tags, including none.</td>
<td>Video streaming web applications often are tagged high bandwidth and displays ads.</td>
</tr>
</tbody>
</table>

**Guidelines and Limitations for Application Control**

**Automatically Enabling Application Detectors**

If no detector is enabled for an application you want to detect, the system automatically enables all system-provided detectors for the application. If none exist, the system enables the most recently modified user-defined detector for the application.

**Speed of Application Identification**

The system cannot perform application control, including Intelligent Application Bypass (IAB), before both of the following occur:

- A monitored connection is established between a client and server
- The system identifies the application in the session

This identification should occur in 3 to 5 packets, or after the server certificate exchange in the SSL handshake if the traffic is encrypted.

If early traffic matches all other criteria but application identification is incomplete, the system allows the packet to pass and the connection to be established (or the SSL handshake to complete). After the system completes its identification, the system applies the appropriate action to the remaining session traffic.

For access control, these passed packets are inspected by the access control policy’s default intrusion policy (not the default action intrusion policy nor the almost-matched rule’s intrusion policy).

For guidelines about rule ordering for application control, see Recommendations for Application Control, on page 641.

**URL Rules Before Application and Other Rules**

For the most effective URL matching, place rules that include URL conditions before other rules, particularly if the URL rules are block rules and the other rules meet both of the following criteria:

- They include application conditions.
- The traffic to be inspected is encrypted.
Application Control for Encrypted and Decrypted Traffic

The system can identify and filter encrypted and decrypted traffic:

- **Encrypted traffic**—The system can detect application traffic encrypted with StartTLS, including SMTPS, POPS, FTPS, TelnetS, and IMAPS. In addition, it can identify certain encrypted applications based on the Server Name Indication in the TLS ClientHello message, or the subject distinguished name value from the server certificate. These applications are tagged **SSL Protocol**; in an SSL rule, you can choose only these applications. Applications without this tag can only be detected in unencrypted or decrypted traffic.

- **Decrypted traffic**—The system assigns the **decrypted traffic** tag to applications that the system can detect in decrypted traffic only, not encrypted or unencrypted.

Exempting Applications from Active Authorization

In an identity policy, you can exempt certain applications from active authentication, allowing traffic to continue to access control. These applications are tagged **User-Agent Exclusion**. In an identity rule, you can choose only these applications.

Handling Application Traffic Packets Without Payloads

When performing access control, the system applies the default policy action to packets that do not have a payload in a connection where an application is identified.

Handling Referred Application Traffic

To handle traffic referred by a web server, such as advertisement traffic, match the referred application rather than the referring application.

Controlling Application Traffic That Uses Multiple Protocols (Skype, Zoho)

Some applications use multiple protocols. To control their traffic, make sure your access control policy covers all relevant options. For example:

- Skype—To control Skype traffic, choose the **Skype** tag from the **Application Filters list** rather than selecting individual applications. This ensures that the system can detect and control all Skype traffic the same way.

- Zoho—To control Zoho mail, choose both **Zoho** and **Zoho mail** from the Available Application list.

Search Engines Supported for Content Restriction Features

The system supports Safe Search filtering for specific search engines only. The system assigns the **safesearch supported** tag to application traffic from these search engines.

Controlling Evasive Application Traffic

See Application-Specific Notes and Limitations, on page 304.

Related Topics

- The Default Intrusion Policy, on page 1051
- Special Considerations for Application Detection, on page 1261
Application-Specific Notes and Limitations

- **Office 365 Admin Portal:**
  Limitation: If the access policy has logging enabled at the beginning as well as at the end, the first packet will be detected as Office 365 and the end of connection will be detected as Office 365 Admin Portal. This should not affect blocking.

- **Skype:**
  See Guidelines and Limitations for Application Control, on page 302

- **Zoho:**
  See Guidelines and Limitations for Application Control, on page 302

- **Evasive applications such as Bittorrent, Tor, Psiphon, and Ultrasurf:**
  For evasive applications, only the highest-confidence scenarios are detected by default. If you need to take action on this traffic (such as block or implement QoS), it may be necessary to configure more aggressive detection with better effectiveness. To do this, contact TAC to review your configurations as these changes may result in false positives.

Troubleshoot Application Control Rules

If your application control rules don't function as you expect, use the guidelines discussed in this section.

We recommend controlling applications' access to the network as follows:

- To allow or block application access from a less secure network to a more secure network: Use Port (Selected Destination Port) conditions on the access control rule
  
  For example, allow ICMP traffic from the internet (less secure) to an internal network (more secure.)

- To allow or block applications being accessed by user groups: Use Application conditions on the access control rule
  
  For example, block Facebook from being accessed by members of the Contractors group

---

**Note**

Failure to set up your access control rules properly can have unexpected results, including traffic being allowed that should be blocked. In general, application control rules should be lower in your access control list because it takes longer for those rules to match than rules based on IP address, for example.

Access control rules that use specific conditions (such as networks and IP addresses) should be ordered before rules that use general conditions (such as applications). If you're familiar with the Open Systems Interconnect (OSI) model, use similar numbering in concept. Rules with conditions for layers 1, 2, and 3 (physical, data link, and network) should be ordered first in your access control rules. Conditions for layers 5, 6, and 7 (session, presentation, and application) should be ordered later in your access control rules. For more information about the OSI model, see this Wikipedia article.

The following table provides an example of how to set up your access control rules:
### URL Conditions (URL Filtering)

Use URL conditions to control the websites that users on your network can access.

For complete information, see URL Filtering, on page 661.

### User, Realm, and ISE Attribute Conditions (User Control)

You can perform user control with the authoritative user identity data collected by the Firepower System. Identity sources monitor users as they log in and out, or as they authenticate using Microsoft Active Directory (AD) or LDAP credentials. You can then configure rules that use this collected identity data to handle traffic based on the logged-in authoritative user associated with a monitored host. A user remains associated with a host until the user logs off (as reported by an identity source), a realm times out the session, or you delete the user data from the system's database.

For information on the authoritative user identity sources supported in your version of the Firepower System, see About User Identity Sources, on page 1277.

You can use the following rule conditions to perform user control:

<table>
<thead>
<tr>
<th>Type of control</th>
<th>Action</th>
<th>Zones, Networks, VLAN Tags</th>
<th>Users</th>
<th>Applications</th>
<th>Ports</th>
<th>URLs</th>
<th>SGT/ISE Attributes</th>
<th>Inspection, Logging, Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application from less secure to more secure network when application uses a port (for example, SSH)</td>
<td>Your choice (<a href="#">Allow</a> in this example)</td>
<td>Any</td>
<td>Any</td>
<td>Do not set</td>
<td>Available Ports: SSH Add to Selected Destination Ports</td>
<td>Any</td>
<td>Use only with ISE.</td>
<td>Any</td>
</tr>
<tr>
<td>Application from less secure to more secure network when application does not use a port (for example, ICMP)</td>
<td>Your choice (<a href="#">Allow</a> in this example)</td>
<td>Any</td>
<td>Any</td>
<td>Do not set</td>
<td>Selected Destination Ports Protocol: ICMP Type: Any</td>
<td>Do not set</td>
<td>Use only with ISE.</td>
<td>Any</td>
</tr>
<tr>
<td>Application access by a user group</td>
<td>Your choice (<a href="#">Block</a> in this example)</td>
<td>Your choice</td>
<td>Choose a user group (Contractors group in this example)</td>
<td>Choose the name of the application (Facebook in this example)</td>
<td>Do not set</td>
<td>Do not set</td>
<td>Use only with ISE.</td>
<td>Your choice</td>
</tr>
</tbody>
</table>

---

**Related Topics**

Guidelines for Ordering Rules, on page 312
• User and realm conditions—Match traffic based on the logged-in authoritative user of a host. You can control traffic based on realms, individual users, or the groups those users belong to.

• ISE attribute conditions—Match traffic based on a user's ISE-assigned Security Group Tag (SGT), Device Type (also referred to as Endpoint Profile), or Location IP (also referred to as Endpoint Location). Requires that you configure ISE as an identity source.

### Rules with User Conditions

<table>
<thead>
<tr>
<th>Rule Type</th>
<th>Supports User and Realm Conditions?</th>
<th>Supports ISE Attribute Conditions?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access control</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>SSL</td>
<td>yes</td>
<td>no</td>
</tr>
</tbody>
</table>

### Related Topics

- The User Agent Identity Source, on page 1278
- The ISE Identity Source, on page 1280
- The Captive Portal Identity Source, on page 1285

### User Control Prerequisites

#### Configure Identity Sources/Authentication Methods

Configure identity sources for the types of authentication you want to perform. For more information, see About User Identity Sources, on page 1277.

If you configure a User Agent or ISE device to monitor a large number of user groups, or if you have a very large number of users mapped to hosts on your network, the system may drop user mappings based on groups, due to your Firepower Management Center user limit. As a result, rules with realm, user, or user group conditions may not match traffic as expected.

#### Configure Realms

Configure a realm for each AD or LDAP server you want to monitor, including your ISE or User Agent servers, and perform a user download. For more information, see Create a Realm, on page 1330.

When you configure a realm, you specify the users and user groups whose activity you want to monitor. Including a user group automatically includes all of that group’s members, including members of any secondary groups. However, if you want to use the secondary group as a rule criterion, you must explicitly include the secondary group in the realm configuration.

For each realm, you can enable automatic download of user data to refresh authoritative data for users and user groups.

#### Create Identity Policies

Create an identity policy to associate the realm with an authentication method, and associate that policy with access control. For more information, see Create an Identity Policy, on page 1336.

Policies that perform user control on a device (access control, SSL) share an identity policy. That identity policy determines the realms, users, and groups that you can use in rules affecting traffic on those devices.
Configuring User and Realm Conditions

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can constrain a rule by realm, or by users and user groups within that realm.

**Before you begin**

- Fulfill the user control prerequisites described in User, Realm, and ISE Attribute Conditions (User Control), on page 305.

**Procedure**

**Step 1** In the rule editor, click the Users tab.

**Step 2** (Optional) Find and choose the realm you want to use from the Available Realms.

**Step 3** (Optional) Further constrain the rule by choosing users and groups from the Available Users list.

**Step 4** Click Add to Rule, or drag and drop.

**Step 5** Save or continue editing the rule.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Configuring ISE Attribute Conditions

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Before you begin**

- Fulfill the user control prerequisites described in User, Realm, and ISE Attribute Conditions (User Control), on page 305.

**Procedure**

**Step 1** In the rule editor, click the ISE Attributes tab.

**Step 2** Find and choose the ISE attributes you want to use from the Available ISE Session Attributes list:

- Security Group Tag (SGT)
• Device Type (also referred to as Endpoint Profile)
• Location IP (also referred to as Endpoint Location)

**Step 3** Further constrain the rule by choosing attribute metadata from the Available ISE Metadata list. Or, keep the default: any.

**Step 4** Click Add to Rule, or drag and drop.

**Step 5** (Optional) Constrain the rule with an IP address in the Add a Location IP Address field, then click Add.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.

**Step 6** Save or continue editing the rule.

---

**What to do next**

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Troubleshoot User Control**

If you notice unexpected user rule behavior, consider tuning your rule, identity source, or realm configurations. For other related troubleshooting information, see:

• Troubleshoot the User Agent Identity Source, on page 1280
• Troubleshoot the ISE Identity Source, on page 1284
• Troubleshoot the Captive Portal Identity Source, on page 1296
• Troubleshoot Realms and User Downloads, on page 1327

**Rules targeting realms, users, or user groups are not matching traffic**

If you configure a User Agent or ISE device to monitor a large number of user groups, or if you have a very large number of users mapped to hosts on your network, the system may drop user records due to your Firepower Management Center user limit. As a result, rules with user conditions may not match traffic as expected.

**Rules targeting user groups or users within user groups are not matching traffic as expected**

If you configure a rule with a user group condition, your LDAP or Active Directory server must have user groups configured. The system cannot perform user group control if the server organizes the users in basic object hierarchy.

**Rules targeting users in secondary groups are not matching traffic as expected**

If you configure a rule with a user group condition that includes or excludes users who are members of a secondary group on your Active Directory server, your server may be limiting the number of users it reports.

By default, Active Directory servers limit the number of users they report from secondary groups. You must customize this limit so that all of the users in your secondary groups are reported to the Firepower Management Center and eligible for use in rules with user conditions.
Rules are not matching users when seen for the first time

After the system detects activity from a previously-unseen user, the system retrieves information about them from the server. Until the system successfully retrieves this information, activity seen by this user is not handled by matching rules. Instead, the user session is handled by the next rule it matches (or the policy’s default action, if applicable).

For example, this might explain when:

- Users who are members of user groups are not matching rules with user group conditions.
- Users who were reported by a User Agent or ISE device are not matching rules, when the server used for user data retrieval is an Active Directory server.

Note that this might also cause the system to delay the display of user data in event views and analysis tools.

Rules are not matching all ISE users

This is expected behavior. You can perform user control on ISE users who were authenticated by an Active Directory domain controller. You cannot perform user control on ISE users who were authenticated by an LDAP, RADIUS, or RSA domain controller.

Searching for Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

In many policies, you can search for and within rules. The system matches your input to rule names and condition values, including objects and object groups.

You cannot search for values in a Security Intelligence or URL list or feed.

Procedure

Step 1
In the policy editor, click the Rules tab.

Step 2
Click the Search Rules prompt, enter a complete or partial search string, then press Enter.

The column for matching values is highlighted for each matching rule. A status message displays the current match and the total number of matches.

Step 3
Find the rules you are interested in.

To navigate between matching rules, click the next-match (▶) or previous-match (◀) icon.

What to do next

- Before you begin a new search, click the clear icon (✘) to clear the search and any highlighting.
Filtering Rules by Device

Some policy editors allow you to filter your rule view by affected devices.

The system uses a rule's interface constraints to determine if the rule affects a device. If you constrain a rule by interface (security zone condition), the device where that interface is located is affected by that rule. Rules with no interface constraint apply to any interface, and therefore every device.

Procedure

**Step 1**  
In the policy editor, click the **Rules** tab, then click **Filter by Device**.  
A list of targeted devices and device groups appears.

**Step 2**  
Check one or more check boxes to display only the rules that apply to those devices or groups. Or, check **All** to reset and display all of the rules.

**Tip**  
Hover your pointer over a rule criterion to see its value. If the criterion represents an object with device-specific overrides, the system displays the override value when you filter the rules list by only that device. If the criterion represents an object with domain-specific overrides, the system displays the override value when you filter the rules list by devices in that domain.

**Step 3**  
Click **OK**.

**Related Topics**

Creating and Editing Access Control Rules, on page 646

Rule and Other Policy Warnings

Policy and rule editors use icons to mark configurations that could adversely affect traffic analysis and flow. Depending on the issue, the system may warn you when you deploy or prevent you from deploying entirely.

**Tip**  
Hover your pointer over an icon to read the warning, error, or informational text.
Table 51: Policy Error Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>❌</td>
<td>error</td>
<td>If a rule or configuration has an error, you cannot deploy until you correct the issue, even if you disable any affected rules.</td>
</tr>
<tr>
<td>🔴</td>
<td>warning</td>
<td>You can deploy a policy that displays rule or other warnings. However, misconfigurations marked with warnings have no effect. If you disable a rule with a warning, the warning icon disappears. It reappears if you enable the rule without correcting the underlying issue.</td>
</tr>
<tr>
<td>⚠️</td>
<td>information</td>
<td>Information icons convey helpful information about configurations that may affect the flow of traffic. These issues do not prevent you from deploying.</td>
</tr>
</tbody>
</table>

Related Topics

Guidelines and Limitations for Application Control, on page 302
Guidelines and Limitations for URL Filtering, on page 662

Rule Performance Guidelines

In the Firepower System, rules in various policies exert granular control over network traffic. Properly configuring and ordering rules is essential to building an effective deployment. Although every organization and deployment has a unique policy and rule set, there are a few general guidelines to follow that can optimize performance while still addressing your needs.

Optimizing performance is especially important if you perform resource-intensive analysis. Complex policies and rules can command significant resources and negatively affect performance. When you deploy configuration changes, the system evaluates all rules together and creates an expanded set of criteria that target devices use to evaluate network traffic. If these criteria exceed the resources (physical memory, processors, and so on) of a target device, you cannot deploy to that device.
Guidelines for Simplifying and Focusing Rules

**Simplify: Do Not Overconfigure**

If one condition is enough to match the traffic you want to handle, do not use two.

Minimize individual rule criteria. Use as few individual elements in rule conditions as possible. For example, in network conditions use IP address blocks rather than individual IP addresses.

Combining elements into objects does **not** improve performance. For example, using a network object that contains 50 individual IP addresses gives you only an organizational—not a performance—benefit over including those IP addresses in the condition individually.

For recommendations related to application detection, see [Recommendations for Application Control](#), on page 641.

**Focus: Narrowly Constrain Resource-Intensive Rules, Especially by Interface**

As much as possible, use rule conditions to narrowly define the traffic handled by resource-intensive rules. Focused rules are also important because rules with broad conditions can match many different types of traffic, and can preempt later, more specific rules. Examples of resource-intensive rules include:

- SSL rules that decrypt traffic—Not only the decryption, but further analysis of the decrypted traffic, requires resources. Narrow focus, and where possible, block or choose not to decrypt encrypted traffic.

- Access control rules that invoke deep inspection—Intrusion, file, and malware inspection requires resources, especially if you use multiple custom intrusion policies and variable sets. Make sure you only invoke deep inspection where required.

For maximum performance benefit, constrain rules by interface. If a rule excludes all of a device’s interfaces, that rule does not affect that device's performance.

**Guidelines for Ordering Rules**

Always order rules to suit your organization's needs. In general, you should place top-priority rules that must apply to all traffic near the top of the policy.

Exceptions are noted in the sections below.
Rule Preemption

Rule preemption occurs when a rule will never match traffic because a rule earlier in the evaluation order matches the traffic first. A rule's conditions govern whether it preempts other rules. In the following example, the second rule cannot block Admin traffic because the first rule allows it:

Access Control Rule 1: allow Admin users
Access Control Rule 2: block Admin users

Any type of rule condition can preempt a subsequent rule. The VLAN range in the first SSL rule includes the VLAN in the second rule, so the first rule preempts the second:

SSL Rule 1: do not decrypt VLAN 22-33
SSL Rule 2: block VLAN 27

In the following example, Rule 1 matches any VLAN because no VLANs are configured, so Rule 1 preempts Rule 2, which attempts to match VLAN 2:

Access Control Rule 1: allow Source Network 10.4.0.0/16
Access Control Rule 2: allow Source Network 10.4.0.0/16, VLAN 2

A rule also preempts an identical subsequent rule where all configured conditions are the same:

Access Control Rule 1: allow VLAN 1 URL www.example.com
Access Control Rule 2: allow VLAN 1 URL www.example.com

A subsequent rule would not be preempted if any condition is different:

Access Control Rule 1: allow VLAN 1 URL www.example.com
Access Control Rule 2: allow VLAN 2 URL www.example.com

Example: Ordering SSL Rules to Avoid Preemption

Consider a scenario where a trusted CA (Good CA) mistakenly issued a CA certificate to a malicious entity (Bad CA), but has not yet revoked that certificate. You want to use an SSL policy to block traffic encrypted with certificates issued by the untrusted CA, but otherwise allow traffic within the trusted CA's chain of trust. After you upload the CA certificates and all intermediate CA certificates, configure an SSL policy with rules in the following order:

SSL Rule 1: Block issuer CN=www.badca.com
SSL Rule 2: Do not decrypt issuer CN=www.goodca.com

If you reverse the rules, you first match all traffic trusted by Good CA, including traffic trusted by Bad CA. Because no traffic ever matches the subsequent Bad CA rule, malicious traffic may be allowed instead of blocked.

Rule Actions and Rule Order

A rule's action determines how the system handles matching traffic. Improve performance by placing rules that do not perform or ensure further traffic handling before the resource-intensive rules that do. Then, the system can divert traffic that it might otherwise have inspected.

The following examples show how you might order rules in various policies, given a set of rules where none is more critical and preemption is not an issue.

If your rules include application conditions, also see Recommendations for Application Control, on page 641.
Optimum Order: SSL Rules

Not only does decryption require resources, but so does further analysis of the decrypted traffic. Place SSL rules that decrypt traffic last.

1. Monitor—Rules that log matching connections, but take no other action on traffic.
2. Block, Block with reset—Rules that block traffic without further inspection.
3. Do not decrypt—Rules that do not decrypt encrypted traffic, passing the encrypted session to access control rules. The payloads of these sessions are not subject to deep inspection.
4. Decrypt - Known Key—Rules that decrypt incoming traffic with a known private key.
5. Decrypt - Resign—Rules that decrypt outgoing traffic by re-signing the server certificate.

Optimum Order: Access Control Rules

Intrusion, file, and malware inspection requires resources, especially if you use multiple custom intrusion policies and variable sets. Place access control rules that invoke deep inspection last.

1. Monitor—Rules that log matching connections, but take no other action on traffic.
2. Trust, Block, Block with reset—Rules that handle traffic without further inspection. Note that trusted traffic is subject to authentication requirements imposed by an identity policy.
3. Allow, Interactive Block (no deep inspection)—Rules that do not inspect traffic further, but allow discovery. Note that allowed traffic is subject to authentication requirements imposed by an identity policy.
4. Allow, Interactive Block (deep inspection)—Rules associated with file or intrusion policies that perform deep inspection for prohibited files, malware, and exploits.

Content Restriction Rule Order

To avoid rule preemption in both SSL and access control policies, position rules governing YouTube restriction above rules governing Safe Search restriction.

When you enable Safe Search for an access control rule, the system adds the search engine category to the Selected Applications and Filters list. This application category includes YouTube. As a result, YouTube traffic matches to the Safe Search rule unless YouTube EDU is enabled in a rule with a higher evaluation priority.

A similar rule preemption occurs if you position an SSL rule with the safesearch supported filter higher in the evaluation order than an SSL rule with specific YouTube application conditions.

Application Rule Order

Rules with application conditions are more likely to match traffic if you move them to a lower order in your list of rules.

Access control rules that use specific conditions (such as networks and IP addresses) should be ordered before rules that use general conditions (such as applications). If you’re familiar with the Open Systems Interconnect (OSI) model, use similar numbering in concept. Rules with conditions for layers 1, 2, and 3 (physical, data link, and network) should be ordered first in your access control rules. Conditions for layers 5, 6, and 7 (session, presentation, and application) should be ordered later in your access control rules. For more information about the OSI model, see this Wikipedia article.
SSL Rule Order

In general, order your rules with specific conditions (such as IP addresses and networks) before rules with general conditions (such as applications).

Allow Traffic from Certificate Pinned Sites

Some applications use a technique referred to as TLS/SSL pinning or certificate pinning, which embeds the fingerprint of the original server certificate in the application itself. As a result, if you configured a TLS/SSL rule with a Decrypt - Resign action, when the application receives a resigned certificate from a managed device, validation fails and the connection is aborted.

To confirm that TLS/SSL pinning is occurring, attempt to log in to a mobile application like Facebook. If a network connection error is displayed, log in using a web browser. (For example, you cannot log in to a Facebook mobile application but can log in to Facebook using Safari or Chrome.) You can use Firepower Management Center connection events as further proof of TLS/SSL pinning.

Note

TLS/SSL pinning is not limited to mobile applications.

To allow this traffic, configure an SSL rule with the Do Not Decrypt action to match the server certificate common name or distinguished name. In the SSL policy, order this rule before all Decrypt - Resign rules that also match the traffic. You can retrieve the pinned certificate from the client's browser after a successful connection to the website. You can also view the certificate from the logged connection event, regardless of whether the connection succeeded or failed.

Situation Where SSL Policy is Bypassed

The SSL policy is bypassed for any connections that match access control rules with actions of Trust, Block, or Block with reset if those rules:

- Use security zone, network, geolocation, and port only as the traffic matching criteria.
- Precede other rules that require inspection, such as rules that match connections based on application or URL, or allow rules that apply intrusion or file inspection.

URL Rule Order

For the most effective URL matching, place rules that include URL conditions before other rules, particularly if the URL rules are block rules and the other rules meet both of the following criteria:

- They include application conditions.
- The traffic to be inspected is encrypted.

Guidelines for Avoiding Intrusion Policy Proliferation

In an access control policy, you can associate one intrusion policy with each Allow and Interactive Block rule, as well as with the default action. Every unique pair of intrusion policy and variable set counts as one policy.
However, there is a maximum number of access control rules or intrusion policies that are supported by a target device. The maximum depends on a number of factors, including policy complexity, physical memory, and the number of processors on the device.

If you exceed the maximum supported by your device, you cannot deploy your access control policy and must reevaluate. You may want to consolidate intrusion policies or variable sets so you can associate a single intrusion policy-variable set pair with multiple access control rules. On some devices you may find you can use only a single variable set for all your intrusion policies, or even a single intrusion policy-variable set pair for the whole device.
CHAPTER 18

Reusable Objects

The following topics describe how to manage reusable objects in the Firepower System:

- Introduction to Reusable Objects, on page 317
- The Object Manager, on page 319
- Network Objects, on page 326
- Port Objects, on page 327
- Application Filters, on page 328
- VLAN Tag Objects, on page 328
- URL Objects, on page 329
- Geolocation Objects, on page 331
- Security Zones, on page 331
- Variable Sets, on page 333
- Security Intelligence Lists and Feeds, on page 349
- Sinkhole Objects, on page 357
- File Lists, on page 358
- Cipher Suite Lists, on page 363
- Distinguished Name Objects, on page 364
- PKI Objects, on page 366

Introduction to Reusable Objects

For increased flexibility and web interface ease-of-use, the Firepower System uses named objects, which are reusable configurations that associate a name with a value. When you want to use that value, use the named object instead. The system supports object use in various places in the web interface, including many policies and rules, event searches, reports, dashboards, and so on. The system provides many predefined objects that represent frequently used configurations.

Use the object manager to create and manage objects. Many configurations that use objects also allow you to create objects on the fly, as needed. You can also use the object manager to:

- Group objects to reference multiple objects with a single configuration; see Object Groups, on page 321.
- Override object values for selected devices or, in a multidomain deployment, selected domains; see Object Overrides, on page 323.
After you edit an object used in an active policy, you must redeploy the changed configuration for your changes to take effect. You cannot delete an object that is in use by an active policy.

**Note**

An object is configured on a managed device if, and only if, the object is used in a policy that is assigned to that device. If you remove an object from all policies assigned to a given device, the object is also removed from the device configuration on the next deployment, and subsequent changes to the object are not reflected in the device configuration.

**Object Types**

The following table lists the objects you can create in the Firepower System, and indicates whether each object type can be grouped or configured to allow overrides.

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Groupable?</th>
<th>Allows Overrides?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Port</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Security Zone</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Application Filter</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>VLAN Tag</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>URL</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Geolocation</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Variable Set</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Security Intelligence: Network, DNS, and URL lists and feeds</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Sinkhole</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>File List</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Cipher Suite List</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Distinguished Name</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Public Key Infrastructure (PKI):</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>• Internal and Trusted CA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Internal and External Certs</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Objects and Multitenancy

In a multidomain deployment, you can create objects in Global and descendant domains. The system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which you cannot edit, with the exception of security zones.

Because security zones are tied to device interfaces, which you configure at the leaf level, administrators in descendant domains can view and edit security zones created in ancestor domains. Subdomain users can add and delete interfaces from ancestor zones, but cannot delete or rename the zones.

Object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

For objects that support grouping, you can group objects in the current domain with objects inherited from ancestor domains.

Object overrides allow you to define device-specific or domain-specific values for certain types of object, including network, port, VLAN tag, and URL. In a multidomain deployment, you can define a default value for an object in an ancestor domain, but allow administrators in descendant domains to add override values for that object.

The Object Manager

You can use the object manager to create and manage objects and object groups.

The object manager displays 20 objects or groups per page. If you have more than 20 of any type of object or group, use the navigation links at the bottom of the page to view additional pages. You can also go to a specific page or click the refresh icon (↻) to refresh your view.

By default, the page lists objects and groups alphabetically by name. However, you can sort each type of object or group by any column in the display. You can also filter the objects on the page by name or value.

Editing Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

Procedure

Step 1: Choose Objects > Object Management.

Step 2: Choose an object type from the list; see Introduction to Reusable Objects, on page 317.
Step 3  Click the edit icon (✏️) next to the object you want to edit.

If a view icon (👀) appears instead, the object belongs to an ancestor domain and has been configured not to allow overrides, or you do not have permission to modify the object.

Step 4  Modify the object settings as desired.

Step 5  If you are editing a variable set, manage the variables in the set; see Managing Variables, on page 345.

Step 6  For objects that can be configured to allow overrides:
- If you want to allow overrides for this object, check the Allow Overrides check box; see Allowing Object Overrides, on page 324. You can change this setting only for objects that belong to the current domain.
- If you want to add override values to this object, expand the Override section and click Add; see Adding Object Overrides, on page 325.

Step 7  Click Save.

Step 8  If you are editing a variable set, and that set is in use by an access control policy, click Yes to confirm that you want to save your changes.

What to do next
- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

Filtering Objects or Object Groups

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current and ancestor domains, which you can filter.

Procedure

Step 1  Choose Objects > Object Management.

Step 2  Enter your filter criteria in the Filter field.

The page updates as you type to display matching items.

You can use the following metacharacters:
- The asterisk (*) matches zero or more occurrences of a character.
- The caret (^) matches content at the beginning of a string.
• The dollar sign (\$) matches content at the end of a string.

## Sorting Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

### Procedure

**Step 1** Choose **Objects > Object Management**.

**Step 2** Click a column heading. To sort in the opposite direction, click the heading again.

## Object Groups

Grouping objects allows you to reference multiple objects with a single configuration. The system allows you to use objects and object groups interchangeably in the web interface. For example, anywhere you would use a port object, you can also use a port object group.

You can group network, port, VLAN tag, URL, and PKI objects.

Objects and object groups of the same type cannot have the same name. In a multidomain deployment, the names of object groups must be unique within the domain hierarchy. Note that the system may identify a conflict with the name of an object group you cannot view in your current domain.

When you edit an object group used in a policy (for example, a network object group used in an access control policy), you must re-deploy the changed configuration for your changes to take effect.

Deleting a group does not delete the objects in the group, just their association with each other. Additionally, you cannot delete a group that is in use in an active policy. For example, you cannot delete a VLAN tag group that you are using in a VLAN condition in a saved access control policy.

### Grouping Reusable Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>
In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

You can group objects in the current domain with objects inherited from ancestor domains.

**Procedure**

**Step 1** Choose **Objects > Object Management**.

**Step 2** If the object type you want to group is **Network**, **Port**, **URL**, or **VLAN Tag**:
   a) Choose the object type from the list of object types.
   b) Choose **Add Group** from the **Add [Object Type]** drop-down list.

**Step 3** If the object type you want to group is **Distinguished Name**:
   a) Expand the **Distinguished Name** node.
   b) Choose **Object Groups**.
   c) Click **Add Distinguished Name Group**.

**Step 4** If the object type you want to group is **PKI**:
   a) Expand the **PKI** node.
   b) Choose one of the following:
      - **Internal CA Groups**
      - **Trusted CA Groups**
      - **Internal Cert Groups**
      - **External Cert Groups**
   c) Click the **Add [Object Type] Group** button.

**Step 5** Enter a unique **Name**.

**Step 6** Choose one or more objects from the list, and click **Add**.

You can also:

   - Use the filter field to search for existing objects to include, which updates as you type to display matching items. Click the reload icon above the search field or click the clear icon in the search field to clear the search string.
   - Click the add icon to create objects on the fly if no existing objects meet your needs.

**Step 7** Optionally for **Network**, **Port**, **URL**, and **VLAN Tag** groups:
   - Enter a **Description**.
   - Check the **Allow Overrides** check box to allow overrides for this object group; see **Allowing Object Overrides**, on page 324.

**Step 8** Click **Save**.
What to do next

• If an active policy references your object group, deploy configuration changes; see Deploy Configuration Changes, on page 277.

Object Overrides

An object override allows you to define an alternate value for an object, which the system uses for the devices you specify.

You can create an object whose definition works for most devices, and then use overrides to specify modifications to the object for the few devices that need different definitions. You can also create an object that needs to be overridden for all devices, but its use allows you to create a single policy for all devices. Object overrides allow you to create a smaller set of shared policies for use across devices without giving up the ability to alter policies when needed for individual devices.

For example, you might want to deny ICMP traffic to the different departments in your company, each of which is connected to a different network. You can do this by defining an access control policy with a rule that includes a network object called Departmental Network. By allowing overrides for this object, you can then create overrides on each relevant device that specifies the actual network where that device is connected.

In a multidomain deployment, you can define a default value for an object in an ancestor domain and allow administrators in descendant domains to add override values for that object. For example, a managed security service provider (MSSP) might use a single Firepower Management Center to manage network security for multiple customers. Administrators at the MSSP can define an object in the Global domain for use in all customers’ deployments. Administrators for each customer can log into descendant domains to override that object for their organizations. These local administrators cannot view or affect the override values of other customers of the MSSP.

You can target an object override to a specific domain. In this case, the system uses the object override value for all devices in the targeted domain unless you override it at the device level.

From the object manager, you can choose an object that can be overridden and define a list of device-level or domain-level overrides for that object.

You can use object overrides with the following object types only:

• Network
• Port
• VLAN tag
• URL

If you can override an object, the Override column appears for the object type in the object manager. Possible values for this column include:

• Green checkmark — indicates that you can create overrides for the object and no overrides have been added yet
• Red X — indicates that you cannot create overrides for the object
• Number — represents a count of the overrides that have been added to that object (for example, "2" indicates two overrides have been added)
Managing Object Overrides

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose Objects > Object Management.

**Step 2** Choose from the list of object types; see Introduction to Reusable Objects, on page 317.

**Step 3** Click the edit icon ( ) next to the object you want to edit.

If a view icon ( ) appears instead, the object belongs to an ancestor domain and has been configured not to allow overrides, or you do not have permission to modify the object.

**Step 4** Manage the object overrides:

- Add—Add object overrides; see Adding Object Overrides, on page 325.
- Allow—Allow object overrides; see Allowing Object Overrides, on page 324.
- Delete—In the object editor, click the delete icon ( ) next to the override you want to remove.
- Edit—Edit object overrides; see Editing Object Overrides, on page 325.

Allowing Object Overrides

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** In the object editor, check the Allow Overrides check box.

**Step 2** Click Save.

**What to do next**

Add object override values; see Adding Object Overrides, on page 325.
Adding Object Overrides

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Before you begin**

Allow object overrides; see Allowing Object Overrides, on page 324.

**Procedure**

**Step 1**
In the object editor, expand the **Override** section.

**Step 2**
Click **Add**.

**Step 3**
On the **Targets** tab, choose domains or devices in the **Available Devices and Domains** list and click **Add**.

**Step 4**
On the **Override** tab, enter a **Name**.

**Step 5**
Optionally, enter a **Description**.

**Step 6**
Enter an override value.

**Example:**
For a network object, enter a network value.

**Step 7**
Click **Add**.

**Step 8**
Click **Save**.

**What to do next**

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

Editing Object Overrides

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can modify the description and the value of an existing override, but you cannot modify the existing target list. Instead, you must add a new override with new targets, which replaces the existing override.

**Procedure**

**Step 1**
In the object editor, expand the **Override** section.
Step 2  Click the edit icon (✏️) next to the override you want to modify.

Step 3  Optionally, modify the Description.

Step 4  Modify the override value.

Step 5  Click Save to save the override.

Step 6  Click Save to save the object.

What to do next
- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

Network Objects

A network object represents one or more IP addresses that you can specify either individually or as address blocks. You can use network objects and groups in various places in the system’s web interface, including access control policies, network variables, identity rules, network discovery rules, event searches, reports, and so on.

Creating Network Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  Choose Objects > Object Management.

Step 2  Choose Network from the list of object types.

Step 3  Choose Add Object from the Add Network drop-down menu.

Step 4  Enter a Name.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

Step 5  Optionally, enter a Description.

Step 6  In the Network field, enter an IP address or address block to add to the object.

Step 7  Manage overrides for the object:
- If you want to allow overrides for this object, check the Allow Overrides check box; see Allowing Object Overrides, on page 324.
- If you want to add override values to this object, expand the Override section and click Add; see Adding Object Overrides, on page 325.
Step 8  Click Save.

What to do next
- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

Port Objects

Port objects represent different protocols in slightly different ways:

TCP and UDP
A port object represents the transport layer protocol, with the protocol number in parentheses, plus an optional associated port or port range. For example: TCP(6)/22.

ICMP and ICMPv6 (IPv6-ICMP)
A port object represents the Internet layer protocol plus an optional type and code. For example: ICMP(1):3:3.

You can restrict an ICMP or IPv6-ICMP port object by type and, if applicable, code. For more information on ICMP types and codes, see:
- http://www.iana.org/assignments/icmp-parameters/icmp-parameters.xml
- http://www.iana.org/assignments/icmpv6-parameters/icmpv6-parameters.xml

Other
A port object can represent other protocols that do not use ports.

The Firepower System provides default port objects for well-known ports. You cannot modify or delete these default objects. You can create custom port objects in addition to the default objects.

You can use port objects and groups in various places in the system’s web interface, including access control policies, identity rules, network discovery rules, port variables, and event searches. For example, if your organization uses a custom client that uses a specific range of ports and causes the system to generate excessive and misleading events, you can configure your network discovery policy to exclude monitoring those ports.

When using port objects, observe the following guidelines:
- You cannot add any protocol other than TCP or UDP for source port conditions in access control rules. Also, you cannot mix transport protocols when setting both source and destination port conditions in a rule.
- If you add an unsupported protocol to a port object group used in a source port condition, the rule where it is used does not take affect on the managed device when the configuration is deployed.
- If you create a port object containing both TCP and UDP ports, then add it as a source port condition in a rule, you cannot add a destination port, and vice versa.
Creating Port Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Access</td>
</tr>
</tbody>
</table>

Procedure

Step 1  Choose Objects > Object Management.

Step 2  Choose Port from the list of object types.

Step 3  Choose Add Object from the Add Port drop-down list.

Step 4  Enter a Name.

Step 5  Choose a Protocol.

Step 6  Depending on the protocol you chose, constrain by Port, or choose an ICMP Type and Code.

You can enter ports from 1 to 65535. Use a hyphen to specify a port range. You must constrain the object by port if you chose to match All protocols, using the Other drop-down list.

Step 7  Manage overrides for the object:

  • If you want to allow overrides for this object, check the Allow Overrides check box; see Allowing Object Overrides, on page 324.
  • If you want to add override values to this object, expand the Override section and click Add; see Adding Object Overrides, on page 325.

Step 8  Click Save.

What to do next

  • If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

Application Filters

System-provided application filters help you perform application control by organizing applications according to basic characteristics: type, risk, business relevance, category, and tags. In the object manager, you can create and manage reusable user-defined application filters based on combinations of the system-provided filters, or on custom combinations of applications. For detailed information, see Application Conditions (Application Control), on page 298.

VLAN Tag Objects

Each VLAN tag object you configure represents a VLAN tag or range of tags.
You can group VLAN tag objects. Groups represent multiple objects; using a range of VLAN tags in a single object is not considered a group in this sense.

You can use VLAN tag objects and groups in various places in the system’s web interface, including rules and event searches. For example, you could write an access control rule that applies only to a specific VLAN.

Creating VLAN Tag Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Access Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Network Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Choose **Objects > Object Management**.

**Step 2** Choose **VLAN Tag** from the list of object types.

**Step 3** Choose **Add Object** from the **Add VLAN Tag** drop-down list.

**Step 4** Enter a **Name**.

**Step 5** Enter a **Description**.

**Step 6** Enter a value in the **VLAN Tag** field. Use a hyphen to specify a range of VLAN tags.

**Step 7** Manage overrides for the object:

- If you want to allow overrides for this object, check the **Allow Overrides** check box; see **Allowing Object Overrides**, on page 324.
- If you want to add override values to this object, expand the **Override** section and click **Add**; see **Adding Object Overrides**, on page 325.

**Step 8** Click **Save**.

What to do next

- If an active policy references your object, deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

URL Objects

Each URL object you configure represents a single URL or IP address. You can use URL objects and groups in various places in the system’s web interface, including access control policies and event searches. For example, you could write an access control rule that blocks a specific website.

When creating URL objects, especially if you do not configure SSL inspection to decrypt or block encrypted traffic, keep the following points in mind:
• If you plan to use a URL object to match HTTPS traffic in an access control rule, create the object using the subject common name in the public key certificate used to encrypt the traffic. Also, the system disregards subdomains within the subject common name, so do not include subdomain information. For example, use example.com rather than www.example.com.

• When matching web traffic using access control rules with URL conditions, the system disregards the encryption protocol (HTTP vs HTTPS). In other words, if you block a website, both HTTP and HTTPS traffic to that website is blocked, unless you use an application condition to refine the rule. When creating a URL object, you do not need to specify the protocol when creating an object. For example, use example.com rather than http://example.com/.

Creating URL Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Choose Objects > Object Management.
Step 2 Choose URL from the list of object types.
Step 3 Choose Add Object from the Add URL drop-down list.
Step 4 Enter a Name.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

Step 5 Optionally, enter a Description.
Step 6 Enter the URL or IP address.
Step 7 Manage overrides for the object:
  • If you want to allow overrides for this object, check the Allow Overrides check box; see Allowing Object Overrides, on page 324.
  • If you want to add override values to this object, expand the Override section and click Add; see Adding Object Overrides, on page 325.

Step 8 Click Save.

What to do next

• If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.
Geolocation Objects

Each geolocation object you configure represents one or more countries or continents that the system has identified as the source or destination of traffic on your monitored network. You can use geolocation objects in various places in the system’s web interface, including access control policies, SSL policies, and event searches. For example, you could write an access control rule that blocks traffic to or from certain countries.

To ensure that you are using up-to-date information to filter your network traffic, Cisco strongly recommends that you regularly update your Geolocation Database (GeoDB).

Creating Geolocation Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Choose **Objects > Object Management**.

Step 2 Choose **Geolocation** from the list of object types.

Step 3 Click **Add Geolocation**.

Step 4 Enter a **Name**.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

Step 5 Check the check boxes for the countries and continents you want to include in your geolocation object. Checking a continent chooses all countries within that continent, as well as any countries that GeoDB updates may add under that continent in the future. Unchecking any country under a continent unchecks the continent. You can choose any combination of countries and continents.

Step 6 Click **Save**.

What to do next

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

Security Zones

Security zones segment your network to help you manage and classify traffic flow. A security zone simply groups interfaces. These groups may span multiple devices; you can also configure multiple zones on a single device.
All interfaces in a security zone must be of the same type: all inline, passive, switched, routed, or ASA FirePOWER. After you create a security zone, you cannot change the type of interfaces it contains. An interface can belong to only one zone.

The Security Zones page of the object manager lists the zones configured on your managed devices. The page also displays the type of interfaces in each zone, and you can expand each zone to view which interfaces on which devices belong to each zone.

---

**Note**

Create inline sets before you add security zones for the interfaces in the inline set; otherwise security zones are removed and you must add them again.

---

**Model-Specific Notes and Warnings**

During initial configuration of a 7000 or 8000 Series device, the system creates security zones based on the detection mode you selected for the device. For example, the system creates a Passive zone in passive deployments, while in inline deployments the system creates External and Internal zones. When you register the device to the Firepower Management Center, those security zones are added to the FMC.

If you modify ASA FirePOWER security contexts, switching from single context mode to multi-context mode or vice versa, the system removes all the device's interfaces from their assigned security zones.

---

**Zones and Multitenancy**

In a multidomain deployment, you can create security zones at any level. A zone created in an ancestor domain can contain interfaces that reside on devices in different domains. In this situation, subdomain users viewing the ancestor zone configuration in the object manager can see only the interfaces in their domain.

Unless restricted by role, subdomain users can view and edit zones created in ancestor domains. Subdomain users can add and delete interfaces from these zones. They cannot, however, delete or rename the zones. You can neither view nor edit zones created in descendant domains.

---

**Creating Security Zone Objects**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

---

**Tip**

You can create empty security zones and add interfaces to them later. To add an interface, the interface must have a name. You can also create security zones while configuring interfaces in Devices > Device Management.

---

**Before you begin**

- Understand the usage requirements and restrictions for each type of security zone. See Security Zones, on page 331.
Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Choose `Objects > Object Management`.
| Step 2 | Choose `Security Zones` from the list of object types.
| Step 3 | Click `Add Security Zone`.
| Step 4 | Enter a `Name`.
| Step 5 | Choose an `Interface Type`.
| Step 6 | From the `Device > Interfaces` drop-down list, choose a device that contains interfaces you want to add.
| Step 7 | Choose one or more interfaces.
| Step 8 | Click `Add` to add the interfaces you chose, grouped by device.
| Step 9 | Click `Save`.

What to do next

- If an active policy references your object, deploy configuration changes; see [Deploy Configuration Changes](#) on page 277.

### Variable Sets

Variables represent values commonly used in intrusion rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies to represent IP addresses in rule suppressions, adaptive profiles, and dynamic rule states.

**Tip**

Preprocessor rules can trigger events regardless of the hosts defined by network variables used in intrusion rules.

You use variable sets to manage, customize, and group your variables. You can use the default variable set provided by the system or create your own custom sets. Within any set you can modify predefined default variables and add and modify user-defined variables.

Most of the shared object rules and standard text rules that the Firepower System provides use predefined default variables to define networks and port numbers. For example, the majority of the rules use the variable $HOME_NET to specify the protected network and the variable $EXTERNAL_NET to specify the unprotected (or outside) network. In addition, specialized rules often use other predefined variables. For example, rules that detect exploits against web servers use the $HTTP_SERVERS and $HTTP_PORTS variables.

Rules are more effective when variables more accurately reflect your network environment. At a minimum, you should modify default variables in the default set. By ensuring that a variable such as $HOME_NET correctly defines your network and $HTTP_SERVERS includes all web servers on your network, processing is optimized and all relevant systems are monitored for suspicious activity.

To use your variables, you link variable sets to intrusion policies associated with access control rules or with the default action of an access control policy. By default, the default variable set is linked to all intrusion policies used by access control policies.
Adding a variable to any set adds it to all sets; that is, each variable set is a collection of all variables currently configured on your system. Within any variable set, you can add user-defined variables and customize the value of any variable.

Initially, the Firepower System provides a single, default variable set comprised of predefined default values. Each variable in the default set is initially set to its default value, which for a predefined variable is the value set by the Cisco Talos Security Intelligence and Research Group (Talos) and provided in rule updates.

Although you can leave predefined default variables configured to their default values, Cisco recommends that you modify a subset of predefined variables.

You could work with variables only in the default set, but in many cases you can benefit most by adding one or more custom sets, configuring different variable values in different sets, and perhaps even adding new variables.

When using multiple sets, it is important to remember that the current value of any variable in the default set determines the default value of the variable in all other sets.

When you select Variable Sets on the Object Manager page, the object manager lists the default variable set and any custom sets you created.

On a freshly installed system, the default variable set is comprised only of the default variables predefined by Cisco.

Each variable set includes the default variables provided by the system and all custom variables you have added from any variable set. Note that you can edit the default set, but you cannot rename or delete the default set.

In a multidomain deployment, the system generates a default variable set for each subdomain.

---

**Caution**

Importing an access control or an intrusion policy overwrites existing default variables in the default variable set with the imported default variables. If your existing default variable set contains a custom variable not present in the imported default variable set, the unique variable is preserved.

---

**Related Topics**

Managing Variables, on page 345
Managing Variable Sets, on page 344

---

**Variable Sets in Intrusion Policies**

By default, the Firepower System links the default variable set to all intrusion policies used in an access control policy. When you deploy an access control policy that uses an intrusion policy, intrusion rules that you have enabled in the intrusion policy use the variable values in the linked variable set.

When you modify a custom variable set used by an intrusion policy in an access control policy, the system reflects the status for that policy as out-of-date on the Access Control Policy page. You must re-deploy the access control policy to implement changes in your variable set. When you modify the default set, the system reflects the status of all access control policies that use intrusion policies as out-of-date, and you must re-deploy all access control policies to implement your changes.

---

**Variables**

Variables belong to one of the following categories:
Default Variables

Variables provided by the Firepower System. You cannot rename or delete a default variable, and you cannot change its default value. However, you can create a customized version of a default variable.

Customized Variables

Variables you create. These variables can include:

• customized default variables

  When you edit the value for a default variable, the system moves the variable from the Default Variables area to the Customized Variables area. Because variable values in the default set determine the default values of variables in custom sets, customizing a default variable in the default set modifies the default value of the variable in all other sets.

• user-defined variables

  You can add and delete your own variables, customize their values within different variable sets, and reset customized variables to their default values. When you reset a user-defined variable, it remains in the Customized Variables area.

  User-defined variables can be one of the following types:

  • network variables specify the IP addresses of hosts in your network traffic.
  • port variables specify TCP or UDP ports in network traffic, including the value any for either type.

  For example, if you create custom standard text rules, you might also want to add your own user-defined variables to more accurately reflect your traffic or as shortcuts to simplify the rule creation process. Alternatively, if you create a rule that you want to inspect traffic in the “demilitarized zone” (or DMZ) only, you can create a variable named $DMZ whose value lists the server IP addresses that are exposed. You can then use the $DMZ variable in any rule written for this zone.

Advanced Variables

Variables provided by the Firepower System under specific conditions. These variables have a very limited deployment.

Predefined Default Variables

By default, the Firepower System provides a single default variable set, which is comprised of predefined default variables. The Cisco Talos Security Intelligence and Research Group (Talos) uses rule updates to provide new and updated intrusion rules and other intrusion policy elements, including default variables.

Because many intrusion rules provided by the system use predefined default variables, you should set appropriate values for these variables. Depending on how you use variable sets to identify traffic on your network, you can modify the values for these default variables in any or all variable sets.

Caution

Importing an access control or an intrusion policy overwrites existing default variables in the default variable set with the imported default variables. If your existing default variable set contains a custom variable not present in the imported default variable set, the unique variable is preserved.
The following table describes the variables provided by the system and indicates which variables you typically would modify. For assistance determining how to tailor variables to your network, contact Professional Services or Support.

Table 52: System-Provided Variables

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Description</th>
<th>Modify?</th>
</tr>
</thead>
<tbody>
<tr>
<td>$AIM_SERVERS</td>
<td>Defines known AOL Instant Messenger (AIM) servers, and is used in chat-based rules and rules that look for AIM exploits.</td>
<td>Not required.</td>
</tr>
<tr>
<td>$DNS_SERVERS</td>
<td>Defines Domain Name Service (DNS) servers. If you create a rule that affects DNS servers specifically, you can use the $DNS_SERVERS variable as a destination or source IP address.</td>
<td>Not required in current rule set.</td>
</tr>
<tr>
<td>$EXTERNAL_NET</td>
<td>Defines the network that the Firepower System views as the unprotected network, and is used in many rules to define the external network.</td>
<td>Yes, you should adequately define $HOME_NET and then exclude $HOME_NET as the value for $EXTERNAL_NET.</td>
</tr>
<tr>
<td>$FILE_DATA_PORTS</td>
<td>Defines non-encrypted ports used in intrusion rules that detect files in a network stream.</td>
<td>Not required.</td>
</tr>
<tr>
<td>$FTP_PORTS</td>
<td>Defines the ports of FTP servers on your network, and is used for FTP server exploit rules.</td>
<td>Yes, if your FTP servers use ports other than the default ports (you can view the default ports in the web interface).</td>
</tr>
<tr>
<td>$GTP_PORTS</td>
<td>Defines the data channel ports where the packet decoder extracts the payload inside a GTP (General Packet Radio Service [GPRS] Tunneling Protocol) PDU.</td>
<td>Not required.</td>
</tr>
<tr>
<td>$HOME_NET</td>
<td>Defines the network that the associated intrusion policy monitors, and is used in many rules to define the internal network.</td>
<td>Yes, to include the IP addresses for your internal network.</td>
</tr>
<tr>
<td>$HTTP_PORTS</td>
<td>Defines the ports of web servers on your network, and is used for web server exploit rules.</td>
<td>Yes, if your web servers use ports other than the default ports (you can view the default ports in the web interface).</td>
</tr>
<tr>
<td>$HTTP_SERVERS</td>
<td>Defines the web servers on your network. Used in web server exploit rules.</td>
<td>Yes, if you run HTTP servers.</td>
</tr>
<tr>
<td>$ORACLE_PORTS</td>
<td>Defines Oracle database server ports on your network, and is used in rules that scan for attacks on Oracle databases.</td>
<td>Yes, if you run Oracle servers.</td>
</tr>
<tr>
<td>$SHELLCODE_PORTS</td>
<td>Defines the ports you want the system to scan for shell code exploits, and is used in rules that detect exploits that use shell code.</td>
<td>Not required.</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Description</td>
<td>Modify?</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>$SIP_PORTS</td>
<td>Defines the ports of SIP servers on your network, and is used for SIP exploit rules.</td>
<td>Not required.</td>
</tr>
<tr>
<td>$SIP_SERVERS</td>
<td>Defines SIP servers on your network, and is used in rules that address SIP-targeted exploits.</td>
<td>Yes, if you run SIP servers, you should adequately define $HOME_NET and then include $HOME_NET as the value for $SIP_SERVERS.</td>
</tr>
<tr>
<td>$SMTP_SERVERS</td>
<td>Defines SMTP servers on your network, and is used in rules that address exploits that target mail servers.</td>
<td>Yes, if you run SMTP servers.</td>
</tr>
<tr>
<td>$SNMP_SERVERS</td>
<td>Defines SNMP servers on your network, and is used in rules that scan for attacks on SNMP servers.</td>
<td>Yes, if you run SNMP servers.</td>
</tr>
<tr>
<td>$SNORT_BPF</td>
<td>Identifies a legacy advanced variable that appears only when it existed on your system in a Firepower System software release before Version 5.3.0 that you subsequently upgraded to Version 5.3.0 or greater.</td>
<td>No, you can only view or delete this variable. You cannot edit it or recover it after deleting it.</td>
</tr>
<tr>
<td>$SQL_SERVERS</td>
<td>Defines database servers on your network, and is used in rules that address database-targeted exploits.</td>
<td>Yes, if you run SQL servers.</td>
</tr>
<tr>
<td>$SSH_PORTS</td>
<td>Defines the ports of SSH servers on your network, and is used for SSH server exploit rules.</td>
<td>Yes, if you run SSH servers, you should adequately define $HOME_NET and then include $HOME_NET as the value for $SSH_SERVERS.</td>
</tr>
<tr>
<td>$SSH_SERVERS</td>
<td>Defines SSH servers on your network, and is used in rules that address SSH-targeted exploits.</td>
<td>Yes, if you run SSH servers, you should adequately define $HOME_NET and then include $HOME_NET as the value for $SSH_SERVERS.</td>
</tr>
<tr>
<td>$TELNET_SERVERS</td>
<td>Defines known Telnet servers on your network, and is used in rules that address Telnet server-targeted exploits.</td>
<td>Yes, if you run Telnet servers.</td>
</tr>
<tr>
<td>$USER_CONF</td>
<td>Provides a general tool that allows you to configure one or more features not otherwise available via the web interface.</td>
<td>No, only as instructed in a feature description or with the guidance of Support.</td>
</tr>
</tbody>
</table>

**Network Variables**

Network variables represent IP addresses you can use in intrusion rules that you enable in an intrusion policy and in intrusion policy rule suppressions, dynamic rule states, and adaptive profiles. Network variables differ from network objects and network object groups in that network variables are specific to intrusion policies.
and intrusion rules, whereas you can use network objects and groups to represent IP addresses in various places in the system’s web interface, including access control policies, network variables, intrusion rules, network discovery rules, event searches, reports, and so on.

You can use network variables in the following configurations to specify the IP addresses of hosts on your network:

• intrusion rules—Intrusion rule Source IPs and Destination IPs header fields allow you to restrict packet inspection to the packets originating from or destined to specific IP addresses.

• suppressions—The Network field in source or destination intrusion rule suppressions allows you to suppress intrusion event notifications when a specific IP address or range of IP addresses triggers an intrusion rule or preprocessor.

• dynamic rule states—The Network field in source or destination dynamic rule states allows you to detect when too many matches for an intrusion rule or preprocessor rule occur in a given time period.

• adaptive profiles—The adaptive profiles Networks field identifies hosts where you want to improve reassembly of packet fragments and TCP streams in passive deployments.

When you use variables in the fields identified in this section, the variable set you link to an intrusion policy determines the variable values in the network traffic handled by an access control policy that uses the intrusion policy.

You can add any combination of the following network configurations to a variable:

• any combination of network variables, network objects, and network object groups that you select from the list of available networks

• individual network objects that you add from the New Variable or Edit Variable page, and can then add to your variable and to other existing and future variables

• literal, single IP addresses or address blocks

You can list multiple literal IP addresses and address blocks by adding each individually. You can list IPv4 and IPv6 addresses and address blocks alone or in any combination. When specifying IPv6 addresses, you can use any addressing convention defined in RFC 4291.

The default value for included networks in any variable you add is the word any, which indicates any IPv4 or IPv6 address. The default value for excluded networks is none, which indicates no network. You can also specify the address :: in a literal value to indicate any IPv6 address in the list of included networks, or no IPv6 addresses in the list of exclusions.

Adding networks to the excluded list negates the specified addresses and address blocks. That is, you can match any IP address with the exception of the excluded IP address or address blocks.

For example, excluding the literal address 192.168.1.1 specifies any IP address other than 192.168.1.1, and excluding 2001:db8:ca2e::fa4c specifies any IP address other than 2001:db8:ca2e::fa4c.

You can exclude any combination of networks using literal or available networks. For example, excluding the literal values 192.168.1.1 and 192.168.1.5 includes any IP address other than 192.168.1.1 or 192.168.1.5. That is, the system interprets this as “not 192.168.1.1 and not 192.168.1.5,” which matches any IP address other than those listed between brackets.

Note the following points when adding or editing network variables:

• You cannot logically exclude the value any which, if excluded, would indicate no address. For example, you cannot add a variable with the value any to the list of excluded networks.
• Network variables identify traffic for the specified intrusion rule and intrusion policy features. Note that preprocessors rules can trigger events regardless of the hosts defined by network variables used in intrusion rules.

• Excluded values must resolve to a subset of included values. For example, you cannot include the address block 192.168.5.0/24 and exclude 192.168.6.0/24.

**Port Variables**

Port variables represent TCP and UDP ports you can use in the **Source Port** and **Destination Port** header fields in intrusion rules that you enable in an intrusion policy. Port variables differ from port objects and port object groups in that port variables are specific to intrusion rules. You can create port objects for protocols other than TCP and UDP, and you can use port objects in various places in the system’s web interface, including port variables, access control policies, network discovery rules, and event searches.

You can use port variables in the intrusion rule **Source Port** and **Destination Port** header fields to restrict packet inspection to packets originating from or destined to specific TCP or UDP ports.

When you use variables in these fields, the variable set you link to the intrusion policy associated with an access control rule or policy determines the values for these variables in the network traffic where you deploy the access control policy.

You can add any combination of the following port configurations to a variable:

• any combination of port variables and port objects that you select from the list of available ports

  Note that the list of available ports does not display port object groups, and you cannot add these to variables.

• individual port objects that you add from the New Variable or Edit Variable page, and can then add to your variable and to other existing and future variables

  Only TCP and UDP ports, including the value `any` for either type, are valid variable values. If you use the new or edit variables page to add a valid port object that is not a valid variable value, the object is added to the system but is not displayed in the list of available objects. When you use the object manager to edit a port object that is used in a variable, you can only change its value to a valid variable value.

• single, literal port values and port ranges

  You must separate port ranges with a dash (`-`). Port ranges indicated with a colon (`:`) are supported for backward compatibility, but you cannot use a colon in port variables that you create.

  You can list multiple literal port values and ranges by adding each individually in any combination.

Note the following points when adding or editing port variables:

• The default value for included ports in any variable you add is the word `any`, which indicates any port or port range. The default value for excluded ports is `none`, which indicates no ports.

  **Tip**

  To create a variable with the value `any`, name and save the variable without adding a specific value.

• You cannot logically exclude the value `any` which, if excluded, would indicate no ports. For example, you cannot save a variable set when you add a variable with the value `any` to the list of excluded ports.
• Adding ports to the excluded list negates the specified ports and port ranges. That is, you can match any port with the exception of the excluded ports or port ranges.

• Excluded values must resolve to a subset of included values. For example, you cannot include the port range 10-50 and exclude port 60.

Advanced Variables

Advanced variables allow you to configure features that you cannot otherwise configure via the web interface. The Firepower System currently provides only one advanced variable, the USER_CONF variable.

**USER_CONF**

USER_CONF provides a general tool that allows you to configure one or more features not otherwise available via the web interface.

⚠️ **Caution**

Do not use the advanced variable USER_CONF to configure an intrusion policy feature unless you are instructed to do so in the feature description or by Support. Conflicting or duplicate configurations will halt the system.

When editing USER_CONF, you can type up to 4096 total characters on a single line; the line wraps automatically. You can include any number of valid instructions or lines until you reach the 8192 maximum character length for a variable or a physical limit such as disk space. Use the backslash (\) line continuation character after any complete argument in a command directive.

Resetting USER_CONF empties it.

Variable Reset

You can reset a variable to its default value on the variable set new or edit variables page. The following table summarizes the basic principles of resetting variables.

**Table 53: Variable Reset Values**

<table>
<thead>
<tr>
<th>Resetting this variable type...</th>
<th>In this set type...</th>
<th>Resets it to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>default</td>
<td>default</td>
<td>the rule update value</td>
</tr>
<tr>
<td>user-defined</td>
<td>default</td>
<td>any</td>
</tr>
<tr>
<td>default or user-defined</td>
<td>custom</td>
<td>the current default set value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(modified or unmodified)</td>
</tr>
</tbody>
</table>

Resetting a variable in a custom set simply resets it to the current value for that variable in the default set.

Conversely, resetting or modifying the value of a variable in the default set always updates the default value of that variable in all custom sets. When the reset icon is grayed out, indicating that you cannot reset the variable, this means that the variable has no customized value in that set. Unless you have customized the value for a variable in a custom set, a change to the variable in the default set updates the value used in any intrusion policy where you have linked the variable set.
It is good practice when you modify a variable in the default set to assess how the change affects any intrusion policy that uses the variable in a linked custom set, especially when you have not customized the variable value in the custom set.

You can hover your pointer over the reset icon ( ) in a variable set to see the reset value. When the customized value and the reset value are the same, this indicates one of the following:

- you are in the custom or default set where you added the variable with the value any
- you are in the custom set where you added the variable with an explicit value and elected to use the configured value as the default value

### Adding Variables to Sets

Adding a variable to a variable set adds it to all other sets. When you add a variable from a custom set, you must choose whether to use the configured value as the customized value in the default set:

- If you do use the configured value (for example, 192.168.0.0/16), the variable is added to the default set using the configured value as a customized value with a default value of any. Because the current value in the default set determines the default value in other sets, the initial, default value in other custom sets is the configured value (which in the example is 192.168.0.0/16).
- If you do not use the configured value, the variable is added to the default set using only the default value any and, consequently, the initial, default value in other custom sets is any.

### Example: Adding User-Defined Variables to Default Sets

The following diagram illustrates set interactions when you add the user-defined variable Var1 to the default set with the value 192.168.1.0/24.

You can customize the value of Var1 in any set. In Custom Set 2 where Var1 has not been customized, its value is 192.168.1.0/24. In Custom Set 1 the customized value 192.168.2.0/24 of Var1 overrides the default value. Resetting a user-defined variable in the default set resets its default value to any in all sets.

It is important to note in this example that, if you do not update Var1 in Custom Set 2, further customizing or resetting Var1 in the default set consequently updates the current, default value of Var1 in Custom Set 2, thereby affecting any intrusion policy linked to the variable set.

Although not shown in the example, note that interactions between sets are the same for user-defined variables and default variables except that resetting a default variable in the default set resets it to the value configured by Cisco in the current rule update.
Example: Adding User-Defined Variables to Custom Sets

The next two examples illustrate variable set interactions when you add a user-defined variable to a custom set. When you save the new variable, you are prompted whether to use the configured value as the default value for other sets. In the following example, you elect to use the configured value.

Note that, except for the origin of `Var1` from Custom Set 1, this example is identical to the example above where you added `Var1` to the default set. Adding the customized value 192.168.1.0/24 for `Var1` to Custom Set 1 copies the value to the default set as a customized value with a default value of any. Thereafter, `Var1` values and interactions are the same as if you had added `Var1` to the default set. As with the previous example, keep in mind that further customizing or resetting `Var1` in the default set consequently updates the current, default value of `Var1` in Custom Set 2, thereby affecting any intrusion policy linked to the variable set.

In the next example, you add `Var1` with the value 192.168.1.0/24 to Custom Set 1 as in the previous example, but you elect not to use the configured value of `Var1` as the default value in other sets.

This approach adds `Var1` to all sets with a default value of any. After adding `Var1`, you can customize its value in any set. An advantage of this approach is that, by not initially customizing `Var1` in the default set, you decrease your risk of customizing the value in the default set and thus inadvertently changing the current value in a set such as Custom Set 2 where you have not customized `Var1`.

Nesting Variables

You can nest variables so long as the nesting is not circular. Nested, negated variables are not supported.

Valid Nested Variables

In this example, SMTP_SERVERS, HTTP_SERVERS, and OTHER_SERVERS are valid nested variables.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Included Networks</th>
<th>Excluded Networks</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP_SERVERS</td>
<td>customized default</td>
<td>10.1.1.1</td>
<td>—</td>
</tr>
<tr>
<td>HTTP_SERVERS</td>
<td>customized default</td>
<td>10.1.1.2</td>
<td>—</td>
</tr>
<tr>
<td>OTHER_SERVERS</td>
<td>user-defined</td>
<td>10.2.2.0/24</td>
<td>—</td>
</tr>
</tbody>
</table>
### An Invalid Nested Variable

In this example, `HOME_NET` is an invalid nested variable because the nesting of `HOME_NET` is circular; that is, the definition of `OTHER_SERVERS` includes `HOME_NET`, so you would be nesting `HOME_NET` in itself.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Included Networks</th>
<th>Excluded Networks</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP_SERVERS</td>
<td>customized default</td>
<td>10.1.1.1</td>
<td>—</td>
</tr>
<tr>
<td>HTTP_SERVERS</td>
<td>customized default</td>
<td>10.1.1.2</td>
<td>—</td>
</tr>
<tr>
<td>OTHER_SERVERS</td>
<td>user-defined</td>
<td>10.2.2.0/24 HOME_NET</td>
<td>—</td>
</tr>
<tr>
<td>HOME_NET</td>
<td>customized default</td>
<td>10.1.1.0/24 OTHER_SERVERS</td>
<td>SMTP_SERVERS HTTP_SERVERS</td>
</tr>
</tbody>
</table>

### An Unsupported Nested, Negated Variable

Because nested, negated variables are not supported, you cannot use the variable `NONCORE_NET` as shown in this example to represent IP addresses that are outside of your protected networks.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Included Networks</th>
<th>Excluded Networks</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOME_NET</td>
<td>customized default</td>
<td>10.1.0.0/16 10.2.0.0/16 10.3.0.0/16</td>
<td>—</td>
</tr>
<tr>
<td>EXTERNAL_NET</td>
<td>customized default</td>
<td>— HOME_NET</td>
<td></td>
</tr>
<tr>
<td>DMZ_NET</td>
<td>user-defined</td>
<td>10.4.0.0/16</td>
<td>—</td>
</tr>
<tr>
<td>NOT_DMZ_NET</td>
<td>user-defined</td>
<td>— DMZ_NET</td>
<td></td>
</tr>
<tr>
<td>NONCORE_NET</td>
<td>user-defined</td>
<td>EXTERNAL_NET NOT_DMZ_NET</td>
<td>—</td>
</tr>
</tbody>
</table>
Alternative to an Unsupported Nested, Negated Variable

As an alternative to the example above, you could represent IP addresses that are outside of your protected networks by creating the variable NONCORE_NET as shown in this example.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Included Networks</th>
<th>Excluded Networks</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOME_NET</td>
<td>customized default</td>
<td>10.1.0.0/16, 10.2.0.0/16, 10.3.0.0/16</td>
<td>—</td>
</tr>
<tr>
<td>DMZ_NET</td>
<td>user-defined</td>
<td>10.4.0.0/16</td>
<td>—</td>
</tr>
<tr>
<td>NONCORE_NET</td>
<td>user-defined</td>
<td>—</td>
<td>HOME_NET, DMZ_NET</td>
</tr>
</tbody>
</table>

Managing Variable Sets

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

Procedure

**Step 1** Choose **Objects > Object Management**.

**Step 2** Choose **Variable Set** from the list of object types.

**Step 3** Manage your variable sets:

- **Add** — If you want to add a custom variable set, click **Add Variable Set**; see Creating Variable Sets, on page 345.
- **Delete** — If you want to delete a custom variable set, click the delete icon (.delete_icon) next to the variable set, then click **Yes**. You cannot delete the default variable set or variable sets belonging to ancestor domains.
  
  **Note** Variables created in a variable set you delete are not deleted or otherwise affected in other sets.

  - **Edit** — If you want to edit a variable set, click the edit icon (edit_icon) next to the variable set you want to modify; see Editing Objects, on page 319.
  - **Filter** — If you want to filter variable sets by name, begin entering a name; as you type, the page refreshes to display matching names. If you want to clear name filtering, click the clear icon (clear_icon) in the filter field.
• Manage Variables — To manage the variables included in variable sets, see Managing Variables, on page 345.

## Creating Variable Sets

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1** Choose Objects > Object Management.

**Step 2** Choose Variable Set from the list of object types.

**Step 3** Click Add Variable Set.

**Step 4** Enter a Name.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

**Step 5** Optionally, enter a Description.

**Step 6** Manage the variables in the set; see Managing Variables, on page 345.

**Step 7** Click Save.

### What to do next

• If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

## Managing Variables

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.
Managing Variables

Procedure

**Step 1** Choose **Objects > Object Management**.

**Step 2** Choose **Variable Set** from the list of object types.

**Step 3** Click the edit icon (-pencil) next to the variable set you want to edit.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4** Manage your variables:

- **Display** — If you want to display the complete value for a variable, hover your pointer over the value in the **Value** column next to the variable.
- **Add** — If you want to add a variable, click **Add**; see Adding Variables, on page 347.
- **Delete** — Click the delete icon (-trash) next to the variable. If you have saved the variable set since adding the variable, click **Yes** to confirm that you want to delete the variable.

You **cannot** delete the following:

- default variables
- user-defined variables that are used by intrusion rules or other variables
- variables belonging to ancestor domains

- **Edit** — Click the edit icon (-pencil) next to the variable you want to edit; see Editing Variables, on page 348.
- **Reset** — If you want to reset a modified variable to its default value, click the reset icon (-repeat) next to a modified variable. If the reset icon is dimmed, one of the following is true:
  - The current value is already the default value.
  - The configuration belongs to an ancestor domain.

**Tip** Hover your pointer over an active reset icon to display the default value.

**Step 5** Click **Save** to save the variable set. If the variable set is in use by an access control policy, click **Yes** to confirm that you want to save your changes.

Because the current value in the default set determines the default value in all other sets, modifying or resetting a variable in the default set changes the current value in other sets where you have not customized the default value.

---

**What to do next**

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.
Adding Variables

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** In the variable set editor, click **Add**.

**Step 2** Enter a unique variable **Name**.

**Step 3** From the **Type** drop-down list, choose either **Network** or **Port**.

**Step 4** Specify values for the variable:

- If you want to move items from the list of available networks or ports to the list of included or excluded items, you can choose one or more items and then drag and drop, or click **Include** or **Exclude**.

  **Tip** If addresses or ports in the included and excluded lists for a network or port variable overlap, excluded addresses or ports take precedence.

- Enter a single literal value, then click **Add**. For network variables, you can enter a single IP address or address block. For port variables you can add a single port or port range, separating the upper and lower values with a hyphen (-). Repeat this step as needed to enter multiple literal values.

- If you want to remove an item from the included or excluded lists, click the delete icon (Trash) next to the item.

  **Note** The list of items to include or exclude can be comprised of any combination of literal strings and existing variables, objects, and network object groups in the case of network variables.

**Step 5** Click **Save** to save the variable. If you are adding a new variable from a custom set, you have the following options:

- Click **Yes** to add the variable using the configured value as the customized value in the default set and, consequently, the default value in other custom sets.

- Click **No** to add the variable as the default value of any in the default set and, consequently, in other custom sets.

**Step 6** Click **Save** to save the variable set. Your changes are saved, and any access control policy the variable set is linked to displays an out-of-date status.

**What to do next**

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.
Editing Variables

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

You can edit both custom and default variables.

You cannot change the Name or Type values in an existing variable.

Procedure

**Step 1**
In the variable set editor, click the edit icon (edit) next to the variable you want to modify.

If a view icon (view) appears instead, the object belongs to an ancestor domain, or you do not have permission to modify the object.

**Step 2**
Modify the variable:

- If you want to move items from the list of available networks or ports to the list of included or excluded items, you can select one or more items and then drag and drop, or click Include or Exclude.

  **Tip**
  If addresses or ports in the included and excluded lists for a network or port variable overlap, excluded addresses or ports take precedence.

- Enter a single literal value, then click Add. For network variables, you can enter a single IP address or address block. For port variables you can add a single port or port range, separating the upper and lower values with a hyphen (-). Repeat this step as needed to enter multiple literal values.

- If you want to remove an item from the included or excluded lists, click the delete icon next to the item.

  **Note**
  The list of items to include or exclude can be comprised of any combination of literal strings and existing variables, objects, and network object groups in the case of network variables.

**Step 3**
Click Save to save the variable.

**Step 4**
Click Save to save the variable set. If the variable set is in use by an access control policy, click Yes to confirm that you want to save your changes. Your changes are saved, and any access control policy the variable set is linked to displays an out-of-date status.

What to do next

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.
Security Intelligence Lists and Feeds

Security Intelligence lists and feeds help you quickly filter traffic by collecting:

- IP address and address blocks—Use in access control policies to blacklist and whitelist as part of Security Intelligence.
- Domain Names—Use in DNS policies to blacklist and whitelist as part of Security Intelligence.
- URLs—Use in access control policies to blacklist and whitelist as part of Security Intelligence. You can also use URL lists in access control rules, whose analysis and traffic handling phases occur after Security Intelligence.

Lists

A list is a static collection that you manage manually.

By default, access control and DNS policies use Global blacklists and whitelists as part of Security Intelligence. Whitelist Now and Blacklist Now actions allow you to build and implement these lists; see Blacklist Now, Whitelist Now, and Global Lists, on page 350.

Custom lists can augment and fine-tune feeds and the Global lists.

Feeds

A feed is a dynamic collection that updates on an interval over HTTP or HTTPS.

The regularly updated Cisco Intelligence Feed allows you to filter network traffic based on the latest threat intelligence from Talos. You can also use third-party feeds. Or, with a custom internal feed, you could easily maintain an enterprise-wide blacklist in a large deployment with multiple Firepower Management Center appliances.

If you want strict control over when the system updates a feed from the Internet, you can disable automatic updates for that feed. However, automatic updates ensure the most up-to-date, relevant data.

Note

The system does not perform peer SSL certificate verification when downloading custom feeds, nor does the system support the use of certificate bundles or self-signed certificates to verify the remote peer.

List and Feed Formatting

Each list or feed must be a simple text file no larger than 500MB. List files must have the .txt extension. Include one entry or comment per line: one IP address, one URL, one domain name.

Tip

The number of entries you can include is limited by the maximum size of the file. For example, a URL list with no comments and an average URL length of 100 characters (including Punycode or percent Unicode representations and newlines) can contain more than 5.24 million entries.

In a DNS list entry, you can specify an asterisk (*) wildcard character for a domain label. All labels match the wildcard. For example, an entry of www.example.* matches both www.example.com and www.example.co.
If you add comment lines within the source file, they must start with the pound (#) character. If you upload a source file with comments, the system removes your comments during upload. Source files you download contain all your entries without your comments.

**List and Feed Updates**

List and feed updates replace the existing list or feed file with the contents of the new file. Contents of existing and new files are not merged.

If the system downloads a corrupt feed or a feed with no recognizable entries, the system continues using the old feed data (unless it is the first download). However, if the system can recognize even one entry in the feed, it uses the entries it can recognize.

### Security Intelligence Object Quick Reference

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Edit Capabilities</th>
<th>Requires Redeploy After Edit?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default (but custom-populated) whitelists and blacklists: Global, descendant, and domain-specific</td>
<td>Add entries using the context menu. Delete entries using the object manager.</td>
<td>No after adding entries. Yes after deleting entries.</td>
</tr>
<tr>
<td>Custom whitelists and blacklists</td>
<td>Upload new and replacement lists using the object manager.</td>
<td>Yes</td>
</tr>
<tr>
<td>System-provided Intelligence Feeds</td>
<td>Disable or change update frequency using the object manager.</td>
<td>No</td>
</tr>
<tr>
<td>Custom feeds</td>
<td>Fully modify using the object manager.</td>
<td>No</td>
</tr>
<tr>
<td>Sinkhole</td>
<td>Fully modify using the object manager.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Blacklist Now, Whitelist Now, and Global Lists

The Firepower Management Center context menu (see The Context Menu, on page 26) allows you to quickly blacklist and whitelist with Security Intelligence. For example, if you notice a set of routable IP addresses in intrusion events associated with exploit attempts, you can immediately blacklist those IP addresses. Although it may take a few minutes for your changes to propagate, you do not have to redeploy.

**Blacklist Now** and **Whitelist Now** context-menu options are available on IP address, URL, and DNS request hotspots. Blacklisting or whitelisting with the context menu adds the chosen item to the appropriate default Global list. By default, Access control and DNS policies use these Global lists, which apply to all security zones. You can opt not to use these lists on a per-policy basis.

---

**Note**

These options apply to Security Intelligence only. Security Intelligence cannot blacklist traffic that has already been fastpathed. Similarly, Security Intelligence whitelisting does not automatically trust or fastpath matching traffic. For more information, see _About Security Intelligence, on page 675._
<table>
<thead>
<tr>
<th>Context Menu Option</th>
<th>Target Item</th>
<th>Affected Global Lists</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blacklist Now</td>
<td>An IP address</td>
<td>Global Blacklist</td>
</tr>
<tr>
<td>Whitelist Now</td>
<td></td>
<td>Global Whitelist</td>
</tr>
<tr>
<td>Blacklist HTTP/S Connections to URL</td>
<td>A URL</td>
<td>Global Blacklist for URL</td>
</tr>
<tr>
<td>Whitelist HTTP/S Connections to URL</td>
<td></td>
<td>Global Whitelist for URL</td>
</tr>
<tr>
<td>Blacklist HTTP/S Connections to Domain</td>
<td>An entire domain</td>
<td>Global Blacklist for URL</td>
</tr>
<tr>
<td>Whitelist HTTP/S Connections to Domain</td>
<td></td>
<td>Global Whitelist for URL</td>
</tr>
<tr>
<td>Blacklist DNS Requests to Domain</td>
<td>DNS requests for an entire domain</td>
<td>Global Blacklist for DNS</td>
</tr>
<tr>
<td>Whitelist DNS Requests to Domain</td>
<td></td>
<td>Global Whitelist for DNS</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can choose the Firepower System domains where you want to enforce the blacklisting or whitelisting by adding items to Domain lists as well as the Global lists; see Security Intelligence Lists and Multitenancy, on page 351.

Because adding an entry to a Security Intelligence list affects access control, you must have one of:

- Administrator access
- A combination of default roles: Network Admin or Access Admin, plus Security Analyst and Security Approver
- A custom role with both Modify Access Control Policy and Deploy Configuration to Devices permissions

**Security Intelligence Lists and Multitenancy**

In a multidomain deployment, the Global domain owns the Global blacklists and whitelists. Only Global administrators can add to or remove items from the Global lists. So that subdomain users can whitelist and blacklist networks, domain names, and URLs, multitenancy adds:

- Domain lists—Whitelists or blacklists whose contents apply to a particular subdomain only. The Global lists are Domain lists for the Global domain.
- Descendant Domain lists—Whitelists or blacklists that aggregate the Domain lists of the current domain’s descendants.

**Domain Lists**

In addition to being able to access (but not edit) the Global lists, each subdomain has its own named lists, the contents of which apply only to that subdomain. For example, a subdomain named Company A owns:

- Domain Blacklist - Company A and Domain Whitelist - Company A
- Domain Blacklist for DNS - Company A, Domain Whitelist for DNS - Company A
- Domain Blacklist for URL - Company A, Domain Whitelist for URL - Company A
Any administrator at or above the current domain can populate these lists. You can use the context menu to whitelist or blacklist an item in the current and all descendant domains. However, only an administrator in the associated domain can remove an item from a Domain list.

For example, a Global administrator could choose to blacklist the same IP address in the Global domain and Company A’s domain, but not blacklist it in Company B’s domain. This action would add the same IP address to:

- Global Blacklist (where it can be removed only by Global administrators)
- Domain Blacklist - Company A (where it can be removed only by Company A administrators)

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.

**Descendant Domain Lists**

A Descendant Domain list is a whitelist or blacklist that aggregates the Domain lists of the current domain’s descendants. Leaf domains do not have Descendant Domain lists.

Descendant Domain lists are useful because a higher-level domain administrator can enforce general Security Intelligence settings, while still allowing subdomain users to blacklist and whitelist items in their own deployment.

For example, the Global domain has the following Descendant Domain lists:

- Descendant Blacklists - Global, Descendant Whitelists - Global
- Descendant Blacklists for URL - Global, Descendant Whitelists for URL - Global
- Descendant Blacklists for URL - Global, Descendant Whitelists for URL - Global

**Note**

Descendant Domain lists do not appear in the object manager because they are symbolic aggregations, not hand-populated lists. They appear where you can use them: in access control and DNS policies.

### Changing the Update Frequency for Security Intelligence Feeds

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

By default, each feed updates the Management Center every two hours. You cannot delete the system-provided feeds, but you can change the frequency of (or disable) their updates.

In a multidomain deployment, the system-provided feeds belong to the Global domain and can be modified only by an administrator in that domain. You can modify the update frequency for custom feeds belonging to your domain.
The Management Center pushes Security Intelligence updates to managed devices every 30 minutes. You cannot modify this frequency.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Objects &gt; Object Management.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Expand the Security Intelligence node, then choose the feed type whose frequency you want to change.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Next to the feed you want to update, click the edit icon (редактировать). If a view icon (смотреть) appears instead, the object belongs to an ancestor domain, or you do not have permission to modify the object.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Edit the Update Frequency.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click Save.</td>
</tr>
</tbody>
</table>

**Custom Security Intelligence Feeds**

Custom or third-party Security Intelligence feeds allow you to augment the system-provided Intelligence Feeds with other regularly-updated reputable whitelists and blacklists on the Internet. You can also set up an internal feed, which is useful if you want to update multiple Firepower Management Centers in your deployment using one source list.

**Note**

You cannot whitelist or blacklist address blocks using a /0 netmask in a Security Intelligence feed. If you want to monitor or block all traffic targeted by a policy, use an access control rule with the Monitor or Block rule action, respectively, and a default value of any for the Source Networks and Destination Networks.

When you configure a feed, you specify its location using a URL; the URL cannot be Punycode-encoded. By default, the system downloads the entire feed source on the interval you configure, then automatically updates its managed devices.

You also can configure the system to use an md5 checksum to determine whether to download an updated feed. If the checksum has not changed since the last time the system downloaded the feed, the system does not need to re-download it. You may want to use md5 checksums for internal feeds, especially if they are large. The md5 checksum must be stored in a simple text file with only the checksum. Comments are not supported.

Manually updating Security Intelligence feeds updates all feeds, including the Intelligence Feeds.
Creating Security Intelligence Feeds

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network/Group Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Choose Objects > Object Management.
Step 2 Expand the Security Intelligence node, then choose a feed type you want to add.
Step 3 Click the option appropriate to the feed type you chose above:
   • Add Network Lists and Feeds (for IP addresses)
   • Add DNS Lists and Feeds
   • Add URL Lists and Feeds
Step 4 Enter a Name for the feed.
      In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.
Step 5 Choose Feed from the Type drop-down list.
Step 6 Enter a Feed URL.
Step 7 Optionally, enter an MD5 URL.
Step 8 Choose an Update Frequency.
Step 9 Click Save.
      Unless you disabled feed updates, the system attempts to download and verify the feed.

Manually Updating Security Intelligence Feeds

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat (Security Intelligence)</td>
<td>Protection (Security Intelligence)</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network/Group Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Choose Objects > Object Management.
Step 2 Expand the Security Intelligence node, then choose a feed type.
Step 3 Click Update Feeds, then confirm.
Step 4 Click OK.
After the Firepower Management Center downloads and verifies the feed updates, it communicates any changes to its managed devices. Your deployment begins filtering traffic using the updated feeds.

**Custom Security Intelligence Lists**

Security Intelligence lists are simple static lists of IP addresses and address blocks, URLs, or domain names that you manually upload to the system. Custom lists are useful if you want to augment and fine-tune feeds or one of the global lists, for a single Firepower Management Center’s managed devices.

For example, if a reputable feed improperly blocks your access to vital resources but is overall useful to your organization, you can create a custom whitelist that contains only the improperly classified IP addresses, rather than removing the IP address feed object from the access control policy’s blacklist.

You cannot whitelist or blacklist address blocks using a /0 netmask in a Security Intelligence list. If you want to monitor or block all traffic targeted by a policy, use an access control rule with the **Monitor** or **Block** rule action, respectively, and a default value of **any** for the **Source Networks** and **Destination Networks**.

Regarding list entry formatting, note the following:

- Netmasks for address blocks can be integers from 0 to 32 or 0 to 128, for IPv4 and IPv6, respectively.
- Unicode in domain names must be encoded in Punycode format, and are case insensitive.
- Characters in domain names are case-insensitive.
- Unicode in URLs should be encoded in percent-encoding format.
- Characters in URL subdirectories are case-sensitive.
- List entries that start with the pound sign (#) are treated as comments.

Regarding matching list entries, note the following:

- The system matches sub-level domains if a higher-level domain exists in a URL or DNS list. For example, if you add `example.com` to a DNS list, the system matches both `www.example.com` and `test.example.com`.

- The system does not perform DNS lookups (forward or reverse) on DNS or URL list entries. For example, if you add `http://192.168.0.2` to a URL list, and it resolves to `http://www.example.com`, the system only matches `http://192.168.0.2`, not `http://www.example.com`.

- If you add a URL ending in a forward slash (/) character to a URL list, only exact URLs match that entry.

- If you add a URL that does not end in a forward slash to a URL or DNS list, any URL that shares the same common prefix matches that entry. For example, if you add `www.example.com` to a URL list, the system matches both `www.example.com` and `www.example.com/example`.

### Uploading New Security Intelligence Lists to the Firepower Management Center

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Deployment Management**

**Custom Security Intelligence Lists**

**Firepower Management Center Configuration Guide, Version 6.0**
To modify a Security Intelligence list, you must make your changes to the source file and upload a new copy. You cannot modify the file's contents using the web interface. If you do not have access to the source file, download a copy from the system.

**Procedure**

**Step 1** Choose **Objects > Object Management**.

**Step 2** Expand the **Security Intelligence** node, then choose a list type.

**Step 3** Click the option appropriate to the list you chose above:

- **Add Network Lists and Feeds** (for IP addresses)
- **Add DNS Lists and Feeds**
- **Add URL Lists and Feeds**

**Step 4** Enter a **Name**.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

**Step 5** From the **Type** drop-down list, choose **List**.

**Step 6** Click **Browse** to browse to the list .txt file, then click **Upload**.

**Step 7** Click **Save**.

**What to do next**

- If an active policy references your object, deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

**Updating Security Intelligence Lists**

<table>
<thead>
<tr>
<th></th>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

**Procedure**

**Step 1** Choose **Objects > Object Management**.

**Step 2** Expand the **Security Intelligence** node, then choose a list type.

**Step 3** Next to the list you want to update, click the edit icon (✏️).
If a view icon () appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4**
If you need a copy of the list to edit, click **Download**, then follow your browser’s prompts to save the list as a text file.

**Step 5**
Make changes to the list as necessary.

**Step 6**
On the Security Intelligence pop-up window, click **Browse** to browse to the modified list, then click **Upload**.

**Step 7**
Click **Save**.

---

**What to do next**

- If an active policy references your object, deploy configuration changes; see [Deploy Configuration Changes, on page 277](#).

---

### Sinkhole Objects

A sinkhole object represents either a DNS server that gives non-routeable addresses for all domain names within the sinkhole, or an IP address that does not resolve to a server. You can reference the sinkhole object within a DNS policy rule to redirect matching traffic to the sinkhole. You must assign the object both an IPv4 address and an IPv6 address.

### Creating Sinkhole Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

---

**Procedure**

**Step 1**
Choose **Objects** > **Object Management**.

**Step 2**
Choose **Sinkhole** from the list of object types.

**Step 3**
Click **Add Sinkhole**.

**Step 4**
Enter a **Name**.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

**Step 5**
Enter the **IPv4 Address** and **IPv6 Address** of your sinkhole.

**Step 6**
You have the following options:

- If you want to redirect traffic to a sinkhole server, choose **Log Connections to Sinkhole**.
- If you want to redirect traffic to a non-resolving IP address, choose **Block and Log Connections to Sinkhole**.
**Step 7** If you want to assign an Indication of Compromise (IoC) type to your sinkhole, choose one from the Type drop-down.

**Step 8** Click Save.

---

## File Lists

If you use AMP for Networks, and the AMP cloud incorrectly identifies a file’s disposition, you can add the file to a file list to better detect the file in the future. These files are specified using SHA-256 hash values. Each file list can contain up to 10000 unique SHA-256 values.

There are two predefined categories of file lists:

**Clean List**

If you add a file to this list, the system treats it as if the AMP cloud assigned a clean disposition.

**Custom Detection List**

If you add a file to this list, the system treats it as if the AMP cloud assigned a malware disposition.

In a multidomain deployment, a clean list and custom detection list is present for each domain. In lower-level domains, you can view but not modify ancestor’s lists.

Because you manually specify the blocking behavior for the files included in these lists, the system does not query the AMP cloud for these files’ dispositions. You must configure a rule in the file policy with either a Malware Cloud Lookup or Block Malware action and a matching file type to calculate a file’s SHA value.

---

**Caution**

Do not include malware on the clean list. The clean list overrides both the AMP cloud and the custom detection list.

---

## Source Files for File Lists

You can add multiple SHA-256 values to a file list by uploading a comma-separated value (CSV) source file containing a list of SHA-256 values and descriptions. The Firepower Management Center validates the contents and populates the file list with valid SHA-256 values.

The source file must be a simple text file with a .csv file name extension. Any header must start with a pound sign (#); it is treated as a comment and not uploaded. Each entry should contain a single SHA-256 value followed by a description and end with either the LF or CR+LF Newline character. The system ignores any additional information in the entry.

Note the following:

- Deleting a source file from the file list also removes all associated SHA-256 hashes from the file list.
- You cannot upload multiple files to a file list if the successful source file upload results in the file list containing more than 10000 distinct SHA-256 values.
- The system truncates descriptions exceeding 256 characters to the first 256 characters on upload. If the description contains commas, you must use an escape character (\,). If no description is included, the source file name is used instead.
• All non-duplicate SHA-256 values are added to the file list. If a file list contains a SHA-256 value, and you upload a source file containing that value, the newly uploaded value does not modify the existing SHA-256 value. When viewing captured files, file events, or malware events related to the SHA-256 value, any threat name or description is derived from the individual SHA-256 value.

• The system does not upload invalid SHA-256 values in a source file.

• If multiple uploaded source files contain an entry for the same SHA-256 value, the system uses the most recent value.

• If a source file contains multiple entries for the same SHA-256 value, the system uses the last one.

• You cannot directly edit a source file within the object manager. To make changes, you must first modify your source file directly, delete the copy on the system, then upload the modified source file.

• The number of entries associated with a source file refers to the number of distinct SHA-256 values. If you delete a source file from a file list, the total number of SHA-256 entries the file list contains decreases by the number of valid entries in the source file.

### Adding Individual SHA-256 Values to File Lists

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware</td>
<td>Malware</td>
<td>Firepower</td>
<td>Any</td>
<td>Admin/Network Admin/Access Admin</td>
</tr>
</tbody>
</table>

You can submit a file’s SHA-256 value to add it to a file list. You cannot add duplicate SHA-256 values.

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

**Before you begin**

• Right-click a file or malware event from the event view, choose Show Full Text in the context menu, and copy the full SHA-256 value for pasting into the file list.

**Procedure**

1. **Step 1** Choose Objects > Object Management.
2. **Step 2** Choose File List from the list of object types.
3. **Step 3** Click the edit icon (📝) next to the clean list or custom detection list where you want to add a file.

   If a view icon (🔍) appears instead, the object belongs to an ancestor domain, or you do not have permission to modify the object.

4. **Step 4** Choose Enter SHA Value from the Add by drop-down list.
5. **Step 5** Enter a description of the source file in the Description field.
Step 6 Enter or paste the file’s entire value in the SHA-256 field. The system does not support matching partial values.

Step 7 Click Add.

Step 8 Click Save.

What to do next

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

Note

After configuration changes are deployed, the system no longer queries the AMP cloud for files on the list.

### Uploading Individual Files to File Lists

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware</td>
<td>Malware</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

If you have a copy of the file you want to add to a file list, you can upload the file to the Firepower Management Center for analysis; the system calculates the file’s SHA-256 value and adds the file to the list. The system does not enforce a limit on the size of files for SHA-256 calculation.

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

**Procedure**

**Step 1** Choose **Objects > Object Management**.

**Step 2** Choose **File List** from the list of object types.

**Step 3** Click the edit icon (📝) next to the clean list or custom detection list where you want to add a file.

If a view icon (👀) appears instead, the object belongs to an ancestor domain, or you do not have permission to modify the object.

**Step 4** From the Add by drop-down list, choose **Calculate SHA**.

**Step 5** Optionally, enter a description of the file in the Description field. If you do not enter a description, the file name is used for the description on upload.

**Step 6** Click **Browse**, and choose a file to upload.

**Step 7** Click **Calculate and Add SHA**.
Step 8

Click Save.

What to do next

• If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

Note

After you deploy configuration changes, the system no longer queries the AMP cloud for files on the list.

Uploading Source Files to File Lists

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware</td>
<td>Malware</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

Procedure

Step 1
Choose Objects > Object Management.

Step 2
Click File List.

Step 3
Click the edit icon (✍️) next to the file list where you want to add values from a source file.

If a view icon (смотреть) appears instead, the object belongs to an ancestor domain, or you do not have permission to modify the object.

Step 4
In the Add by drop-down list, choose List of SHAs.

Step 5
Optionally, enter a description of the source file in the Description field. If you do not enter a description, the system uses the file name.

Step 6
Click Browse to browse to the source file, then click Upload and Add List.

Step 7
Click Save.

What to do next

• If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.
After you deploy the policies, the system no longer queries the AMP cloud for files on the list.

### Editing SHA-256 Values in File Lists

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware</td>
<td>Malware</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can edit or delete individual SHA-256 values on a file list. Note that you cannot directly edit a source file within the object manager. To make changes, you must first modify your source file directly, delete the copy on the system, then upload the modified source file.

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

### Procedure

1. **Step 1** Choose **Objects > Object Management**.
2. **Step 2** Click **File List**.
3. **Step 3** Click the edit icon (📝) next to the clean list or custom detection list where you want to modify a file.

If a view icon (🔍) appears instead, the object belongs to an ancestor domain, or you do not have permission to modify the object.

4. **Step 4** You can:
   - Click the edit icon (📝) next to the SHA-256 value you want to change, and modify the **SHA-256** or **Description** values as desired.
   - Click the delete icon (🗑️) next to the SHA-256 value you want to delete.

5. **Step 5** Click **Save** to update the file entry in the list.
6. **Step 6** Click **Save** to save the file list.

### What to do next

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

### Note

After configuration changes are deployed, the system no longer queries the AMP cloud for files on the list.
**Downloading Source Files from File Lists**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware</td>
<td>Malware</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

**Procedure**

**Step 1** Choose **Objects > Object Management**.

**Step 2** Choose **File List** from the list of object types.

**Step 3** Click the edit icon ( ) next to the clean list or custom detection list where you want to download a source file.

If a view icon ( ) appears instead, the object belongs to an ancestor domain, or you do not have permission to modify the object.

**Step 4** Next to the source file you want to download, click the view icon ( ).

**Step 5** Click **Download SHA List** and follow the prompts to save the source file.

**Step 6** Click **Close**.

---

**Cipher Suite Lists**

A cipher suite list is an object comprised of several cipher suites. Each predefined cipher suite value represents a cipher suite used to negotiate an SSL- or TLS-encrypted session. You can use cipher suites and cipher suite lists in SSL rules to control encrypted traffic based on whether the client and server negotiated the SSL session using that cipher suite. If you add a cipher suite list to an SSL rule, SSL sessions negotiated with any of the cipher suites in the list match the rule.

**Note**

Although you can use cipher suites in the web interface in the same places as cipher suite lists, you cannot add, modify, or delete cipher suites.
## Creating Cipher Suite Lists

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1** Choose **Objects > Object Management**.

**Step 2** Choose **Cipher Suite List** from the list of object types.

**Step 3** Click **Add Cipher Suites**.

**Step 4** Enter a Name.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

**Step 5** Choose one or more cipher suites from the **Available Ciphers** list.

**Step 6** Click **Add**.

**Step 7** Optionally, click the delete icon (삭제) next to any cipher suites in the **Selected Ciphers** list that you want to remove.

**Step 8** Click **Save**.

### What to do next

- If an active policy references your object, deploy configuration changes; see [Deploy Configuration Changes](#), on page 277.

## Distinguished Name Objects

Each distinguished name object represents the distinguished name listed for a public key certificate’s subject or issuer. You can use distinguished name objects and groups in SSL rules to control encrypted traffic based on whether the client and server negotiated the SSL session using a server certificate with the distinguished name as subject or issuer.

Your distinguished name object can contain the common name attribute (CN). If you add a common name without “CN=” then the system prepends “CN=” before saving the object.

You can also add a distinguished name with one of each attribute listed in the following table, separated by commas.
### Table 54: Distinguished Name Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Allowed Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Country Code</td>
<td>two alphabetic characters</td>
</tr>
<tr>
<td>CN</td>
<td>Common Name</td>
<td>up to 64 alphanumeric, backslash (/), hyphen (-), quotation (&quot;), or asterisk (*) characters, or spaces</td>
</tr>
<tr>
<td>O</td>
<td>Organization</td>
<td>up to 64 alphanumeric, backslash (/), hyphen (-), quotation (&quot;), or asterisk (*) characters, or spaces</td>
</tr>
<tr>
<td>OU</td>
<td>Organizational Unit</td>
<td>up to 64 alphanumeric, backslash (/), hyphen (-), quotation (&quot;), or asterisk (*) characters, or spaces</td>
</tr>
</tbody>
</table>

You can define one or more asterisks (*) as wild cards in an attribute. In a common name attribute, you can define one or more asterisks per domain name label. Wild cards match only within that label, though you can define multiple labels with wild cards. See the following table for examples.

### Table 55: Common Name Attribute Wild Card Examples

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Matches</th>
<th>Does Not Match</th>
</tr>
</thead>
<tbody>
<tr>
<td>CN=“*ample.com”</td>
<td>example.com</td>
<td>mail.example.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>example.text.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ampleexam.com</td>
</tr>
<tr>
<td>CN=“exam*.com”</td>
<td>example.com</td>
<td>mail.example.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>example.text.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ampleexam.com</td>
</tr>
<tr>
<td>CN=“xamp*.com”</td>
<td>example.com</td>
<td>mail.example.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>example.text.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ampleexam.com</td>
</tr>
<tr>
<td>CN=“*.example.com”</td>
<td>mail.example.com</td>
<td>example.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>example.text.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ampleexam.com</td>
</tr>
<tr>
<td>CN=“*.com”</td>
<td>example.com</td>
<td>mail.example.com</td>
</tr>
<tr>
<td></td>
<td>ampleexam.com</td>
<td>example.com</td>
</tr>
<tr>
<td>CN=“<em>.</em>.com”</td>
<td>mail.example.com</td>
<td>example.com</td>
</tr>
<tr>
<td></td>
<td>example.text.com</td>
<td>ampleexam.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ampleexam.com</td>
</tr>
</tbody>
</table>
Creating Distinguished Name Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Choose Objects > Object Management.

**Step 2** Expand the Distinguished Name node, and choose Individual Objects.

**Step 3** Click Add Distinguished Name.

**Step 4** Enter a Name.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

**Step 5** In the DN field, enter a value for the distinguished name or common name. You have the following options:

- If you add a distinguished name, you can include one of each attribute listed in Distinguished Name Objects, on page 364 separated by commas.
- If you add a common name, you can include multiple labels and wildcards.

**Step 6** Click Save.

What to do next

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

PKI Objects

**PKI Objects for SSL Application**

PKI objects represent the public key certificates and paired private keys required to support your deployment. Internal and trusted CA objects consist of certificate authority (CA) certificates; internal CA objects also contain the private key paired with the certificate. Internal and external certificate objects consist of server certificates; internal certificate objects also contain the private key paired with the certificate.

If you use trusted certificate authority objects and internal certificate objects to configure a connection to ISE, you can use ISE as an identity source.

If you use internal certificate objects to configure captive portal, the system can authenticate the identity of your captive portal device when connecting to users’ web browsers.

If you use trusted certificate authority objects to configure realms, you can configure secure connections to LDAP or AD servers.
If you use PKI objects in SSL rules, you can match traffic encrypted with:

- the certificate in an external certificate object
- a certificate either signed by the CA in a trusted CA object, or within the CA’s chain of trust

If you use PKI objects in SSL rules, you can decrypt:

- outgoing traffic by re-signing the server certificate with an internal CA object
- incoming traffic using the known private key in an internal certificate object

You can manually input certificate and key information, upload a file containing that information, or in some cases, generate a new CA certificate and private key.

When you view a list of PKI objects in the object manager, the system displays the certificate’s Subject distinguished name as the object value. Hover your pointer over the value to view the full certificate Subject distinguished name. To view other certificate details, edit the PKI object.

---

**Note**

The Firepower Management Center and managed devices encrypt all private keys stored in internal CA objects and internal certificate objects with a randomly generated key before saving them. If you upload private keys that are password protected, the appliance decrypts the key using the user-supplied password, then reencrypts it with the randomly generated key before saving it.

---

**Internal Certificate Authority Objects**

Each internal certificate authority (CA) object you configure represents the CA public key certificate of a CA your organization controls. The object consists of the object name, CA certificate, and paired private key. You can use internal CA objects and groups in SSL rules to decrypt outgoing encrypted traffic by re-signing the server certificate with the internal CA.

---

**Note**

If you reference an internal CA object in a Decrypt - Resign SSL rule and the rule matches an encrypted session, the user’s browser may warn that the certificate is not trusted while negotiating the SSL handshake. To avoid this, add the internal CA object certificate to either the client or domain list of trusted root certificates.

---

You can create an internal CA object in the following ways:

- import an existing RSA-based or elliptic curve-based CA certificate and private key
- generate a new self-signed RSA-based CA certificate and private key
- generate an unsigned RSA-based CA certificate and private key. You must submit a certificate signing request (CSR) to another CA to sign the certificate before using the internal CA object.

After you create an internal CA object containing a signed certificate, you can download the CA certificate and private key. The system encrypts downloaded certificates and private keys with a user-provided password.

Whether system-generated or user-created, you can modify the internal CA object name, but cannot modify other object properties.
You cannot delete an internal CA object that is in use. Additionally, after you edit an internal CA object used in an SSL policy, the associated access control policy goes out-of-date. You must re-deploy the access control policy for your changes to take effect.

CA Certificate and Private Key Import

You can configure an internal CA object by importing an X.509 v3 CA certificate and private key. You can upload files encoded in one of the following supported formats:

- Distinguished Encoding Rules (DER)
- Privacy-enhanced Electronic Mail (PEM)

If the private key file is password-protected, you can supply the decryption password. If the certificate and key are encoded in the PEM format, you can also copy and paste the information.

You can upload only files that contain proper certificate or key information, and that are paired with each other. The system validates the pair before saving the object.

Note

If you configure a rule with the Decrypt - Resign action, the rule matches traffic based on the referenced internal CA certificate’s encryption algorithm type, in addition to any configured rule conditions. You must upload an elliptic curve-based CA certificate to decrypt outgoing traffic encrypted with an elliptic curve-based algorithm, for example.

Importing a CA Certificate and Private Key

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

Procedure

**Step 1** Choose **Objects > Object Management**.

**Step 2** Expand the PKI node, and choose **Internal CAs**.

**Step 3** Click **Import CA**.

**Step 4** Enter a **Name**.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

**Step 5** Above the **Certificate Data** field, click **Browse** to upload a DER or PEM-encoded X.509 v3 CA certificate file.

**Step 6** Above the **Key** field, click **Browse** to upload a DER or PEM-encoded paired private key file.
Step 7  If the uploaded file is password-protected, check the **Encrypted, and the password is:** check box, and enter the password.

Step 8  Click **Save.**

---

**What to do next**

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

## Generating a New CA Certificate and Private Key

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can configure an internal CA object by providing identification information to generate a self-signed RSA-based CA certificate and private key.

The generated CA certificate is valid for ten years. The Valid From date is a week before generation.

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

---

### Procedure

**Step 1**  Choose **Objects > Object Management.**

**Step 2**  Expand the **PKI** node, and choose **Internal CAs.**

**Step 3**  Click **Generate CA.**

**Step 4**  Enter a **Name.**

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

**Step 5**  Enter the identification attributes.

**Step 6**  Click **Generate self-signed CA.**

---

## New Signed Certificates

You can configure an internal CA object by obtaining a signed certificate from a CA. This involves two steps:

- Provide identification information to configure the internal CA object. This generates an unsigned certificate and paired private key, and creates a certificate signing request (CSR) to a CA you specify.
- After the CA issues the signed certificate, upload it to the internal CA object, replacing the unsigned certificate.
You can only reference an internal CA object in an SSL rule if it contains a signed certificate.

**Creating an Unsigned CA Certificate and CSR**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network/Network/Network/Admin</td>
</tr>
</tbody>
</table>

**Procedure**

1. **Step 1** Choose **Objects > Object Management**.
2. **Step 2** Expand the **PKI** node, and choose **Internal CAs**.
3. **Step 3** Click **Generate CA**.
4. **Step 4** Enter a **Name**.

   In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

5. **Step 5** Enter the identification attributes.
6. **Step 6** Click **Generate CSR**.
7. **Step 7** Copy the CSR to submit to a CA.
8. **Step 8** Click **OK**.

**What to do next**

- You must upload a signed certificate issued by a CA as described in Uploading a Signed Certificate Issued in Response to a CSR, on page 370

**Uploading a Signed Certificate Issued in Response to a CSR**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network/Network/Network/Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

Once uploaded, the signed certificate can be referenced in SSL rules.
Procedure

Step 1  Choose Object Management.
Step 2  Expand the PKI node, and choose Internal CAs.
Step 3  Click the edit icon ( ) next to the CA object containing the unsigned certificate awaiting the CSR.
Step 4  Click Install Certificate.
Step 5  Click Browse to upload a DER or PEM-encoded X.509 v3 CA certificate file.
Step 6  If the uploaded file is password protected, check the Encrypted, and the password is: check box, and enter the password.
Step 7  Click Save to upload a signed certificate to the CA object.

What to do next

• If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

CA Certificate and Private Key Downloads

You can back up or transfer a CA certificate and paired private key by downloading a file containing the certificate and key information from an internal CA object.

⚠️ Caution
Always store downloaded key information in a secure location.

The system encrypts the private key stored in an internal CA object with a randomly generated key before saving it to disk. If you download a certificate and private key from an internal CA object, the system first decrypts the information before creating a file containing the certificate and private key information. You must then provide a password the system uses to encrypt the downloaded file.

⚠️ Caution
Private keys downloaded as part of a system backup are decrypted, then stored in the unencrypted backup file.

Downloading a CA Certificate and Private Key

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

You can download CA certificates for both the current domain and ancestor domains.
Procedure

**Step 1** Choose **Objects > Object Management**.
**Step 2** Expand the **PKI** node, and choose **Internal CAs**.
**Step 3** Next to the internal CA object whose certificate and private key you want to download, click the edit icon (✍).

In a multidomain deployment, click the view icon (🔍) to download the certificate and private key for an object in an ancestor domain.

**Step 4** Click **Download**.
**Step 5** Enter an encryption password in the **Password** and **Confirm Password** fields.
**Step 6** Click **OK**.

---

**Trusted Certificate Authority Objects**

Each trusted certificate authority (CA) object you configure represents a CA public key certificate belonging to a trusted CA. The object consists of the object name and CA public key certificate. You can use external CA objects and groups in:

- your SSL policy to control traffic encrypted with a certificate signed either by the trusted CA, or any CA within the chain of trust.
- your realm configurations to establish secure connections to LDAP or AD servers.
- your ISE connection. Select trusted certificate authority objects for the **pxGrid Server CA** and **MNT Server CA** fields.

After you create the trusted CA object, you can modify the name and add certificate revocation lists (CRL), but cannot modify other object properties. There is no limit on the number of CRLs you can add to an object. If you want to modify a CRL you have uploaded to an object, you must delete the object and recreate it.

**Note**

Adding a CRL to an object has no effect when the object is used in your ISE integration configuration.

You cannot delete a trusted CA object that is in use. Additionally, after you edit a trusted CA object that is in use, the associated access control policy goes out-of-date. You must re-deploy the access control policy for your changes to take effect.

**Trusted CA Object**

You can configure an external CA object by uploading an X.509 v3 CA certificate. You can upload a file encoded in one of the following supported formats:

- Distinguished Encoding Rules (DER)
- Privacy-enhanced Electronic Mail (PEM)
If the file is password-protected, you must supply the decryption password. If the certificate is encoded in the PEM format, you can also copy and paste the information.
You can upload a CA certificate only if the file contains proper certificate information; the system validates the certificate before saving the object.

Adding a Trusted CA Object

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Choose **Objects > Object Management**.

**Step 2** Expand the **PKI** node, and choose **Trusted CAs**.

**Step 3** Click **Add Trusted CAs**.

**Step 4** Enter a **Name**.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

**Step 5** Click **Browse** to upload a DER or PEM-encoded X.509 v3 CA certificate file.

**Step 6** If the file is password-protected, check the **Encrypted, and the password is** check box, and enter the password.

**Step 7** Click **Save**.

What to do next

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

Certificate Revocation Lists in Trusted CA Objects

You can upload CRLs to a trusted CA object. If you reference that trusted CA object in an SSL policy, you can control encrypted traffic based on whether the CA that issued the session encryption certificate subsequently revoked the certificate. You can upload files encoded in one of the following supported formats:

- Distinguished Encoding Rules (DER)
- Privacy-enhanced Electronic Mail (PEM)

After you add the CRL, you can view the list of revoked certificates. If you want to modify a CRL you have uploaded to an object, you must delete the object and recreate it.
You can upload only files that contain a proper CRL. There is no limit to the number of CRLs you can add to a trusted CA object. However, you must save the object each time you upload a CRL, before adding another CRL.

**Note**
Adding a CRL to an object has no effect when the object is used in your ISE integration configuration.

### Adding a Certificate Revocation List to a Trusted CA Object

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays objects created in the current domain, which you can edit. It also displays objects created in ancestor domains, which in most cases you cannot edit. To view and edit objects in a descendant domain, switch to that domain.

**Note**
Adding a CRL to an object has no effect when the object is used in your ISE integration configuration.

#### Procedure

1. Choose **Objects > Object Management**.
2. Expand the **PKI** node, and choose **Trusted CAs**.
3. Click the edit icon (📝) next to a trusted CA object.
   
   If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
4. Click **Add CRL** to upload a DER or PEM-encoded CRL file.
5. Click **OK**.

#### What to do next

- If an active policy references your object, deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

### External Certificate Objects

Each external certificate object you configure represents a server public key certificate that does not belong to your organization. The object consists of the object name and certificate. You can use external certificate
objects and groups in SSL rules to control traffic encrypted with the server certificate. For example, you can upload a self-signed server certificate that you trust, but cannot verify with a trusted CA certificate.

You can configure an external certificate object by uploading an X.509 v3 server certificate. You can upload a file in one of the following supported formats:

- Distinguished Encoding Rules (DER)
- Privacy-enhanced Electronic Mail (PEM)

You can upload only files that contains proper server certificate information; the system validates the file before saving the object. If the certificate is encoded in the PEM format, you can also copy and paste the information.

## Adding External Certificate Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

### Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Choose Objects &gt; Object Management.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Expand the PKI node, and choose External Certs.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click Add External Cert.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Enter a Name.</td>
</tr>
<tr>
<td></td>
<td>In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 server certificate file.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Click Save.</td>
</tr>
</tbody>
</table>

### What to do next

- If an active policy references your object, deploy configuration changes; see Deploy Configuration Changes, on page 277.

## Internal Certificate Objects

Each internal certificate object you configure represents a server public key certificate belonging to your organization. The object consists of the object name, public key certificate, and paired private key. You can use internal certificate objects and groups in:

- your SSL rules to decrypt traffic incoming to one of your organization’s servers using the known private key.
• your ISE connection. Select an internal certificate object for the **MC Server Certificate** field.

• your captive portal configuration to authenticate the identity of your captive portal device when connecting to users' web browsers. Select an internal certificate object for the **Server Certificate** field.

You can configure an internal certificate object by uploading an X.509 v3 RSA-based or elliptic curve-based server certificate and paired private key. You can upload a file in one of the following supported formats:

• Distinguished Encoding Rules (DER)

• Privacy-enhanced Electronic Mail (PEM)

If the file is password-protected, you must supply the decryption password. If the certificate and key are encoded in the PEM format, you can also copy and paste the information.

You can upload only files that contain proper certificate or key information, and that are paired with each other. The system validates the pair before saving the object.

After you create the internal certificate object, you can modify the name, but cannot modify other object properties.

You cannot delete an internal certificate object that is in use. Additionally, after you edit an internal certificate object that is in use, the associated access control policy goes out-of-date. You must re-deploy the access control policy for your changes to take effect.

### Adding Internal Certificate Objects

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1** Choose **Objects > Object Management**.

**Step 2** Expand the **PKI** node, and choose **Internal Certs**.

**Step 3** Click **Add Internal Cert**.

**Step 4** Enter a **Name**.

In a multidomain deployment, object names must be unique within the domain hierarchy. The system may identify a conflict with the name of an object you cannot view in your current domain.

**Step 5** Above the **Certificate Data** field, click **Browse** to upload a DER or PEM-encoded X.509 v3 server certificate file.

**Step 6** Above the **Key** field, or click **Browse** to upload a DER or PEM-encoded paired private key file.

**Step 7** If the uploaded private key file is password-protected, check the **Encrypted, and the password is** check box, and enter the password.

**Step 8** Click **Save**.
PART V

Configuration Basics

• Classic Device Management Basics, on page 379
• IPS Device Deployments and Configuration, on page 391
CHAPTER 19

Classic Device Management Basics

The following topics describe how to manage Classic devices (7000 and 8000 Series devices, ASA with FirePOWER Services, and NGIPSv) in the Firepower System:

• Remote Management Configuration, on page 379
• Interface Configuration Settings, on page 382

Remote Management Configuration

Before you can manage a Firepower System device, you must set up a two-way, SSL-encrypted communication channel between the device and the Firepower Management Center. The appliances use the channel to share configuration and event information. High availability peers also use the channel, which is by default on port 8305/tcp.

Note

This documentation explains how to configure remote management of a 7000 or 8000 Series device using its local web interface, before you register the device to the FMC. For information on configuring remote management for other models, see the appropriate quick start guide.

To enable communications between two appliances, you must provide a way for the appliances to recognize each other. There are three criteria the Firepower System uses when allowing communications:

• the hostname or IP address of the appliance with which you are trying to establish communication.
  
  In NAT environments, even if the other appliance does not have a routable address, you must provide a hostname or an IP address either when you are configuring remote management, or when you are adding the managed appliance.

• a self-generated alphanumeric registration key up to 37 characters in length that identifies the connection.

• an optional unique alphanumeric NAT ID that can help the Firepower System establish communications in a NAT environment.

The NAT ID must be unique among all NAT IDs used to register managed appliances.
Configuring Remote Management on a Managed Device

### Procedure

**Step 1**
On the web interface for the device you want to manage, choose **System > Integration > Remote Management**.

**Step 2**
Click the **Remote Management** tab, if it is not already displaying.

**Step 3**
Click **Add Manager**.

**Step 4**
In the **Management Host** field, enter one of the following for the Firepower Management Center that you want to use to manage this appliance:

- The IP address
- The fully qualified domain name or the name that resolves through the local DNS to a valid IP address (that is, the hostname)

**Caution**
Use a host name rather than an IP address if your network uses DHCP to assign IP addresses.

In a NAT environment, you do not need to specify an IP address or host name here if you plan to specify it when you add the managed appliance. In this case, the Firepower System uses the NAT ID you will provide later to identify the remote manager on the managed appliance’s web interface.

**Step 5**
In the **Registration Key** field, enter the registration key that you want to use to set up communications between appliances.

**Step 6**
For NAT environments, in the **Unique NAT ID** field, enter a **unique** alphanumeric NAT ID that you want to use to set up communications between appliances.

**Step 7**
Click **Save**.

### What to do next

- Wait until the appliances confirm that they can communicate with each other and the Pending Registration status appears.
- Add this device to the Firepower Management Center; see Add Devices to the Firepower Management Center, on page 178.

## Editing Remote Management on a Managed Device

### Procedure

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>N/A</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

When editing a remote manager, note that:
• The **Host** field specifies the fully qualified domain name or the name that resolves through the local DNS to a valid IP address (that is, the host name).

• The **Name** field specifies the display name of the managing appliance, which is used only within the context of the Firepower System. Entering a different display name does not change the host name for the managing device.

### Procedure

**Step 1**
On the web interface for the device, choose **System > Integration**.

**Step 2**
Click the **Remote Management** tab, if it is not already displaying.

**Step 3**
You can:

• Disable remote management — Click the slider next to the manager to enable or disable it. Disabling management blocks the connection between the Firepower Management Center and the device, but does **not** delete the device from the Firepower Management Center. If you no longer want to manage a device, see Deleting Devices from the Firepower Management Center, on page 180.

• Edit manager information — Click the edit icon (📝) next to the manager you want to modify, modify the **Name** and **Host** fields, and click **Save**.

---

### Changing the Management Port

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>7000 &amp; 8000 Series FMC</td>
<td>Global only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Appliances communicate using a two-way, SSL-encrypted communication channel, which by default is on port 8305.

Although Cisco **strongly** recommends that you keep the default setting, you can choose a different port if the management port conflicts with other communications on your network. Usually, changes to the management port are made during installation of the Firepower System.

⚠️ **Caution**

If you change the management port, you must change it for all appliances in your deployment that need to communicate with each other.

### Procedure

**Step 1**
Choose **System > Configuration**.

**Step 2**
Click **Management Interfaces**.
Step 3 In the Shared Settings section, enter the port number that you want to use in the Remote Management Port field.

Step 4 Click Save.

What to do next

- Repeat this procedure for every appliance in your deployment that must communicate with this appliance.

Interface Configuration Settings

The Interfaces page of the appliance editor displays detailed interface configuration information. The page is composed of the physical hardware view and the interfaces table view, which allow you to drill down to configuration details. You can add and edit interfaces from this page.

The Physical Hardware View

The top of the Interfaces page provides a graphical representation of the physical hardware view of a 7000 or 8000 Series device.

Use the physical hardware view to:

- view a network module’s type, part number, and serial number
- select an interface in the interfaces table view
- open an interface editor
- view the name of the interface, the type of interface, whether the interface has link, the interface’s speed setting, and whether the interface is currently in bypass mode
- view the details about an error or warning

Interface Icons

Table 56: Interface Icon Types and Descriptions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Interface Type</th>
<th>For more information, see...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Physical — an unconfigured physical interface.</td>
<td>Configuring Physical Switched Interfaces, on page 543 or Configuring Physical Routed Interfaces, on page 553</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Passive — a sensing interface configured to analyze traffic in a passive deployment.</td>
<td>Configuring Passive Interfaces, on page 392</td>
</tr>
<tr>
<td>Icon</td>
<td>Interface Type</td>
<td>For more information, see...</td>
</tr>
<tr>
<td>------</td>
<td>----------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>🌂</td>
<td>Inline — a sensing interface configured to handle traffic in an inline deployment.</td>
<td>Configuring Inline Interfaces, on page 395</td>
</tr>
<tr>
<td>🌂</td>
<td>Switched — an interface configured to switch traffic in a Layer 2 deployment.</td>
<td>Switched Interface Configuration, on page 541</td>
</tr>
<tr>
<td>🌂</td>
<td>Routed — an interface configured to route traffic in a Layer 3 deployment.</td>
<td>Routed Interfaces, on page 552</td>
</tr>
<tr>
<td>🌂</td>
<td>Aggregate — multiple physical interfaces configured as a single logical link.</td>
<td>About Aggregate Interfaces, on page 583</td>
</tr>
<tr>
<td>🌂</td>
<td>Aggregate Switched — multiple physical interfaces configured as a single logical link in a Layer 2 deployment.</td>
<td>Adding Aggregate Switched Interfaces, on page 589</td>
</tr>
<tr>
<td>🌂</td>
<td>Aggregate Routed — multiple physical interfaces configured as a single logical link in a Layer 3 deployment.</td>
<td>Adding Aggregate Routed Interfaces, on page 591</td>
</tr>
<tr>
<td>🌂</td>
<td>Hybrid — a logical interface configured to bridge traffic between a virtual router and a virtual switch.</td>
<td>Logical Hybrid Interfaces, on page 597</td>
</tr>
<tr>
<td>🌂</td>
<td>ASA FirePOWER — an interface configured on an ASA device with the ASA FirePOWER module installed.</td>
<td>Managing Cisco ASA FirePOWER Interfaces, on page 387</td>
</tr>
</tbody>
</table>

## Using the Physical Hardware View

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  
Choose Devices > Device Management.

**Step 2**  
Click the edit icon (📝) next to the device you want to manage.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.
Step 3  Use the graphical interface to:
  - Choose — If you want to choose an interface, click the interface icon. The system highlights the related entry in the interface table.
  - Edit — If you want to open an interface editor, double-click the interface icon.
  - View error or warning information — If you want to view the details about an error or warning, hover your cursor over the affected port on the network module.
  - View interface information — If you want to view the name of the interface, the type of interface, whether the interface has link, the interface’s speed setting, and whether the interface is currently in bypass mode, hover your cursor over the interface.
  - View network module information — If you want to view a network module’s type, part number, and serial number, hover your cursor over the dark circle in the lower left corner of the network module.

**Configuring Sensing Interfaces**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Classic</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can configure the sensing interfaces of a managed device, according to your Firepower System deployment, from the Interfaces page of the appliance editor. Note that you can only configure a total of 1024 interfaces on a managed device.

**Note**

The Firepower Management Center does not display ASA interfaces when the ASA FirePOWER is deployed in SPAN port mode.

**Procedure**

**Step 1**  Choose Devices > Device Management.

**Step 2**  Next to the device where you want to configure an interface, click the edit icon (-pencil).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3**  Click the edit icon (-pencil) next to the interface you want to configure.

**Step 4**  Use the interface editor to configure the sensing interface:
  - HA Link — If you want an interface configured on each member of a high-availability pair of devices to act as a redundant communications channel between the devices; also called a high availability link interface, click HA Link and proceed as described in Configuring HA Link Interfaces, on page 385.
  - Inline — If you want an interface configured to handle traffic in an inline deployment, click Inline and proceed as described in Configuring Inline Interfaces, on page 395.
  - Passive — If you want an interface configured to analyze traffic in a passive deployment, click Passive and proceed as described in Configuring Passive Interfaces, on page 392.
• Routed — If you want an interface configured to route traffic in a Layer 3 deployment, click Routed and proceed as described in Routed Interfaces, on page 552.

• Switched — If you want an interface configured to switch traffic in a Layer 2 deployment, click Switched and proceed as described in Switched Interface Configuration, on page 541.

Step 5 Click Save to complete your configuration.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Configuring HA Link Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>SupportedDomains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

After you establish a 7000 or 8000 Series device high-availability pair, you should configure a physical interface as a high availability (HA) link interface. This link acts as a redundant communications channel for sharing health information between the paired devices. When you configure an HA link interface on one device, you automatically configure an interface on the second device. You must configure both HA links on the same broadcast domain.

Dynamic NAT relies on dynamically allocating IP addresses and ports to map to other IP addresses and ports. Without an HA link, these mappings are lost in a failover, causing all translated connections to fail as they are routed through the now-active device in the high-availability pair.

Similarly, 7000 or 8000 Series devices with high-availability state sharing, dynamic NAT, or VPN require an HA link interface.

Procedure

Step 1 Choose Devices > Device Management.

Step 2 Next to the peer where you want to configure the HA link interface, click the edit icon (⋯).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3 Next to the interface you want to configure as a HA link interface, click the edit icon (⋯).

Step 4 Click HA Link.

Step 5 Check the Enabled check box.

Note If you clear the check box, the system administratively takes down the interface, disabling it.

Step 6 From the Mode drop-down list, choose an option to designate the link mode, or choose Autonegotiation to specify that the interface is configured to autonegotiate speed and duplex settings.
Step 7 From the MDI/MDIX drop-down list, choose an option to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX.

**Note** Normally, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.

Step 8 Enter a maximum transmission unit (MTU) in the MTU field.

The range of MTU values can vary depending on the model of the managed device and the interface type. See MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388 for more information.

**Caution** Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

Step 9 Click Save.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

- Snort® Restart Scenarios, on page 279
- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388

## Disabling Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>7000 &amp; 8000 Series NGIPSv</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can disable an interface by setting the interface type to None. Disabled interfaces appear grayed out in the interface list.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device where you want to disable the interface, click the edit icon (✏️).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Next to the interface you want to disable, click the edit icon (✏️).

**Step 4** Click None.
Step 5

Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Managing Cisco ASA FirePOWER Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>ASA FirePOWER</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

When editing an ASA FirePOWER interface, you can configure only the interface’s security zone from the Firepower Management Center.

You fully configure ASA FirePOWER interfaces using the ASA-specific software and CLI. If you edit an ASA FirePOWER and switch from multiple context mode to single context mode (or visa versa), the ASA FirePOWER renames all of its interfaces. You must reconfigure all Firepower System security zones, correlation rules, and related configurations to use the updated ASA FirePOWER interface names. For more information about ASA FirePOWER interface configuration, see the ASA documentation.

Note

You cannot change the type of ASA FirePOWER interface, nor can you disable the interface from the Firepower Management Center.

Procedure

Step 1

Choose Devices > Device Management.

Step 2

Next to the device where you want to edit the interface, click the edit icon (🔗).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3

Click the Interfaces tab if it is not already displaying.

Step 4

Next to the interface you want to edit, click the edit icon (🔗).

Step 5

Choose an existing security zone from the Security Zone drop-down list, or choose New to add a new security zone.

Step 6

Click Save to configure the security zone.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
MTU Ranges for 7000 and 8000 Series Devices and NGIPSv

Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

Note

The system trims 18 bytes from the configured MTU value. Do not set the IPv4 MTU lower than 594 or the IPv6 MTU lower than 1298.

<table>
<thead>
<tr>
<th>Classic Device Model</th>
<th>MTU Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>7000 &amp; 8000 Series</td>
<td>576-9234 (management interface)</td>
</tr>
<tr>
<td></td>
<td>576-10172 (inline sets, passive interface)</td>
</tr>
<tr>
<td></td>
<td>576-9922 (all others)</td>
</tr>
<tr>
<td>NGIPSv</td>
<td>576-9018 (all interfaces, inline sets)</td>
</tr>
</tbody>
</table>

Related Topics

About the MTU

Synchronizing Security Zone Object Revisions

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NGIPSv</td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you update a security zone object, the system saves a new revision of the object. As a result, if you have managed devices in the same security zone that have different revisions of the security zone object configured in the interfaces, you may log what appear to be duplicate connections.

If you notice duplicate connection reporting, you can update all managed devices to use the same revision of the object.

Procedure

Step 1 Choose Devices > Device Management.

Step 2 Next to the device where you want to update the security zone selection, click the edit icon (✏).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3 For each interface logging duplicate connection events, change the Security Zone to another zone, click Save, then change it back to the desired zone, and click Save again.
**Step 4**  
Repeat steps 2 through 3 for each device logging duplicate events. You must edit all devices before you continue.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**Caution**  
Do not deploy configuration changes to any device until you edit the zone setting for interfaces on all devices you want to sync. You must deploy to all managed devices at the same time.
IPS Device Deployments and Configuration

The following topics describe how to configure your device in an IPS deployment:

- Introduction to IPS Device Deployment and Configuration, on page 391
- Passive IPS Deployments, on page 391
- Inline IPS Deployments, on page 393

Introduction to IPS Device Deployment and Configuration

You can configure your device in either a passive or inline IPS deployment. In a passive deployment, you deploy the system out of band from the flow of network traffic. In an inline deployment, you configure the system transparently on a network segment by binding two ports together.

Passive IPS Deployments

In a passive IPS deployment, the Firepower System monitors traffic flowing across a network using a switch SPAN or mirror port. The SPAN or mirror port allows for traffic to be copied from other ports on the switch. This provides the system visibility within the network without being in the flow of network traffic. When configured in a passive deployment, the system cannot take certain actions such as blocking or shaping traffic. Passive interfaces receive all traffic unconditionally, and no traffic received on these interfaces is retransmitted.

Note

Outbound traffic includes flow control packets. Because of this, passive interfaces on your appliances may show outbound traffic and, depending on your configuration, generate events; this is expected behavior.

Passive Interfaces on the Firepower System

You can configure one or more physical ports on a managed device as passive interfaces.

When you enable a passive interface to monitor traffic, you designate mode and MDI/MDIX settings, which are available only for copper interfaces. Interfaces on 8000 Series appliances do not support half-duplex options.

When you disable a passive interface, users can no longer access it for security purposes.

The range of MTU values can vary depending on the model of the managed device and the interface type.
Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

**Related Topics**
- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
- Snort® Restart Scenarios, on page 279

### Configuring Passive Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>feature dependent</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  
Choose Devices > Device Management.

**Step 2**  
Click the edit icon (-pencil) next to the device where you want to configure the passive interface.  
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3**  
Click the edit icon (-pencil) next to the interface you want to configure as a passive interface.

**Step 4**  
Click Passive.

**Step 5**  
If you want to associate the passive interface with a security zone, do one of the following:  
- Choose an existing security zone from the Security Zone drop-down list.  
- Choose New to add a new security zone; see Creating Security Zone Objects, on page 332.

**Step 6**  
Check the Enabled check box.  
If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.

**Step 7**  
7000 & 8000 Series only: From the Mode drop-down list, designate the link mode, or choose Autonegotiation to specify that the interface is configured to automatically negotiate speed and duplex settings.  
Mode settings are available only for copper interfaces.

**Step 8**  
7000 & 8000 Series only: From the MDI/MDIX drop-down list, designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX.  
MDI/MDIX settings are available only for copper interfaces.

By default, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.
Step 9  Enter a maximum transmission unit (MTU) in the **MTU** field.

The range of MTU values can vary depending on the model of the managed device and the interface type.

**Caution**  Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified.

Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

Step 10  Click **Save**.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**Inline IPS Deployments**

In an inline IPS deployment, you configure the Firepower System transparently on a network segment by binding two ports together. This allows the system to be installed in any network environment without the configuration of adjacent network devices. Inline interfaces receive all traffic unconditionally, but all traffic received on these interfaces is retransmitted out of an inline set unless explicitly dropped.

**Note**  For the system to affect traffic, you must deploy relevant configurations to managed devices using routed, switched, or transparent interfaces, or inline interface pairs.

You can configure the interfaces on your managed device to route traffic between a host on your network and external hosts through different inline interface pairs, depending on whether the device traffic is inbound or outbound. This is an *asynchronous routing* configuration. If you deploy asynchronous routing but you include only one interface pair in an inline set, the device might not correctly analyze your network traffic because it might see only half of the traffic.

Adding multiple inline interface pairs to the same inline interface set allows the system to identify the inbound and outbound traffic as part of the same traffic flow. For passive interfaces only, you can also achieve this by including the interface pairs in the same security zone.

When the system generates a connection event from traffic passing through an asynchronous routing configuration, the event may identify an ingress and egress interface from the same inline interface pair. The configuration in the following diagram, for example, would generate a connection event identifying `eth3` as the ingress interface and `eth2` as the egress interface. This is expected behavior in this configuration.
If you assign multiple interface pairs to a single inline interface set but you experience issues with duplicate traffic, reconfigure to help the system uniquely identify packets. For example, you could reassign your interface pairs to separate inline sets or modify your security zones.

For devices with inline sets, a software bridge is automatically set up to transport packets after the device restarts. If the device is restarting, there is no software bridge running anywhere. If you enable bypass mode on the inline set, it goes into hardware bypass while the device is restarting. In that case, you may lose a few seconds of packets as the system goes down and comes back up, due to renegotiation of link with the device. However, the system will pass traffic while Snort is restarting.

Related Topics
- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
- Snort® Restart Scenarios, on page 279

### Inline Interfaces on the Firepower System

You can configure one or more physical ports on a managed device as inline interfaces. You must assign a pair of inline interfaces to an inline set before they can handle traffic in an inline deployment.

Note:
• The system warns you if you set the interfaces in an inline pair to different speeds or if the interfaces negotiate to different speeds.

• If you configure an interface as an inline interface, the adjacent port on its NetMod automatically becomes an inline interface as well to complete the pair.

• To configure inline interfaces on an NGIPSv device, you must create the inline pair using adjacent interfaces.

## Configuring Inline Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>feature dependent</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1** Choose Devices > Device Management.

**Step 2** Click the edit icon (✏️) next to the device where you want to configure the interface.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the edit icon (✏️) next to the interface you want to configure.

**Step 4** Click Inline.

**Step 5** If you want to associate the inline interface with a security zone, do one of the following:

  • Choose an existing security zone from the Security Zone drop-down list.
  
  • Choose New to add a new security zone; see Creating Security Zone Objects, on page 332.

**Step 6** Choose an existing inline set from the Inline Set drop-down list, or choose New to add a new inline set.

  **Note** If you add a new inline set, you must configure it after you set up the inline interface; see Adding Inline Sets, on page 397.

**Step 7** Check the Enabled check box.

If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.

**Step 8** 7000 & 8000 Series only: From the Mode drop-down list, designate the link mode, or choose Autonegotiation to specify that the interface is configured to automatically negotiate speed and duplex settings.

Mode settings are available only for copper interfaces.

Interfaces on 8000 Series appliances do not support half-duplex options.

**Step 9** 7000 & 8000 Series only: From the MDI/MDIX drop-down list, designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX.

MDI/MDIX settings are available only for copper interfaces.
By default, MDI/MDIX is set to **Auto-MDIX**, which automatically handles switching between MDI and MDIX to attain link.

**Step 10**

Click **Save**.

---

**What to do next**

- Deploy configuration changes; see *Deploy Configuration Changes, on page 277.*

---

## Inline Sets on the Firepower System

Before you can use inline interfaces in an inline deployment, you must configure inline sets and assign inline interface pairs to them. An inline set is a grouping of one or more inline interface pairs on a device; an inline interface pair can belong to only one inline set at a time.

The **Inline Sets** tab of the Device Management page displays a list of all inline sets you have configured on a device.

You can add inline sets from the **Inline Sets** tab of the Device Management page or you can add inline sets as you configure inline interfaces.

You can **assign only** inline interface pairs to an inline set. If you want to create an inline set before you configure the inline interfaces on your managed devices, you can create an empty inline set and add interfaces to it later. You can use alphanumeric characters and spaces when you type a name for an inline set.

---

**Note**

Create inline sets before you add security zones for the interfaces in the inline set; otherwise security zones are removed and you must add them again.

---

**Name**

The name of the inline set.

---

**Interfaces**

A list of all inline interface pairs assigned to the inline set. A pair is not available when you disable either interface in the pair from the Interfaces tab.

---

**MTU**

The maximum transmission unit for the inline set. The range of MTU values can vary depending on the model of the managed device and the interface type.

---

**Caution**

Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See *Snort® Restart Traffic Behavior, on page 280* for more information.
Failsafe

Allows traffic to bypass detection and continue through the device. Managed devices monitor internal traffic buffers and bypass detection if those buffers are full.

Bypass Mode

Firepower 7000 or 8000 Series only: The configured bypass mode of the inline set. This setting determines how the relays in the inline interfaces respond when an interface fails. The bypass mode allows traffic to continue to pass through the interfaces. The non-bypass mode blocks traffic.

Caution

In bypass mode, you may lose a few packets when you reboot the appliance. You cannot configure bypass mode for inline sets on 7000 or 8000 Series devices in a high-availability pair, inline sets on an NGIPSv device, for non-bypass NetMods on 8000 Series devices, or for SFP modules on Firepower 7115 or 7125 devices.

Related Topics

MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
Snort® Restart Scenarios, on page 279

Viewing Inline Sets

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Choose Devices > Device Management.

**Step 2** Click the edit icon ( ) next to the device where you want to view the inline sets.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Inline Sets tab.

Adding Inline Sets

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>feature dependent</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>
Procedure

Step 1 Choose **Devices > Device Management**.

Step 2 Click the edit icon (📝) next to the device where you want to add the inline set.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3 Click the **Inline Sets** tab.

Step 4 Click **Add Inline Set**.

Step 5 Enter a **Name**.

Step 6 Next to **Interfaces**, choose one or more inline interface pairs, then click the add selected icon (➕). To add all interface pairs to the inline set, click the add all icon (➕).  

**Tip** To remove inline interfaces from the inline set, choose one or more inline interface pairs and click the remove selected icon (➖). To remove all interface pairs from the inline set, click the remove all icon (➖). Disabling either interface in a pair from the **Interfaces** tab also removes the pair.

Step 7 Enter a maximum transmission unit (MTU) in the **MTU** field.

The range of MTU values can vary depending on the model of the managed device and the interface type.

**Caution** Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See **Snort® Restart Traffic Behavior**, on page 280 for more information.

Step 8 If you want to specify that traffic is allowed to bypass detection and continue through the device, choose **Failsafe**.

Managed devices monitor internal traffic buffers and bypass detection if those buffers are full.

Step 9 7000 and 8000 Series only: Specify the bypass mode:

- Click **Bypass** to allow traffic to continue to pass through the interfaces.
- Click **Non-Bypass** to block traffic.

**Note** You cannot configure bypass mode for inline sets on 7000 or 8000 Series devices in high-availability pairs, inline sets on an NGIPSv device, for non-bypass NetMods on 8000 Series devices, or for SFP modules on Firepower 7115 or 7125 devices.

Step 10 Optionally, configure advanced settings; see **Advanced Inline Set Options**, on page 399.

Step 11 Click **OK**.

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.
Advanced Inline Set Options

There are a number of advanced options you may consider as you configure inline sets.

**Tap Mode**

Tap mode is available on 7000 and 8000 Series devices when you create an inline or inline with fail-open interface set.

With tap mode, the device is deployed inline, but instead of the packet flow passing through the device, a copy of each packet is sent to the device and the network traffic flow is undisturbed. Because you are working with copies of packets rather than the packets themselves, rules that you set to drop and rules that use the replace keyword do not affect the packet stream. However, rules of these types do generate intrusion events when they are triggered, and the table view of intrusion events indicates that the triggering packets would have dropped in an inline deployment.

There are benefits to using tap mode with devices that are deployed inline. For example, you can set up the cabling between the device and the network as if the device were inline and analyze the kinds of intrusion events the device generates. Based on the results, you can modify your intrusion policy and add the drop rules that best protect your network without impacting its efficiency. When you are ready to deploy the device inline, you can disable tap mode and begin dropping suspicious traffic without having to reconfigure the cabling between the device and the network.

Note that you cannot enable this option and strict TCP enforcement on the same inline set.

**Propagate Link State**

Link state propagation is not supported on virtual devices.

Link state propagation is a feature for inline sets configured in bypass mode and non-bypass mode so both pairs of an inline set track state. Link state propagation is available for both copper and fiber configurable bypass interfaces.

Link state propagation automatically brings down the second interface in the inline interface pair when one of the interfaces in an inline set goes down. When the downed interface comes back up, the second interface automatically comes back up, also. In other words, if the link state of one interface changes, the appliance senses the change and updates the link state of the other interface to match it. Note that appliances require up to 4 seconds to propagate link state changes.

Link state propagation is especially useful in resilient network environments where routers are configured to reroute traffic automatically around network devices that are in a failure state.

Note that only 7000 and 8000 Series devices support link state propagation.

You cannot disable link state propagation for inline sets configured on 7000 and 8000 Series devices in high-availability pairs.
Transparent Inline Mode

Transparent Inline Mode option allows the device to act as a “bump in the wire” and means that the device forwards all the network traffic it sees, regardless of its source and destination. Note that you cannot disable this option on 7000 and 8000 Series devices.

Strict TCP Enforcement

Note

Strict TCP enforcement is not supported on virtual devices.

To maximize TCP security, you can enable strict enforcement, which blocks connections where the three-way handshake was not completed. Strict enforcement also blocks:

- non-SYN TCP packets for connections where the three-way handshake was not completed
- non-SYN/RST packets from the initiator on a TCP connection before the responder sends the SYN-ACK
- non-SYN-ACK/RST packets from the responder on a TCP connection after the SYN but before the session is established
- SYN packets on an established TCP connection from either the initiator or the responder

Note that only 7000 and 8000 Series devices support this option. In addition, you cannot enable this option and tap mode on the same inline set.

Configuring Advanced Inline Set Options

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>feature dependent</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Choose Devices > Device Management.

Step 2 Click the edit icon (-pencil) next to the device where you want to edit the inline set.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3 Click the Inline Sets tab.

Step 4 Click the edit icon (-pencil) next to the inline set you want to edit.

Step 5 Click the Advanced tab.

Step 6 Configure options as described in Advanced Inline Set Options, on page 399.

Note Link state propagation and strict TCP enforcement are not supported on virtual devices.
Deleting Inline Sets

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

## Deleting Inline Sets

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

When you delete an inline set, any inline interfaces assigned to the set become available for inclusion in another set. The interfaces are not deleted.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device where you want to delete the inline set, click the edit icon (-pencil).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Inline Sets tab.

**Step 4** Next to the inline set you want to delete, click the delete icon (Trash).

**Step 5** When prompted, confirm that you want to delete the inline set.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.
PART VI

High Availability and Scalability

- 7000 and 8000 Series Device High Availability, on page 405
- 8000 Series Device Stacking, on page 421
CHAPTER 21

7000 and 8000 Series Device High Availability

The following topics describe how to configure high availability for Firepower 7000 Series and 8000 Series devices in the Firepower System:

- About 7000 and 8000 Series Device High Availability, on page 405
- Establishing Device High Availability, on page 409
- Editing Device High Availability, on page 410
- Configuring Individual Devices in a High-Availability Pair, on page 411
- Configuring Individual Device Stacks in a High-Availability Pair, on page 411
- Configuring Interfaces on a Device in a High-Availability Pair, on page 412
- Switching the Active Peer in a Device High-Availability Pair, on page 413
- Placing a High-Availability Peer into Maintenance Mode, on page 413
- Replacing a Device in a Stack in a High-Availability Pair, on page 414
- Device High Availability State Sharing, on page 414
- Device High Availability State Sharing Statistics for Troubleshooting, on page 417
- Separating Device High-Availability Pairs, on page 420

About 7000 and 8000 Series Device High Availability

With 7000 and 8000 Series device high availability, you can establish redundancy of networking functionality and configuration data between two peer devices or two peer device stacks.

You achieve configuration redundancy by configuring two peer devices or two peer device stacks into a high-availability pair to act as a single logical system for policy deploys, system updates, and registration. The system automatically synchronizes other configuration data.

---

Note

Static routes, non-SFRP IP addresses, and routing priorities are not synchronized between the peer devices or peer device stacks. Each peer device or peer device stack maintains its own routing intelligence.

---

Related Topics

- SFRP
- Advanced Virtual Switch Settings, on page 547
Device High Availability Requirements

Before you can configure a 7000 and 8000 Series device high-availability pair, the following must be true:

- You can only pair single devices with single devices or device stacks with device stacks.
- Both devices or device stacks must have normal health status, be running the same software, and have the same licenses. See Using the Health Monitor, on page 234 for more information. In particular, the devices cannot have hardware failures that would cause them to enter maintenance mode and trigger a failover.

Note
After you pair the devices, you cannot change the license options for individual paired devices, but you can change the license for the entire high-availability pair.

- Interfaces must be configured on each device or each primary device in a stack.
- Both devices or the primary members of the device stacks must be the same model and have identical copper or fiber interfaces.
- Device stacks must have identical hardware configurations, except for an installed malware storage pack. For example, you can pair a Firepower 8290 with another 8290. None, one, or all devices in either stack might have a malware storage pack.

Caution
Do not attempt to install a hard drive that was not supplied by Cisco in your device. Installing an unsupported hard drive may damage the device. Malware storage pack kits are available for purchase only from Cisco, and are for use only with 8000 Series devices. Contact Support if you require assistance with the malware storage pack. See the Firepower System Malware Storage Pack Guide for more information.

- If the devices are targeted by NAT policies, both peers must have the same NAT policy.
- In a multidomain deployment, you can only establish 7000 or 8000 Series device high-availability or device stacks within a leaf domain.

Note
After failover and recovery, SFRP preempts to the master node.

Device High Availability Failover and Maintenance Mode

With a 7000 and 8000 Series device high availability, the system fails over either manually or automatically. You manually trigger failover by placing one of the paired devices or stacks in maintenance mode.

Automatic failover occurs after the health of the active device or stack becomes compromised, during a system update, or after a user with Administrator privileges shuts down the device. Automatic failover also occurs after an active device or device stack experiences NMSB failure, NFE failure, hardware failure, firmware
failure, critical process failure, a disk full condition, or link failure between two stacked devices. If the health of the backup device or stack becomes similarly compromised, the system does not fail over and enters a degraded state. The system also does not fail over when one of the devices or device stacks is in maintenance mode. Note that disconnecting the stacking cable from an active stack sends that stack into maintenance mode. Shutting down the secondary device in an active stack also sends that stack into maintenance mode.

**Note**

If the active member of the high-availability pair goes into maintenance mode and the active role fails over to the other pair member, when the original active pair member is restored to normal operation it does not automatically reclaim the active role.

---

**Configuration Deployment and Upgrade Behavior for High-Availability Pairs**

This topic describes upgrade and deployment behavior for 7000 and 8000 Series devices (and stacks) in high availability pairs.

**Behavior During Deploy**

You deploy configuration changes to the members of a high availability pair at the same time. Deploy either succeeds or fails for both peers. The Firepower Management Center deploys to the active device; if that succeeds then changes are deployed to the standby.

**Caution**

When you deploy, resource demands may result in a small number of packets dropping without inspection. Additionally, deploying some configurations restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 and Configurations that Restart the Snort Process When Deployed or Activated, on page 281.

**Behavior During Upgrade**

You should not experience interruptions in traffic flow or inspection while upgrading devices (or device stacks) in high availability pairs. To ensure continuity of operations, they upgrade one at a time. Devices operate in maintenance mode while they upgrade.

Which peer upgrades first depends on your deployment:

- Routed or switched—Standby upgrades first. The devices switch roles, then the new standby upgrades. When the upgrade completes, the devices' roles remain switched. If you want to preserve the active/standby roles, manually switch the roles before you upgrade. That way, the upgrade process switches them back.

- Access control only—Active upgrades first. When the upgrade completes, the active and standby maintain their old roles.

**Deployment Types and Device High Availability**

You determine how to configure 7000 or 8000 Series device high availability depending on your Firepower System deployment: passive, inline, routed, or switched. You can also deploy your system in multiple roles at once. Of the four deployment types, only passive deployments require that you configure devices or stacks...
using high availability to provide redundancy. You can establish network redundancy for the other deployment types with or without device high availability. For a brief overview on high availability in each deployment type, see the sections below.

**Note**

You can achieve Layer 3 redundancy without using device high availability by using the Cisco Redundancy Protocol (SFRP). SFRP allows devices to act as redundant gateways for specified IP addresses. With network redundancy, you configure two devices or stacks to provide identical network connections, ensuring connectivity for other hosts on the network.

---

**Passive Deployment Redundancy**

Passive interfaces are generally connected to tap ports on central switches, which allows them to analyze all of the traffic flowing across the switch. If multiple devices are connected to the same tap feed, the system generates events from each of the devices. When configured in a high-availability pair, devices act as either active or backup, which allows the system to analyze traffic even in the event of a system failure while also preventing duplicate events.

**Inline Deployment Redundancy**

Because an inline set has no control over the routing of the packets being passed through it, it must always be active in a deployment. Therefore, redundancy relies on external systems to route traffic correctly. You can configure redundant inline sets with or without 7000 or 8000 Series device high availability.

To deploy redundant inline sets, you configure the network topology so that it allows traffic to pass through only one of the inline sets while preventing circular routing. If one of the inline sets fails, the surrounding network infrastructure detects the loss of connectivity to the gateway address and adjusts the routes to send traffic through the redundant set.

**Routed Deployment Redundancy**

Hosts in an IP network must use a well-known gateway address to send traffic to different networks. Establishing redundancy in a routed deployment requires that routed interfaces share the gateway addresses so that only one interface handles traffic for that address at any given time. To accomplish this, you must maintain an equal number of IP addresses on a virtual router. One interface advertises the address. If that interface goes down, the backup interface begins advertising the address.

In devices that are not members of a high-availability pair, you use SFRP to establish redundancy by configuring gateway IP addresses shared between multiple routed interfaces. You can configure SFRP with or without 7000 or 8000 Series device high availability. You can also establish redundancy using dynamic routing such as OSPF or RIP.

**Switched Deployment Redundancy**

You establish redundancy in a switched deployment using the Spanning Tree Protocol (STP), one of the advanced virtual switch settings. STP is a protocol that manages the topology of bridged networks. It is specifically designed to allow redundant links to provide automatic backup for switched interfaces without configuring backup links. Devices in a switched deployment rely on STP to manage traffic between redundant interfaces. Two devices connected to the same broadcast network receive traffic based on the topology calculated by STP.
Cisco strongly recommends that you enable STP when configuring a virtual switch that you plan to deploy in a 7000 or 8000 Series device high-availability pair.

**Device High Availability Configuration**

When establishing 7000 or 8000 Series device high availability, you designate one of the devices or stacks as active and the other as backup. The system applies a merged configuration to the paired devices. If there is a conflict, the system applies the configuration from the device or stack you designated as active.

After you pair the devices, you cannot change the license options for individual paired devices, but you can change the license for the entire high-availability pair. If there are interface attributes that need to be set on switched interfaces or routed interfaces, the system establishes the high-availability pair, but sets it to a pending status. After you configure the necessary attributes, the system completes the high-availability pair and sets it to a normal status.

After you establish a high-availability pair, the system treats the peer devices or stacks as a single device on the Device Management page. Device high-availability pairs display the High Availability icon ( ) in the appliance list. Any configuration changes you make are synchronized between the paired devices. The Device Management page displays which device or stack in the high-availability pair is active, which changes after manual or automatic failover.

Removing registration of a device high-availability pair from a Firepower Management Center removes registration from both devices or stacks. You remove a device high-availability pair from the Firepower Management Center as you would an individual managed device.

You can then register the high-availability pair on another Firepower Management Center. To register single devices from a high-availability pair, you add remote management to the active device in the pair and then add that device to the Firepower Management Center, which adds the whole pair. To register stacked devices in a high-availability pair, you add remote management to the primary device of the either stack and then add that device to the Firepower Management Center, which adds the whole pair.

After you establish a device high-availability pair, you should configure a high-availability link interface.

---

If you plan to set up dynamic NAT, HA state sharing, or VPN using the devices in the high-availability pair, you must configure a high-availability link interface. For more information, see Configuring HA Link Interfaces, on page 385.

---

### Establishing Device High Availability

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>
When establishing a 7000 & 8000 Series device high-availability pair, you designate one of the devices or stacks as active and the other as backup. The system applies a merged configuration to the paired devices. If there is a conflict, the system applies the configuration from the device or stack you designated as active.

In a multidomain deployment, devices in a high-availability pair must belong to the same domain.

Before you begin

- Confirm that all requirements are met; see Device High Availability Requirements, on page 406.

Procedure

Step 1 Choose Devices > Device Management.

Step 2 From the Add drop-down menu, choose Add High Availability.

Step 3 Enter a Name.

Step 4 Assign roles for the devices or stacks:

  a) Choose the Active device or stack for the high-availability pair.
  b) Choose the Backup device or stack for the high-availability pair.

Step 5 Click Add. The process takes a few minutes as the system synchronizes data.

What to do next

Create an HA Link interface on each of the devices in the high-availability pair if you plan to set up HA state sharing, dynamic NAT, or VPN with the devices. For more information on HA link interfaces, see Configuring HA Link Interfaces, on page 385.

**Editing Device High Availability**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
</tbody>
</table>

After you establish a 7000 or 8000 Series device high-availability pair, most changes you make to the device configuration also change the configuration of the whole high-availability pair.

You can view the status of the high-availability pair by hovering your pointer over the status icon in the General section. You can also view which device or stack is the active peer and backup peer in the pair.

Procedure

Step 1 Choose Devices > Device Management.

Step 2 Next to the device high availability pair where you want to edit the configuration, click the edit icon (✏). In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.
Configuring Individual Devices in a High-Availability Pair

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

After you establish a 7000 or 8000 Series device high-availability pair, you can still configure some attributes for each device within the pair. You can make changes to a paired device just as you would to a single device.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device high-availability pair where you want to edit the configuration, click the edit icon (🛠️).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Devices tab.

**Step 4** From the Selected Device drop-down list, choose the device you want to modify.

**Step 5** Use the sections on the Devices page to make changes to the individual paired device as you would a single device.

Configuring Individual Device Stacks in a High-Availability Pair

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>Firepower 8140, Firepower 8200 family, Firepower 8300 family</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

After you configure stacked 8000 Series devices into a high-availability pair, the system limits the stack attributes that you can edit. You can edit the name of a stack in a paired stack. In addition, you can edit the network configuration of the stack, as described in Configuring Interfaces on a Device in a High-Availability Pair, on page 412.

**Procedure**

**Step 1** Choose Devices > Device Management.
Configuring Interfaces on a Device in a High-Availability Pair

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can configure interfaces on individual devices in a 7000 or 8000 Series device high-availability pair. However, you must also configure an equivalent interface on the peer device in the pair. For paired stacks, you configure identical interfaces on the primary devices of the stacks. When you configure virtual routers, you select the stack where you want to configure the routers.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device high-availability pair where you want to configure interfaces, click the edit icon ( Modiﬁer Key ).
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Interfaces tab.

**Step 4** From the Selected Device drop-down list, choose the device you want to modify.

**Step 5** Configure interfaces as you would on an individual device.

**Related Topics**

- Virtual Router Configuration, on page 559
Switching the Active Peer in a Device High-Availability Pair

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

After you establish a 7000 or 8000 Series device high-availability pair, you can manually switch the active and backup peer devices or stacks.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device high-availability pair where you want to change the active peer, click the Switch Active Peer icon ( ![Switch Active Peer Icon](image)).

**Step 3** You can:

- Click Yes to immediately make the backup peer the active peer in the high-availability pair.
- Click No to cancel and return to the Device Management page.

Placing a High-Availability Peer into Maintenance Mode

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

After you establish a 7000 or 8000 Series device high-availability pair, you can manually trigger failover by placing one of the peers into maintenance mode to perform maintenance on the devices. In maintenance mode, the system administratively takes down all interfaces except for the management interface. After maintenance is completed, you can re-enable the peer to resume normal operation.

**Note**

You should not place both peers in a high-availability pair into maintenance mode at the same time. Doing so will prevent that pair from inspecting traffic.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the peer you want to place in maintenance mode, click the toggle maintenance mode icon ( ![Toggle Maintenance Mode Icon](image)).
Replacing a Device in a Stack in a High-Availability Pair

After you place a stack that is a member of a high-availability pair into maintenance mode, you can replace a secondary device in the stack for another device. You can only select devices that are not currently stacked or paired. The new device must follow the same guidelines for establishing a device stack.

Procedure

Step 1  Choose **Devices > Device Management**.
Step 2  Next to the stack member you want to place into maintenance mode, click the toggle maintenance mode icon (○).
Step 3  Click **Yes** to confirm maintenance mode.
Step 4  Click the replace device icon (○).
Step 5  Choose the **Replacement Device** from the drop-down list.
Step 6  Click **Replace** to replace the device.
Step 7  Click the toggle maintenance mode icon (○) again to bring the stack immediately out of maintenance mode.

**Note**  You do not need to re-deploy the device configuration.

Device High Availability State Sharing

Device high availability state sharing allows devices or stacks in high-availability pairs to synchronize as much state as necessary, so that if either device or stack fails, the other peer can take over with no interruption to traffic flow. Without state sharing, the following features may not fail over properly:

- **Strict TCP enforcement**
- **Unidirectional access control rules**
• Blocking persistence

Note, however, that enabling state sharing slows system performance.

You must configure and enable HA link interfaces on both devices or the primary stacked devices in the high-availability pair before you can configure high availability state sharing. Firepower 82xx Family and 83xx Family devices require a 10G HA link, while other model devices require a 1G HA link.

You must disable state sharing before you can modify the HA link interfaces.

---

**Note**

If paired devices fail over, the system terminates all existing SSL-encrypted sessions on the active device. Even if you establish high availability state sharing, these sessions must be renegotiated on the backup device. If the server establishing the SSL session supports session reuse and the backup device does not have the SSL session ID, it cannot renegotiate the session.

---

**Strict TCP Enforcement**

When you enable strict TCP enforcement for a domain, the system drops any packets that are out of order on TCP sessions. For example, the system drops non-SYN packets received on an unestablished connection. With state sharing, devices in the high-availability pair allow TCP sessions to continue after failover without having to reestablish the connection, even if strict TCP enforcement is enabled. You can enable strict TCP enforcement on inline sets, virtual routers, and virtual switches.

---

**Unidirectional Access Control Rules**

If you have configured unidirectional access control rules, network traffic may match a different access control rule than intended when the system reevaluates a connection midstream after failover. For example, consider if you have a policy containing the following two access control rules:

```
Rule 1: Allow from 192.168.1.0/24 to 192.168.2.0/24
Rule 2: Block all
```

Without state sharing, if an allowed connection from 192.168.1.1 to 192.168.2.1 is still active following a failover and the next packet is seen as a response packet, the system denies the connection. With state sharing, a midstream pickup would match the existing connection and continue to be allowed.

---

**Blocking Persistence**

While many connections are blocked on the first packet based on access control rules or other factors, there are cases where the system allows some number of packets through before determining that the connection should be blocked. With state sharing, the system immediately blocks the connection on the peer device or stack as well.

When establishing state sharing for a high-availability pair, you can configure the following options:

---

**Enabled**

Click the check box to enable state sharing. Clear the check box to disable state sharing.
Minimum Flow Lifetime

Specify the minimum time (in milliseconds) for a session before the system sends any synchronization messages for it. You can use any integer from 0 to 65535. The system does not synchronize any sessions that have not met the minimum flow lifetime, and the system synchronizes only when a packet is received for the connection.

Minimum Sync. Interval

Specify the minimum time (in milliseconds) between update messages for a session. You can use any integer from 0 to 65535. The minimum synchronization interval prevents synchronization messages for a given connection from being sent more frequently than the configured value after the connection reaches the minimum lifetime.

Maximum HTTP URL Length

Specify the maximum characters for the URL the system synchronizes between the paired devices. You may use any integer from 0 to 225.

Related Topics

Configuring HA Link Interfaces, on page 385

Establishing Device High-Availability State Sharing

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
</tbody>
</table>

Device high-availability state sharing allows 7000 or 8000 Series devices or stacks in high-availability pairs to synchronize as much state as necessary, so that if either device or stack fails, the other peer can take over with no interruption to traffic flow.

Caution

Modifying a high-availability state sharing option on a 7000 or 8000 Series device restarts the Snort process on the primary and secondary devices, temporarily interrupting traffic inspection on both devices. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Procedure

Step 1 Configure HA link interfaces for each device in the device high-availability pair; see Configuring HA Link Interfaces, on page 385.

Step 2 Choose Devices > Device Management.

Step 3 Next to the device high-availability pair you want to edit, click the edit icon (✏).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 4 In the State Sharing section, click the edit icon (✏).
Step 5 Decrease the state sharing values to improve paired peer readiness, or increase the values to allow better performance.

Note Cisco recommends that you use the default values, unless your deployment presents a good reason to change them.

Step 6 Click OK to save your changes.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Configuring HA Link Interfaces, on page 385
Snort® Restart Scenarios, on page 279

Device High Availability State Sharing Statistics for Troubleshooting

The sections below describe the statistics you can view for each device and how you can use them to troubleshoot your state sharing configuration for 7000 and 8000 Series device high-availability pairs.

Messages Received (Unicast)

Messages received are the number of high availability synchronization messages received from the paired peer.

The value should be close to the number of messages sent by the peer. During active use, the values may not match, but should be close. If traffic stops, the values should become stable and the messages received will match the messages sent.

For troubleshooting, you should view both the messages received and the messages sent, compare the rate of increase, and make sure the values are close. The sent value on each peer should be incrementing at approximately the same rate as the received value on the opposite peer.

Contact Support if the received messages stop incrementing or increment slower than the messages sent by the peer.

Packets Received

The system batches multiple messages into single packets in order to decrease overhead. The Packets Received counter displays the total number of these data packets, as well as other control packets that have been received by a device.

The value should be close to the number of packets sent by the peer device. During active use, the values may not match, but should be close. Because the number of messages received should be close and incrementing at the same rate as the number of messages sent by the peer, the number of packets received should have the same behavior.
For troubleshooting, you should view both the packets received and the messages sent, compare the rate of increase, and make sure the values are increasing at the same rate. If the sent value on the paired peer is incrementing, the received value on the device should also increase at the same rate.

Contact Support if the received packets stop incrementing or increment slower than the messages sent by the peer.

Total Bytes Received
Total bytes received are the number of bytes that make up the packets received by the peer.

The value should be close to the number of bytes sent by the other peer. During active use, the values may not match, but should be close.

For troubleshooting, you should view both the total bytes received and the messages sent, compare the rate of increase, and make sure the values are increasing at the same rate. If the sent value on the paired peer is incrementing, the received value on the device should also increase at the same rate.

Contact Support if the received bytes stop incrementing or increment slower than the messages sent by the peer.

Protocol Bytes Received
Protocol bytes received are the number of bytes of protocol overhead received, which includes everything but the payload of session state synchronization messages.

The value should be close to the number of bytes sent by the peer. During active use, the values may not match, but should be close.

For troubleshooting, you should view the total bytes received to discover how much actual state data is being shared in comparison to protocol data. If the protocol data is a large percentage of the data being sent, you can adjust the minimum sync interval.

Contact Support if the protocol bytes received increment at a similar rate to the total bytes received. Protocol bytes received should be minimal in relation to the total bytes received.

Messages Sent
Messages sent are the number of high availability synchronization messages sent to the paired peer.

This data is useful in comparison to the number of messages received. During active use, the values may not match, but should be close.

For troubleshooting, you should view both the messages received and the messages sent, compare the rate of increase, and make sure the values are close.

Contact Support if the messages sent increment at a similar rate to the total bytes received.

Bytes Sent
Bytes sent are the total number of bytes sent that make up the high availability synchronization messages sent to the peer.

This data are useful in comparison to the number of messages received. During active use, the values may not match, but should be close. The number of bytes received on the peer should be close to, but not more than this value.

Contact Support if the total bytes received is not incrementing at about the same rate as the bytes sent.
**Tx Errors**

Tx errors are the number of memory allocation failures the system encounters when trying to allocate space for messages to be sent to the paired peer.

This value should be zero at all times on both peers. Contact Support if this number is not zero or if the number steadily increases, which indicates the system has encountered an error where it cannot allocate memory.

**Tx Overruns**

Tx overruns are the number of times the system attempts and fails to place a message into the transit queue.

This value should be zero at all times on both peers. When the value is not zero or is steadily increasing, it indicates that the system is sharing too much data across the HA link that cannot be sent quickly enough.

You should increase the HA link MTU if it was previously set below the default value (9918 or 9922). You can change the minimum flow lifetime and minimum synchronization interval settings to reduce the amount of data shared across the HA link to prevent the number from incrementing.

Contact Support if this value persists or continues to increase.

**Recent Logs**

The system log displays the most recent high availability synchronization messages. The log should not display any ERROR or WARN messages. It should remain comparable between the peers, such as the same number of sockets being connected.

However, the data displayed may be opposite in some instances, for example, one peer reports that it received a connection from the other peer and references different IP addresses. The log provides a comprehensive view of the high availability state sharing connection, and any errors within the connection.

Contact Support if the log displays an ERROR or WARN message, or any message that does not appear to be purely informational.

### Viewing Device High Availability State Sharing Statistics

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

After you establish state sharing, you can view the following information about the configuration in the State Sharing section of the High Availability page:

- The HA link interface that is being used and its current link state
- Detailed synchronization statistics for troubleshooting issues

The state sharing statistics are primarily counters for different aspects of the high availability synchronization traffic sent and received, along with some other error counters. In addition, you can view the latest system logs for each device in the high-availability pair.
Procedure

Step 1 Choose **Devices > Device Management**.

Step 2 Next to the device high-availability pair you want to edit, click the edit icon (📝).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3 In the **State Sharing** section, click the view statistics icon (📊).

Step 4 Choose a **Device** to view if your high-availability pair is composed of device stacks.

Step 5 You can:

- Click **Refresh** to update the statistics.
- Click **View** to view the latest data log for each device in the high-availability pair.

### Separating Device High-Availability Pairs

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

When you separate, or "break," a 7000 or 8000 Series device high-availability pair:

- The active peer (device or stack) retains full deployment functionality
- The backup peer (device or stack) loses its interface configurations and fails over to the active peer, unless you choose to leave the interface configurations active, in which case the backup peer resumes normal operation.
- The backup peer always loses the configuration of passive interfaces.
- Any peer in maintenance mode resumes normal operation.

Procedure

Step 1 Choose **Devices > Device Management**.

Step 2 Next to the high-availability pair you want to break, click the Break HA icon (✂️).

Step 3 Optionally, check the check box to remove the interface configurations on the backup peer.

This step administratively takes down all interfaces except for the management interface.

Step 4 Click **Yes**.
8000 Series Device Stacking

The following topics describe how to work with Firepower 8000 Series device stacks in the Firepower System:

- About Device Stacks, on page 421
- Device Stack Configuration, on page 423
- Establishing Device Stacks, on page 424
- Editing Device Stacks, on page 425
- Replacing a Device in a Stack, on page 425
- Replacing a Device in a Stack in a High-Availability Pair, on page 426
- Configuring Individual Devices in a Stack, on page 427
- Configuring Interfaces on a Stacked Device, on page 427
- Separating Stacked Devices, on page 428
- Replacing a Device in a Stack, on page 429

About Device Stacks

You can increase the amount of traffic inspected on a network segment by using devices in a stacked configuration. For each stacked configuration, all devices in the stack must have the same hardware. However, none, some, or all devices might have an installed malware storage pack. The devices must also be from the same device family based on the following stacked configurations:

The stacked configuration is supported for Firepower 8140, Firepower 8200 family, Firepower 8300 family devices.

For the 81xx Family:
- two Firepower 8140s

For the 82xx Family:
- up to four Firepower 8250s
- a Firepower 8260 (a primary device and a secondary device)
- a Firepower 8270 (a primary device with 40G capacity and two secondary devices)
- a Firepower 8290 (a primary device with 40G capacity and three secondary devices)
For the 83xx Family:

- up to four Firepower 8350s
- up to four AMP8350s
- a Firepower 8360 (a primary device with 40G capacity and a secondary device)
- an AMP8360 (a primary device with 40G capacity and a secondary device)
- a Firepower 8370 (a primary device with 40G capacity and two secondary devices)
- an AMP8370 (a primary device with 40G capacity and two secondary devices)
- a Firepower 8390 (a primary device with 40G capacity and three secondary devices)
- an AMP8390 (a primary device with 40G capacity and three secondary devices)

For more information about stacked configurations, see the *Cisco Firepower 8000 Series Getting Started Guide*. For more information about the malware storage pack, see the *Firepower System Malware Storage Pack Guide*. *Firepower System Malware Storage Pack Guide*.

---

**Caution**

Do not attempt to install a hard drive that was not supplied by Cisco in your device. Installing an unsupported hard drive may damage the device. Malware storage pack kits are available for purchase only from Cisco, and are for use only with 8000 Series devices. Contact Support if you require assistance with the malware storage pack. See the *Firepower System Malware Storage Pack Guide* for more information.

---

When you establish a stacked configuration, you combine the resources of each stacked device into a single, shared configuration.

You designate one device as the primary device, where you configure the interfaces for the entire stack. You designate the other devices as secondary. Secondary devices must not be currently sensing any traffic and must not have link on any interface.

Connect the primary device to the network segment you want to analyze in the same way you would configure a single device. Connect the secondary devices to the primary device using the stacked device cabling instructions found in the *Cisco Firepower 8000 Series Getting Started Guide*.

All devices in the stacked configuration must have the same hardware, run the same software version, and have the same licenses. If the devices are targeted by NAT policies, both the primary and secondary device must have the same NAT policy. You must deploy updates to the entire stack from the Firepower Management Center. If an update fails on one or more devices in the stack, the stack enters a mixed-version state. You cannot deploy policies to or update a stack in a mixed-version state. To correct this state, you can break the stack or remove individual devices with different versions, update the individual devices, then reestablish the stacked configuration. After you stack the devices, you can change the licenses only for the entire stack at once.

After you establish the stacked configuration, the devices act like a single, shared configuration. If the primary device fails, no traffic is passed to the secondary devices. Health alerts are generated indicating that the stacking heartbeat has failed on the secondary devices.

If the secondary device in a stack fails, inline sets with configurable bypass enabled go into bypass mode on the primary device. For all other configurations, the system continues to load balance traffic to the failed secondary device. In either case, a health alert is generated to indicate loss of link.
You can use a device stack as you would a single device in your deployment, with a few exceptions. If you have 7000 or 8000 Series devices in a high-availability pair, you cannot stack a device high-availability pair or a device in a high-availability pair. You also cannot configure NAT on a device stack.

**Note**

If you use eStream to stream event data from stacked devices to an external client application, collect the data from each device and ensure that you configure each device identically. The eStream settings are not automatically synchronized between stacked devices.

In a multidomain deployment, you can only stack devices that belong to the same domain.

**Related Topics**

[About Health Monitoring](#), on page 219

### Device Stack Configuration

You can increase the amount of traffic inspected on a network segment by stacking two Firepower 8140 devices, up to four Firepower 8250s, a Firepower 8260, a Firepower 8270, a Firepower 8290, up to four Firepower 8350s, a Firepower 8360, a Firepower 8370, or a Firepower 8390 and using their combined resources in a single, shared, configuration. If you have 7000 or 8000 Series devices in a high-availability pair, you cannot stack a device high-availability pair or a device in a high-availability pair. However, you can configure two device stacks into a high-availability pair.

After you establish a device stack, the system treats the devices as a single device on the Device Management page. Device stacks display the stack icon (stack) in the appliance list.

Removing registration of a device stack from a Firepower Management Center also removes registration from both devices. You delete stacked devices from the Firepower Management Center as you would a single managed device; you can then register the stack on another Firepower Management Center. You only need to register one of the stacked devices on the new Firepower Management Center for the entire stack to appear.

After you establish the device stack, you cannot change which devices are primary or secondary unless you break and reestablish the stack. However, you can:

- add secondary devices to an existing stack of two or three Firepower 8250s, a Firepower 8260, or a Firepower 8270 up to the limit of four Firepower 8250s in a stack
- add secondary devices to an existing stack of two or three Firepower 8350s, a Firepower 8360, or a Firepower 8370 up to the limit of four Firepower 8350s in a stack

For additional devices, the primary device in the stack must have the necessary stacking NetMods for additional cabled devices. For example, if you have a Firepower 8260 where the primary only has a single stacking NetMod, you cannot add another secondary device to this stack. You add secondary devices to an existing stack in the same manner that you initially establish a stacked device configuration.
Establishing Device Stacks

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Firepower 8140, 8200 family, 8300 family</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

All devices in a stack must be of the same hardware model (for example, a Firepower 8140 with another 8140). You can stack a total of four devices (one primary device and up to three secondary devices) in the 8200 family and in the 8300 family.

In a multidomain deployment, all devices in the stack must belong to the same domain.

Before you begin

- Decide which unit will be the primary device.
- Confirm that the units are cabled properly before designating the primary/secondary relationship. For information about cabling, see the Cisco Firepower 8000 Series Getting Started Guide.

Procedure

**Step 1** Choose Devices > Device Management.

**Step 2** From the Add drop-down menu, choose Add Stack.

**Step 3** From the Primary drop-down list, choose the device that you cabled for primary operation.

**Note** If you choose a device that is not cabled as the primary device, you cannot perform the next series of steps.

**Step 4** Enter a Name.

**Step 5** Click Add to choose the devices you want to include in the stack.

**Step 6** From the Slot on Primary Device drop-down list, choose the stacking network module that connects the primary device to the secondary device.

**Step 7** From the Secondary Device drop-down list, choose the device you cabled for secondary operation.

**Step 8** From the Slot on Secondary Device drop-down list, choose the stacking network module that connects the secondary device to the primary device.

**Step 9** Click Add.

**Step 10** Repeat steps 5 through 9 if you are adding secondary devices to an existing stack of Firepower 8250s, a Firepower 8260, a Firepower 8270, an existing stack of Firepower 8350s, a Firepower 8360, or a Firepower 8370.

**Step 11** Click Stack to establish the device stack or to add secondary devices. Note that this process takes a few minutes as the process synchronizes system data.

Related Topics

- About 7000 and 8000 Series Device High Availability, on page 405
Editing Device Stacks

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Firepower 8140, Firepower 8200 family, Firepower 8300 family</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

After you establish a device stack, most changes you make to the device configuration also change the configuration of the entire stack. On the Stack page of the appliance editor, you can make changes to the stack configuration as on the Device page of a single device.

You can change the display name of the stack, enable and disable licenses, view system and health policies, and configure advanced settings.

**Procedure**

**Step 1** Choose Devices > Device Management.
**Step 2** Next to the stacked device where you want to edit the configuration, click the edit icon (✏️).
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.
**Step 3** Use the sections on the Stack page to make changes to the stacked configuration as you would a single device configuration.

### Replacing a Device in a Stack

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>FirePOWER 8140, 8200 family, 8300 family</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

If the Firepower Management Center cannot communicate with the device, you must connect to the device and use CLI commands to separate the stack and unregister the device. For more information, see **stacking disable** and **delete** CLI commands in the relevant chapter: Classic Device CLI Configuration Commands, on page 1839.

To replace a device within a stack:
Procedure

Step 1 Select the stack with the device to replace and break that stack. For more information, see Separating Stacked Devices, on page 428.

Step 2 Unregister the device from the Firepower Management Center. For more information, see Deleting Devices from the Firepower Management Center, on page 180.

Step 3 Register the replacement device to the Firepower Management Center. For more information, see Add Devices to the Firepower Management Center, on page 178.

Step 4 Create a device stack that includes the replacement device. For more information, see Establishing Device Stacks, on page 424.

Replacing a Device in a Stack in a High-Availability Pair

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>Firepower 8140, 8200 family, 8300 family</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

After you place a stack that is a member of a high-availability pair into maintenance mode, you can replace a secondary device in the stack for another device. You can only select devices that are not currently stacked or paired. The new device must follow the same guidelines for establishing a device stack.

Procedure

Step 1 Choose Devices > Device Management.

Step 2 Next to the stack member you want to place into maintenance mode, click the toggle maintenance mode icon ( ).

Step 3 Click Yes to confirm maintenance mode.

Step 4 Click the replace device icon ( ).

Step 5 Choose the Replacement Device from the drop-down list.

Step 6 Click Replace to replace the device.

Step 7 Click the toggle maintenance mode icon ( ) again to bring the stack immediately out of maintenance mode.

Note You do not need to re-deploy the device configuration.
Configuring Individual Devices in a Stack

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Firepower 8140, Firepower 8200 family, Firepower 8300 family</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

After you establish a device stack, you can still configure some attributes for an individual device within the stack. You can make changes to a device configured in a stack as you would for a single device. You can change the display name of a device, view system settings, shut down or restart a device, view health information, and edit device management settings.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the stacked device where you want to edit the configuration, click the edit icon (-pencil).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Device tab.

**Step 4** From the Selected Device drop-down list, choose the device you want to modify.

**Step 5** Use the sections on the Devices page to make changes to the individual stacked device as you would a single device.

Configuring Interfaces on a Stacked Device

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Firepower 8140, Firepower 8200 family, Firepower 8300 family</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

With the exception of the management interface, you configure stacked device interfaces on the Interfaces page of the primary device in the stack. You can choose any device in the stack to configure the management interface.

The Interfaces page of a Firepower stacked device includes the hardware and interfaces views that you find on an individual device.
Procedure

Step 1  Choose Devices > Device Management.
Step 2  Next to the primary stacked device, click the edit icon (📝).
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.
Step 3  Click the Interfaces tab.
Step 4  From the Selected Device drop-down list, choose the device you want to modify.
Step 5  Configure interfaces as you would on an individual device; see Configuring Sensing Interfaces, on page 384.

Related Topics
Management Interfaces, on page 445

Separating Stacked Devices

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>FirePOWER 8140, 8200 family, 8300 family</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

If you no longer need to use a stacked configuration for your devices, you can break the stack and separate the devices.

Note
If a stacked device fails, or if communication fails between member devices of a stack, you cannot separate the stacked devices using the Firepower Management Center web interface. In this case, use the auxiliary CLI command `configure stacking disable` to remove the stack configuration from each device individually.

Procedure

Step 1  Choose Devices > Device Management.
Step 2  Next to the device stack you want to break, click the break stack icon (🗑).

Tip
To remove a secondary device from a stack of three or more Firepower 8250 devices without breaking the stack, click the remove from stack icon (🗑). Removing the secondary device causes a brief disruption of traffic inspection, traffic flow, or link state as the system reconfigures the stack for operation without the extra device.

Step 3  Click Yes to separate the device stack.
Replacing a Device in a Stack

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>FirePOWER 8140, 8200 family, 8300 family</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

If the Firepower Management Center cannot communicate with the device, you must connect to the device and use CLI commands to separate the stack and unregister the device. For more information, see stacking disable and delete CLI commands in the relevant chapter: Classic Device CLI Configuration Commands, on page 1839.

To replace a device within a stack:

**Procedure**

**Step 1** Select the stack with the device to replace and break that stack. For more information, see Separating Stacked Devices, on page 428.

**Step 2** Unregister the device from the Firepower Management Center. For more information, see Deleting Devices from the Firepower Management Center, on page 180.

**Step 3** Register the replacement device to the Firepower Management Center. For more information, see Add Devices to the Firepower Management Center, on page 178.

**Step 4** Create a device stack that includes the replacement device. For more information, see Establishing Device Stacks, on page 424.
PART VII

Appliance Platform Settings

- System Configuration, on page 433
- Platform Settings Policies for Managed Devices, on page 493
- Platform Settings for Classic Devices, on page 497
System Configuration

The following topics explain how to configure system configuration settings on Firepower Management Centers and managed devices:

- Introduction to System Configuration, on page 433
- Appliance Information, on page 436
- HTTPS Certificates, on page 438
- External Database Access Settings, on page 442
- Database Event Limits, on page 443
- Management Interfaces, on page 445
- System Shut Down and Restart, on page 459
- Remote Storage Management, on page 461
- Change Reconciliation, on page 465
- Policy Change Comments, on page 466
- The Access List, on page 467
- Audit Logs, on page 469
- Dashboard Settings, on page 470
- DNS Cache, on page 471
- Email Notifications, on page 472
- Language Selection, on page 473
- Login Banners, on page 474
- SNMP Polling, on page 475
- STIG Compliance, on page 477
- Time and Time Synchronization, on page 478
- Session Timeouts, on page 482
- Vulnerability Mapping, on page 483
- Remote Console Access Management, on page 484
- VMware Tools and Virtual Systems, on page 491

Introduction to System Configuration

System configuration settings apply to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, NGIPSv):
• For the Firepower Management Center these configuration settings are part of a "local" system configuration. Note that system configuration on the Firepower Management Center is specific to a single system, and changes to a FMC’s system configuration affect only that system.

• For a Classic managed device, you apply a configuration from the Firepower Management Center as part of a platform settings policy. You create a shared policy to configure a subset of the system configuration settings, appropriate for managed devices, that are likely to be similar across a deployment.

Tip
For 7000 and 8000 Series devices, you can perform limited system configuration tasks from the local web interface, such as console configuration and remote management. These are not the same configurations that you apply to a 7000 or 8000 Series device using a platform settings policy.

Navigating the Firepower Management Center System Configuration

The system configuration identifies basic settings for a Firepower Management Center.

Procedure

Step 1
Choose System > Configuration.

Step 2
Use the navigation panel to choose configurations to change; see Table 57: System Configuration Settings, on page 434 for more information.

System Configuration Settings

The following table describes the system configuration settings for the Firepower Management Center. For 7000 and 8000 Series devices, the table also identifies which settings you configure from the device's local web interface, and which you configure using a platform settings policy deployed from the Firepower Management Center.

Table 57: System Configuration Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Also configurable from:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Platform Settings</td>
</tr>
<tr>
<td>Information</td>
<td>View current information about the appliance and edit the display name; see</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td>Appliance Information, on page 436.</td>
<td></td>
</tr>
<tr>
<td>HTTPS Certificate</td>
<td>Request an HTTPS server certificate, if needed, from a trusted authority and</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td>upload certificates to the system; see HTTPS Certificates, on page 438.</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Also configurable from:</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>External Database Access</td>
<td>Enable external read-only access to the database, and provide a client driver to download; see External Database Access Settings, on page 442.</td>
<td>no</td>
</tr>
<tr>
<td>Database</td>
<td>Specify the maximum number of each type of event that the Firepower Management Center can store; see Database Event Limits, on page 443.</td>
<td>no</td>
</tr>
<tr>
<td>Management Interfaces</td>
<td>Change options such as the IP address, hostname, and proxy settings of the appliance; see Management Interfaces, on page 445.</td>
<td>yes</td>
</tr>
<tr>
<td>Process</td>
<td>Shut down, reboot, or restart Firepower System-related processes; see System Shut Down and Restart, on page 459.</td>
<td>yes</td>
</tr>
<tr>
<td>Remote Storage Device</td>
<td>Configure remote storage for backups and reports; see Remote Storage Management, on page 461.</td>
<td>no</td>
</tr>
<tr>
<td>Change Reconciliation</td>
<td>Configure the system to send a detailed report of changes to the system over the last 24 hours; see Change Reconciliation, on page 465.</td>
<td>yes</td>
</tr>
<tr>
<td>Access Control Preferences</td>
<td>Configure the system to prompt users for a comment when they add or modify an access control policy; see Policy Change Comments, on page 466.</td>
<td>no</td>
</tr>
<tr>
<td>Access List</td>
<td>Control which computers can access the system on specific ports; see The Access List, on page 467.</td>
<td>yes</td>
</tr>
<tr>
<td>Audit Log</td>
<td>Configure the system to send an audit log to an external host; see Audit Logs, on page 469.</td>
<td>yes</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Enable Custom Analysis widgets on the dashboard; see Dashboard Settings, on page 470.</td>
<td>no</td>
</tr>
<tr>
<td>DNS Cache</td>
<td>Configure the system to resolve IP addresses automatically on event view pages; see DNS Cache, on page 471.</td>
<td>no</td>
</tr>
<tr>
<td>Email Notification</td>
<td>Configure a mail host, select an encryption method, and supply authentication credentials for email-based notifications and reporting; see Email Notifications, on page 472.</td>
<td>no</td>
</tr>
<tr>
<td>External Authentication</td>
<td>Set the default user role for any user who is authenticated by an external RADIUS, LDAP or Microsoft Active Directory repository; see External Authentication Settings, on page 501</td>
<td>yes</td>
</tr>
<tr>
<td>Intrusion Policy Preferences</td>
<td>Configure the system to prompt users for a comment when they modify an intrusion policy; see Policy Change Comments, on page 466.</td>
<td>no</td>
</tr>
<tr>
<td>Language</td>
<td>Specify a different language for the web interface; see Language Selection, on page 473.</td>
<td>yes</td>
</tr>
<tr>
<td>Login Banner</td>
<td>Create a custom login banner that appears when users log in; see Login Banners, on page 474.</td>
<td>yes</td>
</tr>
</tbody>
</table>
### Appliance Information

The Information page of the web interface includes the information listed in the table below. Unless otherwise noted, all fields are read-only.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name you assign to the appliance. Note that this name is only used within the context of the Firepower System. Although you can use the host name as the name of the appliance, entering a different name in this field does not change the host name.</td>
</tr>
<tr>
<td>Product Model</td>
<td>The model name of the appliance.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>The serial number of the appliance.</td>
</tr>
</tbody>
</table>

### Setting

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Also configurable from:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Analysis Policy Preferences</td>
<td>Configure the system to prompt users for a comment when they modify a network analysis policy; see Policy Change Comments, on page 466.</td>
<td>Platform Settings</td>
</tr>
<tr>
<td>SNMP</td>
<td>Enable Simple Network Management Protocol (SNMP) polling; see SNMP Polling, on page 475.</td>
<td>7000 &amp; 8000 Series</td>
</tr>
<tr>
<td>STIG Compliance</td>
<td>Enable compliance with specific requirements set out by the United States Department of Defense; see STIG Compliance, on page 477.</td>
<td>no</td>
</tr>
<tr>
<td>Time</td>
<td>View the current time setting and, if the time synchronization setting in the current system configuration is set to Manually in Local Configuration, change the time; see Time and Time Synchronization, on page 478.</td>
<td>yes</td>
</tr>
<tr>
<td>Time Synchronization</td>
<td>Manage time synchronization on the system; see Time and Time Synchronization, on page 478.</td>
<td>no</td>
</tr>
<tr>
<td>Shell Timeout</td>
<td>Configure the amount of idle time, in minutes, before a user’s login session times out due to inactivity; see Session Timeouts, on page 482.</td>
<td>yes</td>
</tr>
<tr>
<td>Vulnerability Mapping</td>
<td>Map vulnerabilities to a host IP address for any application protocol traffic received or sent from that address; see Vulnerability Mapping, on page 483.</td>
<td>no</td>
</tr>
<tr>
<td>Console Configuration</td>
<td>Configure console access via VGA or serial port, or via Lights-Out Management (LOM); see Remote Console Access Management, on page 484.</td>
<td>no</td>
</tr>
<tr>
<td>VMware Tools</td>
<td>Enable and use VMware Tools on a Firepower Management Center Virtual; see VMware Tools and Virtual Systems, on page 491.</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Related Topics**

Introduction to Firepower Platform Settings, on page 497
### Appliance Platform Settings

#### Viewing and Modifying the System Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Version</td>
<td>The version of the software currently installed on the appliance.</td>
</tr>
<tr>
<td>Prohibit Packet Transfer to the Firepower Management Center</td>
<td>Specifies whether the managed device sends packet data with events, allowing the data to be stored on the Firepower Management Center. This setting is available on the local web interface on 7000 and 8000 Series devices.</td>
</tr>
<tr>
<td>Operating System</td>
<td>The operating system currently running on the appliance.</td>
</tr>
<tr>
<td>Operating System Version</td>
<td>The version of the operating system currently running on the appliance.</td>
</tr>
<tr>
<td>IPv4 Address</td>
<td>The IPv4 address of the default (eth0) management interface. If IPv4 management is disabled, this field indicates that.</td>
</tr>
<tr>
<td>IPv6 Address</td>
<td>The IPv6 address of the default (eth0) management interface. If IPv6 management is disabled, this field indicates that.</td>
</tr>
<tr>
<td>Current Policies</td>
<td>The system-level policies currently deployed. If a policy has been updated since it was last deployed, the name of the policy appears in italics.</td>
</tr>
<tr>
<td>Model Number</td>
<td>The appliance-specific model number stored on the internal flash drive. This number may be important for troubleshooting.</td>
</tr>
</tbody>
</table>

#### Viewing and Modifying the System Information

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7000 &amp; 8000 Series</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Information page on the Firepower Management Center’s web interface or on the 7000 and 8000 Series local web interface provides information about your system, including read-only information such as the product name and model number. The page also provides you with an option to change the display name of the system and, for 7000 and 8000 Series devices, prohibit packet transfer.

---

**Note**

Prohibiting packet transfer can be a good idea in a low-bandwidth deployment where you are not concerned about the specific content of the packet that triggered the intrusion policy violation.
HTTPS Certificates

Secure Sockets Layer (SSL) certificates enable Firepower Management Centers and 7000 and 8000 Series devices to establish an encrypted channel between the system and a web browser. A default certificate is included with all Firepower devices, but it is not generated by a certificate authority (CA) trusted by any globally known CA. For this reason, consider replacing it with a custom certificate signed by a globally known or internally trusted CA.

Default HTTPS Server Certificates

If you use the default server certificate provided with an appliance, do not configure the system to require a valid HTTPS client certificate for web interface access because the default server certificate is not signed by the CA that signs your client certificate.

Custom HTTPS Server Certificates

You can use the Firepower Management Center web interface to generate a server certificate request based on your system information and the identification information you supply. You can use that request to sign a certificate if you have an internal certificate authority (CA) installed that is trusted by your browser. You can also send the resulting request to a certificate authority to request a server certificate. After you have a signed certificate from a certificate authority (CA), you can import it.

HTTPS Client Certificates

You can restrict access to the Firepower System web server using client browser certificate checking. When you enable user certificates, the web server checks that a user’s browser client has a valid user certificate selected. That user certificate must be generated by the same trusted certificate authority that is used for the server certificate. The browser cannot load the web interface under any of the following circumstances:

- The user selects a certificate in the browser that is not valid.
- The user selects a certificate in the browser that is not generated by the certificate authority that signed the server certificate.
• The user selects a certificate in the browser that is not generated by a certificate authority in the certificate chain on the device.

You can also load a certificate revocation list (CRL) for the server. The CRL lists any certificates that the certificate authority has revoked, so the web server can verify that the client browser certificate is valid. If the user selects a certificate that is listed in the CRL as a revoked certificate, the browser cannot load the web interface.

### Viewing the Current Server Certificate

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7000 &amp; 8000 Series</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can only view server certificates for the appliance you are logged into.

**Procedure**

**Step 1** Choose **System > Configuration**.

**Step 2** Click **HTTPS Certificate**.

### Generating and Submitting a Certificate Signing Request

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Classic</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you generate a certificate request through the local configuration HTTPS Certificate page using this procedure, you can only generate a certificate for a single system. Similarly, if you install a certificate that is not signed by a globally known or internally trusted CA, you receive a security warning when you connect to the system.

The key generated for the certificate request is in Base-64 encoded PEM format.

**Procedure**

**Step 1** Choose **System > Configuration**.

**Step 2** Click **HTTPS Certificate**.

**Step 3** Click **Generate New CSR**.

**Step 4** Enter a country code in the **Country Name (two-letter code)** field.

**Step 5** Enter a state or province postal abbreviation in the **State or Province** field.

**Step 6** Enter a **Locality or City**.

**Step 7** Enter an **Organization** name.
Step 8  Enter an **Organizational Unit (Department)** name.

Step 9  Enter the fully qualified domain name of the server for which you want to request a certificate in the **Common Name** field.

**Note**  You must enter the fully qualified domain name of the server exactly as it should appear in the certificate in the **Common Name** field. If the common name and the DNS host name do not match, you receive a warning when connecting to the appliance.

Step 10  Click **Generate**.

Step 11  Open a text editor.

Step 12  Copy the entire block of text in the certificate request, including the `BEGIN CERTIFICATE REQUEST` and `END CERTIFICATE REQUEST` lines, and paste it into a blank text file.

Step 13  Save the file as `servername.csr`, where `servername` is the name of the server where you plan to use the certificate.

Step 14  Click **Save**.

---

**What to do next**

- Upload the signed server certificate; see [Uploading Server Certificates](#), on page 440.

---

**Server Certificate Upload**

If the signing authority that generated the certificate requires you to trust an intermediate CA, you must also supply a certificate chain, sometimes referred to as a certificate path. If you require user certificates, they must be generated by a certificate authority whose intermediate authority is included in the certificate chain.

---

**Uploading Server Certificates**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If the signing authority that generated the certificate requires you to trust an intermediate CA, you must also supply a certificate chain, sometimes referred to as a certificate path. If you require user certificates, they must be generated by a certificate authority whose intermediate authority is included in the certificate chain.

**Before you begin**

- Generate a certificate signing request; see [Generating and Submitting a Certificate Signing Request](#), on page 439.

- Upload the CSR file to the certificate authority where you want to request a certificate, or use the CSR to create a self-signed certificate.
Procedure

**Step 1** Choose System > Configuration.

**Step 2** Click HTTPS Certificate.

**Step 3** Click Import HTTPS Certificate.

**Step 4** Open the server certificate in a text editor, copy the entire block of text, including the `BEGIN CERTIFICATE` and `END CERTIFICATE` lines, and paste it into the Server Certificate field.

**Step 5** If you want to upload a private key, open the private key file, copy the entire block of text, including the `BEGIN RSA PRIVATE KEY` and `END RSA PRIVATE KEY` lines, and paste it into the Private Key field.

**Step 6** Open any intermediate certificates you need to provide, copy the entire block of text, for each, and paste it into the Certificate Chain field.

**Step 7** Click Save.

### Requiring Valid User Certificates

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

The system supports upload of CRLs in Distinguished Encoding Rules (DER) format. You can only load one CRL for a server.

To ensure that the list of revoked certificates stays current, you can create a scheduled task to update the CRL. The most recent refresh of the CRL is listed in the interface.

**Note**

You must have a valid user certificate present in your browser (or a CAC inserted in your reader) to enable user certificates and to access the web interface after doing so.

### Before you begin

- Use the same certificate authority used for the server certificate to generate the user certificate.
- Upload the intermediate certificate for the certificates; see Server Certificate Upload, on page 440.

### Procedure

**Step 1** Choose System > Configuration.

**Step 2** Click HTTPS Certificate.

**Step 3** Choose Enable User Certificates. If prompted, select the appropriate certificate from the drop-down list.

**Step 4** If you want to retrieve the CRL, choose Enable Fetching of CRL.
Step 5  Enter a valid URL to an existing CRL file and click **Refresh CRL**. The current CRL at the supplied URL loads to the server.

**Note**  Enabling fetching of the CRL creates a scheduled task to update the CRL on a regular basis. Edit the task to set the frequency of the update.

Step 6  Verify that you have a valid user certificate generated by the same certificate authority that created the server certificate.

**Caution**  If you save a configuration with enabled user certificates, but you do not have a valid user certificate in your browser certificate store, you disable all web server access to the appliance. Make sure you have a valid certificate installed before saving settings.

Step 7  Click **Save**.

---

**External Database Access Settings**

You can configure the Firepower Management Center to allow read-only access to its database by a third-party client. This allows you to query the database using SQL using any of the following:

- industry-standard reporting tools such as Actuate BIRT, JasperSoft iReport, or Crystal Reports
- any other reporting application (including a custom application) that supports JDBC SSL connections
- the Cisco-provided command-line Java application called RunQuery, which you can either run interactively or use to obtain comma-separated results for a single query

Use the Firepower Management Center's system configuration to enable database access and create an access list that allows selected hosts to query the database. Note that this access list does not also control appliance access.

You can also download a package that contains the following:

- RunQuery, the Cisco-provided database query tool
- InstallCert, a tool you can use to retrieve and accept the SSL certificate from the Firepower Management Center you want to access
- the JDBC driver you must use to connect to the database

See the Firepower System Database Access Guide for information on using the tools in the package you downloaded to configure database access.

---

**Enabling External Access to the Database**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

---


**Procedure**

**Step 1** Choose System > Configuration.

**Step 2** Click External Database Access.

**Step 3** Select the **Allow External Database Access** check box.

**Step 4** Enter an appropriate value in the **Server Hostname** field. Depending on your third-party application requirements, this value can be either the fully qualified domain name (FQDN), IPv4 address, or IPv6 address of the Firepower Management Center.

**Step 5** Next to **Client JDBC Driver**, click Download and follow your browser’s prompts to download the `client.zip` package.

**Step 6** To add database access for one or more IP addresses, click Add Hosts. An **IP Address** field appears in the Access List field.

**Step 7** In the **IP Address** field, enter an IP address or address range, or any.

**Step 8** Click Add.

**Step 9** Click Save.

**Tip** If you want to revert to the last saved database settings, click Refresh.

---

**Related Topics**

[Firepower System IP Address Conventions](#), on page 14

---

**Database Event Limits**

You can specify the maximum number of each type of event that the Firepower Management Center can store. To improve performance, you should tailor event limits to the number of events you regularly work with. For some event types, you can disable storage.

The system automatically prunes intrusion events, discovery events, audit records, security intelligence data, or URL filtering data from the appliance's database. You can configure the system to generate automated email notifications when events are automatically pruned. You can also manually prune the discovery and user databases to remove selected discovery data; and you can purge discovery and connection data from the Firepower Management Center database.

### Configuring Database Event Limits

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Before you begin**

- If you want to receive email notifications when events are pruned from the Firepower Management Center's database, you must configure an email server; see [Configuring a Mail Relay Host and Notification Address](#), on page 472.
**Procedure**

**Step 1** Choose **System > Configuration**.

**Step 2** Choose **Database**.

**Step 3** For each of the databases, enter the number of records you want to store.

For information on how many records each database can maintain, see **Database Event Limits**, on page 444.

**Step 4** Optionally, in the **Data Pruning Notification Address** field, enter the email address where you want to receive pruning notifications.

**Step 5** Click **Save**.

**Database Event Limits**

The following table lists the minimum and maximum number of records for each event type that you can store on a Firepower Management Center.

**Table 58: Database Event Limits**

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Upper Limit</th>
<th>Lower Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intrusion events</td>
<td>10 million (FMC Virtual)</td>
<td>10,000</td>
</tr>
<tr>
<td></td>
<td>20 million (MC750)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>30 million (MC1500)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>60 million (MC2000)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>150 million (MC3500)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>300 million (MC4000)</td>
<td></td>
</tr>
<tr>
<td>Discovery events</td>
<td>10 million</td>
<td>Zero (disables storage)</td>
</tr>
<tr>
<td></td>
<td>20 million (MC2000, MC4000)</td>
<td></td>
</tr>
<tr>
<td>Connection events</td>
<td>50 million (FMC Virtual)</td>
<td>Zero (disables storage)</td>
</tr>
<tr>
<td>Security Intelligence events</td>
<td>50 million (MC750)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>100 million (MC1500)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>300 million (MC2000)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>500 million (MC3500)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 billion (MC4000)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Limit is shared between connection events and Security Intelligence events. The sum of the configured maximums cannot exceed this limit.</td>
<td></td>
</tr>
</tbody>
</table>
### Management Interfaces

After setup, you can change the management network settings, including adding more management interfaces, hostname, search domains, DNS servers, and HTTP proxy on both the FMC and the managed devices.

### About Management Interfaces

By default, the Firepower Management Center manages all devices on a single management interface. Each device includes a single management interface for communicating with the FMC.

You also perform initial setup on the management interface (for both the FMC and managed devices), and log into the FMC on this interface as an administrator.

Management interfaces are also used to communicate with the Smart Licensing server, to download updates, and to perform other management functions.

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Upper Limit</th>
<th>Lower Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection summaries (aggregated connection events)</td>
<td>50 million (FMC Virtual)</td>
<td>Zero (disables storage)</td>
</tr>
<tr>
<td></td>
<td>50 million (MC750)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>100 million (MC1500)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>300 million (MC2000)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>500 million (MC3500)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 billion (MC4000)</td>
<td></td>
</tr>
<tr>
<td>Correlation events and compliance white list events</td>
<td>1 million</td>
<td>One</td>
</tr>
<tr>
<td></td>
<td>2 million (MC2000, MC4000)</td>
<td></td>
</tr>
<tr>
<td>Malware events</td>
<td>10 million</td>
<td>10,000</td>
</tr>
<tr>
<td></td>
<td>20 million (MC2000, MC4000)</td>
<td></td>
</tr>
<tr>
<td>File events</td>
<td>10 million</td>
<td>Zero (disables storage)</td>
</tr>
<tr>
<td></td>
<td>20 million (MC2000, MC4000)</td>
<td></td>
</tr>
<tr>
<td>Health events</td>
<td>1 million</td>
<td>Zero (disables storage)</td>
</tr>
<tr>
<td>Audit records</td>
<td>100,000</td>
<td>One</td>
</tr>
<tr>
<td>Remediation status events</td>
<td>10 million</td>
<td>One</td>
</tr>
<tr>
<td>White list violation history</td>
<td>a 30-day history of violations</td>
<td>One day’s history</td>
</tr>
<tr>
<td>User activity (user events)</td>
<td>10 million</td>
<td>One</td>
</tr>
<tr>
<td>User logins (user history)</td>
<td>10 million</td>
<td>One</td>
</tr>
<tr>
<td>Intrusion rule update import log records</td>
<td>1 million</td>
<td>One</td>
</tr>
</tbody>
</table>
Management Interfaces on the Firepower Management Center

The Firepower Management Center uses the eth0 interface for initial setup, HTTP access for administrators, management of devices, as well as other management functions such as licensing and updates.

You can also configure additional management interfaces on the same network, or on different networks. When the FMC manages large numbers of devices, adding more management interfaces can improve throughput and performance. You can also use these interfaces for all other management functions. You might want to use each management interface for particular functions; for example, you might want to use one interface for HTTP administrator access and another for device management.

For device management, the management interface carries two separate traffic channels: the management traffic channel carries all internal traffic (such as inter-device traffic specific to managing the device), and the event traffic channel carries all event traffic (such as web events). You can optionally configure a separate event-only interface on the FMC to handle event traffic; you can configure only one event interface. Event traffic can use a large amount of bandwidth, so separating event traffic from management traffic can improve the performance of the FMC. For example, you can assign a 10 GigabitEthernet interface to be the event interface, if available, while using 1 GigabitEthernet interfaces for management. You might want to configure an event-only interface on a completely secure, private network while using the regular management interface on a network that includes Internet access, for example. You can also use both management and event interfaces on the same network if the goal is only to take advantage of increased throughput. If you configure an event-only interface on the FMC, you can support devices with separate management and event-only interfaces, but also devices that do not have separate interfaces. For devices with a single combined management/event interface, all traffic goes to the FMC management interface.

**Note**

All management interfaces support HTTP administrator access as controlled by your Access List configuration (Configuring the Access List for Your System, on page 468). Conversely, you cannot restrict an interface to only HTTP access; management interfaces always support device management (management traffic, event traffic, or both).

**Note**

Only the eth0 interface supports DHCP IP addressing. Other management interfaces only support static IP addresses.

Management Interfaces on Managed Devices

Some models include an additional management interface that you can configure for event-only traffic, so you can separate management and event traffic when communicating with the FMC.

When you set up your device, you specify the FMC IP address that you want to connect to. Both management and event traffic go to this address at initial registration. Note: In some situations, the FMC might establish the initial connection on a different management interface; subsequent connections should use the management interface with the specified IP address.

If both the device and the FMC have separate event interfaces, then after they learn about each other's event interfaces during management communication, subsequent event traffic is sent between these interfaces if the network allows. If the event network goes down, then event traffic reverts to the regular management interface. The device uses a separate event interface when possible, but the management interface is always the backup. If you use only one management interface on the managed device, then you cannot send management traffic to the FMC management interface, and then send event traffic to the separate FMC event interface; both FMC
and managed device must have separate event interfaces. In this case, both management and event traffic go to the FMC management interface, and the FMC event interface is not used for this device.

### Management Interface Support

See the hardware installation guide for your model for the management interface locations.

See the following tables for supported management interfaces on each Firepower Management Center and managed device model.

**Table 59: Management Interface Support on the Firepower Management Center**

<table>
<thead>
<tr>
<th>Model</th>
<th>Management Interfaces</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC750, MC1500, MC3500</td>
<td>eth0 (Default)</td>
</tr>
<tr>
<td></td>
<td>eth1</td>
</tr>
<tr>
<td>MC2000, MC4000</td>
<td>eth0 (Default)</td>
</tr>
<tr>
<td></td>
<td>eth1</td>
</tr>
<tr>
<td></td>
<td>eth2</td>
</tr>
<tr>
<td></td>
<td>eth3</td>
</tr>
<tr>
<td>Firepower Management Center Virtual</td>
<td>eth0 (Default)</td>
</tr>
</tbody>
</table>

**Table 60: Management Interface Support on Managed Devices**

<table>
<thead>
<tr>
<th>Model</th>
<th>Management Interface</th>
<th>Optional Event Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>7000 series</td>
<td>eth0</td>
<td>No support</td>
</tr>
<tr>
<td>8000 series</td>
<td>eth0</td>
<td>ethl</td>
</tr>
<tr>
<td>NGIPSv</td>
<td>ethl</td>
<td>No support</td>
</tr>
<tr>
<td>ASA FirePOWER services module on the ASA 5585-X</td>
<td>ethl</td>
<td>ethl is the internal name of the Management 1/0 interface.</td>
</tr>
<tr>
<td>ASA FirePOWER services module on the ASA 5506-X, 5508-X, or 5516-X</td>
<td>ethl</td>
<td>ethl is the internal name of the Management 1/1 interface.</td>
</tr>
<tr>
<td>ASA FirePOWER services module on the ASA 5512-X-X through 5555-X</td>
<td>ethl</td>
<td>No support</td>
</tr>
</tbody>
</table>

*Note: eth0 is the internal name of the Management 1/0 interface.*

*Note: ethl is the internal name of the Management 1/1 interface.*
Network Routes on Management Interfaces

Management interfaces (including event-only interfaces) support only static routes to reach remote networks. When you set up your FMC or managed device, the setup process creates a default route to the gateway IP address that you specify. You cannot delete this route; you can only modify the gateway address.

The default route always uses the lowest-numbered management interface (e.g. eth0).

At least 1 static route is recommended per management interface to access remote networks, including when multiple interfaces are on the same network.

For example, on the FMC both eth0 and eth1 are on the same network, but you want to manage a different group of devices on each interface. The default gateway is 192.168.45.1. If you want eth1 to manage devices on the remote 10.6.6.0/24 destination network, you can create a static route for 10.6.6.0/24 through eth1 with the same gateway of 192.168.45.1. Traffic to 10.6.6.0/24 will hit this route before it hits the default route, so eth1 will be used as expected.

If you want to use 2 FMC interfaces to manage remote devices that are on the same network, then static routing on the FMC may not scale well, because you need separate static routes per device IP address.

Another example includes separate management and event-only interfaces on both the FMC and the managed device. The event-only interfaces are on a separate network from the management interfaces. In this case, add a static route through the event-only interface for traffic destined for the remote event-only network, and vice versa.

Note

The routing for management interfaces is completely separate from routing that you configure for data interfaces.

Management and Event Traffic Channel Examples

The following example shows the Firepower Management Center and managed devices using only the default management interfaces.

Figure 3: Single Management Interface on the Firepower Management Center

The following example shows the Firepower Management Center using separate management interfaces for devices; and each managed device using 1 management interface.
The following example shows a mix of multiple management interfaces and a separate event interface on the Firepower Management Center and a mix of managed devices using a separate event interface, or using a single management interface.

**Figure 6: Mixed Management and Event Interface Usage**

**Configure Management Interfaces**

You can change management interface settings for Firepower appliances:

- Firepower Management Center—Use the web interface. (The Firepower Management Center supports Linux shell access only under Cisco TAC supervision.)
- NGIPSv, ASA FirePOWER—Use the CLI
- 7000 & 8000 Series devices—Use the limited web interface or the CLI.
See the following sections.

Related Topics
Communication Port Requirements, on page 1803

Configure Firepower Management Center Management Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Modify the management interface settings on the Firepower Management Center. You can optionally enable additional management interfaces or configure an event-only interface.

⚠️ Caution

Be careful when making changes to the management interface to which you are connected; if you cannot re-connect because of a configuration error, you need to access the FMC console port to re-configure the network settings in the Linux shell. You must contact Cisco TAC to guide you in this operation.

Before you begin
If you use a proxy:

- Proxies that use NT LAN Manager (NTLM) authentication are not supported.
- If you use or will use Smart Licensing, the proxy FQDN cannot have more than 64 characters.

Procedure

Step 1
Choose System > Configuration, and then choose Management Interfaces.

Step 2
In the Interfaces area, click Edit next to the interface that you want to configure.

All available interfaces are listed in this section. You cannot add more interfaces.

You can configure the following options on each management interface:

- **Enabled**—Enable the management interface. Do not disable the default eth0 management interface. Some processes require the eth0 interface.
- **Channels**—Configure an event-only interface; you can configure only one event interface on the FMC. To do so, uncheck the Management Traffic check box, and leave the Event Traffic check box checked. You can optionally disable Event Traffic for the management interface(s). In either case, the device will try to send events to the event-only interface, and if that interface is down, it will send events on the management interface even if you disable the event channel. You cannot disable both event and management channels on an interface.
- **Mode**—Specify a link mode. Note that any changes you make to auto-negotiation are ignored for GigabitEthernet interfaces.
- **MDI/MDIX**—Set the Auto-MDIX setting.
- **MTU**—Set the maximum transmission unit (MTU). The default is 1500. The range within which you can set the MTU can vary depending on the model and interface type.
Because the system automatically trims 18 bytes from the configured MTU value, any value below 1298 does not comply with the minimum IPv6 MTU setting of 1280, and any value below 594 does not comply with the minimum IPv4 MTU setting of 576. For example, the system automatically trims a configured value of 576 to 558.

- **IPv4 Configuration**—Set the IPv4 IP address. Choose:
  - **Static**—Manually enter the IPv4 Management IP address and IPv4 Netmask.
  - **DHCP**—Set the interface to use DHCP (eth0 only).
  - **Disabled**—Disable IPv4. Do not disable both IPv4 and IPv6.

- **IPv6 Configuration**—Set the IPv6 IP address. Choose:
  - **Static**—Manually enter the IPv6 Management IP address and IPv6 Prefix Length.
  - **DHCP**—Set the interface to use DHCPv6 (eth0 only).
  - **Router Assigned**—Enable stateless autoconfiguration.
  - **Disabled**—Disable IPv6. Do not disable both IPv4 and IPv6.

**Step 3**

In the Routes area, edit a static route by clicking the edit icon ( ), or add a route by clicking the add icon ( ). View the route statistics by clicking the view icon ( ).

You need a static route for each additional interface to reach remote networks. For more information about when new routes are needed, see Network Routes on Management Interfaces, on page 448.

**Note** For the default route, you can change only the gateway IP address. The default route always uses the eth0 interface.

You can configure the following settings for a static route:

- **Destination**—Set the destination address of the network to which you want to create a route.
- **Netmask** or **Prefix Length**—Set the netmask (IPv4) or prefix length (IPv6) for the network.
- **Interface**—Set the egress management interface.
- **Gateway**—Set the gateway IP address.

**Step 4**

In the Shared Settings area, set network parameters shared by all interfaces.

**Note** If you selected DHCP for the eth0 interface, you cannot manually specify some shared settings derived from the DHCP server.

You can configure the following shared settings:

- **Hostname**—Set the FMC hostname. If you change the hostname, reboot the FMC if you want the new hostname reflected in syslog messages. Syslog messages do not reflect a new hostname until after a reboot.
- **Domains**—Set the search domain(s) for the FMC, separated by commas. These domains are added to hostnames when you do not specify a fully-qualified domain name in a command, for example, ping system. The domains are used only on the management interface, or for commands that go through the management interface.
• **Primary DNS Server, Secondary DNS Server, Tertiary DNS Server**—Set the DNS servers to be used in order of preference.

• **Remote Management Port**—Set the remote management port for communication with managed devices. The FMC and managed devices communicate using a two-way, SSL-encrypted communication channel, which by default is on port 8305.

  **Note**  
  Cisco strongly recommends that you keep the default settings for the remote management port, but if the management port conflicts with other communications on your network, you can choose a different port. If you change the management port, you must change it for all devices in your deployment that need to communicate with each other.

**Step 5**  
In the **Proxy** area, configure HTTP proxy settings.

The FMC is configured to directly-connect to the internet on ports TCP/443 (HTTPS) and TCP/80 (HTTP). You can use a proxy server, to which you can authenticate via HTTP Digest.

See proxy requirements in the prerequisites to this topic.

a) Check the **Enabled** check box.

b) In the **HTTP Proxy** field, enter the IP address or fully-qualified domain name of your proxy server.

  See requirements in the prerequisites to this topic.

c) In the **Port** field, enter a port number.

d) Supply authentication credentials by choosing **Use Proxy Authentication**, and then provide a **UserName** and **Password**.

**Step 6**  
Click **Save**.

**Step 7**  
If you changed the management IP address, it might affect communication between the FMC and managed devices.

Changing the IP address will not affect the current connection. However, if the device or FMC reloads, then the connection needs to be reestablished. You need at least one of the devices (FMC or managed device) to have the correct IP address of the peer. For example, if you added the device on the FMC and specified a NAT ID (instead of an IP address), then the FMC IP address that you defined on the device at setup will be wrong, and the device will not be able to reestablish communications. Moreover, you cannot **update** the FMC IP address on a device; you can only replace the IP address and re-register as a new device (**configure manager add**). On the other hand, if the FMC knows the correct IP address of the managed device, then even if the managed device has the wrong IP address for the FMC, then the FMC can successfully establish the connection.

### Configure Classic Device Management Interfaces at the Web Interface

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Modify the management interface settings on the managed device using the web interface. You can optionally enable an event interface if your model supports it.
Be careful when making changes to the management interface; if you cannot re-connect because of a configuration error, you will need to access the device console port and reconfigure the settings at the CLI.

**Procedure**

**Step 1**  
Choose **System > Configuration**, and then choose **Management Interfaces**.

**Step 2**  
In the **Interfaces** area, click **Edit** next to the interface that you want to configure.

All available interfaces are listed in this section. You cannot add more interfaces.

You can configure the following options on each management interface:

- **Enabled**—Enable the management interface. Do **not** disable the default eth0 management interface. Some processes require the eth0 interface.

- **Channels**—(8000 series only) Configure an event-only interface. You can enable the eth1 management interface on your 8000 series device to act as an event interface. To do so, uncheck the **Management Traffic** check box, and leave the **Event Traffic** check box checked. For the eth0 management interface, leave both check boxes checked.

  The Firepower Management Center event-only interface cannot accept management channel traffic, so you should simply disable the management channel on the device event interface.

  You can optionally disable **Event Traffic** for the management interface. In either case, the device will try to send events on the event-only interface, and if that interface is down, it will send events on the management interface even if you disable the event channel.

  You cannot disable both event and management channels on an interface.

- **Mode**—Specify a link mode. Note that any changes you make to auto-negotiation are ignored for GigabitEthernet interfaces.

- **MTU**—Set the maximum transmission unit (MTU). The default is 1500. The range within which you can set the MTU can vary depending on the model and interface type.

  Because the system automatically trims 18 bytes from the configured MTU value, any value below 1298 does not comply with the minimum IPv6 MTU setting of 1280, and any value below 594 does not comply with the minimum IPv4 MTU setting of 576. For example, the system automatically trims a configured value of 576 to 558.

- **MDI/MDIX**—Set the **Auto-MDIX** setting.

- **IPv4 Configuration**—Set the IPv4 IP address. Choose:

  - **Static**—Manually enter the **IPv4 Management IP** address and **IPv4 Netmask**.
  
  - **DHCP**—Set the interface to use DHCP (eth0 only).
  
  - **Disabled**—Disable IPv4. Do **not** disable both IPv4 and IPv6.

- **IPv6 Configuration**—Set the IPv6 IP address. Choose:

  - **Static**—Manually enter the **IPv6 Management IP** address and **IPv6 Prefix Length**.
  
  - **DHCP**—Set the interface to use DHCPv6 (eth0 only).
• **Router Assigned**—Enable stateless autoconfiguration.

• **Disabled**—Disable IPv6. Do **not** disable both IPv4 and IPv6.

**Step 3**

In the **Routes** area, edit a static route by clicking the edit icon (✏️), or add a route by clicking the add icon (➕). View the route statistics by clicking the view icon (🔍).

**Note**

You need to add a static route for the event-only interface if the Firepower Management Center is on a remote network; otherwise, all traffic will match the default route through the management interface. For the default route, you can change only the gateway IP address. The default route always uses the eth0 interface. For information about routing, see **Network Routes on Management Interfaces**, on page 448.

You can configure the following settings for a static route:

- **Destination**—Set the destination address of the network to which you want to create a route.

- **Netmask or Prefix Length**—Set the netmask (IPv4) or prefix length (IPv6) for the network.

- **Interface**—Set the egress management interface.

- **Gateway**—Set the gateway IP address.

**Step 4**

In the **Shared Settings** area, set network parameters shared by all interfaces.

**Note**

If you selected **DHCP** for the eth0 interface, you cannot manually specify some shared settings derived from the DHCP server.

You can configure the following shared settings:

- **Hostname**—Set the device hostname. If you change the hostname, reboot the device if you want the new hostname reflected in syslog messages. Syslog messages do not reflect a new hostname until after a reboot.

- **Domains**—Set the search domain(s) for the device, separated by commas. These domains are added to hostnames when you do not specify a fully-qualified domain name in a command, for example, `ping system`. The domains are used only on the management interface, or for commands that go through the management interface.

- **Primary DNS Server, Secondary DNS Server, Tertiary DNS Server**—Set the DNS servers to be used in order of preference.

- **Remote Management Port**—Set the remote management port for communication with the FMC. The FMC and managed devices communicate using a two-way, SSL-encrypted communication channel, which by default is on port 8305.

  **Note**

  Cisco **strongly** recommends that you keep the default settings for the remote management port, but if the management port conflicts with other communications on your network, you can choose a different port. If you change the management port, you must change it for **all** devices in your deployment that need to communicate with each other.

**Step 5**

In the **LCD Panel** area, check the **Allow reconfiguration of network settings** check box to enable changing network settings using the device’s LCD panel.
You can use the LCD panel to edit the IP address for the device. Confirm that any changes you make are reflected on the managing Firepower Management Center. In some cases, you may need to update the data manually on the Firepower Management Center as well.

**Caution** Allowing reconfiguration using the LCD panel can present a security risk. You need only physical access, not authentication, to configure network settings using the LCD panel. The web interface warns you that enabling this option is a potential security issue.

**Step 6** In the **Proxy** area, configure HTTP proxy settings.

The device is configured to directly-connect to the internet on ports TCP/443 (HTTPS) and TCP/80 (HTTP). You can use a proxy server, to which you can authenticate via HTTP Digest.

**Note** Proxies that use NT LAN Manager (NTLM) authentication are not supported.

a) Check the **Enabled** check box.
b) In the **HTTP Proxy** field, enter the IP address or fully-qualified domain name of your proxy server.
c) In the **Port** field, enter a port number.
d) Supply authentication credentials by choosing **Use Proxy Authentication**, and then provide a **User Name** and **Password**.

**Step 7** Click **Save**.

**Step 8** If you changed the management IP address, it might affect communication between the FMC and the managed device.

Changing the IP address will not affect the current connection. However, if the device or FMC reloads, then the connection needs to be reestablished. You need at least one of the devices (FMC or managed device) to have the correct IP address of the peer. For example, if you specified a NAT ID (instead of an IP address) for the FMC during device setup, then the device IP address that you defined on the FMC when you added the device will be wrong, and the FMC will not be able to reestablish communications. In this case, you must change the management IP address of the device in the FMC; see **Editing Device Management Settings**, on page 184.

---

### Configure Classic Device Management Interfaces at the CLI

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Classic</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Modify the management interface settings on the managed device using the CLI. Many of these settings are ones that you set when you performed the initial setup; this procedure lets you change those settings, and set additional settings such as enabling an event interface if your model supports it, or adding static routes. For information about the CLI, see **Command Line Reference**, on page 1807 in this guide.

**Note** When using SSH, be careful when making changes to the management interface; if you cannot re-connect because of a configuration error, you will need to access the device console port.
Before you begin

- For the 7000 & 8000 Series devices, you can create user accounts at the web interface as described in Creating a User Account, on page 62.

Procedure

Step 1
Connect to the device CLI, either from the console port or using SSH. See Logging Into the Command Line Interface, on page 24.

Step 2
Log in with the Admin username and password.

Step 3
Enable an event-only interface (for supported models; see Management Interface Support, on page 447):

```plaintext
configure network management-interface enable management_interface
configure network management-interface disable-management-channel management_interface
```

Example:

```plaintext
> configure network management-interface enable management1
Configuration updated successfully

> configure network management-interface disable-management-channel management1
Preserve existing configuration- currently no IP addresses on eth1 to update (bootproto IPv4:, bootproto IPv6:
at /usr/local/sf/lib/perl/5.10.1/SF/NetworkConf/NetworkSettings.pm line 821.
Configuration updated successfully

> 
```

The Firepower Management Center event-only interface cannot accept management channel traffic, so you should simply disable the management channel on the device event interface.

You can optionally disable events for the management interface using the configure network management-interface disable-events-channel command. In either case, the device will try to send events on the event-only interface, and if that interface is down, it will send events on the management interface even if you disable the event channel.

You cannot disable both event and management channels on an interface.

Step 4
Configure the network settings of the management interface and/or event interface:

If you do not specify the management_interface argument, then you change the network settings for the default management interface. When configuring an event interface, be sure to specify the management_interface argument. The event interface can be on a separate network from the management interface, or on the same network. If you are connected to the interface you are configuring, you will be disconnected. You can re-connect to the new IP address.

a) Configure the IPv4 address:

- Manual configuration:

```
configure network ipv4 manual ip_address netmask gateway_ip [management_interface]
```

Note that the gateway_ip in this command is only used to create the default route for the primary management interface. If you set the gateway for an event-only interface, then this command ignores
the gateway and does not create a default or static route for it. You must create a static route separately using the `configure network static-routes` command.

**Example:**

```
> configure network ipv4 manual 10.10.10.45 255.255.255.0 management1
Setting IPv4 network configuration.
Network settings changed.
>
```

• DHCP (supported on the default management interface only):

```
configure network ipv4 dhcp
```

b) Configure the IPv6 address:

• Stateless autoconfiguration:

```
configure network ipv6 router [management_interface]
```

**Example:**

```
> configure network ipv6 router management0
Setting IPv6 network configuration.
Network settings changed.
>
```

• Manual configuration:

```
configure network ipv6 manual ip6_address ip6_prefix_length [ip6_gateway_ip] [management_interface]
```

Note that the `ipv6_gateway_ip` in this command is only used to create the default route for the primary management interface. If you set the gateway for an event-only interface, then this command ignores the gateway and does not create a default or static route for it. You must create a static route separately using the `configure network static-routes` command.

**Example:**

```
> configure network ipv6 manual 2001:0DB8:BA98::3210 64 management1
Setting IPv6 network configuration.
Network settings changed.
>
```

• DHCPv6 (supported on the default management interface only):

```
configure network ipv6 dhcp
```

**Step 5** Add a static route for the event-only interface if the Firepower Management Center is on a remote network; otherwise, all traffic will match the default route through the management interface.

```
configure network static-routes {ipv4 | ipv6}add management_interface destination_ip netmask_or_prefix gateway_ip
```
For the default route, do not use this command; you can only change the default route gateway IP address when you use the `configure network ipv4` or `ipv6` commands for the default management interface (see step 4).

For information about routing, see Network Routes on Management Interfaces, on page 448.

**Example:**

```
> configure network static-routes ipv4 add management1 192.168.6.0 255.255.255.0 10.10.10.1
Configuration updated successfully

> configure network static-routes ipv6 add management1 2001:0DB8:AA98::5110 64 2001:0DB8:BA98::3211
Configuration updated successfully
```

To display static routes, enter `show network-static-routes` (the default route is not shown):

```
> show network-static-routes
---------------[ IPv4 Static Routes ]---------------
Interface                   : management1
Destination                 : 192.168.6.0
Gateway                     : 10.10.10.1
Netmask                     : 255.255.255.0
[...]
```

**Step 6**

Set the hostname:

`configure network hostname name`

**Example:**

```
> configure network hostname farscape1
```

Syslog messages do not reflect a new hostname until after a reboot.

**Step 7**

Set the search domains:

`configure network dns searchdomains domain_list`

**Example:**

```
> configure network dns searchdomains example.com,cisco.com
```

Set the search domain(s) for the device, separated by commas. These domains are added to hostnames when you do not specify a fully-qualified domain name in a command, for example, `ping system`. The domains are used only on the management interface, or for commands that go through the management interface.

**Step 8**

Set up to 3 DNS servers, separated by commas:

`configure network dns servers dns_ip_list`

**Example:**

```
> configure network dns servers 10.10.6.5,10.20.89.2,10.80.54.3
```
Step 9
Set the remote management port for communication with the FMC:

```
configure network management-interface tcpport number
```

Example:

```
> configure network management-interface tcpport 8555
```

The FMC and managed devices communicate using a two-way, SSL-encrypted communication channel, which by default is on port 8305.

**Note** Cisco strongly recommends that you keep the default settings for the remote management port, but if the management port conflicts with other communications on your network, you can choose a different port. If you change the management port, you must change it for all devices in your deployment that need to communicate with each other.

Step 10
Configure an HTTP proxy. The device is configured to directly-connect to the internet on ports TCP/443 (HTTPS) and TCP/80 (HTTP). You can use a proxy server, to which you can authenticate via HTTP Digest. After issuing the command, you are prompted for the HTTP proxy address and port, whether proxy authentication is required, and if it is required, the proxy username, proxy password, and confirmation of the proxy password.

```
configure network http-proxy
```

Example:

```
> configure network http-proxy
Manual proxy configuration
Enter HTTP Proxy address: 10.100.10.10
Enter HTTP Proxy Port: 80
Use Proxy Authentication? (y/n) [n]: Y
Enter Proxy Username: proxyuser
Enter Proxy Password: proxypassword
Confirm Proxy Password: proxypassword
```

Step 11
If you changed the management IP address, change the managed device IP address in the FMC according to Editing Device Management Settings, on page 184.

If you specified a NAT ID (instead of an IP address) for the device in the FMC, then you can skip this step.

---

**System Shut Down and Restart**

Use your Firepower System's web interface to control the shut down and restart of processes on your appliance. Shutting down the appliance prepares the system to be safely powered off and restarted without losing configuration data.

You have several options for controlling the processes on Firepower Management Centers. You can:

- Shut down the system — Initiates a graceful shutdown of the Firepower system.
- Reboot the system — Shuts down and restarts the system in an orderly manner.
Restart the console — Restarts the communications, database, and HTTP server processes. This is typically used during troubleshooting.

These same options are available for 7000 and 8000 Series managed devices. You can also restart the Snort process on these devices.

---

**Caution**

Do not shut off appliances using the power button; it may cause a loss of data. Shut down appliances completely via the web interface.

---

**Caution**

Restarting the Snort process temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

---

For Firepower virtual managed devices, the virtual infrastructure, such as VMware, typically provides configurable power options to define the way a virtual machine is shut down, restarted, or suspended. Consult the documentation for your virtual platform to determine how to set these options.

---

**Note**

For Firepower virtual managed devices running on VMware, custom power options are part of VMware Tools, so you must have VMware Tools installed on your virtual machines to configure graceful shut down.

---

**Shutting Down and Restarting the System**

**Shutting Down and Restarting the System**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**

Choose **System > Configuration**.

**Step 2**

Choose **Process**.

**Step 3**

To shut down the appliance:

- FMC—Click **Run Command** next to **Shutdown Management Center**.
- Managed device—Click **Run Command** next to **Shutdown Appliance**.

**Step 4**

To reboot the appliance:

- FMC—Click **Run Command** next to **Reboot Management Center**.
- Managed device—Click **Run Command** next to **Reboot Appliance**.

**Note**

When you reboot your Firepower Management Center or managed device, this logs you out of your appliance, and the system runs a database check that can take up to an hour to complete.
Step 5  To restart the appliance:

- FMC—Click **Run Command** next to **Restart Management Center**.
- Managed device—Click **Run Command** next to **Restart Appliance Console**.

**Note**  Restarting the Firepower Management Center may cause deleted hosts to reappear in the network map.

Step 6  To restart the Snort process on a managed device, click **Run Command** next to **Restart Snort**.

**Note**  This command is only available from the 7000 and 8000 Series device's local web interface.

**Caution**  Restarting the Snort process temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without inspection depends on how the device is configured. See Snort® Restart Traffic Behavior, on page 280 for more information.

---

**Remote Storage Management**

On Firepower Management Centers, you can use the following for local or remote storage for backups and reports:

- Network File System (NFS)
- Server Message Block (SMB)/Common Internet File System (CIFS)
- Secure Shell (SSH)

**Note**  The system supports only SMBv1 for backup and remote storage.

You cannot send backups to one remote system and reports to another, but you can choose to send either to a remote system and store the other on the Firepower Management Center.

**Tip**  After configuring and selecting remote storage, you can switch back to local storage **only** if you **have not** increased the connection database limit.

---

**Configuring Local Storage**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>
Configuring NFS for Remote Storage

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Before you begin

• Ensure that your external remote storage system is functional and accessible from your FMC.

Procedure

Step 1 Choose System > Configuration.
Step 2 Click Remote Storage Device.
Step 3 Choose NFS from the Storage Type drop-down list.
Step 4 Add the connection information:
  • Enter the IPv4 address or hostname of the storage system in the Host field.
  • Enter the path to your storage area in the Directory field.
Step 5 Optionally, check the Use Advanced Options check box and enter any required command line options; see Remote Storage Management Advanced Options, on page 464.
Step 6 Under System Usage:
  • Choose Use for Backups to store backups on the designated host.
  • Choose Use for Reports to store reports on the designated host.
  • Enter Disk Space Threshold for backup to remote storage. Default is 90%.
Step 7 To test the settings, click Test.
Step 8 Click Save.
Configuring SMB for Remote Storage

Before you begin

- Ensure that your external remote storage system is functional and accessible from your FMC.

Procedure

Step 1  Choose **System** > **Configuration**.
Step 2  Click **Remote Storage Device**.
Step 3  Choose **SMB** from the **Storage Type** drop-down list.
Step 4  Add the connection information:
  - Enter the IPv4 address or hostname of the storage system in the **Host** field.
  - Enter the share of your storage area in the **Share** field. Note that the system only recognizes top-level shares and not full file paths. To use the specified Share directory as a remote backup destination, it must be shared on the Windows system.
  - Optionally, enter the domain name for the remote storage system in the **Domain** field.
  - Enter the user name for the storage system in the **Username** field and the password for that user in the **Password** field.

Step 5  Optionally, check the **Use Advanced Options** check box and enter any required command line options; see Remote Storage Management Advanced Options, on page 464.

Step 6  Under **System Usage**:
  - Choose **Use for Backups** to store backups on the designated host.
  - Choose **Use for Reports** to store reports on the designated host.

Step 7  To test the settings, click **Test**.
Step 8  Click **Save**.

Configuring SSH for Remote Storage

If you enable STIG compliance on an appliance, you cannot use SSH for remote storage for that appliance.
Before you begin

- Ensure that your external remote storage system is functional and accessible from your Firepower Management Center.

Procedure

Step 1  Choose System > Configuration.

Step 2  Click Remote Storage Device.

Step 3  Choose SSH from the Storage Type drop-down list.

Step 4  Add the connection information:

- Enter the IP address or host name of the storage system in the Host field.
- Enter the path to your storage area in the Directory field.
- Enter the storage system’s user name in the Username field and the password for that user in the Password field. To specify a network domain as part of the connection user name, precede the user name with the domain followed by a forward slash (/).
- To use SSH keys, copy the content of the SSH Public Key field and place it in your authorized_keys file.

Step 5  Optionally, check the Use Advanced Options check box and enter any required command line options; see Remote Storage Management Advanced Options, on page 464.

Step 6  Under System Usage:

- Choose Use for Backups to store backups on the designated host.
- Choose Use for Reports to store reports on the designated host.

Step 7  If you want to test the settings, you must click Test.

Step 8  Click Save.

Remote Storage Management Advanced Options

If you select the Network File System (NFS) protocol, Server Message Block (SMB) protocol, or SSH to use secure file transfer protocol (SFTP) to store your reports and backups, you can select the Use Advanced Options check box to use one of the mount binary options as documented in an NFS, SMB, or SSH mount man page.

If you select SMB, you can enter the security mode in the Command Line Options field using the following format:

```
sec=mode
```

where mode is the security mode you want to use for remote storage.
### Table 61: SMB Security Mode Settings

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[none]</td>
<td>Attempt to connect as null user (no name).</td>
</tr>
<tr>
<td>krb5</td>
<td>Use Kerberos version 5 authentication.</td>
</tr>
<tr>
<td>krb5i</td>
<td>Use Kerberos authentication and packet signing.</td>
</tr>
<tr>
<td>ntlm</td>
<td>Use NTLM password hashing. (Default)</td>
</tr>
<tr>
<td>ntlmi</td>
<td>Use NTLM password hashing with signing (may be Default if /proc/fs/cifs/PacketSigningEnabled is on or if server requires signing).</td>
</tr>
<tr>
<td>ntlmv2</td>
<td>Use NTLMv2 password hashing.</td>
</tr>
<tr>
<td>ntlmv2i</td>
<td>Use NTLMv2 password hashing with packet signing.</td>
</tr>
</tbody>
</table>

### Change Reconciliation

To monitor the changes that users make and ensure that they follow your organization’s preferred standard, you can configure the system to send, via email, a detailed report of changes made over the past 24 hours. Whenever a user saves changes to the system configuration, a snapshot is taken of the changes. The change reconciliation report combines information from these snapshots to present a clear summary of recent system changes.

The following sample graphic displays a User section of an example change reconciliation report and lists both the previous value for each configuration and the value after changes. When users make multiple changes to the same configuration, the report lists summaries of each distinct change in chronological order, beginning with the most recent.

You can view changes made during the previous 24 hours.

### Configuring Change Reconciliation

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Before you begin**

- Configure an email server to receive emailed reports of changes made to the system over a 24 hour period; see Configuring a Mail Relay Host and Notification Address, on page 472 for more information.
Procedure

Step 1 Choose **System > Configuration**.
Step 2 Click **Change Reconciliation**.
Step 3 Check the **Enable** check box.
Step 4 Choose the time of day you want the system to send out the change reconciliation report from the **Time to Run** drop-down lists.
Step 5 Enter email addresses in the **Email to** field.

**Tip** Once you have added email addresses, click **Resend Last Report** to send recipients another copy of the most recent change reconciliation report.

Step 6 If you want to include policy changes, check the **Include Policy Configuration** check box.
Step 7 If you want to include all changes over the past 24 hours, check the **Show Full Change History** check box.
Step 8 Click **Save**.

Related Topics

- **Using the Audit Log to Examine Changes**, on page 1794

Change Reconciliation Options

The **Include Policy Configuration** option controls whether the system includes records of policy changes in the change reconciliation report. This includes changes to access control, intrusion, system, health, and network discovery policies. If you do not select this option, the report will not show changes to any policies. This option is available on Firepower Management Centers only.

The **Show Full Change History** option controls whether the system includes records of all changes over the past 24 hours in the change reconciliation report. If you do not select this option, the report includes only a consolidated view of changes for each category.

Policy Change Comments

You can configure the Firepower System to track several policy-related changes using the comment functionality when users modify access control, intrusion, or network analysis policies.

With policy change comments enabled, administrators can quickly assess why critical policies in a deployment were modified. Optionally, you can have changes to intrusion and network analysis policies written to the audit log.

Configuring Comments to Track Policy Changes

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can configure the Firepower System to prompt users for comments when they modify an access control policy, intrusion policy, or network analysis policy. You can use comments to track users’ reasons for policy
changes. If you enable comments on policy changes, you can make the comment optional or mandatory. The system prompts the user for a comment when each new change to a policy is saved.

**Procedure**

**Step 1** Choose **System > Configuration**.

The system configuration options appear in the left navigation panel.

**Step 2** Configure the policy comment preferences for any of the following:

- Click **Access Control Preferences** for comment preferences for access control policies.
- Click **Intrusion Policy Preferences** for comment preferences for intrusion policies.
- Click **Network Analysis Policy Preferences** for comment preferences for network analysis policies.

**Step 3** You have the following choices for each policy type:

- **Disabled**—Disables change comments.
- **Optional**—Gives users the option to describe their changes in a comment.
- **Required**—Requires users to describe their changes in a comment before saving.

**Step 4** Optionally for intrusion or network analysis policy comments:

- Check **Write changes in Intrusion Policy to audit log** to write all intrusion policy changes to the audit log.
- Check **Write changes in Network Analysis Policy to audit log** to write all network analysis policy changes to the audit log.

**Step 5** Click **Save**.

---

**The Access List**

On Firepower Management Center and Classic managed devices, you can use access lists to limit access to the system by IP address and port. By default, the following ports are enabled for any IP address:

- **443 (HTTPS)**—Used for web interface access.
- **22 (SSH)**—Used for command line access.

You can also add access to poll for SNMP information over port 161.

---

**Caution**

By default, access is not restricted. To operate in a more secure environment, consider adding access for specific IP addresses and then deleting the default any option.
Configuring the Access List for Your System

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC Classic</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

This configuration applies to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv):

- For the Firepower Management Center, this configuration is part of the system configuration.
- For a Classic managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.

In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.

Note that this access list does not control external database access.

Procedure

**Step 1**
Depending on whether you are configuring a Firepower Management Center or a Classic managed device:

- FMC—Choose System > Configuration.
- Managed device—Choose Devices > Platform Settings and create or edit a Firepower policy.

**Step 2**
Click Access List.

**Step 3**
Optionally, to delete one of the current settings, click the delete icon (🗑).

**Caution** If you delete access for the IP address that you are currently using to connect to the appliance interface, and there is no entry for “IP=any port=443”, you will lose access to the system when you deploy the policy.

**Step 4**
To add access for one or more IP addresses, click Add Rules.

**Step 5**
In the IP Address field, enter an IP address or address range, or any.

**Step 6**
Choose SSH, HTTPS, SNMP, or a combination of these options to specify which ports you want to enable for these IP addresses.

**Step 7**
Click Add.

**Step 8**
Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Firepower System IP Address Conventions, on page 14
Audit Logs

Firepower Management Center records the activity of management center users in read-only audit logs. Classic devices also maintain audit logs. See Audit Logs on Classic Devices, on page 500.

You can review audit log data in several ways:

- Audit logs are presented in a standard event view in the web interface. From this event view, you can view, sort, and filter audit log messages based on any item in the audit view. You can easily delete and report on audit information and you can view detailed reports of the changes that users make. See Auditing the System, on page 1791.

- You can configure Firepower Management Center to send audit log messages to the syslog.

- You can configure Firepower Management Center to stream audit log messages to an HTTP server.

Streaming audit log data to an external syslog or HTTP server allows you to conserve space on the local appliance. See Configure the Audit Log for External Streaming, on page 469.

Configure the Audit Log for External Streaming

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

The following is an example of the output structure:

```
Date Time  Host [Tag]  Sender: {User_Name}@{User_IP}, {Subsystem}, {Action}
```

where the local date, time, and hostname precede the bracketed optional tag, and the sending device name precedes the audit log message.

For example:

```
Mar 01 14:45:24 localhost [TAG]  Dev-DC3500: admin@10.1.1.2, Operations > Monitoring, Page View
```

Before you begin

- Ensure that the external host is functional and accessible from the system sending the audit log.

Procedure

1. Choose System > Configuration.
2. Click Audit Log.
3. Choose Enabled from the Send Audit Log to Syslog drop-down menu.
4. Designate the destination host for the audit information by using the IP address or the fully qualified name of the host in the Host field. The default port (514) is used.
Caution If the computer you configure to receive an audit log is not set up to accept remote messages, the host will not accept the audit log.

**Step 5** Choose a syslog **Facility**.

**Step 6** Choose a **Severity**.

**Step 7** Optionally, insert a reference tag in the **Tag (optional)** field.

**Step 8** To send regular audit log updates to an external HTTP server, choose **Enabled** from the **Send Audit Log to HTTP Server** drop-down list.

**Step 9** In the **URL to Post Audit** field, designate the URL where you want to send audit information. You must enter an URL that corresponds to a listener program that expects the HTTP POST variables as listed:

- subsystem
- actor
- event_type
- message
- action_source_ip
- action_destination_ip
- result
- time
- tag (if defined, as above)

Caution To allow encrypted posts, you must use an HTTPS URL. Note that sending audit information to an external URL may affect system performance.

**Step 10** Click **Save**.

---

**Dashboard Settings**

Dashboards provide you with at-a-glance views of current system status through the use of widgets: small, self-contained components that provide insight into different aspects of the Firepower System. The Firepower System is delivered with several predefined dashboard widgets.

You can configure the Firepower Management Center so that Custom Analysis widgets are enabled on the dashboard.

**Related Topics**

- About Dashboards, on page 197
Enabling Custom Analysis Widgets for Dashboards

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Use Custom Analysis dashboard widgets to create a visual representation of events based on a flexible, user-configurable query.

**Procedure**

1. Choose **System > Configuration**.
2. Click **Dashboard**.
3. Check the **Enable Custom Analysis Widgets** check box to allow users to add Custom Analysis widgets to dashboards.
4. Click **Save**.

DNS Cache

You can configure the system to resolve IP addresses automatically on the event view pages. You can also configure basic properties for DNS caching performed by the appliance. Configuring DNS caching allows you to identify IP addresses you previously resolved without performing additional lookups. This can reduce the amount of traffic on your network and speed the display of event pages when IP address resolution is enabled.

**Configuring DNS Cache Properties**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

DNS resolution caching is a system-wide setting that allows the caching of previously resolved DNS lookups.

**Procedure**

1. Choose **System > Configuration**.
2. Choose **DNS Cache**.
3. From the **DNS Resolution Caching** drop-down list, choose one of the following:
   - **Enabled**—Enable caching.
   - **Disabled**—Disable caching.
4. In the **DNS Cache Timeout (in minutes)** field, enter the number of minutes a DNS entry remains cached in memory before it is removed for inactivity.
The default setting is 300 minutes (five hours).

**Step 5**  
Click **Save**.

---

### Related Topics

- [Configuring Event View Settings](#), on page 31
- [Management Interfaces](#), on page 445

---

## Email Notifications

Configure a mail host if you plan to:

- Email event-based reports
- Email status reports for scheduled tasks
- Email change reconciliation reports
- Email data-pruning notifications
- Use email for discovery event, impact flag, correlation event alerting, intrusion event alerting, and health event alerting

When you configure email notification, you can select an encryption method for the communication between the system and mail relay host, and can supply authentication credentials for the mail server if needed. After configuring, you can test the connection.

### Configuring a Mail Relay Host and Notification Address

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  
Choose **System > Configuration**.

**Step 2**  
Click **Email Notification**.

**Step 3**  
In the **Mail Relay Host** field, enter the hostname or IP address of the mail server you want to use. The mail host you enter **must** allow access from the appliance.

**Step 4**  
In the **Port Number** field, enter the port number to use on the email server.

Typical ports include:

- 25, when using no encryption
- 465, when using SSLv3
- 587, when using TLS
Step 5  Choose an **Encryption Method**:

- SSLv3—Encrypt communications using Secure Socket Layers.
- None—Allow unencrypted communication.

**Note**  Certificate validation is not required for encrypted communication between the appliance and mail server.

Step 6  In the **From Address** field, enter the valid email address you want to use as the source email address for messages sent by the appliance.

Step 7  Optionally, to supply a user name and password when connecting to the mail server, choose **Use Authentication**. Enter a user name in the **Username** field. Enter a password in the **Password** field.

Step 8  To send a test email using the configured mail server, click **Test Mail Server Settings**. A message appears next to the button indicating the success or failure of the test.

Step 9  Click **Save**.

---

**Language Selection**

You can use the Language page to specify a different language for the web interface.

**Specifying a Different Language**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7000 &amp; 8000 Series</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This configuration applies to either a Firepower Management Center or a 7000 and 8000 Series managed device.

- For the Firepower Management Center, this configuration is part of the system configuration.
- For a 7000 and 8000 Series managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.

In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.

**Caution**

The language you specify here is used for the web interface for every user who logs into the appliance.

**Procedure**

**Step 1**  Depending on whether you are configuring a Firepower Management Center or a Classic managed device:
• FMC—Choose System > Configuration.
• Managed device—Choose Devices > Platform Settings and create or edit a Firepower policy.

Step 2
Click Language.

Step 3
Choose the language you want to use.

Step 4
Click Save.

What to do next
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Login Banners

You can use the Login Banner page to specify session, login, or custom message banners for a security appliance or shared policy.

You can use spaces but not tabs in banner text. You can specify multiple lines of text for the banner. If your text includes empty lines, the system displays this as a carriage return (CR) in the banner. You can only use ASCII characters, including new-line (press the Enter key), which counts as two characters.

When you access the security appliance through Telnet or SSH, the session closes if there is not enough system memory available to process the banner messages, or if a TCP write error occurs when attempting to display the banner messages.

Adding a Custom Login Banner

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Classic</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can create a custom login banner that appears to users logging in via either SSH or the web interface.

This configuration applies to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv):

• For the Firepower Management Center, this configuration is part of the system configuration.

• For a Classic managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.

In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.

Procedure

Step 1
Depending on whether you are configuring a Firepower Management Center or a Classic managed device:
SNMP Polling

You can enable Simple Network Management Protocol (SNMP) polling for Firepower Management Centers and Classic managed devices. This feature supports use of versions 1, 2, and 3 of the SNMP protocol. This feature allows access to:

- The standard management information base (MIB), which includes system details such as contact, administrative, location, service information, IP addressing and routing information, and transmission protocol usage statistics
- Additional MIBs for 7000 and 8000 Series managed devices that include statistics on traffic passing through physical interfaces, logical interfaces, virtual interfaces, ARP, NDP, virtual bridges, and virtual routers

When selecting SNMP versions for the SNMP protocol, note that SNMPv2 only supports read-only communities and SNMPv3 only supports read-only users. SNMPv3 also supports encryption with AES128.

Note that enabling the SNMP feature does not cause the system to send SNMP traps; it only makes the information in the MIBs available for polling by your network management system.

Configuring SNMP Polling

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC Classic</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

This configuration applies to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv):

- For the Firepower Management Center, this configuration is part of the system configuration.
- For a Classic managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.
In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.

Note
You must add SNMP access for any computer you plan to use to poll the system. Note that the SNMP MIB contains information that could be used to attack your deployment. Cisco recommends that you restrict your access list for SNMP access to the specific hosts that will be used to poll for the MIB. Cisco also recommends you use SNMPv3 and use strong passwords for network management access.

SNMPv3 only supports read-only users and encryption with AES128.

Before you begin
• Add SNMP access for each computer you plan to use to poll the system as described in Configuring the Access List for Your System, on page 468.

Procedure

Step 1
Depending on whether you are configuring a Firepower Management Center or a Classic managed device:
• FMC—Choose System > Configuration.
• Managed device—Choose Devices > Platform Settings and create or edit a Firepower policy.

Step 2
Click SNMP.

Step 3
From the SNMP Version drop-down list, choose the SNMP version you want to use.

Step 4
You have the following choices:
• If you chose Version 1 or Version 2, enter the SNMP community name in the Community String field. Go to step 13.
  Note SNMPv2 only supports read-only communities.

• If you chose Version 3, click Add User to display the user definition page.
  Note SNMPv3 only supports read-only users and encryption with AES128.

Step 5
Enter a Username.

Step 6
Choose the protocol you want to use for authentication from the Authentication Protocol drop-down list.

Step 7
Enter the password required for authentication with the SNMP server in the Authentication Password field.

Step 8
Re-enter the authentication password in the Verify Password field.

Step 9
Choose the privacy protocol you want to use from the Privacy Protocol list, or choose None to not use a privacy protocol.

Step 10
Enter the SNMP privacy key required by the SNMP server in the Privacy Password field.

Step 11
Re-enter the privacy password in the Verify Password field.

Step 12
Click Add.

Step 13
Click Save.
What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

STIG Compliance

Organizations within the United States federal government sometimes need to comply with a series of security checklists set out in Security Technical Implementation Guides (STIGs). The Firepower System supports compliance with STIG requirements established by the United States Department of Defense.

If you enable STIG compliance on any appliances in your deployment, you must enable it on all appliances. Non-compliant managed devices cannot be registered to STIG-compliant Firepower Management Centers and STIG-compliant devices cannot be registered to non-compliant Firepower Management Centers.

Enabling STIG compliance does not guarantee strict compliance to all applicable STIGs.

When you enable STIG compliance, password complexity and retention rules for local shell access accounts change. In addition, you cannot use SSH remote storage when in STIG compliance mode.

Caution

You cannot disable this setting without assistance from Support. In addition, this setting may substantially impact the performance of your system. Cisco does not recommend enabling STIG compliance except to comply with Department of Defense security requirements.

Enabling STIG Compliance

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td>Any</td>
<td>Classic</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This configuration applies to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv):

- For the Firepower Management Center, this configuration is part of the system configuration.
- For a Classic managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.

In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.

Caution

If you enable STIG compliance on any appliances in your deployment, you must enable it on all appliances.

You cannot disable this setting without assistance from Support. In addition, this setting may substantially impact the performance of your system. Cisco does not recommend enabling STIG compliance except to comply with Department of Defense security requirements.
Procedure

**Step 1** Depending on whether you are configuring a Firepower Management Center or a Classic managed device:
- FMC—Choose **System > Configuration**.
- Managed device—Choose **Devices > Platform Settings** and create or edit a Firepower policy.

**Step 2** Click **STIG Compliance**.

*Note* Appliances reboot when you enable STIG compliance. The Firepower Management Center reboots when you save the system configuration; managed devices reboot when you deploy configuration changes.

**Step 3** If you want to *permanently* enable STIG compliance on the appliance, choose **Enable STIG Compliance**.

**Step 4** Click **Save**.

**What to do next**
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
- If your appliances were updated from versions earlier than Version 5.2.0, enabling STIG compliance regenerates appliance certificates. After you enable STIG compliance across your deployment, re-register managed devices to the Firepower Management Center.

**Time and Time Synchronization**

Synchronizing the system time on your Firepower Management Center and its managed devices is essential to successful operation of your Firepower System.

Use a Network Time Protocol (NTP) server to synchronize system time on FMC and all devices.

---

**Caution** Unintended consequences may occur when time is not synchronized between the Firepower Management Center and managed devices.

**Synchronize Time Using a Network NTP Server**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

The best way to ensure proper synchronization between Firepower Management Center and all managed devices is to use an NTP server on your network.

**Before you begin**

Note the following:
• If your FMC and managed devices cannot access a network NTP server, do not use this procedure. Instead, see Synchronize Time Without Access to a Network NTP Server, on page 479.

• Do not specify an untrusted NTP server.

• Connections to NTP servers do not use configured proxy settings.

⚠️ Caution

If the Firepower Management Center is rebooted and your DHCP server sets an NTP server record different than the one you specify here, the DHCP-provided NTP server will be used instead. To avoid this situation, configure your DHCP server to set the same NTP server.

Procedure

Step 1
Choose System > Configuration.

Step 2
Click Time Synchronization.

Step 3
If Serve Time via NTP is Enabled, choose Disabled.

Step 4
For the Set My Clock option, choose Via NTP from and enter the hostname or IP address of an NTP server. If your organization has corroborative NTP servers, enter multiple NTP servers as a comma-separated list.

Step 5
Click Save.

Step 6
Set managed devices to synchronize with the same NTP server:

a) In the Time Synchronization settings for the platform settings policy assigned to your managed devices, set the clock to synchronize Via NTP from and specify the same NTP server that you specified above.

b) Deploy the change to the devices.

For instructions:

See Synchronizing Time on Classic Devices, on page 510.

Synchronize Time Without Access to a Network NTP Server

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If your devices cannot directly reach the network NTP server, or your organization does not have a network NTP server, a physical-hardware Firepower Management Center can serve as an NTP server.

⚠️ Important

Do not use a virtual Firepower Management Center as an NTP server.
Procedure

Step 1  Manually set the system time on the Firepower Management Center:
   a) Choose System > Configuration.
   b) Click Time Synchronization.
   c) If Serve Time via NTP is Enabled, choose Disabled.
   d) Click Save.
   e) For Set My Clock, choose Manually in Local Configuration.
   f) Click Save.
   g) In the navigation panel at the left side of the screen, click Time.
   h) Use the Set Time drop-down lists to set the time.
   i) If the time zone displayed is not UTC, click it and set the time zone to UTC.
   j) Click Save.
   k) Click Done.
   l) Click Apply.

Step 2  Set the Firepower Management Center to serve as an NTP server:
   a) In the navigation panel at the left side of the screen, click Time Synchronization.
   b) For Serve Time via NTP, choose Enabled.
   c) Click Save.

Step 3  Set managed devices to synchronize with the Firepower Management Center NTP server:
   a) In the Time Synchronization settings for the platform settings policy assigned to your managed devices, set the clock to synchronize Via NTP from Management Center.
   b) Deploy the change to managed devices.

For instructions:
See Synchronizing Time on Classic Devices, on page 510.

About Changing Time Synchronization Settings

• If you configure the FMC to serve time using NTP, and then later disable it, the NTP service on managed devices still attempts to synchronize time with the FMC. You must update and redeploy any applicable platform settings policies to establish a new time source.

• If you need to change the time manually after configuring the Firepower Management Center as an NTP server, you need to disable the NTP option, change the time manually, and then re-enable the NTP option.

View Current System Time, Source, and NTP Server Connection Status

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>
Time settings are displayed on most pages in local time using the time zone you set on the Time Zone page in User Preferences (the default is America/New York), but are stored on the appliance using UTC time.

In addition, the current time appears in UTC at the top of the Time Synchronization page (local time is displayed in the Manual clock setting option, if enabled).

**Restriction**

The Time Zone function (in User Preferences) assumes that the default system clock is set to UTC time. DO NOT ATTEMPT TO CHANGE THE SYSTEM TIME. Be advised that changing the system time from UTC is NOT supported, and doing so will require you to reimage the device to recover from an unsupported state.

**Note**

To view time and time source information on your NGIPS hardware device, see View Current System Time, Source, and NTP Server Connection Status for NGIPS Devices, on page 511.

**Procedure**

**Step 1**

Choose **System > Configuration**.

**Step 2**

Click **Time**.

If your appliance uses an NTP server: For information about the table entries, see NTP Server Status, on page 481.

**NTP Server Status**

When the system is synchronizing time from an NTP server, you can view the NTP Status from the Firepower Management Center's **Time** page (under the **System > Configuration** menu) and from the local web interface of 7000 and 8000 Series devices:

**Table 62: NTP Status**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTP Server</td>
<td>The IP address and name of the configured NTP server.</td>
</tr>
</tbody>
</table>
### Session Timeouts

Unattended login sessions of the Firepower System web interface or auxiliary command line interface may be security risks. You can configure, in minutes, the amount of idle time before a user’s login session times out due to inactivity. You can also set a similar timeout for shell (command line) sessions.

Your deployment may have users who plan to passively, securely monitor the web interface for long periods of time. You can exempt users from the web interface session timeout with a user configuration option. Users with the Administrator role, whose complete access to menu options poses an extra risk if compromised, cannot be made exempt from session timeouts.

### Configuring Session Timeouts

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

This configuration applies to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv):

- For the Firepower Management Center, this configuration is part of the system configuration.
For a Classic managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.

In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.

**Procedure**

**Step 1** Depending on whether you are configuring a Firepower Management Center or a Classic managed device:
- FMC—Choose System > Configuration.
- Managed device—Choose Devices > Platform Settings and create or edit a Firepower policy.

**Step 2** Click Shell Timeout.

**Step 3** You have the following choices:
- To configure session timeout for the web interface, enter a number (of minutes) in the Browser Session Timeout (Minutes) field. The default value is 60; the maximum value is 1440 (24 hours). For information on how to exempt users from this session timeout, see User Account Login Options, on page 64.
- To configure session timeout for the command line interface, enter a number (of minutes) in the Shell Timeout (Minutes) field. The default value is 0; the maximum value is 1440 (24 hours).

**Step 4** Click Save.

**What to do next**
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Vulnerability Mapping**

The Firepower System automatically maps vulnerabilities to a host IP address for any application protocol traffic received or sent from that address, when the server has an application ID in the discovery event database and the packet header for the traffic includes a vendor and version.

For any servers which do not include vendor or version information in their packets, you can configure whether the system associates vulnerabilities with server traffic for these vendor and versionless servers.

For example, a host serves SMTP traffic that does not have a vendor or version in the header. If you enable the SMTP server on the Vulnerability Mapping page of a system configuration, then save that configuration to the Firepower Management Center managing the device that detects the traffic, all vulnerabilities associated with SMTP servers are added to the host profile for the host.

Although detectors collect server information and add it to host profiles, the application protocol detectors will not be used for vulnerability mapping, because you cannot specify a vendor or version for a custom application protocol detector and cannot select the server for vulnerability mapping.
Mapping Vulnerabilities for Servers

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Protection</td>
<td>FMC</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Choose System > Configuration.

**Step 2** Choose Vulnerability Mapping.

**Step 3** You have the following choices:

- To prevent vulnerabilities for a server from being mapped to hosts that receive application protocol traffic without vendor or version information, clear the check box for that server.
- To cause vulnerabilities for a server to be mapped to hosts that receive application protocol traffic without vendor or version information, check the check box for that server.

**Tip** You can check or clear all check boxes at once using the check box next to Enabled.

**Step 4** Click Save.

Remote Console Access Management

You can use a Linux system console for remote access on supported systems via either the VGA port (which is the default) or the serial port on the physical appliance. Use the Console Configuration page to choose the option most suitable to the physical layout of your organization’s Cisco deployment.

On supported physical-hardware-based Firepower systems, you can use Lights-Out Management (LOM) on the default (eth0) management interface on a Serial Over LAN (SOL) connection to remotely monitor or manage the system without logging into the management interface of the system. You can perform limited tasks, such as viewing the chassis serial number or monitoring such conditions as fan speed and temperature, using a command line interface on an out-of-band management connection.

You must enable LOM for both the system and the user you want to manage the system. After you enable the system and the user, you use a third-party Intelligent Platform Management Interface (IPMI) utility to access and manage your system.

Configuring Remote Console Settings on the System

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC and 7000 &amp; 8000 Series</td>
<td>Global only</td>
<td>Admin with LOM access</td>
</tr>
</tbody>
</table>
Before you begin

- Disable Spanning Tree Protocol (STP) on any third-party switching equipment connected to the device’s management interface.

Procedure

**Step 1** Choose **System > Configuration**.

**Step 2** Click **Console Configuration**.

**Step 3** Choose a remote console access option:

- Choose **VGA** to use the appliance’s VGA port.
- Choose **Physical Serial Port** to use the appliance’s serial port, or to use LOM/SOL on a Firepower Management Center, Firepower 7050, or 8000 Series device.
- Choose **Lights-Out Management** to use LOM/SOL on a 7000 Series device (except the Firepower 7050). On these devices, you cannot use SOL and a regular serial connection at the same time.

**Note** When you change your remote console from **Physical Serial Port** to **Lights-Out Management** or from **Lights-Out Management** to **Physical Serial Port** on the 70xx Family of devices (except the Firepower 7050), you may have to reboot the appliance twice to see the expected boot prompt.

**Step 4** To configure LOM via SOL, enter the necessary IPv4 settings:

- Choose the address **Configuration** for the system (**DHCP** or **Manual**)
- Enter the **IP Address** to be used for LOM.

**Note** The LOM IP address must be different from the management interface IP address of the system.

- Enter the **Netmask** for the system.
- Enter the **Default Gateway** for the system.

**Step 5** Click **Save**.

What to do next


**Lights-Out Management User Access Configuration**

You must explicitly grant Lights-Out Management permissions to users who will use the feature. LOM users also have the following restrictions:

- You must assign the Administrator role to the user.
- The username may have up to 16 alphanumeric characters. Hyphens and longer user names are not supported for LOM users.
The password may have up to 20 alphanumeric characters, except when set on 71xx Family devices. If LOM is enabled on a Firepower 7110, 7115, 7120, or 7125 device, the password may have up to 16 alphanumeric characters. Passwords longer than 20 or 16 characters, respectively, are not supported for LOM users. A user’s LOM password is the same as that user’s system password. Cisco recommends that you use a complex, non-dictionary-based password of the maximum supported length for your appliance and change it every three months.

Physical Firepower Management Centers and 8000 Series devices can have up to 13 LOM users. 8000 Series devices can have up to eight LOM users.

Note that if you deactivate, then reactivate, a role with LOM while a user with that role is logged in, or restore a user or user role from a backup during that user’s login session, that user must log back into the web interface to regain access to IPMI tool commands.

### Enabling Lights-Out Management User Access

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC and 7000 &amp; 8000 Series</td>
<td>Global only</td>
<td>Admin with LOM access</td>
</tr>
</tbody>
</table>

You configure LOM and LOM users on a per-system basis using each system’s local web interface. You cannot use the Firepower Management Center to configure LOM on a managed device. Similarly, because users are managed independently per appliance, enabling or creating a LOM-enabled user on the Firepower Management Center does not transfer that capability to users on managed devices.

**Procedure**

**Step 1** Choose **System > Configuration**.

**Step 2** Click **Console Configuration**.

**Step 3** Click **Lights Out Management**.

**Step 4** You have the following choices:

- To grant LOM user access to an existing user, click the edit icon (📝) next to a user name in the list.
- To grant LOM user access to a new user, click **Create User**.

**Step 5** Under **User Configuration**, enable the Administrator role.

**Step 6** Check the **Allow Lights-Out Management Access** check box.

**Step 7** Click **Save**.

### Serial Over LAN Connection Configuration

You use a third-party IPMI utility on your computer to create a Serial Over LAN connection to the appliance. If your computer uses a Linux-like or Mac environment, use IPMItool; for Windows environments, use IPMIutil.
Cisco recommends using IPMItool version 1.8.12 or greater.

**Linux**

IPMItool is standard with many distributions and is ready to use.

**Mac**

You must install IPMItool on a Mac. First, confirm that your Mac has Apple's XCode Developer tools installed, making sure that the optional components for command line development are installed (UNIX Development and System Tools in newer versions, or Command Line Support in older versions). Then you can install macports and the IPMItool. Use your favorite search engine for more information or try these sites:

http://www.macports.org/

**Windows**

You must compile IPMIutil on Windows. If you do not have access to a compiler, you can use IPMIutil itself to compile. Use your favorite search engine for more information or try this site:

http://ipmiutil.sourceforge.net/

**Understanding IPMI Utility Commands**

Commands used for IPMI utilities are composed of segments as in the following IPMItool example:

```bash
ipmitool -I lanplus -H IP_address -U user_name command
```

where:

- **ipmitool** invokes the utility
- **-I lanplus** enables encryption for the session
- **-H IP_address** indicates the IP address of the appliance you want to access
- **-U user_name** is the name of an authorized user
- **command** is the name of the command you want to give

The same command for Windows looks like this:

```bash
ipmiutil command -V 4 -J 3 -N IP_address -U user_name
```

This command connects you to the command line on the appliance where you can log in as if you were physically present at the appliance. You may be prompted to enter a password.
Configuring Serial Over LAN with IPMItool

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC and 7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin with LOM access</td>
</tr>
</tbody>
</table>

**Procedure**

Using IPMItool, enter the following command, and a password if prompted:

```
ipmitool -I lanplus -H IP_address -U user_name sol activate
```

Configuring Serial Over LAN with IPMIutil

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC and 7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin with LOM access</td>
</tr>
</tbody>
</table>

**Procedure**

Using IPMIutil, enter the following command, and a password if prompted:

```
ipmiutil -J 3 -H IP_address -U username sol -a
```

Lights-Out Management Overview

Lights-Out Management (LOM) provides the ability to perform a limited set of actions over an SOL connection on the default (eth0) management interface without the need to log into the system. You use the command to create a SOL connection followed by one of the LOM commands. After the command is completed, the connection ends. Note that not all power control commands are valid on 70xx Family devices.

**Note**

The baseboard management controller (BMC) for a Firepower 71xx, Firepower 82xx, or a Firepower 83xx device is only accessible via 1Gbps link speeds when the host is powered on. When the device is powered down, the BMC can only establish Ethernet link at 10 and 100Mbps. Therefore if LOM is being used to remotely power the device, connect the device to the network using 10 and 100Mbps link speeds only.
In rare cases, if your computer is on a different subnet than the system's management interface and the system is configured for DHCP, attempting to access LOM features can fail. If this occurs, you can either disable and then re-enable LOM on the system, or use a computer on the same subnet as the system to ping its management interface. You should then be able to use LOM.

Cisco is aware of a vulnerability inherent in the Intelligent Platform Management Interface (IPMI) standard (CVE-2013-4786). Enabling Lights-Out Management (LOM) on an system exposes this vulnerability. To mitigate this vulnerability, deploy your systems on a secure management network accessible only to trusted users and use a complex, non-dictionary-based password of the maximum supported length for your system and change it every three months. To prevent exposure to this vulnerability, do not enable LOM.

If all attempts to access your system have failed, you can use LOM to restart your system remotely. Note that if a system is restarted while the SOL connection is active, the LOM session may disconnect or time out.

Do not restart your system unless it does not respond to any other attempts to restart. Remotely restarting does not gracefully reboot the system and you may lose data.

Table 63: Lights-Out Management Commands

<table>
<thead>
<tr>
<th>IPMIttool</th>
<th>IPMIutil</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(not applicable)</td>
<td>-V 4</td>
<td>Enables admin privileges for the IPMI session</td>
</tr>
<tr>
<td>-I lanplus</td>
<td>-J 3</td>
<td>Enables encryption for the IPMI session</td>
</tr>
<tr>
<td>-H</td>
<td>-N</td>
<td>Indicates the IP address of the remote appliance</td>
</tr>
<tr>
<td>-U</td>
<td>-U</td>
<td>Indicates the username of an authorized LOM account</td>
</tr>
<tr>
<td>sol activate</td>
<td>sol -a</td>
<td>Starts the SOL session</td>
</tr>
<tr>
<td>sol deactivate</td>
<td>sol -d</td>
<td>Ends the SOL session</td>
</tr>
<tr>
<td>chassis power cycle</td>
<td>power -c</td>
<td>Restarts the appliance (not valid on 70xx Family devices)</td>
</tr>
<tr>
<td>chassis power on</td>
<td>power -u</td>
<td>Powers up the appliance</td>
</tr>
<tr>
<td>chassis power off</td>
<td>power -d</td>
<td>Powers down the appliance (not valid on 70xx Family devices)</td>
</tr>
<tr>
<td>sdr</td>
<td>sensor</td>
<td>Displays appliance information, such as fan speeds and temperatures</td>
</tr>
</tbody>
</table>
For example, to display a list of appliance information, the IPMItool command is:

```
ipmitool -I lanplus -H IP_address -U user_name sdr
```

**Note** Cisco recommends using IPMItool version 1.8.12 or greater.

The same command with the IPMIutil utility is:

```
ipmiutil sensor -V 4 -J 3 -N IP_address -U user_name
```

### Configuring Lights-Out Management with IPMItool

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC and 7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin with LOM access</td>
</tr>
</tbody>
</table>

**Procedure**

Enter the following command for IPMItool and a password if prompted:

```
ipmitool -I lanplus -H IP_address -U user_name command
```

### Configuring Lights-Out Management with IPMIutil

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC and 7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin with LOM access</td>
</tr>
</tbody>
</table>

**Procedure**

Enter the following command for IPMIutil and a password if prompted:

```
ipmiutil -J 3 -H IP_address -U username command
```
VMware Tools and Virtual Systems

VMware Tools is a suite of performance-enhancing utilities intended for virtual machines. These utilities allow you to make full use of the convenient features of VMware products. Firepower virtual appliances running on VMware support the following plugins:

- guestInfo
- powerOps
- timeSync
- vmbackup

You can also enable VMware Tools on all supported versions of ESXi. For a list of supported versions, see the Cisco Firepower NGIPSv for VMware Quick Start Guide. For information on the full functionality of VMware Tools, see the VMware website (http://www.vmware.com/).

Enabling VMware Tools on the Firepower Management Center for VMware

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Firepower Management Center</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Because NGIPSv does not have a web interface, you must use the CLI to enable VMware Tools on that platform; see the Cisco Firepower NGIPSv for VMware Quick Start Guide.

Procedure

Step 1 Choose System > Configuration.
Step 2 Click VMware Tools.
Step 3 Click Enable VMware Tools.
Step 4 Click Save.
Platform Settings Policies for Managed Devices

The following topics explain platform settings policies and how to deploy them to managed devices:

- Introduction to Platform Settings, on page 493
- Managing Platform Settings Policies, on page 494
- Creating a Platform Settings Policy, on page 494
- Setting Target Devices for a Platform Settings Policy, on page 495

Introduction to Platform Settings

A platform settings policy is a shared set of features or parameters that define the aspects of a managed device that are likely to be similar to other managed devices in your deployment, such as time settings and external authentication.

A shared policy makes it possible to configure multiple managed devices at once, which provides consistency in your deployment and streamlines your management efforts. Any changes to a platform settings policy affects all the managed devices where you applied the policy. Even if you want different settings per device, you must create a shared policy and apply it to the desired device.

For example, your organization’s security policies may require that your appliances have a “No Unauthorized Use” message when a user logs in. With platform settings, you can set the login banner once in a platform settings policy.

You can also benefit from having multiple platform settings policies on a Firepower Management Center. For example, if you have different mail relay hosts that you use under different circumstances or if you want to test different access lists, you can create several platform settings policies and switch between them, rather than editing a single policy.

Related Topics
- Configuring Firepower Platform Settings, on page 497
- System Configuration Settings, on page 434
Managing Platform Settings Policies

Use the Platform Settings page (Devices > Platform Settings) to manage platform settings policies. This page indicates the type of device for each policy. The Status column shows the device targets for the policy.

Procedure

**Step 1** Choose Devices > Platform Settings.

**Step 2** Manage your platform settings policies:

- **Create** — To create a new platform settings policy, click New Policy; see Creating a Platform Settings Policy, on page 494.

- **Copy** — To copy a platform settings policy, click the copy icon (COPYICON).

- **Edit** — To modify the settings in an existing platform settings policy, click the edit icon (EDITICON).

- **Delete** — To delete a policy that is not in use, click the delete icon (DELETEICON), then confirm your choice.

**Caution** You should not delete a policy that is the last deployed policy on any of its target devices, even if it is out of date. Before you delete the policy completely, it is good practice to deploy a different policy to those targets.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Creating a Platform Settings Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin Admin</td>
</tr>
</tbody>
</table>

Firepower Management Center Configuration Guide, Version 6.0
### Setting Target Devices for a Platform Settings Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can add targeted devices at the same time you create a new policy, or you can change them later.

#### Procedure

**Step 1** Choose Devices > Platform Settings.

**Step 2** Click the edit icon (📝) next to the platform settings policy that you want to edit.

**Step 3** Click Policy Assignment.

**Step 4** Do any of the following:

- To assign a device, stack, high-availability pair, or device group to the policy, select it in the Available Devices list and click Add to Policy. You can also drag and drop.

- To remove a device assignment, click the delete icon (🗑️) next to a device, stack, high-availability pair, or device group in the Selected Devices list.
Step 5  Click OK.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Platform Settings for Classic Devices

The following topics explain Firepower platform settings and how to configure them on Classic devices:

- Introduction to Firepower Platform Settings, on page 497
- Configuring Firepower Platform Settings, on page 497
- The Access List, on page 498
- Audit Logs on Classic Devices, on page 500
- External Authentication Settings, on page 501
- Language Selection, on page 503
- Login Banners, on page 504
- Session Timeouts, on page 505
- SNMP Polling, on page 506
- STIG Compliance, on page 508
- Time and Time Synchronization (Classic Devices), on page 509

Introduction to Firepower Platform Settings

Platform settings for Firepower Classic managed devices configure a range of unrelated features whose values you might want to share among several devices. In this case, 7000 and 8000 Series, ASA FirePOWER modules, and NGIPSv devices. Even if you want different settings per device, you must create a shared policy and apply it to the desired device.

Related Topics
- Platform Settings Policies for Managed Devices, on page 493
- System Configuration Settings, on page 434

Configuring Firepower Platform Settings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Classic</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

To configure platform settings, you can edit an existing platform settings policy or create a new policy. If you edit a platform settings policy that is currently deployed to a device, redeploy the policy after you have saved your changes.
**Procedure**

**Step 1** Choose **Devices > Platform Settings.**

The Platform Settings page appears, including a list of the existing policies.

**Step 2** Create a new policy or edit an existing policy.

- To create a new policy, see Creating a Platform Settings Policy, on page 494.
- To edit an existing policy, click the edit icon next to the policy that you want to edit.

The Edit Policy page appears. You can change the policy name and policy description. For information about configuring each aspect of the platform settings policy, see one of the following sections:

  - Configuring the Access List for Your System, on page 468
  - Configure the Audit Log for External Streaming, on page 469
  - Enabling External Authentication to Classic Devices, on page 502
  - Specifying a Different Language, on page 473
  - Adding a Custom Login Banner, on page 474
  - Configuring Session Timeouts, on page 482
  - Configuring SNMP Polling, on page 475
  - Enabling STIG Compliance, on page 477
  - Synchronizing Time on Classic Devices, on page 510

**Step 3** (Optional) Click **Policy Assignment** to choose the **Available Devices** where you want to deploy the policy. Click **Add to Policy** (or drag and drop) to add the selected devices.

You can enter a search string in the **Search** field to narrow the list of devices.

**Step 4** Click **Save.**

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**The Access List**

On Firepower Management Center and Classic managed devices, you can use access lists to limit access to the system by IP address and port. By default, the following ports are enabled for any IP address:

- 443 (HTTPS)—Used for web interface access.
- 22 (SSH)—Used for command line access.

You can also add access to poll for SNMP information over port 161.

**Caution**

By default, access is not restricted. To operate in a more secure environment, consider adding access for specific IP addresses and then deleting the default any option.
Configuring the Access List for Your System

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Classic</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This configuration applies to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv):

- For the Firepower Management Center, this configuration is part of the system configuration.
- For a Classic managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.

In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.

Note that this access list does not control external database access.

**Procedure**

**Step 1**
Depending on whether you are configuring a Firepower Management Center or a Classic managed device:

- FMC—Choose System > Configuration.
- Managed device—Choose Devices > Platform Settings and create or edit a Firepower policy.

**Step 2**
Click Access List.

**Step 3**
Optionally, to delete one of the current settings, click the delete icon (✓).

**Caution** If you delete access for the IP address that you are currently using to connect to the appliance interface, and there is no entry for “IP=any port=443”, you will lose access to the system when you deploy the policy.

**Step 4**
To add access for one or more IP addresses, click Add Rules.

**Step 5**
In the IP Address field, enter an IP address or address range, or any.

**Step 6**
Choose SSH, HTTPS, SNMP, or a combination of these options to specify which ports you want to enable for these IP addresses.

**Step 7**
Click Add.

**Step 8**
Click Save.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Audit Logs on Classic Devices

Classic devices record the activity of management center users in read-only audit logs.

You can review audit log data in several ways:

- Audit logs are presented in a standard event view in the web interface. From this event view, you can view, sort, and filter audit log messages based on any item in the audit view. You can easily delete and report on audit information and you can view detailed reports of the changes that users make. See Auditing the System, on page 1791.

- You can configure Classic devices to send audit log messages to the syslog.

- You can configure Classic devices to stream audit log messages to an HTTP server.

Streaming audit log data to an external syslog or HTTP server allows you to conserve space on the local device. See Configuring the Audit Log for External Streaming from Classic Devices, on page 500.

Configuring the Audit Log for External Streaming from Classic Devices

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>Classic</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

The following is an example of the output structure:

Date Time Host [Tag] Sender: [User_Name]@[User_IP], [Subsystem], [Action]

where the local date, time, and hostname precede the bracketed optional tag, and the sending device name precedes the audit log message.

For example:

Mar 01 14:45:24 localhost [TAG] Dev-DC3500: admin@10.1.1.2, Operations > Monitoring, Page View

Before you begin

- Ensure that the external host is functional and accessible from the system sending the audit log.

Procedure

Step 1  Choose Devices > Platform Settings.
Step 2  Create or edit a Firepower policy.
Step 3  Click Audit Log.
Step 4  Choose Enabled from the Send Audit Log to Syslog drop-down menu.
Step 5  Designate the destination host for the audit information by using the IP address or the fully qualified name of the host in the Host field. The default port (514) is used.

Caution  If the computer you configure to receive an audit log is not set up to accept remote messages, the host will not accept the audit log.
Step 6  Choose a syslog **Facility**.
Step 7  Choose a **Severity**.
Step 8  Optionally, insert a reference tag in the **Tag (optional)** field.
Step 9  To send regular audit log updates to an external HTTP server, choose **Enabled** from the **Send Audit Log to HTTP Server** drop-down list.
Step 10 In the **URL to Post Audit** field, designate the URL where you want to send audit information. You must enter an URL that corresponds to a listener program that expects the HTTP POST variables as listed:

- subsystem
- actor
- event_type
- message
- action_source_ip
- action_destination_ip
- result
- time
- tag (if defined, as above)

**Caution**  To allow encrypted posts, you must use an HTTPS URL. Note that sending audit information to an external URL may affect system performance.

Step 11  Click **Save**.

---

**What to do next**

- Make sure the policy is assigned to your devices. See Setting Target Devices for a Platform Settings Policy, on page 495.

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**External Authentication Settings**

If you create an authentication object referencing an external authentication server, you can enable external authentication to let users logging into the managed device authenticate to that server, rather than using the local database.

When you enable external authentication, the system verifies the user credentials against users on an LDAP or RADIUS server. In addition, if a user has local, internal authentication enabled and the user credentials are not found in the internal database, the system then checks the external server for a set of matching credentials. If a user has the same username on multiple systems, all passwords across all servers work. Note, however, that if authentication fails on the available external authentication servers, the system does not revert to checking the local database.
When you enable external authentication, you can set the default user role for any user whose account is externally authenticated. You can select multiple roles, as long as those roles can be combined. For example, if you enable external authentication that retrieves only users in the Network Security group in your company, you may set the default user role to include the Security Analyst role so users can access collected event data without any additional user configuration on your part. However, if your external authentication retrieves records for other personnel in addition to the security group, you would probably want to leave the default role unselected.

If no access role is selected, users can log in but cannot access any functionality. After a user attempts to log in, their account is listed on the user management page (System > Users), where you can edit the account settings to grant additional permissions.

Tip

If you configure the system to use one user role and apply the policy, then later modify the configuration to use different default user roles, any user accounts created before the modification retain the first user role until you modify the accounts, or delete and recreate them.

If you want to specify the set of users who can authenticate against the LDAP server for shell access or for CAC authentication and authorization, you must create separate authentication objects for each and enable the objects separately.

If a user with internal authentication attempts to log in, the system first checks if that user is in the local user database. If the user exists, the system then checks the username and password against the local database. If a match is found, the user logs in successfully. If the login fails, however, and external authentication is enabled, the system checks the user against each external authentication server in the authentication order shown in the configuration. If the username and password match results from an external server, the system changes the user to an external user with the default privileges for that authentication object.

If an external user attempts to log in, the system checks the username and password against the external authentication server. If a match is found, the user logs in successfully. If the login fails, the user login attempt is rejected. External users cannot authenticate against the user list in the local database. If the user is a new external user, an external user account is created in the local database with the default privileges from the external authentication object.

Related Topics

User Accounts, on page 61

Enabling External Authentication to Classic Devices

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>7000 &amp; 8000</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Before you begin

- Configure external authentication objects as described in External Authentication, on page 69.

Procedure

Step 1

Choose Devices > Platform Settings and create or edit a Firepower policy.
Step 2  Click **External Authentication**.

Step 3  From the **Status** drop-down list, choose **Enabled**.

Step 4  From the **Default User Role** drop-down list, choose user roles to define the default permissions you want to grant to externally authenticated users.

Step 5  If you want to use the external server to authenticate CLI or shell access accounts, choose **Enabled** from the **Shell Authentication** drop-down list.

Step 6  If you want to enable CAC authentication and authorization, choose an available CAC authentication object from the **CAC Authentication** drop-down list. For information about configuring CAC authentication and authorization, see **CAC Authentication**, on page 71.

Step 7  Check the check boxes next to the each external authentication object that you want to use. If you enable more than 1 object, then users are checked against servers in the order specified. See the next step to reorder servers.

If you enable shell authentication, you must enable an external authentication object that includes a **Shell Access Filter**. CLI/shell access users can only authenticate against the server whose authentication object is highest in the list.

If you need both CLI and CAC authentication, you must use separate authentication objects for each purpose.

Step 8  (Optional) Use the up and down arrows to change the order in which authentication servers are accessed when an authentication request occurs.

Step 9  Click **Save**.

---

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

---

**Language Selection**

You can use the Language page to specify a different language for the web interface.

**Specifying a Different Language**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

This configuration applies to either a Firepower Management Center or a 7000 and 8000 Series managed device.

- For the Firepower Management Center, this configuration is part of the system configuration.

- For a 7000 and 8000 Series managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.

In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.
The language you specify here is used for the web interface for every user who logs into the appliance.

**Procedure**

**Step 1** Depending on whether you are configuring a Firepower Management Center or a Classic managed device:
- **FMC**—Choose *System > Configuration*.
- Managed device—Choose *Devices > Platform Settings* and create or edit a Firepower policy.

**Step 2** Click **Language**.

**Step 3** Choose the language you want to use.

**Step 4** Click **Save**.

**What to do next**
- Deploy configuration changes; see *Deploy Configuration Changes, on page 277*.

---

**Login Banners**

You can use the Login Banner page to specify session, login, or custom message banners for a security appliance or shared policy.

You can use spaces but not tabs in banner text. You can specify multiple lines of text for the banner. If your text includes empty lines, the system displays this as a carriage return (CR) in the banner. You can only use ASCII characters, including new-line (press the Enter key), which counts as two characters.

When you access the security appliance through Telnet or SSH, the session closes if there is not enough system memory available to process the banner messages, or if a TCP write error occurs when attempting to display the banner messages.

**Adding a Custom Login Banner**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC Classic</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can create a custom login banner that appears to users logging in via either SSH or the web interface.

This configuration applies to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv):
- For the Firepower Management Center, this configuration is part of the system configuration.
- For a Classic managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.
In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.

**Procedure**

**Step 1** Depending on whether you are configuring a Firepower Management Center or a Classic managed device:
- FMC—Choose System > Configuration.
- Managed device—Choose Devices > Platform Settings and create or edit a Firepower policy.

**Step 2** Choose Login Banner.

**Step 3** In the Custom Login Banner field, enter the login banner text you want to use.

**Step 4** Click Save.

**What to do next**
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

### Session Timeouts

Unattended login sessions of the Firepower System web interface or auxiliary command line interface may be security risks. You can configure, in minutes, the amount of idle time before a user’s login session times out due to inactivity. You can also set a similar timeout for shell (command line) sessions.

Your deployment may have users who plan to passively, securely monitor the web interface for long periods of time. You can exempt users from the web interface session timeout with a user configuration option. Users with the Administrator role, whose complete access to menu options poses an extra risk if compromised, cannot be made exempt from session timeouts.

### Configuring Session Timeouts

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC Classic</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

This configuration applies to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv):
- For the Firepower Management Center, this configuration is part of the system configuration.
- For a Classic managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.

In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.
**SNMP Polling**

You can enable Simple Network Management Protocol (SNMP) polling for Firepower Management Centers and Classic managed devices. This feature supports use of versions 1, 2, and 3 of the SNMP protocol.

This feature allows access to:

- The standard management information base (MIB), which includes system details such as contact, administrative, location, service information, IP addressing and routing information, and transmission protocol usage statistics
- Additional MIBs for 7000 and 8000 Series managed devices that include statistics on traffic passing through physical interfaces, logical interfaces, virtual interfaces, ARP, NDP, virtual bridges, and virtual routers

---

**Note**

When selecting SNMP versions for the SNMP protocol, note that SNMPv2 only supports read-only communities and SNMPv3 only supports read-only users. SNMPv3 also supports encryption with AES128.

Note that enabling the SNMP feature does not cause the system to send SNMP traps; it only makes the information in the MIBs available for polling by your network management system.
Configuring SNMP Polling

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC Classic</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

This configuration applies to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv):

- For the Firepower Management Center, this configuration is part of the system configuration.
- For a Classic managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.

In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.

**Note**

You must add SNMP access for any computer you plan to use to poll the system. Note that the SNMP MIB contains information that could be used to attack your deployment. Cisco recommends that you restrict your access list for SNMP access to the specific hosts that will be used to poll for the MIB. Cisco also recommends you use SNMPv3 and use strong passwords for network management access.

SNMPv3 only supports read-only users and encryption with AES128.

**Before you begin**

- Add SNMP access for each computer you plan to use to poll the system as described in Configuring the Access List for Your System, on page 468.

**Procedure**

**Step 1** Depending on whether you are configuring a Firepower Management Center or a Classic managed device:

- FMC—Choose System > Configuration.
- Managed device—Choose Devices > Platform Settings and create or edit a Firepower policy.

**Step 2** Click SNMP.

**Step 3** From the SNMP Version drop-down list, choose the SNMP version you want to use.

**Step 4** You have the following choices:

- If you chose Version 1 or Version 2, enter the SNMP community name in the Community String field. Go to step 13.
  
  **Note** SNMPv2 only supports read-only communities.

- If you chose Version 3, click Add User to display the user definition page.
  
  **Note** SNMPv3 only supports read-only users and encryption with AES128.
**STIG Compliance**

Organizations within the United States federal government sometimes need to comply with a series of security checklists set out in Security Technical Implementation Guides (STIGs). The Firepower System supports compliance with STIG requirements established by the United States Department of Defense.

If you enable STIG compliance on any appliances in your deployment, you must enable it on all appliances. Non-compliant managed devices cannot be registered to STIG-compliant Firepower Management Centers and STIG-compliant devices cannot be registered to non-compliant Firepower Management Centers.

Enabling STIG compliance does not guarantee strict compliance to all applicable STIGs.

When you enable STIG compliance, password complexity and retention rules for local shell access accounts change. In addition, you cannot use SSH remote storage when in STIG compliance mode.

---

**Enabling STIG Compliance**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>FMC Classic</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

This configuration applies to either a Firepower Management Center or a Classic managed device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv):

- For the Firepower Management Center, this configuration is part of the system configuration.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
For a Classic managed device, you apply this configuration from the Firepower Management Center as part of a platform settings policy.

In either case, the configuration does not take effect until you save your system configuration changes or deploy the shared platform settings policy.

---

**Caution**

If you enable STIG compliance on any appliances in your deployment, you must enable it on all appliances. You cannot disable this setting without assistance from Support. In addition, this setting may substantially impact the performance of your system. Cisco does not recommend enabling STIG compliance except to comply with Department of Defense security requirements.

**Procedure**

**Step 1**
Depending on whether you are configuring a Firepower Management Center or a Classic managed device:

- FMC—Choose **System > Configuration**.
- Managed device—Choose **Devices > Platform Settings** and create or edit a Firepower policy.

**Step 2**
Click **STIG Compliance**.

*Note* Appliances reboot when you enable STIG compliance. The Firepower Management Center reboots when you save the system configuration; managed devices reboot when you deploy configuration changes.

**Step 3**
If you want to **permanently** enable STIG compliance on the appliance, choose **Enable STIG Compliance**.

**Step 4**
Click **Save**.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
- If your appliances were updated from versions earlier than Version 5.2.0, enabling STIG compliance regenerates appliance certificates. After you enable STIG compliance across your deployment, re-register managed devices to the Firepower Management Center.

---

**Time and Time Synchronization (Classic Devices)**

Synchronizing the system time on your Firepower Management Center and its managed devices is essential to successful operation of your Firepower System.

Use a Network Time Protocol (NTP) server to synchronize system time on FMC and all devices.

---

**Caution**

Unintended consequences may occur when time is not synchronized between the Firepower Management Center and managed devices.
Synchronizing Time on Classic Devices

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ASA FirePOWER</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>NGIPSv</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Synchronizing the system time on your Firepower Management Center and its managed devices is essential to successful operation of your Firepower System.

**Before you begin**

- If your organization has one or more NTP servers, use the same NTP server or servers for your devices that you have configured for Time Synchronization on your FMC on the **System > Configuration** page. Copy the specified value.

- If your managed devices cannot reach your NTP server or your organization does not have one, you must configure your Firepower Management Center to serve as an NTP server. See **Synchronize Time Without Access to a Network NTP Server**, on page 479.

**Procedure**

**Step 1** Choose **Devices > Platform Settings**.

**Step 2** Create or edit a **Firepower** policy.

**Step 3** Click **Time Synchronization**.

**Step 4** Specify how time is synchronized on Classic managed devices:

- Choose **Via NTP from Management Center** if your Firepower Management Center is configured to serve as an NTP server.

- Choose **Via NTP from** to receive time from an NTP server on your network. In the text box, enter the same IP address(es) or hostname(s) that you entered on your FMC on the **System > Configuration > Time Synchronization** page.

**Step 5** Click **Save**.

**What to do next**

- Make sure the policy is assigned to your devices. See **Setting Target Devices for a Platform Settings Policy**, on page 495.

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.
It may take a few minutes for managed devices to synchronize with the configured NTP servers. In addition, if you are synchronizing managed devices to a FMC that is configured as an NTP server, and the FMC itself is configured to use an NTP server, it may take some time for the time to synchronize. This is because the FMC must first synchronize with its configured NTP server before it can serve time to the managed device.

**Note**

View Current System Time, Source, and NTP Server Connection Status for NGIPS Devices

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Any</td>
<td>7000 and 8000 Series</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Use this procedure to verify system time information on 7000 and 8000 Series hardware devices.

Time settings are displayed on most pages in local time using the time zone you set on the Time Zone page in User Preferences (the default is America/New York), but are stored on the appliance using UTC time.

In addition, the current time appears in UTC at the top of the Time Synchronization page (local time is displayed in the Manual clock setting option, if enabled).

**Restriction**

The Time Zone function (in User Preferences) assumes that the default system clock is set to UTC time. DO NOT ATTEMPT TO CHANGE THE SYSTEM TIME. Be advised that changing the system time from UTC is NOT supported, and doing so will require you to reimage the device to recover from an unsupported state.

**Procedure**

**Step 1**
Log on to the local web interface of your NGIPS hardware device. For information, see Logging Into the Web Interface of a 7000 or 8000 Series Device, on page 22.

**Step 2**  
Choose **System > Configuration**.

**Step 3**  
Click **Time**.

If your appliance uses an NTP server: For information about the table entries, see NTP Server Status, on page 481.

**NTP Server Status**

When the system is synchronizing time from an NTP server, you can view the NTP Status from the Firepower Management Center’s **Time** page (under the **System > Configuration** menu) and from the local web interface of 7000 and 8000 Series devices:
## Table 64: NTP Status

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTP Server</td>
<td>The IP address and name of the configured NTP server.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the NTP server time synchronization:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Being Used</strong> indicates that the appliance is synchronized with the NTP server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Available</strong> indicates that the NTP server is available for use, but time is not yet synchronized.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Not Available</strong> indicates that the NTP server is in your configuration, but the NTP daemon is unable to use it.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Pending</strong> indicates that the NTP server is new or the NTP daemon was recently restarted. Over time, its value should change to <strong>Being Used</strong>, <strong>Available</strong>, or <strong>Not Available</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Unknown</strong> indicates that the status of the NTP server is unknown.</td>
</tr>
<tr>
<td>Offset</td>
<td>The number of milliseconds of difference between the time on the appliance and the configured NTP server. Negative values indicate that the appliance is behind the NTP server, and positive values indicate that it is ahead.</td>
</tr>
<tr>
<td>Last Update</td>
<td>The number of seconds that have elapsed since the time was last synchronized with the NTP server. The NTP daemon automatically adjusts the synchronization times based on a number of conditions. For example, if you see larger update times such as 300 seconds, that indicates that the time is relatively stable and the NTP daemon has determined that it does not need to use a lower update increment.</td>
</tr>
</tbody>
</table>
PART VIII

Network Address Translation (NAT)

• NAT Policy Management, on page 515
• NAT for 7000 and 8000 Series Devices, on page 521
NAT Policy Management

The following topics describe how to manage NAT policies for your Firepower System:

- Managing NAT Policies, on page 515
- Creating NAT Policies, on page 516
- Configuring NAT Policies, on page 517
- Configuring NAT Policy Targets, on page 518
- Copying NAT Policies, on page 519

Managing NAT Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

Administrators in ancestor domains can target NAT policies to devices in descendant domains, which descendant domains can use or replace with customized local policies. If a NAT policy targets devices in different descendant domains, administrators in the descendant domains can view information about target devices belonging to their domain only.

Procedure

Step 1

Choose Devices > NAT.

Step 2

Manage your NAT policies:

- Copy — Click the copy icon ( ) next to the policy you want to copy; see Copying NAT Policies, on page 519.

- Create — Click New Policy; see Creating NAT Policies, on page 516.

- Delete — Click the delete icon ( ) next to the policy you want to delete, then click OK. When prompted whether to continue, you are also informed if another user has unsaved changes in the policy.
Creating NAT Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

When you create a new NAT policy you must, at minimum, give it a unique name. Although you are not required to identify policy targets at policy creation time, you must perform this step before you can deploy the policy. If you apply a NAT policy with no rules to a device, the system removes all NAT rules from that device.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

Administrators in ancestor domains can target NAT policies to devices in descendant domains, which descendant domains can use or replace with customized local policies. If a NAT policy targets devices in different descendant domains, administrators in the descendant domains can view information about target devices belonging to their domain only.

Procedure

**Step 1** Choose Devices > NAT.

**Step 2** From the New Policy drop-down list, choose Firepower NAT.

**Step 3** Enter a unique Name.

In a multidomain deployment, policy names must be unique within the domain hierarchy. The system may identify a conflict with the name of a policy you cannot view in your current domain.

**Step 4** Optionally, enter a Description.

**Step 5** Choose the devices where you want to deploy the policy:

- Choose a device in the Available Devices list, and click Add to Policy.
- Click and drag a device from the Available Devices list to the Selected Devices list.
• Remove a device from the **Selected Devices** list by clicking the delete icon ( ) next to the device.

**Step 6**

Click **Save**.

---

**What to do next**

• Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

---

**Configuring NAT Policies**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

Administrators in ancestor domains can target NAT policies to devices in descendant domains, which descendant domains can use or replace with customized local policies. If a NAT policy targets devices in different descendant domains, administrators in the descendant domains can view information about target devices belonging to their domain only.

If you change the type of an interface to a type that is not valid for use with a NAT policy that targets a device with that interface, the policy labels the interface as deleted. Click **Save** in the NAT policy to automatically remove the interface from the policy.

**Procedure**

**Step 1**

Choose **Devices > NAT**.

**Step 2**

Click the edit icon ( ) next to the NAT policy you want to modify.

If a view icon ( ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3**

Configure your NAT policies:

• To modify the policy name or description, click the **Name** or **Description** field, delete any characters as needed, then enter the new name or description. In a multidomain deployment, policy names must be unique within the domain hierarchy. The system may identify a conflict with the name of a policy you cannot view in your current domain.

• To manage policy targets, see **Configuring NAT Policy Targets**, on page 518.

• To save your policy changes, click **Save**.

• To add a rule to a policy, click **Add Rule**.

• To edit an existing rule, click the edit icon ( ) next to the rule.
• To delete a rule, click the delete icon (_pairs) next to the rule, then click **OK**.
• To enable or disable an existing rule, right-click a rule, choose **State**, and choose **Disable** or **Enable**.
• To display the configuration page for a specific rule attribute, click the name, value, or icon in the column for the condition on the row for the rule. For example, click the name or value in the **Source Networks** column to display the Source Network page for the selected rule.

---

**What to do next**

• Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

## Configuring NAT Policy Targets

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can identify the managed devices you want to target with your policy while creating or editing a policy. You can search a list of available devices, 7000 or 8000 Series stacks, and high-availability pairs, and add them to a list of selected devices.

You cannot target stacked devices running different versions of the Firepower System (for example, if an upgrade on one of the devices fails).

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

Administrators in ancestor domains can target NAT policies to devices in descendant domains, which descendant domains can use or replace with customized local policies. If a NAT policy targets devices in different descendant domains, administrators in the descendant domains can view information about target devices belonging to their domain only.

### Procedure

**Step 1** Choose **Devices > NAT**.

**Step 2** Click the edit icon (_pairs) next to the NAT policy you want to modify.

If a view icon (_pairs) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Policy Assignments**.

**Step 4** Do any of the following:

• To assign a device, stack, high-availability pair, or device group to the policy, select it in the **Available Devices** list and click **Add to Policy**. You can also drag and drop.
• To remove a device assignment, click the delete icon ( ) next to a device, stack, high-availability pair, or device group in the Selected Devices list.

Step 5  Click OK.

What to do next
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

### Copying NAT Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can make a copy of a NAT policy. The copy includes all policy rules and configurations.

In a multidomain deployment, you can copy policies from current and ancestor domains.

**Procedure**

**Step 1**  Choose Devices > NAT.

**Step 2**  Click the copy icon ( ) next to the NAT policy you want to copy.

**Step 3**  Enter a unique Name for the policy.

In a multidomain deployment, policy names must be unique within the domain hierarchy. The system may identify a conflict with the name of a policy you cannot view in your current domain.

**Step 4**  Click OK.
Copying NAT Policies

Network Address Translation (NAT)
CHAPTER 27

NAT for 7000 and 8000 Series Devices

The following topics describe how to configure NAT for 7000 and 8000 Series devices:

• NAT Policy Configuration, on page 521
• Rule Organization in a NAT Policy, on page 522
• Organizing NAT Rules, on page 523
• NAT Policy Rules Options, on page 524

NAT Policy Configuration

You can configure NAT policies in different ways to manage specific network needs. You can:

• Expose an internal server to an external network.
  
  In this configuration, you define a static translation from an external IP address to an internal IP address so the system can access an internal server from outside the network. Traffic sent to the server targets the external IP address or IP address and port, and is translated into the internal IP address or IP address and port. Return traffic from the server is translated back to the external address.

• Allow an internal host/server to connect to an external application.
  
  In this configuration, you define a static translation from an internal address to an external address. This definition allows the internal host or server to initiate a connection to an external application that is expecting the internal host or server to have a specific IP address and port. Therefore, the system cannot dynamically allocate the address of the internal host or server.

• Hide private network addresses from an external network.
  
  You can obscure your internal network addresses using either of the following configurations:

  • If you have a sufficient number of external IP addresses to satisfy your internal network needs, you can use a block of IP addresses. In this configuration, you create a dynamic translation that automatically converts the source IP address of any outgoing traffic to an unused IP address from your externally facing IP addresses.

  • If you have an insufficient number of external IP addresses to satisfy your internal network needs, you can use a limited block of IP addresses and port translation. In this configuration, you create a dynamic translation that automatically converts the source IP address and port of outgoing traffic to an unused IP address and port from your externally facing IP addresses.
NAT Policies Configuration Guidelines

To configure a NAT policy, you must give the policy a unique name and identify the devices, or targets, where you want to deploy the policy. You can also add, edit, delete, enable, and disable NAT rules. After you create or modify a NAT policy, you can deploy the policy to all or some targeted devices.

You can deploy NAT policies to a 7000 or 8000 Series device high-availability pair, including paired stacks, as you would a standalone device. However, you can define static NAT rules for interfaces on individual paired devices or the entire high-availability pair and use the interfaces in source zones. For dynamic rules, you can use only the interfaces on the whole high-availability pair in source or destination zones.

If you configure dynamic NAT on a device high-availability pair without HA link interfaces established, both paired devices independently allocate dynamic NAT entries, and the system cannot synchronize the entries between devices.

You can deploy NAT policies to a device stack as you would a standalone device. If you establish a device stack from devices that were included in a NAT policy and had rules associated with interfaces from the secondary device that was a member of the stack, the interfaces from the secondary device remain in the NAT policy. You can save and deploy policies with the interfaces, but the rules do not provide any translation.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain. Administrators in ancestor domains can target NAT policies to devices in descendant domains, which descendant domains can use or replace with customized local policies.

Rule Organization in a NAT Policy

The Edit page for the NAT policy lists static NAT rules and dynamic NAT rules separately. The system sorts static rules alphabetically by name, and you cannot change the display order. You cannot create static rules with identical matching values. The system inspects static translations for a match before it inspects any dynamic translations.

Dynamic rules are processed in numerical order. The numeric position of each dynamic rule appears on the left side of the page next to the rule. You can move or insert dynamic rules and otherwise change the rule order. For example, if you move dynamic rule 10 under dynamic rule 3, rule 10 becomes rule 4 and all subsequent numbers increment accordingly.

A dynamic rule’s position is important because the system compares packets to dynamic rules in the rules’ numeric order on the policy Edit page. When a packet meets all the conditions of a dynamic rule, the system applies the conditions of that rule to the packet and ignores all subsequent rules for that packet.
You can specify a dynamic rule’s numeric position when you add or edit a dynamic rule. You can also highlight a dynamic rule before adding a new dynamic rule to insert the new rule below the rule you highlighted.

You can select one or more dynamic rules by clicking a blank space in the row for the rule. You can drag and drop selected dynamic rules into a new location, thereby changing the position of the rules you moved and all subsequent rules.

You can cut or copy selected rules and paste them above or below an existing rule. You can only paste static rules in the Static Translations list and only dynamic rules in the Dynamic Translations list. You can also delete selected rules and insert new rules into any location in the list of existing rules.

You can display explanatory warnings to identify rules that will never match because they are preempted by preceding rules.

If you have access control policies in your deployment, the system does not translate traffic until it has passed through access control.

## Organizing NAT Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1**  Choose Devices > NAT.

**Step 2**  Click the edit icon (↵) next to the NAT policy you want to modify.

If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3**  Organize your NAT rules:

- To choose a rule, click a blank area in the row for a rule.
- To clear rule selections, click the reload icon (⟳) on the lower right side of the page. To clear individual rules, click a blank area in a rule's row while holding the Ctrl key.
- To cut or copy selected rules, right-click a blank area in the row for a selected rule, then select Cut or Copy.
- To paste rules you have cut or copied into the rule list, right-click a blank area in the row for a rule where you want to paste selected rules, then select Paste above or Paste below.
- To move selected rules, drag and drop selected rules beneath a new location, indicated by a horizontal blue line that appears above your pointer as you drag.
- To delete a rule, click the delete icon (🗑️) next to the rule, then click OK.
- To show warnings, click Show Warnings.
NAT Rule Warnings and Errors

The conditions of a NAT rule may preempt a subsequent rule from matching traffic. Any type of rule condition can preempt a subsequent rule.

A rule also preempts an identical subsequent rule where all configured conditions are the same. A subsequent rule would not be preempted if any condition were different.

If you create a rule that causes the NAT policy to fail upon deploy, an error icon (ℹ️) appears next to the rule. An error occurs if there is a conflict in the static rules, or if you edit a network object used in the policy that now makes the policy invalid. For example, an error occurs if you change a network object to use only IPv6 addresses and the rule that uses that object no longer has any valid networks where at least one network is required. Error icons appear automatically; you do not have to click Show Warnings.

Showing and Hiding NAT Rule Warnings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose Devices > NAT .

**Step 2** Click the edit icon ( MODIFY ) next to the NAT policy you want to modify.

If a view icon ( VIEW ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** To show warnings, click Show Warnings.

The page updates with an warning icon ( 🚨 ) next to each preempted rule.

**Step 4** To display the warning for a rule, hover your pointer over the warning icon ( 🚨 ) next to a rule.

A message indicates which rule preempts the rule.

**Step 5** To clear warnings, click Hide Warnings.

The page refreshes and the warnings disappear.

NAT Policy Rules Options

A NAT rule is simply a set of configurations and conditions that:

- qualifies network traffic
- specifies how the traffic that matches those qualifications is translated

You create and edit NAT rules from within an existing NAT policy. Each rule belongs to only one policy.
The web interface for adding or editing a rule is similar. You specify the rule name, state, type, and position (if dynamic) at the top of the page. You build conditions using the tabs on the left side of the page; each condition type has its own tab.

The following list summarizes the configurable components of a NAT rule.

**Name**

Give each rule a unique name. For static NAT rules, use a maximum of 22 characters. For dynamic NAT rules, use a maximum of 30 characters. You can use printable characters, including spaces and special characters, with the exception of the colon (:).

**Rule State**

By default, rules are enabled. If you disable a rule, the system does not use it to evaluate network traffic for translation. When viewing the list of rules in a NAT policy, disabled rules are grayed out, although you can still modify them.

**Type**

A rule’s type determines how the system handles traffic that matches the rule’s conditions. When you create and edit NAT rules, the configurable components vary according to rule type.

**Position (Dynamic Rules Only)**

Dynamic rules in a NAT policy are numbered, starting at 1. The system matches traffic to NAT rules in top-down order by ascending rule number.

When you add a rule to a policy, you specify its position by placing it **above** or **below** a specific rule, using rule numbers as a reference point. When editing an existing rule, you can **Move** the rule in a similar fashion.

**Conditions**

Rule conditions identify the specific traffic you want to translate. Conditions can match traffic by any combination of multiple attributes, including security zone, network, and transport protocol port.

**Related Topics**

Creating and Editing NAT Rules, on page 525

## Creating and Editing NAT Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays policies and rules created in the current domain, which you can edit. It also displays policies and rules created in ancestor domains, which you cannot edit. To view and edit rules created in a lower domain, switch to that domain.
Procedure

**Step 1** Choose Devices > NAT.

**Step 2** Click the edit icon (📝) next to the NAT policy where you want to add a rule.

If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Add a new rule or edit an existing rule:

- To add a new rule, click Add Rule.
- To edit an existing rule, click the edit icon (📝) next to the rule you want to edit.

**Step 4** Enter a unique rule Name.

**Step 5** Configure the following rule components:

- Specify whether the rule is Enabled.
- Specify a rule Type.
- Specify the rule position (dynamic rules only).
- Configure the rule’s conditions.

**Note** Static rules must include an original destination network. Dynamic rules must include a translated source network.

**Step 6** Click Add.

**Step 7** Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

NAT Rule Types

Every NAT rule has an associated type that:

- qualifies network traffic
- specifies how the traffic that matches those qualifications is translated

The following list summarizes the NAT rule types.

**Static**

Static rules provide one-to-one translations on destination networks and optionally port and protocol. When configuring static translations, you can configure source zones, destination networks, and destination ports. You cannot configure destination zones or source networks.
You must specify an original destination network. For destination networks, you can only select network objects and groups containing a single IP address or enter literal IP addresses that represent a single IP address. You can only specify a single original destination network and a single translated destination network.

**Note**
The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

You can specify a single original destination port and a single translated destination port. You must specify an original destination network before you can specify an original destination port. In addition, you cannot specify a translated destination port unless you also specify an original destination port, and the translated value must match the protocol of the original value.

**Caution**
For static NAT rules on a 7000 or 8000 Series device in a high-availability pair, only select an individual peer interface if all networks affected by the NAT translations are private. Do not use this configuration for static NAT rules affecting traffic between public and private networks.

**Dynamic IP Only**
Dynamic IP Only rules translate many-to-many source networks, but maintain port and protocol. When configuring dynamic IP only translations, you can configure zones, source networks, original destination networks, and original destination ports. You cannot configure translated destination networks or translated destination ports.

You must specify at least one translated source network. If the number of translated source network values is less than the number of original source networks, the system displays a warning on the rule that it is possible to run out of translated addresses before all original addresses are matched.

If there are multiple rules with conditions that match the same packet, the low priority rules become dead, meaning they can never be triggered. The system also displays warnings for dead rules. You can view tooltips to determine which rule supersedes the dead rule.

**Note**
You can save and deploy policies with dead rules, but the rules cannot provide any translation.

In some instances, you may want to create rules with limited scope preceding rules with a broader scope. For example:

**Rule 1:** Match on address A and port A/Translate to address B
**Rule 2:** Match on address A/Translate to Address C

In this example, rule 1 matches some packets that also match rule 2. Therefore, rule 2 is not completely dead.

If you specify only original destination ports, you cannot specify translated destination ports.

**Dynamic IP + Port**
Dynamic IP and port rules translate many-to-one or many-to-many source networks and port and protocol. When configuring dynamic IP and port translations, you can configure zones, source networks, original
destination networks, and original destination ports. You cannot configure translated destination networks or translated destination ports.

You must specify at least one translated source network. If there are multiple rules with conditions that match the same packet, the low priority rules become dead, meaning they can never be triggered. The system also displays warnings for dead rules. You can view tooltips to determine which rule supersedes the dead rule.

**Note**

You can save and deploy policies with dead rules, but the rules cannot provide any translation.

If you specify only original destination ports, you cannot specify translated destination ports.

**Note**

If you create a dynamic IP and port rule, and the system passes traffic that does not use a port, no translation occurs for the traffic. For example, a ping (ICMP) from an IP address that matches the source network does not map, because ICMP does not use a port.

### NAT Rule Condition Types

The following table summarizes the NAT rule condition types that can be configured based on the specified NAT rule type:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Static</th>
<th>Dynamic (IP Only or IP + Port)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Zones</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Destination Zones</td>
<td>Not allowed</td>
<td>Optional</td>
</tr>
<tr>
<td>Original Source Networks</td>
<td>Not allowed</td>
<td>Optional</td>
</tr>
<tr>
<td>Translated Source Networks</td>
<td>Not allowed</td>
<td>Required</td>
</tr>
<tr>
<td>Original Destination Networks</td>
<td><strong>Required</strong></td>
<td>Optional</td>
</tr>
<tr>
<td>Translated Destination Networks</td>
<td>Optional; single address only</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Original Destination Ports</td>
<td>Optional; single port only, and only allowed if you define the original destination network</td>
<td>Optional</td>
</tr>
<tr>
<td>Translated Destination Ports</td>
<td>Optional; single port only, and only allowed if you define the original destination port</td>
<td>Not allowed</td>
</tr>
</tbody>
</table>

### NAT Rule Conditions and Condition Mechanics

You can add conditions to NAT rules to identify the type of traffic that matches the rule. For each condition type, you select conditions you want to add to a rule from a list of available conditions. When applicable, condition filters allow you to constrain available conditions. Lists of available and selected conditions may
be as short as a single condition or many pages long. You can search available conditions and display only those matching a typed name or value in a list that updates as you type.

Depending on the type of condition, lists of available conditions may be comprised of a combination of conditions provided directly by Cisco or configured using other Firepower System features, including objects created using the object manager (Objects > Object Management), objects created directly from individual conditions pages, and literal conditions.

**NAT Rule Conditions**

You can set a NAT rule to match traffic meeting any of the conditions described in the following table:

**Table 66: NAT Rule Condition Types**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zones</td>
<td>A configuration of one or more routed interfaces where you can deploy NAT policies. Zones provide a mechanism for classifying traffic on source and destination interfaces, and you can add source and destination zone conditions to rules.</td>
</tr>
<tr>
<td>Networks</td>
<td>Any combination of individual IP addresses, CIDR blocks, and prefix lengths, either specified explicitly or using network objects and groups. You can add source and destination network conditions to NAT rules.</td>
</tr>
<tr>
<td>Destination Ports</td>
<td>Transport protocol ports, including individual and group port objects you create based on transport protocols.</td>
</tr>
</tbody>
</table>

**Adding Conditions to NAT Rules**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Adding conditions to NAT rules is essentially the same for each type of condition. You choose from a list of available conditions on the left, and add the conditions you chose to one or two lists of selected conditions on the right.

For all condition types, you choose one or more individual available conditions by clicking on them to highlight them. You can either click a button between the two types of lists to add available conditions that you choose to your lists of selected conditions, or drag and drop available conditions that you choose into the list of selected conditions.

You can add up to 50 conditions of each type to a list of selected conditions. For example, you can add up to 50 source zone conditions, up to 50 destination zone conditions, up to 50 source network conditions, and so on, until you reach the upper limit for the appliance.
Procedure

**Step 1** Choose Devices > NAT.

**Step 2** Click the edit icon (📝) next to the NAT policy you want to modify.

If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click Add Rule.

**Step 4** Enter a Name for the rule.

**Step 5** Specify a Type for the rule.

**Step 6** Click the tab for the type of condition you want to add to the rule.

**Step 7** Take any of the following actions:

- To choose available conditions to add to a list of selected conditions, click the available condition.
- To choose all listed available conditions, right-click the row for any available condition, then click Select All.
- To choose a list of available conditions or filters, click inside the Search field and enter a search string. The list updates as you type to display matching items.

You can search on object names and on the values configured for objects. For example, if you have an individual network object named Texas Office with the configured value 192.168.3.0/24, and the object is included in the group object US Offices, you can display both objects by entering a partial or complete search string such as Tex, or by entering a value such as 3.

- To clear a search when searching available conditions or filters, click the reload icon (🔄) above the Search field or the clear icon (❌) in the Search field.
- To add selected zone conditions from a list of available conditions to a list of selected source or destination conditions, click Add to Source or Add to Destination.
- To add selected network and port conditions from a list of available conditions to a list of selected original or translated conditions, click Add to Original or Add to Translated.
- To drag and drop selected available conditions into a list of selected conditions, click a selected condition, then drag and drop into the list of selected conditions.
- To add a literal condition to a list of selected conditions using a literal field, click to remove the prompt from the literal field, enter the literal condition, and click Add. Network conditions provide a field for adding literal conditions.
- To add a literal condition to a list of selected conditions using a drop-down list, choose a condition from the drop-down list, then click Add. Port conditions provide a drop-down list for adding literal conditions.
- To add an individual object or condition filter so you can then choose it from the list of available conditions, click the add icon (➕).

- To delete a single condition from a list of selected conditions, click the delete icon (ลบ) next to the condition.
- To delete a condition from a list of selected conditions, right-click to highlight the row for a selected condition, then click Delete.

**Step 8** Click Add to save your configuration.
Literal Conditions in NAT Rules

You can add a literal value to the list of original and translated conditions for the following condition types:

- Networks
- Ports

For network conditions, you type the literal value in a configuration field below the list of original or translated conditions.

In the case of port conditions, you choose a protocol from a drop-down list. When the protocol is All, TCP or UDP, you enter a port number in a configuration field.

Each relevant conditions page provides the controls needed to add literal values. Values you enter in a configuration field appear as red text if the value is invalid, or until it is recognized as valid. Values change to blue text as you type when they are recognized as valid. A grayed Add button activates when a valid value is recognized. Literal values you add appear immediately in the list of selected conditions.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Objects in NAT Rule Conditions

Objects that you create in the object manager (Objects > Object Management) are immediately available for you to select from relevant lists of available NAT rule conditions.

You can also create objects on-the-fly from the NAT policy. A control on relevant conditions pages provides access to the same configuration controls that you use in the object manager.

Individual objects created on-the-fly appear immediately in the list of available objects. You can add them to the current rule, and to other existing and future rules. On the relevant conditions page, and also on the policy Edit page, you can hover your pointer over an individual object to display the contents of the object, and over a group object to display the number of individual objects in the group.

Zone Conditions in NAT Rules

The security zones on your system are comprised of interfaces on your managed devices. Zones that you add to a NAT rule target the rule to devices on your network that have routed or hybrid interfaces in those zones. You can only add security zones with routed or hybrid interfaces as conditions for NAT rules.

You can add either zones or standalone interfaces that are currently assigned to a virtual router to NAT rules. If there are devices with un-deployed device configurations, the Zones page displays a warning icon (⚠️) at the top of the available zones list, indicating that only deployed zones and interfaces are displayed. You can click the arrow icon (.expand_more) next to a zone to collapse or expand the zone to hide or view its interfaces.

If an interface is on a 7000 or 8000 Series device in a high-availability pair, the available zones list displays an additional branch from that interface with the other interfaces in the high-availability pair as children of
the primary interface on the active device in the high-availability pair. You can also click the arrow icon ( ▶️ )
to collapse or expand the paired device interfaces to hide or view its interfaces.

---

**Note**

You can save and deploy policies with disabled interfaces, but the rules cannot provide any translation until
the interfaces are enabled.

The two lists on the right are the source and destination zones used for matching purposes by the NAT rules.
If the rule already has values configured, these lists display the existing values when you edit the rule. If the
source zones list is empty, the rule matches traffic *from* any zone or interface. If the destination zones list is
empty, the rule matches traffic *to* any zone or interface.

The system displays warnings for rules with zone combinations that never trigger on a targeted device.

---

**Note**

You can save and deploy policies with these zone combinations, but the rules will not provide any translation.

You can add individual interfaces by selecting an item in a zone or by selecting a standalone interface. You
can only add interfaces in a zone if the zone it is assigned to has not already been added to a source zones or
destination zones list. These individually selected interfaces are not affected by changes to zones, even if you
remove them and add them to a different zone. If an interface is the primary member of a high-availability
pair and you are configuring a dynamic rule, you can add only the primary interface to the source zones or
destination zones list. For static rules, you can add individual high-availability pair member interfaces to the
source zones list. You can only add a primary high-availability pair interface to a list if none of its children
have been added, and you can only add individual high-availability pair interfaces if the primary has not been
added.

If you add a zone, the rule uses all interfaces associated with the zone. If you add or remove an interface from
the zone, the rule will not use the updated version of the zone until the device configuration has been re-deployed
to the devices where the interfaces reside.

---

**Note**

In a static NAT rule, you can add only source zones. In a dynamic NAT rule, you can add both source and
destination zones.

### Adding Zone Conditions to NAT Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**

Choose Devices > NAT .

**Step 2**

Click the edit icon ( 🔍 ) next to the NAT policy you want to modify.
If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3**  
Click Add Rule.

**Step 4**  
Enter a Name for the rule.

**Step 5**  
Specify a Type for the rule.

**Step 6**  
Click the Zones tab.

**Step 7**  
Click a zone or interface in the Available Zones list.

**Step 8**  
You have the following choices:

- To match traffic by source zone, click Add to Source.
- To match traffic by destination zone, click Add to Destination.

**Note**  
You can add only source zones to static NAT rules. Additionally, while you can add disabled interfaces to a NAT rule, the rule does not provide any translation.

**Step 9**  
Click Add to save the new rule.

**Step 10**  
Click Save to save the changed policy.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**Source Network Conditions in Dynamic NAT Rules**

You configure the matching values and translation values of the source IP address for packets. If the original source network is not configured, then any source IP address matches the dynamic NAT rule. Note that you cannot configure source networks for static NAT rules. If a packet matches the NAT rule, the system uses the values in the translated source network to assign the new value for the source IP address. For dynamic rules, you must configure a translated source network with at least one value.

**Caution**

If a network object or object group is being used by a NAT rule, and you change or delete the object or group, it can cause the rule to become invalid.

You can add any of the following kinds of source network conditions to a dynamic NAT rule:

- individual and group network objects that you have created using the object manager
- individual network objects that you add from the Source Network conditions page, and can then add to your rule and to other existing and future rules
- literal, single IP addresses, ranges, or address blocks
The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

### Adding Network Conditions to a Dynamic NAT Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

When you update the network conditions in a dynamic rule in use in a deployed policy, the system drops any network sessions using the existing translated address pool.

**Procedure**

1. Choose Devices > NAT.
2. Click the edit icon (📝) next to the NAT policy you want to modify.
   
   If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
3. Click Add Rule.
4. Enter a Name for the rule.
5. Specify a dynamic Type for the rule:
   - Dynamic IP Only
   - Dynamic IP + Port
6. Click the Source Networks tab.
7. Optionally, add an individual network object to the Available Networks list by clicking the add icon (➕) above the list.
   
   You can add multiple IP addresses, CIDR blocks, and prefix lengths to each network object.
8. Click a condition in the Available Networks list.
9. You have the following choices:
   - To match traffic by original source network, click Add to Original.
   - To specify the translation value for traffic that matches the translated source network, click Add to Translated.
10. To add a literal IP address, range, or address block:
    a) Click the Enter an IP address prompt below the Original Source Network or Translated Source Network list.
    b) Enter an IP address, range, or address block.
You add ranges in the following format: lower IP address-upper IP address. For example:


**Note** The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

c) Click **Add** next to the value you entered.

**Step 11** Click **Add** to save the rule.

**Step 12** Click **Save** to save the changed policy.

---

### What to do next

- Deploy configuration changes; see *Deploy Configuration Changes*, on page 277.

### Destination Network Conditions in NAT Rules

You configure the matching values and translation values of the destination IP address for packets. Note that you cannot configure translated destination networks for dynamic NAT rules.

Because static NAT rules are one-to-one translations, the **Available Networks** list contains only network objects and groups that contain only a single IP address. For static translations, you can add only a single object or literal value to both the **Original Destination Network** or **Translated Destination Network** lists.

---

**Caution**

If a network object or object group is being used by a NAT rule, and you change or delete the object or group, it can cause the rule to become invalid.

---

You can add any of the following kinds of destination network conditions to a NAT rule:

- individual and group network objects that you have created using the object manager
- individual network objects that you add from the Destination Network conditions page, and can then add to your rule and to other existing and future rules
- literal, single IP addresses, range, or address blocks

For static NAT rules, you can add only a CIDR with subnet mask /32, and only if there is not already a value in the list.

---

**Note**

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.
Adding Destination Network Conditions to NAT Rules

When you update the network conditions in a dynamic rule in use in a deployed policy, the system drops any network sessions using the existing translated address pool.

Procedure

Step 1  Choose Devices > NAT.
Step 2  Click the edit icon (_pen) next to the NAT policy you want to modify.

If a view icon (_lock) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3  Click Add Rule.
Step 4  Enter a Name for the rule.
Step 5  Specify a Type for the rule.
Step 6  Click the Destination Network tab.
Step 7  Optionally, add an individual network object to the Available Networks list by clicking the add icon (_pen) above the list.

For dynamic rules, you can add multiple IP addresses, CIDR blocks, and prefix lengths to each network object. For static rules, you can add only a single IP address.

Step 8  Click a condition or object in the Available Networks list.
Step 9  You have the following choices:

- To match traffic by original destination network, click Add to Original.
- To specify the translation value for traffic that matches the translated destination network, click Add to Translated.

Step 10 Optionally, click the Enter an IP address prompt below the Original Destination Network or Translated Destination Network list, enter an IP address or address block, and click Add.
Step 11 Click Add.
Step 12 Click Save to save the changes to the policy.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Port Conditions in NAT Rules

You can add a port condition to a rule to match network traffic based on the original and translated destination port and transport protocol for translation. If the original port is not configured, any destination port matches the rule. If a packet matches the NAT rule and a translated destination port is configured, the system translates the port into that value. Note that for dynamic rules, you can specify only the original destination port. For static rules, you can define a translated destination port, but only with an object with the same protocol as the original destination port object or literal value.

The system matches the destination port against the value of the port object or literal port in the original destination port list for static rules, or multiple values for dynamic rules.

Because static NAT rules are one-to-one translations, the Available Ports list contains only port objects and groups that contain only a single port. For static translations, you can add only a single object or literal value to both the Original Port or Translated Port lists.

For dynamic rules, you can add a range of ports. For example, when specifying the original destination port, you can add 1000-1100 as a literal value.

Caution

If a port object or object group is being used by a NAT rule, and you change or delete the object or group, it can cause the rule to become invalid.

You can add any of the following kinds of port conditions to a NAT rule:

- individual and group port objects that you have created using the object manager
- individual port objects that you add from the Destination Ports conditions page, and can then add to your rule and to other existing and future rules
- literal port values, consisting of a TCP, UDP, or All (TCP and UDP) transport protocol and a port

Adding Port Conditions to NAT Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  Choose Devices > NAT.
Step 2  Click the edit icon (✎) next to the NAT policy you want to modify.

If a view icon (.spyglass) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3  Click Add Rule.
Step 4  Enter a Name for the rule.
Step 5  Specify a Type for the rule.
Step 6 Click the Destination Port tab.

Step 7 Optionally, add an individual port object to the Available Ports list by clicking the add icon (✓) above the list.

You can identify a single port or a port range in each port object that you add. You can then choose objects you added as conditions for your rule. For static rules, you can use only port objects with single ports.

Step 8 Click a condition in the Available Ports list.

Step 9 You have the following choices:

• Click Add to Original.
• Click Add to Translated.
• Drag and drop available ports into a list.

Step 10 To add a literal port:

a) Choose an entry from the Protocol drop-down list beneath the Original Port or Translated Port lists.
b) Enter a port.
c) Click Add.

For dynamic rules, you can specify a single port or a range.

Step 11 Click Add.

Step 12 Click Save to save the changes to the policy.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.
PART IX

7000 and 8000 Series Advanced Deployment Options

• Setting Up Virtual Switches, on page 541
• Setting Up Virtual Routers, on page 551
• Aggregate Interfaces and LACP, on page 583
• Hybrid Interfaces, on page 597
• Gateway VPNs, on page 601
Setting Up Virtual Switches

The following topics describe how to set up virtual switches in the Firepower System:

- Virtual Switches, on page 541
- Switched Interface Configuration, on page 541
- Virtual Switch Configuration, on page 546

Virtual Switches

You can configure a 7000 or 8000 Series device in a Layer 2 deployment so that it provides packet switching between two or more networks. In a Layer 2 deployment, you can configure virtual switches to operate as standalone broadcast domains, dividing your network into logical segments. A virtual switch uses the media access control (MAC) address from a host to determine where to send packets.

When you configure a virtual switch, the switch initially broadcasts packets through every available port on the switch. Over time, the switch uses tagged return traffic to learn which hosts reside on the networks connected to each port.

A virtual switch must contain two or more switched interfaces to handle traffic. For each virtual switch, traffic becomes limited to the set of ports configured as switched interfaces. For example, if you configure a virtual switch with four switched interfaces, packets sent in through one port for broadcast can only be sent out of the remaining three ports on the switch.

When you configure a physical switched interface, you must assign it to a virtual switch. You can also define additional logical switched interfaces on a physical port as needed. You can group multiple physical interfaces into a single logical switched interface called a link aggregation group (LAG). This single aggregate logical link provides higher bandwidth, redundancy, and load-balancing between two endpoints.

Caution

If a Layer 2 deployment fails for any reason, the device no longer passes traffic.

Switched Interface Configuration

You can set up switched interfaces to have either physical or logical configurations. You can configure physical switched interfaces for handling untagged VLAN traffic. You can also create logical switched interfaces for handling traffic with designated VLAN tags.
In a Layer 2 deployment, the system drops any traffic received on an external physical interface that does not have a switched interface waiting for it. If the system receives a packet with no VLAN tag and you have not configured a physical switched interface for that port, it drops the packet. If the system receives a VLAN-tagged packet and you have not configured a logical switched interface, it also drops the packet.

The system handles traffic that has been received with VLAN tags on switched interfaces by stripping the outermost VLAN tag on ingress before any rules evaluation or forwarding decisions. Packets leaving the device through a VLAN-tagged logical switched interface are encapsulated with the associated VLAN tag on egress.

Note that if you change the parent physical interface to inline or passive, the system deletes all the associated logical interfaces.

**Switched Interface Configuration Notes**

You can configure one or more physical ports on a managed device as switched interfaces. You must assign a physical switched interface to a virtual switch before it can handle traffic. You can configure link mode settings and MDI/MDIX settings only for copper interfaces.

**Note**

Interfaces on 8000 Series appliances do not support half-duplex options.

For each physical switched interface, you can add multiple logical switched interfaces. You must associate each logical interface with a VLAN tag to handle traffic received by the physical interface with that specific tag. You must assign a logical switched interface to a virtual switch to handle traffic.

When configuring a switched interface, the range within which you can set the MTU can vary depending on the Firepower System device model and interface type.

The range of MTU values can vary depending on the model of the managed device and the interface type.

**Caution**

Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

To edit an existing logical switched interface, click the edit icon next to the interface.

When you delete a logical switched interface, you remove it from the physical interface where it resides, as well as the virtual switch and security zone it is associated with.

**Related Topics**

- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
- Snort® Restart Scenarios, on page 279
Configuring Physical Switched Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1** Choose **Devices > Device Management**.

**Step 2** Next to the device where you want to configure the switched interface, click the edit icon ( ).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Next to the interface you want to configure as a switched interface, click the edit icon ( ).

**Step 4** Click the **Switched** tab.

**Step 5** If you want to associate the switched interface with a security zone, do one of the following:

- Choose an existing security zone from the **Security Zone** drop-down list.
- Choose **New** to add a new security zone; see Creating Security Zone Objects, on page 332.

**Step 6** If you want to associate the switched interface with a virtual switch, do one of the following:

- Choose an existing virtual switch from the **Virtual Switch** drop-down list.
- Choose **New** to add a new virtual switch; see Adding Virtual Switches, on page 547.

**Step 7** Check the **Enabled** check box to allow the switched interface to handle traffic.

**Note** If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.

**Step 8** From the **Mode** drop-down list, choose an option to designate the link mode, or choose **Autonegotiation** to specify that the interface is configured to auto negotiate speed and duplex settings.

Mode settings are available only for copper interfaces.

Interfaces on 8000 Series appliances do not support half-duplex options.

**Step 9** From the **MDI/MDIX** drop-down list, choose an option to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDI.

By default, MDI/MDIX is set to Auto-MDI, which automatically handles switching between MDI and MDIX to attain link.

**Step 10** In the **MTU** field, enter a maximum transmission unit (MTU), which designates the largest size packet allowed.

The range of MTU values can vary depending on the model of the managed device and the interface type.
Caution  Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

Step 11  Click Save.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
Snort® Restart Scenarios, on page 279

Adding Logical Switched Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
</tbody>
</table>

Procedure

Step 1  Choose Devices > Device Management.

Step 2  Next to the device where you want to add the switched interface, click the edit icon ( ).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3  Choose Add Logical Interface from the Add drop-down menu.

Step 4  Click Switched.

Step 5  From the Interface drop-down list, choose the physical interface that will receive the VLAN-tagged traffic.

Step 6  In the VLAN Tag field, enter a tag value that gets assigned to inbound and outbound traffic on this interface. The tag value can be any integer from 1 to 4094.

Step 7  If you want to associate the switched interface with a security zone, do one of the following:

• Choose an existing security zone from the Security Zone drop-down list.
• Choose New to add a new security zone; see Creating Security Zone Objects, on page 332.

Step 8  If you want to associate the switched interface with a virtual switch, do one of the following:

• Choose an existing virtual switch from the Virtual Switch drop-down list.
• Choose New to add a new virtual switch; see Adding Virtual Switches, on page 547.
Step 9
Check the Enabled check box to allow the switched interface to handle traffic.
If you clear the check box, the interface becomes disabled and administratively taken down. If you disable a physical interface, you also disable all of the logical interfaces associated with it.

Step 10
In the MTU field, enter a maximum transmission unit (MTU), which designates the largest size packet allowed. The range of MTU values can vary depending on the model of the managed device and the interface type.

Caution
Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

Step 11
Click Save.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
Snort® Restart Scenarios, on page 279

Deleting Logical Switched Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1
Choose Devices > Device Management.

Step 2
Next to the managed device that contains the switched interface you want to delete, click the edit icon (✍).
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3
Next to the logical switched interface you want to delete, click the delete icon (🗑).

Step 4
When prompted, confirm that you want to delete the interface.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Virtual Switch Configuration

Before you can use switched interfaces in a Layer 2 deployment, you must configure virtual switches and assign switched interfaces to them. A virtual switch is a group of switched interfaces that process inbound and outbound traffic through your network.

Virtual Switch Configuration Notes

You can add virtual switches from the Virtual Switches tab of the Device Management page. The Virtual Switches tab displays a list of all the virtual switches you have configured on a device. The page includes summary information about each switch.

Table 67: Virtual Switches Table View Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the virtual switch.</td>
</tr>
<tr>
<td>Interfaces</td>
<td>All switched interfaces that are assigned to the virtual switch. Interfaces that you have disabled from the Interfaces tab are not available.</td>
</tr>
<tr>
<td>Hybrid Interface</td>
<td>The optionally configured hybrid interface that ties the virtual switch to a virtual router.</td>
</tr>
<tr>
<td>Unicast Packets</td>
<td>Unicast packet statistics for the virtual switch, including:</td>
</tr>
<tr>
<td></td>
<td>• Unicast packets received</td>
</tr>
<tr>
<td></td>
<td>• Unicast packets forwarded (excludes drops by host)</td>
</tr>
<tr>
<td></td>
<td>• Unicast packets unintentionally dropped</td>
</tr>
<tr>
<td>Broadcast Packets</td>
<td>Broadcast packet statistics for the virtual switch, including:</td>
</tr>
<tr>
<td></td>
<td>• Broadcast packets received</td>
</tr>
<tr>
<td></td>
<td>• Broadcast packets forwarded</td>
</tr>
<tr>
<td></td>
<td>• Broadcast packets unintentionally dropped</td>
</tr>
</tbody>
</table>

You can also add switches as you configure switched interfaces. You can assign only switched interfaces to a virtual switch. If you want to create a virtual switch before you configure the switched interfaces on your managed devices, you can create an empty virtual switch and add interfaces to it later.

Tip

To edit an existing virtual switch, click the edit icon (✏️) next to the switch.
Adding Virtual Switches

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device where you want to add the virtual switch, click the edit icon ( ).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Virtual Switches tab.

**Step 4** Click Add Virtual Switch.

**Step 5** Enter a name in the Name field.

**Step 6** From the Available list, choose one or more switched interfaces to add to the virtual switch.

**Tip** Interfaces that you have disabled from the Interfaces tab are not available; disabling an interface after you add it removes it from the configuration.

**Step 7** Click Add.

**Step 8** If you want to tie the virtual switch to a virtual router, choose a hybrid interface from the Hybrid Interface drop-down list.

**Step 9** Optionally, configure advanced settings for the switch; see Advanced Virtual Switch Settings, on page 547

**Step 10** Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

Logical Hybrid Interfaces, on page 597

Advanced Virtual Switch Settings

**Adding Static MAC Entries**

Over time, a virtual switch learns MAC addresses by tagging return traffic from the network. You can manually add a static MAC entry, which designates that a MAC address resides on a specific port. Regardless of whether you ever receive traffic from that port, the MAC address remains static in the table. You can specify one or more static MAC addresses for each virtual switch.
Enabling Spanning Tree Protocol (STP) and Dropping Bridge Protocol Data Units (BPDU)

STP is a network protocol used to prevent network loops. BPDU are exchanged through the network, carrying information about network bridges. The protocol uses BPDU to identify and select the fastest network links, if there are redundant links in the network. If a network link fails, Spanning Tree fails over to an existing alternate link.

Note
Cisco strongly recommends that you enable STP when configuring a virtual switch that you plan to deploy in a 7000 or 8000 Series device high-availability pair. Only enable STP if your virtual switch switches traffic between multiple network interfaces.

If your virtual switch routes traffic between VLANs, similar to a router on a stick, BPDU enter and exit the device through different logical switched interfaces, but the same physical switched interface. As a result, STP identifies the device as a redundant network loop, which can cause issues in certain Layer 2 deployments. To prevent this, you can configure the virtual switch at the domain level to have the device drop BPDU when monitoring traffic. You can only drop BPDU if you disable STP.

Note
Drop BPDU only if your virtual switch routes traffic between VLANs on a single physical interface.

Enabling Strict TCP Enforcement

To maximize TCP security, you can enable strict enforcement, which blocks connections where the three-way handshake was not completed. Strict enforcement also blocks:

- non-SYN TCP packets for connections where the three-way handshake was not completed
- non-SYN/RST packets from the initiator on a TCP connection before the responder sends the SYN-ACK
- non-SYN-ACK/RST packets from the responder on a TCP connection after the SYN but before the session is established
- SYN packets on an established TCP connection from either the initiator or the responder

Note that if you associate the virtual switch with a logical hybrid interface, the switch uses the same strict TCP enforcement setting as the virtual router associated with the logical hybrid interface. You cannot specify strict TCP enforcement on the switch in this case.

Configuring Advanced Virtual Switch Settings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1
Choose Devices > Device Management.
Deleting Virtual Switches

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

When you delete a virtual switch, any switched interfaces assigned to the switch become available for inclusion in another switch.

Procedure

Step 1 Choose Devices > Device Management.
Step 2 Next to the managed device that contains the virtual switch you want to delete, click the edit icon (📝). In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.
Deleting Virtual Switches

**Step 3**  
Click the **Virtual Switches** tab.

**Step 4**  
Next to the virtual switch that you want to delete, click the delete icon (Trash).  

**Step 5**  
When prompted, confirm that you want to delete the virtual switch.

---

**What to do next**

- Deploy configuration changes; see [Deploy Configuration Changes, on page 277](#).
Setting Up Virtual Routers

The following topics describe how to set up virtual routers in the Firepower System:

- Virtual Routers, on page 551
- Routed Interfaces, on page 552
- Configuring Physical Routed Interfaces, on page 553
- Adding Logical Routed Interfaces, on page 555
- Deleting Logical Routed Interfaces, on page 557
- Configuring SFRP, on page 558
- Virtual Router Configuration, on page 559
- Adding Virtual Routers, on page 560
- DHCP Relay, on page 561
- Static Routes, on page 563
- Dynamic Routing, on page 565
- Virtual Router Filters, on page 577
- Adding Virtual Router Authentication Profiles, on page 580
- Viewing Virtual Router Statistics, on page 581
- Deleting Virtual Routers, on page 581

Virtual Routers

You can configure a managed device in a Layer 3 deployment so that it routes traffic between two or more interfaces. To route traffic, you must assign an IP address to each interface and assign the interfaces to the virtual router. The interfaces assigned to virtual routers can be physical, logical, or link aggregation group (LAG) interfaces.

You can configure the system to route packets by making packet forwarding decisions according to the destination address. Interfaces configured as routed interfaces receive and forward the Layer 3 traffic. Routers obtain the destination from the outgoing interface based on the forwarding criteria, and access control rules designate the security policies to be applied.

In Layer 3 deployments, you can define static routes. In addition, you can configure Routing Information Protocol (RIP) and Open Shortest Path First (OSPF) dynamic routing protocols. You can also configure a combination of static routes and RIP or static routes and OSPF.

Note that you can only configure virtual routers, physical routed interfaces, or logical routed interfaces on a 7000 or 8000 Series device.
Caution
If a Layer 3 deployment fails for any reason, the device no longer passes traffic.

**Related Topics**
- LAG Configuration, on page 584

# Routed Interfaces

You can set up routed interfaces with either physical or logical configurations. You can configure physical routed interfaces for handling untagged VLAN traffic. You can also create logical routed interfaces for handling traffic with designated VLAN tags.

In a Layer 3 deployment, the system drops any traffic received on an external physical interface that does not have a routed interface waiting for it. The system drops a packet if:

- It receives a packet with no VLAN tag, and you have not configured a physical routed interface for that port.
- It receives a VLAN-tagged packet, and you have not configured a logical routed interface for that port.

The system handles traffic that has been received with VLAN tags on switched interfaces by stripping the outermost VLAN tag on ingress prior to any rules evaluation or forwarding decisions. Packets leaving the device through a VLAN-tagged logical routed interface are encapsulated with the associated VLAN tag on egress. The system drops any traffic received with a VLAN tag after the stripping process completes.

You can add static Address Resolution Protocol (ARP) entries to a routed interface. If an external host needs to know the MAC address of the destination IP address it needs to send traffic to on your local network, it sends an ARP request. When you configure static ARP entries, the virtual router responds with an IP address and associated MAC address.

Note that disabling the **ICMP Enable Responses** option for logical routed interfaces does not prevent ICMP responses in all scenarios. You can add network-based rules to an access control policy to drop packets where the destination IP is the routed interface’s IP and the protocol is ICMP.

If you have enabled the **Inspect Local Router Traffic** option on the managed device, the system drops the packets before they reach the host, thereby preventing any response.

The range of MTU values can vary depending on the model of the managed device and the interface type.

Caution
Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See **Snort® Restart Traffic Behavior**, on page 280 for more information.

If you change the parent physical interface to inline or passive, the system deletes all the associated logical interfaces.

**Related Topics**
- Advanced Device Settings, on page 183
- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
Configuring Physical Routed Interfaces

You can configure one or more physical ports on a managed device as routed interfaces. You must assign a physical routed interface to a virtual router before it can route traffic.

**Caution**

Adding a routed interface pair on a 7000 or 8000 Series device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Scenarios, on page 279 for more information.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device you want to modify, click the edit icon (-pencil).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Next to the interface you want to modify, click the edit icon (-pencil).

**Step 4** Click Routed to display the routed interface options.

**Step 5** If you want to apply a security zone, do one of the following:

- Choose an existing security zone from the Security Zone drop-down list.
- Choose New to add a new security zone; see Creating Security Zone Objects, on page 332.

**Step 6** If you want to specify a virtual router, do one of the following:

- Choose an existing virtual router from the Virtual Router drop-down list.
- Choose New to add a new virtual router; Adding Virtual Routers, on page 560.

**Step 7** Check the Enabled check box to allow the routed interface to handle traffic. If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.

**Step 8** From the Mode drop-down list, choose an option to designate the link mode, or choose Autonegotiation to specify that the interface is configured to auto negotiate speed and duplex settings.

Mode settings are available only for copper interfaces. Interfaces on 8000 Series appliances do not support half-duplex options.

**Step 9** From the MDI/MDIX drop-down list, choose an option to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX.
Normally, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.

MDI/MDIX settings are available only for copper interfaces.

**Step 10**

In the **MTU** field, choose a maximum transmission unit (MTU), which designates the largest size packet allowed.

The MTU is the Layer 2 MTU/MRU and not the Layer 3 MTU.

The range of MTU values can vary depending on the model of the managed device and the interface type.

**Caution** Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

**Step 11**

Next to **ICMP**, check the **Enable Responses** check box to allow the interface to respond to ICMP traffic such as pings and traceroute.

**Step 12**

Next to **IPv6 NDP**, check the **Enable Router Advertisement** check box to enable the interface to broadcast router advertisements.

**Step 13**

To add an IP address, click **Add**.

**Step 14**

In the **Address** field, enter the routed interface’s IP address and subnet mask using CIDR notation.

Note the following:

- You cannot add network and broadcast addresses, or the static MAC addresses 00:00:00:00:00:00 and FF:FF:FF:FF:FF:FF.
- You cannot add identical IP addresses, regardless of subnet mask, to interfaces in virtual routers.

**Step 15**

If your organization uses IPv6 addresses and you want to set the IP address of the interface automatically, check the **Address Autoconfiguration** check box next to the **IPv6** field.

**Step 16**

For **Type**, choose either **Normal** or **SFRP**.

For SFRP options, see Configuring SFRP, on page 558 for more information.

**Step 17**

Click **OK**.

- To edit an IP address, click the edit icon (ˌ).  
- To delete an IP address, click the delete icon (ˌ).

**Note** When adding an IP address to a routed interface of a 7000 or 8000 Series device in a high-availability pair, you must add a corresponding IP address to the routed interface on the high-availability pair peer.

**Step 18**

To add a static ARP entry, click **Add**.

**Step 19**

In the **IP Address** field, enter an IP address for the static ARP entry.

**Step 20**

In the **MAC Address** field, enter a MAC address to associate with the IP address. Use the standard address format of six groups of two hexadecimal digits separated by colons (for example, 01:23:45:67:89:AB).
Adding Logical Routed Interfaces

For each physical routed interface, you can add multiple logical routed interfaces. You must associate each logical interface with a VLAN tag to handle traffic received by the physical interface with that specific tag. You must assign a logical routed interface to a virtual router to route traffic.

Adding a routed interface pair on 7000 or 8000 Series devices restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Procedure

Step 1 Choose Devices > Device Management.
Step 2 Next to the device you want to modify, click the edit icon ( ).
   In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.
Step 3 Click Add Interface.
Step 4 Click Routed to display the routed interface options.
Step 5 From the Interface drop-down list, choose the physical interface where you want to add the logical interface.
Step 6 In the VLAN Tag field, enter a tag value that gets assigned to inbound and outbound traffic on this interface. The value can be any integer from 1 to 4094.
Step 7  If you want to apply a security zone, do one of the following:

- Choose an existing security zone from the Security Zone drop-down list.
- Choose New to add a new security zone; see Creating Security Zone Objects, on page 332.

Step 8  If you want to specify a virtual router, do one of the following:

- Choose an existing virtual router from the Virtual Router drop-down list.
- Choose New to add a new virtual router; Adding Virtual Routers, on page 560.

Step 9  Check the Enabled check box to allow the routed interface to handle traffic.

If you clear the check box, the interface becomes disabled and administratively taken down. If you disable a physical interface, you also disable all of the logical interfaces associated with it.

Step 10  In the MTU field, enter a maximum transmission unit (MTU), which designates the largest size packet allowed. The MTU is the Layer 2 MTU/MRU and not the Layer 3 MTU.

The range of MTU values can vary depending on the model of the managed device and the interface type.

Caution  Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

Step 11  Next to ICMP, check the Enable Responses check box to communicate updates or error information to other routers, intermediary devices, or hosts.

Step 12  Next to IPv6 NDP, check the Enable Router Advertisement check box to enable the interface to broadcast router advertisements.

Step 13  To add an IP address, click Add.

Step 14  In the Address field, enter the IP address in CIDR notation.

Note the following:

- You cannot add network and broadcast addresses, or the static MAC addresses 00:00:00:00:00:00 and FF:FF:FF:FF:FF:FF.
- You cannot add identical IP addresses, regardless of subnet mask, to interfaces in virtual routers.

Step 15  If your organization uses IPv6 addresses and you want to set the IP address of the interface automatically, choose the Address Autoconfiguration check box next to the IPv6 field.

Step 16  For Type, choose either Normal or SFRP.

For SFRP options, see Configuring SFRP, on page 558 for more information.

Step 17  Click OK.

- To edit an IP address, click the edit icon (✏).
- To delete an IP address, click the delete icon (🗑).
When you add an IP address to a routed interface of a 7000 or 8000 Series device in a high-availability pair, you must add a corresponding IP address to the routed interface on the high-availability pair peer.

**Note**

Step 18  
To add a static ARP entry, click **Add**.

Step 19  
In the **IP Address** field, enter an IP address for the static ARP entry.

Step 20  
In the **MAC Address** field, enter a MAC address to associate with the IP address. Use the standard address format of six groups of two hexadecimal digits separated by colons (for example, 01:23:45:67:89:AB).

Step 21  
Click **OK**. The static ARP entry is added.

**Tip**

To edit a static ARP entry, click the edit icon ( Modiﬁcations to a static ARP entry). To delete a static ARP entry, click the delete icon ().

Step 22  
Click **Save**.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
- Snort® Restart Scenarios, on page 279

---

## Deleting Logical Routed Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

When you delete a logical routed interface, you remove it from the physical interface where it resides, as well as its assigned virtual router and security zone.

**Procedure**

Step 1  
Choose **Devices > Device Management**.

Step 2  
Next to the device you want to modify, click the edit icon ( ).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3  
Next to the logical routed interface you want to delete, click the delete icon ( ).

Step 4  
When prompted, confirm that you want to delete the interface.
Configuring SFRP

You can configure Cisco Redundancy Protocol (SFRP) to achieve network redundancy for high availability on either a 7000 or 8000 Series device high-availability pair or individual devices. SFRP provides gateway redundancy for both IPv4 and IPv6 addresses. You can configure SFRP on routed and hybrid interfaces.

If the interfaces are configured on individual devices, they must be in the same broadcast domain. You must designate at least one of the interfaces as master and an equal number as backup. The system supports only one master and one backup per IP address. If network connectivity is lost, the system automatically promotes the backup to master to maintain connectivity.

The options you set for SFRP must be the same on all interfaces in a group of SFRP interfaces. Multiple IP addresses in a group must be in the same master/backup state. Therefore, when you add or edit an IP address, the state you set for that address propagates to all the addresses in the group. For security purposes, you must enter values for Group ID and Shared Secret that are shared among the interfaces in the group.

To enable SFRP IP addresses on a virtual router, you must also configure one non-SFRP IP address. Note that only one non-SFRP address should be configured per interface.

As all SFRPs in a group failover together, all SFRPs on the same virtual router should be in the same SFRP group. In addition, you should also set up an HA link interface on each device in a high-availability pair when using NAT, HA state sharing, or VPN. For more information on HA link interfaces, see Configuring HA Link Interfaces, on page 385.

For 7000 or 8000 Series devices in a high-availability pair, you designate the shared secret and the system copies it to the high-availability pair peer along with the SFRP IP configuration. The shared secret authenticates peer data.

---

### Note

Cisco does not recommend enabling more than one non-SFRP IP address on a 7000 or 8000 Series device high-availability pair's routed or hybrid interface where one SFRP IP address is already configured. The system does not perform NAT if a 7000 or 8000 Series device high-availability pair fails over while in standby mode.

### Procedure

#### Step 1
Choose Devices > Device Management.

#### Step 2
Next to the device you want to modify, click the edit icon (✏️).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.
Step 3  Next to the interface where you want to configure SFRP, click the edit icon ( ).

Step 4  Choose the type of interface where you want to configure SFRP, either Routed or Hybrid.

Step 5  You can configure SFRP while adding or editing an IP address. Click Add to add an IP address. To edit an IP address, click the edit icon ( ).

Step 6  For Type, choose SFRP to display the SFRP options.

Step 7  In the Group ID field, enter a value that designates a group of master or backup interfaces configured for SFRP.

Step 8  For Priority, choose either Master or Backup to designate the preferred interface:

  - For individual devices, you must set one interface to master on one device and the other to backup on a second device.
  - For 7000 or 8000 Series device high-availability pairs, when you set one interface as master, the other automatically becomes the backup.

Step 9  In the Shared Secret field, enter a shared secret.

  The Shared Secret field populates automatically for a group in a 7000 or 8000 Series device high-availability pair.

Step 10 In the Adv. Interval (seconds) field, enter an interval for route advertisements for Layer 3 traffic.

Step 11 Click OK.

Step 12 Click Save.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

- About 7000 and 8000 Series Device High Availability, on page 405

---

**Virtual Router Configuration**

**Caution**

Adding a virtual router on a 7000 or 8000 Series device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Before you can use routed interfaces in a Layer 3 deployment, you must configure virtual routers and assign routed interfaces to them. A virtual router is a group of routed interfaces that route Layer 3 traffic.

You can assign only routed and hybrid interfaces to a virtual router.

To maximize TCP security, you can enable strict enforcement, which blocks connections where the three-way handshake was not completed. Strict enforcement also blocks:

  - non-SYN TCP packets for connections where the three-way handshake was not completed
• non-SYN/RST packets from the initiator on a TCP connection before the responder sends the SYN-ACK
• non-SYN-ACK/RST packets from the responder on a TCP connection after the SYN but before the session is established
• SYN packets on an established TCP connection from either the initiator or the responder

Note that if you change the configuration of a Layer 3 interface to a non-Layer 3 interface or remove a Layer 3 interface from the virtual router, the router may fall into an invalid state. For example, if it is used in DHCPv6, it may cause an upstream and downstream mismatch.

### Adding Virtual Routers

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can add virtual routers from the Virtual Routers tab of the device management page. You can also add routers as you configure routed interfaces.

If you want to create a virtual router before you configure the interfaces on your managed devices, you can create an empty virtual router and add interfaces to it later.

**Caution**

Adding a virtual router on a 7000 or 8000 Series device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

### Procedure

**Step 1**  Choose **Devices > Device Management**.

**Step 2**  Next to the device you want to modify, click the edit icon (-pencil).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3**  Click the Virtual Routers tab.

**Tip**  If your devices are in a stack in a high-availability pair, choose the stack you want to modify from the Selected Device drop-down list.

**Step 4**  Click **Add Virtual Router**.

**Step 5**  In the Name field, enter a name for the virtual router. You can use alphanumeric characters and spaces.

**Step 6**  Configure IPv6 static routing, OSPFv3, and RIPng on your virtual router by checking or clearing the IPv6 Support check box.

**Step 7**  If you do not want to enable strict TCP enforcement, clear the Strict TCP Enforcement check box. This option is enabled by default.
Step 8 Choose one or more interfaces from the Available list under Interfaces, and click Add.

The Available list contains all enabled Layer 3 interfaces, routed and hybrid, on the device that you can assign to the virtual router.

Tip To remove a routed or hybrid interface from the virtual router, click the delete icon ( ). Disabling a configured interface from the Interfaces tab also removes it.

Step 9 Click Save.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

DHCP Relay

DHCP provides configuration parameters to Internet hosts. A DHCP client that has not yet acquired an IP address cannot communicate directly with a DHCP server outside its broadcast domain. To allow DHCP clients to communicate with DHCP servers, you can configure DHCP relay instances to handle cases where the client is not on the same broadcast domain as the server.

You can set up DHCP relay for each virtual router you configure. By default, this feature is disabled. You can enable either DHCPv4 relay or DHCPv6 relay.

Note You cannot run a DHCPv6 Relay chain through two or more virtual routers running on the same device.

Setting Up DHCPv4 Relay

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

The following procedure explains how to set up DHCPv4 relay on a virtual router.

Procedure

Step 1 Choose Devices > Device Management.

Step 2 Next to the device you want to modify, click the edit icon ( ).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3 Click the Virtual Routers tab.

Step 4 Next to the virtual router you want to modify, click the edit icon ( ).
Setting Up DHCPv6 Relay

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You cannot run a DHCPv6 Relay chain through two or more virtual routers running on the same device.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device you want to modify, click the edit icon (✏).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Virtual Routers tab.

**Step 4** Next to the virtual router where you want to set up DHCP relay, click the edit icon (✏).

**Step 5** Check the DHCPv6 check box.

**Step 6** In the Interfaces field, check the check boxes next to one or more interfaces that have been assigned to the virtual router.

**Tip** You cannot disable an interface from the Interfaces tab while it is configured for DHCPv6 Relay. You must first clear the DHCPv6 Relay interfaces check box and save the configuration.

**Step 7** Next to a selected interface, click the drop-down icon and choose whether the interface relays DHCP requests Upstream, Downstream, or Both.

**Note** You must include at least one downstream interface and one upstream interface. Choosing both means that the interface is both downstream and upstream.

**Step 8** In the Max Hops field, enter the maximum number of hops from 1 to 255.
Step 9  
Click Save.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Static Routes

Static routing allows you to write rules about the IP addresses of traffic passing through a router. It is the simplest way of configuring path selection of a virtual router because there is no communication with other routers regarding the current topology of the network.

Do not configure routing to IP interfaces for DHCPv4 servers that the assigned virtual router cannot route packets to. Doing so will render previously specified routable DHCP4 servers unroutable.

The Static Routes table includes summary information about each route, as described in the following table.

**Table 68: Static Routes Table View Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Specifies whether this route is currently enabled or disabled.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the static route.</td>
</tr>
<tr>
<td>Destination</td>
<td>The destination network where traffic is routed.</td>
</tr>
<tr>
<td>Type</td>
<td>Specifies the action that is taken for this route, which will be one of the following:</td>
</tr>
<tr>
<td></td>
<td>• IP — designates that the route forwards packets to the address of a neighboring router.</td>
</tr>
<tr>
<td></td>
<td>• Interface — designates that the route forwards packets to an interface through which traffic is routed to hosts on a directly connected network.</td>
</tr>
<tr>
<td></td>
<td>• Discard — designates that the static route drops packets.</td>
</tr>
<tr>
<td>Gateway</td>
<td>The target IP address if you selected IP as the static route type or the interface if you selected Interface as the static route type.</td>
</tr>
<tr>
<td>Preference</td>
<td>Determines the route selection. If you have multiple routes to the same destination, the system selects the route with the higher preference.</td>
</tr>
</tbody>
</table>
Viewing the Static Routes Table

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device you want to view, click the edit icon (edit).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Virtual Routers tab.

**Step 4** Next to the virtual router where you want to view static routes, click the edit icon (edit).

If a view icon (view) appears instead, the configuration belongs to a descendant domain, or you do not have permission to modify the configuration.

**Step 5** Click the Static tab.

Adding Static Routes

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device where you want to add the static route, click the edit icon (edit).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Virtual Routers tab.

**Step 4** Next to the virtual router where you want to add the static route, click the edit icon (edit).

**Step 5** Click Static to display the static route options.

**Step 6** Click Add Static Route.

**Step 7** In the Route Name field, enter a name for the static route. You can use alphanumeric characters and spaces.

**Step 8** For Enabled, check the check box to specify that the route is currently enabled.

**Step 9** In the Preference field, enter a numerical value between 1 and 65535 to determine the route selection.
If you have multiple routes to the same destination, the system uses the route with the higher preference.

**Step 10** From the **Type** drop-down list, choose the type of static route you are configuring.

**Step 11** In the **Destination** field, enter the IP address for the destination network where traffic should be routed.

**Step 12** In the **Gateway** field, you have two options:

- If you chose **IP** as the selected static route type, choose an IP address.
- If you chose **Interface** as the selected static route type, choose an enabled interface from the drop-down list.

**Tip** Interfaces you have disabled from the **Interfaces** tab are not available; disabling an interface you have added removes it from the configuration.

**Step 13** Click **OK**.

**Step 14** Click **Save**.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

### Dynamic Routing

Dynamic, or adaptive, routing uses a routing protocol to alter the path that a route takes in response to a change in network conditions. The adaptation is intended to allow as many routes as possible to remain valid, that is, have destinations that can be reached in response to the change. This allows the network to “route around” damage, such as loss of a node or a connection between nodes, so long as other path choices are available.

You can configure a router with no dynamic routing, or you can configure the Routing Information Protocol (RIP) or the Open Shortest Path First (OSPF) routing protocol.

### RIP Configuration

Routing Information Protocol (RIP) is a dynamic routing protocol, designed for small IP networks, that relies on hop count to determine routes. The best routes use the fewest number of hops. The maximum number of hops allowed for RIP is 15. This hop limit also limits the size of the network that RIP can support.

**Adding Interfaces for RIP Configuration**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/N Network Admin</td>
</tr>
</tbody>
</table>

While configuring RIP, you must choose interfaces from those already included in the virtual router, where you want to configure RIP. Disabled interfaces are not available.
Procedure

Step 1  Choose **Devices > Device Management**.

Step 2  Next to the device you want to modify, click the edit icon (-pencil).

Step 3  In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 4  Click the **Virtual Routers** tab.

Step 5  Next to the virtual router you want to modify, click the edit icon (-pencil).

Step 6  Click **Dynamic Routing** to display the dynamic routing options.

Step 7  Click **RIP** to display the RIP options.

Step 8  Under **Interfaces**, click the icon (grid).

Step 9  From the **Name** drop-down list, choose the interface where you want to configure RIP.

Tip  Interfaces you have disabled from the Interfaces tab are not available; disabling an interface you have added removes it from the configuration.

Step 10  From the **Mode** drop-down list, choose one of the following options:

- **Multicast** — default mode where RIP multicasts the entire routing table to all adjacent routers at a specified address.
- **Broadcast** — forces RIP to use broadcast (for example, RIPv1) even though multicast mode is possible.
- **Quiet** — RIP will not transmit any periodic messages to this interface.
- **No Listen** — RIP will send to this interface but not listen to it.

Step 11  Click **Save**.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Configuring Authentication Settings for RIP Configuration

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

RIP authentication uses one of the authentication profiles you configured on the virtual router.
Procedure

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device you want to modify, click the edit icon (✏). In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Virtual Routers tab.

**Step 4** Next to the virtual router where you want to add the RIP authentication profile, click the edit icon (✏).

**Step 5** Click Dynamic Routing to display the dynamic routing options.

**Step 6** Click RIP to display the RIP options.

**Step 7** Under Authentication, choose an existing virtual router authentication profile from the Profile drop-down list, or choose None.

**Step 8** Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

## Configuring Advanced Settings for RIP Configuration

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can configure several advanced RIP settings pertaining to various timeout values and other features that affect the behavior of the protocol.

**Caution**

Changing any of the advanced RIP settings to incorrect values can prevent the router from communicating successfully with other RIP routers.

**Procedure**

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device you want to modify, click the edit icon (✏). In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the Virtual Routers tab.

**Step 4** Next to the virtual router you want to modify, click the edit icon (✏).

**Step 5** Click Dynamic Routing to display the dynamic routing options.

**Step 6** Click RIP to display the RIP options.
Step 7 In the Preference field, enter a numerical value (higher is better) for the preference of the routing protocol. The system prefers routes learned through RIP over static routes.

Step 8 In the Period field, enter the interval, in seconds, between periodic updates. A lower number determines faster convergence, but larger network load.

Step 9 In the Timeout Time field, enter a numerical value that specifies how old routes must be, in seconds, before being considered unreachable.

Step 10 In the Garbage Time field, enter a numerical value that specifies how old routes must be, in seconds, before being discarded.

Step 11 In the Infinity field, enter a numerical value that specifies a value for infinity distance in convergence calculations. Larger values will make protocol convergence slower.

Step 12 From the Honor drop-down list, choose one of the following options to designate when requests for dumping routing tables should be honored:

- **Always** — always honor requests
- **Neighbor** — only honor requests sent from a host on a directly connected network
- **Never** — never honor requests

Step 13 Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**Adding Import Filters for RIP Configuration**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can add an import filter to designate which routes are accepted or rejected from RIP into the route table. Import filters are applied in the order they appear in the table.

When adding an import filter, you use one of the filters you configured on the virtual router.

**Tip**

To edit a RIP import filter, click the edit icon (편집). To delete a RIP import filter, click the delete icon (삭제).

**Before you begin**

- Add a virtual router as described in Adding Virtual Routers, on page 560.
- Configure a filter on the virtual router as described in Setting Up Virtual Router Filters, on page 579.
Procedure

Step 1
Choose Devices > Device Management.

Step 2
Next to the device you want to modify, click the edit icon (✏️).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3
Click the Virtual Routers tab.

Step 4
Next to the virtual router where you want to add the RIP virtual router filter, click the edit icon (✏️).

Step 5
Click Dynamic Routing to display the dynamic routing options.

Step 6
Click RIP to display the RIP options.

Step 7
Under Import Filters, click the add icon (➕).

Step 8
From the Name drop-down list, choose the filter you want to add as an import filter.

Step 9
Next to Action, choose Accept or Reject.

Step 10
Click OK.

Tip
To change the order of the import filters, click the move up (▲) and move down (▼) icons as needed. You can also drag the filters up or down in the list.

Step 11
Click Save.

What to do next
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Adding Export Filters for RIP Configuration

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can add an export filter to define which routes will be accepted or rejected from the route table to RIP. Export filters are applied in the order they appear in the table.

When adding an export filter, you use one of the filters you configured on the virtual router.

Procedure

Step 1
Choose Devices > Device Management.

Step 2
Next to the device you want to modify, click the edit icon (✏️).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3
Click the Virtual Routers tab.
Step 4  Next to the virtual router where you want to add the RIP virtual router filter, click the edit icon ( editText ).
Step 5  Click Dynamic Routing to display the dynamic routing options.
Step 6  Click RIP to display the RIP options.
Step 7  Under Export Filters, click the add icon ( addIcon ).
Step 8  From the Name drop-down list, choose the filter you want to add as an export filter.
Step 9  Next to Action, choose Accept or Reject.
Step 10  Click OK.
Tip  To change the order of the export filters, click the move up ( moveUp ) and move down ( moveDown ) icons as needed. You can also drag the filters up or down in the list.
Step 11  Click Save.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

OSPF Configuration

Open Shortest Path First (OSPF) is an adaptive routing protocol that defines routes dynamically by obtaining information from other routers and advertising routes to other routers using link state advertisements. The router keeps information about the links between it and the destination to make routing decisions. OSPF assigns a cost to each routed interface, and considers the best routes to have the lowest costs.

OSPF Routing Areas

An OSPF network may be structured, or subdivided, into routing areas to simplify administration and optimize traffic and resource use. Areas are identified by 32-bit numbers, expressed either simply in decimal or often in octet-based dot-decimal notation.

By convention, area zero or 0.0.0.0 represents the core or backbone region of an OSPF network. You may choose to identify other areas. Often, administrators select the IP address of a main router in an area as the area's identification. Each additional area must have a direct or virtual connection to the backbone OSPF area. Such connections are maintained by an interconnecting router, known as the area border router (ABR). An ABR maintains separate link state databases for each area it serves and maintains summarized routes for all areas in the network.

Adding OSPF Areas

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>
Procedure

Step 1  Choose Devices > Device Management.

Step 2  Next to the device you want to modify, click the edit icon (-pencil).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3  Click the Virtual Routers tab.

Step 4  Next to the virtual router you want to modify, click the edit icon (-pencil).

Step 5  Click Dynamic Routing to display the dynamic routing options.

Step 6  Click OSPF to display the OSPF options.

Step 7  Under Areas, click the add icon (-plus).

Step 8  In the Area Id field, enter a numerical value for the area. This value can be either an integer or an IPv4 address.

Step 9  Optionally, check the Stubnet check box to designate that the area does not receive router advertisements external to the autonomous system and routing from within the area is based entirely on a default route. If you clear the check box, the area becomes a backbone area or otherwise non-stub area.

Step 10  In the Default cost field, enter a cost associated with the default route for the area.

Step 11  Under Stubnets, click the add icon (-plus).

Step 12  In the IP Address field, enter an IP address in CIDR notation.

Step 13  Choose the Hidden check box to indicate that the stubnet is hidden.

Hidden stubnets are not propagated into other areas.

Step 14  Choose the Summary check box to designate that default stubnets that are subnetworks of this stubnet are suppressed.

Step 15  In the Stub cost field, enter a value that defines the cost associated with routing to this stub network.

Step 16  Click OK.

Step 17  If you want to add a network, click the add icon (-plus) under Networks.

Step 18  In the IP Address field, enter an IP address in CIDR notation for the network.

Step 19  Check the Hidden check box to indicate that the network is hidden. Hidden networks are not propagated into other areas.

Step 20  Click OK.

Step 21  Click Save.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

OSPF Area Interfaces

You can configure a subset of the interfaces assigned to the virtual router for OSPF. The following list describes the options you can specify on each interface.
Interfaces
Select the interface where you want to configure OSPF. Interfaces you have disabled from the Interfaces tab are not available.

Type
Select the type of OSPF interface from the following choices:

- **Broadcast** — On broadcast networks, flooding and hello messages are sent using multicasts, a single packet for all the neighbors. The option designates a router to be responsible for synchronizing the link state databases and originating network link state advertisements. This network type cannot be used on physically non-broadcast multiple-access (NBMP) networks and on unnumbered networks without proper IP prefixes.

- **Point-to-Point (PtP)** — Point-to-point networks connect just two routers together. No election is performed and no network link state advertisement is originated, which makes it simpler and faster to establish. This network type is useful not only for physically PtP interfaces, but also for broadcast networks used as PtP links. This network type cannot be used on physically NBMP networks.

- **Non-Broadcast** — On NBMP networks, the packets are sent to each neighbor separately because of the lack of multicast capabilities. Similar to broadcast networks, the option designates a router, which plays a central role in the propagation of link state advertisements. This network type cannot be used on unnumbered networks.

- **Autodetect** — The system determines the correct type based on the specified interface.

Cost
Specify the output cost of the interface.

Stub
Specify whether the interface should listen for OSPF traffic and transmit its own traffic.

Priority
Enter a numerical value that specifies the priority value used in designated router election. On every multiple access network, the system designates a router and backup router. These routers have some special functions in the flooding process. Higher priority increases preferences in this election. You cannot configure a router with a priority of 0.

Nonbroadcast
Specify whether hello packets are sent to any undefined neighbors. This switch is ignored on any NBMA network.

Authentication
Select the OSPF authentication profile that this interface uses from one of the authentication profiles you configured on the virtual router or select None. For more information about configuring authentication profiles, see Adding Virtual Router Authentication Profiles, on page 580.
Hello Interval
Type the interval, in seconds, between the sending of hello messages.

Poll
Type the interval, in seconds, between the sending of hello messages for some neighbors on NBMA networks.

Retrans Interval
Type the interval, in seconds, between retransmissions of unacknowledged updates.

Retrans Delay
Type the estimated number of seconds it takes to transmit a link state update packet over the interface.

Wait Time
Type the number of seconds that the router waits between starting election and building adjacency.

Dead Interval
Type the number of seconds that the router waits before declaring a neighbor down when not receiving messages from it. If this value is defined, it overrides the value calculated from dead count.

Dead Count
Type a numerical value that when multiplied by the hello interval specifies the number of seconds that the router waits before declaring a neighbor down when not receiving messages from it.

To edit an OSPF area interface, click the edit icon ( ). To delete an OSPF area interface, click the delete icon ( ). Disabling a configured interface from the Interfaces tab also deletes it.

Adding OSPF Area Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can configure a subset of the interfaces assigned to the virtual router for OSPF.

You can choose only one interface for use in an OSPF area.

Procedure

Step 1 Choose Devices > Device Management.

Step 2 Next to the device where you want to add the OSPF interface, click the edit icon ( ).
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3 Click the Virtual Routers tab.
Step 4: Next to the virtual router where you want to add the OSPF interface, click the edit icon ( Edit ).
Step 5: Click Dynamic Routing to display the dynamic routing options.
Step 6: Click OSPF to display the OSPF options.
Step 7: Under Areas, click the add icon ( Add ).
Step 8: Click Interfaces.
Step 9: Click the add icon ( Add ).
Step 10: Take any of the actions as described in OSPF Area Interfaces, on page 571.
Step 11: If you want to add a network, click the add icon ( Add ) under Networks.
Step 12: In the IP address field, enter an IP address for the neighbor receiving hello messages on non-broadcast networks from this interface.
Step 13: Check the Eligible check box to indicate that the neighbor is eligible to receive messages.
Step 14: Click OK.

Tip: To edit a neighbor, click the edit icon ( Edit ). To delete a neighbor, click the delete icon ( Delete ).

Step 15: Click OK.
Step 16: Click Save.
Step 17: Click Save.

What to do next
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Adding OSPF Area Vlinks

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

All areas in an OSPF autonomous system must be physically connected to the backbone area. In some cases where this physical connection is not possible, you can use a vlink to connect to the backbone through a non-backbone area. Vlinks can also be used to connect two parts of a partitioned backbone through a non-backbone area.

You must add a minimum of two OSPF areas before you can add a vlink.

Procedure

Step 1: Choose Devices > Device Management.
Step 2: Next to the device you want to modify, click the edit icon ( Edit ).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.
Step 3  Click the **Virtual Routers** tab.

Step 4  Next to the virtual router you want to modify, click the edit icon ( ).

Step 5  Click **Dynamic Routing** to display the dynamic routing options.

Step 6  Click **OSPF** to display the OSPF options.

Step 7  Under **Areas**, click the add icon ( ).

Step 8  Click **Vlinks**.

Step 9  Click the add icon ( ).

Step 10  In the **Router ID** field, enter an IP address for the router.

Step 11  From the **Authentication** drop-down list, choose the authentication profile the vlink will use.

Step 12  In the **Hello Interval** field, enter the interval, in seconds, between sending of hello messages.

Step 13  In the **Retrans Interval** field, enter the interval, in seconds, between retransmissions of unacknowledged updates.

Step 14  In the **Wait Time** field, enter the number of seconds that the router waits between starting election and building adjacency.

Step 15  In the **Dead Interval** field, enter the number of seconds that the router waits before declaring a neighbor down when not receiving messages from it. If this value is defined, it overrides the value calculated from dead count.

Step 16  In the **Dead Count** field, enter a numerical value that when multiplied by the hello interval, specifies the number of seconds that the router waits before declaring a neighbor down when not receiving messages from it.

Step 17  Click **OK**.

Step 18  Click **Save**.

Step 19  Click **Save**.

---

**What to do next**

- Deploy configuration changes; see [Deploy Configuration Changes, on page 277](#).

**Adding Import Filters for OSPF Configuration**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can add an import filter to define which routes are accepted or rejected from OSPF into the route table. Import filters are applied in the order they appear in the table.

When adding an import filter, you use one of the filters you configured on the virtual router.

**Procedure**

**Step 1**  Choose **Devices > Device Management**.

**Step 2**  Next to the device you want to modify, click the edit icon ( ).
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click **Virtual Routers**.

**Step 4** Next to the virtual router you want to modify, click the edit icon (✏).

**Step 5** Click **Dynamic Routing** to display the dynamic routing options.

**Step 6** Click **OSPF** to display the OSPF options.

**Step 7** Under **Import Filters**, click the add icon (➕).

**Step 8** From the **Name** drop-down list, choose the filter you want to add as an import filter.

**Step 9** Next to **Action**, choose **Accept** or **Reject**.

**Step 10** Click **OK**.

**Tip** To change the order of the import filters, click the move up (▲) and move down (▼) icons as needed. You can also drag the filters up or down in the list.

**Step 11** Click **Save**.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**Adding Export Filters for OSPF Configuration**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can add an export filter to define which routes will be accepted or rejected from the route table to OSPF. Export filters are applied in the order they appear in the table.

When adding an export filter, you use one of the filters you configured on the virtual router.

**Procedure**

**Step 1** Choose **Devices > Device Management**.

**Step 2** Next to the device you want to modify, click the edit icon (✏).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the **Virtual Routers** tab.

**Step 4** Next to the virtual router where you want to add the OSPF virtual router filter, click the edit icon (✏).

**Step 5** Click the **Dynamic Routing** tab to display the dynamic routing options.

**Step 6** Click **OSPF** to display the OSPF options.

**Step 7** Under **Export Filters**, click the add icon (➕).
Step 8  From the **Name** drop-down list, choose the filter you want to add as an export filter.

Step 9  Next to **Action**, choose **Accept** or **Reject**.

Step 10  Click **OK**.

**Tip**

To change the order of the export filters, click the move up (▲) and move down (▼) icons as needed. You can also drag the filters up or down in the list.

Step 11  Click **Save**.

---

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes, on page 277**.

---

**Virtual Router Filters**

Filters provide a way to match routes for importing into the virtual router’s route table and for exporting routes to dynamic protocols. You can create and manage a list of filters. Each filter defines specific criteria to look for in routes that are defined statically or received from a dynamic protocol.

The Virtual Routers Filters table includes summary information about each filter you have configured on a virtual router, as described in the following table.

**Table 69: Virtual Router Filters Table View Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the filter.</td>
</tr>
<tr>
<td>Protocol</td>
<td>The protocol that the route originates from:</td>
</tr>
<tr>
<td></td>
<td>• Static — The route originates as a local static route.</td>
</tr>
<tr>
<td></td>
<td>• RIP — The route originates from a dynamic RIP configuration.</td>
</tr>
<tr>
<td></td>
<td>• OSPF — The route originates from a dynamic OSPF configuration.</td>
</tr>
<tr>
<td>From Router</td>
<td>The router IP addresses that this filter attempts to match in a router. You must enter this value for static and RIP filters.</td>
</tr>
<tr>
<td>Next Hop</td>
<td>The next hop where packets using this route are forwarded. You must enter this value for static and RIP filters.</td>
</tr>
</tbody>
</table>
### Viewing Virtual Router Filters

#### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Type</td>
<td>The type of destination where packets are sent:</td>
</tr>
<tr>
<td></td>
<td>• Router</td>
</tr>
<tr>
<td></td>
<td>• Device</td>
</tr>
<tr>
<td></td>
<td>• Discard</td>
</tr>
<tr>
<td>Destination Network</td>
<td>The networks that this filter attempts to match in a route.</td>
</tr>
<tr>
<td>OSPF Path Type</td>
<td>Applies only to OSPF protocol. The path type can be one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Ext-1</td>
</tr>
<tr>
<td></td>
<td>• Ext-2</td>
</tr>
<tr>
<td></td>
<td>• Inter Area</td>
</tr>
<tr>
<td></td>
<td>• Intra Area</td>
</tr>
<tr>
<td>OSPF Router ID</td>
<td>Applies only to OSPF protocol. The router ID of the router advertising that route/network.</td>
</tr>
</tbody>
</table>

#### Viewing Virtual Router Filters

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

The **Filter** tab of the virtual router editor displays a table listing of all the filters you have configured on a virtual router. The table includes summary information about each filter.

**Procedure**

1. **Step 1** Choose Devices > Device Management.
2. **Step 2** Next to the device you want to view, click the edit icon (редактирование).
   
   In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

3. **Step 3** Click the Virtual Routers tab.
4. **Step 4** Next to the virtual router where you want to view the filters, click the edit icon (редактирование).
5. **Step 5** Click the Filter tab.
Setting Up Virtual Router Filters

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/N Network</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  
Choose Devices > Device Management.

**Step 2**  
Next to the device you want to modify, click the edit icon (تعديل).  
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3**  
Click the Virtual Routers tab.

**Step 4**  
Next to the virtual router you want to modify, click the edit icon (تعديل).

**Step 5**  
Click the Filter tab.

**Step 6**  
Click Add Filter.

**Step 7**  
In the Name field, enter a name for the filter. You can use alphanumeric characters only.

**Step 8**  
Under Protocol, choose All or choose the protocol that applies to the filter.

**Step 9**  
If you chose All, Static, or RIP as the Protocol, under From Router, enter the router IP addresses that this filter will attempt to match in a route.

**Note**  
You can also enter a /32 CIDR block for IPv4 addresses and a /128 prefix length for IPv6 addresses. All other address blocks are invalid for this field.

**Step 10**  
Click Add.

**Step 11**  
If you chose All, Static, or RIP as the Protocol, under Next Hop, enter the IP addresses for the gateways that this filter will attempt to match in a route.

**Note**  
You can also enter a /32 CIDR block for IPv4 addresses and a /128 prefix length for IPv6 addresses. All other address blocks are invalid for this field.

**Step 12**  
Click Add.

**Step 13**  
Under Destination Type, choose the options that apply to the filter.

**Step 14**  
Under Destination Network, enter the IP address of the network that this filter will attempt to match in a route.

**Step 15**  
Click Add.

**Step 16**  
If you chose All or OSPF as the Protocol, under Path Type, choose the options that apply to the filter. You must choose at least one path type.

**Step 17**  
If you chose OSPF as the Protocol, under Router ID, enter the IP address that serves as the router ID of the router advertising the route/network.

**Step 18**  
Click Add.

**Step 19**  
Click OK.
Step 20  Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

### Adding Virtual Router Authentication Profiles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can set up Authentication Profiles for use in RIP and OSPF configurations. You can configure a simple password or specify a shared cryptographic key. Simple passwords allow for every packet to carry eight bytes of the password. The system ignores received packets lacking this password. Cryptographic keys allow for validation, a 16-byte long digest generated from a password to be appended to every packet.

Note that for OSPF, each area can have a different authentication method. Therefore, you create authentication profiles that can be shared among many areas. You cannot add authentication for OSPFv3.

**Procedure**

**Step 1**  Choose Devices > Device Management.

**Step 2**  Next to the device you want to modify, click the edit icon (✏️).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3**  Click the Virtual Routers tab.

**Step 4**  Next to the virtual router you want to modify, click the edit icon (✏️).

**Step 5**  Click Authentication Profile.

**Step 6**  Click Add Authentication Profile.

**Step 7**  In the Authentication Profile Name field, enter a name for the authentication profile.

**Step 8**  From the Authentication Type drop down list, choose simple or cryptographic.

**Step 9**  In the Password field, enter a secure password.

**Step 10**  In the Confirm Password field, enter the password again to confirm it.

**Step 11**  Click OK.

**Step 12**  Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Viewing Virtual Router Statistics

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can view runtime statistics for each virtual router. The statistics display unicast packets, packets dropped, and separate routing tables for IPv4 and IPv6 addresses.

**Procedure**

**Step 1** Choose **Devices > Device Management**.

**Step 2** Next to the device where you want to view statistics, click the edit icon (✍).  
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the **Virtual Routers** tab.

**Step 4** Next to the virtual router where you want to view the router statistics, click the view icon (👀).

Deleting Virtual Routers

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

When you delete a virtual router, any routed interfaces assigned to the router become available for inclusion in another router.

**Procedure**

**Step 1** Choose **Devices > Device Management**.

**Step 2** Next to the device you want to modify, click the edit icon (✍).  
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Click the **Virtual Routers** tab.

**Step 4** Next to the virtual router that you want to delete, click the delete icon (🗑).

**Step 5** When prompted, confirm that you want to delete the virtual router.
What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Aggregate Interfaces and LACP

The following topics explain aggregate interface configuration and how LACP functions on managed devices:

- About Aggregate Interfaces, on page 583
- LAG Configuration, on page 584
- Link Aggregation Control Protocol (LACP), on page 588
- Adding Aggregate Switched Interfaces, on page 589
- Adding Aggregate Routed Interfaces, on page 591
- Adding Logical Aggregate Interfaces, on page 594
- Viewing Aggregate Interface Statistics, on page 595
- Deleting Aggregate Interfaces, on page 595

About Aggregate Interfaces

In the Firepower System, you can group multiple physical Ethernet interfaces into a single logical link on managed devices configured in either a Layer 2 deployment that provides packet switching between networks, or a Layer 3 deployment that routes traffic between interfaces. This single aggregate logical link provides higher bandwidth, redundancy, and load-balancing between two endpoints.

You create aggregate links by creating a switched or routed link aggregation group, or LAG. When you create an aggregation group, a logical interface called an aggregate interface is created. To an upper layer entity a LAG looks like a single logical link and data traffic is transmitted through the aggregate interface. The aggregate link provides increased bandwidth by adding the bandwidth of multiple links together. It also provides redundancy by load-balancing traffic across all available links. If one link fails, the system automatically load-balances traffic across all remaining links.

The endpoints in a LAG can be two 7000 or 8000 Series devices, as shown in the illustration above, or a 7000 or 8000 Series device connected to a third-party access switch or router. The two devices do not have to match, but they must have the same physical configuration and they must support the IEEE 802.ad link aggregation standard. A typical deployment for a LAG might be to aggregate access links between two managed devices, or to create a point-to-point connection between a managed device and an access switch or a router.

Note that you cannot configure aggregate interfaces on NGIPSv devices or ASA FirePOWER modules.
LAG Configuration

There are two types of aggregate interfaces:

- switched — Layer 2 aggregate interfaces
- routed — Layer 3 aggregate interfaces

You implement link aggregation through the use of link aggregation groups (LAGs). You configure a LAG by creating an aggregate switched or routed interface and then associating a set of physical interfaces with the link. All of the physical interfaces must be of the same speed and medium.

You create aggregate links either dynamically or statically. Dynamic link aggregation uses Link Aggregation Control Protocol (LACP), a component of the IEEE 802.ad link aggregation standard, while static link aggregation does not. LACP enables each device on either end of the LAG to exchange link and system information to determine which links will be actively used in the aggregation. A static LAG configuration requires you to manually maintain link aggregations and deploy load-balancing and link selection policies.

When you create a switched or routed aggregate interface, a link aggregation group of the same type is created and numbered automatically. For example, when you create your first LAG (switched or routed), the aggregate interface can be identified by the lag0 label in the Interfaces tab for your managed device. When you associate physical and logical interfaces with this LAG, they appear nested below the primary LAG in a hierarchical tree menu. Note that a switched LAG can only contain switched physical interfaces, and a routed LAG can only contain routed physical interfaces.

Consider the following requirements when you configure a LAG:

- The Firepower System supports a maximum of 14 LAGs, and assigns a unique ID to each LAG interface in the range of 0 to 13. The LAG ID is not configurable.
- You must configure the LAG on both sides of the link, and you must set the interfaces on either side of the link to the same speed.
- You must associate at least two physical interfaces per LAG, up to a maximum of eight. A physical interface cannot belong to more than one LAG.
- Physical interfaces in a LAG cannot be used in any other mode of operation, either as inline or passive, or be used as part of another logical interface for tagged traffic.
- Physical interfaces in a LAG can span multiple NetMods, but cannot span multiple sensors (i.e. all physical interfaces must reside on the same device).
- A LAG cannot contain a stacking NetMod.

Aggregate Switched Interfaces

You can combine between two and eight physical ports on a managed device to create a switched LAG interface. You must assign a switched LAG interface to a virtual switch before it can handle traffic. A managed device can support up to 14 LAG interfaces.

The range of MTU values can vary depending on the model of the managed device and the interface type.
Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

**Related Topics**
- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
- Snort® Restart Scenarios, on page 279

## Aggregate Routed Interfaces

You can combine between two and eight physical ports on a 7000 or 8000 Series device to create a routed LAG interface. You must assign a routed LAG interface to a virtual router before it can route traffic. A managed device can support up to 14 LAG interfaces.

You can add static Address Resolution Protocol (ARP) entries to a routed LAG interface. If an external host needs to know the MAC address of the destination IP address it needs to send traffic to on your local network, it sends an ARP request. When you configure static ARP entries, the virtual router responds with an IP address and associated MAC address.

Disabling the **ICMP Enable Responses** option for routed LAG interfaces does not prevent ICMP responses in all scenarios. You can still use access control rules to handle connections where the destination IP is the routed interface’s IP and the protocol is ICMP; see Port and ICMP Code Conditions, on page 296.

If you enable the **Inspect Local Router Traffic** option, the system blocks packets before they reach the host, thereby preventing any response. For more information about inspecting local router traffic, see Advanced Device Settings, on page 183.

The range of MTU values can vary depending on the model of the managed device and the interface type.

Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

**Related Topics**
- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
- Snort® Restart Scenarios, on page 279

## Logical Aggregate Interfaces

For each switched or routed aggregate interface, you can add multiple logical interfaces. You must associate each logical LAG interface with a VLAN tag to handle traffic received by the LAG interface with that specific tag. You add logical interfaces to switched or routed aggregate interfaces in the same way you would add them to physical switched or routed interfaces.
When you create a LAG interface you also create an “untagged” logical interface by default, which is identified by the `lagn.0` label, where `n` is an integer from 0 to 13. To be operational, each LAG requires this one logical interface at a minimum. You can associate additional logical interfaces with any LAG to handle VLAN-tagged traffic. Each additional logical interface requires a unique VLAN tag. The Firepower System supports VLAN tags in the range of 1 through 4094.

You can also configure the Cisco Redundancy Protocol (SFRP) on a logical routed interface. SFRP allows devices to act as redundant gateways for specified IP addresses.

Note that disabling the **ICMP Enable Responses** option for logical routed interfaces does not prevent ICMP responses in all scenarios. You can add network-based rules to an access control policy to drop packets where the destination IP is the routed interface’s IP and the protocol is ICMP.

If you have enabled the **Inspect Local Router Traffic** option, which is an advanced setting on the managed device, it drops the packets before they reach the host, thereby preventing any response.

The range of MTU values can vary depending on the model of the managed device and the interface type.

Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See [Snort® Restart Traffic Behavior](#) on page 280 for more information.

**Related Topics**

- SFRP
- Advanced Device Settings, on page 183
- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
- Snort® Restart Scenarios, on page 279

**Load-Balancing Algorithms**

You assign an egress load-balancing algorithm to the LAG that determines how to distribute traffic to the LAG bundle’s member links. The load-balancing algorithm makes hashing decisions based on values in various packet fields, such as Layer 2 MAC addresses, Layer 3 IP addresses, and Layer 4 port numbers (TCP/UDP traffic). The load-balancing algorithm you select applies to all of the LAG bundle’s member links.

Choose the load-balancing algorithm that supports your deployment scenario from the following options when you configure a LAG:

- Destination IP
- Destination MAC
- Destination Port
- Source IP
- Source MAC
• Source Port
• Source and Destination IP
• Source and Destination MAC
• Source and Destination Port

**Note**
You should configure both ends of the LAG to have the same load-balancing algorithm. Higher layer algorithms will back off to lower layer algorithms as necessary (such as a Layer 4 algorithm backing off to Layer 3 for ICMP traffic).

### Link Selection Policies

Link aggregation requires the speed and medium of each link to be the same at both endpoints. Because link properties can change dynamically, the link selection policy helps determine how the system manages the link selection process. A link selection policy that maximizes the highest port count supports link redundancy, while a link selection policy that maximizes total bandwidth supports overall link speed. A stable link selection policy attempts to minimize excessive changes in link states.

**Note**
You should configure both ends of the LAG to have the same link selection policy.

Choose the link selection policy that supports your deployment scenario from the following options:

- **Highest Port Count** — Choose this option for the highest total active port count to provide added redundancy.
- **Highest Total Bandwidth** — Choose this option to provide the highest total bandwidth for the aggregated link.
- **Stable** — Choose this option if your primary concern is link stability and reliability. Once you configure a LAG, the active links change only when absolutely necessary (such as link failure) rather than doing so for added port count or bandwidth.
- **LACP Priority** — Choose this option to use the LACP algorithm to determine which links are active in the LAG. This setting is appropriate if you have undefined deployment goals, or if the device at the other end of the LAG is not managed by the Firepower Management Center.

LACP is a key aspect of automating the link selection method that supports dynamic link aggregation. When LACP is enabled, a link selection policy based on LACP priority uses the following properties of LACP:

**LACP system priority**

You configure this value on each partnered device running LACP to determine which one is superior in link aggregation. The system with the lower value has the higher system priority. In dynamic link aggregation, the system with the higher LACP system priority sets the selected state of member links on its side first, then the system with the lower priority sets its member links accordingly. You can specify 0 to 65535. If you do not specify a value, the default priority is 32768.
LACP link priority

You configure this value on each link belonging to the aggregation group. The link priority determines the active and standby links in the LAG. Links with lower values have higher priority. If an active link goes down, the standby link with the highest priority is selected to replace the downed link. However, if two or more links have the same LACP link priority, the link with the lowest physical port number is selected as the standby link. You can specify 0 to 65535. If you do not specify a value, the default priority is 32768.

Link Aggregation Control Protocol (LACP)

Link Aggregation Control Protocol (LACP), a component of IEEE 802.3ad, is a method of exchanging system and port information to create and maintain LAG bundles. When you enable LACP, each device on either end of the LAG uses LACP to determine which links will be actively used in the aggregation. LACP provides availability and redundancy by exchanging LACP packets (or control messages) between links. It learns the capabilities of the links dynamically and informs the other links. Once LACP identifies correctly matched links, it facilitates grouping the links into the LAG. If a link fails, traffic continues on the remaining links. LACP must be enabled at both ends of the LAG for the link to be operational.

LACP

When you enable LACP, you need to specify a transmission mode for each end of the LAG that determines how LACP packets are exchanged between partnered devices. There are two options for LACP mode:

• Active — Choose this mode to place a device into an active negotiating state, in which the device initiates negotiations with remote links by sending LACP packets.

• Passive — Choose this mode to place a device into a passive negotiating state, in which the device responds to LACP packets it receives but does not initiate LACP negotiation.

Both modes allow LACP to negotiate between links to determine if they can form a link bundle based on criteria such as port speed. However, you should avoid a passive-passive configuration, which essentially places both ends of the LAG in listening mode.

LACP has a timer which defines how often LACP packets are sent between devices. LACP exchanges packets at these rates:

• Slow — 30 seconds

• Fast — 1 second

The device where this option is applied expects to receive LACP packets with this frequency from the partner device on the other side of the LAG.
When a LAG is configured on a managed device that is part of a device stack, only the primary device participates in LACP communication with the partner system. All secondary devices forward LACP messages to the primary device. The primary device relays any dynamic LAG modifications to the secondary devices.

## Adding Aggregate Switched Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can combine between two and eight physical ports on a managed device to create a switched LAG interface. You must assign a switched LAG interface to a virtual switch before it can handle traffic. A managed device can support up to 14 LAG interfaces.

### Procedure

**Step 1** Choose **Devices > Device Management**.

**Step 2** Click the edit icon (编辑) next to the device where you want to configure the switched LAG interface. In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Choose **Add Aggregate Interface** from the **Add** drop-down menu.

**Step 4** Click **Switched** to display the switched LAG interface options.

**Step 5** If you want to apply a security zone, do one of the following:

- Choose an existing security zone from the **Security Zone** drop-down list.
- Choose **New** to add a new security zone; see Creating Security Zone Objects, on page 332.

**Step 6** Specify a virtual switch:

- Choose an existing virtual switch from the **Virtual Switch** drop-down list.
- Choose **New** to add a new virtual switch; see Adding Virtual Switches, on page 547.

**Step 7** Check the **Enabled** check box to allow the switched LAG interface to handle traffic.

If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.

**Step 8** From the **Mode**, choose an option to designate the link mode, or choose **Autonegotiation** to specify that the interface is configured to auto negotiate speed and duplex settings.

Mode settings are available only for copper interfaces.

Interfaces on 8000 Series appliances do not support half-duplex options. When links auto negotiate speed, all active links are selected for the LAG based on the same speed setting.

**Step 9** From the **MDI/MDIX** drop-down list, choose an option to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX.
MDI/MDIX settings are available only for copper interfaces.

By default, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.

Step 10
Enter a maximum transmission unit (MTU) in the MTU field.

The range within which you can set the MTU can vary depending on the Firepower System device model and interface type. See MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388 for more information.

Step 11
Under Link Aggregation, choose one or more physical interfaces from Available Interfaces to add to the LAG bundle.

Tip To remove physical interfaces from the LAG bundle, choose one or more physical interfaces and click the remove selected icon. To remove all physical interfaces from the LAG bundle, click the remove all icon. Deleting the LAG interface from the Interfaces tab also removes the interfaces.

Step 12
Choose an option from the Load-Balancing Algorithm drop-down list.

Step 13
Choose a Link Selection Policy from the drop-down list.

Tip Choose LACP Priority if you are configuring an aggregate interface between a Firepower System device and a third-party network device.

Step 14
If you chose LACP Priority as the Link Selection Policy, assign a value for System Priority and click the Configure Interface Priority link to assign a priority value for each interface in the LAG.

Step 15
Choose either Inner or Outer from the Tunnel Level drop-down list.

Note The tunnel level only applies to IPv4 traffic when Layer 3 load balancing is configured. The outer tunnel is always used for Layer 2 and IPv6 traffic. If the Tunnel Level is not explicitly set, the default is Outer.

Step 16
Under LACP, check the Enabled check box to allow the switched LAG interface to handle traffic using the Link Aggregation Control Protocol.

If you clear the check box, the LAG interface becomes a static configuration and the Firepower System will use all of the physical interfaces selected for the aggregation.

Step 17
Click a Rate radio button to set the frequency that determines how often LACP control messages are received from the partner device:

- Click Slow to receive packets every 30 seconds.
- Click Fast to receive packets every 1 second.

Step 18
Click a Mode radio button to establish the listening mode of the device:

- Click Active to initiate negotiations with remote links by sending LACP packets to the partner device.
- Click Passive to respond to LACP packets received.

Step 19
Click Save.
What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
Snort® Restart Scenarios, on page 279

Adding Aggregate Routed Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can combine between two and eight physical ports on a managed device to create a routed LAG interface. You must assign a routed LAG interface to a virtual router before it can route traffic. A managed device can support up to 14 LAG interfaces.

Caution

Adding a routed interface pair on 7000 or 8000 Series devices restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Procedure

Step 1  Choose Devices > Device Management.

Step 2  Click the edit icon ( ) next to the device where you want to configure the routed LAG interface.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3  Choose Add Aggregate Interface from the Add drop-down menu.

Step 4  Click Routed to display the routed LAG interface options.

Step 5  If you want to apply a security zone, do one of the following:
• Choose an existing security zone from the Security Zone drop-down list.
• Choose New to add a new security zone; see Creating Security Zone Objects, on page 332.

Step 6  Specify a virtual router:
• Choose an existing virtual router from the Virtual Router drop-down list.
• Choose New to add a new virtual router; Adding Virtual Routers, on page 560.

Step 7  Check the Enabled check box to allow the routed LAG interface to handle traffic.
If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.
Step 8  From the **Mode** drop-down list, choose an option to designate the link mode, or choose **Autonegotiation** to specify that the LAG interface is configured to auto negotiate speed and duplex settings.

Mode settings are available only for copper interfaces.

Interfaces on 8000 Series appliances do not support half-duplex options. When links auto negotiate speed, all active links are selected for the LAG based on the same speed setting.

Step 9  Choose an option from the **MDI/MDIX** drop-down list to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIx.

MDI/MDIX settings are available only for copper interfaces.

By default, MDI/MDIX is set to Auto-MDIx, which automatically handles switching between MDI and MDIX to attain link.

Step 10  Enter a maximum transmission unit (MTU) in the **MTU** field.

The range of MTU values can vary depending on the model of the managed device and the interface type.

**Caution**  Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

Step 11  If you want to allow the LAG interface to respond to ICMP traffic such as pings and traceroute, check the **Enable Responses** check box next to **ICMP**.

Step 12  If you want to enable the LAG interface to broadcast router advertisements, check the **Enable Router Advertisement** check box next to **IPv6 NDP**.

Step 13  Click **Add** to add an IP address.

Step 14  In the **Address** field, enter the routed LAG interface’s IP address and subnet mask using CIDR notation.

Note the following:

- You cannot add network and broadcast addresses, or the static MAC addresses 00:00:00:00:00:00 and FF:FF:FF:FF:FF:FF.

- You cannot add identical IP addresses, regardless of subnet mask, to interfaces in virtual routers.

Step 15  If your organization uses IPv6 addresses and you want to set the IP address of the LAG interface automatically, check the **Address Autoconfiguration** check box next to the **IPv6** field.

Step 16  For **Type**, choose either Normal or SFRP.

Step 17  If you chose SFRP for **Type**, set options as described in SFRP.

Step 18  Click **OK**.

**Note**  When adding an IP address to a routed interface of a 7000 or 8000 Series device in a high-availability pair, you must add a corresponding IP address to the routed interface on the high-availability peer.

Step 19  Click **Add** to add a static ARP entry.

Step 20  Enter an IP address in the **IP Address** field.

Step 21  Enter a MAC address to associate with the IP address in the **MAC Address** field. Use the standard format (for example, 01:23:45:67:89:AB).
Step 22  Click OK.

Step 23  Under Link Aggregation, choose one or more physical interfaces from Available Interfaces to add to the LAG bundle.

Tip  To remove physical interfaces from the LAG bundle, choose one or more physical interfaces and click the remove selected icon ( ). To remove all physical interfaces from the LAG bundle, click the remove all icon ( ). Deleting the LAG interface from the Interfaces tab also removes the interfaces.

Step 24  Choose a Load-Balancing Algorithm from the drop-down list.

Step 25  Choose a Link Selection Policy from the drop-down list.

Tip  Choose LACP Priority if you are configuring an aggregate interface between a Firepower System device and a third-party network device.

Step 26  If you chose LACP Priority as the Link Selection Policy, assign a value for System Priority and click the Configure Interface Priority link to assign a priority value for each interface in the LAG.

Step 27  Choose either Inner or Outer from the Tunnel Level drop-down list.

Note  The tunnel level only applies to IPv4 traffic when Layer 3 load balancing is configured. The outer tunnel is always used for Layer 2 and IPv6 traffic. If the Tunnel Level is not explicitly set, the default is Outer.

Step 28  Under LACP, check the Enabled check box to allow the routed LAG interface to handle traffic using the Link Aggregation Control Protocol.

If you clear the check box, the LAG interface becomes a static configuration and the Firepower System will use all of the physical interfaces for the aggregation.

Step 29  Click a Rate radio button to set the frequency that determines how often LACP control messages are received from the partner device.

• Click Slow to receive packets every 30 seconds.
• Click Fast to receive packets every 1 second.

Step 30  Click a Mode radio button to establish the listening mode of the device.

• Click Active to initiate negotiations with remote links by sending LACP packets to the partner device.
• Click Passive to respond to LACP packets received.

Step 31  Click Save.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

  Advanced Device Settings, on page 183
Adding Logical Aggregate Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

For each switched or routed aggregate interface, you can add multiple logical interfaces. You must associate each logical LAG interface with a VLAN tag to handle traffic received by the LAG interface with that specific tag. You add logical interfaces to switched or routed aggregate interfaces in the same way you would add them to physical switched or routed interfaces.

**Note**

When you create a LAG interface you also create an “untagged” logical interface by default, which is identified by the \( \text{lagn.0} \) label, where \( n \) is an integer from 0 to 13. To be operational, each LAG requires this one logical interface at a minimum. You can associate additional logical interfaces with any LAG to handle VLAN-tagged traffic. Each additional logical interface requires a unique VLAN tag. The Firepower System supports VLAN tags in the range of 1 through 4094.

**Caution**

Adding a routed interface pair on 7000 or 8000 Series devices restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

**Procedure**

**Step 1**  Choose Devices > Device Management.

**Step 2**  Next to the device where you want to add the logical LAG interface, click the edit icon (✏️).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3**  From the Add drop-down menu, choose Add Logical Interface.

**Step 4**  Click Switched to display the switched interface options, or click Routed to display the routed interface options.

**Step 5**  Choose an available LAG from the Interface drop-down list. The aggregate interface is identified by the \( \text{lagn} \) label, where \( n \) is an integer from 0 to 13.

**Step 6**  Configure the remaining settings appropriate to the interface type you chose:

- **Switched** — See Adding Logical Switched Interfaces, on page 544 for more information on adding a logical interface to a switched interface.
- **Routed** — See Adding Logical Routed Interfaces, on page 555 for more information on adding a logical interface to a routed interface.
Viewing Aggregate Interface Statistics

You can view protocol and traffic statistics for each aggregate interface. The statistics show LACP protocol information such as LACP key and partner information, packets received, packets transmitter, and packets dropped. Statistics are further refined per member interface to show traffic and link information on a per-port basis.

Aggregate interface information is also presented to the dashboard via predefined dashboard widgets. The Current Interface Status widget shows the status of all interfaces on the appliance, enabled or unused. The Interface Traffic widget shows the rate of traffic received (Rx) and transmitted (Tx) on the appliance’s interfaces over the dashboard time range. See Predefined Dashboard Widgets, on page 200.

Procedure

Step 1 Choose Devices > Device Management.

Step 2 Next to the device where you want to view the logical aggregate interface statistics, click the edit icon ( ).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3 Next to the interface where you want to view the interface statistics, click the view icon ( ).

Deleting Aggregate Interfaces

The aggregate interface can be identified by the lag$n$ label, where $n$ can be an integer from 0 to 13.

Procedure

Step 1 Choose Devices > Device Management.
Deleting Aggregate Interfaces

Step 2  Next to the device where you want to delete the aggregate interface, click the edit icon (ручка).
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3  Next to the aggregate interface you want to delete, click the delete icon (удалить).

Step 4  When prompted, confirm that you want to delete the aggregate interface.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.
CHAPTER 31

Hybrid Interfaces

The following topics describe how to configure local hybrid interfaces:

• About Hybrid Interfaces, on page 597
• Logical Hybrid Interfaces, on page 597
• Adding Logical Hybrid Interfaces, on page 598
• Deleting Logical Hybrid Interfaces, on page 600

About Hybrid Interfaces

You can configure logical hybrid interfaces on managed devices that allow the Firepower System to bridge traffic between virtual routers and virtual switches. If IP traffic received on interfaces in a virtual switch is addressed to the MAC address of an associated hybrid logical interface, the system handles it as Layer 3 traffic and either routes or responds to the traffic depending on the destination IP address. If the system receives any other traffic, it handles it as Layer 2 traffic and switches it appropriately. You cannot configure logical hybrid interfaces on an NGIPSv device.

Note that hybrid interfaces that are not associated with both a virtual switch and a virtual router are not available for routing, and do not generate or respond to traffic.

Logical Hybrid Interfaces

You must associate a logical hybrid interface with a virtual router and virtual switch to bridge traffic between Layer 2 and Layer 3. You can only associate a single hybrid interface with a virtual switch. However, you can associate multiple hybrid interfaces with a virtual router.

You can also configure the Cisco Redundancy Protocol (SFRP) on a logical hybrid interface. SFRP allows devices to act as redundant gateways for specified IP addresses.

Note that disabling the ICMP Enable Responses option for hybrid interfaces does not prevent ICMP responses in all scenarios. You can add network-based rules to an access control policy to drop packets where the destination IP is the hybrid interface’s IP and the protocol is ICMP.

If you have enabled the Inspect Local Router Traffic option on the managed device, it drops the packets before they reach the host, thereby preventing any response.

The range of MTU values can vary depending on the model of the managed device and the interface type.
Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

Related Topics
- Configuring SFRP, on page 558
- Advanced Device Settings, on page 183
- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
- Snort® Restart Scenarios, on page 279

Adding Logical Hybrid Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
</tbody>
</table>

Adding a routed interface pair on 7000 or 8000 Series devices restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Procedure

Step 1
Choose Devices > Device Management.

Step 2
Next to the device where you want to add the hybrid interface, click the edit icon (）。

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 3
From the Add drop-down menu, choose Add Logical Interface.

Step 4
Click Hybrid to display the hybrid interface options.

Step 5
In the Name field, enter a name for the interface.

Step 6
From the Virtual Router drop-down list, choose an existing virtual router, choose None, or choose New to add a new virtual router.

Note
If you add a new virtual router, you must configure it on the Device Management page after you finish setting up the hybrid interface. See Adding Virtual Routers, on page 560.

Step 7
From the Virtual Switch drop-down list, choose an existing virtual switch, choose None, or choose New to add a new virtual switch.
If you add a new virtual switch, you must configure it on the Device Management page after you finish setting up the hybrid interface. See Adding Virtual Switches, on page 547.

**Note** If you clear the check box, the interface becomes disabled and administratively taken down.

**Step 8** Check the **Enabled** check box to allow the hybrid interface to handle traffic.

**Note** If you clear the check box, the interface becomes disabled and administratively taken down.

**Step 9** In the **MTU** field, enter a maximum transmission unit (MTU), which designates the largest size packet allowed. The range of MTU values can vary depending on the model of the managed device and the interface type.

**Caution** Changing the highest MTU value among all non-management interfaces on the device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Inspection is interrupted on all non-management interfaces, not just the interface you modified. Whether this interruption drops traffic or passes it without further inspection depends on the model of the managed device and the interface type. See Snort® Restart Traffic Behavior, on page 280 for more information.

**Step 10** Next to **ICMP**, check the **Enable Responses** check box to allow the interface to respond to ICMP traffic such as pings and traceroute.

**Step 11** Next to **IPv6 NDP**, check the **Enable Router Advertisement** check box to enable the interface to broadcast router advertisements. You can only enable this option if you added IPv6 addresses.

**Step 12** To add an IP address, click **Add**.

**Step 13** In the **Address** field, enter the IP address and subnet mask. Note the following:

- You cannot add network and broadcast addresses, or the static MAC addresses 00:00:00:00:00:00 and FF:FF:FF:FF:FF:FF.
- You cannot add identical IP addresses, regardless of subnet mask, to interfaces in virtual routers.

**Step 14** Optionally if you have IPv6 addresses, next to the **IPv6** field, check the **Address Autoconfiguration** check box to set the IP address of the interface automatically.

**Step 15** For **Type**, choose either Normal or SFRP.

**Step 16** If you chose SFRP for **Type**, set options as described in SFRP.

**Step 17** Click **OK**.

**Step 18** Click **Save**.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

- MTU Ranges for 7000 and 8000 Series Devices and NGIPSv, on page 388
- Snort® Restart Scenarios, on page 279
Deleting Logical Hybrid Interfaces

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>7000 &amp; 8000 Series</td>
<td>Leaf only</td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Choose Devices > Device Management.

**Step 2** Next to the device where you want to delete the logical hybrid interface, click the edit icon ( ).

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 3** Next to the logical hybrid interface you want to delete, click the delete icon ( ).

**Step 4** When prompted, confirm that you want to delete the interface.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Gateway VPNs

The following topics describe how to manage your VPN deployment:

- Gateway VPN Basics, on page 601
- VPN Deployments, on page 602
- VPN Deployment Management, on page 604
- VPN Deployment Status, on page 615
- VPN Statistics and Logs, on page 616

Gateway VPN Basics

A virtual private network (VPN) is a network connection that establishes a secure tunnel between endpoints via a public source, such as the internet or other network. You can configure the Firepower System to build secure VPN tunnels between the virtual routers of Firepower managed devices. The system builds tunnels using the Internet Protocol Security (IPsec) protocol suite.

After the VPN connection is established, the hosts behind the local gateway can connect to the hosts behind the remote gateway through the secure VPN tunnel. A connection consists of the IP addresses and host names of the two gateways, the subnets behind them, and the shared secrets for the two gateways to authenticate to each other.

The VPN endpoints authenticate to each other with either the Internet Key Exchange (IKE) version 1 or version 2 protocol to create a security association for the tunnel. The system uses either the IPsec authentication header (AH) protocol or the IPsec encapsulating security payload (ESP) protocol to authenticate the data entering the tunnel. The ESP protocol encrypts the data as well as providing the same functionality as AH.

If you have access control policies in your deployment, the system does not send VPN traffic until it has passed through access control. In addition, the system does not send tunnel traffic to the public source when the tunnel is down.

To configure and deploy VPN for Firepower, you must have a VPN license enabled on each of your target managed devices. Additionally, VPN features are only available on 7000 and 8000 Series devices.

IPsec

The IPsec protocol suite defines how IP packets across a VPN tunnel are hashed, encrypted, and encapsulated in the ESP or AH security protocol. The Firepower System uses the hash algorithm and encryption key of the Security Association (SA), which becomes established between the two gateways by the Internet Key Exchange (IKE) protocol.
Security associations (SA) establish shared security attributes between two devices and allow VPN endpoints to support secure communication. An SA allows two VPN endpoints to handle the parameters for how the VPN tunnel is secured between them.

The system uses the Internet Security Association and Key Management Protocol (ISAKMP) during the initial phase of negotiating the IPsec connection to establish the VPN between endpoints and the authenticated key exchange. The IKE protocol resides within ISAKMP.

The AH security protocol provides protection for packet headers and data, but it cannot encrypt them. ESP provides encryption and protection for packets, but it cannot secure the outermost IP header. In many cases, this protection is not required, and most VPN deployments use ESP more frequently than AH because of its encryption capabilities. Since VPN only operates in tunnel mode, the system encrypts and authenticates the entire packet from Layer 3 and up in the ESP protocol. ESP in tunnel mode encrypts the data as well as providing the latter’s encryption capabilities.

IKE

The Firepower System uses the IKE protocol to mutually authenticate the two gateways against each other as well as to negotiate the SA for the tunnel. The process consists of two phases.

IKE phase 1 establishes a secure authenticated communication channel by using the Diffie-Hellman key exchange to generate a pre-shared key to encrypt further IKE communications. This negotiation results in a bidirectional ISAKMP security association. The system allows you to perform the authentication using a pre-shared key. Phase 1 operates in main mode, which seeks to protect all data during the negotiation, while also protecting the identity of the peers.

During IKE phase 2, the IKE peers use the secure channel established in phase 1 to negotiate security associations on behalf of IPsec. The negotiation results in a minimum of two unidirectional security associations, one inbound and one outbound.

VPN Deployments

A VPN deployment specifies the endpoints and networks that are included in a VPN and how they connect to each other. After you configure a VPN deployment on the Firepower Management Center, you can then deploy it to your managed devices or devices managed by another Firepower Management Center.

The system supports three types of VPN deployments: point-to-point, star, and mesh.

Point-to-Point VPN Deployments

In a point-to-point VPN deployment, two endpoints communicate directly with each other. You configure the two endpoints as peer devices, and either device can start the secured connection. Each of the devices in this configuration must be a VPN-enabled managed device.

The following diagram displays a typical point-to-point VPN deployment.
Star VPN Deployments

In a star VPN deployment, a central endpoint (hub node) establishes a secure connection with multiple remote endpoints (leaf nodes). Each connection between the hub node and an individual leaf node is a separate VPN tunnel. The hosts behind any of the leaf nodes can communicate with each other through the hub node.

Star deployments commonly represent a VPN that connects an organization’s main and branch office locations using secure connections over the Internet or other third-party network. Star VPN deployments provide all employees with controlled access to the organization’s network.

In a typical star deployment, the hub node is located at the main office. Leaf nodes are located at branch offices and start most of the traffic. Each of the nodes must be a VPN-enabled managed device.

Star deployments only support IKE version 2.

The following diagram displays a typical star VPN deployment.
Mesh VPN Deployments

In a mesh VPN deployment, all endpoints can communicate with every other endpoint by an individual VPN tunnel. The mesh deployment offers redundancy so that when one endpoint fails, the remaining endpoints can still communicate with each other. This type of deployment commonly represents a VPN that connects a group of decentralized branch office locations. The number of VPN-enabled managed devices you deploy in this configuration depends on the level of redundancy you require. Each of the endpoints must be a VPN-enabled managed device.

The following diagram displays a typical mesh VPN deployment.

VPN Deployment Management

On the VPN page (Devices > VPN), you can view all of your current VPN deployments by name and the endpoints contained in the deployment. Options on this page allow you to view the status of a VPN deployment, create a new deployment, deploy to managed devices, and edit or delete a deployment.

Note that when you register a device to a Firepower Management Center, deployed VPN deployments sync to the Firepower Management Center during registration.

Related Topics

Managing VPN Deployments, on page 610
VPN Deployment Options

When you create a new VPN deployment you must, at minimum, give it a unique name, specify a deployment type, and designate a preshared key. You can select from three types of deployment, each containing a group of VPN tunnels:

- Point-to-point (PTP) deployments establish a VPN tunnel between two endpoints.
- Star deployments establish a group of VPN tunnels connecting a hub endpoint to a group of leaf endpoints.
- Mesh deployments establish a group of VPN tunnels among a set of endpoints.

Only Cisco managed devices can be used as endpoints in VPN deployments. Third-party endpoints are not supported.

You must define a pre-shared key for VPN authentication. You can specify a default key to use in all of the VPN connections you generate in a deployment. For point-to-point deployments, you can specify a preshared key for each endpoint pair.

In a multidomain deployment, you can configure a VPN deployment across domains; that is, you can assign endpoints to devices that belong to different domains. In such cases, you can view but not modify the ancestor deployment in the related descendant domains. When you drill down for deployment details, the system displays information for devices that belong to the current domain only.

Point-to-Point VPN Deployment Options

When configuring a point-to-point VPN deployment, you define a group of endpoint pairs and then create a VPN between the two nodes in each pair.

The following list describes the options you can specify in your deployment.

**Name**
Specify a unique name for the deployment.

**Type**
Click PTP to specify that you are configuring a point-to-point deployment.

**Pre-shared Key**
Define a unique pre-shared key for authentication. The system uses this key for all the VPNs in your deployment, unless you specify a pre-shared key for each endpoint pair.

**Device**
You can choose a managed device, including a device stack or device high-availability pair, as an endpoint for your deployment. For Cisco-managed devices not managed by the Firepower Management Center you are using, choose Other and then specify an IP address for the endpoint.

**Virtual Router**
If you chose a managed device as your endpoint, choose a virtual router that is currently applied to the selected device. You cannot choose the same virtual router for more than one endpoint.

**Interface**
If you chose a managed device as your endpoint, choose a routed interface that is assigned to the virtual router you specified.
IP Address

- If you chose a managed device as an endpoint, choose an IP address that is assigned to the specified routed interface.
- If the managed device is a device high-availability pair, you can choose only from a list of SFRP IP addresses.
- If you choose a managed device not managed by the Firepower Management Center, specify an IP address for the endpoint.

Protected Networks

Specify the networks in your deployment that are encrypted. Enter a subnet with CIDR block for each network. IKE version 1 only supports a single protected network.

Note that VPN endpoints cannot have the same IP address and that protected networks in a VPN endpoint pair cannot overlap. If a list of protected networks for an endpoint contains one or more IPv4 or IPv6 entry, the other endpoint's protected network must have at least one entry of the same type (i.e., IPv4 or IPv6). If it does not, then the other endpoint's IP address must be of the same type and must not overlap with the entries in the protected network. (Use /32 CIDR address blocks for IPv4 and /128 CIDR address blocks for IPv6). If both of these checks fail, the endpoint pair is invalid.

Internal IP

Check the check box if the endpoint resides behind a firewall with network address translation.

Public IP

If you checked the Internal IP check box, specify a public IP address for the firewall. If the endpoint is a responder, you must specify this value.

Public IKE Port

If you checked the Internal IP check box, specify a single numerical value from 1 to 65535 for the UDP port on the firewall that is being port-forwarded to the internal endpoint. If the endpoint is a responder and the port on the firewall being forwarded is not 500 or 4500, you must specify this value.

Use Deployment Key

Check the check box to use the pre-shared key defined for the deployment. Clear the check box to specify a pre-shared key for VPN authentication for this endpoint pair.

Pre-shared Key

If you cleared the Use Deployment Key check box, specify a pre-shared key in this field.

Related Topics

Configuring Point-to-Point VPN Deployments, on page 611

Star VPN Deployment Options

When configuring a star VPN deployment, you define a single hub node endpoint and a group of leaf node endpoints. You must define the hub node endpoint and at least one leaf node endpoint to configure the deployment.

The following list describes the options you can specify in your deployment.

Name

Specify a unique name for the deployment.
Type
Click **Star** to specify that you are configuring a star deployment.

Pre-shared Key
Define a unique pre-shared key for authentication.

Device
You can choose a managed device, including a device stack or device high-availability pair, as an endpoint for your deployment. For Cisco-managed devices not managed by the Firepower Management Center you are using, choose **Other** and then specify an IP address for the endpoint.

Virtual Router
If you chose a managed device as your endpoint, choose a virtual router that is currently applied to the selected device. You cannot choose the same virtual router for more than one endpoint.

Interface
If you chose a managed device as your endpoint, choose a routed interface that is assigned to the selected virtual router.

IP Address
- If you chose a managed device as an endpoint, choose an IP address that is assigned to the specified routed interface.
- If the managed device is a device high-availability pair, you can choose only from a list of SFRP IP addresses.
- If you chose a managed device **not** managed by the Firepower Management Center, specify an IP address for the endpoint.

Protected Networks
Specify the networks in your deployment that are encrypted. Enter a subnet with CIDR block for each network.

Note that VPN endpoints cannot have the same IP address and that protected networks in a VPN endpoint pair cannot overlap. If a list of protected networks for an endpoint contains one or more IPv4 or IPv6 entry, the other endpoint's protected network must have at least one entry of the same type (i.e., IPv4 or IPv6). If it does not, then the other endpoint's IP address must be of the same type and must not overlap with the entries in the protected network. (Use /32 CIDR address blocks for IPv4 and /128 CIDR address blocks for IPv6). If both of these checks fail, the endpoint pair is invalid.

Internal IP
Check the check box if the endpoint resides behind a firewall with network address translation.

Public IP
If you checked the **Internal IP** check box, specify a public IP address for the firewall. If the endpoint is a responder, you must specify this value.

Public IKE Port
If you checked the **Internal IP** check box, specify a single numerical value from 1 to 65535 for the UDP port on the firewall that is being port-forwarded to the internal endpoint. If the endpoint is a responder and the port on the firewall being forwarded is not 500 or 4500, you must specify this value.
Mesh VPN Deployment Options

When configuring a mesh VPN deployment, you define a group of VPNs to link any two points for a given set of endpoints.

The following list describes the options you can specify in your deployment.

**Name**
Specify a unique name for the deployment.

**Type**
Click **Mesh** to specify that you are configuring a mesh deployment.

**Pre-shared Key**
Define a unique pre-shared key for authentication.

**Device**
You can choose a managed device, including a device stack or device high-availability pair, as an endpoint for your deployment. For Cisco-managed devices not managed by the Firepower Management Center you are using, choose **Other** and then specify an IP address for the endpoint.

**Virtual Router**
If you chose a managed device as your endpoint, choose a virtual router that is currently applied to the specified device. You cannot choose the same virtual router for more than one endpoint.

**Interface**
If you chose a managed device as your endpoint, choose a routed interface that is assigned to the specified virtual router.

**IP Address**
- If you chose a managed device as an endpoint, choose an IP address that is assigned to the selected routed interface.
- If the managed device is a device high-availability pair, you can choose only from a list of SFRP IP addresses.
- If you chose a managed device **not** managed by the Firepower Management Center, specify an IP address for the endpoint.

**Protected Networks**
Specify the networks in your deployment that are encrypted. Enter a subnet with CIDR block for each network. IKE version 1 only supports a single protected network.

Note that VPN endpoints cannot have the same IP address and that protected networks in a VPN endpoint pair cannot overlap. If a list of protected networks for an endpoint contains one or more IPv4 or IPv6 entry, the other endpoint's protected network must have at least one entry of the same type (i.e., IPv4 or IPv6). If it does not, then the other endpoint's IP address must be of the same type and must not overlap with the entries in the protected network. (Use /32 CIDR address blocks for IPv4 and /128 CIDR address blocks for IPv6). If both of these checks fail, the endpoint pair is invalid.
Internal IP

Check the check box if the endpoint resides behind a firewall with network address translation.

Public IP

If you checked the Internal IP check box, specify a public IP address for the firewall. If the endpoint is a responder, you must specify this value.

Public IKE Port

If you checked the Internal IP check box, specify a single numerical value from 1 to 65535 for the UDP port on the firewall that is being port-forwarded to the internal endpoint. If the endpoint is a responder and the port on the firewall being forwarded is not 500 or 4500, you must specify this value.

Related Topics

Configuring Mesh VPN Deployments, on page 612

Advanced VPN Deployment Options

VPN deployments contain some common settings that can be shared among the VPNs in a deployment. Each VPN can use the default settings or you can override the default settings. Advanced settings typically require little or no modification and are not common to every deployment.

The following list describes the advanced options you can specify in your deployment.

Other Algorithm Allowed

Check the check box to enable auto negotiation to an algorithm not listed in the Algorithm list, but proposed by the remote peer.

Algorithm

Specify the phase one and phase two algorithm proposals to secure data in your deployment. Choose Cipher, Hash, and Diffie-Hellman (DH) group authentication messages for both phases.

IKE Life Time

Specify a numerical value and choose a time unit for the maximum IKE SA renegotiation interval. You can specify a minimum of 15 minutes and a maximum of 30 days.

IKE v2

Check the check box to specify that the system uses IKE version 2. This version supports the star deployment and multiple protected networks.

Life Time

Specify a numerical value and select a time unit for the maximum SA renegotiation interval. You can specify a minimum of 5 minutes and a maximum of 24 hours.

Life Packets

Specify the number of packets that can be transmitted over an IPsec SA before it expires. You can use any integer between 0 and 18446744073709551615.

Life Bytes

Specify the number of bytes that can be transmitted over an IPsec SA before it expires. You can use any integer between 0 and 18446744073709551615.
AH

Check the check box to specify that the system uses the authentication header security protocol for the data to be protected. Clear the check box to use encryption service payload (ESP) protocol.

Related Topics

Configuring Advanced VPN Deployment Settings, on page 613

Managing VPN Deployments

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>VPN</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Caution

Adding or removing a VPN on a 7000 or 8000 Series device restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Procedure

Step 1
Choose Devices > VPN.

Step 2
Manage your VPN deployments:

- Add — To create a new VPN deployment, click Add VPN > Firepower Device, and continue as follows depending on deployment type:
  - Configuring Mesh VPN Deployments, on page 612
  - Configuring Point-to-Point VPN Deployments, on page 611
  - Configuring Star VPN Deployments, on page 611

- Edit — To modify the settings in an existing VPN deployment, click the edit icon (🪏); see Editing VPN Deployments, on page 614.

- Delete — To delete a VPN deployment, click the delete icon (🗑).

- Deploy—Click Deploy; see Deploy Configuration Changes, on page 277.

- View VPN status — To view the status of an existing VPN deployment, click the status icon; see Viewing VPN Status, on page 615.

Related Topics

Snort® Restart Scenarios, on page 279
Configuring Point-to-Point VPN Deployments

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>VPN</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Before you begin

If you are using managed devices as endpoints, create a virtual router and apply it to the appropriate device.

Note

You cannot use the same virtual router for more than one endpoint. For more information, see Setting Up Virtual Routers, on page 551

Procedure

Step 1 Choose Devices > VPN.
Step 2 Click Add VPN > Firepower Device.
Step 3 Enter a unique Name.
Step 4 Verify that PTP is chosen as the Type.
Step 5 Enter a unique Pre-shared Key.
Step 6 Next to Node Pairs, click the add icon ( ).
Step 7 Configure the VPN deployment options described in Point-to-Point VPN Deployment Options, on page 605.
Step 8 Under Node A, next to Protected Networks, click the add icon ( ).
Step 9 Enter a CIDR block for the protected network.
Step 10 Click OK.
Step 11 Repeat step 8 through step 10 for Node B.
Step 12 Click Save.
The endpoint pair is added to your deployment.
Step 13 Click Save to finish configuring your deployment.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Configuring Star VPN Deployments

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>VPN</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>
Before you begin

If you are using managed devices as endpoints, create a virtual router and apply it to the appropriate device.

Note

You cannot use the same virtual router for more than one endpoint. For more information, see Setting Up Virtual Routers, on page 551

Procedure

Step 1 Choose Devices > VPN.
Step 2 Click Add VPN > Firepower Device.
Step 3 Enter a unique Name.
Step 4 Click Star to specify the Type.
Step 5 Enter a unique Pre-shared Key.
Step 6 Next to Hub Node, click the edit icon ( ).
Step 7 Configure the VPN deployment options described in Star VPN Deployment Options, on page 606.
Step 8 Next to Protected Networks, click the add icon ( ).
Step 9 Enter an IP address for the protected network.
Step 10 Click OK.
Step 11 Click Save. The hub node is added to your deployment.
Step 12 Next to Leaf Nodes, click the add icon ( ).
Step 13 Repeat step 7 through step 10 to complete the leaf node, which has the same options as the hub node.
Step 14 Click Save.
The leaf node is added to your deployment.
Step 15 Click Save to finish configuring your deployment.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Configuring Mesh VPN Deployments

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>VPN</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Before you begin

If you are using managed devices as endpoints, create a virtual router and apply it to the appropriate device.
You cannot use the same virtual router for more than one endpoint. For more information, see Setting Up Virtual Routers, on page 551

**Procedure**

1. Choose Devices > VPN.
2. Click Add VPN > Firepower Device.
3. Enter a unique Name.
4. Click Mesh to specify the Type.
5. Enter a unique Pre-shared Key.
6. Next to Nodes, click the add icon ( ).
7. Configure the VPN deployment options described in Mesh VPN Deployment Options, on page 608.
8. Next to Protected Networks, click the add icon ( ).
9. Enter a CIDR block for the protected network.
10. Click OK. The protected network is added.
11. Click Save. The endpoint is added to your deployment.
12. Repeat step 6 through step 11 to add more endpoints.
13. Click Save to complete your deployment.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

### Configuring Advanced VPN Deployment Settings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>VPN</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays VPN deployments created in the current domain, which you can edit. It also displays VPN deployments created in ancestor domains if one of the endpoint devices belongs to your domain. You cannot edit VPN deployments created in ancestor domains. To view and edit VPN deployments created in a lower domain, switch to that domain.

**Procedure**

1. Choose Devices > VPN.
Step 2
Click the edit icon ( MODIFY )

If a view icon ( VIEW ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3
Click the Advanced tab.

Step 4
Configure the advanced settings, as described in Advanced VPN Deployment Options, on page 609.

Step 5
Next to Algorithms, click the add icon ( ADD )

Step 6
Chose Cipher, Hash, and Diffie-Hellman (DH) group authentication messages for both phases.

Step 7
Click OK.

Step 8
Click Save.

What to do next
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Editing VPN Deployments

Caution
Two users should not edit the same deployment simultaneously; however, note that the web interface does not prevent simultaneous editing.

In a multidomain deployment, the system displays VPN deployments created in the current domain, which you can edit. It also displays VPN deployments created in ancestor domains if one of the endpoint devices belongs to your domain. You cannot edit VPN deployments created in ancestor domains. To view and edit VPN deployments created in a lower domain, switch to that domain.

Procedure

Step 1
Choose Devices > VPN.

Step 2
Click the edit icon ( MODIFY )

If a view icon ( VIEW ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3
Modify the desired settings:

• Advanced settings; see Configuring Advanced VPN Deployment Settings, on page 613.
• Mesh deployment settings; see Configuring Mesh VPN Deployments, on page 612.
• Point-to-point deployment settings; see Configuring Point-to-Point VPN Deployments, on page 611.
• Star deployment settings; see Configuring Star VPN Deployments, on page 611.
You cannot edit the deployment type after you initially save the deployment. To change the deployment type, you must delete the deployment and create a new one.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

VPN Deployment Status

After you configure a VPN deployment, you can view the status of your configured VPN tunnels. The VPN page displays a status icon for each VPN deployment once it has been deployed:

- The (✅) icon designates that all VPN endpoints are up.
- The (⚠️) icon designates that all VPN endpoints are down.
- The (⚠️) icon designates that some endpoints are up, while others are down.

You can click a status icon to view the deployment status along with basic information about the endpoints in the deployment, such as endpoint name and IP address. The VPN status updates every minute or when a status change occurs, such as an endpoint going down or coming up.

Related Topics

Viewing VPN Status, on page 615

Viewing VPN Status

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>VPN</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays VPN deployments created in the current domain. It also displays VPN deployments created in ancestor domains if one of the endpoint devices belongs to your domain. To view VPN deployments created in a lower domain, switch to that domain.

Procedure

Step 1 Choose Devices > VPN.
Step 2 Click the VPN status icon next to the deployment where you want to view the status.
Step 3 Click OK.
VPN Statistics and Logs

After you configure a VPN deployment, you can view statistics about the data traversing your configured VPN tunnels. In addition, you can view the latest VPN system and IKE logs for each endpoint.

The system displays the following statistics:

**Endpoint**
- The device path to the routed interface and IP address designated as the VPN endpoint.

**Status**
- Whether the VPN connection is up or down.

**Protocol**
- The protocol used for encryption, either ESP or AH.

**Packets Received**
- The number of packets per interface the VPN tunnel receives during an IPsec SA negotiation.

**Packets Forwarded**
- The number of packets per interface the VPN tunnel transmits during an IPsec SA negotiation.

**Bytes Received**
- The number of bytes per interface the VPN tunnel receives during an IPsec SA negotiation.

**Bytes Forwarded**
- The number of bytes per interface the VPN tunnel transmits during an IPsec SA negotiation.

**Time Created**
- The date and time the VPN connection was created.

**Time Last Used**
- The last time a user initiated a VPN connection.

**NAT Traversal**
- If "Yes" is displayed, at least one of the VPN endpoints resides behind a device with network address translation.

**IKE State**
- The state of the IKE SA: connecting, established, deleting, or destroying.

**IKE Event**
- The IKE SA event: reauthentication or rekeying.

**IKE Event Time**
- The time in seconds the next event should occur.

**IKE Algorithm**
- The IKE algorithm being used by the VPN deployment.
IPsec State

The state of the IPsec SA: installing, installed, updating, rekeying, deleting, and destroying.

IPsec Event

Notification of when the IPsec SA event is rekeying.

IPsec Event Time

The time in seconds until the next event should occur.

IPsec Algorithm

IPsec algorithm being used by the VPN deployment.

Related Topics

Viewing VPN Statistics and Logs, on page 617

---

### Viewing VPN Statistics and Logs

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>VPN</td>
<td>7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays VPN deployments created in the current domain. It also displays VPN deployments created in ancestor domains if one of the endpoint devices belongs to your domain. To view VPN deployments created in a lower domain, switch to that domain.

**Procedure**

1. **Step 1** Choose Devices > VPN.
2. **Step 2** Click the VPN status icon next to the deployment for which you want to view statistics.
3. **Step 3** Click the view statistics icon ( ).
4. **Step 4** Optionally, click Refresh to update the VPN statistics.
5. **Step 5** Optionally, click View Recent Log to view the latest data log for each endpoint. To view the log for 7000 or 8000 Series devices in high-availability pairs and stacked devices, you can click the link for either the active/primary or backup/secondary device.
PART X

Access Control

• Getting Started with Access Control Policies, on page 621
• Access Control Rules, on page 639
• Access Control Using Intrusion and File Policies, on page 653
• URL Filtering, on page 661
• HTTP Response Pages and Interactive Blocking, on page 671
• Security Intelligence Blacklisting, on page 675
• DNS Policies, on page 683
• Intelligent Application Bypass, on page 695
### Introduction to Access Control

Access control is a hierarchical policy-based feature that allows you to specify, inspect, and log (non-fast-patched) network traffic. Especially useful in multidomain deployments, you can nest access control policies, where each policy inherits the rules and settings from an ancestor (or base) policy. You can enforce this inheritance, or allow lower-level policies to override their ancestors. Each managed device can be targeted by one access control policy.

The data that the policy’s target devices collect about your network traffic can be used to filter and control that traffic based on:

- simple, easily determined transport and network layer characteristics: source and destination, port, protocol, and so on
- the latest contextual information on the traffic, including characteristics such as reputation, risk, business relevance, application used, or URL visited
- realm, user, user group, or ISE attribute
- characteristics of encrypted traffic; you can also decrypt this traffic for further analysis
- whether unencrypted or decrypted traffic contains a prohibited file, detected malware, or intrusion attempt

Each type of traffic inspection and control occurs where it makes the most sense for maximum flexibility and performance. For example, reputation-based blacklisting uses simple source and destination data, so it can block prohibited traffic early in the process. In contrast, detecting and blocking intrusions and exploits is a last-line defense.
Although you can configure the system without licensing your deployment, many features require that you enable the appropriate licenses before you deploy. Also, some features are only available on certain device models. Warning icons and confirmation dialog boxes designate unsupported features.

For the system to affect traffic, you must deploy relevant configurations to managed devices using routed, switched, or transparent interfaces, or inline interface pairs. Sometimes, the system prevents you from deploying inline configurations to passively deployed devices, including inline devices in tap mode. In other cases, the policy may deploy successfully, but attempting to block or alter traffic using passively deployed devices can have unexpected results. For example, the system may report multiple beginning-of-connection events for each blocked connection, because blocked connections are not blocked in passive deployments.

**Access Control Policy Components**

A newly created access control policy directs its target devices to handle all traffic using its *default action*.

In the following graphic, the default action uses the Balanced Security and Connectivity intrusion policy to inspect traffic before allowing it to its final destination.

The following list describes the configurations you can change after you create a simple policy.

**Note**

You can only edit access control policies that were created in the current domain. Also, you cannot edit settings that are locked by an ancestor access control policy.

**Name and Description**

Each access control policy must have a unique name. A description is optional.

**Inheritance Settings**

Policy inheritance allows you to create a hierarchy of access control policies. A parent (or base) policy defines and enforces default settings for its descendants, which is especially useful in multidomain deployments.
A policy’s inheritance settings allow you to select its base policy. You can also lock settings in the current policy to force any descendants to inherit them. Descendant policies can override unlocked settings.

**Policy Assignment**

Each access control policy identifies the devices that use it. Each device can be targeted by only one access control policy. In a multidomain deployment, you can require that all the devices in a domain use the same base policy.

**Rules**

Access control rules provide a granular method of handling network traffic. Rules in an access control policy are numbered, starting at 1, including rules inherited from ancestor policies. The system matches traffic to access control rules in top-down order by ascending rule number.

Usually, the system handles network traffic according to the *first* access control rule where *all* the rule’s conditions match the traffic. Conditions can be simple or complex, and their use often depends on certain licenses.

**Default Action**

The default action determines how the system handles and logs traffic that is not handled by any other access control configuration. The default action can block or trust all traffic without further inspection, or inspect traffic for intrusions and discovery data.

Although an access control policy can inherit its default action from an ancestor policy, you cannot enforce this inheritance.

**Security Intelligence**

Security Intelligence is a first line of defense against malicious internet content. This feature allows you to blacklist (block) connections based on the latest IP address, URL, and domain name reputation intelligence. To ensure continual access to vital resources, you can override blacklists with custom whitelists.

**HTTP Responses**

When the system blocks a user’s website request, you can either display a generic system-provided response page, or a custom page. You can also display a page that warns users, but also allows them to continue to the originally requested site.

**Advanced Access Control Options**

Advanced access control policy settings typically require little or no modification. Often, the default settings are appropriate. Advanced settings you can modify include traffic preprocessing, SSL inspection, identity, and various performance options.

**Related Topics**

Rule Management: Common Characteristics, on page 289

---

**Access Control Policy Default Action**

In a simple access control policy, the default action specifies how target devices handle all traffic. In a more complex policy, the default action handles traffic that:

- is not trusted by Intelligent Application Bypass
- is not blacklisted by Security Intelligence
• is not blocked by SSL inspection (encrypted traffic only)
• matches none of the rules in the policy (except Monitor rules, which match and log—but do not handle or inspect—traffic)

The access control policy default action can block or trust traffic without further inspection, or inspect traffic for intrusions and discovery data.

**Note**

You cannot perform file or malware inspection on traffic handled by the default action. Logging for connections handled by the default action is initially disabled, though you can enable it.

If you are using policy inheritance, the default action for the lowest-level descendant determines final traffic handling. Although an access control policy can inherit its default action from its base policy, you cannot enforce this inheritance.

The following table describes the types of inspection you can perform on traffic handled by each default action.

**Table 70: Access Control Policy Default Actions**

<table>
<thead>
<tr>
<th>Default Action</th>
<th>Effect on Traffic</th>
<th>Inspection Type and Policy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control: Block All Traffic</td>
<td>block without further inspection</td>
<td>none</td>
</tr>
<tr>
<td>Access Control: Trust All Traffic</td>
<td>trust (allow to its final destination without further inspection)</td>
<td>none</td>
</tr>
<tr>
<td>Intrusion Prevention</td>
<td>allow, as long as it is passed by the intrusion policy you specify</td>
<td>intrusion, using the specified intrusion policy and associated variable set, and discovery, using the network discovery policy</td>
</tr>
<tr>
<td>Network Discovery Only</td>
<td>allow</td>
<td>discovery only, using the network discovery policy</td>
</tr>
<tr>
<td>Inherit from base policy</td>
<td>defined in base policy</td>
<td>defined in base policy</td>
</tr>
</tbody>
</table>

The following diagram illustrates the table.

The following diagrams illustrate the **Block All Traffic** and **Trust All Traffic** default actions.
Access Control Policy Inheritance

Access control uses a hierarchical policy-based implementation that complements multitenancy. Just as you create a domain hierarchy, you can create a corresponding hierarchy of access control policies. A descendant, or child, access control policy inherits rules and settings from its direct parent, or base, policy. That base policy may have its own parent policy from which it inherits rules and settings, and so on.

An access control policy’s rules are nested between its parent policy’s Mandatory and Default rule sections. This implementation enforces Mandatory rules from ancestor policies, but allows the current policy to write rules that preempt Default rules from ancestor policies.

You can lock the following settings to enforce them in all descendant policies. Descendant policies can override unlocked settings.

- Security Intelligence — Blacklisting and whitelisting connections based on the latest IP address, URL, and domain name reputation intelligence.

The purpose of Network Discovery Only is to improve performance in a discovery-only deployment. Different configurations can disable discovery if you are only interested in intrusion detection and prevention.

Related Topics

Performance Considerations for Limited Deployments, on page 287
Logging Connections with a Policy Default Action, on page 1593

Access Control Policy Inheritance
• HTTP Response pages — Displaying a custom or system-provided response page when you block a user's website request.

• Advanced settings — Specifying associated subpolicies, network analysis settings, performance settings, and other general options.

Although an access control policy can inherit its default action from an ancestor policy, you cannot enforce this inheritance.

**Policy Inheritance and Multitenancy**

In a typical multidomain deployment, access control policy hierarchy corresponds to domain structure, and you apply the lowest-level access control policy to managed devices. This implementation allows selective access control enforcement at a higher domain level, while lower-level domain administrators can tailor deployment-specific settings. (You must use roles, not policy inheritance and enforcement alone, to restrict administrators in descendant domains.)

For example, as a Global domain administrator for your organization, you can create an access control policy at the Global level. You can then require that all your devices, which are divided into subdomain by function, use that Global-level policy as a base policy.

When subdomain administrators log into the Firepower Management Center to configure access control, they can deploy the Global-level policy as-is. Or, they can create and deploy a descendant access control policy within the boundaries of the Global-level policy.

**Note**

Although the most useful implementation of access control inheritance and enforcement complements multitenancy, you can create a hierarchy of access control policies within a single domain. You can also assign and deploy access control policies at any level.

**Related Topics**

- Managing Access Control Policy Inheritance, on page 630
- Security Intelligence Blacklisting, on page 675
- HTTP Response Pages and Interactive Blocking, on page 671
- Access Control Policy Advanced Settings, on page 634

---

### Managing Access Control Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Access Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Network Admin</td>
</tr>
</tbody>
</table>

The Firepower System allows you to edit system-provided access control policies and create custom access control policies. Depending on your devices' initial configurations, system-provided policies can include:

• Default Access Control—Blocks all traffic without further inspection.

• Default Intrusion Prevention—Allows all traffic, but also inspects with the Balanced Security and Connectivity intrusion policy and default intrusion variable set.
• Default Network Discovery—Allows all traffic while inspecting it for discovery data but not intrusions or exploits.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

**Procedure**

**Step 1**
Choose Policies > Access Control.

**Step 2**
Manage access control policies:

• Copy—Click the copy icon.
• Create—Click New Policy; see Creating a Basic Access Control Policy, on page 627.
• Delete—Click the delete icon.
• Deploy—Click Deploy; see Deploy Configuration Changes, on page 277.
• Edit—Click the edit icon; see Editing an Access Control Policy, on page 629
• Inheritance—Click the plus icon next to a policy with descendents to expand your view of the policy's hierarchy.
• Import/Export—Click Import/Export; see Configuration Import and Export, on page 145.
• Report—Click the report icon; see Generating Current Policy Reports, on page 286.

**Related Topics**
Out-of-Date Policies, on page 286

---

### Creating a Basic Access Control Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you create a new access control policy, you must, at minimum, choose a default action.

In most cases, logging of connections handled by a default action is initially disabled. An exception occurs if you create a subpolicy in a multidomain deployment. In that case, the system enables connection logging according to the logging configuration of the inherited default action.
Creating a Basic Access Control Policy

**Procedure**

**Step 1** Choose **Policies > Access Control**.

**Step 2** Click **New Policy**.

**Step 3** Enter a unique **Name** and, optionally, a **Description**.

**Step 4** Optionally, choose a base policy from the **Select Base Policy** drop-down list.

If an access control policy is enforced on your domain, this step is not optional. You must choose the enforced policy or one of its descendants as the base policy.

**Step 5** Specify the initial **Default Action**:

- If you chose a base policy, your new policy inherits its default action. You cannot change it here.
- **Block all traffic** creates a policy with the **Access Control: Block All Traffic** default action.
- **Intrusion Prevention** creates a policy with the **Intrusion Prevention: Balanced Security and Connectivity** default action, associated with the default intrusion variable set.
- **Network Discovery** creates a policy with the **Network Discovery Only** default action.

**Tip** If you want to trust all traffic by default, or if you chose a base policy and do not want to inherit the default action, you can change the default action later.

**Caution** Changing the total number of intrusion policies used by an access control policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information. You change the total number of intrusion policies by adding an intrusion policy that is not currently used, or by removing the last instance of an intrusion policy. You can use an intrusion policy in an access control rule, as the default action, or as the default intrusion policy.

**Step 6** Optionally, choose the **Available Devices** where you want to deploy the policy, then click **Add to Policy** (or drag and drop) to add the selected devices. To narrow the devices that appear, type a search string in the **Search** field.

If you want to deploy this policy immediately, you must perform this step.

**Step 7** Click **Save**.

**What to do next**

- Optionally, further configure the new policy as described in Editing an Access Control Policy, on page 629.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

- Access Control Policy Default Action, on page 623
- Setting Target Devices for an Access Control Policy, on page 634
Editing an Access Control Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Network Admin</td>
</tr>
</tbody>
</table>

Only one person should edit a policy at a time, using a single browser window. If multiple users save the same policy, the last saved changes are retained. For your convenience, the system displays information on who (if anyone) is currently editing each policy. To protect the privacy of your session, a warning appears after 30 minutes of inactivity on the policy editor. After 60 minutes, the system discards your changes.

**Procedure**

**Step 1**  Choose Policies > Access Control.

**Step 2**  Click the edit icon (edit) next to the access control policy you want to edit.

If a view icon (view) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3**  Edit your access control policy:

- **Name and Description**—Click either field and enter new information.
- **Default Action**—Choose a value from the Default Action drop-down list.

**Caution**  Changing the total number of intrusion policies used by an access control policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information. You change the the total number of intrusion policies by adding an intrusion policy that is not currently used, or by removing the last instance of an intrusion policy. You can use an intrusion policy in an access control rule, as the default action, or as the default intrusion policy.

- **Default Action Variable Set**—To change the variable set associated with an Intrusion Prevention default action, click the variables icon (variables). In the popup window that appears, select a new variable set and click OK. You can also click the edit icon (edit) to edit the selected variable set in a new window. For more information, see Managing Variables, on page 345.

- **Default Action Logging**—To configure logging for connections handled by the default action, click the logging icon (logging); see Logging Connections with a Policy Default Action, on page 1593.

- **HTTP Responses**—To specify what the user sees in a browser when the system blocks a website request, click the HTTP Responses tab; see Choosing HTTP Response Pages, on page 672.

- **Inheritance: Change Base Policy**—To change the base access control policy for this policy, click Inheritance Settings; see Choosing a Base Access Control Policy, on page 631.
• Inheritance: Lock Settings in Descendants—To enforce this policy’s settings in its descendant policies, click Inheritance Settings; see Locking Settings in Descendant Access Control Policies, on page 632.

• Policy Assignment: Targets—To identify the managed devices targeted by this policy, click Policy Assignment; see Setting Target Devices for an Access Control Policy, on page 634.

• Policy Assignment: Required in Domains—To enforce this policy in a subdomain, click Policy Assignment; see Requiring an Access Control Policy in a Domain, on page 633.

• Rules—To manage access control rules, and to inspect and block malicious traffic using intrusion and file policies, click the Rules tab; see Creating and Editing Access Control Rules, on page 646.

• Security Intelligence—To immediately blacklist (block) connections based on the latest reputation intelligence, click the Security Intelligence tab; see Configure Security Intelligence, on page 677.

• Advanced Options—To set preprocessing, SSL inspection, identity, performance, and other advanced options, click the Advanced tab; see Access Control Policy Advanced Settings, on page 634.

• Warnings—To view a list of warnings or errors in your access control policy (and its descendant and associated policies), click Show Warnings. Warnings and errors mark configurations that could adversely affect traffic analysis and flow or prevent the policy from deploying. If there are no warnings, the button does not appear.

Step 4  
Click Save.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Rule and Other Policy Warnings, on page 310
About Deep Inspection, on page 653

Managing Access Control Policy Inheritance

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  
Edit the access control policy whose inheritance settings you want to change; see Editing an Access Control Policy, on page 629.

Step 2  
Manage policy inheritance:

• Change Base Policy — To change the base access control policy for this policy, click Inheritance Settings and proceed as described in Choosing a Base Access Control Policy, on page 631.
Lock Settings in Descendants — To enforce this policy's settings in its descendant policies, click **Inheritance Settings** and proceed as described in Locking Settings in Descendant Access Control Policies, on page 632.

Required in Domains — To enforce this policy in a subdomain, click **Policy Assignment** and proceed as described in Requiring an Access Control Policy in a Domain, on page 633.

Inherit Settings from Base Policy — To inherit settings from a base access control policy, click the **Security Intelligence**, **HTTP Responses**, or **Advanced** tab and proceed as directed in Inheriting Access Control Policy Settings from the Base Policy, on page 632.

**What to do next**
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

### Choosing a Base Access Control Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access/Network Admin</td>
</tr>
</tbody>
</table>

You can use one access control policy as the base (parent) for another. By default, a child policy inherits its settings from its base policy, though you can change unlocked settings.

When you change the base policy for the current access control policy, the system updates the current policy with any locked settings from the new base policy.

**Procedure**

**Step 1** In the access control policy editor, click **Inheritance Settings**.

**Step 2** Choose a policy from the **Select Base Policy** drop-down list.

In a multidomain deployment, an access control policy may be required in the current domain. You can choose only the enforced policy or one of its descendants as the base policy.

**Step 3** Click Save.

**What to do next**
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Inheriting Access Control Policy Settings from the Base Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

A new child policy inherits many settings from its base policy. If these settings are unlocked in the base policy, you can override them.

If you later reinherit the settings from the base policy, the system displays the base policy's settings and dims the controls. However, the system saves the overrides you made, and restores them if you disable inheritance again.

**Procedure**

**Step 1**  
In the access control policy editor, click the **Security Intelligence**, **HTTP Responses**, or **Advanced** tab.

**Step 2**  
Check the **Inherit from base policy** checkbox for each setting you want to inherit.

If the controls are dimmed, settings are inherited from an ancestor policy, or you do not have permission to modify the configuration.

**Step 3**  
Click **Save**.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Locking Settings in Descendant Access Control Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Lock a setting in an access control policy to enforce the setting in all descendant policies. Descendant policies can override unlocked settings.

When you lock settings, the system saves overrides already made in descendant policies so that the overrides can be restored if you unlock settings again.

**Procedure**

**Step 1**  
In the access control policy editor, click **Inheritance Settings**.

**Step 2**  
In the Child Policy Inheritance Settings area, check the settings you want to lock.

If the controls are dimmed, settings are inherited from an ancestor policy, or you do not have permission to modify the configuration.
Step 3  Click **OK** to save the inheritance settings.

Step 4  Click **Save** to save the access control policy.

---

**What to do next**

- Deploy configuration changes; see *Deploy Configuration Changes, on page 277.*

---

### Requiring an Access Control Policy in a Domain

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can require that every device in a domain use the same base access control policy or one of its descendant policies.

**Before you begin**

- Configure at least one domain other than the Global domain.

**Procedure**

---

**Step 1**  In the access control policy editor, click **Policy Assignments**.

**Step 2**  Click the **Required on Domains** tab.

**Step 3**  Build your domain list:

- **Add** — Select the domains where you want to enforce the current access control policy, then click **Add** or drag and drop into the list of selected domains.

- **Delete** — Click the delete icon (🗑️) next to a leaf domain, or right-click an ancestor domain and choose **Delete Selected**.

- **Search** — Type a search string in the search field. Click the clear icon (❌) to clear the search.

**Step 4**  Click **OK** to save the domain enforcement settings.

**Step 5**  Click **Save** to save the access control policy.

---

**What to do next**

- Deploy configuration changes; see *Deploy Configuration Changes, on page 277.*
Setting Target Devices for an Access Control Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

An access control policy specifies the devices that use it. Each device can be targeted by only one access control policy. In multidomain deployments, you can require that all the devices in a domain use the same base policy.

**Procedure**

**Step 1**  
In the access control policy editor, click **Policy Assignments**.

**Step 2**  
On the **Targeted Devices** tab, build your target list:

- **Add** — Select one or more **Available Devices**, then click **Add to Policy** or drag and drop into the list of **Selected Devices**.
- **Delete** — Click the delete icon ( ⚪️ ) next to a single device, or select multiple devices, right-click, then choose **Delete Selected**.
- **Search** — Type a search string in the search field. Click the clear icon ( ✗ ) to clear the search.

Under **Impacted Devices**, the system lists the devices whose assigned access control policies are children of the current policy. Any change to the current policy affects these devices.

**Step 3**  
Optionally, click the **Required on Domains** tab to require that all the devices in the subdomains you choose use the same base policy. See **Requiring an Access Control Policy in a Domain**, on page 633.

**Step 4**  
Click **OK** to save your targeted device settings.

**Step 5**  
Click **Save** to save the access control policy.

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

**Access Control Policy Advanced Settings**

Advanced access control policy settings typically require little or no modification. The default settings are appropriate for most deployments. Note that many of the advanced preprocessing and performance options in access control policies may be modified by rule updates as described in **Update Intrusion Rules**, on page 124.

If a view icon ( 🎨 ) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.
See Configurations that Restart the Snort Process When Deployed or Activated, on page 281 for a list of advanced setting modifications that restart the Snort process, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

General Settings

To customize the number of characters you store for each URL requested by your users, see Limiting Logging of Long URLs, on page 1594.

To customize the length of time before you re-block a website after a user bypasses an initial block, see Setting the User Bypass Timeout for a Blocked Website, on page 674.

Disable Retry URL cache miss lookup to allow the system to immediately pass traffic to a URL without a cloud lookup when the category is not cached. The system treats URLs that require a cloud lookup as Uncategorized until the cloud lookup completes with a different category. In passive deployments, the system does not retry the lookup, as it cannot hold packets.

To inspect traffic when you deploy configuration changes unless specific configurations require restarting the Snort process, ensure that Inspect traffic during policy apply is set to its default value (enabled). When this option is enabled, resource demands could result in a small number of packets dropping without inspection. Additionally, deploying some configurations restarts the Snort process, which interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Scenarios, on page 279 for more information.

Associated Policies

Use advanced settings to associate subpolicies (SSL, identity) with access control; see Associating Other Policies with Access Control, on page 636.

Network Analysis and Intrusion Policies

Advanced network analysis and intrusion policy settings allow you to:

- Change the access control policy’s default intrusion policy and associated variable set, which are used to initially inspect traffic before the system can determine exactly how to inspect that traffic.
- Change the access control policy’s default network analysis policy, which governs many preprocessing options.
- Use custom network analysis rules and network analysis policies to tailor preprocessing options to specific security zones, networks, and VLANs.

For more information, see Advanced Access Control Settings for Network Analysis and Intrusion Policies, on page 1051.

File and Malware Settings

File and Malware Inspection Performance and Storage Tuning, on page 827 provides information on performance options for file control and AMP for Networks.
Intelligent Application Bypass Settings

Intelligent Application Bypass (IAB) is an expert-level configuration that specifies applications to bypass or test for bypass if traffic exceeds a combination of inspection performance and flow thresholds. For more information, see Intelligent Application Bypass, on page 695.

Transport/Network Layer Preprocessor Settings

Advanced transport and network preprocessor settings apply globally to all networks, zones, and VLANs where you deploy your access control policy. You configure these advanced settings in an access control policy rather than in a network analysis policy. For more information, see Advanced Transport/Network Preprocessor Settings, on page 1139.

Detection Enhancement Settings

Advanced detection enhancement settings allow you to use adaptive profiles to improve reassembly of packet fragments and TCP streams in passive deployments, based on your hosts' operating systems. For more information, see Adaptive Profiles, on page 1193.

Performance Settings and Latency-Based Performance Settings

About Intrusion Prevention Performance Tuning, on page 1037 provides information on improving the performance of your system as it analyzes traffic for attempted intrusions.

For information specific to latency-based performance settings, see Packet and Intrusion Rule Latency Threshold Configuration, on page 1041.

Associating Other Policies with Access Control

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Use an access control policy's advanced settings to associate one of each of the following subpolicies with the access control policy:

• SSL policy—Monitors, decrypts, blocks, or allows application layer protocol traffic encrypted with Secure Socket Layer (SSL) or Transport Layer Security (TLS).

Caution

Adding or removing an SSL policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

• Identity policy—Performs user authentication based on the realm and authentication method associated with the traffic.
Procedure

Step 1  In the access control policy editor, click the **Advanced** tab.
Step 2  Click the edit icon ( ), in the appropriate Policy Settings area.
        If a view icon ( ) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.
Step 3  Choose a policy from the drop-down list.
        If you choose a user-created policy, you can click the edit icon that appears to edit the policy.
Step 4  Click **OK**.
Step 5  Click **Save** to save the access control policy.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

- Snort® Restart Scenarios, on page 279
Associating Other Policies with Access Control
Access Control Rules

The following topics describe how to configure access control rules:

- Introduction to Access Control Rules, on page 639
- Adding an Access Control Rule Category, on page 645
- Creating and Editing Access Control Rules, on page 646
- Enabling and Disabling Access Control Rules, on page 647
- Positioning an Access Control Rule, on page 648
- Access Control Rule Actions, on page 648
- Access Control Rule Comments, on page 651

Introduction to Access Control Rules

Within an access control policy, access control rules provide a granular method of handling network traffic across multiple managed devices.

Note

8000 Series fastpathing, Security Intelligence filtering, SSL inspection, user identification, and some decoding and preprocessing occur before access control rules evaluate network traffic.

The system matches traffic to access control rules in the order you specify. In most cases, the system handles network traffic according to the first access control rule where all the rule’s conditions match the traffic.

Each rule also has an action, which determines whether you monitor, trust, block, or allow matching traffic. When you allow traffic, you can specify that the system first inspect it with intrusion or file policies to block any exploits, malware, or prohibited files before they reach your assets or exit your network.

The following scenario summarizes the ways that traffic can be evaluated by access control rules in an inline, intrusion prevention deployment.
In this scenario, traffic is evaluated as follows:

- **Rule 1: Monitor** evaluates traffic first. Monitor rules track and log network traffic but do not affect traffic flow. The system continues to match traffic against additional rules to determine whether to permit or deny it.

- **Rule 2: Trust** evaluates traffic next. Matching traffic is allowed to pass to its destination without further inspection, though it is still subject to identity requirements. Traffic that does not match continues to the next rule.

- **Rule 3: Block** evaluates traffic third. Matching traffic is blocked without further inspection. Traffic that does not match continues to the final rule.

- **Rule 4: Allow** is the final rule. For this rule, matching traffic is allowed; however, prohibited files, malware, intrusions, and exploits within that traffic are detected and blocked. Remaining non-prohibited, non-malicious traffic is allowed to its destination, though it is still subject to identity requirements. You can configure Allow rules that perform only file inspection, or only intrusion inspection, or neither.

- **Default Action** handles all traffic that does not match any of the rules. In this scenario, the default action performs intrusion prevention before allowing non-malicious traffic to pass. In a different deployment, you might have a default action that trusts or blocks all traffic, without further inspection. (You cannot perform file or malware inspection on traffic handled by the default action.)

Traffic you allow, whether with an access control rule or the default action, is automatically eligible for inspection for host, application, and user data by the network discovery policy. You do not explicitly enable discovery, although you can enhance or disable it. However, allowing traffic does not automatically guarantee discovery data collection. The system performs discovery only for connections involving IP addresses that are explicitly monitored by your network discovery policy; additionally, application discovery is limited for encrypted sessions.

Note that access control rules handle encrypted traffic when your SSL inspection configuration allows it to pass, or if you do not configure SSL inspection. However, some access control rule conditions require unencrypted traffic, so encrypted traffic may match fewer rules. Also, by default, the system disables intrusion and file inspection of encrypted payloads. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion and file inspection configured.
## Recommendations for Application Control

We recommend controlling applications' access to the network as follows:

- To allow or block application access from a less secure network to a more secure network: Use **Port** (Selected Destination Port) conditions on the access control rule

  For example, allow ICMP traffic from the internet (less secure) to an internal network (more secure.)

- To allow or block applications being accessed by user groups: Use **Application** conditions on the access control rule

  For example, block Facebook from being accessed by members of the Contractors group

---

**Note**

Failure to set up your access control rules properly can have unexpected results, including traffic being allowed that should be blocked. In general, application control rules should be lower in your access control list because it takes longer for those rules to match than rules based on IP address, for example.

Access control rules that use specific conditions (such as networks and IP addresses) should be ordered before rules that use general conditions (such as applications). If you're familiar with the Open Systems Interconnect (OSI) model, use similar numbering in concept. Rules with conditions for layers 1, 2, and 3 (physical, data link, and network) should be ordered first in your access control rules. Conditions for layers 5, 6, and 7 (session, presentation, and application) should be ordered later in your access control rules. For more information about the OSI model, see this [Wikipedia article](https://en.wikipedia.org/wiki/Open_Systems_Interconnection).

The following table provides an example of how to set up your access control rules:

<table>
<thead>
<tr>
<th>Type of control</th>
<th>Action</th>
<th>Zones, Networks, VLAN Tags</th>
<th>Users</th>
<th>Applications</th>
<th>Ports</th>
<th>URLs</th>
<th>SGT/ISE Attributes</th>
<th>Inspection, Logging, Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application from less secure to more secure network when application uses a port (for example, SSH)</td>
<td>Your choice <strong>(Allow in this example)</strong></td>
<td>Any</td>
<td>Any</td>
<td>Do not set</td>
<td>Available Ports: <strong>SSH</strong> Add to <strong>Selected Destination Ports</strong></td>
<td>Any</td>
<td>Use only with ISE.</td>
<td>Any</td>
</tr>
<tr>
<td>Application from less secure to more secure network when application does not use a port (for example, ICMP)</td>
<td>Your choice <strong>(Allow in this example)</strong></td>
<td>Any</td>
<td>Any</td>
<td>Do not set</td>
<td>Selected Destination Ports Protocol: <strong>ICMP</strong> Type: <strong>Any</strong></td>
<td>Do not set</td>
<td>Use only with ISE.</td>
<td>Any</td>
</tr>
</tbody>
</table>
### Access Control Rule Management

The **Rules** tab of the access control policy editor allows you to add, edit, categorize, search, move, enable, disable, delete, and otherwise manage access control rules in the current policy.

For each access control rule, the policy editor displays its name, a summary of its conditions, the rule action, and icons that communicate the rule’s inspection options or status. These icons represent:

- **intrusion policy option** (❗)
- **file policy option** (전문)
- **logging option** ( scaleX)
- **comments** (💬)
- **warnings** (⚠)
- **errors** (🔧)
- **important information** (❓)

Disabled rules are dimmed and marked *(disabled)* beneath the rule name.

To create or edit a rule, use the access control rule editor. You can:

- Configure basic properties such as the rule’s name, state, position, and action in the upper portion of the editor.
- Add conditions using the tabs on the left side of the lower portion of the editor.
- Use the tabs on the right side of the lower portion to configure inspection and logging options, and also to add comments to the rule. For your convenience, the editor lists the rule’s inspection and logging options regardless of which tab you are viewing.
Properly creating and ordering access control rules is a complex task, but one that is essential to building an effective deployment. If you do not plan your policy carefully, rules can preempt other rules, require additional licenses, or contain invalid configurations. To help ensure that the system handles traffic as you expect, the access control policy interface has a robust warning and error feedback system for rules.

**Note**

Related Topics

- Access Control Rule Components, on page 643
- Example: Custom User Roles and Access Control, on page 42
- Rule Performance Guidelines, on page 311

**Access Control Rule Components**

In addition to its unique name, each access control rule has the following basic components:

**State**

By default, rules are enabled. If you disable a rule, the system does not use it and stops generating warnings and errors for that rule.

**Position**

Rules in an access control policy are numbered, starting at 1. If you are using policy inheritance, rule 1 is the first rule in the outermost policy. The system matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.

Rules can also belong to a section and a category, which are organizational only and do not affect rule position. Rule position goes across sections and categories.

**Section and Category**

To help you organize access control rules, every access control policy has two system-provided rule sections, Mandatory and Default. To further organize access control rules, you can create custom rule categories inside the Mandatory and Default sections.

If you are using policy inheritance, the current policy's rules are nested between its parent policy's Mandatory and Default sections.

**Conditions**

Conditions specify the specific traffic the rule handles. Conditions can be simple or complex; their use often depends on license.

**Action**

A rule’s action determines how the system handles matching traffic. You can monitor, trust, block, or allow (with or without further inspection) matching traffic. The system does **not** perform deep inspection on trusted, blocked, or encrypted traffic.
Inspection
Deep inspection options govern how the system inspects and blocks malicious traffic you would otherwise allow. When you allow traffic with a rule, you can specify that the system first inspect it with intrusion or file policies to block any exploits, malware, or prohibited files before they reach your assets or exit your network.

Logging
A rule’s logging settings govern the records the system keeps of the traffic it handles. You can keep a record of traffic that matches a rule. In general, you can log sessions at the beginning or end of a connection, or both. You can log connections to the database, as well as to the system log (syslog) or to an SNMP trap server.

Comments
Each time you save changes to an access control rule, you can add comments.

Related Topics
- Rule Performance Guidelines, on page 311
- Access Control Rule Management, on page 642
- Creating and Editing Access Control Rules, on page 646
- Rule Condition Types, on page 290
- Access Control Rule Actions, on page 648
- About Deep Inspection, on page 653
- Best Practices for Connection Logging
- Access Control Rule Comments, on page 651

Access Control Rule Order
Rules in an access control policy are numbered, starting at 1. The system matches traffic to access control rules in top-down order by ascending rule number.

In most cases, the system handles network traffic according to the first access control rule where all the rule’s conditions match the traffic. Except Monitor rules (which log traffic but do not affect traffic flow), the system does not continue to evaluate traffic against additional, lower-priority rules after that traffic matches a rule.

To help you organize access control rules, every access control policy has two system-provided rule sections, Mandatory and Default. To further organize, you can create custom rule categories inside the Mandatory or Default sections. After you create a category, you cannot move it, although you can delete it, rename it, and move rules into, out of, within, and around it. The system assigns rule numbers across sections and categories.

If you use policy inheritance, the current policy's rules are nested between its parent policy's Mandatory and Default rule sections. Rule 1 is the first rule in the outermost policy, not the current policy, and the system assigns rule numbers across policies, sections, and categories.

Any predefined user role that allows you to modify access control policies also allows you to move and modify access control rules within and among rules categories. You can, however, create custom roles that restrict users from moving and modifying rules. Any user who is allowed to modify access control policies can add rules to custom categories and modify rules within them without restriction.
Proper access control rule order reduces the resources required to process network traffic, and prevents rule preemption. Although the rules you create are unique to every organization and deployment, there are a few general guidelines to follow when ordering rules that can optimize performance while still addressing your needs.

### Related Topics

- Guidelines for Ordering Rules, on page 312

## Adding an Access Control Rule Category

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can divide an access control policy's Mandatory and Default rule sections into custom categories. After you create a category, you cannot move it, although you can delete it, rename it, and move rules into, out of, within, and around it. The system assigns rule numbers across sections and categories.

### Procedure

1. In the access control policy editor, click **Add Category**.

   **Tip** If your policy already contains rules, you can click a blank area in the row for an existing rule to set the position of the new category before you add it. You can also right-click an existing rule and select **Insert new category**.

2. Enter a **Name**.

3. From the **Insert** drop-down list, choose where you want to add the category:

   - To insert a category below all existing categories in a section, choose **into Mandatory** or **into Default**.
   - To insert a category above an existing category, choose **above category**, then choose a category.
   - To insert a category above or below an access control rule, choose **above rule** or **below rule**, then enter an existing rule number.

4. Click **OK**.

5. Click **Save** to save the policy.

### What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Creating and Editing Access Control Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Caution
Changing the total number of intrusion policies used by an access control policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information. You change the the total number of intrusion policies by adding an intrusion policy that is not currently used, or by removing the last instance of an intrusion policy. You can use an intrusion policy in an access control rule, as the default action, or as the default intrusion policy.

Procedure

Step 1 In the access control policy editor, you have the following options:
  * To add a new rule, click Add Rule.
  * To edit an existing rule, click the edit icon (✏).

If a view icon (👀) appears next to a rule instead, the rule belongs to an ancestor policy, or you do not have permission to modify the rule.

Step 2 Enter a Name.

Step 3 Configure the rule components, or accept the defaults:
  * Enabled—Specify whether the rule is Enabled.
  * Position—Specify the rule position; see Access Control Rule Order, on page 644.
  * Action—Choose a rule Action; see Access Control Rule Actions, on page 648.
  * Conditions—Click the tab corresponding to the condition you want to add. See Rule Condition Types, on page 290 for more information.

  * Deep Inspection—for Allow and Interactive Block rules, click the intrusion inspection icon (🔍) or the file and malware inspection icon (🔍) to configure the rule’s Inspection options. If the icon is dimmed, no policy of that type is selected for the rule. See Access Control Using Intrusion and File Policies, on page 653 for more information.
• Logging—Click an active (blue) logging icon to specify **Logging** options. If the icon is dimmed, connection logging is disabled for the rule. See **Best Practices for Connection Logging** for more information.

• Comments—Click the number in the comment column to add **Comments**. The number indicates how many comments the rule already contains. See **Access Control Rule Comments**, on page 651 for more information.

**Step 4**

Save the rule.

**Step 5**

Click **Save** to save the policy.

---

**What to do next**

• Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

**Related Topics**

**Rule Performance Guidelines**, on page 311

---

## Enabling and Disabling Access Control Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

When you create an access control rule, it is enabled by default. If you disable a rule, the system does not use it to evaluate network traffic and stops generating warnings and errors for that rule. When viewing the list of rules in an access control policy, disabled rules are grayed out, although you can still modify them.

---

**Tip**

You can also enable or disable an access control rule using the rule editor.

---

**Procedure**

**Step 1**

In the access control policy editor, right-click the rule and choose a rule state.

If a view icon appears next to a rule instead, the rule belongs to an ancestor policy, or you do not have permission to modify the rule.

**Step 2**

Click **Save**.
Positioning an Access Control Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can move an existing rule within, but not between, access control policies. When you add or move a rule to a category, the system places it last in the category.

**Tip**
You can move multiple rules at once by selecting the rules then cutting and pasting using the right-click menu.

**Procedure**

**Step 1**
In the access control rule editor, you have the following options:
- If you are adding a new rule, use the Insert drop-down list.
- If you are editing an existing rule, click Move.

**Step 2**
Choose where you want to move or insert the rule:
- Choose into Mandatory or into Default.
- Choose a into Category, then choose the user-defined category.
- Choose above rule or below rule, then type the appropriate rule number.

**Step 3**
Click Save.

**Step 4**
Click Save to save the policy.

**What to do next**
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Access Control Rule Actions

Every access control rule has an action that determines how the system handles and logs matching traffic. You can monitor, trust, block, or allow (with or without further inspection).
The access control policy’s *default action* handles traffic that does not meet the conditions of any non-Monitor access control rule.

**Access Control Rule Monitor Action**

The *Monitor* action does not affect traffic flow; matching traffic is neither immediately permitted nor denied. Rather, traffic is matched against additional rules to determine whether to permit or deny it. The first non-Monitor rule matched determines traffic flow and any further inspection. If there are no additional matching rules, the system uses the default action.

Because the primary purpose of Monitor rules is to track network traffic, the system automatically logs end-of-connection events for monitored traffic. That is, connections are logged even if the traffic matches no other rules and you do not enable logging on the default action.

---

**Note**

If locally-bound traffic matches a Monitor rule in a Layer 3 deployment, that traffic may bypass inspection. To ensure inspection of the traffic, enable **Inspect Local Router Traffic** in the advanced device settings for the managed device routing the traffic.

**Related Topics**

- **Logging for Monitored Connections**, on page 1587

---

**Access Control Rule Trust Action**

The *Trust* action allows traffic to pass without deep inspection or network discovery. Trusted traffic is still subject to identity requirements.

**Related Topics**

- **Logging for Trusted Connections**, on page 1588

---

**Access Control Rule Blocking Actions**

The *Block* and *Block with reset* actions deny traffic without further inspection of any kind.
Block with reset rules reset the connection, with the exception of web requests met with an *HTTP response page*. This is because the response page, which you configure to appear when the system blocks web requests, cannot display if the connection is immediately reset. For more information, see *HTTP Response Pages and Interactive Blocking*, on page 671.

**Related Topics**
- *Logging for Blocked Connections*, on page 1588
- *About HTTP Response Pages*, on page 671

### Access Control Rule Interactive Blocking Actions

For more information, see *HTTP Response Pages and Interactive Blocking*, on page 671.

If a user bypasses the block, the rule mimics an allow rule. Therefore, you can associate interactive block rules with file and intrusion policies, and matching traffic is also eligible for network discovery.

If a user does not (or cannot) bypass the block, the rule mimics a block rule. Matching traffic is denied without further inspection.

Note that if you enable interactive blocking, you cannot reset *all* blocked connections. This is because the response page cannot display if the connection is immediately reset. Use the *Interactive Block with reset* action to (non-interactively) block-with-reset all non-web traffic, while still enabling interactive blocking for web requests.

For more information, see *HTTP Response Pages and Interactive Blocking*, on page 671.

**Related Topics**
- *Logging for Allowed Connections*, on page 1589
- *TLS/SSL Rule Blocking Actions*, on page 751
Access Control Rule Allow Action

The **Allow** action allows matching traffic to pass, though it is still subject to identity requirements.

Optionally, you can use deep inspection to further inspect and block unencrypted or decrypted traffic before it reaches its destination:

- You can use an intrusion policy to analyze network traffic according to intrusion detection and prevention configurations, and drop offending packets depending on the configuration.
- You can perform file control using a file policy. File control allows you to detect and block your users from uploading (sending) or downloading (receiving) files of specific types over specific application protocols.
- You can perform network-based advanced malware protection (AMP), also using a file policy. AMP for Networks can inspect files for malware, and block detected malware depending on the configuration.

The following diagram illustrates the types of inspection performed on traffic that meets the conditions of an Allow rule (or a user-bypassed Interactive Block rule). Notice that file inspection occurs before intrusion inspection; blocked files are not inspected for intrusion-related exploits.

For simplicity, the diagram displays traffic flow for situations where both (or neither) an intrusion and a file policy are associated with an access control rule. You can, however, configure one without the other. Without a file policy, traffic flow is determined by the intrusion policy; without an intrusion policy, traffic flow is determined by the file policy.

Regardless of whether the traffic is inspected or dropped by an intrusion or file policy, the system can inspect it using network discovery. However, allowing traffic does not automatically guarantee discovery inspection. The system performs discovery only for connections involving IP addresses that are explicitly monitored by your network discovery policy; additionally, application discovery is limited for encrypted sessions.

**Related Topics**

- [Logging for Allowed Connections](#), on page 1589

Access Control Rule Comments

When you create or edit an access control rule, you can add a comment. For example, you might summarize the overall configuration for the benefit of other users, or note when you change a rule and the reason for the change. You can display a list of all comments for a rule along with the user who added each comment and the date the comment was added.
When you save a rule, all comments made since the last save become read-only.

**Related Topics**

Configuring Access Control Policy Preferences

---

# Adding Comments to an Access Control Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  In the access control rule editor, click the **Comments** tab.

**Step 2**  Click **New Comment**.

**Step 3**  Enter your comment and click **OK**. You can edit or delete this comment until you save the rule.

**Step 4**  Click **Save**.

**Step 5**  Click **Save** to save the policy.

---

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes, on page 277**.
CHAPTER 35

Access Control Using Intrusion and File Policies

The following topics describe how to configure access control policies to use intrusion and file policies:

- About Deep Inspection, on page 653
- Access Control Traffic Handling, on page 654
- File and Intrusion Inspection Order, on page 655
- Access Control Rule Configuration to Perform Malware Protection, on page 656
- Access Control Rule Configuration to Perform Intrusion Prevention, on page 658

About Deep Inspection

Intrusion and file policies work together as the last line of defense before traffic is allowed to its destination:

- Intrusion policies govern the system’s intrusion prevention capabilities.
- File policies govern the system’s file control and AMP for Networks capabilities.

Access control occurs before deep inspection; access control rules and the access control default action determine which traffic is inspected by intrusion and file policies.

By associating an intrusion or file policy with an access control rule, you are telling the system that before it passes traffic that matches the access control rule’s conditions, you first want to inspect the traffic with an intrusion policy, a file policy, or both.

Note

By default, the system disables intrusion and file inspection of encrypted payloads. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion and file inspection configured.

The system can also receive AMP for Endpoints data from the AMP cloud, then present this data alongside any AMP for Networks data.

Related Topics

- How Policies Examine Traffic For Intrusions, on page 834
- File Policies, on page 809
Access Control Traffic Handling

Access control rules provide a granular method of handling network traffic across multiple managed devices. The system matches traffic to access control rules in the order you specify. In most cases, the system handles network traffic according to the *first* access control rule where all the rule’s conditions match the traffic. An access control rule’s *action* determines how the system handles matching traffic. You can monitor, trust, block, or allow (with or without further inspection) matching traffic.

The following diagram shows the flow of traffic in an inline intrusion prevention and AMP for Networks deployment, as governed by an access control policy that contains four different types of access control rules and a default action.

In the scenario above, the first three access control rules in the policy—Monitor, Trust, and Block—cannot inspect matching traffic. Monitor rules track and log but do not inspect network traffic, so the system continues to match traffic against additional rules to determine whether to permit or deny it. Trust and Block rules handle matching traffic without further inspection of any kind, while traffic that does not match continues to the next access control rule.

The fourth and final rule in the policy, an Allow rule, invokes various other policies to inspect and handle matching traffic, in the following order:

- **Discovery: Network Discovery Policy**—First, the network discovery policy inspects traffic for discovery data. Discovery is passive analysis and does not affect the flow of traffic. Although you do not explicitly enable discovery, you can enhance or disable it. However, allowing traffic does not automatically guarantee discovery data collection. The system performs discovery only for connections involving IP addresses that are explicitly monitored by your network discovery policy.

- **AMP for Networks and File Control: File Policy**—After traffic is inspected by discovery, the system can inspect it for prohibited files and malware. AMP for Networks detects and optionally blocks malware in many types of files, including PDFs, Microsoft Office documents, and others. If your organization wants to block not only the transmission of malware files, but all files of a specific type (regardless of whether the files contain malware), *file control* allows you to monitor network traffic for transmissions of specific file types, then either block or allow the file.

- **Intrusion Prevention: Intrusion Policy**—After file inspection, the system can inspect traffic for intrusions and exploits. An intrusion policy examines decoded packets for attacks based on patterns, and can block...
or alter malicious traffic. Intrusion policies are paired with variable sets, which allow you to use named values to accurately reflect your network environment.

- **Destination**—Traffic that passes all the checks described above passes to its destination.

An Interactive Block rule (not shown in the diagram) has the same inspection options as an Allow rule. This is so you can inspect traffic for malicious content when a user bypasses a blocked website by clicking through a warning page.

Traffic that does not match any of the non-Monitor access control rules in the policy is handled by the default action. In this scenario, the default action is an Intrusion Prevention action, which allows traffic to its final destination as long as it is passed by the intrusion policy you specify. In a different deployment, you might have a default action that trusts or blocks all traffic without further inspection. Note that the system can inspect traffic allowed by the default action for discovery data and intrusions, but not prohibited files or malware. You **cannot** associate a file policy with the access control default action.

---

**Note**

Sometimes, when a connection is analyzed by an access control policy, the system must process the first few packets in that connection, **allowing them to pass**, before it can decide which access control rule (if any) will handle the traffic. However, so these packets do not reach their destination uninspected, you can use an intrusion policy—called the default intrusion policy—to inspect them and generate intrusion events.

---

**File and Intrusion Inspection Order**

In your access control policy, you can associate multiple Allow and Interactive Block rules with different intrusion and file policies to match inspection profiles to various types of traffic.

---

**Note**

Traffic allowed by an Intrusion Prevention or Network Discovery Only default action can be inspected for discovery data and intrusions, but cannot be inspected for prohibited files or malware. You **cannot** associate a file policy with the access control default action.

---

You do not have to perform both file and intrusion inspection in the same rule. For a connection matching an Allow or Interactive Block rule:

- without a file policy, traffic flow is determined by the intrusion policy
- without an intrusion policy, traffic flow is determined by the file policy
- without either, allowed traffic is inspected by network discovery only

---

**Tip**

The system does not perform any kind of inspection on trusted traffic. Although configuring an Allow rule with neither an intrusion nor file policy passes traffic like a Trust rule, Allow rules let you perform discovery on matching traffic.

---

The diagram below illustrates the types of inspection you can perform on traffic that meets the conditions of either an Allow or user-bypassed Interactive Block access control rule. For simplicity, the diagram displays
traffic flow for situations where both (or neither) an intrusion and a file policy are associated with a single access control rule.

For any single connection handled by an access control rule, file inspection occurs before intrusion inspection. That is, the system does not inspect files blocked by a file policy for intrusions. Within file inspection, simple blocking by type takes precedence over malware inspection and blocking.

For example, consider a scenario where you normally want to allow certain network traffic as defined in an access control rule. However, as a precaution, you want to block the download of executable files, examine downloaded PDFs for malware and block any instances you find, and perform intrusion inspection on the traffic.

You create an access control policy with a rule that matches the characteristics of the traffic you want to provisionally allow, and associate it with both an intrusion policy and a file policy. The file policy blocks the download of all executables, and also inspects and blocks PDFs containing malware:

- First, the system blocks the download of all executables, based on simple type matching specified in the file policy. Because they are immediately blocked, these files are subject to neither malware nor intrusion inspection.

- Next, the system performs malware cloud lookups for PDFs downloaded to a host on your network. Any PDFs with a malware disposition are blocked, and are not subject to intrusion inspection.

- Finally, the system uses the intrusion policy associated with the access control rule to inspect any remaining traffic, including files not blocked by the file policy.

Note

 Until a file is detected and blocked in a session, packets from the session may be subject to intrusion inspection.

Access Control Rule Configuration to Perform Malware Protection

An access control policy can have multiple access control rules associated with file policies. You can configure file inspection for any Allow or Interactive Block access control rule, which permits you to match different file and malware inspection profiles against different types of traffic on your network before it reaches its final destination.
When the system detects a prohibited file (including malware) according to the settings in the file policy, it automatically logs an event to the Firepower Management Center database. If you do not want to log file or malware events, you can disable this logging on a per-access-control-rule basis.

The system also logs the end of the associated connection to the Firepower Management Center database, regardless of the logging configuration of the invoking access control rule.

**Configuring an Access Control Rule to Perform Malware Protection**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat (file control) Malware (AMP)</td>
<td>Protection (file control) Malware (AMP)</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Caution**

Selecting Detect Files or Block Files, enabling or disabling Store files in a Detect Files or Block Files rule, or adding the first or removing the last file rule that combines the Malware Cloud Lookup or Block Malware file rule action with an analysis option (Spero Analysis or MSEXE, Dynamic Analysis, or Local Malware Analysis) or a store files option (Malware, Unknown, Clean, or Custom), restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See *Snort® Restart Traffic Behavior*, on page 280 for more information.

**Before you begin**

- Adaptive profiling must be enabled as described in *Configuring Adaptive Profiles*, on page 1195 for access control rules to perform file control, including AMP.

**Procedure**

**Step 1**

In the access control rule editor, choose an Action of Allow, Interactive Block, or Interactive Block with reset.

**Step 2**

Click the Inspection tab.

**Step 3**

Choose a Malware Policy (file policy) to inspect traffic that matches the access control rule, or choose None to disable file inspection for matching traffic.

**Step 4**

(Optional) Disable logging of file or malware events for matching connections by clicking the Logging tab and unchecking Log Files.

**Note**

Cisco recommends you leave file and malware event logging enabled.

**Step 5**

Save the rule.

**Step 6**

Click Save to save the policy.
Access Control Rule Configuration to Perform Intrusion Prevention

An access control policy can have multiple access control rules associated with intrusion policies. You can configure intrusion inspection for any Allow or Interactive Block access control rule, which permits you to match different intrusion inspection profiles against different types of traffic on your network before it reaches its final destination.

Whenever the system uses an intrusion policy to evaluate traffic, it uses an associated variable set. Variables in a set represent values commonly used in intrusion rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies to represent IP addresses in rule suppressions and dynamic rule states.

Even if you use system-provided intrusion policies, Cisco strongly recommends you configure the system’s intrusion variables to accurately reflect your network environment. At a minimum, modify default variables in the default set.

Understanding System-Provided and Custom Intrusion Policies

Cisco delivers several intrusion policies with the Firepower System. By using system-provided intrusion policies, you can take advantage of the experience of the Cisco Talos Security Intelligence and Research Group (Talos). For these policies, Talos sets intrusion and preprocessor rule states, as well as provides the initial configurations for advanced settings. You can use system-provided policies as-is, or you can use them as the base for custom policies. Building custom policies can improve the performance of the system in your environment and provide a focused view of the malicious traffic and policy violations occurring on your network.

Connection and Intrusion Event Logging

When an intrusion policy invoked by an access control rule detects an intrusion and generates an intrusion event, it saves that event to the Firepower Management Center. The system also automatically logs the end of the connection where the intrusion occurred to the Firepower Management Center database, regardless of the logging configuration of the access control rule.

Related Topics

Predefined Default Variables, on page 335
Access Control Rule Configuration and Intrusion Policies

In addition to custom intrusion policies that you create, the system provides two custom policies: Initial Inline Policy and Initial Passive Policy. These two intrusion policies use the Balanced Security and Connectivity intrusion policy as their base. The only difference between them is their Drop When Inline setting, which enables drop behavior in the inline policy and disables it in the passive policy.

The number of unique intrusion policies you can use in a single access control policy depends on the model of the target devices; more powerful devices can handle more. Every unique pair of intrusion policy and variable set counts as one policy. Although you can associate a different intrusion policy-variable set pair with each Allow and Interactive Block rule (as well as with the default action), you cannot deploy an access control policy if the target devices have insufficient resources to perform inspection as configured.

Configuring an Access Control Rule to Perform Intrusion Prevention

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Caution**

Changing the total number of intrusion policies used by an access control policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information. You change the the total number of intrusion policies by adding an intrusion policy that is not currently used, or by removing the last instance of an intrusion policy. You can use an intrusion policy in an access control rule, as the default action, or as the default intrusion policy.

**Procedure**

**Step 1** In the access control policy editor, create a new rule or edit an existing rule; see Access Control Rule Components, on page 643.

**Step 2** Ensure the rule action is set to Allow, Interactive Block, or Interactive Block with reset.

**Step 3** Click the tab.

**Step 4** Choose a system-provided or custom Intrusion Policy, or choose None to disable intrusion inspection for traffic that matches the access control rule.

**Step 5** If you want to change the variable set associated with the intrusion policy, choose a value from the Variable Set drop-down list.

**Step 6** Click Save to save the rule.

**Step 7** Click Save to save the policy.
What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

- Variable Sets, on page 333
- Snort® Restart Scenarios, on page 279
CHAPTER 36

URL Filtering

• URL Filtering Overview, on page 661
• About URL Filtering with Category and Reputation, on page 661
• Guidelines and Limitations for URL Filtering, on page 662
• How to Configure URL Filtering with Category and Reputation, on page 665
• Manual URL Filtering, on page 669

URL Filtering Overview

Use the URL filtering feature to control the websites that users on your network can access:

• Category and reputation-based URL filtering—With a URL Filtering license, you can control access to websites based on the URL’s general classification (category) and risk level (reputation). This is the recommended option.

• Manual URL filtering—With any license, you can manually specify individual URLs, groups of URLs, and URL lists and feeds to achieve granular, custom control over web traffic. For more information, see Manual URL Filtering, on page 669.

About URL Filtering with Category and Reputation

With a URL Filtering license, you can control access to websites based on the category and reputation of requested URLs:

• Category—A general classification for the URL. For example, ebay.com belongs to the Auctions category, and monster.com belongs to the Job Search category. A URL can belong to more than one category.

• Reputation—How likely the URL is to be used for purposes that might be against your organization’s security policy. Reputations range from High Risk (level 1) to Well Known (level 5).

Benefits of Category and Reputation-Based URL Filtering

URL categories and reputations help you quickly configure URL filtering. For example, you can use access control to block high risk URLs in the Hacking category. There are also categories for types of threats, such as a Spyware and Adware category.
Using category and reputation data simplifies policy creation and administration. It grants you assurance that the system controls web traffic as expected. Because Cisco continually updates its threat intelligence with new URLs, as well as new categories and risks for existing URLs, you can ensure that the system uses up-to-date information to filter requested URLs. Sites that (for example) represent security threats, or that serve undesirable content, may appear and disappear faster than you can update and deploy new policies.

Some examples of how the system can adapt include:

- If an access control rule blocks all gaming sites, as new domains get registered and classified as Games, the system can block those sites automatically.
- If an access control rule blocks all malware sites and a shopping page gets infected with malware, the system can recategorize the URL from Shopping to Malware Sites and block that site.
- If an access control rule blocks high-risk social networking sites and somebody posts a link on their profile page that contains links to malicious payloads, the system can change the reputation of that page from Benign Sites to High Risk and block it.

**Related Topics**

- Snort® Restart Scenarios, on page 279

---

**Guidelines and Limitations for URL Filtering**

**Limitations to URL Identification**

The system cannot filter URLs before:

- A monitored connection is established between a client and server.
- The system identifies the HTTP or HTTPS application in the session.
- The system identifies the requested URL (for encrypted sessions, from either the ClientHello message or the server certificate).

This identification should occur within 3 to 5 packets, or after the server certificate exchange in the TLS/SSL handshake if the traffic is encrypted.

If early traffic matches all other rule conditions but identification is incomplete, the system allows the packet to pass and the connection to be established (or the TLS/SSL handshake to complete). After the system completes its identification, the system applies the appropriate rule action to the remaining session traffic.

For access control, these passed packets are inspected by the access control policy’s default intrusion policy—not the default action intrusion policy nor the almost-matched rule’s intrusion policy.

**URL Rules Before Application and Other Rules**

For the most effective URL matching, place rules that include URL conditions before other rules, particularly if the URL rules are block rules and the other rules meet both of the following criteria:

- They include application conditions.
- The traffic to be inspected is encrypted.
For additional guidelines for rules, see the Rule Management: Common Characteristics, on page 289 chapter, including the following topics: Rule Condition Mechanics, on page 292 and Rule Performance Guidelines, on page 311.

**Uncategorized/Reputationless URLs**

If the system does not know the category and reputation of a URL, browsing to that website does not match rules with category and reputation-based URL conditions. You cannot assign categories and reputations to URLs manually.

When you build a URL rule, you first choose the category you want to match. If you explicitly choose **Uncategorized** URLs, you cannot further constrain by reputation, because uncategorized URLs do not have reputations.

**URL Filtering for Encrypted Web Traffic**

When performing URL filtering on encrypted web traffic, the system:

- Disregards the encryption protocol; a rule matches both HTTPS and HTTP traffic if the rule has a URL condition but not an application condition that specifies the protocol.
- Does not use URL lists. You must use URL objects and groups instead.
- Matches HTTPS traffic based on the subject common name in the public key certificate used to encrypt the traffic, and disregards subdomains within the subject common name.
- Does not display an HTTP response page for encrypted connections blocked by access control rules (or any other configuration); see Limitations to HTTP Response Pages, on page 671.

**HTTP/2**

The system can extract HTTP/2 URLs from TLS certificates, but not from a payload.

**Search Query Parameters in URLs**

The system does not use search query parameters in the URL to match URL conditions. For example, consider a scenario where you block all shopping traffic. In that case, using a web search to search for amazon.com is not blocked, but browsing to amazon.com is.

**Memory Limitations for Selected Device Models**

Due to memory limitations, some device models perform most URL filtering with a smaller, less granular, set of categories and reputations. For example, even if a parent URL’s subsites have different URL categories and reputations, some devices may only store the parent URL’s data. For web traffic handled by these devices, the system may perform cloud lookups to determine category and reputation for sites not in the local database.

Lower-memory devices include:

- 7100 series
- ASA 5512-X, ASA 5515-X, and ASA 5525-X

If you are using NGIPSv, see the Cisco Firepower NGIPSv for VMware Quick Start Guide for information on allocating the correct amount of memory to perform category and reputation-based URL filtering.
Manual URL Filtering

When manually filtering specific URLs, carefully consider other traffic that might be affected. To determine whether network traffic matches a URL condition, the system performs a simple substring match. If the requested URL matches any part of the string, the URLs are considered to match.

Related Topics

- The Default Intrusion Policy, on page 1051

Filtering HTTPS Traffic

To filter encrypted traffic, the system determines the requested URL based on information passed during the TLS/SSL handshake: the subject common name in the public key certificate used to encrypt the traffic.

HTTPS filtering, unlike HTTP filtering, disregards subdomains within the subject common name. Do not include subdomain information when manually filtering HTTPS URLs in access control policies. For example, use example.com rather than www.example.com.

HTTPS filtering also does not support URL lists. You must use URL objects and groups instead.

Tip

In an SSL policy, you can handle and decrypt traffic to specific URLs by defining a distinguished name SSL rule condition. The common name attribute in a certificate’s subject distinguished name contains the site’s URL. Decrypting HTTPS traffic allows access control rules to evaluate the decrypted session, which improves URL filtering.

Controlling Traffic by Encryption Protocol

The system disregards the encryption protocol (HTTP vs HTTPS) when performing URL filtering in access control policies. This occurs for both manual and reputation-based URL conditions. In other words, URL filtering treats traffic to the following websites identically:

- http://example.com/
- https://example.com/

To configure a rule that matches only HTTP or HTTPS traffic, add an application condition to the rule. For example, you could allow HTTPS access to a site while disallowing HTTP access by constructing two access control rules, each with an application and URL condition.

The first rule allows HTTPS traffic to the website:

- Action: Allow
- Application: HTTPS
- URL: example.com

The second rule blocks HTTP access to the same website:

- Action: Block
- Application: HTTP
- URL: example.com
# How to Configure URL Filtering with Category and Reputation

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>If you will use category and reputation-based URL filtering on an NGIPSv device, allocate the required amount of memory.</td>
<td><em>Cisco Firepower NGIPSv for VMware Quick Start Guide</em></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Ensure that you have the correct licenses.</td>
<td><em>Licensing the Firepower System, on page 105, including:</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>URL Filtering Licenses for Classic Devices, on page 110</strong></td>
</tr>
<tr>
<td></td>
<td>Assign the URL Filtering license to each managed device that will filter URLs.</td>
<td>In order to enable the feature, at least one managed device must have a URL Filtering license assigned to it.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Ensure that your Firepower Management Center can communicate with the cloud to obtain URL filtering data.</td>
<td><em>Internet Access Requirements, on page 1801 and Communication Port Requirements, on page 1803.</em></td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>Understand limitations and guidelines and take any necessary actions.</td>
<td><em>Guidelines and Limitations for URL Filtering, on page 662</em></td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Enable the URL Filtering feature.</td>
<td><em>Enable URL Filtering Using Category and Reputation, on page 665</em></td>
</tr>
<tr>
<td><strong>Step 6</strong></td>
<td>Configure policies to filter URLs by category and reputation.</td>
<td><em>Configuring URL Conditions, on page 667, including the information preceding Step 1, and URL Rule Order, on page 315</em></td>
</tr>
</tbody>
</table>

## Enable URL Filtering Using Category and Reputation

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Filtering</td>
<td>URL Filtering</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

### Before you begin

Complete prerequisites described in *How to Configure URL Filtering with Category and Reputation, on page 665.*

### Procedure

**Step 1** Choose System > Integration.
URL Filtering Options

Step 2  Click the Cisco CSI tab.
Step 3  Configure URL Filtering Options, on page 666.
Step 4  Click Save.

Enable URL Filtering

Allows traffic filtering based on a website’s general classification, or category, and risk level, or reputation. Adding a URL Filtering license automatically enables Enable URL Filtering. URL filtering must be enabled before you can choose other URL filtering options.

When you enable URL filtering, depending on how long since URL filtering was last enabled, or if this is the first time you are enabling URL filtering, the Firepower Management Center downloads URL data from Cisco Collective Security Intelligence (Cisco CSI). This process may take some time.

Enable Automatic Updates

Options for updating URL filtering threat data:

- If you enable the Enable Automatic Updates option on this page, the Firepower Management Center checks the cloud every 30 minutes for updates. This option is enabled by default when you add a URL filtering license.

- If you need strict control over when the system contacts external resources, disable automatic updates on this page and instead create a recurring task using the scheduler. See Automating URL Filtering Updates Using a Scheduled Task, on page 166.

Update Now

You can perform a one-time, on-demand update by clicking the Update Now button at the top of this dialog box, but you should also either enable automatic updates or create a recurring task using the scheduler. You cannot start an on-demand update if an update is already in progress.

Although daily updates tend to be small, if it has been more than five days since your last update, new URL data may take up to 20 minutes to download, depending on your bandwidth. Then, it may take up to 30 minutes to perform the update itself.

Query Cisco CSI for Unknown URLs

Allows the system to submit URLs to the cloud for threat intelligence evaluation when users browse to a website whose category and reputation are not in the local dataset. Disable this option if you do not want to submit your uncategorized URLs, for example, for privacy reasons.

Connections to uncategorized URLs do not match rules with category or reputation-based URL conditions. You cannot assign categories or reputations to URLs manually.
Configuring URL Conditions

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Filtering (cat/rep)</td>
<td>URL Filtering (cat/rep)</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Access Admin/Network Admin</td>
</tr>
<tr>
<td>Any (manual)</td>
<td>Any (manual)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When you build a URL condition, you choose the URL categories whose traffic you want to control. Optionally, you can constrain those URL categories with a reputation.

In access control rules, you can also filter individual URLs using predefined URL objects, URL lists and feeds, and manual per-rule URLs. You cannot constrain these URLs with a reputation. Manual URL filtering is not supported in SSL rules; instead, use distinguished name conditions.

---

**Caution**

Adding the first or removing the last URL or Category category/reputation condition in an access control or SSL rule restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

---

**Procedure**

**Step 1**

In the rule editor, click the tab for URL conditions:

- Access control—Click the **URLs** tab.
- SSL—Click the **Category** tab.

**Step 2**

Find and choose the URLs you want to control:

- Categories—Choose URL categories, or keep the default of **Any**. In an access control rule, click the **Category** sub-tab to choose categories.
- URL Objects, Lists, and Feeds—Choose predefined URL objects and URL lists and feeds. In an access control rule, click the **URLs** sub-tab to choose URLs.

**Step 3**

(Optional) Constrain URL categories by choosing a **Reputation**.

Note that if you explicitly match **Uncategorized** URLs, you cannot further constrain by reputation, because uncategorized URLs do not have reputations. Choosing a reputation level also includes other reputations either more or less severe than the level you choose, depending on the rule action:

- Includes less severe reputations—If the rule allows or trusts web traffic. For example, if you configure an access control rule to allow Benign Sites (level 4), it also automatically allows Well Known (level 5) sites.
- Includes more severe reputations—If the rule decrypts, blocks, or monitors web traffic. For example, if you configure an access control rule to block Suspicious Sites (level 2), it also blocks High Risk (level 1) sites.

If you change the rule action, the system automatically changes the reputation levels in URL conditions.

**Step 4**

Click **Add to Rule**, or drag and drop.
Step 5  (Optional) In an access control rule, add any URLs that you want to specify manually by entering a URL and clicking **Add**.

You can enter a URL or IP address. This field does not support wildcards.

Step 6  Save or continue editing the rule.

Example: URL Condition in an Access Control Rule

The following graphic shows the URL condition for an access control rule that blocks all malware sites, all high-risk sites, and all non-benign social networking sites. It also blocks a single site, example.com, which is represented by a URL object.

The following table summarizes how you build the condition.

<table>
<thead>
<tr>
<th>Blocked URL</th>
<th>Category or URL Object</th>
<th>Reputation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware sites, regardless of reputation</td>
<td>Malware Sites</td>
<td>Any</td>
</tr>
<tr>
<td>Any URL with a high risk (level 1)</td>
<td>Any</td>
<td>1 - High Risk</td>
</tr>
<tr>
<td>Social networking sites with a risk greater than benign (levels 1 through 3)</td>
<td>Social Network</td>
<td>3 - Benign sites with security risks</td>
</tr>
<tr>
<td>example.com</td>
<td>The URL object named example.com</td>
<td>None</td>
</tr>
</tbody>
</table>

What to do next

- If you are configuring an access control policy to filter by URL category, specify how to handle access to URLs that require cloud lookups. See information about the **Retry URL cache miss lookup** option in **Access Control Policy Advanced Settings**, on page 634.

- When you block web traffic, you can allow the user’s browser its default behavior, or you can display a generic system-provided or custom HTTP response page. Interactive blocking gives users a chance to bypass a website block by clicking through a warning page. For more information, see **HTTP Response Pages and Interactive Blocking**, on page 671.

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.
Rules with URL Conditions

The following table lists rules that support URL conditions, and the types of filtering that each rule type supports.

<table>
<thead>
<tr>
<th>Rule Type</th>
<th>Supports Cat. and Rep. Filtering?</th>
<th>Supports Manual Filtering?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access control</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>SSL</td>
<td>yes</td>
<td>no; use distinguished name conditions instead</td>
</tr>
</tbody>
</table>

URL Rule Order

For the most effective URL matching, place rules that include URL conditions before other rules, particularly if the URL rules are block rules and the other rules meet both of the following criteria:

- They include application conditions.
- The traffic to be inspected is encrypted.

Manual URL Filtering

In access control rules, you can supplement or selectively override category and reputation-based URL filtering by manually filtering individual URLs, groups of URLs, or URL lists and feeds.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>To filter a large number of URLs, use a URL list instead of individual or grouped URL objects. For more information, see Security Intelligence Lists and Feeds, on page 349.</td>
</tr>
</tbody>
</table>

You can perform this type of URL filtering without a special license. Manual URL filtering is not supported in SSL rules; instead, use distinguished name conditions.

For example, you might use access control to block a category of websites that are not appropriate for your organization. However, if the category contains a website that is appropriate, and to which you want to provide access, you can create a manual Allow rule for that site and place it before the Block rule for the category.

When manually filtering specific URLs, carefully consider other traffic that might be affected. To determine whether network traffic matches a URL condition, the system performs a simple substring match. If the requested URL matches any part of the string, the URLs are considered to match.

For example, if you allow all traffic to example.com, your users could browse to URLs including:

- http://example.com/
- http://example.com/newexample
- http://www.example.com/

As another example, consider a scenario where you want to explicitly block ign.com (a gaming site). However, substring matching means that blocking ign.com also blocks verisign.com, which might not be your intent.
Related Topics

Security Intelligence Lists and Feeds, on page 349
HTTP Response Pages and Interactive Blocking

The following topics describe how to configure custom pages to display when the system blocks web requests:

- About HTTP Response Pages, on page 671
- Choosing HTTP Response Pages, on page 672
- Interactive Blocking with HTTP Response Pages, on page 673

About HTTP Response Pages

As part of access control, you can configure an HTTP response page to display when the system blocks web requests, using either access control rules or the access control policy default action.

The response page displayed depends on how you block the session:

- **Block Response Page**: Overrides the default browser or server page that explains that the connection was denied.

- **Interactive Block Response Page**: Warns users, but also allows them to click a button (or refresh the page) to load the originally requested site. Users may have to refresh after bypassing the response page to load page elements that did not load.

If you do not choose a response page, the system blocks sessions without interaction or explanation.

Limitations to HTTP Response Pages

**Response Pages are for Access Control Rules/Default Action Only**

The system displays a response page only for unencrypted or decrypted HTTP/HTTPS connections blocked (or interactively blocked) either by access control rules or by the access control policy default action. The system does not display a response page for connections blocked or blacklisted by any other policy or mechanism.

**Displaying the Response Page Disables Connection Reset**

The system cannot display a response page if the connection is reset (RST packet sent). If you enable response pages, the system prioritizes that configuration. Even if you choose Block with reset or Interactive Block with reset as the rule action, the system displays the response page and does not reset matching web connections. To ensure that blocked web connections reset, you must disable response pages.
Note that all non-web traffic that matches the rule is blocked with reset.

**No Response Page for Encrypted Connections**
The system does not display a response page if the session is or was encrypted.

**No Response Page for “Promoted” Connections**
The system does not display a response page when web traffic is blocked as a result of a promoted access control rule (an early-placed blocking rule with only simple network conditions).

**No Response Page Before URL Identification**
The system does not display a response page when web traffic is blocked before the system identifies the requested URL; see Guidelines and Limitations for URL Filtering, on page 662.

## Choosing HTTP Response Pages

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Reliable display of HTTP response pages depends on your network configuration, traffic loads, and size of the page. Smaller pages are more likely to display successfully.

**Procedure**

**Step 1** In the access control policy editor, click the **HTTP Responses** tab.

If the controls are dimmed, settings are inherited from an ancestor policy, or you do not have permission to modify the configuration. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.

**Step 2** Choose the **Block Response Page** and **Interactive Block Response Page**:

- System-provided—Displays a generic response. Click the view icon (🔍) to view the code for this page.
- Custom—Create a custom response page. A pop-up window appears, prepopulated with system-provided code that you can replace or modify by clicking the edit icon (✍️). A counter shows how many characters you have used.
- None—Disables the response page and blocks sessions without interaction or explanation. To quickly disable interactive blocking for the whole access control policy, choose this option.

**Step 3** Click **Save** to save the policy.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Interactive Blocking with HTTP Response Pages

When you configure interactive blocking, users can load an originally requested site after reading a warning. Users may have to refresh after bypassing the response page to load page elements that did not load.

To quickly disable interactive blocking for the whole access control policy, display neither the system-provided page nor a custom page. The system then blocks all connections without interaction.

If a user does not bypass an interactive block, matching traffic is denied without further inspection. If a user bypasses an interactive block, the access control rule allows the traffic, although the traffic may still be subject to deep inspection and blocking.

By default, a user bypass is in effect for 10 minutes (600 seconds) without displaying the warning page on subsequent visits. You can set the duration to as long as a year, or you can force the user to bypass the block every time. This limit applies to every Interactive Block rule in the policy. You cannot set the limit per rule.

Logging options for interactively blocked traffic are identical to those in allowed traffic, but if a user does not bypass the interactive block, the system can log only beginning-of-connection events. When the system initially warns the user, it marks any logged beginning-of-connection event with the Interactive Block or Interactive Block with reset action. If the user bypasses the block, additional connection events logged for the session have an action of Allow.

Configuring Interactive Blocking

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin Access Admin Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1
As part of access control, configure an access control rule that matches web traffic; see Creating and Editing Access Control Rules, on page 646:

- Action—Set the rule action to Interactive Block or Interactive Block with reset; see Access Control Rule Interactive Blocking Actions, on page 650.
- Conditions—Use URL conditions to specify the web traffic to interactively block; see URL Conditions (URL Filtering), on page 305.
- Logging—Assume users will bypass the block and choose logging options accordingly; see Logging for Allowed Connections, on page 1589.
- Inspection—Assume users will bypass the block and choose deep inspection options accordingly; see Access Control Using Intrusion and File Policies, on page 653.

Step 2
(Optional) On the access control policy HTTP Responses tab, choose a custom interactive-block HTTP response page; see Choosing HTTP Response Pages, on page 672.
**Step 3**  
(Optional) On the access control policy **Advanced** tab, change the user bypass timeout; see **Setting the User Bypass Timeout for a Blocked Website**, on page 674.  
After a user bypasses a block, the system allows the user to browse to that page without warning until the timeout period elapses.

**Step 4**  
Save the access control policy.

**Step 5**  
Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

---

### Setting the User Bypass Timeout for a Blocked Website

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  
In the access control policy editor, click the **Advanced** tab.

**Step 2**  
Click the edit icon (-pencil) next to General Settings.

If a view icon (-eye) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.

**Step 3**  
In the **Allow an Interactive Block to bypass blocking for (seconds)** field, type the number of seconds that must elapse before the user bypass expires. Specifying zero forces your users to bypass the block every time.

**Step 4**  
Click **OK**.

**Step 5**  
Click **Save** to save the policy.

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.
CHAPTER 38

Security Intelligence Blacklisting

The following topics provide an overview of Security Intelligence, including use for blacklisting and whitelisting traffic and basic configuration.

- About Security Intelligence, on page 675
- Requirements for Security Intelligence, on page 676
- Guidelines for Security Intelligence, on page 676
- Configure Security Intelligence, on page 677
- Troubleshooting Security Intelligence, on page 680

About Security Intelligence

As an early line of defense against malicious internet content, Security Intelligence uses reputation intelligence to quickly block connections to or from IP addresses, URLs, and domain names. This is called Security Intelligence blacklisting.

Security Intelligence is the first phase of access control, before the system performs more resource-intensive evaluation. Blacklisting improves performance by quickly excluding traffic that does not require inspection.

Note

You cannot blacklist fastpathed traffic. 8000 Series fastpathing occurs before Security Intelligence filtering. Fastpathed traffic bypasses all further evaluation, including Security Intelligence.

Although you can configure custom blacklists, Cisco provides access to regularly updated intelligence feeds. Sites representing security threats such as malware, spam, botnets, and phishing appear and disappear faster than you can update and deploy custom configurations.

You can refine Security Intelligence blacklisting with whitelists and monitor-only blacklists. These mechanisms exempt traffic from being blacklisted, but do not automatically trust or fastpath matching traffic. Traffic whitelisted or monitored at the Security Intelligence stage is intentionally subject to further analysis with the rest of access control.

Related Topics

- Security Intelligence Lists and Feeds, on page 349
- Other Connections You Can Log, on page 1584
- Using Connection and Security Intelligence Event Tables, on page 1615
Requirements for Security Intelligence

If you want to whitelist, blacklist, or monitor specific IP addresses, URLs, or domain names, you must configure custom objects, lists, or feeds. You have the following options:

- To configure network, URL, or DNS feeds, see Creating Security Intelligence Feeds, on page 354.
- To configure network, URL, or DNS lists, see Updating Security Intelligence Lists, on page 356.
- To configure network objects and object groups, see Creating Network Objects, on page 326.
- To configure URL objects and object groups, see Creating URL Objects, on page 330.

Blacklisting, whitelisting, or monitoring traffic based on a DNS list or feed also requires that you:

- Create a DNS policy. See Creating Basic DNS Policies, on page 685 for more information.
- Configure DNS rules that reference your DNS lists or feeds. See Creating and Editing DNS Rules, on page 687 for more information.

Because you deploy the DNS policy as part of your access control policy, you must associate both policies. See DNS Policy Deploy, on page 694 for more information.

Guidelines for Security Intelligence

Security Intelligence strategies include using:

- Cisco-provided feeds—Cisco provides access to regularly updated intelligence feeds. Sites representing security threats such as malware, spam, botnets, and phishing appear and disappear faster than you can update and deploy custom configurations.
- Third-party feeds—Supplement Cisco-provided feeds with third-party reputation feeds, which are dynamic lists that the Firepower Management Center downloads from the internet on a regular basis.
- Global and custom blacklists—Blacklist specific IP addresses, URLs, or domain names. To improve performance, you may want to target enforcement, for example, restricting spam blacklisting to a security zone that handles email traffic.
- Whitelists to eliminate false positives—When a blacklist is too broad in scope, or preemptively blocks traffic that you want to further analyze with the rest of access control, you can override a blacklist with a custom whitelist.
- Monitoring instead of blacklisting—Especially useful in passive deployments and for testing feeds before you implement them; you can merely monitor and log the violating sessions instead of blocking them, generating end-of-connection events.

In passive deployments, to optimize performance, we recommend that you use monitor-only settings. Managed devices that are deployed passively cannot affect traffic flow; there is no advantage to configuring the system to block traffic. Additionally, because blocked connections are not actually blocked in passive deployments, the system may report multiple beginning-of-connection events for each blocked connection.
Example: Whitelisting

If a reputable feed improperly blocks your access to vital resources but is overall useful to your organization, you can whitelist only the improperly classified IP addresses, rather than removing the whole feed from the blacklist.

Example: Security Intelligence by Zone

You can whitelist an improperly classified URL, but then restrict the whitelist object using a security zone used by those in your organization who need to access those URLs. That way, only those with a business need can access the whitelisted URLs. Or, you could use a third-party spam feed to blacklist traffic on an email server security zone.

Example: Monitor-Only Blacklisting

Consider a scenario where you want to test a third-party feed before you implement blocking using that feed. When you set the feed to monitor-only, the system allows connections that would have been blocked to be further analyzed by the system, but also logs a record of each of those connections for your evaluation.

Configure Security Intelligence

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network/Network/ Admin</td>
</tr>
</tbody>
</table>

Each access control policy has Security Intelligence options. You can whitelist or blacklist network objects, URL objects and lists, and Security Intelligence feeds and lists, all of which you can constrain by security zone. You can also associate a DNS policy with your access control policy, and whitelist or blacklist domain names.

The number of objects in the whitelists plus the number in the blacklists cannot exceed 255 network objects, or 32767 URL objects and lists.

Note

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.
From the Security Intelligence tab in an access control policy, adding multiple objects to a whitelist or blacklist, or deleting multiple objects, sometimes restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information. Note that whether the Snort process restarts can vary by device, depending on the memory available for inspection.

Before you begin

In passive deployments, or if you want to set Security Intelligence filtering to monitor-only, enable logging; see Logging Connections with Security Intelligence, on page 1591.

Procedure

Step 1

In the access control policy editor, click the Security Intelligence tab.

If the controls are dimmed, settings are inherited from an ancestor policy, or you do not have permission to modify the configuration. If the configuration is unlocked, uncheck Inherit from base policy to enable editing.

Step 2

You have the following options:

• Click the Networks tab to add network objects.
• Click the URLs tab to add URL objects.

Step 3

Find the Available Objects you want to add to the whitelist or blacklist. You have the following options:

• Search the available objects by typing in the Search by name or value field. Clear the search string by clicking reload (⟳) or clear (×).

• If no existing list or feed meets your needs, click the add icon (✚), select New Network List or New URL List, and proceed as described in Creating Security Intelligence Feeds, on page 354 or Uploading New Security Intelligence Lists to the Firepower Management Center, on page 355.

• If no existing object meets your needs, click the add icon (✚), select New Network Object or New URL Object, and proceed as described in Creating Network Objects, on page 326.

Security Intelligence ignores IP address blocks using a /0 netmask.

Step 4

Choose one or more Available Objects to add.

Step 5

(Optional) Choose an Available Zone to constrain the selected objects by zone.

You cannot constrain system-provided Security Intelligence lists by zone.

Step 6

Click Add to Whitelist or Add to Blacklist, or click and drag the selected objects to either list.

To remove an object from a whitelist or blacklist, click its delete icon (🗑️) To remove multiple objects, choose the objects and right-click to Delete Selected.

Step 7

(Optional) Set blacklisted objects to monitor-only by right-clicking the object under Blacklist, then choosing Monitor-only (do not block).
You cannot set system-provided Security Intelligence lists to monitor only.

**Step 8**
Choose a DNS policy from the **DNS Policy** drop-down list; see **DNS Policy Overview**, on page 683.

**Step 9**
Click **Save**.

---

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

**Related Topics**

- **Security Intelligence Lists and Feeds**, on page 349
- **Snort® Restart Scenarios**, on page 279

---

**Security Intelligence Options**

Use the Security Intelligence tab in the access control policy editor to configure network (IP address) and URL Security Intelligence, and to associate the access control policy with a DNS policy.

**Object, Zone, and Blacklist Icons**

On the Security Intelligence tab of the access control policy editor, each type of object or zone is distinguished with a different icon.

In the blacklist, objects set to block are marked with the block icon (❌) while monitor-only objects are marked with the monitor icon (🔧). Monitor-only allows the system to handle connections involving blacklisted IP addresses and URLs using access control, but also logs the connection’s match to the blacklist.

Because the whitelist overrides the blacklist, if you add the same object to both lists, the system displays the blacklisted object with a strikethrough.

**Zone Constraints**

Except for the system-provided Global lists, you can constrain Security Intelligence filtering by zone. To enforce Security Intelligence filtering for an object on multiple zones, you must add the object to the whitelist or blacklist separately for each zone.

**Logging**

Security Intelligence logging, enabled by default, logs all blocked and monitored connections handled by an access control policy’s target devices. However, the system does not log whitelist matches; logging of whitelisted connections depends on their eventual disposition. You must enable logging for blacklisted connections before you can set blacklisted objects to monitor-only.

**Security Intelligence Categories**

<table>
<thead>
<tr>
<th>Security Intelligence Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attacker</td>
<td>Active scanners and blacklisted hosts known for outbound malicious activity</td>
</tr>
<tr>
<td>Security Intelligence Category</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Bogon</td>
<td>Bogon networks and unallocated IP addresses</td>
</tr>
<tr>
<td>Bots</td>
<td>Sites that host binary malware droppers</td>
</tr>
<tr>
<td>CnC</td>
<td>Sites that host command-and-control servers for botnets</td>
</tr>
<tr>
<td>Dga</td>
<td>Malware algorithms used to generate a large number of domain names acting as rendezvous points with their command-and-control servers</td>
</tr>
<tr>
<td>Exploitkit</td>
<td>Software kits designed to identify software vulnerabilities in clients</td>
</tr>
<tr>
<td>Malware</td>
<td>Sites that host malware binaries or exploit kits</td>
</tr>
<tr>
<td>OpenProxy</td>
<td>Open proxies that allow anonymous web browsing</td>
</tr>
<tr>
<td>OpenRelay</td>
<td>Open mail relays that are known to be used for spam</td>
</tr>
<tr>
<td>Phishing</td>
<td>Sites that host phishing pages</td>
</tr>
<tr>
<td>Response</td>
<td>IP addresses and URLs that are actively participating in malicious or suspicious activity</td>
</tr>
<tr>
<td>Spam</td>
<td>Mail hosts that are known for sending spam</td>
</tr>
<tr>
<td>Suspicious</td>
<td>Files that appear to be suspicious and have characteristics that resemble known malware</td>
</tr>
<tr>
<td>TorExitNode</td>
<td>Tor exit nodes</td>
</tr>
</tbody>
</table>

Related Topics

- Blacklist Now, Whitelist Now, and Global Lists, on page 350
- Security Intelligence Lists and Multitenancy, on page 351

Troubleshooting Security Intelligence

Troubleshooting Memory Use

**Symptoms:** Connections that should be blacklisted by Security Intelligence are instead evaluated by access control rules. The Security Intelligence health module alerts that it is out of memory.

**Cause:** Memory limitations. Cisco Intelligence Feeds are based on the latest threat intelligence from Cisco Talos Security Intelligence and Research Group (Talos). These feeds tend to get larger as time passes. When a Firepower device receives a feed update, it loads as many entries as it can into the memory it has allocated for Security Intelligence. When a device cannot load all the entries, it may not block traffic as expected. Some connections that should be blacklisted instead continue to be evaluated by access control rules.

**Affected platforms:** Lower-memory devices are most likely to have this issue, especially if you blacklist a lot of Security Intelligence categories or are also filtering URLs based on category and reputation. These
devices include Firepower 7010, 7020, and 7030; ASA 5506-X, 5508-X, 5516-X, 5512-X, 5515-X, and 5525-X; NGIPSv.

Workaround: If you think this is happening, redeploy configurations to the affected devices. This can allocate more memory to Security Intelligence. If the issue persists, contact Cisco Technical Assistance Center (TAC), who can help you verify the issue and propose a solution appropriate to your deployment.
DNS Policies

The following topics explain DNS policies, DNS rules, and how to deploy DNS policies to managed devices.

- DNS Policy Overview, on page 683
- DNS Policy Components, on page 683
- DNS Rules, on page 687
- DNS Policy Deploy, on page 694

DNS Policy Overview

DNS-based Security Intelligence allows you to whitelist or blacklist traffic based on the domain name requested by a client. Cisco provides domain name intelligence you can use to filter your traffic; you can also configure custom lists and feeds of domain names tailored to your deployment.

Traffic blacklisted by a DNS policy is immediately blocked and therefore is not subject to any further inspection—not for intrusions, exploits, malware, and so on, but also not for network discovery. You can override blacklisting with whitelisting to force access control rule evaluation, and, recommended in passive deployments, you can use a “monitor-only” setting for Security Intelligence filtering. This allows the system to analyze connections that would have been blacklisted, but also logs the match to the blacklist and generates an end-of-connection Security Intelligence event.

Note

DNS-based Security Intelligence may not work as intended for a domain name unless the DNS server deletes a domain cache entry due to expiration, or a client’s DNS cache or the local DNS server’s cache is cleared or expires.

You configure DNS-based Security Intelligence using a DNS policy and associated DNS rules. To deploy it to your devices, you must associate your DNS policy with an access control policy, then deploy your configuration to managed devices.

DNS Policy Components

A DNS policy allows you to whitelist or blacklist connections based on domain name. The following list describes the configurations you can change after creating a DNS policy.
Name and Description

Each DNS policy must have a unique name. A description is optional.

In a multidomain deployment, policy names must be unique within the domain hierarchy. The system may identify a conflict with the name of a policy you cannot view in your current domain.

Rules

Rules provide a granular method of handling network traffic based on the domain name. Rules in a DNS policy are numbered, starting at 1. The system matches traffic to DNS rules in top-down order by ascending rule number.

When you create a DNS policy, the system populates it with a default Global DNS Whitelist rule and a default Global DNS Blacklist rule. Both rules are fixed to the first position in their respective categories. You cannot modify these rules, but you can disable them.

In a multidomain deployment, the system also adds Descendant DNS Whitelists and Descendant DNS Blacklists rules to DNS policies in ancestor domains. These rules are fixed to the second position in their respective categories.

Note

If multitenancy is enabled for your Firepower Management Center, the system is organized into a hierarchy of domains, including ancestor and descendant domains. These domains are distinct and separate from the domain names used in DNS management.

A descendant list contains the domains whitelisted or blacklisted by Firepower System subdomain users. From an ancestor domain, you cannot view the contents of descendant lists. If you do not want subdomain users to whitelist or blacklist domains:

• disable the descendant list rules, and
• enforce Security Intelligence using the access control policy inheritance settings

The system evaluates rules in the following order:

• Global DNS Whitelist rule (if enabled)
• Descendant DNS Whitelists rule (if enabled)
• Whitelist rules
• Global DNS Blacklist rule (if enabled)
• Descendant DNS Blacklists rule (if enabled)
• Blacklist and Monitor rules

Usually, the system handles DN-based network traffic according to the first DNS rule where all the rule’s conditions match the traffic. If no DNS rules match the traffic, the system continues evaluating the traffic based on the associated access control policy's rules. DNS rule conditions can be simple or complex.
Creating Basic DNS Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Choose Policies > Access Control > DNS.
**Step 2** Click Add DNS Policy.
**Step 3** Give the policy a unique Name and, optionally, a Description.
**Step 4** Click Save.

What to do next

- Optionally, further configure the new policy as described in Logging Connections with Security Intelligence, on page 1591.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Editing DNS Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Only one person should edit a DNS policy at a time, using a single browser window. If multiple users attempt to save the same policy, only the first set of saved changes are retained.

To protect the privacy of your session, after thirty minutes of inactivity on the policy editor, a warning appears. After sixty minutes, the system discards your changes.

Procedure

**Step 1** Choose Policies > Access Control > DNS.
**Step 2** Click the edit icon (📝) next to the DNS policy you want to edit.

If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
**Step 3** Edit your DNS policy:
• Name and Description—To change the name or description, click the field and type the new information.

• Rules—To add, categorize, enable, disable, or otherwise manage DNS rules, click the Rules tab and proceed as described in Creating and Editing DNS Rules, on page 687.

**Step 4**

Click Save.

---

**What to do next**

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**Managing DNS Policies**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Use the DNS Policy page (Policies > Access Control > DNS) to manage custom DNS policies. In addition to custom policies that you create, the system provides the Default DNS Policy, which uses the default blacklist and whitelist. You can edit and use this system-provided custom policy. In a multidomain deployment, this default policy uses the default Global DNS Blacklist, Global DNS Whitelist, Descendant DNS Blacklists, and Descendant DNS Whitelists, and can only be edited in the Global domain.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

**Procedure**

**Step 1**

Choose Policies > Access Control > DNS.

**Step 2**

Manage your DNS policy:

• Compare—To compare DNS policies, click Compare Policies and proceed as described in Comparing Policies, on page 284.

• Copy—To copy a DNS policy, click the copy icon ( ) and proceed as described in Editing DNS Policies, on page 685.

• Create—To create a new DNS policy, click Add DNS Policy and proceed as described in Creating Basic DNS Policies, on page 685.

• Delete—To delete a DNS policy, click the delete icon ( ), then confirm you want to delete the policy.

• Edit—To modify an existing DNS policy, click the edit icon ( ) and proceed as described in Editing DNS Policies, on page 685.
DNS Rules

DNS rules handle traffic based on the domain name requested by a host. As part of Security Intelligence, this evaluation happens after any traffic decryption, and before access control evaluation.

The system matches traffic to DNS rules in the order you specify. In most cases, the system handles network traffic according to the first DNS rule where all the rule’s conditions match the traffic. When you create DNS rules, the system places whitelist rules before monitor and blacklist rules, and evaluates traffic against whitelist rules first.

In addition to its unique name, each DNS rule has the following basic components:

State
By default, rules are enabled. If you disable a rule, the system does not use it to evaluate network traffic, and stops generating warnings and errors for that rule.

Position
Rules in a DNS policy are numbered, starting at 1. The system matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.

Conditions
Conditions specify the specific traffic the rule handles. A DNS rule must contain a DNS feed or list condition, and can also match traffic by security zone, network, or VLAN.

Action
A rule’s action determines how the system handles matching traffic:

- Whitelisted traffic is allowed, subject to further access control inspection.
- Monitored traffic is subject to further evaluation by remaining DNS blacklist rules. If the traffic does not match a DNS blacklist rule, it is inspected with access control rules. The system logs a Security Intelligence event for the traffic.
- Blacklisted traffic is dropped without further inspection. You can also return a Domain Not Found response, or redirect the DNS query to a sinkhole server.

Related Topics
About Security Intelligence, on page 675

Creating and Editing DNS Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Firepower Management Center Configuration Guide, Version 6.0
In a DNS policy, you can add up to a total of 32767 DNS lists to the whitelist and blacklist rules; that is, the number of lists in the DNS policy cannot exceed 32767.

Procedure

Step 1 In the DNS policy editor, you have the following options:
  • To add a new rule, click Add DNS Rule.
  • To edit an existing rule, click the edit icon (✏).

Step 2 Enter a Name.

Step 3 Configure the rule components, or accept the defaults:
  • Action—Choose a rule Action; see DNS Rule Actions, on page 689.
  • Conditions—Configure the rule’s conditions; see DNS Rule Conditions, on page 691.
  • Enabled—Specify whether the rule is Enabled.

Step 4 Click Save.

What to do next
  • Deploy configuration changes; see Deploy Configuration Changes, on page 277.

DNS Rule Management

The Rules tab of the DNS policy editor allows you to add, edit, move, enable, disable, delete, and otherwise manage DNS rules within your policy.

For each rule, the policy editor displays its name, a summary of its conditions, and the rule action. Other icons represent warnings (⚠️), errors (😱), and other important information (ℹ️). Disabled rules are dimmed and marked (disabled) beneath the rule name.

Enabling and Disabling DNS Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you create a DNS rule, it is enabled by default. If you disable a rule, the system does not use it to evaluate network traffic and stops generating warnings and errors for that rule. When viewing the list of rules in a DNS policy, disabled rules are dimmed, although you can still modify them. Note that you can also enable or disable a DNS rule using the DNS rule editor.
**Procedure**

**Step 1**  
In the DNS policy editor, right-click the rule and choose a rule state.

**Step 2**  
Click Save.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**DNS Rule Order Evaluation**

Rules in a DNS policy are numbered, starting at 1. The system matches traffic to DNS rules in top-down order by ascending rule number. In most cases, the system handles network traffic according to the first DNS rule where all the rule’s conditions match the traffic:

- For Monitor rules, the system logs the traffic, then continues evaluating traffic against lower-priority DNS blacklist rules.
- For non-Monitor rules, the system does not continue to evaluate traffic against additional, lower-priority DNS rules after that traffic matches a rule.

Note the following regarding rule order:

- The Global Whitelist is always first, and takes precedence over all other rules.
- The Descendant DNS Whitelists rule only appears in multidomain deployments, in non-leaf domains. It is always second, and takes precedence over all other rules except the Global Whitelist.
- The Whitelist section precedes the Blacklist section; whitelist rules always take precedence over other rules.
- The Global Blacklist is always first in the Blacklist section, and takes precedence over all other Monitor and blacklist rules.
- The Descendant DNS Blacklists rule only appears in multidomain deployments, in non-leaf domains. It is always second in the Blacklist section, and takes precedence over all other Monitor and blacklist rules except the Global Blacklist.
- The Blacklist section contains Monitor and blacklist rules.
- When you first create a DNS rule, the system positions it last in the Whitelist section if you assign a Whitelist action, or last in the Blacklist section if you assign any other action.

You can drag and drop rules to reorder them.

---

**DNS Rule Actions**

Every DNS rule has an action that determines the following for matching traffic:

- handling—foremost, the rule action governs whether the system will whitelist, monitor, or blacklist traffic that matches the rule’s conditions
• logging—the rule action determines when and how you can log details about matching traffic

Keep in mind that only devices deployed inline can blacklist traffic. Devices deployed passively or in tap mode can whitelist and log, but not affect, traffic.

**Whitelist Action**

The Whitelist action allows matching traffic to pass. When you whitelist traffic, it is subject to further inspection either by a matching access control rule, or the access control policy’s default action.

The system does not log whitelist matches. However, logging of whitelisted connections depends on their eventual disposition.

**Monitor Action**

The Monitor action does not affect traffic flow; matching traffic is neither immediately whitelisted nor blacklisted. Rather, traffic is matched against additional rules to determine whether to permit or deny it. The first non-Monitor DNS rule matched determines whether the system blacklists the traffic. If there are no additional matching rules, the traffic is subject to access control evaluation.

For connections monitored by a DNS policy, the system logs end-of-connection Security Intelligence and connection events to the Firepower Management Center database.

**Blacklist Actions**

The blacklist actions blacklist traffic without further inspection of any kind:

- The Drop action drops the traffic.
- The Domain Not Found action returns a non-existent internet domain response to the DNS query, which prevents the client from resolving the DNS request.
- The Sinkhole action returns a sinkhole object's IPv4 or IPv6 address in response to the DNS query. The sinkhole server can log, or log and block, follow-on connections to the IP address. If you configure a Sinkhole action, you must also configure a sinkhole object.

For a connection blacklisted based on the Drop or Domain Not Found actions, the system logs beginning-of-connection Security Intelligence and connection events. Because blacklisted traffic is immediately denied without further inspection, there is no unique end of connection to log.

For a connection blacklisted based on the Sinkhole action, logging depends on the sinkhole object configuration. If you configure your sinkhole object to only log sinkhole connections, the system logs end-of-connection connection events for the follow-on connection. If you configure your sinkhole object to log and block sinkhole connections, the system logs beginning-of-connection connection events for the follow-on connection, then blocks that connection.

---

**Note**

On an ASA FirePOWER device, if you configure a DNS rule with a sinkhole action, and traffic matches the rule, the ASA blocks the follow-on sinkhole connection by default. As a workaround, run the following commands from the ASA command line:

```
asa(config)# policy-map global_policy
asa(config-pmap)# class inspection_default
asa(config-pmap-c)# no inspect dns preset_dns_map
```

If the ASA continues to block the connection, contact Support.
DNS Rule Conditions

A DNS rule’s conditions identify the type of traffic that rule handles. Conditions can be simple or complex. You must define a DNS feed or list condition within a DNS rule. You can also optionally control traffic by security zone, network, or VLAN.

When adding conditions to a DNS rule:

• If you do not configure a particular condition for a rule, the system does not match traffic based on that criterion.

• You can configure multiple conditions per rule. Traffic must match all the conditions in the rule for the rule to apply to traffic. For example, a rule with a DNS feed or list condition and network condition but no VLAN tag condition evaluates traffic based on the domain name and source or destination, regardless of any VLAN tagging in the session.

• For each condition in a rule, you can add up to 50 criteria. Traffic that matches any of a condition’s criteria satisfies the condition. For example, you can use a single rule to blacklist traffic based on up to 50 DNS lists and feeds.

Controlling Traffic Based on DNS and Security Zone

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Zone conditions in DNS rules allow you to control traffic by its source and destination security zones. A security zone is a grouping of one or more interfaces, which may be located across multiple devices. An option you choose during a device’s initial setup, called its detection mode, determines how the system initially configures the device’s interfaces, and whether those interfaces belong to a security zone.

Procedure

Step 1 In the DNS rule editor, click the Zones tab.

Step 2 Find and select the zones you want to add from the Available Zones. To search for zones to add, click the Search by name prompt above the Available Zones list, then type a zone name. The list updates as you type to display matching zones.

Step 3 Click to select a zone, or right-click and then select Select All.

Step 4 Click Add to Source, or drag and drop.

Step 5 Save or continue editing the rule.
Controlling Traffic Based on DNS and Network

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
</tbody>
</table>

Network conditions in DNS rules allow you to control traffic by its source IP address. You can explicitly specify the source IP addresses for the traffic you want to control.

Procedure

**Step 1** In the DNS rule editor, click the **Networks** tab.

**Step 2** Find and select the networks you want to add from the **Available Networks**, as follows:

- To add a network object on the fly, which you can then add to the condition, click the add icon (.addButton) above the **Available Networks** list and proceed as described in Creating Network Objects, on page 326.
- To search for network objects to add, click the **Search by name or value** prompt above the **Available Networks** list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects.

**Step 3** Click **Add to Source**, or drag and drop.

**Step 4** Add any source IP addresses or address blocks that you want to specify manually. Click the **Enter an IP address** prompt below the **Source Networks** list; then type an IP address or address block and click **Add**.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

**Step 5** Save or continue editing the rule.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Controlling Traffic Based on DNS and VLAN

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
</tbody>
</table>
VLAN conditions in DNS rules allow you to control VLAN-tagged traffic. The system uses the innermost VLAN tag to identify a packet by VLAN.

When you build a VLAN-based DNS rule condition, you can manually specify VLAN tags. Alternately, you can configure VLAN conditions with VLAN tag objects, which are reusable and associate a name with one or more VLAN tags.

**Procedure**

**Step 1**
In the DNS rule editor, select the **VLAN Tags** tab.

**Step 2**
Find and select the VLANs you want to add from the **Available VLAN Tags**, as follows:

- To add a VLAN tag object on the fly, which you can then add to the condition, click the add icon (+) above the Available VLAN Tags list and proceed as described in Creating VLAN Tag Objects, on page 329.

- To search for VLAN tag objects and groups to add, click the **Search by name or value** prompt above the **Available VLAN Tags** list, then type either the name of the object, or the value of a VLAN tag in the object. The list updates as you type to display matching objects.

**Step 3**
Click **Add to Rule**, or drag and drop.

**Step 4**
Add any VLAN tags that you want to specify manually. Click the **Enter a VLAN Tag** prompt below the **Selected VLAN Tags** list; then type a VLAN tag or range and click **Add**. You can specify any VLAN tag from 1 to 4094; use a hyphen to specify a range of VLAN tags.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal VLAN tags to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

**Step 5**
Save or continue editing the rule.

**What to do next**
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Controlling Traffic Based on DNS List, Feed, or Category**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

DNS conditions in DNS rules allow you to control traffic if a DNS list, feed, or category contains the domain name requested by the client. You must define a DNS condition in a DNS rule.

Regardless of whether you add a global or custom whitelist or blacklist to a DNS condition, the system applies the configured rule action to the traffic. For example, if you add the Global Whitelist to a rule, and configure a Drop action, the system blacklists all traffic that should have been whitelisted.
**Procedure**

**Step 1**  
In the DNS rule editor, click the **DNS** tab.

**Step 2**  
Find and select the DNS lists and feeds you want to add from the **DNS Lists and Feeds**, as follows:

- To add a DNS list or feed on the fly, which you can then add to the condition, click the add icon (.addButton) above the **DNS Lists and Feeds** list and proceed as described in *Creating Security Intelligence Feeds*, on page 354.

- To search for DNS lists, feeds, or categories to add, click the **Search by name or value** prompt above the **DNS Lists and Feeds** list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects.

**Step 3**  
Click **Add to Rule**, or drag and drop.

**Step 4**  
Save or continue editing the rule.

**What to do next**

- Deploy configuration changes; see *Deploy Configuration Changes*, on page 277.

**DNS Policy Deploy**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

After you finish updating your DNS policy configuration, you must deploy it as part of access control configuration.

- Associate your DNS policy with an access control policy, as described in *Configure Security Intelligence*, on page 677.

- Deploy configuration changes; see *Deploy Configuration Changes*, on page 277.
Intelligent Application Bypass

The following topics describe how to configure access control polices to use Intelligent Application Bypass (IAB)

- Introduction to IAB, on page 695
- IAB Options, on page 696
- Configuring IAB, on page 698
- IAB Logging and Analysis, on page 699

Introduction to IAB

IAB identifies applications that you trust to traverse your network without further inspection if performance and flow thresholds are exceeded. For example, if a nightly backup significantly impacts system performance, you can configure thresholds that, if exceeded, trust traffic generated by your backup application. Optionally, you can configure IAB so that, when an inspection performance threshold is exceeded, IAB trusts all traffic that exceeds any flow bypass threshold, regardless of the application type. This option requires Version 6.0.1.4 or a subsequent 6.0.1.x patch.

The system implements IAB on traffic allowed by access control rules or the access control policy's default action, before the traffic is subject to deep inspection. A test mode allows you to determine whether thresholds are exceeded and, if so, to identify the application flows that would have been bypassed if you had actually enabled IAB (called bypass mode).

The following graphic illustrates the IAB decision-making process:
**IAB Options**

**State**
Enables or disables IAB.

**Performance Sample Interval**
Specifies the time in seconds between IAB performance sampling scans, during which the system collects system performance metrics for comparison to IAB performance thresholds. A value of 0 disables IAB.

**Bypassable Applications and Filters**
This feature provides two mutually exclusive options:
Applications/Filters
Provides an editor where you can specify bypassable applications and sets of applications (filters). See Application Conditions (Application Control), on page 298.

All applications including unidentified applications
When an inspection performance threshold is exceeded, trusts all traffic that exceeds any flow bypass threshold, regardless of the application type. This option requires Version 6.0.1.4 or a subsequent 6.0.1.x patch.

Performance and Flow Thresholds
You must configure at least one inspection performance threshold and one flow bypass threshold. When a performance threshold is exceeded, the system examines flow thresholds and, if one threshold is exceeded, trusts the specified traffic. If you enable more than one of either, only one of each must be exceeded.

Inspection performance thresholds provide intrusion inspection performance limits that, if exceeded, trigger the inspection of flow thresholds. IAB does not use inspection performance thresholds set to 0. You can configure one or more of the following inspection performance thresholds:

Drop Percentage
Average packets dropped as a percentage of total packets, when packets are dropped because of performance overloads caused by expensive intrusion rules, file policies, decompression, and so on. This does not refer to packets dropped by normal configurations such as intrusion rules. Note that specifying an integer greater than 1 activates IAB when the specified percentage of packets is dropped. When you specify 1, any percentage from 0 through 1 activates IAB. This allows a small number of packets to activate IAB.

Processor Utilization Percentage
Average percentage of processor resources used.

Package Latency
Average packet latency in microseconds.

Flow Rate
The rate at which the system processes flows, measured as the number of flows per second. Note that this option configures IAB to measure flow rate, not flow count.

Flow bypass thresholds provide flow limits that, if exceeded, trigger IAB to trust bypassable application traffic in bypass mode or allow application traffic subject to further inspection in test mode. IAB does not use flow bypass thresholds set to 0. You can configure one or more of the following flow bypass thresholds:

Bytes per Flow
The maximum number of kilobytes a flow can include.

Packets per Flow
The maximum number of packets a flow can include.

Flow Duration
The maximum number of seconds a flow can remain open.

Flow Velocity
The maximum transfer rate in kilobytes per second.
Configuring IAB

Not all deployments require IAB, and those that do might use it in a limited fashion. Do not enable IAB unless you have expert knowledge of your network traffic, especially application traffic, and system performance, including the causes of predictable performance issues. Before you run IAB in bypass mode, make sure that trusting the specified traffic does not expose you to risk.

### Procedure

**Step 1**
In the access control policy editor, click the **Advanced** tab, then click the edit icon (edit) next to **Intelligent Application Bypass Settings**.

If a view icon (view) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.

**Step 2**
Configure IAB options:
- **State**—Turn IAB **Off** or **On**, or enable IAB in **Test** mode.
- **Performance Sample Interval**—Enter the time in seconds between IAB performance-sampling scans. If you enable IAB, even in test mode, enter a non-zero value. Entering 0 disables IAB.
- **Bypassable Applications and Filters**—Choose from:
  - Click the number of bypassed applications and filters and specify the applications whose traffic you want to bypass; see Configuring Application Conditions and Filters, on page 300.
  - Click **All applications including unidentified applications** so that, when an inspection performance threshold is exceeded, IAB trusts all traffic that exceeds any flow bypass threshold, regardless of the application type. This option requires Version 6.0.1.4 or a subsequent 6.0.1.x patch.
  - Inspection Performance Thresholds—Click **Configure** and enter at least one threshold value.
  - Flow Bypass Thresholds—Click **Configure** and enter at least one threshold value.

You must specify at least one inspection performance threshold and one flow bypass threshold; both must be exceeded for IAB to trust traffic. If you enter more than one threshold of each type, only one of each type must be exceeded. For detailed information, see IAB Options, on page 696.

**Step 3**
Click **OK** to save IAB settings.

**Step 4**
Click **Save** to save the policy.
IAB Logging and Analysis

IAB forces an end-of-connection event that logs bypassed flows and flows that would have been bypassed, regardless of whether you have enabled connection logging. Connection events indicate flows that are bypassed in bypass mode or that would have been bypassed in test mode. Custom dashboard widgets and reports based on connection events can display long-term statistics for bypassed and would-have-bypassed flows.

**IAB Connection Events**

**Action**

When **Reason** includes **Intelligent App Bypass**:

- **Allow** - indicates that the applied IAB configuration was in test mode and traffic for the application specified by **Application Protocol** remains available for inspection.

- **Trust** - indicates that the applied IAB configuration was in bypass mode and traffic for the application specified by **Application Protocol** has been trusted to traverse the network without further inspection.

**Reason**

**Intelligent App Bypass** indicates that IAB triggered the event in bypass or test mode.

**Application Protocol**

This field displays the application protocol that triggered the event.

**Example**

In the following truncated graphic, some fields are omitted. The graphic shows the **Action**, **Reason**, and **Application Protocol** fields for two connection events resulting from different IAB settings in two separate access control policies.

For the first event, the **Trust** action indicates that IAB was enabled in bypass mode andBonjour protocol traffic was trusted to pass without further inspection.

For the second event, the **Allow** action indicates that IAB was enabled in test mode, so Ubuntu Update Manager traffic was subject to further inspection but would have been bypassed if IAB had been in bypass mode.
Example

In the following truncated graphic, some fields are omitted. The flow in the second event was both bypassed (Action: Trust; Reason: Intelligent App Bypass) and inspected by an intrusion rule (Reason: Intrusion Monitor). The Intrusion Monitor reason indicates that an intrusion rule set to Generate Events detected but did not block an exploit during the connection. In the example, this happened before the application was detected. After the application was detected, IAB recognized the application as bypassable and trusted the flow.

![Example Table]

IAB Custom Dashboard Widgets

You can create a Custom Analysis dashboard widget to display long-term IAB statistics based on connection events. Specify the following when creating the widget:

- **Preset**: None
- **Table**: Application Statistics
- **Field**: any
- **Aggregate**: either of:
  - IAB Bypassed Connections
  - IAB Would Bypass Connections
- **Filter**: any

Examples

In the following Custom Analysis dashboard widget examples:

- The *Bypassed* example shows statistics for application traffic bypassed because the applications were specified as bypassable and IAB was enabled in bypass mode in the deployed access control policy.

- The *Would Have Bypassed* example shows statistics for application traffic that would have been bypassed because the applications were specified as bypassable and IAB was enabled in test mode in the deployed access control policy.
IAB Custom Reports

You can create a custom report to display long-term IAB statistics based on connection events. Specify the following when creating the report:

- **Table**: Application Statistics
- **Preset**: None
- **Filter**: any
- **X-Axis**: any
- **Y-Axis**: either of:
  - IAB Bypassed Connections
  - IAB Would Bypass Connections

Examples

The following graphic shows two abbreviated report examples:

- The *Bypassed* example shows statistics for application traffic bypassed because the applications were specified as bypassable and IAB was enabled in bypass mode in the deployed access control policy.

- The *Would Have Bypassed* example shows statistics for application traffic that would have been bypassed because the applications were specified as bypassable and IAB was enabled in test mode in the deployed access control policy.
Related Topics

Connection and Security Intelligence Event Fields, on page 1597
The Custom Analysis Widget, on page 202
Adding Widgets to a Dashboard, on page 212
Report Templates, on page 1426
PART XI

Encrypted Traffic Handling

• Understanding Traffic Decryption, on page 705
• Start Creating SSL Policies, on page 729
• Get Started with TLS/SSL Rules, on page 737
• Decryption Tuning Using TLS/SSL Rules, on page 755
• Troubleshoot TLS/SSL Rules, on page 785
Understanding Traffic Decryption

The following topics provide an overview of Transport Layer Security/Secure Sockets Layer (TLS/SSL) inspection, discuss the prerequisites for TLS/SSL inspection configuration, and detail deployment scenarios.

Because TLS and SSL are often used interchangeably, we use the expression \textit{TLS/SSL} to indicate that either protocol is being discussed. The SSL protocol has been deprecated by the IETF in favor of the more secure TLS protocol, so you can usually interpret \textit{TLS/SSL} as referring to TLS only.

The exception is SSL policies. Because the FMC configuration option is Policies > Access Control > SSL, we use the term \textit{SSL policies} although these policies are used to define rules for TLS and SSL traffic.

For more information about SSL and TLS protocols, see a resource such as SSL vs. TLS - What's the Difference?.

About Traffic Decryption

By default, the Firepower System cannot inspect traffic encrypted with the Secure Socket Layer (SSL) protocol or its successor, the Transport Layer Security (TLS) protocol. \textit{TLS/SSL inspection} enables you to either block encrypted traffic without inspecting it, or inspect encrypted or decrypted traffic with access control. As the system handles encrypted sessions, it logs details about the traffic. The combination of inspecting encrypted traffic and analyzing encrypted session data allows greater awareness and control of the encrypted applications and traffic in your network.

TLS/SSL inspection is a policy-based feature. In the Firepower System, an access control policy is a master configuration that invokes subpolicies and other configurations, including an SSL policy. If you associate an SSL policy with access control, the system uses that SSL policy to handle encrypted sessions before it evaluates them with access control rules. If you do not configure TLS/SSL inspection, or your devices do not support it, access control rules handle all encrypted traffic.

Note that access control rules also handle encrypted traffic when your TLS/SSL inspection configuration allows it to pass. However, some access control rule conditions require unencrypted traffic, so encrypted traffic might match fewer rules. Also, by default, the system disables intrusion and file inspection of encrypted traffic.
payloads. This helps reduce false positives and improves performance when an encrypted connection matches an access control rule that has intrusion and file inspection configured.

If the system detects a TLS/SSL handshake over a TCP connection, it determines whether it can decrypt the detected traffic. If it cannot, it applies a configured action:

- Block the encrypted traffic
- Block the encrypted traffic and reset the TCP connection
- Not decrypt the encrypted traffic

If the system can decrypt the traffic, it blocks the traffic without further inspection, evaluates undecrypted traffic with access control, or decrypts it using one of the following methods:

- Decrypt with a known private key. When an external host initiates a TLS/SSL handshake with a server on your network, the system matches the exchanged server certificate with a server certificate previously uploaded to the system. It then uses the uploaded private key to decrypt the traffic.
- Decrypt by resigning the server certificate. When a host on your network initiates a TLS/SSL handshake with an external server, the system resigns the exchanged server certificate with a previously uploaded certificate authority (CA) certificate. It then uses the uploaded private key to decrypt the traffic.

Decrypted traffic is subject to the same traffic handling and analysis as originally unencrypted traffic: network, reputation, and user-based access control; intrusion detection and prevention; Cisco Advanced Malware Protection (Cisco AMP); and discovery. If the system does not block the decrypted traffic post-analysis, it re-encrypts the traffic before passing it to the destination host.

Note: Set up decrypt rules only if your managed device handles encrypted traffic. Decryption rules require processing overhead that can impact performance.

### TLS/SSL Best Practices

This section discusses information you should keep in mind when creating your decryption policies and rules.

**Note:** Because TLS and SSL are often used interchangeably, we use the expression **TLS/SSL** to indicate that either protocol is being discussed. The SSL protocol has been deprecated by the IETF in favor of the more secure TLS protocol, so you can usually interpret **TLS/SSL** as referring to TLS only.

The exception is SSL policies. Because the FMC configuration option is **Policies > Access Control > SSL**, we use the term **SSL policies** although these policies are used to define rules for TLS and SSL traffic.

For more information about SSL and TLS protocols, see a resource such as [SSL vs. TLS - What's the Difference?](#).

**Related Topics**
- The Case for Decryption, on page 707
- When to Decrypt Traffic, When Not to Decrypt, on page 707
- Other TLS/SSL Rule Actions, on page 709
The Case for Decryption

Only decrypted traffic takes advantage of the Firepower System's threat defense and policy enforcement features. Traffic that is encrypted when it passes through the Firepower System can be allowed or blocked only but it cannot be subjected to deep inspection or the full range of policy enforcement (such as intrusion prevention).

All encrypted connections are:

- Sent through the TLS/SSL decryption policy to determine if they should be decrypted or blocked.
  
  You can also configure TLS/SSL decryption rules to block encrypted traffic of types you know you do not want on your network, such as traffic that uses the unsecure SSL protocol or traffic with an expired or invalid certificate.

- Any unblocked connections, whether or not decrypted, then go through the access control policy for a final allow or block decision.

Keep in mind that decrypting and then re-encrypting traffic adds a processing load on the device, which can reduce overall system performance.

In summary:

- Encrypted traffic can be allowed or blocked by policy; encrypted traffic cannot be inspected

- Decrypted traffic is subject to threat defense and policy enforcement; decrypted traffic can be allowed or blocked by policy

Related Topics

About Deep Inspection, on page 653

When to Decrypt Traffic, When Not to Decrypt

This section provides guidelines on when you should decrypt traffic and when you should allow it to pass through the firewall encrypted.

When not to decrypt traffic

You should not decrypt traffic if doing so is forbidden by:

- Law; for example, some jurisdictions forbid decrypting financial information

- Company policy; for example, your company might forbid decrypting privileged communications

- Privacy regulations

- Traffic that uses certificate pinning (also referred to as TLS/SSL pinning) must remain encrypted to prevent breaking the connection

If you elect to bypass decryption for certain types of traffic, no processing is done on the traffic. The encrypted traffic is first evaluated by SSL policy and then proceeds to the access control policy, where a final allow or
Encrypted traffic can be allowed or blocked on any TLS/SSL rule condition, including, but not limited to:

- Certificate status (for example, expired or invalid certificate)
- Protocol (for example, the unsecure SSL protocol)
- Network (security zone, IP address, VLAN tag, and so on)
- Exact URL or URL category
- Port
- User group

SSL policies provide a Do Not Decrypt action for this traffic; for more information, see TLS/SSL Rule Do Not Decrypt Action, on page 751.

The related information links at the end of this topic explain how some aspects of rule evaluation work. Conditions such as URL and application filtering have limitations with respect to encrypted traffic. Make sure you understand those limitations.

**When to decrypt traffic**

All encrypted traffic must be decrypted to take advantage of the Firepower System's threat protection and policy enforcement features. To the extent your managed device allows traffic to be decrypted (subject to its memory and processing power), you should decrypt traffic that is not protected by law or regulation. If you must decide what traffic to decrypt, base your decision on the risk of allowing the traffic on your network.

The Firepower System provides a flexible framework for classifying traffic using rule conditions, which include URL reputation, cipher suite, protocol, and many other factors.

The Firepower System provides two methods of decryption, which are discussed in the following sections.

**Related Topics**

- Decrypt and Resign (Outgoing Traffic), on page 708
- Known Key Decryption (Incoming Traffic), on page 709
- TLS/SSL Rule Guidelines and Limitations, on page 737
- SSL Rule Order, on page 315
- URL Conditions (URL Filtering), on page 305
- Application Rule Order, on page 314

**Decrypt and Resign (Outgoing Traffic)**

The Decrypt - Resign TLS/SSL rule action enables the Firepower System to act as a man in the middle, intercepting, decrypting, and (if the traffic is allowed) inspecting, and re-encrypting it. The Decrypt - Resign rule action is used with outgoing traffic; that is, the destination server is outside your protected network.

The FTD device negotiates with the client using the Certificate Authority (CA) certificate specified in the rule and builds an SSL tunnel between the client and the FTD device. At the same time, the device connects to the destination web site and creates an SSL tunnel between the server and the FTD device.
Thus, the client sees the CA certificate configured for the SSL decryption rule instead of the certificate from the destination server. The client must trust the certificate to complete the connection. The FTD device then performs decryption/re-encryption in both directions for traffic between the client and the destination server.

**Prerequisite**

To use the **Decrypt - Resign** rule action, you must have a CA certificate file and paired private key file. You can generate a CA and private key in the Firepower System if you don't already have them.

**Related Topics**

- [TLS/SSL Rule Decrypt Actions](#), on page 752
- [External Certificate Objects](#), on page 374

## Known Key Decryption (Incoming Traffic)

The **Decrypt - Known Key** TLS/SSL rule action uses a server's private key to decrypt traffic. The **Decrypt - Known Key** rule action is used with incoming traffic; that is, the destination server is inside your protected network.

The main purpose of decrypting with a known key is to protect your servers from external attacks.

**Prerequisite**

To use the **Decrypt - Known Key** rule action, you must have the server’s certificate file and paired private key file.

**Related Topics**

- [TLS/SSL Rule Decrypt Actions](#), on page 752
- [Internal Certificate Objects](#), on page 375

## Other TLS/SSL Rule Actions

The following sections discuss other TLS/SSL rule actions.

**Related Topics**

- [TLS/SSL Rule Blocking Actions](#), on page 751
- [TLS/SSL Rule Monitor Action](#), on page 750

## TLS/SSL Rule Examples

The following sections provide examples of setting up recommended TLS/SSL rules.

**Related Topics**

- [Block Unsecure Protocols](#), on page 709

### Block Unsecure Protocols

This example shows how to block the following unsecure TLS/SSL protocols on your network:

- TLS 1.0
- SSLv3
- SSLv2
You should exclude these unsecure protocols from your network because they are all exploitable. You can block TLS 1.0 and SSLv3 using the **Version** tab page on the SSL rule. Because the Firepower System considers SSLv2 as undecryptable, you can block it using the **Undecryptable Actions** on the SSL policy.

**Procedure**

**Step 1** Log in to the Firepower Management System if you have not already done so.

**Step 2** Click **Policies > Access Control > SSL**.

**Step 3** Add or edit an SSL policy.

**Step 4** Click **Add Rule**.

**Step 5** In the **Name** field, enter a name for the rule.

**Step 6** From the **Action** list, click **Block** or **Block with reset**.

**Step 7** Click the **Version** tab page.

**Step 8** Check the **SSLv3.0** and **TLS 1.0** checkboxes. Clear the other check boxes.

The following figure shows an example.

**Step 9** Choose other rule conditions as needed.

**Step 10** Save the rule.

**Step 11** On the SSL policy page, click **Undecryptable Actions**.

**Step 12** From the **SSLv2 Session** list, click **Block** or **Block with reset**. The following figure shows an example.

**Step 13** Click **Save**.
Step 14

Because this is a specific rule, order it earlier in your policy than more general rules such as application-matching rules.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

TLS/SSL Rule Conditions, on page 748

TLS/SSL Rule Components

Each TLS/SSL rule has the following components.

State

By default, rules are enabled. If you disable a rule, the system does not use it to evaluate network traffic, and stops generating warnings and errors for that rule.

Position

Rules in an SSL policy are numbered, starting at 1. The system matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.

Conditions

Conditions specify the specific traffic the rule handles. Conditions can match traffic by security zone, network or geographical location, VLAN, port, application, requested URL, user, certificate, certificate subject or issuer, certificate status, cipher suite, or encryption protocol version. The use of conditions can depend on target device licenses.

Action

A rule’s action determines how the system handles matching traffic. You can monitor, allow, block, or decrypt encrypted matching traffic. Decrypted and allowed encrypted traffic is subject to further inspection. Note that the system does not perform inspection on blocked encrypted traffic.

Logging

A rule’s logging settings govern the records the system keeps of the traffic it handles. You can keep a record of traffic that matches a rule. You can log a connection when the system blocks an encrypted session or allows it to pass without decryption, according to the settings in an SSL policy. You can also force the system to log connections that it decrypts for further evaluation by access control rules, regardless of how the system later handles or inspects the traffic. You can log connections to the Firepower Management Center database, as well as to the system log (syslog) or to an SNMP trap server.

For more information about logging, see Best Practices for Connection Logging.
Properly creating and ordering TLS/SSL rules is a complex task. If you do not plan your policy carefully, rules can preempt other rules, require additional licenses, or contain invalid configurations. To help ensure that the system handles traffic as you expect, the SSL policy interface has a robust warning and error feedback system for rules.

Tip

Related Topics
- Security Zone Conditions, on page 293
- Network Conditions, on page 294
- VLAN Conditions, on page 296
- Port and ICMP Code Conditions, on page 296
- Application Conditions (Application Control), on page 298
- URL Conditions (URL Filtering), on page 305
- User, Realm, and ISE Attribute Conditions (User Control), on page 305
- Rule Performance Guidelines, on page 311

TLS/SSL Rule Order Evaluation

When you create the TLS/SSL rule in an SSL policy, you specify its position using the Insert list in the rule editor. TLS/SSL rules in an SSL policy are numbered, starting at 1. The system matches traffic to TLS/SSL rules in top-down order by ascending rule number.

In most cases, the system handles network traffic according to the first TLS/SSL rule where all the rule’s conditions match the traffic. Except in the case of Monitor rules (which log traffic but do not affect traffic flow), the system does not continue to evaluate traffic against additional, lower-priority rules after that traffic matches a rule. Conditions can be simple or complex; you can control traffic by security zone, network or geographical location, VLAN, port, application, requested URL, user, certificate, certificate distinguished name, certificate status, cipher suite, or encryption protocol version.

Each rule also has an action, which determines whether you monitor, block, or inspect matching encrypted or decrypted traffic with access control. Note that the system does not further inspect encrypted traffic it blocks. It does subject encrypted and unencryptable traffic to access control. However, access control rules require unencrypted traffic, so encrypted traffic matches fewer rules.

Rules that use specific conditions (such as network and IP addresses) should be ordered before rules that use general conditions (such as applications). If you’re familiar with the Open Systems Interconnect (OSI) model, use similar numbering in concept. Rules with conditions for layers 1, 2, and 3 (physical, data link, and network) should be ordered first in your rules. Conditions for layers 5, 6, and 7 (session, presentation, and application) should be ordered later in your rules. For more information about the OSI model, see this Wikipedia article.

Tip

Proper TLS/SSL rule order reduces the resources required to process network traffic, and prevents rule preemption. Although the rules you create are unique to every organization and deployment, there are a few general guidelines to follow when ordering rules that can optimize performance while still addressing your needs.

In addition to ordering rules by number, you can group rules by category. By default the system provides three categories: Administrator, Standard, and Root. You can add custom categories, but you cannot delete the system-provided categories or change their order.
Multi-Rule Example

The following scenario summarizes the ways that SSL rules handle traffic in an inline deployment.

In this scenario, traffic is evaluated as follows:

- **Undecryptable Traffic Action** evaluates encrypted traffic first. For traffic the system cannot decrypt, the system either blocks it without further inspection or passes it for access control inspection. Encrypted traffic that does not match continues to the next rule.

- **TLS/SSL Rule 1: Monitor** evaluates encrypted traffic next. Monitor rules track and log encrypted traffic but do not affect traffic flow. The system continues to match traffic against additional rules to determine whether to permit or deny it.
TLS/SSL Rule 2: Do Not Decrypt evaluates encrypted traffic third. Matching traffic is not decrypted; the system inspects this traffic with access control, but not file or intrusion inspection. Traffic that does not match continues to the next rule.

TLS/SSL Rule 3: Block evaluates encrypted traffic fourth. Matching traffic is blocked without further inspection. Traffic that does not match continues to the next rule.

TLS/SSL Rule 4: Decrypt - Known Key evaluates encrypted traffic fifth. Matching traffic incoming to your network is decrypted using a private key you upload. The decrypted traffic is then evaluated against access control rules. Access control rules handle decrypted and unencrypted traffic identically. The system can block traffic as a result of this additional inspection. All remaining traffic is reencrypted before being allowed to the destination. Traffic that does not match the SSL rule continues to the next rule.

TLS/SSL Rule 5: Decrypt - Resign is the final rule. If traffic matches this rule, the system re-signs the server certificate with an uploaded CA certificate, then acts as a man-in-the-middle to decrypt traffic. The decrypted traffic is then evaluated against access control rules. Access control rules treat decrypted and unencrypted traffic identically. The system can block traffic as a result of this additional inspection. All remaining traffic is reencrypted before being allowed to the destination. Traffic that does not match the SSL rule continues to the next rule.

SSL Policy Default Action handles all traffic that does not match any of the TLS/SSL rules. The default action either blocks encrypted traffic without further inspection or does not decrypt it, passing it for access control inspection.

### TLS/SSL Inspection Appliance Deployment Scenarios

This section presents several scenarios in which the Life Insurance Example, Inc. life insurance company (LifeIns) uses SSL inspection on encrypted traffic to help audit their processes. Based on their business processes, LifeIns plans to deploy:

- one 7000 or 8000 Series device in a passive deployment for the Customer Service department
- one 7000 or 8000 Series device in an inline deployment for the Underwriting Department
- one Firepower Management Center to manage both devices

**Customer Service Business Processes**

LifeIns created a customer-facing website for their customers. LifeIns receives encrypted questions and requests regarding policies from prospective customers through their website and through e-mail. LifeIns’s Customer Service department processes them and returns the requested information within 24 hours. Customer Service wants to expand its incoming contact metrics collection. LifeIns has an established internal audit review for Customer Service.

LifeIns also receives encrypted applications online. The Customer Service department processes the applications within 24 hours before sending the case file to the Underwriting department. Customer Service filters out any obvious false applications sent through the online form, which consumes a fair portion of their time.

**Underwriting Business Processes**

LifeIns’s underwriters submit encrypted medical information requests online to the Medical Repository Example, LLC medical data repository (MedRepo). MedRepo reviews the requests and transmits the encrypted
records to LifeIns within 72 hours. The underwriters subsequently underwrite an application and submit policy and rate decisions. Underwriting wants to expand its metrics collection.

Lately, an unknown source has been sending spoofed responses to LifeIns. Though LifeIns’s underwriters receive training on proper Internet use, LifeIns’s IT department first wants to analyze all encrypted traffic that takes the form of medical responses, then wants to block all spoof attempts.

LifeIns places junior underwriters on six-month training periods. Lately, these underwriters have been incorrectly submitting encrypted medical regulation requests to MedRepo’s customer service department. MedRepo has submitted multiple complaints to LifeIns in response. LifeIns plans on extending their new underwriter training period to also audit underwriter requests to MedRepo.

**Traffic Decryption in a Passive Deployment**

LifeIns’s business requirements state that Customer Service must:

• process all requests and applications within 24 hours

• improve its incoming contact metrics collection process

• identify and discard incoming false applications

Customer Service does not require additional audit review.

LifeIns plans to passively deploy a Customer Service managed device.

Traffic from an external network goes to LifeIns’s router. The router routes traffic to the Customer Service department, and mirrors a copy of the traffic to the managed device for inspection.

On the managing Firepower Management Center, a user in the access control configures TLS/SSL inspection to:

• log all encrypted traffic sent to the Customer Service department

• decrypt encrypted traffic sent using the online application form to Customer Service

• not decrypt all other encrypted traffic sent to Customer service, including traffic sent using the online request form

The user also configures access control to inspect the decrypted application form traffic for fake application data and log when fake data is detected.
In the following scenarios, the user submits an online form to Customer Service. The user’s browser establishes a TCP connection with the server, then initiates a TLS/SSL handshake. The managed device receives a copy of this traffic. The client and server complete the TLS/SSL handshake, establishing the encrypted session. Based on handshake and connection details, the system logs the connection and acts upon the copy of the encrypted traffic.

**Encrypted Traffic Monitoring in a Passive Deployment**

For all TLS/SSL-encrypted traffic sent to Customer Service, the managed device logs the connection.

The following steps occur:

1. The user submits the plain text request *(info)*. The client encrypts this *(AaBb)* and sends the encrypted traffic to Customer Service.

2. LifeIn's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the managed device.

3. The Customer Service department server receives the encrypted information request *(AaBb)* and decrypts it to plain text *(info)*.

4. The managed device does not decrypt the traffic.

   The access control policy continues to process the encrypted traffic and allows it. The device generates a connection event after the session ends.

5. The Firepower Management Center receives the connection event.

**Undecrypted Encrypted Traffic in a Passive Deployment**

For all TLS/SSL-encrypted traffic that contains requests about policies, the managed device allows the traffic without decrypting it and logs the connection.
The following steps occur:

1. The user submits the plaintext request (info). The client encrypts this (AaBb) and sends the encrypted traffic to Customer Service.

2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the managed device.

3. The Customer Service department server receives the encrypted information request (AaBb) and decrypts it to plaintext (info).

4. The managed device does not decrypt the traffic.
   The access control policy continues to process the encrypted traffic and allows it. The device generates a connection event after the session ends.

5. The Firepower Management Center receives the connection event.

**Encrypted Traffic Inspection with a Private Key in a Passive Deployment**

For all TLS/SSL-encrypted traffic that contains application form data, the system decrypts the traffic and logs the connection.

---

**Note**

In a passive deployment, if traffic is encrypted with either the DHE or ECDHE cipher suite, you cannot decrypt it with a known private key.

For traffic with legitimate application form information, the system logs the connection.
The following steps occur:

1. The user submits the plain text request (form). The client encrypts this (AaBb) and sends the encrypted traffic to Customer Service.

2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the managed device.

3. The Customer Service department server receives the encrypted information request (AaBb) and decrypts it to plain text (form).

4. The managed device uses the session key obtained with the uploaded known private key to decrypt the encrypted traffic to plain text (form).

   The access control policy continues to process the decrypted traffic and does not find fake application information. The device generates a connection event after the session ends.

5. The Firepower Management Center receives a connection event with information about the encrypted and decrypted traffic.

In contrast, if the decrypted traffic contains fake application data, the system logs the connection and the fake data.
The following steps occur:

1. The user submits the plain text request (fake). The client encrypts this (CcDd) and sends the encrypted traffic to Customer Service.

2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the managed device.

3. The Customer Service department server receives the encrypted information request (CcDd) and decrypts it to plain text (fake).

4. The managed device uses the session key obtained with the uploaded known private key to decrypt the encrypted traffic to plain text (fake).

   The access control policy continues to process the decrypted traffic and finds fake application information. The device generates an intrusion event. After the session ends, it generates a connection event.

5. The Firepower Management Center receives a connection event with information about the encrypted and decrypted traffic, and an intrusion event for the fake application data.

**Traffic Decryption in an Inline Deployment**

LifeIns's business requirements state that Underwriting must:

- audit new and junior underwriters, verifying that their information requests to MedRepo comply with all applicable regulations
- improve its underwriting metrics collection process
- examine all requests that appear to come from MedRepo, then drop any spoofing attempts
- drop all improper regulatory requests to MedRepo's Customer Service department from the Underwriting department
- not audit senior underwriters

LifeIns plans to deploy a device in an inline deployment for the Underwriting department.
Traffic from MedRepo’s network goes to MedRepo’s router. It routes traffic to LifeIns’s network. The managed device receives the traffic, passes allowed traffic to LifeIns’s router, and sends events to the managing Firepower Management Center. LifeIns’s router routes traffic to the destination host.

On the managing Firepower Management Center, a user in the Access Control and SSL Editor custom role configures an SSL access control rule to:

- log all encrypted traffic sent to the Underwriting department
- block all encrypted traffic incorrectly sent from LifeIns’s underwriting department to MedRepo’s customer service department
- decrypt all encrypted traffic sent from MedRepo to LifeIns’s underwriting department, and from LifeIns’s junior underwriters to MedRepo’s requests department
- not decrypt encrypted traffic sent from the senior underwriters

The user also configures access control to inspect decrypted traffic with a custom intrusion policy and:

- block decrypted traffic if it contains a spoof attempt, and log the spoof attempt
- block decrypted traffic that contains information not compliant with regulations, and log the improper information
- allow all other encrypted and decrypted traffic

The system reencrypts allowed decrypted traffic before sending it to the destination host.

In the following scenarios, the user submits information online to a remote server. The user’s browser establishes a TCP connection with the server, then initiates an SSL handshake. The managed device receives this traffic; based on handshake and connection details, the system logs the connection and acts on the traffic. If the system blocks the traffic, it also closes the TCP connection. Otherwise, the client and server complete the SSL handshake, establishing the encrypted session.

**Encrypted Traffic Monitoring in an Inline Deployment**

For all SSL-encrypted traffic sent to and from the Underwriting department, the system logs the connection.
The following steps occur:

1. The user submits the plain text request (**help**). The client encrypts this (**AaBb**) and sends the encrypted traffic to MedRepo’s Requests department server.

2. LifeIns’s router receives the encrypted traffic and routes it to the Requests department server.

3. The managed device does not decrypt the traffic.
   - The access control policy continues to process the encrypted traffic and allows it, then generates a connection event after the session ends.

4. The external router receives the traffic and routes it to the Requests department server.

5. The Underwriting department server receives the encrypted information request (**AaBb**) and decrypts it to plain text (**help**).

6. The Firepower Management Center receives the connection event.

**Undecrypted Encrypted Traffic in an Inline Deployment**

For all TLS/SSL-encrypted traffic originating from the senior underwriters, the managed device allows the traffic without decrypting it and logs the connection.
The following steps occur:

1. The user submits the plain text request (help). The client encrypts this (AaBb) and sends the encrypted traffic to MedRepo’s Requests department server.

2. LifeIns’s router receives the encrypted traffic and routes it to the Requests department server.

3. The managed device does not decrypt this traffic.
   
   The access control policy continues to process the encrypted traffic and allows it, then generates a connection event after the session ends.

4. The external router receives the traffic and routes it to the Requests department server.

5. The Requests department server receives the encrypted information request (AaBb) and decrypts it to plain text (help).

6. The Firepower Management Center receives the connection event.

**Encrypted Traffic Blocking in an Inline Deployment**

For all SMTPS email traffic improperly sent from LifeIns’s underwriting department to MedRepo’s Customer Service department, the system blocks the traffic during the SSL handshake without further inspection and logs the connection.
The following steps occur:

1. Having received the request to establish a TLS/SSL handshake from a client’s browser, the Customer Service department server sends the server certificate (cert) as the next step in the TLS/SSL handshake to the LifeIns underwriter.

2. MedRepo’s router receives the certificate and routes it to the LifeIns underwriter.

3. The managed device blocks the traffic without further inspection and ends the TCP connection. It generates a connection event.

4. The internal router does not receive the blocked traffic.

5. The underwriter does not receive the blocked traffic.

6. The Firepower Management Center receives the connection event.

**Encrypted Traffic Inspection with a Private Key in an Inline Deployment**

For all TLS/SSL-encrypted traffic sent from MedRepo to LifeIns’s underwriting department, the system uses an uploaded server private key to obtain session keys, then decrypts the traffic and logs the connection. Legitimate traffic is allowed and reencrypted before being sent to the Underwriting department.
The following steps occur:

1. The user submits the plain text request (stats). The client encrypts this (AaBbC) and sends the encrypted traffic to the Underwriting department server.

2. The external router receives the traffic and routes it to the Underwriting department server.

3. The managed device uses the session key obtained with the uploaded known private key to decrypt this traffic to plain text (stats).

   The access control policy continues to process the decrypted traffic with the custom intrusion policy and does not find a spoof attempt. The device passes the encrypted traffic (AaBbC), then generates a connection event after the session ends.

4. The internal router receives the traffic and routes it to the Underwriting department server.

5. The Underwriting department server receives the encrypted information (AaBbC) and decrypts it to plain text (stats).

6. The Firepower Management Center receives the connection event with information about the encrypted and decrypted traffic.

In contrast, any decrypted traffic that is a spoof attempt is dropped. The system logs the connection and the spoof attempt.
The following steps occur:

1. The user submits the plain text request (spoof), altering the traffic to appear to originate from MedRepo, LLC. The client encrypts this (FfGgH) and sends the encrypted traffic to the Underwriting department server.

2. The managed device uses the session key obtained with the uploaded known private key to decrypt this traffic to plain text (spoof).

   The access control policy continues to process the decrypted traffic with the custom intrusion policy and finds a spoof attempt. The device blocks the traffic, then generates an intrusion event. It generates a connection event after the session ends.

3. The internal router does not receive the blocked traffic.

4. The Underwriting department server does not receive the blocked traffic.

5. The Firepower Management Center receives a connection event with information about the encrypted and decrypted traffic, and an intrusion event for the spoofing attempt.

**Encrypted Traffic Inspection with a Re-signed Certificate in an Inline Deployment**

For all TLS/SSL-encrypted traffic sent from the new and junior underwriters to MedRepo’s requests department, the system uses a re-signed server certificate to obtain session keys, then decrypts the traffic and logs the connection. Legitimate traffic is allowed and reencrypted before being sent to MedRepo.

---

**Note**

When decrypting traffic in an inline deployment by re-signing the server certificate, the device acts as a man-in-the-middle. It creates two TLS/SSL sessions, one between client and managed device, one between managed device and server. As a result, each session contains different cryptographic session details.
The following steps occur:

1. The user submits the plain text request (help). The client encrypts this (AaBb) and sends the encrypted traffic to the Requests department server.

2. The internal router receives the traffic and routes it to the Requests department server.

3. The managed device uses the session key obtained with a re-signed server certificate and private key to decrypt this traffic to plain text (help).

   The access control policy continues to process the decrypted traffic with the custom intrusion policy and does not find an improper request. The device reencrypts the traffic (CcDd), allowing it to pass. It generates a connection event after the session ends.

4. The external router receives the traffic and routes it to the Requests department server.

5. The Requests department server receives the encrypted information (CcDd) and decrypts it to plain text (help).

6. The Firepower Management Center receives the connection event with information about the encrypted and decrypted traffic.

---

**Note**

Traffic encrypted with a re-signed server certificate causes client browsers to warn that the certificate is not trusted. To avoid this, add the CA certificate to the organization’s domain root trusted certificates store or the client trusted certificates store.

In contrast, any decrypted traffic that contains information that does not meet regulatory requirements is dropped. The system logs the connection and the non-conforming information.
The following steps occur:

1. The user submits the plain text request (regs), which does not comply with regulatory requirements. The client encrypts this (EeFf) and sends the encrypted traffic to the Requests department server.

2. The internal router receives the traffic and routes it to the Requests department server.

3. The managed device uses the session key obtained with a re-signed server certificate and private key to decrypt this traffic to plain text (regs).

   The access control policy continues to process the decrypted traffic with the custom intrusion policy and finds an improper request. The device blocks the traffic, then generates an intrusion event. It generates a connection event after the session ends.

4. The external router does not receive the blocked traffic.

5. The Requests department server does not receive the blocked traffic.

6. The Firepower Management Center receives a connection event with information about the encrypted and decrypted traffic, and an intrusion event for the improper request.

### History for TLS/SSL

<table>
<thead>
<tr>
<th>Feature</th>
<th>Version</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extended Master Secret extension supported</td>
<td>6.3.0.1</td>
<td>The TLS Extended Master Secret extension is supported for SSL policies; specifically, policies with a rule action of Decrypt - Resign or Decrypt - Known Key.</td>
</tr>
<tr>
<td>(see RFC 7627)</td>
<td>6.2.3.9</td>
<td>The TLS Extended Master Secret extension is supported for SSL policies; specifically, policies with a rule action of Decrypt - Resign or Decrypt - Known Key.</td>
</tr>
</tbody>
</table>
Start Creating SSL Policies

The following topics provide an overview of SSL policy creation, configuration, management, and logging.

- SSL Policies Overview, on page 729
- SSL Policy Default Actions, on page 730
- Default Handling Options for Undecryptable Traffic, on page 731
- Manage SSL Policies, on page 732
- Create Basic SSL Policies, on page 733
- Set Default Handling for Undecryptable Traffic, on page 733
- Editing an SSL Policy, on page 735

SSL Policies Overview

An SSL policy determines how the system handles encrypted traffic on your network. You can configure one or more SSL policies, associate an SSL policy with an access control policy, then deploy the access control policy to a managed device. When the device detects a TCP handshake, the access control policy first handles and inspects the traffic. If it subsequently identifies a TLS/SSL-encrypted session over the TCP connection, the SSL policy takes over, handling and decrypting the encrypted traffic.

Caution

Adding or removing an SSL policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

The simplest SSL policy, as shown in the following diagram, directs the device where it is deployed to handle encrypted traffic with a single default action. You can set the default action to block decryptable traffic without further inspection, or to inspect undecrypted decryptable traffic with access control. The system can then either allow or block the encrypted traffic. If the device detects undecryptable traffic, it either blocks the traffic without further inspection or does not decrypt it, inspecting it with access control.
A more complex SSL policy can handle different types of undecryptable traffic with different actions, control traffic based on whether a certificate authority (CA) issued or trusts the encryption certificate, and use SSL rules to exert granular control over encrypted traffic logging and handling. These rules can be simple or complex, matching and inspecting encrypted traffic using multiple criteria.

Because TLS and SSL are often used interchangeably, we use the expression TLS/SSL to indicate that either protocol is being discussed. The SSL protocol has been deprecated by the IETF in favor of the more secure TLS protocol, so you can usually interpret TLS/SSL as referring to TLS only.

The exception is SSL policies. Because the FMC configuration option is Policies > Access Control > SSL, we use the term SSL policies although these policies are used to define rules for TLS and SSL traffic.

For more information about SSL and TLS protocols, see a resource such as SSL vs. TLS - What's the Difference?.

**Note**

Because TLS and SSL are often used interchangeably, we use the expression TLS/SSL to indicate that either protocol is being discussed. The SSL protocol has been deprecated by the IETF in favor of the more secure TLS protocol, so you can usually interpret TLS/SSL as referring to TLS only.

The exception is SSL policies. Because the FMC configuration option is Policies > Access Control > SSL, we use the term SSL policies although these policies are used to define rules for TLS and SSL traffic.

For more information about SSL and TLS protocols, see a resource such as SSL vs. TLS - What's the Difference?.

### SSL Policy Default Actions

The default action for an SSL policy determines how the system handles decryptable encrypted traffic that does not match any non-monitor rule in the policy. When you deploy an SSL policy that does not contain any TLS/SSL rules, the default action determines how all decryptable traffic on your network is handled. Note that the system does not perform any kind of inspection on encrypted traffic blocked by the default action.

<table>
<thead>
<tr>
<th>Default Action</th>
<th>Effect on Encrypted Traffic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block</td>
<td>Block the TLS/SSL session without further inspection.</td>
</tr>
<tr>
<td>Block with reset</td>
<td>Block the TLS/SSL session without further inspection and reset the TCP connection. Choose this option if traffic uses a connectionless protocol like UDP. In that case, the connectionless protocol tries to reestablish the connection until it is reset. This action also displays a connection reset error in the browser so the user is informed that the connection is blocked.</td>
</tr>
<tr>
<td>Do not decrypt</td>
<td>Inspect the encrypted traffic with access control.</td>
</tr>
</tbody>
</table>
# Default Handling Options for Undecryptable Traffic

**Table 72: Undecryptable Traffic Types**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Default Action</th>
<th>Available Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compressed Session</td>
<td>The TLS/SSL session applies a data compression method.</td>
<td>Inherit default action</td>
<td>Do not decrypt</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block with reset</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Inherit default action</td>
</tr>
<tr>
<td>SSLv2 Session</td>
<td>The session is encrypted with SSL version 2.</td>
<td>Inherit default action</td>
<td>Do not decrypt</td>
</tr>
<tr>
<td></td>
<td>Note that traffic is decryptable if the ClientHello message is SSL 2.0, and the remainder of the transmitted traffic is SSL 3.0.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block with reset</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Inherit default action</td>
</tr>
<tr>
<td>Unknown Cipher Suite</td>
<td>The system does not recognize the cipher suite.</td>
<td>Inherit default action</td>
<td>Do not decrypt</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block with reset</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Inherit default action</td>
</tr>
<tr>
<td>Unsupported Cipher Suite</td>
<td>The system does not support decryption based on the detected cipher suite.</td>
<td>Inherit default action</td>
<td>Do not decrypt</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block with reset</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Inherit default action</td>
</tr>
<tr>
<td>Session not cached</td>
<td>The TLS/SSL session has session reuse enabled, the client and server reestablished the session with the session identifier, and the system did not cache that session identifier.</td>
<td>Inherit default action</td>
<td>Do not decrypt</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block with reset</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Inherit default action</td>
</tr>
<tr>
<td>Handshake Errors</td>
<td>An error occurred during TLS/SSL handshake negotiation.</td>
<td>Inherit default action</td>
<td>Do not decrypt</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block with reset</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Inherit default action</td>
</tr>
<tr>
<td>Decryption Errors</td>
<td>An error occurred during traffic decryption.</td>
<td>Block</td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Block with Reset</td>
</tr>
</tbody>
</table>
When you first create an SSL policy, logging connections that are handled by the default action is disabled by default. Because the logging settings for the default action also apply to undecryptable traffic handling, logging connections handled by the undecryptable traffic actions is disabled by default.

Note that if your browser uses certificate pinning to verify a server certificate, you cannot decrypt this traffic by re-signing the server certificate.

Manage SSL Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

In the SSL policy editor, you can:

- Configure your policy.
- Add, edit, delete, enable, disable, and organize TLS/SSL rules.
- Add trusted CA certificates.
- Determine the handling for encrypted traffic the system cannot decrypt.
- Log traffic that is handled by the default action and undecryptable traffic actions.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

Procedure

**Step 1** Choose **Policies > Access Control > SSL**.

**Step 2** Manage SSL policies:

- Associate—To associate an SSL policy with an access control policy, see Associating Other Policies with Access Control, on page 636.
- Compare—Click **Compare Policies**; see Comparing Policies, on page 284.
- Copy—Click the copy icon (COPY).  
- Create—Click **New Policy**; see Create Basic SSL Policies, on page 733.
- Delete—Click the delete icon (DELETE). If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
- Deploy—Click **Deploy**; see Deploy Configuration Changes, on page 277.
- Edit—Click the edit icon (EDIT); see Editing an SSL Policy, on page 735. If a view icon (VIEW) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
Create Basic SSL Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

To configure an SSL policy, you must give the policy a unique name and specify a default action.

Procedure

1. Choose Policies > Access Control > SSL.
2. Click New Policy.
3. Give the policy a unique Name and, optionally, a Description.
4. Specify the Default Action; see SSL Policy Default Actions, on page 730.
5. Configure logging options for the default action as described in Logging Connections with a Policy Default Action, on page 1593.
6. Click Save.

What To Do Next

- Configure rules to add to your SSL policy; see Creating and Modifying TLS/SSL Rules, on page 744.
- Set the default handling for undecryptable traffic; see Set Default Handling for Undecryptable Traffic, on page 733.
- Configure logging options for default handling of undecryptable traffic; see Logging Connections with a Policy Default Action, on page 1593.
- Associate the SSL policy with an access control policy as described in Associating Other Policies with Access Control, on page 636.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Set Default Handling for Undecryptable Traffic

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Firepower Management Center Configuration Guide, Version 6.0

733
You can set undecryptable traffic actions at the SSL policy level to handle certain types of encrypted traffic the system cannot decrypt or inspect. When you deploy an SSL policy that contains no TLS/SSL rules, the undecryptable traffic actions determine how all undecryptable encrypted traffic on your network is handled.

Depending on the type of undecryptable traffic, you can choose to:

- Block the connection.
- Block the connection, then reset it. This option is preferrable for connectionless protocols like UDP, which keep trying to connect until the connection is blocked.
- Inspect the encrypted traffic with access control.
- Inherit the default action from the SSL policy.

**Procedure**

**Step 1**
In the SSL policy editor, click the **Undecryptable Actions** tab.

**Step 2**
For each field, choose either the SSL policy’s default action or another action you want to take on the type of undecryptable traffic. See Default Handling Options for Undecryptable Traffic, on page 731 and SSL Policy Default Actions, on page 730 for more information.

**Step 3**
Click **Save** to save the policy.

**Example**

For example, to block all SSLv2 traffic, set the options as follows:

![SSL Policy editor screenshot]

**What to do next**

- Configure default logging for connections handled by the undecryptable traffic actions; see Logging Connections with a Policy Default Action, on page 1593.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Editing an SSL Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Only one person should edit a policy at a time, using a single browser window. If multiple users save the same policy, the last saved changes are retained. For your convenience, the system displays information on who (if anyone) is currently editing each policy. To protect the privacy of your session, a warning appears after 30 minutes of inactivity on the policy editor. After 60 minutes, the system discards your changes.

Procedure

**Step 1**  Choose **Policies > Access Control > SSL**.

**Step 2**  Click the edit icon (🔗) next to the SSL policy you want to configure.

If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3**  Configure the SSL policy:

- **Describe**—If you want to update your SSL policy description, click the **Description** field and enter the new description.

- **Log**—If you want to log connections for undecryptable traffic handling and traffic that does not match SSL rules, see **Logging Connections with a Policy Default Action**, on page 1593.

- **Rename**—If you want to rename your SSL policy, click the **Name** field and enter the new name.

- **Set the default action**—If you want to configure how your SSL policy handles traffic that does not match SSL rules, see **SSL Policy Default Actions**, on page 730.

- **Set the default action for undecryptable traffic**—If you want to configure how your SSL policy handles undecryptable traffic, see **Set Default Handling for Undecryptable Traffic**, on page 733.

- **Trust**—If you want to add trusted CA certificates to your SSL policy, see **Trusting External Certificate Authorities**, on page 777.

**Step 4**  Edit the rules in your SSL policy:

- **Add**—If you want to add a rule, click **Add Rule**.

- **Copy**—If you want to copy a rule, right-click a selected rule and choose **Copy**.

- **Cut**—If you want to cut a rule, right-click a selected rule and choose **Cut**.

- **Delete**—To delete a rule, click the delete icon (🗑️) next to the rule, then click **OK**.

- **Disable**—To disable an enabled rule, right-click a selected rule, choose **State**, then choose **Disable**.
Display—To display the configuration page for a specific rule attribute, click the name, value, or icon in the column for the condition on the row for the rule. For example, click the name or value in the **Source Networks** column to display the Networks page for the selected rule. See Network-Based TLS/SSL Rule Conditions, on page 756 for more information.

Edit—To edit a rule, click the edit icon (✏️) next to the rule.

Enable—To enable a disabled rule, right-click a selected rule, choose **State**, then choose **Enable**. Disabled rules are dimmed and marked (disabled) beneath the rule name.

Paste—To paste a cut or copied rule, right-click a selected rule and choose **Paste Above** or **Paste Below**.

**Step 5** Save or discard your configuration:

- To save your changes and continue editing, click **Save**.
- To discard your changes, click **Cancel** and, if prompted, click **OK**.

**What to do next**

- If the SSL policy is not already associated with an access control policy, associate it as described in Associating Other Policies with Access Control, on page 636.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

Creating and Modifying TLS/SSL Rules, on page 744
Get Started with TLS/SSL Rules

The following topics provide an overview of creating, configuring, managing, and troubleshooting TLS/SSL rules:

Because TLS and SSL are often used interchangeably, we use the expression TLS/SSL to indicate that either protocol is being discussed. The SSL protocol has been deprecated by the IETF in favor of the more secure TLS protocol, so you can usually interpret TLS/SSL as referring to TLS only.

The exception is SSL policies. Because the FMC configuration option is Policies > Access Control > SSL, we use the term SSL policies although these policies are used to define rules for TLS and SSL traffic.

For more information about SSL and TLS protocols, see a resource such as SSL vs. TLS - What's the Difference?.

TLS/SSL Rules Overview

TLS/SSL rules provide a granular method of handling encrypted traffic across multiple managed devices, whether blocking the traffic without further inspection, not decrypting the traffic and inspecting it with access control, or decrypting the traffic for access control analysis.

TLS/SSL Rule Guidelines and Limitations

Keep the following points in mind when setting up your TLS/SSL rules. Properly configuring TLS/SSL rules is a complex task, but one that is essential to building an effective deployment that handles encrypted traffic. Many factors influence how you configure rules, including certain application behavior that you cannot control.
In addition, rules can preempt each other, require additional licenses, or contain invalid configurations. Thoughtfully configured rules can also reduce the resources required to process network traffic. Creating overly complex rules and ordering rules the wrong way can adversely affect performance.

For detailed information, see Rule Performance Guidelines, on page 311.

Related Topics
- Rule and Other Policy Warnings, on page 310
- Rule Performance Guidelines, on page 311
- Guideline for Using TLS/SSL Decryption, on page 738
- TLS/SSL Rule Unsupported Features, on page 738
- TLS/SSL Do Not Decrypt Guidelines, on page 738
- TLS/SSL Decrypt - Resign Guidelines, on page 739
- TLS/SSL Decrypt - Known Key Guidelines, on page 740
- TLS/SSL Block Guidelines, on page 741
- TLS/SSL Certificate Pinning Guidelines, on page 741
- TLS/SSL Heartbeat Guidelines, on page 742
- TLS/SSL Anonymous Cipher Suite Limitation, on page 742
- TLS/SSL Normalizer Guidelines, on page 742
- Other TLS/SSL Rule Guidelines, on page 742
- SSL Rule Order, on page 315

Guideline for Using TLS/SSL Decryption

Set up Decrypt - Resign or Decrypt - Known Key rules only if your managed device handles encrypted traffic. Decryption rules require processing overhead that can impact performance.

TLS/SSL Rule Unsupported Features

Zone conditions and passive interfaces

If you create a Decrypt - Resign rule, and later add a security zone with passive interfaces to a zone condition, the system displays a warning icon next to the rule. Because you cannot decrypt traffic by re-signing a certificate in a passive deployment, the rule has no effect until you remove the passive interfaces from the rule or change the rule action.

TLS/SSL Do Not Decrypt Guidelines

You should not decrypt traffic if doing so is forbidden by:

- Law; for example, some jurisdictions forbid decrypting financial information
- Company policy; for example, your company might forbid decrypting privileged communications
- Privacy regulations
- Traffic that uses certificate pinning (also referred to as TLS/SSL pinning) must remain encrypted to prevent breaking the connection
If you elect to bypass decryption for certain types of traffic, no processing is done on the traffic. The encrypted traffic is first evaluated by SSL policy and then proceeds to the access control policy, where a final allow or block decision is made. Encrypted traffic can be allowed or blocked on any TLS/SSL rule condition, including, but not limited to:

- Certificate status (for example, expired or invalid certificate)
- Protocol (for example, the unsecure SSL protocol)
- Network (security zone, IP address, VLAN tag, and so on)
- Exact URL or URL category
- Port
- User group

### TLS/SSL Decrypt - Resign Guidelines

You can associate one Certificate Authority certificate and private key with the Decrypt - Resign action. If traffic matches this rule, the system re-signs the server certificate with the CA certificate, then acts as a man-in-the-middle. It creates two TLS/SSL sessions, one between client and managed device, one between managed device and server. Each session contains different cryptographic session details, and allows the system to decrypt and re-encrypt traffic. This action is more suited for outgoing traffic, as you replace the certificate’s private key with one you control to obtain the session keys.

Re-signing a server certificate involves either replacing the certificate’s public key with a CA certificate public key, or replacing the entire certificate. Normally, if you replace an entire server certificate, the client browser warns the certificate is not signed by a trusted authority when establishing the TLS/SSL connection. However, if your client’s browser trusts the CA in the policy, the browser does not warn that the certificate is not trusted. If the original server certificate is self-signed, the system replaces the entire certificate, and trusts the re-signing CA, but the user’s browser does not warn that the certificate is self-signed. In this case, replacing only the server certificate public key causes the client browser does warn that the certificate is self-signed.

If you configure a rule with the Decrypt - Resign action, the rule matches traffic based on the referenced internal CA certificate’s signature algorithm type, in addition to any configured rule conditions. Because you associate one CA certificate with a Decrypt - Resign action, you cannot create a TLS/SSL rule that decrypts multiple types of outgoing traffic encrypted with different signature algorithms. In addition, any external certificate objects and cipher suites you add to the rule must match the associated CA certificate encryption algorithm type. You can optionally replace the self-signed certificate key only and not the entire certificate, in which case users see a self-signed certificate key notice in the browser.

For example, outgoing traffic encrypted with an elliptic curve (EC) algorithm matches a Decrypt - Resign rule only if the action references an EC-based CA certificate; you must add EC-based external certificates and cipher suites to the rule to create certificate and cipher suite rule conditions. Similarly, a Decrypt - Resign rule that references an RSA-based CA certificate matches only outgoing traffic encrypted with an RSA algorithm; outgoing traffic encrypted with an EC algorithm does not match the rule, even if all other configured rule conditions match.

Also note the following:

**Anonymous cipher suite unsupported**

By nature, anonymous cipher suites are not used for authentication and do not use key exchanges. There are limited uses for anonymous cipher suites; for more information, see RFC 5246, section A.5.
You cannot use the Decrypt - Resign or Decrypt - Known Key action in the rule because anonymous cipher suites are not used for authentication.

### Inline or tap mode limitation

You cannot use the Decrypt - Resign action in a passive or inline (tap mode) deployment because the device does not directly inspect traffic. If you create a rule with the Decrypt - Resign action that contains passive or inline (tap mode) interfaces within a security zone, the policy editor displays a warning icon (⚠️) next to the rule.

If your SSL policy targets a device with passive or inline (tap mode) interfaces, and contains a Decrypt - Resign rule, the system displays an information icon (ℹ️) next to the rule. If you later add a zone condition to the TLS/SSL rule that contains passive or inline (tap mode) interfaces, the system displays a warning icon (⚠️). If you deploy an SSL policy that contains a Decrypt - Resign rule to a device with passive or inline (tap mode) interfaces, any TLS/SSL sessions that match the rule fail.

### Non-matching cipher suite

The following error is displayed if you attempt to save a TLS/SSL rule with a cipher suite that does not match the certificate. To resolve the issue, see Verify TLS/SSL Cipher Suites, on page 787.

Traffic cannot match this rule; none of your selected cipher suites contain a signature algorithm that the resigning CA's signature algorithm

### Untrusted Certificate Authority

If the client does not trust the Certificate Authority (CA) used to re-sign the server certificate, it warns the user that the certificate should not be trusted. To prevent this, import the CA certificate into the client trusted CA store. Alternatively, if your organization has a private PKI, you can issue an intermediate CA certificate signed by the root CA which is automatically trusted by all clients in the organization, then upload that CA certificate to the device.

### HTTP proxy limitation

The system cannot decrypt traffic if an HTTP proxy is positioned between a client and your managed device, and the client and server establish a tunneled TLS/SSL connection using the CONNECT HTTP method. The Handshake Errors undecryptable action determines how the system handles this traffic.

### Upload signed CA

If you create an internal CA object and choose to generate a certificate signing request (CSR), you cannot use this CA for a Decrypt - Resign action until you upload the signed certificate to the object.

---

**TLS/SSL Decrypt - Known Key Guidelines**

When you configure the Decrypt - Known Key action, you can associate one or more server certificates and paired private keys with the action. If traffic matches the rule, and the certificate used to encrypt the traffic matches the certificate associated with the action, the system uses the appropriate private key to obtain the session encryption and decryption keys. Because you must have access to the private key, this action is best suited to decrypt traffic incoming to servers your organization controls.

Also note the following:

#### Limitation for DHE and ECDHE key exchanges

You cannot use the Decrypt - Known Key action in a passive deployment if the cipher suite used to establish the TLS/SSL connection applies either the Diffie-Hellman ephemeral (DHE) or the elliptic curve Diffie-Hellman ephemeral (ECDHE) key exchange algorithm. If your SSL policy targets a device
with passive or inline (tap mode) interfaces, and contains a Decrypt - Known Key rule with a cipher suite condition containing either a DHE or an ECDHE cipher suite, the system displays an information icon (ℹ️) next to the rule. If you later add a zone condition to the TLS/SSL rule that contains passive or inline (tap mode) interfaces, the system displays a warning icon (⚠️).

**Anonymous cipher suite unsupported**

By nature, anonymous cipher suites are not used for authentication and do not use key exchanges. There are limited uses for anonymous cipher suites; for more information, see RFC 5246, section A.5.

You cannot use the Decrypt - Resign or Decrypt - Known Key action in the rule because anonymous cipher suites are not used for authentication.

**Cannot match on Distinguished Name or Certificate**

You cannot match on Distinguished Name or Certificate conditions when creating a TLS/SSL rule with a Decrypt - Known Key action. The assumption is that if this rule matches traffic, the certificate, subject DN, and issuer DN already match the certificate associated with the rule.

**Mismatched signature algorithm**

If you configure a rule with the Decrypt - Resign action, and mismatch signature algorithm type for one or more external certificate objects or cipher suites, the policy editor displays an information icon (ℹ️) next to the rule. If you mismatch signature algorithm type for all external certificate objects, or all cipher suites, the policy displays a warning icon (⚠️) next to the rule, and you cannot deploy the access control policy associated with the SSL policy.

**Certificate pinning**

If the customer's browser uses certificate pinning to verify a server certificate, you cannot decrypt this traffic by re-signing the server certificate. To allow this traffic, configure a TLS/SSL rule with the Do not decrypt action to match the server certificate common name or distinguished name.

---

**TLS/SSL Block Guidelines**

If decrypted traffic matches an access control rule with an action of Interactive Block or Interactive Block with reset, the system blocks the matching connection without interaction and the system does not display a response page.

Provided you enabled logging in your rule, two connection events are displayed (in Analysis > Events > Connections): One event for the interactive block and another event to indicate whether or not the user chose to continue to the site or not.

---

**TLS/SSL Certificate Pinning Guidelines**

Some applications use a technique referred to as TLS/SSL pinning or certificate pinning, which embeds the fingerprint of the original server certificate in the application itself. As a result, if you configured a TLS/SSL rule with a Decrypt - Resign action, when the application receives a resigned certificate from a managed device, validation fails and the connection is aborted.

Because TLS/SSL pinning is used to avoid man-in-the-middle attacks, there is no way to prevent or work around it. You have the following options:

- Create a Do Not Decrypt for those applications rule ordered before Decrypt - Resign rules.
• Instruct users to access the applications using a web browser.

For more information about rule ordering, see SSL Rule Order, on page 315.

TLS/SSL Heartbeat Guidelines

Some applications use the TLS heartbeat extension to the Transport Layer Security (TLS) and Datagram Transport Layer Security (DTLS) protocols defined by RFC6520. TLS heartbeat provides a way to confirm the connection is still alive—either the client or server sends a specified number of bytes of data and requests the other party echo the response. If this is successful, encrypted data is sent.

You can configure a Max Heartbeat Length in a Network Analysis Policy (NAP) to determine how to handle TLS heartbeats. For more information, see The SSL Preprocessor, on page 1127.

TLS/SSL Anonymous Cipher Suite Limitation

By nature, anonymous cipher suites are not used for authentication and do not use key exchanges. There are limited uses for anonymous cipher suites; for more information, see RFC 5246, section A.5.

You cannot use the Decrypt - Resign or Decrypt - Known Key action in the rule because anonymous cipher suites are not used for authentication.

You can add an anonymous cipher suite to the Cipher Suite condition in a TLS/SSL rule, but the system automatically strips anonymous cipher suites during ClientHello processing. For the system to use the rule, you must also configure your TLS/SSL rules in an order that prevents ClientHello processing. For more information, see SSL Rule Order, on page 315.

TLS/SSL Normalizer Guidelines

If you enable the Normalize Excess Payload option in the inline normalization preprocessor, when the preprocessor normalizes decrypted traffic, it might drop a packet and replace it with a trimmed packet. This does not end the TLS/SSL session. If the traffic is allowed, the trimmed packet is encrypted as part of the TLS/SSL session.

Other TLS/SSL Rule Guidelines

Users and groups

If you add a group or user to a rule, then change your realm settings to exclude that group or user, the rule has no effect. (The same applies to disabling the realm.) For more information about realms, see Create a Realm, on page 1330.

Categories in TLS/SSL rules

If your SSL policy has a Decrypt - Resign action but web sites are not being decrypted, check the Category tab page on rules associated with that policy.

In some cases, a web site redirects to another site for authentication or other purposes and the redirected site might have a different URL categorization than the site you’re trying to decrypt. For example, gmail.com (Web based email category) redirects to accounts.gmail.com (Internet Portals category) for authentication. Be sure to include all relevant categories in the SSL rule.
Query for URLs not in the local database

If you create a Decrypt - Resign rule and users browse to a web site whose category and reputation are not in the local database, data might not be decrypted. Some web sites are not categorized in the local database and, if not, data from those web sites is not decrypted by default.

You can control this behavior with the setting System > Integration > Cisco CSI, and check Query Cisco CSI for Unknown URLs.

For more information about this option, see Cisco Security Intelligence Clouds, on page 806.

Encrypted Traffic Inspection Configuration

You must create reusable public key infrastructure (PKI) objects to control encrypted traffic based on encrypted session characteristics and decrypt encrypted traffic. You can add this information on the fly when uploading trusted certificate authority (CA) certificates to the SSL policy and creating SSL rule conditions, creating the associated object in the process. However, configuring these objects ahead of time reduces the chance of improper object creation.

Decrypting Encrypted Traffic with Certificates and Paired Keys

The system can decrypt incoming encrypted traffic if you configure an internal certificate object by uploading the server certificate and private key used to encrypt the session. If you reference that object in an SSL rule with an action of Decrypt - Known Key and traffic matches that rule, the system uses the uploaded private key to decrypt the session.

The system can also decrypt outgoing traffic if you configure an internal CA object by uploading a CA certificate and private key. If you reference that object in a TLS/SSL rule with an action of Decrypt - Resign and traffic matches that rule, the system re-signs the server certificate passed to the client browser, then acts as a man-in-the-middle to decrypt the session. You can optionally replace the self-signed certificate key only and not the entire certificate, in which case users see a self-signed certificate key notice in the browser.

Controlling Traffic Based on Encrypted Session Characteristics

The system can control encrypted traffic based on the cipher suite or server certificate used to negotiate the session. You can configure one of several different reusable objects and reference the object in a TLS/SSL rule condition to match traffic. The following table describes the different types of reusable objects you can configure:

<table>
<thead>
<tr>
<th>If you configure...</th>
<th>You can control encrypted traffic based on whether...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A cipher suite list containing one or more cipher suites</td>
<td>The cipher suite used to negotiate the encrypted session matches a cipher suite in the cipher suite list</td>
</tr>
<tr>
<td>A trusted CA object by uploading a CA certificate your</td>
<td>The trusted CA trusts the server certificate used to encrypt the session, whether:</td>
</tr>
<tr>
<td>organization trusts</td>
<td>• The CA issued the certificate directly</td>
</tr>
<tr>
<td></td>
<td>• The CA issued a certificate to an intermediate CA that issued the server certificate</td>
</tr>
<tr>
<td>An external certificate object by uploading a server</td>
<td>The server certificate used to encrypt the session matches the uploaded server certificate</td>
</tr>
<tr>
<td>certificate</td>
<td></td>
</tr>
<tr>
<td>If you configure...</td>
<td>You can control encrypted traffic based on whether...</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>A distinguished name object containing a certificate subject or issuer distinguished name</td>
<td>The subject or issuer common name, country, organization, or organizational unit on the certificate used to encrypt the session matches the configured distinguished name</td>
</tr>
</tbody>
</table>

**Related Topics**
- Cipher Suite Lists, on page 363
- Distinguished Name Objects, on page 364
- PKI Objects, on page 366

## Creating and Modifying TLS/SSL Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**
Log in to the Firepower Management Center.

**Step 2**
Click Policies > Access Control > SSL.

**Step 3**
Click the edit icon (-pencil) next to the SSL policy.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4**
You have the following choices:
- To add a new rule, click **Add Rule**.
- To edit an existing rule, click the edit icon (-pencil).

**Step 5**
Enter a **Name** for the rule.

**Step 6**
Specify whether the rule is **Enabled**.

**Step 7**
Specify the rule position; see TLS/SSL Rule Order Evaluation, on page 712.

**Step 8**
Click a rule **Action**; see Configuring TLS/SSL Rule Actions, on page 752.

**Step 9**
Configure the rule’s conditions; see TLS/SSL Rule Condition Types, on page 749.

**Step 10**
Click **Save**.

If the following error displays, see Verify TLS/SSL Cipher Suites, on page 787: **Traffic cannot match this rule; none of your selected cipher suites contain a signature algorithm that the resigning CA’s signature algorithm.**
Adding a TLS/SSL Rule to a Rule Category

### What to do next
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

#### Access Supported Domains
- **Supported Devices**: Any except NGIPSv
- **Supported Domains**: Any
- **Access**: Admin/Access, Admin/Network Admin

#### Procedure

**Step 1**
In the SSL rule editor, from the **Insert** drop-down list, select **Into Category**, then select the category you want to use.

**Step 2**
Click **Save**.

**Tip**  
When you save the rule, it is placed last in that category.

---

Positioning a TLS/SSL Rule by Number

### What to do next
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

#### Access Supported Domains
- **Supported Devices**: Any except NGIPSv
- **Supported Domains**: Any
- **Access**: Admin/Access, Admin/Network Admin

#### Procedure

**Step 1**
In the SSL rule editor, from the **Insert** drop-down list, select **above rule** or **below rule**, then type the appropriate rule number.

**Step 2**
Click **Save**.

**Tip**  
When you save the rule, it is placed where you specified.

---

What to do next
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
TLS/SSL Rule Search

You can search the list of TLS/SSL rules for matching values using an alphanumeric string, including spaces and printable, special characters. The search inspects the rule name and any rule condition you have added to the rule. For rule conditions, the search matches any name or value you can add for each condition type (zone, network, application, and so on). This includes individual object names or values, group object names, individual object names or values within a group, and literal values.

You can use complete or partial search strings. The column for matching values is highlighted for each matching rule. For example, if you search on all or part of the string 100Bao, at a minimum, the Applications column is highlighted for each rule where you have added the 100Bao application. If you also have a rule named 100Bao, both the Name and Applications columns are highlighted.

You can navigate to each previous or next matching rule. A status message displays the current match and the total number of matches.

Matches may occur on any page of a multi-page rule list. When the first match is not on the first page, the page where the first match occurs is displayed. Selecting the next match when you are at the last match takes you to the first match, and selecting the previous match when you are at the first match takes you to the last match.

Searching TLS/SSL Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** In the SSL policy editor, click the **Search Rules** prompt, type a search string, then press Enter.

**Tip** Columns for rules with matching values are highlighted, with differentiated highlighting for the indicated (first) match.

**Step 2** Find the rules you are interested in:

- To navigate between matching rules, click the next-match (↑) or previous-match (↓) icon.
- To refresh the page and clear the search string and any highlighting, click the clear icon (×).

Enabling and Disabling TLS/SSL Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>
When you create a TLS/SSL rule, it is enabled by default. If you disable a rule, the system does not use it to evaluate network traffic and stops generating warnings and errors for that rule. When viewing the list of rules in an SSL policy, disabled rules are grayed out, although you can still modify them. Note that you can also enable or disable a TLS/SSL rule using the rule editor.

**Procedure**

**Step 1**
In the SSL policy editor, right-click a rule and choose a rule state.

**Step 2**
Click Save.

**What to do next**
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

### Moving a TLS/SSL Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**
In the SSL policy editor, select the rules by clicking in a blank area for each rule.

**Step 2**
Right-click the rule and select Cut.

**Step 3**
Right-click a blank area for a rule next to where you want to paste the cut rules and select Paste above or Paste below.

**Tip**
You cannot copy and paste TLS/SSL rules between two different SSL policies.

**Step 4**
Click Save.

**What to do next**
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

### Adding a New TLS/SSL Rule Category

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>
You can create custom categories between the Standard Rules and Root Rules categories to further organize your rules without having to create additional policies. You can rename and delete categories that you add. You cannot move these categories, but you can move rules into, within, and out of them.

### Procedure

**Step 1**
In the policy editor, click **Add Category**.

**Tip**
If your policy already contains rules, you can click a blank area in the row for an existing rule to set the position of the new category before you add it. You can also right-click an existing rule and select **Insert new category**.

**Step 2**
Type a **Name**.

**Step 3**
You have the following choices:

- Select **above Category** from the first Insert drop-down list, then select the category above which you want to position the rule from the second drop-down list.

- Select **below rule** from the drop-down list, then enter an existing rule number. This option is valid only when at least one rule exists in the policy.

- Select **above rule** from the drop-down list, then, enter an existing rule number. This option is valid only when at least one rule exists in the policy.

**Step 4**
Click **OK**.

**Tip**
Rules in a category you delete are added to the category above.

**Step 5**
Click **Save**.

### TLS/SSL Rule Conditions

An SSL rule’s conditions identify the type of encrypted traffic the rule handles. Conditions can be simple or complex, and you can specify more than one condition type per rule. Only if traffic meets all the conditions in a rule does the rule apply to the traffic.

If you do not configure a particular condition for a rule, the system does not match traffic based on that criterion. For example, a rule with a certificate condition but no version condition evaluates traffic based on the server certificate used to negotiate the session, regardless of the session SSL or TLS version.

Every TLS/SSL rule has an associated action that determines the following for matching encrypted traffic:

- **Handling**: Most importantly, the rule action governs whether the system will monitor, trust, block, or decrypt encrypted traffic that matches the rule’s conditions

- **Logging**: The rule action determines when and how you can log details about matching encrypted traffic.

Your TLS/SSL inspection configuration handles, inspects, and logs decrypted traffic:

- The SSL policy’s undecryptable actions handle traffic that the system cannot decrypt.
The policy’s default action handles traffic that does not meet the condition of any non-Monitor TLS/SSL rule.

You can log a connection event when the system blocks or trusts an encrypted session. You can also force the system to log connections that it decrypts for further evaluation by access control rules, regardless of how the system later handles or inspects the traffic. Connection logs for encrypted sessions contain details about the encryption, such as the certificate used to encrypt that session. You can log only end-of-connection events, however:

- For blocked connections (Block, Block with reset), the system immediately ends the sessions and generates an event
- For trusted connections (Do not decrypt), the system generates an event when the session ends

### TLS/SSL Rule Condition Types

When you add or edit an SSL rule, use the tabs on the left side of the lower portion of the rule editor to add and edit rule conditions.

**Table 73: TLS/SSL Rule Condition Types**

<table>
<thead>
<tr>
<th>This Condition...</th>
<th>Matches Encrypted Traffic...</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zones</td>
<td>Entering or leaving a device via an interface in a specific security zone</td>
<td>A security zone is a logical grouping of one or more interfaces according to your deployment and security policies. Interfaces in a zone may be located across multiple devices.</td>
</tr>
<tr>
<td>Networks</td>
<td>By its source or destination IP address, country, or continent</td>
<td>You can explicitly specify IP addresses. The geolocation feature also allows you to control traffic based on its source or destination country or continent.</td>
</tr>
<tr>
<td>VLAN Tags</td>
<td>Tagged by VLAN</td>
<td>The system uses the innermost VLAN tag to identify a packet by VLAN.</td>
</tr>
<tr>
<td>Ports</td>
<td>By its source or destination port</td>
<td>You can control encrypted traffic based on the TCP port.</td>
</tr>
<tr>
<td>Users</td>
<td>By the user involved in the session</td>
<td>You can control encrypted traffic based on the LDAP user logged into a host involved in an encrypted, monitored session. You can control traffic based on individual users or groups retrieved from a Microsoft Active Directory server.</td>
</tr>
<tr>
<td>Applications</td>
<td>By the application detected in a session</td>
<td>You can control access to individual applications in encrypted sessions, or filter access according to basic characteristics: type, risk, business relevance, and categories.</td>
</tr>
</tbody>
</table>
### This Condition... | Matches Encrypted Traffic... | Details
--- | --- | ---
Categories | By the URL requested in the session, based on the certificate subject distinguished name | You can limit the websites that users on your network can access based on the URL’s general classification and risk level.
Distinguished Names | The URL the user enters in the browser matches the Common Name (CN), or the URL is contained in the certificate’s Subject Alternative Name (SAN) | You can control encrypted traffic based on the CA that issued a server certificate, or the server certificate holder.
Certificates | By the server certificate used to negotiate the encrypted session | You can control encrypted traffic based on the server certificate passed to the user’s browser in order to negotiate the encrypted session.
Certificate Status | By properties of the server certificate used to negotiate the encrypted session | You can control encrypted traffic based on a server certificate’s status.
Cipher Suites | By the cipher suite used to negotiate the encrypted session | You can control encrypted traffic based on the cipher suite selected by the server to negotiate the encrypted session.
Versions | By the version of SSL or TLS used to encrypt the session | You can control encrypted traffic based on the version of SSL or TLS used to encrypt the session.

**Related Topics**
- Network-Based TLS/SSL Rule Conditions, on page 756
- User-Based TLS/SSL Rule Conditions, on page 762
- Reputation-Based URL Blocking in Encrypted Traffic, on page 768
- Server Certificate-Based TLS/SSL Rule Conditions, on page 770

### TLS/SSL Rule Actions

The following sections discuss the actions available with TLS/SSL rules.

**Related Topics**
- TLS/SSL Rule Decrypt Actions, on page 752
- TLS/SSL Rule Blocking Actions, on page 751
- TLS/SSL Rule Do Not Decrypt Action, on page 751
- TLS/SSL Rule Monitor Action, on page 750

### TLS/SSL Rule Monitor Action

The **Monitor** action does not affect encrypted traffic flow; matching traffic is neither immediately permitted nor denied. Rather, traffic is matched against additional rules, if present, to determine whether to trust, block, or decrypt it. The first non-Monitor rule matched determines traffic flow and any further inspection. If there are no additional matching rules, the system uses the default action.
Because the primary purpose of Monitor rules is to track network traffic, the system automatically logs end-of
connection events for monitored traffic to the Firepower Management Center database, regardless of the
logging configuration of the rule or default action that later handles the connection.

**TLS/SSL Rule Do Not Decrypt Action**

The *Do Not Decrypt* action passes encrypted traffic for evaluation by the access control policy’s rules and
default action. Because some access control rule conditions require unencrypted traffic, this traffic may match
fewer rules. The system cannot perform deep inspection on encrypted traffic, such as intrusion or file inspection.

Typical reasons for a *Do Not Decrypt* rule action include:

- When decrypting TLS/SSL traffic is prohibited by law.
- Sites you know you can trust.
- Sites you can disrupt by inspecting traffic (such as Windows Update).
- To view the values of TLS/SSL fields using connection events. (You do not need to decrypt traffic to
  view connection event fields.) For more information, see Requirements for Populating Connection Event
  Fields, on page 1610.

For more information, see Default Handling Options for Undecryptable Traffic, on page 731

**TLS/SSL Rule Blocking Actions**

The Firepower System provides the following TLS/SSL rule actions for traffic you do not want to pass through
the system:

- **Block** to terminate the connection, resulting in an error in the client browser.
  The error message does not indicate the site was blocked due to policy. Instead, errors might indicate
  that there are no common encryption algorithms. It is not obvious from this message that you blocked
  the connection on purpose.
  
- **Interactive block** to interrupt the connection to the destination server and require the user to acknowledge
  that access to the server might be a violation of company policy.
  
  You can use a default acknowledgement page or you can create a custom page.
  Connection events indicate whether or not the user elected to continue to the destination server.
  
- **Block with reset** to terminate and reset the connection, resulting in an error in the client browser.
  
  The error indicates the connection was reset but does not indicate why.

---

**Tip**

You cannot use the **Block** or **Block with reset** action in a passive or inline (tap mode) deployment because
the device does not directly inspect the traffic. If you create a rule with the **Block** or **Block with reset** action
that contains passive or inline (tap mode) interfaces within a security zone condition, the policy editor displays
a warning icon (⚠️) next to the rule.

**Related Topics**

  About HTTP Response Pages, on page 671

---
TLS/SSL Rule Decrypt Actions

The Decrypt - Known Key and Decrypt - Resign actions decrypt encrypted traffic. The system inspects decrypted traffic with access control. Access control rules handle decrypted and unencrypted traffic identically — you can inspect it for discovery data as well as detect and block intrusions, prohibited files, and malware. The system reencrypts allowed traffic before passing it to its destination.

We recommend you use a certificate from a trusted Certificate Authority (CA) to decrypt traffic. This prevents Invalid Issuer from being displayed in the SSL Certificate Status column in connection events.

For more information about adding trusted objects, see Trusted Certificate Authority Objects, on page 372.

Configuring TLS/SSL Rule Actions

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** In the SSL policy editor, you have the following options:

- To add a new rule, click **Add Rule**.

- To edit an existing rule, click the edit icon (✎).

**Step 2** Select a rule action from the **Action** drop-down list.

- To block encrypted traffic, select **Block**.

- To block encrypted traffic and reset the connection, select **Block with reset**.

- To decrypt incoming traffic, see Configuring a Decrypt - Known Key Action, on page 753 for more information.

- To decrypt outgoing traffic, see Configuring a Decrypt - Resign Action, on page 753 for more information.

- To log encrypted traffic, select **Monitor**.

- To not decrypt encrypted traffic, select **Do not decrypt**.

**Step 3** Click **Add**.

What to do next

- Configure rule conditions, as described in Network-Based TLS/SSL Rule Conditions, on page 756, User-Based TLS/SSL Rule Conditions, on page 762, Reputation-Based TLS/SSL Rule Conditions, on page 763, and Server Certificate-Based TLS/SSL Rule Conditions, on page 770.

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Configuring a Decrypt - Resign Action

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** In the SSL rule editor, select **Decrypt - Resign** from the **Action** list.

**Step 2** Select an internal CA certificate object from the list.

**Step 3** To replace only the certificate public key instead of the entire certificate, you must check . Because you're replacing the public key only, users get a self-signed certificate notice in the browser.

**Step 4** Click **Add**.

**Step 5** **Optional.** To use a Trusted CA certificate in your SSL policy so you can avoid **Invalid Issuer** in the SSL Certificate Status column in connection events, add the certificate to the policy:
   a) In the SSL policy editor page, click the **Trusted CA Certificates** tab.
   b) Add the CA certificate corresponding to your known key to the SSL policy.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Configuring a Decrypt - Known Key Action

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** In the SSL rule editor, select **Decrypt - Known Key** from the **Action** drop-down list.

**Step 2** Click the **Click to select decryption certs** field.

**Step 3** Select one or more internal certificate objects in the **Available Certificates** list, then click **Add to Rule**.

**Step 4** Click **OK**.

**Step 5** Click **Add**.

**Step 6** **Optional.** To use a Trusted CA certificate in your SSL policy so you can avoid **Invalid Issuer** in the SSL Certificate Status column in connection events, add the certificate to the policy:
   a) In the SSL policy editor page, click the **Trusted CA Certificates** tab.
   b) Add the CA certificate corresponding to your known key to the SSL policy.
What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

TLS/SSL Rules Management

The Rules tab page of the SSL policy editor allows you to add, edit, search, move, enable, disable, delete, and otherwise manage TLS/SSL rules in your policy.
Decryption Tuning Using TLS/SSL Rules

The following topics provide an overview of how to configure TLS/SSL rule conditions:

- TLS/SSL Rule Conditions Overview, on page 755
- Network-Based TLS/SSL Rule Conditions, on page 756
- User-Based TLS/SSL Rule Conditions, on page 762
- Reputation-Based TLS/SSL Rule Conditions, on page 763
- Server Certificate-Based TLS/SSL Rule Conditions, on page 770

TLS/SSL Rule Conditions Overview

A basic TLS/SSL rule applies its rule action to all encrypted traffic inspected by the device. To better control and decrypt encrypted traffic, you can configure rule conditions to handle and log specific types of traffic. Each TLS/SSL rule can contain 0, 1, or more rule conditions; a rule matches traffic only if the traffic matches every condition in that TLS/SSL rule.

Note

When traffic matches a rule, the device applies the configured rule action to the traffic. When the connection ends, the device logs the traffic if configured to do so.

Each rule condition allows you to specify one or more properties of traffic you want to match against; these properties include details of:

- The flow of traffic, including the security zone through which it travels, IP address and port, country of origin or destination, and origin or destination VLAN.
- The user associated with a detected IP address.
- The traffic payload, including the application detected in the traffic.
- The connection encryption, including the TLS/SSL protocol version and cipher suite and server certificate used to encrypt the connection.
- The category and reputation of the URL specified in the server certificate’s distinguished name.

Related Topics

Network-Based TLS/SSL Rule Conditions, on page 756
User-Based TLS/SSL Rule Conditions, on page 762
Network-Based TLS/SSL Rule Conditions

TLS/SSL rules in SSL policies exert granular control over encrypted traffic logging and handling. Network-based conditions allow you to manage which encrypted traffic can traverse your network, using one or more of the following criteria:

- Zone conditions in TLS/SSL rules allow you to control encrypted traffic by its source and destination security zones. A security zone is a grouping of one or more interfaces, which might be located across multiple devices.

- Network conditions in TLS/SSL rules allow you to control and decrypt encrypted traffic by its source and destination IP address. You can either explicitly specify the source and destination IP addresses for the encrypted traffic you want to control, or use the geolocation feature, which associates IP addresses with geographical locations, to control encrypted traffic based on its source or destination country or continent.

- VLAN conditions in TLS/SSL rules allow you to control VLAN-tagged traffic. The system uses the innermost VLAN tag to identify a packet by VLAN.

- Port conditions in TLS/SSL rules allow you to control encrypted traffic by its source and destination TCP port.

You can combine network-based conditions with each other and with other types of conditions to create a TLS/SSL rule. These TLS/SSL rules can be simple or complex, matching and inspecting traffic using multiple conditions.

Related Topics

Firepower System IP Address Conventions, on page 14

Network Zone TLS/SSL Rule Conditions

You can add a maximum of 50 zones to each of the Sources Zones and Destination Zones in a single zone condition:

- To match encrypted traffic leaving the device from an interface in the zone, add that zone to the Destination Zones.

  Because devices deployed passively do not transmit traffic, you cannot use a zone comprised of passive interfaces in a Destination Zone condition.

- To match encrypted traffic entering the device from an interface in the zone, add that zone to the Source Zones.

If you add both source and destination zone conditions to a rule, matching traffic must originate from one of the specified source zones and egress through one of the destination zones.

Note that just as all interfaces in a zone must be of the same type (all inline, all passive, all switched, or all routed), all zones used in a zone condition for a TLS/SSL rule must be of the same type. That is, you cannot write a single rule that matches encrypted traffic to or from zones of different types.
Warning icons indicate invalid configurations, such as zones that contain no interfaces. For details, hover your pointer over the icon.

### Controlling Encrypted Traffic by Network Zone

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**
In the SSL rule editor, select the Zones tab.

**Step 2**
Find the zones you want to add from the Available Zones. To search for zones to add, click the Search by name prompt above the Available Zones list, then type a zone name. The list updates as you type to display matching zones.

**Step 3**
Click to select a zone. To select all zones, right-click and then select Select All.

**Step 4**
Click Add to Source or Add to Destination.

**Tip**
You can also drag and drop selected zones.

**Step 5**
Save or continue editing the rule.

**Example**

For example, you could deploy additional identically configured devices—managed by the same Firepower Management Center—to protect similar resources in several different locations. Like the first device, each of these devices protects the assets in an Internal security zone.

**Note**

You are not required to group all internal (or external) interfaces into a single zone. Choose the grouping that makes sense for your deployment and security policies.

In this deployment, you may decide that although you want these hosts to have unrestricted access to the Internet, you nevertheless want to protect them by decrypting and inspecting incoming encrypted traffic.

To accomplish this, configure a TLS/SSL rule with a zone condition where the Destination Zone is set to Internal. This simple SSL rule matches traffic that leaves the device from any interface in the Internal zone.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Network or Geolocation TLS/SSL Rule Conditions

When you build a network-based TLS/SSL rule condition, you can manually specify IP address and geographical locations. Alternately, you can configure network conditions with network and geolocation objects, which are reusable and associate a name with one or more IP addresses, address blocks, countries, continents, and so on.

If you want to write rules to control traffic by geographical location, to ensure you are using up-to-date geolocation data to filter your traffic, Cisco strongly recommends you regularly update the geolocation database (GeoDB) on your Firepower Management Center.

You can add a maximum of 50 items to each of the Source Networks and Destination Networks in a single network condition, and you can mix network and geolocation-based configurations:

- To match encrypted traffic from an IP address or geographical location, configure the Source Networks.
- To match encrypted traffic to an IP address or geographical location, configure the Destination Networks.

If you add both source and destination network conditions to a rule, matching encrypted traffic must originate from one of the specified IP addresses and be destined for one of the destination IP addresses.

When building a network condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon.

Related Topics
Firepower System IP Address Conventions, on page 14

Controlling Encrypted Traffic by Network or Geolocation

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Before you begin

- Update the geolocation database (GeoDB) on your Firepower Management Center as described in Update the Geolocation Database (GeoDB), on page 122.

Procedure

Step 1 In the SSL rule editor, select the Networks tab.
Step 2 Find the networks you want to add from the Available Networks, as follows:
• Click the Networks tab to display network objects and groups to add; click the Geolocation tab to display geolocation objects.

• To add a network object on the fly, which you can then add to the condition, click the add icon (+] above the Available Networks list.

• To search for network or geolocation objects to add, select the appropriate tab, click the Search by name or value prompt above the Available Networks list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects.

Step 3 To select an object, click it. To select all objects, right-click and then select Select All.

Step 4 Click Add to Source or Add to Destination.

Tip You can also drag and drop selected objects.

Step 5 Add any source or destination IP addresses or address blocks that you want to specify manually. Click the Enter an IP address prompt below the Source Networks or Destination Networks list; then type an IP address or address block and click Add.

Step 6 Save or continue editing the rule.

Example

The following graphic shows the network condition for a TLS/SSL rule that blocks encrypted connections originating from your internal network and attempting to access resources either in the Cayman Islands or an offshore holding corporation server at 182.16.0.3.

![Source Networks (1) and Destination Networks (2)]

The example manually specifies the offshore holding corporation’s server IP address, and uses a system-provided Cayman Islands geolocation object to represent Cayman Island IP addresses.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Network Objects, on page 326
Firepower System IPAddress Conventions, on page 14

VLAN TLS/SSL Rule Conditions

When you build a VLAN-based TLS/SSL rule condition, you can manually specify a VLAN tag from 1 to 4094. Alternately, you can configure VLAN conditions with VLAN tag objects, which are reusable and associate a name with one or more VLAN tags.
Tip  
After you create a VLAN tag object, you can use it not only to build TLS/SSL rules, but also to represent VLAN tags in various other places in the system’s web interface. You can create VLAN tag objects either using the object manager or on-the-fly while you are configuring access control rules.

You can add a maximum of 50 items to the **Selected VLAN Tags** in a single VLAN tag condition. When building a VLAN tag condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon.

### Controlling Encrypted VLAN Traffic

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
</tbody>
</table>

#### Procedure

**Step 1**  
In the SSL rule editor, select the VLAN Tags tab.

**Step 2**  
Find the VLANs you want to add from the **Available VLAN Tags**, as follows:

- To add a VLAN tag object on the fly, which you can then add to the condition, click the add icon (非常重要) above the Available VLAN Tags list.

- To search for VLAN tag objects and groups to add, click the **Search by name or value** prompt above the **Available VLAN Tags** list, then type either the name of the object, or the value of a VLAN tag in the object. The list updates as you type to display matching objects.

**Step 3**  
To select an object, click it. To select all objects, right-click and then select **Select All**.

**Step 4**  
Click **Add to Rule**.  
**Tip**  
You can also drag and drop selected objects.

**Step 5**  
Add any VLAN tags that you want to specify manually. Click the **Enter a VLAN Tag** prompt below the **Selected VLAN Tags** list; then type a VLAN tag or range and click **Add**. You can specify any VLAN tag from 1 to 4094; use a hyphen to specify a range of VLAN tags.

**Step 6**  
Save or continue editing the rule.

#### Example

The following graphic shows a VLAN tag condition for an SSL rule that matches encrypted traffic on public-facing VLANs (represented by a VLAN tag object group), as well as the manually added VLAN 42.
What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

VLAN Tag Objects, on page 328

Port TLS/SSL Rule Conditions

When you build a port-based TLS/SSL rule condition, you can manually specify TCP ports. Alternately, you can configure port conditions with port objects, which are reusable and associate a name with one or more ports.

You can add a maximum of 50 items to each of the Selected Source Ports and Selected Destination Ports lists in a single network condition:

- To match encrypted traffic from a TCP port, configure the Selected Source Ports.
- To match encrypted traffic to a TCP port, configure the Selected Destination Ports.
- To match encrypted traffic both originating from TCP Selected Source Ports and destined for TCP Selected Destination Ports, configure both.

You can only configure the Selected Source Ports and Selected Destination Ports lists with TCP ports. Port objects containing non-TCP ports are greyed out in the Available Ports list.

When building a port condition, warning icons indicate invalid configurations. For example, you can use the object manager to edit in-use port objects so that the rules that use those object groups become invalid. For details, hover your pointer over the icon.

Controlling Encrypted Traffic by Port

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Encrypted Traffic Handling
Port TLS/SSL Rule Conditions
**User-Based TLS/SSL Rule Conditions**

You can configure TLS/SSL rules to match traffic based on realm, group, or user. Realm, group, and user conditions in TLS/SSL rules allow you perform user control to manage which traffic can traverse your network by associating authoritative users with IP addresses.

For traffic to match a TLS/SSL rule with a user condition, the IP address of either the source or destination host in the monitored session must be associated with a logged in authoritative user. You can control traffic based on realms, individual users, or the groups those users belong to.
Controlling Encrypted Traffic Based on User

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Before you begin

- Configure one or more authoritative user identity sources as described in User Identity Sources, on page 1277.
- Configure a realm as described in Create a Realm, on page 1330.

Procedure

Step 1
In the SSL rule editor, select the Users tab.

Step 2
Search by name or value above the Available Realms list and select a realm.

Step 3
Search by name or value above the Available Users list and select a user or group.

Step 4
Click Add to Rule.

Tip
You can also drag and drop selected users and groups.

Step 5
Save or continue editing the rule.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Reputation-Based TLS/SSL Rule Conditions

Reputation-based conditions in TLS/SSL rules allow you to manage which encrypted traffic can traverse your network, by contextualizing your network traffic and limiting it where appropriate. SSL rules govern the following types of reputation-based control:

- Application conditions allow you to perform application control. When the system analyzes encrypted IP traffic, it can identify and classify commonly used encrypted applications on your network prior to decrypting the encrypted session. The system uses this discovery-based application awareness feature to allow you to control encrypted application traffic on your network.

  In a single TLS/SSL rule, you can select individual applications, including custom applications. You can use system-provided application filters, which are named sets of applications organized according to its basic characteristics: type, risk, business relevance, and categories.

- URL conditions allow you to control web traffic based on a websites’ assigned category and reputation.
Selected Applications and Filters in TLS/SSL Rules

Cisco frequently updates and adds additional detectors via system and vulnerability database (VDB) updates. You can also create your own detectors and assign characteristics (risk, relevance, and so on) to the applications they detect. By using filters based on application characteristics, you can ensure that the system uses the most up-to-date detectors to monitor application traffic.

For traffic to match a TLS/SSL rule with an application condition, the traffic must match one of the filters or applications that you add to a Selected Applications and Filters list.

When you filter application traffic using access control rules, you can use application tags as a criterion to filter. However, you cannot use application tags to filter encrypted traffic because there is no benefit. All applications that the system can detect in encrypted traffic are tagged SSL Protocol; applications without this tag can only be detected in unencrypted or decrypted traffic.

In a single application condition, you can add a maximum of 50 items to the Selected Applications and Filters list. Each of the following counts as an item:

- One or more filters from the Application Filters list, individually or in custom combination. This item represents set of applications, grouped by characteristic.
- A filter created by saving search of the applications in the Available Applications list. This item represents a set of applications, grouped by substring match.
- An individual application from the Available Applications list.

In the web interface, filters added to a condition are listed above and separately from individually added applications.

Note that when you deploy an SSL policy, for each rule with an application condition, the system generates a list of unique applications to match. In other words, you may use overlapping filters and individually specified applications to ensure complete coverage.

Application Filters in TLS/SSL Rules

When building an application condition in a TLS/SSL rule, use the Application Filters list to create a set of applications, grouped by characteristic, whose traffic you want to match.

For your convenience, the system characterizes each application by type, risk, business relevance, category, and tag. You can use these criteria as filters or create custom combinations of filters to perform application control.

Note that the mechanism for filtering applications in a TLS/SSL rule is the same as that for creating reusable, custom application filters using the object manager. You can also save many filters you create on-the-fly in access control rules as new, reusable filters. You cannot save a filter that includes another user-created filter because you cannot nest user-created filters.

Understanding How Filters Are Combined

When you select filters, singly or in combination, the Available Applications list updates to display only the applications that meet your criteria. You can select system-provided filters in combination, but not custom filters.
The system links multiple filters of the same filter type with an OR operation. For example, if you select the Medium and High filters under the Risks type, the resulting filter is:

Risk: Medium OR High

If the Medium filter contained 110 applications and the High filter contained 82 applications, the system displays all 192 applications in the Available Applications list.

The system links different types of filters with an AND operation. For example, if you select the Medium and High filters under the Risks type, and the Medium and High filters under the Business Relevance type, the resulting filter is:

Risk: Medium OR High
AND
Business Relevance: Medium OR High

In this case, the system displays only those applications that are included in both the Medium or High Risk type AND the Medium or High Business Relevance type.

Finding and Selecting Filters

To select filters, click the arrow next to a filter type to expand it, then select or clear the check box next to each filter whose applications you want to display or hide. You can also right-click a Cisco-provided filter type (Risks, Business Relevance, Types, or Categories) and select Check All or Uncheck All.

To search for filters, click the Search by name prompt above the Available Filters list, then type a name. The list updates as you type to display matching filters.

After you are done selecting filters, use the Available Applications list to add those filters to the rule.

Related Topics

Application Filters, on page 328

Available Applications in TLS/SSL Rules

When building an application condition in a TLS/SSL rule, use the Available Applications list to select the applications whose traffic you want to match.

Browsing the List of Applications

When you first start to build the condition the list is unconstrained, and displays every application the system detects, 100 at a time:

- To page through the applications, click the arrows underneath the list.
- To display a pop-up window with summary information about the application’s characteristics, as well as Internet search links that you can follow, click the information icon (i) next to an application.

Finding Applications to Match

To help you find the applications you want to match, you can constrain the Available Applications list in the following ways:

- To search for applications, click the Search by name prompt above the list, then type a name. The list updates as you type to display matching applications.
• To constrain the applications by applying a filter, use the Application Filters list. The Available Applications list updates as you apply filters.

Once constrained, an All apps matching the filter option appears at the top of the Available Applications list.

If you select one or more filters in the Application Filters list and also search the Available Applications list, your selections and the search-filtered Available Applications list are combined using an AND operation. That is, the All apps matching the filter condition includes all the individual conditions currently displayed in the Available Applications list as well as the search string entered above the Available Applications list.

Selecting Single Applications to Match in a Condition
After you find an application you want to match, click to select it. To select all applications in the current constrained view, right-click and select Select All.

In a single application condition, you can match a maximum of 50 applications by selecting them individually; to add more than 50 you must either create multiple TLS/SSL rules or use filters to group applications.

Selecting All Applications Matching a Filter for a Condition
Once constrained by either searching or using the filters in the Application Filters list, the All apps matching the filter option appears at the top of the Available Applications list.

This option allows you to add the entire set of applications in the constrained Available Applications list to the Selected Applications and Filters list, at once. In contrast to adding applications individually, adding this set of applications counts as only one item against the maximum of 50, regardless of the number of individual application that comprise it.

When you build an application condition this way, the name of the filter you add to the Selected Applications and Filters list is a concatenation of the filter types represented in the filter plus the names of up to three filters for each type. More than three filters of the same type are followed by an ellipsis (...). For example, the following filter name includes two filters under the Risks type and four under Business Relevance:

Risks: Medium, High Business Relevance: Low, Medium, High,...

Filter types that are not represented in a filter you add with All apps matching the filter are not included in the name of the filter you add. The instructional text that is displayed when you hover your pointer over the filter name in the Selected Applications and Filters list indicates that these filter types are set to any; that is, these filter types do not constrain the filter, so any value is allowed for these.

You can add multiple instances of All apps matching the filter to an application condition, with each instance counting as a separate item in the Selected Applications and Filters list. For example, you could add all high risk applications as one item, clear your selections, then add all low business relevance applications as another item. This application condition matches applications that are high risk OR have low business relevance.

Application-Based TLS/SSL Rule Condition Requirements
For encrypted traffic to match a TLS/SSL rule with an application condition, the traffic must match one of the filters or applications that you add to a Selected Applications and Filters list.
You can add a maximum of 50 items per condition, and filters added to a condition are listed above and separately from individually added applications. When building an application condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon.

## Adding an Application Condition to a TLS/SSL Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1**  In the SSL rule editor, select the Applications tab.

**Step 2**  If you want to constrain the list of applications displayed in the Available Applications list, you must select one or more filters in the Application Filters list. For more information, see Application Filters in TLS/SSL Rules, on page 764.

**Step 3**  Find and select the applications you want to add from the Available Applications list. You can search for and select individual applications, or, when the list is constrained, All apps matching the filter. For more information, see Available Applications in TLS/SSL Rules, on page 765.

**Step 4**  Click Add to Rule.

**Tip**  Click Clear All Filters to clear your existing selections. You can also drag and drop selected applications and filters.

**Step 5**  Save or continue editing the rule.

### Example

The following graphic shows the application condition for a TLS/SSL rule that decrypts a custom group of applications for MyCompany, all applications with high risk and low business relevance, gaming applications, and some individually selected applications.

![Selected Applications and Filters (6)](image)
Limitations to Encrypted Application Control

Encrypted Application Identification

The system can identify unencrypted applications that become encrypted using StartTLS. This includes such applications as SMTPS, POPS, FTPS, TelnetS, and IMAPS. In addition, it can identify certain encrypted applications based on the Server Name Indication in the TLS ClientHello message, or the server certificate subject distinguished name value.

Speed of Application Identification

The system cannot perform application control on encrypted traffic before:

- An encrypted connection is established between a client and server, and
- The system identifies the application in the encrypted session

This identification occurs after the server certificate exchange. If traffic exchanged during the TLS/SSL handshake matches all other conditions in a TLS/SSL rule containing an application condition but the identification is not complete, the SSL policy allows the packet to pass. This behavior allows the handshake to complete so that applications can be identified. For your convenience, affected rules are marked with an information icon (i).

After the system completes its identification, the system applies the TLS/SSL rule action to the remaining session traffic that matches its application condition.

Automatically Enabling Application Detectors

At least one detector must be enabled for each application rule condition in the policy. If no detector is enabled for an application, the system automatically enables all system-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application.

Related Topics

Activating and Deactivating Detectors, on page 1273

Reputation-Based URL Blocking in Encrypted Traffic

With a URL Filtering license, URL conditions in TLS/SSL rules can control access to encrypted websites, based on the category and reputation of the requested URLs. For detailed information, see URL Conditions (URL Filtering), on page 305.

Tip

URL conditions in TLS/SSL rules do not support manual URL filtering. Instead, use a distinguished name condition matching on the subject common name.
Block Encrypted Traffic Based on URL Reputation

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Filtering</td>
<td>URL Filtering</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1
In the SSL rule editor, select the Category tab.

Step 2
Find the categories of URL you want to add from the Categories list. To match encrypted web traffic regardless of category, select Any category. To search for categories to add, click the Search by name or value prompt above the Categories list, then type the category name. The list updates as you type to display matching categories.

Step 3
To select a category, click it.

Tip Although you can right-click and Select All categories, adding all categories this way exceeds the 50-item maximum for a TLS/SSL rule. Instead, use Any.

Step 4
If you want to qualify your category selections, you must click a reputation level from the Reputations list. You can only select one reputation level. If you do not specify a reputation level, the system defaults to Any, meaning all levels.

- If the rule blocks web access or decrypts traffic (the rule action is Block, Block with reset, Decrypt - Known Key, Decrypt - Resign, or Monitor) selecting a reputation level also selects all reputations more severe than that level. For example, if you configure a rule to block Suspicious sites (level 2), it also automatically blocks High Risk (level 1) sites.

- If the rule allows web access, subject to access control (the rule action is Do not decrypt), selecting a reputation level also selects all reputations less severe than that level. For example, if you configure a rule to allow Benign sites (level 4), it also automatically allows Well known (level 5) sites.

Note If you change the rule action for a rule, the system automatically changes the reputation levels in URL conditions according to the above points.

Step 5
Click Add to Rule to add the selected items to the Selected Categories list.

Tip You can also drag and drop selected items.

Step 6
Save or continue editing the rule.

Example
The following graphic shows the URL condition for an example access control rule that blocks: all malware sites, all high-risk sites, and all non-benign social networking sites.
The following table summarizes how you build the condition shown in the graphic above.

**Table 74: Example: Building A URL Condition**

<table>
<thead>
<tr>
<th>To block...</th>
<th>Select this Category or URL Object...</th>
<th>And this Reputation...</th>
</tr>
</thead>
<tbody>
<tr>
<td>malware sites, regardless of reputation</td>
<td>Malware Sites</td>
<td>Any</td>
</tr>
<tr>
<td>any URL with a high risk (level 1)</td>
<td>Any</td>
<td>1 - High Risk</td>
</tr>
<tr>
<td>social networking sites with a risk greater than benign (levels 1 through 3)</td>
<td>Social Network</td>
<td>3 - Benign sites with security risks</td>
</tr>
</tbody>
</table>

**What to do next**

- Deploy configuration changes; see *Deploy Configuration Changes*, on page 277.

### Server Certificate-Based TLS/SSL Rule Conditions

TLS/SSL rules can handle and decrypt encrypted traffic based on server certificate characteristics. You can configure TLS/SSL rules based on the following server certificate attributes:

- **Distinguished name conditions** allow you to handle and inspect encrypted traffic based on the CA that issued a server certificate, or the certificate holder. Based on the issuer distinguished name, you can handle traffic based on the CA that issued a site’s server certificate.

- **Certificate conditions** in TLS/SSL rules allow you to handle and inspect encrypted traffic based on the server certificate used to encrypt that traffic. You can configure a condition with one or more certificates; traffic matches the rule if the certificate matches any of the condition’s certificates.

- **Certificate status conditions** in TLS/SSL rules allow you to handle and inspect encrypted traffic based on the status of the server certificate used to encrypt the traffic, including whether a certificate is valid, revoked, expired, not yet valid, self-signed, signed by a trusted CA, whether the Certificate Revocation List (CRL) is valid; whether the Server Name Indication (SNI) in the certificate matches the server in the request.

- **Cipher suite conditions** in TLS/SSL rules allow you to handle and inspect encrypted traffic based on the cipher suite used to negotiate the encrypted session.

- **Session conditions** in TLS/SSL rules allow you to inspect encrypted traffic based on the SSL or TLS version used to encrypt the traffic.
To detect multiple cipher suites in a rule, the certificate issuer, or the certificate holder, you can create reusable cipher suite list and distinguished name objects and add them to your rule. To detect the server certificate and certain certificate statuses, you must create external certificate and external CA objects for the rule.

**Certificate Distinguished Name TLS/SSL Rule Conditions**

When configuring the rule condition, you can manually specify a literal value, reference a distinguished name object, or reference a distinguished name group containing multiple objects.

---

**Note**

You cannot configure a distinguished name condition if you also choose the **Decrypt - Known Key** action. Because that action requires you to choose a server certificate to decrypt traffic, the certificate already matches the traffic.

---

You can match against multiple subject and issuer distinguished names in a single certificate status rule condition; only one common or distinguished name needs to match to match the rule.

If you add a distinguished name manually, it can contain the common name attribute (CN). If you add a common name without **CN=**, the system prepends **CN=** before saving the object.

You can also add a distinguished name with one each of the following attributes, separated by commas: C, CN, O, OU.

In a single DN condition, you can add a maximum of 50 literal values and distinguished name objects to the **Subject DNs**, and 50 literal values and distinguished name objects to the **Issuer DNs**.

The system-provided DN object group, Cisco-Undecryptable-Sites, contains websites whose traffic the system cannot decrypt. You can add this group to a DN condition to block or not decrypt traffic to or from these websites, without wasting system resources attempting to decrypt that traffic. You can modify individual entries in the group. You cannot delete the group. System updates can modify the entries on this list, but the system preserves user changes.

**Controlling Encrypted Traffic by Certificate Distinguished Name**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**

In the SSL rule editor, select the DN tab.

**Step 2**

Find the distinguished names you want to add from the **Available DNs**, as follows:

- To add a distinguished name object on the fly, which you can then add to the condition, click the add icon (✓) above the **Available DNs** list.

- To search for distinguished name objects and groups to add, click the **Search by name or value** prompt above the **Available DNs** list, then type either the name of the object, or a value in the object. The list updates as you type to display matching objects.
**Step 3**
To select an object, click it. To select all objects, right-click and then select **Select All**.

**Step 4**
Click **Add to Subject** or **Add to Issuer**.

**Tip**
You can also drag and drop selected objects.

**Step 5**
Add any literal common names or distinguished names that you want to specify manually. Click the **Enter DN or CN** prompt below the **Subject DN**s or **Issuer DN**s list; then type a common name or distinguished name and click **Add**.

**Step 6**
Add or continue editing the rule.

---

**Example**

**Example**
The following graphic illustrates a distinguished name rule condition searching for certificates issued to goodbakery.example.com or issued by goodca.example.com. Traffic encrypted with these certificates is allowed, subject to access control.

<table>
<thead>
<tr>
<th>Subject DN (1)</th>
<th>Issuer DN (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good Bakery</td>
<td>CN=goodca.example.com</td>
</tr>
</tbody>
</table>

The following graphic illustrates a distinguished name rule condition searching for certificates issued to badbakery.example.com and associated domains, or certificates issued by badca.example.com. Traffic encrypted with these certificates is decrypted using a re-signed certificate.

<table>
<thead>
<tr>
<th>Subject DN (3)</th>
<th>Issuer DN (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bad Bakery</td>
<td>CN=badbakery2.example.com</td>
</tr>
<tr>
<td></td>
<td>C=US,CN=badbakery3.</td>
</tr>
<tr>
<td></td>
<td>Bad CA</td>
</tr>
</tbody>
</table>

**What to do next**
- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

**Related Topics**
- **Distinguished Name Objects**, on page 364

---

**Certificate TLS/SSL Rule Conditions**

When you build a certificate-based TLS/SSL rule condition, you can upload a server certificate; you save the certificate as an external certificate **object**, which is reusable and associates a name with a server certificate.
Alternately, you can configure certificate conditions with existing external certificate objects and object groups.

You can search the **Available Certificates** field in the rule condition based for external certificate objects and object groups based on the following certificate distinguished name characteristics:

- Subject or issuer common name (CN)
- Subject or issuer organization (O)
- Subject or issuer organizational unit (OU)

You can choose to match against multiple certificates in a single certificate rule condition; if the certificate used to encrypt the traffic matches any of the uploaded certificates, the encrypted traffic matches the rule.

You can add a maximum of 50 external certificate objects and external certificate object groups to the **Selected Certificates** in a single certificate condition.

Note the following:

- You cannot configure a certificate condition if you also select the **Decrypt - Known Key** action. Because that action requires you to select a server certificate to decrypt traffic, the implication is that the certificate already matches the traffic.

- If you configure a certificate condition with an external certificate object, any cipher suites you add to a cipher suite condition, or internal CA objects you associate with the **Decrypt - Resign** action, must match the external certificate’s signature algorithm type. For example, if your rule’s certificate condition references an EC-based server certificate, any cipher suites you add, or CA certificates you associate with the **Decrypt - Resign** action, must also be EC-based. If you mismatch signature algorithm types in this case, the policy editor displays a warning icon next to the rule.

## Controlling Encrypted Traffic by Certificate

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1**
In the SSL rule editor, select the Certificate tab.

**Step 2**
Find the server certificates you want to add from the **Available Certificates**, as follows;

- To add an external certificate object on the fly, which you can then add to the condition, click the add icon (▼) above the **Available Certificates** list.

- To search for certificate objects and groups to add, click the **Search by name or value** prompt above the **Available Certificates** list, then type either the name of the object, or a value in the object. The list updates as you type to display matching objects.

**Step 3**
To select an object, click it. To select all objects, right-click and then select **Select All**.

**Step 4**
Click **Add to Rule**.
Tip You can also drag and drop selected objects.

Step 5 Add or continue editing the rule.

What to do next
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics
- External Certificate Objects, on page 374

Certificate Status TLS/SSL Rule Conditions

For each certificate status TLS/SSL rule condition you configure, you can match traffic against the presence or absence of a given status. You can select several statuses in one rule condition; if the certificate matches any of the selected statuses, the rule matches the traffic.

You can choose to match against the presence or absence of multiple certificate statuses in a single certificate status rule condition; the certificate needs to match only one of the criteria to match the rule.

You should consider, when setting this parameter, whether you're configuring a decrypt rule or a block rule. Typically, you should click Yes for a block rule and No for a decrypt rule. Examples:

- If you're configuring a Decrypt - Resign rule, the default behavior is to decrypt traffic with an expired certificate. To change that behavior, click No for Expired so traffic with an expired certificate is not decrypted and resigned.
- If you're configuring a Block rule, the default behavior is to allow traffic with an expired certificate. To change that behavior click Yes for Expired so traffic with an expired certificate is blocked.

The following table describes how the system evaluates encrypted traffic based on the encrypting server certificate’s status.

<table>
<thead>
<tr>
<th>Status Check</th>
<th>Status Set to Yes</th>
<th>Status Set to No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revoked</td>
<td>The policy trusts the CA that issued the server certificate, and the CA certificate uploaded to the policy contains a CRL that revokes the server certificate.</td>
<td>The policy trusts the CA that issued the server certificate, and the CA certificate uploaded to the policy does not contain a CRL that revokes the certificate.</td>
</tr>
<tr>
<td>Self-signed</td>
<td>The detected server certificate contains the same subject and issuer distinguished name.</td>
<td>The detected server certificate contains different subject and issuer distinguished names.</td>
</tr>
</tbody>
</table>
## Certificate Status TLS/SSL Rule Conditions

<table>
<thead>
<tr>
<th>Status Check</th>
<th>Status Set to Yes</th>
<th>Status Set to No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid</td>
<td>All of the following are true:</td>
<td>At least one of the following is true:</td>
</tr>
<tr>
<td></td>
<td>• The policy trusts the CA that issued the certificate.</td>
<td>• The policy does not trust the CA that issued the certificate.</td>
</tr>
<tr>
<td></td>
<td>• The signature is valid.</td>
<td>• The signature is invalid.</td>
</tr>
<tr>
<td></td>
<td>• The issuer is valid.</td>
<td>• The issuer is invalid.</td>
</tr>
<tr>
<td></td>
<td>• None of the policy’s trusted CAs revoked the certificate.</td>
<td>• A trusted CA in the policy revoked the certificate.</td>
</tr>
<tr>
<td></td>
<td>• The current date is between the certificate Valid From and Valid To date.</td>
<td>• The current date is before the certificate Valid From date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The current date is after the certificate Valid To date.</td>
</tr>
<tr>
<td>Invalid signature</td>
<td>The certificate’s signature cannot be properly validated against the certificate’s content.</td>
<td>The certificate’s signature is properly validated against the certificate’s content.</td>
</tr>
<tr>
<td>Invalid issuer</td>
<td>The issuer CA certificate is not stored in the policy’s list of trusted CA certificates.</td>
<td>The issuer CA certificate is stored in the policy’s list of trusted CA certificates.</td>
</tr>
<tr>
<td>Expired</td>
<td>The current date is after the certificate Valid To date.</td>
<td>The current date is before or on the certificate Valid To date.</td>
</tr>
<tr>
<td>Not yet valid</td>
<td>The current date is before the certificate Valid From date.</td>
<td>The current date is after or on the certificate Valid From date.</td>
</tr>
<tr>
<td>Status Check</td>
<td>Status Set to Yes</td>
<td>Status Set to No</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Invalid certificate</td>
<td>The certificate is not valid. At least one of the following is true:</td>
<td>The certificate is valid. All of the following are true:</td>
</tr>
<tr>
<td></td>
<td>• Invalid or inconsistent certificate extension; that is, a certificate extension</td>
<td>• Valid certificate extension.</td>
</tr>
<tr>
<td></td>
<td>had an invalid value (for example, an incorrect encoding) or some value</td>
<td>• The certificate can be used for the specified purpose.</td>
</tr>
<tr>
<td></td>
<td>inconsistent with other extensions.</td>
<td>• Valid Basic Constraints path length.</td>
</tr>
<tr>
<td></td>
<td>• The certificate cannot be used for the specified purpose.</td>
<td>• Valid values for Not Before and Not After.</td>
</tr>
<tr>
<td></td>
<td>• The Basic Constraints path length parameter has been exceeded.</td>
<td>• Valid name constraint.</td>
</tr>
<tr>
<td></td>
<td>For more information, see RFC 5280, section 4.2.1.9.</td>
<td>• The root certificate is trusted for the specified purpose.</td>
</tr>
<tr>
<td></td>
<td>• The certificate's value for Not Before or Not After is invalid. These dates</td>
<td>• The root certificate accepts the specified purpose.</td>
</tr>
<tr>
<td></td>
<td>can be encoded as UTCTime or GeneralizedTime</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For more information, see RFC 5280 section 4.1.2.5.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The format of the name constraint is not recognized; for example, an email</td>
<td></td>
</tr>
<tr>
<td></td>
<td>address format of a form not mentioned in RFC 5280, section 4.2.1.10. This</td>
<td></td>
</tr>
<tr>
<td></td>
<td>could be caused by an improper extension or some new feature not currently</td>
<td></td>
</tr>
<tr>
<td></td>
<td>supported.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>An unsupported name constraint type was encountered. OpennSSL currently supports</td>
<td></td>
</tr>
<tr>
<td></td>
<td>only directory name, DNS name, email, and URI types.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The root certificate authority is not trusted for the specified purpose.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The root certificate authority rejects the specified purpose.</td>
<td></td>
</tr>
<tr>
<td>Status Check</td>
<td>Status Set to Yes</td>
<td>Status Set to No</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------</td>
<td>-----------------</td>
</tr>
</tbody>
</table>
| Invalid CRL  | The Certificate Revocation List (CRL) digital signature is not valid. At least one of the following is true:  
- The value of the CRL's Next Update or Last Update field is invalid.  
- The CRL is not yet valid.  
- The CRL has expired.  
- An error occurred when attempting to verify the CRL path. This error occurs only if extended CRL checking is enabled.  
- CRL could not be found.  
- The only CRLs that could be found did not match the scope of the certificate. | The CRL is valid. All of the following are true:  
- Next Update and Last Update fields are valid.  
- The CRL's date is valid.  
- The path is valid.  
- The CRL was found.  
- The CRL matches the certificate's scope. |

Note that even though a certificate might match more than one status, the rule causes an action to be taken on the traffic only once.

Checking whether a CA issued or revoked a certificate requires uploading root and intermediate CA certificates and associated CRLs as objects. You then add these trusted CA objects to an SSL policy’s list of trusted CA certificates.

**Trusting External Certificate Authorities**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

You can trust CAs by adding root and intermediate CA certificates to your SSL policy, then use these trusted CAs to verify server certificates used to encrypt traffic.

If a trusted CA certificate contains an uploaded certificate revocation list (CRL), you can also verify whether a trusted CA revoked the encryption certificate.

**Procedure**

**Step 1** In the SSL rule editor, select the **Trusted CA Certificates** tab.

**Step 2** Find the trusted CAs you want to add from the **Available Trusted CAs**, as follows:

- To add a trusted CA object on the fly, which you can then add to the condition, click the add icon (➕) above the **Available Trusted CAs** list.
• To search for trusted CA objects and groups to add, click the Search by name or value prompt above the Available Trusted CAs list, then type either the name of the object, or a value in the object. The list updates as you type to display matching objects.

**Step 3**
To select an object, click it. To select all objects, right-click and then select Select All.

**Step 4**
Click Add to Rule.

**Tip** You can also drag and drop selected objects.

**Step 5**
Add or continue editing the rule.

---

**What to do next**

• Add a certificate status TLS/SSL rule condition to your SSL rule. See Matching Traffic on Certificate Status, on page 778 for more information.

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

- Trusted Certificate Authority Objects, on page 372

---

**Trusted External Certificate Authority Configuration**

Verified server certificates include certificates signed by trusted CAs. After you add trusted CA certificates to the SSL policy, you can configure a TLS/SSL rule with certificate status conditions to match against this traffic.

**Tip**
Upload all certificates within a root CA's chain of trust to the list of trusted CA certificates, including the root CA certificate and all intermediate CA certificates. Otherwise, it is more difficult to detect trusted certificates issued by intermediate CAs. Also, if you configure certificate status conditions to trust traffic based on the root issuer CA, all traffic within a trusted CA's chain of trust can be allowed without decryption, rather than unnecessarily decrypting it.

When you create an SSL policy, the system populates the Trusted CA Certificates tab with a default Trusted CA object group, Cisco Trusted Authorities. You can modify individual entries in the group, and choose whether to include this group in your SSL policy. You cannot delete the group. System updates can modify the entries on this list, but user changes are preserved.

---

**Matching Traffic on Certificate Status**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>
Before you begin

- Add a trusted CA object or group to your SSL policy. See Trusting External Certificate Authorities, on page 777 for more information.

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>In the Firepower Management Center, choose Policies &gt; Access Control &gt; SSL.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Add a new policy or edit an existing policy.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Add a new TLS/SSL rule or edit an existing rule.</td>
</tr>
<tr>
<td>Step 4</td>
<td>In the Add Rule or Editing Rule dialog box, choose the Cert Status tab.</td>
</tr>
<tr>
<td>Step 5</td>
<td>For each certificate status, you have the following options:</td>
</tr>
<tr>
<td></td>
<td>- Choose Yes to match against the presence of that certificate status.</td>
</tr>
<tr>
<td></td>
<td>- Choose No to match against the absence of that certificate status.</td>
</tr>
<tr>
<td></td>
<td>- Choose Any to skip the condition when matching the rule. In other words, choosing Any means the rule matches whether the certificate status is present or absent.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Add or continue editing the rule.</td>
</tr>
</tbody>
</table>

Example

The organization trusts the Verified Authority certificate authority. The organization does not trust the Spammer Authority certificate authority. The system administrator uploads the Verified Authority certificate and an intermediate CA certificate issued by Verified Authority to the system. Because Verified Authority revoked a certificate it previously issued, the system administrator uploads the CRL that Verified Authority provided.

The following graphic illustrates a certificate status rule condition checking for valid certificates, those issued by a Verified Authority, are not on the CRL, and still within the Valid From and Valid To date. Because of the configuration, traffic encrypted with these certificates is not decrypted and inspected with access control.

The following graphic illustrates a certificate status rule condition checking for the absence of a status. In this case, because of the configuration, it matches against traffic encrypted with a certificate that has not expired and monitors that traffic.
The following graphic illustrates a certificate status rule condition that matches on the presence or absence of several statuses. Because of the configuration, if the rule matches incoming traffic encrypted with a certificate issued by an invalid user, self-signed, invalid, or expired, it decrypts the traffic with a known key.

**Note**

You cannot add new cipher suites. You can neither modify nor delete predefined cipher suites.

You can add a maximum of 50 cipher suites and cipher suite lists to the **Selected Cipher Suites** in a single cipher suite condition. The system supports adding the following cipher suites to a cipher suite condition:

- SSL_RSA_FIPS_WITH_3DES_EDE_CBC_SHA
- SSL_RSA_FIPS_WITH_DES_CBC_SHA
- TLS_DHE_RSA_WITH_3DES_EDE_CBC_SHA
- TLS_DHE_RSA_WITH_DES_CBC_SHA
- TLS_DHE_RSA_WITH_3DES_EDE_CBC_SHA

**Cipher Suite TLS/SSL Rule Conditions**

The system provides predefined cipher suites you can add to a cipher suite rule condition. You can also add cipher suite list objects containing multiple cipher suites.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
• TLS_DHE_RSA_WITH_AES_128_CBC_SHA
• TLS_DHE_RSA_WITH_AES_128_CBC_SHA256
• TLS_DHE_RSA_WITH_AES_128_GCM_SHA256
• TLS_DHE_RSA_WITH_AES_256_CBC_SHA
• TLS_DHE_RSA_WITH_AES_256_CBC_SHA256
• TLS_DHE_RSA_WITH_AES_256_GCM_SHA384
• TLS_DHE_RSA_WITH_CAMELLIA_128_CBC_SHA
• TLS_DHE_RSA_WITH_CAMELLIA_128_CBC_SHA256
• TLS_DHE_RSA_WITH_CAMELLIA_256_CBC_SHA
• TLS_DHE_RSA_WITH_CAMELLIA_256_CBC_SHA256
• TLS_DHE_RSA_WITH_DES_CBC_SHA
• TLS_DH_Anon_WITH_AES_128_GCM_SHA256
• TLS_DH_Anon_WITH_AES_256_GCM_SHA384
• TLS_DH_Anon_WITH_CAMELLIA_128_CBC_SHA
• TLS_DH_anon_WITH_CAMELLIA_128_CBC_SHA256
• TLS_DH_Anon_WITH_CAMELLIA_256_CBC_SHA
• TLS_DH_anon_WITH_CAMELLIA_256_CBC_SHA256
• TLS_ECDHE_ECDSA_WITH_3DES_EDE_CBC_SHA
• TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA
• TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA256
• TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256
• TLS_ECDHE_ECDSA_WITH_AES_256_CBC_SHA
• TLS_ECDHE_ECDSA_WITH_AES_256_CBC_SHA384
• TLS_ECDHE_ECDSA_WITH_NULL_SHA
• TLS_ECDHE_ECDSA_WITH_RC4_128_SHA
• TLS_ECDHE_RSA_WITH_3DES_EDE_CBC_SHA
• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA
• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256
• TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256
• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA
• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384
• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384
• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA256
• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA256
• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384
• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA256
• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
• TLS_ECDHE_RSA_WITH_NULL_SHA
• TLS_ECDHE_RSA_WITH_RC4_128_SHA
• TLS_RSA_WITH_3DES_EDE_CBC_SHA
• TLS_RSA_WITH_AES_128_CBC_SHA
• TLS_RSA_WITH_AES_128_CBC_SHA256
• TLS_RSA_WITH_AES_256_CBC_SHA
• TLS_RSA_WITH_AES_256_CBC_SHA256
• TLS_RSA_WITH_AES_256_GCM_SHA384
• TLS_RSA_WITH_CAMELLIA_128_CBC_SHA
• TLS_RSA_WITH_CAMELLIA_128_CBC_SHA256
• TLS_RSA_WITH_CAMELLIA_256_CBC_SHA
• TLS_RSA_WITH_CAMELLIA_256_CBC_SHA256
• TLS_RSA_WITH_DES_CBC_SHA
• TLS_RSA_WITH_NULL_MD5
• TLS_RSA_WITH_NULL_SHA
• TLS_RSA_WITH_RC4_128_MD5
• TLS_RSA_WITH_RC4_128_SHA

Note the following:
• If you add cipher suites not supported for your deployment, you cannot deploy your configuration. For example, passive deployments do not support decrypting traffic with the any of the ephemeral Diffie-Hellman (DHE) or ephemeral elliptic curve Diffie-Hellman (ECDHE) cipher suites. Creating a rule with these cipher suites prevents you from deploying your access control policy.

• If you configure a cipher suite condition with a cipher suite, any external certificate objects you add to a certificate condition, or internal CA objects you associate with the Decrypt - Resign action, must match the cipher suite’s signature algorithm type. For example, if your rule’s cipher suite condition references an EC-based cipher suite, any server certificates you add, or CA certificates you associate with the Decrypt - Resign action, must also be EC-based. If you mismatch signature algorithm types in this case, the policy editor displays a warning icon next to the rule.

• The system cannot decrypt traffic encrypted with an anonymous cipher suite. You cannot use either the Decrypt - Resign or Decrypt - Known Key action in an SSL rule if you add an anonymous cipher suite to the Cipher Suite condition.
Controlling Encrypted Traffic by Cipher Suite

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  
In the SSL rule editor, select the Cipher Suite tab.

**Step 2**  
Find the cipher suites you want to add from the *Available Cipher Suites*, as follows;

- To add a cipher suite list on the fly, which you can then add to the condition, click the add icon (⊕) above the *Available Cipher Suites* list.

- To search for cipher suites and lists to add, click the **Search by name or value** prompt above the *Available Cipher Suites* list, then type either the name of the cipher suite, or a value in the cipher suite. The list updates as you type to display matching cipher suites.

**Step 3**  
To select a cipher suite, click it. To select all cipher suites, right-click and then select **Select All**.

**Step 4**  
Click **Add to Rule**.

**Tip**  
You can also drag and drop selected cipher suites.

**Step 5**  
Add or continue editing the rule.

**What to do next**

- Deploy configuration changes; see *Deploy Configuration Changes*, on page 277.

**Related Topics**

- *Cipher Suite Lists*, on page 363

**Encryption Protocol Version TLS/SSL Rule Conditions**

You can choose to match against traffic encrypted with SSL version 3.0, or TLS version 1.0, 1.1, or 1.2. By default, all protocol versions are selected when you create a rule; if you select multiple versions, encrypted traffic that matches any of the selected versions matches the rule. You must select at least one protocol version when saving the rule condition.

You cannot select SSL v2.0 in a version rule condition; the system does not support decrypting traffic encrypted with SSL version 2.0. You can configure an undecryptable action to allow or block this traffic without further inspection.
Controlling Traffic by Encryption Protocol Version

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1**
In the SSL rule editor, select the Version tab.

**Step 2**
Select the protocol versions you want to match against.

**Step 3**
Add or continue editing the rule.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
CHAPTER 45

Troubleshoot TLS/SSL Rules

You can diagnose whether or not applications on your network use TLS/SSL pinning with connection events. If applications are using TLS/SSL pinning, see TLS/SSL Rule Guidelines and Limitations, on page 737.

• About TLS/SSL Pinning, on page 785
• Verify TLS/SSL Cipher Suites, on page 787

About TLS/SSL Pinning

Some applications use a technique referred to as **TLS/SSL pinning** or **certificate pinning**, which embeds the fingerprint of the original server certificate in the application itself. As a result, if you configured a TLS/SSL rule with a **Decrypt - Resign** action, when the application receives a resigned certificate from a managed device, validation fails and the connection is aborted.

To confirm that TLS/SSL pinning is occurring, attempt to log in to a mobile application like Facebook. If a network connection error is displayed, log in using a web browser. (For example, you cannot log in to a Facebook mobile application but can log in to Facebook using Safari or Chrome.) You can use Firepower Management Center connection events as further proof of TLS/SSL pinning.

---

**Note**

TLS/SSL pinning is not limited to mobile applications.

Related Topics

Troubleshoot TLS/SSL Pinning, on page 785

Troubleshoot TLS/SSL Pinning

You can view connection events to determine whether or not the devices are experiencing SSL pinning. You must add at least the **SSL Flow Flags** and **SSL Flow Messages** columns to the table view of connection events.

**Before you begin**

• Enable logging for your TLS/SSL rules as discussed in Logging Decryptable Connections with SSL Rules, on page 1591.
• Log in to a mobile application like Facebook; if a network connection error displays, log in to Facebook using Chrome or Safari. If you *can* log in using a web browser but not the native application, SSL pinning is likely occurring.

**Procedure**

**Step 1**
If you haven't done so already, log in to the Firepower Management Center.

**Step 2**
Click **Analysis > Connection > Events**.

**Step 3**
Click **Table View of Connection Events**.

**Step 4**
Click x on any column to add additional columns to at least the **SSL Flow Flags** and **SSL Flow Messages** columns the connection events table.

![SSL Status](image)

The following example shows adding the **SSL Actual Action**, **SSL Flow Error**, **SSL Flow Flags**, **SSL Flow Messages**, **SSL Policy**, and **SSL Rule** columns to the table of connection events.

![Table View](image)

The columns are added in the order discussed in *Connection and Security Intelligence Event Fields*, on page 1597.

**Step 5**
Click **Apply**.

**Step 6**
The following paragraphs discuss how you can identify SSL pinning behavior.

**Step 7**
If you determine that applications in your network use SSL pinning, see *TLS/SSL Rule Guidelines and Limitations*, on page 737.
What to do next

You can use TLS/SSL connection events to confirm TLS/SSL pinning is occurring by looking for any of the following:

- Applications that send an SSL ALERT Message as soon as the client receives the SERVER_HELLO, SERVER_CERTIFICATE, SERVER_HELLO_DONE message from the server, followed by a TCP Reset, exhibit the following symptoms. (The alert, Unknown CA (48), can be viewed using a packet capture.)
  - The SSL Flow Flags column displays ALERT_SEEN but not APP_DATA_C2S or APP_DATA_S2C.
  - The SSL Flow Messages column typically displays: CLIENT_HELLO, SERVER_HELLO, SERVER_CERTIFICATE, SERVER_KEY_EXCHANGE, SERVER_HELLO_DONE.
  - Success is displayed in the SSL Flow Error column.

- Applications that send no alerts but instead send TCP Reset after the SSL handshake is finished exhibit the following symptoms:
  - The SSL Flow Flags column does not display ALERT_SEEN, APP_DATA_C2S, or APP_DATA_S2C.
  - The SSL Flow Messages column typically displays: CLIENT_HELLO, SERVER_HELLO, SERVER_CERTIFICATE, SERVER_KEY_EXCHANGE, SERVER_HELLO_DONE, CLIENT_KEY_EXCHANGE, CLIENT_CHANGE_CIPHER_SPEC, CLIENT_FINISHED, SERVER_CHANGE_CIPHER_SPEC, SERVER_FINISHED.
  - Success is displayed in the SSL Flow Error column.

Related Topics

- Using Connection and Security Intelligence Event Tables, on page 1615
- Connection and Security Intelligence Event Fields, on page 1597
- Information Available in Connection Event Fields, on page 1612
- Event Searches, on page 1553

Verify TLS/SSL Cipher Suites

Before you begin

This topic discusses actions you must take if you see the following error when saving a TLS/SSL rule that has cipher suite conditions:

Traffic cannot match this rule; none of your selected cipher suites contain a signature algorithm that the resigning CA's signature algorithm

The error indicates that one or more of the cipher suites you chose for the TLS/SSL rule condition are incompatible with the certificate used in the TLS/SSL rule. To resolve the issue, you must have access to the certificate you're using.

Note

The tasks in this topic assume knowledge of how TLS/SSL encryption works.
**Procedure**

**Step 1** When you attempt to save an SSL rule with either Decrypt - Resign or Decrypt - Known Key with specified cipher suites, the following error is displayed:

**Example:**
Traffic cannot match this rule; none of your selected cipher suites contain a signature algorithm that the resigning CA’s signature algorithm

**Step 2** Locate the certificate you’re using to decrypt traffic and, if necessary, copy the certificate to a system that can run openssl commands.

**Step 3** Run the following command to display the signature algorithm used by the certificate:

```
openssl x509 -in CertificateName -text -noout
```

The first few lines of output are displayed similar to the following:

```
Certificate:
   Data:
      Version: 3 (0x2)
      Serial Number: 4105 (0x1009)
      Signature Algorithm: ecdsa-with-SHA256
```

**Step 4** The **Signature algorithm** tells you the following:

- The cryptographic function used (in the preceding example, **ECDSA** means Elliptic Curve Digital Signature Algorithm).
- The hash function used to create a digest of the encrypted message (in the preceding example, **SHA256**).

**Step 5** Search a resource such as [OpenSSL at University of Utah](https://www.openssl.org) for cipher suites that match those values. The cipher suite must be in RFC format.

You can also search a variety of other sites, such as [Server Side TLS](https://server-side-tls.org) at the Mozilla wiki or **Appendix C of RFC 5246. Cipher Suites in TLS/SSL (Schannel SSP)** in Microsoft documentation has a detailed explanation of cipher suites.

**Step 6** If necessary, translate the OpenSSL name to an RFC name that the Firepower Management System uses. See the **RFC mapping list** on the [https://testssl.sh](https://testssl.sh) site.

**Step 7** The previous example, **ecdsa-with-SHA256**, can be found in the **Modern Compatibility List** on the Mozilla wiki.

a) Choose only cipher suites that have **ECDSA** and **SHA-256** in the name. These cipher suites follow:

```
ECDHE-ECDSA-AES128-GCM-SHA256
ECDHE-ECDSA-AES128-SHA256
```

b) Find the corresponding RFC cipher suite on **RFC mapping list**. These cipher suites follow:

```
TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256
TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA256
```

**Step 8** Add the preceding cipher suites to your TLS/SSL rule.
PART XII

Advanced Malware Protection (AMP) and File Control

• File Policies and Advanced Malware Protection, on page 791
• File and Malware Inspection Performance and Storage Tuning, on page 827
File Policies and Advanced Malware Protection

The following topics provide an overview of file control, file policies, file rules, AMP cloud connections, and dynamic analysis connections.

- About File Policies and Advanced Malware Protection, on page 791
- Malware Protection Methods, on page 791
- License Requirements for File and Malware Policies, on page 795
- How to Configure Malware Protection, on page 796
- Cloud Connections for Malware Protection, on page 799
- File Policies and File Rules, on page 807
- Retrospective Disposition Changes, on page 821
- (Optional) Malware Protection with AMP for Endpoints, on page 821
- History for the File and Malware Chapter, on page 825

About File Policies and Advanced Malware Protection

File policies can optionally be configured to detect and block malware.

Advanced Malware Protection (AMP) for Firepower can detect, capture, track, analyze, log, and optionally block the transmission of malware in network traffic. In the Firepower Management Center web interface, this feature is called AMP for Networks, formerly called AMP for Firepower. AMP identifies malware using threat data from the Cisco cloud and managed devices deployed inline.

You implement Advanced Malware Protection using file policies, which you associate with access control rules that handle network traffic as part of your overall access control configuration.

When the system detects malware on your network, it generates file and malware events. To analyze file and malware event data, see File/Malware Events and Network File Trajectory, on page 1669.

Malware Protection Methods

The Firepower system applies several methods of file inspection and analysis to determine whether a file contains malware.

Depending on the options you enable in a file rule, the system inspects files using the following tools, in order:

1. Spero Analysis, on page 792 and AMP Cloud Lookup, on page 792
2. Local Malware Analysis, on page 792

3. Dynamic Analysis, on page 793

For a comparison of these tools, see Comparison of Malware Protection Methods, on page 794.

(You can also, if you choose, block all files based on their file type. For more information, see Block All Files by Type, on page 794.)

See also information about Cisco's AMP for Endpoints product at (Optional) Malware Protection with AMP for Endpoints, on page 821 and subtopics.

**Spero Analysis**

Spero analysis examines structural characteristics such as metadata and header information in executable files. After generating a Spero signature based on this information, if the file is an eligible executable file, the device submits it to the Spero heuristic engine in the AMP cloud. Based on the Spero signature, the Spero engine determines whether the file is malware. You can also configure rules to submit files for Spero analysis without also submitting them to the AMP cloud.

Note that you cannot manually submit files for Spero analysis.

**AMP Cloud Lookup**

For files that are eligible for assessment using Advanced Malware Protection, the Firepower Management Center performs a *malware cloud lookup*, querying the AMP cloud for the file's disposition based on its SHA-256 hash value.

To improve performance, the system caches dispositions returned by the cloud and uses the cached disposition for known files rather than querying the AMP cloud. For more information about this cache, see Cached Disposition Longevity, on page 792.

**Local Malware Analysis**

Local malware analysis allows a managed device to locally inspect executables, PDFs, office documents, and other types of files for the most common types of malware, using a detection rule set provided by the Cisco Talos Security Intelligence and Research Group (Talos). Because local analysis does not query the AMP cloud, and does not run the file, local malware analysis saves time and system resources.

If the system identifies malware through local malware analysis, it updates the existing file disposition from Unknown to Malware. The system then generates a new malware event. If the system does not identify malware, it does not update the file disposition from Unknown to Clean. After the system runs local malware analysis, it caches file information such as SHA-256 hash value, timestamp, and disposition, so that if detected again within a certain period of time, the system can identify malware without additional analysis. For more information about the cache, see Cached Disposition Longevity, on page 792.

Local malware analysis does not require establishing communications with the Cisco Threat Grid cloud. However, you must configure communications with the cloud to submit files preclassified as malware for dynamic analysis, and to download updates to the local malware analysis ruleset.

**Cached Disposition Longevity**

Dispositions returned from an AMP cloud query, associated threat scores, and dispositions assigned by local malware analysis, have a time-to-live (TTL) value. After a disposition has been held for the duration specified
in the TTL value without update, the system purges the cached information. Dispositions and associated threat scores have the following TTL values:

- Clean — 4 hours
- Unknown — 1 hour
- Malware — 1 hour

If a query against the cache identifies a cached disposition that timed out, the system re-queries the local malware analysis database and the AMP cloud for a new disposition.

**Dynamic Analysis**

You can configure your file policy to automatically submit files for dynamic analysis using Cisco Threat Grid (formerly AMP Threat Grid), Cisco’s file analysis and threat intelligence platform.

Devices submit eligible files to Cisco Threat Grid (either the public cloud or to an on-premises appliance, whichever you have specified) regardless of whether the device stores the file.

Cisco Threat Grid runs the file in a sandbox environment, analyzes the file’s behavior to determine whether the file is malicious, and returns a threat score that indicates the likelihood that a file contains malware. From the threat score, you can view a dynamic analysis summary report with the reasons for the assigned threat score. You can also look in Cisco Threat Grid to view detailed reports for files that your organization submitted, as well as scrubbed reports with limited data for files that your organization did not submit.

You can optionally configure the file policy to override AMP cloud file dispositions based on the threat score.


To configure your system to perform dynamic analysis, see the topics under **Dynamic Analysis Connections**, on page 804.

**Which Files Are Eligible for Dynamic Analysis?**

A file's eligibility for dynamic analysis depends on:

- the file type
- the file size
- the file rule's action

Additionally:

- The system submits only files that match the file rules you configure.
- The file must have a malware cloud lookup disposition of Unknown or Unavailable at the time the file is sent for analysis.
- The system must preclassify the file as potential malware.
Block All Files by Type

If your organization wants to block not only the transmission of malware files, but all files of a specific type, regardless of whether the files contain malware, you can do so.

File control is supported for all file types where the system can detect malware, plus many additional file types. These file types are grouped into basic categories, such as multimedia (swf, mp3), executables (exe, torrent), and PDFs.

Blocking all files based on their type is not technically a malware protection feature; it does not require a Malware license and does not query the AMP cloud.

Comparison of Malware Protection Methods

The following table details the benefits and drawbacks of each type of file analysis, as well as the way each malware protection method determines a file's disposition.

<table>
<thead>
<tr>
<th>Analysis Type</th>
<th>Benefit</th>
<th>Limitations</th>
<th>Malware Identification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spero analysis</td>
<td>Structural analysis of executable files, submits Spero signature to the AMP Cloud for analysis</td>
<td>Less thorough than local malware analysis or dynamic analysis, only for executable files</td>
<td>Disposition changes from Unknown to Malware only on positive identification of malware.</td>
</tr>
<tr>
<td>Local malware analysis</td>
<td>Consumes fewer resources than dynamic analysis, and returns results more quickly, especially if the detected malware is common</td>
<td>Less thorough results than dynamic analysis</td>
<td>Disposition changes from Unknown to Malware only on positive identification of malware.</td>
</tr>
<tr>
<td>Dynamic analysis</td>
<td>Thorough analysis of unknown files using Cisco Threat Grid</td>
<td>Eligible files are uploaded to the public cloud or an on-premises appliance. It takes some time to complete analysis</td>
<td>Threat score determines maliciousness of a file. Disposition is based on the threat score threshold configured in the file policy.</td>
</tr>
<tr>
<td>Spero analysis and local malware analysis</td>
<td>Consumes fewer resources than configuring local malware analysis and dynamic analysis, while still using AMP cloud resources to identify malware</td>
<td>Less thorough than dynamic analysis, Spero analysis only for executable files</td>
<td>Disposition changes from Unknown to Malware only on positive identification of malware.</td>
</tr>
</tbody>
</table>
Malware Identification

Limitations

Benefit Analysis Type

Threat score changes based on dynamic analysis results for files preclassified as possible malware. Disposition changes based on configured threat score threshold in the file policy, and from Unknown to Malware if the Spero analysis identifies malware.

Results obtained less quickly than if using local malware analysis.

Uses full capabilities of AMP cloud in submitting files and Spero signatures.

Files obtained less quickly than if using local malware analysis.

Uses full capabilities of AMP cloud in submitting files and Spero signatures.

Files obtained less quickly than if using local malware analysis.

Consumes more resources than either alone.

Preclassification does not itself determine a file's disposition; it is merely one of the factors that determine whether a file is eligible for Dynamic Analysis.

License Requirements for File and Malware Policies

<table>
<thead>
<tr>
<th>Analysis Type</th>
<th>Benefit</th>
<th>Limitations</th>
<th>Malware Identification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spero analysis and dynamic analysis</td>
<td>Uses full capabilities of AMP cloud in submitting files and Spero signatures</td>
<td>Results obtained less quickly than if using local malware analysis</td>
<td>Threat score changes based on dynamic analysis results for files preclassified as possible malware. Disposition changes based on configured threat score threshold in the file policy, and from Unknown to Malware if the Spero analysis identifies malware.</td>
</tr>
<tr>
<td>Local malware analysis and dynamic analysis</td>
<td>Thorough results in using both types of file analysis</td>
<td>Consumes more resources than either alone</td>
<td>Threat score changes based on dynamic analysis results for files preclassified as possible malware. Disposition changes from Unknown to Malware if local malware analysis identifies malware, or based on configured threat score threshold in the file policy.</td>
</tr>
<tr>
<td>Spero analysis, local malware analysis and dynamic analysis</td>
<td>Most thorough results</td>
<td>Consumes most resources in running all three types of file analysis</td>
<td>Threat score changes based on dynamic analysis results for files preclassified as possible malware. Disposition changes from Unknown to Malware if Spero analysis or local malware analysis identifies malware, or based on configured threat score threshold in the file policy.</td>
</tr>
</tbody>
</table>

(Block transmission of all files of a specified file type) | Does not require a Malware license (This option is not technically a malware protection option.) | Legitimate files will also be blocked | (No analysis is performed.) |

Note

Preclassification does not itself determine a file's disposition; it is merely one of the factors that determine whether a file is eligible for Dynamic Analysis.

License Requirements for File and Malware Policies

<table>
<thead>
<tr>
<th>To Do This</th>
<th>License Required</th>
<th>File Rule Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block or allow all files of a particular type (for example, block all .exe files)</td>
<td>Protection</td>
<td>Allow, Block, Block with Reset</td>
</tr>
</tbody>
</table>
How to Configure Malware Protection

This topic summarizes the steps you must take to set up your Firepower system to protect your network from malicious software.

Procedure

**Step 1** Plan and Deploy Products and Licenses for Malware Protection, on page 796

**Step 2** Configure Policies to Detect and Handle Malware, on page 797

**Step 3** Arrange Ongoing Maintenance and Monitoring of Malware Protection, on page 798

What to do next

(Optional) Deploy and integrate Cisco's AMP for Endpoints product to further enhance detection of malware in your network. See (Optional) Malware Protection with AMP for Endpoints, on page 821 and subtopics.

Plan and Deploy Products and Licenses for Malware Protection

This procedure is the first set of steps in the complete process for configuring your system to provide malware protection.

Procedure

**Step 1** Purchase and install the necessary Malware licenses for your Firepower system.

See License Requirements for File and Malware Policies, on page 795 and Licensing the Firepower System, on page 105.

**Step 2** Understand how file policies and malware protection fit into your access control plan.

See the chapter Access Control Using Intrusion and File Policies, on page 653.

**Step 3** Understand the file analysis tools that are available for malware protection.

See Malware Protection Methods, on page 791 and subtopics.
Step 4  Determine whether you will use public clouds or private (on-premises) clouds for malware file analysis and dynamic analysis.
See Cloud Connections for Malware Protection, on page 799 and subtopics.

Step 5  If you will use private (on-premises) Cisco AMP clouds: Purchase, deploy, and test those products.
For information, contact your Cisco sales representative or authorized reseller.

Step 6  Configure your firewall to allow communications with your chosen clouds.
See Security, Internet Access, and Communication Ports, on page 1801.

Step 7  Configure connections between the FMC and the AMP clouds (public or private).
• For the AMP cloud, see Change AMP Options, on page 803.
• If you deployed an on-premises Cisco Threat Grid appliance, see Connect to an On-Premises Dynamic Analysis Appliance, on page 805. (Access to the public Threat Grid cloud does not require configuration.)

What to do next
Continue with the remaining steps in How to Configure Malware Protection, on page 796.

Configure Policies to Detect and Handle Malware

Before you begin
Complete the tasks up to this point in the malware protection workflow:
See How to Configure Malware Protection, on page 796.

Procedure

Step 1  Configure file policies:
   a) Understand file policy and file rule restrictions.
      See File Policy and File Rule Guidelines and Limitations, on page 807 and subtopics.
   b) Create a file policy.
      See Creating a File Policy, on page 810.
   c) Create rules within your file policy.
      See File Rules, on page 815 and subtopics.

Step 2  Add your file policies to your access control configuration:
   a) Understand guidelines for file policies in access control policies. (These are different from the file rule and file policy guidelines above.)
      Review File and Intrusion Inspection Order, on page 655.
   b) Associate the file policy with an access control policy.
c) If you have not yet done so, configure network discovery policies so that file and malware events can be associated with hosts on your network.

(Do not simply turn on network discovery; you must configure it to discover hosts on your network to build a network map of your organization.)

See Network Discovery Policies, on page 1299 and subtopics.

d) Assign the access control policy to managed devices.

See Setting Target Devices for an Access Control Policy, on page 634.

e) Deploy the access control policy to managed devices.

See Deploy Configuration Changes, on page 277.

Your system is now configured to detect and handle malware.

Step 3
Test your system to be sure it is processing malicious files as you expect it to.

What to do next
In order to ensure ongoing effectiveness of your deployment, see Arrange Ongoing Maintenance and Monitoring of Malware Protection, on page 798.

Arrange Ongoing Maintenance and Monitoring of Malware Protection

Ongoing maintenance is essential for protecting your network.

Before you begin
Configure your system to protect your network from malware.

See How to Configure Malware Protection, on page 796 and referenced procedures.

Procedure

Step 1
Ensure that your system always has the most current and effective protection.

See Maintain Your System: Update File Types Eligible for Dynamic Analysis, on page 806.

Step 2
Configure alerts for malware-related events and health monitoring.

See Configuring AMP for Networks Alerting, on page 1460 and information in Health Monitoring, on page 219 about the following modules:

• Local Malware Analysis
• Security Intelligence
• Intrusion and File Event Rate
• AMP for Firepower Status
• AMP for Endpoints Status

What to do next
Understand how to use file and malware events to research potential issues.
See File/Malware Events and Network File Trajectory, on page 1669.

Cloud Connections for Malware Protection

Connections to public or private clouds are required in order to protect your network from malware.

AMP Clouds

The Advanced Malware Protection (AMP) cloud is a Cisco-hosted server that uses big data analytics and continuous analysis to provide intelligence that the system uses to detect and block malware on your network. The AMP cloud provides dispositions for possible malware detected in network traffic by managed devices, as well as data updates for local malware analysis and file pre-classification.

If your organization has deployed AMP for Endpoints and configured Firepower to import its data, the system imports this data from the AMP cloud, including scan records, malware detections, quarantines, and indications of compromise (IOC).

Cisco offers the following options for obtaining data from the Cisco cloud about known malware threats:

• **AMP public cloud**— Your Firepower Management Center communicates directly with the public Cisco cloud.

• **An AMP private cloud** is deployed on your network and acts as a compressed, on-premises AMP cloud.
  For details, see Cisco AMP Private Cloud, on page 801.

Dynamic Analysis Cloud

• **Cisco Threat Grid cloud**—Processes eligible files that you send to the cloud for dynamic analysis, and provides threat scores and dynamic analysis reports.

• **On-premises Cisco Threat Grid appliance**—If your organization's security policy does not allow the Firepower System to send files outside of your network, you can deploy an on-premises appliance. This appliance does not contact the public Cisco Threat Grid cloud.
  For more information, see Dynamic Analysis On-Premises Appliance (Cisco Threat Grid), on page 805.

Configure Connections to AMP and Threat Grid Clouds

• **AMP Cloud Connection Configurations**, on page 800

• **Dynamic Analysis Connections**, on page 804
AMP Cloud Connection Configurations

The following topics describe AMP cloud connection configurations for different scenarios:

- Choose an AMP Cloud, on page 800
- Connecting to an AMP Private Cloud, on page 801
- Integrate Firepower and AMP for Endpoints, on page 823

The following topics are also relevant:

- Cisco AMP Private Cloud, on page 801
- Requirements and Guidelines for AMP Cloud Connections, on page 800
- Managing Connections to the AMP Cloud (Public or Private), on page 802

Requirements and Guidelines for AMP Cloud Connections

Requirements for AMP Cloud Connections

To ensure your FMC can communicate with the AMP cloud, see the topics under Security, Internet Access, and Communication Ports, on page 1801.

To use the legacy port for AMP communications, see Communication Port Requirements, on page 1803.

AMP Cloud Connections and Multitenancy

In a multidomain deployment, you configure the AMP for Networks connection at the Global level only. Each Firepower Management Center can have only one AMP for Networks connection.

Choose an AMP Cloud

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware</td>
<td>Malware</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

By default, a connection to the United States (US) AMP public cloud is configured and enabled for your Firepower system. (This connection appears in the web interface as AMP for Networks and sometimes AMP for Firepower.) You cannot delete or disable an AMP for Networks cloud connection, but you can switch between different geographical AMP clouds, or configure an AMP private cloud connection.

Before you begin

- If you will use an AMP private cloud, see Connecting to an AMP Private Cloud, on page 801 instead of this topic.
- Unless Firepower is integrated with AMP for Endpoints, you can configure only one AMP cloud connection. This connection is labeled AMP for Networks or AMP for Firepower.
- If you have deployed AMP for Endpoints and you want to add one or more AMP clouds to integrate that application with Firepower, see Integrate Firepower and AMP for Endpoints, on page 823.
- See Requirements and Guidelines for AMP Cloud Connections, on page 800.
Procedure

Step 1  Choose AMP > AMP Management.
Step 2  Click the pencil icon to edit the existing cloud connection.
Step 3  From the Cloud Name drop-down list, choose the regional cloud nearest to your Firepower Management Center.
Step 4  Click Save.

What to do next

• (Optional) Change AMP Options, on page 803.

Cisco AMP Private Cloud

The Firepower Management Center must connect to the AMP cloud for disposition queries for files detected in network traffic and receipt of retrospective malware events. This cloud can be public or private.

Note

The AMP private cloud does not perform dynamic analysis, nor does it support anonymized retrieval of threat intelligence for other features that rely on Cisco Collective Security Intelligence (CSI), such as URL and Security Intelligence filtering.


Connecting to an AMP Private Cloud

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware (AMP for Networks)</td>
<td>Malware (AMP for Networks)</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td>Any (AMP for Endpoints)</td>
<td>Any (AMP for Endpoints)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Before you begin

• Configure your Cisco AMP private cloud or clouds according to the directions in the documentation for that product. During configuration, note the private cloud host name. You will need this host name in order to configure the connection on the Firepower Management Center.

• Make sure the Firepower Management Center can communicate with the AMP private cloud, and confirm that the private cloud has internet access so it can communicate with the public AMP cloud. See the topics under Security, Internet Access, and Communication Ports, on page 1801.

• Unless your deployment is integrated with AMP for Endpoints, each Firepower Management Center can have only one AMP cloud connection. This connection is labeled AMP for Networks or AMP for Firepower.
If you integrate with AMP for Endpoints, you can configure multiple AMP for Endpoints cloud connections.

**Procedure**

**Step 1** Choose AMP > AMP Management.

**Step 2** Click Create AMP Cloud Connection.

**Step 3** From the Cloud Name drop-down list, choose Private Cloud.

**Step 4** Enter a Name.

This information appears in malware events that are generated or transmitted by AMP private cloud.

**Step 5** In the Host field, enter the private cloud host name that you configured when you set up the private cloud.

**Step 6** Click Browse next to the Certificate Upload Path field to browse to the location of a valid TLS or SSL encryption certificate for the private cloud. For more information, see the AMP private cloud documentation.

**Step 7** If you want to use this private cloud for both AMP for Networks and AMP for Endpoints, select the Use for AMP for Firepower check box.

If you configured a different private cloud to handle AMP for Networks communications, you can clear this check box; if this is your only AMP private cloud connection, you cannot.

In a multidomain deployment, this check box appears only in the Global domain. Each Firepower Management Center can have only one AMP for Networks connection.

**Step 8** To communicate with the AMP private cloud using a proxy, check the Use Proxy for Connection check box.

**Step 9** Click Register, confirm that you want to disable existing direct connections to the AMP cloud, and finally confirm that you want to continue to the AMP private cloud management console to complete registration.

**Step 10** Log into the management console and complete the registration process. For further instructions, see the AMP private cloud documentation.

---

### Managing Connections to the AMP Cloud (Public or Private)

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware (AMP for Networks)</td>
<td>Malware (AMP for Networks)</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td>Any (AMP for Endpoints)</td>
<td>Any (AMP for Endpoints)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use the Firepower Management Center to manage connections to public and private AMP clouds used for AMP for Networks or AMP for Endpoints or both.

You can delete a connection to a public or private AMP cloud if you no longer want to receive malware-related information from the cloud. Note that deregistering a connection using the AMP for Endpoints or AMP private cloud management console does not remove the connection from the system. Deregistered connections display a failed state on the Firepower Management Center web interface.

You can also temporarily disable a connection. When you reenable a cloud connection, the cloud resumes sending data to the system, including queued data from the disabled period.
Caution

For disabled connections, the public or private AMP cloud can store malware events, indications of compromise, and so on until you re-enable the connection. In rare cases—for example, with a very high event rate or a long-term disabled connection—the cloud may not be able to store all information generated while the connection is disabled.

In a multidomain deployment, the system displays connections created in the current domain, which you can manage. It also displays connections created in ancestor domains, which you cannot manage. To manage connections in a lower domain, switch to that domain. Each Firepower Management Center can have only one AMP for Networks connection, which belongs to the Global domain.

Procedure

Step 1 Select AMP > AMP Management.
Step 2 Manage your AMP cloud connections:

- Delete — Click the delete icon ( ), then confirm your choice.
- Enable or Disable — Click the slider, then confirm your choice.

Change AMP Options

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware</td>
<td>Malware</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Choose System > Integration.
Step 2 Click the Cisco CSI tab.
Step 3 Select options:

Table 76: AMP for Networks Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Automatic Local Malware Detection Updates</td>
<td>The local malware detection engine statically analyzes and preclassifies files using signatures provided by Cisco. If you enable this option, the Firepower Management Center checks for signature updates once every 30 minutes.</td>
</tr>
<tr>
<td>Share URI from Malware Events with Cisco</td>
<td>The system can send information about the files detected in network traffic to the AMP cloud. This information includes URI information associated with detected files and their SHA-256 hash values. Although sharing is opt-in, transmitting this information to Cisco helps future efforts to identify and track malware.</td>
</tr>
</tbody>
</table>
Dynamic Analysis Connections

Requirements for Dynamic Analysis

With the appropriate license, the Firepower system automatically has access to the Cisco Threat Grid public cloud.

Dynamic analysis requires that managed devices have direct or proxied access to the Cisco Threat Grid public cloud or an on-premises Cisco Threat Grid appliance on port 443.

See also Which Files Are Eligible for Dynamic Analysis?, on page 793.

If you will connect to an on-premises Threat Grid appliance, see also the prerequisites in Connect to an On-Premises Dynamic Analysis Appliance, on page 805.

Viewing the Default Dynamic Analysis Connection

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware</td>
<td>Malware</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

By default, the Firepower Management Center can connect to the public Cisco Threat Grid cloud for file submission and report retrieval. You can neither configure nor delete this connection.

Procedure

Step 1 Choose AMP > Dynamic Analysis Connections.
Step 2 Click the edit icon (✏️).
Dynamic Analysis On-Premises Appliance (Cisco Threat Grid)

If your organization has privacy or security concerns around submitting files to the public Cisco Threat Grid cloud, you can deploy an on-premises Cisco Threat Grid appliance. Like the public cloud, the on-premises appliance runs eligible files in a sandbox environment, and returns a threat score and dynamic analysis report to the Firepower System. However, the on-premises appliance does not communicate with the public cloud, or any other system external to your network.


Connect to an On-Premises Dynamic Analysis Appliance

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware</td>
<td>Malware</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

If you install an on-premises Cisco Threat Grid appliance on your network, you can configure a dynamic analysis connection to submit files and retrieve reports from the appliance. When configuring the on-premises appliance dynamic analysis connection, you register the Firepower Management Center to the on-premises appliance.

Before you begin

• Set up your on-premises Cisco Threat Grid appliance; see the Cisco Threat Grid Appliance Setup and Configuration Guide.


• Download the public key certificate from the Cisco Threat Grid appliance to use for logins to the on-premises appliance; see the Cisco Threat Grid Appliance Administrator’s Guide.

• Configure a proxy if you want to connect to the on-premises appliance using a proxy; see Configure Firepower Management Center Management Interfaces, on page 450.

• Managed devices must have direct or proxied access to the Cisco Threat Grid appliance on port 443.

Procedure

Step 1 Choose AMP > Dynamic Analysis Connections.
Step 2 Click Add New Connection.
Step 3 Enter a Name.
Step 4 Enter a Host URL.
Step 5 Next to Certificate Upload, click Browse to upload the public key certificate you want to use to establish connections with the on-premises appliance.
Step 6 If you want to use a configured proxy to establish the connection, select Use Proxy When Available.
Step 7 Click Register.
Step 8 Click Yes to display the on-premises Cisco Threat Grid appliance login page.
Step 9  Enter your username and password to the on-premises Cisco Threat Grid appliance.

Step 10 Click Sign in.

Step 11 You have the following options:

- If you previously registered the Firepower Management Center to the on-premises appliance, click Return.
- If you did not register the Firepower Management Center, click Activate.

## Maintain Your System: Update File Types Eligible for Dynamic Analysis

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin</td>
</tr>
</tbody>
</table>

The list of file types eligible for Dynamic Analysis is determined by the vulnerability database (VDB), which is updated periodically (but no more than once per day.)

To ensure that your system has the current list:

**Procedure**

**Step 1** Do one of the following:

- (Recommended) See Vulnerability Database Update Automation, on page 163
- Regularly check for new VDB updates, and Update the Vulnerability Database (VDB) Manually, on page 121 when needed.

  If you choose this option, we recommend that you schedule regular reminders to do this.

**Step 2** If your file policies specify individual file types instead of the Dynamic Analysis Capable file type category, update your file policies to use the newly supported file types.

**Step 3** If the list of eligible file types changes, deploy to managed devices.

## Cisco Security Intelligence Clouds

The Firepower System uses Cisco’s Collective Security Intelligence (CSI) cloud to obtain the threat intelligence data it uses to assess risk for files and to obtain URL category and reputation. With the correct licenses, you can specify communications options for the AMP for Networks and URL Filtering features.

The FMC communicates with resources in the Cisco cloud for the following features:

- For Advanced Malware Protection, see: Change AMP Options, on page 803
- For URL filtering, see:
  - URL Filtering Options, on page 666
  - Enable URL Filtering Using Category and Reputation, on page 665
File Policies and File Rules

File Policy and File Rule Guidelines and Limitations

File Rule Configuration Guidelines and Limitations

- A rule configured to block files in a passive deployment does not block matching files. Because the connection continues to transmit the file, if you configure the rule to log the beginning of the connection, you may see multiple events logged for this connection.

- A policy can include multiple rules. When you create the rules, ensure that no rule is "shadowed" by a previous rule.

- The file types supported for dynamic analysis are a subset of the file types supported for other types of analysis. To view the file types supported for each type of analysis, navigate to the file rule configuration page, select the Block Malware action, and select the checkboxes of interest.

To ensure that the system examines all file types, create separate rules (within the same policy) for dynamic analysis and for other types of analysis.

- If a file rule is configured with a Malware Cloud Lookup or Block Malware action and the Firepower Management Center cannot establish connectivity with the AMP cloud, the system cannot perform any configured rule action options until connectivity is restored.

- Cisco recommends that you enable Reset Connection for the Block Files and Block Malware actions to prevent blocked application sessions from remaining open until the TCP connection resets. If you do not reset connections, the client session will remain open until the TCP connection resets itself.

- If you are monitoring high volumes of traffic, do not store all captured files, or submit all captured files for dynamic analysis. Doing so can negatively impact system performance.

- You cannot perform malware analysis on all file types detected by the system. After you select values from the Application Protocol, Direction of Transfer, and Action drop-down lists, the system constrains the list of file types.

File Detection Notes and Limitations

- If a file matches a rule with an application protocol condition, file event generation occurs after the system successfully identifies a file's application protocol. Unidentified files do not generate file events.

- FTP transfers commands and data over different channels. In a passive or inline tap mode deployment, the traffic from an FTP data session and its control session may not be load-balanced to the same internal resource.

- If the total number of bytes for all file names for files in a POP3, POP, SMTP, or IMAP session exceeds 1024, file events from the session may not reflect the correct file names for files that were detected after the file name buffer filled.

- When transmitting text-based files over SMTP, some mail clients convert newlines to the CRLF newline character standard. Since Mac-based hosts use the carriage return (CR) character and Unix/Linux-based hosts use the line feed (LF) character, newline conversion by the mail client can modify the size of the
file. Note that some mail clients default to newline conversion when processing an unrecognizable file type.

- To detect ISO files, set the "Limit the number of bytes inspected when doing file type detection" option to a value greater than 36870, as described in File and Malware Inspection Performance and Storage Options, on page 827.

File Blocking Notes and Limitations

- If an end-of-file marker is not detected for a file, regardless of transfer protocol, the file will not be blocked by a **Block Malware** rule or the custom detection list. The system waits to block the file until the entire file has been received, as indicated by the end-of-file marker, and blocks the file after the marker is detected.

- If the end-of-file marker for an FTP file transfer is transmitted separately from the final data segment, the marker will be blocked and the FTP client will indicate that the file transfer failed, but the file will actually completely transfer to disk.

- File rules with **Block Files** and **Block Malware** actions block automatic resumption of file download via HTTP by blocking new sessions with the same file, URL, server, and client application detected for 24 hours after the initial file transfer attempt occurs.

- In rare cases, if traffic from an HTTP upload session is out of order, the system cannot reassemble the traffic correctly and therefore will not block it or generate a file event.

- If you transfer a file over NetBIOS-ssn (such as an SMB file transfer) that is blocked with a **Block Files** rule, you may see a file on the destination host. However, the file is unusable because it is blocked after the download starts, resulting in an incomplete file transfer.

- If you create file rules to detect or block files transferred over NetBIOS-ssn (such as an SMB file transfer), the system does not inspect files transferred in an established TCP or SMB session started before you deploy an access control policy invoking the file policy so those files will not be detected or blocked.

File Policy General Guidelines and Limitations

- You **cannot** use a file policy to inspect traffic handled by the access control default action.

- For a new policy, the web interface indicates that the policy is not in use. If you are editing an in-use file policy, the web interface tells you how many access control policies use the file policy. In either case, you can click the text to jump to the Access Control Policies page.

- For an access control policy using a file policy with **Block Malware** rules for FTP, if you set the default action to an intrusion policy with **Drop when Inline** disabled, the system generates events for detected files or malware matching the rules, but does not drop the files. To block FTP file transfers and use an intrusion policy as the default action for the access control policy where you select the file policy, you must select an intrusion policy with **Drop when Inline** enabled.

- Based on your configuration, you can either inspect a file the first time the system detects it, and wait for a cloud lookup result, or pass the file on this first detection without waiting for the cloud lookup result.
File Policies

A file policy is a set of configurations that the system uses to perform malware protection and file control, as part of your overall access control configuration. This association ensures that before the system passes a file in traffic that matches an access control rule’s conditions, it first inspects the file. Consider the following diagram of a simple access control policy in an inline deployment.

The policy has two access control rules, both of which use the Allow action and are associated with file policies. The policy’s default action is also to allow traffic, but without file policy inspection. In this scenario, traffic is handled as follows:

- Traffic that matches Rule 1 is inspected by File Policy A.
- Traffic that does not match Rule 1 is evaluated against Rule 2. Traffic that matches Rule 2 is inspected by File Policy B.
- Traffic that does not match either rule is allowed; you cannot associate a file policy with the default action.

You can associate a single file policy with an access control rule whose action is Allow, Interactive Block, or Interactive Block with reset. The system then uses that file policy to inspect network traffic that meets the conditions of the access control rule.

By associating different file policies with different access control rules, you have granular control over how you identify and block files transmitted on your network.

Managing File Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat (file control) Malware (AMP for Networks)</td>
<td>Protection (file control) Malware (AMP for Networks)</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin</td>
</tr>
</tbody>
</table>
The File Policies page displays a list of existing file policies along with their last-modified dates. You can use this page to manage your file policies.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

The system checks for updates to the list of file types eligible for dynamic analysis (no more than once a day). If the list of eligible file types changes, this constitutes a change in the file policy; any access control policy using the file policy is marked out-of-date if deployed to any devices. You must deploy policies before the updated file policy can take effect on the device. See Maintain Your System: Update File Types Eligible for Dynamic Analysis, on page 806.

Procedure

Step 1
Select Policies > Access Control > Malware & File.

Step 2
Manage your file policies:

• Compare—Click Compare Policies; see Comparing Policies, on page 284.

• Create — To create a file policy, click New File Policy and proceed as described in Creating a File Policy, on page 810.

• Copy — To copy a file policy, click the copy icon (COPY).

  If a view icon (VIEW) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

• Delete — If you want to delete a file policy, click the delete icon (DELETE), then click Yes and OK as prompted.

  If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

• Deploy—Click Deploy; see Deploy Configuration Changes, on page 277.

• Edit — If you want to modify an existing file policy, click the edit icon (EDIT).

• Report—Click the report icon (REPORT); see Generating Current Policy Reports, on page 286.

Creating a File Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat (file control)</td>
<td>Protection (file control)</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin</td>
</tr>
<tr>
<td>Malware (AMP for Networks)</td>
<td>Malware (AMP for Networks)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Before you begin
If you are configuring policies for malware protection, see Configure Policies to Detect and Handle Malware, on page 797.

Procedure

Step 1 Select Policies > Access Control > Malware & File.
Tip To make a copy of an existing file policy, click the copy icon ( ), then type a unique name for the new policy in the dialog box that appears. You can then modify the copy.

Step 2 Click New File Policy.
Step 3 Enter a Name and optional Description for your new policy.
Step 4 Click Save.
Step 5 Add one or more rules to the file policy as described in Creating File Rules, on page 819.
Step 6 Optionally, select the Advanced tab and configure advanced options as described in Advanced and Archive File Inspection Options, on page 811.
Step 7 Save the file policy.

What to do next
• If you are configuring policies for malware protection, return to Configure Policies to Detect and Handle Malware, on page 797.
• Otherwise:
  • Add the file policy to an access control rule as described in Access Control Rule Configuration to Perform Malware Protection, on page 656.
  • Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Advanced and Archive File Inspection Options
The Advanced tab in the file policy editor has the following general options:
• First Time File Analysis—Select this option to store and locally analyze first-seen (Unknown) files while the AMP cloud disposition is pending. The file must match a rule configured to perform a malware cloud lookup and Spero, local malware, or dynamic analysis. Deselect this option to conserve storage and processing resources. If you deselect this option, files detected for the first time are marked with an Unknown disposition.
• Enable Custom Detection List—Block files on the custom detection list.
• Enable Clean List—Allow files on the clean list.
• Override AMP Cloud Disposition Based upon Threat Score—Set a threshold threat score; files with scores equal or worse than the threshold are considered malware.
If you select lower threshold values, you increase the number of files treated as malware. Depending on the action selected in your file policy, this can result in an increase of blocked files.

The Advanced tab in the file policy editor has the following archive file inspection options:

- **Inspect Archives**—Enables inspection of the contents of archive files, for archive files as large as the Maximum file size to store advanced access control setting.

  ![Caution]

  Enabling or disabling Inspect Archives restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

- **Block Encrypted Archives**—Blocks archive files that have encrypted contents.

- **Block Uninspectable Archives**—Blocks archive files with contents that the system is unable to inspect for reasons other than encryption. This usually applies to corrupted files, or those that exceed your specified maximum archive depth.

- **Max Archive Depth**—Blocks nested archive files that exceed the specified depth. The top-level archive file is not considered in this count; depth begins at 1 with the first nested file.

### Archive Files

Archive files are files that contain other files, such as .zip or .rar files.

If any individual file in an archive matches a file rule with a block action, the system blocks the entire archive, not just the individual file.

For details about options for archive file inspection, see Advanced and Archive File Inspection Options, on page 811.

### Archive Files That Can Be Inspected

- **File types**
  
  A complete list of inspectable archive file types appears on the file rule configuration page. To view that page, see Creating File Rules, on page 819.

  Contained files that can be inspected appears in the same page.

- **File size**
  
  You can inspect archive files as large as the Maximum file size to store file policy advanced access control setting.

- **Nested archives**
  
  Archive files can contain other archive files, which can in turn contain archive files. The level at which a file is nested is its archive file depth. Note that the top-level archive file is not included in the depth count; depth begins at 1 with the first nested file.
The system can inspect up to three levels of nested files beneath the outermost archive file (level 0). You can configure your file policy to block archive files that exceed that depth (or a lower maximum depth that you specify).

If you choose not to block files that exceed the maximum archive file depth of 3, when archive files that contain some extractable contents and some contents nested at a depth of 3 or greater appear in monitored traffic, the system examines and reports data only for the files it was able to inspect.

All features applicable to uncompressed files (such as dynamic analysis and file storage) are available for nested files inside archive files.

- **Encrypted files**
  You can configure the system to block archives whose contents are encrypted or otherwise cannot be inspected.

- **Archives that are not inspected**
  If traffic that contains an archive file is blacklisted or whitelisted by Security Intelligence, or if the top-level archive file’s SHA-256 value is on the custom detection list, the system does not inspect the contents of the archive file. If a nested file is blacklisted, the entire archive is blocked; however, if a nested file is whitelisted, the archive is not automatically passed (depending on any other nested files and characteristics).

### Archive File Dispositions

Archive file dispositions are based on the dispositions assigned to the files inside the archive. All archives that contain identified malware files receive a disposition of **Malware**. Archives without identified malware files receive a disposition of **Unknown** if they contain any unknown files, and a disposition of **Clean** if they contain only clean files.

<table>
<thead>
<tr>
<th>Archive File Disposition</th>
<th>Number of Unknown Files</th>
<th>Number of Clean Files</th>
<th>Number of Malware Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown</td>
<td>1 or more</td>
<td>Any</td>
<td>0</td>
</tr>
<tr>
<td>Clean</td>
<td>0</td>
<td>1 or more</td>
<td>0</td>
</tr>
<tr>
<td>Malware</td>
<td>Any</td>
<td>Any</td>
<td>1 or more</td>
</tr>
</tbody>
</table>

Archive files, like other files, may have dispositions of **Custom Detection** or **Unavailable** if the conditions for those dispositions apply.

### Viewing Archive Contents and Details

If your file policy is configured to inspect archive file contents, you can use the context menu in a table on pages under the Analysis > Files menu, and the network file trajectory viewer to view information about the files inside an archive when the archive file appears in a file event, malware event, or as a captured file.

All file contents of the archive are listed in table form, with a short summary of their relevant information: name, SHA-256 hash value, type, category, and archive depth. A network file trajectory icon appears by each file, which you can click to view further information about that specific file.
Override File Disposition Using Custom Lists

If a file has a disposition in the AMP cloud that you know to be incorrect, you can add the file’s SHA-256 value to a file list that overrides the disposition from the cloud:

• To treat a file as if the AMP cloud assigned a clean disposition, add the file to the **clean list**.

• To treat a file as if the AMP cloud assigned a malware disposition, add the file to the **custom detection list**.

On subsequent detection, the device either allows or blocks the file without reevaluating the file's disposition. You can use the clean list or custom detection list per file policy.

---

**Note**

To calculate a file's SHA-256 value, you must configure a rule in the file policy to either perform a malware cloud lookup or block malware on matching files.

For complete information about using file lists in Firepower, see File Lists, on page 358.

## Editing a File Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat (file control)</td>
<td>Protection (file control)</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin</td>
</tr>
<tr>
<td>Malware (AMP for Networks)</td>
<td>Malware (AMP for Networks)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Procedure

**Step 1** Select Policies > Access Control > Malware & File.

**Step 2** Click the edit icon (✏️) next to the file policy you want to edit. If a view icon (👁️) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** You have the following options:

• Add a file rule by selecting Add File Rule. For more information, see File Rules, on page 815.

• Edit an existing file rule by clicking the edit icon (✏️) next to the rule you want to edit.

• Configure advanced options as described in Advanced and Archive File Inspection Options, on page 811.

**Note** The file policy editor displays how many access control policies use the file policy you are currently editing. You can click the notification to display a list of the parent policies and, optionally, continue to the Access Control Policies page.

### What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.
File Rules

A file policy, like its parent access control policy, contains rules that determine how the system handles files that match the conditions of each rule. You can configure separate file rules to take different actions for different file types, application protocols, or directions of transfer.

For example, when a file matches a rule, the rule can:
- allow or block files based on simple file type matching
- block files based on disposition
- store captured files to the device
- submit captured files for local malware, Spero, or dynamic analysis

In addition, the file policy can:
- automatically treat a file as if it is clean or malware based on entries in the clean list or custom detection list
- treat a file as if it is malware if the file’s threat score exceeds a configurable threshold
- inspect the contents of archive files (such as .zip or .rar)
- block archive files whose contents are encrypted, nested beyond a specified maximum archive depth, or otherwise uninspectable

File Rule Components

Table 78: File Rule Components

<table>
<thead>
<tr>
<th>File Rule Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>application protocol</td>
<td>The system can detect and inspect files transmitted via FTP, HTTP, SMTP, IMAP, POP3, and NetBIOS-ssn (SMB). Any, the default, detects files in HTTP, SMTP, IMAP, POP3, FTP, and NetBIOS-ssn (SMB) traffic. To improve performance, you can restrict file detection to only one of those application protocols on a per-file rule basis.</td>
</tr>
<tr>
<td>direction of transfer</td>
<td>You can inspect incoming FTP, HTTP, IMAP, POP3, and NetBIOS-ssn (SMB) traffic for downloaded files; you can inspect outgoing FTP, HTTP, SMTP, and NetBIOS-ssn (SMB) traffic for uploaded files. Use Any to detect files over multiple application protocols, regardless of whether users are sending or receiving.</td>
</tr>
</tbody>
</table>
File Rule Component | Description
--- | ---
file categories and types | The system can detect various types of files. These file types are grouped into basic categories, including multimedia (swf, mp3), executables (exe, torrent), and PDFs. You can configure file rules that detect individual file types, or on entire categories of file types.

For example, you could block all multimedia files, or just ShockWave Flash (swf) files. Or, you could configure the system to alert you when a user downloads a BitTorrent (torrent) file.

For a list of file types the system can inspect, select Policies > Access Control > Malware & File, create a temporary new file policy, then click Add Rule. Select a file type category and the file types that the system can inspect appear in the File Types list.

Note: Frequently triggered file rules can affect system performance. For example, detecting multimedia files in HTTP traffic (YouTube, for example, transmits significant Flash content) could generate an overwhelming number of events.

file rule action | A file rule’s action determines how the system handles traffic that matches the conditions of the rule.

Depending on the selected action, you can configure whether the system stores the file or performs Spero, local malware, or dynamic analysis on a file. If you select a Block action, you can also configure whether the system also resets the blocked connection.

For descriptions of these actions and options, see File Rule Actions, on page 816.

File rules are evaluated in rule-action, not numerical, order. For details, see File Rule Actions: Evaluation Order, on page 817.

File Rule Actions

File rules give you granular control over which file types you want to log, block, or scan for malware. Each file rule has an associated action that determines how the system handles traffic that matches the conditions of the rule. To be effective, a file policy must contain one or more rules. You can use separate rules within a file policy to take different actions for different file types, application protocols, or directions of transfer.

**File Rule Actions**

- *Detect Files* rules allow you to log the detection of specific file types to the database, while still allowing their transmission.

- *Block Files* rules allow you to block specific file types. You can configure options to reset the connection when a file transfer is blocked, and store captured files to the managed device.
• **Malware Cloud Lookup** rules allow you to obtain and log the disposition of files traversing your network, while still allowing their transmission.

• **Block Malware** rules allow you to calculate the SHA-256 hash value of specific file types, query the AMP cloud to determine if files traversing your network contain malware, then block files that represent threats.

### File Rule Action Options

Depending on the action you select, you have different options:

<table>
<thead>
<tr>
<th>File Rule Action Option</th>
<th>Block Files capable?</th>
<th>Block Malware capable?</th>
<th>Detect Files capable?</th>
<th>Malware Cloud Lookup capable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spero Analysis* for MSEXE</td>
<td>no</td>
<td>yes, you can submit executable files</td>
<td>no</td>
<td>yes, you can submit executable files</td>
</tr>
<tr>
<td>Dynamic Analysis*</td>
<td>no</td>
<td>yes, you can submit executable files with Unknown file dispositions</td>
<td>no</td>
<td>yes, you can submit executable files with Unknown file dispositions</td>
</tr>
<tr>
<td>Capacity Handling</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Local Malware Analysis*</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Reset Connection</td>
<td>yes (recommended)</td>
<td>yes (recommended)</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Store files</td>
<td>yes, you can store all matching file types</td>
<td>yes, you can store file types matching the file dispositions you select</td>
<td>yes, you can store all matching file types</td>
<td>yes, you can store file types matching the file dispositions you select</td>
</tr>
</tbody>
</table>

* For complete information about these options, see Malware Protection Methods, on page 791 and its subtopics.

**Caution**

Selecting Detect Files or Block Files, enabling or disabling Store files in a Detect Files or Block Files rule, or adding the first or removing the last file rule that combines the Malware Cloud Lookup or Block Malware file rule action with an analysis option (Spero Analysis or MSEXE, Dynamic Analysis, or Local Malware Analysis) or a stores option (Malware, Unknown, Clean, or Custom), restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

### File Rule Actions: Evaluation Order

A file policy will likely contain multiple rules with different actions for different situations. If more than one rule can apply to a particular situation, the evaluation order described in this topic applies. In general, simple blocking takes precedence over malware inspection and blocking, which takes precedence over simple detection and logging.

The order of precedence of file-rule actions is:
Dynamic Analysis and Capacity Handling

Capacity handling allows you to temporarily store files that are otherwise eligible for dynamic analysis if the system is temporarily unable to submit files to the cloud, either because the device cannot communicate with the cloud or because the maximum number of submissions has been reached. The system submits the stored files when the hindering condition has passed.

The device stores files either on its hard drive or malware storage pack. See also Malware Storage Pack (8000-Series Devices Only), on page 819.

Captured Files and File Storage

The file storage feature allows you to capture selected files detected in traffic, and automatically store a copy of the file temporarily to a device’s hard drive or, if installed, to the malware storage pack.

After your device captures the files, you can:

• Store captured files on the device’s hard drive for later analysis.
• Download the stored file to a local computer for further manual analysis or archival purposes.
• Submit captured files for AMP cloud lookup or dynamic analysis.

Note that once a device stores a file, it will not re-capture it if the file is detected in the future and the device still has that file stored.

When a file is detected for the first time on your network, you can generate a file event that represents the file’s detection. However, if your file rule performs a malware cloud lookup, the system requires additional time to query the AMP cloud and return a disposition. Due to this delay, the system cannot store this file until the second time it is seen on your network, and the system can immediately determine the file’s disposition.

Whether the system captures or stores a file, you can:

• Review information about the captured file from Analysis > Files > Captured Files, including whether the file was stored or submitted for dynamic analysis, file disposition, and threat score, allowing you to quickly review possible malware threats detected on your network.
• View the file’s trajectory to determine how it traversed your network and which hosts have a copy.
• Add the file to the clean list or custom detection list to always treat the file as if it had a clean or malware disposition on future detection.

You configure file rules in a file policy to capture and store files of a specific type, or with a particular file disposition, if available. After you associate the file policy with an access control policy and deploy it to your devices, matching files in traffic are captured and stored. You can also limit the minimum and maximum file sizes to store.
Stored files are not included in system backups.
You can view captured file information under Analysis > Files > Captured Files, and download a copy for offline analysis.

Malware Storage Pack (8000-Series Devices Only)

Based on your file policy configuration, your device may store a substantial amount of file data to the hard drive. You can install a malware storage pack in the device; the system stores files to the malware storage pack, allowing more room on the primary hard drive to store events and configuration files. The system periodically deletes older files. If the device’s primary hard drive does not have enough available space, and does not have an installed malware storage pack, you cannot store files.

⚠️ Caution

Do not attempt to install a hard drive that was not supplied by Cisco in your device. Installing an unsupported hard drive may damage the device. Malware storage pack kits are available for purchase only from Cisco, and are for use only with 8000 Series devices. Contact Support if you require assistance with the malware storage pack. See the Firepower System Malware Storage Pack Guide for more information.

Without a malware storage pack installed, when you configure a device to store files, it allocates a set portion of the primary hard drive’s space to captured file storage. If you configure capacity handling to temporarily store files for dynamic analysis, the system uses the same hard drive allocation to store these files until it can resubmit them to the cloud.

When you install a malware storage pack in a device and configure file storage or capacity handling, the device allocates the entire malware storage pack for storing these files. The device cannot store any other information on the malware storage pack.

When the allocated space for captured file storage fills to capacity, the system deletes the oldest stored files until the allocated space reaches a system-defined threshold. Based on the number of files stored, you may see a substantial drop in disk usage after the system deletes files.

If a device has already stored files when you install a malware storage pack, the next time you restart the device, any captured files or capacity handling files stored on the primary hard drive are moved to the malware storage pack. Any future files the device stores are stored to the malware storage pack.

Creating File Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat (file control)</td>
<td>Protection (file control)</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td>Malware (AMP for Networks)</td>
<td>Malware (AMP for Networks)</td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>
Caution

Selecting Detect Files or Block Files, enabling or disabling Store files in a Detect Files or Block Files rule, or adding the first or removing the last file rule that combines the Malware Cloud Lookup or Block Malware file rule action with an analysis option (Spero Analysis or MSEXE, Dynamic Analysis, or Local Malware Analysis) or a store files option (Malware, Unknown, Clean, or Custom), restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Before you begin

If you are configuring rules for malware protection, see Configure Policies to Detect and Handle Malware, on page 797.

Procedure

Step 1
In the file policy editor, click Add File Rule.

Step 2
Select an Application Protocol and Direction of Transfer as described in File Rule Components, on page 815.

Step 3
Select one or more File Types.

The file types you see depend on the selected application protocol, direction of transfer, and action.

You can filter the list of file types in the following ways:

- Select one or more File Type Categories, then click All types in selected Categories.
- Search for a file type by its name or description. For example, type Windows in the Search name and description field to display a list of Microsoft Windows-specific files.

Tip
Hover your pointer over a file type to view its description.

Step 4
Select a file rule Action as described in File Rule Actions, on page 816, with consideration for File Rule Actions: Evaluation Order, on page 817.

The actions available to you depend on the licenses you have installed. See License Requirements for File and Malware Policies, on page 795.

Step 5
Depending on the action you selected, configure options:

- reset the connection after blocking the file
- store files that match the rule
- enable Spero analysis*
- enable local malware analysis*
- enable dynamic analysis* and capacity handling

* For information about these options, see File Rule Actions, on page 816 and Malware Protection Methods, on page 791 and its subtopics.
Step 6  Click Add.
Step 7  Click Save to save the policy.

What to do next

- If you are configuring policies for malware protection, return to Configure Policies to Detect and Handle Malware, on page 797.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Retrospective Disposition Changes

File dispositions can change. For example, as new information is discovered, the AMP cloud can determine that a file that was previously thought to be clean is now identified as malware, or the reverse—that a malware-identified file is actually clean. When the disposition changes for a file you queried in the past week, the AMP cloud notifies the system so it can automatically take action the next time it detects that file being transmitted. A changed disposition is called a retrospective disposition.

(Optional) Malware Protection with AMP for Endpoints

Cisco's AMP for Endpoints is a separate malware-protection product that can supplement malware protection provided by the Firepower system and be integrated with your Firepower deployment.

AMP for Endpoints is Cisco’s enterprise-class Advanced Malware Protection solution that runs as a lightweight connector on individual users' endpoints (computers and mobile devices) to discover, understand, and block advanced malware outbreaks, advanced persistent threats, and targeted attacks.

Benefits of AMP for Endpoints include:

- configure custom malware detection policies and profiles for your entire organization, as well as perform flash and full scans on all your users’ files
- perform malware analysis, including view heat maps, detailed file information, network file trajectory, and threat root causes
- configure multiple aspects of outbreak control, including automatic quarantines, application blocking to stop non-quarantined executables from running, and exclusion lists
- create custom protections, block execution of certain applications based on group policy, and create custom whitelists
- use the AMP for Endpoints management console to help you mitigate the effect of malware. The management console provides a robust, flexible web interface where you control all aspects of your AMP for Endpoints deployment and manage all phases of an outbreak.

For detailed information about AMP for Endpoints, see:

- Online help in the AMP for Endpoints management console.
Comparison of Malware Protection: Firepower vs. AMP for Endpoints

Table 79: Advanced Malware Protection Differences by Detecting Product

<table>
<thead>
<tr>
<th>Feature</th>
<th>Firepower Malware Protection (AMP for Networks)</th>
<th>AMP for Endpoints</th>
</tr>
</thead>
<tbody>
<tr>
<td>File type detection and blocking method (file control)</td>
<td>In network traffic, using access control and file policies</td>
<td>Not supported</td>
</tr>
<tr>
<td>Malware detection and blocking method</td>
<td>In network traffic, using access control and file policies</td>
<td>On individual endpoints (end-user computers and mobile devices), using a connector that communicates with the AMP cloud</td>
</tr>
<tr>
<td>Network traffic inspected</td>
<td>Traffic passing through a managed device</td>
<td>None; connectors installed on endpoints directly inspect files</td>
</tr>
<tr>
<td>Malware intelligence data source</td>
<td>AMP cloud (public or private)</td>
<td>AMP cloud (public or private)</td>
</tr>
<tr>
<td>Malware detection robustness</td>
<td>Limited file types</td>
<td>All file types</td>
</tr>
<tr>
<td>Malware analysis choices</td>
<td>FMC-based, plus analysis in the AMP cloud</td>
<td>FMC-based, plus additional options on the AMP for Endpoints management console</td>
</tr>
<tr>
<td>Malware mitigation</td>
<td>Malware blocking in network traffic, FMC-initiated remediations</td>
<td>AMP for Endpoints-based quarantine and outbreak control options, FMC-initiated remediations</td>
</tr>
<tr>
<td>Events generated</td>
<td>File events, captured files, malware events, and retrospective malware events</td>
<td>Malware events</td>
</tr>
<tr>
<td>Information in malware events</td>
<td>Basic malware event information, plus connection data (IP address, port, and application protocol)</td>
<td>In-depth malware event information; no connection data</td>
</tr>
<tr>
<td>Network file trajectory</td>
<td>FMC-based</td>
<td>FMC and the AMP for Endpoints management console each have a network file trajectory. Both are useful.</td>
</tr>
<tr>
<td>Required licenses or subscriptions</td>
<td>Licenses required to perform file control and AMP for Networks</td>
<td>AMP for Endpoints subscription. No license is required to bring AMP for Endpoints data into FMC.</td>
</tr>
</tbody>
</table>

About Integrating Firepower with AMP for Endpoints

If your organization has deployed AMP for Endpoints, you can optionally integrate that product with your Firepower deployment.
Integration with AMP for Endpoints does not require a dedicated Firepower license.

Benefits of Integrating Firepower and AMP for Endpoints

Integrating your AMP for Endpoints deployment with your Firepower system offers the following benefits:

- The system can import malware events detected by AMP for Endpoints into Firepower Management Center so you can manage these events along with malware events generated by the Firepower system. Import data for these events includes scans, malware detections, quarantines, blocked executions, and cloud recalls, as well as indications of compromise (IOCs) that FMC displays for hosts that it monitors.

  For more information, see Malware Event Analysis with AMP for Endpoints, on page 1672.

---

**Important**

If you use a Cisco AMP Private Cloud, see limitations at AMP for Endpoints and AMP Private Cloud, on page 823.

AMP for Endpoints and AMP Private Cloud

If you configure a Cisco AMP private cloud to collect AMP endpoint data on your network, all AMP for Endpoints connectors send data to the private cloud, which forwards that data to the Firepower Management Center. The private cloud does not share any of your endpoint data over an external connection.

You can configure multiple private clouds to support the capacity you require.

Integrate Firepower and AMP for Endpoints

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If your organization has deployed Cisco's AMP for Endpoints product, you can integrate that application with Firepower to achieve the benefits described in Benefits of Integrating Firepower and AMP for Endpoints, on page 823.

When you integrate with AMP for Endpoints, you must configure an AMP for Endpoints connection even if you already have an AMP for Networks (AMP for Firepower) connection configured. You can configure multiple AMP for Endpoints cloud connections.

---

**Caution**

In a multidomain deployment, configure AMP for Endpoints connections at the leaf level only, especially if your leaf domains have overlapping IP space. If multiple subdomains have hosts with the same IP-MAC address pair, the system could save malware events that are generated by AMP for Endpoints to the wrong leaf domain, or associate IOCs with the wrong hosts.

However, you can configure AMP for Endpoints connections at any domain level, provided you use a separate AMP for Endpoints account for each connection. For example, each client of an MSSP might have its own AMP for Endpoints deployment.
An AMP for Endpoints connection that has not registered successfully does not affect AMP for Networks.

Before you begin

• If your deployment uses Cisco AMP Private Cloud, see limitations at AMP for Endpoints and AMP Private Cloud, on page 823.

• AMP for Endpoints must be set up and working properly on your network.

• The Firepower Management Center must have direct access to the Internet.

• Make sure your FMC and AMP for Endpoints can communicate with each other. See the topics under Security, Internet Access, and Communication Ports, on page 1801.

• If you are connecting to the AMP cloud after either restoring your Firepower Management Center to factory defaults or reverting to a previous version, use the AMP for Endpoints management console to remove the previous connection.

• You will need your AMP for Endpoints credentials to log in to the AMP for Endpoints console during this procedure.

Procedure

Step 1
Choose AMP > AMP Management.

Step 2
Click Add AMP Cloud Connection.

Step 3
From the Cloud Name drop-down list, choose the cloud you want to use:

  • The AMP cloud closest to the geographical location of your Firepower Management Center.

  • For AMP private cloud (AMPv), choose Private Cloud and proceed as described in Cisco AMP Private Cloud, on page 801.

Step 4
If you want to use this cloud for both AMP for Networks and AMP for Endpoints, select the Use for AMP for Firepower check box.

If you configured a different cloud to handle AMP for Networks (AMP for Firepower) communications, you can clear this check box; if this is your only AMP cloud connection, you cannot.

In a multidomain deployment, this check box appears only in the Global domain. Each Firepower Management Center can have only one AMP for Networks connection.

Step 5
Click Register.

A spinning state icon indicates that a connection is pending, for example, after you configure a connection on the Firepower Management Center, but before you authorize it using the AMP for Endpoints management console. A failed or denied icon (ि) indicates that the cloud denied the connection or the connection failed for another reason.

Step 6
Confirm that you want to continue to the AMP for Endpoints management console, then log into the management console.
Step 7
Using the management console, authorize the AMP cloud to send AMP for Endpoints data to the Firepower Management Center.

Step 8
If you want to restrict the data that the FMC receives, select specific groups within your organization for which you want to receive information.

By default, the AMP cloud sends data for all groups. To manage groups, choose Management > Groups on the AMP for Endpoints management console. For detailed information, see the management console online help.

Step 9
Click Allow to enable the connection and start the transfer of data.

Clicking Deny returns you to the Firepower Management Center, where the connection is marked as denied. If you navigate away from the Applications page on the AMP for Endpoints management console, and neither deny nor allow the connection, the connection is marked as pending on the Firepower Management Center’s web interface. The health monitor does not alert you of a failed connection in either of these situations. If you want to connect to the AMP cloud later, delete the failed or pending connection, then recreate it.

Incomplete registration of an AMP for Endpoints connection does not disable the AMP for Networks connection.

Step 10
To verify that the connection is correctly configured:
  a) On the AMP > AMP Management page, click the Cloud Name that includes AMP for Endpoints in the Cisco AMP Solution Type column.
  b) In the AMP for Endpoints console window that displays, choose Accounts > Applications.
  c) Verify that your Firepower Management Center is on the list.
  d) In the AMP for Endpoints console window, choose Manage > Computers.
  e) Verify that your Firepower Management Center is on the list.

What to do next

• In the AMP for Endpoints console window, configure settings as needed. For example, define group membership for your management center and assign policies. For information, see the AMP for Endpoints online help or other documentation.

• The default health policy warns you if the Firepower Management Center cannot connect to the AMP for Endpoints portal after an initial successful connection, or if the connection is deregistered using the AMP portal.

Verify that the AMP for Endpoints Status monitor is enabled under System > Health > Policy.

History for the File and Malware Chapter

<table>
<thead>
<tr>
<th>Feature</th>
<th>Version</th>
<th>Details</th>
</tr>
</thead>
</table>
| Chapter restructure    | any version that is republished | Restructured this chapter's content to reduce confusion.  
Some content was moved to or from the chapter for File/Malware Events and Network File Trajectory, on page 1669. |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Version</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moved URL Filtering information to the new URL Filtering chapter</td>
<td>6.3</td>
<td>Moved information about configuring cloud communications for URL Filtering to the new URL Filtering chapter. Made related changes to the structure of the Cisco CSI topics in the chapter.</td>
</tr>
</tbody>
</table>
CHAPTER 47

File and Malware Inspection Performance and Storage Tuning

The following topics describe how to configure file and malware inspection performance and storage:

- File and Malware Inspection Performance and Storage Options, on page 827
- Tuning File and Malware Inspection Performance and Storage, on page 829

File and Malware Inspection Performance and Storage Options

Increasing the file sizes can affect the performance of the system.

Caution

Configuring a non-default value under Files and Malware Settings restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Table 80: Advanced Access Control File and AMP for Networks Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Guidelines and Restrictions</th>
</tr>
</thead>
</table>
| Limit the number of bytes inspected when doing file type detection | Specifies the number of bytes inspected when performing file type detection. | 0 - 4294967295 (4GB)  
0 removes the restriction.  
The default value is the maximum segment size of a TCP packet (1460 bytes). In most cases, the system can identify common file types using the first packet.  
To detect ISO files, enter a value greater than 36870. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Guidelines and Restrictions</th>
</tr>
</thead>
</table>
| Allow file if cloud lookup for Block Malware takes longer than (seconds) | Specifies how long the system will hold the last byte of a file that matches a Block Malware rule and that does not have a cached disposition, while malware cloud lookup occurs. If the time elapses without the system obtaining a disposition, the file passes. Dispositions of Unavailable are not cached. | 0 - 30 seconds  
Do not set this option to 0 without contacting Support.  
Cisco recommends that you use the default value to avoid blocking traffic because of connection failures.                                                                                           |
| Do not calculate SHA-256 hash values for files larger than (in bytes) | Prevents the system from storing files larger than a certain size, performing a malware cloud lookup on the files, or blocking the files if added to the custom detection list. | 0 - 4294967295 (4GB)  
0 removes the restriction.  
This value must be greater than or equal to Maximum file size to store (bytes) and Maximum file size for dynamic analysis testing (bytes). |
| Minimum file size to store (bytes)        | These settings specify:  
- The file size that the system can inspect using the following detectors:  
  - Spero analysis  
  - Sandboxing and preclassification  
  - Local malware analysis/ClamAV  
  - Archive inspection  
- The file size that the system can store using a file rule. | 0 - 10485760 (10MB)  
0 disables file storage.  
Must be less than or equal to Maximum file size to store (bytes) and Do not calculate SHA-256 hash values for files larger than (in bytes). |
| Maximum file size to store (bytes)        | 0 - 10485760 (10MB)  
0 disables file storage.  
Must be greater than or equal to Minimum file size to store (bytes), and less than or equal to Do not calculate SHA-256 hash values for files larger than (in bytes). | 0 - 10485760 (10MB)  
0 disables file storage.  
Must be greater than or equal to Minimum file size to store (bytes), and less than or equal to Do not calculate SHA-256 hash values for files larger than (in bytes). |
| Minimum file size for dynamic analysis testing (bytes) | Specifies the minimum file size the system can submit to the AMP cloud for dynamic analysis.                                                                                                              | 0 -10485760 (10MB)  
Must be less than or equal to Maximum file size for dynamic analysis testing (bytes) and Do not calculate SHA-256 hash values for files larger than (in bytes).  
The file size for dynamic analysis must be within the limits defined by the minimum and maximum settings for file analysis.  
If you deploy to a device running Firepower Version 5.x, the system changes all values less than 15360, to 15360.  
The system checks the AMP cloud for updates to the minimum file size you can submit (no more than once a day). If the new minimum size is larger than your current value, your current value is updated to the new minimum, and your policy is marked out-of-date. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Guidelines and Restrictions</th>
</tr>
</thead>
</table>
| Maximum file size for dynamic analysis testing (bytes) | Specifies the maximum file size the system can submit to the AMP cloud for dynamic analysis. | 0 -10485760 (10MB)  
Must be greater than or equal to **Minimum file size for dynamic analysis testing (bytes)**, and less than or equal to **Do not calculate SHA-256 hash values for files larger than (in bytes)**.  
The file size for dynamic analysis must be within the limits defined by the minimum and maximum settings for file analysis.  
If you deploy to a device running Firepower Version 5.x, the system changes all values greater than 2097152, to 2097152.  
The system checks the AMP cloud for updates to the maximum file size you can submit (no more than once a day). If the new maximum size is smaller than your current value, your current value is updated to the new maximum, and your policy is marked out-of-date. |

**Tuning File and Malware Inspection Performance and Storage**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat (file control)</td>
<td>Protection (file control)</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td>Malware (AMP)</td>
<td>Malware (AMP)</td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Caution**

Configuring a non-default value under Files and Malware Settings restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See **Snort® Restart Traffic Behavior**, on page 280 for more information.

**Procedure**

**Step 1**
In the access control policy editor, click the **Advanced** tab.

**Step 2**
Click the edit icon (🔍) next to **Files and Malware Settings**.

If a view icon (👀) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.

**Step 3**
Set any of the options described in **File and Malware Inspection Performance and Storage Options**, on page 827.
Step 4  Click OK.
Step 5  Click Save to save the policy.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

  Snort® Restart Scenarios, on page 279
PART XIII

Intrusion Detection and Prevention

• An Overview of Network Analysis and Intrusion Policies, on page 833
• Layers in Intrusion and Network Analysis Policies, on page 849
• Getting Started with Intrusion Policies, on page 865
• Tuning Intrusion Policies Using Rules, on page 873
• Tailoring Intrusion Protection to Your Network Assets, on page 901
• Sensitive Data Detection, on page 907
• Globally Limiting Intrusion Event Logging, on page 921
• The Intrusion Rules Editor, on page 927
• Intrusion Prevention Performance Tuning, on page 1037
An Overview of Network Analysis and Intrusion Policies

The following topics provide an overview of network analysis and intrusion policies:

- Network Analysis and Intrusion Policy Basics, on page 833
- How Policies Examine Traffic For Intrusions, on page 834
- System-Provided and Custom Network Analysis and Intrusion Policies, on page 838
- The Navigation Panel: Network Analysis and Intrusion Policies, on page 845
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

Network Analysis and Intrusion Policy Basics

Network analysis and intrusion policies work together as part of the Firepower System’s intrusion detection and prevention feature.

- The term intrusion detection generally refers to the process of passively monitoring and analyzing network traffic for potential intrusions and storing attack data for security analysis. This is sometimes referred to as "IDS."

- The term intrusion prevention includes the concept of intrusion detection, but adds the ability to block or alter malicious traffic as it travels across your network. This is sometimes referred to as "IPS."

In an intrusion prevention deployment, when the system examines packets:

- A network analysis policy governs how traffic is decoded and preprocessed so it can be further evaluated, especially for anomalous traffic that might signal an intrusion attempt.

- An intrusion policy uses intrusion and preprocessor rules (sometimes referred to collectively as intrusion rules) to examine the decoded packets for attacks based on patterns. Intrusion policies are paired with variable sets, which allow you to use named values to accurately reflect your network environment.

Both network analysis and intrusion policies are invoked by a parent access control policy, but at different times. As the system analyzes traffic, the network analysis (decoding and preprocessing) phase occurs before and separately from the intrusion prevention (additional preprocessing and intrusion rules) phase. Together, network analysis and intrusion policies provide broad and deep packet inspection. They can help you detect, alert on, and protect against network traffic that could threaten the availability, integrity, and confidentiality of hosts and their data.
The Firepower System is delivered with several similarly named network analysis and intrusion policies (for example, Balanced Security and Connectivity) that complement and work with each other. By using system-provided policies, you can take advantage of the experience of the Cisco Talos Security Intelligence and Research Group (Talos). For these policies, Talos sets intrusion and preprocessor rule states, as well as provides the initial configurations for preprocessors and other advanced settings.

You can also create custom network analysis and intrusion policies. You can tune settings in custom policies to inspect traffic in the way that matters most to you so that you can improve both the performance of your managed devices and your ability to respond effectively to the events they generate.

You create, edit, save, and manage network analysis and intrusion policies using similar policy editors in the web interface. When you are editing either type of policy, a navigation panel appears on the left side of the web interface; the right side displays various configuration pages.

How Policies Examine Traffic For Intrusions

When the system analyzes traffic as part of your access control deployment, the network analysis (decoding and pre-processing) phase occurs before and separately from the intrusion prevention (intrusion rules and advanced settings) phase.

The following diagram shows, in a simplified fashion, the order of traffic analysis in an inline, intrusion prevention and AMP for Networks deployment. It illustrates how the access control policy invokes other policies to examine traffic, and in which order those policies are invoked. The network analysis and intrusion policy selection phases are highlighted.

In an inline deployment (that is, where relevant configurations are deployed to devices using routed, switched, or transparent interfaces, or inline interface pairs), the system can block traffic without further inspection at almost any step in the illustrated process. Security Intelligence, the SSL policy, network analysis policies, file policies, and intrusion policies can all either drop or modify traffic. Only the network discovery policy, which passively inspects packets, cannot affect the flow of traffic.

Similarly, at each step of the process, a packet could cause the system to generate an event. Intrusion and preprocessor events (sometimes referred to collectively as intrusion events) are indications that a packet or its contents may represent a security risk.

Tip

The diagram does not reflect that access control rules handle encrypted traffic when your SSL inspection configuration allows it to pass, or if you do not configure SSL inspection. By default, the system disables intrusion and file inspection of encrypted payloads. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion and file inspection configured.
Note that for a single connection, although the system selects a network analysis policy before an access control rule as shown in the diagram, some preprocessing (notably application layer preprocessing) occurs after access control rule selection. This does not affect how you configure preprocessing in custom network analysis policies.

Decoding, Normalizing, and Preprocessing: Network Analysis Policies

Without decoding and preprocessing, the system could not appropriately evaluate traffic for intrusions because protocol differences would make pattern matching impossible. Network analysis policies govern these traffic-handling tasks:

- **after** traffic is filtered by Security Intelligence
- **after** encrypted traffic is decrypted by an optional SSL policy
- **before** traffic can be inspected by file or intrusion policies

A network analysis policy governs packet processing in phases. First the system decodes packets through the first three TCP/IP layers, then continues with normalizing, preprocessing, and detecting protocol anomalies:

- The packet decoder converts packet headers and payloads into a format that can be easily used by the preprocessors and later, intrusion rules. Each layer of the TCP/IP stack is decoded in turn, beginning with the data link layer and continuing through the network and transport layers. The packet decoder also detects various anomalous behaviors in packet headers.

- In inline deployments, the inline normalization preprocessor reformats (normalizes) traffic to minimize the chances of attackers evading detection. It prepares packets for examination by other preprocessors and intrusion rules, and helps ensure that the packets the system processes are the same as the packets received by the hosts on your network.

**Note**

In a passive deployment, Cisco recommends that you configure adaptive profiles at the access control policy level, instead of inline normalization at the network analysis level.

- Various network and transport layers preprocessors detect attacks that exploit IP fragmentation, perform checksum validation, and perform TCP and UDP session preprocessing.

Note that some advanced transport and network preprocessor settings apply globally to all traffic handled by the target devices of an access control policy. You configure these in the access control policy rather than in a network analysis policy.

- Various application-layer protocol decoders normalize specific types of packet data into formats that the intrusion rules engine can analyze. Normalizing application-layer protocol encodings allows the system to effectively apply the same content-related intrusion rules to packets whose data is represented differently, and to obtain meaningful results.

- The Modbus and DNP3 SCADA preprocessors detect traffic anomalies and provide data to intrusion rules. Supervisory Control and Data Acquisition (SCADA) protocols monitor, control, and acquire data from industrial, infrastructure, and facility processes such as manufacturing, production, water treatment, electric power distribution, airport and shipping systems, and so on.
Several preprocessors allow you to detect specific threats, such as Back Orifice, portscans, SYN floods and other rate-based attacks.

Note that you configure the sensitive data preprocessor, which detects sensitive data such as credit card numbers and Social Security numbers in ASCII text, in intrusion policies.

In a newly created access control policy, one default network analysis policy governs preprocessing for all traffic for all intrusion policies invoked by the same parent access control policy. Initially, the system uses the Balanced Security and Connectivity network analysis policy as the default, but you can change it to another system-provided or custom network analysis policy. In a more complex deployment, advanced users can tailor traffic preprocessing options to specific security zones, networks, and VLANs by assigning different custom network analysis policies to preprocess matching traffic.

Access Control Rules: Intrusion Policy Selection

After initial preprocessing, access control rules (when present) evaluate traffic. In most cases, the first access control rule that a packet matches is the rule that handles that traffic; you can monitor, trust, block, or allow matching traffic.

When you allow traffic with an access control rule, the system can inspect the traffic for discovery data, malware, prohibited files, and intrusions, in that order. Traffic not matching any access control rule is handled by the access control policy’s default action, which can also inspect for discovery data and intrusions.

Note

All packets, regardless of which network analysis policy preprocesses them, are matched to configured access control rules—and thus are potentially subject to inspection by intrusion policies—in top-down order.

The diagram in How Policies Examine Traffic For Intrusions, on page 834 shows the flow of traffic through a device in an inline, intrusion prevention and AMP for Networks deployment, as follows:

- Access Control Rule A allows matching traffic to proceed. The traffic is then inspected for discovery data by the network discovery policy, for prohibited files and malware by File Policy A, and then for intrusions by Intrusion Policy A.

- Access Control Rule B also allows matching traffic. However, in this scenario, the traffic is not inspected for intrusions (or files or malware), so there are no intrusion or file policies associated with the rule. Note that by default, traffic that you allow to proceed is inspected by the network discovery policy; you do not need to configure this.

- In this scenario, the access control policy’s default action allows matching traffic. The traffic is then inspected by the network discovery policy, and then by an intrusion policy. You can (but do not have to) use a different intrusion policy when you associate intrusion policies with access control rules or the default action.

The example in the diagram does not include any blocking or trusting rules because the system does not inspect blocked or trusted traffic.

Intrusion Inspection: Intrusion Policies, Rules, and Variable Sets

You can use intrusion prevention as the system’s last line of defense before traffic is allowed to proceed to its destination. Intrusion policies govern how the system inspects traffic for security violations and, in inline
deployments, can block or alter malicious traffic. The main function of intrusion policies is to manage which intrusion and preprocessor rules are enabled and how they are configured.

**Intrusion and Preprocessor Rules**

An intrusion rule is a specified set of keywords and arguments that detects attempts to exploit vulnerabilities on your network; the system uses an intrusion rule to analyze network traffic to check if it matches the criteria in the rule. The system compares packets against the conditions specified in each rule and, if the packet data matches all the conditions specified in a rule, the rule triggers.

The system includes the following types of rules created by Cisco Talos Security Intelligence and Research Group (Talos):

- **shared object intrusion rules**, which are compiled and cannot be modified (except for rule header information such as source and destination ports and IP addresses)
- **standard text intrusion rules**, which can be saved and modified as new custom instances of the rule.
- **preprocessor rules**, which are rules associated with preprocessors and packet decoder detection options in the network analysis policy. You cannot copy or edit preprocessor rules. Most preprocessor rules are disabled by default; you must enable them to use preprocessors to generate events and, in an inline deployment, drop offending packets.

When the system processes packets according to an intrusion policy, first a rule optimizer classifies all activated rules in subsets based on criteria such as: transport layer, application protocol, direction to or from the protected network, and so on. Then, the intrusion rules engine selects the appropriate rule subsets to apply to each packet. Finally, a multi-rule search engine performs three different types of searches to determine if the traffic matches the rule:

- The protocol field search looks for matches in particular fields in an application protocol.
- The generic content search looks for ASCII or binary byte matches in the packet payload.
- The packet anomaly search looks for packet headers and payloads that, rather than containing specific content, violate well-established protocols.

In a custom intrusion policy, you can tune detection by enabling and disabling rules, as well as by writing and adding your own standard text rules. You can also use Firepower recommendations to associate the operating systems, servers, and client application protocols detected on your network with rules specifically written to protect those assets.

**Variable Sets**

Whenever the system uses an intrusion policy to evaluate traffic, it uses an associated *variable set*. Most variables in a set represent values commonly used in intrusion rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies to represent IP addresses in rule suppressions and dynamic rule states.

The system provides a single default variable set, which is comprised of predefined default variables. Most system-provided shared object rules and standard text rules use these predefined default variables to define networks and port numbers. For example, for the majority of the rules use the variable $HOME_NET to specify the protected network and the variable $EXTERNAL_NET to specify the unprotected (or outside) network. In addition, specialized rules often use other predefined variables. For example, rules that detect exploits against web servers use the $HTTP_SERVERS and $HTTP_PORTS variables.
Even if you use system-provided intrusion policies, Cisco **strongly** recommends that you modify key default variables in the default set. When you use variables that accurately reflect your network environment, processing is optimized and the system can monitor relevant systems for suspicious activity. Advanced users can create and use custom variable sets for pairing with one or more custom intrusion policies.

**Tip**

*Related Topics*

Predefined Default Variables, on page 335

**Intrusion Event Generation**

When the system identifies a possible intrusion, it generates an *intrusion or preprocessor event* (sometimes collectively called *intrusion events*). Managed devices transmit their events to the Firepower Management Center, where you can view the aggregated data and gain a greater understanding of the attacks against your network assets. In an inline deployment, managed devices can also drop or replace packets that you know to be harmful.

Each intrusion event in the database includes an event header and contains information about the event name and classification; the source and destination IP addresses; ports; the process that generated the event; and the date and time of the event, as well as contextual information about the source of the attack and its target. For packet-based events, the system also logs a copy of the decoded packet header and payload for the packet or packets that triggered the event.

The packet decoder, the preprocessors, and the intrusion rules engine can all cause the system to generate an event. For example:

- If the packet decoder (configured in the network analysis policy) receives an IP packet that is less than 20 bytes, which is the size of an IP datagram without any options or payload, the decoder interprets this as anomalous traffic. If, later, the accompanying decoder rule in the intrusion policy that examines the packet is enabled, the system generates a preprocessor event.

- If the IP defragmentation preprocessor encounters a series of overlapping IP fragments, the preprocessor interprets this as a possible attack and, when the accompanying preprocessor rule is enabled, the system generates a preprocessor event.

- Within the intrusion rules engine, most standard text rules and shared object rules are written so that they generate intrusion events when triggered by packets.

As the database accumulates intrusion events, you can begin your analysis of potential attacks. The system provides you with the tools you need to review intrusion events and evaluate whether they are important in the context of your network environment and your security policies.

**System-Provided and Custom Network Analysis and Intrusion Policies**

Creating a new access control policy is one of the first steps in managing traffic flow using the Firepower System. By default, a newly created access control policy invokes system-provided network analysis and intrusion policies to examine traffic.
The following diagram shows how a newly created access control policy in an inline, intrusion-prevention deployment initially handles traffic. The preprocessing and intrusion prevention phases are highlighted.

New Access Control Policy: **Intrusion Prevention**

- Security Intelligence (global list only)
- Default Network Analysis Policy: Balanced
- Default Action
- Default Network Discovery Policy
- Default Action: Intrusion Policy: Balanced

Note how:

- A default network analysis policy governs the preprocessing of all traffic handled by the access control policy. Initially, the system-provided *Balanced Security and Connectivity network analysis policy* is the default.

- The default action of the access control policy allows all non-malicious traffic, as determined by the system-provided *Balanced Security and Connectivity intrusion policy*. Because the default action allows traffic to pass, the discovery feature can examine it for host, application, and user data before the intrusion policy can examine and potentially block malicious traffic.

- The policy uses default Security Intelligence options (global whitelist and blacklist only), does not decrypt encrypted traffic with an SSL policy, and does not perform special handling and inspection of network traffic using access control rules.

A simple step you can take to tune your intrusion prevention deployment is to use a different set of system-provided network analysis and intrusion policies as your defaults. Cisco delivers several pairs of these policies with the Firepower System.

Or, you can tailor your intrusion prevention deployment by creating and using custom policies. You may find that the preprocessor options, intrusion rule, and other advanced settings configured in those policies do not address the security needs of your network. By tuning your network analysis and intrusion policies you can configure, at a very granular level, how the system processes and inspects the traffic on your network for intrusions.

### System-Provided Network Analysis and Intrusion Policies

Cisco delivers several pairs of network analysis and intrusion policies with the Firepower System. By using system-provided network analysis and intrusion policies, you can take advantage of the experience of the Cisco Talos Security Intelligence and Research Group (Talos). For these policies, Talos provides intrusion and preprocessor rule states as well as initial configurations for preprocessors and other advanced settings.

No system-provided policy covers every network profile, traffic mix, or defensive posture. Each covers common cases and network setups that provide a starting point for a well-tuned defensive policy. Although you can use system-provided policies as-is, Cisco strongly recommends that you use them as the base for custom policies that you tune to suit your network.

**Tip**

> Even if you use system-provided network analysis and intrusion policies, you should configure the system’s intrusion variables to accurately reflect your network environment. At a minimum, modify key default variables in the default set.

As new vulnerabilities become known, Talos releases intrusion rule updates (also known as *Snort Rule Updates*). These rule updates can modify any system-provided network analysis or intrusion policy, and can provide new and updated intrusion rules and preprocessor rules, modified states for existing rules, and modified
default policy settings. Rule updates may also delete rules from system-provided policies and provide new rule categories, as well as modify the default variable set.

If a rule update affects your deployment, the web interface marks affected intrusion and network analysis policies as out of date, as well as their parent access control policies. You must re-deploy an updated policy for its changes to take effect.

For your convenience, you can configure rule updates to automatically re-deploy affected intrusion policies, either alone or in combination with affected access control policies. This allows you to easily and automatically keep your deployment up-to-date to protect against recently discovered exploits and intrusions.

To ensure up-to-date preprocessing settings, you must re-deploy access control policies, which also deploys any associated SSL, network analysis, and file policies that are different from those currently running, and can also can update default values for advanced preprocessing and performance options.

Cisco delivers the following network analysis and intrusion policies with the Firepower System:

**Balanced Security and Connectivity network analysis and intrusion policies**

These policies are built for both speed and detection. Used together, they serve as a good starting point for most organizations and deployment types. The system uses the Balanced Security and Connectivity policies and settings as defaults in most cases.

**Connectivity Over Security network analysis and intrusion policies**

These policies are built for organizations where connectivity (being able to get to all resources) takes precedence over network infrastructure security. The intrusion policy enables far fewer rules than those enabled in the Security over Connectivity policy. Only the most critical rules that block traffic are enabled.

**Security Over Connectivity network analysis and intrusion policies**

These policies are built for organizations where network infrastructure security takes precedence over user convenience. The intrusion policy enables numerous network anomaly intrusion rules that could alert on or drop legitimate traffic.

**Maximum Detection network analysis and intrusion policies**

These policies are built for organizations where network infrastructure security is given even more emphasis than is given by the Security Over Connectivity policies, with the potential for even greater operational impact. For example, the intrusion policy enables rules in a large number of threat categories including malware, exploit kit, old and common vulnerabilities, and known in-the-wild exploits.

**No Rules Active intrusion policy**

In the No Rules Active intrusion policy, all intrusion rules, and all advanced settings except intrusion rule thresholds, are disabled. This policy provides a starting point if you want to create your own intrusion policy instead of basing it on the enabled rules in one of the other system-provided policies.

---

**Note**

Depending on the system-provided base policy that is selected, the settings of the policy vary. To view the policy settings, click the **Edit** icon next to the policy and then click the **Manage Base Policy** link.
Benefits of Custom Network Analysis and Intrusion Policies

You may find that the preprocessor options, intrusion rules, and other advanced settings configured in the system-provided network analysis and intrusion policies do not fully address the security needs of your organization.

Building custom policies can improve the performance of the system in your environment and can provide a focused view of the malicious traffic and policy violations occurring on your network. By creating and tuning custom policies you can configure, at a very granular level, how the system processes and inspects the traffic on your network for intrusions.

All custom policies have a base policy, also called a base layer, which defines the default settings for all configurations in the policy. A layer is a building block that you can use to efficiently manage multiple network analysis or intrusion policies.

In most cases, you base custom policies on system-provided policies, but you can use another custom policy. However, all custom policies have a system-provided policy as the eventual base in a policy chain. Because rule updates can modify system-provided policies, importing a rule update may affect you even if you are using a custom policy as your base. If a rule update affects your deployment, the web interface marks affected policies as out of date.

In addition to custom policies that you create, the system provides two custom intrusion and two custom network analysis policies: Initial Inline Policy and Initial Passive Policy. These policies use the appropriate Balanced Security and Connectivity policy as their base. The only difference between them is their drop behavior, which enables traffic blocking and modification in the inline policies and disables it in the passive policies. You can edit and use these system-provided custom policies.

Benefits of Custom Network Analysis Policies

By default, one network analysis policy preprocesses all unencrypted traffic handled by the access control policy. That means that all packets are decoded and preprocessed according to the same settings, regardless of the intrusion policy (and therefore intrusion rule set) that later examines them.

Initially, the system-provided Balanced Security and Connectivity network analysis policy is the default. A simple way to tune preprocessing is to create and use a custom network analysis policy as the default.

Tuning options available vary by preprocessor, but some of the ways you can tune preprocessors and decoders include:

• You can disable preprocessors that do not apply to the traffic you are monitoring. For example, the HTTP Inspect preprocessor normalizes HTTP traffic. If you are confident that your network does not include any web servers using Microsoft Internet Information Services (IIS), you can disable the preprocessor option that looks for IIS-specific traffic and thereby reduce system processing overhead.

Note

If you disable a preprocessor in a custom network analysis policy, but the system needs to use that preprocessor to later evaluate packets against an enabled intrusion or preprocessor rule, the system automatically enables and uses the preprocessor although the preprocessor remains disabled in the network analysis policy web interface.

• Specify ports, where appropriate, to focus the activity of certain preprocessors. For example, you can identify additional ports to monitor for DNS server responses or encrypted SSL sessions, or ports on which you decode telnet, HTTP, and RPC traffic.
For advanced users with complex deployments, you can create multiple network analysis policies, each tailored to preprocess traffic differently. Then, you can configure the system to use those policies to govern the preprocessing of traffic using different security zones, networks, or VLANs. (Note that ASA FirePOWER modules cannot restrict preprocessing by VLAN.)

**Note**

Tailoring preprocessing using custom network analysis policies—especially multiple network analysis policies—is an advanced task. Because preprocessing and intrusion inspection are so closely related, you must be careful to allow the network analysis and intrusion policies examining a single packet to complement each other.

### Benefits of Custom Intrusion Policies

In a newly created access control policy initially configured to perform intrusion prevention, the default action allows all traffic, but first inspects it with the system-provided Balanced Security and Connectivity intrusion policy. Unless you add access control rules or change the default action, all traffic is inspected by that intrusion policy.

To customize your intrusion prevention deployment, you can create multiple intrusion policies, each tailored to inspect traffic differently. Then, configure an access control policy with rules that specify which policy inspects which traffic. Access control rules can be simple or complex, matching and inspecting traffic using multiple criteria including security zone, network or geographical location, VLAN, port, application, requested URL, or user.

The main function of intrusion policies is to manage which intrusion and preprocessor rules are enabled and how they are configured, as follows:

- Within each intrusion policy, you should verify that all rules applicable to your environment are enabled, and improve performance by disabling rules that are not applicable to your environment. In an inline deployment, you can specify which rules should drop or modify malicious packets.
- Firepower recommendations allow you to associate the operating systems, servers, and client application protocols detected on your network with rules specifically written to protect those assets.
- You can modify existing rules and write new standard text rules as needed to catch new exploits or to enforce your security policies.

Other customizations you might make to an intrusion policy include:

- The sensitive data preprocessor detects sensitive data such as credit card numbers and Social Security numbers in ASCII text. Note that other preprocessors that detect specific threats (back orifice attacks, several portscan types, and rate-based attacks that attempt to overwhelm your network with excessive traffic) are configured in network analysis policies.
- Global thresholds cause the system to generate events based on how many times traffic matching an intrusion rule originates from or is targeted to a specific address or address range within a specified time period. This helps prevent the system from being overwhelmed with a large number of events.
- Suppressing intrusion event notifications and setting thresholds for individual rules or entire intrusion policies can also prevent the system from being overwhelmed with a large number of events.
- In addition to the various views of intrusion events within the web interface, you can enable logging to syslog facilities or send event data to an SNMP trap server. Per policy, you can specify intrusion event notification limits, set up intrusion event notification to external logging facilities, and configure external
responses to intrusion events. Note that in addition to these per-policy alerting configurations, you can globally enable or disable email alerting on intrusion events for each rule or rule group. Your email alert settings are used regardless of which intrusion policy processes a packet.

**Limitations of Custom Policies**

Because preprocessing and intrusion inspection are so closely related, you **must** be careful that your configuration allows the network analysis and intrusion policies processing and examining a single packet to complement each other.

By default, the system uses one network analysis policy to preprocess all traffic handled by managed devices using a single access control policy. The following diagram shows how a newly created access control policy in an inline, intrusion-prevention deployment initially handles traffic. The preprocessing and intrusion prevention phases are highlighted.

Notice how a default network analysis policy governs the preprocessing of all traffic handled by the access control policy. Initially, the system-provided Balanced Security and Connectivity network analysis policy is the default.

A simple way to tune preprocessing is to create and use a custom network analysis policy as the default. However, if you disable a preprocessor in a custom network analysis policy but the system needs to evaluate preprocessed packets against an enabled intrusion or preprocessor rule, the system automatically enables and uses the preprocessor although it remains disabled in the network analysis policy web interface.

---

**Note**

In order to get the performance benefits of disabling a preprocessor, you **must** make sure that none of your intrusion policies have enabled rules that require that preprocessor.

An additional challenge arises if you use multiple custom network analysis policies. For advanced users with complex deployments, you can tailor preprocessing to specific security zones, networks, and VLANs by assigning custom network analysis policies to preprocess matching traffic. (Note that ASA FirePOWER cannot restrict preprocessing by VLAN.) To accomplish this, you add custom network analysis rules to your access control policy. Each rule has an associated network analysis policy that governs the preprocessing of traffic that matches the rule.

---

**Tip**

You configure network analysis rules as an advanced setting in an access control policy. Unlike other types of rules in the Firepower System, network analysis rules invoke—rather than being contained by—network analysis policies.

The system matches packets to any configured network analysis rules in top-down order by rule number. Traffic that does not match any network analysis rule is preprocessed by the default network analysis policy. While this allows you a great deal of flexibility in preprocessing traffic, keep in mind that all packets, **regardless** of which network analysis policy preprocessed them, are subsequently matched to access control rules—and thus to potential inspection by intrusion policies—in their own process. In other words, preprocessing a packet...
with a particular network analysis policy does not guarantee that the packet will be examined with any particular intrusion policy. You must carefully configure your access control policy so it invokes the correct network analysis and intrusion policies to evaluate a particular packet.

The following diagram shows in focused detail how the network analysis policy (preprocessing) selection phase occurs before and separately from the intrusion prevention (rules) phase. For simplicity, the diagram eliminates the discovery and file/malware inspection phases. It also highlights the default network analysis and default-action intrusion policies.

In this scenario, an access control policy is configured with two network analysis rules and a default network analysis policy:

- Network Analysis Rule A preprocesses matching traffic with Network Analysis Policy A. Later, you want this traffic to be inspected by Intrusion Policy A.
- Network Analysis Rule B preprocesses matching traffic with Network Analysis Policy B. Later, you want this traffic to be inspected by Intrusion Policy B.
- All remaining traffic is preprocessed with the default network analysis policy. Later, you want this traffic to be inspected by the intrusion policy associated with the access control policy’s default action.

After the system preprocesses traffic, it can examine the traffic for intrusions. The diagram shows an access control policy with two access control rules and a default action:

- Access Control Rule A allows matching traffic. The traffic is then inspected by Intrusion Policy A.
- Access Control Rule B allows matching traffic. The traffic is then inspected by Intrusion Policy B.
- The access control policy’s default action allows matching traffic. The traffic is then inspected by the default action’s intrusion policy.

Each packet’s handling is governed by a network analysis policy and intrusion policy pair, but the system does not coordinate the pair for you. Consider a scenario where you misconfigure your access control policy so that Network Analysis Rule A and Access Control Rule A do not process the same traffic. For example, you could intend the paired policies to govern the handling of traffic on a particular security zone, but you mistakenly use different zones in the two rules’ conditions. This could cause traffic to be incorrectly preprocessed. For this reason, tailoring preprocessing using network analysis rules and custom policies is an advanced task.
Note that for a single connection, although the system selects a network analysis policy before an access control rule, some preprocessing (notably application layer preprocessing) occurs after access control rule selection. This does not affect how you configure preprocessing in custom network analysis policies.

The Navigation Panel: Network Analysis and Intrusion Policies

Network analysis and intrusion policies use similar web interfaces to edit and save changes to their configurations.

A navigation panel appears on the left side of the web interface when you are editing either type of policy. The following graphic shows the navigation panel for the network analysis policy (left) and the intrusion policy (right).

A dividing line separates the navigation panel into links to policy settings you can configure with (below) or without (above) direct interaction with policy layers. To navigate to any settings page, click its name in the navigation panel. Dark shading of an item in the navigation panel highlights your current settings page. For example, in the illustration above the Policy Information page would be displayed to the right of the navigation panel.

Policy Information

The Policy Information page provides configuration options for commonly used settings. As shown in the illustration for the network analysis policy panel above, a policy change icon (▲) appears next to Policy Information in the navigation panel when the policy contains unsaved changes. The icon disappears when you save your changes.

Rules (intrusion policy only)

The Rules page in an intrusion policy allows you to configure rule states and other settings for shared object rules, standard text rules, and preprocessor rules.

Firepower Recommendations (intrusion policy only)

The Firepower Recommendations page in an intrusion policy allows you to associate the operating systems, servers, and client application protocols detected on your network with intrusion rules specifically written to
protect those assets. This allows you to tailor your intrusion policy to the specific needs of your monitored network.

**Settings (network analysis policy) and Advanced Settings (intrusion policy)**

The Settings page in a network analysis policy allows you to enable or disable preprocessors and access preprocessor configuration pages. Expanding the **Settings** link displays sublinks to individual configuration pages for all enabled preprocessors in the policy.

The Advanced Settings page in an intrusion policy allows you to enable or disable advanced settings and access configuration pages for those advanced settings. Expanding the **Advanced Settings** link displays sublinks to individual configuration pages for all enabled advanced settings in the policy.

**Policy Layers**

The Policy Layers page displays a summary of the layers that comprise your network analysis or intrusion policy. Expanding the Policy Layers link displays sublinks to summary pages for the layers in your policy. Expanding each layer sublink displays further sublinks to the configuration pages for all rules, preprocessors, or advanced settings that are enabled in the layer.

---

**Conflicts and Changes: Network Analysis and Intrusion Policies**

When you edit a network analysis or intrusion policy, a policy change icon (⚠️) appears next to **Policy Information** in the navigation panel to indicate that the policy contains unsaved changes. You must save (or commit) your changes before the system recognizes them.

---

**Note**

After you save, you must deploy the network analysis or intrusion policy for your changes to take effect. If you deploy a policy without saving, the system uses the most recently saved configuration.

---

**Resolving Editing Conflicts**

The Network Analysis Policy page (Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy) and Intrusion Policy page (Policies > Access Control > Intrusion) display whether each policy has unsaved changes, as well as information about who is currently editing the policy. Cisco recommends that only one person edit a policy at a time. If you are performing simultaneous editing, the consequences are as follows:

- If you are editing a network analysis or intrusion policy at the same time another user is editing the same policy, and the other user saves their changes to the policy, you are warned when you commit the policy that you will overwrite the other user’s changes.

- If you are editing the same network analysis or intrusion policy via multiple web interface instances as the same user, and you save your changes for one instance, you cannot save your changes for the other instance.

---

**Resolving Configuration Dependencies**

To perform their particular analysis, many preprocessors and intrusion rules require that traffic first be decoded or preprocessed in a certain way, or have other dependencies. When you save a network analysis or intrusion
policy, the system either automatically enables required settings, or warns you that disabled settings will have no effect on traffic, as follows:

- You cannot save an intrusion policy if you added an SNMP rule alert but did not configure SNMP alerting. You must either configure SNMP alerting or disable the rule alert, then save again.

- You cannot save an intrusion policy if it includes enabled sensitive data rules but you have not enabled the sensitive data preprocessor. You must either allow the system to enable the preprocessor and save the policy, or disable the rules and save again.

- If you disable a required preprocessor in a network analysis policy, you can still save the policy. However, the system automatically uses the disabled preprocessor with its current settings, even though the preprocessor remains disabled in the web interface.

- If you disable inline mode in a network analysis policy but enable the Inline Normalization preprocessor, you can still save the policy. However, the system warns you that normalization settings will be ignored. Disabling inline mode also causes the system to ignore other settings that allow preprocessors to modify or block traffic, including checksum verification and rate-based attack prevention.

**Committing, Discarding, and Caching Policy Changes**

While editing a network analysis or intrusion policy, if you exit the policy editor without saving your changes, the system caches those changes. Your changes are cached even when you log out of the system or experience a system crash. The system cache can store unsaved changes for one network analysis and one intrusion policy per user; you must commit or discard your changes before editing another policy of the same type. The system discards the cached changes when you edit another policy without saving your changes to the first policy, or when you import an intrusion rule update.

You can commit or discard policy changes on the Policy Information page of either the network analysis or intrusion policy editor.

In the Firepower Management Center configuration, you can control:

- whether you are prompted (or required) to comment on your network analysis or intrusion policy changes when you commit them
- whether changes and comments are recorded in the audit log

**Related Topics**

- Configuring Network Analysis Policy Preferences
- Configuring Intrusion Policy Preferences

**Exiting a Network Analysis or Intrusion Policy**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

**Procedure**

If you want to exit the network analysis or intrusion policy advanced editor, you have the following choices:
• Cache — To exit the policy and cache changes, choose any menu or other path to another page. On exiting, click **Leave page** when prompted, or click **Stay on page** to remain in the advanced editor.
• Discard — To discard unsaved changes, click **Discard Changes** on the Policy Information page, then click **OK**.
• Save — To save changes to the policy, click **Commit Changes** on the Policy Information page. If prompted, enter a comment, and then click **OK**.
Layers in Intrusion and Network Analysis Policies

The following topics explain how to use layers in intrusion and network analysis policies:

- Layer Basics, on page 849
- The Layer Stack, on page 849
- Layer Management, on page 854

Layer Basics

Larger organizations with many managed devices may have many intrusion policies and network analysis policies to support the unique needs of different departments, business units or, in some instances, different companies. Configurations in both policy types are contained in building blocks called layers, which you can use to efficiently manage multiple policies.

Layers in intrusion and network analysis policies work in essentially the same way. You can create and edit either policy type without consciously using layers. You can modify your policy configurations and, if you have not added user layers to your policy, the system automatically includes your changes in a single configurable layer that is initially named My Changes. You can also add up to 200 layers where you can configure any combination of settings. You can copy, merge, move, and delete user layers and, most important, share individual user layers with other policies of the same type.

The Layer Stack

Layer stacks are composed of the following:

User Layers

User-configurable layers. You can copy, merge, move, or delete any user-configurable layer and set any user-configurable layer to be shared by other policies of the same type. This layer includes the automatically-generated layer initially named My Changes.

Built-in Layers

The read-only base policy layer. The policy in this layer can be either a system-provided policy or a custom policy you created.
By default, a network analysis or intrusion policy includes a base policy layer and a My Changes layer. You can add user layers as necessary.

Each policy layer contains complete configurations for either all preprocessors in a network analysis policy or all intrusion rules and advanced settings in an intrusion policy. The lowest, base policy layer includes all the settings from the base policy you selected when you created the policy. A setting in a higher layer takes precedence over the same setting in a lower layer. Features not explicitly set in a layer inherit their settings from the next highest layer where they are explicitly set. The system flattens the layers, that is, it applies only the cumulative effect of all settings, when it handles network traffic.

Tip

You can create an intrusion or network analysis policy based solely on the default settings in the base policy. In the case of an intrusion policy, you can also use Firepower rule state recommendations if you want to tailor your intrusion policy to the specific needs of your monitored network.

The following figure shows an example layer stack that, in addition to the base policy layer and the initial My Changes layer, also includes two additional user-configurable layers, User Layer 1 and User Layer 2. Note in the figure that each user-configurable layer that you add is initially positioned as the highest layer in the stack; thus, User Layer 2 in the figure was added last and is highest in the stack.

Regardless of whether you allow rule updates to modify your policy, changes in a rule update never override changes you make in a layer. This is because changes in a rule update are made in the base policy, which determines the default settings in your base policy layer; your changes are always made in a higher layer, so they override any changes that a rule update makes to your base policy.

The Base Layer

The base layer, also referred to as the base policy, of an intrusion or network analysis policy defines the default settings for all configurations in the policy, and is the lowest layer in the policy. When you create a new policy and change a setting without adding new layers, the change is stored in the My Changes layer, and overrides—but does not change—the setting in the base policy.

System-Provided Base Policies

The Firepower System provides several pairs of network analysis and intrusion policies. By using system-provided network analysis and intrusion policies, you can take advantage of the experience of the Cisco Talos Security Intelligence and Research Group (Talos). For these policies, Talos sets intrusion and preprocessor rule states, as well as provides the initial configurations for preprocessors and other advanced settings. You can use these system-provided policies as-is, or you can use them as the base for custom policies.

If you use a system-provided policy as your base, importing rule updates may modify settings in your base policy. However, you can configure a custom policy so that the system does not automatically make these changes to its system-provided base policy. This allows you to update system-provided base policies manually, on a schedule independent of rule updates. In either case, changes that a rule update makes to your base policy do not change or override settings in your My Changes or any other layer.
System-provided intrusion and network analysis policies are similarly named but contain different configurations. For example, the Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates.

Custom Base Policies

You can use a custom policy as your base. You can tune settings in custom policies to inspect traffic in ways that matter most to you so you can improve both the performance of your managed devices and your ability to respond effectively to the events they generate.

If you change the custom policy that you use as the base for another policy, those changes are automatically used as the default settings of the policy that uses the base.

In addition, a rule update may affect your policy even if you use a custom base policy, because all policies have a system-provided policy as the eventual base in a policy chain. If the first custom policy in a chain (the one that uses the system-provided policy as its base) allows rule updates to modify its base policy, your policy may be affected.

Regardless of how changes are made to your base policy—whether by a rule update or when you modify a custom policy that you use as a base policy—they do not change or override settings in your My Changes or any other layer.

The Effect of Rule Updates on Base Policies

When you import rule updates, the system modifies system-provided intrusion, access control, and network analysis policies. Rule updates can include:

- modified network analysis preprocessor settings
- modified advanced settings in intrusion and access control policies
- new and updated intrusion rules
- modified states for existing rules
- new rule categories and default variables

Rule updates can also delete existing rules from system-provided policies.

Changes to default variables and rule categories are handled at the system level.

When you use a system-provided policy as your intrusion or network analysis base policy, you can allow rule updates to modify your base policy which, in this case, is a copy of the system-provided policy. If you allow rule updates to update your base policy, a new rule update makes the same changes in your base policy that it makes to the system-provided policy that you use as your base policy. If you have not modified the corresponding setting, a setting in your base policy determines the setting in your policy. However, rule updates do not override changes you make in your policy.

If you do not allow rule updates to modify your base policy, you can manually update your base policy after importing one or more rule updates.

Rule updates always delete intrusion rules that Talos deletes, regardless of the rule state in your intrusion policy or whether you allow rule updates to modify your base intrusion policy.

Until you re-deploy your changes to network traffic, rules in your currently deployed intrusion policies behave as follows:

- Disabled intrusion rules remain disabled.
• Rules set to Generate Events continue to generate events when triggered.

• Rules set to Drop and Generate Events continue to generate events and drop offending packets when triggered.

Rule updates do not modify a custom base policy unless both of the following conditions are met:

• You allow rule updates to modify the system-provided base policy of the parent policy, that is, the policy that originated the custom base policy.

• You have not made changes in the parent policy that override the corresponding settings in the parent’s base policy.

When both conditions are met, changes in the rule update are passed to the child policy, that is, the policy using the custom base policy, when you save the parent policy.

For example, if a rule update enables a previously disabled intrusion rule, and you have not modified the rule’s state in the parent intrusion policy, the modified rule state is passed to the base policy when you save the parent policy.

Likewise, if a rule update modifies a default preprocessor setting and you have not modified the setting in the parent network analysis policy, the modified setting is passed to the base policy when you save the parent policy.

## Changing the Base Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can choose a different system-provided or custom policy as your base policy.

You can chain up to five custom policies, with four of the five using one of the other four previously created policies as its base policy; the fifth must use a system-provided policy as its base.

### Procedure

**Step 1** While editing your policy, click Policy Information in the navigation panel.

**Step 2** You can configure the following choices:

• Choose a base policy — Choose from the Base Policy drop-down list.

• Allow rule updates to modify the base policy — Click Manage Base Policy, then check the Update when a new Rule Update is installed check box.

**Tip** When you save your policy with the check box cleared and then import a rule update, an Update Now button appears on the Base Policy summary page and the status message on the page updates to inform you that the policy is out of date. If you want to update your base policy with the changes in the most recently imported rule update, click Update Now.

**Step 3** To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.
If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

The Firepower Recommendations Layer

When you generate rule state recommendations in an intrusion policy, you can choose whether to automatically modify rule states based on the recommendations.

As seen in the following figure, using recommended rule states inserts a read-only, built-in Firepower Recommendations layer immediately above the base layer.

```
| User Layer 2 |
| User Layer 1 |
| User Layer (My Changes) |
| Firepower Recommendations Layer |
| Base Policy Layer |
```

Note that this layer is unique to intrusion policies.

If you subsequently choose not to use recommended rule states, the system removes the Firepower Recommendations layer. You cannot manually delete this layer, but you can add and remove it by choosing to use or not use recommended rule states.

Adding the Firepower Recommendations layer adds a Firepower Recommendations link under Policy Layers in the navigation panel. This link leads you to a read-only view of the Firepower Recommendations layer page where you can access a recommendation-filtered view of the Rules page in read-only mode.

Using recommended rule states also adds a Rules sublink beneath the Firepower Recommendations link in the navigation panel. The Rules sublink provides access to a read-only display of the Rules page in the Firepower Recommendations layer. Note the following in this view:

• When there is no rule state icon in the state column, the state is inherited from the base policy.

• When there is no rule state icon in the Firepower Recommendation column in this or other Rules page views, there is no recommendation for this rule.

Related Topics

Tailoring Intrusion Protection to Your Network Assets, on page 901
Layer Management

The Policy Layers page provides a single-page summary of the complete layer stack for your network analysis or intrusion policy. On this page you can add shared and unshared layers, copy, merge, move, and delete layers, access the summary page for each layer, and access configuration pages for enabled, disabled, and overridden configurations within each layer.

For each layer, you can view the following information:

• whether the layer is a built-in, shared user, or unshared user layer

• which layers contain the highest, that is the effective, preprocessor or advanced setting configurations, by feature name

• in an intrusion policy, the number of intrusion rules whose states are set in the layer, and the number of rules set to each rule state.

The Policy Layers page also provides a summary of the net effect of all enabled preprocessors (network analysis) or advanced settings (intrusion) and, for intrusion policies, intrusion rules.

The feature name in the summary for each layer indicates which configurations are enabled, disabled, overridden, or inherited in the layer, as follows:

<table>
<thead>
<tr>
<th>When the feature is...</th>
<th>The feature name is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>enabled in the layer</td>
<td>written in plain text</td>
</tr>
<tr>
<td>disabled in the layer</td>
<td>struck out</td>
</tr>
<tr>
<td>overridden by the configuration in a higher layer</td>
<td>written in italic text</td>
</tr>
<tr>
<td>inherited from a lower layer</td>
<td>not present</td>
</tr>
</tbody>
</table>

You can add up to 200 layers to a network analysis or intrusion policy. When you add a layer, it appears as the highest layer in your policy. The initial state is Inherit for all features and, in an intrusion policy, no event filtering, dynamic state, or alerting rule actions are set.

You give a user-configurable layer a unique name when you add the layer to your policy. Later, you can change the name and, optionally, add or modify a description that is visible when you edit the layer.

You can copy a layer, move a layer up or down within the User Layers page area, or delete a user layer, including the initial My Changes layer. Note the following considerations:

• When you copy a layer, the copy appears as the highest layer.

• Copying a shared layer creates a layer that is initially unshared and which you can then share if you choose.

• You cannot delete a shared layer; a layer with sharing enabled that you have not shared with another policy is not a shared layer.

You can merge a user-configurable layer with another user-configurable layer immediately beneath it. A merged layer retains all settings that were unique to either layer, and accepts the settings from the higher layer if both layers included settings for the same preprocessor, intrusion rule, or advanced setting. The merged layer retains the name of the lower layer. In the policy where you create a sharable layer that you can add to
other policies, you can merge an unshared layer immediately above the sharable layer with the sharable layer, but you cannot merge the sharable layer with an unshared layer beneath it. In a policy where you add a shared layer that you created in another policy, you can merge the shared layer into an unshared layer immediately beneath it and the resulting layer is no longer shared; you cannot merge an unshared layer into a shared layer beneath it.

**Shared Layers**

A *shared layer* is a layer you add to your policy after creating the layer in another policy where you allow it to be shared. A *sharable layer* is a layer you allow to be shared.

The following figure shows an example master policy where you create the company-wide layer and site-specific layers for sites A and B, and allow these to be shared. You then add these as shared layers to the policies for sites A and B.

The company-wide layer in the master policy includes settings applicable to sites A and B. The site-specific layers include settings specific to each site. For example, in the case of a network analysis policy Site A might not have web servers on the monitored network and would not require the protection or processing overhead of the HTTP Inspect preprocessor, but both sites would likely require TCP stream preprocessing. You could enable TCP stream processing in the company-wide layer that you share with both sites, disable the HTTP Inspect preprocessor in the site-specific layer that you share with Site A, and enable the HTTP Inspect preprocessor in the site-specific layer that you share with Site B. By editing configurations in a higher layer in the site-specific policies, you could also further tune the policy for each site if necessary with any configuration adjustments.

It is unlikely that the flattened net settings in the example master policy would be useful for monitoring traffic, but the time saved in configuring and updating the site-specific policies makes this a useful application of policy layers.

Many other layer configurations are possible. For example, you could define policy layers by company, by department, by network, or even by user. In the case of an intrusion policy, you could also include advanced settings in one layer and rule settings in another.

You can allow a user-configurable layer to be shared with other policies of the same type (intrusion or network analysis). When you modify a configuration within a sharable layer and then commit your changes, the system updates all policies that share the layer and provides you with a list of all affected policies. You can only change feature configurations in the policy where you created the layer.

You cannot disable sharing for a layer that you have added to another policy; you must first delete the layer from the other policy or delete the other policy.

You cannot add a shared layer to a policy when your base policy is a custom policy where the layer you want to share was created. To do so would give the policy a circular dependency.

In a multidomain deployment, you can add shared layers from ancestor policies to policies in descendant domains.
Managing Layers

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1**  
While editing your policy, click **Policy Layers in the navigation panel**.

**Step 2**  
You can take any of the following management actions on the Policy Layers page:

- Add a shared layer from another policy — Click the add shared layer icon (🪐) next to User Layers, choose the layer from the **Add Shared Layer** drop-down list, then click **OK**.

- Add an unshared layer — Click the add layer icon (🪐) next to User Layers, enter a **Name**, and click **OK**.

- Add or change the layer description — Click the edit icon (📝) next to the layer, then add or change the **Description**.

- Allow a layer to be shared with another policy — Click the edit icon (📝) next to the layer, then clear the **Sharing** check box.

- Change the layer name — Click the edit icon (📝) next to the layer, then change the **Name**.

- Copy a layer — Click the copy icon (複製) for the layer.

- Delete a layer — Click the delete icon (🗑️) for the layer, then click **OK**.

- Merge two layers — Click the merge icon (併合) for the upper of the two layers, then click **OK**.

- Move a layer — Click any open area in the layer summary and drag until the position arrow (↑) points to a line above or below a layer where you want to move the layer.

**Step 3**  
To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

### What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

### Related Topics

- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846
Navigating Layers

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1**
While editing your policy, click **Policy Layers** in the navigation panel.

**Step 2**
You can take any of the following actions to navigate through your layers:

- Access a preprocessor or advanced settings page — If you want to access a layer-level preprocessor or advanced setting configuration page, click the feature name in the row for the layer. Configuration pages are read-only in the base policy and in shared layers.
- Access a rule page — If you want to access a layer-level rule configuration page filtered by rule state type, click the icon for drop and generate events (❌), generate events (➡️), or disabled (➡️) in the summary for the layer. No rules are displayed if the layer contains no rules set to the selected rule state.
- Display the Policy Information page — If you want to display the Policy Information page, click **Policy Summary** in the navigation panel.
- Display a layer summary page — If you want to display the summary page for a layer, click the layer name in the row for the layer or, alternately, click the edit icon (✍️) next to a user layer. You can also click the view icon (👀) to access the read-only summary page for a shared layer.

**Step 3**
To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

What to do next

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

Related Topics

Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

Intrusion Rules in Layers

You can view individual layer settings on the Rules page for the layer, or view the net effect of all settings on the policy view of the Rules page. When you modify rule settings on the policy view of the Rules page, you are modifying the highest user-configurable layer in the policy. You can switch to another layer using the layer drop-down list on any Rules page.

The following table describes the effects of configuring the same type of setting in multiple layers.
Table 81: Layer Rule Settings

<table>
<thead>
<tr>
<th>You can set...</th>
<th>Of this setting type...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>one</td>
<td>rule state</td>
<td>override a rule state set for the rule in a lower layer, and ignore all thresholds, suppressions, rate-based rule states, and alerts for that rule configured in lower layers. If you want a rule to inherit its state from the base policy or a lower layer, set the rule state to Inherit. Note that when you are working on the intrusion policy Rules page, you cannot set a rule state to Inherit because the intrusion policy Rules page is a composite view of the net effect of all rule settings.</td>
</tr>
<tr>
<td>one</td>
<td>threshold SNMP alert</td>
<td>override a setting of the same type for the rule in a lower layer. Note that setting a threshold overwrites any existing threshold for the rule in the layer.</td>
</tr>
<tr>
<td>one or more</td>
<td>suppression rate-based rule state</td>
<td>cumulatively combine settings of the same type for each selected rule down to the first layer where a rule state is set for the rule. Settings below the layer where a rule state is set are ignored.</td>
</tr>
<tr>
<td>one or more</td>
<td>comment</td>
<td>add a comment to a rule. Comments are rule-specific, not policy- or layer-specific. You can add one or more comments to a rule in any layer.</td>
</tr>
</tbody>
</table>

For example, if you set a rule state to Drop and Generate Events in one layer and to Disabled in a higher layer, the intrusion policy Rules page shows that the rule is disabled.

In another example, if you set a source-based suppression for a rule to 192.168.1.1 in one layer, and you also set a destination-based suppression for the rule to 192.168.1.2 in another layer, the Rules page shows that the cumulative effect is to suppress events for the source address 192.168.1.1 and the destination address 192.168.1.2. Note that suppression and rate-based rule state settings cumulatively combine settings of the same type for each selected rule down to the first layer where a rule state is set for the rule. Settings below the layer where a rule state is set are ignored.

Color-coding on each Rules page for a specific layer indicates whether the effective state is in a higher, lower, or the current layer, as follows:

- red—the effective state is in a higher layer
- yellow—the effective state is in a lower layer
- unshaded—the effective state is in the current layer
Because the intrusion policy Rules page is a composite view of the net effect of all rule settings, rule states are not color-coded on this page.

**Configuring Intrusion Rules in Layers**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

In an intrusion policy, you can set the rule state, event filtering, dynamic state, alerting, and rule comments for a rule in any user-configurable layer. After accessing the layer where you want to make your changes, you add settings on the Rules page for the layer the same as you would on the intrusion policy Rules page.

**Procedure**

1. **Step 1** While editing your intrusion policy, expand **Policy Layers** in the navigation panel.
2. **Step 2** Expand the policy layer you want to modify.
3. **Step 3** Click **Rules** immediately beneath the policy layer you want to modify.
4. **Step 4** Modify any of the settings described in Tuning Intrusion Policies Using Rules, on page 873.

**Tip**

To delete an individual setting from an editable layer, double-click the rule message on the Rules page for the layer to display rule details. Click **Delete** next to the setting you want to delete, then click **OK** twice.

5. **Step 5** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

**Removing Rule Settings from Multiple Layers**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can simultaneously remove a specific type of event filter, dynamic state, or alerting from multiple layers in your intrusion policy. The system removes the selected setting and copies the remaining settings for the rule to the highest editable layer in the policy.
The system removes the setting type downward through each layer where it is set until it removes all the settings or encounters a layer where a rule state is set for the rule. In the latter case, it removes the setting from that layer and stops removing the setting type.

When the system encounters the setting type in a shared layer or in the base policy, and if the highest layer in the policy is editable, the system copies the remaining settings and rule state for the rule to that editable layer. Otherwise, if the highest layer in the policy is a shared layer, the system creates a new editable layer above the shared layer and copies the remaining settings and rule state for the rule to that editable layer.

---

**Note**

Removing rule settings derived from a shared layer or the base policy causes any changes to this rule from lower layers or the base policy to be ignored. To stop ignoring changes from lower layers or the base policy, set the rule state to *Inherit* on the summary page for the topmost layer.

---

**Procedure**

**Step 1** While editing your intrusion policy, click *Rules* immediately beneath *Policy Information* in the navigation panel.

**Tip** You can also choose *Policy* from the layer drop-down list on the Rules page for any layer, or click *Manage Rules* on the Policy Information page.

**Step 2** Choose the rule or rules from which you want to remove multiple settings:

- **Choose specific** — If you want to choose specific rules, check the check box next to each rule.
- **Choose all** — If you want to choose all the rules in the current list, check the check box at the top of the column.

**Step 3** Choose one of the following options:

- **Event Filtering > Remove Thresholds**
- **Event Filtering > RemoveSuppressions**
- **Dynamic State > Remove Rate-Based Rule States**
- **Alerting > Remove SNMP Alerts**

**Note** Removing rule settings derived from a shared layer or the base policy causes any changes to this rule from lower layers or the base policy to be ignored. To stop ignoring changes from lower layers or the base policy, set the rule state to *Inherit* on the summary page for the topmost layer.

**Step 4** Click *OK*.

**Step 5** To save changes you made in this policy since the last policy commit, click *Policy Information*, then click *Commit Changes*.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.
Accepting Rule Changes from a Custom Base Policy

When a custom network analysis or intrusion policy where you have not added layers uses another custom policy as its base policy, you must set a rule to inherit its rule state if:

- you delete an event filter, dynamic state, or SNMP alert that is set for the rule in the base policy, and
- you want the rule to accept subsequent changes that you make to it in the other custom policy that you use as your base policy.

**Procedure**

**Step 1** While editing your intrusion policy, expand **Policy Layers** in the navigation panel.

**Step 2** Expand **My Changes**.

**Step 3** Click the **Rules** link immediately beneath **My Changes**.

**Step 4** Choose the rule or rules whose settings you want to accept. You have the following choices:

- Choose specific rules — If you want to choose specific rules, check the check box next to each rule.
- Choose all rules — If you want to choose all the rules in the current list, check the check box at the top of the column.

**Step 5** Choose **Inherit** from the **Rule State** drop-down list.

**Step 6** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes, on page 277**.

**Related Topics**

- **Conflicts and Changes: Network Analysis and Intrusion Policies**, on page 846
Preprocessors and Advanced Settings in Layers

You use similar mechanisms to configure preprocessors in a network analysis policy and advanced settings in an intrusion policy. You can enable and disable preprocessors on the network analysis Settings page and intrusion policy advanced settings on the intrusion policy Advanced Settings page. These pages also provide summaries of the effective states for all relevant features. For example, if the network analysis SSL preprocessor is disabled in one layer and enabled in a higher layer, the Settings page shows it as enabled. Changes made on these pages appear in the top layer of the policy. Note that the Back Orifice preprocessor has no user-configurable options.

You can also enable or disable preprocessors or advanced settings and access their configuration pages on the summary page for a user-configurable layer. On this page you can modify the layer name and description and configure whether to share the layer with other policies of the same type. You can switch to the summary page for another layer by selecting the layer name beneath Policy Layers in the navigation panel.

When you enable a preprocessor or advanced setting, a sublink to the configuration page for that feature appears beneath the layer name in the navigation panel, and an edit icon ( ) appears next to the feature on the summary page for the layer; these disappear when you disable the feature in the layer or set it to Inherit.

Setting the state (enabled or disabled) for a preprocessor or advanced setting overrides the state and configuration settings for that feature in lower layers. If you want a preprocessor or advanced setting to inherit its state and configuration from the base policy or a lower layer, set it to Inherit. Note that the Inherit selection is not available when you are working in the Settings or Advanced Settings page. Note also that if you inherit a feature that is currently enabled, the feature sublink in the navigation panel and the edit icon on the configuration page no longer appear.

The system uses the configuration in the highest layer where the feature is enabled. Unless you explicitly modify the configuration, the system uses the default configuration. For example, if you enable and modify the network analysis DCE/RPC preprocessor in one layer, and you also enable but do not modify it in a higher layer, the system uses the default configuration in the higher layer.

Color-coding on each layer summary page indicates whether the effective configuration is in a higher, lower, or the current layer, as follows:

- red—the effective configuration is in a higher layer
- yellow—the effective configuration is in a lower layer
- unshaded—the effective configuration is in the current layer

Because the Settings and Advanced Settings pages are composite views of all relevant settings, these page do not use color coding to indicate the positions of effective configurations.

### Configuring Preprocessors and Advanced Settings in Layers

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>
Procedure

Step 1  While editing your policy, expand **Policy Layers** in the navigation panel, then click the name of the layer you want to modify.

Step 2  You have the following choices:

- Change the layer **Name**.
- Add or change the **Description**.
- Check or clear the **Sharing** check box to specify whether a layer can be shared with another policy.
- To access the configuration page for an enabled preprocessor/advanced setting, click the edit icon (📝) or the feature sublink.
- To disable a preprocessor/advanced setting in the current layer, click **Disabled** next to the feature.
- To enable a preprocessor/advanced setting in the current layer, click **Enabled** next to the feature.
- To inherit the preprocessor/advanced setting state and configuration from the settings in the highest layer below the current layer, click **Inherit**.

Step 3  To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846
Getting Started with Intrusion Policies

The following topics explain how to get started with intrusion policies:

- Intrusion Policy Basics, on page 865
- Managing Intrusion Policies, on page 866
- Custom Intrusion Policy Creation, on page 867
- Editing Intrusion Policies, on page 868
- Drop Behavior in an Inline Deployment, on page 870
- Drop Behavior in a Dual System Deployment, on page 871
- Intrusion Policy Advanced Settings, on page 871
- Optimizing Performance for Intrusion Detection and Prevention, on page 872

Intrusion Policy Basics

Intrusion policies are defined sets of intrusion detection and prevention configurations that inspect traffic for security violations and, in inline deployments, can block or alter malicious traffic. Intrusion policies are invoked by your access control policy and are the system’s last line of defense before traffic is allowed to its destination.

At the heart of each intrusion policy are the intrusion rules. An enabled rule causes the system to generate intrusion events for (and optionally block) traffic matching the rule. Disabling a rule stops processing of the rule.

The Firepower System delivers several base intrusion policies, which enable you to take advantage of the experience of the Cisco Talos Security Intelligence and Research Group (Talos). For these policies, Talos sets intrusion and preprocessor rule states (enabled or disabled), as well as provides the initial configurations for other advanced settings.

If you create a custom intrusion policy, you can:

- Tune detection by enabling and disabling rules, as well as by writing and adding your own rules.

Tip

System-provided intrusion and network analysis policies are similarly named but contain different configurations. For example, the Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. However, the network analysis policy governs mostly preprocessing options, whereas the intrusion policy governs mostly intrusion rules.
• Use Firepower recommendations to associate the operating systems, servers, and client application protocols detected on your network with rules specifically written to protect those assets.

• Configure various advanced settings such as external alerting, sensitive data preprocessing, and global rule thresholding.

• Use layers as building blocks to efficiently manage multiple intrusion policies.

In an inline deployment, an intrusion policy can block and modify traffic:

• Drop rules can drop matching packets and generate intrusion events. To configure an intrusion or preprocessor drop rule, set its state to Drop and Generate Events.

• Intrusion rules can use the replace keyword to replace malicious content.

For intrusion rules to affect traffic, you must correctly configure drop rules and rules that replace content, as well as correctly deploy managed devices inline, that is, with inline interface sets. Finally, you must enable the intrusion policy’s drop behavior, or Drop when Inline setting.

When tailoring your intrusion policy, especially when enabling and adding rules, keep in mind that some intrusion rules require that traffic first be decoded or preprocessed in a certain way. Before an intrusion policy examines a packet, the packet is preprocessed according to configurations in a network analysis policy. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy web interface.

Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task.

After you configure a custom intrusion policy, you can use it as part of your access control configuration by associating the intrusion policy with one or more access control rules or an access control policy’s default action. This forces the system to use the intrusion policy to examine certain allowed traffic before the traffic passes to its final destination. A variable set that you pair with the intrusion policy allows you to accurately reflect your home and external networks and, as appropriate, the servers on your network.

Note that by default, the system disables intrusion inspection of encrypted payloads. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion inspection configured.

### Managing Intrusion Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

On the Intrusion Policy page (Policies > Access Control > Intrusion) you can view your current custom intrusion policies, along with the following information:

• the time and date the policy was last modified (in local time) and the user who modified it
• whether the **Drop when Inline** setting is enabled, which allows you to drop and modify traffic in an inline deployment

• which access control policies and devices are using the intrusion policy to inspect traffic

• whether a policy has unsaved changes, as well as information about who (if anyone) is currently editing the policy

• in a multidomain deployment, the domain where the policy was created

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

**Procedure**

**Step 1**
Choose **Policies > Access Control > Intrusion**.

**Step 2**
Manage your intrusion policy:

• Compare—Click **Compare Policies**; see **Comparing Policies**, on page 284.

• Create — Click **Create Policy**; see **Creating a Custom Intrusion Policy**, on page 868.

• Delete — Click the delete icon (🗑️) next to the policy you want to delete. The system prompts you to confirm and informs you if another user has unsaved changes in the policy. Click **OK** to confirm.

  If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

• Edit — Click the edit icon (✍️) next to the policy you want to edit; see **Editing Intrusion Policies**, on page 868.

  If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

• Export — If you want to export an intrusion policy to import on another Firepower Management Center, click the export icon (🔗); see **Exporting Configurations**, on page 147.

• Deploy—Click **Deploy**; see **Deploy Configuration Changes**, on page 277.

• Report—Click the report icon (📊); see **Generating Current Policy Reports**, on page 286.

---

**Custom Intrusion Policy Creation**

When you create a new intrusion policy you must give it a unique name, specify a base policy, and specify drop behavior.
The base policy defines the intrusion policy’s default settings. Modifying a setting in the new policy overrides—but does not change—the settings in the base policy. You can use either a system-provided or custom policy as your base policy.

The intrusion policy’s drop behavior, or Drop when Inline setting, determines how the system handles drop rules (intrusion or preprocessors rules whose rule state is set to Drop and Generate Events) and other intrusion policy configurations that affect traffic. You should enable drop behavior in inline deployments when you want to drop or replace malicious packets. Note that in passive deployments, the system cannot affect traffic flow regardless of the drop behavior.

Creating a Custom Intrusion Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

Procedure

1. **Step 1** Choose Policies > Access Control > Intrusion.
2. **Step 2** Click Create Policy. If you have unsaved changes in another policy, click Cancel when prompted to return to the Intrusion Policy page.
3. **Step 3** Enter a unique Name and, optionally, a Description.
4. **Step 4** Specify the initial Base Policy.
   You can use either a system-provided or another custom policy as your base policy.
5. **Step 5** Set the system’s drop behavior in an inline deployment as described in Setting Drop Behavior in an Inline Deployment, on page 870.
6. **Step 6** Create the policy:
   - Click Create Policy to create the new policy and return to the Intrusion Policy page. The new policy has the same settings as its base policy.
   - Click Create and Edit Policy to create the policy and open it for editing in the advanced intrusion policy editor; see Intrusion Policy Changes, on page 869.

Related Topics

- Intrusion Rules in Layers, on page 857
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

Editing Intrusion Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>
**Procedure**

**Step 1** Choose Policies > Access Control > Intrusion.

**Step 2** Click the edit icon (-pencil) next to the intrusion policy you want to configure.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Edit your policy:

- Change the base policy—Choose a base policy from the Base Policy drop-down list; see Changing the Base Policy, on page 852.
- Configure advanced settings—Click Advanced Settings in the navigation panel; see Intrusion Policy Advanced Settings, on page 871.
- Configure Firepower recommended intrusion rules—Click Firepower Recommendations in the navigation panel; see Generating and Applying Firepower Recommendations, on page 904.
- Drop behavior in an inline deployment—Check or clear Drop when Inline; see Setting Drop Behavior in an Inline Deployment, on page 870.
- Filter rules by recommended rule state—After you generate recommendations, click View next to each recommendation type. Click View Recommended Changes to view all recommendations.
- Filter rules by current rule state—Click View next to each rule state type (generate events, drop and generate events); see Intrusion Rule Filters in an Intrusion Policy, on page 881.
- Manage policy layers—Click Policy Layers in the navigation panel; see Layer Management, on page 854.
- Manage intrusion rules—Click Manage Rules; see Viewing Intrusion Rules in an Intrusion Policy, on page 874.
- View settings in base policy—Click Manage Base Policy; see The Base Layer, on page 850.

**Step 4** To save changes you made in this policy since the last policy commit, choose Policy Information, then click Commit Changes.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

- Generating and Applying Firepower Recommendations, on page 904
- Configuring Intrusion Rules in Layers, on page 859
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

**Intrusion Policy Changes**

When you create a new intrusion policy, it has the same intrusion rule and advanced settings as its base policy.
The system caches one intrusion policy per user. While editing an intrusion policy, if you choose any menu or other path to another page, your changes stay in the system cache even if you leave the page.

**Drop Behavior in an Inline Deployment**

If you want to assess how your configuration would function in an inline deployment (that is, where relevant configurations are deployed to devices using routed, switched, or transparent interfaces, or inline interface pairs) without actually affecting traffic, you can disable drop behavior. In this case, the system generates intrusion events but does not drop packets that trigger drop rules. When you are satisfied with the results, you can enable drop behavior.

Note that in passive deployments or inline deployments in tap mode, the system cannot affect traffic regardless of the drop behavior. In other words, in a passive deployment, rules set to Drop and Generate Events behave identically to rules set to Generate Events—the system generates intrusion events but cannot drop packets.

---

To block the transfer of malware over FTP, you must not only correctly configure AMP for Networks, but also enable **Drop when Inline** in your access control policy’s default intrusion policy.

When you view intrusion events, workflows can include the **inline result**, which indicates whether traffic was actually dropped, or whether it only would have dropped.

**Setting Drop Behavior in an Inline Deployment**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose **Policies > Access Control > Intrusion**.

**Step 2** Click the edit icon (✏️) next to the policy you want to edit.

If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Set the policy’s drop behavior:

- Check the **Drop when Inline** check box to allow intrusion rules to affect traffic and generate events.
- Clear the **Drop when Inline** check box to prevent intrusion rules from affecting traffic while still generating events.

**Step 4** Click **Commit Changes** to save changes you made in this policy since the last policy commit.
If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Drop Behavior in a Dual System Deployment

When there are two systems connected back to back in a network, it is normal to see the first system drop events and still record a drop or "would have dropped" event on the second system. The first system decides to drop the packets by the time it scans the last packet of the file, while the second system also investigates and identifies the traffic as "to be dropped".

For example, a 5 packet HTTP GET request whose first packet triggers a rule is blocked by the first system and only the last packet is dropped. The second system receives only 4 packets and the connection gets dropped, but when the second system finally flushes the partial GET request while it is pruning the session, it triggers the same rule with "would have dropped" as the inline result.

Intrusion Policy Advanced Settings

An intrusion policy’s advanced settings require specific expertise to configure. The base policy for your intrusion policy determines which advanced settings are enabled by default and the default configuration for each.

When you choose Advanced Settings in the navigation panel of an intrusion policy, the policy lists its advanced settings by type. On the Advanced Settings page, you can enable or disable advanced settings in your intrusion policy, as well as access advanced setting configuration pages. An advanced setting must be enabled for you to configure it.

When you disable an advanced setting, the sublink and Edit link no longer appear, but your configurations are retained. Note that some intrusion policy configurations (sensitive data rules, SNMP alerts for intrusion rules) require enabled and correctly configured advanced settings.

Modifying the configuration of an advanced setting requires an understanding of the configuration you are modifying and its potential impact on your network.

Specific Threat Detection

The sensitive data preprocessor detects sensitive data such as credit card numbers and Social Security numbers in ASCII text.

Note that other preprocessors that detect specific threats (back orifice attacks, several portscan types, and rate-based attacks that attempt to overwhelm your network with excessive traffic) are configured in network analysis policies.
Intrusion Rule Thresholds

Global rule thresholding can prevent your system from being overwhelmed with a large number of events by allowing you to use thresholds to limit the number of times the system logs and displays intrusion events.

External Responses

In addition to the various views of intrusion events with in the web interface, you can enable logging to system log (syslog) facilities or send event data to an SNMP trap server. Per policy, you can specify intrusion event notification limits, set up intrusion event notification to external logging facilities, and configure external responses to intrusion events.

Note that in addition to these per-policy alerting configurations, you can globally enable or disable email alerting on intrusion events for each rule or rule group. Your email alert settings are used regardless of which intrusion policy processes a packet.

Related Topics

- Sensitive Data Detection Basics, on page 907
- Global Rule Thresholding Basics, on page 921

Optimizing Performance for Intrusion Detection and Prevention

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin (access control); Admin/Discovery Admin (network discovery)</td>
</tr>
</tbody>
</table>

If you want the Firepower System to perform intrusion detection and prevention but do not need to take advantage of discovery data, you can optimize performance by disabling new discovery as described below.

Procedure

**Step 1** Modify or delete rules associated with the access control policy deployed at the target device. None of the access control rules associated with that device can have user, application, or URL conditions; see Creating and Editing Access Control Rules, on page 646.

**Step 2** Delete all rules from the network discovery policy for the target device; see Configuring Network Discovery Rules, on page 1302.

**Step 3** Deploy the changed configuration to the target device; see Deploy Configuration Changes, on page 277.
CHAPTER 51

Tuning Intrusion Policies Using Rules

The following topics explain how to use rules to tune intrusion policies:

- Intrusion Rule Tuning Basics, on page 873
- Intrusion Rule Types, on page 873
- Viewing Intrusion Rules in an Intrusion Policy, on page 874
- Intrusion Rule Filters in an Intrusion Policy, on page 881
- Intrusion Rule States, on page 888
- Intrusion Event Notification Filters in an Intrusion Policy, on page 890
- Dynamic Intrusion Rule States, on page 897
- Adding Intrusion Rule Comments, on page 900

Intrusion Rule Tuning Basics

You can use the Rules page in an intrusion policy to configure rule states and other settings for shared object rules, standard text rules, and preprocessor rules.

You enable a rule by setting its rule state to Generate Events or to Drop and Generate Events. Enabling a rule causes the system to generate events on traffic matching the rule. Disabling a rule stops processing of the rule. You can also set your intrusion policy so that a rule set to Drop and Generate Events in an inline deployment generates events on, and drops, matching traffic. In a passive deployment, a rule set to Drop and Generate Events just generates events on matching traffic.

You can filter rules to display a subset of rules, enabling you to select the exact set of rules where you want to change rule states or rule settings.

When an intrusion rule or rule argument requires a disabled preprocessor, the system automatically uses it with its current configuration even though it remains disabled in the network analysis policy’s web interface.

Intrusion Rule Types

An intrusion rule is a specified set of keywords and arguments that the system uses to detect attempts to exploit vulnerabilities in your network. As the system analyzes network traffic, it compares packets against the conditions specified in each rule, and triggers the rule if the data packet meets all the conditions specified in the rule.

An intrusion policy contains:
• intrusion rules, which are subdivided into shared object rules and standard text rules

• preprocessor rules, which are associated with a detection option of the packet decoder or with one of the preprocessors included with the Firepower System

The following table summarizes attributes of these rule types:

<table>
<thead>
<tr>
<th>Type</th>
<th>Generator ID (GID)</th>
<th>Snort ID (SID)</th>
<th>Source</th>
<th>Can Copy?</th>
<th>Can Edit?</th>
</tr>
</thead>
<tbody>
<tr>
<td>shared object rule</td>
<td>3</td>
<td>lower than 1000000</td>
<td>Cisco Talos Security Intelligence and Research Group (Talos)</td>
<td>yes</td>
<td>limited</td>
</tr>
<tr>
<td>standard text rule</td>
<td>1</td>
<td>lower than 1000000</td>
<td>Talos</td>
<td>yes</td>
<td>limited</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1000000 or higher</td>
<td>Created or imported by user</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>preprocessor rule</td>
<td>decoder- or preprocessor-specific</td>
<td>lower than 1000000</td>
<td>Talos</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1000000 or higher</td>
<td>Generated by the system during option configuration</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

You cannot save changes to any rule created by Talos, but you can save a copy of a modified rule as a custom rule. You can modify either variables used in the rule or rule header information (such as source and destination ports and IP addresses). In a multidomain deployment, rules created by Talos belong to the Global domain. Administrators in descendant domains can save local copies of the rules, which they can then edit.

For the rules it creates, Talos assigns default rule states in each default intrusion policy. Most preprocessor rules are disabled by default and must be enabled if you want the system to generate events for preprocessor rules and, in an inline deployment, drop offending packets.

In a multidomain deployment, the system prepends a domain number to the SID of any custom rule created in or imported into a descendant domain. For example, a rule added in the Global domain would have a SID of 1000000 or greater, and rules added in descendant domains would have SIDs of [domain number]000000 or greater.

### Viewing Intrusion Rules in an Intrusion Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can adjust how rules are displayed in the intrusion policy, and can sort rules by several criteria. You can also display the details for a specific rule to see rule settings, rule documentation, and other rule specifics.
Procedure

**Step 1** Choose **Policies > Access Control > Intrusion**.

**Step 2** Click the edit icon (-pencil) next to the policy you want to edit.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Rules** under **Policy Information** in the navigation panel.

**Step 4** While viewing the rules, you can:

- Filter the rules as described in *Setting a Rule Filter in an Intrusion Policy*, on page 887.
- Sort the rules by clicking the title or icon in the top of the column you want to sort by.
- View an intrusion rule’s details as described in *Viewing Intrusion Rule Details*, on page 877.
- View rules in different policy layers by choosing a layer from the **Policy** drop-down list.

### Intrusion Rules Page Columns

The Intrusion Rules page uses the same icons in its menu bar and column headers. For example, the Rule State menu uses the same icon (triangle) as the Rule State column in the rule listing.

**Table 83: Rules Page Columns**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GID</td>
<td>Integer that indicates the Generator ID (GID) for the rule.</td>
</tr>
</tbody>
</table>
| SID     | Integer that indicates the Snort ID (SID), which acts as a unique identifier for the rule. For custom rules, the SID is 1000000 or higher.  
In a multidomain deployment, the system prepends a domain number to the SID of any custom rule created in or imported into a descendant domain. For example, a rule added in the Global domain would have a SID of 1000000 or greater, and rules added in descendant domains would have SIDs of [domain number]000000 or greater. |
| Message | Message included in events generated by this rule, which also acts as the name of the rule. |
| –––      | The rule state for the rule:  
- Drop and generate events (X)  
- Generate events (≠≠)  
- Disabled (≠≠)  
Note the icon for a disabled rule is a dimmed version of the icon for a rule that is set to generate events without dropping traffic. Also, clicking the rule state icon for a rule allows you to change the rule state. |
Intrusion Rule Details

You can view rule documentation, Firepower recommendations, and rule overhead from the Rule Detail view. You can also view and add rule-specific features.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>The rule summary. For rule-based events, this row appears when the rule documentation contains summary information.</td>
</tr>
<tr>
<td>Rule State</td>
<td>The current rule state for the rule. Also indicates the layer where the rule state is set.</td>
</tr>
<tr>
<td>Firepower Recommendation</td>
<td>If Firepower recommendations have been generated, an icon that represents the recommended rule state; see Intrusion Rules Page Columns, on page 875. If the recommendation is to enable the rule, the system also indicates the network assets or configurations that triggered the recommendation.</td>
</tr>
<tr>
<td>Rule Overhead</td>
<td>The rule’s potential impact on system performance and the likelihood that the rule might generate false positives. Local rules do not have an assigned overhead, unless they are mapped to a vulnerability.</td>
</tr>
<tr>
<td>Thresholds</td>
<td>Thresholds currently set for this rule, as well as the facility to add a threshold for the rule.</td>
</tr>
<tr>
<td>Suppressions</td>
<td>Suppression settings currently set for this rule, as well as the facility to add suppressions for the rule.</td>
</tr>
<tr>
<td>Dynamic State</td>
<td>Rate-based rule states currently set for this rule, as well as the facility to add dynamic rule states for the rule.</td>
</tr>
<tr>
<td>Alerts</td>
<td>SNMP alerts set for this rule, as well as the facility to add an alert for the rule.</td>
</tr>
</tbody>
</table>
### Viewing Intrusion Rule Details

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>Comments added to this rule, as well as the facility to add comments for the rule.</td>
</tr>
<tr>
<td>Documentation</td>
<td>The rule documentation for the current rule, supplied by the Cisco Talos Security Intelligence and Research Group (Talos).</td>
</tr>
</tbody>
</table>

#### Procedure

**Step 1** Choose Policies > Access Control > Intrusion.

**Step 2** Click the edit icon (🔗) next to the policy you want to edit.

If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** On the navigation pane, click Rules.

**Step 4** Click the rule whose rule details you want to view, then click Show Details at the bottom of the page.

Rule details appear, as described in Intrusion Rule Details, on page 876.

**Step 5** From the rule details, you can configure:

- Alerts—See Setting an SNMP Alert for an Intrusion Rule, on page 880.
- Comments—See Adding a Comment to an Intrusion Rule, on page 880.
- Dynamic rule states—See Setting a Dynamic Rule State from the Rule Details Page, on page 879.
- Thresholds—See Setting a Threshold for an Intrusion Rule, on page 877.
- Suppressions—See Setting Suppression for an Intrusion Rule, on page 878.

### Setting a Threshold for an Intrusion Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can set a single threshold for a rule from the Rule Detail page. Adding a threshold overwrites any existing threshold for the rule.

Note that a revert icon (🔄) appears in a field when you enter an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value.
**Setting Suppression for an Intrusion Rule**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can set one or more suppressions for a rule in your intrusion policy.

Note that a revert icon ( расположен в поле при вводе недействительного значения; щелкните по нему, чтобы вернуться к предыдущему действительному значению поля или очистить это поле, если в нем не было предыдущего значения.

**Procedure**

**Step 1** From an intrusion rule’s details, click **Add** next to **Suppressions**.

**Step 2** From the **Suppression Type** drop-down list, choose one of the following options:

- Choose **Rule** to completely suppress events for a selected rule.
- Choose **Source** to suppress events generated by packets originating from a specified source IP address.
- Choose **Destination** to suppress events generated by packets going to a specified destination IP address.

**Step 3** If you chose **Source** or **Destination** for the suppression type, in the **Network** field enter the IP address, an address block, or a comma-separated list comprised of any combination of these.

If the intrusion policy is associated with the default action of an access control policy, you can also specify or list a network variable in the default action variable set.
The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.

**Step 4** Click OK.

**Tip** The system displays an event filter icon (👍) next to the rule in the Event Filtering column next the suppressed rule. If you add multiple event filters to a rule, a number over the icon indicates the number of filters.

### Setting a Dynamic Rule State from the Rule Details Page

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can set one or more dynamic rule states for a rule. The first dynamic rule state listed has the highest priority. When two dynamic rule states conflict, the action of the first is carried out.

Dynamic rule states are policy-specific.

Note that a revert icon (🔄) appears in a field when you enter an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value.

**Procedure**

**Step 1** From an intrusion rule’s details, click **Add** next to **Dynamic State**.

**Step 2** From the **Track By** drop-down list, choose an option to indicate how you want the rule matches tracked:
- Choose **Source** to track the number of hits for that rule from a specific source or set of sources.
- Choose **Destination** to track the number of hits for that rule to a specific destination or set of destinations.
- Choose **Rule** to track all matches for that rule.

**Step 3** If you set **Track By** to **Source** or **Destination**, enter the IP address of each host you want to track in the **Network** field.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.

**Step 4** Next to **Rate**, specify the number of rule matches per time period to set the attack rate:
- In the **Count** field, specify the number of rule matches you want to use as your threshold.
- In the **Seconds** field, specify the number of seconds that make up the time period for which attacks are tracked.

**Step 5** From the **New State** drop-down list, choose the new action to be taken when the conditions are met.

**Step 6** Enter a value in the **Timeout** field.

After the timeout occurs, the rule reverts to its original state. Enter 0 to prevent the new action from timing out.
Step 7  
Click OK.

Tip  
The system displays a dynamic state icon (⏰) next to the rule in the Dynamic State column. If you add multiple dynamic rule state filters to a rule, a number over the icon indicates the number of filters.

---

### Setting an SNMP Alert for an Intrusion Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can set an SNMP alert for a rule from the Rule Detail page.

**Procedure**

From an intrusion rule’s details, click **Add SNMP Alert** next to **Alerts**.

Tip  
The system displays an alert icon (🔔) next to the rule in the Alerting column. If you add multiple alerts to a rule, the system includes an indication over the icon of the number of alerts.

---

### Adding a Comment to an Intrusion Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  From an intrusion rule’s details, click **Add** next to **Comments**.

**Step 2**  In the **Comment** field, enter the rule comment.

**Step 3**  Click **OK**.

Tip  
The system displays a comment icon (📝) next to the rule in the Comments column. If you add multiple comments to a rule, a number over the icon indicates the number of comments.

**Step 4**  To delete a rule comment, click **Delete** in the rule comments section. You can only delete a comment if the comment is cached with uncommitted intrusion policy changes.
Intrusion Rule Filters in an Intrusion Policy

You can filter the rules you display on the Rules page by a single criteria, or a combination of one or more criteria.

Rule filter keywords help you find the rules for which you want to apply rule settings, such as rule states or event filters. You can filter by a keyword and simultaneously select the argument for the keyword by selecting the argument you want from the Rules page filter panel.

Intrusion Rule Filters Notes

The filter you construct is shown in the Filter text box. You can click keywords and keyword arguments in the filter panel to construct a filter. When you choose multiple keywords, the system combines them using AND logic to create a compound search filter. For example, if you choose preprocessor under Category and then choose Rule Content > GID and enter 116, you get a filter of Category: “preprocessor” GID:“116”, which retrieves all rules that are preprocessor rules and have a GID of 116.

The Category, Microsoft Vulnerabilities, Microsoft Worms, Platform Specific, Preprocessor, and Priority filter groups allow you to submit more than one argument for a keyword, separated by commas. For example, you can choose os-linux and os-windows from Category to produce the filter Category:”os-windows,os-linux”, which retrieves any rules in the os-linux category or in the os-windows category.

To show the filter panel, click the show icon ( ).

To hide the filter panel, click the hide icon ( ).

Intrusion Policy Rule Filters Construction Guidelines

In most cases, when you are building a filter, you can use the filter panel to the left of the Rules page in the intrusion policy to choose the keywords/arguments you want to use.

Rule filters are grouped into rule filter groups in the filter panel. Many rule filter groups contain sub-criteria so that you can more easily find the specific rules you are looking for. Some rule filters have multiple levels that you can expand to drill down to individual rules.

Items in the filter panel sometimes represent filter type groups, sometimes represent keywords, and sometimes represent the argument to a keyword. Note the following:

• When you choose a filter type group heading that is not a keyword (Rule Configuration, Rule Content, Platform Specific, and Priority), it expands to list the available keywords.

When you choose a keyword by clicking on a node in the criteria list, a pop-up window appears, where you supply the argument you want to filter by.

If that keyword is already used in the filter, the argument you supply replaces the existing argument for that keyword.
For example, if you click **Drop and Generate Events** under **Rule Configuration > Recommendation** in the filter panel, **Recommendation:** "Drop and Generate Events" is added to the filter text box. If you then click **Generate Events** under **Rule Configuration > Recommendation**, the filter changes to **Recommendation:** "Generate Events".

- When you choose a filter type heading that is a keyword (Category, Classifications, Microsoft Vulnerabilities, Microsoft Worms, Priority, and Rule Update), it lists the available arguments. When you choose an item from this type of group, the argument and the keyword it applies to are immediately added to the filter. If the keyword is already in the filter, it replaces the existing argument for the keyword that corresponds to that group.

For example, if you click **os-linux** under **Category** in the filter panel, **Category:** "os-linux" is added to the filter text box. If you then click **os-windows** under **Category**, the filter changes to **Category:** "os-windows".

- **Reference** under Rule Content is a keyword, and so are the specific reference ID types listed below it. When you choose any of the reference keywords, a pop-up window appears, where you supply an argument and the keyword is added to the existing filter. If the keyword is already in use in the filter, the new argument you supply replaces the existing argument.

For example, if you click **Rule Content > Reference > CVE ID** in the filter panel, a pop-up window prompts you to supply the CVE ID. If you enter 2007, then **CVE:** "2007" is added to the filter text box.

Another example, if you click **Rule Content > Reference** in the filter panel, a pop-up window prompts you to supply the reference. If you enter 2007, then **Reference:** "2007" is added to the filter text box.

- When you choose rule filter keywords from different groups, each filter keyword is added to the filter and any existing keywords are maintained (unless overridden by a new value for the same keyword).

For example, if you click **os-linux** under **Category** in the filter panel, **Category:** "os-linux" is added to the filter text box. If you then click **MS00-006** under **Microsoft Vulnerabilities**, the filter changes to **Category:** "os-linux Microsoft Vulnerabilities:" MS00-006".

- When you choose multiple keywords, the system combines them using AND logic to create a compound search filter. For example, if you choose **preprocessor** under **Category** and then choose **Rule Content > GID** and enter 116, you get a filter of **Category:** "preprocessor" **GID:** "116", which retrieves all rules that are preprocessor rules and have a GID of 116.

- The Category, Microsoft Vulnerabilities, Microsoft Worms, Platform Specific, and Priority filter groups allow you to submit more than one argument for a keyword, separated by commas. For example, you can choose **os-linux** and **os-windows** from **Category** to produce the filter **Category:** "os-windows, app-detect", which retrieves any rules in the os-linux category or in the os-windows category.

The same rule may be retrieved by more than one filter keyword/argument pair. For example, the DOS Cisco attempt rule (SID 1545) appears if rules are filtered by the **dos** category, and also if you filter by the **High** priority.

---

**Note**

The Cisco Talos Security Intelligence and Research Group (Talos) may use the rule update mechanism to add and remove rule filters.

---

Note that the rules on the Rules page may be either shared object rules (generator ID 3) or standard text rules (generator ID 1). The following table describes the different rule filters.
### Table 85: Rule Filter Groups

<table>
<thead>
<tr>
<th>Filter Group</th>
<th>Description</th>
<th>Multiple Argument Support?</th>
<th>Heading is...</th>
<th>Items in List are...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Configuration</td>
<td>Finds rules according to the configuration of the rule.</td>
<td>No</td>
<td>A grouping</td>
<td>keywords</td>
</tr>
<tr>
<td>Rule Content</td>
<td>Finds rules according to the content of the rule.</td>
<td>No</td>
<td>A grouping</td>
<td>keywords</td>
</tr>
<tr>
<td>Category</td>
<td>Finds rules according to the rule categories used by the rule editor. Note that local rules appear in the local sub-group.</td>
<td>Yes</td>
<td>A keyword</td>
<td>arguments</td>
</tr>
<tr>
<td>Classifications</td>
<td>Finds rules according to the attack classification that appears in the packet display of an event generated by the rule.</td>
<td>No</td>
<td>A keyword</td>
<td>arguments</td>
</tr>
<tr>
<td>Microsoft Vulnerabilities</td>
<td>Finds rules according to Microsoft bulletin number.</td>
<td>Yes</td>
<td>A keyword</td>
<td>arguments</td>
</tr>
<tr>
<td>Microsoft Worms</td>
<td>Finds rules based on specific worms that affect Microsoft Windows hosts.</td>
<td>Yes</td>
<td>A keyword</td>
<td>arguments</td>
</tr>
<tr>
<td>Platform Specific</td>
<td>Finds rules according to their relevance to specific versions of operating systems. Note that a rule may affect more than one operating system or more than one version of an operating system. For example, enabling SID 2260 affects multiple versions of Mac OS X, IBM AIX, and other operating systems.</td>
<td>Yes</td>
<td>A keyword</td>
<td>arguments</td>
</tr>
<tr>
<td>Filter Group</td>
<td>Description</td>
<td>Multiple Argument Support?</td>
<td>Heading is...</td>
<td>Items in List are...</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------</td>
<td>---------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Preprocessors</td>
<td>Finds rules for individual preprocessors. Note that you must enable preprocessor rules associated with a preprocessor option to generate events and, in an inline deployment, drop offending packets for the option when the preprocessor is enabled.</td>
<td>Yes</td>
<td>A grouping</td>
<td>sub-groupings</td>
</tr>
<tr>
<td>Priority</td>
<td>Finds rules according to high, medium, and low priorities. The classification assigned to a rule determines its priority. These groups are further grouped into rule categories. Note that local rules (that is, rules that you import or create) do not appear in the priority groups.</td>
<td>Yes</td>
<td>A keyword</td>
<td>arguments</td>
</tr>
<tr>
<td>Rule Update</td>
<td>Finds rules added or modified through a specific rule update. For each rule update, view all rules in the update, only new rules imported in the update, or only existing rules changed by the update.</td>
<td>No</td>
<td>A keyword</td>
<td>arguments</td>
</tr>
</tbody>
</table>

### Intrusion Rule Configuration Filters

You can filter the rules listed in the Rules page by several rule configuration settings. For example, if you want to view the set of rules whose rule state does not match the recommended rule state, you can filter on rule state by selecting **Does not match recommendation**.

When you choose a keyword by clicking on a node in the criteria list, you can supply the argument you want to filter by. If that keyword is already used in the filter, the argument you supply replaces the existing argument for that keyword.

For example, if you click **Drop and Generate Events** under **Rule Configuration > Recommendation** in the filter panel, `Recommendation:"Drop and Generate Events"` is added to the filter text box. If you then...
click **Generate Events** under **Rule Configuration > Recommendation**, the filter changes to Recommendation:"Generate Events".

**Intrusion Rule Content Filters**

You can filter the rules listed in the Rules page by several rule content items. For example, you can quickly retrieve a rule by searching for the rule’s SID. You can also find all rules that inspect traffic going to a specific destination port.

When you select a keyword by clicking on a node in the criteria list, you can supply the argument you want to filter by. If that keyword is already used in the filter, the argument you supply replaces the existing argument for that keyword.

For example, if you click **SID** under **Rule Content** in the filter panel, a pop-up window appears, prompting you to supply a SID. If you type 1045, then **SID:**“1045” is added to the filter text box. If you then click **SID** again and change the SID filter to 1044, the filter changes to **SID:**“1044”.

**Table 86: Rule Content Filters**

<table>
<thead>
<tr>
<th>This filter...</th>
<th>Finds rules that...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
<td>contain the supplied string in the message field.</td>
</tr>
<tr>
<td>SID</td>
<td>have the specified SID.</td>
</tr>
<tr>
<td>GID</td>
<td>have the specified GID.</td>
</tr>
<tr>
<td>Reference</td>
<td>contain the supplied string in the reference field. You can also filter by a specific type of reference and supplied string.</td>
</tr>
<tr>
<td>Action</td>
<td>start with alert or pass.</td>
</tr>
<tr>
<td>Protocol</td>
<td>include the selected protocol.</td>
</tr>
<tr>
<td>Direction</td>
<td>are based on whether the rule includes the indicated directional setting.</td>
</tr>
<tr>
<td>Source IP</td>
<td>use the specified addresses or variables for the source IP address designation in the rule. You can filter by a valid IP address, a CIDR block/prefix length, or using variables such as $HOME_NET or $EXTERNAL_NET.</td>
</tr>
<tr>
<td>Destination IP</td>
<td>use the specified addresses or variables for the source IP address designation in the rule. You can filter by a valid IP address, a CIDR block/prefix length, or using variables such as $HOME_NET or $EXTERNAL_NET.</td>
</tr>
<tr>
<td>Source port</td>
<td>include the specified source port. The port value must be an integer between 1 and 65535 or a port variable.</td>
</tr>
<tr>
<td>Destination port</td>
<td>include the specified destination port. The port value must be an integer between 1 and 65535 or a port variable.</td>
</tr>
<tr>
<td>Rule Overhead</td>
<td>have the selected rule overhead.</td>
</tr>
</tbody>
</table>
**Intrusion Rule Categories**

The Firepower System places rules in categories based on the type of traffic the rule detects. On the Rules page, you can filter by rule category, so you can set a rule attribute for all rules in a category. For example, if you do not have Linux hosts on your network, you could filter by the `os-linux` category, then disable all the rules showing to disable the entire `os-linux` category.

You can hover your pointer over a category name to display the number of rules in that category.

---

**Intrusion Rule Filter Components**

You can edit your filter to modify the special keywords and their arguments that are supplied when you click on a filter in the filter panel. Custom filters on the Rules page function like those used in the rule editor, but you can also use any of the keywords supplied in the Rules page filter, using the syntax displayed when you select the filter through the filter panel. To determine a keyword for future use, click on the appropriate argument in the filter panel on the right. The filter keyword and argument syntax appear in the filter text box. Remember that comma-separated multiple arguments for a keyword are only supported for the Category and Priority filter types.

You can use keywords and arguments, character strings, and literal character strings in quotes, with spaces separating multiple filter conditions. A filter cannot include regular expressions, wild card characters, or any special operator such as a negation character (!), a greater than symbol (>), less than symbol (<), and so on. When you type in search terms without a keyword, without initial capitalization of the keyword, or without quotes around the argument, the search is treated as a string search and the category, message, and SID fields are searched for the specified terms.

Except for the `gid` and `sid` keywords, all arguments and strings are treated as partial strings. Arguments for `gid` and `sid` return only exact matches.

Each rule filter can include one or more keywords in the format:

```
keyword:"argument"
```

where keyword is one of the keywords in the intrusion rule filter groups and argument is enclosed in double quotes and is a single, case-insensitive, alphanumeric string to search for in the specific field or fields relevant to the keyword. Note that keywords should be typed with initial capitalization.

Arguments for all keywords except `gid` and `sid` are treated as partial strings. For example, the argument `123` returns "12345", "41235", "45123", and so on. The arguments for `gid` and `sid` return only exact matches; for example, `sid:3080` returns only SID 3080.

Each rule filter can also include one or more alphanumeric character strings. Character strings search the rule Message field, Snort ID (SID), and Generator ID (GID). For example, the string `123` returns the strings...
"lotus123", "123mania", and so on in the rule message, and also returns SID 6123, SID 12375, and so on. You can search for a partial SID by filtering with one or more character strings.

All character strings are case-insensitive and are treated as partial strings. For example, any of the strings ADMIN, admin, or Admin return "admin", "CFADMIN", "Administrator" and so on.

You can enclose character strings in quotes to return exact matches. For example, the literal string "overflow attempt" in quotes returns only that exact string, whereas a filter comprised of the two strings overflow and attempt without quotes returns "overflow attempt", "overflow multipacket attempt", "overflow with evasion attempt", and so on.

You can narrow filter results by entering any combination of keywords, character strings, or both, separated by spaces. The result includes any rule that matches all the filter conditions.

You can enter multiple filter conditions in any order. For example, each of the following filters returns the same rules:

- url:at login attempt cve:200
- login attempt cve:200 url:at
- login cve:200 attempt url:at

**Intrusion Rule Filter Usage**

You can select predefined filter keywords from the filter panel on the left side of the Rules page in the intrusion policy. When you select a filter, the page displays all matching rules, or indicates when no rules match.

You can add keywords to a filter to further constrain it. Any filter you enter searches the entire rules database and returns all matching rules. When you enter a filter while the page still displays the result of a previous filter, the page clears and returns the result of the new filter instead.

You can also type a filter using the same keyword and argument syntax supplied when you select a filter, or modify argument values in a filter after you select it. When you type in search terms without a keyword, without initial capitalization of the keyword, or without quotes around the argument, the search is treated as a string search and the category, message, and SID fields are searched for the specified terms.

**Setting a Rule Filter in an Intrusion Policy**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can filter the rules on the Rules page to display a subset of rules. You can then use any of the page features, including choosing any of the features available in the context menu. This can be useful, for example, when you want to set a threshold for all the rules in a specific category. You can use the same features with rules in a filtered or unfiltered list. For example, you can apply new rule states to rules in a filtered or unfiltered list.

All filter keywords, keyword arguments, and character strings are case-insensitive. If you click an argument for a keyword already in the filter, it replaces the existing argument.
**Procedure**

**Step 1** Choose Policies > Access Control > Intrusion.

**Step 2** Click the edit icon (📝) next to the policy you want to edit.

If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click Rules.

**Step 4** Construct a filter using any of the following methods, separately or in combination:

- Enter a value in the Filter text box, and press Enter.
- Expand any of the predefined keywords. For example, click Rule Configuration.
- Click a keyword, and specify an argument value if prompted. For example:
  - Under Rule Configuration, you could click Rule State, choose Generate Events from the drop-down-list, and click OK.
  - Under Rule Configuration, you could click Comment, enter the string of comment text to filter by, and click OK.
  - Under Category, you could click app-detect, which the system uses as the argument value.
- Expand a keyword, and click an argument value. For example, expand Rule State and click Generate Events.

---

**Intrusion Rule States**

Intrusion rule states allow you to enable or disable the rule within an individual intrusion policy, as well as specify which action the system takes if monitored conditions trigger the rule.

The Cisco Talos Security Intelligence and Research Group (Talos) sets the default state of each intrusion and preprocessor rule in each default policy. For example, a rule may be enabled in the Security over Connectivity default policy and disabled in the Connectivity over Security default policy. Talos sometimes uses a rule update to change the default state of one or more rules in a default policy. If you allow rule updates to update your base policy, you also allow the rule update to change the default state of a rule in your policy when the default state changes in the default policy you used to create your policy (or in the default policy it is based on). Note, however, that if you have changed the rule state, the rule update does not override your change.

When you create an intrusion rule, it inherits the default states of the rules in the default policy you use to create your policy.

**Intrusion Rule State Options**

In an intrusion policy, you can set a rule’s state to the following values:
Generate Events

You want the system to detect a specific intrusion attempt and generate an intrusion event when it finds matching traffic. When a malicious packet crosses your network and triggers the rule, the packet is sent to its destination and the system generates an intrusion event. The malicious packet reaches its target, but you are notified via the event logging.

Drop and Generate Events

You want the system to detect a specific intrusion attempt, drop the packet containing the attack, and generate an intrusion event when it finds matching traffic. The malicious packet never reaches its target, and you are notified via the event logging.

Note

Choosing either the Generate Events or Drop and Generate Events options enables the rule. Choosing Disable disables the rule.

Cisco strongly recommends that you do not enable all the intrusion rules in an intrusion policy. The performance of your managed device is likely to degrade if all rules are enabled. Instead, tune your rule set to match your network environment as closely as possible.

Setting Intrusion Rule States

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/IntrusionAdmin</td>
</tr>
</tbody>
</table>

Intrusion rule states are policy-specific.

Procedure

Step 1  Choose Policies > Access Control > Intrusion.

Step 2  Click the edit icon (-pencil) next to the policy you want to edit.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Tip  This page indicates the total number of enabled rules, the total number of enabled rules set to Generate Events, and the total number set to Drop and Generate Events. Note also that in a passive deployment, rules set to Drop and Generate Events only generate events.

Step 3  Click Rules immediately under Policy Information in the navigation panel.
**Step 4** Choose the rule or rules where you want to set the rule state.

**Step 5** Choose one of the following:
- Rule State > Generate Events
- Rule State > Drop and Generate Events
- Rule State > Disable

**Step 6** To save changes you made in this policy since the last policy commit, click Policy Information in the navigation panel, then click Commit Changes.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

---

**What to do next**
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**Intrusion Event Notification Filters in an Intrusion Policy**

The importance of an intrusion event can be based on frequency of occurrence, or on source or destination IP address. In some cases you may not care about an event until it has occurred a certain number of times. For example, you may not be concerned if someone attempts to log into a server until they fail a certain number of times. In other cases, you may only need to see a few occurrences to know there is a widespread problem. For example, if a DoS attack is launched against your web server, you may only need to see a few occurrences of an intrusion event to know that you need to address the situation. Seeing hundreds of the same event only overwhelms your system.

**Intrusion Event Thresholds**

You can set thresholds for individual rules, per intrusion policy, to limit the number of times the system logs and displays an intrusion event based on how many times the event is generated within a specified time period. This can prevent you from being overwhelmed with a large number of identical events. You can set thresholds per shared object rule, standard text rule, or preprocessor rule.

**Intrusion Event Thresholds Configuration**

To set a threshold, first specify the thresholding type.

**Table 87: Thresholding Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit</td>
<td>Logs and displays events for the specified number of packets (specified by the Count argument) that trigger the rule during the specified time period. For example, if you set the type to Limit, the Count to 10, and the Seconds to 60, and 14 packets trigger the rule, the system stops logging events for the rule after displaying the first 10 that occur within the same minute.</td>
</tr>
</tbody>
</table>
Threshold

Logs and displays a single event when the specified number of packets (specified by the Count argument) trigger the rule during the specified time period. Note that the counter for the time restarts after you hit the threshold count of events and the system logs that event. For example, you set the type to **Threshold, Count** to 10, and **Seconds** to 60, and the rule triggers 10 times by second 33. The system generates one event, then resets the Seconds and Count counters to 0. The rule then triggers another 10 times in the next 25 seconds. Because the counters reset to 0 at second 33, the system logs another event.

Both

Logs and displays an event once per specified time period, after the specified number (count) of packets trigger the rule. For example, if you set the type to **Both, Count** to two, and **Seconds** to 10, the following event counts result:

- If the rule is triggered once in 10 seconds, the system does not generate any events (the threshold is not met)
- If the rule is triggered twice in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time)
- If the rule is triggered four times in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time, and following events are ignored)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Logs and displays a single event when the specified number of packets (specified by the Count argument) trigger the rule during the specified time period. Note that the counter for the time restarts after you hit the threshold count of events and the system logs that event. For example, you set the type to <strong>Threshold, Count</strong> to 10, and <strong>Seconds</strong> to 60, and the rule triggers 10 times by second 33. The system generates one event, then resets the Seconds and Count counters to 0. The rule then triggers another 10 times in the next 25 seconds. Because the counters reset to 0 at second 33, the system logs another event.</td>
</tr>
<tr>
<td>Both</td>
<td>Logs and displays an event once per specified time period, after the specified number (count) of packets trigger the rule. For example, if you set the type to <strong>Both, Count</strong> to two, and <strong>Seconds</strong> to 10, the following event counts result:</td>
</tr>
<tr>
<td></td>
<td>- If the rule is triggered once in 10 seconds, the system does not generate any events (the threshold is not met)</td>
</tr>
<tr>
<td></td>
<td>- If the rule is triggered twice in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time)</td>
</tr>
<tr>
<td></td>
<td>- If the rule is triggered four times in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time, and following events are ignored)</td>
</tr>
</tbody>
</table>

Next, specify tracking, which determines whether the event threshold is calculated per source or destination IP address.

<table>
<thead>
<tr>
<th>Table 88: Thresholding IP Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>Source</td>
</tr>
<tr>
<td>Destination</td>
</tr>
</tbody>
</table>

Finally, specify the number of instances and time period that define the threshold.

<table>
<thead>
<tr>
<th>Table 89: Thresholding Instance/Time Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>Count</td>
</tr>
</tbody>
</table>
Adding and Modifying Intrusion Event Thresholds

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seconds</td>
<td>The number of seconds that elapse before the count resets. If you set the threshold type to limit, the tracking to Source IP, the count to 10, and the seconds to 10, the system logs and displays the first 10 events that occur in 10 seconds from a given source port. If only 7 events occur in the first 10 seconds, the system logs and displays those; if 40 events occur in the first 10 seconds, the system logs and displays 10, then begins counting again when the 10-second time period elapses.</td>
</tr>
</tbody>
</table>

Note that you can use intrusion event thresholding alone or in any combination with rate-based attack prevention, the detection_filter keyword, and intrusion event suppression.

Tip

You can also add thresholds from within the packet view of an intrusion event.

Related Topics

The detection_filter Keyword, on page 1020
Setting Threshold Options within the Packet View, on page 1649

Adding and Modifying Intrusion Event Thresholds

You can set a threshold for one or more specific rules in an intrusion policy. You can also separately or simultaneously modify existing threshold settings. You can set a single threshold for each. Adding a threshold overwrites any existing threshold for the rule.

You can also modify the global threshold that applies by default to all rules and preprocessor-generated events associated with the intrusion policy.

A revert icon (✍️) appears in a field when you enter an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value.

Tip

A global or individual threshold on a managed device with multiple CPUs may result in a higher number of events than expected.

Procedure

Step 1 Choose Policies > Access Control > Intrusion.

Step 2 Click the edit icon (✍️) next to the policy you want to edit.
If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Rules** immediately under **Policy Information** in the navigation pane.

**Step 4** Choose the rule or rules where you want to set a threshold.

**Step 5** Choose **Event Filtering > Threshold**.

**Step 6** Choose a threshold type from the **Type** drop-down list.

**Step 7** From the **Track By** drop-down list, choose whether you want the event instances tracked by **Source** or **Destination** IP address.

**Step 8** Enter a value in the **Count** field.

**Step 9** Enter a value in the **Seconds** field.

**Step 10** Click **OK**.

**Tip** The system displays an event filter icon (🔍) next to the rule in the Event Filtering column. If you add multiple event filters to a rule, a number over the icon indicates the number of event filters.

**Step 11** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

---

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

**Related Topics**

- **Global Rule Thresholding Basics**, on page 921

---

**Viewing and Deleting Intrusion Event Thresholds**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
<td></td>
</tr>
</tbody>
</table>

You may want to view or delete an existing threshold setting for a rule. You can use the Rules Details view to display the configured settings for a threshold to see if they are appropriate for your system. If they are not, you can add a new threshold to overwrite the existing values.

Note that you can also modify the global threshold that applies by default to all rules and preprocessor-generated events logged by the intrusion policy.

**Procedure**

**Step 1** Choose **Policies > Access Control > Intrusion**.
Step 2  Click the edit icon (-pencil) next to the policy you want to edit.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3  Click Rules immediately under Policy Information in the navigation pane.

Step 4  Choose the rule or rules with a configured threshold you want to view or delete.

Step 5  To remove the threshold for each selected rule, choose Event Filtering > Remove Thresholds.

Step 6  Click OK.

Step 7  To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

- Global Rule Thresholding Basics, on page 921

Intrusion Policy Suppression Configuration

You can suppress intrusion event notification when a specific IP address or range of IP addresses triggers a specific rule or preprocessor. This is useful for eliminating false positives. For example, if you have a mail server that transmits packets that look like a specific exploit, you might suppress event notification for that event when it is triggered by your mail server. The rule triggers for all packets, but you only see events for legitimate attacks.

Intrusion Policy Suppression Types

Note that you can use intrusion event suppression alone or in any combination with rate-based attack prevention, the detection_filter keyword, and intrusion event thresholding.

Tip

You can add suppressions from within the packet view of an intrusion event. You can also access suppression settings by using the right-click context menu on the intrusion rules editor page (Objects > Intrusion Rules) and on any intrusion event page (if the event was triggered by an intrusion rule).

Related Topics

- The detection_filter Keyword, on page 1020
- Setting Threshold Options within the Packet View, on page 1649
Suppressing Intrusion Events for a Specific Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can suppress intrusion event notification for a rule or rules in your intrusion policy. When notification is suppressed for a rule, the rule triggers but events are not generated. You can set one or more suppressions for a rule. The first suppression listed has the highest priority. When two suppressions conflict, the action of the first is carried out.

Note that a revert icon (💨) appears in a field when you enter an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value.

**Procedure**

**Step 1** Choose Policies > Access Control > Intrusion.

**Step 2** Click the edit icon (✍️) next to the policy you want to edit.

If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click Rules immediately under Policy Information in the navigation panel.

**Step 4** Choose the rule or rules for which you want to configure suppression conditions.

**Step 5** Choose Event Filtering > Suppression.

**Step 6** Choose a Suppression Type.

**Step 7** If you chose Source or Destination for the suppression type, in the Network field enter the IP address, address block, or variable you want to specify as the source or destination IP address, or a comma-separated list comprised of any combination of these.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.

**Step 8** Click OK.

**Tip** The system displays an event filter icon (وع) next to the rule in the Event Filtering column next the suppressed rule. If you add multiple event filters to a rule, a number over the icon indicates the number of event filters.

**Step 9** To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.
Viewing and Deleting Suppression Conditions

You may want to view or delete an existing suppression condition. For example, you can suppress event notification for packets originating from a mail server IP address because the mail server normally transmits packets that look like exploits. If you then decommission that mail server and reassign the IP address to another host, you should delete the suppression conditions for that source IP address.

**Procedure**

**Step 1** Choose **Policies > Access Control > Intrusion**.

**Step 2** Click the edit icon (✏️) next to the policy you want to edit.

If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Rules** immediately under **Policy Information** in the navigation panel.

**Step 4** Choose the rule or rules for which you want to view or delete suppressions.

**Step 5** You have the following choices:

- To remove all suppression for a rule, choose **Event Filtering > Remove Suppressions**.
- To remove a specific suppression setting, click the rule, then click **Show details**. Expand the suppression settings and click **Delete** next to the suppression settings you want to remove.

**Step 6** Click **OK**.

**Step 7** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes, on page 277**.
Dynamic Intrusion Rule States

Rate-based attacks attempt to overwhelm a network or host by sending excessive traffic toward the network or host, causing it to slow down or deny legitimate requests. You can use rate-based prevention to change the action of a rule in response to excessive rule matches for specific rules.

You can configure your intrusion policies to include a rate-based filter that detects when too many matches for a rule occur in a given time period. You can use this feature on managed devices deployed inline to block rate-based attacks for a specified time, then revert to a rule state where rule matches only generate events and do not drop traffic.

Rate-based attack prevention identifies abnormal traffic patterns and attempts to minimize the impact of that traffic on legitimate requests. You can identify excessive rule matches in traffic going to a particular destination IP address or addresses or coming from a particular source IP address or addresses. You can also respond to excessive matches for a particular rule across all detected traffic.

In some cases, you may not want to set a rule to the Drop and Generate Events state because you do not want to drop every packet that matches the rule, but you do want to drop packets matching the rule if a particular rate of matches occurs in a specified time. Dynamic rule states let you configure the rate that should trigger a change in the action for a rule, what the action should change to when the rate is met, and how long the new action should persist.

The following diagram shows an example where an attacker is attempting to access a host. Repeated attempts to find a password trigger a rule which has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events after rule matches occur five times in a 10-second span. The new rule attribute times out after 15 seconds.

After the timeout, note that packets are still dropped in the rate-based sampling period that follows. If the sampled rate is above the threshold in the current or previous sampling period, the new action continues. The new action reverts to Generate Events only after a sampling period completes where the sampled rate was below the threshold rate.

Dynamic Intrusion Rule State Configuration

In the intrusion policy, you can configure a rate-based filter for any intrusion or preprocessor rule. The rate-based filter contains three components:
• the rule matching rate, which you configure as a count of rule matches within a specific number of seconds
• a new action to be taken when the rate is exceeded, with three available actions: Generate Events, Drop and Generate Events, and Disable
• the duration of the action, which you configure as a timeout value

Note that when started, the new action occurs until the timeout is reached, even if the rate falls below the configured rate during that time period. When the timeout is reached, if the rate has fallen below the threshold, the action for the rule reverts to the action initially configured for the rule.

You can configure rate-based attack prevention in an inline deployment to block attacks, either temporarily or permanently. Without rate-based configuration, rules set to Generate Events do generate events, but the system does not drop packets for those rules. However, if the attack traffic matches rules that have rate-based criteria configured, the rate action may cause packet dropping to occur for the period of time that the rate action is active, even if those rules are not initially set to Drop and Generate Events.

Rate-based actions cannot enable disabled rules or drop traffic that matches disabled rules.

You can define multiple rate-based filters on the same rule. The first filter listed in the intrusion policy has the highest priority. Note that when two rate-based filter actions conflict, the action of the first rate-based filter is carried out.

### Setting a Dynamic Rule State from the Rules Page

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

You can set one or more dynamic rule states for a rule. The first dynamic rule state listed has the highest priority. When two dynamic rule states conflict, the action of the first is carried out.

Dynamic rule states are policy-specific.

A revert icon (🪨) appears in a field when you enter an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value.

Dynamic rule states cannot enable disabled rules or drop traffic that matches disabled rules.

### Procedure

**Step 1** Choose Policies > Access Control > Intrusion.

**Step 2** Click the edit icon (📝) next to the policy you want to edit.
If a view icon (🔗) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Rules** immediately under **Policy Information** in the navigation pane.

**Step 4** Choose the rule or rules where you want to add a dynamic rule state.

**Step 5** Choose **Dynamic State > Add Rate-Based Rule State**.

**Step 6** Choose a value from the **Track By** drop-down list.

**Step 7** If you set **Track By** to **Source** or **Destination**, enter the address of each host you want to track in the **Network** field. You can specify a single IP address, address block, variable, or a comma-separated list comprised of any combination of these.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.

**Step 8** Next to **Rate**, specify the number of rule matches per time period to set the attack rate:

- Enter a value in the **Count** field.
- Enter a value in the **Seconds** field.

**Step 9** From the **New State** drop-down list, specify the new action to be taken when the conditions are met.

**Step 10** Enter a value in the **Timeout** field.

After the timeout occurs, the rule reverts to its original state. Specify 0 or leave the **Timeout** field blank to prevent the new action from timing out.

**Step 11** Click **OK**.

**Tip** The system displays a dynamic state icon (🔗) next to the rule in the Dynamic State column. If you add multiple dynamic rule state filters to a rule, a number over the icon indicates the number of filters.

**Tip** To delete all dynamic rule settings for a set of rules, choose the rules on the Rules page, then choose **Dynamic State > Remove Rate-Based States**. You can also delete individual rate-based rule state filters from the rule details for the rule by choosing the rule, clicking **Show details**, then clicking **Delete** by the rate-based filter you want to remove.

**Step 12** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.
Adding Intrusion Rule Comments

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can add comments to rules in your intrusion policy. Comments added this way are policy-specific; that is, comments you add to a rule in one intrusion policy are not visible in other intrusion policies. Any comments you add can be seen in the Rule Details view on the Rules page for the intrusion policy.

After you commit the intrusion policy changes containing the comment, you can also view the comment by clicking **Rule Comment** on the rule Edit page.

**Procedure**

**Step 1** Choose **Policies > Access Control > Intrusion**.

**Step 2** Click the edit icon (✏️) next to the policy you want to edit.

If a view icon (👁️) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Rules** immediately under **Policy Information** in the navigation panel.

**Step 4** Choose the rule or rules where you want to add a comment.

**Step 5** Choose **Comments > Add Rule Comment**.

**Step 6** In the **Comment** field, enter the rule comment.

**Step 7** Click **OK**.

**Tip** The system displays a comment icon (💬) next to the rule in the Comments column. If you add multiple comments to a rule, a number over the icon indicates the number of comments.

**Step 8** Optionally, delete a rule comment by clicking **Delete** next to the comment.

You can only delete a comment if the comment is cached with uncommitted intrusion policy changes. After intrusion policy changes are committed, the rule comment is permanent.

**Step 9** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.
Tailoring Intrusion Protection to Your Network Assets

The following topics describe how to use Firepower recommended rules:

- About Firepower Recommended Rules, on page 901
- Default Settings for Firepower Recommendations, on page 902
- Advanced Settings for Firepower Recommendations, on page 903
- Generating and Applying Firepower Recommendations, on page 904

About Firepower Recommended Rules

You can use Firepower intrusion rule recommendations to associate the operating systems, servers, and client application protocols detected on your network with rules specifically written to protect those assets. This allows you to tailor your intrusion policy to the specific needs of your monitored network.

The system makes an individual set of recommendations for each intrusion policy. It typically recommends rule state changes for standard text rules and shared object rules. However, it can also recommend changes for preprocessor and decoder rules.

When you generate rule state recommendations, you can use the default settings or configure advanced settings. Advanced settings allow you to:

- Redefine which hosts on your network the system monitors for vulnerabilities
- Influence which rules the system recommends based on rule overhead
- Specify whether to generate recommendations to disable rules

You can also choose either to use the recommendations immediately or to review the recommendations (and affected rules) before accepting them.

Choosing to use recommended rule states adds a read-only Firepower Recommendations layer to your intrusion policy, and subsequently choosing not to use recommended rule states removes the layer.

You can schedule a task to generate recommendations automatically based on the most recently saved configuration settings in your intrusion policy.

The system does not change rule states that you set manually:
• Manually setting the states of specified rules before you generate recommendations prevents the system from modifying the states of those rules in the future.

• Manually setting the states of specified rules after you generate recommendations overrides the recommended states of those rules.

Tip

The intrusion policy report can include a list of rules with rule states that differ from the recommended state.

While displaying the recommendation-filtered Rules page, or after accessing the Rules page directly from the navigation panel or the Policy Information page, you can manually set rule states, sort rules, and take any of the other actions available on the Rules page, such as suppressing rules, setting rule thresholds, and so on.

Note

The Cisco Talos Security Intelligence and Research Group (Talos) determines the appropriate state of each rule in the system-provided policies. If you use a system-provided policy as your base policy, and you allow the system to set your rules to the Firepower recommended rule state, the rules in your intrusion policy match the settings recommended by Cisco for your network assets.

Recommended Rules and Multitenancy

The system builds a separate network map for each leaf domain. In a multidomain deployment, if you enable this feature in an intrusion policy in an ancestor domain, the system generates recommendations using data from all descendant leaf domains. This can enable intrusion rules tailored to assets that may not exist in all leaf domains, which can affect performance.

Default Settings for Firepower Recommendations

When you generate Firepower recommendations, the system searches your base policy for rules that protect against vulnerabilities associated with your network assets, and identifies the current state of rules in your base policy. The system then recommends rule states and, if you choose to, sets the rules to the recommended states.

The system performs the following basic analysis to generate recommendations:

Table 90: Rule State Recommendations Based on Vulnerabilities

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Disabled</td>
<td>Generate Events</td>
</tr>
<tr>
<td></td>
<td>Generate Events</td>
<td>Generate Events</td>
</tr>
<tr>
<td></td>
<td>Drop and Generate Events</td>
<td>Drop and Generate Events</td>
</tr>
<tr>
<td>No</td>
<td>Any</td>
<td>Disabled</td>
</tr>
</tbody>
</table>
Note the following in the table:

- If a rule is disabled in the base policy, or set to Generate Events, the recommended state is always Generate Events.
  
  For example, if the base policy is No Rules Active, in which all rules are disabled, there will be no recommendations to Drop and Generate Events.

- Recommendations to Drop and Generate Events are made only for rules already set to Drop and Generate Events in the base policy.

  If you want a rule to be set to Drop and Generate events and the rule was disabled or set to Generate Events in the base policy, you must manually reset the rule state.

When you generate recommendations without changing the advanced settings for Firepower recommended rules, the system recommends rule state changes for all hosts in your entire discovered network.

By default, the system generates recommendations only for rules with low or medium overhead, and generates recommendations to disable rules.

The system does not recommend a rule state for an intrusion rule that is based on a vulnerability that you disable using the Impact Qualification feature.

The system always recommends that you enable a local rule associated with a third-party vulnerability mapped to a host.

The system does not make state recommendations for unmapped local rules.

**Related Topics**

- Deactivating Individual Vulnerabilities, on page 1724
- Third-Party Product Mappings, on page 1224

---

**Advanced Settings for Firepower Recommendations**

**Include all differences between recommendations and rule states in policy reports**

By default, an intrusion policy report lists the policy’s enabled rules, that is, rules set to either Generate Events or Drop and Generate Events. Enabling the Include all differences option also lists the rules whose recommended states differ from their saved states. For information on policy reports, see Policy Reports, on page 285.

**Networks to Examine**

Specifies the monitored networks or individual hosts to examine for recommendations. You can specify a single IP address or address block, or a comma-separated list comprised of either or both.

Lists of addresses within the hosts that you specify are linked with an OR operation except for negations, which are linked with an AND operation after all OR operations are calculated.

If you want to dynamically adapt active rule processing for specific packets based on host information, you can also enable adaptive profiles.

**Recommendation Threshold (By Rule Overhead)**

Prevents the system from recommending or automatically enabling intrusion rules with a higher overhead than the threshold you choose.
Overhead is based on the rule’s potential impact on system performance and the likelihood that the rule may generate false positives. Permitting rules with higher overhead usually results in more recommendations, but can affect system performance. You can view the overhead rating for a rule in the rule detail view on the intrusion Rules page.

Note that the system does not factor rule overhead into recommendations to disable rules. Also, local rules are considered to have no overhead, unless they are mapped to a third-party vulnerability.

Generating recommendations for rules with the overhead rating at a particular setting does not preclude you from generating recommendations with different overhead, then generating recommendations again for the original overhead setting. You get the same rule state recommendations for each overhead setting each time you generate recommendations for the same rule set, regardless of the number of times you generate recommendations or how many different overhead settings you generate with. For example, you can generate recommendations with overhead set to medium, then to high, then finally to medium again; if the hosts and applications on your network have not changed, both sets of recommendations with overhead set to medium are then the same for that rule set.

Accept Recommendations to Disable Rules

Specifies whether the system disables intrusion rules based on Firepower recommendations.

Accepting recommendations to disable rules restricts your rule coverage. Omitting recommendations to disable rules augments your rule coverage.

Related Topics

Firepower System IP Address Conventions, on page 14
Adaptive Profiles and Firepower Recommended Rules, on page 1193

---

### Generating and Applying Firepower Recommendations

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

Starting or stopping use of Firepower recommendations may take several minutes, depending on the size of your network and intrusion rule set.

The system builds a separate network map for each leaf domain. In a multidomain deployment, if you enable this feature in an intrusion policy in an ancestor domain, the system generates recommendations using data from all descendant leaf domains. This can enable intrusion rules tailored to assets that may not exist in all leaf domains, which can affect performance.

**Procedure**

**Step 1** In the intrusion policy editor's navigation pane, click Firepower Recommendations.

**Step 2** (Optional) Configure advanced settings; see Advanced Settings for Firepower Recommendations, on page 903.

**Step 3** Generate and apply recommendations.

- Generate and Use Recommendations—Generates recommendations and changes rule states to match. Only available if you have never generated recommendations.
• Generate Recommendations—Regardless of whether you are using recommendations, generates new recommendations but does not change rule states to match.
• Update Recommendations—If you are using recommendations, generates recommendations and changes rule states to match. Otherwise, generates new recommendations without changing rule states.
• Use Recommendations—Changes rule states to match any unimplemented recommendations.
• Do Not Use Recommendations—Stops use of recommendations. If you manually changed a rule's state before you applied recommendations, the rule state returns to the value you gave it. Otherwise, the rule state returns to its default value.

When you generate recommendations, the system displays a summary of the recommended changes. To view a list of rules where the system recommends a state change, click **View** next to the newly proposed rule state.

**Step 4** Evaluate and adjust the recommendations you implemented.

Even if you accept most Firepower recommendations, you can override individual recommendations by setting rule states manually; see Setting Intrusion Rule States, on page 889.

**Step 5** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

---

**What to do next**

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

Automating Firepower Recommendations, on page 159
CHAPTER 53

Sensitive Data Detection

The following topics explain sensitive data detection and how to configure it:

- Sensitive Data Detection Basics, on page 907
- Global Sensitive Data Detection Options, on page 908
- Individual Sensitive Data Type Options, on page 909
- System-Provided Sensitive Data Types, on page 910
- Configuring Sensitive Data Detection, on page 911
- Monitored Application Protocols and Sensitive Data, on page 912
- Selecting Application Protocols to Monitor, on page 913
- Special Case: Sensitive Data Detection in FTP Traffic, on page 914
- Custom Sensitive Data Types, on page 914

Sensitive Data Detection Basics

Sensitive data such as Social Security numbers, credit card numbers, driver’s license numbers, and so on may be leaked onto the Internet, intentionally or accidentally. The system provides a sensitive data preprocessor that can detect and generate events on sensitive data in ASCII text, which can be particularly useful in detecting accidental data leaks.

Global sensitive data preprocessor options control how the preprocessor functions. You can modify global options that specify the following:

- whether the preprocessor replaces all but the last four credit card or Social Security numbers in triggering packets
- which destination hosts on your network to monitor for sensitive data
- how many total occurrences of all data types in a single session result in an event

Individual data types identify the sensitive data you can detect and generate events on in your specified destination network traffic. You can modify default settings for data type options that specify the following:

- a threshold that must be met for a detected data type to generate a single per-session event
- the destination ports to monitor for each data type
- the application protocols to monitor for each data type
You can create and modify custom data types to detect data patterns that you specify. For example, a hospital might create a data type to protect patient numbers, or a university might create a data type to detect student numbers that have a unique numbering pattern.

The system detects sensitive data per TCP session by matching individual data types against traffic. You can modify the default settings for each data type and for global options that apply to all data types in your intrusion policy. The Firepower System provides predefined, commonly used data types. You can also create custom data types.

A sensitive data preprocessor rule is associated with each data type. You enable sensitive data detection and event generation for each data type by enabling the corresponding preprocessor rule for the data type. A link on the configuration page takes you to a filtered view of sensitive data rules on the Rules page, where you can enable and disable rules and configure other rule attributes.

When you save changes to your intrusion policy, you are given the option to automatically enable the sensitive data preprocessor if the rule associated with a data type is enabled and sensitive data detection is disabled.

**Tip**

The sensitive data preprocessor can detect sensitive data in unencrypted Microsoft Word files that are uploaded and downloaded using FTP or HTTP; this is possible because of the way Word files group ASCII text and formatting commands separately.

The system does not detect encrypted or obfuscated sensitive data, or sensitive data in a compressed or encoded format such as a Base64-encoded email attachment. For example, the system would detect the phone number (555)123-4567, but not an obfuscated version where each number is separated by spaces, as in (5 5 5) 1 2 3 - 4 5 6 7, or by intervening HTML code, such as `<b>(555)</b>-<i>123-4567</i>`. However, the system would detect, for example, the HTML coded number `<b>(555)-123-4567</b>` where no intervening codes interrupt the numbering pattern.

### Global Sensitive Data Detection Options

Global sensitive data options are policy-specific and apply to all data types.

**Mask**

Replaces with Xs all but the last four digits of credit card numbers and Social Security numbers in the triggering packet. The masked numbers appear in the intrusion event packet view in the web interface and in downloaded packets.

**Networks**

Specifies the destination host or hosts to monitor for sensitive data. You can specify a single IP address, address block, or a comma-separated list of either or both. The system interprets a blank field as `any`, meaning any destination IP address.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.
Global Threshold

Specifies the total number of all occurrences of all data types during a single session that the preprocessor must detect in any combination before generating a global threshold event. You can specify 1 through 65535. Cisco recommends that you set the value for this option higher than the highest threshold value for any individual data type that you enable in your policy.

Note the following points regarding global thresholds:

• You must enable preprocessor rule 139:1 to detect and generate events and, in an inline deployment, drop offending packets on combined data type occurrences.

• The preprocessor generates up to one global threshold event per session.

• Global threshold events are independent of individual data type events; that is, the preprocessor generates an event when the global threshold is reached, regardless of whether the event threshold for any individual data type has been reached, and vice versa.

Related Topics

Firepower System IP Address Conventions, on page 14

Individual Sensitive Data Type Options

At a minimum, each custom data type must specify an event threshold and at least one port or application protocol to monitor.

Each system-provided data type uses an otherwise inaccessible `sd_pattern` keyword to define a built-in data pattern to detect in traffic. You can also create custom data types for which you use simple regular expressions to specify your own data patterns.

Sensitive data types display in all intrusion policies where Sensitive Data Detection is enabled. System-provided data types display as read-only. For custom data types, the name and pattern fields display as read-only, but you can set the other options to policy-specific values.

In a multidomain deployment, the system displays sensitive data types created in the current domain, which you can edit. It also displays data types created in ancestor domains, which you can edit in a limited way. For ancestor data types, the name and pattern fields display as read-only, but you can set the other options to policy-specific values.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Type</td>
<td>Specifies the unique name for the data type.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Specifies the number of occurrences of the data type when the system generates an event. You can specify 1 through 255. Note that the preprocessor generates one event for a detected data type per session. Note also that global threshold events are independent of individual data type events; that is, the preprocessor generates an event when the data type event threshold is reached, regardless of whether the global event threshold has been reached, and vice versa.</td>
</tr>
</tbody>
</table>
### System-Provided Sensitive Data Types

Each intrusion policy includes system-provided data types for detecting commonly used data patterns such as credit card numbers, email addresses, U.S. phone numbers, and U.S. Social Security numbers with and without dashes.

Each system-provided data type is associated with a single sensitive data preprocessor rule that has a generator ID (GID) of 138. You must enable the associated sensitive data rule in the intrusion policy to generate events and, in an inline deployment, drop offending packets for each data type that you want to use in your policy.

The following table describes each data type and lists the corresponding preprocessor rule.

#### Table 92: System-Provided Sensitive Data Types

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
<th>Preprocessor Rule GID:SID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit Card Numbers</td>
<td>Matches Visa®, MasterCard®, Discover® and American Express®, fifteen- and sixteen-digit credit card numbers, with or without their normal separating dashes or spaces; also uses the Luhn algorithm to verify credit card check digits.</td>
<td>138:2</td>
</tr>
<tr>
<td>Email Addresses</td>
<td>Matches email addresses.</td>
<td>138:5</td>
</tr>
<tr>
<td>U.S. Phone Numbers</td>
<td>Matches U.S. phone numbers adhering to the pattern <code>(^\d{3}) ?\d{3}-\d{4}</code>.</td>
<td>138:6</td>
</tr>
<tr>
<td>Data Type</td>
<td>Description</td>
<td>Preprocessor Rule GID:SID</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>U.S. Social Security Numbers</td>
<td>Matches 9-digit U.S. Social Security numbers that have valid 3-digit area numbers, valid 2-digit group numbers, and do not have dashes.</td>
<td>138:4</td>
</tr>
<tr>
<td>Without Dashes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>U.S. Social Security Numbers With</td>
<td>Matches 9-digit U.S. Social Security numbers that have valid 3-digit area numbers, valid 2-digit group numbers, and dashes.</td>
<td>138:3</td>
</tr>
<tr>
<td>Dashes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To reduce false positives from 9-digit numbers other than Social Security numbers, the preprocessor uses an algorithm to validate the 3-digit area number and 2-digit group number that precede the 4-digit serial number in each Social Security number. The preprocessor validates Social Security group number through November 2009.

## Configuring Sensitive Data Detection

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection or Control</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

Because sensitive data detection can have a high impact on the performance of your Firepower System, Cisco recommends that you adhere to the following guidelines:

- Choose the No Rules Active default policy as your base intrusion policy.
- Ensure that the following settings are enabled in the corresponding network analysis policy:
  - FTP and Telnet Configuration under Application Layer Preprocessors
  - IP Defragmentation and TCP Stream Configuration under Transport/Network Layer Preprocessors.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

### Procedure

**Step 1** Choose Policies > Access Control > Intrusion

**Step 2** Click the edit icon (🔑) next to the policy you want to edit.

If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click Advanced Settings in the navigation panel.
Step 4  If Sensitive Data Detection under Specific Threat Detection is disabled, click Enabled.

Step 5  Click the edit icon (📝) next to Sensitive Data Detection.

Step 6  You have the following choices:
   • Modify the global settings as described in Global Sensitive Data Detection Options, on page 908.
   • Choose a data type in the Targets section, and modify the data type configuration as described in Individual Sensitive Data Type Options, on page 909.
   • If you want to inspect custom sensitive data, create a custom data type; see Custom Sensitive Data Types, on page 914.

Step 7  Add or remove application protocols to monitor for a data type; see Monitored Application Protocols and Sensitive Data, on page 912.

   Note  To detect sensitive data in FTP traffic, you must add the Ftp data application protocol.

Step 8  Optionally, to display sensitive data preprocessor rules, click Configure Rules for Sensitive Data Detection.

   You can enable or disable any of the listed rules. You can also configure sensitive data rules for any of the other actions available on the Rules page, such as rule suppression, rate-based attack prevention, and so on; see Intrusion Rule Types, on page 873 for more information.

Step 9  To save changes you made in this policy since the last policy commit, click Policy Information in the navigation panel, then click Commit Changes.

   If you enable sensitive data preprocessor rules in your policy without enabling sensitive data detection, you are prompted to enable sensitive data detection when you save changes to your policy.

   If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

What to do next
   • If you want to generate intrusion events, enable Sensitive Data Detection rules 138:2, 138:3, 138:4, 138:5, 138:6, 138:>999999, or 139:1. For more information, see Intrusion Rule States, on page 888, Global Sensitive Data Detection Options, on page 908, System-Provided Sensitive Data Types, on page 910, and Custom Sensitive Data Types, on page 914.

   • Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics
   Special Case: Sensitive Data Detection in FTP Traffic, on page 914

Monitored Application Protocols and Sensitive Data

You can specify up to eight application protocols to monitor for each data type. At least one detector must be enabled for each application protocol you select. By default, all system-provided detectors are activated. If no detector is enabled for an application protocol, the system automatically enables all system-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application.
You must specify at least one application protocol or port to monitor for each data type. However, except in the case where you want to detect sensitive data in FTP traffic, Cisco recommends for the most complete coverage that you specify corresponding ports when you specify application protocols. For example, if you specify HTTP, you might also configure the well-known HTTP port 80. If a new host on your network implements HTTP, the system monitors port 80 during the interval when it is discovering the new HTTP application protocol.

In the case where you want to detect sensitive data in FTP traffic, you must specify the FTP data application protocol; there is no advantage in specifying a port number.

**Related Topics**
- Activating and Deactivating Detectors, on page 1273
- Special Case: Sensitive Data Detection in FTP Traffic, on page 914

### Selecting Application Protocols to Monitor

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Control</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can specify application protocols to monitor in both system-provided and custom sensitive data types. The application protocols you select are policy-specific.

**Procedure**

**Step 1** Choose Policies > Access Control > Intrusion.

**Step 2** Click the edit icon (✏️) next to the policy you want to edit.

If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click Advanced Settings in the navigation panel.

**Step 4** If Sensitive Data Detection under Specific Threat Detection is disabled, click Enabled.

**Step 5** Click the edit icon (✏️) next to Sensitive Data Detection.

**Step 6** Click the name of a data type under Data Types.

**Step 7** Click edit icon (✏️) next to the Application Protocols field.

**Step 8** You have the following choices:

- To add application protocols for monitoring, choose one or more application protocols from the Available list, then click the right arrow (>) button. You can add up to eight application protocols for monitoring.
- To remove an application protocol from monitoring, choose it from the Enabled list, then click the left arrow (<) button.

**Step 9** Click OK.

**Step 10** To save changes you made in this policy since the last policy commit, click Policy Information in the navigation pane, then click Commit Changes.
If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

- Special Case: Sensitive Data Detection in FTP Traffic, on page 914

---

### Special Case: Sensitive Data Detection in FTP Traffic

You usually determine which traffic to monitor for sensitive data by specifying the ports to monitor or specifying application protocols in deployments.

However, specifying ports or application protocols is not sufficient for detecting sensitive data in FTP traffic. Sensitive data in FTP traffic is found in traffic for the FTP application protocol, which occurs intermittently and uses a transient port number, making it difficult to detect. To detect sensitive data in FTP traffic, you must include the following in your configuration:

- Specify the FTP data application protocol to enable detection of sensitive data in FTP traffic.
  - In the special case of detecting sensitive data in FTP traffic, specifying the FTP data application protocol does not invoke detection; instead, it invokes the rapid processing of the FTP/Telnet processor to detect sensitive data in FTP traffic.

- Ensure that the FTP Data detector, which is enabled by default, is enabled.

- Ensure that your configuration includes at least one port to monitor for sensitive data.

Note that it is not necessary to specify an FTP port except in the unlikely case where you only want to detect sensitive data in FTP traffic. Most sensitive data configurations will include other ports such as HTTP or email ports. In the case where you do want to specify only one FTP port and no other ports to monitor, Cisco recommends that you specify the FTP command port 23.

**Related Topics**

- The FTP/Telnet Decoder, on page 1082
- Activating and Deactivating Detectors, on page 1273
- Configuring Sensitive Data Detection, on page 911

---

### Custom Sensitive Data Types

Each custom data type you create also creates a single sensitive data preprocessor rule that has a Generator ID (GID) of 138 and a Snort ID (SID) of 1000000 or greater, that is, a SID for a local rule. In a multidomain deployment, the system prepends a domain number to the SID of any custom rule created in or imported into a descendant domain. For example, a rule added in the Global domain would have a SID of 1000000 or greater, and rules added in descendant domains would have SIDs of [domain number]000000 or greater.
You must enable the associated sensitive data rule to enable detection, generate events and, in an inline deployment, drop offending packets for each custom data type that you want to use in your policy.

To help you enable sensitive data rules, a link on the configuration page takes you to a filtered view of the intrusion policy Rules page that displays all system-provided and custom sensitive data rules. You can also display custom sensitive data rules along with any custom local rules by choosing the local filtering category on the intrusion policy Rules page. Note that custom sensitive data rules are not listed on the intrusion rules editor page (Objects > Intrusion Rules).

Once you create a custom data type, you can enable it in any intrusion policy in the system or, for multidomain deployments, in the current domain. To enable a custom data type, you must enable the associated sensitive data rule in any policy that you want to use to detect that custom data type.

### Data Patterns in Custom Sensitive Data Types

You define the data pattern for a custom data type using a simple set of regular expressions comprised of the following:

- three metacharacters
- escaped characters that allow you to use the metacharacters as literal characters
- six character classes

Metacharacters are literal characters that have special meaning within regular expressions.

**Table 93: Sensitive Data Pattern Metacharacters**

<table>
<thead>
<tr>
<th>Metacharacter</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Matches zero or one occurrence of the preceding character or escape sequence; that is, the preceding character or escape sequence is optional.</td>
<td>color?r matches color or colour</td>
</tr>
<tr>
<td>{n}</td>
<td>Matches the preceding character or escape sequence n times.</td>
<td>For example, \d{2} matches 55, 12, and so on; \l{3} matches AbC, www, and so on; \w{3} matches a1B, 25C, and so on; x{5} matches xxxxx</td>
</tr>
<tr>
<td>\</td>
<td>Allows you to use metacharacters as actual characters and is also used to specify a predefined character class.</td>
<td>? matches a question mark, \ matches a backslash, \d matches numeric characters, and so on</td>
</tr>
</tbody>
</table>

You must use a backslash to escape certain characters for the sensitive data preprocessor to interpret them correctly as literal characters.

**Table 94: Escaped Sensitive Data Pattern Characters**

<table>
<thead>
<tr>
<th>Use this escaped character...</th>
<th>To represent this literal character...</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>?</td>
</tr>
<tr>
<td>{</td>
<td>{</td>
</tr>
</tbody>
</table>
When defining a custom sensitive data pattern, you can use character classes.

<table>
<thead>
<tr>
<th>Character Class</th>
<th>Description</th>
<th>Character Class Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d</td>
<td>Matches any numeric ASCII character 0-9</td>
<td>0-9</td>
</tr>
<tr>
<td>\D</td>
<td>Matches any byte that is not a numeric ASCII character</td>
<td>not 0-9</td>
</tr>
<tr>
<td>\l (lowercase “ell”)</td>
<td>Matches any ASCII letter</td>
<td>a-zA-Z</td>
</tr>
<tr>
<td>\L</td>
<td>Matches any byte that is not an ASCII letter</td>
<td>not a-zA-Z</td>
</tr>
<tr>
<td>\w</td>
<td>Matches any ASCII alphanumeric character Note that, unlike PCRE regular expressions, this does not include an underscore (_).</td>
<td>a-zA-Z0-9</td>
</tr>
<tr>
<td>\W</td>
<td>Matches any byte that is not an ASCII alphanumeric character</td>
<td>not a-zA-Z0-9</td>
</tr>
</tbody>
</table>

The preprocessor treats characters entered directly, instead of as part of a regular expression, as literal characters. For example, the data pattern 1234 matches 1234.

The following data pattern example, which is used in system-provided sensitive data rule 138:4, uses the escaped digits character class, the multiplier and option-specifier metacharacters, and the literal dash (-) and left and right parentheses () characters to detect U.S. phone numbers:

```
(\d{3}) ?\d{3}-\d{4}
```

Exercise caution when creating custom data patterns. Consider the following alternative data pattern for detecting phone numbers which, although using valid syntax, could cause many false positives:

```
(?\d{3}) ?\d{3}-?\d{4}
```

Because the second example combines optional parentheses, optional spaces, and optional dashes, it would detect, among others, phone numbers in the following desirable patterns:

* (555) 123-4567
* 555123-4567
* 5551234567

However, the second example pattern would also detect, among others, the following potentially invalid patterns, resulting in false positives:
Consider finally, for illustration purposes only, an extreme example in which you create a data pattern that detects the lowercase letter a using a low event threshold in all destination traffic on a small company network. Such a data pattern could overwhelm your system with literally millions of events in only a few minutes.

### Configuring Custom Sensitive Data Types

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays sensitive data types created in the current domain, which you can edit. It also displays data types created in ancestor domains, which you can edit in a limited way. For ancestor data types, the name and pattern fields display as read-only, but you can set the other options to policy-specific values.

You cannot delete a data type if the sensitive data rule for that data type is enabled in any intrusion policy.

**Procedure**

**Step 1** Choose **Policies > Access Control > Intrusion**

**Step 2** Click the edit icon (🖼) next to the policy you want to edit.

If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Advanced Settings** in the navigation panel.

**Step 4** If **Sensitive Data Detection** under **Specific Threat Detection** is disabled, click **Enabled**.

**Step 5** Click the edit icon (✍️) next to **Sensitive Data Detection**.

**Step 6** Click the add icon (➕) next to **Data Types**.

**Step 7** Enter a name for the data type.

**Step 8** Enter the pattern you want to detect with this data type; see [Data Patterns in Custom Sensitive Data Types](#), on page 915.

**Step 9** Click **OK**.

**Step 10** Optionally, click the data type name, and modify the options described in [Individual Sensitive Data Type Options](#), on page 909.

**Step 11** Optionally, delete a custom data type by clicking the delete icon (🗑️), then **OK** to confirm.

**Note** If the sensitive data rule for that data type is enabled in any intrusion policy, the system warns that you cannot delete the data type. You must disable the sensitive data rule in affected policies before attempting the deletion again; see [Setting Intrusion Rule States](#), on page 889.
Step 12
To save changes you made in this policy since the last policy commit, click Policy Information in the navigation panel, then click Commit Changes.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

What to do next
• Enable the associated custom sensitive data preprocessing rule in each policy where you want to use that data type; see Setting Intrusion Rule States, on page 889.
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics
Editing Custom Sensitive Data Types, on page 918

Editing Custom Sensitive Data Types

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can edit all fields in custom sensitive data types. Note, however, that when you modify the name or pattern field, these settings change in all intrusion policies on the system. You can set the other options to policy-specific values.

In a multidomain deployment, the system displays sensitive data types created in the current domain, which you can edit. It also displays data types created in ancestor domains, which you can edit in a limited way. For ancestor data types, the name and pattern fields display as read-only, but you can set the other options to policy-specific values.

Procedure

Step 1 Choose Policies > Access Control > Intrusion
Step 2 Click the edit icon (📝) next to the policy you want to edit.

If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3 Click Advanced Settings in the navigation panel.
Step 4 If Sensitive Data Detection under Specific Threat Detection is disabled, click Enabled.
Step 5 Click Edit next to Sensitive Data Detection.
Step 6 In the Targets section, click the name of the custom data type.
Step 7 Click Edit Data Type Name and Pattern.
Step 8 Modify the data type name and pattern; see Data Patterns in Custom Sensitive Data Types, on page 915.
Step 9 Click OK.
Step 10
Set the remaining options to policy-specific values; see Individual Sensitive Data Type Options, on page 909.

Step 11
To save changes you made in this policy since the last policy commit, click Policy Information in the navigation panel, then click Commit Changes.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Globally Limiting Intrusion Event Logging

The following topics describe how to globally limit intrusion event logging:

- Global Rule Thresholding Basics, on page 921
- Global Rule Thresholding Options, on page 922
- Configuring Global Thresholds, on page 924
- Disabling the Global Threshold, on page 925

Global Rule Thresholding Basics

The global rule threshold sets limits for event logging by an intrusion policy. You can set a global rule threshold across all traffic to limit how often the policy logs events from a specific source or destination and displays those events per specified time period. You can also set thresholds per shared object rule, standard text rule, or preprocessor rule in the policy. When you set a global threshold, that threshold applies for each rule in the policy that does not have an overriding specific threshold. Thresholds can prevent you from being overwhelmed with a large number of events.

Every intrusion policy contains a default global rule threshold that applies by default to all intrusion rules and preprocessor rules. This default threshold limits the number of events on traffic going to a destination to one event per 60 seconds.

You can:

- Change the global threshold.
- Disable the global threshold.
- Override the global threshold by setting individual thresholds for specific rules.

For example, you might set a global limit threshold of five events every 60 seconds, but then set a specific threshold of ten events for every 60 seconds for SID 1315. All other rules generate no more than five events in each 60-second period, but the system generates up to ten events for each 60-second period for SID 1315.

Tip

A global or individual threshold on a managed device with multiple CPUs may result in a higher number of events than expected.
The following diagram demonstrates how the global rule thresholding works. In this example, an attack is in progress for a specific rule. The global limit threshold is set to limit event generation for each rule to two events every 20 seconds. Note that the period starts at one second and ends at 21 seconds. After the period ends, the cycle starts again and the next two rule matches generate events, then the system does not generate any more events during that period.

**Global Rule Thresholding Options**

The default threshold limits event generation for each rule to one event every 60 seconds on traffic going to the same destination. The default values for the global rule thresholding options are:

- **Type** — Limit
- **Track By** — Destination
- **Count** — 1
- **Seconds** — 60

You can modify these default values as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit</td>
<td>Logs and displays events for the specified number of packets (specified by the count argument) that trigger the rule during the specified time period. For example, if you set the type to <strong>Limit</strong>, the <strong>Count</strong> to 10, and the <strong>Seconds</strong> to 60, and 14 packets trigger the rule, the system stops logging events for the rule after displaying the first 10 that occur within the same minute.</td>
</tr>
</tbody>
</table>
Threshold

Logs and displays a single event when the specified number of packets (specified by the count argument) trigger the rule during the specified time period. Note that the counter for the time restarts after you hit the threshold count of events and the system logs that event.

For example, you set the type to **Threshold, Count** to 10, and **Seconds** to 60, and the rule triggers 10 times by second 33. The system generates one event, then resets the Seconds and Count counters to 0. The rule then triggers another 10 times in the next 25 seconds. Because the counters reset to 0 at second 33, the system logs another event.

Both

Logs and displays an event once per specified time period, after the specified number (count) of packets trigger the rule.

For example, if you set the type to **Both, Count** to 2, and **Seconds** to 10, the following event counts result:

- If the rule is triggered once in 10 seconds, the system does not generate any events (the threshold is not met)
- If the rule is triggered twice in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time)
- If the rule is triggered four times in 10 seconds, the system generates one event (the threshold is met when the rule triggered the second time and following events are ignored)

The **Track By** option determines whether the event instance count is calculated per source or destination IP address.

You can also specify the number of instances and time period that define the threshold, as follows:

Table 97: Thresholding Instance/Time Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>For a <strong>Limit</strong> threshold, the number of event instances per specified time period per tracking IP address or address range required to meet the threshold. For a <strong>Threshold</strong> threshold, the number of rule matches you want to use as your threshold.</td>
</tr>
</tbody>
</table>
### Configuring Global Thresholds

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seconds</td>
<td>For a <strong>Limit</strong> threshold, the number of seconds that make up the time period when attacks are tracked. For a <strong>Threshold</strong> threshold, the number of seconds that elapse before the count resets. If you set the threshold type to <strong>Limit</strong>, the tracking to <strong>Source</strong>, <strong>Count</strong> to 10, and <strong>Seconds</strong> to 10, the system logs and displays the first 10 events that occur in 10 seconds from a given source port. If only seven events occur in the first 10 seconds, the system logs and displays those. If 40 events occur in the first 10 seconds, the system logs and displays 10, then begins counting again when the 10-second time period elapses.</td>
</tr>
</tbody>
</table>

### Related Topics
- Configuring Global Thresholds, on page 924
- Intrusion Event Thresholds, on page 890

### Procedure

1. **Step 1** Choose **Policies > Access Control > Intrusion**.
2. **Step 2** Click the edit icon (✏️) next to the policy you want to edit.
   - If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
3. **Step 3** Click **Advanced Settings** in the navigation panel.
4. **Step 4** If **Global Rule Thresholding** under **Intrusion Rule Thresholds** is disabled, click **Enabled**.
5. **Step 5** Click the edit icon (✏️) next to **Global Rule Thresholding**.
6. **Step 6** Using the **Type** radio buttons, specify the type of threshold that will apply over the time you specify in the **Seconds** field.
7. **Step 7** Using the **Track By** radio buttons, specify the tracking method.
8. **Step 8** Enter a value in the **Count** field.
9. **Step 9** Enter a value in the **Seconds** field.
To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes, on page 277**.

**Related Topics**

- **Global Rule Thresholding Options**, on page 922
- **Configuring Intrusion Rules in Layers**, on page 859
- **Conflicts and Changes: Network Analysis and Intrusion Policies**, on page 846

## Disabling the Global Threshold

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can disable global thresholding in the highest policy layer if you want to threshold events for specific rules rather than applying thresholding to every rule by default.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

**Procedure**

**Step 1** Choose **Policies > Access Control > Intrusion**

**Step 2** Click the edit icon ( chỉnh sửa ) next to the policy you want to edit.

If a view icon ( xem ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Advanced Settings** in the navigation panel.

**Step 4** Next to **Global Rule Thresholding** under **Intrusion Rule Thresholds**, click **Disabled**.

**Step 5** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.
What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846
Configuring Intrusion Rules in Layers, on page 859
The Intrusion Rules Editor

The following topics describe how to use the intrusion rules editor:

- An Introduction to Intrusion Rule Editing, on page 927
- Rule Anatomy, on page 928
- Custom Rule Creation, on page 940
- Searching for Rules, on page 945
- Rule Filtering on the Intrusion Rules Editor Page, on page 947
- Keywords and Arguments in Intrusion Rules, on page 950

An Introduction to Intrusion Rule Editing

An intrusion rule is a set of keywords and arguments that the system uses to detect attempts to exploit vulnerabilities on your network. As the system analyzes network traffic, it compares packets against the conditions specified in each rule. If the packet data matches all the conditions specified in a rule, the rule triggers. If a rule is an alert rule, it generates an intrusion event. If it is a pass rule, it ignores the traffic. For a drop rule in an inline deployment, the system drops the packet and generates an event. You can view and evaluate intrusion events from the Firepower Management Center web interface.

The Firepower System provides two types of intrusion rules: shared object rules and standard text rules. The Cisco Talos Security Intelligence and Research Group (Talos) can use shared object rules to detect attacks against vulnerabilities in ways that traditional standard text rules cannot. You cannot create shared object rules. When you write your own intrusion rule, you create a standard text rule.

You can write custom standard text rules to tune the types of events you are likely to see. Note that while this documentation sometimes discusses rules targeted to detect specific exploits, the most successful rules target traffic that may attempt to exploit known vulnerabilities rather than specific known exploits. By writing rules and specifying the rule’s event message, you can more easily identify traffic that indicates attacks and policy evasions.

When you enable a custom standard text rule in a custom intrusion policy, keep in mind that some rule keywords and arguments require that traffic first be decoded or preprocessed in a certain way. This chapter explains the options you must configure in your network analysis policy, which governs preprocessing. Note that if you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy web interface.
**Rule Anatomy**

All standard text rules contain two logical sections: the rule header and the rule options. The rule header contains:

- the rule's action or type
- the protocol
- the source and destination IP addresses and netmasks
- direction indicators showing the flow of traffic from source to destination
- the source and destination ports

The rule options section contains:

- event messages
- keywords and their parameters and arguments
- patterns that a packet’s payload must match to trigger the rule
- specifications of which parts of the packet the rules engine should inspect

The following diagram illustrates the parts of a rule:

```
alert tcp $EXTERNAL_NET any -> $HTTP_SERVERS $HTTP_PORTS
```

Note that the options section of a rule is the section enclosed in parentheses. The intrusion rules editor provides an easy-to-use interface to help you build standard text rules.
The Intrusion Rule Header

Every standard text rule and shared object rule has a rule header containing parameters and arguments. The following illustrates parts of a rule header:

![Rule Header Diagram]

The following table describes each part of the rule header shown above.

<table>
<thead>
<tr>
<th>Rule Header Component</th>
<th>Example Value</th>
<th>This Value...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>alert</td>
<td>Generates an intrusion event when triggered.</td>
</tr>
<tr>
<td>Protocol</td>
<td>tcp</td>
<td>Tests TCP traffic only.</td>
</tr>
<tr>
<td>Source IP Address</td>
<td>$EXTERNAL_NET</td>
<td>Tests traffic coming from any host that is not on your internal network.</td>
</tr>
<tr>
<td>Source Ports</td>
<td>any</td>
<td>Tests traffic coming from any port on the originating host.</td>
</tr>
<tr>
<td>Operator</td>
<td>-&gt;</td>
<td>Tests external traffic (destined for the web servers on your network).</td>
</tr>
<tr>
<td>Destination IP Address</td>
<td>$HTTP_SERVERS</td>
<td>Tests traffic to be delivered to any host specified as a web server on your internal network.</td>
</tr>
<tr>
<td>Destination Ports</td>
<td>$HTTP_PORTS</td>
<td>Tests traffic delivered to an HTTP port on your internal network.</td>
</tr>
</tbody>
</table>

The previous example uses default variables, as do most intrusion rules.

Related Topics

Variable Sets, on page 333

Intrusion Rule Header Action

Each rule header includes a parameter that specifies the action the system takes when a packet triggers a rule. Rules with the action set to alert generate an intrusion event against the packet that triggered the rule and log the details of that packet. Rules with the action set to pass do not generate an event against, or log the details of, the packet that triggered the rule.
In an inline deployment, rules with the rule state set to *Drop and Generate Events* generate an intrusion event against the packet that triggered the rule. Also, if you apply a drop rule in a passive deployment, the rule acts as an alert rule.

By default, pass rules override alert rules. You can create pass rules to prevent packets that meet criteria defined in the pass rule from triggering the alert rule in specific situations, rather than disabling the alert rule. For example, you might want a rule that looks for attempts to log into an FTP server as the user “anonymous” to remain active. However, if your network has one or more legitimate anonymous FTP servers, you could write and activate a pass rule that specifies that, for those specific servers, anonymous users do not trigger the original rule.

Within the intrusion rules editor, you select the rule type from the **Action** list.

### Intrusion Rule Header Protocol

In each rule header, you must specify the protocol of the traffic the rule inspects. You can specify the following network protocols for analysis:

- **ICMP (Internet Control Message Protocol)**
- **IP (Internet Protocol)**
- **TCP (Transmission Control Protocol)**
- **UDP (User Datagram Protocol)**

**Note**
The system ignores port definitions in an intrusion rule header when the protocol is set to **ip**.

Use **IP** as the protocol type to examine all protocols assigned by IANA, including TCP, UDP, ICMP, IGMP, and many more.

**Note**
You cannot currently write rules that match patterns in the next header (for example, the TCP header) in an IP payload. Instead, content matches begin with the last decoded protocol. As a workaround, you can match patterns in TCP headers by using rule options.

Within the Intrusion Rules editor, you select the protocol type from the **Protocol** list.

**Related Topics**

- [*Intrusion Rule Header Protocol*, on page 930](#)

### Intrusion Rule Header Direction

Within the rule header, you can specify the direction that the packet must travel for the rule to inspect it. The following table describes these options.
Intrusion Rule Header Source and Destination IP Addresses

Restricting packet inspection to the packets originating from specific IP addresses or destined to a specific IP address reduces the amount of packet inspection the system must perform. This also reduces false positives by making the rule more specific and removing the possibility of the rule triggering against packets whose source and destination IP addresses do not indicate suspicious behavior.

Tip

The system recognizes only IP addresses and does not accept host names for source or destination IP addresses.

Within the intrusion rules editor, you specify source and destination IP addresses in the **Source IPs** and **Destination IPs** fields.

When writing standard text rules, you can specify IPv4 and IPv6 addresses in a variety of ways, depending on your needs. You can specify a single IP address, *any*, IP address lists, CIDR notation, prefix lengths, or a network variable. Additionally, you can indicate that you want to exclude a specific IP address or set of IP addresses. When specifying IPv6 addresses, you can use any addressing convention defined in RFC 4291.

**IP Address Syntax in Intrusion Rules**

The following table summarizes the various ways you can specify source and destination IP addresses.

<table>
<thead>
<tr>
<th>To Specify...</th>
<th>Use...</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>any IP address</td>
<td>any</td>
<td>any</td>
</tr>
<tr>
<td>a specific IP address</td>
<td>the IP address</td>
<td>192.168.1.1</td>
</tr>
<tr>
<td></td>
<td>Note that you would not mix IPv4 and IPv6 source and destination addresses in the same rule.</td>
<td>2001:db8::abcd</td>
</tr>
<tr>
<td>a list of IP addresses</td>
<td>brackets ([]) to enclose the IP addresses and commas to separate them</td>
<td>[192.168.1.1,192.168.1.15]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[2001:db8::b3ff, 2001:db8::0202]</td>
</tr>
<tr>
<td>a block of IP addresses</td>
<td>IPv4 CIDR block or IPv6 address prefix notation</td>
<td>192.168.1.0/24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2001:db8::/32</td>
</tr>
<tr>
<td>anything except a specific IP address or set of addresses</td>
<td>the : character before the IP address or addresses you want to negate</td>
<td>!192.168.1.15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>!2001:db8::0202:b3ff:fe1e</td>
</tr>
</tbody>
</table>
### IP Address Syntax in Intrusion Rules

<table>
<thead>
<tr>
<th>To Specify...</th>
<th>Use...</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>anything in a block of IP addresses except one or more specific IP addresses</td>
<td>a block of addresses followed by a list of negated addresses or blocks</td>
<td>![10.0.0/8, !10.2.3.4, !10.1.0.0/16] ![2001:db8::/32, !2001:db8::8329, !2001:db8::0202]</td>
</tr>
<tr>
<td>IP addresses defined by a network variable</td>
<td>the variable name, in uppercase letters, preceded by $</td>
<td>$HOME_NET</td>
</tr>
<tr>
<td>all IP addresses except addresses defined by an IP address variable</td>
<td>the variable name, in uppercase letters, preceded by !$</td>
<td>!$HOME_NET</td>
</tr>
</tbody>
</table>

The following descriptions provide additional information on some of the IP address entry methods.

**Any IP Address**

You can specify the word `any` as a rule source or destination IP address to indicate any IPv4 or IPv6 address. For example, the following rule uses the argument `any` in the **Source IPs** and **Destination IPs** fields and evaluates packets with any IPv4 or IPv6 source or destination address:

```
alert tcp any any -> any any
```

You can also specify `::` to indicate any IPv6 address.

**Multiple IP Addresses**

You can list individual IP addresses by separating the IP addresses with commas and, optionally, by surrounding non-negated lists with brackets, as shown in the following example:

```
[192.168.1.100,192.168.1.103,192.168.1.105]
```

You can list IPv4 and IPv6 addresses alone or in any combination, as shown in the following example:

```
[192.168.1.100,2001:db8::1234,192.168.1.105]
```

Note that surrounding an IP address list with brackets, which was required in earlier software releases, is not required. Note also that, optionally, you can enter lists with a space before or after each comma.

---

**Note**

You must surround negated lists with brackets.

You can also use IPv4 Classless Inter-Domain Routing (CIDR) notation or IPv6 prefix lengths to specify address blocks. For example:

- 192.168.1.0/24 specifies the IPv4 addresses in the 192.168.1.0 network with a subnet mask of 255.255.255.0, that is, 192.168.1.0 through 192.168.1.255.

If you need to specify a block of IP addresses but cannot express it using CIDR or prefix length notation alone, you can use CIDR blocks and prefix lengths in an IP address list.

**IP Addresses Negation**

You can use an exclamation point (!) to negate a specified IP address. That is, you can match any IP address with the exception of the specified IP address or addresses. For example, !192.168.1.1 specifies any IP address other than 192.168.1.1, and !2001:db8:ca2e::fa4c specifies any IP address other than 2001:db8:ca2e::fa4c.

To negate a list of IP addresses, place ! before a bracketed list of IP addresses. For example, ![192.168.1.1,192.168.1.5] would define any IP address other than 192.168.1.1 or 192.168.1.5.

You must use brackets to negate a list of IP addresses.

Be careful when using the negation character with IP address lists. For example, if you use ![192.168.1.1,192.168.1.5] to match any address that is not 192.168.1.1 or 192.168.1.5, the system interprets this syntax as “anything that is not 192.168.1.1, or anything that is not 192.168.1.5.”

Because 192.168.1.5 is not 192.168.1.1, and 192.168.1.1 is not 192.168.1.5, both IP addresses match the IP address value of ![192.168.1.1,192.168.1.5], and it is essentially the same as using “any.”

Instead, use ![192.168.1.1,192.168.1.5]. The system interprets this as “not 192.168.1.1 and not 192.168.1.5,” which matches any IP address other than those listed between brackets.

Note that you cannot logically use negation with any which, if negated, would indicate no address.

**Related Topics**

Variable Sets, on page 333

**Intrusion Rule Header Source and Destination Ports**

Within the intrusion rules editor, you specify source and destination ports in the Source Port and Destination Port fields.

**Port Syntax in Intrusion Rules**

The Firepower System uses a specific type of syntax to define the port numbers used in rule headers.

You can list ports by separating the ports with commas, as shown in the following example:

80, 8080, 8138, 8600-9000, !8650-8675
Optionally, the following example shows how you can surround a port list with brackets, which was required in previous software versions but is no longer required:

```
[80, 8080, 8138, 8600-9000, !8650-8675]
```

Note that you must surround negated port lists in brackets, as shown in the following example:

```
![(20, 22, 23)
```

The following table summarizes the syntax you can use:

<table>
<thead>
<tr>
<th>To Specify...</th>
<th>Use</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>any port</td>
<td>any</td>
<td>any</td>
</tr>
<tr>
<td>a specific port</td>
<td>the port number</td>
<td>80</td>
</tr>
<tr>
<td>a range of ports</td>
<td>a dash between the first and last port number in the range</td>
<td>80-443</td>
</tr>
<tr>
<td>all ports less than or equal to a specific port</td>
<td>a dash before the port number</td>
<td>80-21</td>
</tr>
<tr>
<td>all ports greater than or equal to a specific port</td>
<td>a dash after the port number</td>
<td>80-21</td>
</tr>
<tr>
<td>all ports except a specific port or range of ports</td>
<td>the ! character before the port, port list, or range of ports you want to negate Note that you can logically use negation with all port designations except any, which if negated would indicate no port.</td>
<td>!20</td>
</tr>
<tr>
<td>all ports defined by a port variable</td>
<td>the variable name, in uppercase letter, preceded by $</td>
<td>$HTTP_PORTS</td>
</tr>
<tr>
<td>all ports except ports defined by a port variable</td>
<td>the variable name, in uppercase letter, preceded by !$</td>
<td>!$HTTP_PORTS</td>
</tr>
</tbody>
</table>

### Intrusion Event Details

As you construct a standard text rule, you can include contextual information that describes the vulnerability that the rule detects in exploit attempts. You can also include external references to vulnerability databases and define the priority that the event holds in your organization. When analysts see the event, they then have information about the priority, exploit, and known mitigation readily available.

### Message

You can specify meaningful text that appears as a message when the rule triggers. The message gives immediate insight into the nature of the vulnerability that the rule detects attempts to exploit. You can use any printable standard ASCII characters except curly braces (\{\}). The system strips quotes that completely surround the message.
You must specify a rule message. Also, the message cannot consist of white space only, one or more quotation marks only, one or more apostrophes only, or any combination of just white space, quotation marks, or apostrophes.

To define the event message in the intrusion rules editor, you enter the event message in the **Message** field.

**Classification**

For each rule, you can specify an attack classification that appears in the packet display of the event. The following table lists the name and number for each classification.

### Table 102: Rule Classifications

<table>
<thead>
<tr>
<th>Number</th>
<th>Classification Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>not-suspicious</td>
<td>Not Suspicious Traffic</td>
</tr>
<tr>
<td>2</td>
<td>unknown</td>
<td>Unknown Traffic</td>
</tr>
<tr>
<td>3</td>
<td>bad-unknown</td>
<td>Potentially Bad Traffic</td>
</tr>
<tr>
<td>4</td>
<td>attempted-recon</td>
<td>Attempted Information Leak</td>
</tr>
<tr>
<td>5</td>
<td>successful-recon-limited</td>
<td>Information Leak</td>
</tr>
<tr>
<td>6</td>
<td>successful-recon-largescale</td>
<td>Large Scale Information Leak</td>
</tr>
<tr>
<td>7</td>
<td>attempted-dos</td>
<td>Attempted Denial of Service</td>
</tr>
<tr>
<td>8</td>
<td>successful-dos</td>
<td>Denial of Service</td>
</tr>
<tr>
<td>9</td>
<td>attempted-user</td>
<td>Attempted User Privilege Gain</td>
</tr>
<tr>
<td>10</td>
<td>unsuccessful-user</td>
<td>Unsuccessful User Privilege Gain</td>
</tr>
<tr>
<td>11</td>
<td>successful-user</td>
<td>Successful User Privilege Gain</td>
</tr>
<tr>
<td>12</td>
<td>attempted-admin</td>
<td>Attempted Administrator Privilege Gain</td>
</tr>
<tr>
<td>13</td>
<td>successful-admin</td>
<td>Successful Administrator Privilege Gain</td>
</tr>
<tr>
<td>14</td>
<td>rpc-portmap-decode</td>
<td>Decode of an RPC Query</td>
</tr>
<tr>
<td>15</td>
<td>shellcode-detect</td>
<td>Executable Code was Detected</td>
</tr>
<tr>
<td>16</td>
<td>string-detect</td>
<td>A Suspicious String was Detected</td>
</tr>
<tr>
<td>17</td>
<td>suspicious-filename-detect</td>
<td>A Suspicious Filename was Detected</td>
</tr>
<tr>
<td>18</td>
<td>suspicious-login</td>
<td>An Attempted Login Using a Suspicious Username was Detected</td>
</tr>
<tr>
<td>19</td>
<td>system-call-detect</td>
<td>A System Call was Detected</td>
</tr>
<tr>
<td>Number</td>
<td>Classification Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>20</td>
<td>tcp-connection</td>
<td>A TCP Connection was Detected</td>
</tr>
<tr>
<td>21</td>
<td>trojan-activity</td>
<td>A Network Trojan was Detected</td>
</tr>
<tr>
<td>22</td>
<td>unusual-client-port-connection</td>
<td>A Client was Using an Unusual Port</td>
</tr>
<tr>
<td>23</td>
<td>network-scan</td>
<td>Detection of a Network Scan</td>
</tr>
<tr>
<td>24</td>
<td>denial-of-service</td>
<td>Detection of a Denial of Service Attack</td>
</tr>
<tr>
<td>25</td>
<td>non-standard-protocol</td>
<td>Detection of a Non-Standard Protocol or Event</td>
</tr>
<tr>
<td>26</td>
<td>protocol-command-decode</td>
<td>Generic Protocol Command Decode</td>
</tr>
<tr>
<td>27</td>
<td>web-application-activity</td>
<td>Access to a Potentially Vulnerable Web Application</td>
</tr>
<tr>
<td>28</td>
<td>web-application-attack</td>
<td>Web Application Attack</td>
</tr>
<tr>
<td>29</td>
<td>misc-activity</td>
<td>Misc Activity</td>
</tr>
<tr>
<td>30</td>
<td>misc-attack</td>
<td>Misc Attack</td>
</tr>
<tr>
<td>31</td>
<td>icmp-event</td>
<td>Generic ICMP Event</td>
</tr>
<tr>
<td>32</td>
<td>inappropriate-content</td>
<td>Inappropriate Content was Detected</td>
</tr>
<tr>
<td>33</td>
<td>policy-violation</td>
<td>Potential Corporate Privacy Violation</td>
</tr>
<tr>
<td>34</td>
<td>default-login-attempt</td>
<td>Attempt to Login By a Default Username and Password</td>
</tr>
<tr>
<td>35</td>
<td>sdf</td>
<td>Sensitive Data</td>
</tr>
<tr>
<td>36</td>
<td>malware-cnc</td>
<td>Known malware command and control traffic</td>
</tr>
<tr>
<td>37</td>
<td>client-side-exploit</td>
<td>Known client side exploit attempt</td>
</tr>
<tr>
<td>38</td>
<td>file-format</td>
<td>Known malicious file or file based exploit</td>
</tr>
</tbody>
</table>

**Custom Classification**

If you want more customized content for the packet display description of the events generated by a rule you define, you can create a custom classification.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification Name</td>
<td>The name of the classification. The page is difficult to read if you use more than 40 characters. The following characters are not supported: <code>&lt;&gt;</code> ( ) &quot; &quot; &amp; $; and the space character.</td>
</tr>
<tr>
<td>Classification Description</td>
<td>A description of the classification. You can use alphanumeric characters and spaces. The following characters are not supported: <code>&lt;&gt;</code> ( ) &quot; &quot; &amp; $;</td>
</tr>
</tbody>
</table>
**Argument** | **Description**
---|---
Priority | High, medium, or low.

**Custom Priority**

By default, the priority of a rule derives from the event classification for the rule. However, you can override the classification priority for a rule by adding the `priority` keyword to the rule and selecting a high, medium, or low priority. For example, to assign a high priority for a rule that detects web application attacks, add the `priority` keyword to the rule and select **high** as the priority.

**Custom Reference**

You can use the `reference` keyword to add references to external web sites and additional information about the event. Adding a reference provides analysts with an immediately available resource to help them identify why the packet triggered a rule. The following table lists some of the external systems that can provide data on known exploits and attacks.

**Table 103: External Attack Identification Systems**

<table>
<thead>
<tr>
<th>System ID</th>
<th>Description</th>
<th>Example ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>bugtraq</td>
<td>Bugtraq page</td>
<td>8550</td>
</tr>
<tr>
<td>cve</td>
<td>Common Vulnerabilities and Exposure page</td>
<td>CAN-2003-0702</td>
</tr>
<tr>
<td>mcafee</td>
<td>McAfee page</td>
<td>98574</td>
</tr>
<tr>
<td>url</td>
<td>Website reference</td>
<td><a href="http://www.example.com?exploit=14">www.example.com?exploit=14</a></td>
</tr>
<tr>
<td>mab</td>
<td>Microsoft security bulletin</td>
<td>MS11-082</td>
</tr>
<tr>
<td>nessus</td>
<td>Nessus page</td>
<td>10039</td>
</tr>
<tr>
<td>secure-url</td>
<td>Secure Website Reference (https://...)</td>
<td>intranet/exploits/exploit=14</td>
</tr>
</tbody>
</table>

Note that you can use `secure-url` with any secure website.

You specify a reference by entering a reference value, as follows:

```
$id_system,id$
```

where `id_system` is the system being used as a prefix, and `id` is the Bugtraq ID, CVE number, Arachnids ID, or URL (without `http://`).

For example, to specify the authentication bypass vulnerability on Microsoft Commerce Server 2002 servers documented in Bugtraq ID 17134, enter the value:

```
bugtraq,17134
```
Note the following when adding references to a rule:

- Do not use a space after the comma.
- Do not use uppercase letters in the system ID.

Related Topics
- Adding a Custom Classification, on page 938
- Defining an Event Priority, on page 939
- Defining an Event Reference, on page 939

Adding a Custom Classification

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays custom classifications created in the current domain, and you can set the priorities for these classifications. It also displays custom classifications created in ancestor domains, but you cannot set the priorities for these classifications. To view and edit custom classifications created in a lower domain, switch to that domain.

Procedure

Step 1  While creating or editing a rule, choose Edit Classifications from the Classification drop-down list.
If View Classifications displays instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 2  Enter a Classification Name and Classification Description as described in Intrusion Event Details, on page 934.

Step 3  Choose a priority for the classification from the Priority drop-down list.

Step 4  Click Add.

Step 5  Click Done.

What to do next

- Continue with creating or editing the rule. See Writing New Rules, on page 941 or Modifying Existing Rules, on page 942 for more information.

Related Topics
- Custom Rule Creation, on page 940
Defining an Event Priority

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  While creating or editing a rule, choose priority from the Detection Options drop-down list.
Step 2  Click Add Option.
Step 3  Choose a value from the priority drop-down list.
Step 4  Click Save.

What to do next

- Continue with creating or editing the rule. See Writing New Rules, on page 941 or Modifying Existing Rules, on page 942 for more information.

Related Topics

Custom Rule Creation, on page 940

Defining an Event Reference

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  While creating or editing a rule, choose reference from the Detection Options drop-down list.
Step 2  Click Add Option.
Step 3  Enter a value in the reference field as described in Intrusion Event Details, on page 934.
Step 4  Click Save.

What to do next

- Continue with creating or editing the rule. See Writing New Rules, on page 941 or Modifying Existing Rules, on page 942 for more information.

Related Topics

Custom Rule Creation, on page 940
Custom Rule Creation

You can create a custom intrusion rule by:

- creating your own standard text rules
- saving existing standard text rules as new
- saving system-provided shared object rules as new
- in a multidomain deployment, saving ancestor rules as new in a descendant domain
- importing a local rule file

The system saves the custom rule in the local rule category, regardless of the method you used to create it. When you create a custom intrusion rule, the system assigns it a unique rule number, which has the format \text{GID:SID:Rev}. The elements of this number are:

\textbf{GID}

Generator ID. For all standard text rules, this value is 1. For all shared object rules you save as new, this value is 3.

\textbf{SID}

Snort ID. Indicates whether the rule is a local rule of a system rule. When you create a new rule, the system assigns the next available SID for a local rule.

SID numbers for local rules start at 1000000, and the SID for each new local rule is incremented by one. In a multidomain deployment, the system prepends a domain number to the SID of any custom rule created in or imported into a descendant domain. For example, a rule added in the Global domain would have a SID of 1000000 or greater, and rules added in descendant domains would have SIDs of [domain number]000000 or greater.

\textbf{Rev}

The revision number. For a new rule, the revision number is one. Each time you modify a custom rule the revision number increments by one.

In a custom standard text rule, you set the rule header settings and the rule keywords and arguments. You can use the rule header settings to focus the rule to only match traffic using a specific protocol and traveling to or from specific IP addresses or ports.

In a custom system-provided standard text rule or shared object rule, you are limited to modifying rule header information such as the source and destination ports and IP addresses. You cannot modify the rule keywords or arguments.

Modifying header information for a shared object rule and saving your changes creates a new instance of the rule with a generator ID (GID) of 3 and the next available SID for a custom rule. The system links the new instance of the shared object rule to the reserved \texttt{soid} keyword, which maps the rule you create to the rule created by the Cisco Talos Security Intelligence and Research Group (Talos). You can delete instances of a shared object rule that you create, but you cannot delete shared object rules created by Talos.
Writing New Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  
Access the intrusion rules using either of the following methods:
- Choose **Policies > Access Control > Intrusion**, and click **Intrusion Rules**.
- Choose **Objects > Intrusion Rules**.

**Step 2**  
Click **Create Rule**.

**Step 3**  
Enter a value in the **Message** field.

**Step 4**  
Choose a value from each of the following drop-down lists:
- **Classification**
- **Action**
- **Protocol**
- **Direction**

**Step 5**  
Enter values in the following fields:
- **Source IPs**
- **Destination IPs**
- **Source Port**
- **Destination Port**

The system uses the value **any** if you do not specify a value for these fields.

**Note**  
The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.

**Step 6**  
Choose a value from the **Detection Options** drop-down list.

**Step 7**  
Click **Add Option**.

**Step 8**  
Enter any arguments for the keyword you added.

**Step 9**  
Optionally, repeat steps 6 to 8.

**Step 10**  
If you added multiple keywords, you can:
- Reorder keywords — Click the up or down arrow next to the keyword you want to move.
- Delete a keyword — Click the **X** next to that keyword.

**Step 11**  
Click **Save As New**.
What to do next

- Enable your new or changed rules within the appropriate intrusion policy; see Viewing Intrusion Rules in an Intrusion Policy, on page 874.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Modifying Existing Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can modify custom intrusion rules. In a multidomain deployment, you can modify custom intrusion rules that belong to the current domain only.

You can save system-provided rules and rules belonging to ancestor domains as new custom rules in the local rule category, which you can then modify.

Procedure

**Step 1** Access the intrusion rules using either of the following methods:
- Choose Policies > Access Control > Intrusion, and click Intrusion Rules.
- Choose Objects > Intrusion Rules.

**Step 2** Locate the rule you want to modify. You have the following choices:
- Navigate through the folders to the rule.
- Search for the rule; see Searching for Rules, on page 945.
- Filter for the group to which the rule belongs; see Filtering Rules, on page 949.

**Step 3** Click the edit icon (📝) next to the rule or, in the case of search results, click the rule message.

If a view icon (👁️) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4** Modify the rule as appropriate for the rule type.

**Note** Do not modify the protocol for a shared object rule; doing so would render the rule ineffective.

**Step 5** You have the following choices:
- Click Save if you are editing a custom rule and want to overwrite the current version of that rule.
- Click Save As New if you are editing a system-provided rule or any rule belonging to an ancestor domain, or if you are editing a custom rule and want to save the changes as a new rule.
### What to do next

- If you want to use the local modification of the rule instead of the system-provided rule, deactivate the system-provided rule by using the procedures at [Intrusion Rule States](#), and activate the local rule.

- Deploy configuration changes; see [Deploy Configuration Changes](#).

### Related Topics
- [Searching for Rules](#)
- [Rule Filtering on the Intrusion Rules Editor Page](#)

### Viewing Rule Documentation

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

From the Rule Edit page, you can view rule documentation supplied by the Cisco Talos Security Intelligence and Research Group (Talos). While viewing, you can click external references to view additional information provided by Talos. You can also click Context Explorer to view contextual information for events generated by the rule.

**Procedure**

#### Step 1
Access an intrusion rule using either of the following methods:

- Choose Policies > Access Control > Intrusion, and click Intrusion Rules.
- Choose Objects > Intrusion Rules.

#### Step 2
Locate the rule you want to view. You have the following choices:

- Navigate through the folders to the rule.
- Search for the rule; see [Searching for Rules](#).
- Filter for the group to which the rule belongs; see [Filtering Rules](#).

#### Step 3
Click the edit icon (للصورة) next to the rule or, in the case of search results, click the rule message.

If a view icon (للصورة) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

#### Step 4
Click View Documentation.

#### Step 5
Optionally, click either of the following links:

- References—see [Keyword Filtering](#) and Custom Reference in [Intrusion Event Details](#) for information on available external references.
- Context Explorer—see for information on viewing event data for the rule in the context explorer.
Adding Comments to Intrusion Rules

You can add comments to any intrusion rule. Such comments can be helpful to provide context and additional information about the rule and the exploit or policy violation it identifies.

In a multidomain deployment, the system displays comments created in the current domain, which you can delete. It also displays comments created in ancestor domains, which you cannot delete. To view comments created in a lower domain, switch to that domain.

Procedure

Step 1  Access the intrusion rules using either of the following methods:
• Choose Policies > Access Control > Intrusion, and click Intrusion Rules.
• Choose Objects > Intrusion Rules.

Step 2  Locate the rule you want to annotate. You have the following choices:
• Navigate through the folders to the rule.
• Search for the rule; see Searching for Rules, on page 945.
• Filter for the group where the rule belongs; see Filtering Rules, on page 949.

Step 3  Click the edit icon ( ) next to the rule or, in the case of search results, click the rule message.

If a view icon ( ) appears next to a rule instead, the rule belongs to an ancestor policy, or you do not have permission to modify the rule.

Step 4  Click Rule Comment.

Step 5  Enter your comment in the text box.

Step 6  Click Add Comment.

Tip  You can also add and view rule comments in an intrusion event’s packet view.

What to do next

• Continue with creating or editing the rule. See Writing New Rules, on page 941 or Modifying Existing Rules, on page 942 for more information.
Deleting Custom Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can delete custom rules if the rules are not currently enabled in an intrusion policy. You cannot delete either standard text rules or shared object rules provided by the system. In a multidomain deployment, you can delete local rules created in the current domain only.

The system stores deleted rules in the deleted category, and you can use a deleted rule as the basis for a new rule. The Rules page in an intrusion policy does not display the deleted category, so you cannot enable deleted custom rules.

Tip
Custom rules include shared object rules that you save with modified header information. The system also saves these in the local rule category and lists them with a GID of 3. You can delete your modified version of a shared object rule, but you cannot delete the original shared object rule.

Procedure

Step 1
Access the intrusion rules using either of the following methods:

- Choose Policies > Access Control > Intrusion, and click Intrusion Rules.
- Choose Objects > Intrusion Rules.

Step 2
You have two choices:

- Delete all local rules — Click Delete Local Rules, then click OK.
- Delete a single rule — Choose Local Rules from the Group Rules By drop-down, click the delete icon ( ) next to a rule you want to delete, and click OK to confirm the deletion.

Related Topics
Intrusion Rule States, on page 888

Searching for Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>
The Firepower System provides thousands of standard text rules, and the Cisco Talos Security Intelligence and Research Group (Talos) continues to add rules as new vulnerabilities and exploits are discovered. You can easily search for specific rules so that you can activate, deactivate, or edit them.

**Procedure**

**Step 1**  
Access the intrusion rules using either of the following methods:
- Choose **Policies > Access Control > Intrusion**, and click **Intrusion Rules**.
- Choose **Objects > Intrusion Rules**.

**Step 2**  
Click **Search** on the toolbar.

**Step 3**  
Add search criteria.

**Step 4**  
Click **Search**.

**What to do next**
- If you want to view or edit a located rule (or a copy of the rule, if it is a system rule), click the hyperlinked rule message. See **Writing New Rules, on page 941** or **Modifying Existing Rules, on page 942** for more information.

### Search Criteria for Intrusion Rules

The following table describes the available search options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signature ID</td>
<td>To search for a single rule based on Snort ID (SID), enter an SID number. To search for multiple rules, enter a comma-separated list of SID numbers. This field has an 80-character limit.</td>
</tr>
<tr>
<td>Generator ID</td>
<td>To search for standard text rules, select 1. To search for shared object rules, select 3.</td>
</tr>
<tr>
<td>Message</td>
<td>To search for a rule with a specific message, enter a single word from the rule message in the <strong>Message</strong> field. For example, to search for DNS exploits, you would enter <strong>DNS</strong>, or to search for buffer overflow exploits, enter <strong>overflow</strong>.</td>
</tr>
<tr>
<td>Protocol</td>
<td>To search rules that evaluate traffic of a specific protocol, select the protocol. If you do not select a protocol, search results contain rules for all protocols.</td>
</tr>
<tr>
<td>Source Port</td>
<td>To search for rules that inspect packets originating from a specified port, enter a source port number or a port-related variable.</td>
</tr>
<tr>
<td>Destination Port</td>
<td>To search for rules that inspect packets destined for a specific port, enter a destination port number or a port-related variable.</td>
</tr>
<tr>
<td>Source IP</td>
<td>To search for rules that inspect packets originating from a specified IP address, enter a source IP address or an IP address-related variable.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Destination IP</td>
<td>To search for rules that inspect packets destined for a specified IP address, enter a destination IP address or an IP address-related variable.</td>
</tr>
<tr>
<td>Keyword</td>
<td>To search for specific keywords, you can use the keyword search options. You select a keyword and enter a keyword value for which to search. You can also precede the keyword value with an exclamation point (!) to match any value other than the specified value.</td>
</tr>
<tr>
<td>Category</td>
<td>To search for rules in a specific category, select the category from the Category list.</td>
</tr>
<tr>
<td>Classification</td>
<td>To search for rules that have a specific classification, select the classification name from the Classification list.</td>
</tr>
<tr>
<td>Rule State</td>
<td>To search for rules within a specific policy and a specific rule state, select the policy from the first Rule State list, and choose a state from the second list to search for rules set to Generate Events, Drop and Generate Events, or Disabled.</td>
</tr>
</tbody>
</table>

### Rule Filtering on the Intrusion Rules Editor Page

You can filter the rules on the intrusion rules editor page to display a subset of rules. This can be useful, for example, when you want to modify a rule or change its state but have difficulty finding it among the thousands of rules available.

When you enter a filter, the page displays any folder that includes at least one matching rule, or a message when no rule matches.

### Filtering Guidelines

Your filter can include special keywords and their arguments, character strings, and literal character strings in quotes, with spaces separating multiple filter conditions. A filter cannot include regular expressions, wildcard characters, or any special operator such as a negation character (!), a greater than symbol (>), less than symbol (<), and so on.

All keywords, keyword arguments, and character strings are case-insensitive. Except for the `gid` and `sid` keywords, all arguments and strings are treated as partial strings. Arguments for `gid` and `sid` return only exact matches.

You can expand a folder on the original, unfiltered page and the folder remains expanded when the subsequent filter returns matches in that folder. This can be useful when the rule you want to find is in a folder that contains a large number of rules.

You cannot constrain a filter with a subsequent filter. Any filter you enter searches the entire rules database and returns all matching rules. When you enter a filter while the page still displays the result of a previous filter, the page clears and returns the result of the new filter instead.

You can use the same features with rules in a filtered or unfiltered list. For example, you can edit rules in a filtered or unfiltered list on the intrusion rules editor page. You can also use any of the options in the context menu for the page.
Keyword Filtering

Filtering may take significantly longer when the combined total of rules in all sub-groups is large because rules appear in multiple categories, even when the total number of unique rules is much smaller.

Keyword Filtering

Each rule filter can include one or more keywords in the format:

`keyword:argument`

where keyword is one of the keywords in the following table and argument is a single, case-insensitive, alphanumeric string to search for in the specific field or fields relevant to the keyword.

Arguments for all keywords except `gid` and `sid` are treated as partial strings. For example, the argument `123` returns "12345", "41235", "45123", and so on. The arguments for `gid` and `sid` return only exact matches; for example, `sid:3080` returns only SID 3080.

You can search for a partial SID by filtering with one or more character strings.

The following table describes the specific filtering keywords and arguments you can use to filter rules.

### Table 105: Rule Filter Keywords

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>arachnids</td>
<td>Returns one or more rules based on all or part of the Arachnids ID in a rule reference.</td>
<td>arachnids:181</td>
</tr>
<tr>
<td>bugtraq</td>
<td>Returns one or more rules based on all or part of the Bugtraq ID in a rule reference.</td>
<td>bugtraq:2120</td>
</tr>
<tr>
<td>cve</td>
<td>Returns one or more rules based on all or part of the CVE number in a rule reference.</td>
<td>cve:2003-0109</td>
</tr>
<tr>
<td>gid</td>
<td>The argument 1 returns standard text rules. The argument 3 returns shared object rules.</td>
<td>gid:3</td>
</tr>
<tr>
<td>mcafee</td>
<td>Returns one or more rules based on all or part of the McAfee ID in a rule reference.</td>
<td>mcafee:10566</td>
</tr>
<tr>
<td>msg</td>
<td>Returns one or more rules based on all or part of the rule Message field, also known as the event message.</td>
<td>msg:chat</td>
</tr>
<tr>
<td>nessus</td>
<td>Returns one or more rules based on all or part of the Nessus ID in a rule reference.</td>
<td>nessus:10737</td>
</tr>
<tr>
<td>ref</td>
<td>Returns one or more rules based on all or part of a single alphanumeric string in a rule reference or in the rule Message field.</td>
<td>ref:MS03-039</td>
</tr>
</tbody>
</table>
Character String Filtering

Each rule filter can include one or more alphanumeric character strings. Character strings search the rule Message field, Snort ID (SID), and Generator ID (GID). For example, the string 123 returns the strings "Lotus123", "123mania", and so on in the rule message, and also returns SID 6123, SID 12375, and so on.

All character strings are case-insensitive and are treated as partial strings. For example, any of the strings ADMIN, admin, or Admin return "admin", "CFADMIN", "Administrator" and so on.

You can enclose character strings in quotes to return exact matches. For example, the literal string "overflow attempt" in quotes returns only that exact string, whereas a filter comprised of the two strings overflow and attempt without quotes returns "overflow attempt", "overflow multipacket attempt", "overflow with evasion attempt", and so on.

Filtering Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

Related Topics
- Defining an Event Reference, on page 939
- Intrusion Event Details, on page 934
- Preprocessor Generator IDs, on page 1637
On the Intrusion Rules page, you can filter rules into subsets so you can more easily find specific rules. You can then use any of the page features, including choosing any of the features available in the context menu. Rule filtering can be particularly useful to locate a specific rule to edit.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Access the intrusion rules using either of the following methods:  
- Choose **Policies > Access Control > Intrusion**, and click **Intrusion Rules**.  
- Choose **Objects > Intrusion Rules**. |
| Step 2 | Prior to filtering, you have the following choices:  
- Expand any rule group you want to expand. Some rule groups also have sub-groups that you can expand. Expanding a group on the original, unfiltered page can be useful when you expect that a rule might be in that group. The group remains expanded when the subsequent filter results in a match in that folder, and when you return to the original, unfiltered page by clicking on the filter clearing icon (🗑️).  
- Choose a different grouping method from the **Group Rules By** drop-down list. |
| Step 3 | Enter filter constraints in the text box next to the filter icon (🔍) under the **Group Rules By** list. |
| Step 4 | Press Enter. |

**Note**  
Clear the current filtered list by clicking the filter clearing icon (🗑️).  

**Keywords and Arguments in Intrusion Rules**

Using the rules language, you can specify the behavior of a rule by combining keywords. Keywords and their associated values (called *arguments*) dictate how the system evaluates packets and packet-related values that the rules engine tests. The Firepower System currently supports keywords that allow you to perform inspection functions, such as content matching, protocol-specific pattern matching, and state-specific matching. You can define up to 100 arguments per keyword, and combine any number of compatible keywords to create highly specific rules. This helps decrease the chance of false positives and false negatives and focus the intrusion information you receive.

Note that you can also use adaptive profiles in passive deployments to dynamically adapt active rule processing for specific packets based on rule metadata and host information.

Keywords described in this section are listed under Detection Options in the rules editor.

**Related Topics**

- About Adaptive Profiles, on page 1193

**The content and protected_content Keywords**

Use the *content* keyword or the *protected_content* keyword to specify content that you want to detect in a packet.
You should almost always follow a content or protected_content keyword by modifiers that indicate where the content should be searched for, whether the search is case sensitive, and other options.

Note that all content matches must be true for the rule to trigger an event, that is, each content match has an AND relationship with the others.

Note also that, in an inline deployment, you can set up rules that match malicious content and then replace it with your own text string of equal length.

**content**

When you use the content keyword, the rules engine searches the packet payload or stream for that string. For example, if you enter /bin/sh as the value for one of the content keywords, the rules engine searches the packet payload for the string /bin/sh.

Match content using either an ASCII string, hexadecimal content (binary byte code), or a combination of both. Surround hexadecimal content with pipe characters () in the keyword value. For example, you can mix hexadecimal content and ASCII content using something that looks like |90C8 COFF FFFF|/bin/sh.

You can specify multiple content matches in a single rule. To do this, use additional instances of the content keyword. For each content match, you can indicate that content matches must be found in the packet payload or stream for the rule to trigger.

⚠️ **Caution**

You may invalidate your intrusion policy if you create a rule that includes only one content keyword and that keyword has the Not option selected.

**protected_content**

The protected_content keyword allows you to encode your search content string before configuring the rule argument. The original rule author uses a hash function (SHA-512, SHA-256, or MD5) to encode the string before configuring the keyword.

When you use the protected_content keyword instead of the content keyword, there is no change to how the rules engine searches the packet payload or stream for that string and most of the keyword options function as expected. The following table summarizes the exceptions, where the protected_content keyword options differ from the content keyword options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hash Type</td>
<td>New option for the protected_content rule keyword.</td>
</tr>
<tr>
<td>Case Insensitive</td>
<td>Not supported</td>
</tr>
<tr>
<td>Within</td>
<td>Not supported</td>
</tr>
<tr>
<td>Depth</td>
<td>Not supported</td>
</tr>
<tr>
<td>Length</td>
<td>New option for the protected_content rule keyword.</td>
</tr>
<tr>
<td>Use Fast Pattern Matcher</td>
<td>Not supported</td>
</tr>
<tr>
<td>Fast Pattern Matcher Only</td>
<td>Not supported</td>
</tr>
</tbody>
</table>
Cisco recommends that you include at least one `content` keyword in rules that include a `protected_content` keyword to ensure that the rules engine uses the fast pattern matcher, which increases processing speed and improves performance. Position the `content` keyword before the `protected_content` keyword in the rule.

Note that the rules engine uses the fast pattern matcher when a rule includes at least one `content` keyword, regardless of whether you enable the `content` keyword Use Fast Pattern Matcher argument.

---

**Caution**

You may invalidate your intrusion policy if you create a rule that includes only one `protected_content` keyword and that keyword has the **Not** option selected.

---

**Related Topics**

- Custom Rule Creation, on page 940
- Basic content and protected_content Keyword Arguments, on page 952
- The replace Keyword, on page 961

---

### Basic content and protected_content Keyword Arguments

You can constrain the location and case-sensitivity of content searches with parameters that modify the `content` or `protected_content` keyword. Configure options that modify the `content` or `protected_content` keyword to specify the content for which you want to search.

---

#### Case Insensitive

This option is **not** supported when configuring the `protected_content` keyword.

---

You can instruct the rules engine to ignore case when searching for content matches in ASCII strings. To make your search case-insensitive, check **Case Insensitive** when specifying a content search.

---

#### Hash Type

This option is **only** configurable with the `protected_content` keyword.

---

Use the **Hash Type** drop-down to identify the hash function you used to encode your search string. The system supports SHA-512, SHA-256, and MD5 hashing for `protected_content` search strings. If the length of your hashed content does not match the selected hash type, the system does **not** save the rule.

The system automatically selects the Cisco-set default value. When **Default** is selected, no specific hash function is written into the rule and the system assumes SHA-512 for the hash function.

---

#### Raw Data

The **Raw Data** option instructs the rules engine to analyze the original packet payload before analyzing the normalized payload data (decoded by a network analysis policy) and does not use an argument value. You
can use this keyword when analyzing telnet traffic to check the telnet negotiation options in the payload before normalization.

You cannot use the Raw Data option together in the same content or protected_content keyword with any HTTP content option.

Tip
You can configure the HTTP Inspect preprocessor Client Flow Depth and Server Flow Depth options to determine whether raw data is inspected in HTTP traffic, and how much raw data is inspected.

Not
Select the Not option to search for content that does not match the specified content. If you create a rule that includes a content or protected_content keyword with the Not option selected, you must also include in the rule at least one other content or protected_content keyword without the Not option selected.

Caution
Do not create a rule that includes only one content or protected_content keyword if that keyword has the Not option selected. You may invalidate your intrusion policy.

For example, SMTP rule 1:2541:9 includes three content keywords, one of which has the Not option selected. A custom rule based on this rule would be invalid if you removed all of the content keywords except the one with the Not option selected. Adding such a rule to your intrusion policy could invalidate the policy.

Tip
You cannot select the Not check box and the Use Fast Pattern Matcher check box with the same content keyword.

content and protected_content Keyword Search Locations

You can use search location options to specify where to begin searching for the specified content and how far to continue searching.

Permitted Combinations: content Search Location Arguments

You can use either of two content location pairs to specify where to begin searching for the specified content and how far to continue searching, as follows:

- Use Offset and Depth together to search relative to the beginning of the packet payload.
- Use Distance and Within together to search relative to the current search location.

When you specify only one of a pair, the default for the other option in the pair is assumed.

You cannot mix the Offset and Depth options with the Distance and Within options. For example, you cannot pair Offset and Within. You can use any number of location options in a rule.

When no location is specified, the defaults for Offset and Depth are assumed; that is, the content search starts at the beginning of the packet payload and continues to the end of the packet.

You can also use an existing byte_extract variable to specify the value for a location option.
Permitted Combinations: protected_content Search Location Arguments

You can use any number of location options in a rule.

Tip

You cannot mix the Offset and Distance options within a single keyword configuration, but you can use any number of location options in a rule.

Related Topics

The byte_extract Keyword, on page 967

Permitted Combinations: protected_content Search Location Arguments

Use the required Length protected_content location option in combination with either the Offset or Distance location option to specify where to begin searching for the specified content and how far to continue searching, as follows:

• Use Length and Offset together to search for the protected string relative to the beginning of the packet payload.

• Use Length and Distance together to search for the protected string relative to the current search location.

Tip

When no location is specified, the defaults are assumed; that is, the content search starts at the beginning of the packet payload and continues to the end of the packet.

You can also use an existing byte_extract variable to specify the value for a location option.

Related Topics

The byte_extract Keyword, on page 967

content and protected_content Search Location Arguments

Depth

Note

This option is only supported when configuring the content keyword.

Specifies the maximum content search depth, in bytes, from the beginning of the offset value, or if no offset is configured, from the beginning of the packet payload.

For example, in a rule with a content value of cgi-bin/phf, and offset value of 3, and a depth value of 22, the rule starts searching for a match to the cgi-bin/phf string at byte 3, and stops after processing 22 bytes (byte 25) in packets that meet the parameters specified by the rule header.

You must specify a value that is greater than or equal to the length of the specified content, up to a maximum of 65535 bytes. You cannot specify a value of 0.

The default depth is to search to the end of the packet.

Distance

Instructs the rules engine to identify subsequent content matches that occur a specified number of bytes after the previous successful content match.
Because the distance counter starts at byte 0, specify one less than the number of bytes you want to move forward from the last successful content match. For example, if you specify 4, the search begins at the fifth byte.

You can specify a value of -65535 to 65535 bytes. If you specify a negative Distance value, the byte you start searching on may fall outside the beginning of a packet. Any calculations will take into account the bytes outside the packet, even though the search actually starts on the first byte in the packet. For example, if the current location in the packet is the fifth byte, and the next content rule option specifies a Distance value of -10 and a Within value of 20, the search starts at the beginning of the payload and the Within option is adjusted to 15.

The default distance is 0, meaning the current location in the packet subsequent to the last content match.

**Length**

This option is only supported when configuring the protected_content keyword.

The Length protected_content keyword option indicates the length, in bytes, of the unhashed search string. For example, if you used the content Sample1 to generate a secure hash, use 7 for the Length value. You must enter a value in this field.

**Offset**

Specifies in bytes where in the packet payload to start searching for content relative to the beginning of the packet payload. You can specify a value of 65535 to 65535 bytes.

Because the offset counter starts at byte 0, specify one less than the number of bytes you want to move forward from the beginning of the packet payload. For example, if you specify 7, the search begins at the eighth byte.

The default offset is 0, meaning the beginning of the packet.

**Within**

This option is only supported when configuring the content keyword.

The Within option indicates that, to trigger the rule, the next content match must occur within the specified number of bytes after the end of the last successful content match. For example, if you specify a Within value of 8, the next content match must occur within the next eight bytes of the packet payload or it does not meet the criteria that triggers the rule.

You can specify a value that is greater than or equal to the length of the specified content, up to a maximum of 65535 bytes.

The default for Within is to search to the end of the packet.

**Overview: HTTP content and protected_content Keyword Arguments**

HTTP content or protected_content keyword options let you specify where to search for content matches within an HTTP message decoded by the HTTP Inspect preprocessor.
Two options search status fields in HTTP responses:

• **HTTP Status Code**
• **HTTP Status Message**

Note that although the rules engine searches the raw, unnormalized status fields, these options are listed here separately to simplify explanation below of the restrictions to consider when combining other raw HTTP fields and normalized HTTP fields.

Five options search normalized fields in HTTP requests, responses, or both, as appropriate:

• **HTTP URI**
• **HTTP Method**
• **HTTP Header**
• **HTTP Cookie**
• **HTTP Client Body**

Three options search raw (unnormalized) non-status fields in HTTP requests, responses, or both, as appropriate:

• **HTTP Raw URI**
• **HTTP Raw Header**
• **HTTP Raw Cookie**

Use the following guidelines when selecting HTTP `content` options:

• **HTTP content** options apply only to TCP traffic.

• To avoid a negative impact on performance, select only those parts of the message where the specified content might appear.

  For example, when traffic is likely to include large cookies such as those in shopping cart messages, you might search for the specified content in the HTTP header but not in HTTP cookies.

• To take advantage of HTTP Inspect preprocessor normalization, and to improve performance, any HTTP-related rule you create should at a minimum include at least one `content` or `protected_content` keyword with an **HTTP URI**, **HTTP Method**, **HTTP Header**, or **HTTP Client Body** option selected.

• You cannot use the `replace` keyword in conjunction with `content` or `protected_content` keyword options.

You can specify a single normalized HTTP option or status field, or use normalized HTTP options and status fields in any combination to target a content area to match. However, note the following restrictions when using HTTP field options:

• You cannot use the **Raw Data** option together in the same `content` or `protected_content` keyword with any HTTP option.

• You cannot use a raw HTTP field option (**HTTP Raw URI**, **HTTP Raw Header**, or **HTTP Raw Cookie**) together in the same `content` or `protected_content` keyword with its normalized counterpart (**HTTP URI**, **HTTP Header**, or **HTTP Cookie**, respectively).
• You cannot select **Use Fast Pattern Matcher** in combination with one or more of the following HTTP field options:

**HTTP Raw URI, HTTP Raw Header, HTTP Raw Cookie, HTTP Cookie, HTTP Method, HTTP Status Message, or HTTP Status Code**

However, you can include the options above in a `content` or `protected_content` keyword that also uses the fast pattern matcher to search one of the following normalized fields:

**HTTP URI, HTTP Header, or HTTP Client Body**

For example, if you select **HTTP Cookie, HTTP Header, and Use Fast Pattern Matcher**, the rules engine searches for content in both the HTTP cookie and the HTTP header, but the fast pattern matcher is applied only to the HTTP header, not to the HTTP cookie.

• When you combine restricted and unrestricted options, the fast pattern matcher searches only the unrestricted fields you specify to test whether to pass the rule to the intrusion rules editor for complete evaluation, including evaluation of the restricted fields.

**Related Topics**

[content Keyword Fast Pattern Matcher Arguments](#), on page 959

**HTTP content and protected_content Keyword Arguments**

**HTTP URI**

Select this option to search for content matches in the normalized request URI field.

Note that you cannot use this option in combination with the `pcre` keyword **HTTP URI (U)** option to search the same content.

---

**HTTP Raw URI**

Select this option to search for content matches in the normalized request URI field.

Note that you cannot use this option in combination with the `pcre` keyword **HTTP URI (U)** option to search the same content.

---

**HTTP Method**

Select this option to search for content matches in the request method field, which identifies the action such as GET and POST to take on the resource identified in the URI.

---

A pipelined HTTP request packet contains multiple URIs. When **HTTP URI** is selected and the rules engine detects a pipelined HTTP request packet, the rules engine searches all URIs in the packet for a content match.
HTTP Header
Select this option to search for content matches in the normalized header field, except for cookies, in HTTP requests; also in responses when the HTTP Inspect preprocessor **Inspect HTTP Responses** option is enabled. Note that you cannot use this option in combination with the `pcre` keyword HTTP header (H) option to search the same content.

HTTP Raw Header
Select this option to search for content matches in the raw header field, except for cookies, in HTTP requests; also in responses when the HTTP Inspect preprocessor **Inspect HTTP Responses** option is enabled. Note that you cannot use this option in combination with the `pcre` keyword HTTP raw header (D) option to search the same content.

HTTP Cookie
Select this option to search for content matches in any cookie identified in a normalized HTTP client request header; also in response set-cookie data when the HTTP Inspect preprocessor **Inspect HTTP Responses** option is enabled. Note that the system treats cookies included in the message body as body content.

You must enable the HTTP Inspect preprocessor **Inspect HTTP Cookies** option to search only the cookie for a match; otherwise, the rules engine searches the entire header, including the cookie.

Note the following:

- You cannot use this option in combination with the `pcre` keyword HTTP cookie (C) option to search the same content.
- The `Cookie:` and `Set-Cookie:` header names, leading spaces on the header line, and the CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.

HTTP Raw Cookie
Select this option to search for content matches in any cookie identified in a raw HTTP client request header; also in response set-cookie data when the HTTP Inspect preprocessor **Inspect HTTP Responses** option is enabled; note that the system treats cookies included in the message body as body content.

You must enable the HTTP Inspect preprocessor **Inspect HTTP Cookies** option to search only the cookie for a match; otherwise, the rules engine searches the entire header, including the cookie.

Note the following:

- You cannot use this option in combination with the `pcre` keyword HTTP raw cookie (K) option to search the same content.
- The `Cookie:` and `Set-Cookie:` header names, leading spaces on the header line, and the CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.

HTTP Client Body
Select this option to search for content matches in the message body in an HTTP client request.

Note that for this option to function, you must specify a value of 0 to 65535 for the HTTP Inspect preprocessor **HTTP Client Body Extraction Depth** option.
HTTP Status Code
Select this option to search for content matches in the 3-digit status code in an HTTP response.
You must enable the HTTP Inspect preprocessor Inspect HTTP Responses option for this option to return a match.

HTTP Status Message
Select this option to search for content matches in the textual description that accompanies the status code in an HTTP response.
You must enable the HTTP Inspect preprocessor Inspect HTTP Responses option for this option to return a match.

Related Topics
pcre Modifier Options, on page 972
Server-Level HTTP Normalization Options, on page 1091

Overview: content Keyword Fast Pattern Matcher

Note
These options are not supported when configuring the protected_content keyword.

The fast pattern matcher quickly determines which rules to evaluate before passing a packet to the rules engine. This initial determination improves performance by significantly reducing the number of rules used in packet evaluation.

By default, the fast pattern matcher searches packets for the longest content specified in a rule; this is to eliminate as much as possible needless evaluation of a rule. Consider the following example rule fragment:

```
alert tcp any any -> any 80 (msg:"Exploit"; content:"GET"; http_method; nocase; content:"/exploit.cgi"; http_uri; nocase;)
```

Almost all HTTP client requests contain the content GET, but few will contain the content /exploit.cgi. Using GET as the fast pattern content would cause the rules engine to evaluate this rule in most cases and would rarely result in a match. However, most client GET requests would not be evaluated using /exploit.cgi, thus increasing performance.

The rules engine evaluates the packet against the rule only when the fast pattern matcher detects the specified content. For example, if one content keyword in a rule specifies the content short, another specifies longer, and a third specifies longest, the fast pattern matcher will use the content longest and the rule will be evaluated only if the rules engine finds longest in the payload.

content Keyword Fast Pattern Matcher Arguments

Use Fast Pattern Matcher
Use this option to specify a shorter search pattern for the fast pattern matcher to use. Ideally, the pattern you specify is less likely to be found in the packet than the longest pattern and, therefore, more specifically identifies the targeted exploit.

Note the following restrictions when selecting Use Fast Pattern Matcher and other options in the same content keyword:
• You can specify **Use Fast Pattern Matcher** only one time per rule.

• You cannot use **Distance**, **Within**, **Offset**, or **Depth** when you select **Use Fast Pattern Matcher** in combination with **Not**.

• You cannot select Use Fast Pattern Matcher in combination with any of the following HTTP field options:
  
  **HTTP Raw URI**, **HTTP Raw Header**, **HTTP Raw Cookie**, **HTTP Cookie**, **HTTP Method**, **HTTP Status Message**, or **HTTP Status Code**

  However, you can include the options above in a **content** keyword that also uses the fast pattern matcher to search one of the following normalized fields:

  **HTTP URI**, **HTTPHeader**, or **HTTP Client Body**

  For example, if you select **HTTP Cookie**, **HTTPHeader**, and **Use Fast Pattern Matcher**, the rules engine searches for content in both the HTTP cookie and the HTTP header, but the fast pattern matcher is applied only to the HTTP header, not to the HTTP cookie.

  Note that you cannot use a raw HTTP field option (**HTTP Raw URI**, **HTTP Raw Header**, or **HTTP Raw Cookie**) together in the same **content** keyword with its normalized counterpart (**HTTP URI**, **HTTPHeader**, or **HTTP Cookie**, respectively).

  When you combine restricted and unrestricted options, the fast pattern matcher searches only the unrestricted fields you specify to test whether to pass the packet to the rules engine for complete evaluation, including evaluation of the restricted fields.

• Optionally, when you select **Use Fast Pattern Matcher** you can also select **Fast Pattern Matcher Only** or **Fast Pattern Matcher Offset and Length**, but not both.

• You cannot use the fast pattern matcher when inspecting Base64 data.

**Fast Pattern Matcher Only**

This option allows you to use the **content** keyword only as a fast pattern matcher option and not as a rule option. You can use this option to conserve resources when rules engine evaluation of the specified content is not necessary. For example, consider a case where a rule requires only that the content `12345` be anywhere in the payload. When the fast pattern matcher detects the pattern, the packet can be evaluated against additional keywords in the rule. There is no need for the rules engine to reevaluate the packet to determine if it includes the pattern `12345`.

You would not use this option when the rule contains other conditions relative to the specified content. For example, you would not use this option to search for the content `1234` if another rule condition sought to determine if `abcd` occurs before `1234`. In this case, the rules engine could not determine the relative location because specifying **Fast Pattern Matcher Only** instructs the rules engine not to search for the specified content.

Note the following conditions when using this option:

• The specified content is location-independent; that is, it may occur anywhere in the payload; thus, you cannot use positional options (**Distance**, **Within**, **Offset**, **Depth**, or **Fast Pattern Matcher Offset and Length**).

• You cannot use this option in combination with **Not**.

• You cannot use this option in combination with **Fast Pattern Matcher Offset and Length**.
• The specified content will be treated as case-insensitive, because all patterns are inserted into the fast pattern matcher in a case-insensitive manner; this is handled automatically, so it is not necessary to select Case Insensitive when you select this option.

• You should not immediately follow a content keyword that uses the Fast Pattern Matcher Only option with the following keywords, which set the search location relative to the current search location:
  - isdataat
  - pcre
  - content when Distance or Within is selected
  - content when HTTP URI is selected
  - asn1
  - byte_jump
  - byte_test
  - byte_extract
  - base64_decode

**Fast Pattern Matcher Offset and Length**

The Fast Pattern Matcher Offset and Length option allows you to specify a portion of the content to search. This can reduce memory consumption in cases where the pattern is very long and only a portion of the pattern is sufficient to identify the rule as a likely match. When a rule is selected by the fast pattern matcher, the entire pattern is evaluated against the rule.

You determine the portion for the fast pattern matcher to use by specifying in bytes where to begin the search (offset) and how far into the content (length) to search, using the syntax:

```
offset,length
```

For example, for the content:

```
1234567
```

if you specify the number of offset and length bytes as:

```
1,5
```

the fast pattern matcher searches only for the content 23456.

Note that you cannot use this option together with Fast Pattern Matcher Only.

**Related Topics**

- Overview: HTTP content and protected_content Keyword Arguments, on page 955
- The base64_decode and base64_data Keywords, on page 1034

**The replace Keyword**

You can the replace keyword in an inline deployment to replace specified content.
You cannot use the `replace` keyword to replace content in SSL traffic detected by the Cisco SSL Appliance. The original encrypted data, not the replacement data, will be transmitted. See the *Cisco SSL Appliance Administration and Deployment Guide* for more information.

To use the `replace` keyword, construct a custom standard text rule that uses the `content` keyword to look for a specific string. Then use the `replace` keyword to specify a string to replace the content. The replace value and content value must be the same length.

You cannot use the `replace` keyword to replace hashed content in a `protected_content` keyword.

Optionally, you can enclose the replacement string in quotation marks for backward compatibility with previous Firepower System software versions. If you do not include quotation marks, they are added to the rule automatically so the rule is syntactically correct. To include a leading or trailing quotation mark as part of the replacement text, you must use a backslash to escape it, as shown in the following example:

```
"replacement text plus "quotation\" marks"
```

A rule can contain multiple `replace` keywords, but only one `content` keyword. Only the first instance of the content found by the rule is replaced.

The following are example uses of the `replace` keyword:

- If the system detects an incoming packet that contains an exploit, you can replace the malicious string with a harmless one. Sometimes this technique is more successful than simply dropping the offending packet. In some attack scenarios, the attacker simply resend the dropped packet until it bypasses your network defenses or floods your network. By substituting one string for another rather than dropping the packet, you may trick the attacker into believing that the attack was launched against a target that was not vulnerable.

- If you are concerned about reconnaissance attacks that try to learn whether you are running a vulnerable version of, for example, a web server, then you can detect the outgoing packet and replace the banner with your own text.

Make sure that you set the rule state to Generate Events in the inline intrusion policy where you want to use the replace rule; setting the rule to Drop and Generate events would cause the packet to drop, which would prevent replacing the content.

As part of the string replacement process, the system automatically updates the packet checksums so that the destination host can receive the packet without error.

Note that you cannot use the `replace` keyword in combination with HTTP request message `content` keyword options.

**Related Topics**

- The `content` and `protected_content` Keywords, on page 950
- Overview: HTTP content and protected_content Keyword Arguments, on page 955
The byte_jump Keyword

The byte_jump keyword calculates the number of bytes defined in a specified byte segment, and then skips that number of bytes within the packet, either forward from the end of the specified byte segment, or from the beginning of the packet payload, or from a point relative to the last content match, depending on the options you specify. This is useful in packets where a specific segment of bytes describe the number of bytes included in variable data within the packet.

The following table describes the arguments required by the byte_jump keyword.

**Table 107: Required byte_jump Arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td>The number of bytes to pick up from the packet. If used without DCE/RPC, the allowed values are 1 to 10, with the following restrictions: • If you specify a number of bytes other than 1, 2, or 4, you must specify a Number Type (hexadecimal, octal, or decimal.) If used with DCE/RPC, allowed values are 1, 2, and 4.</td>
</tr>
<tr>
<td>Offset</td>
<td>The number of bytes into the payload to start processing. The offset counter starts at byte 0, so calculate the offset value by subtracting 1 from the number of bytes you want to jump forward from the beginning of the packet payload or the last successful content match. You can specify (-65535) to 65535 bytes. You can also use an existing byte_extract variable to specify the value for this argument.</td>
</tr>
</tbody>
</table>

The following table describes options you can use to define how the system interprets the values you specified for the required arguments.

**Table 108: Additional Optional byte_jump Arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative</td>
<td>Makes the offset relative to the last pattern found in the last successful content match.</td>
</tr>
<tr>
<td>Align</td>
<td>Rounds the number of converted bytes up to the next 32-bit boundary.</td>
</tr>
<tr>
<td>Multiplier</td>
<td>Indicates the value by which the rules engine should multiply the byte_jump value obtained from the packet to get the final byte_jump value. That is, instead of skipping the number of bytes defined in a specified byte segment, the rules engine skips that number of bytes multiplied by an integer you specify with the Multiplier argument.</td>
</tr>
</tbody>
</table>
The byte_jump Keyword

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post Jump Offset</td>
<td>The number of bytes -65535 through 65535 to skip forward or backward after applying other byte_jump arguments. A positive value skips forward and a negative value skips backward. Leave the field blank or enter 0 to disable. Note that some byte_jump arguments do not apply when you select the DCE/RPC argument.</td>
</tr>
<tr>
<td>From Beginning</td>
<td>Indicates that the rules engine should skip the specified number of bytes in the payload starting from the beginning of the packet payload, instead of from the current position in the packet.</td>
</tr>
</tbody>
</table>

You can specify only one of DCE/RPC, Endian, or Number Type.

If you want to define how the byte_jump keyword calculates the bytes, you can choose from the arguments described in the following table. If you do not select a byte-ordering argument, the rules engine uses big endian byte order.

**Table 109: Byte-Ordering byte_jump Arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Big Endian</td>
<td>Processes data in big endian byte order, which is the default network byte order.</td>
</tr>
<tr>
<td>Little Endian</td>
<td>Processes data in little endian byte order.</td>
</tr>
<tr>
<td>DCE/RPC</td>
<td>Specifies a byte_jump keyword for traffic processed by the DCE/RPC preprocessor. The DCE/RPC preprocessor determines big endian or little endian byte order, and the Number Type and Endian arguments do not apply. When you enable this argument, you can also use byte_jump in conjunction with other specific DCE/RPC keywords.</td>
</tr>
</tbody>
</table>

Define how the system views string data in a packet by using one of the arguments in the following table.

**Table 110: Number Type Arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal String</td>
<td>Represents converted string data in hexadecimal format.</td>
</tr>
<tr>
<td>Decimal String</td>
<td>Represents converted string data in decimal format.</td>
</tr>
<tr>
<td>Octal String</td>
<td>Represents converted string data in octal format.</td>
</tr>
</tbody>
</table>

For example, if the values you set for byte_jump are as follows:

- Bytes = 4
- Offset = 12
- Relative enabled
- Align enabled
the rules engine calculates the number described in the four bytes that appear 13 bytes after the last successful content match, and skips ahead that number of bytes in the packet. For instance, if the four calculated bytes in a specific packet were 00 00 00 1F, the rules engine would convert this to 31. Because align is specified (which instructs the engine to move to the next 32-bit boundary), the rules engine skips ahead 32 bytes in the packet.

Alternately, if the values you set for byte_jump are as follows:

- Bytes = 4
- Offset = 12
- From Beginning enabled
- Multiplier = 2

the rules engine calculates the number described in the four bytes that appear 13 bytes after the beginning of the packet. Then, the engine multiplies that number by two to obtain the total number of bytes to skip. For instance, if the four calculated bytes in a specific packet were 00 00 00 1F, the rules engine would convert this to 31, then multiply it by two to get 62. Because From Beginning is enabled, the rules engine skips the first 63 bytes in the packet.

**Related Topics**

The byte_extract Keyword, on page 967
DCE/RPC Keywords, on page 996

---

## The byte_test Keyword

The byte_test keyword tests the specified byte segment against the Value argument and its operator.

The following table describes the required arguments for the byte_test keyword.

### Table 111: Required byte_test Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
</table>
| Bytes    | The number of bytes to calculate from the packet.  
If used without DCE/RPC, the allowed values are 1 to 10. However, if you specify a number of bytes other than 1, 2, or 4, you must specify a Number Type (hexadecimal, octal, or decimal).  
If used with DCE/RPC, allowed values are 1, 2, and 4. |
| Value    | Value to test, including its operator.  
Supported operators: <, >, =, !, &, ^, !>, !<, !=, &&, or !^.

For example, if you specify !1024, byte_test would convert the specified number, and if it did not equal 1024, it would generate an event (if all other keyword parameters matched).

Note that ! and != are equivalent.

You can also use an existing byte_extract variable to specify the value for this argument. |
The number of bytes into the payload to start processing. The offset counter starts at byte 0, so calculate the offset value by subtracting 1 from the number of bytes you want to count forward from the beginning of the packet payload or the last successful content match.

You can use an existing byte_extract variable to specify the value for this argument.

You can further define how the system uses byte_test arguments with the arguments described in the following table.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offset</td>
<td>The offset value is calculated by subtracting 1 from the number of bytes you want to count forward from the beginning of the packet payload or the last successful content match.</td>
</tr>
</tbody>
</table>

You can specify only one of DCE/RPC, Endian, or Number Type.

To define how the byte_test keyword calculates the bytes it tests, choose from the arguments in the following table. If you do not select a byte-ordering argument, the rules engine uses big endian byte order.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Big Endian</td>
<td>Processes data in big endian byte order, which is the default network byte order.</td>
</tr>
<tr>
<td>Little Endian</td>
<td>Processes data in little endian byte order.</td>
</tr>
<tr>
<td>DCE/RPC</td>
<td>Specifies a byte_test keyword for traffic processed by the DCE/RPC preprocessor. The DCE/RPC preprocessor determines big endian or little endian byte order, and the Number Type and Endian arguments do not apply. When you enable this argument, you can also use byte_test in conjunction with other specific DCE/RPC keywords.</td>
</tr>
</tbody>
</table>

You can define how the system views string data in a packet by using one of the arguments in the following table.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal String</td>
<td>Represents converted string data in hexadecimal format.</td>
</tr>
<tr>
<td>Decimal String</td>
<td>Represents converted string data in decimal format.</td>
</tr>
<tr>
<td>Octal String</td>
<td>Represents converted string data in octal format.</td>
</tr>
</tbody>
</table>

For example, if the value for byte_test is specified as the following:

- Bytes = 4
• Operator and Value > 128
• Offset = 8
• Relative enabled

The rules engine calculates the number described in the four bytes that appear 9 bytes away from (relative to) the last successful content match, and, if the calculated number is larger than 128 bytes, the rule is triggered.

**Related Topics**
- [The byte_extract Keyword](#), on page 967
- [DCE/RPC Keywords](#), on page 996

## The byte_extract Keyword

You can use the `byte_extract` keyword to read a specified number of bytes from a packet into a variable. You can then use the variable later in the same rule as the value for specific arguments in certain other detection keywords.

This is useful, for example, for extracting data size from packets where a specific segment of bytes describes the number of bytes included in data within the packet. For example, a specific segment of bytes might say that subsequent data is comprised of four bytes; you can extract the data size of four bytes to use as your variable value.

You can use `byte_extract` to create up to two separate variables in a rule concurrently. You can redefine a `byte_extract` variable any number of times; entering a new `byte_extract` keyword with the same variable name and a different variable definition overwrites the previous definition of that variable.

The following table describes the arguments required by the `byte_extract` keyword.

### Table 115: Required byte_extract Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes to Extract</td>
<td>The number of bytes to pick up from the packet. If you specify a number of bytes other than 1, 2, or 4, you must specify a Number Type (hexadecimal, octal, or decimal.)</td>
</tr>
<tr>
<td>Offset</td>
<td>The number of bytes into the payload to begin extracting data. You can specify -65535 to 65535 bytes. The offset counter starts at byte 0, so calculate the offset value by subtracting 1 from the number of bytes you want to count forward. For example, specify 7 to count forward 8 bytes. The rules engine counts forward from the beginning of the packet payload or, if you also specify <code>Relative</code>, after the last successful content match. Note that you can specify negative numbers only when you also specify <code>Relative</code>.</td>
</tr>
<tr>
<td>Variable Name</td>
<td>The variable name to use in arguments for other detection keywords. You can specify an alphanumeric string that must begin with a letter.</td>
</tr>
</tbody>
</table>

To further define how the system locates the data to extract, you can use the arguments described in the following table.
Table 116: Additional Optional byte_extract Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiplier</td>
<td>A multiplier for the value extracted from the packet. You can specify 0 to 65535. If you do not specify a multiplier, the default value is 1.</td>
</tr>
<tr>
<td>Align</td>
<td>Rounds the extracted value to the nearest 2-byte or 4-byte boundary. When you also select Multiplier, the system applies the multiplier before the alignment.</td>
</tr>
<tr>
<td>Relative</td>
<td>Makes Offset relative to the end of the last successful content match instead of the beginning of the payload.</td>
</tr>
</tbody>
</table>

You can specify only one of **DCE/RPC**, **Endian**, or **Number Type**.

To define how the byte_extract keyword calculates the bytes it tests, you can choose from the arguments in the following table. If you do not select a byte-ordering argument, the rules engine uses big endian byte order.

Table 117: Byte-Ordering byte_extract Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Big Endian</td>
<td>Processes data in big endian byte order, which is the default network byte order.</td>
</tr>
<tr>
<td>Little Endian</td>
<td>Processes data in little endian byte order.</td>
</tr>
<tr>
<td>DCE/RPC</td>
<td>Specifies a byte_extract keyword for traffic processed by the DCE/RPC preprocessor. The DCE/RPC preprocessor determines big endian or little endian byte order, and the Number Type and Endian arguments do not apply. When you enable this argument, you can also use byte_extract in conjunction with other specific DCE/RPC keywords.</td>
</tr>
</tbody>
</table>

You can specify a number type to read data as an ASCII string. To define how the system views string data in a packet, you can select one of the arguments in the following table.

Table 118: Number Type byte_extract arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal String</td>
<td>Reads extracted string data in hexadecimal format.</td>
</tr>
<tr>
<td>Decimal String</td>
<td>Reads extracted string data in decimal format.</td>
</tr>
<tr>
<td>Octal String</td>
<td>Reads extracted string data in octal format.</td>
</tr>
</tbody>
</table>

For example, if the value for byte_extract is specified as the following:

- Bytes to Extract = 4
- Variable Name = var
- Offset = 8
- Relative = enabled
the rules engine reads the number described in the four bytes that appear 9 bytes away from (relative to) the last successful content match into a variable named var, which you can specify later in the rule as the value for certain keyword arguments.

The following table lists the keyword arguments where you can specify a variable defined in the byte_extract keyword.

**Table 119: Arguments Accepting a byte_extract Variable**

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Argument</th>
</tr>
</thead>
<tbody>
<tr>
<td>content</td>
<td>Depth, Offset, Distance, Within</td>
</tr>
<tr>
<td>byte_jump</td>
<td>Offset</td>
</tr>
<tr>
<td>byte_test</td>
<td>Offset, Value</td>
</tr>
<tr>
<td>isdataat</td>
<td>Offset</td>
</tr>
</tbody>
</table>

**Related Topics**
- The DCE/RPC Preprocessor, on page 1067
- DCE/RPC Keywords, on page 996
- Basic content and protected_content Keyword Arguments, on page 952
- The byte_jump Keyword, on page 963
- The byte_test Keyword, on page 965
- Packet Characteristics, on page 1017

**Overview: The pcre Keyword**

The `pcre` keyword allows you to use Perl-compatible regular expressions (PCRE) to inspect packet payloads for specified content. You can use PCRE to avoid writing multiple rules to match slight variations of the same content.

Regular expressions are useful when searching for content that could be displayed in a variety of ways. The content may have different attributes that you want to account for in your attempt to locate it within a packet’s payload.

Note that the regular expression syntax used in intrusion rules is a subset of the full regular expression library and varies in some ways from the syntax used in commands in the full library. When adding a `pcre` keyword using the intrusion rules editor, enter the full value in the following format:

`!/pcre/ ismxAEGRBUIPDHDMCKSY`  

where:

- `!` is an optional negation (use this if you want to match patterns that **do not** match the regular expression).
- `/pcre/` is a Perl-compatible regular expression.
- `ismxAEGRBUIPDHDMCKSY` is any combination of modifier options.

Also note that you must escape the characters listed in the following table for the rules engine to interpret them correctly when you use them in a PCRE to search for specific content in a packet payload.
### Table 120: Escaped PCRE Characters

<table>
<thead>
<tr>
<th>You must escape...</th>
<th>with a backslash...</th>
<th>or Hex code...</th>
</tr>
</thead>
<tbody>
<tr>
<td># (hash mark)</td>
<td>#</td>
<td>\x23</td>
</tr>
<tr>
<td>; (semicolon)</td>
<td>;</td>
<td>\x3B</td>
</tr>
<tr>
<td></td>
<td>(vertical bar)</td>
<td>|</td>
</tr>
<tr>
<td>: (colon)</td>
<td>:</td>
<td>\x3A</td>
</tr>
</tbody>
</table>

You can also use `m?regex`, where `?` is a delimiter other than `/`. You may want to use this in situations where you need to match a forward slash within a regular expression and do not want to escape it with a backslash. For example, you might use `m?regex` `ismxAEGRBUIPHDMCKSY` where `regex` is your Perl-compatible regular expression and `ismxAEGRBUIPHDMCKSY` is any combination of modifier options.

---

**Tip**

Optionally, you can surround your Perl-compatible regular expression with quote characters, for example, `pcre_expression` or `"pcre_expression"`. The option of using quotes accommodates experienced users accustomed to previous versions when quotes were required instead of optional. The intrusion rules editor does not display quotation marks when you display a rule after saving it.

---

### pcresyntax

The `pcresyntax` keyword accepts standard Perl-compatible regular expression (PCRE) syntax. The following sections describe that syntax.

---

**Tip**

While this section describes the basic syntax you may use for PCRE, you may want to consult an online reference or book dedicated to Perl and PCRE for more advanced information.

---

### Metacharacters

Metacharacters are literal characters that have special meaning within regular expressions. When you use them within a regular expression, you must “escape” them by preceding them with a backslash.

The following table describes the metacharacters you can use with PCRE and gives examples of each.

---

### Table 121: PCRE Metacharacters

<table>
<thead>
<tr>
<th>Metacharacter</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>Matches any character except newlines. If <code>s</code> is used as a modifying option, it also includes newline characters.</td>
<td><code>abc. matches abcd, abci, abci, and so on.</code></td>
</tr>
<tr>
<td>*</td>
<td>Matches zero or more occurrences of a character or expression.</td>
<td><code>abc* matches abc, abcc, abccc, abcccc, and so on.</code></td>
</tr>
<tr>
<td>?</td>
<td>Matches zero or one occurrence of a character or expression.</td>
<td><code>abc? matches abc</code></td>
</tr>
</tbody>
</table>
## pcre Syntax

### Metacharacter Description Example

<table>
<thead>
<tr>
<th>Metacharacter</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Matches one or more occurrences of a character or expression.</td>
<td>abc+ matches abc, abcc, abccc, abcccccc, and so on.</td>
</tr>
<tr>
<td>()</td>
<td>Groups expressions.</td>
<td>(abc)+ matches abc, abcabc, abcabcabc and so on.</td>
</tr>
<tr>
<td>{}</td>
<td>Specifies a limit for the number of matches for a character or expression. If you want to set a lower and upper limit, separate the lower limit and upper limit with a comma.</td>
<td>a{4,6} matches aaaa, aaaaaa, or aaaaaaaa. (ab){2} matches abab.</td>
</tr>
<tr>
<td>[]</td>
<td>Allows you to define character classes, and matches any character or combination of characters described in the set.</td>
<td>[abc123] matches a or b or c, and so on.</td>
</tr>
<tr>
<td>^</td>
<td>Matches content at the beginning of a string. Also used for negation, if used within a character class.</td>
<td>^in matches the “in” in info, but not in bin. [^a] matches anything that does not contain a.</td>
</tr>
<tr>
<td>$</td>
<td>Matches content at the end of a string.</td>
<td>ce$ matches the “ce” in announce, but not cent.</td>
</tr>
<tr>
<td></td>
<td>Indicates an OR expression.</td>
<td>(MAILTO</td>
</tr>
<tr>
<td>\</td>
<td>Allows you to use metacharacters as actual characters and is also used to specify a predefined character class.</td>
<td>. matches a period, * matches an asterisk, \ matches a backslash and so on. \d matches the numeric characters, \w matches alphanumeric characters, and so on.</td>
</tr>
</tbody>
</table>

### Character Classes

Character classes include alphabetic characters, numeric characters, alphanumerical characters, and white space characters. While you can create your own character classes within brackets, you can use the predefined classes as shortcuts for different types of character types. When used without additional qualifiers, a character class matches a single digit or character.

The following table describes and provides examples of the predefined character classes accepted by PCRE.

#### Table 122: PCRE Character Classes

<table>
<thead>
<tr>
<th>Character Class</th>
<th>Description</th>
<th>Character Class Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d</td>
<td>Matches a numeric character (“digit”).</td>
<td>[0-9]</td>
</tr>
<tr>
<td>\D</td>
<td>Matches anything that is not an numeric character.</td>
<td>[^0-9]</td>
</tr>
<tr>
<td>\w</td>
<td>Matches an alphanumerical character (“word”).</td>
<td>[a-zA-Z0-9_]</td>
</tr>
<tr>
<td>\W</td>
<td>Matches anything that is not an alphanumerical character.</td>
<td>[^a-zA-Z0-9_]</td>
</tr>
<tr>
<td>\s</td>
<td>Matches white space characters, including spaces, carriage returns, tabs, newlines, and form feeds.</td>
<td>[ \r\t\n\f]</td>
</tr>
<tr>
<td>\S</td>
<td>Matches anything that is not a white space character.</td>
<td>[^ \r\t\n\f]</td>
</tr>
</tbody>
</table>
pcre Modifier Options

You can use modifying options after you specify regular expression syntax in the `pcre` keyword’s value. These modifiers perform Perl, PCRE, and Snort-specific processing functions. Modifiers always appear at the end of the PCRE value, and appear in the following format:

```
/pcre/ismxAEGRBUIPHDMCKSY
```

where `ismxAEGRBUIPHMC` can include any of the modifying options that appear in the following tables.

**Tip**

Optionally, you can surround the regular expression and any modifying options with quotes, for example, “/pcre/ismxAEGRBUIPHDMCKSY”. The option of using quotes accommodates experienced users accustomed to previous versions when quotes were required instead of optional. The intrusion rules editor does not display quotation marks when you display a rule after saving it.

The following table describes options you can use to perform Perl processing functions.

**Table 123: Perl-Related Post Regular Expression Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>Makes the regular expression case-insensitive.</td>
</tr>
<tr>
<td>s</td>
<td>The dot character (.) describes all characters except the newline or \n character. You can use “s” as an option to override this and have the dot character match all characters, including the newline character.</td>
</tr>
<tr>
<td>m</td>
<td>By default, a string is treated as a single line of characters, and ^ and $ match the beginning and ending of a specific string. When you use “m” as an option, ^ and $ match content immediately before or after any newline character in the buffer, as well as at the beginning or end of the buffer.</td>
</tr>
<tr>
<td>x</td>
<td>Ignores white space data characters that may appear within the pattern, except when escaped (preceded by a backslash) or included inside a character class.</td>
</tr>
</tbody>
</table>

The following table describes the PCRE modifiers you can use after the regular expression.

**Table 124: PCRE-Related Post Regular Expression Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>The pattern must match at the beginning of the string (same as using ^ in a regular expression).</td>
</tr>
<tr>
<td>E</td>
<td>Sets $ to match only at the end of the subject string. (Without E, $ also matches immediately before the final character if it is a newline, but not before any other newline characters).</td>
</tr>
<tr>
<td>G</td>
<td>By default, * + and ? are “greedy,” which means that if two or more matches are found, they will choose the longest match. Use the G character to change this so that these characters always choose the first match unless followed by a question mark character (?). For example, *? +? and ?? would be greedy in a construct using the G modifier, and any incidences of *, +, or ? without the additional question mark will not be greedy.</td>
</tr>
</tbody>
</table>
The following table describes the Snort-specific modifiers that you can use after the regular expression.

**Table 125: Snort-Specific Post Regular Expression Modifiers**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Searches for matching content relative to the end of the last match found by the rules engine.</td>
</tr>
<tr>
<td>B</td>
<td>Searches for the content within data before it is decoded by a preprocessor (this option is similar to using the <code>Raw Data</code> argument with the <code>content</code> or <code>protected_content</code> keyword).</td>
</tr>
<tr>
<td>U</td>
<td>Searches for the content within the URI of a normalized HTTP request message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the <code>content</code> or <code>protected_content</code> keyword <code>HTTP URI</code> option to search the same content. Note that a pipelined HTTP request packet contains multiple URIs. A PCRE expression that includes the U option causes the rules engine to search for a content match only in the first URI in a pipelined HTTP request packet. To search all URIs in the packet, use the <code>content</code> or <code>protected_content</code> keyword with <code>HTTP URI</code> selected, either with or without an accompanying PCRE expression that uses the U option.</td>
</tr>
<tr>
<td>I</td>
<td>Searches for the content within the URI of a raw HTTP request message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the <code>content</code> or <code>protected_content</code> keyword <code>HTTP Raw URI</code> option to search the same content.</td>
</tr>
<tr>
<td>P</td>
<td>Searches for the content within the body of a normalized HTTP request message decoded by the HTTP Inspect preprocessor.</td>
</tr>
<tr>
<td>H</td>
<td>Searches for the content within the header, excluding cookies, of an HTTP request or response message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the <code>content</code> or <code>protected_content</code> keyword <code>HTTP Header</code> option to search the same content.</td>
</tr>
<tr>
<td>D</td>
<td>Searches for the content within the header, excluding cookies, of a raw HTTP request or response message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the <code>content</code> or <code>protected_content</code> keyword <code>HTTP Raw Header</code> option to search the same content.</td>
</tr>
<tr>
<td>M</td>
<td>Searches for the content within the method field of a normalized HTTP request message decoded by the HTTP Inspect preprocessor; the method field identifies the action such as GET, PUT, CONNECT, and so on to take on the resource identified in the URI.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| C      | When the HTTP Inspect preprocessor **Inspect HTTP Cookies** option is enabled, searches for the normalized content within any cookie in an HTTP request header, and also within any set-cookie in an HTTP response header when the preprocessor **Inspect HTTP Responses** option is enabled. When **Inspect HTTP Cookies** is not enabled, searches the entire header, including the cookie or set-cookie data. Note the following:  
  • Cookies included in the message body are treated as body content.  
  • You cannot use this option in combination with the `content` or `protected_content` keyword **HTTP Cookie** option to search the same content.  
  • The `Cookie:` and `Set-Cookie:` header names, leading spaces on the header line, and the `CRLF` that terminates the header line are inspected as part of the header and not as part of the cookie. |
| K      | When the HTTP Inspect preprocessor **Inspect HTTP Cookies** option is enabled, searches for the raw content within any cookie in an HTTP request header, and also within any set-cookie in an HTTP response header when the preprocessor **Inspect HTTP Responses** option is enabled. When **Inspect HTTP Cookies** is not enabled, searches the entire header, including the cookie or set-cookie data. Note the following:  
  • Cookies included in the message body are treated as body content.  
  • You cannot use this option in combination with the `content` or `protected_content` keyword **HTTP Raw Cookie** option to search the same content.  
  • The `Cookie:` and `Set-Cookie:` header names, leading spaces on the header line, and the `CRLF` that terminates the header line are inspected as part of the header and not as part of the cookie. |
| S      | Searches the 3-digit status code in an HTTP response. |
| Y      | Searches the textual description that accompanies the status code in an HTTP response. |

**Note**

Do not use the U option in combination with the R option. This could cause performance problems. Also, do not use the U option in combination with any other HTTP content option (I, P, H, D, M, C, K, S, or Y).

**Related Topics**

- Overview: HTTP content and protected_content Keyword Arguments, on page 955

**pcre Example Keyword Values**

The following examples show values that you could enter for `pcre`, with descriptions of what each example would match.
• /feedback\([\(d(0,1)\)]?\..cgi/U

This example searches packet payload for `feedback`, followed by zero or one numeric character, followed by `.cgi`, and located only in URI data.

This example would match:
  • feedback.cgi
  • feedback1.cgi
  • feedback2.cgi
  • feedback3.cgi

This example would not match:
  • feedbacka.cgi
  • feedback11.cgi
  • feedback21.cgi
  • feedbackzb.cgi

• /^ez(\w(3,5))\..cgi/iU

This example searches packet payload for `ez` at the beginning of a string, followed by a word of 3 to 5 letters, followed by `.cgi`. The search is case-insensitive and only searches URI data.

This example would match:
  • EZBoard.cgi
  • ezman.cgi
  • ezadmin.cgi
  • EZAdmin.cgi

This example would not match:
  • ezez.cgi
  • fez.cgi
  • abcezboard.cgi
  • ezboardman.cgi

• /mail(file|seek)\.cgi/U

This example searches packet payload for `mail`, followed by either `file` or `seek`, in URI data.

This example would match:
  • mailfile.cgi
  • mailseek.cgi
This example would not match:

- MailFile.cgi
- mailfilefile.cgi
- m?http\x3a\x2f\x2f\x2e\x2e\x2e.*\(\n|\t\)+?U

This example searches packet payload for URI content for a tab or newline character in an HTTP request, after any number of characters. This example uses `m?regex?` to avoid using `http:\/\/` in the expression. Note that the colon is preceded by a backslash.

This example would match:

- http://www.example.com?scriptvar=x&othervar=\n\n\n
- http://www.example.com?scriptvar=t

This example would not match:

- ftp://ftp.example.com?scriptvar=&othervar=\n\n\n
- http://www.example.com?scriptvar=\!/bin/sh -i

- m?http\x3a\x2f\x2f\x2e\x2e\x2e.*=\|.*\|+?sU

This example searches packet payload for a URL with any number of characters, including newlines, followed by an equal sign, and pipe characters that contain any number of characters or white space. This example uses `m?regex?` to avoid using `http:\/\/` in the expression.

This example would match:

- http://www.example.com?value=\!/bin/sh/ -i

- http://www.example.com?input=\!cat /etc/passwd

This example would not match:


- http://www.example.com?value=x&input?\!cat /etc/passwd

- /[0-9a-f]{2}:[0-9a-f]{2}:[0-9a-f]{2}:[0-9a-f]{2}:[0-9a-f]{2}:[0-9a-f]{2}/i

This example searches packet payload for any MAC address. Note that it escapes the colon characters with backslashes.

### The metadata Keyword

You can use the `metadata` keyword to add your own descriptive information to a rule. You can also use the `metadata` keyword with `service` arguments to identify applications and ports in network traffic. You can use the information you add to organize or identify rules in ways that suit your needs, and you can search rules for information you add and for `service` arguments.

The system validates metadata based on the argument format:

`key value`
where key and value provide a combined description separated by a space. This is the format used by the Cisco Talos Security Intelligence and Research Group (Talos) for adding metadata to rules provided by Cisco.

Alternatively, you can also use the format:

```
key = value
```

For example, you could use the key value format to identify rules by author and date, using a category and sub-category as follows:

```
author SnortGuru_20050406
```

You can use multiple metadata keywords in a rule. You can also use commas to separate multiple key value arguments in a single metadata keyword, as seen in the following example:

```
author SnortGuru_20050406, revised_by SnortUser1_20050707,
revised_by SnortUser2_20061003,
revised_by SnortUser1_20070123
```

You are not limited to using a key value or key=value format; however, you should be aware of limitations resulting from validation based on these formats.

**Restricted Characters to Avoid**

Note the following character restrictions:

- Do not use a semicolon (;) or colon (:).
- The system interprets a comma as a separator for multiple key value or key=value arguments. For example:
  
  `key value, key value, key value`
  
- The system interprets the equal to (=) character or space character as separators between key and value. For example:
  
  `key value`
  
  `key=value`

All other characters are permitted.

**Reserved Metadata to Avoid**

Avoid using the following words in a metadata keyword, either as a single argument or as the key in a key value argument; these are reserved for use by Talos:

```
application
engine
impact_flag
os
policy
rule-type
rule-flushing
soid
```

**Note**

Contact Support for assistance in adding restricted metadata to local rules that might not otherwise function as expected.
Impact Level 1

You can use the following reserved `key value` argument in a `metadata` keyword:

`impact_flag red`

This `key value` argument sets the impact flag to red (level 1) for a local rule you import or a custom rule you create using the intrusion rules editor.

Note that when Talos includes the `impact_flag red` argument in a rule provided by Cisco, Talos has determined that a packet triggering the rule indicates that the source or destination host is potentially compromised by a virus, trojan, or other piece of malicious software.

Related Topics

- Guidelines for Importing Local Intrusion Rules, on page 128
- The Intrusion Events Clipboard, on page 1658

Service Metadata

The system detects applications running on the hosts in your network and inserts application protocol information into your network traffic; it does this regardless of the configuration of your discovery policy. You can use `metadata` keyword `service` arguments in a TCP or UDP rule to match application protocols and ports in your network traffic. You can combine one or more `service` `application` arguments in a rule with a single port argument.

Service Applications

You can use the `metadata` keyword with `service` as the `key` and an application as the `value` to match packets with the identified application protocol. For example, the following `key value` argument in a `metadata` keyword associates the rule with HTTP traffic:

`service http`

You can identify multiple applications separated by commas. For example:

`service http, service smtp, service ftp`

Caution

Adaptive profiling must be enabled as described in Configuring Adaptive Profiles, on page 1195 for intrusion rules to use service metadata.

The following table describes the most common application values used with the `service` keyword.

Note

Contact Support for assistance if you have difficulty identifying applications not in the table.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cvs</td>
<td>Concurrent Versions System</td>
</tr>
<tr>
<td>dcerpc</td>
<td>Distributed Computing Environment/Remote Procedure Calls System</td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>dns</td>
<td>Domain Name System</td>
</tr>
<tr>
<td>finger</td>
<td>Finger user information protocol</td>
</tr>
<tr>
<td>ftp</td>
<td>File Transfer Protocol</td>
</tr>
<tr>
<td>ftp-data</td>
<td>File Transfer Protocol (Data Channel)</td>
</tr>
<tr>
<td>http</td>
<td>Hypertext Transfer Protocol</td>
</tr>
<tr>
<td>imap</td>
<td>Internet Message Access Protocol</td>
</tr>
<tr>
<td>isakmp</td>
<td>Internet Security Association and Key Management Protocol</td>
</tr>
<tr>
<td>mysql</td>
<td>My Structured Query Language</td>
</tr>
<tr>
<td>netbios-dgm</td>
<td>NETBIOS Datagram Service</td>
</tr>
<tr>
<td>netbios-ns</td>
<td>NETBIOS Name Service</td>
</tr>
<tr>
<td>netbios-ssn</td>
<td>NETBIOS Session Service</td>
</tr>
<tr>
<td>nntp</td>
<td>Network News Transfer Protocol</td>
</tr>
<tr>
<td>oracle</td>
<td>Oracle Net Services</td>
</tr>
<tr>
<td>shell</td>
<td>OS Shell</td>
</tr>
<tr>
<td>pop2</td>
<td>Post Office Protocol, version 2</td>
</tr>
<tr>
<td>pop3</td>
<td>Post Office Protocol, version 3</td>
</tr>
<tr>
<td>smtp</td>
<td>Simple Mail Transfer Protocol</td>
</tr>
<tr>
<td>snmp</td>
<td>Simple Network Management Protocol</td>
</tr>
<tr>
<td>ssh</td>
<td>Secure Shell network protocol</td>
</tr>
<tr>
<td>sunrpc</td>
<td>Sun Remote Procedure Call Protocol</td>
</tr>
<tr>
<td>telnet</td>
<td>Telnet network protocol</td>
</tr>
<tr>
<td>tftp</td>
<td>Trivial File Transfer Protocol</td>
</tr>
<tr>
<td>x11</td>
<td>X Window System</td>
</tr>
</tbody>
</table>

**Service Ports**

You can use the `metadata` keyword with `service` as the key and a specified port argument as the value to define how the rule matches ports in combination with applications.

You can specify any of the port values in the table below, one value per rule.
Table 127: service Port Values

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| else-ports or unknown | The system applies the rule if either of the following conditions is met:  
  • The packet application is known and matches the rule application.  
  • The packet application is unknown and packet ports match the rule ports.  
  The else-ports and unknown values produce the default behavior that the system uses when service specifies an application protocol with no port modifier. |
| and-ports        | The system applies the rule if the packet application is known and matches the rule application, and the packet port matches the ports in the rule header. You cannot use and-ports in a rule that does not specify an application. |
| or-ports         | The system applies the rule if any of the following conditions are met:  
  • The packet application is known and matches the rule application.  
  • The packet application is unknown and packet port matches the rule ports.  
  • The packet application does not match the rule application and packet ports match the rule ports.  
  • The rule does not specify an application and packet ports match the rule ports. |

Note the following:
  • You must include a service application argument with the service and-ports argument.
  • If a rule specifies more than one of the values in the table above, the system applies the last one that appears in the rule.
  • Port and application arguments can be in any order.

Except for the and-ports value, you can include a service port argument with or without one or more service application arguments. For example:

service or-ports, service http, service smtp

Applications and Ports in Traffic

The diagrams below illustrate the application and port combinations that intrusion rules support, and the results of applying these rule constraints to packet data.
Host application protocol else source/destination ports:

```
else-port, unknown, or no port key/value specified in rule
```

```
Application metadata in rule?
```

```
Yes
```

```
Application in packet?
```

```
Yes
```

```
Apply rule if it matches application in traffic
```

```
No
```

```
Apply rule if it matches port in traffic
```

Host application protocol and source/destination ports:

```
and-porto AND application (required) specified in rule
```

```
Application in packet?
```

```
Yes
```

```
Apply rule if it matches port AND application in traffic
```

```
No
```

```
Do not apply rule
```

Host application protocol or source/destination ports:

Example Matches

The following sample rules using the `metadata` keyword with `service` arguments are shown with examples of data they match and do not match:

- `alert tcp any any -> any [80,8080] (metadata:service and-ports, service http, service smtp;)

<table>
<thead>
<tr>
<th>Example Matches</th>
<th>Example Non-Matches</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HTTP traffic over TCP port 80  &lt;br&gt; • HTTP traffic over TCP port 8080  &lt;br&gt; • SMTP traffic over TCP port 80  &lt;br&gt; • SMTP traffic over TCP port 8080</td>
<td>• POP3 traffic on ports 80 or 8080  &lt;br&gt; • Traffic of unknown application on ports 80 or 8080  &lt;br&gt; • HTTP traffic on port 9999</td>
</tr>
</tbody>
</table>

- `alert tcp any any -> any [80,8080] (metadata:service or-ports, service http;)

<table>
<thead>
<tr>
<th>Example Matches</th>
<th>Example Non-Matches</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HTTP traffic on any port  &lt;br&gt; • SMTP traffic on port 80  &lt;br&gt; • SMTP traffic on port 8080  &lt;br&gt; • Traffic of unknown application on port 80 and 8080</td>
<td>• Non-HTTP and non-SMTP traffic on ports other than 80 or 8080</td>
</tr>
</tbody>
</table>
Any of the following rules:

- `alert tcp any any -> any [80,8080] metadata:service else-ports, service http;)
- `alert tcp any any -> any [80,8080] metadata:service unknown, service http;)
- `alert tcp any any -> any [80,8080] metadata:service http;)

### Example Matches

<table>
<thead>
<tr>
<th>Example Matches</th>
<th>Example Non-Matches</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HTTP traffic on any port</td>
<td>• SMTP traffic on ports 80 or 8080</td>
</tr>
<tr>
<td>• port 80 if packet application is unknown</td>
<td>• POP3 traffic on ports 80 or 8080</td>
</tr>
<tr>
<td>• port 8080 if packet application is unknown</td>
<td></td>
</tr>
</tbody>
</table>

### Metadata Search Guidelines

To search for rules that use the `metadata` keyword, select the `metadata` keyword on the rules Search page and, optionally, type any portion of the metadata. For example, you can type:

- `search` to display all rules where you have used `search` for `key`.
- `search http` to display all rules where you have used `search` for `key` and `http` for `value`.
- `author snortguru` to display all rules where you have used `author` for `key` and `SnortGuru` for `value`.
- `author s` to display all rules where you have used `author` for `key` and any terms such as `SnortGuru`, `SnortUser1`, or `SnortUser2` for `value`.

**Tip**

When you search for both `key` and `value`, use the same connecting operator (equal to `[]` or a space character) in searches that is used in the `key value` argument in the rule; searches return different results depending on whether you follow `key` with equal to (`=`) or a space character.

Note that regardless of the format you use to add metadata, the system interprets your metadata search term as all or part of a `key value` or `key=value` argument. For example, the following would be valid metadata that does not follow a `key value` or `key=value` format:

```
ab cd ef gh
```

However, the system would interpret each space in the example as a separator between a `key` and `value`. Thus, you could successfully locate a rule containing the example metadata using any of the following searches for juxtaposed and single terms:

```
cd ef
ef gh
ef
```

but you would not locate the rule using the following search, which the system would interpret as a single `key value` argument:

```
ab ef
```
IP Header Values

You can use keywords to identify possible attacks or security policy violations in the IP headers of packets.

**fragbits**

The `fragbits` keyword inspects the fragment and reserved bits in the IP header. You can check each packet for the Reserved Bit, the More Fragments bit, and the Don't Fragment bit in any combination.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Reserved bit</td>
</tr>
<tr>
<td>M</td>
<td>More Fragments bit</td>
</tr>
<tr>
<td>D</td>
<td>Don’t Fragment bit</td>
</tr>
</tbody>
</table>

To further refine a rule using the `fragbits` keyword, you can specify any operator described in the following table after the argument value in the rule.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>plus sign (+)</td>
<td>The packet must match against all specified bits.</td>
</tr>
<tr>
<td>asterisk (*)</td>
<td>The packet can match against any of the specified bits.</td>
</tr>
<tr>
<td>exclamation point (!)</td>
<td>The packet meets the criteria if none of the specified bits are set.</td>
</tr>
</tbody>
</table>

For example, to generate an event against packets that have the Reserved Bit set (and possibly any other bits), use `R+` as the `fragbits` value.

**id**

The `id` keyword tests the IP header fragment identification field against the value you specify in the keyword’s argument. Some denial-of-service tools and scanners set this field to a specific number that is easy to detect. For example, in SID 630, which detects a Synscan portscan, the `id` value is set to `39426`, the static value used as the ID number in packets transmitted by the scanner.

---

**Note**

`id` argument values must be numeric.

**ipopts**

The `ipopts` keyword allows you to search packets for specified IP header options. The following table lists the available argument values.
Table 130: IPoption Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rr</td>
<td>record route</td>
</tr>
<tr>
<td>eol</td>
<td>end of list</td>
</tr>
<tr>
<td>nop</td>
<td>no operation</td>
</tr>
<tr>
<td>ts</td>
<td>time stamp</td>
</tr>
<tr>
<td>sec</td>
<td>IP security option</td>
</tr>
<tr>
<td>lsrr</td>
<td>loose source routing</td>
</tr>
<tr>
<td>ssrr</td>
<td>strict source routing</td>
</tr>
<tr>
<td>satid</td>
<td>stream identifier</td>
</tr>
</tbody>
</table>

Analysts most frequently watch for strict and loose source routing because these options may be an indication of a spoofed source IP address.

**ip_proto**

The `ip_proto` keyword allows you to identify packets with the IP protocol specified as the keyword’s value. You can specify the IP protocols as a number, 0 through 255. You can combine these numbers with the following operators: <, >, or !. For example, to inspect traffic with any protocol that is not ICMP, use !1 as a value to the `ip_proto` keyword. You can also use the `ip_proto` keyword multiple times in a single rule; note, however, that the rules engine interprets multiple instances of the keyword as having a Boolean AND relationship. For example, if you create a rule containing `ip_proto: !3; ip_proto: !6`, the rule ignores traffic using the GGP protocol AND the TCP protocol.

**tos**

Some networks use the type of service (ToS) value to set precedence for packets traveling on that network. The `tos` keyword allows you to test the packet’s IP header ToS value against the value you specify as the keyword’s argument. Rules using the `tos` keyword will trigger on packets whose ToS is set to the specified value and that meet the rest of the criteria set forth in the rule.

**Note**

Argument values for `tos` must be numeric.

The ToS field has been deprecated in the IP header protocol and replaced with the Differentiated Services Code Point (DSCP) field.

**ttl**

A packet’s time-to-live (ttl) value indicates how many hops it can make before it is dropped. You can use the `ttl` keyword to test the packet’s IP header ttl value against the value, or range of values, you specify as the keyword’s argument. It may be helpful to set the `ttl` keyword parameter to a low value such as 0 or 1, as low time-to-live values are sometimes indicative of a traceroute or intrusion evasion attempt. (Note, though, that
the appropriate value for this keyword depends on your managed device placement and network topology.) Use syntax as follows:

- Use an integer from 0 to 255 to set a specific value for the TTL value. You can also precede the value with an equal (=) sign (for example, you can specify 5 or =5).
- Use a hyphen (-) to specify a range of TTL values (for example, 0-2 specifies all values 0 through 2, -5 specifies all values 0 through 5, and 5- specifies all values 5 through 255).
- Use the greater than (>) sign to specify TTL values greater than a specific value (for example, >3 specifies all values greater than 3).
- Use the greater than and equal to signs (>=) to specify TTL values greater than or equal to a specific value (for example, >=3 specifies all values greater than or equal to 3).
- Use the less than (<) sign to specify TTL values less than a specific value (for example, <3 specifies all values less than 3).
- Use the less than and equal to signs (<=) to specify TTL values less than or equal to a specific value (for example, <=3 specifies all values less than or equal to 3).

**ICMP Header Values**

The Firepower System supports keywords that you can use to identify attacks and security policy violations in the headers of ICMP packets. Note, however, that predefined rules exist that detect most ICMP types and codes. Consider enabling an existing rule or creating a local rule based on an existing rule; you may be able to find a rule that meets your needs more quickly than if you build an ICMP rule from scratch.

**icmp_id and icmp_seq**

The ICMP identification and sequence numbers help associate ICMP replies with ICMP requests. In normal traffic, these values are dynamically assigned to packets. Some covert channel and Distributed Denial of Server (DDoS) programs use static ICMP ID and sequence values. The following keywords allow you to identify ICMP packets with static values.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>icmp_id</td>
<td>Inspects an ICMP echo request or reply packet's ICMP ID number. Use a numeric value that corresponds with the ICMP ID number as the argument for the <code>icmp_id</code> keyword.</td>
</tr>
<tr>
<td>icmp_seq</td>
<td>The <code>icmp_seq</code> keyword inspects an ICMP echo request or reply packet's ICMP sequence. Use a numeric value that corresponds with the ICMP sequence number as the argument for the <code>icmp_seq</code> keyword.</td>
</tr>
</tbody>
</table>

**itype**

Use the `itype` keyword to look for packets with specific ICMP message type values. You can specify either a valid ICMP type value or an invalid ICMP type value to test for different types of traffic. For example, attackers may set ICMP type values out of range to cause denial of service and flooding attacks.

You can specify a range for the `itype` argument value using less than (<) and greater than (>). For example:
ICMP messages sometimes include a code value that provides details when a destination is unreachable. You can use the icode keyword to identify packets with specific ICMP code values. You can choose to specify either a valid ICMP code value or an invalid ICMP code value to test for different types of traffic. You can specify a range for the icode argument value using less than (<) and greater than (>). For example:

- to find values less than 35, specify <35.
- to find values greater than 36, specify >36.
- to find values between 3 and 55, specify 3<>55.

Tip

You can use the icode and itype keywords together to identify traffic that matches both. For example, to identify ICMP traffic that contains an ICMP Destination Unreachable code type with an ICMP Port Unreachable code type, specify an itype keyword with a value of 3 (for Destination Unreachable) and an icode keyword with a value of 3 (for Port Unreachable).

TCP Header Values and Stream Size

The Firepower System supports keywords that are designed to identify attacks attempted using TCP headers of packets and TCP stream size.

ack

You can use the ack keyword to compare a value against a packet’s TCP acknowledgment number. The rule triggers if a packet’s TCP acknowledgment number matches the value specified for the ack keyword. Argument values for ack must be numeric.

flags

You can use the flags keyword to specify any combination of TCP flags that, when set in an inspected packet, cause the rule to trigger.

Note

In situations where you would traditionally use A+ as the value for flags, you should instead use the flow keyword with a value of established. Generally, you should use the flow keyword with a value of stateless when using flags to ensure that all combinations of flags are detected.

You can either check for or ignore the values described in the following table for the flag keyword.
### Table 131: flag Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>TCP Flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ack</td>
<td>Acknowledges data.</td>
</tr>
<tr>
<td>Psh</td>
<td>Data should be sent in this packet.</td>
</tr>
<tr>
<td>Syn</td>
<td>A new connection.</td>
</tr>
<tr>
<td>Urg</td>
<td>Packet contains urgent data.</td>
</tr>
<tr>
<td>Fin</td>
<td>A closed connection.</td>
</tr>
<tr>
<td>Rst</td>
<td>An aborted connection.</td>
</tr>
<tr>
<td>CWR</td>
<td>An ECN congestion window has been reduced. This was formerly the R1 argument, which is still supported for backward compatibility.</td>
</tr>
<tr>
<td>ECE</td>
<td>ECN echo. This was formerly the R2 argument, which is still supported for backward compatibility.</td>
</tr>
</tbody>
</table>

When using the `flags` keyword, you can use an operator to indicate how the system performs matches against multiple flags. The following table describes these operators.

### Table 132: Operators Used with flags

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>all</td>
<td>The packet must contain all specified flags.</td>
<td>Select Urg and all to specify that a packet must contain the Urgent flag and may contain any other flags.</td>
</tr>
<tr>
<td>any</td>
<td>The packet can contain any of the specified flags.</td>
<td>Select Ack, Psh, and any to specify that either or both the Ack and Psh flags must be set to trigger the rule, and that other flags may also be set on a packet.</td>
</tr>
<tr>
<td>not</td>
<td>The packet must not contain the specified flag set.</td>
<td>Select Urg and not to specify that the Urgent flag is not set on packets that trigger this rule.</td>
</tr>
</tbody>
</table>

### flow

You can use the `flow` keyword to select packets for inspection by a rule based on session characteristics. The `flow` keyword allows you to specify the direction of the traffic flow to which a rule applies, applying rules to either the client flow or server flow. To specify how the `flow` keyword inspects your packets, you can set the direction of traffic you want analyzed, the state of packets inspected, and whether the packets are part of a rebuilt stream.

Stateful inspection of packets occurs when rules are processed. If you want a TCP rule to ignore stateless traffic (traffic without an established session context), you must add the `flow` keyword to the rule and select the Established argument for the keyword. If you want a UDP rule to ignore stateless traffic, you must add the `flow` keyword to the rule and select either the Established argument or a directional argument, or both. This causes the TCP or UDP rule to perform stateful inspection of a packet.
When you add a directional argument, the rules engine inspects only those packets that have an established state with a flow that matches the direction specified. For example, if you add the `flow` keyword with the `established` argument and the `From Client` argument to a rule that triggers when a TCP or UDP connection is detected, the rules engine only inspects packets that are sent from the client.

For maximum performance, always include a `flow` keyword in a TCP rule or a UDP session rule.

The following table describes the stream-related arguments you can specify for the `flow` keyword:

**Table 133: State-Related flow Arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Established</td>
<td>Triggers on established connections.</td>
</tr>
<tr>
<td>Stateless</td>
<td>Triggers regardless of the state of the stream processor.</td>
</tr>
</tbody>
</table>

The following table describes the directional options you can specify for the `flow` keyword:

**Table 134: flow Directional Arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Client</td>
<td>Triggers on server responses.</td>
</tr>
<tr>
<td>To Server</td>
<td>Triggers on client responses.</td>
</tr>
<tr>
<td>From Client</td>
<td>Triggers on client responses.</td>
</tr>
<tr>
<td>From Server</td>
<td>Triggers on server responses.</td>
</tr>
</tbody>
</table>

Notice that `From Server` and `To Client` perform the same function, as do `To Server` and `From Client`. These options exist to add context and readability to the rule. For example, if you create a rule designed to detect an attack from a server to a client, use `From Server`. But, if you create a rule designed to detect an attack from the client to the server, use `From Client`.

The following table describes the stream-related arguments you can specify for the `flow` keyword:

**Table 135: Stream-Related flow Arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore Stream Traffic</td>
<td>Does not trigger on rebuilt stream packets.</td>
</tr>
<tr>
<td>Only Stream Traffic</td>
<td>Triggers only on rebuilt stream packets.</td>
</tr>
</tbody>
</table>

For example, you can use `To Server, Established, Only Stream Traffic` as the value for the `flow` keyword to detect traffic, traveling from a client to the server in an established session, that has been reassembled by the stream preprocessor.
**seq**

The `seq` keyword allows you to specify a static sequence number value. Packets whose sequence number matches the specified argument trigger the rule containing the keyword. While this keyword is used rarely, it is helpful in identifying attacks and network scans that use generated packets with static sequence numbers.

**window**

You can use the `window` keyword to specify the TCP window size you are interested in. A rule containing this keyword triggers whenever it encounters a packet with the specified TCP window size. While this keyword is used rarely, it is helpful in identifying attacks and network scans that use generated packets with static TCP window sizes.

**stream_size**

You can use the `stream_size` keyword in conjunction with the stream preprocessor to determine the size in bytes of a TCP stream, using the format:

```
direction, operator, bytes
```

where bytes is number of bytes. You must separate each option in the argument with a comma (,).

The following table describes the case-insensitive directional options you can specify for the `stream_size` keyword:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>client</td>
<td>triggers on a stream from the client matching the specified stream size.</td>
</tr>
<tr>
<td>server</td>
<td>triggers on a stream from the server matching the specified stream size.</td>
</tr>
</tbody>
</table>
| both     | triggers on traffic from the client and traffic from the server both matching the specified stream size.  
For example, the argument `both, >, 200` would trigger when traffic from the client is greater than 200 bytes AND traffic from the server is greater than 200 bytes. |
| either   | triggers on traffic from either the client or the server matching the specified stream size, whichever occurs first.  
For example, the argument `either, >, 200` would trigger when traffic from the client is greater than 200 bytes OR traffic from the server is greater than 200 bytes. |

The following table describes the operators you can use with the `stream_size` keyword:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>equal to</td>
</tr>
<tr>
<td>!=</td>
<td>not equal to</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
</tr>
</tbody>
</table>
For example, you could use `client, >=, 5001216` as the argument for the `stream_size` keyword to detect a TCP stream traveling from a client to a server and greater than or equal to 5001216 bytes.

### The stream_reassemble Keyword

You can use the `stream_reassemble` keyword to enable or disable TCP stream reassembly for a single connection when inspected traffic on the connection matches the conditions of the rule. Optionally, you can use this keyword multiple times in a rule.

Use the following syntax to enable or disable stream reassembly:

```
enable|disable, server|client|both, option, option
```

The following table describes the optional arguments you can use with the `stream_reassemble` keyword.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>noalert</td>
<td>Generate no events regardless of any other detection options specified in the rule.</td>
</tr>
<tr>
<td>fastpath</td>
<td>Ignore the rest of the connection traffic when there is a match.</td>
</tr>
</tbody>
</table>

For example, the following rule disables TCP client-side stream reassembly without generating an event on the connection where a 200 OK status code is detected in an HTTP response:

```
alert tcp any 80 -> any any (flow:to_client, established; content: "200 OK"; stream_reassemble:disable, client, noalert)
```

### SSL Keywords

You can use SSL rule keywords to invoke the Secure Sockets Layer (SSL) preprocessor and extract information about SSL version and session state from packets in an encrypted session.

When a client and server communicate to establish an encrypted session using SSL or Transport Layer Security (TLS), they exchange handshake messages. Although the data transmitted in the session is encrypted, the handshake messages are not.

The SSL preprocessor extracts state and version information from specific handshake fields. Two fields within the handshake indicate the version of SSL or TLS used to encrypt the session and the stage of the handshake.

**ssl_state**

The `ssl_state` keyword can be used to match against state information for an encrypted session. To check for two or more SSL versions used simultaneously, use multiple `ssl_version` keywords in a rule.
When a rule uses the `ssl_state` keyword, the rules engine invokes the SSL preprocessor to check traffic for SSL state information.

For example, to detect an attacker’s attempt to cause a buffer overflow on a server by sending a `ClientHello` message with an overly long challenge length and too much data, you could use the `ssl_state` keyword with `client_hello` as an argument then check for abnormally large packets.

Use a comma-separated list to specify multiple arguments for the SSL state. When you list multiple arguments, the system evaluates them using the OR operator. For example, if you specify `client_hello` and `server_hello` as arguments, the system evaluates the rule against traffic that has a `client_hello` OR a `server_hello`.

You can also negate any argument; for example:

```
!client_hello, !unknown
```

To ensure the connection has reached each of a set of states, multiple rules using the `ssl_state` rule option should be used. The `ssl_state` keyword takes the following identifiers as arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>client_hello</code></td>
<td>Matches against a handshake message with <code>ClientHello</code> as the message type, where the client requests an encrypted session.</td>
</tr>
<tr>
<td><code>server_hello</code></td>
<td>Matches against a handshake message with <code>ServerHello</code> as the message type, where the server responds to the client’s request for an encrypted session.</td>
</tr>
<tr>
<td><code>client_keyx</code></td>
<td>Matches against a handshake message with <code>ClientKeyExchange</code> as the message type, where the client transmits a key to the server to confirm receipt of a key from the server.</td>
</tr>
<tr>
<td><code>server_keyx</code></td>
<td>Matches against a handshake message with <code>ServerKeyExchange</code> as the message type, where the client transmits a key to the server to confirm receipt of a key from the server.</td>
</tr>
<tr>
<td><code>unknown</code></td>
<td>Matches against any handshake message type.</td>
</tr>
</tbody>
</table>

### ssl_version

The `ssl_version` keyword can be used to match against version information for an encrypted session. When a rule uses the `ssl_version` keyword, the rules engine invokes the SSL preprocessor to check traffic for SSL version information.

For example, if you know there is a buffer overflow vulnerability in SSL version 2, you could use the `ssl_version` keyword with the `sslv2` argument to identify traffic using that version of SSL.

Use a comma-separated list to specify multiple arguments for the SSL version. When you list multiple arguments, the system evaluates them using the OR operator. For example, if you wanted to identify any encrypted traffic that was not using SSLv2, you could add `ssl_version:ssl_v3,tlsv1.0,tlsv1.1,tlsv1.2` to a rule. The rule would evaluate any traffic using SSL Version 3, TLS Version 1.0, TLS Version 1.1, or TLS Version 1.2.

The `ssl_version` keyword takes the following SSL/TLS version identifiers as arguments:
### Table 140: ssl_version Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>sslv2</td>
<td>Matches against traffic encoded using Secure Sockets Layer (SSL) Version 2.</td>
</tr>
<tr>
<td>sslv3</td>
<td>Matches against traffic encoded using Secure Sockets Layer (SSL) Version 3.</td>
</tr>
<tr>
<td>tls1.0</td>
<td>Matches against traffic encoded using Transport Layer Security (TLS) Version 1.0.</td>
</tr>
<tr>
<td>tls1.2</td>
<td>Matches against traffic encoded using Transport Layer Security (TLS) Version 1.2.</td>
</tr>
</tbody>
</table>

### The appid Keyword

You can use the `appid` keyword to identify the application protocol, client application, or web application in a packet. For example, you could target a specific application that you know is susceptible to a specific vulnerability.

Within the `appid` keyword of an intrusion rule, click **Configure AppID** to select one or more applications that you want to detect.

#### Browsing the Available Applications

When you first start to build the condition, the **Available Applications** list is unconstrained and displays every application the system detects, 100 per page:

- To page through the applications, click the arrows underneath the list.
- To display a pop-up window with summary information about the application’s characteristics, as well as Internet search links that you can follow, click the information icon (ℹ️) next to an application.

#### Using Application Filters

To help you find the applications you want to match, you can constrain the **Available Applications** list in the following ways:

- To search for applications, click the **Search by name** prompt above the list, then type a name. The list updates as you type to display matching applications.
- To constrain the applications by applying a filter, use the **Application Filters** list. The **Available Applications** list updates as you apply filters. For your convenience, the system uses an unlock icon (🔒) to mark applications that the system can identify only in decrypted traffic—not encrypted or unencrypted.

---

**Note**

If you select one or more filters in the Application Filters list and also search the **Available Applications** list, your selections and the search-filtered **Available Applications** list are combined using an AND operation.
Selecting Applications

To select a single application, select it and click Add to Rule. To select all applications in the current constrained view, right-click and select Select All.

Application Layer Protocol Values

Although preprocessors perform most of the normalization and inspection of application layer protocol values, you can continue to inspect application layer values using various preprocessor options.

The RPC Keyword

The rpc keyword identifies Open Network Computing Remote Procedure Call (ONC RPC) services in TCP or UDP packets. This allows you to detect attempts to identify the RPC programs on a host. Intruders can use an RPC portmapper to determine if any of the RPC services running on your network can be exploited. They can also attempt to access other ports running RPC without using portmapper. The following table lists the arguments that the rpc keyword accepts.

Table 141: rpc Keyword Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>application</td>
<td>The RPC application number</td>
</tr>
<tr>
<td>procedure</td>
<td>The RPC procedure invoked</td>
</tr>
<tr>
<td>version</td>
<td>The RPC version</td>
</tr>
</tbody>
</table>

To specify the arguments for the rpc keyword, use the following syntax:

application,procedure,version

where application is the RPC application number, procedure is the RPC procedure number, and version is the RPC version number. You must specify all arguments for the rpc keyword — if you are not able to specify one of the arguments, replace it with an asterisk (*).

For example, to search for RPC portmapper (which is the RPC application indicated by the number 100000), with any procedure or version, use 100000, *, * as the arguments.

The ASN.1 Keyword

The asn1 keyword allows you to decode a packet or a portion of a packet, looking for various malicious encodings.

The following table describes the arguments for the asn1 keyword.

Table 142: asn1 Keyword Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitstring Overflow</td>
<td>Detects invalid, remotely exploitable bitstring encodings.</td>
</tr>
<tr>
<td>Double Overflow</td>
<td>Detects a double ASCII encoding that is larger than a standard buffer. This is known to be an exploitable function in Microsoft Windows, but it is unknown at this time which services may be exploitable.</td>
</tr>
<tr>
<td>Argument</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Oversize Length</td>
<td>Detects ASN.1 type lengths greater than the supplied argument. For example, if you set the Oversize Length to 500, any ASN.1 type greater than 500 triggers the rule.</td>
</tr>
<tr>
<td>Absolute Offset</td>
<td>Sets an absolute offset from the beginning of the packet payload. (Remember that the offset counter starts at byte 0.) For example, if you want to decode SNMP packets, set Absolute Offset to 0 and do not set a Relative Offset. Absolute Offset may be positive or negative.</td>
</tr>
<tr>
<td>Relative Offset</td>
<td>This is the relative offset from the last successful content match, pcre, or byte_jump. To decode an ASN.1 sequence right after the content &quot;foo&quot;, set Relative Offset to 0, and do not set an Absolute Offset. Relative Offset may be positive or negative. (Remember that the offset counter starts at 0.)</td>
</tr>
</tbody>
</table>

For example, there is a known vulnerability in the Microsoft ASN.1 Library that creates a buffer overflow, allowing an attacker to exploit the condition with a specially crafted authentication packet. When the system decodes the asn.1 data, exploit code in the packet could execute on the host with system-level privileges or could cause a DoS condition. The following rule uses the `asn1` keyword to detect attempts to exploit this vulnerability:

```
alert tcp $EXTERNAL_NET any -> $HOME_NET 445
(flow:to_server, established; content:"|FF|SMB|73|";
nocase; offset:4; depth:5;
asn1:bitstring_overflow, double_overflow, oversize_length 100,
relative_offset 54;)
```

The above rule generates an event against TCP traffic traveling from any IP address defined in the $EXTERNAL_NET variable, from any port, to any IP address defined in the $HOME_NET variable using port 445. In addition, it only executes the rule on established TCP connections to servers. The rule then tests for specific content in specific locations. Finally, the rule uses the `asn1` keyword to detect bitstring encodings and double ASCII encodings and to identify asn.1 type lengths over 100 bytes in length starting 55 bytes from the end of the last successful content match. (Remember that the offset counter starts at byte 0.)

**The urilen Keyword**

You can use the `urilen` keyword in conjunction with the HTTP Inspect preprocessor to inspect HTTP traffic for URIs of a specific length, less than a maximum length, greater than a minimum length, or within a specified range.

After the HTTP Inspect preprocessor normalizes and inspects the packet, the rules engine evaluates the packet against the rule and determines whether the URI matches the length condition specified by the `urilen` keyword. You can use this keyword to detect exploits that attempt to take advantage of URI length vulnerabilities, for example, by creating a buffer overflow that allows the attacker to cause a DoS condition or execute code on the host with system-level privileges.

Note the following when using the `urilen` keyword in a rule:

- In practice, you always use the `urilen` keyword in combination with the `flow:established` keyword and one or more other keywords.
- The rule protocol is always TCP.
- Target ports are always HTTP ports.

You specify the URI length using a decimal number of bytes, less than (<) and greater than (>).
For example:

- specify 5 to detect a URI 5 bytes long.
- specify < 5 (separated by one space character) to detect a URI less than 5 bytes long.
- specify > 5 (separated by one space character) to detect a URI greater than 5 bytes long.
- specify 3 <> 5 (with one space character before and after <>) to detect a URI between 3 and 5 bytes long inclusive.

For example, there is a known vulnerability in Novell’s server monitoring and diagnostics utility iMonitor version 2.4, which comes with eDirectory version 8.8. A packet containing an excessively long URI creates a buffer overflow, allowing an attacker to exploit the condition with a specially crafted packet that could execute on the host with system-level privileges or could cause a DoS condition. The following rule uses the urilen keyword to detect attempts to exploit this vulnerability:

```
alert tcp $EXTERNAL_NET any -> $HOME_NET $HTTP_PORTS
   (msg:"EXPLOIT eDirectory 8.8 Long URI iMonitor buffer overflow attempt";
    flow:to_server,established;
    urilen:> 8192; uricontent:"/nds/"; nocase;
    classtype:attempted-admin; sid:x; rev:1;)
```

The above rule generates an event against TCP traffic traveling from any IP address defined in the $EXTERNAL_NET variable, from any port, to any IP address defined in the $HOME_NET variable using the ports defined in the $HTTP_PORTS variable. In addition, packets are evaluated against the rule only on established TCP connections to servers. The rule uses the urilen keyword to detect any URI over 8192 bytes in length. Finally, the rule searches the URI for the specific case-insensitive content /nds/.

**Related Topics**

- Intrusion Rule Header Protocol, on page 930
- Intrusion Rule Header Source and Destination Ports, on page 933
- Predefined Default Variables, on page 335

### DCE/RPC Keywords

The three DCE/RPC keywords described in the following table allow you to monitor DCE/RPC session traffic for exploits. When the system processes rules with these keywords, it invokes the DCE/RPC preprocessor.

**Table 143: DCE/RPC Keywords**

<table>
<thead>
<tr>
<th>Use...</th>
<th>In this way...</th>
<th>To detect...</th>
</tr>
</thead>
<tbody>
<tr>
<td>dce_iface</td>
<td>alone</td>
<td>packets identifying a specific DCE/RPC service</td>
</tr>
<tr>
<td>dce_opnum</td>
<td>preceded by dce_iface</td>
<td>packets identifying specific DCE/RPC service operations</td>
</tr>
<tr>
<td>dce_stub_data</td>
<td>preceded by dce_iface + dce_opnum</td>
<td>stub data defining a specific operation request or response</td>
</tr>
</tbody>
</table>

Note in the table that you should always precede dce_opnum with dce_iface, and you should always precede dce_stub_data with dce_iface + dce_opnum.
You can also use these DCE/RPC keywords in combination with other rule keywords. Note that for DCE/RPC rules, you use the byte_jump, byte_test, and byte_extract keywords with their DCE/RPC arguments selected.

Cisco recommends that you include at least one content keyword in rules that include DCE/RPC keywords to ensure that the rules engine uses the fast pattern matcher, which increases processing speed and improves performance. Note that the rules engine uses the fast pattern matcher when a rule includes at least one content keyword, regardless of whether you enable the content keyword Use Fast Pattern Matcher argument.

You can use the DCE/RPC version and adjoining header information as the matching content in the following cases:

- the rule does not include another content keyword
- the rule contains another content keyword, but the DCE/RPC version and adjoining information represent a more unique pattern than the other content
  
  For example, the DCE/RPC version and adjoining information are more likely to be unique than a single byte of content.

You should end qualifying rules with one of the following version and adjoining information content matches:

- For connection-oriented DCE/RPC rules, use the content |05 00 00| (for major version 05, minor version 00, and the request PDU (protocol data unit) type 00).
- For connectionless DCE/RPC rules, use the content |04 00| (for version 04, and the request PDU type 00).

In either case, position the content keyword for version and adjoining information as the last keyword in the rule to invoke the fast pattern matcher without repeating processing already completed by the DCE/RPC preprocessor. Note that placing the content keyword at the end of the rule applies to version content used as a device to invoke the fast pattern matcher, and not necessarily to other content matches in the rule.

**Related Topics**

The DCE/RPC Preprocessor, on page 1067
The content and protected_content Keywords, on page 950
content Keyword Fast Pattern Matcher Arguments, on page 959
Overview: The byte_jump and byte_test Keywords
The byte_extract Keyword, on page 967

dce_iface

You can use the dce_iface keyword to identify a specific DCE/RPC service.

Optionally, you can also use dce_iface in combination with the dce_opnum and dce_stub_data keywords to further limit the DCE/RPC traffic to inspect.

A fixed, sixteen-byte Universally Unique Identifier (UUID) identifies the application interface assigned to each DCE/RPC service. For example, the UUID 4b324fc8-670-01d3-1278-5a47bf6ee188 identifies the DCE/RPC lanmanger server service, also known as the srvsvc service, which provides numerous management functions for sharing peer-to-peer printers, files, and SMB named pipes. The DCE/RPC preprocessor uses the UUID and associated header values to track DCE/RPC sessions.

The interface UUID is comprised of five hexadecimal strings separated by hyphens:

<4hexbytes>-<2hexbytes>-<2hexbytes>-<2hexbytes>-<6hexbytes>
You specify the interface by entering the entire UUID including hyphens, as seen in the following UUID for the netlogon interface:

12345678-1234-abcd-ef00-01234567cffb

Note that you must specify the first three strings in the UUID in big endian byte order. Although published interface listings and protocol analyzers typically display UUIDs in the correct byte order, you might encounter a need to rearrange the UUID byte order before entering it. Consider the following messenger service UUID shown as it might sometimes be displayed in raw ASCII text with the first three strings in little endian byte order:

f8 91 7b 5a 00 ff d0 11 a9 b2 00 c0 4f b6 e6 fc

You would specify the same UUID for the dce_iface keyword by inserting hyphens and putting the first three strings in big endian byte order as follows:

5a7b91f8-ff00-11d0-a9b2-00c04fb6e6fc

Although a DCE/RPC session can include requests to multiple interfaces, you should include only one dce_iface keyword in a rule. Create additional rules to detect additional interfaces.

DCE/RPC application interfaces also have interface version numbers. You can optionally specify an interface version with an operator indicating that the version equals, does not equal, is less than, or greater than the specified value.

Both connection-oriented and connectionless DCE/RPC can be fragmented in addition to any TCP segmentation or IP fragmentation. Typically, it is not useful to associate any DCE/RPC fragment other than the first with the specified interface, and doing so may result in a large number of false positives. However, for flexibility you can optionally evaluate all fragments against the specified interface.

The following table summarizes the dce_iface keyword arguments.

### Table 144: dce_iface Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface UUID</td>
<td>The UUID, including hyphens, that identifies the application interface of the specific service that you want to detect in DCE/RPC traffic. Any request associated with the specified interface would match the interface UUID.</td>
</tr>
<tr>
<td>Version</td>
<td>Optionally, the application interface version number 0 to 65535 and an operator indicating whether to detect a version greater than (&gt;) or less than (&lt;), equal to (=/), or not equal to (!) the specified value.</td>
</tr>
<tr>
<td>All Fragments</td>
<td>Optionally, enable to match against the interface in all associated DCE/RPC fragments and, if specified, on the interface version. This argument is disabled by default, indicating that the keyword matches only if the first fragment or the entire unfragmented packet is associated with the specified interface. Note that enabling this argument may result in false positives.</td>
</tr>
</tbody>
</table>

### The dce_opnum Keyword

You can use the dce_opnum keyword in conjunction with the DCE/RPC preprocessor to detect packets that identify one or more specific operations that a DCE/RPC service provides.
Client function calls request specific service functions, which are referred to in DCE/RPC specifications as operations. An operation number (opnum) identifies a specific operation in the DCE/RPC header. It is likely that an exploit would target a specific operation.

For example, the UUID 12345678-1234-abcd-ef00-01234567cffb identifies the interface for the netlogon service, which provides several dozen different operations. One of these is operation 6, the NetServerPasswordSet operation.

You should precede a dce_opnum keyword with a dce_iface keyword to identify the service for the operation.

You can specify a single decimal value 0 to 65535 for a specific operation, a range of operations separated by a hyphen, or a comma-separated list of operations and ranges in any order.

Any of the following examples would specify valid netlogon operation numbers:

15
15-18
15, 18-20
15, 20-22, 17
15, 18-20, 22, 24-26

The dce_stub_data Keyword

You can use the dce_stub_data keyword in conjunction with the DCE/RPC preprocessor to specify that the rules engine should start inspection at the beginning of the stub data, regardless of any other rule options. Packet payload rule options that follow the dce_stub_data keyword are applied relative to the stub data buffer.

DCE/RPC stub data provides the interface between a client procedure call and the DCE/RPC run-time system, the mechanism that provides the routines and services central to DCE/RPC. DCE/RPC exploits are identified in the stub data portion of the DCE/RPC packet. Because stub data is associated with a specific operation or function call, you should always precede dce_stub_data with dce_iface and dce_opnum to identify the related service and operation.

The dce_stub_data keyword has no arguments.

SIP Keywords

Four SIP keywords allow you to monitor SIP session traffic for exploits.

Note that the SIP protocol is vulnerable to denial of service (DoS) attacks. Rules addressing these attacks can benefit from rate-based attack prevention.

The sip_header Keyword

You can use the sip_header keyword to start inspection at the beginning of the extracted SIP request or response header and restrict inspection to header fields.

The sip_header keyword has no arguments.

The following example rule fragment points to the SIP header and matches the CSeq header field:

alert udp any any -> any 5060 ( sip_header; content:"CSeq"; )

Related Topics

Dynamic Intrusion Rule States, on page 897
Rate-Based Attack Prevention, on page 1182
The sip_body Keyword

You can use the sip_body keyword to start inspection at the beginning of the extracted SIP request or response message body and restrict inspection to the message body.

The sip_body keyword has no arguments.

The following example rule fragment points to the SIP message body and matches a specific IP address in the c (connection information) field in extracted SDP data:

```
alert udp any any -> any 5060 ( sip_body; content:"c=IN 192.168.12.14"; )
```

Note that rules are not limited to searching for SDP content. The SIP preprocessor extracts the entire message body and makes it available to the rules engine.

The sip_method Keyword

A method field in each SIP request identifies the purpose of the request. You can use the sip_method keyword to test SIP requests for specific methods. Separate multiple methods with commas.

You can specify any of the following currently defined SIP methods:

- ack
- benotify
- bye
- cancel
- do
- info
- invite
- join
- message
- notify
- options
- prack
- publish
- quath
- refer
- register
- service
- sprack
- subscribe
- unsubscribe
- update

Methods are case-insensitive. You can separate multiple methods with commas.

Because new SIP methods might be defined in the future, you can also specify a custom method, that is, a method that is not a currently defined SIP method. Accepted field values are defined in RFC 2616, which allows all characters except control characters and separators such as =, (, and ). See RFC 2616 for the complete list of excluded separators. When the system encounters a specified custom method in traffic, it will inspect the packet header but not the message.

The system supports up to 32 methods, including the 21 currently defined methods and an additional 11 methods. The system ignores any undefined methods that you might configure. Note that the 32 total methods includes methods specified using the Methods to Check SIP preprocessor option.

You can specify only one method when you use negation. For example:

```
!invite
```

Note, however, that multiple sip_method keywords in a rule are linked with an AND operation. For example, to test for all extracted methods except invite and cancel, you would use two negated sip_method keywords:

```
sip_method: !invite
sip_method: !cancel
```

Cisco recommends that you include at least one content keyword in rules that include the sip_method keyword to ensure that the rules engine uses the fast pattern matcher, which increases processing speed and improves performance. Note that the rules engine uses the fast pattern matcher when a rule includes at least one content keyword, regardless of whether you enable the content keyword Use Fast Pattern Matcher argument.

Related Topics

- SIP Preprocessor Options, on page 1106
- The content and protected_content Keywords, on page 950
- content Keyword Fast Pattern Matcher Arguments, on page 959
The sip_stat_code Keyword

A three-digit status code in each SIP response indicates the outcome of the requested action. You can use the sip_stat_code keyword to test SIP responses for specific status codes.

You can specify a one-digit response-type number 1-9, a specific three-digit number 100-999, or a comma-separated list of any combination of either. A list matches if any single number in the list matches the code in the SIP response.

The following table describes the SIP status code values you can specify.

<table>
<thead>
<tr>
<th>To detect...</th>
<th>Specify...</th>
<th>For example...</th>
<th>Detects...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a specific status code</td>
<td>the three-digit status code</td>
<td>189</td>
<td>189</td>
</tr>
<tr>
<td>any three-digit code that begins with a specified single digit</td>
<td>the single digit</td>
<td>1</td>
<td>1xx; that is, 100, 101, 102, and so on</td>
</tr>
<tr>
<td>a list of values</td>
<td>any comma-separated combination of specific codes and single digits</td>
<td>222, 3</td>
<td>222 plus 300, 301, 302, and so on</td>
</tr>
</tbody>
</table>

Note also that the rules engine does not use the fast pattern matcher to search for the value specify using the sip_stat_code keyword, regardless of whether your rule includes a content keyword.

GTP Keywords

Three GSRP Tunneling Protocol (GTP) keywords allow you to inspect the GTP command channel for GTP version, message type, and information elements. You cannot use GTP keywords in combination with other intrusion rule keywords such as content or byte_jump. You must use the gtp_version keyword in each rule that uses the gtp_info or gtp_type keyword.

The gtp_version Keyword

You can use the gtp_version keyword to inspect GTP control messages for GTP version 0, 1, or 2.

Because different GTP versions define different message types and information elements, you must use gtp_version when you use the gtp_type or gtp_info keyword. You can specify the value 0, 1, or 2.

The gtp_type Keyword

Each GTP message is identified by a message type, which is comprised of both a numeric value and a string. You can use the gtp_type keyword to inspect traffic for specific GTP message types. Because different GTP versions define different message types and information elements, you must also use gtp_version when you use the gtp_type or gtp_info keyword.

You can specify a defined decimal value for a message type, a defined string, or a comma-separated list of either or both in any combination, as seen in the following example:

10, 11, echo_request

The system uses an OR operation to match each value or string that you list. The order in which you list values and strings does not matter. Any single value or string in the list matches the keyword. You receive an error if you attempt to save a rule that includes an unrecognized string or an out-of-range value.
Note in the table that different GTP versions sometimes use different values for the same message type. For example, the `sgsn_context_request` message type has a value of 50 in GTPv0 and GTPv1, but a value of 130 in GTPv2.

The `gtp_type` keyword matches different values depending on the version number in the packet. In the example above, the keyword matches the message type value 50 in a GTPv0 or GTPv1 packet and the value 130 in a GTPv2 packet. The keyword does not match a packet when the message type value in the packet is not a known value for the version specified in the packet.

If you specify an integer for the message type, the keyword matches if the message type in the keyword matches the value in the GTP packet, regardless of the version specified in the packet.

The following table lists the defined values and strings recognized by the system for each GTP message type.

<table>
<thead>
<tr>
<th>Value</th>
<th>Version 0</th>
<th>Version 1</th>
<th>Version 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>echo_request</td>
<td>echo_request</td>
<td>echo_request</td>
</tr>
<tr>
<td>2</td>
<td>echo_response</td>
<td>echo_response</td>
<td>echo_response</td>
</tr>
<tr>
<td>3</td>
<td>version_not_supported</td>
<td>version_not_supported</td>
<td>version_not_supported</td>
</tr>
<tr>
<td>4</td>
<td>node_alive_request</td>
<td>node_alive_request</td>
<td>N/A</td>
</tr>
<tr>
<td>5</td>
<td>node_alive_response</td>
<td>node_alive_response</td>
<td>N/A</td>
</tr>
<tr>
<td>6</td>
<td>redirection_request</td>
<td>redirection_request</td>
<td>N/A</td>
</tr>
<tr>
<td>7</td>
<td>redirection_response</td>
<td>redirection_response</td>
<td>N/A</td>
</tr>
<tr>
<td>16</td>
<td>create_pdp_context_request</td>
<td>create_pdp_context_request</td>
<td>N/A</td>
</tr>
<tr>
<td>17</td>
<td>create_pdp_context_response</td>
<td>create_pdp_context_response</td>
<td>N/A</td>
</tr>
<tr>
<td>18</td>
<td>update_pdp_context_request</td>
<td>update_pdp_context_request</td>
<td>N/A</td>
</tr>
<tr>
<td>19</td>
<td>update_pdp_context_response</td>
<td>update_pdp_context_response</td>
<td>N/A</td>
</tr>
<tr>
<td>20</td>
<td>delete_pdp_context_request</td>
<td>delete_pdp_context_request</td>
<td>N/A</td>
</tr>
<tr>
<td>21</td>
<td>delete_pdp_context_response</td>
<td>delete_pdp_context_response</td>
<td>N/A</td>
</tr>
<tr>
<td>22</td>
<td>create_aa_pdp_context_request</td>
<td>init_pdp_context_activation_request</td>
<td>N/A</td>
</tr>
<tr>
<td>23</td>
<td>create_aa_pdp_context_response</td>
<td>init_pdp_context_activation_response</td>
<td>N/A</td>
</tr>
<tr>
<td>24</td>
<td>delete_aa_pdp_context_request</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>25</td>
<td>delete_aa_pdp_context_response</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>26</td>
<td>error_indication</td>
<td>error_indication</td>
<td>N/A</td>
</tr>
<tr>
<td>27</td>
<td>pdu_notification_request</td>
<td>pdu_notification_request</td>
<td>N/A</td>
</tr>
<tr>
<td>28</td>
<td>pdu_notification_response</td>
<td>pdu_notification_response</td>
<td>N/A</td>
</tr>
</tbody>
</table>
### The gtp_type Keyword

<table>
<thead>
<tr>
<th>Value</th>
<th>Version 0</th>
<th>Version 1</th>
<th>Version 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>29</td>
<td>pdu_notification_reject_request</td>
<td>pdu_notification_reject_request</td>
<td>N/A</td>
</tr>
<tr>
<td>30</td>
<td>pdu_notification_reject_response</td>
<td>pdu_notification_reject_response</td>
<td>N/A</td>
</tr>
<tr>
<td>31</td>
<td>N/A</td>
<td>supported_ext_header_notification</td>
<td>N/A</td>
</tr>
<tr>
<td>32</td>
<td>send_routing_info_request</td>
<td>send_routing_info_request</td>
<td>create_session_request</td>
</tr>
<tr>
<td>33</td>
<td>send_routing_info_response</td>
<td>send_routing_info_response</td>
<td>create_session_response</td>
</tr>
<tr>
<td>34</td>
<td>failure_report_request</td>
<td>failure_report_request</td>
<td>modify_bearer_request</td>
</tr>
<tr>
<td>35</td>
<td>failure_report_response</td>
<td>failure_report_response</td>
<td>modify_bearer_response</td>
</tr>
<tr>
<td>36</td>
<td>note_ms_present_request</td>
<td>note_ms_present_request</td>
<td>delete_session_request</td>
</tr>
<tr>
<td>37</td>
<td>note_ms_present_response</td>
<td>note_ms_present_response</td>
<td>delete_session_response</td>
</tr>
<tr>
<td>38</td>
<td>N/A</td>
<td>N/A</td>
<td>change_notification_request</td>
</tr>
<tr>
<td>39</td>
<td>N/A</td>
<td>N/A</td>
<td>change_notification_response</td>
</tr>
<tr>
<td>48</td>
<td>identification_request</td>
<td>identification_request</td>
<td>N/A</td>
</tr>
<tr>
<td>49</td>
<td>identification_response</td>
<td>identification_response</td>
<td>N/A</td>
</tr>
<tr>
<td>50</td>
<td>sgsn_context_request</td>
<td>sgsn_context_request</td>
<td>N/A</td>
</tr>
<tr>
<td>51</td>
<td>sgsn_context_response</td>
<td>sgsn_context_response</td>
<td>N/A</td>
</tr>
<tr>
<td>52</td>
<td>sgsn_context_ack</td>
<td>sgsn_context_ack</td>
<td>N/A</td>
</tr>
<tr>
<td>53</td>
<td>N/A</td>
<td>forward_relocation_request</td>
<td>N/A</td>
</tr>
<tr>
<td>54</td>
<td>N/A</td>
<td>forward_relocation_response</td>
<td>N/A</td>
</tr>
<tr>
<td>55</td>
<td>N/A</td>
<td>forward_relocation_complete</td>
<td>N/A</td>
</tr>
<tr>
<td>56</td>
<td>N/A</td>
<td>relocation_cancel_request</td>
<td>N/A</td>
</tr>
<tr>
<td>57</td>
<td>N/A</td>
<td>relocation_cancel_response</td>
<td>N/A</td>
</tr>
<tr>
<td>58</td>
<td>N/A</td>
<td>forward_srns_contex</td>
<td>N/A</td>
</tr>
<tr>
<td>59</td>
<td>N/A</td>
<td>forward_relocation_complete_ack</td>
<td>N/A</td>
</tr>
<tr>
<td>60</td>
<td>N/A</td>
<td>forward_srns_contex_ack</td>
<td>N/A</td>
</tr>
<tr>
<td>64</td>
<td>N/A</td>
<td>N/A</td>
<td>modify_bearer_command</td>
</tr>
<tr>
<td>65</td>
<td>N/A</td>
<td>N/A</td>
<td>modify_bearer_failure_indication</td>
</tr>
<tr>
<td>66</td>
<td>N/A</td>
<td>N/A</td>
<td>delete_bearer_command</td>
</tr>
<tr>
<td>67</td>
<td>N/A</td>
<td>N/A</td>
<td>delete_bearer_failure_indication</td>
</tr>
<tr>
<td>Value</td>
<td>Version 0</td>
<td>Version 1</td>
<td>Version 2</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>68</td>
<td>N/A</td>
<td>N/A</td>
<td>bearer_resource_command</td>
</tr>
<tr>
<td>69</td>
<td>N/A</td>
<td>N/A</td>
<td>bearer_resource_failure_indication</td>
</tr>
<tr>
<td>70</td>
<td>N/A</td>
<td>ran_info Relay</td>
<td>downlink_failure_indication</td>
</tr>
<tr>
<td>71</td>
<td>N/A</td>
<td>N/A</td>
<td>trace_session_activation</td>
</tr>
<tr>
<td>72</td>
<td>N/A</td>
<td>N/A</td>
<td>trace_session_deactivation</td>
</tr>
<tr>
<td>73</td>
<td>N/A</td>
<td>N/A</td>
<td>stop_paging_indication</td>
</tr>
<tr>
<td>95</td>
<td>N/A</td>
<td>N/A</td>
<td>create_bearer_request</td>
</tr>
<tr>
<td>96</td>
<td>N/A</td>
<td>mbms_notification_request</td>
<td>create_bearer_response</td>
</tr>
<tr>
<td>97</td>
<td>N/A</td>
<td>mbms_notification_response</td>
<td>update_bearer_request</td>
</tr>
<tr>
<td>98</td>
<td>N/A</td>
<td>mbms_notification_reject_request</td>
<td>update_bearer_response</td>
</tr>
<tr>
<td>99</td>
<td>N/A</td>
<td>mbms_notification_reject_response</td>
<td>delete_bearer_request</td>
</tr>
<tr>
<td>100</td>
<td>N/A</td>
<td>create_mbms_context_request</td>
<td>delete_bearer_response</td>
</tr>
<tr>
<td>101</td>
<td>N/A</td>
<td>create_mbms_context_response</td>
<td>delete_pdn_request</td>
</tr>
<tr>
<td>102</td>
<td>N/A</td>
<td>update_mbms_context_request</td>
<td>delete_pdn_response</td>
</tr>
<tr>
<td>103</td>
<td>N/A</td>
<td>update_mbms_context_response</td>
<td>N/A</td>
</tr>
<tr>
<td>104</td>
<td>N/A</td>
<td>delete_mbms_context_request</td>
<td>N/A</td>
</tr>
<tr>
<td>105</td>
<td>N/A</td>
<td>delete_mbms_context_response</td>
<td>N/A</td>
</tr>
<tr>
<td>112</td>
<td>N/A</td>
<td>mbms_register_request</td>
<td>N/A</td>
</tr>
<tr>
<td>113</td>
<td>N/A</td>
<td>mbms_register_response</td>
<td>N/A</td>
</tr>
<tr>
<td>114</td>
<td>N/A</td>
<td>mbms_deregister_request</td>
<td>N/A</td>
</tr>
<tr>
<td>115</td>
<td>N/A</td>
<td>mbms_deregister_response</td>
<td>N/A</td>
</tr>
<tr>
<td>116</td>
<td>N/A</td>
<td>mbms_session_start_request</td>
<td>N/A</td>
</tr>
<tr>
<td>117</td>
<td>N/A</td>
<td>mbms_session_start_response</td>
<td>N/A</td>
</tr>
<tr>
<td>118</td>
<td>N/A</td>
<td>mbms_session_stop_request</td>
<td>N/A</td>
</tr>
<tr>
<td>119</td>
<td>N/A</td>
<td>mbms_session_stop_response</td>
<td>N/A</td>
</tr>
<tr>
<td>120</td>
<td>N/A</td>
<td>mbms_session_update_request</td>
<td>N/A</td>
</tr>
<tr>
<td>121</td>
<td>N/A</td>
<td>mbms_session_update_response</td>
<td>N/A</td>
</tr>
<tr>
<td>128</td>
<td>N/A</td>
<td>ms_info_change_request</td>
<td>identification_request</td>
</tr>
<tr>
<td>Value</td>
<td>Version 0</td>
<td>Version 1</td>
<td>Version 2</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>129</td>
<td>N/A</td>
<td>ms_info_change_response</td>
<td>identification_response</td>
</tr>
<tr>
<td>130</td>
<td>N/A</td>
<td>N/A</td>
<td>sgsn_context_request</td>
</tr>
<tr>
<td>131</td>
<td>N/A</td>
<td>N/A</td>
<td>sgsn_context_response</td>
</tr>
<tr>
<td>132</td>
<td>N/A</td>
<td>N/A</td>
<td>sgsn_context_ack</td>
</tr>
<tr>
<td>133</td>
<td>N/A</td>
<td>N/A</td>
<td>forward_relocation_request</td>
</tr>
<tr>
<td>134</td>
<td>N/A</td>
<td>N/A</td>
<td>forward_relocation_response</td>
</tr>
<tr>
<td>135</td>
<td>N/A</td>
<td>N/A</td>
<td>forward_relocation_complete</td>
</tr>
<tr>
<td>136</td>
<td>N/A</td>
<td>N/A</td>
<td>forward_relocation_complete_ack</td>
</tr>
<tr>
<td>137</td>
<td>N/A</td>
<td>N/A</td>
<td>forward_access</td>
</tr>
<tr>
<td>138</td>
<td>N/A</td>
<td>N/A</td>
<td>forward_access_ack</td>
</tr>
<tr>
<td>139</td>
<td>N/A</td>
<td>N/A</td>
<td>relocation_cancel_request</td>
</tr>
<tr>
<td>140</td>
<td>N/A</td>
<td>N/A</td>
<td>relocation_cancel_response</td>
</tr>
<tr>
<td>141</td>
<td>N/A</td>
<td>N/A</td>
<td>configuration_transfer_tunnel</td>
</tr>
<tr>
<td>149</td>
<td>N/A</td>
<td>N/A</td>
<td>detach</td>
</tr>
<tr>
<td>150</td>
<td>N/A</td>
<td>N/A</td>
<td>detach_ack</td>
</tr>
<tr>
<td>151</td>
<td>N/A</td>
<td>N/A</td>
<td>cs_paging</td>
</tr>
<tr>
<td>152</td>
<td>N/A</td>
<td>N/A</td>
<td>ran_info_relay</td>
</tr>
<tr>
<td>153</td>
<td>N/A</td>
<td>N/A</td>
<td>alert_mme</td>
</tr>
<tr>
<td>154</td>
<td>N/A</td>
<td>N/A</td>
<td>alert_mme_ack</td>
</tr>
<tr>
<td>155</td>
<td>N/A</td>
<td>N/A</td>
<td>ue_activity</td>
</tr>
<tr>
<td>156</td>
<td>N/A</td>
<td>N/A</td>
<td>ue_activity_ack</td>
</tr>
<tr>
<td>160</td>
<td>N/A</td>
<td>N/A</td>
<td>create_forward_tunnel_request</td>
</tr>
<tr>
<td>161</td>
<td>N/A</td>
<td>N/A</td>
<td>create_forward_tunnel_response</td>
</tr>
<tr>
<td>162</td>
<td>N/A</td>
<td>N/A</td>
<td>suspend</td>
</tr>
<tr>
<td>163</td>
<td>N/A</td>
<td>N/A</td>
<td>suspend_ack</td>
</tr>
<tr>
<td>164</td>
<td>N/A</td>
<td>N/A</td>
<td>resume</td>
</tr>
<tr>
<td>165</td>
<td>N/A</td>
<td>N/A</td>
<td>resume_ack</td>
</tr>
<tr>
<td>166</td>
<td>N/A</td>
<td>N/A</td>
<td>create_indirect_forward_tunnel_request</td>
</tr>
</tbody>
</table>
### The `gtp_info` Keyword

A GTP message can include multiple information elements, each of which is identified by both a defined numeric value and a defined string. You can use the `gtp_info` keyword to start inspection at the beginning of a specified information element, and restrict inspection to the specified information element. Because different GTP versions define different message types and information elements, you must also use `gtp_version` when you use this keyword.

<table>
<thead>
<tr>
<th>Value</th>
<th>Version 0</th>
<th>Version 1</th>
<th>Version 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>167</td>
<td>N/A</td>
<td>N/A</td>
<td>create_indirect_forward_tunnel_response</td>
</tr>
<tr>
<td>168</td>
<td>N/A</td>
<td>N/A</td>
<td>delete_indirect_forward_tunnel_request</td>
</tr>
<tr>
<td>169</td>
<td>N/A</td>
<td>N/A</td>
<td>delete_indirect_forward_tunnel_response</td>
</tr>
<tr>
<td>170</td>
<td>N/A</td>
<td>N/A</td>
<td>release_access_bearer_request</td>
</tr>
<tr>
<td>171</td>
<td>N/A</td>
<td>N/A</td>
<td>release_access_bearer_response</td>
</tr>
<tr>
<td>176</td>
<td>N/A</td>
<td>N/A</td>
<td>downlink_data</td>
</tr>
<tr>
<td>177</td>
<td>N/A</td>
<td>N/A</td>
<td>downlink_data_ack</td>
</tr>
<tr>
<td>179</td>
<td>N/A</td>
<td>N/A</td>
<td>pgw_restart</td>
</tr>
<tr>
<td>180</td>
<td>N/A</td>
<td>N/A</td>
<td>pgw_restart_ack</td>
</tr>
<tr>
<td>200</td>
<td>N/A</td>
<td>N/A</td>
<td>update_pdn_request</td>
</tr>
<tr>
<td>201</td>
<td>N/A</td>
<td>N/A</td>
<td>update_pdn_response</td>
</tr>
<tr>
<td>211</td>
<td>N/A</td>
<td>N/A</td>
<td>modify_access_bearer_request</td>
</tr>
<tr>
<td>212</td>
<td>N/A</td>
<td>N/A</td>
<td>modify_access_bearer_response</td>
</tr>
<tr>
<td>231</td>
<td>N/A</td>
<td>N/A</td>
<td>mbms_session_start_request</td>
</tr>
<tr>
<td>232</td>
<td>N/A</td>
<td>N/A</td>
<td>mbms_session_start_response</td>
</tr>
<tr>
<td>233</td>
<td>N/A</td>
<td>N/A</td>
<td>mbms_session_update_request</td>
</tr>
<tr>
<td>234</td>
<td>N/A</td>
<td>N/A</td>
<td>mbms_session_update_response</td>
</tr>
<tr>
<td>235</td>
<td>N/A</td>
<td>N/A</td>
<td>mbms_session_stop_request</td>
</tr>
<tr>
<td>236</td>
<td>N/A</td>
<td>N/A</td>
<td>mbms_session_stop_response</td>
</tr>
<tr>
<td>240</td>
<td>data_record_transfer_request</td>
<td>data_record_transfer_request</td>
<td>N/A</td>
</tr>
<tr>
<td>241</td>
<td>data_record_transfer_response</td>
<td>data_record_transfer_response</td>
<td>N/A</td>
</tr>
<tr>
<td>254</td>
<td>N/A</td>
<td>end_marker</td>
<td>N/A</td>
</tr>
<tr>
<td>255</td>
<td>pdu</td>
<td>pdu</td>
<td>N/A</td>
</tr>
</tbody>
</table>
You can specify either the defined decimal value or the defined string for an information element. You can specify a single value or string, and you can use multiple `gtp_info` keywords in a rule to inspect multiple information elements.

When a message includes multiple information elements of the same type, all are inspected for a match. When information elements occur in an invalid order, only the last instance is inspected.

Note that different GTP versions sometimes use different values for the same information element. For example, the `cause` information element has a value of 1 in GTPv0 and GTPv1, but a value of 2 in GTPv2.

The `gtp_info` keyword matches different values depending on the version number in the packet. In the example above, the keyword matches the information element value 1 in a GTPv0 or GTPv1 packet and the value 2 in a GTPv2 packet. The keyword does not match a packet when the information element value in the packet is not a known value for the version specified in the packet.

If you specify an integer for the information element, the keyword matches if the message type in the keyword matches the value in the GTP packet, regardless of the version specified in the packet.

The following table lists the values and strings recognized by the system for each GTP information element.

### Table 147: GTP Information Elements

<table>
<thead>
<tr>
<th>Value</th>
<th>Version 0</th>
<th>Version 1</th>
<th>Version 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>cause</td>
<td>cause</td>
<td>imsi</td>
</tr>
<tr>
<td>2</td>
<td>imsi</td>
<td>imsi</td>
<td>cause</td>
</tr>
<tr>
<td>3</td>
<td>rai</td>
<td>rai</td>
<td>recovery</td>
</tr>
<tr>
<td>4</td>
<td>tlli</td>
<td>tlli</td>
<td>N/A</td>
</tr>
<tr>
<td>5</td>
<td>p_tmsi</td>
<td>p_tmsi</td>
<td>N/A</td>
</tr>
<tr>
<td>6</td>
<td>qos</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>8</td>
<td>recording_required</td>
<td>recording_required</td>
<td>N/A</td>
</tr>
<tr>
<td>9</td>
<td>authentication</td>
<td>authentication</td>
<td>N/A</td>
</tr>
<tr>
<td>11</td>
<td>map_cause</td>
<td>map_cause</td>
<td>N/A</td>
</tr>
<tr>
<td>12</td>
<td>p_tmsi_sig</td>
<td>p_tmsi_sig</td>
<td>N/A</td>
</tr>
<tr>
<td>13</td>
<td>ms_validated</td>
<td>ms_validated</td>
<td>N/A</td>
</tr>
<tr>
<td>14</td>
<td>recovery</td>
<td>recovery</td>
<td>N/A</td>
</tr>
<tr>
<td>15</td>
<td>selection_mode</td>
<td>selection_mode</td>
<td>N/A</td>
</tr>
<tr>
<td>16</td>
<td>flow_label_data_1</td>
<td>teid_1</td>
<td>N/A</td>
</tr>
<tr>
<td>17</td>
<td>flow_label_signalling</td>
<td>teid_control</td>
<td>N/A</td>
</tr>
<tr>
<td>18</td>
<td>flow_label_data_2</td>
<td>teid_2</td>
<td>N/A</td>
</tr>
<tr>
<td>19</td>
<td>ms_unreachable</td>
<td>teardown_ind</td>
<td>N/A</td>
</tr>
<tr>
<td>Value</td>
<td>Version 0</td>
<td>Version 1</td>
<td>Version 2</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>20</td>
<td>N/A</td>
<td>nsapi</td>
<td>N/A</td>
</tr>
<tr>
<td>21</td>
<td>N/A</td>
<td>ranap</td>
<td>N/A</td>
</tr>
<tr>
<td>22</td>
<td>N/A</td>
<td>rab_context</td>
<td>N/A</td>
</tr>
<tr>
<td>23</td>
<td>N/A</td>
<td>radio_priority_sms</td>
<td>N/A</td>
</tr>
<tr>
<td>24</td>
<td>N/A</td>
<td>radio_priority</td>
<td>N/A</td>
</tr>
<tr>
<td>25</td>
<td>N/A</td>
<td>packet_flow_id</td>
<td>N/A</td>
</tr>
<tr>
<td>26</td>
<td>N/A</td>
<td>charging_char</td>
<td>N/A</td>
</tr>
<tr>
<td>27</td>
<td>N/A</td>
<td>trace_ref</td>
<td>N/A</td>
</tr>
<tr>
<td>28</td>
<td>N/A</td>
<td>trace_type</td>
<td>N/A</td>
</tr>
<tr>
<td>29</td>
<td>N/A</td>
<td>ms_unreachable</td>
<td>N/A</td>
</tr>
<tr>
<td>71</td>
<td>N/A</td>
<td>N/A</td>
<td>apn</td>
</tr>
<tr>
<td>72</td>
<td>N/A</td>
<td>N/A</td>
<td>ambr</td>
</tr>
<tr>
<td>73</td>
<td>N/A</td>
<td>N/A</td>
<td>ebi</td>
</tr>
<tr>
<td>74</td>
<td>N/A</td>
<td>N/A</td>
<td>ip_addr</td>
</tr>
<tr>
<td>75</td>
<td>N/A</td>
<td>N/A</td>
<td>mei</td>
</tr>
<tr>
<td>76</td>
<td>N/A</td>
<td>N/A</td>
<td>msisdn</td>
</tr>
<tr>
<td>77</td>
<td>N/A</td>
<td>N/A</td>
<td>indication</td>
</tr>
<tr>
<td>78</td>
<td>N/A</td>
<td>N/A</td>
<td>pco</td>
</tr>
<tr>
<td>79</td>
<td>N/A</td>
<td>N/A</td>
<td>paa</td>
</tr>
<tr>
<td>80</td>
<td>N/A</td>
<td>N/A</td>
<td>bearer_qos</td>
</tr>
<tr>
<td>80</td>
<td>N/A</td>
<td>N/A</td>
<td>flow_qos</td>
</tr>
<tr>
<td>82</td>
<td>N/A</td>
<td>N/A</td>
<td>rat_type</td>
</tr>
<tr>
<td>83</td>
<td>N/A</td>
<td>N/A</td>
<td>serving_network</td>
</tr>
<tr>
<td>84</td>
<td>N/A</td>
<td>N/A</td>
<td>bearer_tft</td>
</tr>
<tr>
<td>85</td>
<td>N/A</td>
<td>N/A</td>
<td>tad</td>
</tr>
<tr>
<td>86</td>
<td>N/A</td>
<td>N/A</td>
<td>uli</td>
</tr>
<tr>
<td>87</td>
<td>N/A</td>
<td>N/A</td>
<td>f_teid</td>
</tr>
<tr>
<td>88</td>
<td>N/A</td>
<td>N/A</td>
<td>tmsi</td>
</tr>
<tr>
<td>Value</td>
<td>Version 0</td>
<td>Version 1</td>
<td>Version 2</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>89</td>
<td>N/A</td>
<td>N/A</td>
<td>cn_id</td>
</tr>
<tr>
<td>90</td>
<td>N/A</td>
<td>N/A</td>
<td>s103pdf</td>
</tr>
<tr>
<td>91</td>
<td>N/A</td>
<td>N/A</td>
<td>s1udf</td>
</tr>
<tr>
<td>92</td>
<td>N/A</td>
<td>N/A</td>
<td>delay_value</td>
</tr>
<tr>
<td>93</td>
<td>N/A</td>
<td>N/A</td>
<td>bearer_context</td>
</tr>
<tr>
<td>94</td>
<td>N/A</td>
<td>N/A</td>
<td>charging_id</td>
</tr>
<tr>
<td>95</td>
<td>N/A</td>
<td>N/A</td>
<td>charging_char</td>
</tr>
<tr>
<td>96</td>
<td>N/A</td>
<td>N/A</td>
<td>trace_info</td>
</tr>
<tr>
<td>97</td>
<td>N/A</td>
<td>N/A</td>
<td>bearer_flag</td>
</tr>
<tr>
<td>99</td>
<td>N/A</td>
<td>N/A</td>
<td>pdn_type</td>
</tr>
<tr>
<td>100</td>
<td>N/A</td>
<td>N/A</td>
<td>pti</td>
</tr>
<tr>
<td>101</td>
<td>N/A</td>
<td>N/A</td>
<td>drx_parameter</td>
</tr>
<tr>
<td>103</td>
<td>N/A</td>
<td>N/A</td>
<td>gsm_key_tri</td>
</tr>
<tr>
<td>104</td>
<td>N/A</td>
<td>N/A</td>
<td>umts_key_cipher_quin</td>
</tr>
<tr>
<td>105</td>
<td>N/A</td>
<td>N/A</td>
<td>gsm_key_cipher_quin</td>
</tr>
<tr>
<td>106</td>
<td>N/A</td>
<td>N/A</td>
<td>umts_key_quin</td>
</tr>
<tr>
<td>107</td>
<td>N/A</td>
<td>N/A</td>
<td>eps_quad</td>
</tr>
<tr>
<td>108</td>
<td>N/A</td>
<td>N/A</td>
<td>umts_key_quad_quin</td>
</tr>
<tr>
<td>109</td>
<td>N/A</td>
<td>N/A</td>
<td>pdn_connection</td>
</tr>
<tr>
<td>110</td>
<td>N/A</td>
<td>N/A</td>
<td>pdn_number</td>
</tr>
<tr>
<td>111</td>
<td>N/A</td>
<td>N/A</td>
<td>p_tmsi</td>
</tr>
<tr>
<td>112</td>
<td>N/A</td>
<td>N/A</td>
<td>p_tmsi_sig</td>
</tr>
<tr>
<td>113</td>
<td>N/A</td>
<td>N/A</td>
<td>hop_counter</td>
</tr>
<tr>
<td>114</td>
<td>N/A</td>
<td>N/A</td>
<td>ue_time_zone</td>
</tr>
<tr>
<td>115</td>
<td>N/A</td>
<td>N/A</td>
<td>trace_ref</td>
</tr>
<tr>
<td>116</td>
<td>N/A</td>
<td>N/A</td>
<td>complete_request_msg</td>
</tr>
<tr>
<td>117</td>
<td>N/A</td>
<td>N/A</td>
<td>guti</td>
</tr>
<tr>
<td>118</td>
<td>N/A</td>
<td>N/A</td>
<td>f_container</td>
</tr>
<tr>
<td>Value</td>
<td>Version 0</td>
<td>Version 1</td>
<td>Version 2</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>119</td>
<td>N/A</td>
<td>N/A</td>
<td>f_cause</td>
</tr>
<tr>
<td>120</td>
<td>N/A</td>
<td>N/A</td>
<td>plmn_id</td>
</tr>
<tr>
<td>121</td>
<td>N/A</td>
<td>N/A</td>
<td>target_id</td>
</tr>
<tr>
<td>122</td>
<td>N/A</td>
<td>N/A</td>
<td>packet_flow_id</td>
</tr>
<tr>
<td>123</td>
<td>N/A</td>
<td>N/A</td>
<td>rab_context</td>
</tr>
<tr>
<td>124</td>
<td>N/A</td>
<td>N/A</td>
<td>src_rnc_pdcap</td>
</tr>
<tr>
<td>125</td>
<td>N/A</td>
<td>N/A</td>
<td>udp_src_port</td>
</tr>
<tr>
<td>126</td>
<td>N/A</td>
<td>N/A</td>
<td>apn_restriction</td>
</tr>
<tr>
<td>127</td>
<td>charge_id</td>
<td>charge_id</td>
<td>selection_mode</td>
</tr>
<tr>
<td>128</td>
<td>end_user_address</td>
<td>end_user_address</td>
<td>src_id</td>
</tr>
<tr>
<td>129</td>
<td>mm_context</td>
<td>mm_context</td>
<td>apn_change_report_action</td>
</tr>
<tr>
<td>130</td>
<td>pdp_context</td>
<td>pdp_context</td>
<td>protocol_config</td>
</tr>
<tr>
<td>131</td>
<td>apn</td>
<td>apn</td>
<td>fq_csid</td>
</tr>
<tr>
<td>132</td>
<td>gsn</td>
<td>gsn</td>
<td>channel</td>
</tr>
<tr>
<td>133</td>
<td>msisdn</td>
<td>msisdn</td>
<td>emlpp_pri</td>
</tr>
<tr>
<td>134</td>
<td>N/A</td>
<td>qos</td>
<td>node_type</td>
</tr>
<tr>
<td>135</td>
<td>N/A</td>
<td>authentication_qu</td>
<td>fqdn</td>
</tr>
<tr>
<td>136</td>
<td>N/A</td>
<td>tft</td>
<td>ti</td>
</tr>
<tr>
<td>137</td>
<td>N/A</td>
<td>target_id</td>
<td>mbms_session_duration</td>
</tr>
<tr>
<td>138</td>
<td>N/A</td>
<td>utran_trans</td>
<td>mbms_service_area</td>
</tr>
<tr>
<td>139</td>
<td>N/A</td>
<td>rab_setup</td>
<td>mbms_session_id</td>
</tr>
<tr>
<td>140</td>
<td>N/A</td>
<td>ext_header</td>
<td>mbms_flow_id</td>
</tr>
<tr>
<td>141</td>
<td>N/A</td>
<td>trigger_id</td>
<td>mbms_ip_multicast</td>
</tr>
<tr>
<td>142</td>
<td>N/A</td>
<td>ome_id</td>
<td>mbms_distribution_ack</td>
</tr>
<tr>
<td>143</td>
<td>N/A</td>
<td>ran_trans</td>
<td>rfs_p_index</td>
</tr>
<tr>
<td>144</td>
<td>N/A</td>
<td>pdp_context_pri</td>
<td>uci</td>
</tr>
<tr>
<td>145</td>
<td>N/A</td>
<td>addi_rab_setup</td>
<td>csg_info</td>
</tr>
<tr>
<td>146</td>
<td>N/A</td>
<td>sgsn_number</td>
<td>csg_id</td>
</tr>
<tr>
<td>147</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Version 0</td>
<td>Version 1</td>
<td>Version 2</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>148</td>
<td>N/A</td>
<td>common_flag</td>
<td>cmi</td>
</tr>
<tr>
<td>149</td>
<td>N/A</td>
<td>apn_restriction</td>
<td>service_indicator</td>
</tr>
<tr>
<td>150</td>
<td>N/A</td>
<td>radio_priority_lcs</td>
<td>detach_type</td>
</tr>
<tr>
<td>151</td>
<td>N/A</td>
<td>rat_type</td>
<td>ldn</td>
</tr>
<tr>
<td>152</td>
<td>N/A</td>
<td>user_loc_info</td>
<td>node_feature</td>
</tr>
<tr>
<td>153</td>
<td>N/A</td>
<td>ms_time_zone</td>
<td>mbms_time_to_transfer</td>
</tr>
<tr>
<td>154</td>
<td>N/A</td>
<td>imei_sv</td>
<td>throttling</td>
</tr>
<tr>
<td>155</td>
<td>N/A</td>
<td>camel</td>
<td>arp</td>
</tr>
<tr>
<td>156</td>
<td>N/A</td>
<td>mbms_ue_context</td>
<td>epc_timer</td>
</tr>
<tr>
<td>157</td>
<td>N/A</td>
<td>tmp_mobile_group_id</td>
<td>signalling_priority_indication</td>
</tr>
<tr>
<td>158</td>
<td>N/A</td>
<td>rim_routing_addr</td>
<td>tmgi</td>
</tr>
<tr>
<td>159</td>
<td>N/A</td>
<td>mbms_config</td>
<td>mm_srvcc</td>
</tr>
<tr>
<td>160</td>
<td>N/A</td>
<td>mbms_service_area</td>
<td>flags_srvcc</td>
</tr>
<tr>
<td>161</td>
<td>N/A</td>
<td>src_rnc_pdc</td>
<td>nmbr</td>
</tr>
<tr>
<td>162</td>
<td>N/A</td>
<td>addi_trace_info</td>
<td>N/A</td>
</tr>
<tr>
<td>163</td>
<td>N/A</td>
<td>hop_counter</td>
<td>N/A</td>
</tr>
<tr>
<td>164</td>
<td>N/A</td>
<td>plmn_id</td>
<td>N/A</td>
</tr>
<tr>
<td>165</td>
<td>N/A</td>
<td>mbms_session_id</td>
<td>N/A</td>
</tr>
<tr>
<td>166</td>
<td>N/A</td>
<td>mbms_2g3g_indicator</td>
<td>N/A</td>
</tr>
<tr>
<td>167</td>
<td>N/A</td>
<td>enhanced_nsapi</td>
<td>N/A</td>
</tr>
<tr>
<td>168</td>
<td>N/A</td>
<td>mbms_session_duration</td>
<td>N/A</td>
</tr>
<tr>
<td>169</td>
<td>N/A</td>
<td>addi_mbms_trace_info</td>
<td>N/A</td>
</tr>
<tr>
<td>170</td>
<td>N/A</td>
<td>mbms_session_repetition_num</td>
<td>N/A</td>
</tr>
<tr>
<td>171</td>
<td>N/A</td>
<td>mbms_time_to_data</td>
<td>N/A</td>
</tr>
<tr>
<td>173</td>
<td>N/A</td>
<td>bss</td>
<td>N/A</td>
</tr>
<tr>
<td>174</td>
<td>N/A</td>
<td>cell_id</td>
<td>N/A</td>
</tr>
<tr>
<td>175</td>
<td>N/A</td>
<td>pdu_num</td>
<td>N/A</td>
</tr>
<tr>
<td>177</td>
<td>N/A</td>
<td>mbms_bearer_capab</td>
<td>N/A</td>
</tr>
<tr>
<td>Value</td>
<td>Version 0</td>
<td>Version 1</td>
<td>Version 2</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>178</td>
<td>N/A</td>
<td>rim_routing_disc</td>
<td>N/A</td>
</tr>
<tr>
<td>179</td>
<td>N/A</td>
<td>list_pfc</td>
<td>N/A</td>
</tr>
<tr>
<td>180</td>
<td>N/A</td>
<td>ps_xid</td>
<td>N/A</td>
</tr>
<tr>
<td>181</td>
<td>N/A</td>
<td>ms_info_change_report</td>
<td>N/A</td>
</tr>
<tr>
<td>182</td>
<td>N/A</td>
<td>direct_tunnel_flags</td>
<td>N/A</td>
</tr>
<tr>
<td>183</td>
<td>N/A</td>
<td>correlation_id</td>
<td>N/A</td>
</tr>
<tr>
<td>184</td>
<td>N/A</td>
<td>bearer_control_mode</td>
<td>N/A</td>
</tr>
<tr>
<td>185</td>
<td>N/A</td>
<td>mbms_flow_id</td>
<td>N/A</td>
</tr>
<tr>
<td>186</td>
<td>N/A</td>
<td>mbms_ip_multicast</td>
<td>N/A</td>
</tr>
<tr>
<td>187</td>
<td>N/A</td>
<td>mbms_distribution_ack</td>
<td>N/A</td>
</tr>
<tr>
<td>188</td>
<td>N/A</td>
<td>reliable_inter_rat_handover</td>
<td>N/A</td>
</tr>
<tr>
<td>189</td>
<td>N/A</td>
<td>rfs_index</td>
<td>N/A</td>
</tr>
<tr>
<td>190</td>
<td>N/A</td>
<td>fqdn</td>
<td>N/A</td>
</tr>
<tr>
<td>191</td>
<td>N/A</td>
<td>evolved_allocation1</td>
<td>N/A</td>
</tr>
<tr>
<td>192</td>
<td>N/A</td>
<td>evolved_allocation2</td>
<td>N/A</td>
</tr>
<tr>
<td>193</td>
<td>N/A</td>
<td>extended_flags</td>
<td>N/A</td>
</tr>
<tr>
<td>194</td>
<td>N/A</td>
<td>uci</td>
<td>N/A</td>
</tr>
<tr>
<td>195</td>
<td>N/A</td>
<td>csg_info</td>
<td>N/A</td>
</tr>
<tr>
<td>196</td>
<td>N/A</td>
<td>csg_id</td>
<td>N/A</td>
</tr>
<tr>
<td>197</td>
<td>N/A</td>
<td>cmi</td>
<td>N/A</td>
</tr>
<tr>
<td>198</td>
<td>N/A</td>
<td>apn_ambr</td>
<td>N/A</td>
</tr>
<tr>
<td>199</td>
<td>N/A</td>
<td>ue_network</td>
<td>N/A</td>
</tr>
<tr>
<td>200</td>
<td>N/A</td>
<td>ue_ambr</td>
<td>N/A</td>
</tr>
<tr>
<td>201</td>
<td>N/A</td>
<td>apn_ambr_nsapi</td>
<td>N/A</td>
</tr>
<tr>
<td>202</td>
<td>N/A</td>
<td>ggsn_backoff_timer</td>
<td>N/A</td>
</tr>
<tr>
<td>203</td>
<td>N/A</td>
<td>signalling_priority_indication</td>
<td>N/A</td>
</tr>
<tr>
<td>204</td>
<td>N/A</td>
<td>signalling_priority_indication_nsapi</td>
<td>N/A</td>
</tr>
<tr>
<td>205</td>
<td>N/A</td>
<td>high_bitrate</td>
<td>N/A</td>
</tr>
</tbody>
</table>
SCADA Keywords

The rules engine uses Modbus and DNP3 rules to access certain protocol fields.

Modbus Keywords

You can use Modbus keywords alone or in combination with other keywords such as content and byte_jump.

**modbus_data**

You can use the `modbus_data` keyword to point to the beginning of the Data field in a Modbus request or response.

**modbus_func**

You can use the `modbus_func` keyword to match against the Function Code field in a Modbus application layer request or response header. You can specify either a single defined decimal value or a single defined string for a Modbus function code.

The following table lists the defined values and strings recognized by the system for Modbus function codes.

**Table 148: Modbus Function Codes**

<table>
<thead>
<tr>
<th>Value</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>read_coils</td>
</tr>
<tr>
<td>2</td>
<td>read_discrete_inputs</td>
</tr>
<tr>
<td>3</td>
<td>read_holding_registers</td>
</tr>
<tr>
<td>4</td>
<td>read_input_registers</td>
</tr>
<tr>
<td>5</td>
<td>write_single_coil</td>
</tr>
<tr>
<td>6</td>
<td>write_single_register</td>
</tr>
<tr>
<td>7</td>
<td>read_exception_status</td>
</tr>
<tr>
<td>8</td>
<td>diagnostics</td>
</tr>
<tr>
<td>11</td>
<td>get_comm_event_counter</td>
</tr>
<tr>
<td>12</td>
<td>get_comm_event_log</td>
</tr>
<tr>
<td>15</td>
<td>write_multiple_coils</td>
</tr>
</tbody>
</table>
DNP3 Keywords

You can use the `modbus_unit` keyword to match a single decimal value against the Unit ID field in a Modbus request or response header.

DNP3 Keywords

You can use DNP3 keywords alone or in combination with other keywords such as `content` and `byte_jump`.

**dnp3_data**

You can use the `dnp3_data` keyword to point to the beginning of reassembled DNP3 application layer fragments. The DNP3 preprocessor reassembles link layer frames into application layer fragments. The `dnp3_data` keyword points to the beginning of each application layer fragment; other rule options can match against the reassembled data within fragments without separating the data and adding checksums every 16 bytes.

**dnp3_func**

You can use the `dnp3_func` keyword to match against the Function Code field in a DNP3 application layer request or response header. You can specify either a single defined decimal value or a single defined string for a DNP3 function code.

The following table lists the defined values and strings recognized by the system for DNP3 function codes.

### Table 149: DNP3 Function Codes

<table>
<thead>
<tr>
<th>Value</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>confirm</td>
</tr>
<tr>
<td>1</td>
<td>read</td>
</tr>
<tr>
<td>2</td>
<td>write</td>
</tr>
<tr>
<td>3</td>
<td>select</td>
</tr>
</tbody>
</table>

You can use the `modbus_unit` keyword to match a single decimal value against the Unit ID field in a Modbus request or response header.

The following table lists the defined values and strings recognized by the system for DNP3 function codes.
<table>
<thead>
<tr>
<th>Value</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>operate</td>
</tr>
<tr>
<td>5</td>
<td>direct_operate</td>
</tr>
<tr>
<td>6</td>
<td>direct_operate_nr</td>
</tr>
<tr>
<td>7</td>
<td>immed_freeze</td>
</tr>
<tr>
<td>8</td>
<td>immed_freeze_nr</td>
</tr>
<tr>
<td>9</td>
<td>freeze_clear</td>
</tr>
<tr>
<td>10</td>
<td>freeze_clear_nr</td>
</tr>
<tr>
<td>11</td>
<td>freeze_at_time</td>
</tr>
<tr>
<td>12</td>
<td>freeze_at_time_nr</td>
</tr>
<tr>
<td>13</td>
<td>cold_restart</td>
</tr>
<tr>
<td>14</td>
<td>warm_restart</td>
</tr>
<tr>
<td>15</td>
<td>initialize_data</td>
</tr>
<tr>
<td>16</td>
<td>initialize_appl</td>
</tr>
<tr>
<td>17</td>
<td>start_appl</td>
</tr>
<tr>
<td>18</td>
<td>stop_appl</td>
</tr>
<tr>
<td>19</td>
<td>save_config</td>
</tr>
<tr>
<td>20</td>
<td>enable_unsolicited</td>
</tr>
<tr>
<td>21</td>
<td>disable_unsolicited</td>
</tr>
<tr>
<td>22</td>
<td>assign_class</td>
</tr>
<tr>
<td>23</td>
<td>delay_measure</td>
</tr>
<tr>
<td>24</td>
<td>record_current_time</td>
</tr>
<tr>
<td>25</td>
<td>open_file</td>
</tr>
<tr>
<td>26</td>
<td>close_file</td>
</tr>
<tr>
<td>27</td>
<td>delete_file</td>
</tr>
<tr>
<td>28</td>
<td>get_file_info</td>
</tr>
<tr>
<td>29</td>
<td>authenticate_file</td>
</tr>
<tr>
<td>30</td>
<td>abort_file</td>
</tr>
<tr>
<td>31</td>
<td>activate_config</td>
</tr>
</tbody>
</table>
You can use the `dnp3_ind` keyword to match against flags in the Internal Indications field in a DNP3 application layer response header.

You can specify the string for a single known flag or a comma-separated list of flags, as seen in the following example:

```
class_1_events, class_2_events
```

When you specify multiple flags, the keyword matches against any flag in the list. To detect a combination of flags, use the `dnp3_ind` keyword multiple times in a rule.

The following list provides the string syntax recognized by the system for defined DNP3 internal indications flags.

```
class_1_events
class_2_events
class_3_events
need_time
local_control
device_trouble
device_restart
no_func_code_support
object_unknown
parameter_error
event_buffer_overflow
already_executing
config_corrupt
reserved_2
reserved_1
```

You can use the `dnp3_obj` keyword to match against DNP3 object headers in a request or response.

DNP3 data is comprised of a series of DNP3 objects of different types such as analog input, binary input, and so on. Each type is identified with a `group` such as analog input group, binary input group, and so on, each of which can be identified by a decimal value. The objects in each group are further identified by an `object variation` such as 16-bit integers, 32-bit integers, short floating point, and so on, each of which specifies the data format of the object. Each type of object variation can also be identified by a decimal value.

You identify object headers by specifying the decimal number for the type of object header group and the decimal number for the type of object variation. The combination of the two defines a specific type of DNP3 object.
Packet Characteristics

You can write rules that only generate events against packets with specific packet characteristics.

**ds**

The *ds* keyword tests the packet payload size. With it, you can use the greater than and less than operators (*<* and *>* ) to specify a range of values. You can use the following syntax to specify ranges:

- `>number_of_bytes`
- `<number_of_bytes`
- `number_of_bytes<>number_of_bytes`

For example, to indicate a packet size greater than 400 bytes, use `>400` as the *dtype* value. To indicate a packet size of less than 500 bytes, use `<500`. To specify that the rule trigger against any packet between 400 and 500 bytes inclusive, use `400<>500`.

---

**Caution**
The *ds* keyword tests packets before they are decoded by any preprocessors.

**isdataat**

The *isdataat* keyword instructs the rules engine to verify that data resides at a specific location in the payload.

The following table lists the arguments you can use with the *isdataat* keyword.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offset</td>
<td>Required</td>
<td>The specific location in the payload. For example, to test that data appears at byte 50 in the packet payload, you would specify <code>50</code> as the offset value. A <code>!</code> modifier negates the results of the <em>isdataat</em> test; it alerts if a certain amount of data is not present within the payload. You can also use an existing <em>byte_extract</em> variable to specify the value for this argument.</td>
</tr>
<tr>
<td>Relative</td>
<td>Optional</td>
<td>Makes the location relative to the last successful content match. If you specify a relative location, note that the counter starts at byte 0, so calculate the location by subtracting 1 from the number of bytes you want to move forward from the last successful content match. For example, to specify that the data must appear at the ninth byte after the last successful content match, you would specify a relative offset of 8.</td>
</tr>
<tr>
<td>Raw Data</td>
<td>Optional</td>
<td>Specifies that the data is located in the original packet payload before decoding or application layer normalization by any Firepower System preprocessor. You can use this argument with <em>Relative</em> if the previous content match was in the raw packet data.</td>
</tr>
</tbody>
</table>

For example, in a rule searching for the content *foo*, if the value for *isdataat* is specified as the following:

- Offset = `!10`
- Relative = enabled

The system alerts if the rules engine does not detect 10 bytes after *foo* before the payload ends.
sameip

The sameip keyword tests that a packet’s source and destination IP addresses are the same. It does not take an argument.

fragoffset

The fragoffset keyword tests the offset of a fragmented packet. This is useful because some exploits (such as WinNuke denial-of-service attacks) use hand-generated packet fragments that have specific offsets.

For example, to test whether the offset of a fragmented packet is 31337 bytes, specify 31337 as the fragoffset value.

You can use the following operators when specifying arguments for the fragoffset keyword.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>not</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
</tr>
<tr>
<td>&lt;</td>
<td>less than</td>
</tr>
</tbody>
</table>

Note that you cannot use the not ( ! ) operator in combination with < or >.

cvs

The cvs keyword tests Concurrent Versions System (CVS) traffic for malformed CVS entries. An attacker can use a malformed entry to force a heap overflow and execute malicious code on the CVS server. This keyword can be used to identify attacks against two known CVS vulnerabilities: CVE-2004-0396 (CVS 1.11.x up to 1.11.15, and 1.12.x up to 1.12.7) and CVS-2004-0414 (CVS 1.12.x through 1.12.8, and 1.11.x through 1.11.16). The cvs keyword checks for a well-formed entry, and generates alerts when a malformed entry is detected.

Your rule should include the ports where CVS runs. In addition, any ports where traffic may occur should be added to the list of ports for stream reassembly in your TCP policies so state can be maintained for CVS sessions. The TCP ports 2401 ( pserver ) and 514 ( rsh ) are included in the list of client ports where stream reassembly occurs. However, note that if your server runs as an xinetd server (i.e., pserver), it can run on any TCP port. Add any non-standard ports to the stream reassembly Client Ports list.

Related Topics

- The byte_extract Keyword, on page 967
- TCP Stream Preprocessing Options, on page 1161

Active Response Keywords

The resp and react keywords provide two approaches to initiating active responses. An intrusion rule that contains either keyword initiates a single active response when a packet triggers the rule. Active response keywords initiate active responses to close TCP connections in response to triggered TCP rules or UDP sessions in response to triggered UDP rules. See Active Responses in Intrusion Drop Rules, on page 1140. Active responses are not intended to take the place of a firewall for a number of reasons, including that an attacker may have chosen to ignore or circumvent active responses.
Active responses are supported in inline, including routed or transparent, deployments. For example, in response to the `react` keyword in an inline deployment, the system can insert a TCP reset (RST) packet directly into the traffic for each end of the connection, which normally should close the connection. Active responses are not supported or suited for passive deployments.

Because active responses can be routed back, the system does not allow TCP resets to initiate TCP resets; this prevents an unending sequence of active responses. The system also does not allow ICMP unreachable packets to initiate ICMP unreachable packets in keeping with standard practice.

You can configure the TCP stream preprocessor to detect additional traffic on a TCP connection after an intrusion rule has triggered an active response. When the preprocessor detects additional traffic, it sends additional active responses up to a specified maximum to both ends of the connection or session. See Maximum Active Responses and Minimum Response Seconds in Advanced Transport/Network Preprocessor Options, on page 1141.

**Related Topics**

- Active Responses in Intrusion Drop Rules, on page 1140

### The resp Keyword

You can use the `resp` keyword to actively respond to TCP connections or UDP sessions, depending on whether you specify the TCP or UDP protocol in the rule header.

Keyword arguments allow you to specify the packet direction and whether to use TCP reset (RST) packets or ICMP unreachable packets as active responses.

You can use any of the TCP reset or ICMP unreachable arguments to close TCP connections. You should use only ICMP unreachable arguments to close UDP sessions.

Different TCP reset arguments also allow you to target active responses to the packet source, destination, or both. All ICMP unreachable arguments target the packet source and allow you to specify whether to use an ICMP network, host, or port unreachable packet, or all three.

The following table lists the arguments you can use with the `resp` keyword to specify exactly what you want the Firepower System to do when the rule triggers.

#### Table 152: resp Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reset_source</td>
<td>Directs a TCP reset packet to the endpoint that sent the packet that triggered the rule. Alternatively, you can specify <code>rst_snd</code>, which is supported for backward compatibility.</td>
</tr>
<tr>
<td>reset_dest</td>
<td>Directs a TCP reset packet to the intended destination endpoint of the packet that triggered the rule. Alternatively, you can specify <code>rst_rcv</code>, which is supported for backward compatibility.</td>
</tr>
<tr>
<td>reset_both</td>
<td>Directs a TCP reset packet to both the sending and receiving endpoints. Alternatively, you can specify <code>rst_all</code>, which is supported for backward compatibility.</td>
</tr>
<tr>
<td>icmp_net</td>
<td>Directs an ICMP network unreachable message to the sender.</td>
</tr>
<tr>
<td>icmp_host</td>
<td>Directs an ICMP host unreachable message to the sender.</td>
</tr>
<tr>
<td>icmp_port</td>
<td>Directs an ICMP port unreachable message to the sender. This argument is used to terminate UDP traffic.</td>
</tr>
</tbody>
</table>
**The react Keyword**

You can use the `react` keyword to send a default HTML page to the TCP connection client when a packet triggers the rule; after sending the HTML page, the system uses TCP reset packets to initiate active responses to both ends of the connection. The `react` keyword does not trigger active responses for UDP traffic.

Optionally, you can specify the following argument:

**msg**

When a packet triggers a `react` rule that uses the `msg` argument, the HTML page includes the rule event message.

If you do not specify the `msg` argument, the HTML page includes the following message:

*You are attempting to access a forbidden site.*

*Consult your system administrator for details.*

**Note**

Because active responses can be routed back, ensure that the HTML response page does not trigger a `react` rule; this could result in an unending sequence of active responses. Cisco recommends that you test `react` rules extensively before activating them in a production environment.

**Related Topics**

- Rule Anatomy, on page 928
- The config response Command

**The detection_filter Keyword**

You can use the `detection_filter` keyword to prevent a rule from generating events unless a specified number of packets trigger the rule within a specified time. This can stop the rule from prematurely generating
events. For example, two or three failed login attempts within a few seconds could be expected behavior, but a large number of attempts within the same time could indicate a brute force attack.

The `detection_filter` keyword requires arguments that define whether the system tracks the source or destination IP address, the number of times the detection criteria must be met before triggering an event, and how long to continue the count.

Use the following syntax to delay the triggering of events:

```
track by_src/by_dst, count count, seconds number_of_seconds
```

The `track` argument specifies whether to use the packet’s source or destination IP address when counting the number of packets that meet the rule’s detection criteria. Select from the argument values described in the following table to specify how the system tracks event instances.

**Table 153: detection_filter Track Arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>by_src</td>
<td>Detection criteria count by source IP address.</td>
</tr>
<tr>
<td>by_dst</td>
<td>Detection criteria count by destination IP address.</td>
</tr>
</tbody>
</table>

The `count` argument specifies the number of packets that must trigger the rule for the specified IP address within the specified time before the rule generates an event.

The `seconds` argument specifies the number of seconds within which the specified number of packets must trigger the rule before the rule generates an event.

Consider the case of a rule that searches packets for the content `foo` and uses the `detection_filter` keyword with the following arguments:

```
track by_src, count 10, seconds 20
```

In the example, the rule will not generate an event until it has detected `foo` in 10 packets within 20 seconds from a given source IP address. If the system detects only 7 packets containing `foo` within the first 20 seconds, no event is generated. However, if `foo` occurs 40 times in the first 20 seconds, the rule generates 30 events and the count begins again when 20 seconds have elapsed.

### Comparing the threshold and detection_filter Keywords

The `detection_filter` keyword replaces the deprecated `threshold` keyword. The `threshold` keyword is still supported for backward compatibility and operates the same as thresholds that you set within an intrusion policy.

The `detection_filter` keyword is a detection feature that is applied before a packet triggers a rule. The rule does not generate an event for triggering packets detected before the specified packet count and, in an inline deployment, does not drop those packets if the rule is set to drop packets. Conversely, the rule does generate events for packets that trigger the rule and occur after the specified packet count and, in an inline deployment, drops those packets if the rule is set to drop packets.

Thresholding is an event notification feature that does not result in a detection action. It is applied after a packet triggers an event. In an inline deployment, a rule that is set to drop packets drops all packets that trigger the rule, independent of the rule threshold.

Note that you can use the `detection_filter` keyword in any combination with the intrusion event thresholding, intrusion event suppression, and rate-based attack prevention features in an intrusion policy. Note also that
policy validation fails if you enable an imported local rule that uses the deprecated `threshold` keyword in combination with the intrusion event thresholding feature in an intrusion policy.

**Related Topics**
- Intrusion Event Thresholds, on page 890
- Intrusion Policy Suppression Configuration, on page 894
- Setting a Dynamic Rule State from the Rules Page, on page 898
- Guidelines for Importing Local Intrusion Rules, on page 128

## The tag Keyword

Use the `tag` keyword to tell the system to log additional traffic for the host or session. Use the following syntax when specifying the type and amount of traffic you want to capture using the `tag` keyword:

```
tagging_type, count, metric, optional_direction
```

The next three tables describe the other available arguments.

You can choose from two types of tagging. The following table describes the two types of tagging. Note that the session tag argument type causes the system to log packets from the same session as if they came from different sessions if you configure only rule header options in the intrusion rule. To group packets from the same session together, configure one or more rule options (such as a `flag` keyword or `content` keyword) within the same intrusion rule.

**Table 154: Tag Arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>session</td>
<td>Logs packets in the session that triggered the rule.</td>
</tr>
<tr>
<td>host</td>
<td>Logs packets from the host that sent the packet that triggered the rule. You can add a directional modifier to log only the traffic coming from the host (src) or going to the host (dst).</td>
</tr>
</tbody>
</table>

To indicate how much traffic you want to log, use the following argument:

**Table 155: Count Argument**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>count</td>
<td>The number of packets or seconds you want to log after the rule triggers. This unit of measure is specified with the metric argument, which follows the count argument.</td>
</tr>
</tbody>
</table>

Select the metric you want to use to log by time or volume of traffic from those described in the following table.

**Caution**

High-bandwidth networks can see thousands of packets per second, and tagging a large number of packets may seriously affect performance, so make sure you tune this setting for your network environment.
Table 156: Logging Metrics Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>packets</td>
<td>Logs the number of packets specified by the count after the rule triggers.</td>
</tr>
<tr>
<td>seconds</td>
<td>Logs traffic for the number of seconds specified by the count after the rule triggers.</td>
</tr>
</tbody>
</table>

For example, when a rule with the following `tag` keyword value triggers:

```
host, 30, seconds, dst
```

all packets that are transmitted from the client to the host for the next 30 seconds are logged.

The flowbits Keyword

Use the `flowbits` keyword to assign state names to sessions. By analyzing subsequent packets in a session according to the previously named state, the system can detect and alert on exploits that span multiple packets in a single session.

The `flowbits` state name is a user-defined label assigned to packets in a specific part of a session. You can label packets with state names based on packet content to help distinguish malicious packets from those you do not want to alert on. You can define up to 1024 state names per managed device. For example, if you want to alert on malicious packets that you know only occur after a successful login, you can use the `flowbits` keyword to filter out the packets that constitute an initial login attempt so you can focus only on the malicious packets. You can do this by first creating a rule that labels all packets in the session that have an established login with a `logged_in` state, then creating a second rule where `flowbits` checks for packets with the state you set in the first rule and acts only on those packets.

An optional `group name` allows you to include a state name in a group of states. A state name can belong to several groups. States not associated with a group are not mutually exclusive, so a rule that triggers and sets a state that is not associated with a group does not affect other currently set states.

flowbits Keyword Options

The following table describes the various combinations of operators, states, and groups available to the `flowbits` keyword. Note that state names can contain alphanumeric characters, periods (.), underscores (_), and dashes (-).

Table 157: flowbits Options

<table>
<thead>
<tr>
<th>Operator</th>
<th>State Option</th>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>set</td>
<td>state_name</td>
<td>optional</td>
<td>Sets the specified state for a packet. Sets the state in the specified group if a group is defined.</td>
</tr>
<tr>
<td>set</td>
<td>state_name&amp;state_name</td>
<td>optional</td>
<td>Sets the specified states for a packet. Sets the states in the specified group if a group is defined.</td>
</tr>
<tr>
<td>setx</td>
<td>state_name</td>
<td>mandatory</td>
<td>Sets the specified state in the specified group for a packet, and unsets all other states in the group.</td>
</tr>
<tr>
<td>setx</td>
<td>state_name&amp;state_name</td>
<td>mandatory</td>
<td>Sets the specified states in the specified group for a packet, and unsets all other states in the group.</td>
</tr>
</tbody>
</table>
### Guidelines for Using the flowbits Keyword

Note the following when using the `flowbits` keyword:

<table>
<thead>
<tr>
<th>Operator</th>
<th>State Option</th>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>unset</td>
<td>state_name</td>
<td>no group</td>
<td>Unsets the specified state for a packet.</td>
</tr>
<tr>
<td>unset</td>
<td>state_name&amp;state_name</td>
<td>no group</td>
<td>Unsets the specified states for a packet.</td>
</tr>
<tr>
<td>unset</td>
<td>all</td>
<td>mandatory</td>
<td>Unsets all the states in the specified group.</td>
</tr>
<tr>
<td>toggle</td>
<td>state_name</td>
<td>no group</td>
<td>Unsets the specified state if it is set, and sets the specified state if it is unset.</td>
</tr>
<tr>
<td>toggle</td>
<td>state_name&amp;state_name</td>
<td>no group</td>
<td>Unsets the specified states if they are set, and sets the specified states if they are unset.</td>
</tr>
<tr>
<td>toggle</td>
<td>all</td>
<td>mandatory</td>
<td>Unsets all states set in the specified group, and sets all states unset in the specified group.</td>
</tr>
<tr>
<td>isset</td>
<td>state_name</td>
<td>no group</td>
<td>Determines if the specified state is set in the packet.</td>
</tr>
<tr>
<td>isset</td>
<td>state_name&amp;state_name</td>
<td>no group</td>
<td>Determines if the specified states are set in the packet.</td>
</tr>
<tr>
<td>isset</td>
<td>state_name</td>
<td>state_name</td>
<td>no group</td>
</tr>
<tr>
<td>isset</td>
<td>any</td>
<td>mandatory</td>
<td>Determines if any state is set in the specified group.</td>
</tr>
<tr>
<td>isset</td>
<td>all</td>
<td>mandatory</td>
<td>Determines if all states are set in the specified group.</td>
</tr>
<tr>
<td>isnotset</td>
<td>state_name</td>
<td>no group</td>
<td>Determines if the specified state is not set in the packet.</td>
</tr>
<tr>
<td>isnotset</td>
<td>state_name&amp;state_name</td>
<td>no group</td>
<td>Determines if the specified states are not set in the packet.</td>
</tr>
<tr>
<td>isnotset</td>
<td>state_name</td>
<td>state_name</td>
<td>no group</td>
</tr>
<tr>
<td>isnotset</td>
<td>any</td>
<td>mandatory</td>
<td>Determines if any state is not set in the packet.</td>
</tr>
<tr>
<td>isnotset</td>
<td>all</td>
<td>mandatory</td>
<td>Determines if all states are not set in the packet.</td>
</tr>
<tr>
<td>reset</td>
<td>(no state)</td>
<td>optional</td>
<td>Unsets all states for all packets. Unsets all states in a group if a group is specified.</td>
</tr>
<tr>
<td>noalert</td>
<td>(no state)</td>
<td>no group</td>
<td>Use this in conjunction with any other operator to suppress event generation.</td>
</tr>
</tbody>
</table>
When using the setx operator, the specified state can only belong to the specified group, and not to any other group.

You can define the setx operator multiple times, specifying different states and the same group with each instance.

When you use the setx operator and specify a group, you cannot use the set, toggle, or unset operators on that specified group.

The isset and isnotset operators evaluate for the specified state regardless of whether the state is in a group.

During intrusion policy saves, intrusion policy reapplies, and access control policy applies (regardless of whether the access control policy references one intrusion policy or multiple intrusion policies), if you enable a rule that contains the isset or isnotset operator without a specified group, and you do not enable at least one rule that affects flowbits assignment (set, setx, unset, toggle) for the corresponding state name and protocol, all rules that affect flowbits assignment for the corresponding state name are enabled.

During intrusion policy saves, intrusion policy reapplies, and access control policy applies (regardless of whether the access control policy references one intrusion policy or multiple intrusion policies), if you enable a rule that contains the isset or isnotset operator with a specified group, all rules that affect flowbits assignment (set, setx, unset, toggle) and define a corresponding group name are also enabled.

**flowbits Keyword Examples**

This section provides three examples that use the flowbits keyword.

**flowbits Keyword Example: A Configuration Using state_name**

This is an example of a flowbits configuration using state_name. Consider the IMAP vulnerability described in Bugtraq ID #1110. This vulnerability exists in an implementation of IMAP, specifically in the LIST, LSUB, RENAME, FIND, and COPY commands. However, to take advantage of the vulnerability, the attacker must be logged into the IMAP server. Because the LOGIN confirmation from the IMAP server and the exploit that follows are necessarily in different packets, it is difficult to construct non-flow-based rules that catch this exploit. Using the flowbits keyword, you can construct a series of rules that track whether the user is logged into the IMAP server and, if so, generate an event if one of the attacks is detected. If the user is not logged in, the attack cannot exploit the vulnerability and no event is generated.

The two rule fragments that follow illustrate this example. The first rule fragment looks for an IMAP login confirmation from the IMAP server:

```plaintext
alert tcp any 143 -> any any (msg:"IMAP login"; content:"OK LOGIN"; flowbits:set,logged_in; flowbits:noalert;)
```

The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
Note that `flowbits:set` sets a state of `logged_in`, while `flowbits:noalert` suppresses the alert because you are likely to see many innocuous login sessions on an IMAP server.

The next rule fragment looks for a LIST string, but does not generate an event unless the logged_in state has been set as a result of some previous packet in the session:

```plaintext
alert tcp any any -> any 143 (msg:"IMAP LIST";
content:"LIST"; flowbits:isset,logged_in;)
```

The following diagram illustrates the effect of the `flowbits` keyword in the preceding rule fragment:
In this case, if a previous packet has caused a rule containing the first fragment to trigger, then a rule containing the second fragment triggers and generates an event.

flowbits Keyword Example: A Configuration Resulting in False Positive Events

Including different state names that are set in different rules in a group can prevent false positive events that might otherwise occur when content in a subsequent packet matches a rule whose state is no longer valid. The following example illustrates how you can get false positives when you do not include multiple state names in a group.

Consider the case where the following three rule fragments trigger in the order shown during a single session:

```plaintext
(msg:"JPEG transfer";
 content:"image/";pcre:"/Content-Type\s*\s*\s*\s*image\s*\s*\.jpe?g/smi";
```

The following diagram illustrates the effect of the `flowbits` keyword in the preceding rule fragment:
The `content` and `pcre` keywords in the first rule fragment match a JPEG file download, `flowbits:set,http.jpeg` sets the `http.jpeg` flowbits state, and `flowbits:noalert` stops the rule from generating events. No event is generated because the rule’s purpose is to detect the file download and set the `flowbits` state so one or more companion rules can test for the state name in combination with malicious content and generate events when malicious content is detected.

The next rule fragment detects a GIF file download subsequent to the JPEG file download above:

```plaintext
{msg:"GIF transfer"; content:"image/";
pcre:"/Content-Type:x3A\{a*|a*r?\n\s+s+\}image\x2Fgif/smii";
flowbits:isset,http.jpg,image_downloads; flowbits:noalert;}
```

The following diagram illustrates the effect of the `flowbits` keyword in the preceding rule fragment:

The `content` and `pcre` keywords in the second rule match the GIF file download, `flowbits:set,http.jpg` sets the `http.jpg` flowbit state, and `flowbits:noalert` stops the rule from generating an event. Note that the `http.jpeg` state set by the first rule fragment is still set even though it is no longer needed; this is because the JPEG download must have ended if a subsequent GIF download has been detected.

The third rule fragment is a companion to the first rule fragment:

```plaintext
{msg:"JPEG exploit";?flowbits:isset,http.jpeg;content:"|FF|";
pcre:"?\xFF\xEF\x82\xED\xEF|\x00\{\x00|\x01\};"}
```

The following diagram illustrates the effect of the `flowbits` keyword in the preceding rule fragment:

In the third rule fragment, `flowbits:isset,http.jpeg` determines that the now-irrelevant `http.jpeg` state is set, and `content` and `pcre` match content that would be malicious in a JPEG file but not in a GIF file. The third rule fragment results in a false positive event for a nonexistent exploit in a JPEG file.
flowbits Keyword Example: A Configuration for Preventing False Positive Events

The following example illustrates how including state names in a group and using the `setx` operator can prevent false positives.

Consider the same case as the previous example, except that the first two rules now include their two different state names in the same state group.

```plaintext
(msg: "JPEG transfer";
  content: "image/";
  pcre: "/\Content-?Type\s*\s*\r?\n\s*image\x2fp?jpe?g/smi";
```

The following diagram illustrates the effect of the `flowbits` keyword in the preceding rule fragment:

When the first rule fragment detects a JPEG file download, the `flowbits: setx, http.jpeg, image_downloads` keyword sets the `flowbits` state to `http.jpeg` and includes the state in the `image_downloads` group.

The next rule then detects a subsequent GIF file download:

```plaintext
(msg: "GIF transfer"; content: "image/";
  pcre: "/\Content-?Type\s*\s*\r?\n\s*image\x2fgif/smi";
```

The following diagram illustrates the effect of the `flowbits` keyword in the preceding rule fragment:

When the second rule fragment matches the GIF download, the `flowbits: setx, http.jpeg, image_downloads` keyword sets the `http.jpeg` `flowbits` state and unsets `http.jpeg`, the other state in the group.

The third rule fragment does not result in a false positive:

```plaintext
(msg: "JPEG exploit"; ?flowbits: isset, http.jpeg; content: "|FF|";
  pcre: "/?\xFF\[\xE1\xE2\xED\xFE\]\x00\[\x00\x01]/";
)
```

The following diagram illustrates the effect of the `flowbits` keyword in the preceding rule fragment:
Because `flowbits:isset,http.jpeg` is false, the rules engine stops processing the rule and no event is generated, thus avoiding a false positive even in a case where content in the GIF file matches exploit content for a JPEG file.

## The `http_encode` Keyword

You can use the `http_encode` keyword to generate events on the type of encoding in an HTTP request or response before normalization, either in the HTTP URI, in non-cookie data in an HTTP header, in cookies in HTTP requests headers, or set-cookie data in HTTP responses.

You must configure the HTTP Inspect preprocessor to inspect HTTP responses and HTTP cookies to return matches for rules using the `http_encode` keyword.

Also, you must enable both the decoding and alerting option for each specific encoding type in your HTTP Inspect preprocessor configuration so the `http_encode` keyword in an intrusion rule can trigger events on that encoding type.

The following table describes the encoding types this option can generate events for in HTTP URIs, headers, cookies, and set-cookies:

<table>
<thead>
<tr>
<th>Encoding Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>utf8</td>
<td>Detects UTF-8 encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.</td>
</tr>
<tr>
<td>double_encode</td>
<td>Detects double encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.</td>
</tr>
<tr>
<td>non_ascii</td>
<td>Detects non-ASCII characters in the specified location when non-ASCII characters are detected but the detected encoding type is not enabled.</td>
</tr>
<tr>
<td>uencode</td>
<td>Detects Microsoft %u encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.</td>
</tr>
<tr>
<td>bare_byte</td>
<td>Detects bare byte encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.</td>
</tr>
</tbody>
</table>

Related Topics

- [The HTTP Inspect Preprocessor](#)
- [Server-Level HTTP Normalization Options](#)
http_encode Keyword Syntax

Encoding Location
Specifies whether to search for the specified encoding type in an HTTP URI, header, or cookie, including a set-cookie.

Encoding Type
Specifies one or more encoding types using one of the following formats:

```
encode_type
encode_type|encode_type|encode_type...
```

where `encode_type` is one of the following:

- utf8
- double_encode
- non_ascii
- uencode
- bare_byte.

Note that you cannot use the negation (!) and OR (|) operators together.

http_encode Keyword example: Using Two http_encode Keywords to Search for Two Encodings

The following example uses two `http_encode` keywords in the same rule to search the HTTP URI for UTF-8 AND Microsoft IIS %u encoding:

First, the `http_encode` keyword:

- **Encoding Location**: HTTP URI
- **Encoding Type**: utf8

Then, the additional `http_encode` keyword:

- **Encoding Location**: HTTP URI
- **Encoding Type**: uencode

Overview: The file_type and file_group Keywords

The `file_type` and `file_group` keywords allow you to detect files transmitted via FTP, HTTP, SMTP, IMAP, POP3, and NetBIOS-ssn (SMB) based on their type and version. Do not use more than one `file_type` or `file_group` keyword in a single intrusion rule.

Tip
Updating your vulnerability database (VDB) populates the intrusion rules editor with the most up-to-date file types, versions, and groups.
The system does not automatically enable preprocessors to accommodate the `file_type` and `file_group` keywords.

You **must** enable specific preprocessors if you want to generate events and, in an inline deployment, drop offending packets for traffic matching your `file_type` or `file_group` keywords.

**Table 159: file_type and file_group Intrusion Event Generation**

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Required Preprocessor or Preprocessor Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTP</td>
<td>FTP/Telnet preprocessor and the <strong>Normalize TCP Payload</strong> inline normalization</td>
</tr>
<tr>
<td></td>
<td>preprocessor option</td>
</tr>
<tr>
<td>HTTP</td>
<td>HTTP Inspect preprocessor to generate intrusion events in HTTP traffic</td>
</tr>
<tr>
<td>SMTP</td>
<td>SMTP preprocessor to generate intrusion events in HTTP traffic</td>
</tr>
<tr>
<td>IMAP</td>
<td>IMAP preprocessor</td>
</tr>
<tr>
<td>POP3</td>
<td>POP preprocessor</td>
</tr>
<tr>
<td>Netbios-ssn (SMB)</td>
<td>The DCE/RPC preprocessor and the <strong>SMB File Inspection</strong> DCE/RPC preprocessor</td>
</tr>
</tbody>
</table>

**Related Topics**

- The FTP/Telnet Decoder, on page 1082
- The Inline Normalization Preprocessor, on page 1144
- The HTTP Inspect Preprocessor, on page 1089
- The SMTP Preprocessor, on page 1118
- The IMAP Preprocessor, on page 1111
- The POP Preprocessor, on page 1115
- The DCE/RPC Preprocessor, on page 1067

**The file_type and file_group Keywords**

**file_type**

The `file_type` keyword allows you to specify the file type and version of a file detected in traffic. File type arguments (for example, JPEG and PDF) identify the format of the file you want to find in traffic.

**Note**

Do not use the `file_type` keyword with another `file_type` or `file_group` keyword in the same intrusion rule.

The system selects **Any Version** by default, but some file types allow you to select version options (for example, PDF version 1.7) to identify specific file type versions you want to find in traffic.
file_group

The file_group keyword allows you to select a Cisco-defined group of similar file types to find in traffic (for example, multimedia or audio). File groups also include Cisco-defined versions for each file type in the group.

Note

Do not use the file_group keyword with another file_group or file_type keyword in the same intrusion rule.

The file_data Keyword

The file_data keyword provides a pointer that serves as a reference for the positional arguments available for other keywords such as content, byte_jump, byte_test, and pcre. The detected traffic determines the type of data the file_data keyword points to. You can use the file_data keyword to point to the beginning of the following payload types:

• HTTP response body
  To inspect HTTP response packets, the HTTP Inspect preprocessormust be enabled and you must configure the preprocessorto inspect HTTP responses. The file_data keyword matches if the HTTP Inspect preprocessordetects HTTP response body data.

• Uncompressed gzip file data
  To inspect uncompressed gzip files in the HTTP response body, the HTTP Inspect preprocessormust be enabled and you must configure the preprocessorto inspect HTTP responses and to decompress gzip-compressed files in the HTTP response body. For more information, see the Inspect HTTP Responses and Inspect Compressed Data Server-Level HTTP Normalization options. The file_data keyword matches if the HTTP Inspect preprocessordetectsuncompressed gzip data in the HTTP response body.

• Normalized JavaScript
  To inspect normalized JavaScript data, the HTTP Inspect preprocessormust be enabled and you must configure the preprocessorto inspect HTTP responses. The file_data keyword matches if the HTTP Inspect preprocessordetects JavaScript in response body data.

• SMTP payload
  To inspect the SMTP payload, the SMTP preprocessormust be enabled. The file_data keyword matches if the SMTP preprocessordetects SMTP data.

• Encoded email attachments in SMTP, POP, or IMAP traffic
  To inspect email attachments in SMTP, POP, or IMAP traffic, the SMTP, POP, or IMAP preprocessors, respectively, must be enabled, alone or in any combination. Then, for each enabled preprocessors, you must ensure that the preprocessors are configured to decode each attachment encoding type that you want decoded. The attachment decoding options that you can configure for each preprocessors are: Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, and Unix-to-Unix Decoding Depth.
  You can use multiple file_data keywords in a rule.
The pkt_data Keyword

The pkt_data keyword provides a pointer that serves as a reference for the positional arguments available for other keywords such as content, byte_jump, byte_test, and pcre.

When normalized FTP, telnet, or SMTP traffic is detected, the pkt_data keyword points to the beginning of the normalized packet payload. When other traffic is detected, the pkt_data keyword points to the beginning of the raw TCP or UDP payload.

The following normalization options must be enabled for the system to normalize the corresponding traffic for inspection by intrusion rules:

- Enable the FTP & Telnet preprocessor Detect Telnet Escape codes within FTP commands option to normalize FTP traffic for inspection.
- Enable the FTP & Telnet preprocessor Normalize telnet option to normalize telnet traffic for inspection.
- Enable the SMTP preprocessor Normalize option to normalize SMTP traffic for inspection.

You can use multiple pkt_data keywords in a rule.

Related Topics
- Client-Level FTP Options, on page 1087
- Telnet Options, on page 1083
- SMTP Preprocessor Options, on page 1118

The base64_decode and base64_data Keywords

You can use the base64_decode and base64_data keywords in combination to instruct the rules engine to decode and inspect specified data as Base64 data. This can be useful, for example, for inspecting Base64-encoded HTTP Authentication request headers and Base64-encoded data in HTTP PUT and POST requests.

These keywords are particularly useful for decoding and inspecting Base64 data in HTTP requests. However, you can also use them with any protocol such as SMTP that uses the space and tab characters the same way HTTP uses these characters to extend a lengthy header line over multiple lines. When this line extension, which is known as folding, is not present in a protocol that uses it, inspection ends at any carriage return or line feed that is not followed with a space or tab.

base64_decode

The base64_decode keyword instructs the rules engine to decode packet data as Base64 data. Optional arguments let you specify the number of bytes to decode and where in the data to begin decoding.

You can use the base64_decode keyword once in a rule; it must precede at least one instance of the base64_data keyword.
Before decoding Base64 data, the rules engine unfolds lengthy headers that are folded across multiple lines. Decoding ends when the rules engine encounters any of the following:

- the end of a header line
- the specified number of bytes to decode
- the end of the packet

The following table describes the arguments you can use with the `base64_decode` keyword.

**Table 160: Optional base64_decode Arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td>Specifies the number of bytes to decode. When not specified, decoding continues to the end of a header line or the end of the packet payload, whichever comes first. You can specify a positive, non-zero value.</td>
</tr>
<tr>
<td>Offset</td>
<td>Determines the offset relative to the start of the packet payload or, when you also specify <code>Relative</code>, relative to the current inspection location. You can specify a positive, non-zero value.</td>
</tr>
<tr>
<td>Relative</td>
<td>Specifies inspection relative to the current inspection location.</td>
</tr>
</tbody>
</table>

The `base64_data` keyword provides a reference for inspecting Base64 data decoded using the `base64_decode` keyword. The `base64_data` keyword sets inspection to begin at the start of the decoded Base64 data. Optionally, you can then use the positional arguments available for other keywords such as `content` or `byte_test` to further specify the location to inspect.

You must use the `base64_data` keyword at least once after using the `base64_decode` keyword; optionally, you can use `base64_data` multiple times to return to the beginning of the decoded Base64 data.

Note the following when inspecting Base64 data:

- You cannot use the fast pattern matcher.
- If you interrupt Base64 inspection in a rule with an intervening HTTP content argument, you must insert another `base64_data` keyword in the rule before further inspecting Base64 data.

**Related Topics**

- [Overview: HTTP content and protected_content Keyword Arguments](#), on page 955
- [content Keyword Fast Pattern Matcher Arguments](#), on page 959
The `base64_decode` and `base64_data` Keywords
Intrusion Prevention Performance Tuning

The following topics describe how to refine intrusion prevention performance:

- About Intrusion Prevention Performance Tuning, on page 1037
- Limiting Pattern Matching for Intrusions, on page 1038
- Regular Expression Limits Overrides for Intrusion Rules, on page 1038
- Overriding Regular Expression Limits for Intrusion Rules, on page 1039
- Per Packet Intrusion Event Generation Limits, on page 1040
- Limiting Intrusion Events Generated Per Packet, on page 1041
- Packet and Intrusion Rule Latency Threshold Configuration, on page 1041
- Intrusion Performance Statistic Logging Configuration, on page 1046
- Configuring Intrusion Performance Statistic Logging, on page 1047

About Intrusion Prevention Performance Tuning

Cisco provides several features for improving the performance of your system as it analyzes traffic for attempted intrusions. You can:

- specify the number of packets to allow in the event queue. You can also, before and after stream reassembly, enable or disable inspection of packets that will be rebuilt into larger streams.

- override default match and recursion limits on PCRE that are used in intrusion rules to examine packet payload content.

- elect to have the rules engine log more than one event per packet or packet stream when multiple events are generated, allowing you to collect information beyond the reported event.

- balance security with the need to maintain device latency at an acceptable level with packet and rule latency thresholding.

- configure the basic parameters of how devices monitor and report their own performance. This allows you to specify the intervals at which the system updates performance statistics on your devices.

You configure these performance settings on a per-access-control-policy basis, and they apply to all intrusion policies invoked by that parent access control policy.
Limiting Pattern Matching for Intrusions

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  In the access control policy editor, click the Advanced tab.

Step 2  Click the edit icon ( ) next to Performance Settings.

If a view icon ( ) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck Inherit from base policy to enable editing.

Step 3  Click the Pattern Matching Limits tab in the Performance Settings pop-up window.

Step 4  Enter a value for the maximum number of events to queue in the Maximum Pattern States to Analyze Per Packet field.

Step 5  To disable the inspection of packets that will be rebuilt into larger streams of data before and after stream reassembly, check the Disable Content Checks on Traffic Subject to Future Reassembly check box. Inspection before and after reassembly requires more processing overhead and may decrease performance.

Step 6  Click OK.

Step 7  Click Save to save the policy.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Regular Expression Limits Overrides for Intrusion Rules

The default regular expression limits ensure a minimum level of performance. Overriding these limits could increase security, but could also significantly impact performance by permitting packet evaluation against inefficient regular expressions.

Caution

Do not override default PCRE limits unless you are an experienced intrusion rule writer with knowledge of the impact of degenerative patterns.
### Table 161: Regular Expression Constraint Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Match Limit State</strong></td>
<td>Specifies whether to override <strong>Match Limit</strong>. You have the following options:</td>
</tr>
<tr>
<td></td>
<td>• select <strong>Default</strong> to use the value configured for <strong>Match Limit</strong></td>
</tr>
<tr>
<td></td>
<td>• select <strong>Unlimited</strong> to permit an unlimited number of attempts</td>
</tr>
<tr>
<td></td>
<td>• select <strong>Custom</strong> to specify either a limit of 1 or greater for <strong>Match Limit</strong>, or to specify 0 to completely disable PCRE match evaluations</td>
</tr>
<tr>
<td><strong>Match Limit</strong></td>
<td>Specifies the number of times to attempt to match a pattern defined in a PCRE regular expression.</td>
</tr>
<tr>
<td><strong>Match Recursion Limit State</strong></td>
<td>Specifies whether to override <strong>Match Recursion Limit</strong>. You have the following options:</td>
</tr>
<tr>
<td></td>
<td>• select <strong>Default</strong> to use the value configured for <strong>Match Recursion Limit</strong></td>
</tr>
<tr>
<td></td>
<td>• select <strong>Unlimited</strong> to permit an unlimited number of recursions</td>
</tr>
<tr>
<td></td>
<td>• select <strong>Custom</strong> to specify either a limit of 1 or greater for <strong>Match Recursion Limit</strong>, or to specify 0 to completely disable PCRE recursions</td>
</tr>
<tr>
<td><strong>Match Recursion Limit</strong></td>
<td>Specifies the number of recursions when evaluating a PCRE regular expression against the packet payload.</td>
</tr>
</tbody>
</table>

**Related Topics**

- *Overview: The pcre Keyword*, on page 969

---

### Overriding Regular Expression Limits for Intrusion Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

---
Procedure

**Step 1** In the access control policy editor, click the **Advanced** tab.

**Step 2** Click the edit icon (✏️) next to **Performance Settings**.

If a view icon (🔍) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.

**Step 3** Click the **Regular Expression Limits** tab in the **Performance Settings** pop-up window.

**Step 4** You can modify any of the options in **Regular Expression Limits Overrides for Intrusion Rules**, on page 1038.

**Step 5** Click **OK**.

**Step 6** Click **Save** to save the policy.

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

## Per Packet Intrusion Event Generation Limits

When the intrusion rules engine evaluates traffic against rules, it places the events generated for a given packet or packet stream in an event queue, then reports the top events in the queue to the user interface. When configuring the intrusion event logging limits, you can specify how many events can be placed in the queue and how many are logged, and select the criteria for determining event order within the queue.

**Table 162: Intrusion Event Logging Limits Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Events Stored Per Packet</td>
<td>The maximum number of events that can be stored for a given packet or packet stream.</td>
</tr>
<tr>
<td>Maximum Events Logged Per Packet</td>
<td>The number of events logged for a given packet or packet stream. This cannot exceed the <strong>Maximum Events Stored Per Packet</strong> value.</td>
</tr>
<tr>
<td>Prioritize Event Logging By</td>
<td>The value used to determine event ordering within the event queue. The highest ordered event is reported through the user interface. You can select from:</td>
</tr>
<tr>
<td></td>
<td>• <strong>priority</strong>, which orders events in the queue by the event priority.</td>
</tr>
<tr>
<td></td>
<td>• <strong>content_length</strong>, which orders events by the longest identified content match. When events are ordered by content length, rule events always take precedence over decoder and preprocessor events.</td>
</tr>
</tbody>
</table>
Limiting Intrusion Events Generated Per Packet

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  In the access control policy editor, click the Advanced tab.
Step 2  Click the edit icon ( ) next to Performance Settings.

If a view icon ( ) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck Inherit from base policy to enable editing.

Step 3  Click the Intrusion Event Logging Limits tab in the Performance Settings pop-up window.
Step 4  You can modify any of the options in Per Packet Intrusion Event Generation Limits, on page 1040.
Step 5  Click OK.
Step 6  Click Save to save the policy.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Packet and Intrusion Rule Latency Threshold Configuration

Each access control policy has latency-based settings that use thresholding to manage packet and rule processing performance.

Packet latency thresholding measures the total elapsed time taken to process a packet by applicable decoders, preprocessors, and rules, and ceases inspection of the packet if the processing time exceeds a configurable threshold.

Rule latency thresholding measures the elapsed time each rule takes to process an individual packet, suspends the violating rule along with a group of related rules for a specified time if the processing time exceeds the rule latency threshold a configurable consecutive number of times, and restores the rules when the suspension expires.

Packet Latency Thresholding

Packet latency thresholding measures elapsed time, not just processing time, in order to more accurately reflect the actual time required for the rule to process a packet. However, latency thresholding is a software-based latency implementation that does not enforce strict timing.
The trade-off for the performance and latency benefits derived from latency thresholding is that uninspected packets could contain attacks. A timer starts for each packet when decoder processing begins. Timing continues either until all processing ends for the packet or until the processing time exceeds the threshold at a timing test point.

As illustrated in the above figure, packet latency timing is tested at the following test points:

- after the completion of all decoder and preprocessor processing and before rule processing begins
- after processing by each rule

If the processing time exceeds the threshold at any test point, packet inspection ceases.

**Tip**

Total packet processing time does not include routine TCP stream or IP fragment reassembly times.

Packet latency thresholding has no effect on events triggered by a decoder, preprocessor, or rule processing the packet. Any applicable decoder, preprocessor, or rule triggers normally until a packet is fully processed, or until packet processing ends because the latency threshold is exceeded, whichever comes first. If a drop rule detects an intrusion in an inline deployment, the drop rule triggers an event and the packet is dropped.

**Note**

No packets are evaluated against rules after processing for that packet ceases because of a packet latency threshold violation. A rule that would have triggered an event cannot trigger that event, and for drop rules, cannot drop the packet.

Packet latency thresholding can improve system performance in both passive and inline deployments, and can reduce latency in inline deployments, by stopping inspection of packets that require excessive processing time. These performance benefits might occur when, for example:

- for both passive and inline deployments, sequential inspection of a packet by multiple rules requires an excessive amount of time
- for inline deployments, a period of poor network performance, such as when someone downloads an extremely large file, slows packet processing

In a passive deployment, stopping the processing of packets might not contribute to restoring network performance because processing simply moves to the next packet.
Packet Latency Thresholding Notes

Table 163: Packet Latency Thresholding Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold (microseconds)</td>
<td>Specifies the time, in microseconds, when inspection of a packet ceases.</td>
</tr>
</tbody>
</table>

You can enable rule 134:3 to generate an event and, in an inline deployment, drop offending packets when the system stops inspecting a packet because the packet latency threshold is exceeded. For more information, see Intrusion Rule State Options, on page 888.

Configuring Packet Latency Thresholding

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access/Network/Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** In the access control policy editor, click the Advanced tab.

**Step 2** Click the edit icon (edit) next to Latency-Based Performance Settings.

If a view icon (view) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck Inherit from base policy to enable editing.

**Step 3** Click the Packet Handling tab in the Latency-Based Performance Settings pop-up window.

**Step 4** See Packet Latency Thresholding Notes, on page 1043 for recommended minimum Threshold settings.

**Step 5** Click OK.

**Step 6** Click Save to save the policy.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Rule Latency Thresholding

Rule latency thresholding measures elapsed time, not just processing time, in order to more accurately reflect the actual time required for the rule to process a packet. However, latency thresholding is a software-based latency implementation that does not enforce strict timing.

The trade-off for the performance and latency benefits derived from latency thresholding is that uninspected packets could contain attacks. A timer measures the processing time each time a packet is processed against a group of rules. Any time the rule processing time exceeds a specified rule latency threshold, the system
increments a counter. If the number of consecutive threshold violations reaches a specified number, the system takes the following actions:

- suspends the rules for the specified period
- triggers an event indicating the rules have been suspended
- re-enables the rules when the suspension expires
- triggers an event indicating the rules have been re-enabled

The system zeroes the counter when the group of rules has been suspended, or when rule violations are not consecutive. Permitting some consecutive violations before suspending rules lets you ignore occasional rule violations that might have negligible impact on performance and focus instead on the more significant impact of rules that repeatedly exceed the rule latency threshold.

The following example shows five consecutive rule processing times that do not result in rule suspension.

```
<table>
<thead>
<tr>
<th>Packet</th>
<th>Processing time (microseconds)</th>
<th>Violations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5</td>
<td>1100 1100 1100 500 1100</td>
<td>(Threshold = 1000) (Consecutive violations before suspending = 5)</td>
</tr>
</tbody>
</table>
```

= No violation  = Threshold violation

In the above example, the time required to process each of the first three packets violates the rule latency threshold of 1000 microseconds, and the violations counter increments with each violation. Processing of the fourth packet does not violate the threshold, and the violations counter resets to zero. The fifth packet violates the threshold and the violations counter restarts at one.

The following example shows five consecutive rule processing times that do result in rule suspension.

```
<table>
<thead>
<tr>
<th>Packet</th>
<th>Processing time (microseconds)</th>
<th>Violations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5</td>
<td>1100 1100 1100 1100 1100</td>
<td>(Threshold = 1000) (Consecutive violations before suspending = 5)</td>
</tr>
</tbody>
</table>
```

= No violation  = Threshold violation  = Not inspected (rule suspended)

In the second example, the time required to process each of the five packets violates the rule latency threshold of 1000 microseconds. The group of rules is suspended because the rule processing time of 1100 microseconds for each packet violates the threshold of 1000 microseconds for the specified five consecutive violations. Any subsequent packets, represented in the figure as packets 6 through n, are not examined against suspended rules until the suspension expires. If more packets occur after the rules are re-enabled, the violations counter begins again at zero.

Rule latency thresholding has no effect on intrusion events triggered by the rules processing the packet. A rule triggers an event for any intrusion detected in the packet, regardless of whether the rule processing time exceeds the threshold. If the rule detecting the intrusion is a drop rule in an inline deployment, the packet is
dropped. When a drop rule detects an intrusion in a packet that results in the rule being suspended, the drop rule triggers an intrusion event, the packet is dropped, and that rule and all related rules are suspended.

---

**Note**

Packets are not evaluated against suspended rules. A suspended rule that would have triggered an event cannot trigger that event and, for drop rules, cannot drop the packet.

Rule latency thresholding can improve system performance in both passive and inline deployments, and can reduce latency in inline deployments, by suspending rules that take the most time to process packets. Packets are not evaluated again against suspended rules until a configurable time expires, giving the overloaded device time to recover. These performance benefits might occur when, for example:

- hastily written, largely untested rules require an excessive amount of processing time
- a period of poor network performance, such as when someone downloads an extremely large file, causes slow packet inspection

### Rule Latency Thresholding Notes

Rule latency thresholding suspends rules for the time specified by **Suspension Time** when the time rules take to process a packet exceeds **Threshold** for the consecutive number of times specified by **Consecutive Threshold Violations Before Suspending Rule**.

You can enable rule 134:1 to generate an event when rules are suspended, and rule 134:2 to generate an event when suspended rules are enabled. See **Intrusion Rule State Options**, on page 888.

#### Table 164: Rule Latency Thresholding Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Specifies the time in microseconds that rules should not exceed when examining a packet.</td>
</tr>
<tr>
<td>Consecutive Threshold Violations Before Suspending Rule</td>
<td>Specifies the consecutive number of times rules can take longer than the time set for <strong>Threshold</strong> to inspect packets before rules are suspended.</td>
</tr>
<tr>
<td>Suspension Time</td>
<td>Specifies the number of seconds to suspend a group of rules.</td>
</tr>
</tbody>
</table>

### Configuring Rule Latency Thresholding

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access/Network/Admin</td>
</tr>
</tbody>
</table>
**Procedure**

**Step 1**  
In the access control policy editor, click the **Advanced** tab.

**Step 2**  
Click the edit icon (📝) next to **Latency-Based Performance Settings**.

If a view icon (🔍) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.

**Step 3**  
Click the **Rule Handling** tab in the **Latency-Based Performance Settings** pop-up window.

**Step 4**  
You can configure any of the options in Rule Latency Thresholding Notes, on page 1045.

**Step 5**  
Click **OK**.

**Step 6**  
Click **Save** to save the policy.

**What to do next**

- If you want to generate events, enable latency rules 134:1 and 134:2. For more information, see Intrusion Rule State Options, on page 888.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**Intrusion Performance Statistic Logging Configuration**

**Sample time (seconds) and Minimum number of packets**

When the number of seconds specified elapses between performance statistics updates, the system verifies it has analyzed the specified number of packets. If it has, the system updates performance statistics. Otherwise, the system waits until it analyzes the specified number of packets.

**Troubleshooting Options: Log Session/Protocol Distribution**

Support might ask you during a troubleshooting call to log protocol distribution, packet length, and port statistics.

⚠️ **Caution**

Do not enable **Log Session/Protocol Distribution** unless instructed to by Support. Note that enabling or disabling **Log Session/Protocol Distribution** restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

**Troubleshooting Options: Summary**

Support might ask you during a troubleshooting call to configure the system to calculate the performance statistics only when the Snort process is shut down or restarted. To enable this option, you must also enable the **Log Session/Protocol Distribution** troubleshooting option.
Caution
Do not enable **Summary** unless instructed to do so by Support.

## Configuring Intrusion Performance Statistic Logging

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1** In the access control policy editor, click the **Advanced** tab, then click the edit icon (Editar) next to **Performance Settings**.

If a view icon (Ver) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.

**Step 2** Click the **Performance Statistics** tab in the pop-up window that appears.

**Step 3** Modify the **Sample time** or **Minimum number of packets** as described above.

**Step 4** Optionally, expand the **Troubleshoot Options** section and modify those options only if asked to do so by Support.

**Caution** Enabling or disabling **Log Session/Protocol Distribution** restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See **Snort® Restart Traffic Behavior**, on page 280 for more information.

**Step 5** Click **OK**.

### What to do next

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.
PART XIV

Advanced Network Analysis and Preprocessing

- Advanced Access Control Settings for Network Analysis and Intrusion Policies, on page 1051
- Getting Started with Network Analysis Policies, on page 1059
- Application Layer Preprocessors, on page 1067
- SCADA Preprocessors, on page 1133
- Transport & Network Layer Preprocessors, on page 1139
- Detecting Specific Threats, on page 1173
- Adaptive Profiles, on page 1193
Advanced Access Control Settings for Network Analysis and Intrusion Policies

The following topics describe how to configure advanced settings for network analysis and intrusion policies:

- About Advanced Access Control Settings for Network Analysis and Intrusion Policies, on page 1051
- The Default Intrusion Policy, on page 1051
- Advanced Settings for Network Analysis Policies, on page 1053

About Advanced Access Control Settings for Network Analysis and Intrusion Policies

Many of the advanced settings in an access control policy govern intrusion detection and prevention configurations that require specific expertise to configure. Advanced settings typically require little or no modification and are not common to every deployment.

The Default Intrusion Policy

Each access control policy uses its default intrusion policy to initially inspect traffic before the system can determine exactly how to inspect that traffic. This is needed because sometimes the system must process the first few packets in a connection, allowing them to pass, before it can decide which access control rule (if any) will handle the traffic. However, so that these packets do not reach their destination uninspected, you can use an intrusion policy—called the default intrusion policy—to inspect them and generate intrusion events. By default, the default intrusion policy uses the default variable set.

A default intrusion policy is especially useful when performing application control and URL filtering, because the system cannot identify applications or filter URLs before a connection is fully established between the client and the server. For example, if a packet matches all the other conditions in an access control rule with an application or URL condition, it and subsequent packets are allowed to pass until the connection is established and application or URL identification is complete, usually 3 to 5 packets.

The system inspects these allowed packets with the default intrusion policy, which can generate events and, if placed inline, block malicious traffic. After the system identifies the access control rule or default action that should handle the connection, the remaining packets in the connection are handled and inspected accordingly.
When you create an access control policy, its default intrusion policy depends on the default action you first chose. Initial default intrusion policies for access control are as follows:

- Balanced Security and Connectivity (a system-provided policy) is the default intrusion policy for an access control policy where you first chose the **Intrusion Prevention** default action.

- No Rules Active is the default intrusion policy for an access control policy where you first chose the **Block all traffic** or **Network Discovery** default action. Although choosing this option disables intrusion inspection on the allowed packets described above, it can improve performance if you are not interested in intrusion data.

  **Note**  
  If you are not performing intrusion inspection (for example, in a discovery-only deployment), keep the No Rules Active policy as your default intrusion policy.

If you change your default action after you create the access control policy, the default intrusion policy does not automatically change. To change it manually, use the access control policy’s advanced options.

You can choose a system- or user-created policy.

**Note**  
The network analysis policy associated with the first matching network analysis rule preprocesses traffic for the default intrusion policy. If there are no network analysis rules, or none match, the default network analysis policy is used.

### Setting the Default Intrusion Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Caution**  
Changing the total number of intrusion policies used by an access control policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See [Snort® Restart Traffic Behavior, on page 280](#) for more information. You change the the total number of intrusion policies by adding an intrusion policy that is not currently used, or by removing the last instance of an intrusion policy. You can use an intrusion policy in an access control rule, as the default action, or as the default intrusion policy.

**Procedure**

**Step 1**  
In the access control policy editor, click the **Advanced** tab, then click the edit icon (/grid) next to the Network Analysis and Intrusion Policies section.
If a view icon ( ) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck Inherit from base policy to enable editing.

**Step 2**
Select an intrusion policy from the **Intrusion Policy used before Access Control rule is determined** drop-down list.

If you choose a user-created policy, you can click an edit icon ( ) to edit the policy in a new window. You cannot edit system-provided policies.

**Step 3**
Optionally, select a different variable set from the **Intrusion Policy Variable Set** drop-down list. You can also select the edit icon ( ) next to the variable set to create and edit variable sets. If you do not change the variable set, the system uses a default set.

**Step 4**
Click OK.

**Step 5**
Click Save to save the policy.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**
Variable Sets, on page 333

---

**Advanced Settings for Network Analysis Policies**

*Network analysis policies* govern how traffic is decoded and preprocessed so that it can be further evaluated, especially for anomalous traffic that might signal an intrusion attempt. This traffic preprocessing occurs after Security Intelligence blacklisting and traffic decryption, but before intrusion policies inspect packets in detail. By default, the system-provided Balanced Security and Connectivity network analysis policy is the default network analysis policy.

---

**Tip**
The system-provided Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. However, the network analysis policy governs mostly preprocessing options, whereas the intrusion policy governs mostly intrusion rules.

A simple way to tune preprocessing is to create and use a custom network analysis policy as the default. For advanced users with complex deployments, you can create multiple network analysis policies, each tailored to preprocess traffic differently. Then, you can configure the system to use those policies to govern the preprocessing of traffic using different security zones, networks, or VLANs.

To accomplish this, you add custom *network analysis rules* to your access control policy. A network analysis rule is simply a set of configurations and conditions that specifies how you preprocess traffic that matches those qualifications. You create and edit network analysis rules in the advanced options in an existing access control policy. Each rule belongs to only one policy.

Each rule has:

- a set of rule conditions that identifies the specific traffic you want to preprocess
• an associated network analysis policy that you want to use to preprocess traffic that meets all the rules’ conditions

When it is time for the system to preprocess traffic, it matches packets to network analysis rules in top-down order by rule number. Traffic that does not match any network analysis rules is preprocessed by the default network analysis policy.

### Setting the Default Network Analysis Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can choose a system- or user-created policy.

---

**Note**

If you disable a preprocessor but the system needs to evaluate preprocessed packets against an enabled intrusion or preprocessor rule, the system automatically enables and uses the preprocessor although it remains disabled in the network analysis policy web interface. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. Because preprocessing and intrusion inspection are so closely related, you must be careful that you allow the network analysis and intrusion policies examining a single packet to complement each other.

---

**Procedure**

**Step 1**

In the access control policy editor, click the Advanced tab, then click the edit icon (嚅) next to the Network Analysis and Intrusion Policies section.

If a view icon (ﳓ) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck Inherit from base policy to enable editing.

**Step 2**

From the Default Network Analysis Policy drop-down list, select a default network analysis policy.

If you choose a user-created policy, you can click an edit icon (蜩) to edit the policy in a new window. You cannot edit system-provided policies.

**Caution**

Changing the total number of network analysis policies used by an access control policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information. You change the total number of network analysis policies by adding a policy that is not currently used, or by removing the last instance of a network analysis policy. You can use a network analysis policy with network analysis rules or as the default network analysis policy.

**Step 3**

Click OK.
Step 4  Click **Save** to save the policy.

---

**What to do next**

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

**Related Topics**

- **Limitations of Custom Policies**, on page 843

### Network Analysis Rules

Within your access control policy’s advanced settings, you can use network analysis rules to tailor preprocessing configurations to network traffic.

Network analysis rules are numbered, starting at 1. When it is time for the system to preprocess traffic, it matches packets to network analysis rules in top-down order by ascending rule number, and preprocesses traffic according to the first rule where all the rule’s conditions match.

You can add zone, network, and VLAN tag conditions to a rule. If you do not configure a particular condition for a rule, the system does not match traffic based on that criterion. For example, a rule with a network condition but no zone condition evaluates traffic based on its source or destination IP address, regardless of its ingress or egress interface. Traffic that does not match any network analysis rules is preprocessed by the default network analysis policy.

### Configuring Network Analysis Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  In the access control policy editor, click the **Advanced** tab, then click the edit icon (✏️) next to the Network Analysis and Intrusion Policies section.

If a view icon (👁️‍🗨️) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.

**Tip**  Click **Network Analysis Policy List** to view and edit existing custom network analysis policies.

**Step 2**  Next to **Network Analysis Rules**, click the statement that indicates how many custom rules you have.

**Step 3**  Click **Add Rule**.

**Step 4**  Configure the rule's conditions by clicking the tabs corresponding to the conditions you want to add; see **Rule Condition Types**, on page 290.

**Step 5**  Click the **Network Analysis** tab and choose the **Network Analysis Policy** you want to use to preprocess the traffic matching this rule.
Click the edit icon (عدل) to edit a custom policy in a new window. You cannot edit system-provided policies.

**Caution** Changing the total number of network analysis policies used by an access control policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information. You change the total number of network analysis policies by adding a policy that is not currently used, or by removing the last instance of a network analysis policy. You can use a network analysis policy with network analysis rules or as the default network analysis policy.

**Step 6** Click **Add**.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

### Managing Network Analysis Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

A network analysis rule is simply a set of configurations and conditions that specifies how you preprocess traffic that matches those qualifications. You create and edit network analysis rules in the advanced options in an existing access control policy. Each rule belongs to only one policy.

**Procedure**

**Step 1** In the access control policy editor, click the **Advanced** tab, then click the edit icon (عدل) next to the Intrusion and Network Analysis Policies section.

If a view icon (عرض) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck **Inherit from base policy** to enable editing.

**Step 2** Next to **Network Analysis Rules**, click the statement that indicates how many custom rules you have.

**Step 3** Edit your custom rules. You have the following options:

- To edit a rule’s conditions, or change the network analysis policy invoked by the rule, click the edit icon (عدل) next to the rule.

- To change a rule’s order of evaluation, click and drag the rule to the correct location. To select multiple rules, use the Shift and Ctrl keys.

- To delete a rule, click the delete icon (حذف) next to the rule.
Right-clicking a rule displays a context menu that allows you to cut, copy, paste, edit, delete, and add new network analysis rules.

**Tip**

**Step 4**  Click **OK**.

**Step 5**  Click **Save** to save the policy.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
CHAPTER 58

Getting Started with Network Analysis Policies

The following topics describe how to get started with network analysis policies:

- Network Analysis Policy Basics, on page 1059
- Managing Network Analysis Policies, on page 1059

Network Analysis Policy Basics

Network analysis policies govern many traffic preprocessing options, and are invoked by advanced settings in your access control policy. Network analysis-related preprocessing occurs after Security Intelligence blacklisting and SSL decryption, but before intrusion or file inspection begins.

By default, the system uses the Balanced Security and Connectivity network analysis policy to preprocess all traffic handled by an access control policy. However, you can choose a different default network analysis policy to perform this preprocessing. For your convenience, the system provides a choice of several non-modifiable network analysis policies, which are tuned for a specific balance of security and connectivity by the Cisco Talos Security Intelligence and Research Group (Talos). You can also create a custom network analysis policy with custom preprocessing settings.

Tip
System-provided intrusion and network analysis policies are similarly named but contain different configurations. For example, the Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. However, the network analysis policy governs mostly preprocessing options, whereas the intrusion policy governs mostly intrusion rules. Network analysis and intrusion policies work together to examine your traffic.

You can also tailor traffic preprocessing options to specific security zones, networks, and VLANs by creating multiple custom network analysis policies, then assigning them to preprocess different traffic. (Note that ASA FirePOWER cannot restrict preprocessing by VLAN.)

Managing Network Analysis Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>
In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

**Procedure**

**Step 1** Choose **Policies** > **Access Control**, then click **Network Analysis Policy** or **Policies** > **Access Control** > **Intrusion**, then click **Network Analysis Policy**.

**Note** If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2** Manage your network analysis policy:

- **Compare** — Click **Compare Policies**; see *Comparing Policies*, on page 284.

- **Create** — If you want to create a new network analysis policy, click **Create Policy** and proceed as described in *Custom Network Analysis Policy Creation*, on page 1060.

- **Delete** — If you want to delete a network analysis policy, click the delete icon ((identity)), then confirm that you want to delete the policy. You cannot delete a network analysis policy if an access control policy references it.

  If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

- **Deploy** — Click **Deploy**; see *Deploy Configuration Changes*, on page 277.

- **Edit** — If you want edit an existing network analysis policy, click the edit icon (document) and proceed as described in *Network Analysis Policy Settings and Cached Changes*, on page 1062.

  If a view icon (eyes) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

- **Report** — Click the report icon (printer); see *Generating Current Policy Reports*, on page 286.

**Custom Network Analysis Policy Creation**

When you create a new network analysis policy you must give it a unique name, specify a base policy, and choose an *inline mode*.

The base policy defines the network analysis policy’s default settings. Modifying a setting in the new policy overrides—but does not change—the settings in the base policy. You can use either a system-provided or custom policy as your base policy.

The network analysis policy’s inline mode allows preprocessors to modify (normalize) and drop traffic to minimize the chances of attackers evading detection. Note that in passive deployments, the system cannot affect traffic flow regardless of the inline mode.
Creating a Custom Network Analysis Policy

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

Procedure

Step 1  Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note  If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2  Click Create Policy. If you have unsaved changes in another policy, click Cancel when prompted to return to the Network Analysis Policy page.

Step 3  Enter a unique Name.

In a multidomain deployment, policy names must be unique within the domain hierarchy. The system may identify a conflict with the name of a policy you cannot view in your current domain.

Step 4  Optionally, enter a Description.

Step 5  Choose the initial Base Policy. You can use either a system-provided or custom policy as your base policy.

Step 6  If you want to allow preprocessors to affect traffic in an inline deployment, enable Inline Mode.

Step 7  Create the policy:

- Click Create Policy to create the new policy and return to the Network Analysis Policy page. The new policy has the same settings as its base policy.
- Click Create and Edit Policy to create the policy and open it for editing in the advanced network analysis policy editor.

Related Topics

Creating Custom User Roles, on page 57
Network Analysis Policy Management

On the Network Analysis Policy page (or Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy) you can view your current custom network analysis policies, along with the following information:

- the time and date the policy was last modified (in local time) and the user who modified it
- whether the Inline Mode setting is enabled, which allows preprocessors to affect traffic
- which access control policies and devices are using the network analysis policy to preprocess traffic
- whether a policy has unsaved changes, as well as information about who (if anyone) is currently editing the policy

In addition to custom policies that you create, the system provides two custom policies: Initial Inline Policy and Initial Passive Policy. These two network analysis policies use the Balanced Security and Connectivity network analysis policy as their base. The only difference between them is their inline mode, which allows preprocessors to affect traffic in the inline policy and disables it in the passive policy. You can edit and use these system-provided custom policies.

Note that you can create and edit network analysis as well as intrusion policies if your Firepower System user account’s role is restricted to Intrusion Policy or Modify Intrusion Policy.

Related Topics
- Creating a Custom Network Analysis Policy, on page 1061
- Editing Network Analysis Policies, on page 1063

Network Analysis Policy Settings and Cached Changes

When you create a new network analysis policy, it has the same settings as its base policy.

When tailoring a network analysis policy, especially when disabling preprocessors, keep in mind that some preprocessors and intrusion rules require that traffic first be decoded or preprocessed in a certain way. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy web interface.

Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task.

The system caches one network analysis policy per user. While editing a network analysis policy, if you select any menu or other path to another page, your changes stay in the system cache even if you leave the page.

Related Topics
- How Policies Examine Traffic For Intrusions, on page 834
- Limitations of Custom Policies, on page 843
Editing Network Analysis Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

Procedure

Step 1 Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2 Click the edit icon (-pencil) next to the network analysis policy you want to configure.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3 Edit your network analysis policy:

- Change the base policy — If you want to change the base policy, choose a base policy from the Base Policy drop-down list on the Policy Information page.
- Manage policy layers — If you want to manage policy layers, click Policy Layers in the navigation panel.
- Modify a preprocessor — If you want to enable, disable, or edit the settings for a preprocessor, click Settings in the navigation panel.
- Modify traffic — If you want to allow preprocessors to modify or drop traffic, check the Inline Mode check box on the Policy Information page.
- View settings — If you want to view the settings in the base policy, click Manage Base Policy on the Policy Information page.

Step 4 To save changes you made in this policy since the last policy commit, choose Policy Information, then click Commit Changes. If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

What to do next

- If you want a preprocessor to generate events and, in an inline deployment, drop offending packets, enable rules for the preprocessor. For more information, see Setting Intrusion Rule States, on page 889.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Preprocessor Configuration in a Network Analysis Policy

Preprocessors prepare traffic to be further inspected by normalizing traffic and identifying protocol anomalies. Preprocessors can generate preprocessorevents when packets trigger preprocessor optionsthat you configure. The base policy for your network analysis policy determines which preprocessors are enabled by default and the default configuration for each.

In most cases, preprocessors require specific expertise to configure and typically require little or no modification. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other.

Modifying a preprocessor configuration requires an understanding of the configuration and its potential impact on your network.

Note that some advanced transport and network preprocessor settings apply globally to all networks, zones, and VLANs where you deploy your access control policy. You configure these advanced settings in an access control policy rather than in a network analysis policy.

Note also that you configure the sensitive data preprocessor, which detects sensitive data such as credit card numbers and Social Security numbers in ASCII text, in intrusion policies.

Related Topics
- The DCE/RPC Preprocessor, on page 1067
- The DNP3 Preprocessor, on page 1135
- The DNS Preprocessor, on page 1078
- The FTP/Telnet Decoder, on page 1082
- The GTP Preprocessor, on page 1110
- The HTTP Inspect Preprocessor, on page 1089
- The IMAP Preprocessor, on page 1111
- The Inline Normalization Preprocessor, on page 1144
- The IP Defragmentation Preprocessor, on page 1150
- The Modbus Preprocessor, on page 1133
- The Packet Decoder, on page 1155
- The POP Preprocessor, on page 1115
- Sensitive Data Detection Basics, on page 907
- The SIP Preprocessor, on page 1105
- The SMTP Preprocessor, on page 1118
- The SSH Preprocessor, on page 1123
Preprocessor Traffic Modification in Inline Deployments

In an inline deployment (that is, where relevant configurations are deployed to devices using routed, switched, or transparent interfaces, or inline interface pairs), some preprocessors can modify and block traffic. For example:

• The inline normalization preprocessor normalizes packets to prepare them for analysis by other preprocessors and the intrusion rules engine. You can also use the preprocessor’s Allow These TCP Options and Block Unresolvable TCP Header Anomalies options to block certain packets.

• The system can drop packets with invalid checksums.

• The system can drop packets matching rate-based attack prevention settings.

For a preprocessor configured in the network analysis policy to affect traffic, you must enable and correctly configure the preprocessor, as well as correctly deploy managed devices inline. Finally, you must enable the network analysis policy’s Inline Mode setting.

Preprocessor Configuration in a Network Analysis Policy Notes

When you select Settings in the navigation panel of a network analysis policy, the policy lists its preprocessors by type. On the Settings page, you can enable or disable preprocessors in your network analysis policy, as well as access preprocessor configuration pages.

A preprocessor must be enabled for you to configure it. When you enable a preprocessor, a sublink to the configuration page for the preprocessor appears beneath the Settings link in the navigation panel, and an Edit link to the configuration page appears next to the preprocessor on the Settings page.

Tip

To revert a preprocessor’s configuration to the settings in the base policy, click Revert to Defaults on a preprocessor configuration page. When prompted, confirm that you want to revert.

When you disable a preprocessor, the sublink and Edit link no longer appear, but your configurations are retained. Note that to perform their particular analysis, many preprocessors and intrusion rules require that traffic first be decoded or preprocessed in a certain way. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy web interface.

If you want to assess how your configuration would function in an inline deployment without actually modifying traffic, you can disable inline mode. In passive deployments or inline deployments in tap mode, the system cannot affect traffic regardless of the inline mode setting.
Disabling inline mode can affect intrusion event performance statistics graphs. With inline mode enabled in an inline deployment, the Intrusion Event Performance page (Overview > Summary > Intrusion Event Performance) displays graphs that represent normalized and blocked packets. If you disable inline mode, or in a passive deployment, many of the graphs display data about the traffic the system would have normalized or dropped.

In an inline deployment, Cisco recommends that you enable inline mode and configure the inline normalization preprocessor with the Normalize TCP Payload option enabled. In a passive deployment, Cisco recommends that you use adaptive profiles.

Related Topics

- Advanced Transport/Network Preprocessor Settings, on page 1139
- Checksum Verification, on page 1142
- The Inline Normalization Preprocessor, on page 1144
- Intrusion Event Performance Statistics Graph Types, on page 1662
CHAPTER 59

Application Layer Preprocessors

The following topics explain application layer preprocessors and how to configure them:

- Introduction to Application Layer Preprocessors, on page 1067
- The DCE/RPC Preprocessor, on page 1067
- The DNS Preprocessor, on page 1078
- The FTP/Telnet Decoder, on page 1082
- The HTTP Inspect Preprocessor, on page 1089
- The Sun RPC Preprocessor, on page 1103
- The SIP Preprocessor, on page 1105
- The GTP Preprocessor, on page 1110
- The IMAP Preprocessor, on page 1111
- The POP Preprocessor, on page 1115
- The SMTP Preprocessor, on page 1118
- The SSH Preprocessor, on page 1123
- The SSL Preprocessor, on page 1127

Introduction to Application Layer Preprocessors

Application layer protocols can represent the same data in a variety of ways. The Firepower System provides application layer protocol decoders that normalize specific types of packet data into formats that the intrusion rules engine can analyze. Normalizing application-layer protocol encodings allows the rules engine to effectively apply the same content-related rules to packets whose data is represented differently and obtain meaningful results.

When an intrusion rule or rule argument requires a disabled preprocessor, the system automatically uses it with its current configuration even though it remains disabled in the network analysis policy’s web interface.

Note that preprocessors do not generate events in most cases unless you enable the accompanying preprocessor rules in an intrusion policy.

The DCE/RPC Preprocessor

The DCE/RPC protocol allows processes on separate network hosts to communicate as if the processes were on the same host. These inter-process communications are commonly transported between hosts over TCP and UDP. Within the TCP transport, DCE/RPC might also be further encapsulated in the Windows Server
Message Block (SMB) protocol or in Samba, an open-source SMB implementation used for inter-process communication in a mixed environment comprised of Windows and UNIX- or Linux-like operating systems. In addition, Windows IIS web servers on your network might use IIS RPC over HTTP, which provides distributed communication through a firewall, to proxy TCP-transported DCE/RPC traffic.

Note that descriptions of DCE/RPC preprocessor options and functionality include the Microsoft implementation of DCE/RPC known as MSRPC; descriptions of SMB options and functionality refer to both SMB and Samba.

Although most DCE/RPC exploits occur in DCE/RPC client requests targeted for DCE/RPC servers, which could be practically any host on your network that is running Windows or Samba, exploits can also occur in server responses. The DCE/RPC preprocessor detects DCE/RPC requests and responses encapsulated in TCP, UDP, and SMB transports, including TCP-transported DCE/RPC using version 1 RPC over HTTP. The preprocessor analyzes DCE/RPC data streams and detects anomalous behavior and evasion techniques in DCE/RPC traffic. It also analyzes SMB data streams and detects anomalous SMB behavior and evasion techniques.

The DCE/RPC preprocessor also desegments SMB and defragments DCE/RPC in addition to the IP defragmentation provided by the IP defragmentation preprocessor and the TCP stream reassembly provided by the TCP stream preprocessor.

Finally, the DCE/RPC preprocessor normalizes DCE/RPC traffic for processing by the rules engine.

**Connectionless and Connection-Oriented DCE/RPC Traffic**

DCE/RPC messages comply with one of two distinct DCE/RPC Protocol Data Unit (PDU) protocols:

- **connection-oriented DCE/RPC PDU protocol**
  
  The DCE/RPC preprocessor detects connection-oriented DCE/RPC in the TCP, SMB, and RPC over HTTP transports.

- **connectionless DCE/RPC PDU protocol**
  
  The DCE/RPC preprocessor detects connectionless DCE/RPC in the UDP transport.

The two DCE/RPC PDU protocols have their own unique headers and data characteristics. For example, the connection-oriented DCE/RPC header length is typically 24 bytes and the connectionless DCE/RPC header length is fixed at 80 bytes. Also, correct fragment order of fragmented connectionless DCE/RPC cannot be handled by a connectionless transport and, instead, must be ensured by connectionless DCE/RPC header values; in contrast, the transport protocol ensures correct fragment order for connection-oriented DCE/RPC.

The DCE/RPC preprocessor uses these and other protocol-specific characteristics to monitor both protocols for anomalies and other evasion techniques, and to decode and defragment traffic before passing it to the rules engine.

The following diagram illustrates the point at which the DCE/RPC preprocessor begins processing DCE/RPC traffic for the different transports.
Note the following in the figure:

- The well-known TCP or UDP port 135 identifies DCE/RPC traffic in the TCP and UDP transports.
- The figure does not include RPC over HTTP.
  For RPC over HTTP, connection-oriented DCE/RPC is transported directly over TCP as shown in the figure after an initial setup sequence over HTTP.
- The DCE/RPC preprocessor typically receives SMB traffic on the well-known TCP port 139 for the NetBIOS Session Service or the similarly implemented well-known Windows port 445.
  Because SMB has many functions other than transporting DCE/RPC, the preprocessor first tests whether the SMB traffic is carrying DCE/RPC traffic and stops processing if it is not or continues processing if it is.
- IP encapsulates all DCE/RPC transports.
- TCP transports all connection-oriented DCE/RPC.
- UDP transports connectionless DCE/RPC.

**DCE/RPC Target-Based Policies**

Windows and Samba DCE/RPC implementations differ significantly. For example, all versions of Windows use the DCE/RPC context ID in the first fragment when defragmenting DCE/RPC traffic, and all versions of Samba use the context ID in the last fragment. As another example, Windows Vista uses the opnum (operation number) header field in the first fragment to identify a specific function call, and Samba and all other Windows versions use the opnum field in the last fragment.

There are also significant differences in Windows and Samba SMB implementations. For example, Windows recognizes the SMB OPEN and READ commands when working with named pipes, but Samba does not recognize these commands.

When you enable the DCE/RPC preprocessor, you automatically enable a default target-based policy. Optionally, you can add target-based policies that target other hosts running different Windows or Samba versions. The default target-based policy applies to any host not included in another target-based policy.

In each target-based policy, you can:

- enable one or more transports and specify *detection ports* for each
• enable and specify *auto-detection ports*

• set the preprocessor to detect when there is an attempt to connect to one or more shared SMB resources that you identify

• configure the preprocessor to detect files in SMB traffic and to inspect a specified number of bytes in a detected file

• modify an advanced option that should be modified only by a user with SMB protocol expertise; this option lets you set the preprocessor to detect when a number of chained SMB AndX commands exceed a specified maximum number

In addition to enabling SMB traffic file detection in the DCE/RPC preprocessor, you can configure a file policy to optionally capture and block these files, or submit them to the Cisco AMP cloud for dynamic analysis. Within that policy, you must create a file rule with an *Action* of *Detect Files* or *Block Files* and a selected *Application Protocol* of *Any* or *NetBIOS-ssn (SMB).*

**RPC over HTTP Transport**

Microsoft RPC over HTTP allows you to tunnel DCE/RPC traffic through a firewall as shown in the following diagram. The DCE/RPC preprocessor detects version 1 of Microsoft RPC over HTTP.

![Diagram of RPC over HTTP Transport](image)

The Microsoft IIS proxy server and the DCE/RPC server can be on the same host or on different hosts. Separate proxy and server options provide for both cases. Note the following in the figure:

• The DCE/RPC server monitors port 593 for DCE/RPC client traffic, but the firewall blocks port 593. Firewalls typically block port 593 by default.

• RPC over HTTP transports DCE/RPC over HTTP using well-known HTTP port 80, which firewalls are likely to permit.

• Example 1 shows that you would choose the *RPC over HTTP proxy* option to monitor traffic between the DCE/RPC client and the Microsoft IIS RPC proxy server.

• Example 2 shows that you would choose the *RPC over HTTP server* option when the Microsoft IIS RPC proxy server and the DCE/RPC server are located on different hosts and the device monitors traffic between the two servers.
• Traffic is comprised solely of connection-oriented DCE/RPC over TCP after RPC over HTTP completes the proxied setup between the DCE/RPC client and server.

DCE/RPC Global Options

Global DCE/RPC preprocessor options control how the preprocessor functions. Note that, except for the Memory Cap Reached and Auto-Detect Policy on SMB Session options, modifying these options could have a negative impact on performance or detection capability. You should not modify them unless you have a thorough understanding of the preprocessor and the interaction between the preprocessor and enabled DCE/RPC rules.

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

Maximum Fragment Size

When Enable Defragmentation is selected, specifies the maximum DCE/RPC fragment length allowed. The preprocessor truncates larger fragments for processing purposes to the specified size before defragmenting but does not alter the actual packet. A blank field disables this option.

Make sure that the Maximum Fragment Size option is greater than or equal to the depth to which the rules need to detect.

Reassembly Threshold

When Enable Defragmentation is selected, 0 disables this option, or specifies a minimum number of fragmented DCE/RPC bytes and, if applicable, segmented SMB bytes to queue before sending a reassembled packet to the rules engine. A low value increases the likelihood of early detection but could have a negative impact on performance. You should test for performance impact if you enable this option.

Make sure that the Reassembly Threshold option is greater than or equal to the depth to which the rules need to detect.

Enable Defragmentation

Specifies whether to defragment fragmented DCE/RPC traffic. When disabled, the preprocessor still detects anomalies and sends DCE/RPC data to the rules engine, but at the risk of missing exploits in fragmented DCE/RPC data.

Although this option provides the flexibility of not defragmenting DCE/RPC traffic, most DCE/RPC exploits attempt to take advantage of fragmentation to hide the exploit. Disabling this option would bypass most known exploits, resulting in a large number of false negatives.

Memory Cap Reached

Detects when the maximum memory limit allocated to the preprocessor is reached or exceeded. When the maximum memory cap is reached or exceeded, the preprocessor frees all pending data associated with the session that caused the memory cap event and ignores the rest of that session.

You can enable rule 133:1 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.
Auto-Detect Policy on SMB Session

Detects the Windows or Samba version that is identified in SMB Session Setup AndX requests and responses. When the detected version is different from the Windows or Samba version configured for the Policy configuration option, the detected version overrides the configured version for that session only.

For example, if you set Policy to Windows XP and the preprocessor detects Windows Vista, the preprocessor uses a Windows Vista policy for that session. Other settings remain in effect.

When the DCE/RPC transport is not SMB (that is, when the transport is TCP or UDP), the version cannot be detected and the policy cannot be automatically configured.

To enable this option, choose one of the following from the drop-down list:

- Choose Client to inspect server-to-client traffic for the policy type.
- Choose Server to inspect client-to-server traffic for the policy type.
- Choose Both to inspect server-to-client and client-to-server traffic for the policy type.

Legacy SMB Inspection Mode

Specifies which SMB versions to inspect. When Legacy SMB Inspection Mode is enabled, the DCE/RPC preprocessor inspects only SMB Version 1 traffic. When this option is disabled, the DCE/RPC preprocessor inspects traffic that uses SMB Versions 1, 2, and 3.

Related Topics

Basic content and protected_content Keyword Arguments, on page 952
Overview: The byte_jump and byte_test Keywords

DCE/RPC Target-Based Policy Options

In each target-based policy, you can enable one or more of the TCP, UDP, SMB, and RPC over HTTP transports. When you enable a transport, you must also specify one or more detection ports, that is, ports that are known to carry DCE/RPC traffic.

Cisco recommends that you use the default detection ports, which are either well-known ports or otherwise commonly-used ports for each protocol. You would add detection ports only if you detected DCE/RPC traffic on a non-default port.

You can specify ports for one or more transports in any combination in a Windows target-based policy to match the traffic on your network, but you can only specify ports for the SMB transport in a Samba target-based policy.

Note

You must enable at least one DCE/RPC transport in the default target-based policy except when you have added a DCE/RPC target-based policy that has at least one transport enabled. For example, you might want to specify the hosts for all DCE/RPC implementations and not have the default target-based policy deploy to unspecified hosts, in which case you would not enable a transport for the default target-based policy.

Optionally, you can also enable and specify auto-detection ports, that is, ports that the preprocessor tests first to determine if they carry DCE/RPC traffic and continues processing only when it detects DCE/RPC traffic.

When you enable auto-detection ports, ensure that they are set to the port range from 1025 to 65535 to cover the entire ephemeral port range.
Note that auto-detection occurs only for ports not already identified by transport detection ports.

It is unlikely that you would enable or specify auto-detection ports for the RPC over HTTP Proxy Auto-Detect Ports option or the SMB Auto-Detect Ports option because there is little likelihood that traffic for either would occur or even be possible except on the specified default detection ports.

Each target-based policy allows you to specify the various options below. If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

**Networks**

The host IP addresses where you want to deploy the DCE/RPC target-based server policy. Also named the Server Address field in the Add Target pop-up window when you add a target-based policy.

You can specify a single IP address or address block, or a comma-separated list of either or both. You can configure up to 255 total profiles including the default policy.

> **Note**
> The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).

**Policy**

The Windows or Samba DCE/RPC implementation used by the targeted host or hosts on your monitored network segment.

Note that you can enable the Auto-Detect Policy on SMB Session global option to automatically override the setting for this option on a per session basis when SMB is the DCE/RPC transport.

**SMB Invalid Shares**

Identifies one or more SMB shared resources the preprocessor will detect when there is an attempt to connect to a shared resource that you specify. You can specify multiple shares in a comma-separated list and, optionally, you can enclose shares in quotes, which was required in previous software versions but is no longer required; for example:

"C$", D$, "admin", private

The preprocessor detects invalid shares in SMB traffic when you have enabled SMB Ports.

Note that in most cases you should append a dollar sign to a drive named by Windows that you identify as an invalid share. For example, identify drive C as C$ or "C$".

Note also that to detect SMB invalid shares, you must also enable SMB Ports or SMB Auto-Detect Ports.

You can enable rule 133:26 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.
**SMB Maximum AndX Chain**

The maximum number of chained SMB AndX commands to permit. Typically, more than a few chained AndX commands represent anomalous behavior and could indicate an evasion attempt. Specify 1 to permit no chained commands or 0 to disable detecting the number of chained commands.

Note that the preprocessor first counts the number of chained commands and generates an event if accompanying SMB preprocessor rules are enabled and the number of chained commands equals or exceeds the configured value. It then continues processing.

---

**Caution**

Only someone who is expert in the SMB protocol should modify the setting for the **SMB Maximum AndX Chains** option.

You can enable rule 133:20 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**RPC proxy traffic only**

Enabling **RPC over HTTP Proxy Ports** indicates whether detected client-side RPC over HTTP traffic is proxy traffic only or might include other web server traffic. For example, port 80 could carry both proxy and other web server traffic.

When this option is disabled, both proxy and other web server traffic are expected. Enable this option, for example, if the server is a dedicated proxy server. When enabled, the preprocessor tests traffic to determine if it carries DCE/RPC, ignores the traffic if it does not, and continues processing if it does. Note that enabling this option adds functionality only if the **RPC over HTTP Proxy Ports** check box is also enabled.

**RPC over HTTP Proxy Ports**

Enables detection of DCE/RPC traffic tunneled by RPC over HTTP over each specified port when your managed device is positioned between the DCE/RPC client and the Microsoft IIS RPC proxy server.

When enabled, you can add any ports where you see DCE/RPC traffic, although this is unlikely to be necessary because web servers typically use the default port for both DCE/RPC and other traffic. When enabled, you would not enable **RPC over HTTP Proxy Auto-Detect Ports**, but you would enable the **RPC Proxy Traffic Only** when detected client-side RPC over HTTP traffic is proxy traffic only and does not include other web server traffic.

---

**Note**

You would rarely, if ever, select this option.

**RPC over HTTP Server Ports**

Enables detection of DCE/RPC traffic tunneled by RPC over HTTP on each specified port when the Microsoft IIS RPC proxy server and the DCE/RPC server are located on different hosts and the device monitors traffic between the two servers.

Typically, when you enable this option you should also enable **RPC over HTTP Server Auto-Detect Ports** with a port range from 1025 to 65535 for that option even if you are not aware of any proxy web servers on your network. Note that the RPC over HTTP server port is sometimes reconfigured, in which case you should add the reconfigured server port to port list for this option.
TCP Ports

Enables detection of DCE/RPC traffic in TCP on each specified port.

Legitimate DCE/RPC traffic and exploits might use a wide variety of ports, and other ports above port 1024 are common. Typically, when this option is enabled you should also enable TCP Auto-Detect Ports with a port range from 1025 to 65535 for that option.

UDP Ports

Enables detection of DCE/RPC traffic in UDP on each specified port.

Legitimate DCE/RPC traffic and exploits might use a wide variety of ports, and other ports above port 1024 are common. Typically, when this option is enabled you should also enable UDP Auto-Detect Ports with a port range from 1025 to 65535 for that option.

SMB Ports

Enables detection of DCE/RPC traffic in SMB on each specified port.

You could encounter SMB traffic using the default detection ports. Other ports are rare. Typically, use the default settings.

Note that you can enable the Auto-Detect Policy on SMB Session global option to automatically override the policy type configured for a targeted policy on a per session basis when SMB is the DCE/RPC transport.

RPC over HTTP Proxy Auto-Detect Ports

Enables auto-detection of DCE/RPC traffic tunneled by RPC over HTTP on the specified ports when your managed device is positioned between the DCE/RPC client and the Microsoft IIS RPC proxy server.

When enabled, you would typically specify a port range from 1025 to 65535 to cover the entire range of ephemeral ports.

RPC over HTTP Server Auto-Detect Ports

Enables auto-detection of DCE/RPC traffic tunneled by RPC over HTTP on the specified ports when the Microsoft IIS RPC proxy server and the DCE/RPC server are located on different hosts and the device monitors traffic between the two servers.

TCP Auto-Detect Ports

Enables auto-detection of DCE/RPC traffic in TCP on the specified ports.

UDP Auto-Detect Ports

Enables auto-detection of DCE/RPC traffic in UDP on each specified port.

SMB Auto-Detect Ports

Enables auto-detection of DCE/RPC traffic in SMB.

---

**Note**

You would rarely, if ever, select this option.
SMB File Inspection

Enables inspection of SMB traffic for file detection. You have the following options:

- Select **Off** to disable file inspection.
- Select **Only** to inspect file data without inspecting the DCE/RPC traffic in SMB. Selecting this option can improve performance over inspecting both files and DCE/RPC traffic.
- Select **On** to inspect both files and the DCE/RPC traffic in SMB. Selecting this option can impact performance.

Inspection of SMB traffic for the following is not supported:

- files transferred in an established TCP or SMB session before this option is enabled and the policy applied
- files transferred concurrently in a single TCP or SMB session
- files transferred across multiple TCP or SMB sessions
- files transferred with non-contiguous data, such as when message signing is negotiated
- files transferred with different data at the same offset, overlapping the data
- files opened on a remote client for editing that the client saves to the file server

SMB File Inspection Depth

If **SMB File Inspection** is set to **Only** or **On**, the number of bytes inspected when a file is detected in SMB traffic. Specify one of the following:

- a positive value
- 0 to inspect the entire file
- -1 to disable file inspection

Enter a value in this field equal to or smaller than the one defined in the File and Malware Settings section of the Advanced tab in your access control policy. If you set a value for this option larger than the one defined for **Limit the number of bytes inspected when doing file type detection**, the system uses the access control policy setting as the functional maximum.

If **SMB File Inspection** is set to **Off**, this field is disabled.

**Related Topics**

**Firepower System IP Address Conventions**, on page 14

**Traffic-Associated DCE/RPC Rules**

Most DCE/RPC preprocessor rules trigger against anomalies and evasion techniques detected in SMB, connection-oriented DCE/RPC, or connectionless DCE/RPC traffic. The following table identifies the rules that you can enable for each type of traffic.
Configuring the DCE/RPC Preprocessor

### Table 165: Traffic-Associated DCE/RPC Rules

<table>
<thead>
<tr>
<th>Traffic</th>
<th>Preprocessor Rule GID:SID</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMB</td>
<td>133:2 through 133:26, and 133:48 through 133:57</td>
</tr>
<tr>
<td>Connection-Oriented DCE/RPC</td>
<td>133:27 through 133:39</td>
</tr>
<tr>
<td>Detect Connectionless DCE/RPC</td>
<td>133:40 through 133:43</td>
</tr>
</tbody>
</table>

#### Configuring the DCE/RPC Preprocessor

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You configure the DCE/RPC preprocessor by modifying any of the global options that control how the preprocessor functions, and by specifying one or more target-based server policies that identify the DCE/RPC servers on your network by IP address and by either the Windows or Samba version running on them. Target-based policy configuration also includes enabling transport protocols, specifying the ports carrying DCE/RPC traffic to those hosts, and setting other server-specific options.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

**Before you begin**

- Confirm that networks you want to identify in a custom target-based policy match or are a subset of the networks, zones, and VLANs handled by its parent network analysis policy. See Advanced Settings for Network Analysis Policies, on page 1053 for more information.

**Procedure**

1. **Step 1** Choose **Policies > Access Control**, then click **Network Analysis Policy** or **Policies > Access Control > Intrusion**, then click **Network Analysis Policy**.
   **Note** If your custom user role limits access to the first path listed here, use the second path to access the policy.

2. **Step 2** Click the edit icon (.pen) next to the policy you want to edit.
   If a view icon (.pen) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

3. **Step 3** Click **Settings** in the navigation panel on the left.

4. **Step 4** If **DCE/RPC Configuration** under **Application Layer Preprocessors** is disabled, click **Enabled**.

5. **Step 5** Click the edit icon (.pen) next to **DCE/RPC Configuration**.
Step 6 Modify the options in the Global Settings section; see DCE/RPC Global Options, on page 1071.

Step 7 You have the following choices:

- Add a server profile — Click the add icon ( ) next to Servers. Specify one or more IP addresses in the Server Address field, then click OK.
- Delete a server profile — Click the delete icon ( ) next to the policy.
- Edit a server profile — Click the configured address for the profile under Servers, or click default. You can modify any of the settings in the Configuration section; see DCE/RPC Target-Based Policy Options, on page 1072.

Step 8 To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

What to do next

- If you want to generate intrusion events, enable DCE/RPC preprocessor rules (GID 132 or 133). For more information, see Setting Intrusion Rule States, on page 889, DCE/RPC Global Options, on page 1071, DCE/RPC Target-Based Policy Options, on page 1072, and Traffic-Associated DCE/RPC Rules, on page 1076.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

- Firepower System IP Address Conventions, on page 14
- File and Malware Inspection Performance and Storage Options, on page 827
- DCE/RPC Keywords, on page 996
- Managing Layers, on page 856
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

The DNS Preprocessor

The DNS preprocessor inspects DNS name server responses for the following specific exploits:

- Overflow attempts on RData text fields
- Obsolete DNS resource record types
- Experimental DNS resource record types

The most common type of DNS name server response provides one or more IP addresses that correspond to domain names in the query that prompted the response. Other types of server responses provide, for example, the destination of an email message or the location of a name server that can provide information not available from the server originally queried.

A DNS response is comprised of:

- a message header
• a Question section that contains one or more requests
• three sections that respond to requests in the Question section
  • Answer
  • Authority
  • Additional Information.

Responses in these three sections reflect the information in resource records (RR) maintained on the name server. The following table describes these three sections.

<table>
<thead>
<tr>
<th>This section...</th>
<th>Includes...</th>
<th>For example...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer</td>
<td>Optionally, one or more resource records that provide a specific answer to a query</td>
<td>The IP address corresponding to a domain name</td>
</tr>
<tr>
<td>Authority</td>
<td>Optionally, one or more resource records that point to an authoritative name server for the response</td>
<td></td>
</tr>
<tr>
<td>Additional Information</td>
<td>Optionally, one or more resource records that provided additional information related to the Answer sections</td>
<td>The IP address of another server to query</td>
</tr>
</tbody>
</table>

There are many types of resource records, all adhering to the following structure:

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Class</th>
<th>TTL</th>
<th>RData Length</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Theoretically, any type of resource record can be used in the Answer, Authority, or Additional Information section of a name server response message. The DNS preprocessor inspects any resource record in each of the three response sections for the exploits it detects.

The Type and RData resource record fields are of particular importance to the DNS preprocessor. The Type field identifies the type of resource record. The RData (resource data) field provides the response content. The size and content of the RData field differ depending on the type of resource record.

DNS messages typically use the UDP transport protocol but also use TCP when the message type requires reliable delivery or the message size exceeds UDP capabilities. The DNS preprocessor inspects DNS server responses in both UDP and TCP traffic.

The DNS preprocessor does not inspect TCP sessions picked up in midstream, and ceases inspection if a session loses state because of dropped packets.
DNS Preprocessor Options

Ports
This field specifies the source port or ports the DNS preprocessor should monitor for DNS server responses. Separate multiple ports with commas.

The typical port to configure for the DNS preprocessor is well-known port 53, which DNS name servers use for DNS messages in both UDP and TCP.

Detect Overflow attempts on RData Text fields
When the resource record type is TXT (text), the RData field is a variable-length ASCII text field.

When selected, this option detects a specific vulnerability identified by entry CVE-2006-3441 in MITRE’s Current Vulnerabilities and Exposures database. This is a known vulnerability in Microsoft Windows 2000 Service Pack 4, Windows XP Service Pack 1 and Service Pack 2, and Windows Server 2003 Service Pack 1. An attacker can exploit this vulnerability and take complete control of a host by sending or otherwise causing the host to receive a maliciously crafted name server response that causes a miscalculation in the length of an RData text field, resulting in a buffer overflow.

You should enable this option when your network might include hosts running operating systems that have not been upgraded to correct this vulnerability.

You can enable rule 131:3 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Detect Obsolete DNS RR Types
RFC 1035 identifies several resource record types as obsolete. Because these are obsolete record types, some systems do not account for them and may be open to exploits. You would not expect to encounter these record types in normal DNS responses unless you have purposely configured your network to include them.

You can configure the system to detect known obsolete resource record types. The following table lists and describes these record types.

Table 167: Obsolete DNS Resource Record Types

<table>
<thead>
<tr>
<th>RR Type</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>MD</td>
<td>a mail destination</td>
</tr>
<tr>
<td>4</td>
<td>MF</td>
<td>a mail forwarder</td>
</tr>
</tbody>
</table>

You can enable rule 131:1 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Detecting Experimental DNS RR Types
RFC 1035 identifies several resource record types as experimental. Because these are experimental record types, some systems do not account for them and may be open to exploits. You would not expect to encounter these record types in normal DNS responses unless you have purposely configured your network to include them.
You can configure the system to detect known experimental resource record types. The following table lists and describes these record types.

Table 168: Experimental DNS Resource Record Types

<table>
<thead>
<tr>
<th>RR Type</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>MB</td>
<td>a mailbox domain name</td>
</tr>
<tr>
<td>8</td>
<td>MG</td>
<td>a mail group member</td>
</tr>
<tr>
<td>9</td>
<td>MR</td>
<td>a mail rename domain name</td>
</tr>
<tr>
<td>10</td>
<td>NUL</td>
<td>a null resource record</td>
</tr>
</tbody>
</table>

You can enable rule 131:2 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Configuring the DNS Preprocessor

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

Procedure

Step 1 Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2 Click the edit icon ( pencil ) next to the policy you want to edit.

If a view icon ( eye ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3 Click Settings in the navigation panel.

Step 4 If DNS Configuration under Application Layer Preprocessors is disabled, click Enabled.

Step 5 Click the edit icon ( pencil ) next to DNS Configuration.

Step 6 Modify the settings described in DNS Preprocessor Options, on page 1080.

Step 7 To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.
If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

What to do next

- If you want to generate intrusion events, enable DNS preprocessor rules (GID 131). For more information, see Setting Intrusion Rule States, on page 889 and DNS Preprocessor Options, on page 1080.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

- Layers in Intrusion and Network Analysis Policies, on page 849
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

The FTP/Telnet Decoder

The FTP/Telnet decoder analyzes FTP and telnet data streams, normalizing FTP and telnet commands before processing by the rules engine.

Global FTP and Telnet Options

You can set global options to determine whether the FTP/Telnet decoder performs stateful or stateless inspection of packets, whether the decoder detects encrypted FTP or telnet sessions, and whether the decoder continues to check a data stream after it encounters encrypted data.

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

Stateful Inspection
When selected, causes the FTP/Telnet decoder to save state and provide session context for individual packets and only inspect reassembled sessions. When cleared, analyzes each individual packet without session context.

To check for FTP data transfers, this option must be selected.

Detect Encrypted Traffic
Detects encrypted telnet and FTP sessions.

You can enable rules 125:7 and 126:2 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Continue to Inspect Encrypted Data
Instructs the preprocessor to continue checking a data stream after it is encrypted, looking for eventual decrypted data that can be processed.
**Telnet Options**

You can enable or disable normalization of telnet commands by the FTP/Telnet decoder, enable or disable a specific anomaly case, and set the threshold number of Are You There (AYT) attacks to permit. If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

**Ports**

Indicates the ports whose telnet traffic you want to normalize. Telnet typically connects to TCP port 23. In the interface, list multiple ports separated by commas.

⚠️ **Caution**

Because encrypted traffic (SSL) cannot be decoded, adding port 22 (SSH) could yield unexpected results.

**Normalize**

Normalizes telnet traffic to the specified ports.

**Detect Anomalies**

Enables detection of Telnet SB (subnegotiation begin) without the corresponding SE (subnegotiation end). Telnet supports subnegotiation, which begins with SB (subnegotiation begin) and must end with an SE (subnegotiation end). However, certain implementations of Telnet servers will ignore the SB without a corresponding SE. This is anomalous behavior that could be an evasion case. Because FTP uses the Telnet protocol on the control connection, it is also susceptible to this behavior.

You can enable rule 126:3 to generate an event and, in an inline deployment, drop offending packets when this anomaly is detected in Telnet traffic, and rule 125:9 when it is detected on the FTP command channel. See Setting Intrusion Rule States, on page 889.

**Are You There Attack Threshold Number**

Detects when the number of consecutive AYT commands exceeds the specified threshold. Cisco recommends that you set the AYT threshold to a value no higher than the default value.

You can enable rule 126:1 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Server-Level FTP Options**

You can set options for decoding on multiple FTP servers. Each server profile you create contains the server IP address and the ports on the server where traffic should be monitored. You can specify which FTP commands to validate and which to ignore for a particular server, and set maximum parameter lengths for commands. You can also set the specific command syntax the decoder should validate against for particular commands and set alternate maximum command parameter lengths.

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
Networks

Use this option to specify one or more IP addresses of FTP servers.

You can specify a single IP address or address block, or a comma-separated list comprised of either or both. You can configure up to 1024 characters, and you can specify up to 255 profiles including the default profile.

Note

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or address block for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).

Ports

Use this option to specify the ports on the FTP server where the managed device should monitor traffic. In the interface, list multiple ports separated by commas. Port 21 is the well-known port for FTP traffic.

File Get Commands

Use this option to define the FTP commands used to transfer files from server to client. Do not change these values unless directed to do so by Support.

Caution

Do not modify the File Get Commands field unless directed to by Support.

File Put Commands

Use this option to define the FTP commands used to transfer files from client to server. Do not change these values unless directed to do so by Support.

Caution

Do not modify the File Put Commands field unless directed to by Support.

Additional FTP Commands

Use this line to specify the additional commands that the decoder should detect. Separate additional commands by spaces.

Additional commands you may want to add include XPWD, XCWD, XCUP, XMKD, and XRMD. For more information on these commands, see RFC 775, the Directory oriented FTP commands specification by the Network Working Group.

Default Max Parameter Length

Use this option to detect the maximum parameter length for commands where an alternate maximum parameter length has not been set. You can add as many alternative maximum parameter lengths as needed.
You can enable rule 125:3 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Alternate Max Parameter Length**

Use this option to specify commands where you want to detect a different maximum parameter length, and to specify the maximum parameter length for those commands. Click Add to add lines where you can specify a different maximum parameter length to detect for particular commands.

**Check Commands for String Format Attacks**

Use this option to check the specified commands for string format attacks.

You can enable rule 125:5 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Command Validity**

Use this option to enter a valid format for a specific command. Click Add to add a command validation line.

You can enable rules 125:2 and 125:4 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Ignore FTP Transfers**

Use this option to improve performance on FTP data transfers by disabling all inspection other than state inspection on the data transfer channel.

---

**Note**

To inspect data transfers, the global FTP/Telnet Stateful Inspection option must be selected.

**Detect Telnet Escape Codes within FTP Commands**

Use this option to detect when telnet commands are used over the FTP command channel.

You can enable rule 125:1 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Ignore Erase Commands during Normalization**

When Detect Telnet Escape Codes within FTP Commands is selected, use this option to ignore telnet character and line erase commands when normalizing FTP traffic. The setting should match how the FTP server handles telnet erase commands. Note that newer FTP servers typically ignore telnet erase commands, while older servers typically process them.

**Troubleshooting Option: Log FTP Command Validation Configuration**

Support might ask you during a troubleshooting call to configure your system to print the configuration information for each FTP command listed for the server.

---

**Caution**

Do not enable Log FTP Command Validation Configuration unless instructed to do so by Support.
FTP Command Validation Statements

When setting up a validation statement for an FTP command, you can specify a group of alternative parameters by separating the parameters with spaces. You can also create a binary OR relationship between two parameters by separating them with a pipe character (|) in the validation statement. Surrounding parameters by square brackets ([ ]) indicates that those parameters are optional. Surrounding parameters with curly brackets ({ }) indicates that those parameters are required.

You can create FTP command parameter validation statements to validate the syntax of a parameter received as part of an FTP communication.

Any of the parameters listed in the following table can be used in FTP command parameter validation statements.

Table 169: FTP Command Parameters

<table>
<thead>
<tr>
<th>If you use...</th>
<th>The following validation occurs...</th>
</tr>
</thead>
<tbody>
<tr>
<td>int</td>
<td>The represented parameter must be an integer.</td>
</tr>
<tr>
<td>number</td>
<td>The represented parameter must be an integer between 1 and 255.</td>
</tr>
<tr>
<td>char _chars</td>
<td>The represented parameter must be a single character and a member of the characters specified in the _chars argument. For example, defining the command validity for MODE with the validation statement char SBC checks that the parameter for the MODE command comprises the character S (representing Stream mode), the character B (representing Block mode), or the character C (representing Compressed mode).</td>
</tr>
<tr>
<td>date _datefmt</td>
<td>If _datefmt contains #, the represented parameter must be a number. If _datefmt contains c, the represented parameter must be a character. If _datefmt contains literal strings, the represented parameter must match the literal string.</td>
</tr>
<tr>
<td>string</td>
<td>The represented parameter must be a string.</td>
</tr>
<tr>
<td>host_port</td>
<td>The represented parameter must be a valid host port specifier as defined by RFC 959, the File Transfer Protocol specification by the Network Working Group.</td>
</tr>
</tbody>
</table>

You can combine the syntax in the table above as needed to create parameter validation statements that correctly validate each FTP command where you need to validate traffic.

Note

When you include a complex expression in a TYPE command, surround it by spaces. Also, surround each operand within the expression by spaces. For example, type char A | B, not char A|B.
Related Topics

- Server-Level FTP Options, on page 1083
- Firepower System IP Address Conventions, on page 14
- FTP Command Validation Statements, on page 1086

Client-Level FTP Options

Use these options to configure custom FTP client profiles. If an option description does not include a preprocessor rule, the option is not associated with a preprocessor rule.

**Networks**

Use this option to specify one or more IP addresses of FTP clients.

You can specify a single IP address or address block, or a comma-separated list comprised of either or both. You can specify up to 1024 characters, and you can specify up to 255 profiles including the default profile.

---

**Note**

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or address block for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).

**Max Response Length**

Use this option to specify the maximum allowed response length to an FTP command accepted by the client. This can detect basic buffer overflows.

You can enable rule 125:6 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Detect FTP Bounce Attempts**

Use this option to detect FTP bounce attacks.

You can enable rule 125:8 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Allow FTP Bounce to**

Use this option to configure a list of additional hosts and ports on those hosts on which FTP PORT commands should not be treated as FTP bounce attacks.

**Detect Telnet Escape Codes within FTP Commands**

Use this option to detect when telnet commands are used over the FTP command channel.

You can enable rule 125:1 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.
Ignore Erase Commands During Normalization

When Detect Telnet Escape Codes within FTP Commands is selected, use this option to ignore telnet character and line erase commands when normalizing FTP traffic. The setting should match how the FTP client handles telnet erase commands. Note that newer FTP clients typically ignore telnet erase commands, while older clients typically process them.

Related Topics
Firepower System IP Address Conventions, on page 14

Configuring the FTP/Telnet Decoder

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

You can configure client profiles for FTP clients to monitor FTP traffic from clients.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Before you begin

• Confirm that any networks you want to identify in a custom target-based policy match or are a subset of the networks, zones, and VLANs handled by its parent network analysis policy. See Advanced Settings for Network Analysis Policies, on page 1053 for more information.

Procedure

Step 1  Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note  If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2  Click the edit icon ( MODIFY ) next to the policy you want to edit.

If a view icon ( VIEW ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3  Click Settings in the navigation panel.

Step 4  If FTP and Telnet Configuration under Application Layer Preprocessors is disabled, click Enabled.

Step 5  Click the edit icon ( MODIFY ) next to FTP and Telnet Configuration.

Step 6  Set options in the Global Settings section as described in Global FTP and Telnet Options, on page 1082.

Step 7  Set options in the Telnet Settings section as described in Telnet Options, on page 1083.

Step 8  Manage FTP server profiles:
• Add a server profile — Click the add icon ( ) next to FTP Server. Specify one or more IP addresses for the client in the Server Address field and click OK. You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 1024 characters, and you can configure up to 255 policies, including the default policy.

• Edit a server profile — Click the configured address for a custom profile under FTP Server, or click default. You can modify the settings in the Configuration section; see Server-Level FTP Options, on page 1083.

• Delete a server profile — Click the delete icon ( ) next to the profile.

Step 9 Manage FTP client profiles:

• Add a client profile — Click the add icon ( ) next to FTP Client. Specify one or more IP addresses for the client in the Client Address field and click OK. You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 1024 characters, and you can configure up to 255 policies, including the default policy.

• Edit a client profile — Click the configured address for a profile you have added under FTP Client, or click default. You can modify the settings in the Configuration page area; see Client-Level FTP Options, on page 1087.

• Delete a client profile — Click the delete icon ( ) next to a custom profile.

Step 10 To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

What to do next

• If you want to generate intrusion events, enable FTP and telnet preprocessor rules (GID 125 and 126). For more information, see Setting Intrusion Rule States, on page 889.

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

  Firepower System IP Address Conventions, on page 14
  Managing Layers, on page 856
  Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

The HTTP Inspect Preprocessor

The HTTP Inspect preprocessor is responsible for:

• decoding and normalizing HTTP requests sent to and HTTP responses received from web servers on your network

• separating messages sent to web servers into URI, non-cookie header, cookie header, method, and message body components to improve performance of HTTP-related intrusion rules
• separating messages received from web servers into status code, status message, non-set-cookie header, cookie header, and response body components to improve performance of HTTP-related intrusion rules
• detecting possible URI-encoding attacks
• making the normalized data available for additional rule processing

HTTP traffic can be encoded in a variety of formats, making it difficult for rules to appropriately inspect. HTTP Inspect decodes 14 types of encoding, ensuring that your HTTP traffic gets the best inspection possible.

You can configure HTTP Inspect options globally, on a single server, or for a list of servers.

Note that the preprocessor engine performs HTTP normalization statelessly. That is, it normalizes HTTP strings on a packet-by-packet basis, and can only process HTTP strings that have been reassembled by the TCP stream preprocessor.

Global HTTP Normalization Options

The global HTTP options provided for the HTTP Inspect preprocessor control how the preprocessor functions. Use these options to enable or disable HTTP normalization when ports not specified as web server ports receive HTTP traffic.

Note the following:

• If you enable Unlimited Decompression, the Maximum Compressed Data Depth and Maximum Decompressed Data Depth options are automatically set to 65535 when you commit your changes.

• The highest value is used when the values for Maximum Compressed Data Depth or Maximum Decompressed Data Depth are different in:
  • the default network analysis policy
  • any other custom network analysis policy invoked by network analysis rules in the same access control policy

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

Detect Anomalous HTTP Servers

Detects HTTP traffic sent to or received by ports not specified as web server ports.

Note

If you turn this option on, be sure to list all ports that do receive HTTP traffic in a server profile on the HTTP Configuration page. If you do not, and you enable this option and the accompanying preprocessor rule, normal traffic to and from the server will generate events. The default server profile contains all ports normally used for HTTP traffic, but if you modified that profile, you may need to add those ports to another profile to prevent events from being generated.

You can enable rule 120:1 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.
Detect HTTP Proxy Servers

Detects HTTP traffic using proxy servers not defined by the Allow HTTP Proxy Use option.

You can enable rule 119:17 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Maximum Compressed Data Depth

Sets the maximum size of compressed data to decompress when Inspect Compressed Data (and, optionally, Decompress SWF File (LZMA), Decompress SWF File (Deflate), or Decompress PDF File (Deflate)) is enabled.

Maximum Decompressed Data Depth

Sets the maximum size of the normalized decompressed data when Inspect Compressed Data (and, optionally, Decompress SWF File (LZMA), Decompress SWF File (Deflate), or Decompress PDF File (Deflate)) is enabled.

Server-Level HTTP Normalization Options

You can set server-level options for each server you monitor, globally for all servers, or for a list of servers. Additionally, you can use a predefined server profile to set these options, or you can set them individually to meet the needs of your environment. Use these options, or one of the default profiles that set these options, to specify the HTTP server ports whose traffic you want to normalize, the amount of server response payload you want to normalize, and the types of encoding you want to normalize.

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

Networks

Use this option to specify the IP address of one or more servers. You can specify a single IP address or address block, or a comma-separated list comprised of either or both.

In addition to a limit of up to 255 total profiles, including the default profile, you can include up to 496 characters, or approximately 26 entries, in an HTTP server list, and specify a total of 256 address entries for all server profiles.

Note

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).

Ports

The ports whose HTTP traffic the preprocessor engine normalizes. Separate multiple port numbers with commas.
Oversize Dir Length

Detects URL directories longer than the specified value.

You can enable rule 119:15 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Client Flow Depth

Specifies the number of bytes for rules to inspect in raw HTTP packets, including header and payload data, in client-side HTTP traffic defined in Ports. Client flow depth does not apply when HTTP content rule options within a rule inspect specific parts of a request message.

Specify any of the following:

• A positive value inspects the specified number of bytes in the first packet. If the first packet contains fewer bytes than specified, inspect the entire packet. Note that the specified value applies to both segmented and reassembled packets.

  Note also that a value of 300 typically eliminates inspection of large HTTP Cookies that appear at the end of many client request headers.

• 0 inspects all client-side traffic, including multiple packets in a session and exceeding the upper byte limit if necessary. Note that this value is likely to affect performance.

• -1 ignores all client-side traffic.

Server Flow Depth

Specifies the number of bytes for rules to inspect in raw HTTP packets in server-side HTTP traffic specified by Ports. Inspection includes the raw header and payload when Inspect HTTP Responses disabled and only the raw response body when Inspect HTTP Response is enabled.

Server flow depth specifies the number of bytes of raw server response data in a session for rules to inspect in server-side HTTP traffic defined in Ports. You can use this option to balance performance and the level of inspection of HTTP server response data. Server flow depth does not apply when HTTP content options within a rule inspect specific parts of a response message.

Unlike client flow depth, server flow depth specifies the number of bytes per HTTP response, not per HTTP request packet, for rules to inspect.

You can specify any of the following:

• A positive value:

  When Inspect HTTP Responses is enabled, inspects only the raw HTTP response body, and not raw HTTP headers; also inspects decompressed data when Inspect Compressed Data is enabled.

  When Inspect HTTP Responses is disabled, inspects the raw packet header and payload.

  If the session includes fewer response bytes than specified, rules fully inspect all response packets in a given session, across multiple packets as needed. If the session includes more response bytes than specified, rules inspect only the specified number of bytes for that session, across multiple packets as needed.

  Note that a small flow depth value may cause false negatives from rules that target server-side traffic defined in Ports. Most of these rules target either the HTTP header or content that is likely to be in the first hundred or so bytes of non-header data. Headers are usually under 300 bytes long, but header size may vary.
Note also that the specified value applies to both segmented and reassembled packets.

- 0 inspects the entire packet for all HTTP server-side traffic defined in **Ports**, including response data in a session that exceeds 65535 bytes.

  Note that this value is likely to affect performance.

- -1:

  When **Inspect HTTP Responses** is enabled, inspects only raw HTTP headers and not the raw HTTP response body.

  When **Inspect HTTP Responses** is disabled, ignores all server-side traffic defined in **Ports**.

**Maximum Header Length**

Detects a header field longer than the specified maximum number of bytes in an HTTP request; also in HTTP responses when **Inspect HTTP Responses** is enabled. A value of 0 disables this option. Specify a positive value to enable it.

You can enable rule 119:19 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Maximum Number of Headers**

Detects when the number of headers exceeds this setting in an HTTP request. A value of 0 disables this option. Specify a positive value to enable it.

You can enable rule 119:20 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Maximum Number of Spaces**

Detects when the number of white spaces in a folded line equals or exceeds this setting in an HTTP request. A value of 0 disables this option. Specify a positive value to enable it.

You can enable rule 119:26 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**HTTP Client Body Extraction Depth**

Specifies the number of bytes to extract from the message body of an HTTP client request. You can use an intrusion rule to inspect the extracted data by selecting the *content* or *protected_content* keyword **HTTP Client Body** option.

Specify -1 to ignore the client body. Specify 0 to extract the entire client body. Note that identifying specific bytes to extract can improve system performance. Note also that you must specify a value greater than or equal to 0 for the **HTTP Client Body** option to function in an intrusion rule.

**Small Chunk Size**

Specifies the maximum number of bytes at which a chunk is considered small. Specify a positive value. A value of 0 disables detection of anomalous consecutive small segments. See the **Consecutive Small Chunks** option for more information.
**Consecutive Small Chunks**

Specifies how many consecutive small chunks represent an abnormally large number in client or server traffic that uses chunked transfer encoding. The **Small Chunk Size** option specifies the maximum size of a small chunk.

For example, set **Small Chunk Size** to 10 and **Consecutive Small Chunks** to 5 to detect 5 consecutive chunks of 10 bytes or less.

You can enable preprocessor rule 119:27 to generate events and, in an inline deployment, drop offending packets on excessive small chunks in client traffic, and rule 120:7 in server traffic. When **Small Chunk Size** is enabled and this option is set to 0 or 1, enabling these rules would trigger an event on every chunk of the specified size or less.

**HTTP Methods**

Specifies HTTP request methods in addition to GET and POST that you expect the system to encounter in traffic. Use a comma to separate multiple values.

Intrusion rules use the `content` or `protected_content` keyword with the **HTTP Method** argument to search for content in HTTP methods. You can enable rule 119:31 to generate events and, in an inline deployment, drop offending packets when a method other than GET, POST, or a method configured for this option is encountered in traffic. See Setting Intrusion Rule States, on page 889.

**No Alerts**

Disables intrusion events when accompanying preprocessor rules are enabled.

---

**Note**

This option does **not** disable HTTP standard text rules and shared object rules.

---

**Normalize HTTP Headers**

When **Inspect HTTP Responses** is enabled, enables normalization of non-cookie data in request and response headers. When **Inspect HTTP Responses** is **not** enabled, enables normalization of the entire HTTP header, including cookies, in request and response headers.

**Inspect HTTP Cookies**

Enables extraction of cookies from HTTP request headers. Also enables extraction of set-cookie data from response headers when **Inspect HTTP Responses** is enabled. Disabling this option when cookie extraction is not required can improve performance.

Note that the **Cookie:** and **Set-Cookie:** header names, leading spaces on the header line, and the **CRLF** that terminates the header line are inspected as part of the header and not as part of the cookie.

**Normalize Cookies in HTTP headers**

Enables normalization of cookies in HTTP request headers. When **Inspect HTTP Responses** is enabled, also enables normalization of set-cookie data in response headers. You must select **Inspect HTTP Cookies** before selecting this options.
Allow HTTP Proxy Use

Allows the monitored web server to be used as an HTTP proxy. This option is used only in the inspection of HTTP requests.

Inspect URI Only

Inspects only the URI portion of the normalized HTTP request packet.

Inspect HTTP Responses

Enables extended inspection of HTTP responses so, in addition to decoding and normalizing HTTP request messages, the preprocessor extracts response fields for inspection by the rules engine. Enabling this option causes the system to extract the response header, body, status code, and so on, and also extracts set-cookie data when Inspect HTTP Cookies is enabled.

You can enable rules 120:2 and 120:3 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Normalize UTF Encodings to UTF-8

When Inspect HTTP Responses is enabled, detects UTF-16LE, UTF-16BE, UTF-32LE, and UTF32-BE encodings in HTTP responses and normalizes them to UTF-8.

You can enable rule 120:4 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Inspect Compressed Data

When Inspect HTTP Responses is enabled, enables deconstruction of gzip and deflate-compatible compressed data in the HTTP response body, and inspection of the normalized decompressed data. The system inspects chunked and non-chunked HTTP response data. The system inspects decompressed data packet by packet across multiple packets as needed; that is, the system does not combine the decompressed data from different packets for inspection. Decompression ends when Maximum Compressed Data Depth, Maximum Decompressed Data Depth, or the end of the compressed data is reached. Inspection of decompressed data ends when Server Flow Depth is reached unless you also select Unlimited Decompression. You can use the file_data rule keyword to inspect decompressed data.

You can enable rule 120:6 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Unlimited Decompression

When Inspect Compressed Data (and, optionally, Decompress SWF File (LZMA), Decompress SWF File (Deflate), or Decompress PDF File (Deflate)) is enabled, overrides Maximum Decompressed Data Depth across multiple packets; that is, this option enables unlimited decompression across multiple packets. Note that enabling this option does not affect Maximum Compressed Data Depth or Maximum Decompressed Data Depth within a single packet. Note also that enabling this option sets Maximum Compressed Data Depth and Maximum Decompressed Data Depth to 65535 when you commit your changes.

Normalize Javascript

When Inspect HTTP Responses is enabled, enables detection and normalization of Javascript within the HTTP response body. The preprocessor normalizes obfuscated Javascript data such as the unescape and
decodeURI functions and the String.fromCharCode method. The preprocessor normalizes the following encodings within the unescape, decodeURI, and decodeURIComponent functions:

- `%XX`
- `%uXXXX`
- `0xXX`
- `\xXX`
- `\uXXXX`

The preprocessor detects consecutive white spaces and normalizes them into a single space. When this option is enabled, a configuration field allows you to specify the maximum number of consecutive white spaces to permit in obfuscated Javascript data. You can enter a value from 1 to 65535. The value 0 disables event generation, regardless of whether the preprocessor rule (120:10) associated with this field is enabled.

The preprocessor also normalizes the Javascript plus (+) operator and concatenates strings using the operator. You can use the file_data intrusion rule keyword to point intrusion rules to the normalized Javascript data.

You can enable rules 120:9, 120:10, and 120:11 to generate events and, in an inline deployment, drop offending packets, as follows:

**Table 170: Normalize Javascript Option Rules**

<table>
<thead>
<tr>
<th>This rule...</th>
<th>Triggers when...</th>
</tr>
</thead>
<tbody>
<tr>
<td>120:9</td>
<td>the obfuscation level within the preprocessor is greater than or equal to 2.</td>
</tr>
<tr>
<td>120:10</td>
<td>the number of consecutive white spaces in the Javascript obfuscated data is greater than or equal to the value configured for the maximum number of consecutive white spaces allowed.</td>
</tr>
<tr>
<td>120:11</td>
<td>escaped or encoded data includes more than one type of encoding.</td>
</tr>
</tbody>
</table>

**Decompress SWF File (LZMA) and Decompress SWF File (Deflate)**

When HTTP Inspect Responses is enabled, these options decompress the compressed portions of files located within the HTTP response body of HTTP requests.

**Note**

You can **only** decompress the compressed portions of files found in HTTP GET responses.

- **Decompress SWF File (LZMA)** decompresses the LZMA-compatible compressed portions of Adobe ShockWave Flash (.swf) files
- **Decompress SWF File (Deflate)** decompresses the deflate-compatible compressed portions of Adobe ShockWave Flash (.swf) files

Decompression ends when Maximum Compressed Data Depth, Maximum Decompressed Data Depth, or the end of the compressed data is reached. Inspection of decompressed data ends when Server Flow Depth
is reached unless you also select **Unlimited Decompression**. You can use the `file_data` intrusion rule keyword to inspect decompressed data.

You can enable rules 120:12 and 120:13 to generate events and, in an inline deployment, drop offending packets, as follows:

**Table 171: Decompress SWF File Option Rules**

<table>
<thead>
<tr>
<th>This rule...</th>
<th>Triggers when...</th>
</tr>
</thead>
<tbody>
<tr>
<td>120:12</td>
<td>deflate file decompression fails.</td>
</tr>
<tr>
<td>120:13</td>
<td>LZMA file decompression fails.</td>
</tr>
</tbody>
</table>

**Decompress PDF File (Deflate)**

When **HTTP Inspect Responses** is enabled, **Decompress PDF File (Deflate)** decompresses the deflate-compatible compressed portions of Portable Document Format (.pdf) files located within the HTTP response body of HTTP requests. The system can only decompress PDF files with the `/FlateDecode` stream filter. Other stream filters (including `/FlateDecode /FlateDecode`) are unsupported.

**Note**

You can only decompress the compressed portions of files found in HTTP GET responses.

Decompression ends when **Maximum Compressed Data Depth**, **Maximum Decompressed Data Depth**, or the end of the compressed data is reached. Inspection of decompressed data ends when **Server Flow Depth** is reached unless you also select **Unlimited Decompression**. You can use the `file_data` intrusion rule keyword to inspect decompressed data.

You can enable rules 120:14, 120:15, 120:16, and 120:17 to generate events and, in an inline deployment, drop offending packets, as follows:

**Table 172: Decompress PDF File (Deflate) Option Rules**

<table>
<thead>
<tr>
<th>This rule...</th>
<th>Triggers when...</th>
</tr>
</thead>
<tbody>
<tr>
<td>120:14</td>
<td>file decompression fails.</td>
</tr>
<tr>
<td>120:15</td>
<td>file decompression fails due to an unsupported compression type.</td>
</tr>
<tr>
<td>120:16</td>
<td>file decompression fails due to an unsupported PDF stream filter.</td>
</tr>
<tr>
<td>120:17</td>
<td>file parsing fails.</td>
</tr>
</tbody>
</table>

**Extract Original Client IP Address**

Enables extraction of the original client IP address from the X-Forwarded-For (XFF), True-Client-IP, or custom-defined HTTP header. You can display the extracted original client IP address in the intrusion events table view.

You can enable rules 119:23, 119:29, and 119:30 to generate events and, in an inline deployment, drop offending packets for this option. See **Setting Intrusion Rule States**, on page 889.
XFF Header Priority

When **Extract Original Client IP Address** is enabled, specifies the order in which the system processes original client IP HTTP headers. If, on your monitored network, you expect to encounter original client IP headers other than X-Forwarded-For (XFF) or True-Client-IP, click **Add** to add additional header names to the priority list. Then use the up and down arrow icons beside each header type to adjust its priority. Note that if multiple XFF headers appear in an HTTP request, the system processes only the header with the highest priority.

Log URI

Enables extraction of the raw URI, if present, from HTTP request packets and associates the URI with all intrusion events generated for the session.

When this option is enabled, you can display the first fifty characters of the extracted URI in the HTTP URI column of the intrusion events table view. You can display the complete URI, up to 2048 bytes, in the packet view.

Log Hostname

Enables extraction of the host name, if present, from the HTTP request Host header and associates the host name with all intrusion events generated for the session. When multiple Host headers are present, extracts the host name from the first header.

When this option is enabled, you can display the first fifty characters of the extracted host name in the HTTP Hostname column of the intrusion events table view. You can display the complete host name, up to 256 bytes, in the packet view.

You can enable rule 119:25 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Note that, when enabled, rule 119:24 triggers if it detects multiple Host headers in an HTTP request, regardless of the setting for this option.

Profile

Specifies the types of encoding that are normalized for HTTP traffic. The system provides a default profile appropriate for most servers, default profiles for Apache servers and IIS servers, and custom default settings that you can tailor to meet the needs of your monitored traffic:

- Select **All** to use the standard default profile, appropriate for all servers.
- Select **IIS** to use the system-provided IIS profile.
- Select **Apache** to use the system-provided Apache profile.
- Select **Custom** to create your own server profile.

Server-Level HTTP Normalization Encoding Options

When you set the HTTP server-level **Profile** option to **Custom**, you can specify the types of encoding that are normalized for HTTP traffic, and enable HTTP preprocessor rules to generate events against traffic containing the different encoding types.

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
ASCII Encoding
Decodes encoded ASCII characters and specifies whether the rules engine generates an event on ASCII-encoded URIs.
You can enable rule 119:1 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

UTF-8 Encoding
Decodes standard UTF-8 Unicode sequences in the URI.
You can enable rule 119:6 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Microsoft %U Encoding
Decodes the IIS %u encoding scheme that uses %u followed by four characters where the 4 characters are a hex encoded value that correlates to an IIS Unicode codepoint.

Tip
Legitimate clients rarely use %u encodings, so Cisco recommends decoding HTTP traffic encoded with %u encodings.
You can enable rule 119:3 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Bare Byte UTF-8 Encoding
Decodes bare byte encoding, which uses non-ASCII characters as valid values in decoding UTF-8 values.

Tip
Bare byte encoding allows the user to emulate an IIS server and interpret non-standard encodings correctly. Cisco recommends enabling this option because no legitimate clients encode UTF-8 this way.
You can enable rule 119:4 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Microsoft IIS Encoding
Decodes using Unicode codepoint mapping.

Tip
Cisco recommends enabling this option, because it is seen mainly in attacks and evasion attempts.
You can enable rule 119:7 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Double Encoding
Decodes IIS double encoded traffic by making two passes through the request URI performing decodes in each one. Cisco recommends enabling this option because it is usually found only in attack scenarios.
You can enable rule 119:2 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Multi-Slash Obfuscation**

Normalizes multiple slashes in a row into a single slash.

You can enable rule 119:8 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**IIS Backslash Obfuscation**

Normalizes backslashes to forward slashes.

You can enable rule 119:9 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Directory Traversal**

Normalizes directory traversals and self-referential directories. If you enable the accompanying preprocessor rules to generate events against this type of traffic, it may generate false positives because some web sites refer to files using directory traversals.

You can enable rules 119:10 and 119:11 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Tab Obfuscation**

Normalizes the non-RFC standard of using a tab for a space delimiter. Apache and other non-IIS web servers use the tab character (0x09) as a delimiter in URLs.

Regardless of the configuration for this option, the HTTP Inspect preprocessor treats a tab as white space if a space character (0x20) precedes it.

You can enable rule 119:12 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Invalid RFC Delimiter**

Normalizes line breaks (\n) in URI data.

You can enable rule 119:13 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Webroot Directory Traversal**

Detects directory traversals that traverse past the initial directory in the URL.

You can enable rule 119:18 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.
Tab URI Delimiter

Turns on the use of the tab character (0x09) as a delimiter for a URI. Apache, newer versions of IIS, and some other web servers use the tab character as a delimiter in URLs.

---

Note

Regardless of the configuration for this option, the HTTP Inspect preprocessor treats a tab as white space if a space character (0x20) precedes it.

---

Non-RFC characters

Detects the non-RFC character list you add in the corresponding field when it appears within incoming or outgoing URI data. When modifying this field, use the hexadecimal format that represents the byte character. If and when you configure this option, set the value with care. Using a character that is very common may overwhelm you with events.

You can enable rule 119:14 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Max Chunk Encoding Size

Detects abnormally large chunk sizes in URI data.

You can enable rules 119:16 and 119:22 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

Disable Pipeline Decoding

Disables HTTP decoding for pipelined requests. When this option is disabled, performance is enhanced because HTTP requests waiting in the pipeline are not decoded or analyzed, and are only inspected using generic pattern matching.

Non-Strict URI Parsing

Enables non-strict URI parsing. Use this option only on servers that will accept non-standard URIs in the format "GET/index.html abc x\r \n". Using this option, the decoder assumes that the URI is between the first and second space, even if there is no valid HTTP identifier after the second space.

Extended ASCII Encoding

Enables parsing of extended ASCII characters in an HTTP request URI. Note that this option is available in custom server profiles only, and not in the default profiles provided for Apache, IIS, or all servers.

Related Topics

- Overview: HTTP content and protected_content Keyword Arguments, on page 955
- Firepower System IP Address Conventions, on page 14
Configuring The HTTP Inspect Preprocessor

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

**Before you begin**

- Confirm that any networks you want to identify in a custom target-based policy match or are a subset of the networks, zones, and VLANs handled by its parent network analysis policy. See Advanced Settings for Network Analysis Policies, on page 1053 for more information.

**Procedure**

**Step 1** Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

**Note** If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2** Click the edit icon (edit) next to the policy you want to edit.

If a view icon (view) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click Settings in the navigation panel.

**Step 4** If HTTP Configuration under Application Layer Preprocessors is disabled, click Enabled.

**Step 5** Click the edit icon (edit) next to HTTP Configuration.

**Step 6** Modify the options in the Global Settings page area; see Global HTTP Normalization Options, on page 1090.

**Step 7** You have three choices:

- Add a server profile — Click the add icon (add) in the Servers section. Specify one or more IP addresses for the client in the Server Address field, and click OK. You can specify a single IP address or address block, or a comma-separated list of either or both. You can include up to 496 characters in a list, specify a total of 256 address entries for all server profiles, and create a total of 255 profiles including the default profile.

- Edit a server profile — Click the configured address for a profile you have added under Servers, or click default. You can modify any of the settings in the Configuration section; see Server-Level HTTP Normalization Options, on page 1091. If you choose Custom for the Profile value, you can also modify the encoding options described in Server-Level HTTP Normalization Encoding Options, on page 1098.

- Delete a server profile — Click the delete icon (delete) next to a custom profile.
Step 8

To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

---

What to do next

- If you want generate events and, in an inline deployment, drop offending packets, enable HTTP preprocessor rules (GID 119). For more information, see **Setting Intrusion Rule States**, on page 889.
- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

Related Topics

- **Managing Layers**, on page 856
- **Conflicts and Changes: Network Analysis and Intrusion Policies**, on page 846

---

**Additional HTTP Inspect Preprocessor Rules**

You can enable the rules in the **Preprocessor Rule GID:SID** column of the following table to generate events for HTTP Inspect preprocessor rules that are not associated with specific configuration options.

<table>
<thead>
<tr>
<th>Preprocessor Rule GID:SID</th>
<th>Triggers when...</th>
</tr>
</thead>
<tbody>
<tr>
<td>119:21</td>
<td>an HTTP request header has more than one content-length field.</td>
</tr>
<tr>
<td>119:24</td>
<td>an HTTP request has more than one Host header.</td>
</tr>
<tr>
<td>119:28, 120:8</td>
<td>N/A. When enabled, these rules do not generate events.</td>
</tr>
<tr>
<td>119:32</td>
<td>HTTP version 0.9 is encountered in traffic. Note that the TCP stream configuration must also be enabled.</td>
</tr>
<tr>
<td>119:33</td>
<td>an HTTP URI includes an unescaped space.</td>
</tr>
<tr>
<td>119:34</td>
<td>a TCP connection contains 24 or more pipelined HTTP requests.</td>
</tr>
<tr>
<td>120:5</td>
<td>UTF-7 encoding is encountered in HTTP response traffic; UTF-7 should only appear where 7-bit parity is required, such as in SMTP traffic.</td>
</tr>
</tbody>
</table>

---

**The Sun RPC Preprocessor**

Remote Procedure Call (RPC) normalization takes fragmented RPC records and normalizes them to a single record so the rules engine can inspect the complete record. For example, an attacker may attempt to discover the port where RPC `admind` runs. Some UNIX hosts use RPC `admind` to perform remote distributed system tasks. If the host performs weak authentication, a malicious user could take control of remote administration.
The standard text rule (GID: 1) with the Snort ID (SID) 575 detects this attack by searching for content in specific locations to identify inappropriate `portmap` `GETPORT` requests.

**Sun RPC Preprocessor Options**

**Ports**
Specify the ports whose traffic you want to normalize. In the interface, list multiple ports separated by commas. Typical RPC ports are 111 and 32771. If your network sends RPC traffic to other ports, consider adding them.

**Detect fragmented RPC records**
Detects RPC fragmented records.
You can enable rules 106:1 and 106:5 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Detect multiple records in one packet**
Detects more than one RPC request per packet (or reassembled packet).
You can enable rule 106:2 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Detect fragmented record sums which exceed one fragment**
Detects reassembled fragment record lengths that exceed the current packet length.
You can enable rule 106:3 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Detect single fragment records which exceed the size of one packet**
Detects partial records
You can enable rule 106:4 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Configuring the Sun RPC Preprocessor**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**
Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.
If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2**
Click the edit icon (تعديل) next to the policy you want to edit.

If a view icon appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3**
Click **Settings** in the navigation panel.

**Step 4**
If **Sun RPC Configuration** under Application Layer Preprocessors is disabled, click **Enabled**.

**Step 5**
Click the edit icon (تعديل) next to **Sun RPC Configuration**.

**Step 6**
Modify the settings described in **Sun RPC Preprocessor Options, on page 1104**.

**Step 7**
To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

---

**What to do next**

- If you want to generate events and, in an inline deployment, drop offending packets, enable Sun RPC preprocessor rules (GID 106). For more information, see Setting Intrusion Rule States, on page 889.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**
- Managing Layers, on page 856
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

---

**The SIP Preprocessor**

The Session Initiation Protocol (SIP) provides call setup, modification, and teardown of one or more sessions for one or more users of client applications such as Internet telephony, multimedia conferencing, instant messaging, online gaming, and file transfer. A method field in each SIP request identifies the purpose of the request, and a Request-URI specifies where to send the request. A status code in each SIP response indicates the outcome of the requested action.

After calls are set up using SIP, the Real-time Transport Protocol (RTP) is responsible for subsequent audio and video communication; this part of the session is sometimes referred to as the call channel, the data channel, or the audio/video data channel. RTP uses the Session Description Protocol (SDP) within the SIP message body for data-channel parameter negotiation, session announcement, and session invitation.

The SIP preprocessor is responsible for:

- decoding and analyzing SIP 2.0 traffic
- extracting the SIP header and message body, including SDP data when present, and passing the extracted data to the rules engine for further inspection
• generating events when the following conditions are detected and the corresponding preprocessor rules are enabled:
  • anomalies and known vulnerabilities in SIP packets
  • out-of-order and invalid call sequences
  • optionally, ignoring the call channel

The preprocessor identifies the RTP channel based on the port identified in the SDP message, which is embedded in the SIP message body, but the preprocessor does not provide RTP protocol inspection.

Note the following when using the SIP preprocessor:
• UDP typically carries media sessions supported by SIP. UDP stream preprocessing provides SIP session tracking for the SIP preprocessor.
• SIP rule keywords allow you to point to the SIP packet header or message body and to limit detection to packets for specific SIP methods or status codes.

**SIP Preprocessor Options**

For the following options, you can specify a positive value from 1 to 65535 bytes, or 0 to disable event generation for the option regardless of whether the associated rule is enabled.

- **Maximum Request URI Length**
- **Maximum Call ID Length**
- **Maximum Request Name Length**
- **Maximum From Length**
- **Maximum To Length**
- **Maximum Via Length**
- **Maximum Contact Length**
- **Maximum Content Length**

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

**Ports**

Specifies the ports to inspect for SIP traffic. You can specify an integer from 0 to 65535. Separate multiple port numbers with commas.

**Methods to Check**

Specifies SIP methods to detect. You can specify any of the following currently defined SIP methods:

ack, benotify, bye, cancel, do, info, invite, join, message, notify, options, prack, publish, quath, refer, register, service, sprack, subscribe, unsubscribe, update
Methods are case-insensitive. The method name can include alphabetic characters, numbers, and the underscore character. No other special characters are permitted. Separate multiple methods with commas.

Because new SIP methods might be defined in the future, your configuration can include an alphabetic string that is not currently defined. The system supports up to 32 methods, including the 21 currently defined methods and an additional 11 methods. The system ignores any undefined methods that you might configure.

Note that, in addition to any methods you specify for this option, the 32 total methods includes methods specified using the `sip_method` keyword in intrusion rules.

**Maximum Dialogs within a Session**

Specifies the maximum number of dialogs allowed within a stream session. If more dialogs than this number are created, the oldest dialogs are dropped until the number of dialogs does not exceed the maximum number specified. You can specify an integer from 1 to 4194303.

You can enable rule 140:27 to generate events and, in an inline deployment, drop offending packets for this option. See Setting Intrusion Rule States, on page 889.

**Maximum Request URI Length**

Specifies the maximum number of bytes to allow in the Request-URI header field. A longer URI generates an event and, in an inline deployment, drops offending packets when rule 140:3 is enabled. The request URI field indicates the destination path or page for the request.

**Maximum Call ID Length**

Specifies the maximum number of bytes to allow in the request or response Call-ID header field. A longer Call-ID generates an event and, in an inline deployment, drops offending packets when rule 140:5 is enabled. The Call-ID field uniquely identifies the SIP session in requests and responses.

**Maximum Request Name Length**

Specifies the maximum number of bytes to allow in the request name, which is the name of the method specified in the CSeq transaction identifier. A longer request name generates an event and, in an inline deployment, drops offending packets when rule 140:7 is enabled.

**Maximum From Length**

Specifies the maximum number of bytes to allow in the request or response From header field. A longer From generates an event and, in an inline deployment, drops offending packets when rule 140:9 is enabled. The From field identifies the message initiator.

**Maximum To Length**

Specifies the maximum number of bytes to allow in the request or response To header field. A longer To generates an event and, in an inline deployment, drops offending packets when rule 140:11 is enabled. The To field identifies the message recipient.

**Maximum Via Length**

Specifies the maximum number of bytes to allow in the request or response Via header field. A longer Via generates an event and, in an inline deployment, drops offending packets when rule 140:13 is enabled. The Via field provides the path followed by the request and, in a response, receipt information.
Maximum Contact Length

Specifies the maximum number of bytes to allow in the request or response Contact header field. A longer Contact generates an event and, in an inline deployment, drops offending packets when rule 140:15 is enabled. The Contact field provides a URI that specifies the location to contact with subsequent messages.

Maximum Content Length

Specifies the maximum number of bytes to allow in the content of the request or response message body. Longer content generates an event and, in an inline deployment, drops offending packets when rule 140:16 is enabled.

Ignore Audio/Video Data Channel

Enables and disables inspection of data channel traffic. Note that the preprocessor continues inspection of other non-data-channel SIP traffic when you enable this option.

Related Topics

SIP Keywords, on page 999

Configuring the SIP Preprocessor

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

Procedure

Step 1  Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note  If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2  Click the edit icon (📝) next to the policy you want to edit.

If a view icon (👁️) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3  Click Settings in the navigation panel.

Step 4  If SIP Configuration under Application Layer Preprocessors is disabled, click Enabled.

Step 5  Click the edit icon (📝) next to SIP Configuration.

Step 6  Modify the options described in SIP Preprocessor Options, on page 1106.

Step 7  To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.
If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

**What to do next**

- If you want to generate events and, in an inline deployment, drop offending packets, enable SIP preprocessor rules (GID 140). For more information, see Setting Intrusion Rule States, on page 889.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

- Managing Layers, on page 856
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

### Additional SIP Preprocessor Rules

The SIP preprocessor rules in the following table are not associated with specific configuration options. As with other SIP preprocessor rules, you must enable these rules if you want them to generate events and, in an inline deployment, drop offending packets.

**Table 174: Additional SIP Preprocessor Rules**

<table>
<thead>
<tr>
<th>Preprocessor Rule GID:SID</th>
<th>Triggers when...</th>
</tr>
</thead>
<tbody>
<tr>
<td>140:1</td>
<td>the preprocessor is monitoring the maximum number of SIP sessions allowed by the system.</td>
</tr>
<tr>
<td>140:2</td>
<td>the required Request_URI field is empty in a SIP request.</td>
</tr>
<tr>
<td>140:4</td>
<td>the Call-ID header field is empty in a SIP request or response.</td>
</tr>
<tr>
<td>140:6</td>
<td>the value for the sequence number in the SIP request or response CSeq field is not a 32-bit unsigned integer less than 231.</td>
</tr>
<tr>
<td>140:8</td>
<td>the From header field is empty in a SIP request or response.</td>
</tr>
<tr>
<td>140:10</td>
<td>the To header field is empty in a SIP request or response.</td>
</tr>
<tr>
<td>140:12</td>
<td>the Via header field is empty in a SIP request or response.</td>
</tr>
<tr>
<td>140:14</td>
<td>the required Contact header field is empty in a SIP request or response.</td>
</tr>
<tr>
<td>140:17</td>
<td>a single SIP request or response packet in UDP traffic contains multiple messages. Note that older SIP versions supported multiple messages, but SIP 2.0 supports only one message per packet.</td>
</tr>
<tr>
<td>140:18</td>
<td>the actual length of the message body in a SIP request or response in UDP traffic does not match the value specified in the Content-Length header field in a SIP request or response.</td>
</tr>
</tbody>
</table>
The GTP Preprocessor

The General Service Packet Radio (GPRS) Tunneling Protocol (GTP) provides communication over a GTP core network. The GTP preprocessor detects anomalies in GTP traffic and forwards command channel signaling messages to the rules engine for inspection. You can use the `gtp_version`, `gtp_type`, and `gtp_info` rule keywords to inspect GTP command channel traffic for exploits.

A single configuration option allows you to modify the default setting for the ports that the preprocessor inspects for GTP command channel messages.

GTP Preprocessor Rules

You must enable the GTP preprocessor rules in the following table if you want them to generate events and, in an inline deployment, drop offending packets.

<table>
<thead>
<tr>
<th>Preprocessor Rule GID:SID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>143:1</td>
<td>Generates an event when the preprocessor detects an invalid message length.</td>
</tr>
<tr>
<td>143:2</td>
<td>Generates an event when the preprocessor detects an invalid information element length.</td>
</tr>
<tr>
<td>143:3</td>
<td>Generates an event when the preprocessor detects information elements that are out of order.</td>
</tr>
</tbody>
</table>
Configuring the GTP Preprocessor

You can use this procedure to modify the ports the GTP preprocessor monitors for GTP command messages.

**Procedure**

**Step 1** Choose **Policies > Access Control**, then click **Network Analysis Policy** or **Policies > Access Control > Intrusion**, then click **Network Analysis Policy**.

**Note** If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2** Click the edit icon (-pencil) next to the policy you want to edit.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Settings** in the navigation panel on the left.

**Step 4** If **GTP Command Channel Configuration** under **Application Layer Preprocessors** is disabled, click **Enabled**.

**Step 5** Click the edit icon (-pencil) next to **GTP Command Channel Configuration**.

**Step 6** Enter a **Ports** value.

Separate multiple ports with commas.

**Step 7** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

**What to do next**

- If you want to enable intrusion events, enable GTP preprocessor rules (GID 143). For more information, see **Setting Intrusion Rule States**, on page 889.

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

### The IMAP Preprocessor

The Internet Message Application Protocol (IMAP) is used to retrieve email from a remote IMAP server. The IMAP preprocessor inspects server-to-client IMAP4 traffic and, when associated preprocessor rules are
enabled, generates events on anomalous traffic. The preprocessor can also extract and decode email attachments in client-to-server IMAP4 traffic and send the attachment data to the rules engine. You can use the `file_data` keyword in an intrusion rule to point to the attachment data.

Extraction and decoding include multiple attachments, when present, and large attachments that span multiple packets.

**IMAP Preprocessor Options**

Note that decoding, or extraction when the MIME email attachment does not require decoding, includes multiple attachments when present, and large attachments that span multiple packets.

Note also that the highest value is used when the values for the **Base64 Decoding Depth**, **7-Bit/8-Bit/Binary Decoding Depth**, **Quoted-Printable Decoding Depth**, or **Unix-to-Unix Decoding Depth** options are different in:

- the default network analysis policy
- any other custom network analysis policy invoked by network analysis rules in the same access control policy

---

**Caution**

Changing the value for **Base64 Decoding Depth**, **7-Bit/8-Bit/Binary Decoding Depth**, **Quoted-Printable Decoding Depth**, or **Unix-to-Unix Decoding Depth** restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

**Ports**

Specifies the ports to inspect for IMAP traffic. You can specify an integer from 0 to 65535. Separate multiple port numbers with commas.

**Base64 Decoding Depth**

Specifies the maximum number of bytes to extract and decode from each Base64 encoded MIME email attachment. You can specify a positive value, or specify 0 to decode all the Base64 data. Specify -1 to ignore Base64 data.

Note that positive values not divisible by 4 are rounded up to the next multiple of 4 except for the values 65533, 65534, and 65535, which are rounded down to 65532.

When this option is enabled, you can enable rule 141:4 generate events and, in an inline deployment, drop offending packets when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.

**7-Bit/8-Bit/Binary Decoding Depth**

Specifies the maximum bytes of data to extract from each MIME email attachment that does not require decoding. These attachment types include 7-bit, 8-bit, binary, and various multipart content types such as...
plain text, jpeg images, mp3 files, and so on. You can specify a positive value, or specify 0 to extract all data in the packet. Specify -1 to ignore non-decoded data.

When this option is enabled, you can enable rule 141:6 to generate events and, in an inline deployment, drop offending packets when extraction fails; extraction could fail, for example, because of corrupted data.

**Quoted-Printable Decoding Depth**

Specifies the maximum number of bytes to extract and decode from each quoted-printable (QP) encoded MIME email attachment. You can specify a positive value, or specify 0 to decode all QP encoded data in the packet. Specify -1 to ignore QP encoded data.

When this option is enabled, you can enable rule 141:5 to generate events and, in an inline deployment, drop offending packets when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.

**Unix-to-Unix Decoding Depth**

Specifies the maximum number of bytes to extract and decode from each Unix-to-Unix encoded (uueencoded) email attachment. You can specify a positive value, or specify 0 to decode all uueencoded data in the packet. Specify -1 to ignore uueencoded data.

When this option is enabled, you can enable rule 141:7 to generate events and, in an inline deployment, drop offending packets when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.

**Related Topics**

- [The file_data Keyword](#), on page 1033

---

**Configuring the IMAP Preprocessor**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

**Caution**

Changing the value for **Base64 Decoding Depth**, **7-Bit/8-Bit/Binary Decoding Depth**, **Quoted-Printable Decoding Depth**, or **Unix-to-Unix Decoding Depth** restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See [Snort® Restart Traffic Behavior](#), on page 280 for more information.

**Procedure**

**Step 1**

Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

**Note**

If your custom user role limits access to the first path listed here, use the second path to access the policy.
**Step 2**  
Click the edit icon (✏️) next to the policy you want to edit.

If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3**  
Click **Settings** in the navigation panel.

**Step 4**  
If **IMAP Configuration** under **Application Layer Preprocessors** is disabled, click **Enabled**.

**Step 5**  
Click the edit icon (✏️) next to **IMAP Configuration**.

**Step 6**  
Modify the settings described in **IMAP Preprocessor Options**, on page 1112.

**Step 7**  
To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

---

**What to do next**

- If you want to enable intrusion events, enable IMAP preprocessor rules (GID 141); see **Setting Intrusion Rule States**, on page 889.
- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

**Related Topics**

- **Layers in Intrusion and Network Analysis Policies**, on page 849
- **Conflicts and Changes: Network Analysis and Intrusion Policies**, on page 846

### Additional IMAP Preprocessor Rules

The IMAP preprocessor rules in the following table are not associated with specific configuration options. As with other IMAP preprocessor rules, you must enable these rules if you want them to generate events and, in an inline deployment, drop offending packets.

<table>
<thead>
<tr>
<th>Preprocessor Rule GID:SID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>141:1</td>
<td>Generates an event when the preprocessor detects a client command that is not defined in RFC 3501.</td>
</tr>
<tr>
<td>141:2</td>
<td>Generates an event when the preprocessor detects a server response that is not defined in RFC 3501.</td>
</tr>
<tr>
<td>141:3</td>
<td>Generates an event when the preprocessor is using the maximum amount of memory allowed by the system. At this point, the preprocessor stops decoding until memory becomes available.</td>
</tr>
</tbody>
</table>
The POP Preprocessor

The Post Office Protocol (POP) is used to retrieve email from a remote POP mail server. The POP preprocessor inspects server-to-client POP3 traffic and, when associated preprocessor rules are enabled, generates events on anomalous traffic. The preprocessor can also extract and decode email attachments in client-to-server POP3 traffic and send the attachment data to the rules engine. You can use the `file_data` keyword in an intrusion rule to point to attachment data.

Extraction and decoding include multiple attachments, when present, and large attachments that span multiple packets.

POP Preprocessor Options

Note that decoding, or extraction when the MIME email attachment does not require decoding, includes multiple attachments when present, and large attachments that span multiple packets.

Note also that the highest value is used when the values for the **Base64 Decoding Depth**, **7-Bit/8-Bit/Binary Decoding Depth**, **Quoted-Printable Decoding Depth**, or **Unix-to-Unix Decoding Depth** options are different in:

- the default network analysis policy
- any other custom network analysis policy invoked by network analysis rules in the same access control policy

⚠️ **Caution**

Changing the value for **Base64 Decoding Depth**, **7-Bit/8-Bit/Binary Decoding Depth**, **Quoted-Printable Decoding Depth**, or **Unix-to-Unix Decoding Depth** restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See **Snort® Restart Traffic Behavior, on page 280** for more information.

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

**Ports**

Specifies the ports to inspect for POP traffic. You can specify an integer from 0 to 65535. Separate multiple port numbers with commas.

**Base64 Decoding Depth**

Specifies the maximum number of bytes to extract and decode from each Base64 encoded MIME email attachment. You can specify a positive value, or specify 0 to decode all the Base64 data. Specify -1 to ignore Base64 data.

Note that positive values not divisible by 4 are rounded up to the next multiple of 4 except for the values 65533, 65534, and 65535, which are rounded down to 65532.
When this option is enabled, you can enable rule 142:4 to generate an event and, in an inline deployment, drop offending packets when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.

**7-Bit/8-Bit/Binary Decoding Depth**

Specifies the maximum bytes of data to extract from each MIME email attachment that does not require decoding. These attachment types include 7-bit, 8-bit, binary, and various multipart content types such as plain text, jpeg images, mp3 files, and so on. You can specify a positive value, or specify 0 to extract all data in the packet. Specify -1 to ignore non-decoded data.

When this option is enabled, you can enable rule 142:6 to generate an event and, in an inline deployment, drop offending packets when extraction fails; extraction could fail, for example, because of corrupted data.

**Quoted-Printable Decoding Depth**

Specifies the maximum number of bytes to extract and decode from each quoted-printable (QP) encoded MIME email attachment. You can specify a positive value, or specify 0 to decode all QP encoded data in the packet. Specify -1 to ignore QP encoded data.

When this option is enabled, you can enable rule 142:5 to generate an event and, in an inline deployment, drop offending packets when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.

**Unix-to-Unix Decoding Depth**

Specifies the maximum number of bytes to extract and decode from each Unix-to-Unix encoded (uuencoded) email attachment. You can specify a positive value, or specify 0 to decode all uuencoded data in the packet. Specify -1 to ignore uuencoded data.

When this option is enabled, you can enable rule 142:7 to generate an event and, in an inline deployment, drop offending packets when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.

**Related Topics**

- Managing Layers, on page 856
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846
- The file_data Keyword, on page 1033

---

**Configuring the POP Preprocessor**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

**Caution**

Changing the value for Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.
**Procedure**

**Step 1** Choose **Policies > Access Control**, then click **Network Analysis Policy** or **Policies > Access Control > Intrusion**, then click **Network Analysis Policy**.

**Note** If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2** Click the edit icon (вшись) next to the policy you want to edit.

If a view icon ( **) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Settings** in the navigation panel.

**Step 4** If **POP Configuration** under **Application Layer Preprocessors** is disabled, click **Enabled**.

**Step 5** Click the edit icon (ALLERY) next to **POP Configuration**.

**Step 6** Modify the settings described in **POP Preprocessor Options**, on page 1115.

**Step 7** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

**What to do next**

- If you want to enable intrusion events, enable POP preprocessor rules (GID 142). For more information, see **Setting Intrusion Rule States**, on page 889.

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

**Related Topics**

- **Managing Layers**, on page 856
- **Conflicts and Changes: Network Analysis and Intrusion Policies**, on page 846

**Additional POP Preprocessor Rules**

The POP preprocessor rules in the following table are not associated with specific configuration options. As with other POP preprocessor rules, you must enable these rules if you want them to generate events and, in an inline deployment, drop offending packets.

**Table 177: Additional POP Preprocessor Rules**

<table>
<thead>
<tr>
<th>Preprocessor Rule GID:SID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>142:1</td>
<td>Generates an event when the preprocessor detects a client command that is not defined in RFC 1939.</td>
</tr>
</tbody>
</table>
The SMTP Preprocessor

The SMTP preprocessor instructs the rules engine to normalize SMTP commands. The preprocessor can also extract and decode email attachments in client-to-server traffic and, depending on the software version, extract email file names, addresses, and header data to provide context when displaying intrusion events triggered by SMTP traffic.

SMTP Preprocessor Options

You can enable or disable normalization, and you can configure options to control the types of anomalous traffic the SMTP decoder detects.

Note that decoding, or extraction when the MIME email attachment does not require decoding, includes multiple attachments when present, and large attachments that span multiple packets.

Note also that the highest value is used when the values for the Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth options are different in:

- the default network analysis policy
- any other custom network analysis policy invoked by network analysis rules in the same access control policy

Caution

Changing the value for Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

Ports

Specifies the ports whose SMTP traffic you want to normalize. You can specify a value greater than or equal to 0. Separate multiple ports with commas.

<table>
<thead>
<tr>
<th>Preprocessor Rule GID:SID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>142:2</td>
<td>Generates an event when the preprocessor detects a server response that is not defined in RFC 1939.</td>
</tr>
<tr>
<td>142:3</td>
<td>Generates an event when the preprocessor is using the maximum amount of memory allowed by the system. At this point, the preprocessor stops decoding until memory becomes available.</td>
</tr>
</tbody>
</table>
Stateful Inspection
When selected, causes SMTP decoder to save state and provide session context for individual packets and only inspects reassembled sessions. When cleared, analyzes each individual packet without session context.

Normalize
When set to All, normalizes all commands. Checks for more than one space character after a command.
When set to None, normalizes no commands.
When set to Cmds, normalizes the commands listed in Custom Commands.

Custom Commands
When Normalize is set to Cmds, normalizes the listed commands.
Specify commands which should be normalized in the text box. Checks for more than one space character after a command.
The space (ASCII 0x20) and tab (ASCII 0x09) characters count as space characters for normalization purposes.

Ignore Data
Does not process mail data; processes only MIME mail header data.

Ignore TLS Data
Does not process data encrypted under the Transport Layer Security protocol.

No Alerts
Disables intrusion events when accompanying preprocessor rules are enabled.

Detect Unknown Commands
Detects unknown commands in SMTP traffic.
You can enable rule 124:5 to generate events and, in an inline deployment, drop offending packets for this option.

Max Command Line Len
Detects when an SMTP command line is longer than this value. Specify 0 to never detect command line length.
RFC 2821, the Network Working Group specification on the Simple Mail Transfer Protocol, recommends 512 as a maximum command line length.
You can enable rule 124:1 to generate events and, in an inline deployment, drop offending packets for this option.

Max Header Line Len
Detects when an SMTP data header line is longer than this value. Specify 0 to never detect data header line length.
You can enable rules 124:2 and 124:7 to generate events and, in an inline deployment, drop offending packets for this option.
**Max Response Line Len**

Detects when an SMTP response line is longer than this value. Specify 0 to never detect response line length. RFC 2821 recommends 512 as a maximum response line length.

You can enable rule 124:3 to generate events and, in an inline deployment, drop offending packets for this option and also for **Alt Mac Command Line Len**, when that option is enabled.

**Alt Max Command Line Len**

Detects when the SMTP command line for any of the specified commands is longer than this value. Specify 0 to never detect command line length for the specified commands. Different default line lengths are set for numerous commands.

This setting overrides the Max Command Line Len setting for the specified commands.

You can enable rule 124:3 to generate events and, in an inline deployment, drop offending packets for this option and also for **Max Response Line Len** when that option is enabled.

**Invalid Commands**

Detects if these commands are sent from the client side.

You can enable rule 124:6 to generate events and, in an inline deployment, drop offending packets for this option and also for **Invalid Commands**.

**Valid Commands**

Permits commands in this list.

Even if this list is empty, the preprocessor permits the following valid commands: ATRN AUTH BDAT DATA DEBUG EHLO EMAL ESAM ESND ETRN EVFY EXPN HELO HELP IDENT MAIL NOOP ONEX QUEU QUIT RCPT RSET SAML SEND SIZE SOML STARTTLS TICK TIME TURN TURNME VERB VRFY XADR XAUTH XCIR XEXCH50 X-EXPS XGEN XLICENSE X-LINK2STATE XQUE XSTA XTRN XUSR

---

**Note**

RCPT TO and MAIL FROM are SMTP commands. The preprocessor configuration uses command names of RCPT and MAIL, respectively. Within the code, the preprocessor maps RCPT and MAIL to the correct command name.

You can enable rule 124:4 to generate events and, in an inline deployment, drop offending packets for this option and also for **Invalid Commands** when that option is configured.

**Data Commands**

Lists commands that initiate sending data in the same way the SMTP DATA command sends data per RFC 5321. Separate multiple commands with spaces.

**Binary Data Commands**

Lists commands that initiate sending data in a way that is similar to how the BDAT command sends data per RFC 3030. Separate multiple commands with spaces.
**Authentication Commands**

Lists commands that initiate an authentication exchange between client and server. Separate multiple commands with spaces.

**Detect xlink2state**

Detects packets that are part of X-Link2State Microsoft Exchange buffer data overflow attacks. In inline deployments, the system can also drop those packets.

You can enable rule 124:8 to generate events and, in an inline deployment, drop offending packets for this option.

**Base64 Decoding Depth**

When Ignore Data is disabled, specifies the maximum number of bytes to extract and decode from each Base64 encoded MIME email attachment. You can specify from a positive value, or specify 0 to decode all the Base64 data. Specify -1 to ignore Base64 data. The preprocessor will not decode data when Ignore Data is selected.

Note that positive values not divisible by 4 are rounded up to the next multiple of 4 except for the values 65533, 65534, and 65535, which are rounded down to 65532.

When this option is enabled, you can enable rule 124:10 to generate events and, in an inline deployment, drop offending packets when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.

Note that this option replaces the deprecated options Enable MIME Decoding and Maximum MIME Decoding Depth, which are still supported in existing intrusion policies for backward compatibility.

**7-Bit/8-Bit/Binary Decoding Depth**

When Ignore Data is disabled, specifies the maximum bytes of data to extract from each MIME email attachment that does not require decoding. These attachment types include 7-bit, 8-bit, binary, and various multipart content types such as plain text, jpeg images, mp3 files, and so on. You can specify a positive value, or specify 0 to extract all data in the packet. Specify -1 to ignore non-decoded data. The preprocessor will not extract data when Ignore Data is selected.

**Quoted-Printable Decoding Depth**

When Ignore Data is disabled, specifies the maximum number of bytes to extract and decode from each quoted-printable (QP) encoded MIME email attachment.

You can specify from 1 to 65535 bytes, or specify 0 to decode all QP encoded data in the packet. Specify -1 to ignore QP encoded data. The preprocessor will not decode data when Ignore Data is selected.

When this option is enabled, you can enable rule 124:11 to generate events and, in an inline deployment, drop offending packets when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.

**Unix-to-Unix Decoding Depth**

When Ignore Data is disabled, specifies the maximum number of bytes to extract and decode from each Unix-to-Unix encoded (uuencoded) email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all uuencoded data in the packet. Specify -1 to ignore uuencoded data. The preprocessor will not decode data when Ignore Data is selected.
When this option is enabled, you can enable rule 124:13 to generate events and, in an inline deployment, drop offending packets when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.

**Log MIME Attachment Names**

Enables extraction of MIME attachment file names from the MIME Content-Disposition header and associates the file names with all intrusion events generated for the session. Multiple file names are supported.

When this option is enabled, you can view file names associated with events in the Email Attachment column of the intrusion events table view.

**Log To Addresses**

Enables extraction of recipient email addresses from the SMTP RCPT TO command and associates the recipient addresses with all intrusion events generated for the session. Multiple recipients are supported.

When this option is enabled, you can view recipients associated with events in the Email Recipient column of the intrusion events table view.

**Log From Addresses**

Enables extraction of sender email addresses from the SMTP MAIL FROM command and associates the sender addresses with all intrusion events generated for the session. Multiple sender addresses are supported.

When this option is enabled, you can view senders associated with events in the Email Sender column of the intrusion events table view.

**Log Headers**

Enables extraction of email headers. The number of bytes to extract is determined by the value specified for *Header Log Depth*.

You can use the `content` or `protected_content` keyword to write intrusion rules that use email header data as a pattern. You can also view the extracted email header in the intrusion event packet view.

**Header Log Depth**

Specifies the number of bytes of the email header to extract when *Log Headers* is enabled. You can specify 0 to 20480 bytes. A value of 0 disables *Log Headers*.

**Related Topics**

Basic content and protected_content Keyword Arguments, on page 952

### Configuring SMTP Decoding

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.
Changing the value for Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

Procedure

Step 1
Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2
Click the edit icon ( ) next to the policy you want to edit.

If a view icon ( ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3
Click Settings in the navigation pane.

Step 4
If SMTP Configuration under Application Layer Preprocessors is disabled, click Enabled.

Step 5
Click the edit icon ( ) next to SMTP Configuration.

Step 6
Modify the options described in SMTP Preprocessor Options, on page 1118.

Step 7
To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

What to do next

• If you want to generate events and, in an inline deployment, drop offending packets, enable SMTP preprocessor rules (GID 124). For more information, see Setting Intrusion Rule States, on page 889.

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics
Managing Layers, on page 856
Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

The SSH Preprocessor

The SSH preprocessor detects:

• The Challenge-Response Buffer Overflow exploit
• The CRC-32 exploit
• The SecureCRT SSH Client Buffer Overflow exploit
• Protocol mismatches
• Incorrect SSH message direction
• Any version string other than version 1 or 2

Challenge-Response Buffer Overflow and CRC-32 attacks occur after the key exchange and are, therefore, encrypted. Both attacks send an uncharacteristically large payload of more than 20 KBytes to the server immediately after the authentication challenge. CRC-32 attacks apply only to SSH Version 1; Challenge-Response Buffer Overflow exploits apply only to SSH Version 2. The version string is read at the beginning of the session. Except for the difference in the version string, both attacks are handled in the same way.

The SecureCRT SSH exploit and protocol mismatch attacks occur when attempting to secure a connection, before the key exchange. The SecureCRT exploit sends an overly long protocol identifier string to the client that causes a buffer overflow. A protocol mismatch occurs when either a non-SSH client application attempts to connect to a secure SSH server or the server and client version numbers do not match.

You can configure the SSH preprocessor to inspect traffic on a specified port or list of ports, or to automatically detect SSH traffic. It will continue to inspect SSH traffic until either a specified number of encrypted packets has passed within a specified number of bytes, or until a specified maximum number of bytes is exceeded within the specified number of packets. If the maximum number of bytes is exceeded, it is assumed that a CRC-32 (SSH Version 1) or a Challenge-Response Buffer Overflow (SSH Version 2) attack has occurred. Note that without configuration the preprocessor detects any version string value other than version 1 or 2.

Also note the that the SSH preprocessor does not handle brute force attacks.

SSH Preprocessor Options

The preprocessor stops inspecting traffic for a session when either of the following occurs:

• a valid exchange between the server and the client has occurred for this number of encrypted packets; the connection continues.

• the Number of Bytes Sent Without Server Response is reached before the number of encrypted packets to inspect is reached; the assumption is made that there is an attack.

Each valid server response during Number of Encrypted Packets to Inspect resets the Number of Bytes Sent Without Server Response and the packet count continues.

Consider the following example SSH preprocessor configuration:

• Server Ports: 22
• Autodetect Ports: off
• Maximum Length of Protocol Version String: 80
• Number of Encrypted Packets to Inspect: 25
• Number of Bytes Sent Without Server Response: 19,600
• All detect options are enabled.
In the example, the preprocessor inspects traffic only on port 22. That is, auto-detection is disabled, so it inspects only on the specified port.

Additionally, the preprocessor in the example stops inspecting traffic when either of the following occurs:

- The client sends 25 encrypted packets which contain no more than 19,600 bytes, cumulative. The assumption is there is no attack.
- The client sends more than 19,600 bytes within 25 encrypted packets. In this case, the preprocessor considers the attack to be the Challenge-Response Buffer Overflow exploit because the session in the example is an SSH Version 2 session.

The preprocessor in the example will also detect any of the following that occur while it is processing traffic:

- a server overflow, triggered by a version string greater than 80 bytes and indicating a SecureCRT exploit
- a protocol mismatch
- a packet flowing in the wrong direction

Finally, the preprocessor will automatically detect any version string other than version 1 or version 2.

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

**Server Ports**

Specifies on which ports the SSH preprocessor should inspect traffic.

You can configure a single port or a comma-separated list of ports.

**Autodetect Ports**

Sets the preprocessor to automatically detect SSH traffic.

When this option is selected, the preprocessor inspects all traffic for an SSH version number. It stops processing when neither the client nor the server packet contains a version number. When disabled, the preprocessor inspects only the traffic identified by the **Server Ports** option.

**Number of Encrypted Packets to Inspect**

Specifies the number of encrypted packets to examine per session.

Setting this option to zero will allow all traffic to pass.

Reducing the number of encrypted packets to inspect may result in some attacks escaping detection. Raising the number of encrypted packets to inspect may negatively affect performance.

**Number of Bytes Sent Without Server Response**

Specifies the maximum number of bytes an SSH client may send to a server without getting a response before assuming there is a Challenge-Response Buffer Overflow or CRC-32 attack.

Increase the value for this option if the preprocessor generates false positives on the Challenge-Response Buffer Overflow or CRC-32 exploit.
SSH Preprocessor Options

**Maximum Length of Protocol Version String**
Specifies the maximum number of bytes allowed in the server’s version string before considering it to be a SecureCRT exploit.

**Detect Challenge-Response Buffer Overflow Attack**
Enables or disables detecting the Challenge-Response Buffer Overflow exploit.

You can enable rule 128:1 to generate events and, in an inline deployment, drop offending packets for this option. Note that an SFTP session can occasionally trigger rule 128:1.

**Detect SSH1 CRC-32 Attack**
Enables or disables detecting the CRC-32 exploit.

You can enable rule 128:2 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Server Overflow**
Enables or disables detecting the SecureCRT SSH Client Buffer Overflow exploit.

You can enable rule 128:3 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Protocol Mismatch**
Enables or disables detecting protocol mismatches.

You can enable rule 128:4 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Bad Message Direction**
Enables or disables detecting when traffic flows in the wrong direction (that is, if the presumed server generates client traffic, or if a client generates server traffic).

You can enable rule 128:5 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Payload Size Incorrect for the Given Payload**
Enables or disables detecting packets with an incorrect payload size such as when the length specified in the SSH packet is not consistent with the total length specified in the IP header or the message is truncated, that is, there is not enough data for a full SSH header.

You can enable rule 128:6 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Bad Version String**
Note that, when enabled, the preprocessor detects without configuration any version string other than version 1 or 2.

You can enable rule 128:7 to generate events and, in an inline deployment, drop offending packets for this option.
Configuring the SSH Preprocessor

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose **Policies > Access Control**, then click **Network Analysis Policy** or **Policies > Access Control > Intrusion**, then click **Network Analysis Policy**.

**Note** If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2** Click the edit icon ( ) next to the policy you want to edit.

If a view icon ( ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Settings** in the navigation panel.

**Step 4** If **SSH Configuration** under **Application Layer Preprocessors** is disabled, click **Enabled**.

**Step 5** Click the edit icon ( ) next to **SSH Configuration**.

**Step 6** Modify the options described in **SSH Preprocessor Options**, on page 1124.

**Step 7** To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

**What to do next**

- If you want to enable intrusion events, enable SSH preprocessors rules (GID 128). For more information, see **Setting Intrusion Rule States**, on page 889.

- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

**Related Topics**

- **Managing Layers**, on page 856
- **Conflicts and Changes: Network Analysis and Intrusion Policies**, on page 846

---

**The SSL Preprocessor**

The SSL preprocessor allows you to configure SSL inspection, which can block encrypted traffic, decrypt it, or inspect the traffic with access control. Whether or not you configure SSL inspection, the SSL preprocessor also analyzes SSL handshake messages when detected in traffic and determines when a session becomes...
encrypted. Identifying encrypted traffic allows the system to stop intrusion and file inspection of encrypted payloads, which helps reduce false positives and improve performance.

The SSL preprocessor can also examine encrypted traffic to detect attempts to exploit the Heartbleed bug, and generate events when it detects such exploits.

You can suspend inspecting traffic for intrusions and malware once the session is encrypted. If you configure SSL inspection, the SSL preprocessor also identifies encrypted traffic you can block, decrypt, or inspect with access control.

Using the SSL preprocessor to decrypt encrypted traffic does not require a license. All other SSL preprocessor functionality, including halting inspection of encrypted payloads for malware and intrusions, and detecting Heartbleed bug exploits, requires a Protection license.

**How SSL Preprocessing Works**

The SSL preprocessor stops intrusion and file inspection of encrypted data, and inspects encrypted traffic with an SSL policy if you configure SSL inspection. This can help to eliminate false positives. The SSL preprocessor maintains state information as it inspects the SSL handshake, tracking both the state and SSL version for that session. When the preprocessor detects that a session state is encrypted, the system marks the traffic in that session as encrypted. You can configure the system to stop processing on all packets in an encrypted session when encryption is established, as well as generate an event when it detects an attempt to exploit the Heartbleed bug.

For each packet, the SSL preprocessor verifies that the traffic contains an IP header, a TCP header, and a TCP payload, and that it occurs on the ports specified for SSL preprocessing. For qualifying traffic, the following scenarios determine whether the traffic is encrypted:

- The system observes all packets in a session, **Server side data is trusted** is not enabled, and the session includes a Finished message from both the server and the client and at least one packet from each side with an Application record and without an Alert record.
- The system misses some of the traffic, **Server side data is trusted** is not enabled, and the session includes at least one packet from each side with an Application record that is not answered with an Alert record.
- The system observes all packets in a session, **Server side data is trusted** is enabled, and the session includes a Finished message from the client and at least one packet from the client with an Application record and without an Alert record.
- The system misses some of the traffic, **Server side data is trusted** is enabled, and the session includes at least one packet from the client with an Application record that is not answered with an Alert record.

If you choose to stop processing on encrypted traffic, the system ignores future packets in a session after it marks the session as encrypted.

In addition, during the SSL handshake, the preprocessor monitors heartbeat requests and responses. The preprocessor generates an event if it detects:

- a heartbeat request containing a payload length value greater than the payload itself
- a heartbeat response that is larger than the value stored in the Max Heartbeat Length field
You can add the `ssl_state` and `ssl_version` keywords to a rule to use SSL state or version information within the rule.

Related Topics

- SSL Keywords, on page 991
- TLS/SSL Inspection Requirements

### SSL Preprocessor Options

The system-provided network analysis policies enable the SSL preprocessor by default. Cisco recommends that you do not disable the SSL preprocessor in custom deployments if you expect encrypted traffic to cross your network.

Without SSL inspection configured, the system attempts to inspect encrypted traffic for malware and intrusions without decrypting it. When you enable the SSL preprocessor, it detects when a session becomes encrypted. After the SSL preprocessor is enabled, the rules engine can invoke the preprocessor to obtain SSL state and version information. If you enable rules using the `ssl_state` and `ssl_version` keywords in an intrusion policy, you should also enable the SSL preprocessor in that policy.

### Ports

Specifies the ports, separated by commas, where the SSL preprocessor should monitor traffic for encrypted sessions. Only ports specified in this field will be checked for encrypted traffic.

If the SSL preprocessor detects non-SSL traffic over the ports specified for SSL monitoring, it tries to decode the traffic as SSL traffic, and then flags it as corrupt.

### Stop inspecting encrypted traffic

Enables or disables inspection of traffic in a session after the session is marked as encrypted.

Enable this option to disable inspection and reassembly for encrypted sessions. The SSL preprocessor maintains state for the session so it can disable inspection of all traffic in the session. When this option is enabled a few packets of a session are verified to ensure the flow is encrypted after which deep inspection is bypassed. Every bypassed session increases the fast-forwarded flows count shown in the response of the `show snort statistics` command. Moreover, since deep inspection is bypassed, the initiator and responder bytes in the connection event are not accurate. They are less than the value of the actual session, since it only includes the packets inspected by Snort and it does not include any packets after the deep inspection is bypassed. This behavior holds good for connection summary events and all traffic values shown in the widgets.

The system only stops inspecting traffic in encrypted sessions if both:

- SSL preprocessing is enabled
- this option is selected
If you clear this option, you cannot modify the Server side data is trusted option.

Server side data is trusted

When Stop inspecting encrypted traffic is enabled, enables identification of encrypted traffic based only on the client-side traffic,

Max Heartbeat Length

By specifying a number of bytes, enables inspection of heartbeat requests and responses within the SSL handshake for Heartbleed bug exploit attempts. You can specify an integer from 1 to 65535, or 0 to disable the option.

If the preprocessor detects a heartbeat request whose payload length is greater than the actual payload length and rule 137:3 is enabled, or a heartbeat response greater in size than the value configured for this option when rule 137:4 is enabled, the preprocessor generates an event and, in an inline deployment, drops offending packets.

### Configuring the SSL Preprocessor

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1** Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

**Note** If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2** Click the edit icon (📝) next to the policy you want to edit.

If a view icon (ビュー) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click Settings in the navigation panel.

**Step 4** If SSL Configuration under Application Layer Preprocessors is disabled, click Enabled.

**Step 5** Click the edit icon (📝) next to SSL Configuration.

**Step 6** Modify any of the settings described in SSL Preprocessor Options, on page 1129.

- Enter a value in the Ports field. Separate multiple values with commas.
- Check or clear the Stop inspecting encrypted traffic check box.
- If you checked Stop inspecting encrypted traffic, check or clear Server side data is trusted.
- Enter a value in the Max Heartbeat Length field.

**Tip** A value of 0 disables this option.
Step 7
To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.
If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

What to do next
- If you want to enable intrusion events, enable SSL preprocessor rules (GID 137). For more information, see Setting Intrusion Rule States, on page 889.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics
- Managing Layers, on page 856
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846
- TLS/SSL Inspection Requirements

SSL Preprocessor Rules
If you want to generate events and, in an inline deployment, drop offending packets, enable SSL preprocessor rules (GID 137).
The following table describes the SSL preprocessor rules you can enable.

Table 178: SSL Preprocessor Rules

<table>
<thead>
<tr>
<th>Preprocessor Rule GID:SID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>137:1</td>
<td>Detects a ClientHello message after a ServerHello message, which is invalid and considered to be anomalous behavior.</td>
</tr>
<tr>
<td>137:2</td>
<td>Detects a ServerHello message without a ClientHello message when the SSL preprocessor option Server side data is trusted is disabled, which is invalid and considered to be anomalous behavior.</td>
</tr>
<tr>
<td>137:3</td>
<td>Detects a heartbeat request with a payload length greater than the payload itself when the SSL preprocessor option Max Heartbeat Length contains a non-zero value, which indicates an attempt to exploit the Heartbleed bug.</td>
</tr>
<tr>
<td>137:4</td>
<td>Detects a heartbeat response larger than a non-zero value specified in the SSL preprocessor option Max Heartbeat Length, which indicates an attempt to exploit the Heartbleed bug.</td>
</tr>
</tbody>
</table>
The following topics explain preprocessors for Supervisory Control and Data Acquisition (SCADA) protocols, and how to configure them:

- Introduction to SCADA Preprocessors, on page 1133
- The Modbus Preprocessor, on page 1133
- The DNP3 Preprocessor, on page 1135

## Introduction to SCADA Preprocessors

Supervisory Control and Data Acquisition (SCADA) protocols monitor, control, and acquire data from industrial, infrastructure, and facility processes such as manufacturing, production, water treatment, electric power distribution, airport and shipping systems, and so on. The Firepower System provides preprocessors for the Modbus and Distributed Network Protocol (DNP3) SCADA protocols that you can configure as part of your network analysis policy.

If the Modbus or DNP3 preprocessor is disabled, and you enable and deploy an intrusion rule that requires one of these preprocessors, the system automatically uses the required preprocessor, with its current settings, although the preprocessor remains disabled in the web interface for the corresponding network analysis policy.

## The Modbus Preprocessor

The Modbus protocol, which was first published in 1979 by Modicon, is a widely used SCADA protocol. The Modbus preprocessor detects anomalies in Modbus traffic and decodes the Modbus protocol for processing by the rules engine, which uses Modbus keywords to access certain protocol fields.

A single configuration option allows you to modify the default setting for the port that the preprocessor inspects for Modbus traffic.

**Related Topics**

- SCADA Keywords, on page 1013
Modbus Preprocessor Ports Option

Ports

Specifies the ports that the preprocessor inspects for Modbus traffic. Separate multiple ports with commas.

Configuring the Modbus Preprocessor

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

You should not enable this preprocessor in a network analysis policy that you apply to traffic if your network does not contain any Modbus-enabled devices.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

Procedure

Step 1
Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note
If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2
Click the edit icon (EDIT) next to the policy you want to edit.

If a view icon (VIEW) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3
Click Settings in the navigation panel.

Step 4
If Modbus Configuration under SCADA Preprocessors is disabled, click Enabled.

Step 5
Click the edit icon (EDIT) next to Modbus Configuration.

Step 6
Enter a value in the Ports field.
Separate multiple values with commas.

Step 7
To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.
If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.
What to do next

• If you want to generate events and, in an inline deployment, drop offending packets, enable Modbus preprocessor rules (GID 144). For more information, see Setting Intrusion Rule States, on page 889 and Modbus Preprocessor Rules, on page 1135.

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Managing Layers, on page 856
Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

Modbus Preprocessor Rules

You must enable the Modbus preprocessor rules in the following table if you want these rules to generate events and, in an inline deployment, drop offending packets.

Table 179: Modbus Preprocessor Rules

<table>
<thead>
<tr>
<th>Preprocessor Rule GID:SID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>144:1</td>
<td>Generates an event when the length in the Modbus header does not match the length required by the Modbus function code. Each Modbus function has an expected format for requests and responses. If the length of the message does not match the expected format, this event is generated.</td>
</tr>
<tr>
<td>144:2</td>
<td>Generates an event when the Modbus protocol ID is non-zero. The protocol ID field is used for multiplexing other protocols with Modbus. Because the preprocessor does not process these other protocols, this event is generated instead.</td>
</tr>
<tr>
<td>144:3</td>
<td>Generates an event when the preprocessor detects a reserved Modbus function code.</td>
</tr>
</tbody>
</table>

The DNP3 Preprocessor

The Distributed Network Protocol (DNP3) is a SCADA protocol that was originally developed to provide consistent communication between electrical stations. DNP3 has also become widely used in the water, waste, transportation, and many other industries.

The DNP3 preprocessor detects anomalies in DNP3 traffic and decodes the DNP3 protocol for processing by the rules engine, which uses DNP3 keywords to access certain protocol fields.

Related Topics

DNP3 Keywords, on page 1014
DNP3 Preprocessor Options

**Ports**
Enables inspection of DNP3 traffic on each specified port. You can specify a single port or a comma-separated list of ports.

**Log bad CRCs**
Validates the checksums contained in DNP3 link layer frames. Frames with invalid checksums are ignored. You can enable rule 145:1 to generate events and, in an inline deployment, drop offending packets when invalid checksums are detected.

Configuring the DNP3 Preprocessor

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

You should not enable this preprocessor in a network analysis policy that you apply to traffic if your network does not contain any DNP3-enabled devices.

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.

**Procedure**

**Step 1** Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

**Note** If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2** Click the edit icon (✍) next to the policy you want to edit.

If a view icon (👁) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click Settings in the navigation panel.

**Step 4** If DNP3 Configuration under SCADA Preprocessors is disabled, click Enabled.

**Step 5** Click the edit icon (✍) next to DNP3 Configuration.

**Step 6** Enter a value for Ports.
Separate multiple values with commas.

**Step 7** Check or clear the Log bad CRCs check box.
Step 8  

To save changes you made in this policy since the last policy commit, click **Policy Information**, then click **Commit Changes**.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

---

What to do next

- If you want to generate events and, in an inline deployment, drop offending packets, enable DNP3 preprocessor rules (GID 145). For more information, see Setting Intrusion Rule States, on page 889, DNP3 Preprocessor Options, on page 1136, and DNP3 Preprocessor Rules, on page 1137.

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Managing Layers, on page 856
Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

---

DNP3 Preprocessor Rules

You must enable the DNP3 preprocessor rules in the following table if you want these rules to generate events and, in an inline deployment, drop offending packets.

**Table 180: DNP3 Preprocessor Rules**

<table>
<thead>
<tr>
<th>Preprocessor Rule GID:SID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>145:1</td>
<td>When <strong>Log bad CRC</strong> is enabled, generates an event when the preprocessor detects a link layer frame with an invalid checksum.</td>
</tr>
<tr>
<td>145:2</td>
<td>Generates an event and blocks the packet when the preprocessor detects a DNP3 link layer frame with an invalid length.</td>
</tr>
<tr>
<td>145:3</td>
<td>Generates an event and blocks the packet during reassembly when the preprocessor detects a transport layer segment with an invalid sequence number.</td>
</tr>
<tr>
<td>145:4</td>
<td>Generates an event when the DNP3 reassembly buffer is cleared before a complete fragment can be reassembled. This happens when a segment carrying the FIR flag appears after other segments have been queued.</td>
</tr>
<tr>
<td>145:5</td>
<td>Generates an event when the preprocessor detects a DNP3 link layer frame that uses a reserved address.</td>
</tr>
<tr>
<td>145:6</td>
<td>Generates an event when the preprocessor detects a DNP3 request or response that uses a reserved function code.</td>
</tr>
</tbody>
</table>
DNP3 Preprocessor Rules
Transport & Network Layer Preprocessors

The following topics explain transport and network layer preprocessors and how to configure them:

- Introduction to Transport and Network Layer Preprocessors, on page 1139
- Advanced Transport/Network Preprocessor Settings, on page 1139
- Checksum Verification, on page 1142
- The Inline Normalization Preprocessor, on page 1144
- The IP Defragmentation Preprocessor, on page 1150
- The Packet Decoder, on page 1155
- TCP Stream Preprocessing, on page 1159
- UDP Stream Preprocessing, on page 1169

Introduction to Transport and Network Layer Preprocessors

Transport and network layer preprocessors detect attacks that exploit IP fragmentation, checksum validation, and TCP and UDP session preprocessing. Before packets are sent to preprocessors, the packet decoder converts packet headers and payloads into a format that can be easily used by the preprocessors and the intrusion rules engine and detects various anomalous behaviors in packet headers. After packet decoding and before sending packets to other preprocessors, the inline normalization preprocessor normalizes traffic for inline deployments.

When an intrusion rule or rule argument requires a disabled preprocessor, the system automatically uses it with its current configuration even though it remains disabled in the network analysis policy’s web interface.

Advanced Transport/Network Preprocessor Settings

Advanced transport and network preprocessor settings apply globally to all networks, zones, and VLANs where you deploy your access control policy. You configure these advanced settings in an access control policy rather than in a network analysis policy.

Ignored VLAN Headers

Different VLAN tags in traffic traveling in different directions for the same connection can affect traffic reassembly and rule processing. For example, in the following graphic traffic for the same connection could be transmitted over VLAN A and received over VLAN B.
You can configure the system to ignore the VLAN header so packets can be correctly processed for your deployment.

**Note**
This option is not supported on ASA FirePOWER.

### Active Responses in Intrusion Drop Rules

A drop rule is an intrusion or preprocessor rule whose rule state is set to Drop and Generate Events. In an inline deployment, the system responds to TCP or UDP drop rules by dropping the triggering packet and blocking the session where the packet originated.

**Tip**
Because UDP data streams are not typically thought of in terms of sessions, the stream preprocessor uses the source and destination IP address fields in the encapsulating IP datagram header and the port fields in the UDP header to determine the direction of flow and identify a UDP session.

You can configure the system to initiate one or more active responses to more precisely and specifically close a TCP connection or UDP session when an offending packet triggers a TCP or UDP drop rule. You can use active responses in inline, including routed and transparent, deployments. Active responses are not suited or supported for passive deployments.

To configure active responses:

- Create or modify a TCP or UDP (**resp** keyword only) intrusion rule. See [Intrusion Rule Header Protocol](#), on page 930.
- Add the **react** or **resp** keyword to the intrusion rule; see [Active Response Keywords](#), on page 1018.
- Optionally, for a TCP connection, specify the maximum number of additional active responses to send and the number of seconds to wait between active responses; see [Maximum Active Responses](#) and [Minimum Response Seconds](#) in [Advanced Transport/Network Preprocessor Options](#), on page 1141.

Active responses close the session when matching traffic triggers a drop rule, as follows:

- **TCP**—drops the triggering packet and inserts a TCP Reset (RST) packet in both the client and server traffic.
- **UDP**—sends an ICMP unreachable packet to each end of the session.
Advanced Transport/Network Preprocessor Options

Ignored the VLAN header when tracking connections

Specifies whether to ignore or include VLAN headers when identifying traffic, as follows:

- When this option is selected, the system ignores VLAN headers. Use this setting for deployed devices that might detect different VLAN tags for the same connection in traffic traveling in different directions.
- When this option is disabled, the system includes VLAN headers. Use this setting for deployed devices that will not detect different VLAN tags for the same connection traffic traveling in different directions.

Note

This option is not supported on ASA FirePOWER.

Maximum Active Responses

Specifies a maximum number of active responses per TCP connection. When additional traffic occurs on a connection where an active response has been initiated, and the traffic occurs more than Minimum Response Seconds after a previous active response, the system sends another active response unless the specified maximum has been reached. A setting of 0 disables additional active responses triggered by resp or react rules. See Active Responses in Intrusion Drop Rules, on page 1140 and Active Response Keywords, on page 1018.

Note that a triggered resp or react rule initiates an active response regardless of the configuration of this option.

Minimum Response Seconds

Until Maximum Active Responses occur, specifies the number of seconds to wait before any additional traffic on a connection where the system has initiated an active response results in a subsequent active response.

Troubleshooting Options: Session Termination Logging Threshold

Caution

Do not modify Session Termination Logging Threshold unless instructed to do so by Support.

Support might ask you during a troubleshooting call to configure your system to log a message when an individual connection exceeds the specified threshold. Changing the setting for this option will affect performance and should be done only with Support guidance.

This option specifies for the number of bytes that result in a logged message when the session terminates and the specified number was exceeded.

Note

The upper limit of 1 GB is also restricted by the amount of memory on the managed device allocated for stream processing.

Related Topics

Active Response Keywords, on page 1018
Configuring Advanced Transport/Network Preprocessor Settings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1**
In the access control policy editor, click the Advanced tab.

**Step 2**
Click the edit icon (📝) next to the Transport/Network Layer Settings section.

**Step 3**
Except for the troubleshooting option **Session Termination Logging Threshold**, modify the options described in Advanced Transport/Network Preprocessor Options, on page 1141.

**Note**
The **Ignore the VLAN header when tracking connections** option is not available on the ASA FirePOWER module.

**Caution**
Do not modify **Session Termination Logging Threshold** unless instructed to do so by Support.

**Step 4**
Click OK.

What to do next

- Optionally, further configure the policy as described in Editing an Access Control Policy, on page 629.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Checksum Verification

The system can verify all protocol-level checksums to ensure that complete IP, TCP, UDP, and ICMP transmissions are received and that, at a basic level, packets have not been tampered with or accidentally altered in transit. A checksum uses an algorithm to verify the integrity of a protocol in the packet. The packet is considered to be unchanged if the system computes the same value that is written in the packet by the end host.

Disabling checksum verification may leave your network susceptible to insertion attacks. Note that the system does not generate checksum verification events. In an inline deployment, you can configure the system to drop packets with invalid checksums.

Checksum Verification Options

You can set any of the following options to **Enabled** or **Disabled** in a passive or inline deployment, or to **Drop** in an inline deployment:

- **ICMP Checksums**
• IP Checksums
• TCP Checksums
• UDP Checksums

To drop offending packets, in addition to setting an option to Drop you must also enable Inline Mode in the associated network analysis policy and ensure that the device is deployed inline.

Setting these options to Drop in a passive deployment, or in an inline deployment in tap mode, is the same as setting them to Enabled.

The default for all checksum verification options is Enabled.

Related Topics
Preprocessor Traffic Modification in Inline Deployments, on page 1065

Verifying Checksums

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2 Click the edit icon ( ) next to the policy you want to edit.

If a view icon ( ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3 Click Settings in the navigation panel.

Step 4 If Checksum Verification under Transport/Network Layer Preprocessors is disabled, click Enabled.

Step 5 Click the edit icon ( ) next to Checksum Verification.

Step 6 Modify the options described in Checksum Verification, on page 1142.

Step 7 To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.
What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Layer Management, on page 854
Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

The Inline Normalization Preprocessor

The inline normalization preprocessor normalizes traffic to minimize the chances of attackers evading detection in inline deployments.

Note

For the system to affect traffic, you must deploy relevant configurations to managed devices using routed, switched, or transparent interfaces, or inline interface pairs.

You can specify normalization of any combination of IPv4, IPv6, ICMPv4, ICMPv6, and TCP traffic. Most normalizations are on a per-packet basis and are conducted by the inline normalization preprocessor. However, the TCP stream preprocessor handles most state-related packet and stream normalizations, including TCP payload normalization.

Inline normalization takes place immediately after decoding by the packet decoder and before processing by other preprocessors. Normalization proceeds from the inner to outer packet layers.

The inline normalization preprocessor does not generate events; it prepares packets for use by other preprocessors and the rules engine in inline deployments. The preprocessor also helps ensure that the packets the system processes are the same as the packets received by the hosts on your network.

Note

In an inline deployment, Cisco recommends that you enable inline mode and configure the inline normalization preprocessor with the Normalize TCP Payload option enabled. In a passive deployment, Cisco recommends that you use adaptive profiles.

Related Topics

Preprocessor Traffic Modification in Inline Deployments, on page 1065
About Adaptive Profiles, on page 1193

Inline Normalization Options

Minimum TTL

When Reset TTL is greater than or equal to the value set for this option, specifies the following:

• the minimum value the system will permit in the IPv4 Time to Live (TTL) field when Normalize IPv4 is enabled; a lower value results in normalizing the packet value for TTL to the value set for Reset TTL

• the minimum value the system will permit in the IPv6 Hop Limit field when Normalize IPv6 is enabled; a lower value results in normalizing the packet value for Hop Limit to the value set for Reset TTL
The system assumes a value of 1 when the field is empty.

When the packet decoding Detect Protocol Header Anomalies option is enabled, you can enable the following rules in the decoder rule category to generate events and, in an inline deployment, drop offending packets for this option:

- You can enable rule 116:428 to trigger when the system detects an IPv4 packet with a TTL less than the specified minimum.
- You can enable rule 116:270 to trigger when the system detects an IPv6 packet with a hop limit that is less than the specified minimum.

**Reset TTL**

When set to a value greater than or equal to Minimum TTL, normalizes the following:

- the IPv4 TTL field when Normalize IPv4 is enabled
- the IPv6 Hop Limit field when Normalize IPv6 is enabled

The system normalizes the packet by changing its TTL or Hop Limit value to the value set for this option when the packet value is less than Minimum TTL. Leaving this field blank, or setting it to 0, or to any value less than Minimum TTL, disables the option.

**Normalize IPv4**

Enables normalization of IPv4 traffic. The system also normalizes the TTL field as needed when:

- this option is enabled, and
- the value set for Reset TTL enables TTL normalization.

You can also enable additional IPv4 options when this option is enabled.

When you enable this option, the system performs the following base IPv4 normalizations:

- truncates packets with excess payload to the datagram length specified in the IP header
- clears the Differentiated Services (DS) field, formerly known as the Type of Service (TOS) field
- sets all option octets to 1 (No Operation)

**Normalize Don’t Fragment Bit**

Clears the single-bit Don’t Fragment subfield of the IPv4 Flags header field. Enabling this option allows a downstream router to fragment packets if necessary instead of dropping them; enabling this option can also prevent evasions based on crafting packets to be dropped. You must enable Normalize IPv4 to select this option.

**Normalize Reserved Bit**

Clears the single-bit Reserved subfield of the IPv4 Flags header field. You would typically enable this option. You must enable Normalize IPv4 to select this option.
**Normalize TOS Bit**

Clears the one byte Differentiated Services field, formerly known as Type of Service. You must enable Normalize IPv4 to select this option.

**Normalize Excess Payload**

Truncates packets with excess payload to the datagram length specified in the IP header plus the Layer 2 (for example, Ethernet) header, but does not truncate below the minimum frame length. You must enable Normalize IPv4 to select this option.

**Normalize IPv6**

Sets all Option Type fields in the Hop-by-Hop Options and Destination Options extension headers to 00 (Skip and continue processing). The system also normalizes the Hop Limit field as needed when this option is enabled and the value set for Reset TTL enables hop limit normalization.

**Normalize ICMPv4**

Clears the 8-bit Code field in Echo (Request) and Echo Reply messages in ICMPv4 traffic.

**Normalize ICMPv6**

Clears the 8-bit Code field in Echo (Request) and Echo Reply messages in ICMPv6 traffic.

**Normalize/Clear Reserved Bits**

Clears the Reserved bits in the TCP header.

**Normalize/Clear Option Padding Bytes**

Clears any TCP option padding bytes.

**Clear Urgent Pointer if URG=0**

Clears the 16-bit TCP header Urgent Pointer field if the urgent (URG) control bit is not set.

**Clear Urgent Pointer/URG on Empty Payload**

Clears the TCP header Urgent Pointer field and the URG control bit if there is no payload.

**Clear URG if Urgent Pointer is Not Set**

Clears the TCP header URG control bit if the urgent pointer is not set.

**Normalize Urgent Pointer**

Sets the two-byte TCP header Urgent Pointer field to the payload length if the pointer is greater than the payload length.

**Normalize TCP Payload**

Enables normalization of the TCP Data field to ensure consistency in retransmitted data. Any segment that cannot be properly reassembled is dropped.
**Remove Data on SYN**
Removes data in synchronization (SYN) packets if your TCP operating system policy is **not** Mac OS.
This option also disables rule 129:2, which can otherwise trigger when the TCP stream preprocessor **Policy** option is not set to **Mac OS**.

**Remove Data on RST**
Removes any data from a TCP reset (RST) packet.

**Trim Data to Window**
Trims the TCP Data field to the size specified in the Window field.

**Trim Data to MSS**
Trims the TCP Data field to the Maximum Segment Size (MSS) if the payload is longer than MSS.

**Block Unresolvable TCP Header Anomalies**
When you enable this option, the system blocks anomalous TCP packets that, if normalized, would be invalid and likely would be blocked by the receiving host. For example, the system blocks any SYN packet transmitted subsequent to an established session.

The system also drops any packet that matches any of the following TCP stream preprocessor rules, regardless of whether the rules are enabled:

- 129:1
- 129:3
- 129:4
- 129:6
- 129:8
- 129:11
- 129:14 through 129:19

The Total Blocked Packets performance graph tracks the number of packets blocked in inline deployments and, in passive deployments and inline deployments in tap mode, the number that would have been blocked in an inline deployment.

**Explicit Congestion Notification**
Enables per-packet or per-stream normalization of Explicit Congestion Notification (ECN) flags as follows:

- select **Packet** to clear ECN flags on a per-packet basis regardless of negotiation
- select **Stream** to clear ECN flags on a per-stream basis if ECN use was not negotiated

If you select **Stream**, you must also ensure that the TCP stream preprocessor **Require TCP 3-Way Handshake** option is enabled for this normalization to take place.
**Clear Existing TCP Options**

Enables **Allow These TCP Options**.

---

**Allow These TCP Options**

Disables normalization of specific TCP options you allow in traffic.

The system does not normalize options that you explicitly allow. It normalizes options that you do not explicitly allow by setting the options to No Operation (TCP Option 1).

The system always allows the following options regardless of the configuration of **Allow These TCP Options** because they are commonly used for optimal TCP performance:

- Maximum Segment Size (MSS)
- Window Scale
- Time Stamp TCP

The system does not automatically allow other less commonly used options.

You can allow specific options by configuring a comma-separated list of option keywords, option numbers, or both as shown in the following example:

```
sack, echo, 19
```

Specifying an option keyword is the same as specifying the number for one or more TCP options associated with the keyword. For example, specifying `sack` is the same as specifying TCP options 4 (Selective Acknowledgment Permitted) and 5 (Selective Acknowledgment). Option keywords are not case sensitive.

You can also specify `any`, which allows all TCP options and effectively disables normalization of all TCP options.

The following table summarizes how you can specify TCP options to allow. If you leave the field empty, the system allows only the MSS, Window Scale, and Time Stamp options.

<table>
<thead>
<tr>
<th>Specify...</th>
<th>To allow...</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sack</code></td>
<td>TCP options 4 (Selective Acknowledgment Permitted) and 5 (Selective Acknowledgment)</td>
</tr>
<tr>
<td><code>echo</code></td>
<td>TCP options 6 (Echo Request) and 7 (Echo Reply)</td>
</tr>
<tr>
<td><code>partial_order</code></td>
<td>TCP options 9 (Partial Order Connection Permitted) and 10 (Partial Order Service Profile)</td>
</tr>
<tr>
<td><code>conn_count</code></td>
<td>TCP Connection Count options 11 (CC), 12 (CC.New), and 13 (CC.Echo)</td>
</tr>
<tr>
<td><code>alt_checksum</code></td>
<td>TCP options 14 (Alternate Checksum Request) and 15 (Alternate Checksum)</td>
</tr>
<tr>
<td><code>md5</code></td>
<td>TCP option 19 (MD5 Signature)</td>
</tr>
<tr>
<td>the option number, 2 to 255</td>
<td>a specific option, including options for which there is no keyword</td>
</tr>
</tbody>
</table>
To allow... | Specify...
---|---
all TCP options; this setting effectively disables TCP option normalization | any

When you do not specify \textit{any} for this option, normalizations include the following:

- except MSS, Window Scale, Time Stamp, and any explicitly allowed options, sets all option bytes to No Operation (TCP Option 1)
- sets the Time Stamp octets to No Operation if Time Stamp is present but invalid, or valid but not negotiated
- blocks the packet if Time Stamp is negotiated but not present
- clears the Time Stamp Echo Reply (TSecr) option field if the Acknowledgment (ACK) control bit is not set
- sets the MSS and Window Scale options to No Operation (TCP Option 1) if the SYN control bit is not set

\textbf{Related Topics}

\textit{Intrusion Event Performance Statistics Graph Types}, on page 1662

### Configuring Inline Normalization

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

\textbf{Before you begin}

- If you want to normalize or drop offending packets, enable \textbf{Inline Mode} as described in Preprocessor Traffic Modification in Inline Deployments, on page 1065. The managed device must also be deployed inline.

\textbf{Procedure}

\begin{itemize}
  \item \textbf{Step 1} Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.
  \item \textbf{Note} If your custom user role limits access to the first path listed here, use the second path to access the policy.
  \item \textbf{Step 2} Click the edit icon (-pencil) next to the policy you want to edit.
  \item If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
  \item \textbf{Step 3} Click Settings in the navigation panel.
\end{itemize}
The IP Defragmentation Preprocessor

When an IP datagram is broken into two or more smaller IP datagrams because it is larger than the maximum transmission unit (MTU), it is fragmented. A single IP datagram fragment may not contain enough information to identify a hidden attack. Attackers may attempt to evade detection by transmitting attack data in fragmented packets. The IP defragmentation preprocessor reassembles fragmented IP datagrams before the rules engine executes rules against them so the rules can more appropriately identify attacks in those packets. If fragmented datagrams cannot be reassembled, rules do not execute against them.

IP Fragmentation Exploits

Enabling IP defragmentation helps you detect attacks against hosts on your network, like the teardrop attack, and resource consumption attacks against the system itself, like the Jolt2 attack.

The Teardrop attack exploits a bug in certain operating systems that causes them to crash when trying to reassemble overlapping IP fragments. When enabled and configured to do so, the IP defragmentation preprocessor identifies the overlapping fragments. The IP defragmentation preprocessor detects the first packets in an overlapping fragment attack such as Teardrop, but does not detect subsequent packets for the same attack.

The Jolt2 attack sends a large number of copies of the same fragmented IP packet in an attempt to overuse IP defragmentors and cause a denial of service attack. A memory usage cap disrupts this and similar attacks in the IP defragmentation preprocessor, and places the system self-preservation above exhaustive inspection. The system is not overwhelmed by the attack, remains operational, and continues to inspect network traffic.

Different operating systems reassemble fragmented packets in different ways. Attackers who can determine which operating systems your hosts are running can also fragment malicious packets so that a target host...
reassembles them in a specific manner. Because the system does not know which operating systems the hosts on your monitored network are running, the preprocessor may reassemble and inspect the packets incorrectly, thus allowing an exploit to pass through undetected. To mitigate this kind of attack, you can configure the defragmentation preprocessor to use the appropriate method of defragmenting packets for each host on your network.

Note that you can also use adaptive profiles in a passive deployment to dynamically select target-based policies for the IP defragmentation preprocessor using host operating system information for the target host in a packet.

**Target-Based Defragmentation Policies**

A host's operating system uses three criteria to determine which packet fragments to favor when reassembling the packet:

- the order in which the fragment was received by the operating system
- its offset (the fragment's distance, in bytes, from the beginning of the packet)
- its beginning and ending position compared to overlap fragments.

Although every operating system uses these criteria, different operating systems favor different fragments when reassembling fragmented packets. Therefore, two hosts with different operating systems on your network could reassemble the same overlapping fragments in entirely different ways.

An attacker, aware of the operating system of one of your hosts, could attempt to evade detection and exploit that host by sending malicious content hidden in overlapping packet fragments. This packet, when reassembled and inspected, seems innocuous, but when reassembled by the target host, contains a malicious exploit. However, if you configure the IP defragmentation preprocessor to be aware of the operating systems running on your monitored network segment, it will reassemble the fragments the same way that the target host does, allowing it to identify the attack.

**IP Defragmentation Options**

You can choose to simply enable or disable IP defragmentation; however, Cisco recommends that you specify the behavior of the enabled IP defragmentation preprocessor at a more granular level.

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

You can configure the following global option:

**Preallocated Fragments**

The maximum number of individual fragments that the preprocessor can process at once. Specifying the number of fragment nodes to preallocate enables static memory allocation.

---

**Caution**

Processing an individual fragment uses approximately 1550 bytes of memory. If the preprocessor requires more memory to process the individual fragments than the predetermined allowable memory limit for the managed device, the memory limit for the device takes precedence.

You can configure the following options for each IP defragmentation policy:
Networks

The IP address of the host or hosts to which you want to apply the defragmentation policy.

You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 255 total profiles, including the default policy.

Note

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).

Policy

The defragmentation policy you want to use for a set of hosts on your monitored network segment.

You can select one of seven defragmentation policies, depending on the operating system of the target host. The following table lists the seven policies and the operating systems that use each one. The First and Last policy names reflect whether those policies favor original or subsequent overlapping packets.

Table 181: Target-Based Defragmentation Policies

<table>
<thead>
<tr>
<th>Policy</th>
<th>Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSD</td>
<td>AIX</td>
</tr>
<tr>
<td>BSD</td>
<td>FreeBSD</td>
</tr>
<tr>
<td>BSD</td>
<td>IRIX</td>
</tr>
<tr>
<td>BSD</td>
<td>VAX/VMS</td>
</tr>
<tr>
<td>BSD-right</td>
<td>HP JetDirect</td>
</tr>
<tr>
<td>First</td>
<td>Mac OS</td>
</tr>
<tr>
<td>Linux</td>
<td>Linux</td>
</tr>
<tr>
<td>Linux</td>
<td>OpenBSD</td>
</tr>
<tr>
<td>Last</td>
<td>Cisco IOS</td>
</tr>
<tr>
<td>Solaris</td>
<td>SunOS</td>
</tr>
<tr>
<td>Windows</td>
<td>Windows</td>
</tr>
</tbody>
</table>
**Timeout**

Specifies the maximum amount of time, in seconds, that the preprocessor engine can use when reassembling a fragmented packet. If the packet cannot be reassembled within the specified time period, the preprocessor engine stops attempting to reassemble the packet and discards received fragments.

**Min TTL**

Specifies the minimum acceptable TTL value a packet may have. This option detects TTL-based insertion attacks.

You can enable rule 123:11 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Anomalies**

Identifies fragmentation problems such as overlapping fragments.

You can enable the following rules to generate events and, in an inline deployment, drop offending packets for this option:

- 123:1 through 123:4
- 123:5 (BSD policy)
- 123:6 through 123:8

**Overlap Limit**

Specifies that when the configured number of overlapping segments in a session has been detected, defragmentation stops for that session.

You must enable Detect Anomalies to configure this option. A blank value disables this option. A value of 0 specifies an unlimited number overlapping segments.

You can enable rule 123:12 to generate events and, in an inline deployment, drop offending packets for this option.

**Minimum Fragment Size**

Specifies that when a non-last fragment smaller than the configured number of bytes has been detected, the packet is considered malicious.

You must enable Detect Anomalies to configure this option. A blank value disables this option. A value of 0 specifies an unlimited number of bytes.

You can enable rule 123:13 to generate events and, in an inline deployment, drop offending packets for this option.

**Related Topics**

- [Firepower System IP Address Conventions](#), on page 14
Configuring IP Defragmentation

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Before you begin

- Confirm that any networks you want to identify in a custom target-based policy match or are a subset of the networks, zones, and VLANs handled by its parent network analysis policy. See Advanced Settings for Network Analysis Policies, on page 1053 for more information.

Procedure

Step 1
Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note
If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2
Click the edit icon (✎) next to the policy you want to edit.

If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3
Click Settings in the navigation panel.

Step 4
If IP Defragmentation under Transport/Network Layer Preprocessors is disabled, click Enabled.

Step 5
Click the edit icon (✎) next to IP Defragmentation.

Step 6
Optionally, enter a value in the Preallocated Fragments field.

Step 7
You have the following choices:

- Add a server profile — Click the add icon (➕) next to Servers on the left side of the page, then enter a value in the Host Address field and click OK. You can specify a single IP address or address block, or a comma-separated list of either or both. You can create a total of 255 target-based policies including the default policy.
- Edit a server profile — Click the configured address for under Servers on the left side of the page, or click default.
- Delete a profile — Click the delete icon (🗑️) next to the policy.

Step 8
Modify the options described in IP Defragmentation Options, on page 1151.

Step 9
To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.
If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

What to do next

- If you want to generate events and, in an inline deployment, drop offending packets, enable IP defragmentation rules (GID 123). For more information, see Setting Intrusion Rule States, on page 889 and IP Defragmentation Options, on page 1151.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

- Firepower System IP Address Conventions, on page 14
- Layer Basics, on page 849
- Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

The Packet Decoder

Before sending captured packets to a preprocessor, the system first sends the packets to the packet decoder. The packet decoder converts packet headers and payloads into a format that preprocessors and the rules engine can easily use. Each stack layer is decoded in turn, beginning with the data link layer and continuing through the network and transport layers.

Packet Decoder Options

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

Decode GTP Data Channel

Decodes the encapsulated GTP (General Packet Radio Service [GPRS] Tunneling Protocol) data channel. By default, the decoder decodes version 0 data on port 3386 and version 1 data on port 2152. You can use the GTP_PORTS default variable to modify the ports that identify encapsulated GTP traffic.

You can enable rules 116:297 and 116:298 to generate events and, in an inline deployment, drop offending packets for this option.

Detect Teredo on Non-Standard Ports

Inspects Teredo tunneling of IPv6 traffic that is identified on a UDP port other than port 3544.

The system always inspects IPv6 traffic when it is present. By default, IPv6 inspection includes the 4in6, 6in4, 6to4, and 6in6 tunneling schemes, and also includes Teredo tunneling when the UDP header specifies port 3544.

In an IPv4 network, IPv4 hosts can use the Teredo protocol to tunnel IPv6 traffic through an IPv4 Network Address Translation (NAT) device. Teredo encapsulates IPv6 packets within IPv4 UDP datagrams to permit IPv6 connectivity behind an IPv4 NAT device. The system normally uses UDP port 3544 to identify Teredo.
traffic. However, an attacker could use a non-standard port in an attempt to avoid detection. You can enable Detect Teredo on Non-Standard Ports to cause the system to inspect all UDP payloads for Teredo tunneling. Teredo decoding occurs only on the first UDP header, and only when IPv4 is used for the outer network layer. When a second UDP layer is present after the Teredo IPv6 layer because of UDP data encapsulated in the IPv6 data, the rules engine uses UDP intrusion rules to analyze both the inner and outer UDP layers.

Note that intrusion rules 12065, 12066, 12067, and 12068 in the policy-other rule category detect, but do not decode, Teredo traffic. Optionally, you can use these rules to drop Teredo traffic in an inline deployment; however, you should ensure that these rules are disabled or set to generate events without dropping traffic when you enable Detect Teredo on Non-Standard Ports.

**Detect Excessive Length Value**

Detects when the packet header specifies a packet length that is greater than the actual packet length. You can enable rules 116:6, 116:47, 116:97, and 116:275 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Invalid IP Options**

Detects invalid IP header options to identify exploits that use invalid IP options. For example, there is a denial of service attack against a firewall which causes the system to freeze. The firewall attempts to parse invalid Timestamp and Security IP options and fails to check for a zero length, which causes an irrecoverable infinite loop. The rules engine identifies the zero length option, and provides information you can use to mitigate the attack at the firewall.

You can enable rules 116:4 and 116:5 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Experimental TCP Options**

Detects TCP headers with experimental TCP options. The following table describes these options.

<table>
<thead>
<tr>
<th>TCP Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Partial Order Connection Permitted</td>
</tr>
<tr>
<td>10</td>
<td>Partial Order Service Profile</td>
</tr>
<tr>
<td>14</td>
<td>Alternate Checksum Request</td>
</tr>
<tr>
<td>15</td>
<td>Alternate Checksum Data</td>
</tr>
<tr>
<td>18</td>
<td>Trailer Checksum</td>
</tr>
<tr>
<td>20</td>
<td>Space Communications Protocol Standards (SCPS)</td>
</tr>
<tr>
<td>21</td>
<td>Selective Negative Acknowledgements (SCPS)</td>
</tr>
<tr>
<td>22</td>
<td>Record Boundaries (SCPS)</td>
</tr>
<tr>
<td>23</td>
<td>Corruption (SPCS)</td>
</tr>
<tr>
<td>24</td>
<td>SNAP</td>
</tr>
<tr>
<td>26</td>
<td>TCP Compression Filter</td>
</tr>
</tbody>
</table>
Because these are experimental options, some systems do not account for them and may be open to exploits.

In addition to the experimental options listed in the above table, the system considers any TCP option with an option number greater than 26 to be experimental.

You can enable rule 116:58 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Obsolete TCP Options**

Detects TCP headers with obsolete TCP options. Because these are obsolete options, some systems do not account for them and may be open to exploits. The following table describes these options.

<table>
<thead>
<tr>
<th>TCP Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Echo</td>
</tr>
<tr>
<td>7</td>
<td>Echo Reply</td>
</tr>
<tr>
<td>16</td>
<td>Skeeter</td>
</tr>
<tr>
<td>17</td>
<td>Bubba</td>
</tr>
<tr>
<td>19</td>
<td>MD5 Signature</td>
</tr>
<tr>
<td>25</td>
<td>Unassigned</td>
</tr>
</tbody>
</table>

You can enable rule 116:57 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect T/TCP**

Detects TCP headers with the CC.ECHO option. The CC.ECHO option confirms that TCP for Transactions (T/TCP) is being used. Because T/TCP header options are not in widespread use, some systems do not account for them and may be open to exploits.

You can enable rule 116:56 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Other TCP Options**

Detects TCP headers with invalid TCP options not detected by other TCP decoding event options. For example, this option detects TCP options with the incorrect length or with a length that places the option data outside the TCP header.

You can enable rules 116:54, 116:55, and 116:59 to generate events and, in an inline deployment, drop offending packets for this option.

**Detect Protocol Header Anomalies**

Detects other decoding errors not detected by the more specific IP and TCP decoder options. For example, the decoder might detect a malformed data-link protocol header.
To generate events and, in an inline deployment, drop offending packets for this option, you can enable any of the following rules:

<table>
<thead>
<tr>
<th>GID:SID</th>
<th>Generates an event if:</th>
</tr>
</thead>
<tbody>
<tr>
<td>116:467</td>
<td>The packet is smaller than the minimum size of a packet encapsulated with a Cisco FabricPath header.</td>
</tr>
<tr>
<td>116:468</td>
<td>The Cisco Meta Data (CMD) field in the header contains a header length smaller than the minimum size of a valid CMD header. The CMD field is associated with the Cisco Trustsec protocol.</td>
</tr>
<tr>
<td>116:469</td>
<td>The CMD field in the header contains an invalid field length.</td>
</tr>
<tr>
<td>116:470</td>
<td>The CMD field in the header contains an invalid Security Group Tag (SGT) option type.</td>
</tr>
<tr>
<td>116:471</td>
<td>The CMD field in the header contains an SGT with a reserved value.</td>
</tr>
</tbody>
</table>

You can also enable any packet decoder rule not associated with other packet decoder options.

**Related Topics**
- Predefined Default Variables, on page 335

## Configuring Packet Decoding

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose **Policies > Access Control**, then click **Network Analysis Policy** or **Policies > Access Control > Intrusion**, then click **Network Analysis Policy**.

**Note** If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2** Click the edit icon (📝) next to the policy you want to edit.

If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click **Settings** in the navigation panel.

**Step 4** If **Packet Decoding** under **Transport/Network Layer Preprocessors** is disabled, click **Enabled**.

**Step 5** Click the edit icon (📝) next to **Packet Decoding**.
Step 6
Enable or disable the options described in Packet Decoder Options, on page 1155.

Step 7
To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

What to do next

• If you want to generate events and, in an inline deployment, drop offending packets, enable packet decoder rules (GID 116). For more information, see Setting Intrusion Rule States, on page 889 and Packet Decoder Options, on page 1155.

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics
Layer Basics, on page 849
Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846

TCP Stream Preprocessing

The TCP protocol defines various states in which connections can exist. Each TCP connection is identified by the source and destination IP addresses and source and destination ports. TCP permits only one connection with the same connection parameter values to exist at a time.

State-Related TCP Exploits

If you add the flow keyword with the established argument to an intrusion rule, the intrusion rules engine inspects packets matching the rule and the flow directive in stateful mode. Stateful mode evaluates only the traffic that is part of a TCP session established with a legitimate three-way handshake between a client and server.

You can configure the system so that the preprocessor detects any TCP traffic that cannot be identified as part of an established TCP session, although this is not recommended for typical use because the events would quickly overload the system and not provide meaningful data.

Attacks like stick and snot use the system’s extensive rule sets and packet inspection against itself. These tools generate packets based on the patterns in Snort-based intrusion rules, and send them across the network. If your rules do not include the flow or flowbits keyword to configure them for stateful inspection, each packet will trigger the rule, overwhelming the system. Stateful inspection allows you to ignore these packets because they are not part of an established TCP session and do not provide meaningful information. When performing stateful inspection, the rules engine detects only those attacks that are part of an established TCP session, allowing analysts to focus on these rather than the volume of events caused by stick or snot.

Target-Based TCP Policies

Different operating systems implement TCP in different ways. For example, Windows and some other operating systems require a TCP reset segment to have a precise TCP sequence number to reset a session, while Linux
and other operating systems permit a range of sequence numbers. In this example, the stream preprocessor must understand exactly how the destination host will respond to the reset based on the sequence number. The stream preprocessor stops tracking the session only when the destination host considers the reset to be valid, so an attack cannot evade detection by sending packets after the preprocessor stops inspecting the stream. Other variations in TCP implementations include such things as whether an operating system employs a TCP timestamp option and, if so, how it handles the timestamp, and whether an operating system accepts or ignores data in a SYN packet.

Different operating systems also reassemble overlapping TCP segments in different ways. Overlapping TCP segments could reflect normal retransmissions of unacknowledged TCP traffic. They could also represent an attempt by an attacker, aware of the operating system of one of your hosts, to evade detection and exploit that host by sending malicious content hidden in overlapping segments. However, you can configure the stream preprocessor to be aware of the operating systems running on your monitored network segment so it reassembles segments the same way the target host does, allowing it to identify the attack.

You can create one or more TCP policies to tailor TCP stream inspection and reassembly to the different operating systems on your monitored network segment. For each policy, you identify one of thirteen operating system policies. You bind each TCP policy to a specific IP address or address block using as many TCP policies as you need to identify any or all of the hosts using a different operating system. The default TCP policy applies to any hosts on the monitored network that you do not identify in any other TCP policy, so there is no need to specify an IP address or address block for the default TCP policy.

Note that you can also use adaptive profiles in a passive deployment to dynamically select target-based policies for the TCP stream preprocessor using host operating system information for the target host in a packet.

**TCP Stream Reassembly**

The stream preprocessor collects and reassembles all the packets that are part of a TCP session’s server-to-client communication stream, client-to-server communication stream, or both. This allows the rules engine to inspect the stream as a single, reassembled entity rather than inspecting only the individual packets that are part of a given stream.

Stream reassembly allows the rules engine to identify stream-based attacks, which it may not detect when inspecting individual packets. You can specify which communication streams the rules engine reassembles based on your network needs. For example, when monitoring traffic on your web servers, you may only want to inspect client traffic because you are much less likely to receive malicious traffic from your own web server.

In each TCP policy, you can specify a comma-separated list of ports to identify the traffic for the stream preprocessor to reassemble. If adaptive profiles are enabled, you can also list services that identify traffic to reassemble, either as an alternative to ports or in combination with ports.

You can specify ports, services, or both. You can specify separate lists of ports for any combination of client ports, server ports, and both. You can also specify separate lists of services for any combination of client services, server services, and both. For example, assume that you wanted to reassemble the following:

- SMTP (port 25) traffic from the client
- FTP server responses (port 21)
- telnet (port 23) traffic in both directions

You could configure the following:

- For client ports, specify 23, 25
- For server ports, specify 21, 23
Or, instead, you could configure the following:

- For client ports, specify 25
- For server ports, specify 21
- For both ports, specify 23

Additionally, consider the following example which combines ports and services and would be valid when adaptive profiles are enabled:

- For client ports, specify 23
- For client services, specify smtp
- For server ports, specify 21
- For server services, specify telnet

Negating a port (for example, !80) can improve performance by preventing the TCP stream preprocessor from processing traffic for that port.

Although you can also specify all as the argument to provide reassembly for all ports, Cisco does not recommend setting ports to all because it may increase the amount of traffic inspected by this preprocessor and slow performance unnecessarily.

TCP reassembly automatically and transparently includes ports that you add to other preprocessors. However, if you do explicitly add ports to TCP reassembly lists that you have added to other preprocessor configurations, these additional ports are handled normally. This includes port lists for the following preprocessors:

- FTP/Telnet (server-level FTP)
- DCE/RPC
- HTTP Inspect
- SMTP
- Session Initiation Protocol
- POP
- IMAP
- SSL

Note that reassembling additional traffic types (client, server, both) increases resource demands.

**TCP Stream Preprocessing Options**

If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.

You can configure the following global TCP option:
Packet Type Performance Boost

Enables ignoring TCP traffic for all ports and application protocols that are not specified in enabled intrusion rules, except when a TCP rule with both the source and destination ports set to any has a flow or flowbits option. This performance improvement could result in missed attacks.

You can configure the following options for each TCP policy.

Network

Specifies the host IP addresses to which you want to apply the TCP stream reassembly policy.

You can specify a single IP address or address block. You can specify up to 255 total profiles including the default policy.

Note

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).

Policy

Identifies the TCP policy operating system of the target host or hosts. If you select a policy other than Mac OS, the system removes the data from the synchronization (SYN) packets and disables event generation for rule 129:2. Note that enabling the inline normalization preprocessor Remove Data on SYN option also disables rule 129:2.

The following table identifies the operating system policies and the host operating systems that use each.

<table>
<thead>
<tr>
<th>Policy</th>
<th>Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>unknown OS</td>
</tr>
<tr>
<td>Last</td>
<td>Cisco IOS</td>
</tr>
<tr>
<td>BSD</td>
<td>AIX</td>
</tr>
<tr>
<td></td>
<td>FreeBSD</td>
</tr>
<tr>
<td></td>
<td>OpenBSD</td>
</tr>
<tr>
<td>Linux</td>
<td>Linux 2.4 kernel</td>
</tr>
<tr>
<td></td>
<td>Linux 2.6 kernel</td>
</tr>
<tr>
<td>Old Linux</td>
<td>Linux 2.2 and earlier kernel</td>
</tr>
<tr>
<td>Policy</td>
<td>Operating Systems</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Windows</td>
<td>Windows 98</td>
</tr>
<tr>
<td></td>
<td>Windows NT</td>
</tr>
<tr>
<td></td>
<td>Windows 2000</td>
</tr>
<tr>
<td></td>
<td>Windows XP</td>
</tr>
<tr>
<td>Windows 2003</td>
<td>Windows 2003</td>
</tr>
<tr>
<td>Windows Vista</td>
<td>Windows Vista</td>
</tr>
<tr>
<td>Solaris</td>
<td>Solaris OS</td>
</tr>
<tr>
<td></td>
<td>SunOS</td>
</tr>
<tr>
<td>IRIX</td>
<td>SGI Irix</td>
</tr>
<tr>
<td>HPUX</td>
<td>HP-UX 11.0 and later</td>
</tr>
<tr>
<td>HPUX 10</td>
<td>HP-UX 10.2 and earlier</td>
</tr>
<tr>
<td>Mac OS</td>
<td>Mac OS 10 (Mac OS X)</td>
</tr>
</tbody>
</table>

**Tip**

The First operating system policy could offer some protection when you do not know the host operating system. However, it may result in missed attacks. You should edit the policy to specify the correct operating system if you know it.

**Timeout**

The number of seconds between 1 and 86400 the intrusion rules engine keeps an inactive stream in the state table. If the stream is not reassembled in the specified time, the intrusion rules engine deletes it from the state table.

**Note**

If your managed device is deployed on a segment where the network traffic is likely to reach the device’s bandwidth limits, you should consider setting this value higher (for example, to 600 seconds) to lower the amount of processing overhead.

FTD devices use this option only for connections that are inspected by Snort. For other connections, you need to configure a global TCP timeout in your platform settings policy.

**Maximum TCP Window**

Specifies the maximum TCP window size between 1 and 1073725440 bytes allowed as specified by a receiving host. Setting the value to 0 disables checking for the TCP window size.
The upper limit is the maximum window size permitted by RFC, and is intended to prevent an attacker from evading detection, but setting a significantly large maximum window size could result in a self-imposed denial of service.

When **Stateful Inspection Anomalies** is enabled, you can enable rule 129:6 to generate events and, in an inline deployment, drop offending packets for this option.

**Overlap Limit**

Specifies that when the configured number between 0 (unlimited) and 255 of overlapping segments in a session has been detected, segment reassembly stops for that session and, if **Stateful Inspection Anomalies** is enabled and the accompanying preprocessor rule is enabled, an event is generated.

You can enable rule 129:7 to generate events and, in an inline deployment, drop offending packets for this option.

**Flush Factor**

In an inline deployment, specifies that when a segment of decreased size has been detected subsequent to the configured number between 1 and 2048 of segments of non-decreasing size, the system flushes segment data accumulated for detection. Setting the value to 0 disables detection of this segment pattern, which can indicate the end of a request or response. Note that the Inline Normalization **Normalize TCP Payload** option must be enabled for this option to be effective.

**Stateful Inspection Anomalies**

Detects anomalous behavior in the TCP stack. When accompanying preprocessor rules are enabled, this may generate many events if TCP/IP stacks are poorly written.

You can enable the following rules to generate events and, in an inline deployment, drop offending packets for this option:

- 129:1 through 129:5
- 129:6 (Mac OS only)
- 129:8 through 129:11
- 129:13 through 129:19

Note the following:

- for rule 129:6 to trigger you must also configure a value greater than 0 for **Maximum TCP Window**.
- for rules 129:9 and 129:10 to trigger you must also enable **TCP Session Hijacking**.

**TCP Session Hijacking**

Detects TCP session hijacking by validating the hardware (MAC) addresses detected from both sides of a TCP connection during the 3-way handshake against subsequent packets received on the session. When the MAC address for one side or the other does not match, if **Stateful Inspection Anomalies** is enabled and one of the two corresponding preprocessor rules are enabled, the system generates events.
You can enable rules 129:9 and 129:10 to generate events and, in an inline deployment, drop offending packets for this option. Note that for either of these rules to generate events you must also enable Stateful Inspection Anomalies.

**Consecutive Small Segments**

When Stateful Inspection Anomalies is enabled, specifies a maximum number of 1 to 2048 consecutive small TCP segments allowed. Setting the value to 0 disables checking for consecutive small segments.

You must set this option together with the Small Segment Size option, either disabling both or setting a non-zero value for both. Note that receiving as many as 2000 consecutive segments, even if each segment was 1 byte in length, without an intervening ACK would be far more consecutive segments than you would normally expect.

You can enable rule 129:12 to generate events and, in an inline deployment, drop offending packets for this option.

**Small Segment Size**

When Stateful Inspection Anomalies is enabled, specifies the 1 to 2048 byte TCP segment size that is considered small. Setting the value to 0 disables specifying the size of a small segment.

You must set this option together with the Consecutive Small Segments option, either disabling both or setting a non-zero value for both. Note that a 2048 byte TCP segment is larger than a normal 1500 byte Ethernet frame.

**Ports Ignoring Small Segments**

When Stateful Inspection Anomalies, Consecutive Small Segments, and Small Segment Size are enabled, specifies a comma-separated list of one or more ports that ignore small TCP segment detection. Leaving this option blank specifies that no ports are ignored.

You can add any port to the list, but the list only affects ports specified in one of the Perform Stream Reassembly on port lists in the TCP policy.

**Require TCP 3-Way Handshake**

Specifies that sessions are treated as established only upon completion of a TCP three-way handshake. Disable this option to increase performance, protect from SYN flood attacks, and permit operation in a partially asynchronous environment. Enable it to avoid attacks that attempt to generate false positives by sending information that is not part of an established TCP session.

You can enable rule 129:20 to generate events and, in an inline deployment, drop offending packets for this option.

**3-Way Handshake Timeout**

Specifies the number of seconds between 0 (unlimited) and 86400 (twenty-four hours) by which a handshake must be completed when Require TCP 3-Way Handshake is enabled. You must enable Require TCP 3-Way Handshake to modify the value for this option.

**Packet Size Performance Boost**

Sets the preprocessor to not queue large packets in the reassembly buffer. This performance improvement could result in missed attacks. Disable this option to protect against evasion attempts using small packets of
one to twenty bytes. Enable it when you are assured of no such attacks because all traffic is comprised of very large packets.

**Legacy Reassembly**

Sets the stream preprocessor to emulate the deprecated Stream 4 preprocessor when reassembling packets, which lets you compare events reassembled by the stream preprocessor to events based on the same data stream reassembled by the Stream 4 preprocessor.

**Asynchronous Network**

Specifies whether the monitored network is an asynchronous network, that is, a network where the system sees only half the traffic. When this option is enabled, the system does not reassemble TCP streams to increase performance.

**Perform Stream Reassembly on Client Ports**

Enables stream reassembly based on ports for the client side of the connection. In other words, it reassembles streams destined for web servers, mail servers, or other IP addresses typically defined by the IP addresses specified in $HOME_NET. Use this option when you expect malicious traffic to originate from clients.

**Perform Stream Reassembly on Client Services**

Enables stream reassembly based on services for the client side of the connection. Use this option when you expect malicious traffic to originate from clients.

At least one client detector must be enabled for each client service you select. By default, all Cisco-provided detectors are activated. If no detector is enabled for an associated client application, the system automatically enables all Cisco-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application.

This feature requires Protection and Control licenses.

**Perform Stream Reassembly on Server Ports**

Enables stream reassembly based on ports for the server side of the connection only. In other words, it reassembles streams originating from web servers, mail servers, or other IP addresses typically defined by the IP addresses specified in $EXTERNAL_NET. Use this option when you want to watch for server side attacks. You can disable this option by not specifying ports.

---

**Note**

For a thorough inspection of a service, add the service name in the Perform Stream Reassembly on Server Services field in addition to adding the port number in the Perform Stream Reassembly on Server Ports field. For example, add 'HTTP' service in the Perform Stream Reassembly on Server Services field to inspect HTTP service in addition to adding port number 80 in the Perform Stream Reassembly on Server Ports field.

**Perform Stream Reassembly on Server Services**

Enables stream reassembly based on services for the server side of the connection only. Use this option when you want to watch for server side attacks. You can disable this option by not specifying services.

At least one detector must be enabled. By default, all Cisco-provided detectors are activated. If no detector is enabled for a service, the system automatically enables all Cisco-provided detectors for the associated
application protocol; if none exist, the system enables the most recently modified user-defined detector for the application protocol.

This feature requires Protection and Control licenses.

**Perform Stream Reassembly on Both Ports**

Enables stream reassembly based on ports for both the client and server side of the connection. Use this option when you expect that malicious traffic for the same ports may travel in either direction between clients and servers. You can disable this option by not specifying ports.

**Perform Stream Reassembly on Both Services**

Enables stream reassembly based on services for both the client and server side of the connection. Use this option when you expect that malicious traffic for the same services may travel in either direction between clients and servers. You can disable this option by not specifying services.

At least one detector must be enabled. By default, all Cisco-provided detectors are activated. If no detector is enabled for an associated client application or application protocol, the system automatically enables all Cisco-provided detectors for the application or application protocol; if none exist, the system enables the most recently modified user-defined detector for the application or application protocol.

This feature requires Protection and Control licenses.

**Troubleshooting Options: Maximum Queued Bytes**

Support might ask you during a troubleshooting call to specify the amount of data that can be queued on one side of a TCP connection. A value of 0 specifies an unlimited number of bytes.

⚠️ **Caution**

Changing the setting for this troubleshooting option will affect performance and should be done only with Support guidance.

**Troubleshooting Options: Maximum Queued Segments**

Support might ask you during a troubleshooting call to specify the maximum number of bytes of data segments that can be queued on one side of a TCP connection. A value of 0 specifies an unlimited number of data segment bytes.

⚠️ **Caution**

Changing the setting for this troubleshooting option will affect performance and should be done only with Support guidance.

**Related Topics**

- [Firepower System IP Address Conventions](#), on page 14
- [Activating and Deactivating Detectors](#), on page 1273
- [Layer Management](#), on page 854
- [Conflicts and Changes: Network Analysis and Intrusion Policies](#), on page 846
Configuring TCP Stream Preprocessing

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

Before you begin

- Confirm that networks you want to identify in a custom target-based policy match or are a subset of the networks, zones, and VLANs handled by its parent network analysis policy. See Advanced Settings for Network Analysis Policies, on page 1053 for more information.

Procedure

Step 1  Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note  If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2  Click the edit icon ( ) next to the policy you want to modify.

If a view icon ( ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3  Click Settings in the navigation panel on the left.

Step 4  If the TCP Stream Configuration setting is disabled under Transport/Network Layer Preprocessors, enable it by clicking Enabled.

Step 5  Click the edit icon ( ) next to TCP Stream Configuration.

Step 6  Check or clear the Packet Type Performance Boost check box in the Global Settings section.

Step 7  You can:

- Add a target-based policy — Click the add icon ( ) next to Hosts in the Targets section. Specify one or more IP addresses in the Host Address field. You can specify a single IP address or address block. You can create a total of 255 target-based policies including the default policy. When done, click OK.
- Edit an exist target-based policy — Under Hosts, click on the address for the policy you want to edit, or click default to edit the default configuration values.
- Modify the TCP Stream Preprocessing options — See TCP Stream Preprocessing Options, on page 1161.

Caution  Do not modify Maximum Queued Bytes or Maximum Queued Segments unless instructed to do so by Support.
Tip  To modify stream reassembly settings based on client, server, or both services, click inside the field you want to modify or click Edit next to the field. Use the arrow buttons to move services between the Available and Enabled lists in the pop-up window, then click OK.

- Delete an existing target-based policy — Click the delete icon ( ■ ) next to the policy you want to remove.

Step 8  To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.

If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

What to do next

- If you want to generate events and, in an inline deployment, drop offending packets, enable TCP Stream preprocessor rules (GID 129). For more information, see Setting Intrusion Rule States, on page 889 and TCP Stream Preprocessing Options, on page 1161.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics
  - Layer Management, on page 854
  - Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846
  - Firepower System IP Address Conventions, on page 14

UDP Stream Preprocessing

UDP stream preprocessing occurs when the rules engine processes packets against a UDP rule that includes the flow keyword using any of the following arguments:

- Established
- To Client
- From Client
- To Server
- From Server

UDP data streams are not typically thought of in terms of sessions. UDP is a connectionless protocol that does not provide a means for two endpoints to establish a communication channel, exchange data, and close the channel. However, the stream preprocessor uses the source and destination IP address fields in the encapsulating IP datagram header and the port fields in the UDP header to determine the direction of flow and identify a session. A session ends when a configurable timer is exceeded, or when either endpoint receives an ICMP message that the other endpoint is unreachable or the requested service is unavailable.

Note that the system does not generate events related to UDP stream preprocessing; however, you can enable related packet decoder rules to detect UDP protocol header anomalies.
UDP Stream Preprocessing Options

**Timeout**

Specifies the number of seconds the preprocessor keeps an inactive stream in the state table. If additional datagrams are not seen in the specified time, the preprocessor deletes the stream from the state table.

FTD devices use this option only for connections that are inspected by Snort. For other connections, you need to configure a global UDP timeout in your platform settings policy.

**Packet Type Performance Boost**

Sets to preprocess to ignore UDP traffic for all ports and application protocols that are not specified in enabled rules, except when a UDP rule with both the source and destination ports set to any has a flow or flowbits option. This performance improvement could result in missed attacks.

Configuring UDP Stream Preprocessing

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

**Note**   If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2**  Click the edit icon (-pencil) next to the policy you want to edit.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3**  Click Settings in the navigation panel.

**Step 4**  If UDP Stream Configuration under Transport/Network Layer Preprocessors is disabled, click Enabled.

**Step 5**  Click the edit icon (-pencil) next to UDP Stream Configuration.

**Step 6**  Set the options described in UDP Stream Preprocessing Options, on page 1170.

**Step 7**  To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.
If you leave the policy without committing changes, cached changes since the last commit are discarded if you edit a different policy.

What to do next

- If you want to generate events and, in an inline deployment, drop offending packets, enable related packet decoder rules (GID 116). For more information, see Setting Intrusion Rule States, on page 889 and The Packet Decoder, on page 1155.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics

Layer Management, on page 854
Conflicts and Changes: Network Analysis and Intrusion Policies, on page 846
Detecting Specific Threats

The following topics explain how to use preprocessors in a network analysis policy to detect specific threats:

- Introduction to Specific Threat Detection, on page 1173
- Back Orifice Detection, on page 1173
- Portscan Detection, on page 1175
- Rate-Based Attack Prevention, on page 1182

Introduction to Specific Threat Detection

You can use several preprocessors in a network analysis policy to detect specific threats to your monitored network, such as Back Orifice attacks, several portscan types, and rate-based attacks that attempt to overwhelm your network with excessive traffic. Note that when an intrusion rule or rule argument requires a disabled preprocessor, the system automatically uses it with its current configuration even though it remains disabled in the network analysis policy’s web interface.

You can also use sensitive data detection, which you configure in an intrusion policy, to detect unsecured transmission of sensitive numerical data.

Back Orifice Detection

The Firepower System provides a preprocessor that detects the existence of the Back Orifice program. This program can be used to gain admin access to your Windows hosts.

Back Orifice Detection Preprocessor

The Back Orifice preprocessor analyzes UDP traffic for the Back Orifice magic cookie, "!*QWTY?", which is located in the first eight bytes of the packet and is XOR-encrypted.

The Back Orifice preprocessor has a configuration page, but no configuration options. When it is enabled, you must also enable preprocessor rules for the preprocessor to generate events and, in an inline deployment, drop offending packets.
### Table 183: Back Orifice GID:SIDs

<table>
<thead>
<tr>
<th>Preprocessor rule GID:SID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>105:1</td>
<td>Back Orifice traffic detected</td>
</tr>
<tr>
<td>105:2</td>
<td>Back Orifice client traffic detected</td>
</tr>
<tr>
<td>105:3</td>
<td>Back Orifice server traffic detected</td>
</tr>
<tr>
<td>105:4</td>
<td>Back Orifice Snort buffer attack detected</td>
</tr>
</tbody>
</table>

### Detecting Back Orifice

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

#### Procedure

**Step 1** Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

*Note* If your custom user role limits access to the first path listed here, use the second path to access the policy.

**Step 2** Click the edit icon (📝) next to the policy you want to edit.

If a view icon (👁️) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Click Settings in the navigation panel.

**Step 4** If Back Orifice Detection under Specific Threat Detection is disabled, click Enabled.

*Note* There are no user-configurable options for Back Orifice.

**Step 5** To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

#### What to do next

- If you want to generate events and, in an inline deployment, drop offending packets, enable Back Orifice Detection rules 105:1, 105:2, 105:3, or 105:4. For more information, see Intrusion Rule States, on page 888 and Back Orifice Detection Preprocessor, on page 1173.
Portscan Detection

A portscan is a form of network reconnaissance that is often used by attackers as a prelude to an attack. In a portscan, an attacker sends specially crafted packets to a targeted host. By examining the packets that the host responds with, the attacker can often determine which ports are open on the host and, either directly or by inference, which application protocols are running on those ports.

By itself, a portscan is not evidence of an attack. In fact, some of the portscanning techniques used by attackers can also be employed by legitimate users on your network. Cisco’s portscan detector is designed to help you determine which portscans might be malicious by detecting patterns of activity.

Portscan Types, Protocols, and Filtered Sensitivity Levels

Attackers are likely to use several methods to probe your network. Often they use different protocols to draw out different responses from a target host, hoping that if one type of protocol is blocked, another may be available.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP</td>
<td>Detects TCP probes such as SYN scans, ACK scans, TCP connect() scans, and scans with unusual flag combinations such as Xmas tree, FIN, and NULL.</td>
</tr>
<tr>
<td>UDP</td>
<td>Detects UDP probes such as zero-byte UDP packets.</td>
</tr>
<tr>
<td>ICMP</td>
<td>Detects ICMP echo requests (pings).</td>
</tr>
<tr>
<td>IP</td>
<td>Detects IP protocol scans. These scans differ from TCP and UDP scans because the attacker, instead of looking for open ports, is trying to discover which IP protocols are supported on a target host.</td>
</tr>
</tbody>
</table>

Portscans are generally divided into four types based on the number of targeted hosts, the number of scanning hosts, and the number of ports that are scanned.
### Portscan Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Portscan Detection      | A one-to-one portscan in which an attacker uses one or a few hosts to scan multiple ports on a single target host. One-to-one portscans are characterized by:  
  • a low number of scanning hosts  
  • a single host that is scanned  
  • a high number of ports scanned  
  This option detects TCP, UDP, and IP portscans. |
| Port Sweep              | A one-to-many portsweep in which an attacker uses one or a few hosts to scan a single port on multiple target hosts. Portsweeps are characterized by:  
  • a low number of scanning hosts  
  • a high number of scanned hosts  
  • a low number of unique ports scanned  
  This option detects TCP, UDP, ICMP, and IP portsweeps. |
| Decoy Portscan          | A one-to-one portscan in which the attacker mixes spoofed source IP addresses with the actual scanning IP address. Decoy portscans are characterized by:  
  • a high number of scanning hosts  
  • a low number of ports that are scanned only once  
  • a single (or a low number of) scanned hosts  
  The decoy portscan option detects TCP, UDP, and IP protocol portscans. |
| Distributed Portscan    | A many-to-one portscan in which multiple hosts query a single host for open ports. Distributed portscans are characterized by:  
  • a high number of scanning hosts  
  • a high number of ports that are scanned only once  
  • a single (or a low number of) scanned hosts  
  The distributed portscan option detects TCP, UDP, and IP protocol portscans. |
The information that the portscan detector learns about a probe is largely based on seeing negative responses from the probed hosts. For example, when a web client tries to connect to a web server, the client uses port 80/tcp and the server can be counted on to have that port open. However, when an attacker probes a server, the attacker does not know in advance if it offers web services. When the portscan detector sees a negative response (that is, an ICMP unreachable or TCP RST packet), it records the response as a potential portscan. The process is more difficult when the targeted host is on the other side of a device such as a firewall or router that filters negative responses. In this case, the portscan detector can generate filtered portscan events based on the sensitivity level that you select.

### Table 186: Sensitivity Levels

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>Detects only negative responses from targeted hosts. Select this sensitivity level to suppress false positives, but keep in mind that some types of portscans (slow scans, filtered scans) might be missed. This level uses the shortest time window for portscan detection.</td>
</tr>
<tr>
<td>Medium</td>
<td>Detects portscans based on the number of connections to a host, which means that you can detect filtered portscans. However, very active hosts such as network address translators and proxies may generate false positives. Note that you can add the IP addresses of these active hosts to the Ignore Scanned field to mitigate this type of false positive. This level uses a longer time window for portscan detection.</td>
</tr>
<tr>
<td>High</td>
<td>Detects portscans based on a time window, which means that you can detect time-based portscans. However, if you use this option, you should be careful to tune the detector over time by specifying IP addresses in the Ignore Scanned and Ignore Scanner fields. This level uses a much longer time window for portscan detection.</td>
</tr>
</tbody>
</table>

### Portscan Event Generation

When portscan detection is enabled, you must enable rules with Generator ID (GID) 122 and a Snort ID (SID) from among SIDs 1 through 27 to detect the various portscans and portsweeps.

**Note**

For events generated by the portscan connection detector, the protocol number is set to 255. Because portscan does not have a specific protocol associated with it by default, the Internet Assigned Numbers Authority (IANA) does not have a protocol number assigned to it. IANA designates 255 as a reserved number, so that number is used in portscan events to indicate that there is not an associated protocol for the event.
<table>
<thead>
<tr>
<th>Portscan Type</th>
<th>Protocol:</th>
<th>Sensitivity Level</th>
<th>Preprocessor Rule SID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portscan Detection</td>
<td>TCP</td>
<td>Low</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>UDP</td>
<td>Medium or High</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>ICMP</td>
<td>Low</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>IP</td>
<td>Medium or High</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low</td>
<td>Does not generate events.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Medium or High</td>
<td>Does not generate events.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Medium or High</td>
<td>13</td>
</tr>
<tr>
<td>Port Sweep</td>
<td>TCP</td>
<td>Low</td>
<td>3, 27</td>
</tr>
<tr>
<td></td>
<td>UDP</td>
<td>Medium or High</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>ICMP</td>
<td>Low</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>IP</td>
<td>Medium or High</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Medium or High</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Medium or High</td>
<td>15</td>
</tr>
<tr>
<td>Decoy Portscan</td>
<td>TCP</td>
<td>Low</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>UDP</td>
<td>Medium or High</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>ICMP</td>
<td>Low</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>IP</td>
<td>Medium or High</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low</td>
<td>Does not generate events.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Medium or High</td>
<td>Does not generate events.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Medium or High</td>
<td>14</td>
</tr>
</tbody>
</table>
Portscan Event Packet View

When you enable the accompanying preprocessor rules, the portscan detector generates intrusion events that you can view just as you would any other intrusion event. However, the information presented on the packet view is different from the other types of intrusion events.

Begin by using the intrusion event views to drill down to the packet view for a portscan event. Note that you cannot download a portscan packet because single portscan events are based on multiple packets; however, the portscan packet view provides all usable packet information.

For any IP address, you can click the address to view the context menu and select whois to perform a lookup on the IP address or View Host Profile to view the host profile for that host.

### Table 188: Portscan Packet View

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>The device that detected the event.</td>
</tr>
<tr>
<td>Time</td>
<td>The time when the event occurred.</td>
</tr>
<tr>
<td>Message</td>
<td>The event message generated by the preprocessor.</td>
</tr>
<tr>
<td>Source IP</td>
<td>The IP address of the scanning host.</td>
</tr>
<tr>
<td>Destination IP</td>
<td>The IP address of the scanned host.</td>
</tr>
<tr>
<td>Priority Count</td>
<td>The number of negative responses (for example, TCP RSTs and ICMP unreachables) from the scanned host. The higher the number of negative responses, the higher the priority count.</td>
</tr>
<tr>
<td>Connection Count</td>
<td>The number of active connections on the hosts. This value is more accurate for connection-based scans such as TCP and IP.</td>
</tr>
</tbody>
</table>
### Configuring Portscan Detection

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Count</td>
<td>The number of times that the IP addresses that contact the scanned host changes. For example, if the first IP address is 10.1.1.1, the second IP is 10.1.1.2, and the third IP is 10.1.1.1, then the IP count is 3. This number is less accurate for active hosts such as proxies and DNS servers.</td>
</tr>
<tr>
<td>Scanner/Scanned IP Range</td>
<td>The range of IP addresses for the scanned hosts or the scanning hosts, depending on the type of scan. For portsweeps, this field shows the IP range of scanned hosts. For portscans, this shows the IP range of the scanning hosts.</td>
</tr>
<tr>
<td>Port/Proto Count</td>
<td>For TCP and UDP portscans, the number of times that the port being scanned changes. For example, if the first port scanned is 80, the second port scanned is 8080, and the third port scanned is again 80, then the port count is 3. For IP protocol portscans, the number of times that the protocol being used to connect to the scanned host changes.</td>
</tr>
<tr>
<td>Port/Proto Range</td>
<td>For TCP and UDP portscans, the range of the ports that were scanned. For IP protocol portscans, the range of IP protocol numbers that were used to attempt to connect to the scanned host.</td>
</tr>
<tr>
<td>Open Ports</td>
<td>The TCP ports that were open on the scanned host. This field appears only when the portscan detects one or more open ports.</td>
</tr>
</tbody>
</table>

**Related Topics**

About Intrusion Events, on page 1621

---

**Configuring Portscan Detection**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

The portscan detection configuration options allow you to finely tune how the portscan detector reports scan activity.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.
Procedure

Step 1  Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note  If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2  Click the edit icon ( ) next to the policy you want to edit.

If a view icon ( ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3  Click Settings.

Step 4  If Portscan Detection under Specific Threat Detection is disabled, click Enabled.

Step 5  Click the edit icon ( ) next to Portscan Detection.

Step 6  In the Protocol field, specify protocols to enable.

Note  You must ensure TCP stream processing is enabled to detect scans over TCP, and that UDP stream processing is enabled to detect scans over UDP.

Step 7  In the Scan Type field, specify portscan types you want to detect.

Step 8  Choose a level from the Sensitivity Level list; see Portscan Types, Protocols, and Filtered Sensitivity Levels, on page 1175.

Step 9  If you want to monitor specific hosts for signs of portscan activity, enter the host IP address in the Watch IP field.

You can specify a single IP address or address block, or a comma-separated lists of either or both. Leave the field blank to watch all network traffic.

Step 10  If you want to ignore hosts as scanners, enter the host IP address in the Ignore Scanners field.

You can specify a single IP address or address block, or a comma-separated lists of either or both.

Step 11  If you want to ignore hosts as targets of a scan, enter the host IP address in the Ignore Scanned field.

You can specify a single IP address or address block, or a comma-separated lists of either or both.

Tip  Use the Ignore Scanners and Ignore Scanned fields to indicate hosts on your network that are especially active. You may need to modify this list of hosts over time.

Step 12  If you want to discontinue monitoring of sessions picked up in mid-stream, clear the Detect Ack Scans check box.

Note  Detection of mid-stream sessions helps to identify ACK scans, but may cause false events, particularly on networks with heavy traffic and dropped packets.

Step 13  To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.
If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

---

**What to do next**

- If you want portscan detection to detect various portscans and portsweeps, enable rules 122:1 through 122:27. For more information, see [Intrusion Rule States](#) on page 888 and [Portscan Event Generation](#) on page 1177.
- Deploy configuration changes; see [Deploy Configuration Changes](#) on page 277.

**Related Topics**

- [Firepower System IP Address Conventions](#) on page 14

---

**Rate-Based Attack Prevention**

Rate-based attacks are attacks that depend on frequency of connection or repeated attempts to perpetrate the attack. You can use rate-based detection criteria to detect a rate-based attack as it occurs and respond to it when it happens, then return to normal detection settings after it stops.

You can configure your network analysis policy to include rate-based filters that detect excessive activity directed at hosts on your network. You can use this feature on managed devices deployed in inline mode to block rate-based attacks for a specified time, then revert to only generating events and not drop traffic.

The SYN attack prevention option helps you protect your network hosts against SYN floods. You can protect individual hosts or whole networks based on the number of packets seen over a period of time. If your device is deployed passively, you can generate events. If your device is placed inline, you can also drop the malicious packets. After the timeout period elapses, if the rate condition has stopped, the event generation and packet dropping stops.

For example, you could configure a setting to allow a maximum number of SYN packets from any one IP address, and block further connections from that IP address for 60 seconds.

You can also limit TCP/IP connections to or from hosts on your network to prevent denial of service (DoS) attacks or excessive activity by users. When the system detects the configured number of successful connections to or from a specified IP address or range of addresses, it generates events on additional connections. The rate-based event generation continues until the timeout period elapses without the rate condition occurring. In an inline deployment you can choose to drop packets until the rate condition times out.

For example, you could configure a setting to allow a maximum of 10 successful simultaneous connections from any one IP address, and block further connections from that IP address for 60 seconds.

---

**Note**

Devices load-balance inspection across internal resources. When you configure rate-based attack prevention, you configure the triggering rate per resource, not per device. If rate-based attack prevention is not working as expected, you may need to lower the triggering rate. For help determining the correct rate, contact Support.

---

The following diagram shows an example where an attacker is attempting to access a host. Repeated attempts to find a password trigger a rule which has rate-based attack prevention configured. The rate-based settings
change the rule attribute to Drop and Generate Events after rule matches occur five times in a 10-second span. The new rule attribute times out after 15 seconds.

After the timeout, note that packets are still dropped in the rate-based sampling period that follows. If the sampled rate is above the threshold in the current or previous sampling period, the new action continues. The new action reverts to generating events only after a sampling period completes where the sampled rate is below the threshold rate.

### Related Topics

- [Dynamic Intrusion Rule States](#), on page 897

**Rate-Based Attack Prevention Examples**

The `detection_filter` keyword and the thresholding and suppression features provide other ways to filter either the traffic itself or the events that the system generates. You can use rate-based attack prevention alone or in any combination with thresholding, suppression, or the `detection_filter` keyword.

The `detection_filter` keyword, thresholding or suppression, and rate-based criteria may all apply to the same traffic. When you enable suppression for a rule, events are suppressed for the specified IP addresses even if a rate-based change occurs.

**`detection_filter` Keyword Example**

The following example shows an attacker attempting a brute-force login. Repeated attempts to find a password trigger a rule that also includes the `detection_filter` keyword, with a count set to 5. This rule has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events for 20 seconds when there are five hits on the rule in a 10-second span.

As shown in the diagram, the first five packets matching the rule do not generate events because the rule does not trigger until the rate exceeds the rate indicated by the `detection_filter` keyword. After the rule triggers, event notification begins, but the rate-based criteria do not trigger the new action of Drop and Generate Events until five more packets pass.
After the rate-based criteria are met, events are generated and the packets are dropped until the rate-based timeout period expires and the rate falls below the threshold. After twenty seconds elapse, the rate-based action times out. After the timeout, note that packets are still dropped in the rate-based sampling period that follows. Because the sampled rate is above the threshold rate in the previous sampling period when the timeout happens, the rate-based action continues.

Note that although the example does not depict this, you can use the Drop and Generate Events rule state in combination with the detection_filter keyword to start dropping traffic when hits for the rule reach the specified rate. When deciding whether to configure rate-based settings for a rule, consider whether setting the rule to Drop and Generate Events and including the detection_filter keyword would achieve the same result, or whether you want to manage the rate and timeout settings in the intrusion policy.

**Related Topics**

- Intrusion Rule States, on page 888

**Dynamic Rule State Thresholding or Suppression Example**

The following example shows an attacker attempting a brute-force login. Repeated attempts to find a password trigger a rule that has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events for 15 seconds when there are five hits on the rule in 10 seconds. In addition, a limit threshold limits the number of events the rule can generate to 10 events in 23 seconds.

As shown in the diagram, the rule generates events for the first five matching packets. After five packets, the rate-based criteria trigger the new action of Drop and Generate Events, and for the next five packets the rule...
generates events and the system drops the packet. After the tenth packet, the limit threshold has been reached, so for the remaining packets the system does not generate events but does drop the packets.

After the timeout, note that packets are still dropped in the rate-based sampling period that follows. If the sampled rate is above the threshold rate in the current or previous sampling period, the new action continues. The new action reverts to Generate Events only after a sampling period completes where the sampled rate is below the threshold rate.

Note that although it is not shown in this example, if a new action triggers because of rate-based criteria after a threshold has been reached, the system generates a single event to indicate the change in action. So, for example, when the limit threshold of 10 is reached and the system stops generating events and the action changes from Generate Events to Drop and Generate Events on the 14th packet, the system generates an eleventh event to indicate the change in action.

**Policy-Wide Rate-Based Detection and Thresholding or Suppression Example**

The following example shows an attacker attempting denial of service (DoS) attacks on hosts in your network. Many simultaneous connections to hosts from the same sources trigger a policy-wide Control Simultaneous Connections setting. The setting generates events and drops malicious traffic when there are five connections from one source in 10 seconds. In addition, a global limit threshold limits the number of events any rule or setting can generate to 10 events in 20 seconds.

As shown in the diagram, the policy-wide setting generates events for the first ten matching packets and drops the traffic. After the tenth packet, the limit threshold is reached, so for the remaining packets no events are generated but the packets are dropped.

After the timeout, note that packets are still dropped in the rate-based sampling period that follows. If the sampled rate is above the threshold rate in the current or previous sampling period, the rate-based action of generating events and dropping traffic continues. The rate-based action stops only after a sampling period completes where the sampled rate is below the threshold rate.
Note that although it is not shown in this example, if a new action triggers because of rate-based criteria after a threshold has been reached, the system generates a single event to indicate the change in action. So, for example, if the limit threshold of 10 has been reached and the system stops generating events and the action changes to Drop and Generate events on the 14th packet, the system generates an eleventh event to indicate the change in action.

**Rate-Based Detection with Multiple Filtering Methods Example**

The following example shows an attacker attempting a brute force login, and describes a case where a `detection_filter` keyword, rate-based filtering, and thresholding interact. Repeated attempts to find a password trigger a rule which includes the `detection_filter` keyword, with a count set to 5. This rule also has rate-based attack prevention settings that change the rule attribute to Drop and Generate Events for 30 seconds when there are five rule hits in 15 seconds. In addition, a limit threshold limits the rule to 10 events in 30 seconds.

As shown in the diagram, the first five packets matching the rule do not cause event notification because the rule does not trigger until the rate indicated in the `detection_filter` keyword is exceeded. After the rule triggers, event notification begins, but the rate-based criteria do not trigger the new action of Drop and Generate Events until five more packets pass. After the rate-based criteria are met, the system generates events for packets 11-15 and drops the packets. After the fifteenth packet, the limit threshold has been reached, so for the remaining packets the system does not generate events but does drop the packets.

After the rate-based timeout, note that packets are still dropped in the rate-based sampling period that follows. Because the sampled rate is above the threshold rate in the previous sampling period, the new action continues.
Rate-Based Attack Prevention Options and Configuration

Rate-based attack prevention identifies abnormal traffic patterns and attempts to minimize the impact of that traffic on legitimate requests. Rate-based attacks usually have one of the following characteristics:

- Any traffic containing excessive incomplete connections to hosts on the network, indicating a SYN flood attack
- Any traffic containing excessive complete connections to hosts on the network, indicating a TCP/IP connection flood attack
- Excessive rule matches in traffic going to a particular destination IP address or addresses or coming from a particular source IP address or addresses
- Excessive matches for a particular rule across all traffic

In a network analysis policy, you can either configure SYN flood or TCP/IP connection flood detection for the entire policy; in an intrusion policy, you can set rate-based filters for individual intrusion or preprocessor rules. Note that you cannot manually add a rate-based filter to GID 135 rules or modify their rule state. Rules with GID 135 use the client as the source value and the server as the destination value.
Devices load-balance inspection across internal resources. When you configure rate-based attack prevention, you configure the triggering rate per resource, not per device. If rate-based attack prevention is not working as expected, you may need to lower the triggering rate. For help determining the correct rate, contact Support.

Enabling the **SYN Attack Prevention** option also activates rule 135:1. Manually activating this rule has no effect. The rule state is always displayed as Disabled, and never changes. The rule generates events when this option is enabled and a defined rate condition is exceeded.

Enabling the **Control Simultaneous Connections** option also activates rules 135:2 and 135:3. Manually activating these rule has no effect. The rule state is always displayed as Disabled, and never changes. Rule 135:2 rule generates events when a defined rate condition is exceeded. Rule 135:3 generates events when a session closes or times out.

Each rate-based filter contains several components:

- For policy-wide or rule-based source or destination settings, the network address designation
- The rule matching rate, which you configure as a count of rule matches within a specific number of seconds
- A new action to be taken when the rate is exceeded

  When you set a rate-based setting for the entire policy, the system generates events when it detects a rate-based attack, and can drop the traffic in an inline deployment. When setting rate-based actions for individual rules, you have three available actions: Generate Events, Drop and Generate Events, and Disable.

  - The duration of the action, which you configure as a timeout value

Note that when started, the new action occurs until the timeout is reached, even if the rate falls below the configured rate during that time period. When the timeout period expires, if the rate has fallen below the threshold, the action for the rule reverts to the action initially configured for the rule. For policy-wide settings, the action reverts to the action of each rule the traffic matches or stops if it does not match any rules.

You can configure rate-based attack prevention in an inline deployment to block attacks, either temporarily or permanently. Without rate-based configuration, rules set to Generate Events create events, but the system does not drop packets for those rules. However, if the attack traffic matches rules that have rate-based criteria configured, the rate action may cause packet dropping to occur for the period of time that the rate action is active, even if those rules are not initially set to Drop and Generate Events.

Rate-based actions cannot enable disabled rules or drop traffic that matches disabled rules. However, if you set a rate-based filter at the policy level, you can generate events on or generate events on and drop traffic that contains an excessive number of SYN packets or SYN/ACK interactions within a designated time period.

You can define multiple rate-based filters on the same rule. The first filter listed in the intrusion policy has the highest priority. Note that when two rate-based filter actions conflict, the system implements the action of the first rate-based filter. Similarly, policy-wide rate-based filters override rate-based filters set on individual rules if the filters conflict.

**Related Topics**

- Setting a Dynamic Rule State from the Rules Page, on page 898
Rate-Based Attack Prevention, Detection Filtering, and Thresholding or Suppression

The detection_filter keyword prevents a rule from triggering until a threshold number of rule matches occur within a specified time. When a rule includes the detection_filter keyword, the system tracks the number of incoming packets matching the pattern in the rule per timeout period. The system can count hits for that rule from particular source or destination IP addresses. After the rate exceeds the rate in the rule, event notification for that rule begins.

You can use thresholding and suppression to reduce excessive events by limiting the number of event notifications for a rule, a source, or destination, or by suppressing notifications altogether for that rule. You can also configure a global rule threshold that applies to each rule that does not have an overriding specific threshold.

If you apply suppression to a rule, the system suppresses event notifications for that rule for all applicable IP addresses even if a rate-based action change occurs because of a policy-wide or rule-specific rate-based setting.

Related Topics
- Intrusion Event Thresholds, on page 890
- Intrusion Policy Suppression Configuration, on page 894
- Global Rule Thresholding Basics, on page 921

Configuring Rate-Based Attack Prevention

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can configure rate-based attack prevention at the policy level to stop SYN flood attacks. You can also stop excessive connections from a specific source or to a specific destination.

Procedure

Step 1: Choose Policies > Access Control, then click Network Analysis Policy or Policies > Access Control > Intrusion, then click Network Analysis Policy.

Note: If your custom user role limits access to the first path listed here, use the second path to access the policy.

Step 2: Click the edit icon ( ) next to the policy you want to edit.

Step 3: Click Settings.

Step 4: If Rate-Based Attack Prevention under Specific Threat Detection is disabled, click Enabled.

Step 5: Click the edit icon ( ) next to Rate-Based Attack Prevention.

Step 6: You have two choices:
  • To prevent incomplete connections intended to flood a host, click Add under SYN Attack Prevention.
• To prevent excessive numbers of connections, click Add under Control Simultaneous Connections.

**Step 7** Specify how you want to track traffic:

• To track all traffic from a specific source or range of sources, choose Source from the Track By drop-down list, and enter a single IP address or address block in the Network field.
• To track all traffic to a specific destination or range of destinations, choose Destination from the Track By drop-down list, and enter an IP address or address block in the Network field.

**Note** The system tracks traffic separately for each IP address included in the Network field. Traffic from an IP address that exceeds the configured rate results in generated events only for that IP address. As an example, you might set a source CIDR block of 10.1.0.0/16 for the network setting and configure the system to generate events when there are ten simultaneous connections open. If eight connections are open from 10.1.4.21 and six from 10.1.5.10, the system does not generate events, because neither source has the triggering number of connections open. However, if eleven simultaneous connections are open from 10.1.4.21, the system generates events only for the connections from 10.1.4.21.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

**Step 8** Specify the triggering rate for the rate tracking setting:

• For SYN attack configuration, enter the number of SYN packets per number of seconds in the Rate fields.
• For simultaneous connection configuration, enter the number of connections in the Count field.

Devices load-balance inspection across internal resources. When you configure rate-based attack prevention, you configure the triggering rate per resource, not per device. If rate-based attack prevention is not working as expected, you may need to lower the triggering rate. For help determining the correct rate, contact Support.

**Step 9** To drop packets matching the rate-based attack prevention settings, check the Drop check box.

**Step 10** In the Timeout field, enter the time period after which to stop generating events (and if applicable, dropping) for traffic with the matching pattern of SYNs or simultaneous connections.

**Caution** Setting a high timeout value may entirely block connection to a host in an inline deployment.

**Step 11** Click OK.

**Step 12** To save changes you made in this policy since the last policy commit, click Policy Information, then click Commit Changes.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

---

**What to do next**

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Related Topics

Firepower System IP Address Conventions, on page 14
Adaptive Profiles

The following topics describe how to configure adaptive profiles:

- About Adaptive Profiles, on page 1193
- Adaptive Profiles and Firepower Recommended Rules, on page 1193
- Adaptive Profile Options, on page 1194
- Configuring Adaptive Profiles, on page 1195

About Adaptive Profiles

Typically, the system uses the static settings in your network analysis policy to preprocess and analyze traffic. With adaptive profiles, the system can adapt processing behavior using host information either detected by network discovery or imported from a third party.

Adaptive profiles, like the target-based profiles you can configure manually in a network analysis policy, help to defragment IP packets and reassemble streams in the same way as the operating system on the target host. The intrusion rules engine then analyzes the data in the same format as that used by the destination host.

Manually configured target-based profiles apply either the default operating system profile you select, or profiles you bind to specific hosts. Adaptive profiles, however, switch to the appropriate operating system profile based on the operating system in the host profile for the target host.

Consider a scenario where you configure adaptive profiles for the 10.6.0.0/16 subnet and set the default IP Defragmentation target-based policy to Linux. The Firepower Management Center where you configure the settings has a network map that includes the 10.6.0.0/16 subnet.

- When the system detects traffic from Host A, which is not in the 10.6.0.0/16 subnet, it uses the Linux target-based policy to reassemble IP fragments.
- When the system detects traffic from Host B, which is in the 10.6.0.0/16 subnet, it retrieves Host B’s operating system data from the network map. The system uses a profile based on that operating system to defragment the traffic destined for Host B.

Adaptive Profiles and Firepower Recommended Rules

The adaptive profiles feature is an advanced setting in an access control policy that applies globally to all intrusion policies invoked by that access control policy. The Firepower recommended rules feature applies to the individual intrusion policy where you configure it.
Like Firepower recommended rules, adaptive profiles compare metadata in a rule to host information to determine whether a rule should apply for a particular host. However, while Firepower recommended rules provide recommendations for enabling or disabling rules using that information, adaptive profiles use the information to apply specific rules to specific traffic.

Firepower recommended rules require your interaction to implement suggested changes to rule states. Adaptive profiles, on the other hand, do not modify intrusion policies. Adaptive treatment of rules happens on a packet-by-packet basis.

Additionally, Firepower recommended rules can result in enabling disabled rules. Adaptive profiles, in contrast, only affect the application of rules that are already enabled in intrusion policies. Adaptive profiles never change the rule state.

You can use adaptive profiles and Firepower recommended rules in combination. Adaptive profiles use the rule state for a rule when your intrusion policy is deployed to determine whether to include it as a candidate for applying, and your choices to accept or decline recommendations are reflected in that rule state. You can use both features to ensure that you have enabled or disabled the most appropriate rules for each network you monitor, and then to apply enabled rules most efficiently for specific traffic.

### Related Topics
- [About Firepower Recommended Rules](#), on page 901

---

## Adaptive Profile Options

### Adaptive Profiles - Enabled

Enable or disable adaptive profiles

### Adaptive Profiles - Attribute Update Interval

You can control how frequently in minutes network map data is synced from the Firepower Management Center to its managed devices. The system uses the data to determine what profiles should be used when processing traffic. Increasing the value for this option can improve performance in a large network.

### Adaptive Profiles - Networks

Optionally, you can improve performance by constraining adaptive profiles to a comma-separated list of IP addresses, address blocks, and network variables. If you use a network variable, the system uses the variable's value in the variable set linked to the default intrusion policy for your access control policy. For example, you could enter: `192.168.1.101, 192.168.4.0/24, $HOME_NET`.

---

**Note**
The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. If you enable and enforce adaptive profiles in an ancestor policy, Cisco recommends you keep the default network constraint of `0.0.0.0/0`, or use a network variable with a value of `any`. This setting applies adaptive profiles to all monitored hosts in all subdomains.

### Related Topics
- [The Default Intrusion Policy](#), on page 1051
- [Firepower System IP Address Conventions](#), on page 14
In a passive deployment, Cisco recommends that you configure adaptive profiles. In an inline deployment, configure the inline normalization preprocessor with the Normalize TCP Payload option enabled.

**Caution**

Adaptive profiling must be enabled as described in this procedure for access control rules to perform application or file control, including AMP, and for intrusion rules to use service metadata. Enabling or disabling adaptive profiles restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

**Procedure**

**Step 1**

In the access control policy editor, click the Advanced tab, then click the edit icon (📝) next to the Detection Enhancement Settings section.

If a view icon (👀) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck Inherit from base policy to enable editing.

**Step 2**

Set adaptive profile options as described in Adaptive Profile Options, on page 1194.

**Step 3**

Click OK.

**Step 4**

Click Save to save the policy.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Related Topics**

- The Inline Normalization Preprocessor, on page 1144
- Snort® Restart Scenarios, on page 279
PART XV

Discovery and Identity

- Introduction to Network Discovery and Identity, on page 1199
- Host Identity Sources, on page 1213
- Application Detection, on page 1257
- User Identity Sources, on page 1277
- Network Discovery Policies, on page 1299
- Realms and Identity Policies, on page 1323
CHAPTER 64

Introduction to Network Discovery and Identity

The following topics provide an introduction to network discovery and identity policies and data:

- Uses for Host, Application, and User Discovery and Identity Data, on page 1199
- Host and Application Detection Fundamentals, on page 1200
- About User Identity, on page 1206
- Firepower System Host and User Limits, on page 1209

Uses for Host, Application, and User Discovery and Identity Data

Logging discovery and identity data allows you to take advantage of many features in the Firepower System, including:

- Viewing the network map, which is a detailed representation of your network assets and topology that you can view by grouping hosts and network devices, host attributes, application protocols, or vulnerabilities.
- Performing application and user control; that is, writing access control rules using application, realm, user, user group, and ISE attribute conditions.
- Viewing host profiles, which are complete views of all the information available for your detected hosts.
- Viewing dashboards, which (among other capabilities) can provide you with an at-a-glance view of your network assets and user activity.
- Viewing detailed information on the discovery events and user activity logged by the system.
- Associating hosts and any servers or clients they are running with the exploits to which they are susceptible. This enables you to identify and mitigate vulnerabilities, evaluate the impact that intrusion events have on your network, and tune intrusion rule states so that they provide maximum protection for your network assets.
- Alerting you by email, SNMP trap, or syslog when the system generates either an intrusion event with a specific impact flag, or a specific type of discovery event.
- Monitoring your organization’s compliance with a white list of allowed operating systems, clients, application protocols, and protocols.
• Creating correlation policies with rules that trigger and generate correlation events when the system generates discovery events or detects user activity
• Logging and using NetFlow connections, if applicable.

Host and Application Detection Fundamentals

You can configure your network discovery policy to perform host and application detection.

For more information, see Overview: Host Data Collection, on page 1213 and Overview: Application Detection, on page 1257.

Passive Detection of Operating System and Host Data

Passive detection is the system's default method of populating the network map by analyzing network traffic (and any exported NetFlow data). Passive detection provides contextual information about your network assets, such as operating systems and running applications.

If traffic from a monitored host does not offer conclusive evidence of the host's operating system, the network map displays the most likely operating system. For example, a NAT device may appear to be running several operating systems because of the hosts "behind" the NAT device. To make this most-likely determination, the system uses a confidence value it assigns to each detected operating system, and the amount of corroborating data among detected operating systems.

Note

The system does not consider reported "unknown" applications and operating systems in its determination.

If passive detection inaccurately identifies your network assets, consider the placement of your managed devices. You can also augment the system's passive detection capabilities with custom operating-system fingerprints and custom application detectors. Or, you can use active detection, which is not based on traffic analysis, but instead allows you to directly update the network map using scan results or other information sources.

Active Detection of Operating System and Host Data

Active detection adds host information collected by active sources to network maps. For example, you can use the Nmap scanner to actively scan the hosts that you target on your network. Nmap discovers operating systems and applications on hosts.

In addition, the host input feature allows you to actively add host input data to network maps. There are two different categories of host input data:

• user input data—Data added through the Firepower System user interface. You can modify a host’s operating system or application identity through this interface.

• host import input data—Data imported using a command line utility.

The system retains one identity for each active source. When you run an Nmap scan instance, for example, the results of the previous scan are replaced with the new scan results. However, if you run an Nmap scan and then replace those results with data from a client whose results are imported through the command line,
the system retains both the identities from the Nmap results and the identities from the import client. The system then uses the priorities set in the network discovery policy to determine which active identity to use as the current identity.

Note that user input is considered one source, even if it comes from different users. As an example, if UserA sets the operating system through the host profile, and then UserB changes that definition through the host profile, the definition set by UserB is retained, and the definition set by UserA is discarded. In addition, note that user input overrides all other active sources and is used as the current identity if it exists.

Current Identities for Applications and Operating Systems

The current identity for an application or an operating system on a host is the identity that the system finds most likely to be correct.

The system uses the current identity for an operating system or application for the following purposes:

• to assign vulnerabilities to a host
• for impact assessment
• when evaluating correlation rules written against operating system identifications, host profile qualifications, and compliance white lists
• for display in the Hosts and Servers table views in workflows
• for display in the host profile
• to calculate the operating system and application statistics on the Discovery Statistics page

The system uses source priorities to determine which active identity should be used as the current identity for an application or operating system.

For example, if a user sets the operating system to Windows 2003 Server on a host, Windows 2003 Server is the current identity. Attacks which target Windows 2003 Server vulnerabilities on that host are given a higher impact, and the vulnerabilities listed for that host in the host profile include Windows 2003 Server vulnerabilities.

The database may retain information from several sources for the operating system or for a particular application on a host.
The system treats an operating system or application identity as the current identity when the source for the data has the highest source priority. Possible sources have the following priority order:

1. user
2. scanner and application (set in the network discovery policy)
3. managed devices
4. NetFlow records

A new higher priority application identity will not override a current application identity if it has less detail than the current identity.

In addition, when an identity conflict occurs, the resolution of the conflict depends on settings in the network discovery policy or on your manual resolution.

**Current User Identities**

When the system detects multiple logins to the same host by different users, the system assumes that only one user is logged into any given host at a time, and that the current user of a host is the last authoritative user login. If only non-authoritative user logins have been logged into the host, the last non-authoritative user login is considered the current user. If multiple users are logged in through remote sessions, the last user reported by the server is the user reported to the Firepower Management Center.

When the system detects multiple logins to the same host by the same user, the system records the first time that a user logs into a specific host and disregards subsequent logins. If an individual user is the only person who logs into a specific host, the only login that the system records is the original login.

If another user logs into that host, however, the system records the new login. Then, if the original user logs in again, his or her new login is recorded.

**Application and Operating System Identity Conflicts**

An identity conflict occurs when the system reports a new passive identity that conflicts with the current active identity and previously reported passive identities. For example, the previous passive identity for an operating system is reported as Windows 2000, then an active identity of Windows XP becomes current. Next, the system detects a new passive identity of Ubuntu Linux 8.04.1. The Windows XP and the Ubuntu Linux identities are in conflict.

When an identity conflict exists for the identity of the host’s operating system or one of the applications on the host, the system lists both conflicting identities as current and uses both for impact assessment until the conflict is resolved.

A user with Administrator privileges can resolve identity conflicts automatically by choosing to always use the passive identity or always use the active identity. Unless you disable automatic resolution of identity conflicts, identity conflicts are always automatically resolved.
A user with Administrator privileges can also configure the system to generate an event when an identity conflict occurs. That user can then set up a correlation policy with a correlation rule that uses an Nmap scan as a correlation response. When an event occurs, Nmap scans the host to obtain updated host operating system and application data.

**Netflow Data in the Firepower System**

NetFlow is a Cisco IOS application that provides statistics on packets flowing through a router. It is available on Cisco networking devices and can also be embedded in Juniper, FreeBSD, and OpenBSD devices.

When NetFlow is enabled on a network device, a database on the device (the NetFlow cache) stores records of the flows that pass through the router. A flow, called a connection in the Firepower System, is a sequence of packets that represents a session between a source and destination host, using specific ports, protocol, and application protocol. The network device can be configured to export this NetFlow data. In this documentation, network devices configured in this way are called NetFlow exporters.

Firepower System managed devices can be configured to collect records from NetFlow exporters, generate unidirectional end-of-connection events based on the data in those records, and finally send those events to the Firepower Management Center to be logged in the connection event database. You can also configure the network discovery policy to add host and application protocol information to the database based on the information in NetFlow connections.

You can use this discovery and connection data to supplement the data gathered directly by your managed devices. This is especially useful if you have NetFlow exporters monitoring networks that your managed devices cannot monitor.

**Requirements for Using NetFlow Data**

Before you configure the Firepower System to analyze NetFlow data, you must enable the NetFlow feature on the routers or other NetFlow-enabled network devices you plan to use, and configure the devices to broadcast NetFlow data to a destination network where the sensing interface of a managed device is connected.

The Firepower System can parse both NetFlow version 5 and NetFlow version 9 records. NetFlow exporters must use one of those versions if you want to export the data to the Firepower System. In addition, the system requires that specific fields be present in the exported NetFlow templates and records. If your NetFlow exporters
are using version 9, which you can customize, you must make sure that the exported templates and records contain the following fields, in any order:

- IN_BYTES (1)
- IN_PKTS (2)
- PROTOCOL (4)
- TCP_FLAGS (6)
- L4_SRC_PORT (7)
- IPV4_SRC_ADDR (8)
- L4_DST_PORT (11)
- IPV4_DST_ADDR (12)
- LAST_SWITCHED (21)
- FIRST_SWITCHED (22)
- IPV6_SRC_ADDR (27)
- IPV6_DST_ADDR (28)

Because the Firepower System uses managed devices to analyze NetFlow data, your deployment must include at least one managed device that can monitor NetFlow exporters. At least one sensing interface on that managed device must be connected to a network where it can collect the exported NetFlow data. Because the sensing interfaces on managed devices do not usually have IP addresses, the system does not support the direct collection of NetFlow records.

Note that the Sampled NetFlow feature available on some network devices collects NetFlow statistics on only a subset of packets that pass through the devices. Although enabling this feature can improve CPU utilization on the network device, it may affect the NetFlow data you are collecting for analysis by the Firepower System.

**Differences between NetFlow and Managed Device Data**

Firepower does not directly analyze the traffic represented by NetFlow data. Instead, it converts exported NetFlow records into connection logs and host and application protocol data.

As a result, there are several differences between converted NetFlow data and the discovery and connection data gathered directly by your managed devices. You should keep these differences in mind when performing analysis that requires:

- Statistics on the number of detected connections
- Operating system and other host-related information (including vulnerabilities)
- Application data, including client information, web application information, and vendor and version server information
- Knowing which host in a connection is the initiator and which is the responder
**Network Discovery Policy versus Access Control Policy**

You configure NetFlow data collection, including connection logging, using rules in the network discovery policy. Contrast this with connection logging for connections detected by Firepower System managed devices, which you configure per access control rule.

**Types of Connection Events**

Because NetFlow data collection is linked to networks rather than access control rules, you do not have granular control over which NetFlow connections the system logs.

NetFlow data cannot generate Security Intelligence events.

NetFlow-based connection events can be stored in the connection event database only; you cannot send them to the system log or an SNMP trap server.

**Number of Connection Events Generated Per Monitored Session**

For connections detected directly by managed devices, you can configure the access control rule to log a bidirectional connection event at the beginning or end of a connection, or both.

In contrast, because exported NetFlow records contain unidirectional connection data, the system generates at least two connection events for each NetFlow record it processes. This also means that a summary’s connection count is incremented by two for every connection based on NetFlow data, providing an inflated count of the number of connections that are actually occurring on your network.

Because the NetFlow exporter outputs records at a fixed interval even if a connection is still ongoing, long-running sessions can result in multiple exported records, each of which generates a connection event. For example, if the NetFlow exporter exports every five minutes, and a particular connection lasts twelve minutes, the system generates six connection events for that session:

- One pair of events for the first five minutes
- One pair for the second five minutes
- A final pair when the connection is terminated

**Host and Operating System Data**

Hosts added to the network map from NetFlow data do not have operating system, NetBIOS, or host type (host vs network device) information. You can, however, manually set a host’s operating system identity using the host input feature.

**Application Data**

For connections detected directly by managed devices, the system can identify application protocols, clients, and web applications by examining the packets in the connection.

When the system processes NetFlow records, the system uses a port correlation in `/etc/sf/services` to extrapolate application protocol identity. However, there is no vendor or version information for those application protocols, nor do connection logs contain information on client or web applications used in the session. You can, however, manually provide this information using the host input feature.

Note that a simple port correlation means that application protocols running on non-standard ports may be unidentified or misidentified. Additionally, if no correlation exists, the system marks the application protocol as `unknown` in connection logs.
Vulnerability Mappings

The system cannot map vulnerabilities to hosts monitored by NetFlow exporters, unless you use the host input feature to manually set either a host’s operating system identity or an application protocol identity. Note that because there is no client information in NetFlow connections, you cannot associate client vulnerabilities with hosts created from NetFlow data.

Initiator and Responder Information in Connections

For connections detected directly by managed devices, the system can identify which host is the initiator, or source, and which is the responder, or destination. However, NetFlow data does not contain initiator or responder information.

When the Firepower System processes NetFlow records, it uses an algorithm to determine this information based on the ports each host is using, and whether those ports are well-known:

- If both or neither port being used is a well-known port, the system considers the host using the lower-number port to be the responder.
- If only one of the hosts is using a well-known port, the system considers that host to be the responder.

For this purpose, a well-known port is any port that is either numbered from 1 to 1023, or that contains application protocol information in /etc/sf/services on the managed device.

In addition, for connections detected directly by managed devices, the system records two byte counts in the corresponding connection event:

- The **Initiator Bytes** field records bytes sent.
- The **Responder Bytes** field records bytes received.

Connection events based on unidirectional NetFlow records contain only one byte count, which the system assigns to either **Initiator Bytes** or **Responder Bytes**, depending on the port-based algorithm. The system sets the other field to 0. Note that if you are viewing connection summaries (aggregated connection data) of NetFlow records, both fields may be populated.

NetFlow-only Connection Event Fields

A small number of fields are present only in connection events generated from NetFlow records; see Information Available in Connection Event Fields, on page 1612.

Related Topics

- Information Available in Connection Event Fields, on page 1612

About User Identity

User identity information can help you to identify the source of policy breaches, attacks, or network vulnerabilities, and trace them to specific users. For example, you could determine:

- Who owns the host targeted by an intrusion event that has a Vulnerable (level 1: red) impact level.
- Who initiated an internal attack or portscan.
- Who is attempting unauthorized access to a specified host.
- Who is consuming an unreasonable amount of bandwidth.
• Who has not applied critical operating system updates.
• Who is using instant messaging software or peer-to-peer file-sharing applications in violation of company policy.

Armed with this information, you can use other features of the Firepower System to mitigate risk, perform access control, and take action to protect others from disruption. These capabilities also significantly improve audit controls and enhance regulatory compliance.

After you configure user identity sources to gather user data, you can perform user awareness and user control.

**Related Topics**
- Identity Terminology, on page 1207
- Identity Deployments, on page 1208

## Identity Terminology

This topic discusses common terminology for user identity and user control.

### User awareness

Identifying users on your network using *identity sources* (such as User Agent or TS Agent). User awareness enables you to identify users from both *authoritative* (such as Active Directory) and *non-authoritative* (application-based) sources. To use Active Directory as an identity source, you must configure a realm and directory. For more information, see About User Identity Sources, on page 1277.

### User control

Configuring an *identity policy* that you associate with an *access control policy*. (The identity policy is then referred to as an access control *subpolicy.*) The identity policy specifies the identity source and, optionally, users and groups belonging to that source.

By associating the identity policy with an access control policy, you determine whether to monitor, trust, block, or allow users or user activity in traffic on your network. For more information, see Getting Started with Access Control Policies, on page 621.

### Authoritative identity sources

A trusted server validated the user login (for example, Active Directory). You can use the data obtained from authoritative logins to perform user awareness and user control. Authoritative user logins are obtained from passive and active authentications:

- *Passive authentications* occur when a user authenticates through an external server. The User Agent and ISE are the passive authentication methods supported by the Firepower System.

- *Active authentications* occur when a user authenticates through preconfigured managed devices. Captive portal is the only active authentication method supported by the Firepower System.

### Non-authoritative identity sources

An unknown or untrusted server validated the user login. Traffic-based detection is the only non-authoritative identity source supported by the Firepower System. You can use the data obtained from non-authoritative logins to perform user awareness.
Identity Deployments

When the system detects user data from a user login, from any identity source, the user from the login is checked against the list of users in the Firepower Management Center user database. If the login user matches an existing user, the data from the login is assigned to the user. Logins that do not match existing users cause a new user to be created, unless the login is in SMTP traffic. Non-matching logins in SMTP traffic are discarded.

The group to which the user belongs is associated with the user when the user passes traffic on the network.

The following diagram illustrates how the Firepower System collects and stores user data:

![Diagram of user activity database](image)

The User Activity Database

The user activity database on the Firepower Management Center contains records of user activity on your network detected or reported by all of your configured identity sources. The system logs events in the following circumstances:

- When it detects individual logins or logoffs.
- When it detects a new user.
- When a system administrator manually delete a user.
- When the system detects a user that is not in the database, but cannot add the user because you have reached your user limit.

You can view user activity detected by the system using the Firepower Management Center web interface. (Analysis > Users > User Activity).

The Users Database

The users database on the Firepower Management Center contains a record for each user detected or reported by all of your configured identity sources. You can use data obtained from an authoritative source for user control.
See About User Identity Sources, on page 1277 for more information about the supported non-authoritative and authoritative identity sources.

The total number of users the Firepower Management Center can store depends on the Firepower Management Center model, as described in Firepower System User Limit, on page 1210. After the user limit is reached, the system prioritizes previously-undetected user data based on its identity source, as follows:

- If the new user is from a non-authoritative identity source, the system does not add the user to the database. To allow new users to be added, you must delete users manually or with a database purge.
- If the new user is from an authoritative identity source, the system deletes the non-authoritative user who has remained inactive for the longest period and adds the new user to the database.

If an identity source is configured to exclude specific user names, user activity data for those user names are not reported to the Firepower Management Center. These excluded user names remain in the database, but are not associated with IP addresses. For more information about the type of data stored by the system, see User Data, on page 1772.

When the system detects a new user session, the user session data remains in the users database until one of the following occurs:

- A user on the Firepower Management Center manually deletes the user session.
- An identity source reports the logout of that user session.
- A realm ends the user session as specified by the realm’s User Session Timeout: Authenticated Users, User Session Timeout: Failed Authentication Users, or User Session Timeout: Guest Users setting.

Firepower System Host and User Limits

Your Firepower Management Center model determines how many individual hosts you can monitor with your deployment, as well as how many users you can monitor and use to perform user control.

Related Topics
Purging Data from the FMC Database, on page 171

Firepower System Host Limit

The system adds a host to the network map when it detects activity associated with an IP address in your monitored network (as defined in your network discovery policy). The number of hosts a Firepower Management Center can monitor, and therefore store in the network map, depends on its model.

Table 189: Host Limits by Firepower Management Center Model

<table>
<thead>
<tr>
<th>FMC Model</th>
<th>Hosts</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC750</td>
<td>2,000</td>
</tr>
<tr>
<td>MC1000</td>
<td>50,000</td>
</tr>
<tr>
<td>MC1500</td>
<td>50,000</td>
</tr>
<tr>
<td>FS2000</td>
<td>150,000</td>
</tr>
</tbody>
</table>
### FMC Model and Hosts

<table>
<thead>
<tr>
<th>FMC Model</th>
<th>Hosts</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC2500</td>
<td>150,000</td>
</tr>
<tr>
<td>MC3500</td>
<td>300,000</td>
</tr>
<tr>
<td>MC4000</td>
<td>600,000</td>
</tr>
<tr>
<td>MC4500</td>
<td>600,000</td>
</tr>
<tr>
<td>virtual</td>
<td>50,000</td>
</tr>
</tbody>
</table>

You cannot view contextual data for hosts not in the network map. However, you can perform access control. For example, you can perform application control on traffic to and from a host not in the network map, even though you cannot use a compliance white list to monitor the host's network compliance.

### Note

The system counts MAC-only hosts separately from hosts identified by both IP addresses and MAC addresses. All IP addresses associated with a host are counted together as one host.

### Reaching the Host Limit and Deleting Hosts

The network discovery policy controls what happens when you detect a new host after you reach the host limit; you can drop the new host, or replace the host that has been inactive for the longest time. You can also set the period after which the system removes a host from the network map due to inactivity. Although you can manually delete a host, an entire subnet, or all of your hosts from the network map, if the system detects activity associated with a deleted host, it re-adds the host.

In a multidomain deployment, each leaf domain has its own network discovery policy. Therefore, each leaf domain governs its own behavior when the system discovers a new host.

### Related Topics

- Domain Properties, on page 269
- Network Discovery Data Storage Settings, on page 1318

### Firepower System User Limit

Your Firepower Management Center model determines how many individual users you can monitor. When the system detects activity from a new user, that user is added to the Users database on the Firepower Management Center. You can detect users using any identity source.

There are two types of user limits to consider:

- The **concurrent user limit** is the number of users logged in to the system at the same time. These users are all **authoritative users**, which means they were reported to the Firepower Management Center by an authoritative user source: User Agent, ISE, the TS Agent, and captive portal.

  Only authoritative users are available for user control with access control policies.

- The **total user limit**, which is the number of authoritative and non-authoritative users you can store in the database. Non-authoritative user data is gathered using traffic-based detection.
Table 190: User Limits by Firepower Management Center Model

<table>
<thead>
<tr>
<th>FMC Model</th>
<th>Concurrent Users</th>
<th>Total Users</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC750</td>
<td>2,000</td>
<td>2,000</td>
</tr>
<tr>
<td>MC1000</td>
<td>50,000</td>
<td>50,000</td>
</tr>
<tr>
<td>MC1500</td>
<td>50,000</td>
<td>50,000</td>
</tr>
<tr>
<td>FS2000</td>
<td>64,000</td>
<td>150,000</td>
</tr>
<tr>
<td>MC2500</td>
<td>64,000</td>
<td>150,000</td>
</tr>
<tr>
<td>MC3500</td>
<td>64,000</td>
<td>300,000</td>
</tr>
<tr>
<td>MC4000</td>
<td>64,000</td>
<td>600,000</td>
</tr>
<tr>
<td>MC4500</td>
<td>64,000</td>
<td>600,000</td>
</tr>
<tr>
<td>virtual</td>
<td>50,000</td>
<td>50,000</td>
</tr>
</tbody>
</table>

When the system detects a new, previously-undetected user after the limit has been reached, it prioritizes user data based on their identity source:

- If the new user is from a non-authoritative source, the system does not add the non-authoritative user to the database. To allow new users to be added, you must delete users manually or purge the database.

- If the new user is from an authoritative identity source, the system deletes the non-authoritative user who has remained inactive for the longest period of and adds the new authoritative user to the database.

**Note**
If your deployment includes an ASA FirePOWER module managed via ASDM, you can store a maximum of 2,000 authoritative users, regardless of your Firepower Management Center model.

**Tip**
Note that if you are using traffic-based detection, you can restrict user logging by protocol to help minimize username clutter and preserve space in the database. For example, you could prevent the system from adding users discovered in AIM, POP3, and IMAP traffic because you know it is traffic from specific contractors or visitors you do not want to monitor.
Host Identity Sources

The following topics provide information on host identity sources:

- Overview: Host Data Collection, on page 1213
- Determining Which Host Operating Systems the System Can Detect, on page 1214
- Identifying Host Operating Systems, on page 1214
- Custom Fingerprinting, on page 1214
- Host Input Data, on page 1223
- Nmap Scanning, on page 1233

Overview: Host Data Collection

As the Firepower System passively monitors the traffic that travels through your network, it compares specific packet header values and other unique data from network traffic against established definitions (called fingerprints) to determine information about the hosts on your network, including:

- the number and types of hosts (including network devices such as bridges, routers, load balancers, and NAT devices)
- basic network topology data, including the number of hops from the discovery point on the network to the hosts
- the operating systems running on the hosts
- applications on the hosts and users associated with these applications

If the system cannot identify a host's operating system, you can create custom client or server fingerprints. The system uses these fingerprints to identify new hosts. You can map fingerprints to systems in the vulnerability database (VDB) to allow the appropriate vulnerability information to be displayed whenever a host is identified using the custom fingerprint.

Note: In addition to collecting host data from monitored network traffic, the system can collect host data from exported NetFlow records, and you can actively add host data using Nmap scans and the host input feature.
Determining Which Host Operating Systems the System Can Detect

To learn which exact operating systems the system can fingerprint, view the list of available fingerprints that is shown during the process of creating a custom OS fingerprint.

Procedure

Step 1 Choose Policies > Network Discovery.
Step 2 Click Custom Operating Systems.
Step 3 Click Create Custom Fingerprint.
Step 4 View the lists of options in the drop-down lists in the OS Vulnerability Mappings section. These options are the operating systems that the system can fingerprint.

What to do next

As needed, see Identifying Host Operating Systems, on page 1214.

Identifying Host Operating Systems

If the system does not correctly identify a host’s operating system (for example, it shows in the Host Profile as Unknown or is incorrectly identified), try the strategies below.

Procedure

Try one of the following strategies:

• Check the Network Discovery Identity Conflict Settings.
• Create a custom fingerprint for the host.
• Run an Nmap scan against the host.
• Import data into the network map, using the host input feature.
• Manually enter operating system information.

Custom Fingerprinting

The Firepower System includes operating system fingerprints that the system uses to identify the operating system on each host it detects. However, sometimes the system cannot identify a host operating system or
misidentifies it because no fingerprints exist that match the operating system. To correct this problem, you can create a custom fingerprint, which provides a pattern of operating system characteristics unique to the unknown or misidentified operating system, to supply the name of the operating system for identification purposes.

If the system cannot match a host’s operating system, it cannot identify the vulnerabilities for the host, because the system derives the list of vulnerabilities for each host from its operating system fingerprint. For example, if the system detects a host running Microsoft Windows, the system has a stored Microsoft Windows vulnerability list that it adds to the host profile for that host based on the detected Windows operating system.

As an example, if you have several devices on your network running a new beta version of Microsoft Windows, the system cannot identify that operating system or map vulnerabilities to the hosts. However, knowing that the system has a list of vulnerabilities for Microsoft Windows, you may want to create a custom fingerprint for one of the hosts to help identify the other hosts running the same operating system. You can include a mapping of the vulnerability list for Microsoft Windows in the fingerprint to associate that list with each host that matches the fingerprint.

When you create a custom fingerprint, the Firepower Management Center lists the set of vulnerabilities associated with that fingerprint for any hosts running the same operating system. If the custom fingerprint you create does not have any vulnerabilities mappings in it, the system uses the fingerprint to assign the custom operating system information you provide in the fingerprint. When the system sees new traffic from a previously detected host, the system updates the host with the new fingerprint information. The system also uses the new fingerprint to identify any new hosts with that operating system the first time they are detected.

Before creating a custom fingerprint, you should determine why the host is not being identified correctly to decide whether custom fingerprinting is a viable solution.

You can create two types of fingerprints with the system:

- Client fingerprints, which identify operating systems based on the SYN packet that the host sends when it connects to a TCP application running on another host on the network.

- Server fingerprints, which identify operating systems based on the SYN-ACK packet that the host uses to respond to an incoming connection to a running TCP application.

If both a client and server fingerprint match the same host, the client fingerprint is used.

After creating fingerprints, you must activate them before the system can associate them with hosts.

**Related Topics**

Creating a Custom Fingerprint for Clients, on page 1218

Creating a Custom Fingerprint for Servers, on page 1220

**Managing Fingerprints**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

After a fingerprint is created and activated, you can edit a fingerprint to make changes or add vulnerability mappings.
Procedure

Step 1 Choose Policies > Network Discovery.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 2 Click Custom Operating Systems. If the system is awaiting data to create a fingerprint, it automatically refreshes the page every 10 seconds until the fingerprint is created.

Step 3 Manage your custom fingerprints:
- Activate/Deactivate — Activate or deactivate a fingerprint as described in Activating and Deactivating Fingerprints, on page 1216.
- Create — Create fingerprints as described in Creating a Custom Fingerprint for Clients, on page 1218 and Creating a Custom Fingerprint for Servers, on page 1220.
- Edit — Edit a fingerprint as described in Editing an Active Fingerprint, on page 1217 and Editing an Inactive Fingerprint, on page 1217.
- Delete — Click the delete icon (删除) next to the fingerprint you want to delete, and click OK to confirm. You can only delete deactivated fingerprints.

Activating and Deactivating Fingerprints

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery</td>
</tr>
</tbody>
</table>

You must activate a custom fingerprint before the system can use it to identify hosts. After the new fingerprint is activated, the system uses it to re-identify previously discovered hosts and discover new hosts.

If you want to stop using a fingerprint, you can deactivate it. Deactivating a fingerprint causes a fingerprint to no longer be used, but allows it to remain on the system. When you deactivate a fingerprint, the operating system is marked as unknown for hosts that use the fingerprint. If the hosts are detected again and match a different active fingerprint, they are then identified by that active fingerprint.

Deleting a fingerprint removes it from the system completely. After deactivating a fingerprint, you can delete it.

Procedure

Step 1 Choose Policies > Network Discovery.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 2 Click Custom Operating Systems.

Step 3 Click the slider next to the fingerprint you want to activate or deactivate.
Note  The activate option is only available if the fingerprint you created is valid. If the slider is not available, try creating the fingerprint again.

Editing an Active Fingerprint

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

If a fingerprint is active, you can modify the fingerprint name, description, custom operating system display, and map additional vulnerabilities to it.

You can modify the fingerprint name, description, custom operating system display, and map additional vulnerabilities to it.

Procedure

Step 1  Choose Policies > Network Discovery.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 2  Click Custom Operating Systems

Step 3  Click the edit icon ( ) next to the fingerprint you want to edit.

Step 4  Modify the fingerprint name, description, and custom OS display, if necessary.

Step 5  If you want to delete a vulnerability mapping, click Delete next to the mapping in the Pre-Defined OS Product Maps section of the page.

Step 6  If you want to add additional operating systems for vulnerability mapping, choose the Product and, if applicable, Major Version, Minor Version, Revision Version, Build, Patch, and Extension and then click Add OS Definition.

The vulnerability mapping is added to the Pre-Defined OS Product Maps list.

Step 7  Click Save.

Editing an Inactive Fingerprint

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

If a fingerprint is inactive, you can modify all elements of the fingerprint and resubmit it to the Firepower Management Center. This includes all properties you specified when creating the fingerprint, such as fingerprint type, target IP addresses and ports, vulnerability mappings, and so on. When you edit an inactive fingerprint and submit it, it is resubmitted to the system and, if it is a client fingerprint, you must resend traffic to the appliance before activating it. Note that you can choose only a single vulnerability mapping for an inactive
fingerprint. After you activate the fingerprint, you can map additional operating systems and versions to its vulnerabilities list.

**Procedure**

**Step 1** Choose **Policies > Network Discovery**.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click **Custom Operating Systems**.

**Step 3** Click the edit icon (✏️) next to the fingerprint you want to edit.

**Step 4** Make changes to the fingerprint as necessary:

- If you are modifying a client fingerprint, see Creating a Custom Fingerprint for Clients, on page 1218.
- If you are modifying a server fingerprint, see Creating a Custom Fingerprint for Servers, on page 1220.

**Step 5** Click **Save**.

**What to do next**

- If you modified a client fingerprint, remember to send traffic from the host to the appliance gathering the fingerprint.

**Creating a Custom Fingerprint for Clients**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Client fingerprints identify operating systems based on the SYN packet a host sends when it connects to a TCP application running on another host on the network.

If the Firepower Management Center does not have direct contact with monitored hosts, you can specify a device that is managed by the FMC and is closest to the host you intend to fingerprint when specifying client fingerprint properties.

Before you begin the fingerprinting process, obtain the following information about the host you want to fingerprint:

- The number of network hops between the host and the Firepower Management Center or the device you use to obtain the fingerprint. (Cisco strongly recommends that you directly connect the Firepower Management Center or the device to the same subnet that the host is connected to.)
- The network interface (on the Firepower Management Center or the device) that is connected to the network where the host resides.
- The actual operating system vendor, product, and version of the host.
- Access to the host in order to generate client traffic.
**Procedure**

**Step 1** Choose Policies > Network Discovery.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click Custom Operating Systems.

**Step 3** Click Create Custom Fingerprint.

**Step 4** From the Device drop-down list, choose the Firepower Management Center or the device that you want to use to collect the fingerprint.

**Step 5** Enter a Fingerprint Name.

**Step 6** Enter a Fingerprint Description.

**Step 7** From the Fingerprint Type list, choose Client.

**Step 8** In the Target IP Address field, enter an IP address of the host you want to fingerprint.
Note that the fingerprint will only be based on traffic to and from the host IP address you specify, not any of the host’s other IP addresses (if it has any).

**Step 9** In the Target Distance field, enter the number of network hops between the host and the device that you chose earlier to collect the fingerprint.

*Caution* This must be the actual number of physical network hops to the host, which may or may not be the same as the number of hops detected by the system.

**Step 10** From the Interface list, choose the network interface that is connected to the network segment where the host resides.

*Caution* Cisco recommends that you do not use the sensing interface on a managed device for fingerprinting for several reasons. First, fingerprinting does not work if the sensing interface is on a span port. Also, if you use the sensing interface on a device, the device stops monitoring the network for the amount of time it takes to collect the fingerprint. You can, however, use the management interface or any other available network interfaces to perform fingerprint collection. If you do not know which interface is the sensing interface on your device, refer to the Installation Guide for the specific model you are using to fingerprint.

**Step 11** If you want to display custom information in the host profile for fingerprinted hosts (or if the host you want to fingerprint does not reside in the OS Vulnerability Mappings section), choose Use Custom OS Display and provide the values you want to display for the following:

- In the Vendor String field, enter the operating system’s vendor name. For example, the vendor for Microsoft Windows would be Microsoft.

- In the Product String field, enter the operating system’s product name. For example, the product name for Microsoft Windows 2000 would be Windows.

- In the Version String field, enter the operating system’s version number. For example, the version number for Microsoft Windows 2000 would be 2000.

**Step 12** In the OS Vulnerability Mappings section, choose the operating system, product, and versions you want to use for vulnerability mapping.
You must specify **Vendor** and **Product** values in this section if you want to use the fingerprint to identify vulnerabilities for matching hosts or if you do not assign custom operating system display information.

To map vulnerabilities for all versions of an operating system, specify only the **Vendor** and **Product** values.

**Note** Not all options in the **Major Version**, **Minor Version**, **Revision Version**, **Build**, **Patch**, and **Extension** drop-down lists may apply to the operating system you choose. In addition, if no definition appears in a list that matches the operating system you want to fingerprint, you can leave these values empty. Be aware that if you do not create any OS vulnerability mappings in a fingerprint, the system cannot use the fingerprint to assign a vulnerabilities list with hosts identified by the fingerprint.

**Example:**

If you want your custom fingerprint to assign the list of vulnerabilities from Redhat Linux 9 to matching hosts, choose **Redhat, Inc.** as the vendor, **Redhat Linux** as the product, and 9 as the major version.

**Example:**

To add all versions of the Paltm OS, you would choose **PalmSource, Inc.** from the **Vendor** list, **Palm OS** from the **Product** list, and leave all other lists at their default settings.

**Step 13**

Click **Create**.

The status briefly shows **New**, then switches to **Pending**, where it remains until traffic is seen for the fingerprint. Once traffic is seen, it switches to **Ready**.

The Custom Fingerprint status page refreshes every ten seconds until it receives data from the host in question.

**Step 14**

Using the IP address you specified as the target IP address, access the host you are trying to fingerprint and initiate a TCP connection to the appliance.

To create an accurate fingerprint, traffic **must** be seen by the appliance collecting the fingerprint. If you are connected through a switch, traffic to a system other than the appliance may not be seen by the system.

**Example:**

Access the web interface of the Firepower Management Center from the host you want to fingerprint or SSH into the FMC from the host. If you are using SSH, use the command below, where localIPv6address is the IPv6 address specified in step 7 that is currently assigned to the host and DCmanagementIPv6address is the management IPv6 address of the FMC. The Custom Fingerprint page should then reload with a “Ready” status.

```
ssh -b localIPv6address DCmanagementIPv6address
```

---

**What to do next**

- Activate the fingerprint as described in **Activating and Deactivating Fingerprints, on page 1216.**

### Creating a Custom Fingerprint for Servers

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>
Server fingerprints identify operating systems based on the SYN-ACK packet that the host uses to respond to an incoming connection to a running TCP application. Before you begin, you should obtain the following information about the host you want to fingerprint:

- The number of network hops between the host and the appliance you use to obtain the fingerprint. Cisco strongly recommends that you directly connect an unused interface on the appliance to the same subnet that the host is connected to.
- The network interface (on the appliance) that is connected to the network where the host resides.
- The actual operating system vendor, product, and version of the host.
- An IP address that is not currently in use and is authorized on the network where the host is located.

**Tip**

If the Firepower Management Center does not have direct contact with monitored hosts, you can specify a managed device that is closest to the host you intend to fingerprint when specifying server fingerprint properties.

**Procedure**

**Step 1**
Choose **Policies > Network Discovery**.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2**
Click **Custom Operating Systems**.

**Step 3**
Click **Create Custom Fingerprint**.

**Step 4**
From the **Device** list, choose the Firepower Management Center or the managed device that you want to use to collect the fingerprint.

**Step 5**
Enter a **Fingerprint Name**.

**Step 6**
Enter a **Fingerprint Description**.

**Step 7**
From the **Fingerprint Type** list, choose **Server** to display the server fingerprinting options.

**Step 8**
In the **Target IP Address** field, enter an IP address of the host you want to fingerprint.

Note that the fingerprint will only be based on traffic to and from the host IP address you specify, not any of the host’s other IP addresses (if it has any).

**Caution**
You can capture IPv6 fingerprints only with appliances running Version 5.2 and later of the Firepower System.

**Step 9**
In the **Target Distance** field, enter the number of network hops between the host and the device that you chose earlier to collect the fingerprint.

**Caution**
This must be the actual number of physical network hops to the host, which may or may not be the same as the number of hops detected by the system.

**Step 10**
From the **Interface** list, choose the network interface that is connected to the network segment where the host resides.
Cisco recommends that you do not use the sensing interface on a managed device for fingerprinting for several reasons. First, fingerprinting does not work if the sensing interface is on a span port. Also, if you use the sensing interface on a device, the device stops monitoring the network for the amount of time it takes to collect the fingerprint. You can, however, use the management interface or any other available network interfaces to perform fingerprint collection. If you do not know which interface is the sensing interface on your device, refer to the Installation Guide for the specific model you are using to fingerprint.

**Step 11** Click Get Active Ports.

**Step 12** In the **Server Port** field, enter the port that you want the device chose to collect the fingerprint to initiate contact with, or choose a port from the Get Active Ports drop-down list.

You can use any server port that you know is open on the host (for instance, 80 if the host is running a web server).

**Step 13** In the **Source IP Address** field, enter an IP address that should be used to attempt to communicate with the host.

You should use a source IP address that is authorized for use on the network but is not currently being used, for example, a DHCP pool address that is currently not in use. This prevents you from temporarily knocking another host offline while you create the fingerprint.

You should exclude that IP address from monitoring in your network discovery policy while you create the fingerprint. Otherwise, the network map and discovery event views will be cluttered with inaccurate information about the host represented by that IP address.

**Step 14** In the **Source Subnet Mask** field, enter the subnet mask for the IP address you are using.

**Step 15** If the **Source Gateway** field appears, enter the default gateway IP address that should be used to establish a route to the host.

**Step 16** If you want to display custom information in the host profile for fingerprinted hosts or if the fingerprint name you want to use does not exist in the OS Definition section, choose **Use Custom OS Display** in the Custom OS Display section.

Provide the values you want to appear in host profiles for the following:

- In the **Vendor String** field, enter the operating system’s vendor name. For example, the vendor for Microsoft Windows would be Microsoft.

- In the **Product String** field, enter the operating system’s product name. For example, the product name for Microsoft Windows 2000 would be Windows.

- In the **Version String** field, enter the operating system’s version number. For example, the version number for Microsoft Windows 2000 would be 2000.

**Step 17** In the OS Vulnerability Mappings section, choose the operating system, product, and versions you want to use for vulnerability mapping.

You must specify a Vendor and Product name in this section if you want to use the fingerprint to identify vulnerabilities for matching hosts or if you do not assign custom operating system display information.

To map vulnerabilities for all versions of an operating system, specify only the vendor and product name.
Note: Not all options in the **Major Version**, **Minor Version**, **Revision Version**, **Build**, **Patch**, and **Extension** drop-down lists may apply to the operating system you choose. In addition, if no definition appears in a list that matches the operating system you want to fingerprint, you can leave these values empty. Be aware that if you do not create any OS vulnerability mappings in a fingerprint, the system cannot use the fingerprint to assign a vulnerabilities list with hosts identified by the fingerprint.

Example:

If you want your custom fingerprint to assign the list of vulnerabilities from Redhat Linux 9 to matching hosts, choose **Redhat, Inc.** as the vendor, **Redhat Linux** as the product, and 9 as the version.

Example:

To add all versions of the Palm OS, you would choose **PalmSource, Inc.** from the **Vendor** list, **Palm OS** from the **Product** list, and leave all other lists at their default settings.

Step 18

Click **Create**.

The Custom Fingerprint status page refreshes every ten seconds and should reload with a “Ready” status.

Note: If the target system stops responding during the fingerprinting process, the status shows an **ERROR**: **No Response** message. If you see this message, submit the fingerprint again. Wait three to five minutes (the time period may vary depending on the target system), click the edit icon (✏️) to access the Custom Fingerprint page, and then click **Create**.

What to do next

- Activate the fingerprint as described in **Activating and Deactivating Fingerprints**, on page 1216.

**Host Input Data**

You can augment the network map by importing network map data from third parties. You can also use the host input feature by modifying operating system or application identities or deleting application protocols, protocols, host attributes, or clients using the web interface.

The system may reconcile data from multiple sources to determine the current identity of an operating system or application.

All data except third-party vulnerabilities is discarded when the affected host is removed from the network map. For more information on setting up scripts or import files, see the *Firepower System Host Input API Guide*.

To include imported data in impact correlations, you must map the data to the operating system and application definitions in the database.

**Requirements for Using Third-Party Data**

You can import discovery data from third-party systems on your network. However, to enable features where intrusion and discovery data are used together, such as Firepower recommendations, adaptive profiles, or impact assessment, you should map as many elements of it as possible to corresponding definitions. Consider the following requirements for using third-party data:
• If you have a third-party system that has specific data on your network assets, you can import that data using the host input feature. However, because third parties may name the products differently, you must map the third-party vendor, product, and versions to the corresponding Cisco product definition. After you map the products, you must enable vulnerability mappings for impact assessment in the Firepower Management Center configuration to allow impact correlation. For versionless or vendorless application protocols, you need to map vulnerabilities for the application protocols in the Firepower Management Center configuration.

• If you import patch information from a third party and you want to mark all vulnerabilities fixed by that patch as invalid, you must map the third-party fix name to a fix definition in the database. All vulnerabilities addressed by the fix will then be removed from hosts where you add that fix.

• If you import operating system and application protocol vulnerabilities from a third party and you want to use them for impact correlation, you must map the third-party vulnerability identification string to vulnerabilities in the database. Note that although many clients have associated vulnerabilities, and clients are used for impact assessment, you cannot import and map third-party client vulnerabilities. After the vulnerabilities are mapped, you must enable third-party vulnerability mappings for impact assessment in the Firepower Management Center configuration. To cause application protocols without vendor or version information to map to vulnerabilities, an administrative user must also map vulnerabilities for the applications in the Firepower Management Center configuration.

• If you import application data and you want to use that data for impact correlation, you must map the vendor string for each application protocol to the corresponding Cisco application protocol definition.

Related Topics
Mapping Third-Party Products, on page 1224
Mapping Third-Party Product Fixes, on page 1226
Mapping Third-Party Vulnerabilities, on page 1227
Mapping Vulnerabilities for Servers, on page 484
Creating Custom Product Mappings, on page 1228

Third-Party Product Mappings

When you add data from third parties to the network map through the user input feature, you must map the vendor, product, and version names used by the third party to the Cisco product definitions. Mapping the products to Cisco definitions assigns vulnerabilities based on those definitions.

Similarly, if you are importing patch information from a third party, such as a patch management product, you must map the name for the fix to the appropriate vendor and product and the corresponding fix in the database.

Mapping Third-Party Products

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If you import data from a third party, you must map the Cisco product to the third-party name to assign vulnerabilities and perform impact correlation using that data. Mapping the product associates Cisco vulnerability information with the third-party product name, which allows the system to perform impact correlation using that data.
If you import data using the host input import feature, you can also use the AddScanResult function to map third-party products to operating system and application vulnerabilities during the import.

For example, if you import data from a third party that lists Apache Tomcat as an application and you know it is version 6 of that product, you could add a third-party map where:

- **Vendor Name** is set to **Apache**.
- **Product Name** is set to **Tomcat**.
- **Apache** is chosen from the **Vendor** drop-down list.
- **Tomcat** is chosen from the **Product** drop-down list.
- **6** is chosen from the **Version** drop-down list.

This mapping would cause any vulnerabilities for Apache Tomcat 6 to be assigned to hosts with an application listing for Apache Tomcat.

Note that for versionless or vendorless applications, you must map vulnerabilities for the application types in the Firepower Management Center configuration. Although many clients have associated vulnerabilities, and clients are used for impact assessment, you cannot import and map third-party client vulnerabilities.

**Tip**

If you have already created a third-party mapping on another Firepower Management Center, you can export it and then import it onto this FMC. You can then edit the imported mapping to suit your needs.

**Procedure**

**Step 1** Choose **Policies > Application Detectors**.

**Step 2** Click **User Third-Party Mappings**.

**Step 3** You have two choices:

- Create — To create a new map set, click **Create Product Map Set**.
- Edit — To edit an existing map set, click the edit icon (📝) next to the map set you want to modify. If a view icon (👁️) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4** Enter a **Mapping Set Name**.

**Step 5** Enter a **Description**.

**Step 6** You have two choices:

- Create — To map a third-party product, click **Add Product Map**.
- Edit — To edit an existing third-party product map, click the edit icon (📝) next to the map set you want to modify. If a view icon (👁️) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 7** Enter the **Vendor String** used by the third-party product.

**Step 8** Enter the **Product String** used by the third-party product.

**Step 9** Enter the **Version String** used by the third-party product.
### Step 10

In the Product Mappings section, choose the operating system, product, and versions you want to use for vulnerability mapping from the *Vendor*, *Product*, *Major Version*, *Minor Version*, *Revision Version*, *Build*, *Patch*, and *Extension* fields.

**Example:**

If you want a host running a product whose name consists of third-party strings to use the vulnerabilities from Red Hat Linux 9, choose *Redhat, Inc.* as the vendor, *Redhat Linux* as the product, and *9* as the version.

### Step 11

Click **Save**.

---

**Related Topics**

- Mapping Vulnerabilities for Servers, on page 484

---

# Mapping Third-Party Product Fixes

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If you map a fix name to a particular set of fixes in the database, you can then import data from a third-party patch management application and apply the fix to a set of hosts. When the fix name is imported to a host, the system marks all vulnerabilities addressed by the fix as invalid for that host.

### Procedure

**Step 1** Choose Policies > Application Detectors.

**Step 2** Click **User Third-Party Mappings**.

**Step 3** You have two choices:

- **Create** — To create a new map set, click **Create Product Map Set**.
- **Edit** — To edit an existing map set, click the edit icon (_edit icon_) next to the map set you want to modify. If a view icon (_view icon_) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4** Enter a **Mapping Set Name**.

**Step 5** Enter a **Description**.

**Step 6** You have two choices:

- **Create** — To map a third-party product, click **Add Fix Map**.
- **Edit** — To edit an existing third-party product map, click the edit icon (edit icon) next to it. If a view icon (view icon) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 7** Enter the name of the fix you want to map in the **Third-Party Fix Name** field.

**Step 8** In the **Product Mappings** section, choose the operating system, product, and versions you want to use for fix mapping from the following fields:

- **Vendor**
- **Product**


- Major Version
- Minor Version
- Revision Version
- Build
- Patch
- Extension

Example:
If you want your mapping to assign the fixes from Red Hat Linux 9 to hosts where the patch is applied, choose Redhat, Inc. as the vendor, Redhat Linux as the product, and 9 as the version.

Step 9
Click Save to save the fix map.

### Mapping Third-Party Vulnerabilities

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

To add vulnerability information from a third party to the VDB, you must map the third-party identification string for each imported vulnerability to any existing SVID, Bugtraq, or SID. After you create a mapping for the vulnerability, the mapping works for all vulnerabilities imported to hosts in the network map and allows impact correlation for those vulnerabilities.

You must enable impact correlation for third-party vulnerabilities to allow correlation to occur. For versionless or vendorless applications, you must also map vulnerabilities for the application types in the Firepower Management Center configuration.

Although many clients have associated vulnerabilities, and clients are used for impact assessment, you cannot use third-party client vulnerabilities for impact assessment.

**Tip**
If you have already created a third-party mapping on another Firepower Management Center, you can export it and then import it onto this FMC. You can then edit the imported mapping to suit your needs.

### Procedure

**Step 1**
Choose Policies > Application Detectors.

**Step 2**
Click User Third-Party Mappings.

**Step 3**
You have two choices:

- **Create** — To create a new vulnerability set, click Create Vulnerability Map Set.
- **Edit** — To edit an existing vulnerability set, click the edit icon (📝) next to the vulnerability set. If a view icon (👁) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4**
Click Add Vulnerability Map.
Step 5 Enter the third-party identification for the vulnerability in the Vulnerability ID field.

Step 6 Enter a Vulnerability Description.

Step 7 Optionally:
   • Enter a Snort ID in the Snort Vulnerability ID Mappings field.
   • Enter a legacy vulnerability ID in the SVID Mappings field.
   • Enter a Bugtraq identification number in the Bugtraq Vulnerability ID Mappings field.

Step 8 Click Add.

Related Topics
   Enabling Network Discovery Vulnerability Impact Assessment, on page 1315
   Mapping Vulnerabilities for Servers, on page 484

Custom Product Mappings

You can use product mappings to ensure that servers input by a third party are associated with the appropriate Cisco definitions. After you define and activate the product mapping, all servers or clients on monitored hosts that have the mapped vendor strings use the custom product mappings. For this reason, you may want to map vulnerabilities for all servers in the network map with a particular vendor string instead of explicitly setting the vendor, product, and version for the server.

Creating Custom Product Mappings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If the system cannot map a server to a vendor and product in the VDB, you can manually create the mapping. When you activate a custom product mapping, the system maps vulnerabilities for the specified vendor and product to all servers in the network map where that vendor string occurs.

Note

Custom product mappings apply to all occurrences of an application protocol, regardless of the source of the application data (such as Nmap, the host input feature, or the Firepower System itself). However, if third-party vulnerability mappings for data imported using the host input feature conflicts with the mappings you set through a custom product mapping, the third-party vulnerability mapping overrides the custom product mapping and uses the third-party vulnerability mapping settings when the input occurs.

You create lists of product mappings and then enable or disable use of several mappings at once by activating or deactivating each list. When you specify a vendor to map to, the system updates the list of products to include only those made by that vendor.

After you create a custom product mapping, you must activate the custom product mapping list. After you activate a list of custom product mappings, the system updates all servers with occurrences of the specified vendor strings. For data imported through the host input feature, vulnerabilities update unless you have already explicitly set the product mappings for this server.

If, for example, your company modifies the banner for your Apache Tomcat web servers to read Internal Web Server, you can map the vendor string Internal Web Server to the vendor Apache and the product
Tomcat, then activate the list containing that mapping, all hosts where a server labeled Internal Web Server occurs have the vulnerabilities for Apache Tomcat in the database.

Tip
You can use this feature to map vulnerabilities to local intrusion rules by mapping the SID for the rule to another vulnerability.

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose Policies &gt; Application Detectors.</td>
</tr>
<tr>
<td>2</td>
<td>Click Custom Product Mappings</td>
</tr>
<tr>
<td>3</td>
<td>Click Create Custom Product Mapping List.</td>
</tr>
<tr>
<td>4</td>
<td>Enter a Custom Product Mapping List Name.</td>
</tr>
<tr>
<td>5</td>
<td>Click Add Vendor String.</td>
</tr>
<tr>
<td>6</td>
<td>In the Vendor String field, enter the vendor string that identifies the applications that should map to the chosen vendor and product values.</td>
</tr>
<tr>
<td>7</td>
<td>Choose the vendor you want to map to from the Vendor drop-down list.</td>
</tr>
<tr>
<td>8</td>
<td>Choose the product you want to map to from the Product drop-down list.</td>
</tr>
<tr>
<td>9</td>
<td>Click Add to add the mapped vendor string to the list.</td>
</tr>
<tr>
<td>10</td>
<td>Optionally, repeat steps 4 to 8 as needed to add additional vendor string mappings to the list.</td>
</tr>
<tr>
<td>11</td>
<td>Click Save.</td>
</tr>
</tbody>
</table>

What to do next

- Activate the custom product mapping list. For more information, see Activating and Deactivating Custom Product Mappings, on page 1230.

Editing Custom Product Mapping Lists

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can modify existing custom product mapping lists by adding or removing vendor strings or changing the list name.

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose Policies &gt; Application Detectors.</td>
</tr>
<tr>
<td>2</td>
<td>Click Custom Product Mappings.</td>
</tr>
<tr>
<td>3</td>
<td>Click the edit icon (📝) next to the product mapping list you want to edit.</td>
</tr>
</tbody>
</table>
If a view icon ( ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4** Make changes to the list as described in Creating Custom Product Mappings, on page 1228.

**Step 5** When you finish, click **Save**.

---

### Activating and Deactivating Custom Product Mappings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can enable or disable use of an entire list of custom product mappings at once. After you activate a custom product mapping list, each mapping on that list applies to all applications with the specified vendor string, whether detected by managed devices or imported through the host input feature.

**Procedure**

**Step 1** Choose **Policies > Application Detectors**.

**Step 2** Click **Custom Product Mappings**.

**Step 3** Click the slider next to the custom product mapping list to activate or deactivate it.

If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

---

### eStreamer Server Streaming

The Event Streamer (eStreamer) allows you to stream several kinds of event data from a Firepower Management Center or 7000 or 8000 Series device to a custom-developed client application. For more information, see Firepower eStreamer Integration Guide.

Before the appliance you want to use as an eStreamer server can begin streaming eStreamer events to an external client, you must configure the eStreamer server to send events to clients, provide information about the client, and generate a set of authentication credentials to use when establishing communication. You can perform all of these tasks from the appliance’s user interface. Once your settings are saved, the events you selected will be forwarded to eStreamer clients when requested.

You can control which types of events the eStreamer server is able to transmit to clients that request them.

**Table 191: Event Types Transmittable by the eStreamer Server**

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
<th>Available on FMC</th>
<th>Available on 7000 &amp; 8000 Series Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intrusion Events</td>
<td>intrusion events generated by managed devices</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
### Choosing eStreamer Event Types

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
<th>Available on FMC</th>
<th>Available on 7000 &amp; 8000 Series Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intrusion Event Packet Data</td>
<td>packets associated with intrusion events</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Intrusion Event Extra Data</td>
<td>additional data associated with an intrusion event such as the originating IP addresses of a client connecting to a web server through an HTTP proxy or load balancer</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Discovery Events</td>
<td>Network discovery events</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Correlation and White List Events</td>
<td>correlation and white list events</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Impact Flag Alerts</td>
<td>impact alerts generated by the FMC</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>User Events</td>
<td>user events</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Malware Events</td>
<td>malware events</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>File Events</td>
<td>file events</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Connection Events</td>
<td>information about the session traffic between your monitored hosts and all other hosts.</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

**Choosing eStreamer Event Types**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

The eStreamer Event Configuration check boxes control which events the eStreamer server can transmit. Your client must still specifically request the types of events you want it to receive in the request message it sends to the eStreamer server. For more information, see the Firepower eStreamer Integration Guide.

In a multidomain deployment, you can configure eStreamer Event Configuration at any domain level. However, if an ancestor domain has enabled a particular event type, you cannot disable that event type in the descendant domains.

**Procedure**

1. **Step 1** Choose System > Integration.
2. **Step 2** Click the eStreamer tab.
3. **Step 3** Under eStreamer Event Configuration, check or clear the check boxes next to the types of events you want eStreamer to forward to requesting clients, described in eStreamer Server Streaming, on page 1230.
Configuring eStreamer Client Communications

Before eStreamer can send eStreamer events to a client, you must add the client to the eStreamer server’s peers database from the eStreamer page. You must also copy the authentication certificate generated by the eStreamer server to the client. After completing these steps you do not need to restart the eStreamer service to enable the client to connect to the eStreamer server.

In a multidomain deployment, you can create an eStreamer client in any domain. The authentication certificate allows the client to request events only from the client certificate's domain and any descendant domains. The eStreamer configuration page shows only clients associated with the current domain, so if you want to download or revoke a certificate, switch to the domain where the client was created.

Procedure

- **Step 1** Choose **System > Integration**.
- **Step 2** Click the **eStreamer** tab.
- **Step 3** Click **Create Client**.
- **Step 4** In the **Hostname** field, enter the host name or IP address of the host running the eStreamer client.

  **Note**  If you have not configured DNS resolution, use an IP address.

- **Step 5** If you want to encrypt the certificate file, enter a password in the **Password** field.
- **Step 6** Click **Save**.

  The eStreamer server now allows the host to access port 8302 on the eStreamer server and creates an authentication certificate to use during client-server authentication.

- **Step 7** Click the download file icon (활동) next to the client hostname to download the certificate file.
- **Step 8** Save the certificate file to the appropriate directory used by your client for SSL authentication.
- **Step 9** To revoke access for a client, click the delete icon (삭제) next to the host you want to remove.

  Note that you do not need to restart the eStreamer service; access is revoked immediately.

### Configuring the Host Input Client

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>FMC</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Configuring eStreamer Client Communications
The host input feature allows you to update the Firepower Management Center's network map from a client program running on another appliance. For example, you can add or delete hosts from the network map, or update the host OS and service information. For more information, see Firepower System Host Input API Guide.

Before you can run a remote client, you must add the client to the Firepower Management Center’s peers database from the Host Input Client page. You must also copy the authentication certificate generated by the FMC to the client. After completing these steps the client can connect to the FMC.

In a multidomain deployment, you can create a client in any domain. The authentication certificate allows the client to submit network map updates for any leaf domains associated with the client certificate’s domain. If you create a certificate for an ancestor domain (or if your certificate domain later becomes an ancestor domain after adding descendant domains), any clients using that certificate must specify a target leaf domain with every transaction, as described in the Firepower System Host Input API Guide.

The Host Input Client tab shows only clients associated the current domain, so if you want to download or revoke a certificate, switch to the domain where the client was created.

**Procedure**

**Step 1** Choose System > Integration.
**Step 2** Click the Host Input Client tab.
**Step 3** Click Create Client.
**Step 4** In the Hostname field, enter the host name or IP address of the host running the host input client.

*Note* If you have not configured DNS resolution, use an IP address.

**Step 5** If you want to encrypt the certificate file, enter a password in the Password field.
**Step 6** Click Save.
The host input service allows the host to access port 8307 on the Firepower Management Center and creates an authentication certificate to use during client-server authentication.

**Step 7** Click the download file icon (🔗) next to the certificate file.
**Step 8** Save the certificate file to the directory used by your client for SSL authentication.
**Step 9** To revoke access for a client, click the delete icon (🗑️) next to the host you want to remove.

**Nmap Scanning**

The Firepower System builds network maps through passive analysis of traffic on your network. Information obtained through this passive analysis can occasionally be incomplete, depending on system conditions. However, you can actively scan a host to obtain complete information. For example, if a host has a server running on an open port but the server has not received or sent traffic during the time that the system has been monitoring your network, the system does not add information about that server to the network map. If you directly scan that host using an active scanner, however, you can detect the presence of the server.

The Firepower System integrates with Nmap™, an open source active scanner for network exploration and security auditing.
When you scan a host using Nmap, the system:

- Adds servers on previously undetected open ports to the Servers list in the host profile for that host. The host profile lists any servers detected on filtered or closed TCP ports or on UDP ports in the Scan Results section. By default, Nmap scans more than 1660 TCP ports.

  If the system recognizes a server identified in an Nmap scan and has a corresponding server definition, the system maps the names Nmap uses for servers to the corresponding Cisco server definitions.

- Compares the results of the scan to over 1500 known operating system fingerprints to determine the operating system and assigns scores to each. The operating system assigned to the host is the operating system fingerprint with the highest score.

  The system maps Nmap operating system names to Cisco operating system definitions.

- Assigns vulnerabilities to the host for the added servers and operating systems.

Note:

- A host must exist in the network map before Nmap can append its results to the host profile.

- If the host is deleted from the network map, any Nmap scan results for that host are discarded.

Tip

Some scanning options (such as portscans) may place a significant load on networks with low bandwidths. Schedule scans like these to run during periods of low network use.

For more information on the underlying Nmap technology used to scan, refer to the Nmap documentation at http://insecure.org/.

Related Topics

  Nmap Scan Automation, on page 156

**Nmap Remediation Options**

You define the settings for an Nmap scan by creating an Nmap remediation. An Nmap remediation can be used as a response in a correlation policy, run on demand, or scheduled to run at a specific time.

Note that Nmap-supplied server and operating system data remain static until you run another Nmap scan. If you plan to scan a host for operating system and server data using Nmap, you may want to set up regularly scheduled scans to keep any Nmap-supplied operating system and server data up-to-date.

The following table explains the options configurable in Nmap remediations on a Firepower System.
### Table 192: Nmap Remediation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Corresponding Nmap Option</th>
</tr>
</thead>
</table>
| Scan Which Address(es) From Event?          | When you use an Nmap scan as a response to a correlation rule, select one of the following options to control which address in the event is scanned, that of the source host, the destination host, or both:  
  • **Scan Source and Destination Addresses** scans the hosts represented by the source IP address and the destination IP address in the event.  
  • **Scan Source Address Only** scans the host represented by the event’s source IP address.  
  • **Scan Destination Address Only** scans the host represented by the event’s destination IP address.                                           | N/A                       |
### Nmap Remediation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Corresponding Nmap Option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan Types</strong></td>
<td>Select how Nmap scans ports:</td>
<td></td>
</tr>
<tr>
<td><strong>TCP Syn</strong></td>
<td>The TCP Syn scan connects quickly to thousand of ports without using a complete TCP handshake. This options allows you to scan quickly in stealth mode on hosts where the admin account has raw packet access or where IPv6 is not running, by initiating TCP connections but not completing them. If a host acknowledges the Syn packet sent in a TCP Syn scan, Nmap resets the connection.</td>
<td>TCP Syn: <code>-sS</code></td>
</tr>
<tr>
<td><strong>TCP Connect</strong></td>
<td>The TCP Connect scan uses the <code>connect()</code> system call to open connections through the operating system on the host. You can use the TCP Connect scan if the admin user on the Firepower Management Center or managed device does not have raw packet privileges on a host or you are scanning IPv6 networks. In other words, use this option in situations where the TCP Syn scan cannot be used.</td>
<td>TCP Connect: <code>-sT</code></td>
</tr>
<tr>
<td><strong>TCP ACK</strong></td>
<td>The TCP ACK scan sends an ACK packet to check whether ports are filtered or unfiltered.</td>
<td>TCP ACK: <code>-sA</code></td>
</tr>
<tr>
<td><strong>TCP Window</strong></td>
<td>The TCP Window scan works in the same way as a TCP ACK scan but can also determine whether a port is open or closed.</td>
<td>TCP Window: <code>-sW</code></td>
</tr>
<tr>
<td><strong>TCP Maimon</strong></td>
<td>The TCP Maimon scan identifies BSD-derived systems using a FIN/ACK probe.</td>
<td>TCP Maimon: <code>-sM</code></td>
</tr>
<tr>
<td><strong>Scan for UDP ports</strong></td>
<td>Enable to scan UDP ports in addition to TCP ports. Note that scanning UDP ports may be time-consuming, so avoid using this option if you want to scan quickly.</td>
<td><code>-sU</code></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Corresponding Nmap Option</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Use Port From Event</td>
<td>If you plan to use the remediation as a response in a correlation policy, enable to cause the remediation to scan only the port specified in the event that triggers the correlation response.</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>On</strong> to scan the port in the correlation event, rather than the ports you specify during Nmap remediation configuration. If you scan the port in the correlation event, note that the remediation scans the port on the IP addresses that you specify during Nmap remediation configuration. These ports are also added to the remediation’s dynamic scan target.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Off</strong> to scan only the ports you specify Nmap remediation configuration.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You can also control whether Nmap collects information about operating system and server information. Enable the <strong>Use Port From Event</strong> option to scan the port associated with the new server.</td>
<td></td>
</tr>
<tr>
<td>Scan from reporting detection engine</td>
<td>Enable to scan a host from the appliance where the detection engine that reported the host resides.</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• To scan from the appliance running the reporting detection engine, select <strong>On</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• To scan from the appliance configured in the remediation, select <strong>Off</strong>.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Corresponding Nmap Option</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Fast Port Scan</td>
<td>Enable to scan only the TCP ports listed in the <code>nmap-services</code> file located in the <code>/var/sf/nmap/share/nmap/nmap-services</code> directory on the device that does the scanning, ignoring other port settings. Note that you cannot use this option with the Port Ranges and Scan Order option.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* To scan only the ports listed in the <code>nmap-services</code> file located in the <code>/var/sf/nmap/share/nmap/nmap-services</code> directory on the device that does the scanning, ignoring other port settings, select <strong>On</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* To scan all TCP ports, select <strong>Off</strong>.</td>
<td>-F</td>
</tr>
<tr>
<td>Port Ranges and Scan Order</td>
<td>Set the specific ports you want to scan, using Nmap port specification syntax, and the order you want to scan them. Note that you cannot use this option with the Fast Port Scan option.</td>
<td>-p</td>
</tr>
<tr>
<td>Probe open ports for vendor and version information</td>
<td>Enable to detect server vendor and version information. If you probe open ports for server vendor and version information, Nmap obtains server data that it uses to identify servers. It then replaces the Cisco server data for that server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Select <strong>On</strong> to scan open ports on the host for server information to identify server vendors and versions.</td>
<td>-Sv</td>
</tr>
<tr>
<td></td>
<td>* Select <strong>Off</strong> to continue using Cisco server information for the host.</td>
<td></td>
</tr>
<tr>
<td>Service Version Intensity</td>
<td>Select the intensity of Nmap probes for service versions.</td>
<td>--version-intensity <code>&lt;intensity&gt;</code></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Corresponding Nmap Option</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
</tbody>
</table>
| Detect Operating System       | Enable to detect operating system information for the host. If you configure detection of the operating system for a host, Nmap scans the host and uses the results to create a rating for each operating system that reflects the likelihood that the operating system is running on the host.  
  • Select **On** to scan the host for information to identify the operating system.  
  • Select **Off** to continue using Cisco operating system information for the host. | -o                        |
| Treat All Hosts As Online     | Enable to skip the host discovery process and run a port scan on every host in the target range. Note that when you enable this option, Nmap ignores settings for **Host Discovery Method** and **Host Discovery Port List**.  
  • To skip the host discovery process and run a port scan on every host in the target range, select **On**.  
  • To perform host discovery using the settings for **Host Discovery Method** and **Host Discovery Port List** and skip the port scan on any host that is not available, select **Off**. | -PN                       |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Corresponding Nmap Option</th>
</tr>
</thead>
</table>
| **Host Discovery Method**      | Select to perform host discovery for all hosts in the target range, over the ports listed in the **Host Discovery Port List**, or if no ports are listed, over the default ports for that host discovery method. Note that if you also enabled **Treat All Hosts As Online**, however, the **Host Discovery Method** option has no effect and host discovery is not performed. Select the method to be used when Nmap tests to see if a host is present and available:  

- **TCP SYN** option sends an empty TCP packet with the SYN flag set and recognizes the host as available if a response is received. TCP SYN scans port 80 by default. Note that TCP SYN scans are less likely to be blocked by a firewall with stateful firewall rules.  

- **TCP ACK** option sends an empty TCP packet with the ACK flag set and recognizes the host as available if a response is received. TCP ACK also scans port 80 by default. Note that TCP ACK scans are less likely to be blocked by a firewall with stateless firewall rules.  

- **UDP** option sends a UDP packet and assumes host availability if a port unreachable response comes back from a closed port. UDP scans port 40125 by default.                                                                                   | TCP SYN: -PS  
TCP ACK: -PA  
UDP: -PU |
<p>| <strong>Host Discovery Port List</strong>   | Specify a customized list of ports, separated by commas, that you want to scan when doing host discovery.                                                                                                     | port list for host discovery method |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Corresponding Nmap Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default NSE Scripts</td>
<td>Enable to run the default set of Nmap scripts for host discovery and server and operating system and vulnerability detection. See <a href="https://nmap.org/nsedoc/categories/default.html">https://nmap.org/nsedoc/categories/default.html</a> for the list of default scripts.</td>
<td>-sC</td>
</tr>
<tr>
<td></td>
<td>• To run the default set of Nmap scripts, select <strong>On</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• To skip the default set of Nmap scripts, select <strong>Off</strong>.</td>
<td></td>
</tr>
<tr>
<td>Timing Template</td>
<td>Select the timing of the scan process; the higher the number you select, the faster and less comprehensive the scan.</td>
<td>0: $t_0$ (paranoid)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1: $t_1$ (sneaky)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: $t_2$ (polite)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3: $t_3$ (normal)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4: $t_4$ (aggressive)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5: $t_5$ (insane)</td>
</tr>
</tbody>
</table>

**Nmap Scanning Guidelines**

While active scanning can obtain valuable information, overuse of a tool such as Nmap may overload your network resources or even crash important hosts. When using any active scanner, you should create a scanning strategy following these guidelines to make sure that you are scanning only the hosts and ports that you need to scan.

**Selecting Appropriate Scan Targets**

When you configure Nmap, you can create scan targets that identify which hosts you want to scan. A scan target includes a single IP address, a CIDR block or octet range of IP addresses, an IP address range, or a list of IP addresses or ranges to scan, as well as the ports on the host or hosts.

You can specify targets in the following ways:

- For IPv6 hosts:
  - an exact IP address (for example, 192.168.1.101)

- For IPv4 hosts:
  - an exact IP address (for example, 192.168.1.101) or a list of IP addresses separated by commas or spaces
  - an IP address block using CIDR notation (for example, 192.168.1.0/24 scans the 254 hosts between 192.168.1.1 and 192.168.1.254, inclusive).
  - an IP address range using octet range addressing (for example, 192.168.0-255.1-254 scans all addresses in the 192.168.x.x range, except those that end in .0 and or .255)
Ideal scan targets for Nmap scans include hosts with operating systems that the system is unable to identify, hosts with unidentified servers, or hosts recently detected on your network. Remember that Nmap results cannot be added to the network map for hosts that do not already exist in the network map.

**Caution**

- Nmap-supplied server and operating system data remains static until you run another Nmap scan. If you plan to scan a host using Nmap, regularly schedule scans.
- If a host is deleted from the network map, any Nmap scan results are discarded.
- Make sure you have permission to scan your targets. Using Nmap to scan hosts that do not belong to you or your company may be illegal.

### Selecting Appropriate Ports to Scan

For each scan target you configure, you can select the ports you want to scan. You can designate individual port numbers, port ranges, or a series of port numbers and port ranges to identify the exact set of ports that should be scanned on each target.

By default, Nmap scans TCP ports 1 through 1024. If you plan to use the remediation as a response in a correlation policy, you can cause the remediation to scan only the port specified in the event that triggers the correlation response. If you run the remediation on demand or as a scheduled task, or if you do not use the port from the event, you can use other port options to determine which ports are scanned. You can choose to scan only the TCP ports listed in the `nmap-services` file, ignoring other port settings. You can also scan UDP ports in addition to TCP ports. Note that scanning for UDP ports may be time-consuming, so avoid using that option if you want to scan quickly. To select the specific ports or range of ports to scan, use Nmap port specification syntax to identify ports.

### Setting Host Discovery Options

You can decide whether to perform host discovery before starting a port scan for a host, or you can assume that all the hosts you plan to scan are online. If you choose not to treat all hosts as online, you can choose what method of host discovery to use and, if needed, customize the list of ports scanned during host discovery. Host discovery does not probe the ports listed for operating system or server information; it uses the response over a particular port only to determine whether a host is active and available. If you perform host discovery and a host is not available, Nmap does not scan ports on that host.

### Related Topics

- [Firepower System IP Address Conventions](#), on page 14
- [Nmap Scan Automation](#), on page 156

### Example: Using Nmap to Resolve Unknown Operating Systems

This example walks through an Nmap configuration designed to resolve unknown operating systems. For a complete look at Nmap configuration, see [Managing Nmap Scanning](#), on page 1245.
If the system cannot determine the operating system on a host on your network, you can use Nmap to actively scan the host. Nmap uses the information it obtains from the scan to rate the possible operating systems. It then uses the operating system that has the highest rating as the host operating system identification.

Using Nmap to challenge new hosts for operating system and server information deactivates the system’s monitoring of that data for scanned hosts. If you use Nmap to discover host and server operating system for hosts the system marks as having unknown operating systems, you may be able to identify groups of hosts that are similar. You can then create a custom fingerprint based on one of them to cause the system to associate the fingerprint with the operating system you know is running on the host based on the Nmap scan. Whenever possible, create a custom fingerprint rather than inputting static data through a third-party source like Nmap because the custom fingerprint allows the system to continue to monitor the host operating system and update it as needed.

In this example, you would:

1. Configure a scan instance as described in Adding an Nmap Scan Instance, on page 1245.
2. Create an Nmap remediation using the following settings:
   - Enable **Use Port From Event** to scan the port associated with the new server.
   - Enable **Detect Operating System** to detect operating system information for the host.
   - Enable **Probe open ports for vendor and version information** to detect server vendor and version information.
   - Enable **Treat All Hosts as Online**, because you know the host exists.
3. Create a correlation rule that triggers when the system detects a host with an unknown operating system. The rule should trigger when a discovery event occurs and the OS information for a host has changed and it meets the following conditions: **OS Name is unknown**.
4. Create a correlation policy that contains the correlation rule.
5. In the correlation policy, add the Nmap remediation you created in step 2 as a response to the rule you created in step 3.
6. Activate the correlation policy.
7. Purge the hosts on the network map to force network discovery to restart and rebuild the network map.
8. After a day or two, search for events generated by the correlation policy. Analyze the Nmap results for the operating systems detected on the hosts to see if there is a particular host configuration on your network that the system does not recognize.
9. If you find hosts with unknown operating systems whose Nmap results are identical, create a custom fingerprint for one of those hosts and use it to identify similar hosts in the future.

Related Topics
- Creating an Nmap Remediation, on page 1249
- Configuring Correlation Rules, on page 1365
- Nmap Scan Results, on page 1253
- Creating a Custom Fingerprint for Clients, on page 1218
- Configuring Correlation Policies, on page 1362
Example: Using Nmap to Respond to New Hosts

This example walks through an Nmap configuration designed to respond to new hosts. For a complete look at Nmap configuration, see Managing Nmap Scanning, on page 1245.

When the system detects a new host in a subnet where intrusions may be likely, you may want to scan that host to make sure you have accurate vulnerability information for it.

You can accomplish this by creating and activating a correlation policy that detects when a new host appears in this subnet, and that launches a remediation that performs an Nmap scan on the host.

To do this, you would:

1. Configure a scan instance as described in Adding an Nmap Scan Instance, on page 1245.
2. Create an Nmap remediation using the following settings:
   - Enable Use Port From Event to scan the port associated with the new server.
   - Enable Detect Operating System to detect operating system information for the host.
   - Enable Probe open ports for vendor and version information to detect server vendor and version information.
   - Enable Treat All Hosts as Online, because you know the host exists.
3. Create a correlation rule that triggers when the system detects a new host on a specific subnet. The rule should trigger when a discovery event occurs and a new host is detected.
4. Create a correlation policy that contains the correlation rule.
5. In the correlation policy, add the Nmap remediation you created in step 2 as a response to the rule you created in step 3.
6. Activate the correlation policy.
7. When you are notified of a new host, check the host profile to see the results of the Nmap scan and address any vulnerabilities that apply to the host.

After you activate the policy, you can periodically check the remediation status view (Analysis > Correlation > Status) to see when the remediation launched. The remediation’s dynamic scan target should include the IP addresses of the hosts it scanned as a result of the server detection. Check the host profile for those hosts to see if there are vulnerabilities that need to be addressed for the host, based on the operating system and servers detected by Nmap.

Caution

If you have a large or dynamic network, detection of a new host may be too frequent an occurrence to respond to using a scan. To prevent resource overload, avoid using Nmap scans as a response to events that occur frequently. In addition, note that using Nmap to challenge new hosts for operating system and server information deactivates Cisco monitoring of that data for scanned hosts.

Related Topics

- Creating an Nmap Remediation, on page 1249
- Configuring Correlation Rules, on page 1365
- Configuring Correlation Policies, on page 1362
Managing Nmap Scanning

To use Nmap scanning, you must, at minimum, configure an Nmap scan instance and an Nmap remediation. Configuring an Nmap scan target is optional.

Procedure

Step 1
Configure the Nmap scan:

- Add an Nmap scan instance as described in Adding an Nmap Scan Instance, on page 1245.
- Create an Nmap remediation as described in Creating an Nmap Remediation, on page 1249.
- Optionally, add an Nmap scan target as described in Adding an Nmap Scan Target, on page 1247.

Step 2
Run the Nmap scan:

- Run an on-demand Nmap scan as described in Running an On-Demand Nmap Scan, on page 1252.
- Configure automatic Nmap scans as described in Nmap Scan Automation, on page 156.
- Schedule automatic Nmap scans as described in Scheduling an Nmap Scan, on page 156.

What to do next

- Monitor the Nmap scan in progress by viewing the related task; see Viewing Task Messages, on page 261.
- Optionally, refine the scan:
  - Edit an Nmap scan instance as described in Editing an Nmap Scan Instance, on page 1247.
  - Edit an Nmap scan target as described in Editing an Nmap Scan Target, on page 1249.
  - Edit an Nmap remediation as described in Editing an Nmap Remediation, on page 1251.

Adding an Nmap Scan Instance

You can set up a separate scan instance for each Nmap module that you want to use to scan your network for vulnerabilities. You can set up scan instances for the local Nmap module on the Firepower Management Center and for any devices you want to use to run scans remotely. The results of each scan are always stored on the Firepower Management Center where you configure the scan, even if you run the scan from a remote
To prevent accidental or malicious scanning of mission-critical hosts, you can create a blacklist for the instance to indicate the hosts that should never be scanned with the instance.

You cannot add a scan instance with the same name as any existing scan instance.

In a multidomain deployment, the system displays scan instances created in the current domain, which you can edit. It also displays scan instances created in ancestor domains, which you cannot edit. To view and edit scan instances in a lower domain, switch to that domain.

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Access the list of Nmap scan instances using either of the following methods:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Choose <strong>Policies &gt; Actions &gt; Instances</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Choose <strong>Policies &gt; Actions &gt; Scanners</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2</th>
<th>Add the remediation:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If you accessed the list via the first method above, locate the Add a New Instance section, choose the Nmap Remediation module from the drop-down list, and click <strong>Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>• If you accessed the list via the second method above, click <strong>Add Nmap Instance</strong>.</td>
</tr>
</tbody>
</table>

| Step 3 | Enter an **Instance Name**. |

| Step 4 | Enter a **Description**. |

| Step 5 | Optionally, in the **Black Listed Scan hosts** field, specify any hosts or networks that should *never* be scanned with this scan instance, using the following syntax: |
|        | • For IPv6 hosts, an exact IP address (for example, 2001:DB8::fedd:eeff) |
|        | • For IPv4 hosts, an exact IP address (for example, 192.168.1.101) or an IP address block using CIDR notation (for example, 192.168.1.0/24 scans the 254 hosts between 192.168.1.1 and 192.168.1.254, inclusive) |
|        | • Note that you cannot use an exclamation mark (!) to negate an address value. |

**Note** If you specifically target a scan to a host that is in a blacklisted network, that scan will not run.

| Step 6 | Optionally, to run the scan from a remote device instead of the Firepower Management Center, specify the IP address or name of the device as it appears in the Information page for the device in the FMC web interface, in the **Remote Device Name** field. |

| Step 7 | Click **Create**. |
|        | When the system is done creating the instance, it displays it in edit mode. |

| Step 8 | Optionally, add an Nmap remediation to the instance. To do so, locate the Configured Remediations section of the instance, click **Add**, and create a remediation as described in Creating an Nmap Remediation, on page 1249. |

| Step 9 | Click **Cancel** to return to the list of instances. |

**Note** If you accessed the list of Nmap scan instances via the **Scanners** option, the system does not display the instance you added unless you also added a remediation to the instance. To view any instances to which you have not yet added remediations, use the **Instances** menu option to access the list.
Editing an Nmap Scan Instance

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

When you edit a scan instance, you can view, add, and delete remediations associated with the instance. Delete an Nmap scan instance when you no longer want to use the Nmap module profiled in the instance. Note that when you delete the scan instance, you also delete any remediations that use that instance.

In a multidomain deployment, the system displays scan instances created in the current domain, which you can edit. It also displays scan instances created in ancestor domains, which you cannot edit. To view and edit scan instances in a lower domain, switch to that domain.

**Procedure**

**Step 1**
Access the list of Nmap scan instances using either of the following methods:

- Choose *Policies > Actions > Instances*.
- Choose *Policies > Actions > Scanners*.

**Step 2**
Click the view icon (اظهار) next to the instance you want to edit.

**Step 3**
Make changes to the scan instance settings as described in *Adding an Nmap Scan Instance*, on page 1245.

**Step 4**
Click *Save*.

**Step 5**
Click *Done*.

**What to do next**

- Optionally, add a new remediation to the scan instance; see *Creating an Nmap Remediation*, on page 1249.
- Optionally, edit a remediation associated with the instance; see *Editing an Nmap Remediation*, on page 1251.
- Optionally, delete a remediation associated with the instance; see *Running an On-Demand Nmap Scan*, on page 1252.
- Optionally, delete the scan instance by clicking the delete icon (حذف) next to it.

Adding an Nmap Scan Target

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

When you configure an Nmap module, you can create and save scan targets that identify the hosts and ports you want to target when you perform an on-demand or a scheduled scan, so that you do not have to construct...
a new scan target every time. A scan target includes a single IP address or a block of IP addresses to scan, as well as the ports on the host or hosts. For Nmap targets, you can also use Nmap octet range addressing or IP address ranges. For more information on Nmap octet range addressing, refer to the Nmap documentation at http://insecure.org.

Note:

• Scans for scan targets containing a large number of hosts can take an extended period of time. As a workaround, scan fewer hosts at a time.

• Nmap-supplied server and operating system data remains static until you run another Nmap scan. If you plan to scan a host using Nmap, regularly schedule scans. If a host is deleted from the network map, any Nmap scan results are discarded.

• In a multidomain deployment, the system displays scan targets created in the current domain, which you can edit. It also displays scan targets created in ancestor domains, which you cannot edit. To view and edit scan targets in a lower domain, switch to that domain.

Procedure

Step 1  Choose Policies > Actions > Scanners.
Step 2  On the toolbar, click Targets.
Step 3  Click Create Scan Target.
Step 4  In the Name field, enter the name you want to use for this scan target.
Step 5  In the IP Range text box, specify the host or hosts you want to scan using the syntax described in Nmap Scanning Guidelines, on page 1241.

Note  If you use a comma in a list of IP addresses or ranges in a scan target, the comma converts to a space when you save the target.

Step 6  In the Ports field, specify the ports you want to scan.
You can enter any of the following, using values from 1 to 65535:

• a port number

• a list of ports separated by commas

• a range of port numbers separated by a dash

• ranges of port numbers separated by dashes, separated by commas

Step 7  Click Save.

Related Topics

Nmap Scan Automation, on page 156
Editing an Nmap Scan Target

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

You might want to edit a remediation’s dynamic scan target if you do not want to use the remediation to scan a specific IP address, but the IP address was added to the target because the host was involved in a correlation policy violation that launched the remediation.

Delete a scan target if you no longer want to scan the hosts listed in it.

In a multidomain deployment, the system displays scan targets created in the current domain, which you can edit. It also displays scan targets created in ancestor domains, which you cannot edit. To view and edit scan targets in a lower domain, switch to that domain.

Procedure

**Step 1** Choose **Policies > Actions > Scanners**.

**Step 2** On the toolbar, click **Targets**.

**Step 3** Click the edit icon (-pencil) next to the scan target you want to edit.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4** Make modifications as necessary. For more information, see Adding an Nmap Scan Target, on page 1247.

**Step 5** Click **Save**.

**Step 6** Optionally, delete the scan target by clicking the delete icon (-trash can) next to it.

Creating an Nmap Remediation

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

An Nmap remediation can only be created by adding it to an existing Nmap scan instance. The remediation defines the settings for the scan. It can be used as a response in a correlation policy, run on demand, or run as a scheduled task at a specific time.

Nmap-supplied server and operating system data remains static until you run another Nmap scan. If you plan to scan a host using Nmap, regularly schedule scans. If a host is deleted from the network map, any Nmap scan results are discarded.

For general information about Nmap functionality, refer to the Nmap documentation at [http://insecure.org](http://insecure.org).
In a multidomain deployment, the system displays Nmap remediations created in the current domain, which you can edit. It also displays Nmap remediations created in ancestor domains, which you cannot edit. To view and edit Nmap remediations in a lower domain, switch to that domain.

**Before you begin**

- Add an Nmap scan instance as described in *Adding an Nmap Scan Instance*, on page 1245.

**Procedure**

**Step 1**  
Choose **Policies > Actions > Instances**.

**Step 2**  
Click the view icon ( ) next to the instance to which you want to add the remediation.

**Step 3**  
In the Configured Remediations section, click **Add**.

**Step 4**  
Enter a **Remediation Name**.

**Step 5**  
Enter a **Description**.

**Step 6**  
If you plan to use this remediation in response to a correlation rule that triggers on an intrusion event, a connection event, or a user event, configure the **Scan Which Address(es) From Event?** option.

**Tip**  
If you plan to use this remediation in response to a correlation rule that triggers on a discovery event or a host input event, by default the remediation scans the IP address of the host involved in the event; you do not need to configure this option.

**Note**  
Do not assign an Nmap remediation as a response to a correlation rule that triggers on a traffic profile change.

**Step 7**  
Configure the **Scan Type** option.

**Step 8**  
Optionally, to scan UDP ports in addition to TCP ports, choose **On** for the **Scan for UDP ports** option.

**Tip**  
A UDP portscan takes more time than a TCP portscan. To speed up your scans, leave this option disabled.

**Step 9**  
If you plan to use this remediation in response to correlation policy violations, configure the **Use Port From Event** option.

**Step 10**  
If you plan to use this remediation in response to correlation policy violations and want to run the scan using the appliance running the detection engine that detected the event, configure the **Scan from reporting detection engine** option.

**Step 11**  
Configure the **Fast Port Scan** option.

**Step 12**  
In the **Port Ranges and Scan Order** field, enter the ports you want to scan by default, using Nmap port specification syntax, in the order you want to scan those ports.

Use the following format:

- Specify values from 1 to 65535.
- Separate ports using commas or spaces.
- Use a hyphen to indicate a port range.
- When scanning for both TCP and UDP ports, preface the list of TCP ports you want to scan with a T and the list of UDP ports with a U.
The Use Port From Event option overrides this setting when the remediation is launched in response to a correlation policy violation, as described in step 8.

**Example:**
To scan ports 53 and 111 for UDP traffic, then scan ports 21-25 for TCP traffic, enter `U:53,111,T:21-25`.

**Step 13**
To probe open ports for server vendor and version information, configure **Probe open ports for vendor and version information**.

**Step 14**
If you choose to probe open ports, set the number of probes used by choosing a number from the **Service Version Intensity** drop-down list.

**Step 15**
To scan for operating system information, configure **Detect Operating System** settings.

**Step 16**
To determine whether host discovery occurs and whether port scans are only run against available hosts, configure **Treat All Hosts As Online**.

**Step 17**
To set the method you want Nmap to use when it tests for host availability, choose a method from the **Host Discovery Method** drop-down list.

**Step 18**
If you want to scan a custom list of ports during host discovery, enter a list of ports appropriate for the host discovery method you chose, separated by commas, in the **Host Discovery Port List** field.

**Step 19**
Configure the **Default NSE Scripts** option to control whether to use the default set of Nmap scripts for host discovery and server, operating system, and vulnerability discovery.

**Tip**
See [http://nmap.org/nsedoc/categories/default.html](http://nmap.org/nsedoc/categories/default.html) for the list of default scripts.

**Step 20**
To set the timing of the scan process, choose a timing template number from the **Timing Template** drop-down list.

Choose a higher number for a faster, less comprehensive scan and a lower number for a slower, more comprehensive scan.

**Step 21**
Click **Create**.
When the system is done creating the remediation, it displays it in edit mode.

**Step 22**
Click **Done** to return to the related instance.

**Step 23**
Click **Cancel** to return to the instance list.

---

**Related Topics**
- [Nmap Scan Automation](#), on page 156
- [Nmap Remediation Options](#), on page 1234

---

**Editing an Nmap Remediation**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Modifications you make to Nmap remediations do not affect scans in progress. The new settings take effect when the next scan starts. Delete an Nmap remediation if you no longer need it.

In a multidomain deployment, the system displays Nmap remediations created in the current domain, which you can edit. It also displays Nmap remediations created in ancestor domains, which you cannot edit. To view and edit Nmap remediations in a lower domain, switch to that domain.
Procedure

Step 1  Access the list of Nmap scan instances using either of the following methods:
- Choose **Policies > Actions > Instances**.
- Choose **Policies > Actions > Scanners**.

Step 2  Access the remediation you want to edit:
- If you accessed the list via the first method above, click the view icon (🔍) next to the relevant instance, and then click it again next to the remediation you want to edit in the Configured Remediations section.
- If you accessed the list via the second method above, click the view icon (🔍) next to the remediation you want to edit.

Step 3  Make modifications as necessary as described in **Creating an Nmap Remediation, on page 1249**.

Step 4  Click **Save** if you want to save your changes, or **Done** if you want to exit without saving.

Step 5  Optionally, delete the remediation by clicking the delete icon (🗑️) next to it.

---

Running an On-Demand Nmap Scan

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

You can launch on-demand Nmap scans whenever needed. You can specify the target for an on-demand scan by entering the IP addresses and ports you want to scan or by choosing an existing scan target.

Nmap-supplied server and operating system data remains static until you run another Nmap scan. If you plan to scan a host using Nmap, regularly schedule scans. If a host is deleted from the network map, any Nmap scan results are discarded.

**Before you begin**
- Optionally, add an Nmap scan target; see **Adding an Nmap Scan Target, on page 1247**.

Procedure

Step 1  Choose **Policies > Actions > Scanners**.

Step 2  Next to the Nmap remediation you want to use to perform the scan, click the scan icon (跑去).

Step 3  Optionally, to scan using a saved scan target, choose a target from the **Saved Targets** drop-down list, and click **Load**.

**Note**
To add a scan target, you can click the edit icon ( Modi) at the top of the dialog.

Step 4  In the **IP Range(s)** field, specify the IP address for hosts you want to scan or modify the loaded list.
Note:

- For hosts with IPv4 addresses, you can specify multiple IP addresses separated by commas or use CIDR notation. You can also negate IP addresses by preceding them with an exclamation point (!).
- For hosts with IPv6 addresses, use an exact IP address. Ranges are not supported.

**Step 5**

In the **Ports** field, specify the ports you want to scan or modify the loaded list.

You can enter a port number, a list of ports separated by commas, or a range of port numbers separated by a dash.

**Step 6**

In a multidomain deployment, use the **Domain** field to specify the leaf domain where you want to perform the scan.

**Step 7**

Click **Scan Now**.

---

**What to do next**

- Optionally, monitor the task status; see **Viewing Task Messages**, on page 261.

**Related Topics**

- **Nmap Scan Automation**, on page 156
- **Firepower System IPAddress Conventions**, on page 14
- **Ports in Searches**, on page 1557

---

**Nmap Scan Results**

You can monitor Nmap scans in progress, import results from scans previously performed through the Firepower System or results performed outside the Firepower System, and view and analyze scan results.

You can view scan results that you create using the local Nmap module as a rendered page in a pop-up window. You can also download the Nmap results file in raw XML format.

You can also view operating system and server information detected by Nmap in host profiles and in the network map. If a scan of a host produces server information for servers on filtered or closed ports, or if a scan collects information that cannot be included in the operating system information or the servers section, the host profile includes those results in an Nmap Scan Results section.

**Viewing Nmap Scan Results**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

When an Nmap scan is complete, you can view a table of scan results.

You can manipulate the results view depending on the information you are looking for. The page you see when you access scan results differs depending on the workflow you use. You can use the predefined workflow, which includes a table view of scan results. You can also create a custom workflow that displays only the information that matches your specific needs.
In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

You can download and view the Nmap results using the Nmap Version 1.01 DTD, available at http://insecure.org.

You can also clear scan results.

**Procedure**

**Step 1** Choose Policies > Actions > Scanners.

**Step 2** On the toolbar, click Scan Results.

**Step 3** You have the following choices:

- Adjust the time range as described in Event Time Constraints, on page 1540.
- To use a different workflow, including a custom workflow, click (switch workflows) by the workflow title.
- To view the scan results as a rendered page in a pop-up window, click View next to the scan job.
- To save a copy of the scan results file so that you can view the raw XML code in any text editor, click Download next to the scan job.
- To sort scan results, click the column title. Click the column title again to reverse the sort order.
- To constrain the columns that appear, click the close icon ( X ) in the column heading that you want to hide. In the pop-up window that appears, click Apply.

**Tip** To hide or show other columns, check or clear the appropriate check boxes before you click Apply. To add a disabled column back to the view, click the expand arrow to expand the search constraints, then click the column name under Disabled Columns.

- To drill down to the next page in the workflow, see Using Drill-Down Pages, on page 1531.
- To configure scan instances and remediations, click Scanners in the toolbar and see Managing Nmap Scanning, on page 1245.
- To navigate within and between workflow pages, see Workflow Page Navigation Tools, on page 1528.
- To navigate to other event views to view associated events, choose the name of the event view you want to see from the Jump to drop-down list.
- To search for scan results, enter your search criteria in the appropriate fields.

**Related Topics**

Nmap Scan Results Fields, on page 1254

**Nmap Scan Results Fields**

When you run an Nmap scan, the Firepower Management Center collects the scan results in a database. The following table describes the fields in the scan results table that can be viewed and searched.

**Table 193: Scan Results Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Time</td>
<td>The date and time that the scan that produced the results started.</td>
</tr>
</tbody>
</table>
### Importing Nmap Scan Results

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Time</td>
<td>The date and time that the scan that produced the results ended.</td>
</tr>
<tr>
<td>Target</td>
<td>The IP address (or host name, if DNS resolution is enabled) of the scan target for the scan that produced the results.</td>
</tr>
<tr>
<td>Scan Type</td>
<td>Either Nmap or the name of the third-party scanner to indicate the type of the scan that produced the results.</td>
</tr>
<tr>
<td>Scan Mode</td>
<td>The mode of the scan that produced the results:</td>
</tr>
<tr>
<td></td>
<td>• On Demand — results from scans run on demand.</td>
</tr>
<tr>
<td></td>
<td>• Imported — results from scans on a different system and imported onto the Firepower Management Center.</td>
</tr>
<tr>
<td></td>
<td>• Scheduled — results from scans run as a scheduled task.</td>
</tr>
<tr>
<td>Results</td>
<td>The results of the scan.</td>
</tr>
<tr>
<td>Domain</td>
<td>The domain of the scan target. This field is only present in a multidomain deployment.</td>
</tr>
</tbody>
</table>

#### Related Topics

Event Searches, on page 1553

#### Importing Nmap Scan Results

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

You can import XML results files created by an Nmap scan performed outside of the Firepower System. You can also import XML results files that you previously downloaded from the Firepower System. To import Nmap scan results, the results file must be in XML format and adhere to the Nmap Version 1.01 DTD. For more information on creating Nmap results and on the Nmap DTD, refer to the Nmap documentation at [http://insecure.org](http://insecure.org).

A host must already exist in the network map before Nmap can append its results to the host profile.

#### Procedure

**Step 1** Choose Policies > Actions > Scanners.

**Step 2** On the toolbar, click Import Results.

**Step 3** In a multidomain deployment, choose a leaf domain from the Domain drop-down list to specify where you want to store the imported results.

**Step 4** Click Browse to navigate to the results file.

**Step 5** After you return to the Import Results page, click Import to import the results.
Overview: Application Detection

When the Firepower System analyzes IP traffic, it attempts to identify the commonly used applications on your network. Application awareness is crucial to application control.

There are three types of applications that the system detects:

- application protocols such as HTTP and SSH, which represent communications between hosts
- clients such as web browsers and email clients, which represent software running on the host
- web applications such as MPEG video and Facebook, which represent the content or requested URL for HTTP traffic

The system identifies applications in your network traffic according to the characteristics specified in the detector. For example, the system can identify an application by an ASCII pattern in the packet header. In addition, Secure Socket Layers (SSL) protocol detectors use information from the secured session to identify the application from the session.

There are two sources of application detectors in the Firepower System:

- System-provided detectors detect web applications, clients, and application protocols.

The availability of system-provided detectors for applications (and operating systems) depends on the version of the Firepower System and the version of the VDB you have installed. Release notes and advisories contain information on new and updated detectors. You can also import individual detectors authored by Professional Services.
• Custom application protocol detectors are user-created and detect web applications, clients, and application protocols.

You can also detect application protocols through implied application protocol detection, which infers the existence of an application protocol based on the detection of a client.

The system identifies only those application protocols running on hosts in your monitored networks, as defined in the network discovery policy. For example, if an internal host accesses an FTP server on a remote site that you are not monitoring, the system does not identify the application protocol as FTP. On the other hand, if a remote or internal host accesses an FTP server on a host you are monitoring, the system can positively identify the application protocol.

If the system can identify the client used by a monitored host to connect to a non-monitored server, the system identifies the client's corresponding application protocol, but does not add the protocol to the network map. Note that client sessions must include a response from the server for application detection to occur.

The system characterizes each application that it detects; see Application Characteristics, on page 301. The system uses these characteristics to create groups of applications, called application filters. Application filters are used to perform access control and to constrain search results and data used in reports and dashboard widgets.

You can also supplement application detector data using exported NetFlow records, Nmap active scans, and the host input feature.

Related Topics

Recommendations for Application Control, on page 641
Application Detector Fundamentals, on page 1258

Application Detector Fundamentals

The Firepower System uses application detectors to identify the commonly used applications on your network. Use the Detectors page (Policies > Application Detectors) to view the detector list and customize detection capability.

Whether you can modify a detector or change its state (active or inactive) depends on its type. The system uses only active detectors to analyze application traffic.

Note

Cisco-provided detectors may change with Firepower System and VDB updates. See the release notes and advisories for information on updated detectors.

Cisco-Provided Internal Detectors

Internal detectors are a special category of detectors for client, web application, and application protocol traffic. Internal detectors are delivered with system updates and are always on.

If an application matches against internal detectors designed to detect client-related activity and no specific client detector exists, a generic client may be reported.
Cisco-Provided Client Detectors

*Client detectors* detect client traffic and are delivered via VDB or system update, or are provided for import by Cisco Professional Services. You can activate and deactivate client detectors. You can export a client detector only if you import it.

Cisco-Provided Web Application Detectors

*Web application detectors* detect web applications in HTTP traffic payloads and are delivered via VDB or system update. Web application detectors are always on.

Cisco-Provided Application Protocol (Port) Detectors

*Port-based application protocol detectors* use well-known ports to identify network traffic. They are delivered via VDB or system update, or are provided for import by Cisco Professional Services. You can activate and deactivate application protocol detectors, and view a detector definition to use it as the basis for a custom detector.

Cisco-Provided Application Protocol (Firepower) Detectors

*Firepower-based application protocol detectors* analyze network traffic using Firepower application fingerprints and are delivered via VDB or system update. You can activate and deactivate application protocol detectors.

Custom Application Detectors

*Custom application detectors* are pattern-based. They detect patterns in packets from client, web application, or application protocol traffic. You have full control over imported and custom detectors.

Identification of Application Protocols in the Web Interface

The following table outlines how the Firepower System identifies detected application protocols:

**Table 194: Firepower System Identification of Application Protocols**

<table>
<thead>
<tr>
<th>Identification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>application protocol name</td>
<td>The Firepower Management Center identifies an application protocol with its name if the application protocol was:</td>
</tr>
<tr>
<td></td>
<td>• positively identified by the system</td>
</tr>
<tr>
<td></td>
<td>• identified using NetFlow data and there is a port-application protocol correlation in <code>/etc/sf/services</code></td>
</tr>
<tr>
<td></td>
<td>• manually identified using the host input feature</td>
</tr>
<tr>
<td></td>
<td>• identified by Nmap or another active source</td>
</tr>
</tbody>
</table>
The Firepower Management Center identifies an application protocol as **pending** if the system can neither positively nor negatively identify the application.

Most often, the system needs to collect and analyze more connection data before it can identify a pending application.

In the Application Details and Servers tables and in the host profile, the pending status appears only for application protocols where specific application protocol traffic was detected (rather than inferred from detected client or web application traffic).

The Firepower Management Center identifies an application protocol as **unknown** if:

- the application does not match any of the system’s detectors
- the application protocol was identified using NetFlow data, but there is no port-application protocol correlation in `/etc/sf/services`

All available detected data has been examined, but no application protocol was identified. In the Application Details and Servers tables and in the host profile, the application protocol is left blank for non-HTTP generic client traffic with no detected application protocol.

---

**Implied Application Protocol Detection from Client Detection**

If the system can identify the client used by a monitored host to access a non-monitored server, the Firepower Management Center infers that the connection is using the application protocol that corresponds with the client. (Because the system tracks applications only on monitored networks, connection logs usually do not include application protocol information for connections where a monitored host is accessing a non-monitored server.)

This process, or implied application protocol detection, has the following consequences:

- Because the system does not generate a New TCP Port or New UDP Port event for these servers, the server does not appear in the Servers table. In addition, you cannot trigger either discovery event alerts or correlation rules using the detection of these application protocol as a criterion.

- Because the application protocol is not associated with a host, you cannot view its details in host profiles, set its server identity, or use its information in host profile qualifications for traffic profiles or correlation rules. In addition, the system does not associate vulnerabilities with hosts based on this type of detection.

You can, however, trigger correlation events on whether the application protocol information is present in a connection. You can also use the application protocol information in connection logs to create connection trackers and traffic profiles.
Host Limits and Discovery Event Logging

When the system detects a client, server, or web application, it generates a discovery event unless the associated host has already reached its maximum number of clients, servers, or web applications.

Host profiles display up to 16 clients, 100 servers, and 100 web applications per host.

Note that actions dependent on the detection of clients, servers, or web applications are unaffected by this limit. For example, access control rules configured to trigger on a server will still log connection events.

Special Considerations for Application Detection

Squid

The system positively identifies Squid server traffic when either:

- the system detects a connection from a host on your monitored network to a Squid server where proxy authentication is enabled, or
- the system detects a connection from a Squid proxy server on your monitored network to a target system (that is, the destination server where the client is requesting information or another resource).

However, the system cannot identify Squid service traffic if:

- a host on your monitored network connects to a Squid server where proxy authentication is disabled, or
- the Squid proxy server is configured to strip Via: header fields from its HTTP responses

SSL Application Detection

The system provides application detectors that can use session information from a Secure Socket Layers (SSL) session to identify the application protocol, client application, or web application in the session.

When the system detects an encrypted connection, it marks that connection as either a generic HTTPS connection or as a more specific secure protocol, such as SMTPS, when applicable. When the system detects an SSL session, it adds SSL client to the Client field in connection events for the session. If it identifies a web application for the session, the system generates discovery events for the traffic.

For SSL application traffic, managed devices can also detect the common name from the server certificate and match that against a client or web application from an SSL host pattern. When the system identifies a specific client, it replaces SSL client with the name of the client.

Because the SSL application traffic is encrypted, the system can use only information in the certificate for identification, not application data within the encrypted stream. For this reason, SSL host patterns can sometimes only identify the company that authored the application, so SSL applications produced by the same company may have the same identification.

In some instances, such as when an HTTPS session is launched from within an HTTP session, managed devices detect the server name from the client certificate in a client-side packet.

To enable SSL application identification, you must create access control rules that monitor responder traffic. Those rules must have either an application condition for the SSL application or URL conditions using the URL from the SSL certificate. For network discovery, the responder IP address does not have to be in the networks to monitor in the network discovery policy; the access control policy configuration determines
whether the traffic is identified. To identify detections for SSL applications, you can filter by the SSL protocol tag, in the application detectors list or when adding application conditions in access control rules.

**Referred Web Applications**

Web servers sometimes refer traffic to other websites, which are often advertisement servers. To help you better understand the context for referred traffic occurring on your network, the system lists the web application that referred the traffic in the **Web Application** field in events for the referred session. The VDB contains a list of known referred sites. When the system detects traffic from one of those sites, the referring site is stored with the event for that traffic. For example, if an advertisement accessed via Facebook is actually hosted on Advertising.com, the detected Advertising.com traffic is associated with the Facebook web application. The system can also detect referring URLs in HTTP traffic, such as when a website provides a simple link to another site; in this case, the referring URL appears in the HTTP Referrer event field.

In events, if a referring application exists, it is listed as the web application for the traffic, while the URL is that for the referred site. In the example above, the web application for the connection event for that traffic would be Facebook, but the URL would be Advertising.com. A referred application may appear as the web application if no referring web application is detected, if the host refers to itself, or if there is a chain of referrals. In the dashboard, connection and byte counts for web applications include sessions where the web application is associated with traffic referred by that application.

Note that if you create a rule to act specifically on referred traffic, you should add a condition for the referred application, rather than the referring application. To block Advertising.com traffic referred from Facebook, for example, add an application condition to your access control rule for the Advertising.com application.

**Custom Application Detectors**

If you use a custom application on your network, you can create a custom web application, client, or application protocol detector that provides the system with the information it needs to identify the application. The type of application detector is determined by your selections in the **Protocol**, **Type**, and **Direction** fields.

Client sessions must include a responder packet from the server for the system to begin detecting and identifying application protocols in server traffic. Note that, for UDP traffic, the system designates the source of the responder packet as the server.

If you have already created a detector on another Firepower Management Center, you can export it and then import it onto this Firepower Management Center. You can then edit the imported detector to suit your needs. You can export and import custom detectors as well as detectors provided by Cisco Professional Services. However, you cannot export or import any other type of Cisco-provided detectors.

**Custom Application Detector and User-Defined Application Fields**

You can use the following fields to configure custom application detectors and user-defined applications.

**Custom Application Detector Fields: General**

Use the following fields to configure basic and advanced custom application detectors.

**Application Protocol**

The application protocol you want to detect. This can be a system-provided application or a user-defined application.
If you want the application to be available for exemption from active authentication (configured in your identity rules), you must select or create an application protocol with the **User-Agent Exclusion** tag.

**Description**

A description for the application detector.

**Name**

A name for the application detector.

**Detector Type**

The type of detector, **Basic** or **Advanced**. Basic application detectors are created in the web interface as a series of fields. Advanced application detectors are created externally and uploaded as custom .lua files.

**Custom Application Detector Fields: Detection Patterns**

Use the following fields to configure the detection patterns for basic custom application detectors.

**Direction**

The source of the traffic the detector should inspect, **Client** or **Server**.

**Offset**

The location in a packet, in bytes from the beginning of the packet payload, where the system should begin searching for the pattern.

Because packet payloads start at byte 0, calculate the offset by subtracting 1 from the number of bytes you want to move forward from the beginning of the packet payload. For example, to look for the pattern in the fifth bit of the packet, type 4 in the **Offset** field.

**Pattern**

The pattern string associated with the **Type** you selected.

**Ports**

The port of the traffic the detector should inspect.

**Protocol**

The protocol you want to detect. Your protocol selection determines whether the **Type** or the **URL** field displays.

The protocol (and, in some cases, your subsequent selections in the **Type** and **Direction** fields) determine the type of application detector you create: web application, client, or application protocol.

<table>
<thead>
<tr>
<th>Detector Type</th>
<th>Protocol</th>
<th>Type or Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Application</td>
<td>HTTP</td>
<td><strong>Type</strong> is <strong>Content Type</strong> or <strong>URL</strong></td>
</tr>
<tr>
<td></td>
<td>RTMP</td>
<td>Any</td>
</tr>
<tr>
<td></td>
<td>SSL</td>
<td>Any</td>
</tr>
</tbody>
</table>
## Discovery and Identity

### Custom Application Detector and User-Defined Application Fields

<table>
<thead>
<tr>
<th>Detector Type</th>
<th>Protocol</th>
<th>Type or Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>HTTP</td>
<td>Type is User Agent</td>
</tr>
<tr>
<td></td>
<td>SIP</td>
<td>Any</td>
</tr>
<tr>
<td></td>
<td>TCP or UDP</td>
<td>Direction is Client</td>
</tr>
<tr>
<td>Application Protocol</td>
<td>TCP or UDP</td>
<td>Direction is Server</td>
</tr>
</tbody>
</table>

### Type

The type of pattern string you entered. The options you see are determined by the Protocol you selected. If you selected RTMP as the protocol, the URL field displays instead of the Type field.

### Note

If you select User Agent as the Type, the system automatically sets the Tag for the application to User-Agent Exclusion.

<table>
<thead>
<tr>
<th>Type Selection</th>
<th>String Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ascii</td>
<td>The string is ASCII encoded.</td>
</tr>
<tr>
<td>Common Name</td>
<td>The string is the value in the commonName field within the server response message.</td>
</tr>
<tr>
<td>Content Type</td>
<td>The string is the value in the content-type field within the server response header.</td>
</tr>
<tr>
<td>Hex</td>
<td>The string is in hexadecimal notation.</td>
</tr>
<tr>
<td>Organizational Unit</td>
<td>The string is the value in the organizationName field within the server response message.</td>
</tr>
<tr>
<td>SIP Server</td>
<td>The string is the value in the From field within the message header.</td>
</tr>
<tr>
<td>SSL Host</td>
<td>The string is the value in the server_name field within the ClientHello message.</td>
</tr>
<tr>
<td>URL</td>
<td>The string is a URL. The detector assumes that the string you enter is a complete section of the URL. For example, entering cisco.com would match <a href="http://www.cisco.com/support">www.cisco.com/support</a> and <a href="http://www.cisco.com">www.cisco.com</a>, but not <a href="http://www.wearecisco.com">www.wearecisco.com</a>.</td>
</tr>
<tr>
<td>User Agent</td>
<td>The string is the value in the user-agent field within the GET request header. It is also available for the SIP protocol and indicates that the string is the value in the User-Agent field within the SIP message header.</td>
</tr>
</tbody>
</table>
URL

Either a full URL or a section of a URL from the swfURL field within the C2 message of a RTMP packet. This field displays instead of the Type field when you select RTMP as the Protocol.

Note

The detector assumes that the string you enter is a complete section of the URL. For example, entering cisco.com would match www.cisco.com/support and www.cisco.com, but not www.wearecisco.com.

User-Defined Application Fields

Use the following fields to configure user-defined applications within basic and advanced custom application detectors.

Business Relevance

The likelihood that the application is used within the context of your organization’s business operations, as opposed to recreationally: Very High, High, Medium, Low, or Very Low. Select the option that best describes the application.

Categories

A general classification for the application that describes its most essential function.

Description

A description for the application.

Name

A name for the application.

Risk

The likelihood that the application is used for purposes that might be against your organization’s security policy: Very High, High, Medium, Low, or Very Low. Select the option that best describes the application.

Tags

One or more predefined tags that provide additional information about the application. If you want an application to be available for exemption from active authentication (configured in your identity rules), you must add the User-Agent Exclusion tag to your application.

Configuring Custom Application Detectors

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

You can configure basic or advanced custom application detectors.
Procedure

Step 1 Select Policies > Application Detectors.
Step 2 Click Create Custom Detector.
Step 3 Enter a Name and a Description.
Step 4 Select an Application Protocol. You have the following options:
   • If you are creating a detector for an existing application protocol (for example, if you want to detect a particular application protocol on a non-standard port), select the application protocol from the drop-down list.
   • If you are creating a detector for a user-defined application, follow the procedure outlined in Creating a User-Defined Application, on page 1267.
Step 5 Select a Detector Type.
Step 6 Click OK.
Step 7 Configure Detection Patterns or Detection Criteria:
   • If you are configuring a basic detector, specify preset Detection Patterns as described in Specifying Detection Patterns in Basic Detectors, on page 1267.
   • If you are configuring an advanced detector, specify custom Detection Criteria as described in Specifying Detection Criteria in Advanced Detectors, on page 1268.
   Caution Advanced custom detectors are complex and require outside knowledge to construct valid .lua files. Incorrectly configured detectors could have a negative impact on performance or detection capability.
Step 8 If you are configuring an advanced detector, use Packet Captures to test the new detector as described in Testing a Custom Application Protocol Detector, on page 1270. If you are configuring a basic detector, this step is optional.
Step 9 Click Save.

Note If you include the application in an access control rule, the detector is automatically activated and cannot be deactivated while in use.

What to do next
• Activate the detector as described in Activating and Deactivating Detectors, on page 1273.

Related Topics
Custom Application Detector and User-Defined Application Fields, on page 1262
Creating a User-Defined Application

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Applications, categories, and tags created here are available in access control rules and in the application filter object manager as well.

Before you begin

• Begin configuring your custom application protocol detector as described in Configuring Custom Application Detectors, on page 1265.

Procedure

**Step 1** On the Create Detector page, click Add.

**Step 2** Type a Name.

**Step 3** Type a Description.

**Step 4** Select a Business Relevance.

**Step 5** Select a Risk.

**Step 6** Click Add next to Categories to add a category and type a new category name, or select an existing category from the Categories drop-down list.

**Step 7** Optionally, click Add next to Tags to add a tag and type a new tag name, or select an existing tag from the Tags drop-down list.

**Step 8** Click OK.

What to do next

• Continue configuring your custom application protocol detector as described in Configuring Custom Application Detectors, on page 1265. You must save and activate the detector before the system can use it to analyze traffic.

Related Topics

Custom Application Detector and User-Defined Application Fields, on page 1262

Specifying Detection Patterns in Basic Detectors

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

You can configure a custom application protocol detector to search application protocol packet headers for a particular pattern string. You can also configure detectors to search for multiple patterns; in that case the
application protocol traffic must match all of the patterns for the detector to positively identify the application protocol.

Application protocol detectors can search for ASCII or hexadecimal patterns, using any offset.

**Before you begin**

- Begin configuring your custom application protocol detector as described in Configuring Custom Application Detectors, on page 1265.

**Procedure**

**Step 1**
On the Create Detector page, in the Detection Patterns section, click Add.

**Step 2**
Select a Protocol for traffic the detector should inspect.

**Step 3**
Specify the pattern Type you want to detect.

**Step 4**
Type a Pattern String that matches the Type you specified.

**Step 5**
Optionally, type the Offset (in bytes).

**Step 6**
Optionally, to identify application protocol traffic based on the port it uses, type a port from 1 to 65535 in the Port(s) field. To use multiple ports, separate them by commas.

**Step 7**
Optionally, select a Direction: Client or Server.

**Step 8**
Click OK.

**Tip**
If you want to delete a pattern, click the delete icon ( ) next to the pattern you want to delete.

**What to do next**

- Continue configuring your custom application protocol detector as described in Configuring Custom Application Detectors, on page 1265. You must save and activate the detector before the system can use it to analyze traffic.

**Related Topics**

Specifying Detection Criteria in Advanced Detectors, on page 1268

**Specifying Detection Criteria in Advanced Detectors**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin&lt;br&gt;Admin</td>
</tr>
</tbody>
</table>

**Caution**

Advanced custom detectors are complex and require outside knowledge to construct valid .lua files. Incorrectly configured detectors could have a negative impact on performance or detection capability.
Caution

Do not upload .lua files from untrusted sources.

Custom .lua files contain your custom application detector settings. Creating custom .lua files requires advanced knowledge of the lua programming language and experience with Cisco's C-lua API. Cisco strongly recommends you use the following to prepare .lua files:

• third-party instruction and reference material for the lua programming language

• The Open Source Detectors Developers Guide: https://www.snort.org/downloads

• OpenAppID Snort community resources: http://blog.snort.org/search/label/openappid

Note

The system does not support .lua files that reference system calls or file I/O.

Before you begin

• Begin configuring your custom application protocol detector as described in Configuring Custom Application Detectors, on page 1265.

• Prepare to create a valid .lua file by downloading and studying the .lua files for comparable detectors. For more information about downloading detector files, see Viewing or Downloading Detector Details, on page 1270.

• Create a valid .lua file that contains your custom application detector settings.

Procedure

Step 1
On the Create Detector page for an advanced custom application detector, in the Detection Criteria section, click Add.

Step 2
Click Browse... to navigate to the .lua file and upload it.

Step 3
Click OK.

What to do next

• Continue configuring your custom application protocol detector as described in Configuring Custom Application Detectors, on page 1265. You must save and activate the detector before the system can use it to analyze traffic.

Related Topics

Specifying Detection Patterns in Basic Detectors, on page 1267
Testing a Custom Application Protocol Detector

If you have a packet capture (pcap) file that contains packets with traffic from the application protocol you want to detect, you can test a custom application protocol detector against that pcap file. Cisco recommends using a simple, clean pcap file without unnecessary traffic.

Pcap files must be 256 KB or smaller; if you try to test your detector against a larger pcap file, the Firepower Management Center automatically truncates it and tests the incomplete file. You must fix the unresolved checksums in a pcap before using the file to test a detector.

### Before you begin

- Configure your custom application protocol detector as described in Configuring Custom Application Detectors, on page 1265.

### Procedure

1. **Step 1** On the Create Detector page, in the Packet Captures section, click **Add**.
2. **Step 2** Browse to the pcap file in the pop-up window and click **OK**.
3. **Step 3** To test your detector against the contents of the pcap file, click the evaluate icon next to the pcap file. A message indicates whether the test succeeded.
4. **Step 4** Optionally, repeat steps 1 to 3 to test the detector against additional pcap files.

**Tip** To delete a pcap file, click the delete icon (🗑️) next to the file you want to delete.

### What to do next

- Continue configuring your custom application protocol detector as described in Configuring Custom Application Detectors, on page 1265. You must save and activate the detector before the system can use it to analyze traffic.

### Viewing or Downloading Detector Details

You can use the detectors list to view application detector details (all detectors) and download detector details (custom application detectors only).
Procedure

Step 1
To view application detector details, do one of the following:

- See the Cisco Firepower Application Detector Reference for the relevant VDB version at
- Select Policies > Application Detectors.
  a. Filter the list to find a particular detector.
  b. Click the information icon (i)

Step 2
To download detector details for a custom application detector, click the download icon ( ).
If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have the necessary permissions.

Sorting the Detector List

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

By default, the Detectors page lists detectors alphabetically by name. An up or down arrow next to a column heading indicates that the page is sorted by that column in that direction.

Procedure

Step 1
Select Policies > Application Detectors.

Step 2
Click the appropriate column heading.

Filtering the Detector List

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>
Procedure

Step 1  Select Policies > Application Detectors.
Step 2  Expand one of the filter groups described in Filter Groups for the Detector List, on page 1272 and select the check box next to a filter. To select all filters in a group, right-click the group name and select Check All.
Step 3  If you want to remove a filter, click the remove icon (×) in the name of the filter in the Filters field or disable the filter in the filter list. To remove all filters in a group, right-click the group name and select Uncheck All.
Step 4  If you want to remove all filters, click Clear all next to the list of filters applied to the detectors.

Filter Groups for the Detector List

You can use several filter groups, separately or in combination, to filter the list of detectors.

Name
Finds detectors with names or descriptions containing the string you type. Strings can contain any alphanumeric or special character.

Custom Filter
Finds detectors matching a custom application filter created on the object management page.

Author
Finds detectors according to who created the detector. You can filter detectors by:
- any individual user who has created or imported a custom detector
- Cisco, which represents all Cisco-provided detectors except individually imported add-on detectors (you are the author for any detector that you import)
- Any User, which represents all detectors not provided by Cisco

State
Finds detectors according to their state, that is, Active or Inactive.

Type
Finds detectors according to the detector type, as described in Application Detector Fundamentals, on page 1258.

Protocol
Finds detectors according to which traffic protocol the detector inspects.

Category
Finds detectors according to the categories assigned to the application they detect.
Tag
Finds detectors according to the tags assigned to the application they detect.

Risk
Finds detectors according to the risks assigned to the application they detect: Very High, High, Medium, Low, and Very Low.

Business Relevance
Finds detectors according to the business relevance assigned to the application they detect: Very High, High, Medium, Low, and Very Low.

Navigating to Other Detector Pages

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  Select Policies > Application Detectors.
Step 2  If you want to view the next page, click the right arrow icon ( → ).
Step 3  If you want to view the previous page, click the left arrow icon ( ← ).
Step 4  If you want to view a different page, type the page number and press Enter.
Step 5  If you want to jump to the last page, click the right end arrow icon ( ↑ ).
Step 6  If you want to jump to the first page, click the left end arrow icon ( ↓ ).

Activating and Deactivating Detectors

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You must activate a detector before you can use it to analyze network traffic. By default, all Cisco-provided detectors are activated.

You can activate multiple application detectors for each port to supplement the system’s detection capability.

When you include an application in an access control rule in a policy and that policy is deployed, if there is no active detector for that application, one or more detectors automatically activate. Similarly, while an
application is in use in a deployed policy, you cannot deactivate a detector if deactivating leaves no active detectors for that application.

Tip
For improved performance, deactivate any application protocol, client, or web application detectors you do not intend to use.

Procedure

Step 1
Select Policies > Application Detectors.

Step 2
Click the slider next to the detector you want to activate or deactivate. If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Note
Some application detectors are required by other detectors. If you deactivate one of these detectors, a warning appears to indicate that the detectors that depend on it are also disabled.

Editing Custom Application Detectors

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Use the following procedure to modify custom application detectors.

Procedure

Step 1
Select Policies > Application Detectors.

Step 2
Click the edit icon (宽阔) next to the detector you want to modify. If a view icon (拓宽) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3
Make changes to the detector as described in Configuring Custom Application Detectors, on page 1265.

Step 4
You have the following saving options, depending on the state of the detector:

- To save an inactive detector, click Save.
- To save an inactive detector as a new, inactive detector, click Save as New.
- To save an active detector and immediately start using it, click Save and Reactivate.
- To save an active detector as a new, inactive detector, click Save as New.
Deleting Detectors

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery</td>
</tr>
</tbody>
</table>

You can delete custom detectors as well as individually imported add-on detectors provided by Cisco Professional Services. You cannot delete any of the other Cisco-provided detectors, though you can deactivate many of them.

Note
While a detector is in use in a deployed policy, you cannot delete the detector.

Procedure

Step 1  Select Policies > Application Detectors.

Step 2  Click the delete icon (ï) next to the detector you want to delete. If a view icon (.views) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3  Click OK.
User Identity Sources

The following topics describe Firepower System user identity sources, which are sources for user awareness. These users can be controlled with identity and access control policies:

- About User Identity Sources, on page 1277
- The User Agent Identity Source, on page 1278
- The ISE Identity Source, on page 1280
- The Captive Portal Identity Source, on page 1285
- The Traffic-Based Detection Identity Source, on page 1296

About User Identity Sources

The following table provides a brief overview of the user identity sources supported by the Firepower System. Each identity source provides a store of users for user awareness. These users can then be controlled with identity and access control policies.

<table>
<thead>
<tr>
<th>User Identity Source</th>
<th>Policy</th>
<th>Server Requirements</th>
<th>Type</th>
<th>Authentication Type</th>
<th>User Awareness?</th>
<th>User Control?</th>
<th>For more information, see...</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Agent Identity</td>
<td>Identity</td>
<td>Microsoft Active Directory</td>
<td>Authoritative logins</td>
<td>Passive</td>
<td>Yes</td>
<td>Yes</td>
<td><a href="#">The User Agent Identity Source, on page 1278</a></td>
</tr>
<tr>
<td>ISE</td>
<td>Identity</td>
<td>Microsoft Active Directory</td>
<td>Authoritative logins</td>
<td>Passive</td>
<td>Yes</td>
<td>Yes</td>
<td><a href="#">The ISE Identity Source, on page 1280</a></td>
</tr>
<tr>
<td>Captive portal</td>
<td>Identity</td>
<td>Microsoft Active Directory</td>
<td>Authoritative logins</td>
<td>Active</td>
<td>Yes</td>
<td>Yes</td>
<td><a href="#">The Captive Portal Identity Source, on page 1285</a></td>
</tr>
<tr>
<td>Identity</td>
<td>RADIUS</td>
<td>Authoritative logins</td>
<td>Active</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Consider the following when selecting identity sources to deploy:

- You must use traffic-based detection for non-LDAP user logins. For example, if you are using only User Agents to detect user activity, restricting non-LDAP logins has no effect.

- You must use traffic-based detection or captive portal to record failed login or authentication activity. A failed login or authentication attempt does not add a new user to the list of users in the database.

- The captive portal identity source requires a managed device with a routed interface. You cannot use an inline (also referred to as tap mode) interface with captive portal.

Data from those identity sources is stored in the Firepower Management Center's users database and the user activity database. You can configure Firepower Management Center-server user downloads to automatically and regularly download new user data to your databases.

After you configure identity rules using the desired identity source, you must associate each rule with an access control policy and deploy the policy to managed devices for the policy to have any effect. For more information about access control policies and deployment, see User, Realm, and ISE Attribute Conditions (User Control), on page 305.

For general information about user identity in the Firepower System, see About User Identity, on page 1206.

### The User Agent Identity Source

The User Agent is a passive authentication method; it is an authoritative identity source, meaning user information is supplied by a trusted Active Directory server. When integrated with the Firepower System, the user agent monitors users when they log in and out of hosts with Active Directory credentials. The data gained from the User Agent can be used for user awareness and user control.

The user agent associates each user with an IP address, which allows access control rules with user conditions to trigger. You can use one user agent to monitor user activity on up to five Active Directory servers and send encrypted data to up to five Firepower Management Centers.

The User Agent does not report failed login attempts.

### User Agent Guidelines

The User Agent requires a multi-step configuration that includes the following:

- At least one computer with the user agent installed.
• Connections between a Firepower Management Center and the computers or Active Directory servers
  with the user agent installed.

• An identity realm configured in each Firepower Management Center that receives user data from a user
  agent.

For detailed information about the multi-step User Agent configuration and a complete discussion of the
server requirements, see the Firepower User Agent Configuration Guide.

---

**Note**

Make sure the time on your computer or Active Directory server is synchronized with the time on the Firepower
Management Center. If the appliances are not synchronized, the system might perform user timeouts at
unexpected intervals.

The Firepower Management Center connection not only allows you to retrieve metadata for the users whose
logins and logoffs were detected by User Agents, but also is used to specify the users and groups you want
to use in access control rules. If the user agent is configured to exclude specific user names, login data for
those user names are not reported to the Firepower Management Center. User agent data is stored in the user
database and user activity database on the Firepower Management Center.

---

**Note**

User Agents cannot transmit Active Directory user names ending with the $ character to the Firepower
Management Center. You must remove the final $ character if you want to monitor these users.

If multiple users are logged into a host using remote sessions, the agent might not detect logins from that host
properly. For information about how to prevent this, see the Firepower User Agent Configuration Guide.

---

### Configure the User Agent for User Control

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network/Network/Access</td>
</tr>
</tbody>
</table>

For more information about the User Agent, see The User Agent Identity Source, on page 1278.

**Before you begin**

• Configure and enable an Active Directory realm for your User Agent connection as described in Create
  a Realm, on page 1330.

**Procedure**

**Step 1** Log in to the Firepower Management Center.
**Step 2** Click System > Integration.
**Step 3** Click the Identity Sources tab.
Step 4  Click **User Agent** for the **Service Type** to enable the User Agent connection.

**Note**  To disable the connection, click **None**.

Step 5  Click **New Agent** to add a new agent.

Step 6  Enter the **Hostname** or **Address** of the computer where you plan to install the agent. You must use an IPv4 address; you cannot configure the Firepower Management Center to connect to a User Agent using an IPv6 address.

Step 7  Click **Add**.

Step 8  To delete a connection, click the delete icon ( ) and confirm that you want to delete it.

---

**What to do next**

- Continue User Agent setup as described in the *Firepower User Agent Configuration Guide*.
- Configure an identity rule as described in Create an Identity Rule, on page 1337.
- Associate the identity policy with an access control policy as discussed in Associating Other Policies with Access Control, on page 636.
- Deploy your identity and access control policies to managed devices as discussed in Deploy Configuration Changes, on page 277.

**Related Topics**

- Troubleshoot the User Agent Identity Source, on page 1280
- Getting Started with Access Control Policies, on page 621

---

**Troubleshoot the User Agent Identity Source**

If you experience issues with the User Agent connection, see the *Firepower User Agent Configuration Guide*.

For related troubleshooting information in this guide, see Troubleshoot Realms and User Downloads, on page 1327 and Troubleshoot User Control, on page 308.

If you experience issues with user data reported by the User Agent, note:

- After the system detects activity from a User Agent user whose data is not yet in the database, the system retrieves information about them from the server. That user's activity is not handled by rules, and is not displayed in the web interface until the system successfully retrieves information about them in a user download.

- Active FTP sessions are displayed as the **Unknown** user in events. This is normal because, in active FTP, the server (not the client) initiates the connection and the FTP server should not have an associated user name. For more information about active FTP, see RFC 959.

---

**The ISE Identity Source**

You can integrate your Cisco Identity Services Engine (ISE) deployment with the Firepower System to use ISE for passive authentication.
ISE is an authoritative identity source, and provides user awareness data for users who authenticate using Active Directory (AD), LDAP, RADIUS, or RSA. Additionally, you can perform user control on Active Directory users. ISE does not report failed login attempts or the activity of ISE Guest Services users.

---

**Note**

The Firepower System does not support 802.1x machine authentication alongside Active Directory authentication because the system does not associate machine authentication with users. If you use 802.1x active logins, configure ISE to report only 802.1x active logins (both machine and user). That way, a machine login is reported only once to the system.

For more information on Cisco ISE, see the *Cisco Identity Services Engine Administrator Guide*.

---

**ISE Guidelines and Limitations**

Use the guidelines discussed in this section when configuring ISE with the Firepower System.

**ISE Version and Configuration Compatibility**

Your ISE version and configuration affects its integration and interaction with Firepower, as follows:

- Synchronize the time on the ISE server and the Firepower Management Center. Otherwise, the system might perform user timeouts at unexpected intervals.
- To implement user control using ISE data, configure and enable a realm for the ISE server assuming the pxGrid persona as described in *Create a Realm*, on page 1330.
- Each Firepower Management Center host name that connects to an ISE server must be unique; otherwise, the connection to one of the Firepower Management Centers will be dropped.
- Version 1.3 of ISE does not include support for IPv6-enabled endpoints. With this version of ISE, you cannot gather user identity data or perform remediations on IPv6-enabled endpoints.

For the specific versions of ISE that are compatible with this version of the system, see the *Cisco Firepower Compatibility Guide*.

**Approve clients in ISE**

Before a connection between the ISE server and the Firepower Management Center succeeds, you must manually approve the clients in ISE. (Typically, there are two clients: one for the connection test and another for ISE agent.)

You can also enable **Automatically approve new accounts** in ISE as discussed in the chapter on Managing users and external identity sources in the *Cisco Identity Services Engine Administrator Guide*.

**Security Group Tags (SGT)**

A Security Group Tag (SGT) specifies the privileges of a traffic source within a trusted network. Cisco ISE and Cisco TrustSec use a feature called Security Group Access (SGA) to apply SGT attributes to packets as they enter the network. These SGTs correspond to a user's assigned security group within ISE or TrustSec. If you configure ISE as an identity source, the Firepower System can use these SGTs to filter traffic.

**ISE and High Availability**

When the primary Firepower Management Center fails, the following occur:
• Until the standby is promoted to primary, the user database on the secondary Firepower Management Center is read-only.

Users added to the repository (for example, Active Directory) are not downloaded to the Firepower Management Center and those users are identified as Unknown.

New SGTs are not used.

• After the standby is promoted to primary, all operations return to normal; that is, users are downloaded, new SGTs are used, and users are identified if possible.

When the ISE primary server fails, you must manually promote the secondary to primary; there is no automatic failover.

**Endpoint Location (or Location IP)**

An Endpoint Location attribute is the IP address of the network device that used ISE to authenticate the user, as identified by ISE.

**ISE Attributes**

Configuring an ISE connection populates the Firepower Management Center database with ISE attribute data. You can use the following ISE attributes for user awareness and user control.

**Endpoint Profile (or Device Type)**

An Endpoint Profile attribute is the user's endpoint device type, as identified by ISE.

### Configure ISE for User Control

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

**Before you begin**

- Configure and enable a realm for the ISE server, assuming the pxGrid persona, as discussed in [Create a Realm, on page 1330](#).

- To use an encrypted connection to authenticate the Firepower Management Center with the ISE server, either [PKI Objects](#) or have your certificate data and key available on the machine from which you're accessing the Firepower Management Center.

**Procedure**

**Step 1** Log in to the Firepower Management Center.

**Step 2** Click **System > Integration**.

**Step 3** Click the **Identity Sources** tab.

**Step 4** Click **Identity Services Engine** for the **Service Type** to enable the ISE connection.

**Note** To disable the connection, click **None**.
Step 5 Enter a **Primary Host Name/IP Address** and, optionally, a **Secondary Host Name/IP Address**.

Step 6 Click the appropriate certificate authorities from the **pxGrid Server CA** and **MNT Server CA** lists, and the appropriate certificate from the **FMC Server Certificate** list. You can also click the add icon (➕) to add a certificate.

**Note** The **FMC Server Certificate** must include the **clientAuth** extended key usage value, or it must not include any extended key usage values.

Step 7 (Optional.) Enter an **ISE Network Filter** using CIDR block notation.

Step 8 To test the connection, click **Test**.

---

**What to do next**

- Specify users to control and other options using an identity policy as described in **Create an Identity Policy**, on page 1336.

- Associate the identity rule with an access control policy, which filters and optionally inspects traffic, as discussed in **Associating Other Policies with Access Control**, on page 636.

- Deploy your identity and access control policies to managed devices as discussed in **Deploy Configuration Changes**, on page 277.

- Monitor user activity as discussed in **Using Workflows**, on page 1523.

**Related Topics**

- **Troubleshoot the Captive Portal Identity Source**, on page 1296
- **Trusted Certificate Authority Objects**, on page 372
- **Internal Certificate Objects**, on page 375

**ISE Configuration Fields**

The following fields are used to configure a connection to ISE.

**Primary and Secondary Host Name/IP Address**

The hostname or IP address for the primary and, optionally, the secondary pxGrid ISE servers.

The ports used by the host names you specify must be reachable by both ISE and the Firepower Management Center.

**pxGrid Server CA**

The certificate authority for the pxGrid framework. If your deployment includes a primary and a secondary pxGrid node, the certificates for both nodes must be signed by the same certificate authority.

**MNT Server CA**

The certificate authority for the ISE certificate when performing bulk downloads. If your deployment includes a primary and a secondary MNT node, the certificates for both nodes must be signed by the same certificate authority.

**FMC Server Certificate**

The certificate and key that the Firepower Management Center must provide to ISE to connect to ISE or to perform bulk downloads.
The FMC Server Certificate must include the clientAuth extended key usage value, or it must not include any extended key usage values.

ISE Network Filter

An optional filter you can set to restrict the data that ISE reports to the Firepower Management Center. If you provide a network filter, ISE reports data from the networks within that filter. You can specify a filter in the following ways:

- Leave the field blank to specify any.
- Enter a single IPv4 address block using CIDR notation.
- Enter a list of IPv4 address blocks using CIDR notation, separated by commas.

This version of the Firepower System does not support filtering using IPv6 addresses, regardless of your ISE version.

Related Topics
- Trusted Certificate Authority Objects, on page 372
- Internal Certificate Objects, on page 375

Troubleshoot the ISE Identity Source

For other related troubleshooting information, see Troubleshoot Realms and User Downloads, on page 1327 and Troubleshoot User Control, on page 308.

If you experience issues with the ISE connection, check the following:

- The pxGrid Identity Mapping feature in ISE must be enabled before you can successfully integrate ISE with the Firepower System.
- When the primary server fails, you must manually promote the secondary to primary; there is no automatic failover.
- Before a connection between the ISE server and the Firepower Management Center succeeds, you must manually approve the clients in ISE. (Typically, there are two clients: one for the connection test and another for ISE agent.)
- The FMC Server Certificate must include the clientAuth extended key usage value, or it must not include any extended key usage values.
- The time on your ISE server must be synchronized with the time on the Firepower Management Center. If the appliances are not synchronized, the system may perform user timeouts at unexpected intervals.
- If your deployment includes a primary and a secondary pxGrid node,
  - The certificates for both nodes must be signed by the same certificate authority.
The ports used by the host name must be reachable by both the ISE server and by the Firepower Management Center.

If your deployment includes a primary and a secondary MNT node, the certificates for both nodes must be signed by the same certificate authority.

If you experience issues with user data reported by ISE, note the following:

- After the system detects activity from an ISE user whose data is not yet in the database, the system retrieves information about them from the server. Activity seen by the ISE user is not handled by access control rules, and is not displayed in the web interface until the system successfully retrieves information about them in a user download.

- You cannot perform user control on ISE users who were authenticated by an LDAP, RADIUS, or RSA domain controller.

- The Firepower Management Center does not receive user data for ISE Guest Services users.

- Your ISE version and configuration impact how you can use ISE in the Firepower System. For more information, see The ISE Identity Source, on page 1280.

- Active FTP sessions are displayed as the Unknown user in events. This is normal because, in active FTP, the server (not the client) initiates the connection and the FTP server should not have an associated user name. For more information about active FTP, see RFC 959.

If you experience issues with supported functionality, see The ISE Identity Source, on page 1280 for more information about version compatibility.

### The Captive Portal Identity Source

Captive portal is one of the authoritative identity sources supported by the Firepower System. It is the only active authentication method supported by the Firepower System, where users can authenticate onto the network using a managed device.

You typically use captive portal to require authentication to access the internet or to access restricted internal resources; you can optionally configure guest access to resources. After the system authenticates captive portal users, it handles their user traffic according to access control rules. Captive portal performs authentication on HTTP and HTTPS traffic only.

**Note**

HTTPS traffic must be decrypted before captive portal can perform authentication.

Captive portal also records failed authentication attempts. A failed attempt does not add a new user to the list of users in the database. The user activity type for failed authentication activity reported by captive portal is Failed Auth User.

The authentication data gained from captive portal can be used for user awareness and user control.

**Related Topics**

- How to Configure the Captive Portal for User Control, on page 1287
Captive Portal Guidelines and Limitations

When you configure and deploy captive portal in an identity policy, users from specified realms authenticate through the following device to access your network:

- Virtual routers on 7000 and 8000 Series devices
- ASA FirePOWER devices in routed mode running Version 9.5(2) or later

**Routed Interface Required**

Captive portal active authentication can be performed only by a device with a routed interface configured. If you are configuring the rule for captive portal and your captive portal device contains inline and routed interfaces, you must configure an interface condition to target only the routed interfaces on the device.

If the identity policy referenced by your access control policy contains one or more captive portal identity rules and you deploy the policy on a Firepower Management Center that manages:

- One or more devices with routed interfaces configured, the policy deployment succeeds and the routed interfaces perform active authentication.

  The system does not validate the type of interface in ASA with FirePOWER devices. If you apply a captive portal policy to an inline (tap mode) interface on an ASA with FirePOWER device, the policy deployment succeeds but users in traffic matching those rules are identified as Unknown.

- One or more NGIPSv devices, the policy deployment fails.

**Captive Portal and Policies**

You configure captive portal in your identity policy and invoke active authentication in your identity rules. Identity policies are associated with access control policies.

You configure some captive portal identity policy settings on the access control policy's Active Authentication tab page and configure the rest in an identity rule associated with the access control policy.

An active authentication rule has either an Active Authentication rule action, or a Passive Authentication rule action with Use active authentication if passive authentication cannot identify user selected. In each case the system transparently enables or disables SSL decryption, which restarts the Snort process.

---

**Caution**

Adding the first or removing the last active authentication rule when SSL decryption is disabled (that is, when the access control policy does not include an SSL policy) restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

---

**Captive Portal Requirements and Limitations**

Note the following requirements and limitations:

- The system supports up to 20 captive portal logins per second.

- There is a maximum five minute limit between failed login attempts for a failed login attempt to be counted toward the count of maximum login attempts. The five minute limit is not configurable.
(Maximum login attempts are displayed in connection events: Analysis > Connections > Events.)

If more than five minutes elapse between failed logins, the user will continue to be redirected to captive portal for authentication, will not be designated a failed login user or a guest user, and will not be reported to the Firepower Management Center.

- The only way to be sure a user logs out is to close and reopen the browser. Unless that happens, in some cases, the user can log out of captive portal and be able to access the network without authenticating again using the same browser.

- If a realm is created for a parent domain and the managed device detects a login to a child of that parent domain, the user's subsequent logout is not detected by the managed device.

- To use an ASA FirePOWER device (in routed mode and running ASA version 9.5(2) or later) for captive portal, use the captive-portal ASA CLI command to enable captive portal for active authentication and define the port as described in the ASA Firewall Configuration Guide (Version 9.5(2) or later): https://www.cisco.com/c/en/us/support/security/adaptive-security-appliance-asa-software/products-installation-and-configuration-guides-list.html.

- You must allow traffic destined for the IP address and port of the device you plan to use for captive portal.

- To perform captive portal active authentication on HTTPS traffic, you must use an SSL policy to decrypt the traffic from the users you want to authenticate. You cannot decrypt the traffic in the connection between a captive portal user's web browser and the captive portal daemon on the managed device; this connection is used to authenticate the captive portal user.

- To limit the amount of non-HTTP or HTTPS traffic that is allowed through the managed device, you should enter typical HTTP and HTTPS ports in the identity policy's Ports tab page.

The managed device changes a previously unseen user from Pending to Unknown when it determines that the incoming request does not use the HTTP or HTTPS protocol. As soon as the managed device changes a user from Pending to another state, access control, Quality of Service, and SSL policies can be applied to that traffic. If your other policies don't permit non-HTTP or HTTPS traffic, configuring ports on the captive portal identity policy can prevent undesired traffic from being allowed through the managed device.

**How to Configure the Captive Portal for User Control**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any, except NGIPSv</td>
<td>Any</td>
<td>Administrator/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

High-level overview of how to control user activity with captive portal:

**Before you begin**

To use the captive portal for active authentication, you must set up an access control policy, an identity policy, an SSL policy, and associate the identity and SSL policies with the access control policy. Finally, you must deploy the policies to managed devices. This topic provides a high-level summary of those tasks.
An example of the entire procedure begins in Configure the Captive Portal Part 1: Create an Identity Policy, on page 1289.

Perform the following tasks first:

- Confirm that your Firepower Management Center manages one or more devices with a routed interface configured.
  
  In particular, if your Firepower Management Center manages ASA with FirePOWER devices, see Captive Portal Guidelines and Limitations, on page 1286.

- To use encrypted authentication with the captive portal, either create a PKI object or have your certificate data and key available on the machine from which you're accessing the Firepower Management Center. To create a PKI object, see PKI Objects, on page 366.

**Procedure**

**Step 1**  
Create and enable a realm as discussed in the following topics:

- Create a Realm, on page 1330
- Configure a Realm Directory, on page 1333
- Download Users and Groups, on page 1334

**Step 2**  
Create an active authentication identity policy for captive portal. The identity policy enables selected users in your realm access resources after authenticating with the captive portal.

For more information, see Configure the Captive Portal Part 1: Create an Identity Policy, on page 1289.

**Step 3**  
Configure an access control rule for the captive portal that allows traffic on the captive portal port (by default, TCP 885).

You can choose any available TCP port for the captive portal to use. Whatever your choice, you must create a rule that allows traffic on that port.

For more information, see Configure the Captive Portal Part 2: Create a TCP Port Access Control Rule, on page 1290.

**Step 4**  
Add another access control rule to allow users in the selected realms to access resources using the captive portal.

This enables users to authenticate with captive portal. For more information, see Configure the Captive Portal Part 3: Create a User Access Control Rule, on page 1291.

**Step 5**  
Configure an SSL decrypt-resign policy for the Unknown user so captive portal users can access web pages using the HTTPS protocol.

The captive portal can authenticate users only if the HTTPS traffic is decrypted before the traffic is sent to the captive portal. Captive portal is seen by the system as the Unknown user.

For more information, see Configure Captive Portal Part 4: Create an SSL Decrypt-Resign Policy, on page 1292.

**Step 6**  
Associate the identity and SSL policies with the access control policy from step 2.

This final step enables the system to authenticate users with the captive portal.
For more information, see Configure Captive Portal Part 5: Associate Identity and SSL Policies with the Access Control Policy, on page 1293.

What to do next
See Configure the Captive Portal Part 1: Create an Identity Policy, on page 1289.

Related Topics
- Exclude Applications from Captive Portal, on page 1295
- Internal Certificate Objects, on page 375
- Troubleshoot the Captive Portal Identity Source, on page 1296
- Snort® Restart Scenarios, on page 279

Configure the Captive Portal Part 1: Create an Identity Policy

Before you begin
This five-part procedure shows how to set up the captive portal using the default TCP port 885 and using a Firepower Management Center server certificate for both the captive portal and for SSL decryption. Each part of this example explains one task required to enable the captive portal to perform active authentication.

If you follow all the steps in this procedure, you can configure captive portal to work for users in your domains. You can optionally perform additional tasks, which are discussed in each part of the procedure.

For an overview of the entire procedure, see How to Configure the Captive Portal for User Control, on page 1287.

Procedure

Step 1 Log into the Firepower Management Center if you have not already done so.
Step 2 Click Policies > Access Control > Identity and create or edit an identity policy.
Step 3 (Optional.) Click Add Category to add a category for the captive portal identity rules and enter a Name for the category.
Step 4 Click the Active Authentication tab.
Step 5 Choose the appropriate Server Certificate from the list or click the add icon (✔️) to add a certificate.

Note Captive portal does not support the use of Digital Signature Algorithm (DSA) or Elliptic Curve Digital Signature Algorithm (ECDSA) certificates.

Step 6 Enter 885 in the Port field and specify the Maximum login attempts.
Step 7 (Optional.) Choose an Active Authentication Response Page as described in Captive Portal Fields, on page 1294.
The following figure shows an example.

![Captive Portal](image)

**Step 8** Click **Save**.

**Step 9** Click the **Rules** tab.

**Step 10** Click **Add Rule** to add a new captive portal identity policy rule, or click the edit icon (-write) to edit an existing rule.

**Step 11** Enter a **Name** for the rule.

**Step 12** From the **Action** list, choose **Active Authentication**.

The system can enforce captive portal active authentication on HTTP and HTTPS traffic only. If an identity rule **Action** is **Active Authentication** (you are using captive portal) or if you are using passive authentication and you check the option on the **Realms & Settings** tab page to **Use active authentication if passive authentication cannot identify user**, use TCP ports constraints only.

**Step 13** Click the **Realm & Settings** tab.

**Step 14** From the **Realms** list, choose a realm to use for user authentication.

**Step 15** (Optional.) Check **Identify as Guest if authentication cannot identify user**. For more information, see Captive Portal Fields, on page 1294.

**Step 16** Choose an **Authentication Type** from the list.

**Step 17** (Optional.) To exempt specific application traffic from captive portal, see Exclude Applications from Captive Portal, on page 1295.

**Step 18** Add conditions to the rule (port, network, and so on) as discussed in Rule Condition Types, on page 290.

**Step 19** Click **Add**.

**Step 20** At the top of the page, click **Save**.

**What to do next**

Continue with Configure the Captive Portal Part 2: Create a TCP Port Access Control Rule, on page 1290.

### Configure the Captive Portal Part 2: Create a TCP Port Access Control Rule

This part of the procedure shows how to create an access control rule that allows the captive portal to communicate with clients using TCP port 885, which is the captive portal's default port. You can choose
another port if you wish, but the port must match the one you chose in Configure the Captive Portal Part 1: Create an Identity Policy, on page 1289.

Before you begin
For an overview of the entire captive portal configuration, see How to Configure the Captive Portal for User Control, on page 1287.

Procedure

**Step 1** In the access control policy editor, click Add Rule.

**Step 2** Enter a Name for the rule.

**Step 3** Choose Allow from the Action list.

**Step 4** Click the Ports tab.

**Step 5** From the Protocol list under the Selected Destination Ports field, choose TCP.

**Step 6** In the Port field, enter 885.

**Step 7** Click Add next to the Port field. The following figure shows an example.

![Add Rule](image)

**Step 8** Click Add at the bottom of the page.

What to do next
Continue with Configure the Captive Portal Part 3: Create a User Access Control Rule, on page 1291.

Configure the Captive Portal Part 3: Create a User Access Control Rule

This part of the procedure discusses how to add an access control rule that enables users in a realm to authenticate using captive portal.

Before you begin
For an overview of the entire captive portal configuration, see How to Configure the Captive Portal for User Control, on page 1287.
Configure Captive Portal Part 4: Create an SSL Decrypt-Resign Policy

This part of the procedure discusses how to create an SSL access policy to decrypt and resign traffic before the traffic reaches the captive portal. The captive portal can authenticate traffic only after it has been decrypted.

Before you begin

For an overview of the entire captive portal configuration, see How to Configure the Captive Portal for User Control, on page 1287.

Procedure

Step 1 If you haven't done so already, create a certificate object to decrypt SSL traffic as discussed in PKI Objects, on page 366.
Step 2 Click Policies > Access Control > SSL.
Step 3 Click New Policy.
Step 4 Enter a Name and choose a Default Action for the policy. Default actions are discussed in SSL Policy Default Actions, on page 730.
Step 5 Click Save.
Step 6 Click Add Rule.
Step 7 Enter a Name for the rule.
Step 8 From the Action list, choose Decrypt - Resign.
Step 9 From the with list, choose your PKI object.
Step 10 Click the Users tab.
Step 11 Above the Available Realms list, click (refresh).
Step 12 In the Available Realms list, click Special Identities.
Step 13 In the Available Users list, click Unknown.
Step 14 Click Add to Rule.
The following figure shows an example.

Step 15 (Optional.) Set other options as discussed in TLS/SSL Rule Conditions, on page 748.
Step 16 Click Add.
Step 17 At the top of the page, click Save.

What to do next
Continue with Configure Captive Portal Part 5: Associate Identity and SSL Policies with the Access Control Policy, on page 1293.

Configure Captive Portal Part 5: Associate Identity and SSL Policies with the Access Control Policy

This part of the procedure discusses how to associate the identity policy and SSL Decrypt - Resign rule with the access control policy you created earlier. After this, users can authenticate using the captive portal.

Before you begin
For an overview of the entire captive portal configuration, see How to Configure the Captive Portal for User Control, on page 1287.

Procedure

Step 1 Click Policies > Access Control > Access Control and edit the access control policy you created as discussed in Configure the Captive Portal Part 2: Create a TCP Port Access Control Rule, on page 1290. If a view icon (보기) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
Step 2 Either create a new access control policy or edit an existing policy.
Step 3 At the top of the page, click the link next to Identity Policy.
Step 4: From the list, choose the name of your identity policy and, at the top of the page, click Save.

Step 5: Repeat the preceding steps to associate your captive portal SSL policy with the access control policy.

Step 6: If you haven't done so already, target the policy at managed devices as discussed in Setting Target Devices for an Access Control Policy, on page 634.

What to do next

- Deploy your identity and access control policies to managed devices as discussed in Deploy Configuration Changes, on page 277.
- Monitor user activity as discussed in Using Workflows, on page 1523.

Captive Portal Fields

Use the following fields to configure captive portal on the Active Authentication tab of your identity policy. See also Identity Rule Fields, on page 1338.

Server Certificate

The server certificate presented by the captive portal daemon.

Note

Captive portal does not support the use of Digital Signature Algorithm (DSA) or Elliptic Curve Digital Signature Algorithm (ECDSA) certificates.

Port

The port number to use for the captive portal connection. If you plan to use an ASA FirePOWER device for captive portal, the port number in this field must match the port number you configured on the ASA FirePOWER device using the captive-portal CLI command.

Maximum login attempts

The maximum allowed number of failed login attempts before the system denies a user's login request.

Active Authentication Response Page

The system-provided or custom HTTP response page you want to display to captive portal users. After you select an Active Authentication Response Page in your identity policy active authentication settings, you also must configure one or more identity rules with HTTP Response Page as the Authentication Type.

Choose the following options:

- To use a generic response, click System-provided. You can click the view icon (🔍) to view the HTML code for this page.
- To create a custom response, click Custom. A window with system-provided code is displayed that you can replace or modify. When you are done, save your changes. You can edit a custom page by clicking the edit icon (📝).

Related Topics

Internal Certificate Objects, on page 375
Exclude Applications from Captive Portal

You can select applications (identified by their HTTP User-Agent strings) and exempt them from captive portal active authentication. This allows traffic from the selected applications to pass through the identity policy without authenticating.

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any, except NGIPSv</td>
<td>Any</td>
<td>Administrator, Access Admin, Network Admin</td>
</tr>
</tbody>
</table>

Note

Only applications with the **User-Agent Exclusion Tag** are displayed in this list.

Procedure

**Step 1**

On the **Realm & Settings** tab of the identity rule editor page, use Cisco-provided filters in the **Application Filters** list to narrow the list of applications you want to add to the filter.

- Click the arrow next to each filter type to expand and collapse the list.
- Right-click a filter type and click **Check All** or **Uncheck All**. Note that the list indicates how many filters you have selected of each type.
- To narrow the filters that appear, type a search string in the **Search by name** field; this is especially useful for categories and tags. To clear the search, click the clear icon ( × ).
- To refresh the filters list and clear any selected filters, click the reload icon (🔄).
- To clear all filters and search fields, click **Clear All Filters**.

Note

The list displays 100 applications at a time.

**Step 2**

Choose the applications that you want to add to the filter from the **Available Applications** list:

- To narrow the individual applications that appear, enter a search string in the **Search by name** field. To clear the search, click the clear icon ( × ).
- Use the paging icons at the bottom of the list to browse the list of individual available applications.
- To refresh the applications list and clear any selected applications, click the reload icon (🔄).

**Step 3**

Add the selected applications to exclude from external authentication. You can click and drag, or you can click **Add to Rule**. The result is the combination of the application filters you selected.

What to do next

- Continue configuring the identity rule as described in Create an Identity Rule, on page 1337.
Troubleshoot the Captive Portal Identity Source

For other related troubleshooting information, see Troubleshoot Realms and User Downloads, on page 1327 and Troubleshoot User Control, on page 308.

If you experience issues with captive portal, check the following:

- The time on your captive portal server must be synchronized with the time on the Firepower Management Center.

- If the connection between your Firepower Management Center and a managed device fails, no captive portal logins reported by the device can be identified during the downtime, unless the users were previously seen and downloaded to the Firepower Management Center. The unidentified users are logged as Unknown users on the Firepower Management Center. After the downtime, the Unknown users are reidentified and processed according to the rules in your identity policy.

- If the device you want to use for captive portal contains both inline and routed interfaces, you must configure a zone condition in your captive portal identity rules to target only the routed interfaces on the captive portal device.

- The system does not validate the type of interface in ASA with FirePOWER devices. If you apply a captive portal policy to an inline (tap mode) interface on an ASA with FirePOWER device, the policy deployment succeeds but users in traffic matching those rules are identified as Unknown.

- The only way to be sure a user logs out is to close and reopen the browser. Unless that happens, in some cases, the user can log out of captive portal and be able to access the network without authenticating again using the same browser.

- Active FTP sessions are displayed as the Unknown user in events. This is normal because, in active FTP, the server (not the client) initiates the connection and the FTP server should not have an associated user name. For more information about active FTP, see RFC 959.

The Traffic-Based Detection Identity Source

Traffic-based detection is the only non-authoritative identity source supported by the Firepower System. When configured, managed devices detect LDAP, AIM, POP3, IMAP, Oracle, SIP (VoIP), FTP, HTTP, MDNS, and SMTP logins on the networks you specify. The data gained from traffic-based detection can be used only for user awareness. Unlike authoritative identity sources, you configure traffic-based detection in your network discovery policy as described in Configuring Traffic-Based User Detection, on page 1310.

Note the following limitations:

- Traffic-based detection interprets only Kerberos logins for LDAP connections as LDAP authentications. Managed devices cannot detect encrypted LDAP authentications using protocols such as SSL or TLS.

- Traffic-based detection detects AIM logins using the OSCAR protocol only. They cannot detect AIM logins using TOC2.

- Traffic-based detection cannot restrict SMTP logging. This is because users are not added to the database based on SMTP logins; although the system detects SMTP logins, the logins are not recorded unless there is already a user with a matching email address in the database.
Traffic-based detection also records failed login attempts. A failed login attempt does not add a new user to the list of users in the database. The user activity type for detected failed login activity detected by traffic-based detection is **Failed User Login**.

---

**Note**

The system cannot distinguish between failed and successful HTTP logins. To see HTTP user information, you must enable **Capture Failed Login Attempts** in the traffic-based detection configuration.

---

**Caution**

Enabling or disabling non-authoritative, traffic-based user detection over the HTTP, FTP, or MDNS protocols, using the network discovery policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See **Snort® Restart Traffic Behavior, on page 280** for more information.

---

**Traffic-Based Detection Data**

When a device detects a login using traffic-based detection, it sends the following information to the Firepower Management Center to be logged as user activity:

- the user name identified in the login
- the time of the login
- the IP address involved in the login, which can be the IP address of the user’s host (for LDAP, POP3, IMAP, and AIM logins), the server (for HTTP, MDNS, FTP, SMTP and Oracle logins), or the session originator (for SIP logins)
- the user’s email address (for POP3, IMAP, and SMTP logins)
- the name of the device that detected the login

If the user was previously detected, the Firepower Management Center updates that user’s login history. Note that the Firepower Management Center can use the email addresses in POP3 and IMAP logins to correlate with LDAP users. This means that, for example, if the Firepower Management Center detects a new IMAP login, and the email address in the IMAP login matches that for an existing LDAP user, the IMAP login does not create a new user; rather, it updates the LDAP user’s history.

If the user was previously undetected, the Firepower Management Center adds the user to the users database. Unique AIM, SIP, and Oracle logins always create new user records, because there is no data in those login events that the Firepower Management Center can correlate with other login types.

The Firepower Management Center does **not** log user activity or user identities in the following cases:

- if you configured the network discovery policy to ignore that login type
- if a managed device detects an SMTP login, but the users database does not contain a previously detected LDAP, POP3, or IMAP user with a matching email address

The user data is added to the users table.
Traffic-Based Detection Strategies

You can restrict the protocols where user activity is discovered to reduce the total number of detected users so you can focus on users likely to provide the most complete user information. Limiting protocol detection helps minimize user name clutter and preserve storage space on your Firepower Management Center.

Consider the following when selecting traffic-based detection protocols:

• Obtaining user names through protocols such as AIM, POP3, and IMAP may introduce user names not relevant to your organization due to network access from contractors, visitors, and other guests.

• AIM, Oracle, and SIP logins may create extraneous user records. This occurs because these login types are not associated with any of the user metadata that the system obtains from an LDAP server, nor are they associated with any of the information contained in the other types of login that your managed devices detect. Therefore, the Firepower Management Center cannot correlate these users with other types of users.

Related Topics

Configuring Traffic-Based User Detection, on page 1310
Network Discovery Policies

The following topics describe how to create, configure, and manage network discovery policies:

- Overview: Network Discovery Policies, on page 1299
- Network Discovery Customization, on page 1300
- Network Discovery Rules, on page 1301
- Configuring Advanced Network Discovery Options, on page 1311
- Troubleshooting Your Network Discovery Strategy, on page 1321

Overview: Network Discovery Policies

The network discovery policy on the Firepower Management Center controls how the system collects data on your organization’s network assets and which network segments and ports are monitored.

In a multidomain deployment, each leaf domain has an independent network discovery policy. Network discovery policy rules and other settings cannot be shared, inherited, or copied between domains. Whenever you create a new domain, the system creates a network discovery policy for the new domain, using default settings. You must explicitly apply any desired customizations to the new policy.

Discovery rules within the policy specify which networks and ports the Firepower System monitors to generate discovery data based on network data in traffic, and the zones to which the policy is deployed. Within a rule, you can configure whether hosts, applications, and non-authoritative users are discovered. You can create rules to exclude networks and zones from discovery. You can configure discovery of data from NetFlow exporters and restrict the protocols for traffic where user data is discovered on your network.

The network discovery policy has a single default rule in place, configured to discover applications from all observed traffic. The rule does not exclude any networks, zones, or ports, host and user discovery is not configured, and the rule is not configured to monitor a NetFlow exporter. This policy is deployed by default to any managed devices when they are registered to the Firepower Management Center. To begin collecting host or user data, you must add or modify discovery rules and re-deploy the policy to a device.

If you want to adjust the scope of network discovery, you can create additional discovery rules and modify or remove the default rule.

Remember that the access control policy for each managed device defines the traffic that you permit for that device and, therefore, the traffic you can monitor with network discovery. If you block certain traffic using access control, the system cannot examine that traffic for host, user, or application activity. For example, if an access control policy blocks access to social networking applications, the system cannot provide any discovery data on those applications.
If you enable traffic-based user detection in your discovery rules, you can detect non-authoritative users through user login activity in traffic over a set of application protocols. You can disable discovery in particular protocols across all rules if needed. Disabling some protocols can help avoid reaching the user limit associated with your Firepower Management Center model, reserving available user count for users from the other protocols.

Advanced network discovery settings allow you to manage what data is logged, how discovery data is stored, what indications of compromise (IOC) rules are active, what vulnerability mappings are used for impact assessment, and what happens when sources offer conflicting discovery data. You can also add sources for host input and NetFlow exporters to monitor.

**Network Discovery Customization**

The information about your network traffic collected by the Firepower System is most valuable to you when the system can correlate this information to identify the hosts on your network that are most vulnerable and most important.

As an example, if you have several devices on your network running a customized version of SuSE Linux, the system cannot identify that operating system and so cannot map vulnerabilities to the hosts. However, knowing that the system has a list of vulnerabilities for SuSE Linux, you may want to create a custom fingerprint for one of the hosts that can then be used to identify the other hosts running the same operating system. You can include a mapping of the vulnerability list for SuSE Linux in the fingerprint to associate that list with each host that matches the fingerprint.

The system also allows you to input host data from third-party systems directly into the network map, using the host input feature. However, third-party operating system or application data does not automatically map to vulnerability information. If you want to see vulnerabilities and perform impact correlation for hosts using third-party operating system, server, and application protocol data, you must map the vendor and version information from the third-party system to the vendor and version listed in the vulnerability database (VDB). You also may want to maintain the host input data on an ongoing basis. Note that even if you map application data to Firepower System vendor and version definitions, imported third-party vulnerabilities are not used for impact assessment for clients or web applications.

If the system cannot identify application protocols running on hosts on your network, you can create user-defined application protocol detectors that allow the system to identify the applications based on a port or a pattern. You can also import, activate, and deactivate certain application detectors to further customize the application detection capability of the Firepower System.

You can also replace detection of operating system and application data using scan results from the Nmap active scanner or augment the vulnerability lists with third-party vulnerabilities. The system may reconcile data from multiple sources to determine the identity for an application.

**Configuring the Network Discovery Policy**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery</td>
</tr>
</tbody>
</table>

In a multidomain deployment, each domain has a separate network discovery policy. If your user account can manage multiple domains, switch to the leaf domain where you want to configure the policy.
Procedure

Step 1  Choose Policies > Network Discovery.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 2  Configure the following components of your policy:

- Discovery rules — See Configuring Network Discovery Rules, on page 1302.
- Traffic-based detection for users — See Configuring Traffic-Based User Detection, on page 1310.
- Advanced network discovery options — See Configuring Advanced Network Discovery Options, on page 1311.
- Custom operating system definitions (fingerprints) — See Creating a Custom Fingerprint for Clients, on page 1218 and Creating a Custom Fingerprint for Servers, on page 1220.

Network Discovery Rules

Network discovery rules allow you to tailor the information discovered for your network map to include only the specific data you want. Rules in your network discovery policy are evaluated sequentially. You can create rules with overlapping monitoring criteria, but doing so may affect your system performance.

When you exclude a host or a network from monitoring, the host or network does not appear in the network map and no events are reported for it. Cisco recommends that you exclude load balancers (or specific ports on load balancers) and NAT devices from monitoring. These devices may create excessive and misleading events, filling the database and overloading the Firepower Management Center. For example, a monitored NAT device might exhibit multiple updates of its operating system in a short period of time. If you know the IP addresses of your load balancers and NAT devices, you can exclude them from monitoring.

Tip

The system can identify many load balancers and NAT devices by examining your network traffic.

In addition, if you need to create a custom server fingerprint, you should temporarily exclude from monitoring the IP address that you are using to communicate with the host you are fingerprinting. Otherwise, the network map and discovery event views will be cluttered with inaccurate information about the host represented by that IP address. After you create the fingerprint, you can configure your policy to monitor that IP address again.

Cisco also recommends that you not monitor the same network segment with NetFlow exporters and Firepower System managed devices. Although ideally you should configure your network discovery policy with non-overlapping rules, the system does drop duplicate connection logs generated by managed devices. However, you cannot drop duplicate connection logs for connections detected by both a managed device and a NetFlow exporter.
Configuring Network Discovery Rules

You can configure discovery rules to tailor the discovery of host and application data to your needs.

Before you begin

- Make sure you are logging connections for the traffic where you want to discover network data; see Best Practices for Connection Logging.
- If you want to collect exported NetFlow records, add a NetFlow Exporter as described in Adding NetFlow Exporters to a Network Discovery Policy, on page 1317.
- If you will want to view discovery performance graphs, you must enable hosts, users, and applications in your discovery rule. Note that this may impact system performance.

Procedure

Step 1  Choose Policies > Network Discovery.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 2  Click Add Rule.

Step 3  Set the Action for the rule as described in Actions and Discovered Assets, on page 1302.

Step 4  Set optional discovery parameters:
- Restrict the rule action to specific networks; see Restricting the Monitored Network, on page 1304.
- Restrict the rule action to traffic in specific zones; see Configuring Zones in Network Discovery Rules, on page 1308.
- Exclude ports from monitoring; see Excluding Ports in Network Discovery Rules, on page 1306.
- Configure the rule for NetFlow data discovery; see Configuring Rules for NetFlow Data Discovery, on page 1305.

Step 5  Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Actions and Discovered Assets

When you configure a discovery rule, you must select an action for the rule. The effect of that action depends on whether you are using the rule to discover data from a managed device or from a NetFlow exporter.

The following table describes what assets are discovered by rules with the specified action settings in those two scenarios.
### Table 195: Discovery Rule Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Option</th>
<th>Managed Device</th>
<th>NetFlow Exporter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude</td>
<td>--</td>
<td>Excludes the specified network from monitoring. If the source or destination host for a connection is excluded from discovery, the connection is recorded but discovery events are not created for excluded hosts.</td>
<td>Excludes the specified network from monitoring. If the source or destination host for a connection is excluded from discovery, the connection is recorded but discovery events are not created for excluded hosts.</td>
</tr>
<tr>
<td>Discover</td>
<td>Hosts</td>
<td>Adds hosts to the network map based on discovery events. (Optional, unless user discovery is enabled, then required.)</td>
<td>Adds hosts to the network map and logs connections based on NetFlow records. (Required)</td>
</tr>
<tr>
<td>Discover</td>
<td>Applications</td>
<td>Adds applications to the network map based on application detectors. Note that you cannot discover hosts or users in a rule without also discovering applications. (Required)</td>
<td>Adds application protocols to the network map based on NetFlow records and the port-application protocol correlation in <code>/etc/sf/services</code>. (Optional)</td>
</tr>
<tr>
<td>Discover</td>
<td>Users</td>
<td>Adds users to the users table and logs user activity based on traffic-based detection on the user protocols configured in the network discovery policy. (Optional)</td>
<td>n/a</td>
</tr>
<tr>
<td>Log NetFlow Connections</td>
<td>--</td>
<td>n/a</td>
<td>Logs NetFlow connections only. Does not discover hosts or applications.</td>
</tr>
</tbody>
</table>

If you want the rule to monitor managed device traffic, application logging is required. If you want the rule to monitor users, host logging is required. If you want the rule to monitor exported NetFlow records, you cannot configure it to log users, and logging applications is optional.

---

**Note**

The system detects connections in exported NetFlow records based on the **Action** settings in the network discovery policy. The system detects connections in managed device traffic based on access control policy settings.

## Monitored Networks

A discovery rule causes discovery of monitored assets only in traffic to and from hosts in the specified networks. For a discovery rule, discovery occurs for connections that have at least one IP address within the networks specified, with events generated only for IP addresses within the networks to monitor. The default discovery
rule discovers applications from all observed traffic (0.0.0.0/0 for all IPv4 traffic, and ::/0 for all IPv6 traffic).

If you configure a rule to handle NetFlow discovery and log only connections data, the system also logs connections to and from IP addresses in the specified networks. Note that network discovery rules provide the only way to log NetFlow network connections.

You can also use network object or object groups to specify the networks to monitor.

### Restricting the Monitored Network

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Every discovery rule must include at least one network.

**Procedure**

**Step 1** Choose **Policies > Network Discovery**.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click **Add Rule**.

**Step 3** Click the **Networks** tab, if it is not already open.

**Step 4** Optionally, add network objects to the Available Networks list as described in *Creating Network Objects During Discovery Rule Configuration*, on page 1305.

**Note** If you modify a network object used in the network discovery policy, the changes do not take effect for discovery until you deploy the configuration changes.

**Step 5** Specify a network:

- Choose a network from the **Available Networks** list.

  **Tip** If the network does not immediately appear on the list, click the reload icon (🗂).

- Enter the IP address into the text box below the Available Networks label.

**Step 6** Click **Add**.

**Step 7** Optionally, repeat the previous two steps to add additional networks.

**Step 8** Click **Save** to save the changes you made.

**What to do next**

- Deploy configuration changes; see *Deploy Configuration Changes*, on page 277.
Configuring Rules for NetFlow Data Discovery

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

The Firepower System can use data from NetFlow exporters to generate connection and discovery events, and to add host and application data to the network map.

If you choose a NetFlow exporter in a discovery rule, the rule is limited to discovery of NetFlow data for the specified networks. Choose the NetFlow device to monitor before you configure other aspects of rule behavior, as the available rule actions change when you choose a NetFlow device. You cannot configure port exclusions for monitoring NetFlow exporters.

Before you begin

- Add NetFlow-enabled devices to the network discovery policy; see Adding NetFlow Exporters to a Network Discovery Policy, on page 1317.

Procedure

Step 1 Choose Policies > Network Discovery.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 2 Click Add Rule.

Step 3 Choose the NetFlow Device tab.

Step 4 From the Netflow Device drop-down list, choose the IP address of the NetFlow exporter to be monitored.

Step 5 Specify the type of NetFlow data you want the Firepower System managed device to collect:

- Connection only — Choose Log NetFlow Connections from the Action drop-down list.
- Host, Application, and Connection — Choose Discover from the Action drop-down list. The system automatically checks the Hosts check box and enables collection of connection data. Optionally, you can check the Application check box to collect application data.

Step 6 Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Creating Network Objects During Discovery Rule Configuration

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>
You can add new network objects to the list of available networks that appears in a discovery rule by adding them to the list of reusable network objects and groups.

**Procedure**

**Step 1** Choose Policies > Network Discovery.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** In the Networks tab, click Add Rule.

**Step 3** Click the add icon ( ) next to Available Networks.

**Step 4** Create a network object as described in Creating Network Objects, on page 326.

**Step 5** Finish adding the network discovery rule as described in Configuring Network Discovery Rules, on page 1302.

---

**Port Exclusions**

Just as you can exclude hosts from monitoring, you can exclude specific ports from monitoring. For example:

- Load balancers can report multiple applications on the same port in a short period of time. You can configure your network discovery rules so that they exclude that port from monitoring, such as excluding port 80 on a load balancer that handles a web farm.

- Your organization may use a custom client that uses a specific range of ports. If the traffic from this client generates excessive and misleading events, you can exclude those ports from monitoring. Similarly, you may decide that you do not want to monitor DNS traffic. In that case, you could configure your rules so that your discovery policy does not monitor port 53.

When adding ports to exclude, you can decide whether to use a reusable port object from the Available Ports list, add ports directly to the source or destination exclusion lists, or create a new reusable port and then move it into the exclusion lists.

---

**Note**

You cannot exclude ports in rules handling NetFlow data discovery.

---

**Excluding Ports in Network Discovery Rules**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You cannot exclude ports in rules handling NetFlow data discovery.

**Procedure**

**Step 1** Choose Policies > Network Discovery.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click **Add Rule**.

**Step 3** Click the **Port Exclusions** tab.

**Step 4** Optionally, add port objects to the Available Ports list as described in *Creating Port Objects During Discovery Rule Configuration*, on page 1307.

**Step 5** Exclude specific source ports from monitoring, using either of the following methods:

- Choose a port or ports from the **Available Ports** list and click **Add to Source**.
- To exclude traffic from a specific source port without adding a port object, under the **Selected Source Ports** list, choose a **Protocol**, enter a **Port** number (a value from 1 to 65535), and click **Add**.

**Step 6** Exclude specific destination ports from monitoring, using either of the following methods:

- Choose a port or ports from the **Available Ports** list and click **Add to Destination**.
- To exclude traffic from a specific destination port without adding a port object, under the **Selected Destination Ports** list, choose a **Protocol**, enter a **Port** number, and click **Add**.

**Step 7** Click **Save** to save the changes you made.

---

**What to do next**

- Deploy configuration changes; see *Deploy Configuration Changes*, on page 277.

---

**Creating Port Objects During Discovery Rule Configuration**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

You can add new port objects to the list of available ports that appears in a discovery rule by adding them to the list of reusable port objects and groups that can be used anywhere in the Firepower System.

**Procedure**

**Step 1** Choose **Policies > Network Discovery**.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** In the Networks tab, click **Add Rule**.

**Step 3** Click **Port Exclusions**.

**Step 4** To add a port to the Available Ports list, click the add object icon ( ).

**Step 5** Supply a **Name**.

**Step 6** In the **Protocol** field, specify the protocol of the traffic you want to exclude.

**Step 7** In the **Port** field, enter the ports you want to exclude from monitoring.

You can specify a single port, a range of ports using the dash (-), or a comma-separated list of ports and port ranges. Allowed port values are from 1 to 65535.
Step 8  Click Save.

Step 9  If the port does not immediately appear on the list, click the refresh icon (🔄).

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**Zones in Network Discovery Rules**

To improve performance, discovery rules can be configured so that the zones in the rule include the sensing interfaces on your managed devices that are physically connected to the networks-to-monitor in the rule.

Unfortunately, you may not always be kept informed of network configuration changes. A network administrator may modify a network configuration through routing or host changes without informing you, which may make it challenging to stay on top of proper network discovery policy configurations. If you do not know how the sensing interfaces on your managed devices are physically connected to your network, leave the zone configuration as the default. This default causes the system to deploy the discovery rule to all zones in your deployment. (If no zones are excluded, the system deploy the discovery policy to all zones.)

---

**Configuring Zones in Network Discovery Rules**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  Choose Policies > Network Discovery.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2**  Click Add Rule.

**Step 3**  Click the Zones tab.

**Step 4**  Choose a zone or zones from the Available Zones list.

**Step 5**  Click Save to save the changes you made.

---

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

**The Traffic-Based Detection Identity Source**

Traffic-based detection is the only non-authoritative identity source supported by the Firepower System. When configured, managed devices detect LDAP, AIM, POP3, IMAP, Oracle, SIP (VoIP), FTP, HTTP, MDNS, and SMTP logins on the networks you specify. The data gained from traffic-based detection can be used only
for user awareness. Unlike authoritative identity sources, you configure traffic-based detection in your network discovery policy as described in Configuring Traffic-Based User Detection, on page 1310.

Note the following limitations:

- Traffic-based detection interprets only Kerberos logins for LDAP connections as LDAP authentications. Managed devices cannot detect encrypted LDAP authentications using protocols such as SSL or TLS.

- Traffic-based detection detects AIM logins using the OSCAR protocol only. They cannot detect AIM logins using TOC2.

- Traffic-based detection cannot restrict SMTP logging. This is because users are not added to the database based on SMTP logins; although the system detects SMTP logins, the logins are not recorded unless there is already a user with a matching email address in the database.

Traffic-based detection also records failed login attempts. A failed login attempt does not add a new user to the list of users in the database. The user activity type for detected failed login activity detected by traffic-based detection is Failed User Login.

---

**Note**

The system cannot distinguish between failed and successful HTTP logins. To see HTTP user information, you must enable Capture Failed Login Attempts in the traffic-based detection configuration.

---

**Caution**

Enabling or disabling non-authoritative, traffic-based user detection over the HTTP, FTP, or MDNS protocols, using the network discovery policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information.

---

**Traffic-Based Detection Data**

When a device detects a login using traffic-based detection, it sends the following information to the Firepower Management Center to be logged as user activity:

- the user name identified in the login
- the time of the login
- the IP address involved in the login, which can be the IP address of the user’s host (for LDAP, POP3, IMAP, and AIM logins), the server (for HTTP, MDNS, FTP, SMTP and Oracle logins), or the session originator (for SIP logins)
- the user’s email address (for POP3, IMAP, and SMTP logins)
- the name of the device that detected the login

If the user was previously detected, the Firepower Management Center updates that user’s login history. Note that the Firepower Management Center can use the email addresses in POP3 and IMAP logins to correlate with LDAP users. This means that, for example, if the Firepower Management Center detects a new IMAP login, and the email address in the IMAP login matches that for an existing LDAP user, the IMAP login does not create a new user; rather, it updates the LDAP user’s history.
If the user was previously undetected, the Firepower Management Center adds the user to the users database. Unique AIM, SIP, and Oracle logins always create new user records, because there is no data in those login events that the Firepower Management Center can correlate with other login types.

The Firepower Management Center does not log user activity or user identities in the following cases:

- if you configured the network discovery policy to ignore that login type
- if a managed device detects an SMTP login, but the users database does not contain a previously detected LDAP, POP3, or IMAP user with a matching email address

The user data is added to the users table.

**Traffic-Based Detection Strategies**

You can restrict the protocols where user activity is discovered to reduce the total number of detected users so you can focus on users likely to provide the most complete user information. Limiting protocol detection helps minimize user name clutter and preserve storage space on your Firepower Management Center.

Consider the following when selecting traffic-based detection protocols:

- Obtaining user names through protocols such as AIM, POP3, and IMAP may introduce user names not relevant to your organization due to network access from contractors, visitors, and other guests.
- AIM, Oracle, and SIP logins may create extraneous user records. This occurs because these login types are not associated with any of the user metadata that the system obtains from an LDAP server, nor are they associated with any of the information contained in the other types of login that your managed devices detect. Therefore, the Firepower Management Center cannot correlate these users with other types of users.

**Related Topics**

- Configuring Traffic-Based User Detection, on page 1310

### Configuring Traffic-Based User Detection

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery</td>
</tr>
</tbody>
</table>

When you enable traffic-based user detection in a network discovery rule, host discovery is automatically enabled. For more information about traffic-based detection, see The Traffic-Based Detection Identity Source, on page 1296.

**Procedure**

**Step 1** Choose Policies > Network Discovery.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click Users.

**Step 3** Click the edit icon (📝).
Step 4  Check the check boxes for protocols where you want to detect logins or clear check boxes for protocols where you do not want to detect logins.

Step 5  Optionally, to record failed login attempts detected in LDAP, POP3, FTP, or IMAP traffic, or to capture user information for HTTP logins, enable **Capture Failed Login Attempts**.

Step 6  Click **Save**.

---

### What to do next

**Caution**

Enabling or disabling non-authoritative, traffic-based user detection over the HTTP, FTP, or MDNS protocols, using the network discovery policy restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See **Snort® Restart Traffic Behavior**, on page 280 for more information.

- Configure network discovery rules to discover users as described in **Configuring Network Discovery Rules**, on page 1302.
- Deploy configuration changes; see **Deploy Configuration Changes**, on page 277.

### Configuring Advanced Network Discovery Options

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

The Advanced tab of the network discovery policy allows you to configure policy-wide settings for what events are detected, how long discovery data is retained and how often it is updated, what vulnerability mappings are used for impact correlation, and how operating system and server identity conflicts are resolved. In addition, you can add host input sources and NetFlow exporters to allow import of data from other sources.

**Note**

Database event limits for discovery and user activity events are set in system configuration.

### Procedure

**Step 1**  Choose **Policies > Network Discovery**.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2**  Click **Advanced**.

**Step 3**  Click the edit icon (_edit) or add icon (_add) next to the setting you want to modify:
• Data Storage Settings — Update the settings as described in Configuring Network Discovery Data Storage, on page 1319.
• Event Logging Settings — Update the settings as described in Configuring Network Discovery Event Logging, on page 1319.
• General Settings — Update the settings as described in Configuring Network Discovery General Settings, on page 1313.
• Identity Conflict Settings — Update the settings as described in Configuring Network Discovery Identity Conflict Resolution, on page 1314.
• Indications of Compromise Settings — Update the settings as described in Enabling Indications of Compromise Rules, on page 1316.
• NetFlow Exporters — Update the settings as described in Adding NetFlow Exporters to a Network Discovery Policy, on page 1317.
• OS and Server Identity Sources — Update the settings as described in Adding Network Discovery OS and Server Identity Sources, on page 1320.
• Vulnerabilities to use for Impact Assessment — Update the settings as described in Enabling Network Discovery Vulnerability Impact Assessment, on page 1315.

Step 4  Click Save.

What to do next
• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Related Topics
  Database Event Limits, on page 444

Network Discovery General Settings

The general settings control how often the system updates network maps and whether server banners are captured during discovery.

Capture Banners

Select this check box if you want the system to store header information from network traffic that advertises server vendors and versions (“banners”). This information can provide additional context to the information gathered. You can access server banners collected for hosts by accessing server details.

Update Interval

The interval at which the system updates information (such as when any of a host’s IP addresses was last seen, when an application was used, or the number of hits for an application). The default setting is 3600 seconds (1 hour).

Note that setting a lower interval for update timeouts provides more accurate information in the host display, but generates more network events.
Configuring Network Discovery General Settings

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose Policies > Network Discovery.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click Advanced.

**Step 3** Click the edit icon ( 🔍 ) next to General Settings.

**Step 4** Update the settings as described in Network Discovery General Settings, on page 1312.

**Step 5** Click Save to save the general settings.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

**Network Discovery Identity Conflict Settings**

The system determines which operating system and applications are running on a host by matching fingerprints for operating systems and servers against patterns in traffic. To provide the most reliable operating system and server identity information, the system collates fingerprint information from several sources.

The system uses all passive data to derive operating system identities and assign a confidence value.

By default, unless there is an identity conflict, identity data added by a scanner or third-party application overrides identity data detected by the Firepower System. You can use the Identity Sources settings to rank scanner and third-party application fingerprint sources by priority. The system retains one identity for each source, but only data from the highest priority third-party application or scanner source is used as the current identity. Note, however, that user input data overrides scanner and third-party application data regardless of priority.

An identity conflict occurs when the system detects an identity that conflicts with an existing identity that came from either the active scanner or third-party application sources listed in the Identity Sources settings or from a Firepower System user. By default, identity conflicts are not automatically resolved and you must resolve them through the host profile or by rescanning the host or re-adding new identity data to override the passive identity. However, you can set your system to automatically resolve the conflict by keeping either the passive identity or the active identity.

**Generate Identity Conflict Event**

Specifies whether the system generates an event when an identity conflict occurs.
Automatically Resolve Conflicts

From the Automatically Resolve Conflicts drop-down list, choose one of the following:

- **Disabled** if you want to force manual conflict resolution of identity conflicts
- **Identity** if you want the system to use the passive fingerprint when an identity conflict occurs
- **Keep Active** if you want the system to use the current identity from the highest priority active source when an identity conflict occurs

Configuring Network Discovery Identity Conflict Resolution

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Choose **Policies > Network Discovery**.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click **Advanced**.

**Step 3** Click the edit icon (📝) next to **Identity Conflict Settings**.

**Step 4** Update the settings in the Edit Identity Conflict Settings pop-up window as described in **Network Discovery Identity Conflict Settings, on page 1313**.

**Step 5** Click **Save** to save the identity conflict settings.

What to do next

- Deploy configuration changes; see **Deploy Configuration Changes, on page 277**.

Network Discovery Vulnerability Impact Assessment Options

You can configure how the Firepower System performs impact correlation with intrusion events. Your choices are as follows:

- Check the **Use Network Discovery Vulnerability Mappings** check box if you want to use system-based vulnerability information to perform impact correlation.

- Check the **Use Third-Party Vulnerability Mappings** check box if you want to use third-party vulnerability references to perform impact correlation. For more information, see the **Firepower System Host Input API Guide**.

You can check either or both of the check boxes. If the system generates an intrusion event and the host involved in the event has servers or an operating system with vulnerabilities in the selected vulnerability mapping sets, the intrusion event is marked with the Vulnerable (level 1: red) impact icon. For any servers
which do not have vendor or version information, note that you need to enable vulnerability mapping in the Firepower Management Center configuration.

If you clear both check boxes, intrusion events will **never** be marked with the Vulnerable (level 1: red) impact icon.

**Related Topics**
- Mapping Third-Party Vulnerabilities, on page 1227
- Mapping Vulnerabilities for Servers, on page 484

## Enabling Network Discovery Vulnerability Impact Assessment

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose **Policies > Network Discovery**.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click **Advanced**.

**Step 3** Click the edit icon (📝) next to **Vulnerabilities to use for Impact Assessment**.

**Step 4** Update the settings in the Edit Vulnerability Settings pop-up window as described in Network Discovery Vulnerability Impact Assessment Options, on page 1314.

**Step 5** Click **Save** to save the vulnerability settings.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

## Indications of Compromise

The Firepower System uses IOC rules in the network discovery policy to identify a host as likely to be compromised by malicious means. When a host meets the conditions specified in these system-provided rules, the system tags it with an *indication of compromise* (IOC). The related rules are known as *IOC rules*. Each IOC rule corresponds to one type of IOC tag. The IOC tags specify the nature of the likely compromise.

The Firepower Management Center can tag the host involved when one of the following things occurs:

- The system correlates data gathered about your monitored network and its traffic, using intrusion, connection, Security Intelligence, and file or malware events, and determines that a potential IOC has occurred.

- The Firepower Management Center can import IOC data from your AMP for Endpoints deployments via the AMP cloud. Because this data examines activity on a host itself—such as actions taken by or on individual programs—it can provide insights into possible threats that network-only data cannot. For
your convenience, the Firepower Management Center automatically obtains any new IOC tags that Cisco develops from the AMP cloud.

To configure this feature, see Enabling Indications of Compromise Rules, on page 1316.

You can also write correlation rules against host IOC data and compliance white lists that account for IOC-tagged hosts.

To investigate and work with tagged IOCs, see Indications of Compromise Data, on page 1750 and its subtopics.

### Enabling Indications of Compromise Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

For your system to detect and tag indications of compromise (IOC), you must first activate at least one IOC rule in your network discovery policy. Each IOC rule corresponds to one type of IOC tag, and all IOC rules are predefined by Cisco; you cannot create original rules. You can enable any or all rules, depending on the needs of your network and organization. For example, if hosts using software such as Microsoft Excel never appear on your monitored network, you may decide not to enable the IOC tags that pertain to Excel-based threats.

**Tip**

To disable IOC rules for individual hosts, see Editing Indication of Compromise Rule States for a Single Host, on page 1752.

### Before you begin

Because IOC rules trigger based on data provided by other components of the Firepower System and by AMP for Endpoints, those components must be correctly licensed and configured for IOC rules to set IOC tags. Enable the Firepower System features associated with the IOC rules you will enable, such as intrusion detection and prevention (IPS) and Advanced Malware Protection (AMP). If an IOC rule’s associated feature is not enabled, no relevant data is collected and the rule cannot trigger.

### Procedure

**Step 1** Choose Policies > Network Discovery.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click Advanced.

**Step 3** Click the edit icon (✏️) next to Indications of Compromise Settings.

**Step 4** To toggle the entire IOC feature off or on, click the slider next to Enable IOC.

**Step 5** To globally enable or disable individual IOC rules, click the slider in the rule’s Enabled column.

**Step 6** Click Save to save your IOC rule settings.
Adding NetFlow Exporters to a Network Discovery Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Before you begin

- Configure the NetFlow exporters you plan to use as described in Netflow Data in the Firepower System, on page 1203.
- Review the other NetFlow prerequisites described in Requirements for Using NetFlow Data, on page 1203.

Procedure

**Step 1**
Choose **Policies > Network Discovery**.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2**
Click **Advanced**.

**Step 3**
Click the add icon (➕) next to **NetFlow Devices**.

**Step 4**
In the **IP Address** field, enter the IP address of the network device from which you want the managed device to collect NetFlow data.

**Step 5**
Optionally:
- Repeat the previous two steps to add additional NetFlow exporters.
- Remove a NetFlow exporter by clicking the delete icon (➖). Keep in mind that if you use a NetFlow exporter in a discovery rule, you must delete the rule before you can delete the device from the Advanced page.

**Step 6**
Click **Save**.

What to do next

- Configure a network discovery rule to monitor NetFlow traffic as described in Configuring Network Discovery Rules, on page 1302.
- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Network Discovery Data Storage Settings

Discovery data storage settings include the host limit and timeout settings.

When Host Limit Reached

The number of hosts a Firepower Management Center can monitor, and therefore store in the network map, depends on its model. The **When Host Limit Reached** option controls what happens when you detect a new host after you reach the host limit. You can:

Drop hosts

The system drops the host that has remained inactive for the longest time, then adds the new host. This is the default setting.

Don't insert new hosts

The system does not track any newly discovered hosts. The system only tracks new hosts after the host count drops below the limit, such as after an administrator increases the domain's host limit or manually deletes hosts from the network map, or if the system identifies hosts as timed-out due to inactivity.

In a multidomain deployment, leaf domains share the available pool of monitored hosts. To ensure that each leaf domain can populate its network map, you can set host limits at any subdomain level in the domain's properties. Because each leaf domain has its own network discovery policy, each leaf domain governs its own behavior when the system discovers a new host, as described in the following table.

**Table 196: Reaching the Host Limit with Multitenancy**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Domain Host Limit Set?</th>
<th>Domain Host Limit Reached</th>
<th>Ancestor Domain Host Limit Reached</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop hosts</td>
<td>yes</td>
<td>Drops oldest host in the constrained domain.</td>
<td>Drops the oldest host among all descendant leaf domains configured to drop hosts. If no host can be dropped, does not add the host.</td>
</tr>
<tr>
<td></td>
<td>no</td>
<td>n/a</td>
<td>Drops the oldest host among all descendant leaf domains configured to drop hosts and that share the general pool.</td>
</tr>
<tr>
<td>Don't insert new hosts</td>
<td>yes or no</td>
<td>Does not add the host.</td>
<td>Does not add the host.</td>
</tr>
</tbody>
</table>

Host Timeout

The amount of time that passes, in minutes, before the system drops a host from the network map due to inactivity. The default setting is 10080 minutes (one week). Individual host IP and MAC addresses can time out individually, but a host does not disappear from the network map unless all its associated addresses time out.

To avoid premature timeout of hosts, make sure that the host timeout value is longer than the update interval in the network discovery policy general settings.
Server Timeout

The amount of time that passes, in minutes, before the system drops a server from the network map due to inactivity. The default setting is 10080 minutes (one week).

To avoid premature timeout of servers, make sure that the service timeout value is longer than the update interval in the network discovery policy general settings.

Client Application Timeout

The amount of time that passes, in minutes, before the system drops a client from the network map due to inactivity. The default setting is 10080 minutes (one week).

Make sure that the client timeout value is longer than the update interval in the network discovery policy general settings.

Related Topics
- Firepower System Host Limit, on page 1209
- Domain Properties, on page 269

Configuring Network Discovery Data Storage

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1
Choose Policies > Network Discovery.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 2
Click Advanced.

Step 3
Click the edit icon (📝) next to Data Storage Settings.

Step 4
Update the settings in the Data Storage Settings dialog as described in Network Discovery Data Storage Settings, on page 1318.

Step 5
Click Save to save the data storage settings.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Configuring Network Discovery Event Logging

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>
The Event Logging Settings control whether discovery and host input events are logged. If you do not log an event, you cannot retrieve it in event views or use it to trigger correlation rules.

**Procedure**

**Step 1** Choose **Policies** > **Network Discovery**.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click **Advanced**.

**Step 3** Click the edit icon (📝) next to **Event Logging Settings**.

**Step 4** Check or clear the check boxes next to the discovery and host input event types you want to log in the database, described in *Discovery Event Types*, on page 1734 and *Host Input Event Types*, on page 1738.

**Step 5** Click **Save** to save the event logging settings.

**What to do next**

- Deploy configuration changes; see *Deploy Configuration Changes*, on page 277.

### Adding Network Discovery OS and Server Identity Sources

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

In the Advanced tab of the network discovery policy, you can add new active sources or change the priority or timeout settings for existing sources.

Adding a scanner to this page does not add the full integration capabilities that exist for the Nmap scanners, but does allow integration of imported third-party application or scan results.

If you import data from a third-party application or scanner, make sure that you map vulnerabilities from the source to the vulnerabilities detected in your network.

**Procedure**

**Step 1** Choose **Policies** > **Network Discovery**.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2** Click **Advanced**.

**Step 3** Click the edit icon (📝) next to **OS and Server Identity Sources**.

**Step 4** To add a new source, click **Add Source**.

**Step 5** Enter a **Name**.

**Step 6** Choose the input source **Type** from the drop-down list:
• Choose **Scanner** if you plan to import scan results using the AddScanResult function.
• Choose **Application** if you do not plan to import scan results.

**Step 7**
To indicate the duration of time that should elapse between the addition of an identity to the network map by this source and the deletion of that identity, choose **Hours**, **Days**, or **Weeks** from the **Timeout** drop-down list and enter the appropriate duration.

**Step 8**
Optionally:
• To promote a source and cause the operating system and application identities to be used in favor of sources below it in the list, choose the source and click the up arrow.
• To demote a source and cause the operating system and application identities to be used only if there are no identities provided by sources above it in the list, choose the source and click the down arrow.
• To delete a source, click the delete icon (esture) next to the source.

**Step 9**
Click **Save** to save the identity source settings.

---

**What to do next**
• Deploy configuration changes; see **Deploy Configuration Changes, on page 277**.

**Related Topics**
  
  **Mapping Third-Party Vulnerabilities, on page 1227**

---

**Troubleshooting Your Network Discovery Strategy**

Before you make any changes to the system’s default detection capabilities, you should analyze what hosts are not being identified correctly and why, so you can decide what solution to implement.

**Are Your Managed Devices Correctly Placed?**
If network devices such as load balancers, proxy servers, or NAT devices reside between the managed device and the unidentified or misidentified host, place a managed device closer to the misidentified host rather than using custom fingerprinting. Cisco does not recommend using custom fingerprinting in this scenario.

**Do Unidentified Operating Systems Have a Unique TCP Stack?**
If the system misidentifies a host, you should investigate why the host is misidentified to help you decide between creating and activating a custom fingerprint or substituting Nmap or host input data for discovery data.

---

**Caution**
If you encounter misidentified hosts, contact your support representative before creating custom fingerprints.

---

If a host is running an operating system that is not detected by the system by default and does not share identifying TCP stack characteristics with existing detected operating systems, you should create a custom fingerprint.

For example, if you have a customized version of Linux with a unique TCP stack that the system cannot identify, you would benefit from creating a custom fingerprint, which allows the system to identify the host
and continuing monitoring it, rather than using scan results or third-party data, which require you to actively update the data yourself on an ongoing basis.

Note that many open source Linux distributions use the same kernel, and as such, the system identifies them using the Linux kernel name. If you create a custom fingerprint for a Red Hat Linux system, you may see other operating systems (such as Debian Linux, Mandrake Linux, Knoppix, and so on) identified as Red Hat Linux, because the same fingerprint matches multiple Linux distributions.

You should not use a fingerprint in every situation. For example, a modification may have been made to a host’s TCP stack so that it resembles or is identical to another operating system. For example, an Apple Mac OS X host is altered, making its fingerprint identical to a Linux 2.4 host, causing the system to identify it as Linux 2.4 instead of Mac OS X. If you create a custom fingerprint for the Mac OS X host, it may cause all legitimate Linux 2.4 hosts to be erroneously identified as Mac OS X hosts. In this case, if Nmap correctly identifies the host, you could schedule regular Nmap scans for that host.

If you import data from a third-party system using host input, you must map the vendor, product, and version strings that the third party uses to describe servers and application protocols to the Cisco definitions for those products. Note that even if you map application data to Firepower System vendor and version definitions, imported third-party vulnerabilities are not used for impact assessment for clients or web applications.

The system may reconcile data from multiple sources to determine the current identity for an operating system or application.

For Nmap data, you can schedule regular Nmap scans. For host input data, you can regularly run the Perl script for the import or the command line utility. However, note that active scan data and host input data may not be updated with the frequency of discovery data.

**Can the Firepower System Identify All Applications?**

If a host is correctly identified by the system but has unidentified applications, you can create a user-defined detector to provide the system with port and pattern matching information to help identify the application.

**Have You Applied Patches that Fix Vulnerabilities?**

If the system correctly identifies a host but does not reflect applied fixes, you can use the host input feature to import patch information. When you import patch information, you must map the fix name to a fix in the database.

**Do You Want to Track Third-Party Vulnerabilities?**

If you have vulnerability information from a third-party system that you want to use for impact correlation, you can map the third-party vulnerability identifiers for servers and application protocols to vulnerability identifiers in the Cisco database and then import the vulnerabilities using the host input feature. For more information on using the host input feature, see the *Firepower System Host Input API Guide*. Note that even if you map application data to Firepower System vendor and version definitions, imported third-party vulnerabilities are not used for impact assessment for clients or web applications.
Realms and Identity Policies

The following topics describe realms and identity policies:

- About Realms and Identity Policies, on page 1323
- Create a Realm, on page 1330
- Create an Identity Policy, on page 1336
- Create an Identity Rule, on page 1337
- Manage a Realm, on page 1339
- Manage an Identity Policy, on page 1340
- Manage an Identity Rule, on page 1341

About Realms and Identity Policies

A *realm* consists of one or more LDAP or Microsoft Active Directory servers that share the same directory credentials. You must configure a realm to perform user and user group queries, user control, or to configure an authoritative identity source. After configuring one or more realms, you can configure an identity policy.

An *identity policy* associates traffic on your network with an authoritative identity source and a realm. After configuring one or more identity policies, you can associate one with an access control policy and deploy the access control policy to a managed device.

About Realms

Realms are connections between the Firepower Management Center and the user accounts on the servers you monitor. They specify the connection settings and authentication filter settings for the server. Realms can:

- Specify the users and user groups whose activity you want to monitor.
- Query the user repository for user metadata on authoritative users, as well as some non-authoritative users: POP3 and IMAP users detected by traffic-based detection and users detected by traffic-based detection, a User Agent, or ISE.

You can add multiple domain controllers as directories in a realm, but they must share the same basic realm information. The directories in a realm must be exclusively LDAP or exclusively Active Directory (AD) servers. After you enable a realm, your saved changes take effect next time the Firepower Management Center queries the server.
To perform user awareness, you must configure a realm for any of the Supported Servers for Realms. The system uses these connections to query the servers for data associated with POP3 and IMAP users, and to collect data about LDAP users discovered through traffic-based detection.

The system uses the email addresses in POP3 and IMAP logins to correlate with LDAP users on an Active Directory, or OpenLDAP. For example, if a managed device detects a POP3 login for a user with the same email address as an LDAP user, the system associates the LDAP user’s metadata with that user.

To perform user control, you can configure any of the following:

- A realm for an AD server for either the User Agent or ISE
- A realm for an AD or OpenLDAP server for captive portal

**About User Download**

You can configure a realm to establish a connection between the Firepower Management Center and an LDAP or AD server to retrieve user and user group metadata for certain detected users:

- LDAP and AD users authenticated by captive portal or reported by a User Agent or ISE. This metadata can be used for user awareness and user control.
- POP3 and IMAP user logins detected by traffic-based detection, if those users have the same email address as an LDAP or AD user. This metadata can be used for user awareness.

You configure LDAP server or Active Directory domain controller connections as a directory in a realm. You must check **Download users and user groups for access control** to download a realm’s user and user group data for user awareness and user control.

The Firepower Management Center obtains the following information and metadata about each user:

- LDAP user name
- First and last names
- Email address
- Department
- Telephone number

**About User Activity Data**

User activity data is stored in the user activity database and user identity data is stored in the users database. The maximum number of users you can store and use in access control depends on your Firepower Management Center model. When choosing which users and groups to include, make sure the total number of users is less than your model limit. If your access control parameters are too broad, the Firepower Management Center obtains information on as many users as it can and reports the number of users it failed to retrieve in the Tasks tab page of the Message Center.
If you remove a user that has been detected by the system from your user repository, the Firepower Management Center does not remove that user from its users database; you must manually delete it. However, your LDAP changes are reflected in access control rules when the Firepower Management Center next updates its list of authoritative users.

**Realms and Trusted Domains**

When you configure a realm in the Firepower Management Center, it is associated with an Active Directory or LDAP domain.

A grouping of Microsoft Active Directory (AD) domains that trust each other is commonly referred to as a forest. This trust relationship can enable domains to access each other's resources in different ways. For example, a user account defined in domain A can be marked as a member of a group defined in domain B.

The Firepower System does not support trusted AD domains. This means that the Firepower System does not track which configured domains trust each other, and does not know which domains are parent or child domains of each other. The Firepower System also has not been tested to assure support for environments that use cross-domain trust, even when the trust relationship is exercised outside of the Firepower System.

For more information, see Troubleshoot Realms and User Downloads, on page 1327.

**Supported Servers for Realms**

You can configure realms to connect to the following types of servers, providing they have TCP/IP access from the Firepower Management Center:

<table>
<thead>
<tr>
<th>Server Type</th>
<th>Supported for User Agent data retrieval?</th>
<th>Supported for ISE data retrieval?</th>
<th>Supported for captive portal data retrieval?</th>
<th>Supported for RA VPN data retrieval?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Active Directory on Windows Server 2008 and Windows Server 2012</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>OpenLDAP on Linux</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Note the following about your server group configurations:

- To perform user control on user groups or on users in groups, you must configure user groups on the LDAP or Active Directory server. The Firepower Management Center cannot perform user group control if the server organizes the users in basic object hierarchy.

- Group names cannot start with S= because it is used internally by LDAP.

Neither group names nor organizational unit names can contain special characters like asterisk (*), equals (=), or backslash (\); otherwise, users in those groups or organizational units are not downloaded and are not available for identity policies.
To configure an Active Directory realm that includes or excludes users who are members of a sub-group on your server, note that Microsoft recommends that Active Directory has no more than 5000 users per group in Windows Server 2008 or 2012. For more information, see Active Directory Maximum Limits—Scalability on MSDN.

If necessary, you can modify your Active Directory server configuration to increase this default limit and accommodate more users.

**Supported Server Object Class and Attribute Names**

The servers in your realms *must* use the attribute names listed in the following table for the Firepower Management Center to retrieve user metadata from the servers. If the attribute names are incorrect on your server, the Firepower Management Center cannot populate its database with the information in that attribute.

<table>
<thead>
<tr>
<th>Metadata</th>
<th>FMC Attribute</th>
<th>LDAP ObjectClass</th>
<th>Active Directory Attribute</th>
<th>OpenLDAP Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP user name</td>
<td>Username</td>
<td>• user</td>
<td>samaccountname</td>
<td>cn</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• inetOrgPerson</td>
<td></td>
<td>uid</td>
</tr>
<tr>
<td>first name</td>
<td>First Name</td>
<td></td>
<td>givenname</td>
<td>givenname</td>
</tr>
<tr>
<td>last name</td>
<td>Last Name</td>
<td></td>
<td>sn</td>
<td>sn</td>
</tr>
<tr>
<td>email address</td>
<td>Email</td>
<td></td>
<td>mail</td>
<td>mail</td>
</tr>
<tr>
<td>department</td>
<td>Department</td>
<td></td>
<td>department</td>
<td>ou</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>distinguishedname (if department has no value)</td>
<td></td>
</tr>
<tr>
<td>telephone number</td>
<td>Phone</td>
<td></td>
<td>telephonenumber</td>
<td>telephonenumber</td>
</tr>
</tbody>
</table>

The LDAP ObjectClass for groups is `group`, `memberOfNames`, (`group-of-names` for Active Directory) or `memberOfUniqueNames`.

For more information about ObjectClasses and attributes, see the following references:

- Microsoft Active Directory:
  - ObjectClasses: All Classes on MSDN
  - Attributes: All Attributes on MSDN

- OpenLDAP: RFC 4512
Troubleshoot Realms and User Downloads

If you notice unexpected server connection behavior, consider tuning your realm configuration, device settings, or server settings. For other related troubleshooting information, see:

- Troubleshoot the User Agent Identity Source, on page 1280
- Troubleshoot the ISE Identity Source, on page 1284
- Troubleshoot the Captive Portal Identity Source, on page 1296
- Troubleshoot User Control, on page 308

Symptom: Access control policy doesn't match group membership

This solution applies to an AD domain that is in a trust relationship with other AD domains. In the following discussion, external domain means a domain other than the one to which the user logs in.

If a user belongs to a group defined in a trusted external domain, Firepower doesn't track membership in the external domain. For example, consider the following scenario:

- Domain controllers 1 and 2 trust each other
- Group A is defined on domain controller 2
- User mparvinder in controller 1 is a member of Group A

Even though user mparvinder is in Group A, the Firepower access control policy rules specifying membership Group A don't match.

Solution: Create a similar group in domain controller 1 that contains has all domain 1 accounts that belong to group A. Change the access control policy rule to match any member of Group A or Group B.

Symptom: Access control policy doesn't match child domain membership

If a user belongs to a domain that is child of parent domain, Firepower doesn't track the parent/child relationships between domains. For example, consider the following scenario:

- Domain child.parent.com is child of domain parent.com
- User mparvinder is defined in child.parent.com

Even though user mparvinder is in a child domain, the Firepower access control policy matching the parent.com don't match mparvinder in the child.parent.com domain.

Solution: Change the access control policy rule to match membership in either parent.com or child.parent.com.

Symptom: Realm or realm directory test fails

The Test button on the directory page sends an LDAP query to the hostname or IP address you entered. If it fails, check the following:

- The Hostname you entered resolves to the IP address of an LDAP server or Active Directory domain controller.
- The IP Address you entered is valid.
The Test button on the realm configuration page verifies the following:

- DNS resolves the AD Primary Domain to an LDAP server or Active Directory domain controller’s IP address.
- The AD Join Username and AD Join Password are correct.
  
  AD Join Username must be fully qualified (for example, administrator@mydomain.com, not administrator).
- The user has sufficient privileges to create a computer in the domain and join the Firepower Management Center to the domain as a Domain Computer.

**Symptom: User timeouts are occurring at unexpected times**

If you notice the system performing user timeouts at unexpected intervals, confirm that the time on your User Agent or ISE server is synchronized with the time on the Firepower Management Center. If the appliances are not synchronized, the system may perform user timeouts at unexpected intervals.

**Symptom: Users are not included or excluded as specified in your realm configuration**

If you configure an Active Directory realm that includes or excludes users who are members of a sub-group on your server, note that Microsoft Windows servers limit the number of users they report:

- 5000 users per group on Microsoft Windows Server 2008 or 2012

If necessary, you can modify your server configuration to increase this default limit and accommodate more users.

**Symptom: Users are not downloaded**

Possible causes follow:

- If you have the realm Type configured incorrectly, users and groups cannot be downloaded because of a mismatch between the attribute the Firepower system expects and what the repository provides. For example, if you configure Type as LDAP for a Microsoft Active Directory realm, the Firepower system expects the uid attribute, which is set to none on Active Directory. (Active Directory repositories use sAMAccountName for the user ID.)

  **Solution:** Set the realm Type field appropriately: AD for Microsoft Active Directory or LDAP for another supported LDAP repository.

- Users in Active Directory groups that have special characters in the group or organizational unit name might not be available for identity policy rules. For example, if a group or organizational unit name contains the characters asterisk (*), equals (=), or backslash (\), users in those groups are not downloaded and can't be used for identity policies.

  **Solution:** Remove special characters from the group or organizational unit name.

**Symptom: User data for previously-unseen ISE and User Agent users is not displaying in the web interface**

After the system detects activity from an ISE or User Agent user whose data is not yet in the database, the system retrieves information about them from the server. In some cases, the system requires additional time to successfully retrieve this information from Active Directory servers. Until the data retrieval succeeds, activity seen by the ISE or User Agent user is not displayed in the web interface.
Note that this may also prevent the system from handling the user's traffic using access control rules.

**Symptom: User data in events is unexpected**

If you notice user or user activity events contain unexpected IP addresses, check your realms. The system does not support configuring multiple realms with the same **AD Primary Domain** value.

### About Identity Policies

Identity policies contain identity rules. Identity rules associate sets of traffic with a realm and an authentication method: passive authentication, active authentication, or no authentication.

With the exception noted at the end of this topic, you must configure realms and authentication methods you plan to use before you can invoke them in your identity rules:

- You configure realms outside of your identity policy, at **System > Integration > Realms**. For more information, see [Create a Realm](#)

- You configure the User Agent and ISE, passive authentication identity sources, at **System > Integration > Identity Sources**. For more information, see [Configure the User Agent](#) and [Configure ISE](#).

- You configure captive portal, the active authentication identity source, in the identity policy. For more information, see [How to Configure the Captive Portal](#).

After you add multiple identity rules to a single identity policy, order the rules. The system matches traffic to rules in top-down order by ascending rule number. The first rule that traffic matches is the rule that handles the traffic.

After you configure one or more identity policies, you must associate one identity policy with your access control policy. When traffic on your network matches the conditions in your identity rule, the system associates the traffic with the specified realm and authenticates the users in the traffic using the specified identity source.

If you do not configure an identity policy, the system does not perform user authentication.

### Exception to creating an identity policy

An identity policy is not required if all of the following are true:

- You use the ISE identity source.
- You do not use users or groups in access control policies.
- You use Security Group Tags (SGT) in access control policies. For more information, see [ISE SGT vs Custom SGT Rule Conditions](#).

### Related Topics

[User Identity Sources](#), on page 1277
Create a Realm

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any</td>
<td>Any</td>
<td>Administrator,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Access Admin,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Network Admin</td>
</tr>
</tbody>
</table>

For more information about realm configuration fields, see Realm Fields, on page 1331.

---

**Note**

You must specify a unique AD Primary Domain for every Microsoft Active Directory (AD) realm. Although the system allows you to specify the same AD Primary Domain for different AD realms, the system won't function properly. This happens because system assigns a unique ID to every user and group in each realm; therefore, the system cannot definitively identify any particular user or group.

---

**Procedure**

**Step 1**
Log in to the Firepower Management Center.

**Step 2**
Click System > Integration.

**Step 3**
Click Realms.

**Step 4**
To create a new realm, click New Realm.

**Step 5**
To perform other tasks (such as enable, disable, or delete a realm), see Manage a Realm, on page 1339.

**Step 6**
Enter realm information as discussed in Realm Fields, on page 1331.

**Step 7**
Click OK.

**Step 8**
Configure at least one directory as discussed in Configure a Realm Directory, on page 1333.

**Step 9**
Configure user and user group download (required for access control) as discussed in Download Users and Groups, on page 1334.

**Step 10**
Click the Realm Configuration tab.

**Step 11**
Enter user session timeout values, in minutes, for Authenticated Users, Failed Authentication Users, and Guest Users.

---

**What to do next**

- Configure a Realm Directory, on page 1333
- Edit, delete, enable, or disable a realm; see Manage a Realm, on page 1339.
- Compare Realms, on page 1340.
- Optionally, monitor the task status; see Viewing Task Messages, on page 261.
Realm Fields

The following fields are used to configure a realm.

**Realm Configuration Fields**

These settings apply to all Active Directory servers or domain controllers (also referred to as directories) in a realm.

**Name**

A unique name for the realm. The system supports alphanumeric and special characters.

**Description**

(Optional.) Enter a description of the realm.

**AD Primary Domain**

For Microsoft Active Directory realms only. Domain for the Active Directory server where users should be authenticated.

---

**Note**

You must specify a unique **AD Primary Domain** for every Microsoft Active Directory (AD) realm. Although the system allows you to specify the same **AD Primary Domain** for different AD realms, the system won't function properly. This happens because system assigns a unique ID to every user and group in each realm; therefore, the system cannot definitively identify any particular user or group.

**Directory Username and Directory Password**

The distinguished username and password for a user with appropriate access to the user information you want to retrieve.

Note the following:

- For Microsoft Active Directory, the user does not need elevated privileges. You can specify any user in the domain.

- For OpenLDAP, the user's access privileges are determined by the `<level>` parameter discussed in section 8 of the OpenLDAP specification. The user's `<level>` should be `auth` or better.

- The user name must be fully qualified (for example, `administrator@mydomain.com`, not `administrator`).

**Base DN**

The directory tree on the server where the Firepower Management Center should begin searching for user data.

Typically, the base distinguished name (DN) has a basic structure indicating the company domain name and operational unit. For example, the Security organization of the Example company might have a base DN of `ou=security,dc=example,dc=com`.

**Group DN**

The directory tree on the server where the Firepower Management Center should search for users with the group attribute. A list of supported group attributes is shown in Supported Server Object Class and Attribute Names, on page 1326.
Neither the group name nor the organizational unit name can contain special characters like asterisk (*), equals (=), or backslash (\) because users in those groups are not downloaded and cannot be used in identity policies.

**Group Attribute**

(Optional.) The group attribute for the server, **Member** or **Unique Member**.

**Type**

The type of realm, **AD** for Microsoft Active Directory or **LDAP** for other supported LDAP repositories. For a list of supported LDAP repositories, see Supported Servers for Realms, on page 1325.

**Note**

Only captive portal supports an LDAP realm.

These following fields are available when you edit an existing realm.

**User Session Timeout**

Enter the number of minutes before user sessions time out. The default is 1440 (24 hours) after the user's login event. After the timeout is exceeded, the user's session ends; if the user continues to access the network without logging in again, the user is seen by the Firepower Management Center as Unknown.

**Note**

The user session timeout values apply to both active authentication (captive portal) and passive authentication (TS Agent, user agent, ISE). Setting a large value might prevent user sessions from ending, resulting in those sessions being claimed by other users.

**Realm Directory Fields**

These settings apply to individual servers (such as Active Directory domain controllers) in a realm.

**Encryption**

The encryption method to use for the Firepower Management Center-server connection:

- **STARTTLS**—encrypted LDAP connection
- **LDAPS**—encrypted LDAP connection
- **None**—unencrypted LDAP connection (unsecured traffic)

**Hostname / IP Address**

The host name or IP address of an Active Directory domain controller. If you specify an Encryption method, you must specify a host name in this field.

**Port**

The port to use for the Firepower Management Center-controller connection.
SSL Certificate

The SSL certificate to use for authentication to the server. You must configure **STARTTLS** or **LDAPS** as the Encryption type in order to use an SSL certificate.

If you are using a certificate to authenticate, the name of the server in the certificate must match the server **Hostname / IP Address**. For example, if you use 10.10.10.250 as the IP address but `computer1.example.com` in the certificate, the connection fails.

**User Download Fields**

**Available Groups, Add to Include, Add to Exclude**

Identifies the groups to download and make available for user awareness and user control.

- If you leave a group in the **Available Groups** box, the group is not downloaded.
- If you move a group to the **Add to Include** box, the group is downloaded and user data is available for user awareness and user control.
- If you move a group to the **Add to Exclude** box, the group name only is downloaded. Users in the group are not downloaded.
- To include users from groups that are not included, enter the user name in the field below **Groups to Include** and click **Add**.
- To exclude users from groups that are not excluded, enter the user name in the field below **Groups to Exclude** and click **Add**.

**Note**

The users that are downloaded to the Firepower Management Center is calculated using the formula $R = I - (E + e) + i$, where

- $R$ is list of downloaded users
- $I$ is included groups
- $E$ is excluded groups
- $e$ is excluded users
- $i$ is included users

**Begin automatic download at, Repeat every**

Specifies the frequency of the automatic downloads.

**Download users and groups (required for user access control)**

Enables you to download users and groups for user awareness and user control.

**Configure a Realm Directory**

This procedure enables you to create a realm directory, which corresponds to an LDAP server or a Microsoft Active Directory domain controller. An Active Directory server can have multiple domain controllers, each of which is capable of authenticating different users and groups.
Before you begin

To optionally use an SSL certificate to authenticate with the directory, PKI Objects or have your certificate data and key available on the machine from which you're accessing the Firepower Management Center.

Procedure

**Step 1**
If you haven't done so already, log into the Firepower Management Center and click **Integration > Realms**.

**Step 2**
On the Realms tab page, click the name of the realm for which to configure a directory.

**Step 3**
On the Directory tab page, click **Add Directory**.

**Step 4**
Enter the **Hostname / IP Address** and **Port** for the LDAP server or Active Directory domain controller. The system sends an LDAP query to the hostname or IP address you specify. If the host name resolves to the IP address of an LDAP server or Active Directory domain controller, the **Test** succeeds.

**Step 5**
Select an **Encryption Mode**.

**Step 6**
(Optional.) Choose an **SSL Certificate** from the list or click the add icon (➕) to add a certificate.

**Step 7**
To test the connection, click **Test**.

**Step 8**
Click **OK**.

**Step 9**
Click **Save**. You are returned to the Realms tab page

**Step 10**
If you haven't already enabled the realm, on the Realms tab page, slide **State** to enabled.

**What to do next**

- **Download Users and Groups**, on page 1334.

**Download Users and Groups**

This section discusses how to download users and groups from your Active Directory server to the Firepower Management Center. If you do not specify any groups to include, the system retrieves user data for all the groups that match the parameters you provided. For performance reasons, Cisco recommends that you explicitly include only the groups that represent the users you want to use in access control.
The maximum number of users the Firepower Management Center can retrieve from the server depends on your Firepower Management Center model. If the download parameters in your realm are too broad, the Firepower Management Center obtains information on as many users as it can and reports the number of users it failed to retrieve in the Task tab of the Message Center.

**Note**

User names that include Unicode characters do not display in the Firepower Management Center. Before you download users and groups, make sure to replace Unicode characters with alphanumeric characters.

For more information about realm configuration fields, see Realm Fields, on page 1331.

**Procedure**

**Step 1** Log in to the Firepower Management Center.

**Step 2** Click System > Integration > Realms.

**Step 3** To download users and groups manually, click the download icon (اقل) next to the realm to download users and user groups. If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration. You can skip the remainder of this procedure.

**Step 4** To configure the realm for automatic user and group download, click the edit icon (/edit) next to the realm to configure for automatic user and group download.

**Step 5** On the User Access Control tab page, check Download users and groups (required for user access control).

**Step 6** Select a time to Begin automatic download at from the lists.

**Step 7** Select a download interval from the Repeat Every list.

**Step 8** To include or exclude user groups from the download, choose user groups from the Available Groups column and click Add to Include or Add to Exclude.

Separate multiple users with commas. You can also use an asterisk (*) as a wildcard character in this field.

**Note** You must Add to Include if you want to perform user control on users in that group.

Use the following guidelines:

- If you leave a group in the Available Groups box, the group is not downloaded.

- If you move a group to the Add to Include box, the group is downloaded and user data is available for user awareness and user control.

- If you move a group to the Add to Exclude box, the group is downloaded and user data is available for user awareness, but not for user control.

- To include users from groups that are not included, enter the user name in the field below Groups to Include and click Add.

- To exclude users from groups that are not excluded, enter the user name in the field below Groups to Exclude and click Add.
Create an Identity Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any</td>
<td>Any</td>
<td>Administrator, Access Admin, Network Admin</td>
</tr>
</tbody>
</table>

Before you begin

An identity policy is required to use users and groups in a realm in access control policies. Create and enable one or more realms as described in Create a Realm, on page 1330.

An identity policy is not required if all of the following are true:

- You use the ISE identity source.
- You do not use users or groups in access control policies.
- You use Security Group Tags (SGT) in access control policies. For more information, see ISE SGT vs Custom SGT Rule Conditions.

Procedure

Step 1 Log in to the Firepower Management Center.
Step 2 Click Policies > Access Control > Identity and click New Policy.
Step 3 Enter a Name and, optionally, a Description.
Step 4 Click Save.
Step 5 To add a rule to the policy, click Add Rule as described in Create an Identity Rule, on page 1337.
Step 6 To create a rule category, click Add Category.
Step 7 To configure captive portal active authentication, click the Active Authentication tab as described in How to Configure the Captive Portal for User Control, on page 1287.
Step 8 Click Save to save the identity policy.

What to do next

- Add rules to your identity policy that specify which users to match and other options; see Create an Identity Rule, on page 1337.
- Associate the identity policy with an access control policy to allow or block selected users from accessing specified resources; see Associating Other Policies with Access Control, on page 636.
- Deploy configuration changes to managed devices; see Deploy Configuration Changes, on page 277.

If you encounter issues, see Troubleshoot User Control, on page 308.
# Create an Identity Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any</td>
<td>Any</td>
<td>Administrator,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Access Admin,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Network Admin</td>
</tr>
</tbody>
</table>

For details about configuration options for identity rules, see Identity Rule Fields, on page 1338.

## Procedure

**Step 1** If you haven't done so already, log in to the Firepower Management Center.

**Step 2** Click Policies > Access Control > Identity.

**Step 3** Click edit (-pencil) next to the identity policy to which to add the identity rule.

If a view icon (-eye) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4** Click Add Rule.

**Step 5** Enter a Name.

**Step 6** Specify whether the rule is Enabled.

**Step 7** To add the rule to an existing category, indicate where you want to Insert the rule. To add a new category, click Add Category.

**Step 8** Choose a rule Action from the list.

**Step 9** Click the Realms & Settings tab.

**Step 10** Choose a realm for the identity rule from the Realms list. You must associate a realm with every identity rule. The only exception to the realm requirement is implementing user control using only the ISE SGT attribute tag. In this case, you do not need to configure a realm for the ISE server. ISE SGT attribute conditions can be configured in policies with or without an associated identity policy.

**Step 11** If you're configuring captive portal, see How to Configure the Captive Portal for User Control, on page 1287.

**Step 12** (Optional) To add conditions to the identity rule, see Rule Condition Types, on page 290.

**Step 13** Click Add.

**Step 14** In the policy editor, set the rule position. Click and drag or use the right-click menu to cut and paste. Rules are numbered starting at 1. The system matches traffic to rules in top-down order by ascending rule number. The first rule that traffic matches is the rule that handles that traffic. Proper rule order reduces the resources required to process network traffic and prevents rule preemption.

**Step 15** Click Save.

## Related Topics
- Snort® Restart Scenarios, on page 279
Identity Rule Fields

Use the following fields to configure identity rules.

**Enabled**

Choosing this option enables the identity rule in the identity policy. Deselecting this option disables the identity rule.

**Action**

Specify the type of authentication you want to perform on the users in the specified realm: **Passive Authentication** (default), **Active Authentication**, or **No Authentication**. You must fully configure the authentication method, or *identity source*, before selecting it as the action in an identity rule.

**Caution**

Adding the first or removing the last active authentication rule when SSL decryption is disabled (that is, when the access control policy does not include an SSL policy) restarts the Snort process when you deploy configuration changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See **Snort® Restart Traffic Behavior**, on page 280 for more information.

Note that an active authentication rule has either an **Active Authentication** rule action, or a **Passive Authentication** rule action with **Use active authentication if passive authentication cannot identify user** selected.

For information about which passive and active authentication methods are supported in your version of the Firepower System, see **About User Identity Sources**, on page 1277.

**Realm**

The realm containing the users you want to perform the specified **Action** on. You must fully configure a realm before selecting it as the realm in an identity rule.

**Use active authentication if passive authentication cannot identify user**

Selecting this option authenticates users using captive portal active authentication if a passive or a VPN authentication fails to identify them. You must configure captive portal active authentication in your identity policy in order to select this option.

If you disable this option, users that do not have a VPN identity or that passive authentication cannot identify are identified as Unknown.

**Identify as Special Identities/Guest if authentication cannot identify user**

This field is displayed only if you configure **Active Authentication** (that is, captive portal authentication) as the rule **Action**.

**Authentication Type**

The method to use to perform captive portal active authentication. The selections vary depending on the type of realm, LDAP or AD:

- **Choose HTTP Basic** if you want to authenticate users using an unencrypted HTTP Basic Authentication (BA) connection. Users log in to the network using their browser's default authentication popup window.

  Most web browsers cache the credentials from HTTP Basic logins and use the credentials to seamlessly begin a new session after an old session times out.
• Choose **NTLM** to authenticate users using a NT LAN Manager (NTLM) connection. This selection is available only when you select an AD realm. If transparent authentication is configured in a user's browser, the user is automatically logged in. If transparent authentication is not configured, users log in to the network using their browser's default authentication popup window.

• Choose **HTTP Negotiate** to allow the captive portal server to choose between HTTP Basic or NTLM for the authentication connection. This selection is available only when you select an AD realm.

**Note**

If you are creating an identity rule to perform HTTP Negotiate captive portal and you have DNS resolution configured, you must configure your DNS server to resolve the fully qualified domain name (FQDN) of the captive portal device. The FQDN must match the hostname you provided when configuring DNS.

For ASA with FirePOWER Services, the FQDN must resolve to the IP address of the routed interface used for captive portal.

---

**Manage a Realm**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any</td>
<td>Any</td>
<td>Administrator, Access Admin, Network Admin</td>
</tr>
</tbody>
</table>

This section discusses how to perform various maintenance tasks for a realm using controls on the Realms page. Note the following:

• If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

• If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Procedure**

**Step 1** Log in to the Firepower Management Center.

**Step 2** Click **System > Integration**.

**Step 3** Click **Realms**.

**Step 4** To delete a realm, click the delete icon (삭제).

**Step 5** To edit a realm, click the edit icon (편집) next to the realm and make changes as described in **Create a Realm**, on page 1330.

**Step 6** To enable a realm, slide **State** to the right; to disable a realm, slide it to the left.

**Step 7** To download users and user groups, click the download icon (다운로드).
**Compare Realms**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any</td>
<td>Any</td>
<td>Administrator, Security Approver, Access Admin, Network Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Log in to the Firepower Management Center.
**Step 2** Click System > Integration.
**Step 3** Click Realms.
**Step 4** Click System > Integration.
**Step 5** Click Realms.
**Step 6** Click Compare Realms.
**Step 7** Choose Compare Realm from the Compare Against list.
**Step 8** Choose the realms you want to compare from the Realm A and Realm B lists.
**Step 9** Click OK.
**Step 10** To navigate individually through changes, click Previous or Next above the title bar.
**Step 11** (Optional.) Click Comparison Report to generate the realm comparison report.
**Step 12** (Optional.) Click New Comparison to generate a new realm comparison view.

**Manage an Identity Policy**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any</td>
<td>Any</td>
<td>Administrator, Access Admin, Network Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays policies created in the current domain, which you can edit. It also displays policies created in ancestor domains, which you cannot edit. To view and edit policies created in a lower domain, switch to that domain.
Manage an Identity Rule

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Control</td>
<td>Any</td>
<td>Any</td>
<td>Administrator, Access Admin, Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 If you haven't already done so, log in to the Firepower Management Center.
Step 2 Click Policies > Access Control > Identity.
Step 3 Click the edit icon (✎) next to the policy you want to edit. If a view icon ( глаз ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
Step 4 To edit an identity rule, click the edit icon (✎) and make changes as described in Create an Identity Policy, on page 1336.
Step 5 To delete an identity rule, click the delete icon (🗑).
Step 6 To create a rule category, click Add Category and choose the position and the rule.
Step 7 Click Save.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
Manage an Identity Rule
PART XVI

Correlation and Compliance

- Compliance White Lists, on page 1345
- Correlation Policies, on page 1361
- Traffic Profiling, on page 1399
- Remediations, on page 1411
CHAPTER 70

Compliance White Lists

The following topics describe how to configure compliance white lists before you add them to correlation policies.

- Introduction to Compliance White Lists, on page 1345
- Creating a Compliance White List, on page 1350
- Managing Compliance White Lists, on page 1356
- Managing Shared Host Profiles, on page 1358

Introduction to Compliance White Lists

A compliance white list, sometimes abbreviated as white list, is a set of criteria that specifies which operating systems, applications (web and client), and protocols are allowed on hosts on your network. The system generates an event if a host violates the white list.

A compliance white list has two main components:

- **Targets** are the hosts you select for white list evaluation. You can evaluate all or some monitored hosts, constraining by subnet, VLAN, and host attribute. In a multidomain deployment, you can target domains and subnets within or across domains.

- **Host profiles** specify the compliance criteria for the targets. The global host profile is operating system agnostic. You can also configure operating-system specific host profiles, either unique to one white list or shared across white lists.

The Cisco Talos Security Intelligence and Research Group (Talos) provides a default white list with recommended settings. You can also create custom white lists. A simple custom white list might allow only hosts running a certain operating system. A more complex white list might allow all operating systems, but specify which operating system a host must use to run a certain application protocol on a specific port.

---

**Note**

The system can add hosts to the network map from exported NetFlow records, but the available information for these hosts is limited; see Differences between NetFlow and Managed Device Data, on page 1204. This limitation may affect the way you build compliance white lists.
Implementing Compliance White Lists

To implement white lists, add the white list to an active correlation policy. The system evaluates the targets and assigns every host a corresponding attribute:

• Compliant — The host does not violate the white list.
• Non-Compliant — The host violates the white list.
• Not Evaluated — The host is not a target of the white list, the host is currently being evaluated, or the system has insufficient information to determine whether the host is in compliance.

Note

To delete the host attribute, delete its corresponding white list. Deactivating, deleting, or removing a white list from a correlation policy does not delete the host attribute, nor does it change the attribute’s value for each host.

After its initial evaluation, the system generates a white list event whenever a monitored host goes out of compliance with an active white list; it also records a white list violation.

You can use workflows, dashboards, and network maps to monitor system-wide compliance activity and determine when and how an individual host violates your white lists. You can also automatically respond to white list violations with remediations and alerts.

Example: Restricting HTTP to Web Servers

Your security policy states that only web servers may run HTTP. You create a white list that evaluates your entire network, excluding your web farm, to determine which hosts are running HTTP.

Using the network map and the dashboard, you can obtain an at-a-glance summary of the compliance of your network. In just a few seconds, you can determine exactly which hosts in your organization are running HTTP in violation of your policy, and take appropriate action.

Then, using the correlation feature, you can configure the system to alert you whenever a host that is not in your web farm starts running HTTP.

Related Topics

Configuring Correlation Policies, on page 1362

Compliance White List Target Networks

A target network specifies the hosts you want to evaluate for white list compliance. A white list can have more than one target network, and it evaluates hosts that meet the criteria of any of its targets.

Initially, you constrain a target network by IP address or range. In multidomain deployments, the initial constraints also include a domain.

The system-provided default white list targets all monitored hosts: 0.0.0.0/0 and ::/0. In a multidomain deployment, the default white list is constrained to (and only available in) the Global domain.

If you modify a target network or a host so that the host is no longer a valid target for the white list, the host is no longer evaluated by the white list and is considered neither compliant nor non-compliant.
Surveying and Refining Target Networks

When you add a target network to a white list, the system prompts you to survey the network map to help you characterize compliant hosts. The survey adds a target to the white list that represents the hosts you surveyed.

You can survey a subnet or individual host. In a multidomain deployment, you can survey an entire domain, or you can survey across domains. Surveying an ancestor domain causes the system to survey that domain’s descendants.

In addition to the added target, the survey also populates the white list with one host profile for each operating system detected in the survey. These host profiles allow all the clients, application protocols, web applications, and protocols that the system has detected on the applicable operating systems.

After you survey a target network (or skip the survey), refine the target. You can exclude hosts by IP address, or constrain target networks by host attribute or VLAN.

Targeting Domains with Compliance White Lists

In a multidomain deployment, domains and target networks are closely linked.

- Leaf-domain administrators can create white lists that evaluate hosts within their leaf domains.
- Higher-level domain administrators can create white lists that evaluate hosts across domains. You can target different subnets in different domains in the same white list.

Consider a scenario where you are a Global domain administrator, and you want to apply the same compliance criteria to web servers across the entire deployment. You can create one white list in the Global domain that defines the compliance criteria. Then, constrain the white list with target networks that specify the IP space (or individual IP addresses) of the web servers in each leaf domain.

**Note**

In addition to targeting IP addresses and ranges in leaf domains, you can also constrain a target network using a higher-level domain. Targeting a subnet in a higher-level domain targets the same subnet in each of the descendant leaf domains. The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.

Compliance White List Host Profiles

In a compliance white list, host profiles specify which operating systems, clients, application protocols, web applications, and protocols are allowed to run on the target hosts. There are three types of host profile you can use in a compliance white list; each type appears differently in the compliance white list editor.

**Table 198: Compliance White List Host Profile Types**

<table>
<thead>
<tr>
<th>Host Profile Type</th>
<th>Appearance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>global</td>
<td>Any Operating System</td>
<td>specifies what is allowed to run on target hosts, regardless of operating system</td>
</tr>
<tr>
<td>operating-system specific</td>
<td>is listed in plain text</td>
<td>specifies what is allowed to run on target hosts of a particular operating system</td>
</tr>
</tbody>
</table>
Operating System-Specific Host Profiles

In a compliance white list, operating-system specific host profiles indicate not only which operating systems are allowed to run on your network, but also the application protocols, clients, web applications, and protocols that are allowed to run on those operating systems.

For example, you could require that compliant hosts run a particular version of Microsoft Windows. As another example, you could allow SSH to run on Linux hosts on port 22, and further restrict the vendor and version of the SSH client.

Create one host profile for each operating system you want to allow on your network. To disallow an operating system on your network, do not create a host profile for that operating system. For example, to make sure that all the hosts on your network are running Windows, configure the white list to only contain host profiles for that operating system.

Unidentified hosts remain in compliance with all white lists until they are identified. You can, however, create a white list host profile for unknown hosts. Unidentified hosts are hosts about which the system has not yet gathered enough information to identify their operating systems. Unknown hosts are hosts whose operating systems do not match known fingerprints.

Shared Host Profiles

In a compliance white list, shared host profiles are tied to specific operating systems, but you can use each shared host profile in more than one white list.

For example, you might have offices worldwide with a separate white list for each location, but you want to use the same profile for all hosts running Apple Mac OS X. You can create a shared profile for that operating system and use it in all your white lists.

The default white list uses a special category of shared host profiles, called built-in host profiles. These profiles use built-in application protocols, web applications, protocols, and clients. In the compliance white list editor, the system marks these profiles with the built-in host profile icon ( ).

In a multidomain deployment, the system displays shared host profiles created in the current domain, which you can edit. It also displays shared host profiles from ancestor domains, which you cannot edit. To view and edit shared host profiles created in a lower domain, switch to that domain.

If you modify a shared host profile (including built-ins), or modify a built-in application protocol, protocol, or client, your change affects every white list that uses it. If you make unintended changes to or delete these built-in elements, you can reset to factory defaults.
White List Violation Triggers

The white list compliance of a host can change when the system:

- detects a change in a host’s operating system
- detects an identity conflict for a host’s operating system or an application protocol on the host
- detects a new TCP server port (for example, a port used by SMTP or web servers) active on a host, or a new UDP server running on a host
- detects a change in a discovered TCP or UDP server running on a host, for example, a version change due to an upgrade
- detects a new client or web application running on a host
- drops a client or web application from its database due to inactivity
- detects that a host is communicating with a new network or transport protocol
- detects a new jailbroken mobile device
- detects that a TCP or UDP port has closed or timed out on a host

In addition, you can trigger a compliance change for a host by using the host input feature or the host profile to:

- add a client, protocol, or server to a host
- delete a client, protocol, or server from a host
- set the operating system definition for a host
- change a host attribute for a host so that the host is no longer a valid target

Note
To avoid overwhelming you with events, the system does not generate white list events for non-compliant hosts on its initial evaluation, nor hosts made non-compliant as a result of you modifying an active white list or shared host profile. The violations, however, are still recorded. If you want to generate white list events for all non-compliant targets, purge discovery data. Rediscovering network assets may trigger white list events.

Example: Operating System Compliance

If your white list specifies that only Microsoft Windows hosts are allowed on your network, and the system detects a host running Mac OS X, the system generates a white list event. In addition, the host attribute associated with the white list changes from Compliant to Non-Compliant for that host.

For the host in this example to come back into compliance, one of the following must occur:

- you edit the white list so that the Mac OS X operating system is allowed
- you manually change the operating system definition of the host to Microsoft Windows
- the system detects that the operating system has changed back to Microsoft Windows
Example: Deleting a Non-Compliant Asset from the Network Map

If your white list disallows the use of FTP, and you then delete FTP from the application protocols network map or from an event view, hosts running FTP become compliant. However, if the system detects the application protocol again, the system generates a white list event and the hosts become non-compliant.

Example: Triggering on Complete Information Only

If your white list allows only TCP FTP traffic on port 21, and the system detects indeterminate activity on port 21/TCP, the white list does not trigger. The white list triggers only when the system identifies the traffic as something other than FTP, or you use the host input feature to designate the traffic as non-FTP traffic. The system does not record a violation with only partial information.

Creating a Compliance White List

When you create a white list, the system prompts you to survey your network to create an initial target and to help you characterize compliant hosts.

Procedure

**Step 1** Choose Policies > Correlation, then click the White List tab.

**Step 2** Click New White List.

**Step 3** Optionally, enter the IP Address and Netmask for an initial target network. In a multidomain deployment, choose the Domain where the target network resides.

**Tip** To survey the entire monitored network, use the default values of 0.0.0.0/0 and ::/0.

**Note** After you choose a domain for the target network, you cannot change it. Targeting a subnet in a higher-level domain targets the same subnet in each of the descendant leaf domains. The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.

**Step 4** Add the target network:

- Add—To add the target network without a survey, click Add.
- Add and Survey Network—To add and survey the target network, click Add and Survey Network.
- Skip—To create a white list without surveying your network, click Skip.

**Step 5** Optionally, enter a new Name and Description for the white list.

**Step 6** Optionally, Allow Jailbroken Mobile Devices on your network. Disabling this option causes jailbroken devices to generate white list violations.

**Step 7** Add at least one Target Network to the white list, as described in Setting Target Networks for a Compliance White List, on page 1351.
Step 8  Characterize compliant hosts using **Allowed Host Profiles**:

- Global Host Profile—To edit the white list’s global host profile, click **Any Operating System** and proceed as described in *Building White List Host Profiles*, on page 1352.

- Edit Surveyed Profiles—To edit an existing operating system-specific host profile created by a network survey, click its name and proceed as described in *Building White List Host Profiles*, on page 1352.

- Create New Profiles—To create a new operating system-specific host profile for this white list, click the add icon (.addButton) next to **Allowed Host Profiles**, and proceed as described in *Building White List Host Profiles*, on page 1352.

- Add Shared Host Profile—To add an existing shared host profile to the white list, click **Add Shared Host Profile**, select the shared host profile you want to add, then click **OK**. Shared host profiles appear in italics.

Step 9  Click **Save White List**.

### What to do next

- Add the white list to an active correlation policy as described in *Configuring Correlation Policies*, on page 1362. The system immediately starts evaluating the white list and generating violations.

### Related Topics

- *Compliance White List Target Networks*, on page 1346
- *Creating a Compliance White List Based on Selected Hosts*, on page 1747
- *Firepower System IP Address Conventions*, on page 14

### Setting Target Networks for a Compliance White List

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

When you add a target network, you can survey it to characterize compliant hosts. This survey populates the white list with one host profile for each operating system detected in the survey. These host profiles allow all the clients, application protocols, web applications, and protocols that the system has detected on the applicable operating systems.

### Procedure

**Step 1**  In the compliance white list editor, click **Add Target Network**.

**Step 2**  Enter the **IP Address** and **Netmask** for the target network.

**Step 3**  In a multidomain deployment, choose the **Domain** where the target network resides.

**Note**  After you choose a domain for the target network, you cannot change it. Targeting a subnet in a higher-level domain targets the **same** subnet in **each** of the descendant leaf domains. The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.
Step 4 Add the target network:

- Add — To add the target network without a survey, click Add.
- Add and Survey Network — To add and survey the target network, click Add and Survey Network.

Step 5 Optionally, click the new target to configure it further:

- Name — Enter a new Name.
- Add Networks — To target additional hosts, click the add icon ( ), then enter the IP Address and Netmask. To exclude the network from white list compliance, select Exclude.
- Add Host Attributes — To target hosts with a specific host attribute, click the add icon ( ), then specify the Attribute and its Value.
- Add VLANs — To target a VLAN, click the add icon ( ), then type a VLAN number (for 802.1q VLANs).
- Delete — To remove a target restriction, click the delete icon ( ).

Step 6 To immediately implement all changes made since the last time you saved, click Save White List.

Related Topics
- Compliance White List Target Networks, on page 1346
- Firepower System IP Address Conventions, on page 14

Building White List Host Profiles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Host profiles specify the white list’s compliance criteria, that is, which operating systems, clients, application protocols, web applications, and protocols are allowed to run on the target hosts.

Every white list has a global host profile which is operating-system agnostic. For example, instead of editing multiple Microsoft Windows and Linux host profiles to allow Mozilla Firefox, you can configure the global host profile to allow Firefox regardless of the operating system where it was detected.

You can also configure operating-system specific host profiles, either unique to one white list or shared across white lists.

Note

If you modify a shared host profile (including built-ins), or modify a built-in application protocol, protocol, or client, your change affects every white list that uses it. If you make unintended changes to or delete these built-in elements, you can reset to factory defaults.

Before you begin

- Create or edit a host profile within a white list as described in Editing a Compliance White List, on page 1357, or create or edit a shared host profile as described in Managing Shared Host Profiles, on page 1358.
**Procedure**

**Step 1**  
In the compliance white list host profile editor, configure a host profile:

- **Name** — Type a Name.

- **Operating System** — To restrict the host profile to a specific operating system, use the OS Vendor, OS Name, and Version drop-down lists. Because its purpose is to apply to hosts running any operating system, you cannot restrict a global host profile.

- **Application Protocol** — To allow an application protocol, click the add icon ( + ) and proceed as described in White Listing an Application Protocol, on page 1353.

- **Client** — To allow a client, click the add icon ( + ) and proceed as described in White Listing a Client, on page 1354.

- **Web Application** — To allow a web application, click the add icon ( + ) and proceed as described in White Listing a Web Application, on page 1355.

- **Protocol** — To allow a protocol, click the add icon ( + ) and proceed as described in White Listing a Protocol, on page 1355.

- **Delete** — To disallow an item you previously allowed, click the delete icon ( - ).

- **Edit Properties** — To edit the properties of an allowed application protocol, client, or protocol, click its name. The changes you make are reflected in every host profile that uses that element.

**Tip**  
Select the appropriate Allow all... check box to allow all application protocols, clients, or web applications for hosts matching this profile.

**Step 2**  
To immediately implement all changes made since the last time you saved, click Save White List (or Save All Profiles if you are editing a shared host profile).

---

**White Listing an Application Protocol**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Using white list host profiles, you can white list application protocols either globally or on specific operating systems. Optionally, you can restrict the application protocol by port, vendor, or version. For example, you could allow a particular version of OpenSSH to run on Linux hosts on port 22/TCP.

**Procedure**

**Step 1**  
While you are creating or modifying a white list host profile, click the add icon ( + ) next to Allowed Application Protocols (or next to Globally Allowed Application Protocols if you are modifying the global host profile).

**Step 2**  
You have two options:
• If the application protocols you want to allow are listed, select them. The web interface lists application protocols that have been allowed or are currently allowed by the white list.

• To allow an application protocol not in the list, select <New Application Protocol> and click OK to display the application protocol editor. Select the application protocol Type and Protocol you want to allow. Optionally, restrict the application protocol by port, Vendor, and Version.

  **Note**  You must type the vendor and version exactly as they would appear in a table view of applications. If you do not specify a vendor or version, the white list allows all vendors and versions as long as the type and protocol match.

**Step 3**  Click OK.

**Step 4**  To immediately implement all changes made since the last time you saved, click Save White List.

---

### White Listing a Client

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Using white list host profiles, you can white list clients either globally or on specific operating systems. Optionally, you can require that the client be a specific version. For example, you could allow only Microsoft Internet Explorer 10 to run on Microsoft Windows hosts.

**Procedure**

**Step 1**  While you are creating or modifying a white list host profile, click the add icon (🧬) next to Allowed Clients (or next to Globally Allowed Clients if you are modifying the global host profile).

**Step 2**  You have two options:

• If the clients you want to allow are listed, select them. The web interface lists clients that have been allowed or are currently allowed by the white list.

• To allow a client not in the list, select <New Client> and click OK to display the client editor. Select the Client you want to allow from the drop-down list, and, optionally, restrict the client to an allowed Version.

  **Note**  You must type the version exactly as it would appear in a table view of clients. If you do not specify a version, the white list allows all versions.

**Step 3**  Click OK.

**Step 4**  To immediately implement all changes made since the last time you saved, click Save White List.
**White Listing a Web Application**

<table>
<thead>
<tr>
<th></th>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Using white list host profiles, you can white list web applications either globally or on specific operating systems.

**Procedure**

**Step 1** While you are creating or modifying a white list host profile, click the add icon (.addButton) next to **Allowed Web Applications** (or next to **Globally Allowed Web Applications** if you are modifying the global host profile).

**Step 2** Select the web applications you want to allow.

**Step 3** Click **OK**.

**Step 4** To immediately implement all changes made since the last time you saved, click **Save White List**.

---

**White Listing a Protocol**

<table>
<thead>
<tr>
<th></th>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Using white list host profiles, you can white list protocols either globally or on specific operating systems. ARP, IP, TCP, and UDP are always allowed to run on any host; you cannot disallow them.

**Procedure**

**Step 1** While you are creating or modifying a white list host profile, click the add icon (.addButton) next to **Allowed Protocols** (or next to **Globally Allowed Protocols** if you are modifying the global host profile).

**Step 2** You have two options:

- If the protocols you want to allow are listed, select them. The web interface lists protocols that have been allowed or are currently allowed by the white list.

- To allow a protocol not in the list, select <New Protocol> and click **OK** to display the protocol editor. From the **Type** drop-down list, select the protocol type (**Network** or **Transport**), then select the **Protocol** from the drop-down list.

  **Tip** Select **Other (manual entry)** to specify a protocol that is not in the list. For network protocols, type the appropriate number as listed in [http://www.iana.org/assignments/ethernet-numbers/](http://www.iana.org/assignments/ethernet-numbers/). For transport protocols, type the appropriate number as listed in [http://www.iana.org/assignments/protocol-numbers/](http://www.iana.org/assignments/protocol-numbers/).

**Step 3** Click **OK**.
Managing Compliance White Lists

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can use the White List page to manage compliance white lists and shared host profiles. The default white list represents recommended settings and uses a special category of shared host profiles, called *built-in host profiles*.

In a multidomain deployment, the system displays compliance white lists created in the current domain, which you can edit. It also displays selected white lists from ancestor domains, which you cannot edit. To view and edit white lists created in a lower domain, switch to that domain.

**Note**

The system does not display configurations from ancestor domains if the configurations expose information about unrelated domains, including names, managed devices, and so on. The default white list is only available in the Global domain.

**Procedure**

**Step 1** Choose Policies > Correlation, then click the White List tab.

**Step 2** Manage your compliance white lists:

- Create — To create a new white list, click New White List and proceed as described in Creating a Compliance White List, on page 1350.

- Delete — To delete a white list that is not in use, click the delete icon (🗑️), then confirm you want to delete the white list. Deleting a white list also removes its associated host attribute from all hosts on your network. If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

- Edit — To modify an existing white list, click the edit icon (✏️) and proceed as described in Editing a Compliance White List, on page 1357. If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

- Shared Host Profiles — To manage your white lists’ shared host profiles, click Edit Shared Profiles and proceed as described in Managing Shared Host Profiles, on page 1358.
Editing a Compliance White List

### Access

<table>
<thead>
<tr>
<th>Access</th>
<th>Admin</th>
</tr>
</thead>
</table>

### Supported Domains

<table>
<thead>
<tr>
<th>Supported Domains</th>
<th>Any</th>
</tr>
</thead>
</table>

### Supported Devices

<table>
<thead>
<tr>
<th>Supported Devices</th>
<th>Any</th>
</tr>
</thead>
</table>

### Classic License

<table>
<thead>
<tr>
<th>Classic License</th>
<th>Any</th>
</tr>
</thead>
</table>

### Smart License

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Any</th>
</tr>
</thead>
</table>

When you modify and save a compliance white list that is included in an active correlation policy, the system immediately re-evaluates the compliance of the hosts in the white list’s target networks. Although this re-evaluation may bring some hosts into or out of compliance, the system does not generate any white list events.

### Procedure

**Step 1**
Choose **Policies > Correlation**, then click the **White List** tab.

**Step 2**
Next to the white list you want to modify, click the edit icon (🖌).

If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3**
Edit your compliance white list:

- **Name and Description** — To change the name or description, click the white list name in the left panel to display basic white list information, then type the new information.

- **Allow Jailbroken Devices** — To allow jailbroken mobile devices on your network, click the white list name in the left panel to display basic white list information, then enable **Allow Jailbroken Mobile Devices**. Disabling this option causes jailbroken devices to generate white list violations.

- **Add Allowed Host Profile** — To create an operating system-specific host profile for this white list, click the add icon (➕) next to Allowed Host Profiles and proceed as described in [Building White List Host Profiles](#), on page 1352.

- **Add Shared Host Profile** — To add an existing shared host profile to the white list, click **Add Shared Host Profile**, select the shared host profile you want to add, then click **OK**. Shared host profiles appear in italics.

- **Add Target Network** — To add a new target network without surveying its hosts, click the add icon (➕) next to Target Networks and proceed as described in [Setting Target Networks for a Compliance White List](#), on page 1351.

- **Delete Host Profile** — To delete a shared or operating-system specific host profile from the white list, click the delete icon (🗑️) next to the host profile, then confirm your choice. Deleting a shared host profile removes it from the white list, but does not delete the profile or remove it from any other white lists that use it. You cannot delete a white list’s global host profile.

- **Delete Target Network** — To remove a target network from the white list, click the delete icon (🗑️) next to the network, then confirm your choice.

- **Edit Global Host Profile** — To edit the white list’s global host profile, click **Any Operating System** and proceed as described in [Building White List Host Profiles](#), on page 1352.
Managing Shared Host Profiles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a compliance white list, *shared host profiles* are tied to specific operating systems, but you can use each shared host profile in more than one white list. If you create multiple white lists but want to use the same host profile to evaluate hosts running a particular operating system across the white lists, use a shared host profile.

In a multidomain deployment, the system displays shared host profiles created in the current domain, which you can edit. It also displays shared host profiles from ancestor domains, which you cannot edit. To view and edit shared host profiles created in a lower domain, switch to that domain.

**Note**

If you modify a shared host profile (including built-ins), or modify a built-in application protocol, protocol, or client, your change affects every white list that uses it. If you make unintended changes to or delete these built-in elements, you can reset to factory defaults.

**Procedure**

**Step 1**
Choose **Policies > Correlation**, then click the **White List** tab.

**Step 2**
Click **Edit Shared Profiles**.

**Step 3**
Manage your shared host profiles:

- Create Shared Host Profile — To create a new shared host profile without surveying hosts, click the add icon ( ) next to Shared Host Profiles and proceed as described in Building White List Host Profiles, on page 1352.

- Create Shared Host Profile by Survey — To create multiple new shared host profiles by surveying a network, click **Add Target Network** and proceed as described in Setting Target Networks for a Compliance White List, on page 1351.

- Delete — To delete a shared host profile, click the delete icon ( ), then confirm your choice.

- Edit — To modify an existing shared host profile (including a built-in shared host profile), click its name and proceed as described in Building White List Host Profiles, on page 1352.
• Reset Built-In Host Profiles — To reset all built-in host profiles to factory defaults, click Built-in Host Profiles, then click Reset to Factory Defaults and confirm your choice.

Step 4 To immediately implement all changes made since the last time you saved, click Save All Profiles.
Correlation Policies

The following topics describe how to configure correlation policies and rules.

- Introduction to Correlation Policies and Rules, on page 1361
- Configuring Correlation Policies, on page 1362
- Configuring Correlation Rules, on page 1365
- Configuring Correlation Response Groups, on page 1396

Introduction to Correlation Policies and Rules

You can use the correlation feature to respond in real time to threats to your network, using correlation policies.

A correlation policy violation occurs when the activity on your network triggers either a correlation rule or compliance white list within an active correlation policy.

Correlation Rules

When a correlation rule in an active correlation policy triggers, the system generates a correlation event. Correlation rules can trigger when:

- The system generates a specific type of event (connection, intrusion, malware, discovery, user activity, and so on).
- Your network traffic deviates from its normal profile.

You can constrain correlation rules in the following ways:

- Add a host profile qualification to constrain the rule using information from the host profile of a host involved in the triggering event.
- Add a connection tracker to a correlation rule so that after the rule’s initial criteria are met, the system begins tracking certain connections. Then, a correlation event is generated only if the tracked connections meet additional criteria.
- Add a user qualification to a correlation rule to track certain users or groups of users. For example, you can constrain a correlation rule so that it triggers only for a particular user's traffic, or traffic from a specific department.
• Add **snooze periods**. When a correlation rule triggers, a snooze period causes that rule not to trigger again for a specified interval. After the snooze period elapses, the rule can trigger again and start a new snooze period.

• Add **inactive periods**. During inactive periods, correlation rules do not trigger.

Although you can configure correlation rules without licensing your deployment, rules that use unlicensed components do not trigger.

**Compliance White Lists**

A compliance white list specifies which operating systems, applications (web and client), and protocols are allowed on hosts on your network. When a host violates a white list used in an active correlation policy, the system generates a **white list event**.

**Correlation Responses**

*Responses* to correlation policy violations include simple alerts and various remediations (such as scanning a host). You can associate each correlation rule or white list with a single response or group of responses.

If network traffic triggers multiple rules or white lists, the system launches all the responses associated with each rule and white list.

**Correlation and Multitenancy**

In a multidomain deployment, you can create correlation policies at any domain level, using whatever rules, white lists, and responses are available at that level. Higher-level domain administrators can perform correlation within or across domains:

• Constraining a correlation rule by domain matches events reported by that domain's descendants.

• Higher-level domain administrators can create compliance white lists that evaluate hosts across domains. You can target different subnets in different domains in the same white list.

The system builds a separate network map for each leaf domain. Using literal configurations (such as IP addresses, VLAN tags, and usernames) to constrain cross-domain correlation rules can have unexpected results.

**Related Topics**

- **Introduction to Compliance White Lists**, on page 1345
- **Firepower Management Center Alert Responses**, on page 1453
- **Introduction to Remediations**, on page 1411

### Configuring Correlation Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>
Use correlation rules, compliance white lists, alert responses, and remediations to build correlation policies.

In a multidomain deployment, you can create correlation policies at any domain level, using whatever constituent configurations are available at that level.

You can assign a priority to each correlation policy, and to each rule and white list used in that policy. Rule and white list priorities override correlation policy priorities. If network traffic violates the correlation policy, the resultant correlation events display the policy priority value, unless the violated rule or white list has its own priority.

**Procedure**

**Step 1** Choose Policies > Correlation.

**Step 2** Click Create Policy.

**Step 3** Enter a Policy Name and Policy Desription.

**Step 4** From the Default Priority drop-down list, choose a priority for the policy. Choose None to use rule priorities only.

**Step 5** Click Add Rules, check the rules and white lists that you want to use in the policy, then click Add.

**Step 6** From the Priority list for each rule or white list, choose a priority:

- A priority value from 1 to 5
- None
- Default to use the policy’s default priority

**Step 7** Add responses to rules and white lists as described in Adding Responses to Rules and White Lists, on page 1363.

**Step 8** Click Save.

**What to do next**

- Activate the policy by clicking the slider.

### Adding Responses to Rules and White Lists

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

You can associate each correlation rule or white list with a single response or group of responses. If network traffic triggers multiple rules or white lists, the system launches all the responses associated with each rule and white list. Note that an Nmap remediation does not launch when used as a response to a traffic profile change.

In a multidomain deployment, you can use responses created in the current domain or in ancestor domains.
Procedure

Step 1
In the correlation policy editor, next to a rule or white list where you want to add responses, click the responses icon ( ).

Step 2
Under Unassigned Responses, choose the responses you want to launch when the rule or white list triggers, and click the up arrow (^).

Step 3
Click Update.

Related Topics
Firepower Management Center Alert Responses, on page 1453
Introduction to Remediations, on page 1411

Managing Correlation Policies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery</td>
</tr>
</tbody>
</table>

Changes made to active correlation policies take effect immediately.

When you activate a correlation policy, the system immediately begins processing events and triggering responses. Note that the system does not generate white list events for non-compliant hosts on its initial, post-activation evaluation.

In a multidomain deployment, the system displays correlation policies created in the current domain, which you can edit. It also displays selected correlation policies from ancestor domains, which you cannot edit. To view and edit correlation policies created in a lower domain, switch to that domain.

Note
The system does not display configurations from ancestor domains if the configurations expose information about unrelated domains, including names, managed devices, and so on.

Procedure

Step 1
Choose Policies > Correlation.

Step 2
Manage your correlation policies:

- Activate or Deactivate — Click the slider. If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
- Create — Click Create Policy; see Configuring Correlation Policies, on page 1362.
- Edit — Click the edit icon ( ); see Configuring Correlation Policies, on page 1362. If a view icon ( ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
Configuring Correlation Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

A simple correlation rule requires only that an event of a certain type occurs. You do not need to provide more specific conditions. For example, correlation rules based on traffic profile changes do not require conditions. You can also create complex correlation rules, with multiple conditions and added constraints.

When you create correlation rule trigger criteria, host profile qualifications, user qualifications, or connection trackers, the syntax varies but the mechanics remain consistent.

In a multidomain deployment, constraining a correlation rule by an ancestor domain matches events reported by that domain's descendants.

Before you begin

- Confirm that your deployment is collecting the type of information you want to use to trigger correlation events. For example, the information available for any individual connection or connection summary event depends on several factors, including the detection method, the logging method, and event type. The system can add hosts to the network map from exported NetFlow records, but the available information for these hosts is limited; see Differences between NetFlow and Managed Device Data, on page 1204.

Procedure

Step 1 Choose Policies > Correlation, then click the Rule Management tab.
Step 2 Click Create Rule.
Step 3 Enter a Rule Name and Rule Description.
Step 4 Optionally, choose a Rule Group for the rule.
Step 5 Choose a base event type and, optionally, specify additional trigger criteria for the correlation rule. You can choose the following base event types:
  - an intrusion event occurs—See Syntax for Intrusion Event Trigger Criteria, on page 1366.
  - a malware event occurs—See Syntax for Malware Event Trigger Criteria, on page 1369.
  - a discovery event occurs—See Syntax for Discovery Event Trigger Criteria, on page 1370.
  - user activity is detected—See Syntax for User Activity Event Trigger Criteria, on page 1373.
  - a host input event occurs—See Syntax for Host Input Event Trigger Criteria, on page 1374.
  - a connection event occurs—See Syntax for Connection Event Trigger Criteria, on page 1375.
• **a traffic profile changes**—See Syntax for Traffic Profile Changes, on page 1378.

**Step 6** Optionally, further constrain the correlation rule by adding any or all of the following:

- Host Profile Qualification—Click **Add Host Profile Qualification**; see Syntax for Correlation Host Profile Qualifications, on page 1380.
- Connection Tracker—Click **Add Connection Tracker**; see Connection Trackers, on page 1383.
- User Qualification—Click **Add User Qualification**; see Syntax for User Qualifications, on page 1383.
- Snooze Period—Under Rule Options, use the **Snooze** text field and drop-down list to specify the interval that the system should wait to trigger a correlation rule again, after the rule triggers.
- Inactive Period—Under Rule Options, click **Add Inactive Period**. Using the text field and drop-down lists, specify when and how often you want the system to refrain from evaluating network traffic against the correlation rule.

**Tip** To remove a snooze period, specify an interval of 0 (seconds, minutes, or hours).

**Step 7** Click **Save Rule**.

---

**Example Simple Correlation Rule**

The following simple correlation rule triggers if a new host is detected in a specific subnet. Note that when the category represents an IP address, choosing **is in** or **is not in** as the operator allows you to specify whether the IP address is in or is not in a block of IP addresses, as expressed in special notation such as CIDR.

![Image](31869)

**What to do next**

- Use the rule in correlation policies as described in Configuring Correlation Policies, on page 1362.

**Related Topics**

- Managing Correlation Rules, on page 1395
- Correlation Rule Building Mechanics, on page 1392
- Snooze and Inactive Periods, on page 1392
- Differences between NetFlow and Managed Device Data, on page 1204

**Syntax for Intrusion Event Trigger Criteria**

The following table describes how to build a correlation rule condition when you choose an intrusion event as the base event.
## Table 199: Syntax for Intrusion Events

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control Policy</td>
<td>Choose one or more access control policies that use the intrusion policy that generated the intrusion event.</td>
</tr>
<tr>
<td>Access Control Rule Name</td>
<td>Enter all or part of the name of the access control rule that uses the intrusion policy that generated the intrusion event.</td>
</tr>
<tr>
<td>Application Protocol</td>
<td>Choose one or more application protocols associated with the intrusion event.</td>
</tr>
<tr>
<td>Application Protocol Category</td>
<td>Choose one or more category of application protocol.</td>
</tr>
<tr>
<td>Classification</td>
<td>Choose one or more classifications.</td>
</tr>
<tr>
<td>Client</td>
<td>Choose one or more clients associated with the intrusion event.</td>
</tr>
<tr>
<td>Client Category</td>
<td>Choose one or more category of client.</td>
</tr>
<tr>
<td>Destination Country or Source Country</td>
<td>Choose one or more countries associated with the source or destination IP address in the intrusion event.</td>
</tr>
<tr>
<td>Destination IP, Source IP, Both Source IP and Destination IP, or Either Source IP or Destination IP</td>
<td>Enter a single IP address or address block.</td>
</tr>
<tr>
<td>Destination Port/ICMP Code or Source Port/ICMP Type</td>
<td>Enter the port number or ICMP type for source traffic or the port number or ICMP code for destination traffic.</td>
</tr>
<tr>
<td>Device</td>
<td>Choose one or more devices that may have generated the event.</td>
</tr>
<tr>
<td>Domain</td>
<td>Choose one or more domains. In a multidomain deployment, constraining by an ancestor domain matches data reported by that domain's descendants. This field is only present if you have ever configured the Firepower Management Center for multitenancy.</td>
</tr>
<tr>
<td>Egress Interface or Ingress Interface</td>
<td>Choose one or more interfaces.</td>
</tr>
<tr>
<td>Egress Security Zone or Ingress Security Zone</td>
<td>Choose one or more security zones.</td>
</tr>
<tr>
<td>Generator ID</td>
<td>Choose one or more preprocessors.</td>
</tr>
<tr>
<td>Impact Flag</td>
<td>Choose the impact level assigned to the intrusion event.</td>
</tr>
</tbody>
</table>

Because no operating system information is available for hosts added to the network map from NetFlow data, the system cannot assign Vulnerable (impact level 1: red) impact levels for intrusion events involving those hosts. In such cases, use the host input feature to manually set the operating system identity for the hosts.
<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inline Result</td>
<td>Choose whether the system <strong>dropped</strong> or <strong>would have dropped</strong> packets as a result of the intrusion policy violation. The system can drop packets in an inline, switched, or routed deployment. It does not drop packets in a passive deployment, including when an inline set is in tap mode, regardless of intrusion rule state or the drop behavior of the intrusion policy.</td>
</tr>
<tr>
<td>Intrusion Policy</td>
<td>Choose one or more intrusion policies that generated the intrusion event.</td>
</tr>
<tr>
<td>IOC Tag</td>
<td>Choose whether an indication of compromise tag was set as a result of the intrusion event.</td>
</tr>
<tr>
<td>Priority</td>
<td>Choose the rule priority. For rule-based intrusion events, the priority corresponds to either the value of the <code>priority</code> keyword or the value for the <code>classtype</code> keyword. For other intrusion events, the priority is determined by the decoder or preprocessor.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Enter the name or number of the transport protocol as listed in <a href="http://www.iana.org/assignments/protocol-numbers">http://www.iana.org/assignments/protocol-numbers</a>.</td>
</tr>
<tr>
<td>Rule Message</td>
<td>Enter all or part of the rule message.</td>
</tr>
<tr>
<td>Rule SID</td>
<td>Enter a single Snort ID (SID) or multiple SIDs separated by commas. If you choose <strong>is in</strong> or <strong>is not in</strong> as the operator, you cannot use the multi-selection pop-up window. You must enter a comma-separated list of SIDs.</td>
</tr>
<tr>
<td>Rule Type</td>
<td>Specify whether the rule is local. Local rules include custom standard text intrusion rules, standard text rules that you modified, and any new instances of shared object rules created when you saved the rule with modified header information.</td>
</tr>
<tr>
<td>SSL Actual Action</td>
<td>Choose the SSL rule action that indicates how the system handled an encrypted connection.</td>
</tr>
<tr>
<td>SSL Certificate Fingerprint</td>
<td>Enter the fingerprint of the certificate used to encrypt the traffic, or choose a subject common name associated with the fingerprint.</td>
</tr>
<tr>
<td>SSL Certificate Subject Common Name (CN)</td>
<td>Enter all or part of the subject common name of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Certificate Subject Country (C)</td>
<td>Choose one or more subject country codes of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Certificate Subject Organization (O)</td>
<td>Enter all or part of the subject organization name of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Certificate Subject Organizational Unit (OU)</td>
<td>Enter all or part of the subject organizational unit name of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Flow Status</td>
<td>Choose one or more statuses based on the result of the system’s attempt to decrypt the traffic.</td>
</tr>
<tr>
<td>Username</td>
<td>Enter the username of the user logged into the source host in the intrusion event.</td>
</tr>
<tr>
<td>VLAN ID</td>
<td>Enter the innermost VLAN ID associated with the packet that triggered the intrusion event.</td>
</tr>
</tbody>
</table>
Syntax for Malware Event Trigger Criteria

To base a correlation rule on a malware event, first specify the type of malware event you want to use. Your choice determines the set of trigger criteria you can use. You can choose:

- **by endpoint-based malware detection** (detection by AMP for Endpoints)
- **by network-based malware detection** (detection by AMP for Networks)
- **by retrospective network-based malware detection** (retroactive detection by AMP for Networks)

The following table describes how to build a correlation rule condition when you choose a malware event as the base event.

**Table 200: Syntax for Malware Events**

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Protocol</td>
<td>Choose one or more application protocols associated with the malware event.</td>
</tr>
<tr>
<td>Application Protocol Category</td>
<td>Choose one or more category of application protocol.</td>
</tr>
<tr>
<td>Client</td>
<td>Choose one or more clients associated with the malware event.</td>
</tr>
<tr>
<td>Client Category</td>
<td>Choose one or more category of client.</td>
</tr>
<tr>
<td>Destination Country or Source Country</td>
<td>Choose one or more countries associated with the source or destination IP address in the malware event.</td>
</tr>
<tr>
<td>Destination IP, Host IP, or Source IP</td>
<td>Enter a single IP address or address block.</td>
</tr>
<tr>
<td>Destination Port/ICMP Code</td>
<td>Enter the port number or ICMP code for destination traffic.</td>
</tr>
<tr>
<td>Disposition</td>
<td>Choose either or both <strong>Malware</strong> or <strong>Custom Detection</strong>.</td>
</tr>
<tr>
<td>Domain</td>
<td>Choose one or more domains. In a multidomain deployment, constraining by an ancestor domain matches data reported by that domain's descendants. This field is only present if you have ever configured the Firepower Management Center for multitenancy.</td>
</tr>
<tr>
<td>Event Type</td>
<td>Choose one or more event types associated with the malware event detected by AMP for Endpoints.</td>
</tr>
</tbody>
</table>
### Syntax for Discovery Event Trigger Criteria

To base a correlation rule on a discovery event, first specify the type of discovery event you want to use. Your choice determines the set of trigger criteria you can use. The following table lists the discovery event types you can choose.

You cannot trigger a correlation rule on hops changes, or when the system drops a new host due to reaching the host limit. You can, however, choose **there is any type of event** to trigger the rule when any type of discovery event occurs.

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Enter the name of the file.</td>
</tr>
<tr>
<td>File Type</td>
<td>Choose the file type.</td>
</tr>
<tr>
<td>File Type Category</td>
<td>Choose one or more file type categories.</td>
</tr>
<tr>
<td>IOC Tag</td>
<td>Choose whether an indication of compromise tag is or is not set as a result of the malware event.</td>
</tr>
<tr>
<td>SHA-256</td>
<td>Enter or paste the SHA-256 hash value of the file.</td>
</tr>
<tr>
<td>SSL Actual Action</td>
<td>Choose the SSL rule action that indicates how the system handled an encrypted connection.</td>
</tr>
<tr>
<td>SSL Certificate Fingerprint</td>
<td>Enter the fingerprint of the certificate used to encrypt the traffic, or choose a subject common name associated with the fingerprint.</td>
</tr>
<tr>
<td>SSL Certificate Subject Common Name (CN)</td>
<td>Enter all or part of the subject common name of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Certificate Subject Country (C)</td>
<td>Choose one or more subject country codes of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Certificate Subject Organization (O)</td>
<td>Enter all or part of the subject organization name of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Certificate Subject Organizational Unit (OU)</td>
<td>Enter all or part of the subject organizational unit name of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Flow Status</td>
<td>Choose one or more statuses based on the result of the system’s attempt to decrypt the traffic.</td>
</tr>
<tr>
<td>Source Port/ICMP Type</td>
<td>Enter the port number or ICMP type for source traffic.</td>
</tr>
<tr>
<td>Web Application</td>
<td>Choose one or more web applications associated with the malware event.</td>
</tr>
<tr>
<td>Web Application Category</td>
<td>Choose one or more category of web application.</td>
</tr>
</tbody>
</table>

**Related Topics**
- File and Malware Event Fields, on page 1674
- Firepower System IP Address Conventions, on page 14
### Table 201: Correlation Rule Trigger Criteria vs Discovery Event Types

<table>
<thead>
<tr>
<th>Choose this option...</th>
<th>To use this discovery event type...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a client has changed</td>
<td>Client Update</td>
</tr>
<tr>
<td>a client timed out</td>
<td>Client Timeout</td>
</tr>
<tr>
<td>a host IP address is reused</td>
<td>DHCP: IP Address Reassigned</td>
</tr>
<tr>
<td>a host is deleted because the host limit was reached</td>
<td>Host Deleted: Host Limit Reached</td>
</tr>
<tr>
<td>a host is identified as a network device</td>
<td>Host Type Changed to Network Device</td>
</tr>
<tr>
<td>a host timed out</td>
<td>Host Timeout</td>
</tr>
<tr>
<td>a host’s IP address has changed</td>
<td>DHCP: IP Address Changed</td>
</tr>
<tr>
<td>a NETBIOS name change is detected</td>
<td>NETBIOS Name Change</td>
</tr>
<tr>
<td>a new client is detected</td>
<td>New Client</td>
</tr>
<tr>
<td>a new IP host is detected</td>
<td>New Host</td>
</tr>
<tr>
<td>a new MAC address is detected</td>
<td>Additional MAC Detected for Host</td>
</tr>
<tr>
<td>a new MAC host is detected</td>
<td>New Host</td>
</tr>
<tr>
<td>a new network protocol is detected</td>
<td>New Network Protocol</td>
</tr>
<tr>
<td>a new transport protocol is detected</td>
<td>New Transport Protocol</td>
</tr>
<tr>
<td>a TCP port closed</td>
<td>TCP Port Closed</td>
</tr>
<tr>
<td>a TCP port timed out</td>
<td>TCP Port Timeout</td>
</tr>
<tr>
<td>a UDP port closed</td>
<td>UDP Port Closed</td>
</tr>
<tr>
<td>a UDP port timed out</td>
<td>UDP Port Timeout</td>
</tr>
<tr>
<td>a VLAN tag was updated</td>
<td>VLAN Tag Information Update</td>
</tr>
<tr>
<td>an IOC was set</td>
<td>Indication of Compromise</td>
</tr>
<tr>
<td>an open TCP port is detected</td>
<td>New TCP Port</td>
</tr>
<tr>
<td>an open UDP port is detected</td>
<td>New UDP Port</td>
</tr>
<tr>
<td>the OS information for a host has changed</td>
<td>New OS</td>
</tr>
<tr>
<td>the OS or server identity for a host has a conflict</td>
<td>Identity Conflict</td>
</tr>
<tr>
<td>the OS or server identity for a host has timed out</td>
<td>Identity Timeout</td>
</tr>
<tr>
<td>there is any kind of event</td>
<td>any event type</td>
</tr>
<tr>
<td>there is new information about a MAC address</td>
<td>MAC Information Change</td>
</tr>
</tbody>
</table>
Choose this option... | To use this discovery event type...
---|---
there is new information about a TCP server | TCP Server Information Update
there is new information about a UDP server | UDP Server Information Update

The following table describes how to build a correlation rule condition when you choose a discovery event as the base event.

*Table 202: Syntax for Discovery Events*

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Protocol</td>
<td>Choose one or more application protocols.</td>
</tr>
<tr>
<td>Application Protocol Category</td>
<td>Choose one or more category of application protocol.</td>
</tr>
<tr>
<td>Application Port</td>
<td>Enter the application protocol port number.</td>
</tr>
<tr>
<td>Client</td>
<td>Choose one or more clients.</td>
</tr>
<tr>
<td>Client Category</td>
<td>Choose one or more category of client.</td>
</tr>
<tr>
<td>Client Version</td>
<td>Enter the version number of the client.</td>
</tr>
<tr>
<td>Device</td>
<td>Choose one or more devices that may have generated the discovery event.</td>
</tr>
<tr>
<td>Domain</td>
<td>Choose one or more domains. In a multidomain deployment, constraining by an ancestor domain matches data reported by that domain's descendants. This field is only present if you have ever configured the Firepower Management Center for multitenancy.</td>
</tr>
<tr>
<td>Hardware</td>
<td>Enter the hardware model for the mobile device. For example, to match all Apple iPhones, enter <em>iPhone</em>.</td>
</tr>
<tr>
<td>Host Type</td>
<td>Choose one or more host types. You can choose between a host or one of several types of network device.</td>
</tr>
<tr>
<td>IP Address or New IP Address</td>
<td>Enter a single IP address or address block.</td>
</tr>
<tr>
<td>Jailbroken</td>
<td>Choose <em>Yes</em> to indicate that the host in the event is a jailbroken mobile device or <em>No</em> to indicate that it is not.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>Enter all or part of the MAC address of the host. For example, if you know that devices from a certain hardware manufacturer have MAC addresses that begin with <code>0A:12:34</code>, you could choose <code>begins with</code> as the operator; then enter <code>0A:12:34</code> as the value.</td>
</tr>
</tbody>
</table>
If you specify... | Choose an operator, then...
---|---
MAC Type | Choose whether the MAC address was **ARP/DHCP Detected**. That is, choose whether the system positively identified the MAC address as belonging to the host (**is ARP/DHCP Detected**), or whether the system is seeing many hosts with that MAC address because, for example, there is a router between the managed device and the host (**is not ARP/DHCP Detected**).
MAC Vendor | Enter all or part of the name of the MAC hardware vendor of the NIC used by the network traffic that triggered the discovery event.
Mobile | Choose **Yes** to indicate that the host in the event is a mobile device or **No** to indicate that it is not.
NETBIOS Name | Enter the NetBIOS name of the host.
Network Protocol | Enter the network protocol number as listed in [http://www.iana.org/assignments/ethernet-numbers](http://www.iana.org/assignments/ethernet-numbers).
OS Name | Choose one or more operating system names.
OS Vendor | Choose one or more operating system vendors.
OS Version | Choose one or more operating system versions.
Protocol or Transport Protocol | Enter the name or number of the transport protocol as listed in [http://www.iana.org/assignments/protocol-numbers](http://www.iana.org/assignments/protocol-numbers).
Source | Choose the source of the host input data (for operating system and server identity changes and timeouts).
Source Type | Choose the type of the source for the host input data (for operating system and server identity changes and timeouts).
VLAN ID | Enter the VLAN ID of the host involved in the event.
Web Application | Choose a web application.

**Related Topics**
- Discovery Event Types, on page 1734
- Discovery Event Fields, on page 1740
- Firepower System IP Address Conventions, on page 14

**Syntax for User Activity Event Trigger Criteria**

To base a correlation rule on user activity, first choose the type of user activity you want to use. Your choice determines the set of trigger criteria you can use. You can choose:

- a new user identity is detected
- a user logs into a host
The following table describes how to build a correlation rule condition when you choose user activity as the base event.

Table 203: Syntax for User Activity

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Choose one or more devices that may have detected the user activity.</td>
</tr>
<tr>
<td>Domain</td>
<td>Choose one or more domains. In a multidomain deployment, constraining by an ancestor domain matches data reported by that domain's descendants. This field is only present if you have ever configured the Firepower Management Center for multitenancy.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Enter a single IP address or address block.</td>
</tr>
<tr>
<td>Username</td>
<td>Enter a username.</td>
</tr>
</tbody>
</table>

Related Topics
- User Activity Data Fields
- Firepower System IP Address Conventions, on page 14

Syntax for Host Input Event Trigger Criteria

To base a correlation rule on a host input event, first specify the type of host input event you want to use. Your choice determines the set of trigger criteria you can use. The following table lists the host input event types you can choose.

You cannot trigger a correlation rule when you add, delete, or change the definition of a user-defined host attribute, or set a vulnerability impact qualification.

Table 204: Correlation Rule Trigger Criteria vs Host Input Event Types

<table>
<thead>
<tr>
<th>Choose this option...</th>
<th>To trigger the rule on this event type...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a client is added</td>
<td>Add Client</td>
</tr>
<tr>
<td>a client is deleted</td>
<td>Delete Client</td>
</tr>
<tr>
<td>a host is added</td>
<td>Add Host</td>
</tr>
<tr>
<td>a protocol is added</td>
<td>Add Protocol</td>
</tr>
<tr>
<td>a protocol is deleted</td>
<td>Delete Protocol</td>
</tr>
<tr>
<td>a scan result is added</td>
<td>Add Scan Result</td>
</tr>
<tr>
<td>a server definition is set</td>
<td>Set Server Definition</td>
</tr>
<tr>
<td>a server is added</td>
<td>Add Port</td>
</tr>
<tr>
<td>a server is deleted</td>
<td>Delete Port</td>
</tr>
</tbody>
</table>
The following table describes how to build a correlation rule condition when you choose a host input event as the base event.

**Table 205: Syntax for Host Input Events**

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>Choose one or more domains. In a multidomain deployment, constraining by an ancestor domain matches data reported by that domain's descendants. This field is only present if you have ever configured the Firepower Management Center for multitenancy.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Enter a single IP address or address block.</td>
</tr>
<tr>
<td>Source</td>
<td>Choose the source for the host input data.</td>
</tr>
<tr>
<td>Source Type</td>
<td>Choose the type of the source for the host input data.</td>
</tr>
</tbody>
</table>

**Related Topics**
- [Host Input Event Types](#), on page 1738
- [Discovery Event Fields](#), on page 1740
- [Firepower System IP Address Conventions](#), on page 14

### Syntax for Connection Event Trigger Criteria

To base a correlation rule on a connection event, first specify the type of connection event you want to use. Note that the information available for a connection event can vary depending on how, why, and when the system logged the connection. You can choose:

- **at either the beginning or the end of the connection**
- **at the beginning of the connection**
- **at the end of the connection**

The following table describes how to build a correlation rule condition when you choose a connection event as the base event.
### Syntax for Connection Event Trigger Criteria

**Table 206: Syntax for Connection Events**

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control Policy</td>
<td>Choose one or more access control policies that logged the connection.</td>
</tr>
<tr>
<td>Access Control Rule Action</td>
<td>Choose one or more actions associated with the access control rule that logged the connection. Choose <strong>Monitor</strong> to trigger correlation events when network traffic matches the conditions of any Monitor rule, regardless of the rule or default action that later handles the connection.</td>
</tr>
<tr>
<td>Access Control Rule</td>
<td>Enter all or part of the name of the access control rule that logged the connection. You can enter the name of any Monitor rule whose conditions were matched by a connection, regardless of the rule or default action that later handled the connection.</td>
</tr>
<tr>
<td>Application Protocol</td>
<td>Choose one or more application protocols associated with the connection.</td>
</tr>
<tr>
<td>Application Protocol Category</td>
<td>Choose one or more categories of application protocol.</td>
</tr>
<tr>
<td>Client</td>
<td>Choose one or more clients.</td>
</tr>
<tr>
<td>Client Category</td>
<td>Choose one or more categories of client.</td>
</tr>
<tr>
<td>Client Version</td>
<td>Enter the version number of the client.</td>
</tr>
<tr>
<td>Connection Duration</td>
<td>Enter the duration of the connection event, in seconds.</td>
</tr>
</tbody>
</table>
| Connection Type | Specify whether you want to trigger the correlation rule based on how the connection information was obtained:  
  - Choose **is** and **Netflow** for connection events generated from exported NetFlow data.  
  - Choose **is not** and **Netflow** for connection events detected by a Firepower System managed device. |
<p>| Destination Country or Source Country | Choose one or more countries associated with the source or destination IP address in the connection event. |
| Device | Choose one or more devices that either detected the connection, or that processed the connection (for connection data from exported NetFlow records). |
| Domain | Choose one or more domains. In a multidomain deployment, constraining by an ancestor domain matches data reported by that domain's descendants. This field is only present if you have ever configured the Firepower Management Center for multitenancy. |
| Egress Interface or Ingress Interface | Choose one or more interfaces. |
| Egress Security Zone or Ingress Security Zone | Choose one or more security zones. |</p>
<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiator Bytes, Responder Bytes, or Total Bytes</td>
<td>Enter one of:</td>
</tr>
<tr>
<td></td>
<td>• The number of bytes sent (Initiator Bytes).</td>
</tr>
<tr>
<td></td>
<td>• The number of bytes received (Responder Bytes).</td>
</tr>
<tr>
<td></td>
<td>• The number of bytes both sent and received (Total Bytes).</td>
</tr>
<tr>
<td>Initiator IP, Responder IP, Both Initiator and Responder IP, or Either Initiator IP or Responder IP</td>
<td>Specify a single IP address or address block.</td>
</tr>
<tr>
<td>Initiator Packets, Responder Packets, or Total Packets</td>
<td>Enter one of:</td>
</tr>
<tr>
<td></td>
<td>• The number of packets sent (Initiator Packets).</td>
</tr>
<tr>
<td></td>
<td>• The number of packets received (Responder Packets).</td>
</tr>
<tr>
<td></td>
<td>• The number of packets both sent and received (Total Packets)</td>
</tr>
<tr>
<td>Initiator Port/ICMP Type or Responder Port/ICMP Code</td>
<td>Enter the port number or ICMP type for initiator traffic or the port number or ICMP code for responder traffic.</td>
</tr>
<tr>
<td>IOC Tag</td>
<td>Specify whether an indication of compromise tag is or is not set due to the connection event.</td>
</tr>
<tr>
<td>NetBIOS Name</td>
<td>Enter the NetBIOS name of the monitored host in the connection.</td>
</tr>
<tr>
<td>NetFlow Device</td>
<td>Choose the IP address of the NetFlow exporter you want to use to trigger the correlation rule. If you did not add any NetFlow exporters to the network discovery policy, the NetFlow Device drop-down list is blank.</td>
</tr>
<tr>
<td>Reason</td>
<td>Choose one or more reasons associated with the connection event.</td>
</tr>
<tr>
<td>Security Intelligence Category</td>
<td>Choose one or more Security Intelligence categories associated with the connection event. To use Security Intelligence Category as a condition for end-of-connection events, set that category to Monitor instead of Block in your access control policy.</td>
</tr>
<tr>
<td>SSL Actual Action</td>
<td>Specify the SSL rule action that indicates how the system handled an encrypted connection.</td>
</tr>
<tr>
<td>SSL Certificate Fingerprint</td>
<td>Enter the fingerprint of the certificate used to encrypt the traffic, or choose a subject common name associated with the fingerprint.</td>
</tr>
<tr>
<td>SSL Certificate Status</td>
<td>Choose one or more statuses associated with the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Certificate Subject Common Name (CN)</td>
<td>Enter all or part of the subject common name of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Certificate Subject Country (C)</td>
<td>Choose one or more subject country codes of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Certificate Subject Organization (O)</td>
<td>Enter all or part of the subject organization name of the certificate used to encrypt the session.</td>
</tr>
</tbody>
</table>
### Syntax for Traffic Profile Changes

To base a correlation rule on a traffic profile change, first choose the traffic profile you want to use. The rule triggers when network traffic deviates from the pattern characterized by the profile you choose.

You can trigger the rule based on either raw data or on the statistics calculated from the data. For example, you could write a rule that triggers if the amount of data traversing your network (measured in bytes) suddenly spikes, which could indicate an attack or other security policy violation. You could specify that the rule trigger if either:

- the number of bytes traversing your network spikes above a certain number of bytes

---

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSL Certificate Subject Organizational Unit (OU)</td>
<td>Enter all or part of the subject organizational unit name of the certificate used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Cipher Suite</td>
<td>Choose one or more cipher suites used to encrypt the session.</td>
</tr>
<tr>
<td>SSL Encrypted Session</td>
<td>Choose <strong>Successfully Decrypted</strong>.</td>
</tr>
<tr>
<td>SSL Flow Status</td>
<td>Choose one or more statuses based on the result of the system’s attempt to decrypt the traffic.</td>
</tr>
<tr>
<td>SSL Policy</td>
<td>Choose one or more SSL policies that logged the encrypted connection.</td>
</tr>
<tr>
<td>SSL Rule Name</td>
<td>Enter all or part of the name of the SSL rule that logged the encrypted connection.</td>
</tr>
<tr>
<td>SSL Server Name</td>
<td>Enter all or part of the name of the server with which the client established an encrypted connection.</td>
</tr>
<tr>
<td>SSL URL Category</td>
<td>Choose one or more URL categories for the URL visited in the encrypted connection.</td>
</tr>
<tr>
<td>SSL Version</td>
<td>Choose one or more SSL or TLS versions used to encrypt the session.</td>
</tr>
<tr>
<td>TCP Flags</td>
<td>Choose a TCP flag that a connection event must contain in order to trigger the correlation rule. Only connection data generated from NetFlow records contains TCP flags.</td>
</tr>
<tr>
<td>Transport Protocol</td>
<td>Enter the transport protocol used by the connection: <strong>TCP</strong> or <strong>UDP</strong>.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter all or part of the URL visited in the connection.</td>
</tr>
<tr>
<td>URL Category</td>
<td>Choose one or more URL categories for the URL visited in the connection.</td>
</tr>
<tr>
<td>URL Reputation</td>
<td>Choose one or more URL reputation values for the URL visited in the connection.</td>
</tr>
<tr>
<td>Username</td>
<td>Enter the username of the user logged in to either host in the connection.</td>
</tr>
<tr>
<td>Web Application</td>
<td>Choose one or more web applications associated with the connection.</td>
</tr>
<tr>
<td>Web Application Category</td>
<td>Choose one or more categories of web application.</td>
</tr>
</tbody>
</table>

---

**Related Topics**

- [Connection and Security Intelligence Event Fields](#)
- [Firepower System IP Address Conventions](#)
• the number of bytes traversing your network spikes above a certain number of standard deviations above or below the mean amount of traffic

Note that to create a rule that triggers when the number of bytes traversing your network falls outside a certain number of standard deviations (whether above or below), you must specify upper and lower bounds, as shown in the following graphic.

To create a rule that triggers when the number of bytes traversing is greater than a certain number of standard deviations above the mean, use only the first condition shown in the graphic.

To create a rule that triggers when the number of bytes traversing is greater than a certain number of standard deviations below the mean, use only the second condition.

Check the use velocity data check box to trigger the correlation rule based on rates of change between data points. If you wanted to use velocity data in the above example, you could specify that the rule triggers if either:

• the change in the number of bytes traversing your network spikes above or below a certain number of standard deviations above the mean rate of change

• the change in the number of bytes traversing your network spikes above a certain number of bytes

The following table describes how to build a condition in a correlation rule when you choose a traffic profile change as the base event.

### Table 207: Syntax for Traffic Profile Changes

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then enter...</th>
<th>Then choose one of...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Connections</td>
<td>the total number of connections detected or the number of standard deviations either above or below the mean that the number of connections detected must be in to trigger the rule</td>
<td>connections standard deviation(s)</td>
</tr>
</tbody>
</table>
| Total Bytes, Initiator Bytes, or Responder Bytes | one of:  
• the total bytes transmitted (Total Bytes)  
• the number of bytes transmitted (Initiator Bytes)  
• the number of bytes received (Responder Bytes)  
or  
the number of standard deviations either above or below the mean that one of the above criteria must be in to trigger the rule | bytes standard deviation(s) |
If you specify... | Choose an operator, then enter... | Then choose one of...
---|---|---
Total Packets, Initiator Packets, or Responder Packets | one of:
  • the total packets transmitted (Total Packets)
  • the number of packets transmitted (Initiator Packets)
  • the number of packets received (Responder Packets)
  or
  the number of standard deviations either above or below the mean that one of the above criteria must be in trigger the rule | packets
  standard deviation(s)

Unique Initiators | the number of unique hosts that initiated sessions
  or
  the number of standard deviations either above or below the mean that the number of unique initiators detected must be to trigger the rule | initiators
  standard deviation(s)

Unique Responders | the number of unique hosts that responded to sessions
  or
  the number of standard deviations either above or below the mean that the number of unique responders detected must be to trigger the rule | responders
  standard deviation(s)

**Syntax for Correlation Host Profile Qualifications**

To constrain a correlation rule based on the host profile of a host involved in the event, add a *host profile qualification*. You cannot add a host profile qualification to a correlation rule that triggers on a malware event, traffic profile change, or on the detection of a new IP host.

When you build a host profile qualification, first specify the host you want to use to constrain your correlation rule. The host you can choose depends on the rule's base event type:

- **connection event** — Choose **Responder Host** or **Initiator Host**.
- **intrusion event** — Choose **Destination Host** or **Source Host**.
- **discovery event, host input event, or user activity** — Choose **Host**.

The following table describes how to build a host profile qualification for a correlation rule.

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Protocol &gt; Application Protocol</td>
<td>Choose an application protocol.</td>
</tr>
<tr>
<td>Application Protocol &gt; Application Port</td>
<td>Enter the application protocol port number.</td>
</tr>
<tr>
<td>If you specify...</td>
<td>Choose an operator, then...</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application Protocol</td>
<td>Choose a protocol.</td>
</tr>
<tr>
<td>Protocol Category</td>
<td>Choose a category.</td>
</tr>
<tr>
<td>Client</td>
<td>Choose a client.</td>
</tr>
<tr>
<td>Client Version</td>
<td>Enter the client version.</td>
</tr>
<tr>
<td>Client Category</td>
<td>Choose a category.</td>
</tr>
<tr>
<td>Domain</td>
<td>Choose one or more domains. In a multidomain deployment, constraining by an ancestor domain</td>
</tr>
<tr>
<td></td>
<td>matches data reported by that domain's descendants. This field is only present if you have</td>
</tr>
<tr>
<td></td>
<td>ever configured the Firepower Management Center for multitenancy.</td>
</tr>
<tr>
<td>Hardware</td>
<td>Enter the hardware model for the mobile device. For example, to match all Apple iPhones,</td>
</tr>
<tr>
<td></td>
<td>enter <strong>iPhone</strong>.</td>
</tr>
<tr>
<td>Host Criticality</td>
<td>Choose the host criticality.</td>
</tr>
<tr>
<td>Host Type</td>
<td>Choose one or more host types. You can choose between a normal host or one of several types</td>
</tr>
<tr>
<td></td>
<td>of network device.</td>
</tr>
<tr>
<td>IOC Tag</td>
<td>Choose one or more indication of compromise tags.</td>
</tr>
<tr>
<td>Jailbroken</td>
<td>Choose <strong>Yes</strong> to indicate that the host in the event is a jailbroken mobile device or <strong>No</strong></td>
</tr>
<tr>
<td></td>
<td>to indicate that it is not.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>Enter all or part of the MAC address of the host.</td>
</tr>
<tr>
<td>MAC Type</td>
<td>Choose whether the MAC type is ARP/DHCP detected:</td>
</tr>
<tr>
<td></td>
<td>• the system positively identified the MAC address as belonging to the host (is <strong>ARP/DHCP</strong></td>
</tr>
<tr>
<td></td>
<td>Detected)</td>
</tr>
<tr>
<td></td>
<td>• the system is seeing many hosts with that MAC address because, for example, there is a</td>
</tr>
<tr>
<td></td>
<td>router between the device and the host (is <strong>not ARP/DHCP Detected</strong>)</td>
</tr>
<tr>
<td></td>
<td>• the MAC type is irrelevant (is any)</td>
</tr>
<tr>
<td>MAC Vendor</td>
<td>Enter all or part of the MAC vendor of hardware used by the host.</td>
</tr>
<tr>
<td>Mobile</td>
<td>Choose <strong>Yes</strong> to indicate that the host in the event is a mobile device or <strong>No</strong> to</td>
</tr>
<tr>
<td></td>
<td>indicate that it is not.</td>
</tr>
<tr>
<td>NetBIOS Name</td>
<td>Enter the NetBIOS name of the host.</td>
</tr>
<tr>
<td>Network Protocol</td>
<td>Enter the network protocol number as listed in [<a href="http://www.iana.org/assignments/ethernet-">http://www.iana.org/assignments/ethernet-</a></td>
</tr>
<tr>
<td></td>
<td>numbers](<a href="http://www.iana.org/assignments/ethernet-numbers">http://www.iana.org/assignments/ethernet-numbers</a>).</td>
</tr>
<tr>
<td>Operating System</td>
<td>Choose one or more operating system vendor names.</td>
</tr>
<tr>
<td>OS Vendor</td>
<td></td>
</tr>
<tr>
<td>Operating System</td>
<td>Choose one or more operating system names.</td>
</tr>
<tr>
<td>OS Name</td>
<td></td>
</tr>
</tbody>
</table>
If you specify... | Choose an operator, then...
---|---
Operating System > OS Version | Choose one or more operating system versions.
Transport Protocol | Enter the name or number of the transport protocol as listed in http://www.iana.org/assignments/protocol-numbers.
VLAN ID | Enter the VLAN ID number of the host.
Web Application | Choose a web application.
Web Application Category | Choose a category.
any available host attribute, including the default compliance white list host attribute | Enter or choose the appropriate value, depending on the host attribute type.

Using Implied or Generic Clients to Build a Host Profile Qualification

When system reports a detected client using an application protocol name followed by client (for example, HTTPS client), that client is an implied or generic client. In these cases, the system has not detected a particular client, but is inferring the existence of a client based on server response traffic.

To create a host profile qualification using an implied or generic client, constrain using the application protocol running on the responder host, not the client.

Using Event Data to Build a Host Profile Qualification

You can often use data from the correlation rule's base event when constructing a host profile qualification.

For example, assume your correlation rule triggers when the system detects the use of a particular browser on one of your monitored hosts. Further assume that when you detect this use, you want to generate an event if the browser version is not the latest.

You could add a host profile qualification to this correlation rule so that the rule triggers only if the Client is the Event Client, but the Client Version is not the latest version.

Example Host Profile Qualification

The following host profile qualification constrains a correlation rule so the rule triggers only if the host involved in the discovery event on which the rule is based is running a version of Microsoft Windows.

Related Topics
Host Data Fields, on page 1743
Syntax for User Qualifications

If you are using a connection, intrusion, discovery, or host input event to trigger your correlation rule, you can constrain the rule based on the identity of a user involved in the event. This constraint is called a user qualification. For example, you could constrain a correlation rule so that it triggers only when the identity of the source or destination user is one from the sales department.

You cannot add a user qualification to a correlation rule that triggers on a traffic profile change or on the detection of user activity. Also, the system obtains user details through the Firepower Management Center-server connection established in an identity realm. This information may not be available for all users in the database.

When you build a user qualification, first specify the identity you want to use to constrain your correlation rule. The identity you can choose depends on the rule's base event type:

- connection event — Choose **Identity on Initiator** or **Identity on Responder**.
- intrusion event — Choose **Identity on Destination** or **Identity on Source**.
- discovery event — Choose **Identity on Host**.
- host input event — Choose **Identity on Host**.

The following table describes how to build a user qualification for a correlation rule.

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication Protocol</td>
<td>Choose the authentication protocol (or user type) protocol used to detect the user.</td>
</tr>
<tr>
<td>Department</td>
<td>Enter a department.</td>
</tr>
<tr>
<td>Domain</td>
<td>Choose one or more domains. In a multidomain deployment, constraining by an ancestor domain matches data reported by that domain's descendants. This field is only present if you have ever configured the Firepower Management Center for multitenancy.</td>
</tr>
<tr>
<td>Email</td>
<td>Enter an email address.</td>
</tr>
<tr>
<td>First Name</td>
<td>Enter a first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Enter a last name.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter a telephone number.</td>
</tr>
<tr>
<td>Username</td>
<td>Enter a username.</td>
</tr>
</tbody>
</table>

**Related Topics**

- User Data Fields

**Connection Trackers**

A connection tracker constrains a correlation rule so that after the rule’s initial criteria are met (including host profile and user qualifications), the system begins tracking certain connections. The system generates a
correlation event for the rule if the tracked connections meet additional criteria gathered over a time period that you specify.

**Tip**

Connection trackers typically monitor very specific traffic and, when triggered, run only for a finite, specified time. Compare connection trackers with traffic profiles, which typically monitor a broad range of network traffic and run persistently.

There are two ways a connection tracker can generate an event.

**Connection Trackers That Fire Immediately When Conditions Are Met**

You can configure a connection tracker so that the correlation rule fires as soon as network traffic meets the tracker’s conditions. When this happens, the system stops tracking connections for this connection tracker instance, even if the timeout period has not expired. If the same type of policy violation that triggered the correlation rule occurs again, the system creates a new connection tracker.

However, if time expires before network traffic meets the conditions in the connection tracker, the system does not generate a correlation event, and also stops tracking connections for that rule instance.

For example, a connection tracker can serve as a kind of event threshold by generating a correlation event only if a certain type of connection occurs more than a specific number of times within a specific time period. Or, you can generate a correlation event only if the system detects excessive data transfer after an initial connection.

**Connection Trackers That Fire at the End of the Timeout Period**

You can configure a connection tracker so that it relies on data collected over the entire timeout period, and therefore cannot fire until the end of the timeout period.

For example, if you configure a connection tracker to fire if you detect fewer than a certain number of bytes being transferred during a certain time period, the system waits until that time period passes and then generates an event if network traffic met that condition.

---

**Adding a Connection Tracker**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

**Before you begin**

- Create a correlation rule based on a connection, intrusion, discovery, user identity, or host input event. You cannot add a connection tracker to a rule based on a malware event or traffic profile change.

**Procedure**

**Step 1** In the correlation rule editor, click **Add Connection Tracker**.

**Step 2** Specify the connections to track; see **Syntax for Connection Trackers**, on page 1385.
Step 3 Based on the tracked connections, specify when you want to generate a correlation event; see Syntax for Connection Tracker Events, on page 1387.

Step 4 Specify the interval (in seconds, minutes, or hours) during which the tracker's conditions must be met.

Syntax for Connection Trackers

The following table describes how to build a connection tracker condition that specifies the kind of connections you want to track.

Table 210: Syntax for Connection Trackers

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control Policy</td>
<td>Choose one or more access control policies that handled the connections you want to track.</td>
</tr>
<tr>
<td>Access Control Rule Action</td>
<td>Choose one or more access control rule actions associated with the access control rule that logged the connections you want to track.</td>
</tr>
<tr>
<td></td>
<td>Choose Monitor to track connections that match the conditions of any Monitor rule, regardless of the rule or default action that later handles the connections.</td>
</tr>
<tr>
<td>Access Control Rule Name</td>
<td>Enter all or part of the name of the access control rule that logged the connections you want to track.</td>
</tr>
<tr>
<td></td>
<td>To track connections that match a Monitor rule, enter the name of the Monitor rule. The system tracks the connections, regardless of the rule or default action that later handles them.</td>
</tr>
<tr>
<td>Application Protocol</td>
<td>Choose one or more application protocols.</td>
</tr>
<tr>
<td>Application Protocol Category</td>
<td>Choose one or more application protocol categories.</td>
</tr>
<tr>
<td>Client</td>
<td>Choose one or more clients.</td>
</tr>
<tr>
<td>Client Category</td>
<td>Choose one or more client categories.</td>
</tr>
<tr>
<td>Client Version</td>
<td>Enter the version of the client.</td>
</tr>
<tr>
<td>Connection Duration</td>
<td>Enter the connection duration, in seconds.</td>
</tr>
<tr>
<td>Connection Type</td>
<td>Specify whether you want to trigger the correlation rule based on how the connection information was obtained:</td>
</tr>
<tr>
<td></td>
<td>• Choose is and Netflow for connection events generated from exported NetFlow records.</td>
</tr>
<tr>
<td></td>
<td>• Choose is not and Netflow for connection events detected by a Firepower System managed device.</td>
</tr>
<tr>
<td>Destination Country or Source Country</td>
<td>Choose one or more countries.</td>
</tr>
</tbody>
</table>
If you specify... | Choose an operator, then...
---|---
Device | Choose one or more devices whose detected connections you want to track. If you want to track NetFlow connections, choose the devices that process the connection data from exported NetFlow records.
Ingress Interface or Egress Interface | Choose one or more interfaces.
Ingress Security Zone or Egress Security Zone | Choose one or more security zones.
Initiator IP, Responder IP, or Initiator/Responder IP | Enter a single IP address or address block.
Initiator Bytes, Responder Bytes, or Total Bytes | Enter one of:
• the number of bytes transmitted (Initiator Bytes)
• the number of bytes received (Responder Bytes)
• the number of bytes both transmitted and received (Total Bytes)
Initiator Packets, Responder Packets, or Total Packets | Enter one of:
• the number of packets transmitted (Initiator Packets)
• the number of packets received (Responder Packets)
• the number of packets both transmitted and received (Total Packets)
Initiator Port/ICMP Type or Responder Port/ICMP Code | Enter the port number or ICMP type for initiator traffic or the port number or ICMP code for responder traffic.
IOC Tag | Choose whether an indication of compromise tag is or is not set.
NETBIOS Name | Enter the NetBIOS name of the monitored host in the connection.
NetFlow Device | Choose the IP address of the NetFlow exporter you want to track. If you did not add any NetFlow exporters to the network discovery policy, the NetFlow Device drop-down list is blank.
Reason | Choose one or more reasons associated with the connections you want to track.
Security Intelligence Category | Choose one or more Security Intelligence categories associated with the connections you want to track.
TCP Flags | Choose the TCP flag that connections must contain in order to track them. Only connections generated from exported NetFlow records contain TCP flag data.
Transport Protocol | Choose the transport protocol used by the connection.
URL | Enter all or part of the URL visited in the connections you want to track.
Using Event Data to Build a Connection Tracker

You can often use data from the correlation rule's base event when constructing a connection tracker.

For example, assume your correlation rule triggers when the system detects a new client. When you add a connection tracker to this type of correlation rule, the system automatically populates the tracker with constraints that refer to the base event:

- The **Initiator/Responder IP** is set to the **Event IP Address**.
- The **Client** is set to the **Event Client**.

Tip

To track connections for a specific IP address or block of IP addresses, click **switch to manual entry** to manually specify the IP. Click **switch to event fields** to go back to using the IP address in the event.

Related Topics

- [Connection and Security Intelligence Event Fields](#), on page 1597
- [Firepower System IP Address Conventions](#), on page 14

Syntax for Connection Tracker Events

The following table describes how to build a connection tracker condition that specifies when you want to generate a correlation event based on the connections you are tracking.

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Connections</td>
<td>the total number of connections detected</td>
</tr>
<tr>
<td>Number of SSL Encrypted Sessions</td>
<td>the total number of SSL- or TLS-encrypted sessions detected</td>
</tr>
</tbody>
</table>
### Sample Configuration for Excessive Connections From External Hosts

Consider a scenario where you archive sensitive files on network 10.1.0.0/16, and where hosts outside this network typically do not initiate connections to hosts inside the network. An occasional connection initiated from outside the network might occur, but you have determined that when four or more connections are initiated within two minutes, there is cause for concern.

The rule shown in the following graphic specifies that when a connection occurs from outside the 10.1.0.0/16 network to inside the network, the system begins tracking connections that meet that criterion. The system then generates a correlation event if the system detects four connections (including the original connection) within two minutes that match that signature.

<table>
<thead>
<tr>
<th>If you specify...</th>
<th>Choose an operator, then enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Bytes, Initiator Bytes, or Responder Bytes</td>
<td>one of:</td>
</tr>
<tr>
<td></td>
<td>• the total bytes transmitted (Total Bytes)</td>
</tr>
<tr>
<td></td>
<td>• the number of bytes transmitted (Initiator Bytes)</td>
</tr>
<tr>
<td></td>
<td>• the number of bytes received (Responder Bytes)</td>
</tr>
<tr>
<td>Total Packets, Initiator Packets, or Responder Packets</td>
<td>one of:</td>
</tr>
<tr>
<td></td>
<td>• the total packets transmitted (Total Packets)</td>
</tr>
<tr>
<td></td>
<td>• the number of packets transmitted (Initiator Packets)</td>
</tr>
<tr>
<td></td>
<td>• the number of packets received (Responder Packets)</td>
</tr>
<tr>
<td>Unique Initiators or Unique Responders</td>
<td>one of:</td>
</tr>
<tr>
<td></td>
<td>• the number of unique hosts that initiated sessions that were detected (Unique Initiators)</td>
</tr>
<tr>
<td></td>
<td>• the number of unique hosts that responded to connections that were detected (Unique Responders)</td>
</tr>
</tbody>
</table>
The following diagram shows how network traffic can trigger the above correlation rule.

In this example, the system detected a connection that met the basic conditions of the correlation rule, that is, the system detected a connection from a host outside the 10.1.0.0/16 network to a host inside the network. This created a connection tracker.

The connection tracker is processed in the following stages:

- First, the system starts tracking connections when it detects a connection from Host A outside the network to Host 1 inside the network.
- The system detects two more connections that match the connection tracker signature: Host B to Host 2 and Host C to Host 1.
- The system detects a fourth qualifying connection when Host A connects to Host 3 within the two-minute time limit. The rule conditions are met.
- Finally, the system generates a correlation event and the system stops tracking connections.
Sample Configuration for Excessive BitTorrent Data Transfers

Consider a scenario where you want to generate a correlation event if the system detects excessive BitTorrent data transfers after an initial connection to any host on your monitored network.

The following graphic shows a correlation rule that triggers when the system detects the BitTorrent application protocol on your monitored network. The rule has a connection tracker that constrains the rule so that the rule triggers only if hosts on your monitored network (in this example, 10.1.0.0/16) collectively transfer more than 7MB of data (7340032 bytes) via BitTorrent in the five minutes following the initial policy violation.

The following diagram shows how network traffic can trigger the above correlation rule.
In this example, the system detected the BitTorrent TCP application protocol on two different hosts: Host 1 and Host 2. These two hosts transmitted data via BitTorrent to four other hosts: Host A, Host B, Host C, and Host D.

This connection tracker is processed in the following stages:

- First, the system starts tracking connections at the 0-second marker when the system detects the BitTorrent application protocol on Host 1. Note that the connection tracker will expire if the system does not detect 7MB of BitTorrent TCP data being transmitted in the next 5 minutes (by the 300-second marker).

- At 5 seconds, Host 1 has transmitted 3MB of data that matches the signature:
  - 1MB from Host 1 to Host A, at the 1-second marker (1MB total BitTorrent traffic counted towards fulfilling the connection tracker)
  - 2MB from Host 1 to Host B, at the 5-second marker (3MB total)

- At 7 seconds, the system detects the BitTorrent application protocol on Host 2 and starts tracking BitTorrent connections for that host as well.

- At 20 seconds, the system has detected additional data matching the signature being transmitted from both Host 1 and Host 2:
  - 1MB from Host 2 to Host A, at the 10-second marker (4MB total)
  - 2MB from Host 1 to Host C, at the 15-second marker (6MB total)
  - 1MB from Host 2 to Host B, at the 20-second marker (7MB total)
Although Host 1 and Host 2 have now transmitted a combined 7MB of BitTorrent data, the rule does not trigger because the total number of bytes transmitted must be more than 7MB (**Responder Bytes are greater than 7340032**). At this point, if the system were to detect no additional BitTorrent transfers for the remaining 280 seconds in the tracker’s timeout period, the tracker would expire and the system would not generate a correlation event.

However, at 30 seconds, the system detects another BitTorrent transfer, and the rule conditions are met:

- 2MB from Host 1 to Host D at the 30-second marker (9MB total)

Finally, the system generates a correlation event. The system also stops tracking connections for this connection tracker instance, even though the 5-minute period has not expired. If the system detects a new connection using the BitTorrent TCP application protocol at this point, it will create a new connection tracker. Note that the system generates the correlation event **after** Host 1 transmits the entire 2MB to Host D, because it does not tally connection data until the session terminates.

### Snooze and Inactive Periods

You can configure **snooze periods** in correlation rules. When a correlation rule triggers, a snooze period instructs the system to stop firing that rule for a specified interval, even if the rule is violated again during the interval. When the snooze period has elapsed, the rule can trigger again (and start a new snooze period).

For example, you may have a host on your network that should never generate traffic. A simple correlation rule that triggers whenever the system detects a connection involving that host may create multiple correlation events in a short period of time, depending on the network traffic to and from the host. To limit the number of correlation events exposing your policy violation, you can add a snooze period so that the system generates a correlation event only for the first connection (within a time period that you specify) that the system detects involving that host.

You can also set up inactive periods in correlation rules. During inactive periods, the correlation rule will not trigger. You can set up inactive periods to recur daily, weekly, or monthly. For example, you might perform a nightly Nmap scan on your internal network to look for host operating system changes. In that case, you could set a daily inactive period on the affected correlation rules for the time and duration of your scan so that those rules do not trigger erroneously.

### Correlation Rule Building Mechanics

You build a correlation rule by specifying the conditions under which it triggers. The syntax you can use within conditions varies depending on the element you are creating, but the mechanics are the same.

Most conditions have three parts: a **category**, an **operator**, and a **value**:

- The categories you can choose depend on whether you are building correlation rule triggers, a host profile qualification, a connection tracker, or a user qualification. Within correlation rule triggers, the categories further depend on the base event type for the rule. Some conditions may contain several categories, each of which may have their own operators and values.

- A condition’s available operators depend on the category.

- The syntax you can use to specify a condition’s value depends on the category and operator. Sometimes you type the value in a text field. Other times, you can choose a value (or multiple values) from a drop-down list.
For example, if you want to generate a correlation event every time a new host is detected, you can create a simple rule with no conditions.

If you want to further constrain the rule and generate an event only if that new host was detected on the 10.4.x.x network, you can add a single condition.

When your construct includes more than one condition, you must link them with an **AND** or an **OR** operator. Conditions on the same level are evaluated together:

- The **AND** operator requires that all conditions on the level it controls must be met.
- The **OR** operator requires that at least one of the conditions on the level it controls must be met.

The following rule, which detects SSH activity on a nonstandard port on the 10.4.x.x network and the 192.168.x.x network, has four conditions, with the bottom two constituting a complex condition.

Logically, the rule is evaluated as follows:

\[(A \text{ and } B \text{ and } (C \text{ or } D))\]

**Table 212: Rule Evaluation**

<table>
<thead>
<tr>
<th>Where...</th>
<th>Is the condition that states...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Application Protocol is SSH</td>
</tr>
<tr>
<td>B</td>
<td>Application Port is not 22</td>
</tr>
<tr>
<td>C</td>
<td>IP Address is in 10.0.0.0/8</td>
</tr>
<tr>
<td>D</td>
<td>IP Address is in 196.168.0.0/16</td>
</tr>
</tbody>
</table>
Evaluating complex correlation rules that trigger on frequently occurring events can degrade system performance. For example, a multicondition rule that the system must evaluate against every logged connection can cause resource overload.

### Adding and Linking Conditions in Correlation Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** In the correlation rule editor, add a simple or complex condition:

- Simple — Click **Add condition**.
- Complex — Click **Add complex condition**.

**Step 2** Link conditions by choosing the **AND** or **OR** operator from the drop-down list to the left of the conditions.

**Example: Simple vs Complex Conditions**

The following graphic shows a correlation rule with two simple conditions joined by the **OR** operator.

The following graphic shows a correlation rule with one simple condition and one complex condition, joined by the **OR** operator. The complex condition comprises two simple conditions joined by the **AND** operator.
Using Multiple Values in Correlation Rule Conditions

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

When you are building a correlation condition, and the condition syntax allows you to pick a value from a drop-down list, you can often use multiple values from the list.

**Procedure**

**Step 1**
In the correlation rule editor, build a condition, choosing *is in* or *is not in* as the operator.

**Step 2**
Click anywhere in the text field or on the **Edit** link.

**Step 3**
Under **Available**, choose multiple values. You can also click and drag to choose multiple adjacent values.

**Step 4**
Click the right arrow (>) to move the selected entries to **Selected**.

**Step 5**
Click **OK**.

Managing Correlation Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays correlation rules and groups created in the current domain, which you can edit. It also displays selected correlation rules and groups from ancestor domains, which you cannot edit. To view and edit correlation rules and groups created in a lower domain, switch to that domain.

**Note**
The system does not display configurations from ancestor domains if the configurations expose information about unrelated domains, including names, managed devices, and so on.

Changes made to rules in active correlation policies take effect immediately.

**Before you begin**
- If you want to delete a rule, delete it from all correlation policies, as described in Managing Correlation Policies, on page 1364.

**Procedure**

**Step 1**
Choose **Policies > Correlation**, then click the **Rule Management** tab.

**Step 2**
Manage your rules:
• Create — Click Create Rule; see Configuring Correlation Rules, on page 1365.
• Create Group — Click Create Group, enter a name for the group, and click Save. To add a rule to a group, edit the rule.
• Edit — Click the edit icon ( ); see Configuring Correlation Rules, on page 1365. If a view icon ( ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
• Delete Rule or Rule Group — Click the delete icon ( ). Deleting a rule group ungroups the rules. If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

### Configuring Correlation Response Groups

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

You can create a correlation response group of alerts and remediations, then activate and assign the group to a correlation rule within an active correlation policy. The system launches all the grouped responses when network traffic matches the correlation rule.

When used in an active correlation policy, changes to an active group or any of its grouped responses take affect immediately.

**Procedure**

**Step 1** Choose Policies > Correlation, then click Groups.

**Step 2** Click Create Group.

**Step 3** Enter a Name.

**Step 4** Check the Active check box if you want to activate the group upon creation.

Deactivated groups do not launch responses.

**Step 5** Choose the Available Responses to group. then click the right arrow (>) to move them to the Responses in Group. To move responses the other way, use the left arrow (<).

**Step 6** Click Save.

**What to do next**

• If you did not activate the group upon creation and you want to activate it now, click the slider.

**Related Topics**

Firepower Management Center Alert Responses, on page 1453

Introduction to Remediations, on page 1411

---

Firepower Management Center Configuration Guide, Version 6.0
Managing Correlation Response Groups

You can delete a response group if it is not used in a correlation policy. Deleting a response group ungroups its responses. You can also temporarily deactivate a response group without deleting it. This leaves the group on the system but does not launch it when policies are violated.

In a multidomain deployment, the system displays groups created in the current domain, which you can edit. It also displays groups created in ancestor domains, which you cannot edit. To view and edit groups created in a lower domain, switch to that domain.

Changes made to active, in-use response groups take effect immediately.

Procedure

Step 1 Choose Policies > Correlation, then click Groups.
Step 2 Manage response groups:

- Activate or Deactivate — Click the slider. If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
- Create — Click Create Group; see Configuring Correlation Response Groups, on page 1396.
- Edit — Click the edit icon (✏️); see Configuring Correlation Response Groups, on page 1396. If a view icon (👀) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
- Delete — Click the delete icon (🗑️). If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.
CHAPTER 72

Traffic Profiling

The following topics describe how to configure traffic profiles:

• Introduction to Traffic Profiles, on page 1399
• Managing Traffic Profiles, on page 1403
• Configuring Traffic Profiles, on page 1404

Introduction to Traffic Profiles

A traffic profile is a graph of network traffic based on connection data collected over a profiling time window (PTW). This measurement presumably represents normal network traffic. After the learning period, you can detect abnormal network traffic by evaluating new traffic against your profile.

The default PTW is one week, but you can change it to be as short as an hour or as long as several weeks. By default, traffic profiles generate statistics on connection events generated by the system over five-minute intervals. However, you can increase this sampling rate to as long as an hour.

Tip
Cisco recommends that the PTW include at least 100 data points. Configure your PTW and sampling rate so that your traffic profiles contain enough data to be statistically meaningful.

The following graphic shows a traffic profile with a PTW of one day and a sampling rate of five minutes.
You can also set up inactive periods in traffic profile. Traffic profiles collect data during inactive periods, but do not use that data when calculating profile statistics. Traffic profile graphs plotted over time show inactive periods as a shaded region.

For example, consider a network infrastructure where all the workstations are backed up at midnight every night. The backup takes about 30 minutes and spikes the network traffic. You could configure recurring inactive period for your traffic profile to coincide with the scheduled backups.

The system uses end-of-connection data to create connection graphs and traffic profiles. To use traffic profiles, make sure you log end-of-connection events to the Firepower Management Center database.

Implementing Traffic Profiles

When you activate a traffic profile, the system collects and evaluates connection data for the learning period (PTW) you configured. After the learning period, the system evaluates correlation rules written against the traffic profile.

For example, you could write a rule that triggers if the amount of data traversing your network (measured in packets, KBytes, or number of connections) suddenly spikes to three standard deviations above the mean amount of traffic, which could indicate an attack or other security policy violation. Then, you could include that rule in a correlation policy to alert you of the traffic spike or to perform a remediation in response.

Targeting Traffic Profiles

Profile conditions and host profile qualifications constrain traffic profiles.

Using profile conditions, you can profile all network traffic, or you can restrict the traffic profile to monitoring a domain, subnets within or across domains, or individual hosts. In a multidomain deployment:

- Leaf-domain administrators can profile network traffic within their leaf domains.
- Higher-level domain administrators can profile traffic within or across domains.
Profile conditions can also constrain traffic profiles using criteria based on connection data. For example, you could set the profile conditions so that the traffic profile only profiles sessions using a specific port, protocol, or application.

Finally, you can also constrain traffic profiles using information about the tracked hosts. This constraint is called a host profile qualification. For example, you could collect connection data only for hosts with high criticality.

Note

Constraining a traffic profile to a higher-level domain aggregates and profiles the same type of traffic in each of the descendant leaf domains. The system builds a separate network map for each leaf domain. In a multidomain deployment, profiling traffic across domains can have unexpected results.

**Related Topics**

[Introduction to Correlation Policies and Rules](#), on page 1361

**Traffic Profile Conditions**

You can create simple traffic profile conditions and host profile qualifications, or you can create more elaborate constructs by combining and nesting conditions.

Conditions have three parts: a category, an operator, and a value:

- The categories you can use depend on whether you are building traffic profile conditions or a host profile qualification.
- The operators you can use depend on the category you choose.
- The syntax you can use to specify a condition’s value depends on the category and operator. Sometimes you must enter the value in a text field. Other times, you can pick one or more values from a drop-down list.

For a host profile qualification, you must also specify whether you are constraining the traffic profile using information data about the initiating or responding hosts.

When your construct includes more than one condition, you must link them with an **AND** or an **OR** operator. Conditions on the same level are evaluated together:

- The **AND** operator requires that all conditions on the level it controls must be met.
- The **OR** operator requires that at least one of the conditions on the level it controls must be met.

**Unconstrained Traffic Profile**

If you want to create a traffic profile that collects data for your entire monitored network segment, you can create a very simple profile with no conditions, as shown in the following graphic.
Simple Traffic Profile

If you wanted to constrain the profile and collect data only for a subnet, you can add a single condition, as shown in the following graphic.

Complex Traffic Profile

The following traffic profile contains two conditions linked by AND. This means that the traffic profile collects connection data only if both conditions are true. In this example, it collects HTTP connections for all hosts with IP addresses in a specific subnet.

In contrast, the following traffic profile, which collects connection data for HTTP activity in either of two subnets, has three conditions, with the last constituting a complex condition.

Logically, the above traffic profile is evaluated as follows:
(A and (B or C))

<table>
<thead>
<tr>
<th>Where...</th>
<th>Is the condition that states...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Application Protocol Name is HTTP</td>
</tr>
<tr>
<td>B</td>
<td>IP Address is in 10.4.0.0/16</td>
</tr>
<tr>
<td>C</td>
<td>IP Address is in 192.168.0.0/16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Managing Traffic Profiles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart License</td>
</tr>
<tr>
<td>Any</td>
</tr>
</tbody>
</table>

Only rules written against active, complete traffic profiles can trigger a correlation policy violation. A slider icon next to each traffic profile indicates whether the profile is active and collecting data. A progress bar shows the status of the traffic profile’s learning period.

In a multidomain deployment, the system displays traffic profiles created in the current domain, which you can edit. It also displays selected traffic profiles from ancestor domains, which you cannot edit. To view and edit traffic profiles created in a lower domain, switch to that domain.

![Note](Image)

The system does not display traffic profiles from ancestor domains if the profiles' conditions expose information about unrelated domains, including names, managed devices, and so on.

**Procedure**

**Step 1** Choose Policies > Correlation, then click the Traffic Profiles tab.

**Step 2** Manage your traffic profiles:
- Activate/Deactivate — To activate or deactivate a traffic profile, click the slider. Deactivating a traffic profile deletes its associated data. If you reactivate the profile, you must wait the length of its PTW before rules written against it will trigger.
- Create — To create a new traffic profile, click New Profile and proceed as described in Configuring Traffic Profiles, on page 1404. You can also click the copy icon (COPY_ICON) to edit a copy of an existing traffic profile.
- Delete — To delete a traffic profile, click the delete icon (DELETE_ICON), then confirm your choice.
- Edit — To modify an existing traffic profile, click the edit icon (EDIT_ICON) and proceed as described in Configuring Traffic Profiles, on page 1404. If a traffic profile is active you can only change its name and description.
• Graph — To view the traffic profile as a graph, click the graph icon ( ). In a multidomain deployment, you cannot view the graph for a traffic profile that belongs to an ancestor domain if the graph exposes information about unrelated domains.

### Configuring Traffic Profiles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery</td>
</tr>
</tbody>
</table>

Constraining a traffic profile to a higher-level domain aggregates and profiles the same type of traffic in each of the descendant leaf domains. The system builds a separate network map for each leaf domain. In a multidomain deployment, profiling traffic across domains can have unexpected results.

**Procedure**

1. **Step 1** Choose Policies > Correlation, then click the Traffic Profiles tab.
2. **Step 2** Click New Profile.
3. **Step 3** Enter a Profile Name, and optionally, a Profile Description.
4. **Step 4** Optionally, constrain the traffic profile:
   - Copy Settings — To copy settings from an existing traffic profile, click Copy Settings, choose the traffic profile you want to use, and click Load.
   - Profile Conditions — To constrain the traffic profile using information from tracked connections, proceed as described in Adding Traffic Profile Conditions, on page 1405.
   - Host Profile Qualification — To constrain the traffic profile using information from tracked hosts, proceed as described in Adding Host Profile Qualifications to a Traffic Profile, on page 1405.
   - Profiling Time Window (PTW) — To change the Profiling Time Window, enter a time unit, then choose hour(s), day(s), or week(s).
   - Sampling Rate — Choose a Sampling Rate, in minutes.
   - Inactive Period — Click Add Inactive Period and use the drop-down lists to specify when and how often you want the traffic profile remain inactive. Inactive traffic profiles do not trigger correlation rules. Traffic profiles do not include data from inactive periods in profile statistics.
5. **Step 5** Save the traffic profile:
   - To save the profile and start collecting data immediately, click Save & Activate.
   - To save the profile without activating it, click Save.
Adding Traffic Profile Conditions

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery</td>
</tr>
</tbody>
</table>

Procedure

**Step 1**
In the traffic profile editor, under Profile Conditions, click **Add condition** or **Add complex condition** for each condition you want to add. Conditions on the same level are evaluated together.

- To require that all conditions on the level that the operator controls are met, choose **AND**.
- To require that only one of the conditions on the level that the operator controls is met, choose **OR**.

**Step 2**
Specify a category, operator, and value for each condition as described in **Syntax for Traffic Profile Conditions**, on page 1406 and **Traffic Profile Conditions**, on page 1401.

If you choose **is in** or **is not in** as the operator, you can select multiple values in a single condition as described in **Using Multiple Values in a Traffic Profile Condition**, on page 1410.

When the category represents an IP address, choosing **is in** or **is not in** as the operator allows you to specify whether the IP address is in or is not in a range of IP addresses.

**Example**
The following traffic profile collects information on a specific subnet. The category of the condition is **Initiator/Responder IP**, the operator is **is in**, and the value is **10.0.0.0/16**.

**Related Topics**
**Firepower System IP Address Conventions**, on page 14

Adding Host Profile Qualifications to a Traffic Profile

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery</td>
</tr>
</tbody>
</table>

Firepower Management Center Configuration Guide, Version 6.0
Procedure

Step 1 In the traffic profile editor, click **Add Host Profile Qualification**.

Step 2 Under Host Profile Qualification, click **Add condition** or **Add complex condition** for each condition you want to add. Conditions on the same level are evaluated together.
- To require that all conditions on the level that the operator controls are met, choose **AND**.
- To require that only one of the conditions on the level that the operator controls is met, choose **OR**.

Step 3 Specify a host type, category, operator, and value for each condition as described in Syntax for Host Profile Qualifications in a Traffic Profile, on page 1407 and Traffic Profile Conditions, on page 1401.

If you choose **is in** or **is not in** as the operator, you can select multiple values in a single condition as described in Using Multiple Values in a Traffic Profile Condition, on page 1410.

Example

The following host profile qualification constrains a traffic profile such that it collects connection data only if the responding host in the detected connection is running a version of Microsoft Windows.

![Host Profile Qualification](image)

**Syntax for Traffic Profile Conditions**

The following table describes how to build a traffic profile condition. Keep in mind the connection data available to build a traffic profile depends on several factors, including traffic characteristics and detection method.

**Table 213: Syntax for Traffic Profile Conditions**

<table>
<thead>
<tr>
<th>If you choose...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Protocol</td>
<td>Choose one or more application protocols.</td>
</tr>
<tr>
<td>Application Protocol Category</td>
<td>Choose one or more application protocol categories.</td>
</tr>
<tr>
<td>Client</td>
<td>Choose one or more clients.</td>
</tr>
<tr>
<td>Client Category</td>
<td>Choose one or more client categories.</td>
</tr>
</tbody>
</table>
If you choose... | Choose an operator, then...
--- | ---
Connection Type | Choose whether the profile uses connection data from traffic monitored by Firepower System managed devices or from exported NetFlow records. If you do not specify a connection type, the traffic profile includes both.
Destination Country or Source Country | Choose one or more countries.
Domain | Choose one or more domains. In a multidomain deployment, constraining by an ancestor domain matches data reported by that domain's descendants.
Initiator IP, Responder IP, or Initiator/Responder IP | Enter an IP address or range of IP addresses. The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.
NetFlow Device | Choose the NetFlow exporter whose data you want to use to create the traffic profile.
Responder Port/ICMP Code | Enter the port number or ICMP code.
Security Intelligence Category | Choose one or more a Security Intelligence categories. To use a Security Intelligence category for a traffic profile condition, that category must be set to **Monitor** instead of **Block** in your access control policy.
SSL Encrypted Session | Choose **Successfully Decrypted**.
Transport Protocol | Enter **TCP** or **UDP** as the transport protocol.
Web Application | Choose one or more web applications.
Web Application Category | Choose one or more web application categories.

**Related Topics**
- **Requirements for Populating Connection Event Fields**, on page 1610
- **Firepower System IP Address Conventions**, on page 14

**Syntax for Host Profile Qualifications in a Traffic Profile**

When you build a host profile qualification condition, you must first choose the host you want to use to constrain your traffic profile. You can choose either **Responder Host** or **Initiator Host**. After you choose the host role, continue building your host profile qualification condition.

Although you can add hosts to the network map using NetFlow records, the available information about these hosts is limited. For example, there is no operating system data available for these hosts, unless you provide it using the host input feature. In addition, if your traffic profile uses connection data from exported NetFlow records, keep in mind that NetFlow records do not contain information about which host in the connection is...
the initiator and which is the responder. When the system processes NetFlow records, it uses an algorithm to determine this information based on the ports each host is using, and whether those ports are well-known.

To match against implied or generic clients, create a host profile qualification based on the application protocol used by the server responding to the client. When the client list on a host that acts as the initiator or source of a connection includes an application protocol name followed by client, that client may actually be an implied client. In other words, the system reports that client based on server response traffic that uses the application protocol for that client, not on detected client traffic.

For example, if the system reports HTTPS client as a client on a host, create a host profile qualification for Responder Host where Application Protocol is set to HTTPS, because HTTPS client is reported as a generic client based on the HTTPS server response traffic sent by the responder or destination host.

### Table 214: Syntax for Host Profile Qualifications

<table>
<thead>
<tr>
<th>If you choose...</th>
<th>Choose an operator, then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Protocol &gt; Application Protocol</td>
<td>Choose one or more application protocols.</td>
</tr>
<tr>
<td>Application Protocol &gt; Application Port</td>
<td>Enter the application protocol port number.</td>
</tr>
<tr>
<td>Application Protocol &gt; Protocol</td>
<td>Choose the protocol.</td>
</tr>
<tr>
<td>Application Protocol Category</td>
<td>Choose one or more application protocol categories.</td>
</tr>
<tr>
<td>Client &gt; Client</td>
<td>Choose one or more clients.</td>
</tr>
<tr>
<td>Client &gt; Client Version</td>
<td>Enter the client version.</td>
</tr>
<tr>
<td>Client Category</td>
<td>Choose one or more client categories.</td>
</tr>
<tr>
<td>Domain</td>
<td>Choose one or more domains. In a multidomain deployment, constraining by an ancestor domain matches data reported by that domain's descendants.</td>
</tr>
<tr>
<td>Hardware</td>
<td>Enter a mobile device hardware model. For example, to match all Apple iPhones, enter iPhone.</td>
</tr>
<tr>
<td>Host Criticality</td>
<td>Choose a host criticality.</td>
</tr>
<tr>
<td>Host Type</td>
<td>Choose one or more host types. You can choose between a normal host or one of several types of network device.</td>
</tr>
<tr>
<td>IOC Tag</td>
<td>Choose one or more IOC tags.</td>
</tr>
<tr>
<td>Jailbroken</td>
<td>Choose Yes to indicate that the host in the event is a jailbroken mobile device or No to indicate that it is not.</td>
</tr>
<tr>
<td>MAC Address &gt; MAC Address</td>
<td>Enter all or part of the MAC address of the host.</td>
</tr>
<tr>
<td>If you choose...</td>
<td>Choose an operator, then...</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MAC Address &gt; MAC Type</td>
<td>Choose whether the MAC type is <strong>ARP/DHCP Detected</strong>, that is, whether:</td>
</tr>
<tr>
<td></td>
<td>• The system positively identified the MAC address as belonging to the host (is <strong>ARP/DHCP Detected</strong>)</td>
</tr>
<tr>
<td></td>
<td>• The system is seeing many hosts with that MAC address because, for example, there is a router between the device and the host (is not <strong>ARP/DHCP Detected</strong>)</td>
</tr>
<tr>
<td></td>
<td>• The MAC type is irrelevant (is <strong>any</strong>)</td>
</tr>
<tr>
<td>MAC Vendor</td>
<td>Enter all or part of the MAC vendor of hardware used by the host.</td>
</tr>
<tr>
<td>Mobile</td>
<td>Choose <strong>Yes</strong> to indicate that the host in the event is a mobile device or <strong>No</strong> to indicate that it is not.</td>
</tr>
<tr>
<td>NETBIOS Name</td>
<td>Enter the NetBIOS name of the host.</td>
</tr>
<tr>
<td>Network Protocol</td>
<td>Enter the network protocol number as listed in <a href="http://www.iana.org/assignments/ethernet-numbers">http://www.iana.org/assignments/ethernet-numbers</a>.</td>
</tr>
<tr>
<td>Operating System &gt; OS Vendor</td>
<td>Choose one or more operating system vendor names.</td>
</tr>
<tr>
<td>Operating System &gt; OS Name</td>
<td>Choose one or more operating system names.</td>
</tr>
<tr>
<td>Operating System &gt; OS Version</td>
<td>Choose one or more operating system versions.</td>
</tr>
<tr>
<td>Transport Protocol</td>
<td>Enter the name or number of the transport protocol as listed in <a href="http://www.iana.org/assignments/protocol-numbers">http://www.iana.org/assignments/protocol-numbers</a>.</td>
</tr>
<tr>
<td>VLAN ID</td>
<td>Enter the VLAN ID number of the host.</td>
</tr>
<tr>
<td></td>
<td>The system builds a separate network map for each leaf domain.</td>
</tr>
<tr>
<td></td>
<td>In a multidomain deployment, using literal VLAN tags to constrain this configuration can have unexpected results.</td>
</tr>
<tr>
<td>Web Application</td>
<td>Choose one or more web applications.</td>
</tr>
<tr>
<td>Web Application Category</td>
<td>Choose one or more web application categories.</td>
</tr>
<tr>
<td>any available host attribute, including the default compliance white list host attribute</td>
<td>Specify the appropriate value, which depends on the type of host attribute you choose:</td>
</tr>
<tr>
<td></td>
<td>• If the host attribute type is Integer, enter an integer value in the range defined for the attribute.</td>
</tr>
<tr>
<td></td>
<td>• If the host attribute type is Text, enter a text value.</td>
</tr>
<tr>
<td></td>
<td>• If the host attribute type is List, choose a valid list string.</td>
</tr>
<tr>
<td></td>
<td>• If the host attribute type is URL, enter a URL value.</td>
</tr>
</tbody>
</table>
Using Multiple Values in a Traffic Profile Condition

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Discovery</td>
</tr>
</tbody>
</table>

When you are building a condition, and the condition syntax allows you to pick a value from a drop-down list, you can often use multiple values from the list.

For example, if you want to add a host profile qualification to a traffic profile that requires that a host be running some flavor of UNIX, instead of constructing multiple conditions linked with the OR operator, use the following procedure.

Procedure

**Step 1** While building a traffic profile or host profile qualification condition, choose **is in** or **is not in** as the operator. The drop-down list changes to a text field.

**Step 2** Click anywhere in the text field or on the **Edit** link.

**Step 3** Under **Available**, choose multiple values.

**Step 4** Click the right arrow to move the selected entries to **Selected**.

**Step 5** Click **OK**.
Remediations

The following topics contain information on configuring remediations:

- Introduction to Remediations, on page 1411
- Managing Remediation Modules, on page 1420
- Managing Remediation Instances, on page 1420
- Managing Instances for a Single Remediation Module, on page 1421

Introduction to Remediations

A remediation is a program that the Firepower System launches in response to a correlation policy violation. When a remediation runs, the system generates a remediation status event. Remediation status events include details such as the remediation name, the correlation policy and rule that triggered it, and the exit status message.

The system supports several remediation modules:

- Cisco IOS Null Route — blocks traffic sent to a host or network involved in a correlation policy violation (requires Cisco IOS Version 12.0 or higher)
- Nmap Scanning — scans hosts to determine running operating systems and servers
- Set Attribute Value — sets a host attribute on a host involved in a correlation policy violation

Tip

You can install custom modules that perform other tasks; see the Firepower System Remediation API Guide.

Implementing Remediations

To implement a remediation, first create at least one instance for the module you choose. You can create multiple instances per module, where each instance is configured differently. For example, to communicate with multiple routers using the Cisco IOS Null Route remediation module, configure multiples instances of that module.

You can then add multiple remediations to each instance that describe the actions you want to perform when a policy is violated.
Finally, associate remediations with rules in correlation policies, so that the system launches the remediations in response to correlation policy violations.

**Remediations and Multitenancy**

In a multidomain deployment, you can install custom remediation modules at any domain level. The system-provided modules belong to the Global domain.

Though you cannot add a remediation to an instance created in an ancestor domain, you can create a similarly configured instance in the current domain and add remediations to that instance. You can also use remediations created in ancestor domains as correlation responses.

**Related Topics**

- *Firepower Management Center Alert Responses*, on page 1453
- *Nmap Scanning*, on page 1233
- *Adding Responses to Rules and White Lists*, on page 1363

## Cisco IOS Null Route Remediations

The Cisco IOS Null Route remediation module allows you to block an IP address or range of addresses using Cisco’s “null route” command. This drops all traffic sent to a host or network by routing it to the router’s NULL interface. This does not block traffic sent from the violating host or network.

**Note**

Do not use a destination-based remediation as a response to a correlation rule that is based on a discovery or host input event. These events are associated with source hosts.

**Caution**

When a Cisco IOS remediation is activated, there is no timeout period. To unblock the IP address or network, you must manually clear the routing change from the router.

## Configuring Remediations for Cisco IOS Routers

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Note**

Do not use a destination-based remediation as a response to a correlation rule that is based on a discovery or host input event. These events are associated with source hosts.

**Caution**

When a Cisco IOS remediation is activated, there is no timeout period. To unblock the IP address or network, you must manually clear the routing change from the router.
Before you begin

- Confirm that your Cisco router is running Cisco IOS 12.0 or higher.
- Confirm that you have level 15 administrative access to the router.

Procedure

Step 1
Enable Telnet on the Cisco router as described in the documentation provided with your Cisco router or IOS software.

Step 2
On the Firepower Management Center, add a Cisco IOS Null Route instance for each Cisco IOS router you plan to use; see Adding a Cisco IOS Instance, on page 1413.

Step 3
Create remediations for each instance, based on the type of response you want to elicit on the router when correlation policies are violated:
- Adding Cisco IOS Block Destination Remediations, on page 1414
- Adding Cisco IOS Block Destination Network Remediations, on page 1415
- Adding Cisco IOS Block Source Remediations, on page 1416
- Adding Cisco IOS Block Source Network Remediations, on page 1417

What to do next

- Assign remediations as responses to correlation policy violations; see Adding Responses to Rules and White Lists, on page 1363.

Adding a Cisco IOS Instance

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Discovery Admin</td>
</tr>
</tbody>
</table>

If you have multiple routers where you want to send remediations, create a separate instance for each router.

Before you begin

- Configure Telnet access on the Cisco IOS router as described in the documentation provided with the router or IOS software.

Procedure

Step 1
Choose Policies > Actions > Instances.

Step 2
From the Add a New Instance list, choose Cisco IOS Null Route and click Add.

Step 3
Enter an Instance Name and Description.
Step 4 In the **Router IP** field, enter the IP address of the Cisco IOS router you want to use for the remediation.

Step 5 In the **Username** field, enter the Telnet user name for the router. This user must have level 15 administrative access on the router.

Step 6 In the **Connection Password** fields, enter the Telnet user’s user password.

Step 7 In the **Enable Password** fields, enter the Telnet user’s enable password. This is the password used to enter privileged mode on the router.

Step 8 In the **White List** field, enter IP addresses or ranges that you want to exempt from the remediation, one per line.

**Note** The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.

Step 9 Click **Create**.

---

**What to do next**

- Add specific remediations to be used by correlation policies as described in *Adding Cisco IOS Block Destination Remediations*, on page 1414, *Adding Cisco IOS Block Destination Network Remediations*, on page 1415, *Adding Cisco IOS Block Source Remediations*, on page 1416, and *Adding Cisco IOS Block Source Network Remediations*, on page 1417.

**Related Topics**

- *Firepower System IP Address Conventions*, on page 14

**Adding Cisco IOS Block Destination Remediations**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin Discovery Admin</td>
</tr>
</tbody>
</table>

The Cisco IOS Block Destination remediation blocks traffic sent from the router to the destination host involved in a correlation policy violation. Do not use this remediation as a response to a correlation rule that is based on a discovery or host input event. These events are associated with source hosts.

In a multidomain deployment, you cannot add a remediation to an instance created in an ancestor domain.

**Before you begin**

- Add a Cisco IOS instance as described in *Adding a Cisco IOS Instance*, on page 1413.

**Procedure**

**Step 1** Choose **Policies > Actions > Instances**.

**Step 2** Next to the instance where you want to add the remediation, click the view icon (🔗).

**Step 3** In the **Configured Remediations** section, choose **Block Destination** and click **Add**.
If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4** Enter a **Remediation Name** and **Description**.

**Step 5** Click **Create**, then click **Done**.

---

**What to do next**

- Assign remediations as responses to correlation policy violations; see Adding Responses to Rules and White Lists, on page 1363.

---

**Adding Cisco IOS Block Destination Network Remediations**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin Discovery Admin</td>
</tr>
</tbody>
</table>

The Cisco IOS Block Destination Network remediation blocks traffic sent from the router to the network of the destination host involved in a correlation policy violation. Do not use this remediation as a response to a correlation rule that is based on a discovery or host input event. These events are associated with source hosts.

In a multidomain deployment, you cannot add a remediation to an instance created in an ancestor domain.

**Before you begin**

- Add a Cisco IOS instance as described in Adding a Cisco IOS Instance, on page 1413.

---

**Procedure**

**Step 1** Choose **Policies > Actions > Instances**.

**Step 2** Next to the instance where you want to add the remediation, click the view icon (▲). 

**Step 3** In the **Configured Remediations** section, choose **Block Destination Network** and click **Add**.

If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4** Enter a **Remediation Name** and **Description**.

**Step 5** In the **Netmask** field, enter the subnet mask or use CIDR notation to describe the network that you want to block traffic to.

For example, to block traffic to an entire Class C network when a single host triggered a rule (this is not recommended), use 255.255.255.0 or 24 as the netmask.

As another example, to block traffic to 30 addresses that include the triggering IP address, specify 255.255.255.224 or 27 as the netmask. In this case, if the IP address 10.1.1.15 triggers the remediation, all IP addresses between 10.1.1.1 and 10.1.1.30 are blocked. To block only the triggering IP address, leave the field blank, enter 32, or enter 255.255.255.255.
Step 6  Click Create, then click Done.

What to do next

- Assign remediations as responses to correlation policy violations; see Adding Responses to Rules and White Lists, on page 1363.

Related Topics

Firepower System IP Address Conventions, on page 14

Adding Cisco IOS Block Source Remediations

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin Discovery Admin</td>
</tr>
</tbody>
</table>

The Cisco IOS Block Source remediation blocks traffic sent from the router to the source host involved in a correlation policy violation.

In a multidomain deployment, you cannot add a remediation to an instance created in an ancestor domain.

Before you begin

- Add a Cisco IOS instance as described in Adding a Cisco IOS Instance, on page 1413.

Procedure

Step 1  Choose Policies > Actions > Instances.

Step 2  Next to the instance where you want to add the remediation, click the view icon ( ).

Step 3  In the Configured Remediations section, choose Block Source and click Add.

If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 4  Enter a Remediation Name and Description.

Step 5  Click Create, then click Done.

What to do next

- Assign remediations as responses to correlation policy violations; see Adding Responses to Rules and White Lists, on page 1363.
Adding Cisco IOS Block Source Network Remediations

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin Discovery Admin</td>
</tr>
</tbody>
</table>

The Cisco IOS Block Source Network remediation blocks traffic sent from the router to the network of the source host involved in a correlation policy violation.

In a multidomain deployment, you cannot add a remediation to an instance created in an ancestor domain.

**Before you begin**

- Add a Cisco IOS instance as described in Adding a Cisco IOS Instance, on page 1413.

**Procedure**

**Step 1** Choose Policies > Actions > Instances.

**Step 2** Next to the instance where you want to add the remediation, click the view icon (🔍).

**Step 3** In the Configured Remediations section, choose Block Source Network and click Add.

If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4** Enter a Remediation Name and Description.

**Step 5** In the Netmask field, enter the subnet mask or CIDR notation that describes the network that you want to block traffic to.

For example, to block traffic to an entire Class C network when a single host triggered a rule (this is not recommended), use 255.255.255.0 or 24 as the netmask.

As another example, to block traffic to 30 addresses that include the triggering IP address, specify 255.255.255.224 or 27 as the netmask. In this case, if the IP address 10.1.1.15 triggers the remediation, all IP addresses between 10.1.1.1 and 10.1.1.30 are blocked. To block only the triggering IP address, leave the field blank, enter 32, or enter 255.255.255.255.

**Step 6** Click Create, then click Done.

**What to do next**

- Assign remediations as responses to correlation policy violations; see Adding Responses to Rules and White Lists, on page 1363.

**Related Topics**

- Firepower System IP Address Conventions, on page 14
Nmap Scan Remediations

The Firepower System integrates with Nmap™, an open source active scanner for network exploration and security auditing. You can respond to a correlation policy violation using an Nmap remediation, which triggers an Nmap scan remediation.

For more information about Nmap scanning, see Nmap Scanning, on page 1233.

Set Attribute Value Remediations

You can respond to a correlation policy violation by setting a host attribute value on the host where the triggering event occurred. For text host attributes, you can use the description from the event as the attribute value.

Configuring Set Attribute Remediations

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin Discovery Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  Choose Policies > Actions > Instances.
Step 2  Create a set attribute instance as described in Adding a Set Attribute Value Instance, on page 1418.
Step 3  Add a set attribute remediation as described in Adding Set Attribute Value Remediations, on page 1419.

What to do next

• Assign remediations as responses to correlation policy violations; see Adding Responses to Rules and White Lists, on page 1363.

Related Topics

- Predefined Host Attributes, on page 1716
- User-Defined Host Attributes, on page 1717

Adding a Set Attribute Value Instance

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin Discovery Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1  Choose Policies > Actions > Instances.
Step 2  From the Add a New Instance list, choose Set Attribute Value and click Add.
Step 3  Enter an Instance Name and Description.
Step 4  Click Create.

What to do next

• Create a set attribute remediation as described in Adding Set Attribute Value Remediations, on page 1419.

Adding Set Attribute Value Remediations

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin Discovery Admin</td>
</tr>
</tbody>
</table>

The Set Attribute Value remediation sets a host attribute on a host involved in a correlation policy violation. Create a remediation for each attribute value you want set. For text attributes, you can use the description from the triggering event as the attribute value.

In a multidomain deployment, you cannot add a remediation to an instance created in an ancestor domain.

Before you begin

• Create a set attribute instance as described in Adding a Set Attribute Value Instance, on page 1418.

Procedure

Step 1  Choose Policies > Actions > Instances.
Step 2  Next to the instance where you want to add the remediation, click the view icon (🔍).
Step 3  In the Configured Remediations section, choose Set Attribute Value and click Add.

If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 4  Enter a Remediation Name and Description.
Step 5  To use this remediation in response to an event with source and destination data, choose an Update Which Host(s) From Event option.
Step 6  For text attributes, specify whether you want to Use Description From Event For Attribute Value:

• To use the description from the event as the attribute value, click On and enter the Attribute Value you want to set.

• To use the Attribute Value setting for the remediation as the attribute value, click Off.

Step 7  Click Create, then click Done.
Managing Remediation Modules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Discovery</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays remediation modules installed in the current domain, which you can delete. It also displays modules installed in ancestor domains, which you cannot delete. To manage remediation modules in a lower domain, switch to that domain.

Procedure

**Step 1** Choose Policies > Actions > Modules.

**Step 2** Manage your remediation modules:

- **Configure** — To view the Module Detail page for a module and configure its instances and remediations, click the view icon ( ). In a multidomain deployment, you cannot use the Module Detail page to add, delete, or edit instances in the current domain for a module installed in an ancestor domain. Instead, use the Instances page (Policies > Actions > Instances); see Managing Remediation Instances, on page 1420.
- **Delete** — To delete a custom module that is not in use, click the delete icon ( ). You cannot delete system-provided modules.
- **Install** — To install a custom module, click Choose File, browse to the module, and click Install. For more information, see the Firepower System Remediation API Guide.

Managing Remediation Instances

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Discovery</td>
</tr>
</tbody>
</table>

The Instances page lists all configured instances for all remediation modules.

In a multidomain deployment, the system displays remediation instances created in the current domain, which you can edit. It also displays instances created in ancestor domains, which you cannot edit. To manage remediation instances in a lower domain, switch to that domain.
Though you cannot add a remediation to an instance created in an ancestor domain, you can create a similarly configured instance in the current domain and add remediations to that instance. You can also use remediations created in ancestor domains as correlation responses.

**Procedure**

**Step 1**
Choose *Policies > Actions > Instances*.

**Step 2**
Manage your remediation instances:

- Add—To add an instance, choose the remediation module for which you want to add an instance and click **Add**. For system-provided modules, see:
  - *Adding a Cisco IOS Instance*, on page 1413
  - *Adding an Nmap Scan Instance*, on page 1245
  - *Adding a Set Attribute Value Instance*, on page 1418

For help adding a custom module, see the documentation for that module, if available.

- Configure—To configure instance details and add remediations to the instance, click the view icon ( ).
- Delete—To delete an instance that is not in use, click the delete icon ( )

---

### Managing Instances for a Single Remediation Module

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin Discovery Admin</td>
</tr>
</tbody>
</table>

The Module Detail page displays all of the instances and remediations configured for a particular remediation module.

In a multidomain deployment, you can access the Module Detail page for remediation modules installed in the current domain and in ancestor domains. However, you cannot use the Module Detail page to add, delete, or edit instances in the current domain for a module installed in an ancestor domain. Instead, use the Instances page (*Policies > Actions > Instances*); see *Managing Remediation Instances*, on page 1420.

**Procedure**

**Step 1**
Choose *Policies > Actions > Modules*.

**Step 2**
Next to the remediation module whose instances you want to manage, click the view icon ( ).

**Step 3**
Manage your remediation instances:

- Add — To add an instance, click **Add**. For system-provided modules, see:
  - *Adding a Cisco IOS Instance*, on page 1413
• Adding an Nmap Scan Instance, on page 1245
• Adding a Set Attribute Value Instance, on page 1418

For help adding an instance for a custom module, see the documentation for that module, if available.

• Configure — To configure instance details and add remediations to the instance, click the view icon ( ).
• Delete — To delete an instance that is not in use, click the delete icon ( ).
PART XVII

Reporting and Alerting

• Working with Reports, on page 1425
• External Alerting with Alert Responses, on page 1453
• External Alerting for Intrusion Events, on page 1461
CHAPTER 74

Working with Reports

The following topics describe how to work with reports in the Firepower System:

- Introduction to Reports, on page 1425
- Report Templates, on page 1426
- Report Template Creation, on page 1427
- Report Template Configuration, on page 1431
- Managing Report Templates, on page 1445
- Generating Reports, on page 1447
- About Working with Generated Reports, on page 1449

Introduction to Reports

The Firepower System provides a flexible reporting system that allows you to quickly and easily generate multi-section reports with the event views or dashboards that appear on your Firepower Management Center. You can also design your own custom reports from scratch.

A report is a document file formatted in PDF, HTML, or CSV with the content you want to communicate. A report template specifies the data searches and formats for the report and its sections. The Firepower System includes a powerful report designer that automates the design of report templates. You can replicate the content of any event view table or dashboard graphic displayed in the web interface.

You can build as many report templates as you need. Each report template defines the individual sections in the report and specifies the database search that creates the report’s content, as well as the presentation format (table, chart, detail view, and so on) and the time frame. Your template also specifies document attributes, such as the cover page and table of contents and whether the document pages have headers and footers (available only for reports in PDF format). You can export a report template in a single configuration package file and import it for reuse on another Firepower Management Center.

You can include input parameters in a template to expand its usefulness. Input parameters allow you to produce tailored variations of the same report. When you generate a report with input parameters, the generation process prompts you to enter a value for each input parameter. The values you type constrain the report contents on a one-time basis. For example, you can place an input parameter in the destination IP field of the search that produces an intrusion event report; at report generation time, you can specify a department’s network segment when prompted for the destination IP address. The generated report then contains only information concerning that particular department.
Report Templates

You use report templates to define the content and format of the data in each of the report’s sections, as well as the document attributes of the report file (cover page, table of contents, and page headers and footers). After you generate a report, the template stays available for reuse until you delete it.

Your reports contain one or more information sections. You choose the format (text, table, or chart) for each section individually. The format you select for a section may constrain the data that can be included. For example, you cannot show time-based information in certain tables using a pie chart format. You can change the data criteria or format of a section at any time to obtain optimum presentation.

You can base a report’s initial design on a predefined event view, or you can start your design by importing content from any defined dashboard, workflow, or summary. You can also start with an empty template, adding sections and defining their attributes one by one.

Note

In a multidomain deployment, you can view but not edit report templates belonging to ancestor domains. To generate reports from these templates, you must copy them to your current domain.

Report Template Fields

The following table describes the fields you can use to build a section in your report template. Not all fields are used in all types of sections; after you choose the section format, the system displays the appropriate fields.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Section Types</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>n/a</td>
<td>Choose the format of the section data:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Bar chart: Compares quantities of the selected variables.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Line chart: Shows trends/changes over time of a selected variable. Available only for time-based tables.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Pie chart: Shows each selected variable as a percentage of the whole. Variables with quantities of zero are dropped from the chart. Very small quantities are clustered into a category labeled Other.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Table view: Shows values of attributes for each record. Not available for summary or statistical data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Detail view: Shows complex object data associated with certain events, such as packets (for intrusion events) and host profiles (for host events). This format is available only for certain event types that involve such objects. Output may degrade performance if large numbers are requested.</td>
</tr>
<tr>
<td>Table</td>
<td>All</td>
<td>Choose the table from which the section data is extracted.</td>
</tr>
<tr>
<td>Preset</td>
<td>All</td>
<td>Predefined searches. Select an appropriate preset to initialize the search criteria when you define a new search.</td>
</tr>
</tbody>
</table>
## Field Name, Section Types, Definition

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Section Types</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search or Filter</td>
<td>All</td>
<td>For most tables, you can constrain a report using a predefined or saved Search. You can also create a new search by clicking the edit icon (✓). For the Application Statistics table, you use a user-defined application Filter to constrain a report.</td>
</tr>
<tr>
<td>X-Axis</td>
<td>Bar chart</td>
<td>Available data for the X-axis of the selected chart. For line charts, the X-axis value is always Time. For bar and pie charts, you cannot select Time as the X-axis value.</td>
</tr>
<tr>
<td></td>
<td>Line chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pie chart</td>
<td></td>
</tr>
<tr>
<td>Y-Axis</td>
<td>Bar chart</td>
<td>Available data for the Y-axis of the selected chart.</td>
</tr>
<tr>
<td></td>
<td>Line chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pie chart</td>
<td></td>
</tr>
</tbody>
</table>
| Section Description | All       | Descriptive text that precedes the search data in the section. Enter a combination of text and input parameters. The default for a new section is $$<Time Window>$$ and $$<Constraints>$$.

| Time Window     | All           | The time window for the data that appears in the section. If the section searches time-based tables, you can select the check box to inherit the report’s global time window. Alternatively, you can set a specific time window for the section.                                                                                     |

| Maximum Results | Table view    | The maximum number of matching records to include.                                                                                                                                                                                                                                                                                                                                                       |
|                 | Detail view   |                                                                                                                                                                                                                                                                                                                                                                                                                                                                      |

| Results         | Bar chart     | Choose either Top or Bottom and enter the number of matching records you want to use to build the chart.                                                                                                                                                                                                                                                                                                  |
|                 | Pie chart     |                                                                                                                                                                                                                                                                                                                                                                                                                                                                     |

| Color           | Bar chart     | Colors for graphed data in the section.                                                                                                                                                                                                                                                                                                                                                                  |
|                 | Line chart    |                                                                                                                                                                                                                                                                                                                                                                                                                                                                     |

## Report Template Creation

A report template is a framework of sections, each independently built from its own database query.

You can build a new report template by creating a new template, using an existing template, basing a template off an event view, or importing a dashboard or workflow.

If you do not want to copy an existing report template, you can create an entirely new template. The first step in creating a template is to generate the framework that allows you to add and format the sections. Then, in the order you prefer, you design the individual template sections and set attributes for the report document.

Each template section consists of a dataset generated by a search or filter, and has a format specification (table, pie chart, and so on) that determines the mode of presentation. You further determine section content by
selecting the fields in the data records you want to include in the output, as well as the time frame and number of records to show.

**Note**

Use the section preview utility to check the column selection and output characteristics such as pie chart colors. It is not a reliable indicator of the correctness of your configured search.

The report you generate from the template has several document attributes that span all sections and control features, such as the cover page, headers and footers, page numbering, and so on.

Note that if you selected CSV as your document format, you have no document attributes to set.

If you identify a good model among your existing templates, you can copy the template and edit its attributes to create a new report template. Cisco also provides a set of predefined report templates, visible on the **Reports Tab** in the list of templates.

From an event view, you can create a report template and modify it to meet your needs. You can add additional sections, modify automatically included sections, and delete sections.

You can quickly create a new report by importing dashboards, workflows, and statistics summaries. The import creates a section for each widget graphic in your dashboard and each event view in your workflow. You can delete any unnecessary sections to focus on the most important information.

**Creating a Custom Report Template**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

1. **Step 1** Choose **Overview > Reporting**.
2. **Step 2** Click the **Report Templates** tab.
3. **Step 3** Click **Create Report Template**.
4. **Step 4** Enter a name for your new template in the **Report Title** field.
5. **Step 5** To add an input parameter to the report title, place your cursor in the title where the parameter value should appear, then click the insert input parameter icon ( ).
6. **Step 6** Use the set of add icons under the Report Sections title bar to insert sections as necessary.
7. **Step 7** Configure section content as described in **Report Template Configuration**, on page 1431.
   - **Tip** You can click **Preview** at the bottom of the section window to view the column layout or graphic format you chose.
8. **Step 8** Click **Advanced** to set attributes for PDF and HTML reports as described in **Document Attributes in a Report Template**, on page 1441.
9. **Step 9** Click **Save**.
If you see an error, look for a yellow triangle beside the results value in each section. If you see any such triangles, do one of the following:

- For each field that displays a yellow triangle, mouse over the triangle and reduce the number of results to the number indicated.
- Click **Generate** and include an output format other than PDF.

---

### Creating a Report Template from an Existing Template

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

1. **Step 1** Choose **Overview > Reporting**.
2. **Step 2** Click the **Report Templates** tab.
3. **Step 3** Click the copy icon (duplicate) next to the report template you want to copy.
4. **Step 4** In the **Report Title** field, enter a name.
5. **Step 5** Click **Save**.
6. **Step 6** Make changes to the template as needed.

---

### Creating a Report Template from an Event View

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

1. **Step 1** Populate an event view with the events you want in the report:
   - Use an event search to define the events you want to view.
   - Drill down through a workflow until you have the appropriate events in your event view.
2. **Step 2** From the event view page, click **Report Designer**.
   The Report Sections page displays a section for each view in the captured workflow.
3. **Step 3** Optionally, enter a new name in the **Report Title** field and click **Save**.
Creating a Report Template by Importing a Dashboard or Workflow

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
</table>
| **Step 1** Identify the dashboard, workflow, or summary you want to replicate in your report.  
**Step 2** Choose Overview > Reporting.  
**Step 3** Click the Report Templates tab.  
**Step 4** Click Create Report Template.  
**Step 5** Enter a name for your new report template in the Report Title field.  
**Step 6** Click Save.  
**Step 7** Click the import sections icon (\[\]). You can choose any of the data sources described in Data Source Options on Import Report Sections, on page 1431.  
**Step 8** Choose a dashboard, workflow, or summary from the drop-down menus.  
**Step 9** For the data sources you want to add, click Import.  

**Creating a Report Template by Importing a Dashboard or Workflow**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Tip** To view the current column layout or chart formatting for a section, click the section’s Preview link.

**Step 4** You can:

- Add a cover page, table of contents, starting page number, or header and footer text — Click Advanced Settings.
- Add page breaks — Click the add page break icon (\[\]), and drag the new page break object from the template bottom to the front of the section that should start the new page.
- Add text sections — Click the add text section icon (\[\]), and drag the new text section from the template bottom to the place where you want it to appear in the report template.
- Change the title of a section — Click the section title in the title bar, enter the section title, and click OK.
- Configure the report sections — Adjust the field settings in each section.

**Tip** To view the current column layout or chart formatting for a section, click the section’s Preview link.

- Exclude template sections from the report — Click the delete icon (\[\]) in the section’s title bar, and confirm the deletion.

**Note** The last report section in some workflows contains detail views that show packets, host profiles, or vulnerabilities, depending on the workflow. Retrieving large numbers of events with these detail views when generating your report may affect performance of the Firepower Management Center.
For dashboards, each widget graphic will have its own section; for workflows, each event view will have its own section.

**Step 10**
Make changes to the content of your sections as needed.

**Note**
The last report section in some workflows contains detail views that show packets, host profiles, or vulnerabilities, depending on the workflow. Retrieving large numbers of events with these detail views when generating your report may affect performance of the Firepower Management Center.

**Step 11**
Click Save.

---

**Data Source Options on Import Report Sections**

**Table 215: Data Source Options on Import Report Sections Window**

<table>
<thead>
<tr>
<th>Select this option...</th>
<th>To import...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Dashboard</td>
<td>any custom analysis widget on the selected dashboard.</td>
</tr>
<tr>
<td>Import Workflow</td>
<td>any predefined or custom workflow. Selections have the format: Table - Workflow name. For example, Connection Events - Traffic by Port imports the views in the Traffic by Port workflow generated from the Connection Events table.</td>
</tr>
</tbody>
</table>
| Import Summary Sections | any of the following generic summaries:  
  - Intrusion Detailed Summary  
  - Intrusion Short Summary  
  - Discovery Detailed Summary  
  - Discovery Short Summary |

---

**Report Template Configuration**

You can modify and customize a report template once you create it. You can modify a variety of report section attributes to adjust the content of the section and its data presentation.

Each section in a report template queries a database table to generate content for that section. Changing the section's data format uses the same data query, but modifies the fields that appear in the section according to the analytical purpose of the format type. For example, the table view of intrusion events populates the section with a large number of data fields per event record, while a pie chart section shows the portion of all matching records that each selected attribute represents, with no details about individual events. Bar chart sections compare the total counts of matching records that have specific attributes. Line charts summarize changes in the matching records over time with respect to a single attribute. Line charts are available only for data that is time-based, not for information about hosts, users, third-party vulnerabilities, and so on.
The search or filter in a report section specifies the database query on which the section content is based. For most tables, you can constrain a report using a predefined or saved search, or you can create a new search on the fly:

- Predefined searches serve as examples for searching certain event tables and can provide quick access to important information about your network that you may want to include in reports.
- Saved event searches include all public event searches that you or others have created, plus all your saved private event searches.
- Saved searches for the current report template are accessible only in the report template itself. The search names of saved report template searches end with the string “Custom Search.” Users create these searches while designing reports.

For the Application Statistics table, you use a user-defined application filter to constrain a report.

If you include table data in a section, you can choose which fields in the data record to show. All fields in the table are available for inclusion or exclusion. You select fields that accomplish the purpose of the report, then order and sort them accordingly.

You can add text sections to your templates to provide custom text, such as an introduction, for the whole report or for individual sections.

You can add page breaks before or after any section in the template. This feature is particularly helpful for multi-section reports with text pages that introduce the various sections.

A report template’s time window defines the template’s reporting period.

**Note**

Security Analysts can edit only report templates they created. In multidomain deployments, you cannot edit report templates from ancestor domains, but you can copy them to create descendant versions.

### Setting the Table and Data Format for a Report Template Section

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**

In the report template section, use the **Table** drop-down menu to choose the table to query.

Icons appear in the **Format** field for each of the output formats available for the table you chose.

**Step 2**

Choose the applicable output format icon for the section.

**Step 3**

To change the search constraints, click the edit icon (📝) next to the **Search** or **Filter** field.

**Step 4**

For graphic output formats (pie chart, bar chart, and so on), adjust the **X-Axis** and **Y-Axis** parameters using the drop-down menus.
When you choose a value for the X-axis, only compatible values appear in the Y-axis drop-down menu, and vice versa.

**Step 5**
For table output, choose the columns, order of appearance, and sort order in your output.

**Step 6**
Click **Save**.

---

**Related Topics**
- Report Template Fields, on page 1426

---

### Specifying the Search or Filter for a Report Template Section

<table>
<thead>
<tr>
<th>Access</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Admin/Any Security Analyst</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart License</td>
<td>Classic License</td>
<td>Supported Devices</td>
<td>Supported Domains</td>
<td>Access</td>
</tr>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**
In the report template section, choose the database table to query from the **Table** drop-down menu:
- For most tables, the **Search** drop-down list appears.
- For the Application Statistics table, the **Filter** drop-down list appears.

**Step 2**
Choose the search or filter you want to use to constrain the report.

You can view the search criteria or create a new search by clicking the edit icon (ə).

**Related Topics**
- Application Filters, on page 328

---

### Setting the Search Fields that Appear in Table Format Sections

<table>
<thead>
<tr>
<th>Access</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Admin/Any Security Analyst</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart License</td>
<td>Classic License</td>
<td>Supported Devices</td>
<td>Supported Domains</td>
<td>Access</td>
</tr>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**
For table format report sections, click the edit icon (ə) next to the **Fields** parameter.

**Step 2**
If you want to modify the section, you must add and delete fields, and drag the field icons into the column order you want.

**Step 3**
If you want to change the sort order of any column, you must use the drop-down lists on each field icon to set the sort order and priority.
Adding a Text Section to a Report Template

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Text sections can have rich text with multiple font sizes and styles (bold, italic, and so on) as well as input parameters and imported images.

Tip

Text sections are useful for introductions to your report or your report sections.

Procedure

Step 1
In the report template editor, click the add text section icon ( ).

Step 2
Drag the new text section to its intended position in the report template.

Step 3
If you want to position the text section first or last on a page, add page breaks before or after the text section.

Step 4
If you want to change the text section's generic name, click section’s name in the title bar, and enter a new name.

Step 5
Add formatted text and images to the body of the text section.

You can include input parameters that dynamically update when you generate the report.

Step 6
Click Save.

Related Topics

Input Parameters, on page 1438

Adding a Page Break to a Report Template

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Procedure

Step 1
In the report template editor, click the add page break icon ( ).

A page break appears at the bottom of the template.
Global Time Windows and Report Template Sections

Report templates with time-based data (such as intrusion or discovery events) have a global time window, which the time-based sections in the template inherit by default when created. Changing the global time window changes the local time window for the sections that are configured to inherit the global time window. You can disable time window inheritance for an individual section by clearing its Inherit Time Window check box. You can then edit the local time window.

Global time window inheritance applies only to report sections with data from time-based tables, such as intrusion events and discovery events. For sections that report on network assets (hosts and devices) and related information (such as vulnerabilities), you must set each time window individually.

Setting the Global Time Window for a Report Template and Its Sections

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Tip
Your report can have different time ranges per section. For example, your first section could be a summary for the month, and the remaining sections could drill down into details at the week level. In such cases, you set the section-level time windows individually.
Setting the Local Time Window for Report Template Sections

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  
On the Report Sections page of a template, clear the Inherit Time Window check box for the section if it is present.

**Step 2**  
To change the section’s local time window, click the time window icon ( ).

**Note**  
Sections with data from statistics tables can have only sliding time windows.

**Step 3**  
Click Apply on the Events Time Window.

**Step 4**  
Click Save.

Renaming a Report Template Section

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  
In the report template editor, click the current section name in the section header.

**Step 2**  
Enter a new name for the section.

**Step 3**  
Click OK.

Previewing a Report Template Section

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

The preview function shows the field layout and sort order for table views and important legibility characteristics of graphics, such as pie chart colors.
Procedure

Step 1  At any time while editing a report template section, click Preview for the section.
Step 2  Close the preview by clicking OK.

Searches in Report Template Sections

The key to generating successful reports is defining the searches that populate the report’s sections. The Firepower System provides a search editor to view the searches available in your report templates and to define new custom searches.

Searching in Report Template Sections

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Procedure

Step 1  From the relevant section in the report template, click the edit icon (Edit) next to the Search field.
Step 2  If you want to base a custom search on a predefined search, you must choose a predefined search from the Saved Searches drop-down list.

This list includes all available predefined searches for this table, including system-wide and report-specific predefined searches.

Step 3  Edit the search criteria in the appropriate fields.

For certain fields, your constraints can include the same operators (>, <>, and so on) as event searches. If you enter multiple criteria, the search returns only the records that match all the criteria.

Step 4  If you want to insert an input parameter from the drop-down menu instead of entering a constraint value, you must click the input parameter icon (Input).

Note  When you edit the constraints of a reporting search, the system saves your edited search under the following name: section custom search, where section is the name in the section title bar followed by the string custom search. To have meaningful names for your saved custom searches, be sure you change the section name before you save the edited search. You cannot rename a saved reporting search.

Step 5  Click OK.
Input Parameters

You can use input parameters in a report template that the report can dynamically update at generation time. The input parameter icon (።) indicates the fields that can process them. There are two kinds of input parameters:

- **Predefined input parameters** are resolved by internal system functions or configuration information. For example, at report generation time, the system replaces the $<Time>$ parameter with the current date and time.

- **User-defined input parameters** supply constraints in section searches. Constraining a search with an input parameter instructs the system to collect a value at generation time from the person who requests the report. In this way, you can dynamically tailor a report at generation time to show a particular subset of data without changing the template. For example, you can provide an input parameter for the Destination IP field of a report section’s search. Then, when you generate the report, you can enter the IP network segment for a particular department to get data for that department only.

You can also define string-type input parameters to add dynamic text in certain fields of your report, such as in emails (subject or body), report file names, and text sections. You can personalize reports for different departments, with customized report file names, email addresses, and email messages, using the same template for all.

### Predefined Input Parameters

<table>
<thead>
<tr>
<th>Insert this parameter...</th>
<th>...to include this information in your template:</th>
</tr>
</thead>
<tbody>
<tr>
<td>$&lt;Logo&gt;$</td>
<td>The selected uploaded logo</td>
</tr>
<tr>
<td>$&lt;Report Title&gt;$</td>
<td>The report title</td>
</tr>
<tr>
<td>$&lt;Time&gt;$</td>
<td>The date and time of day the report ran, with one-second granularity</td>
</tr>
<tr>
<td>$&lt;Month&gt;$</td>
<td>The current month</td>
</tr>
<tr>
<td>$&lt;Year&gt;$</td>
<td>The current year</td>
</tr>
<tr>
<td>$&lt;System Name&gt;$</td>
<td>The name of the Firepower Management Center</td>
</tr>
<tr>
<td>$&lt;Model Number&gt;$</td>
<td>The model number of the Firepower Management Center</td>
</tr>
<tr>
<td>$&lt;Time Window&gt;$</td>
<td>The time window currently applied to the report section</td>
</tr>
<tr>
<td>$&lt;Constraints&gt;$</td>
<td>The search constraints currently applied to the report section</td>
</tr>
</tbody>
</table>
You use input parameters to expand the usefulness of your searches. The input parameter instructs the system to collect a value at generation time from the person who requests the report. In this way, you can dynamically constrain a report at generation time to show a particular subset of data without changing the search. For example, you can provide an input parameter for the Destination IP field of a report section that drills down on security events at a department level. When you generate the report, you can type the IP network segment for a particular department to get data for that department only.

An input parameter’s type determines the search fields where you can use it. You can use a given type only in appropriate fields. For example, a user parameter you define as a string type is available for insertion in text fields but not in fields that take an IP address.

Each input parameter you define has a name and a type.

### Table 217: Predefined Input Parameter Usage

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Report Template Cover Page</th>
<th>Report Template Report Title</th>
<th>Report Template Section Description</th>
<th>Report Template Text Section</th>
<th>Generate Report File Name</th>
<th>Generate Report Email Subject, Body</th>
</tr>
</thead>
<tbody>
<tr>
<td>$&lt;Logo&gt;$</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>$&lt;Report Title&gt;$</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>$&lt;Time&gt;$</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>$&lt;Month&gt;$</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>$&lt;Year&gt;$</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>$&lt;System Name&gt;$</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>$&lt;Model Number&gt;$</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>$&lt;Time Window&gt;$</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>$&lt;Constraints&gt;$</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

### User-Defined Input Parameters

<table>
<thead>
<tr>
<th>Use this parameter type...</th>
<th>With fields with this data...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network/IP</td>
<td>any IP address or network segment in CIDR format</td>
</tr>
<tr>
<td>Application</td>
<td>name of an application protocol, client application, or web application</td>
</tr>
<tr>
<td>Event Message</td>
<td>any event view message</td>
</tr>
<tr>
<td>Device</td>
<td>a FMC or managed device</td>
</tr>
<tr>
<td>Username</td>
<td>user identification such as initiator user and responder user</td>
</tr>
<tr>
<td>Number (VLAN ID, Snort ID, Vuln ID)</td>
<td>any VLAN ID, Snort ID, or vulnerability ID</td>
</tr>
</tbody>
</table>
Creating User-Defined Input Parameters

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  
In the report template editor, click **Advanced**.

**Step 2**  
Click the add input parameter icon (charAt(0)).

**Step 3**  
Enter the parameter **Name**.

**Step 4**  
Choose a value from the **Type** drop-down list.

**Step 5**  
Click **OK** to add the parameter.

**Step 6**  
Click **OK** to return to the editor.

Editing User-Defined Input Parameters

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

The **Input Parameters** section of the report template lists all available user-defined parameters for the template.

**Procedure**

**Step 1**  
In the report template editor, click **Advanced**.

**Step 2**  
Click the edit icon (charAt(0)) next to the parameter you want to modify.

**Step 3**  
Enter a new **Name**.

**Step 4**  
Use the **Type** drop-down list to change the parameter type.

**Step 5**  
Click **OK** to save your changes.

**Step 6**  
If you want to delete an input parameter, click the delete icon (charAt(0)) next to the input parameter and confirm.

**Step 7**  
Click **OK** to return to the report template editor.
Constraining a Search with User-Defined Input Parameters

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Input parameters you define are available only for search fields that match their parameter type. For example, a parameter of type **Network/IP** is available only for fields that accept IP addresses or network segments in CIDR format.

**Procedure**

**Step 1**
In the report template editor, click the edit icon (📝) next to the **Search** field within the section.

Fields that can take an input parameter are marked with the input parameter icon (🔍).

**Step 2**
Click the input parameter icon (🔍) next to the field, then choose the input parameter from the drop-down menu.

User-defined input parameters are marked with the icon (🔍).

**Step 3**
Click **OK**.

**Document Attributes in a Report Template**

Before you generate your report, you can set document attributes that affect the report’s appearance. These attributes include the optional cover page and table of contents. Support for some attributes depends on the selected report format: PDF, HTML, or CSV.

**Table 219: Document Attribute Support**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>PDF Support?</th>
<th>HTML Support?</th>
<th>CSV Support?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover page</td>
<td>yes, with optional logo and custom appearance</td>
<td>yes, with optional logo and custom appearance</td>
<td>no</td>
</tr>
<tr>
<td>Table of contents</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Page headers and footers</td>
<td>yes, with optional text or logo in any field</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Custom starting page number</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Option to suppress numbering of first page</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>
Editing Document Attributes in a Report Template

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**
In the report template editor, click **Advanced**.

**Step 2**
You have the following choices:

- Add cover page — To add a cover page, check the **Include Cover Page** check box.
- Customize cover page — To edit the cover page design, see Customizing a Cover Page, on page 1442.
- Add table of contents — To add a table of contents, check the **Include Table of Contents** check box.
- Manage logos — To manage the logo image associated with the template, see Managing Report Template Logos, on page 1443.
- Configure header and footer — To specify elements for the header and footer of the template, use the drop-down lists in the **Header** and **Footer** fields.
- Set first page number — To specify the page number of the report's first page, enter a **Page Number Start** value.
- Show first page number — To show the page number on the report's first page, check the **Number First Page?** check box. If you choose this option, the cover page is not numbered.

**Step 3**
Click **OK** to save your changes.

Customizing a Cover Page

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can customize a report template’s cover page. Cover pages can have rich text with multiple font sizes and styles (bold, italic, and so on) as well as input parameters and imported images.

**Procedure**

**Step 1**
In the report template editor, click **Advanced**.

**Step 2**
Click the edit icon (✏️) next to **Cover Page Design**.

**Step 3**
Edit the cover page design within the rich text editor.

**Step 4**
Click **OK**.
Managing Report Template Logos

You can store multiple logos on the Firepower Management Center and associate them with different report templates. You set the logo association when you design the template. If you export the template, the export package contains the logo.

When you upload a logo to the Firepower Management Center, it is available for:

- all report templates on the Firepower Management Center, or
- in a multidomain deployment, all report templates in your current domain

Logo images can be in GIF, JPG, or PNG format.

You can change the logo in a report to any JPG image uploaded to your Firepower Management Center. For example, if you reuse a template, you can associate a logo for a different organization with the report.

You can delete any uploaded logos. Deleting a logo removes it from all templates where it is used. The deletion cannot be undone. Note that you cannot delete the predefined Cisco logo.

**Procedure**

**Step 1**
In the report template editor, click *Advanced*.

The logo currently associated with the template appears under *Logo* in *General Settings*.

**Step 2**
Click the edit icon (⚃) next to the logo.

**Step 3**
You have the following choices:

- Add — Add a new logo as described in *Adding a New Logo*, on page 1443.
- Change — Change a report template’s logo as described in *Changing the Logo for a Report Template*, on page 1444.
- Delete — Delete a logo as described in *Deleting a Logo*, on page 1444.

**Adding a New Logo**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**
In the report template editor, click *Advanced*. 
Changing the Logo for a Report Template

**Step 2** Click the edit icon (-pencil) next to the **Logo** field.

**Step 3** Click **Upload Logo**.

**Step 4** Click the **Browse** button, browse to the file’s location, and click **Open**.

**Step 5** Click **Upload**.

**Step 6** If you want to associate the new logo with the current template, choose it, and click **OK**.

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
</tr>
</tbody>
</table>

Deleting a Logo

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
</tr>
</tbody>
</table>
Managing Report Templates

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays report templates created in the current domain, which you can edit. It also displays report templates created in ancestor domains, which you cannot edit. To view and edit report templates in a lower domain, switch to that domain. The system displays reports created in the current domain only.

Procedure

**Step 1** Choose **Overview** > **Reporting**.

**Step 2** Click the **Report Templates** tab.

**Step 3** You have the following choices:

- **Delete** — Next to the template you want to delete, click the delete icon (Trash) and confirm.
  
  You cannot delete system-provided report templates. Security Analysts can delete only report templates they created. In a multidomain deployment, you can delete report templates belonging to the current domain only.

- **Edit** — To edit report templates; see **Editing Report Templates**, on page 1445.

- **Export** — To export report templates, see **Exporting Report Templates**, on page 1446.

  **Tip** You can also export report templates using the standard configuration export process; see **Exporting Configurations**, on page 147.

- **Import** — To import report templates, see **Importing Configurations**, on page 148.

Editing Report Templates

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays report templates created in the current domain, which you can edit. It also displays report templates created in ancestor domains, which you cannot edit. To view and edit report templates in a lower domain, switch to that domain.

Procedure

**Step 1** Choose **Overview** > **Reporting**.
**Step 2**  Click the **Report Templates** tab.

**Step 3**  Click the edit icon (📝) for the template you want to edit.

If a view icon (👁️) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 4**  You have the following choices:

- Add a page break; see Adding a Page Break to a Report Template, on page 1434.
- Add a text section; see Adding a Text Section to a Report Template, on page 1434.
- Configure section content as described in Report Template Configuration, on page 1431.
- Create input parameters; see Creating User-Defined Input Parameters, on page 1440.
- Edit input parameters; see Editing User-Defined Input Parameters, on page 1440.
- Edit document attributes; see Editing Document Attributes in a Report Template, on page 1442.
- Search template sections; see Searching in Report Template Sections, on page 1437.
- Set document attributes described in Document Attributes in a Report Template, on page 1441 by clicking **Advanced**.
- Set the global time window; see Setting the Global Time Window for a Report Template and Its Sections, on page 1435.
- Set the local time window; see Setting the Local Time Window for Report Template Sections, on page 1436.
- Set the search fields; see Setting the Search Fields that Appear in Table Format Sections, on page 1433.
- Set the table and data format; see Setting the Table and Data Format for a Report Template Section, on page 1432.
- Specify searches and filters; see Specifying the Search or Filter for a Report Template Section, on page 1433.

---

### Exporting Report Templates

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  Choose **Overview > Reporting**.

**Step 2**  Choose the **Report Templates** tab.

**Step 3**  For the template you want to export, click the export icon (🗹).

**Step 4**  Click **Save file** and **OK** to save the file to your local computer.
Generating Reports

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

After you create and customize your report template, you are ready to generate the report. The generation process lets you select the report’s format (HTML, PDF, or CSV). You can also adjust the report’s global time window, which applies a consistent time frame to all sections except those you exempt.

For PDF reports:

- File names using Unicode (UTF-8) characters are not supported.
- Any report sections that include special Unicode file names (such as those appearing in file or malware events) display these file names in transliterated form.

If the report template includes user input parameters in its search specification, the generation process prompts you to enter values, which tailor this run of the report to a subset of the data.

If you have a DNS server configured and IP address resolution enabled, reports contain host names if resolution was successful.

In a multidomain deployment, when you generate a report in an ancestor domain, it can include results from all descendant domains. To generate a report for a specific leaf domain, switch to that domain.

**Procedure**

**Step 1** Choose Overview > Reporting.
**Step 2** Click the Report Templates tab.
**Step 3** Click the report icon (square) next to the template you want to use to generate a report.

If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Tip** To generate a report from an ancestor’s template, copy the template into the current domain.

**Step 4** Optionally, configure the report name:

- Enter a new File Name. If you do not enter a new name, the system uses the name specified in the report template.
- Use the input parameter icon (circle) to add one or more input parameters to the file name.

**Step 5** Choose the output format for the report by clicking the corresponding icon: HTML, PDF, or CSV.
**Step 6** If you want to change the global time window, click the time window icon (circle).

**Note** Setting the global time window affects the content of individual report sections only if they are configured to inherit the global setting.

**Step 7** Enter values for any fields that appear in the Input Parameters section.
**Tip** You can ignore user parameters by typing the `*` wildcard character in the field. This eliminates the user parameter’s constraint on the search.

**Note** The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses or VLAN tags to constrain report results can have unexpected results.

**Step 8** If you enabled an email relay host in the Firepower Management Center configuration, click Email to automate email delivery of the report when it generates.

**Step 9** Click OK and confirm when prompted.

Clicking Generate saves Generate settings with the report template.

If you click Cancel, your selections are saved only for the duration of your session.

**Step 10** You have the following choices:

- Click the report link to display the report in a new window.
- Click OK to return to the report template editor.

---

**Report Generation Options**

You can configure report generation options to:

- Schedule generation of future reports, either once or recurring. See Automating Report Generation, on page 157. You can customize the schedule on a full range of time frames such as daily, weekly, monthly, and so on.

- Distribute email reports using the scheduler. You must configure your report template and a mail relay host before scheduling the task.

- Automatically send the report as an email attachment to a list of recipients when you generate a report. You must have a properly configured mail relay host to deliver a report by email.

- Save newly generated report files to your configured remote storage location. To use remote storage, you must first configure a remote storage location.

**Note** If you store remotely and then switch back to local storage, the reports in remote storage do not appear on the Reports tab list. Similarly, if you switch from one remote storage location to another, the reports in the previous location do not appear in the list.

---

**Distributing Reports by Email at Generation Time**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

*Firepower Management Center Configuration Guide, Version 6.0*
Procedure

**Step 1** Choose **Overview > Reporting**.

**Step 2** Click the **Report Templates** tab.

**Step 3** Click the report icon ( ) next to the template you want to use to generate a report.

If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Tip** To generate a report from an ancestor’s template, copy the template into the current domain.

**Step 4** Expand the **Email** section of the window.

**Step 5** In the **Email Options** field, choose **Send Email**.

**Step 6** In the **Recipient List, CC, and BCC** fields, enter recipients’ email addresses in comma-separated lists.

**Step 7** In the **Subject** field, enter an email subject.

**Tip** You can provide input parameters in the **Subject** field and the message body to dynamically generate information in the email, such as a timestamp or the name of the Firepower Management Center.

**Step 8** Enter a cover letter in the email body as necessary.

**Step 9** Click **OK** and confirm.

**Related Topics**

- Configuring a Mail Relay Host and Notification Address, on page 472

**About Working with Generated Reports**

Access and work with previously-generated reports on the Reports tab page.

**Viewing Reports**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Analyst</td>
</tr>
</tbody>
</table>

The Reports tab lists all previously generated reports, with report name, date and time of generation, generating user, and whether the report is stored locally or remotely. A status column indicates whether the report is already generated, is in the generation queue (for example, for scheduled tasks), or failed to generate (for example, due to lack of disk space).

Note that users with Administrator access can view all reports; other users can view only the reports they generated.

In a multidomain deployment, you can view reports generated in the current domain only.

The Reports tab page shows all locally stored reports. It shows remotely stored reports as well, if remote storage is currently configured. The **Location** column data for remotely-stored reports is **Remote**.
If you store remotely and then switch back to local storage, the reports in remote storage do not appear on the Reports tab list. Similarly, if you switch from one remote storage location to another, the reports in the previous location do not appear in the list.

Procedure

Step 1  Choose Overview > Reporting.
Step 2  Click the Reports tab.
Step 3  Click the report you want to view.

Downloading Reports

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can download any report file to your local computer. From there, you can email it or distribute it electronically by other available means.

In a multidomain deployment, you can download reports generated in the current domain only.

Procedure

Step 1  Choose Overview > Reporting.
Step 2  Click the Reports tab.
Step 3  Check the checkboxes next to the reports you want to download, then click Download.

Tip  Click the check box at the top left of the page to download all reports on the page. If you have multiple pages of reports, a second check box appears that you can click to download all reports on all pages.

Step 4  Follow your browser’s prompts to download the reports. If you chose multiple reports, they are downloaded in a single .zip file.

Storing Reports Remotely

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>
The location of your currently configured report storage appears at the bottom of the Overview > Reporting > Reports page, with disk usage for local, NFS, and SMB storage. If you access remote storage using SSH, disk usage data is not available.

Note
If you store remotely and then switch back to local storage, the reports in remote storage do not appear on the Reports tab list. Similarly, if you switch from one remote storage location to another, the reports in the previous location do not appear in the list.

Before you begin
• Configure a remote storage location as described in Remote Storage Management, on page 461.

Procedure

Step 1
Choose Overview > Reporting.

Step 2
Choose the Reports tab.

Step 3
Check the Enable Remote Storage of Reports check box at the bottom of the page.

What to do next
• Move reports from local storage to remote storage; see Moving Reports to Remote Storage, on page 1451.

Related Topics
Remote Storage Management, on page 461
Moving Reports to Remote Storage, on page 1451

Moving Reports to Remote Storage

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can move your reports in local storage to a remote storage location in batch mode or singly.

Note
If you store remotely and then switch back to local storage, the reports in remote storage do not appear on the Reports tab list. Similarly, if you switch from one remote storage location to another, the reports in the previous location do not appear in the list.

Before you begin
• Configure a remote storage location as described in Remote Storage Management, on page 461.
Deleting Reports

You can delete your report files at any time. The procedure completely removes the files, and no recovery is possible. Although you still have the report template that generated the report, it may be difficult to regenerate a particular report file if the time window was expanding or sliding. Regeneration may also be difficult if your template uses input parameters.

In a multidomain deployment, you can delete reports generated in the current domain only.

Procedure

Step 1 Choose Overview > Reporting.
Step 2 Click the Reports tab.
Step 3 You have the following choices:
   • Delete selected — Check the check boxes next to the reports you want to delete, then click Delete.
   • Delete all — Check the check box at the top left of the page to delete all reports on the page. If you have multiple pages of reports, a second check box appears that you can check to delete all reports on all pages.

Step 4 Confirm the deletion.

Deleting Reports

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can delete your report files at any time. The procedure completely removes the files, and no recovery is possible. Although you still have the report template that generated the report, it may be difficult to regenerate a particular report file if the time window was expanding or sliding. Regeneration may also be difficult if your template uses input parameters.

In a multidomain deployment, you can delete reports generated in the current domain only.

Procedure

Step 1 Choose Overview > Reporting.
Step 2 Choose the Reports tab.
Step 3 Choose the checkboxes next to the reports you want to move, then click Move.

Tip Check the checkbox at the top left of the page to move all reports on the page. If you have multiple pages of reports, a second check box appears that you can check to move all reports on all pages.

Step 4 Confirm that you want to move the reports.
External Alerting with Alert Responses

The following topics describe how to send external event alerts from the Firepower Management Center using alert responses:

- Firepower Management Center Alert Responses, on page 1453
- Creating an SNMP Alert Response, on page 1454
- Creating a Syslog Alert Response, on page 1455
- Creating an Email Alert Response, on page 1458
- Configuring Impact Flag Alerting, on page 1459
- Configuring Discovery Event Alerting, on page 1459
- Configuring AMP for Networks Alerting, on page 1460

Firepower Management Center Alert Responses

External event notification via SNMP, syslog, or email can help with critical-system monitoring. The Firepower Management Center uses configurable alert responses to interact with external servers. An alert response is a configuration that represents a connection to an email, SNMP, or syslog server. They are called responses because you can use them to send alerts in response to events detected by Firepower. You can configure multiple alert responses to send different types of alerts to different monitoring servers and/or people.

Note

Alerts that use alert responses are sent by the Firepower Management Center. Intrusion email alerts, which do not use alert responses, are also sent by the Firepower Management Center. By contrast, SNMP and syslog alerts that are based on individual intrusion rules triggering are sent directly by managed devices. For more information, see External Alerting for Intrusion Events, on page 1461.

In most cases, the information in an external alert is the same as the information in any associated event you logged to the database. However, for correlation event alerts where the correlation rule contains a connection tracker, the information you receive is the same as for an alert on a traffic profile change, regardless of the base event type.

You create and manage alert responses on the Alerts page (Policies > Actions > Alerts). New alert responses are automatically enabled. To temporarily stop alert generation, you can disable alert responses rather than deleting them.

Changes to alert responses take effect immediately, except when sending connection logs to an SNMP trap or syslog server.
In a multidomain deployment, when you create an alert response it belongs to the current domain. This alert response can also be used by descendant domains.

**Configurations Supporting Alert Responses**

After you create an alert response, you can use it to send the following external alerts from the Firepower Management Center.

<table>
<thead>
<tr>
<th>Alert/Event Type</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intrusion events, by impact flag</td>
<td>Configuring Impact Flag Alerting, on page 1459</td>
</tr>
<tr>
<td>Discovery events, by type</td>
<td>Configuring Discovery Event Alerting, on page 1459</td>
</tr>
<tr>
<td>Malware and retrospective malware events detected by AMP for Networks</td>
<td>Configuring AMP for Networks Alerting, on page 1460</td>
</tr>
<tr>
<td>Correlation events, by correlation policy violation</td>
<td>Adding Responses to Rules and White Lists, on page 1363</td>
</tr>
<tr>
<td>Connection events, by the logging rule or default action (email alerts</td>
<td>Other Connections You Can Log, on page 1584</td>
</tr>
<tr>
<td>not supported)</td>
<td></td>
</tr>
<tr>
<td>Health events, by health module and severity level</td>
<td>Creating Health Monitor Alerts, on page 232</td>
</tr>
</tbody>
</table>

**Creating an SNMP Alert Response**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can create SNMP alert responses using SNMPv1, SNMPv2, or SNMPv3.

**Note**

When selecting SNMP versions for the SNMP protocol, note that SNMPv2 only supports read-only communities and SNMPv3 only supports read-only users. SNMPv3 also supports encryption with AES128.

If you want to monitor 64-bit values with SNMP, you must use SNMPv2 or SNMPv3. SNMPv1 does not support 64-bit monitoring.

**Before you begin**

- If your network management system requires the Firepower Management Center’s management information base (MIB) file, obtain it at `/etc/sf/DCEALERT.MIB`.

**Procedure**

**Step 1** Choose Policies > Actions > Alerts.
Step 2: From the Create Alert drop-down menu, choose Create SNMP Alert.

Step 3: Enter a Name to identify the SNMP response.

Step 4: In the Trap Server field, enter the hostname or IP address of the SNMP trap server.

**Note** The system does not warn you if you enter an invalid IPv4 address (such as 192.169.1.456) in this field. Instead, the invalid address is treated as a hostname.

Step 5: From the Version drop-down list, choose the SNMP version you want to use. SNMP v3 is the default.

Step 6: Depending on the version on SNMP you use, do one of the following:

- For SNMP v1 or SNMP v2, enter the SNMP community name in the **Community String** field and skip to step 12.
- For SNMP v3, enter the name of the user that you want to authenticate with the SNMP server in the **User Name** field and continue to the next step.

Step 7: From the Authentication Protocol drop-down list, choose the protocol you want to use for authentication.

Step 8: In the Authentication Password field, enter the password required for authentication with the SNMP server.

Step 9: From the Privacy Protocol list, choose None to use no privacy protocol or DES to use Data Encryption Standard as the privacy protocol.

Step 10: In the Privacy Password field, enter the privacy password required by the SNMP server.

Step 11: In the Engine ID field, enter an identifier for the SNMP engine, in hexadecimal notation, using an even number of digits.

When you use SNMPv3, the system uses an Engine ID value to encode the message. Your SNMP server requires this value to decode the message.

Cisco recommends that you use the hexadecimal version of the Firepower Management Center’s IP address. For example, if the Firepower Management Center has an IP address of 10.1.1.77, use 0a01014D0.

Step 12: Click Save.

**What to do next**

Changes take effect immediately, EXCEPT:

If you are using alert responses to send connection logs, you must deploy configuration changes after you edit those alert responses.

### Creating a Syslog Alert Response

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

When configuring a syslog alert response, you can specify the severity and facility associated with the syslog messages to ensure that they are processed properly by the syslog server. The facility indicates the subsystem that creates the message and the severity defines the severity of the message. Facilities and severities are not displayed in the actual message that appears in the syslog, but are instead used to tell the system that receives the syslog message how to categorize it.
Tip
For more detailed information about how syslog works and how to configure it, refer to the documentation for your system. On UNIX systems, the man pages for syslog and syslog.conf provide conceptual information and configuration instructions.

Although you can choose any type of facility when creating a syslog alert response, you should choose one that makes sense based on your syslog server; not all syslog servers support all facilities. For UNIX syslog servers, the syslog.conf file should indicate which facilities are saved to which log files on the server.

Before you begin
- Confirm that the syslog server can accept remote messages.

Procedure

Step 1
Choose **Policies** > **Actions** > **Alerts**.

Step 2
From the **Create Alert** drop-down menu, choose **Create Syslog Alert**.

Step 3
Enter a **Name** for the alert.

Step 4
In the **Host** field, enter the hostname or IP address of your syslog server.

**Note** The system does **not** warn you if you enter an invalid IPv4 address (such as 192.168.1.456) in this field. Instead, the invalid address is treated as a hostname.

Step 5
In the **Port** field, enter the port the server uses for syslog messages. By default, this value is 514.

Step 6
From the **Facility** list, choose a facility described in **Syslog Alert Facilities**, on page 1456.

Step 7
From the **Severity** list, choose a severity described in **Syslog Severity Levels**, on page 1457.

Step 8
In the **Tag** field, enter the tag name that you want to appear with the syslog message.

For example, if you wanted all messages sent to the syslog to be preceded with `FromMC`, enter `FromMC` in the field.

Step 9
Click **Save**.

What to do next
Changes take effect immediately, **EXCEPT:**

If you are using alert responses to send connection logs to a syslog server, you must deploy configuration changes after you edit those alert responses.

### Syslog Alert Facilities

The following table lists the syslog facilities you can select.
### Syslog Severity Levels

The following table lists the standard syslog severity levels you can select.

<table>
<thead>
<tr>
<th>Facility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALERT</td>
<td>An alert message.</td>
</tr>
<tr>
<td>AUDIT</td>
<td>A message generated by the audit subsystem.</td>
</tr>
<tr>
<td>AUTH</td>
<td>A message associated with security and authorization.</td>
</tr>
<tr>
<td>AUTHPRIV</td>
<td>A restricted access message associated with security and authorization. On many systems, these messages are forwarded to a secure file.</td>
</tr>
<tr>
<td>CLOCK</td>
<td>A message generated by the clock daemon.</td>
</tr>
<tr>
<td></td>
<td>Note that syslog servers running a Windows operating system will use the CLOCK facility.</td>
</tr>
<tr>
<td>CRON</td>
<td>A message generated by the clock daemon.</td>
</tr>
<tr>
<td></td>
<td>Note that syslog servers running a Linux operating system will use the CRON facility.</td>
</tr>
<tr>
<td>DAEMON</td>
<td>A message generated by a system daemon.</td>
</tr>
<tr>
<td>FTP</td>
<td>A message generated by the FTP daemon.</td>
</tr>
<tr>
<td>KERN</td>
<td>A message generated by the kernel. On many systems, these messages are printed to the console when they appear.</td>
</tr>
<tr>
<td>LOCAL0-LOCAL7</td>
<td>A message generated by an internal process.</td>
</tr>
<tr>
<td>LPR</td>
<td>A message generated by the printing subsystem.</td>
</tr>
<tr>
<td>MAIL</td>
<td>A message generated by a mail system.</td>
</tr>
<tr>
<td>NEWS</td>
<td>A message generated by the network news subsystem.</td>
</tr>
<tr>
<td>NTP</td>
<td>A message generated by the NTP daemon.</td>
</tr>
<tr>
<td>SYSLOG</td>
<td>A message generated by the syslog daemon.</td>
</tr>
<tr>
<td>USER</td>
<td>A message generated by a user-level process.</td>
</tr>
<tr>
<td>UUCP</td>
<td>A message generated by the UUCP subsystem.</td>
</tr>
</tbody>
</table>
### Table 221: Syslog Severity Levels

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALERT</td>
<td>A condition that should be corrected immediately.</td>
</tr>
<tr>
<td>CRIT</td>
<td>A critical condition.</td>
</tr>
<tr>
<td>DEBUG</td>
<td>Messages that contain debugging information.</td>
</tr>
<tr>
<td>EMERG</td>
<td>A panic condition broadcast to all users.</td>
</tr>
<tr>
<td>ERR</td>
<td>An error condition.</td>
</tr>
<tr>
<td>INFO</td>
<td>Informational messages.</td>
</tr>
<tr>
<td>NOTICE</td>
<td>Conditions that are not error conditions, but require attention.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Warning messages.</td>
</tr>
</tbody>
</table>

### Creating an Email Alert Response

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Before you begin**

- Confirm that the Firepower Management Center can reverse-resolve its own IP address.
- Configure your mail relay host as described in Configuring a Mail Relay Host and Notification Address, on page 472.

**Note**
You cannot use email alerting to log connections.

**Procedure**

**Step 1** Choose Policies > Actions > Alerts.

**Step 2** From the Create Alert drop-down menu, choose Create Email Alert.

**Step 3** Enter a Name for the alert response.

**Step 4** In the To field, enter the email addresses where you want to send alerts, separated by commas.

**Step 5** In the From field, enter the email address that you want to appear as the sender of the alert.

**Step 6** Next to Relay Host, verify the listed mail server is the one that you want to use to send the alert.

**Tip** To change the email server, click the edit icon (✏️).
Step 7 Click Save.

## Configuring Impact Flag Alerting

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can configure the system to alert you whenever an intrusion event with a specific impact flag occurs. Impact flags help you evaluate the impact an intrusion has on your network by correlating intrusion data, network discovery data, and vulnerability information.

### Procedure

**Step 1** Choose Policies > Actions > Alerts.

**Step 2** Click the Impact Flag Alerts tab.

**Step 3** In the Alerts section, choose the alert response you want to use for each alert type.

**Tip** To create a new alert response, choose New from any drop-down list.

**Step 4** In the Impact Configuration section, check the appropriate check boxes to specify the alerts you want to receive for each impact flag.

For definitions of the impact flags, see Intrusion Event Impact Levels, on page 1632.

**Step 5** Click Save.

## Configuring Discovery Event Alerting

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can configure the system to alert you whenever a specific type of discovery event occurs.

### Before you begin

- Configure your network discovery policy to log the discovery event types you want to configure alerting for as described in Configuring Network Discovery Event Logging, on page 1319.

### Procedure

**Step 1** Choose Policies > Actions > Alerts.
Configuring AMP for Networks Alerting

You can configure the system to alert you whenever any malware event, including a retrospective event, is generated by AMP for Networks (that is, a “network-based malware event” is generated.) You cannot alert on malware events generated by AMP for Endpoints (“endpoint-based malware events.”)

Before you begin

• Configure a file policy to perform malware cloud lookups and associate that policy with an access control rule as described in Access Control Using Intrusion and File Policies, on page 653.

Procedure

Step 1 Choose Policies > Actions > Alerts.
Step 2 Click the Advanced Malware Protections Alerts tab.
Step 3 In the Alerts section, choose the alert response you want to use for each alert type.
Tip To create a new alert response, choose New from any drop-down list.
Step 4 In the Event Configuration section, check the check boxes that correspond to the alerts you want to receive for each malware event type.
Keep in mind that All network-based malware events includes Retrospective Events.
(By definition, network-based malware events do not include events generated by AMP for Endpoints.)
Step 5 Click Save.
CHAPTER 76

External Alerting for Intrusion Events

The following topics describe how to configure external alerting for intrusion events:

- About External Alerting for Intrusion Events, on page 1461
- Configuring SNMP Alerting for Intrusion Events, on page 1462
- Configuring Syslog Alerting for Intrusion Events, on page 1463
- Configuring Email Alerting for Intrusion Events, on page 1465

About External Alerting for Intrusion Events

External intrusion event notification can help with critical-system monitoring:

- SNMP—Configured per intrusion policy and sent from managed devices. You can enable SNMP alerting per intrusion rule.
- Syslog—Configured per intrusion policy and sent from managed devices. When you enable syslog alerting in an intrusion policy, you turn it on for every rule in the policy.
- Email—Configured across all intrusion policies and sent from the Firepower Management Center. You can enable email alerts per intrusion rule, as well as limit their length and frequency.

Keep in mind that if you configured intrusion event suppression or thresholding, the system may not generate intrusion events (and thus may not send alerts) every time a rule triggers.

In a multidomain deployment, you can configure external alerting in any domain. In ancestor domains, the system generates notifications for intrusion events in descendant domains.

Note

The Firepower Management Center also uses SNMP, syslog, and email alert responses to send different types of external alerts; see Firepower Management Center Alert Responses, on page 1453. The system does not use alert responses to send alerts based on individual intrusion events.

Related Topics

Intrusion Event Notification Filters in an Intrusion Policy, on page 890
Configuring SNM Alerting for Intrusion Events

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

After you enable external SNMP alerting in an intrusion policy, you can configure individual rules to send SNMP alerts when they trigger. These alerts are sent from the managed device.

Procedure

Step 1 In the intrusion policy editor's navigation pane, click Advanced Settings.

Step 2 Make sure SNMP Alerting is Enabled, then click Edit. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration.

Step 3 Choose an SNMP Version, then specify configuration options as described in Intrusion SNMP Alert Options, on page 1462.

Step 4 In the navigation pane, click Rules.

Step 5 In the rules pane, choose the rules where you want to set SNMP alerts, then choose Alerting > Add SNMP Alert.

Step 6 To save changes you made in this policy since the last policy commit, choose Policy Information, then click Commit Changes. If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

What to do next

• Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Intrusion SNMP Alert Options

If your network management system requires a management information base file (MIB), you can obtain it from the Firepower Management Center at /etc/sf/DCEALERT.MIB.

SNMP v2 Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trap Type</td>
<td>The trap type to use for IP addresses that appear in the alerts. If your network management system correctly renders the INET_IPV4 address type, choose as Binary. Otherwise, choose as String. For example, HP OpenView requires as String.</td>
</tr>
</tbody>
</table>
### SNMP v3 Options

Managed devices encode SNMPv3 alerts with an Engine ID value. To decode the alerts, your SNMP server requires this value, which is the hexadecimal version of the sending device's management interface IP address, appended with "01."

For example, if the device sending the SNMP alert has a management interface IP address of 172.16.1.50, the Engine ID value is 0xAC10013201.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trap Server</td>
<td>The server that will receive SNMP traps notification. You can specify a single IP address or hostname.</td>
</tr>
<tr>
<td>Community String</td>
<td>The community name.</td>
</tr>
</tbody>
</table>

**SNMP v3 Options**

The server that will receive SNMP traps notification.
You can specify a single IP address or hostname.

**Option** | **Description** |
---|---|
Trap Server | The trap type to use for IP addresses that appear in the alerts.  
If your network management system correctly renders the INET_IPV4 address type, choose **as Binary**. Otherwise, choose **as String**. For example, HP OpenView requires **as String**. |
Trap Server | The server that will receive SNMP traps notification.  
You can specify a single IP address or hostname. |
Authentication Password | The password required for authentication. SNMP v3 uses either the Message Digest 5 (MD5) hash function or the Secure Hash Algorithm (SHA) hash function to encrypt this password, depending on configuration.  
If you specify an authentication password, authentication is enabled. |
Private Password | The SNMP key for privacy. SNMP v3 uses the Data Encryption Standard (DES) block cipher to encrypt this password. When you enter an SNMP v3 password, the password displays in plain text during initial configuration but is saved in encrypted format.  
If you specify a private password, privacy is enabled, and you must also specify an authentication password. |
User Name | Your SNMP user name. |

---

### Configuring Syslog Alerting for Intrusion Events

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>
After you enable syslog alerting in an intrusion policy, the system sends all intrusion events to the syslog, either on the managed device itself or to an external host or hosts. If you specify an external host, syslog alerts are sent from the managed device.

**Procedure**

**Step 1**
In the intrusion policy editor's navigation pane, click *Advanced Settings*.

**Step 2**
Make sure *Syslog Alerting* is *Enabled*, then click *Edit*.

A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. The *Syslog Alerting* page is added under *Advanced Settings*.

**Step 3**
Enter the IP addresses of the *Logging Hosts* where you want to send syslog alerts.

If you leave this field blank, the managed device logs intrusion events using its own syslog facility.

The system builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results. Using override-enabled objects allows descendant domain administrators to tailor Global configurations to their local environments.

**Step 4**
Choose *Facility* and *Priority* levels as described in *Facilities and Priorities for Intrusion Syslog Alerts*, on page 1464.

**Step 5**
To save changes you made in this policy since the last policy commit, choose *Policy Information*, then click *Commit Changes*.

If you leave the policy without committing changes, changes since the last commit are discarded if you edit a different policy.

**What to do next**
- Deploy configuration changes; see *Deploy Configuration Changes*, on page 277.

### Facilities and Priorities for Intrusion Syslog Alerts

Managed devices can send intrusion events as syslog alerts using a particular facility and *Priority*, so that the logging host can categorize the alerts. The *facility* specifies the subsystem that generated it. The *priority* specifies its severity. These facility and *Priority* values do not appear in the actual syslog messages.

Choose values that make sense based on your environment. Local configuration files (such as syslog.conf on UNIX-based logging hosts) may indicate which facilities are saved to which log files.

#### Syslog Alert Facilities

<table>
<thead>
<tr>
<th>Facility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTH</td>
<td>A message associated with security and authorization.</td>
</tr>
<tr>
<td>AUTHPRIV</td>
<td>A restricted access message associated with security and authorization. On many systems, these messages are forwarded to a secure file.</td>
</tr>
<tr>
<td>CRON</td>
<td>A message generated by the clock daemon.</td>
</tr>
</tbody>
</table>
### Facility

<table>
<thead>
<tr>
<th>Facility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAEMON</td>
<td>A message generated by a system daemon.</td>
</tr>
<tr>
<td>FTP</td>
<td>A message generated by the FTP daemon.</td>
</tr>
<tr>
<td>KERN</td>
<td>A message generated by the kernel. On many systems, these messages are printed to the console when they appear.</td>
</tr>
<tr>
<td>LOCAL0-LOCAL7</td>
<td>A message generated by an internal process.</td>
</tr>
<tr>
<td>LPR</td>
<td>A message generated by the printing subsystem.</td>
</tr>
<tr>
<td>MAIL</td>
<td>A message generated by a mail system.</td>
</tr>
<tr>
<td>NEWS</td>
<td>A message generated by the network news subsystem.</td>
</tr>
<tr>
<td>SYSLOG</td>
<td>A message generated by the syslog daemon.</td>
</tr>
<tr>
<td>USER</td>
<td>A message generated by a user-level process.</td>
</tr>
<tr>
<td>UUCP</td>
<td>A message generated by the UUCP subsystem.</td>
</tr>
</tbody>
</table>

### Syslog Alert Priorities

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMERG</td>
<td>A panic condition broadcast to all users</td>
</tr>
<tr>
<td>ALERT</td>
<td>A condition that should be corrected immediately</td>
</tr>
<tr>
<td>CRIT</td>
<td>A critical condition</td>
</tr>
<tr>
<td>ERR</td>
<td>An error condition</td>
</tr>
<tr>
<td>WARNING</td>
<td>Warning messages</td>
</tr>
<tr>
<td>NOTICE</td>
<td>Conditions that are not error conditions, but require attention</td>
</tr>
<tr>
<td>INFO</td>
<td>Informational messages</td>
</tr>
<tr>
<td>DEBUG</td>
<td>Messages that contain debug information</td>
</tr>
</tbody>
</table>

### Configuring Email Alerting for Intrusion Events

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>
If you enable intrusion email alerting, the system can send email when it generates an intrusion event, regardless of which managed device or intrusion policy detected the intrusion. These alerts are sent from the Firepower Management Center.

**Before you begin**

- Configure your mail host to receive email alerts; see Configuring a Mail Relay Host and Notification Address, on page 472.
- Ensure that the Firepower Management Center can reverse resolve is own IP address.

**Procedure**

1. Choose **Policies** > **Actions** > **Alerts**.
2. Click the **Intrusion Email** tab.
3. Choose alerting options, including the intrusion rules or rule groups for which you want to alert, as described in Intrusion Email Alert Options, on page 1466.
4. Click **Save**.

---

**Intrusion Email Alert Options**

**On/Off**

Enables or disables intrusion email alerts.

---

**Note**

Enabling it will enable alerting for all rules unless individual rules are selected.

---

**From/To Addresses**

The email sender and recipients. You can specify a comma-separated list of recipients.

---

**Max Alerts and Frequency**

The maximum number of email alerts (**Max Alerts**) that the Firepower Management Center will send per time interval (**Frequency**).

---

**Coalesce Alerts**

Reduces the number of alerts sent by grouping alerts that have the same source IP and rule ID.

---

**Summary Output**

Enables brief alerts, suitable for text-limited devices. Brief alerts contain:

- Timestamp
- Protocol
• Source and destination IPs and ports
• Message
• The number of intrusion events generated against the same source IP

For example: 2011-05-18 10:35:10 10.1.1.100 icmp 10.10.10.1:8 -> 10.2.1.3:0 snort_decoder: Unknown Datagram decoding problem! (116:108)

If you enable **Summary Output**, also consider enabling **Coalesce Alerts**. You may also want to lower **Max Alerts** to avoid exceeding text-message limits.

**Time Zone**

The time zone for alert timestamps.

**Email Alerting on Specific Rules Configuration**

Allows you to choose the rules where you want to set email alerts.
Intrusion Email Alert Options
PART XVIII

Event and Asset Analysis Tools

• Using the Context Explorer, on page 1471
• Using the Network Map, on page 1493
• Incidents, on page 1503
Using the Context Explorer

The following topics describe how to use the Context Explorer in the Firepower System:

- About the Context Explorer, on page 1471
- Refreshing the Context Explorer, on page 1484
- Setting the Context Explorer Time Range, on page 1485
- Minimizing and Maximizing Context Explorer Sections, on page 1485
- Drilling Down on Context Explorer Data, on page 1486
- Filters in the Context Explorer, on page 1487

About the Context Explorer

The Firepower System Context Explorer displays detailed, interactive graphical information in context about the status of your monitored network, including data on applications, application statistics, connections, geolocation, indications of compromise, intrusion events, hosts, servers, Security Intelligence, users, files (including malware files), and relevant URLs. Distinct sections present this data in the form of vivid line, bar, pie, and donut graphs, accompanied by detailed lists. The first section, a line chart of traffic and event counts over time, provides an at-a-glance picture of recent trends in your network’s activity.

You can easily create and apply custom filters to fine-tune your analysis, and you can examine data sections in more detail by simply clicking or hovering your cursor over graph areas. You can also configure the explorer’s time range to reflect a period as short as the last hour or as long as the last year. Only users with the Administrator, Security Analyst, or Security Analyst (Read Only) user roles have access to the Context Explorer.

The Firepower System dashboard is highly customizable and compartmentalized and updates in real time. In contrast, the Context Explorer is manually updated, designed to provide broader context for its data, and has a single, consistent layout designed for active user exploration.

You use the dashboard to monitor real-time activity on your network and appliances according to your own specific needs. Conversely, you use the Context Explorer to investigate a predefined set of recent data in granular detail and clear context: for example, if you notice that only 15% of hosts on your network use Linux, but account for almost all YouTube traffic, you can quickly apply filters to view data only for Linux hosts, only for YouTube-associated application data, or both. Unlike the compact, narrowly focused dashboard widgets, the Context Explorer sections are designed to provide striking visual representations of system activity in a format useful to both expert and casual users of the Firepower System.
The data displayed depends on such factors as how you license and deploy your managed devices, and whether you configure features that provide the data. You can also apply filters to constrain the data that appears in all Context Explorer sections.

In a multidomain deployment, the Context Explorer displays aggregated data from all subdomains when you view it in an ancestor domain. In a leaf domain, you can view data specific to that domain only.

### Differences Between the Dashboard and the Context Explorer

The following table summarizes some of the key differences between the dashboard and the Context Explorer.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Dashboard</th>
<th>Context Explorer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displayable data</td>
<td>Anything monitored by the Firepower System</td>
<td>Applications, application statistics, geolocation, indications of compromise, intrusion events, files (including malware files), hosts, Security Intelligence events, servers, users, and URLs</td>
</tr>
<tr>
<td>Customizability</td>
<td>• Selection of widgets for a dashboard is customizable</td>
<td>• Cannot change base layout</td>
</tr>
<tr>
<td></td>
<td>• Individual widgets can be customized to varying degrees</td>
<td>• Applied filters appear in explorer URL and can be bookmarked for later use</td>
</tr>
<tr>
<td>Data update frequency</td>
<td>Automatic (default); user-configured</td>
<td>Manual</td>
</tr>
<tr>
<td>Data filtering</td>
<td>Possible for some widgets (must edit widget preferences)</td>
<td>Possible for all parts of the explorer, with support for multiple filters</td>
</tr>
<tr>
<td>Graphical context</td>
<td>Some widgets (particularly Custom Analysis) can display data in graph form</td>
<td>Extensive graphical context for all data, including uniquely detailed donut graphs</td>
</tr>
<tr>
<td>Links to relevant web interface pages</td>
<td>In some widgets</td>
<td>In every section</td>
</tr>
<tr>
<td>Time range of displayed data</td>
<td>User-configured</td>
<td>User-configured</td>
</tr>
</tbody>
</table>

**Related Topics**

[About Dashboards](#), on page 197

### The Traffic and Intrusion Event Counts Time Graph

At the top of the Context Explorer is a line chart of traffic and intrusion events over time. The X-axis plots time intervals (which range from five minutes to one month, depending on the selected time window). The Y-axis plots traffic in kilobytes (blue line) and intrusion event count (red line).

Note that the smallest X-axis interval is five minutes. To accommodate this, the system will round the beginning and ending points in your selected time range down to the nearest five-minute interval.

By default, this section shows all network traffic and all generated intrusion events for the selected time range. If you apply filters, the chart changes to display only traffic and intrusion events associated with the criteria
specified in the filters. For example, filtering on the **OS Name** of *Windows* causes the time graph to display only traffic and events associated with hosts using Windows operating systems.

If you filter the Context Explorer on intrusion event data (such as a **Priority** of *High*), the blue Traffic line is hidden to allow greater focus on intrusion events alone.

You can hover your pointer over any point on the graph lines to view exact information about traffic and event counts. Hovering your pointer over one of the colored lines also brings that line to the forefront of the graph, providing clearer context.

This section draws data primarily from the Intrusion Events and Connection Events tables.

---

**The Indications of Compromise Section**

The Indications of Compromise (IOC) section of the Context Explorer contains two interactive sections that provide an overall picture of potentially compromised hosts on your monitored network: a proportional view of the most prevalent IOC types triggered, as well as a view of hosts by number of triggered indications.

For more information about IOCs, see *Indications of Compromise Data*, on page 1750.

---

**The Hosts by Indication Graph**

The Hosts by Indication graph, in donut form, displays a proportional view of the Indications of Compromise (IOC) triggered by hosts on your monitored network. The inner ring divides by IOC category (such as **CnC Connected** or **Malware Detected**), while the outer ring further divides that data by specific event type (such as **Impact 2 Intrusion Event — attempted-admin** or **Threat Detected in File Transfer**).

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

This graph draws data primarily from the Hosts and Indications of Compromise tables.

---

**The Indications by Host Graph**

The Indications by Host graph, in bar form, displays counts of unique Indications of Compromise (IOC) triggered by the 15 most IOC-active hosts on your monitored network.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

This graph draws data primarily from the Hosts and Indications of Compromise tables.

---

**The Network Information Section**

The Network Information section of the Context Explorer contains six interactive graphs that display an overall picture of connection traffic on your monitored network: sources, destinations, users, and security zones associated with traffic, a breakdown of operating systems used by hosts on the network, as well as a proportional view of access control actions your Firepower System has performed on network traffic.

---

**The Operating Systems Graph**

The Operating Systems graph, in donut form, displays a proportional representation of operating systems detected on hosts on your monitored network. The inner ring divides by OS name (such as **Windows** or **Linux**), while the outer ring further divides that data by specific operating system version (such as **Windows Server 2008** or **Linux 11.x**). Some closely related operating systems (such as Windows 2000, Windows XP, and
Windows Server 2003) are grouped together. Very scarce or unrecognized operating systems are grouped under Other.

Note that this graph reflects all available data regardless of date and time constraints. If you change the explorer time range, the graph does not change.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

This graph draws data primarily from the Hosts table.

The Traffic by Source IP Graph

The Traffic by Source IP graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the top 15 most active source IP addresses on your monitored network. For each source IP address listed, blue bars represent traffic data and red bars represent connection data.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Note

If you filter on intrusion event information, the Traffic by Source IP graph is hidden.

This graph draws data primarily from the Connection Events table.

The Traffic by Source User Graph

The Traffic by Source User graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the top 15 most active source users on your monitored network. For each source IP address listed, blue bars represent traffic data and red bars represent connection data.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Note

If you filter on intrusion event information, the Traffic by Source User graph is hidden.

This graph draws data primarily from the Connection Events table. It displays authoritative user data.

The Connections by Access Control Action Graph

The Connections by Access Control Action graph, in pie form, displays a proportional view of access control actions (such as Block or Allow) that your Firepower System deployment has taken on monitored traffic.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Note

If you filter on intrusion event information, the Traffic by Source User graph is hidden.

This graph draws data primarily from the Connection Events table.
The Traffic by Destination IP Graph

The Traffic by Destination IP graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the top 15 most active destination IP addresses on your monitored network. For each destination IP address listed, blue bars represent traffic data and red bars represent connection data.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

---

**Note**

If you filter on intrusion event information, the Traffic by Destination IP graph is hidden.

This graph draws data primarily from the Connection Events table.

The Traffic by Ingress/Egress Security Zone Graph

The Traffic by Ingress/Egress Security Zone graph, in bar form, displays counts of incoming or outgoing network traffic (in kilobytes per second) and unique connections for each security zone configured on your monitored network. You can configure this graph to display either ingress (the default) or egress security zone information, according to your needs.

For each security zone listed, blue bars represent traffic data and red bars represent connection data.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

---

**Tip**

To constrain the graph so it displays only traffic by egress security zone, hover your pointer over the graph, then click **Egress** on the toggle button that appears. Click **Ingress** to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Ingress view.

---

**Note**

If you filter on intrusion event information, the Traffic by Ingress/Egress Security Zone graph is hidden.

This graph draws data primarily from the Connection Events table.

The Application Information Section

The Application Information section of the Context Explorer contains three interactive graphs and one table-format list that display an overall picture of application activity on your monitored network: traffic, intrusion events, and hosts associated with applications, further organized by the estimated risk or business relevance assigned to each application. The Application Details list provides an interactive list of each application and its risk, business relevance, category, and host count.

For all instances of “application” in this section, the Application Information graph set, by default, specifically examines application protocols (such as DNS or SSH). You can also configure the Application Information section to specifically examine client applications (such as PuTTY or Firefox) or web applications (such as Facebook or Pandora).
Focusing the Application Information Section

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

Procedure

**Step 1** Choose Analysis > Context Explorer.

**Step 2** Hover your pointer over the Application Protocol Information section.

**Note** If you previously changed this setting in the same Context Explorer session, the section title may appear as Client Application Information or Web Application Information instead.

**Step 3** Click Application Protocol, Client Application, or Web Application.

The Traffic by Risk/Business Relevance and Application Graph

The Traffic by Risk/Business Relevance and Application graph, in donut form, displays a proportional representation of application traffic detected on your monitored network, arranged by the applications’ estimated risk (the default) or estimated business relevance. The inner ring divides by estimated risk/business relevance level (such as Medium or High), while the outer ring further divides that data by specific application (such as SSH or NetBIOS). Scarcely detected applications are grouped under Other.

Note that this graph reflects all available data regardless of date and time constraints. If you change the explorer time range, the graph does not change.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

**Tip** To constrain the graph so it displays traffic by business relevance and application, hover your pointer over the graph, then click Business Relevance on the toggle button that appears. Click Risk to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Risk view.

**Note** If you filter on intrusion event information, the Traffic by Risk/Business and Application graph is hidden.

This graph draws data primarily from the Connection Events and Application Statistics tables.

The Intrusion Events by Risk/Business Relevance and Application Graph

The Intrusion Events by Risk/Business Relevance and Application graph, in donut form, displays a proportional representation of intrusion events detected on your monitored network and the applications associated with
those events, arranged by the applications’ estimated risk (the default) or estimated business relevance. The inner ring divides by estimated risk/business relevance level (such as Medium or High), while the outer ring further divides that data by specific application (such as SSH or NetBIOS). Scarcely detected applications are grouped under Other.

Hover your pointer over any part of the donut graph to view more detailed information. Click any part of the graph to filter or drill down on that information, or (where applicable) to view application information.

Tip
To constrain the graph so it displays intrusion events by business relevance and application, hover your pointer over the graph, then click Business Relevance on the toggle button that appears. Click Risk to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Risk view.

This graph draws data primarily from the Intrusion Events and Application Statistics tables.

The Hosts by Risk/Business Relevance and Application Graph
The Hosts by Risk/Business Relevance and Application graph, in donut form, displays a proportional representation of hosts detected on your monitored network and the applications associated with those hosts, arranged by the applications’ estimated risk (the default) or estimated business relevance. The inner ring divides by estimated risk/business relevance level (such as Medium or High), while the outer ring further divides that data by specific application (such as SSH or NetBIOS). Very scarce applications are grouped under Other.

Hover your pointer over any part of the donut graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Tip
To constrain the graph so it displays hosts by business relevance and application, hover your pointer over the graph, then click Business Relevance on the toggle button that appears. Click Risk to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Risk view.

This graph draws data primarily from the Applications table.

The Application Details List
At the bottom of the Application Information section is the Application Details List, a table that provides estimated risk, estimated business relevance, category, and hosts count information for each application detected on your monitored network. The applications are listed in descending order of associated host count.

The Application Details List table is not sortable, but you can click on any table entry to filter or drill down on that information, or (where applicable) to view application information. This table draws data primarily from the Applications table.

Note that this list reflects all available data regardless of date and time constraints. If you change the explorer time range, the list does not change.

The Security Intelligence Section
The Security Intelligence section of the Context Explorer contains three interactive bar graphs that display an overall picture of traffic on your monitored network that is blacklisted or monitored by Security Intelligence.
The graphs sort such traffic by category, source IP address, and destination IP address, respectively; both the amount of traffic (in kilobytes per second) and the number of applicable connections appear.

**The Security Intelligence Traffic by Category Graph**

The Security Intelligence Traffic by Category graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the top Security Intelligence categories of traffic on your monitored network. For each category listed, blue bars represent traffic data and red bars represent connection data.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.

**Note**

If you filter on intrusion event information, the Security Intelligence Traffic by Category graph is hidden.

This graph draws data primarily from the Security Intelligence Events table.

**The Security Intelligence Traffic by Source IP Graph**

The Security Intelligence Traffic by Source IP graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the top source IP addresses of Security Intelligence-monitored traffic on your monitored network. For each category listed, blue bars represent traffic data and red bars represent connection data.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.

**Note**

If you filter on intrusion event information, the Security Intelligence Traffic by Source IP graph is hidden.

This graph draws data primarily from the Security Intelligence Events table.

**The Security Intelligence Traffic by Destination IP Graph**

The Security Intelligence Traffic by Destination IP graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the top destination IP addresses of Security Intelligence-monitored traffic on your monitored network. For each category listed, blue bars represent traffic data and red bars represent connection data.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.

**Note**

If you filter on intrusion event information, the Security Intelligence Traffic by Destination IP graph is hidden.

This graph draws data primarily from the Security Intelligence Events table.
The Intrusion Information Section

The Intrusion Information section of the Context Explorer contains six interactive graphs and one table-format list that display an overall picture of intrusion events on your monitored network: impact levels, attack sources, target destinations, users, priority levels, and security zones associated with intrusion events, as well as a detailed list of intrusion event classifications, priorities, and counts.

The Intrusion Events by Impact Graph

The Intrusion Events by Impact graph, in pie form, displays a proportional view of intrusion events on your monitored network, grouped by estimated impact level (from 0 to 4).

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

This graph draws data primarily from the intrusion detection (IDS Statistics) and Intrusion Events tables.

The Top Attackers Graph

The Top Attackers graph, in bar form, displays counts of intrusion events for the top attacking host IP addresses (causing those events) on your monitored network.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

This graph draws data primarily from the Intrusion Events table.

The Top Users Graph

The Top Users graph, in bar form, displays users on your monitored network that are associated with the highest intrusion event counts, by event count.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

This graph draws data primarily from the intrusion detection (IDS) User Statistics and Intrusion Events tables. It displays authoritative user data.

The Intrusion Events by Priority Graph

The Intrusion Events by Priority graph, in pie form, displays a proportional view of intrusion events on your monitored network, grouped by estimated priority level (such as High, Medium, or Low).

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

This graph draws data primarily from the Intrusion Events table.

The Top Targets Graph

The Top Targets graph, in bar form, displays counts of intrusion events for the top target host IP addresses (targeted in the connections causing those events) on your monitored network.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

This graph draws data primarily from the Intrusion Events table.
The Top Ingress/Egress Security Zones Graph

The Top Ingress/Egress Security Zones graph, in bar form, displays counts of intrusion events associated with each security zone (ingress or egress, depending on graph settings) configured on your monitored network.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Tip
To constrain the graph so it displays only traffic by egress security zone, hover your pointer over the graph, then click Egress on the toggle button that appears. Click Ingress to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Ingress view.

This graph draws data primarily from the Intrusion Events table.

You can configure this graph to display either ingress (the default) or egress security zone information, according to your needs.

The Intrusion Event Details List

At the bottom of the Intrusion Information section is the Intrusion Event Details List, a table that provides classification, estimated priority, and event count information for each intrusion event detected on your monitored network. The events are listed in descending order of event count.

The Intrusion Event Details List table is not sortable, but you can click on any table entry to filter or drill down on that information. This table draws data primarily from the Intrusion Events table.

The Files Information Section

The Files Information section of the Context Explorer contains six interactive graphs that display an overall picture of file and malware events on your monitored network.

Five of the graphs display data related to AMP for Networks (formerly called AMP for Firepower): the file types, file names, and malware dispositions of the files detected in network traffic, as well as the hosts sending (uploading) and receiving (downloading) those files. The final graph displays all malware threats detected in your organization, whether by AMP for Networks or AMP for Endpoints.

Note
If you filter on intrusion information, the entire Files Information Section is hidden.

The Top File Types Graph

The Top File Types graph, in donut form, displays a proportional view of the file types detected in network traffic (outer ring), grouped by file category (inner ring).

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Note that you must have a Malware license to for this graph to display AMP for Networks data.

This graph draws data primarily from the File Events table.
The Top File Names Graph

The Top File Names graph, in bar form, displays counts of the top unique file names detected in network traffic.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Note that you must have a Malware license to for this graph to display AMP for Networks data.

This graph draws data primarily from the File Events table.

The Files by Disposition Graph

The Top File Types graph, in pie form, displays a proportional view of the malware dispositions for files detected by the AMP for Networks feature (formerly called AMP for Firepower). Note that only files for which the Firepower Management Center performed a malware cloud lookup have dispositions. Files that did not trigger a cloud lookup have a disposition of **N/A**. The disposition **Unavailable** indicates that the Firepower Management Center could not perform a malware cloud lookup.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Note that you must have a Malware license to for this graph to display AMP for Networks data.

This graph draws data primarily from the File Events table.

The Top Hosts Sending Files Graph

The Top Hosts Sending Files graph, in bar form, displays counts of the number of files detected in network traffic for the top file-sending host IP addresses.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Tip

To constrain the graph so it displays only hosts sending malware, hover your pointer over the graph, then click **Malware** on the toggle button that appears. Click **Files** to return to the default files view. Note that navigating away from the Context Explorer also returns the graph to the default files view.

Note that you must have a Malware license to for this graph to display AMP for Networks data.

This graph draws data primarily from the File Events table.

The Top Hosts Receiving Files Graph

The Top Hosts Receiving Files graph, in bar form, displays counts of the number of files detected in network traffic for the top file-receiving host IP addresses.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
The Top Malware Detections Graph

The Top Malware Detections graph, in bar form, displays counts of the top malware threats detected in your organization, whether by AMP for Networks or AMP for Endpoints.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Note that you must have a Malware license to for this graph to display AMP for Networks data.

This graph draws data primarily from the File Events and Malware Events tables.

The Geolocation Information Section

The Geolocation Information section of the Context Explorer contains three interactive donut graphs that display an overall picture of countries with which hosts on your monitored network are exchanging data: unique connections by initiator or responder country, intrusion events by source or destination country, and file events by sending or receiving country.

The Connections by Initiator/Responder Country Graph

The Connections by Initiator/Responder Country graph, in donut form, displays a proportional view of the countries involved in connections on your network as either the initiator (the default) or the responder. The inner ring groups these countries together by continent.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Tip

To constrain the graph so it displays only countries acting as the responder in connections, hover your pointer over the graph, then click Responder on the toggle button that appears. Click Initiator to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Initiator view.

This graph draws data primarily from the Connection Summary Data table.

The Intrusion Events by Source/Destination Country Graph

The Intrusion Events by Source/Destination Country graph, in donut form, displays a proportional view of the countries involved in intrusion events on your network as either the source of the event (the default) or the destination. The inner ring groups these countries together by continent.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
To constrain the graph so it displays only countries acting as the destinations of intrusion events, hover your pointer over the graph, then click **Destination** on the toggle button that appears. Click **Source** to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Source view.

This graph draws data primarily from the Intrusion Events table.

### The File Events by Sending/Receiving Country Graph

The File Events by Sending/Receiving Country graph, in donut form, displays a proportional view of the countries detected in file events on your network as either sending (the default) or receiving files. The inner ring groups these countries together by continent.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.

Tip

To constrain the graph so it displays only countries receiving files, hover your pointer over the graph, then click **Receiver** on the toggle button that appears. Click **Sender** to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Sender view.

This graph draws data primarily from the File Events table.

### The URL Information Section

The URL Information section of the Context Explorer contains three interactive bar graphs that display an overall picture of URLs with which hosts on your monitored network are exchanging data: traffic and unique connections associated with URLs, sorted by individual URL, URL category, and URL reputation. You cannot filter on URL information.

#### Note

If you filter on intrusion event information, the entire URL Information Section is hidden.

Note that you must have a URL Filtering license for this graph to include URL category and reputation data.

### The Traffic by URL Graph

The Traffic by URL graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the top 15 most requested URLs on your monitored network. For each URL listed, blue bars represent traffic data and red bars represent connection data.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.

#### Note

If you filter on intrusion event information, the Traffic by URL graph is hidden.

Note that you must have a URL Filtering license for this graph to include URL category and reputation data.
This graph draws data primarily from the Connection Events table.

**The Traffic by URL Category Graph**

The Traffic by URL Category graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the most requested URL categories (such as Search Engines or Streaming Media) on your monitored network. For each URL category listed, blue bars represent traffic data and red bars represent connection data.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.

---

**Note**

If you filter on intrusion event information, the Traffic by URL Category graph is hidden.

Note that you must have a URL Filtering license for this graph to include URL category and reputation data.

This graph draws data primarily from the URL Statistics and Connection Events tables.

**The Traffic by URL Reputation Graph**

The Traffic by URL Reputation graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the most requested URL reputation groups (such as Well known or Benign sites with security risks) on your monitored network. For each URL reputation listed, blue bars represent traffic data and red bars represent connection data.

Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.

---

**Note**

If you filter on intrusion event information, the Traffic by URL Reputation graph is hidden.

Note that you must have a URL Filtering license for this graph to include URL category and reputation data.

This graph draws data primarily from the URL Statistics and Connection Events tables.

---

**Refreshing the Context Explorer**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

The Context Explorer does not automatically update the information it displays. To incorporate new data, you must manually refresh the explorer.

Note that, although reloading the Context Explorer itself (by refreshing the browser program or navigating away from, then back to, the Context Explorer) refreshes all displayed information, this does not preserve any changes you made to section configuration (such as the Ingress/Egress graphs and the Application Information section) and may cause delays in loading.
In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose **Analysis > Context Explorer**.

**Step 2** Click **Reload** at the upper right.

The **Reload** button is dimmed until your refresh is finished.

---

**Setting the Context Explorer Time Range**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can configure the Context Explorer time range to reflect a period as short as the last hour (the default) or as long as the last year. Note that when you change the time range, the Context Explorer does not automatically update to reflect the change. To apply the new time range, you must manually refresh the explorer.

Changes to the time range persist even if you navigate away from the Context Explorer or end your login session.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose **Analysis > Context Explorer**.

**Step 2** From the **Show the last** drop-down list, choose a time range.

**Step 3** Optionally, to view data from the new time range, click **Reload**.

**Tip** Clicking **Apply Filters** also applies any time range updates.

---

**Minimizing and Maximizing Context Explorer Sections**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

---
You can minimize and hide one or more sections of the Context Explorer. This is useful if you want to focus on only certain sections, or if you want a simpler view. You cannot minimize the Traffic and Intrusion Event Counts Time Graph.

Context Explorer sections retain the minimized or maximized states that you configure even if you refresh the page or log out of the appliance.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose **Analysis > Context Explorer**.

**Step 2** To minimize a section, click the minimize icon (−) in a section’s title bar.

**Step 3** To maximize a section, click the maximize icon (square) in a minimized section’s title bar.

---

### Drilling Down on Context Explorer Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

If you want to examine graph or list data in more detail than the Context Explorer allows, you can drill down to the table views of the relevant data. (Note that you cannot drill down on the Traffic and Intrusion Events over Time graph.) For example, drilling down on an IP address in the Traffic by Source IP graph displays the Connections with Application Details view of the Connection Events table, including only data associated with the source IP address you selected.

Depending on the type of data you examine, additional options can appear in the context menu. Data points that are associated with specific IP addresses offer the option to view host or whois information on the IP address you select. Data points associated with specific applications offer the option to view application information on the application you select. Data points associated with a specific user offer the option to view that user’s user profile page. Data points associated with an intrusion event message offer the option to view the rule documentation for that event’s associated intrusion rule, and data points associated with a specific IP address offer the option to blacklist or whitelist that address.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose **Analysis > Context Explorer**.

**Step 2** In any section but **Traffic and Intrusion Events over Time**, click a data point that you want to investigate.

**Step 3** Depending on the data point you selected, you have several options:
Filters in the Context Explorer

Beyond the basic, wide-ranging data that the Context Explorer initially displays, you have the option to filter that data for a more granular contextual picture of activity on your network. Filters encompass all types of Firepower System data except URL information, support exclusion as well as inclusion, can be applied quickly by clicking on Context Explorer graph data points, and affect the entire explorer. You can apply up to 20 filters at a time.

You can add filters to Context Explorer data in several ways:

- from the Add Filter dialog
- from the context menu, when you select a data point in the explorer
- from the text links that appear in certain detail view pages (Application Detail, Host Profile, Rule Detail, and User Profile). Clicking these links automatically opens and filters the Context Explorer according to the relevant data on the detail view page. For example, clicking the Context Explorer link on a user detail page for the user jenkins constrains the explorer to show only data associated with that user.

Some filter types are incompatible with others: for example, filters that relate to intrusion events (such as Device and Inline Result) cannot be applied at the same time as connection event-related filters (such as Access Control Action) because the system cannot sort connection event data by intrusion event data. The system automatically prevents incompatible filters from simultaneously applying; when one filter type is more recently activated, filters of the incompatible type are hidden as long as the incompatibility exists.

When multiple filters are active, values for the same data type are treated as OR search criteria: all data that matches at least one of the values appears. Values for different data types are treated as AND search criteria: to appear, data must match at least one value for each filtered data type. For example, data that appears for the filter set of Application: 2channel, Application: Reddit, and User: edickinson must be associated with the user edickinson AND either the application 2channel OR the application Reddit.

In a multidomain deployment, you can filter by multiple descendant domains when viewing the Context Explorer in an ancestor domain. In such cases, use caution when also adding IP Address filters. The system builds a separate network map for each leaf domain. Using literal IP addresses to constrain this configuration can have unexpected results.
Note that the data displayed depends on such factors as how you license and deploy your managed devices and whether you configure features that provide the data.

**Note** Filters function as a simple, agile tool to get the precise Firepower data context you need at any given time. They are not intended as permanent configuration settings, and disappear when you navigate away from the Context Explorer or end your session. To preserve filter settings for later use, see Saving Filtered Context Explorer Views, on page 1491.

## Data Type Field Options

The following table lists the data types available as filters, with examples and brief definitions of each.

<table>
<thead>
<tr>
<th>Type</th>
<th>Example Values</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control Action</td>
<td>Allow, Block</td>
<td>Action taken by your access control policy to allow or block traffic.</td>
</tr>
<tr>
<td>Application Category</td>
<td>web browser, email</td>
<td>General classification of an application’s most essential function.</td>
</tr>
<tr>
<td>Application Name</td>
<td>Facebook, HTTP</td>
<td>Name of an application.</td>
</tr>
<tr>
<td>Application Risk</td>
<td>Very High, Medium</td>
<td>Estimated security risk of an application.</td>
</tr>
<tr>
<td>Application Tag</td>
<td>encrypts communications, sends mail</td>
<td>Additional information about an application; applications can have any number of tags, including none.</td>
</tr>
<tr>
<td>Application Type</td>
<td>Client, Web Application</td>
<td>Type of an application: application protocol, client, or web application.</td>
</tr>
<tr>
<td>Business Relevance</td>
<td>Very Low, High</td>
<td>Estimated relevance of an application to business activity (as opposed to recreation).</td>
</tr>
<tr>
<td>Continent</td>
<td>North America, Asia</td>
<td>Continent associated with a routable IP address detected on your monitored network.</td>
</tr>
<tr>
<td>Country</td>
<td>Canada, Japan</td>
<td>Country associated with a routable IP address detected on your monitored network.</td>
</tr>
<tr>
<td>Device</td>
<td>device1.example.com, 192.168.1.3</td>
<td>Name or IP address of a device on your monitored network.</td>
</tr>
<tr>
<td>Domain</td>
<td>Asia Division, Europe Division</td>
<td>The domain of the device whose network activity you want to graph. This data type is only present in a multidomain deployment.</td>
</tr>
<tr>
<td>Type</td>
<td>Example Values</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Event Classification</td>
<td>Potential Corporate Policy Violation,</td>
<td>Capsule description of an intrusion event, determined by the classification of the rule, decoder, or preprocessor that triggered it.</td>
</tr>
<tr>
<td></td>
<td>Attempted Denial of Service</td>
<td></td>
</tr>
<tr>
<td>Event Message</td>
<td>dns response, P2P</td>
<td>Message generated by an event, determined by the rule, decoder, or preprocessor that triggered it.</td>
</tr>
<tr>
<td>File Disposition</td>
<td>Malware, Clean</td>
<td>Disposition of a file for which the Firepower Management Center performed a malware cloud lookup.</td>
</tr>
<tr>
<td>File Name</td>
<td>Packages.bz2</td>
<td>Name of a file detected in network traffic.</td>
</tr>
<tr>
<td>File SHA256</td>
<td>any 32-bit string</td>
<td>SHA-256 hash value of a file for which the Firepower Management Center performed a malware cloud lookup.</td>
</tr>
<tr>
<td>File Type</td>
<td>GZ, SWF, MOV</td>
<td>File type detected in network traffic.</td>
</tr>
<tr>
<td>File Type Category</td>
<td>Archive, Multimedia, Executables</td>
<td>General category of file type detected in network traffic.</td>
</tr>
<tr>
<td>IP Address</td>
<td>192.168.1.3, 2001:0db8:85a3::0000/24</td>
<td>IPv4 or IPv6 addresses, address ranges, or address blocks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note that searching for an IP address returns events where that address was either the source or the destination for the event.</td>
</tr>
<tr>
<td>Impact Level</td>
<td>Impact Level 1, Impact Level 2</td>
<td>Estimated impact of an event on your monitored network.</td>
</tr>
<tr>
<td>Inline Result</td>
<td>dropped, would have dropped</td>
<td>Whether traffic was dropped, would have been dropped, or was not acted upon by the system.</td>
</tr>
<tr>
<td>IOC Category</td>
<td>High Impact Attack, Malware Detected</td>
<td>Category for a triggered Indication of Compromise (IOC) event.</td>
</tr>
<tr>
<td>IOC Event Type</td>
<td>exploit-kit, malware-backdoor</td>
<td>Identifier associated with a specific Indication of Compromise (IOC), referring to the event that triggers it.</td>
</tr>
<tr>
<td>Malware Threat Name</td>
<td>W32.Trojan.a6b1</td>
<td>The name of a malware threat.</td>
</tr>
<tr>
<td>OS Name</td>
<td>Windows, Linux</td>
<td>Name of an operating system.</td>
</tr>
<tr>
<td>OS Version</td>
<td>XP, 2.6</td>
<td>Specific version of an operating system.</td>
</tr>
<tr>
<td>Priority</td>
<td>high, low</td>
<td>Estimated urgency of an event.</td>
</tr>
<tr>
<td>Type</td>
<td>Example Values</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Security Intelligence Category</td>
<td>Malware, Spam</td>
<td>Category of risky traffic, as determined by Security Intelligence.</td>
</tr>
<tr>
<td>Security Zone</td>
<td>My Security Zone, Security Zone X</td>
<td>A set of interfaces through which traffic is analyzed and, in an inline deployment, passes.</td>
</tr>
<tr>
<td>SSL</td>
<td>yes, no</td>
<td>SSL- or TLS-encrypted traffic.</td>
</tr>
<tr>
<td>User</td>
<td>wsmith, mtwain</td>
<td>Identity of a user logged in to a host on your monitored network.</td>
</tr>
</tbody>
</table>

### Creating a Filter from the Add Filter Window

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Use this procedure to create filters from scratch with the Add Filter window. (You can also use the context menu to create quick filters.)

The Add Filter window, which you access by clicking the plus icon (⁺) under Filters at the top left of the Context Explorer, contains only two fields:

- The **Data Type** drop-down list contains many different types of Firepower System data you can use to constrain the Context Explorer. After you select a data type, you then enter a specific value for that type in the **Filter** field (for example, a value of **Asia** for the type **Continent**). To assist you, the Filter field presents several grayed-out example values for the data type you select. (These are erased when you enter data in the field.)

- In the **Filter** field, you can input special search parameters such as *, ! essentially as you can in event searches. You can create exclusionary filters by prefixing filter parameters with the ! symbol.

**Note**

Filters that you add are not automatically applied; you must click **Apply Filters** to see the filtering in the Context Explorer.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose Analysis > Context Explorer.

**Step 2** Under Filters at the top left, click the plus icon (⁺).

**Step 3** From the **Data Type** drop-down list, choose the data type you want to filter on.
Step 4 In the Filter field, enter the data type value you want to filter on.

Step 5 Click OK.

Step 6 Optionally, repeat the previous steps to add more filters until you have the filter set you need.

Step 7 Click Apply Filters.

Related Topics
Data Type Field Options, on page 1488
Search Constraints, on page 1553

Creating a Quick Filter from the Context Menu

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

While exploring Context Explorer graph and list data, you can click on data points, then use the context menu to quickly create a filter based on that data, either inclusive or exclusive. If you use the context menu to filter on information of data type Application, User, or Intrusion Event Message, or any individual host, the filter widget includes a widget information icon that links to the relevant detail page for that data type (such as Application Detail for application data). Note that you cannot filter on URL data.

You can also use the context menu to investigate specific graph or list data in more detail.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

Procedure

Step 1 Choose Analysis > Context Explorer.

Step 2 In any explorer section except Traffic and Intrusion Events over Time or sections that contain URL data, click a data point you want to filter on.

Step 3 You have two options:

  • To add a filter for this data, click Add Filter.
  • To add an exclusion filter for this data, click Add Exclude Filter. The filter, when applied, displays all data not associated with the excluded value. Exclude filters display an exclamation point (!) before the filter value.

Saving Filtered Context Explorer Views

To preserve filter settings in the Context Explorer after you navigate away from the Context Explorer or end your session, create a browser bookmark of the Context Explorer with your preferred filters applied. Because applied filters are incorporated in the Context Explorer page URL, loading a bookmark of that page also loads the corresponding filters.
Procedure

Create a browser bookmark of the Context Explorer with your preferred filters applied.

Viewing Filter Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

Procedure

**Step 1** Choose Analysis > Context Explorer.

**Step 2** Click the information icon (i) on any eligible filter widget.

Deleting a Filter

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Choose Analysis > Context Explorer.

**Step 2** Under Filters at the top left, click the clear icon (X) on any filter widget.

**Tip** If you want to delete all filters at once, you can click the Clear button.
Using the Network Map

The following topics describe how to use the network map:

- The Network Map, on page 1493
- Custom Network Topologies, on page 1499

The Network Map

The Firepower System monitors traffic traveling over your network, decodes the traffic data, and then compares the data to established operating systems and fingerprints. The system then uses this data to build a detailed representation of your network, called a network map. In multidomain deployments, the system creates an individual network map for each leaf domain.

The system gathers data from the managed devices identified for monitoring in the network discovery policy. The managed devices detect network assets directly from monitored traffic and indirectly from processed NetFlow records. If multiple devices detect the same network asset, the system combines the information into a composite representation of the asset.

To augment data from passive detection, you can:

- Actively scan hosts using the open-source scanner, Nmap™, and add the scan results to your network map.

- Manually add host data from a third-party application using the host input feature.

The network map displays your network topology in terms of detected hosts and network devices.

You can use the network map to:

- Obtain a quick, overall view of your network.

- Select different views to suit the analysis you want to perform. Each view of the network map has the same format: a hierarchical tree with expandable categories and sub-categories. When you click a category, it expands to show you the sub-categories beneath it.

- Organize and identify subnets via the custom topology feature. For example, if each department in your organization uses a different subnet, you can assign familiar labels to those subnets using the custom topology feature.

- View detailed information by drilling down to any monitored host’s host profile.

- Delete an asset if you are no longer interested in investigating it.
If the system detects activity associated with a host you deleted from a network map, it re-adds the host to the network map. Similarly, deleted applications are re-added to the network map if the system detects a change in the application (for example, if an Apache web server is upgraded to a new version). Vulnerabilities are reactivated on specific hosts if the system detects a change that makes the host vulnerable.

Note

If you want to permanently exclude a host or subnet from the network map, modify the network discovery policy. You may wish to exclude load balancers and NAT devices from monitoring if you find that they are generating excessive or irrelevant events.

Tip

Related Topics

Configuring the Network Discovery Policy, on page 1300

The Hosts Network Map

The network map on the Hosts tab displays a host count and a list of host IP addresses and primary MAC addresses. Each address or partial address is a link to the next level. This network map view provides a count of all unique hosts detected by the system, regardless of whether the hosts have one IP address or multiple IP addresses.

Use the hosts network map to view the hosts on your network, organized by subnet in a hierarchical tree, as well as to drill down to the host profiles for specific hosts.

The system can add hosts to the network map from exported NetFlow records, but the available information for these hosts is limited; see Differences between NetFlow and Managed Device Data, on page 1204.

By creating a custom topology for your network, you can assign meaningful labels to your subnets, such as department names, that appear in the hosts network map. You can also view the hosts network map according to the organization you specified in the custom topology.

You can delete entire networks, subnets, or individual hosts from the hosts network map. For example, if you know that a host is no longer attached to your network, you can delete it to simplify your analysis. If the system afterwards detects activity associated with the deleted host, it re-adds the host to the network map. If you want to permanently exclude a host or subnet from the network map, modify the network discovery policy.

Caution

Do not delete network devices from the network map. The system uses them to determine network topology.

On the hosts network map page, you can search only for primary MAC addresses, and the Hosts [MAC] counter includes only primary MAC addresses. For descriptions of primary and secondary MAC addresses, see Basic Host Information in the Host Profile, on page 1701.

The Network Devices Network Map

The network map on the Network Devices tab displays the network devices (bridges, routers, NAT devices, and load balancers) that connect one segment of your network to another. The map contains two sections listing devices identified by an IP address and devices identified by a MAC address.
The map also provides a count of all unique network devices detected by the system, regardless of whether the devices have one IP address or multiple IP addresses.

If you create a custom topology for your network, the labels you assign to your subnets appear in the network devices network map.

The methods the system uses to distinguish network devices include:

- the analysis of Cisco Discovery Protocol (CDP) messages, which can identify network devices and their types (Cisco devices only)
- the detection of the Spanning Tree Protocol (STP), which identifies a device as a switch or bridge
- the detection of multiple hosts using the same MAC address, which identifies the MAC address as belonging to a router
- the detection of TTL value changes from the client side, or TTL values that change more frequently than a typical boot time, which identify NAT devices and load balancers

If a network device communicates using CDP, it may have one or more IP addresses. If it communicates using STP, it may only have a MAC address.

You cannot delete network devices from the network map, because the system uses their locations to determine network topology.

The host profile for a network device has a Systems section rather than an Operating Systems section, which includes a Hardware column that reflects the hardware platform for any mobile devices detected behind the network device. If a value for a hardware platform is listed under Systems, that system represents a mobile device or devices detected behind the network device. Note that mobile devices may or may not have hardware platform information, but hardware platform information is never detected for systems that are not mobile devices.

The Mobile Devices Network Map

The network map on the Mobile Devices tab displays mobile devices attached to your network. This network map also provides a count of all unique mobile devices detected by the system, regardless of whether the devices have one IP address or multiple IP addresses.

Each address or partial address is a link to the next level. You can also delete a subnet or IP address; if the system redisCOVERs the device, it re-adds the device to the network map.

You can also drill down to view the host profiles for the mobile devices.

To identify mobile devices, the system:

- analyzes User-Agent strings in HTTP traffic from the mobile device’s mobile browser
- monitors the HTTP traffic of specific mobile applications

If you create a custom topology for your network, the labels you assign to your subnets appear in the mobile devices network map.
The Indications of Compromise Network Map

The network map on the Indications of Compromise tab displays the compromised hosts on your network, organized by IOC category. Affected hosts are listed beneath each category. Each address or partial address is a link to the next level.

From the indications of compromise network map, you can view the host profile of each host determined to have been compromised in a specific way. You can also delete (mark as resolved) any IOC category or any specific host, which removes the IOC tag from the relevant hosts. For example, you can delete an IOC category from the network map if you have determined that the issue is addressed and unlikely to recur.

Marking a host or IOC category resolved from the network map does not remove it from your network. A resolved host or IOC category reappears in the network map if your system newly detects information that triggers that IOC.

For more information about how the system determines indications of compromise, see Indications of Compromise Data, on page 1750 and subtopics.

The Application Protocols Network Map

The network map on the Application Protocols tab displays the applications running on your network, organized in a hierarchical tree by application name, vendor, version, and finally by the hosts running each application.

The applications that the system detects may change with system software and VDB updates, and if you import any add-on detectors. The release notes or advisory text for each system or VDB update contains information on any new and updated detectors. For a comprehensive up-to-date list of detectors, see the Cisco Support Site (http://www.cisco.com/cisco/web/support/index.html).

From this network map, you can view the host profile of each host that runs a specific application.

You can also delete any application category, any application running on all hosts, or any application running on a specific host. For example, you can delete an application from the network map if you know it is disabled on the host and you want to make sure the system does not use it for impact level qualification.

Deleting an application from the network map does not remove it from your network. A deleted application reappears in the network map if your system detects a change in the application (for example, if an Apache web server is upgraded to a new version) or if you restart your system’s discovery function.

Depending on what you delete, the behavior differs:

- **Application Category** — Deleting removes the application category from the network map. All applications that reside beneath the category are removed from any host profile that contains the applications.

  For example, if you delete **http**, all applications identified as **http** are removed from all host profiles and **http** no longer appears in the applications view of the network map.

- **Specific Application, Vendor, or Version** — Deleting removes the affected application from the network map and from any host profiles that contain it.

  For example, if you expand the **http** category and delete **Apache**, all applications listed as Apache with any version listed beneath Apache are removed from any host profiles that contain them. Similarly, if instead of deleting **Apache**, you delete a specific version (1.3.17, for example), only the version you selected will be deleted from affected host profiles.

- **Specific IP Address** — Deleting the IP address removes it from the application list and removes the application itself from the host profile of the IP address you selected.
For example, if you expand http, Apache, 1.3.17 (Win32), and then delete 172.16.1.50:80/tcp, the Apache 1.3.17 (Win32) application is deleted from the host profile of IP address 172.16.1.50.

The Vulnerabilities Network Map

The network map on the Vulnerabilities tab displays vulnerabilities that the system has detected on your network, organized by legacy vulnerability ID (SVID), Bugtraq ID, CVE ID, or Snort ID. By default, vulnerabilities are displayed by SVID. The vulnerabilities are arranged by identification number, with affected hosts listed beneath each vulnerability.

From this network map, you can view the details of specific vulnerabilities, as well as the host profile of any host subject to a specific vulnerability. This information can help you evaluate the threat posed by that vulnerability to specific affected hosts.

If you determine that a specific vulnerability is not applicable to the hosts on your network (for example, you have applied a patch), you can deactivate the vulnerability. Deactivated vulnerabilities still appear on the network map, but the IP addresses of their previously affected hosts appear in gray italics. The host profiles for those hosts show deactivated vulnerabilities as invalid, though you can manually mark them as valid for individual hosts.

If there is an identity conflict for an application or operating system on a host, the system lists the vulnerabilities for both potential identities. When the identity conflict is resolved, the vulnerabilities remain associated with the current identity.

By default, the network map displays the vulnerabilities of a detected application only if the packet contains the application’s vendor and version. However, you can configure the system to list the vulnerabilities for applications lacking vendor and version data by enabling the vulnerability mapping setting for the application in the Firepower Management Center configuration.

The numbers next to a vulnerability ID (or range of vulnerability IDs) represent two counts:

**Affected Hosts**

The first number is a count of non-unique hosts that are affected by a vulnerability or vulnerabilities. If a host is affected by more than one vulnerability, it is counted multiple times. Therefore, it is possible for the count to be higher than the number of hosts on your network. Deactivating a vulnerability decrements this count by the number of hosts that are potentially affected by the vulnerability. If you have not deactivated any vulnerabilities for any of the potentially affected hosts for a vulnerability or range of vulnerabilities, this count is not displayed.

**Potentially Affected Hosts**

The second number is a count of the total number of non-unique hosts that the system has determined are potentially affected by a vulnerability or vulnerabilities.

Deactivating a vulnerability renders it inactive only for the hosts you designate. You can deactivate a vulnerability for all hosts that have been judged vulnerable or for a specified individual vulnerable host. After a vulnerability is deactivated, the applicable hosts’ IP addresses appear in gray italics in the network map. In addition, host profiles for those hosts show deactivated vulnerabilities as invalid.

If the system subsequently detects the vulnerability on a host where it has not been deactivated (for example, on a new host in the network map), the system activates the vulnerability for that host. You have to explicitly deactivate the newly discovered vulnerability. Also, if the system detects an operating system or application change for a host, it may reactivate associated deactivated vulnerabilities.
The Host Attributes Network Map

The network map on the Host Attributes tab displays the hosts on your network organized by either user-defined or compliance white list host attributes. You cannot organize hosts using predefined host attributes in this display.

When you choose the host attribute you want to use to organize your hosts, the Firepower Management Center lists the possible values for that attribute in the network map and groups hosts based on their assigned values. For example, if you choose to organize your hosts by white list host attributes, the system displays them in categories of Compliant, Non-Compliant, and Not Evaluated.

You can also view the host profile of any host assigned a specific host attribute value.

Related Topics

Host Attributes in the Host Profile, on page 1716

Viewing Network Maps

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Procedure

Step 1
Choose Analysis > Hosts > Network Map.

Step 2
Click the tab of the network map you want to view.

Step 3
Continue as appropriate:

• Choose Domain — In multidomain environments, choose a leaf domain from the Domain drop-down list.
• Filter Hosts — If you want to filter by IP or MAC addresses, enter an address into the search field. To clear the search, click the clear icon (×).
• Drill Down — If you want to investigate a category or host profile, drill down through the categories or subnets in the map. If you have defined a custom topology, click (topology) from the Hosts tab to view it, then click on (hosts) if you want to toggle back to the default view.
• Delete — Click the delete icon (🗑️) next to the appropriate element to:
  • Remove an element from the map on the Hosts, Network Devices, Mobile Devices, or Application Protocols tab.
  • Mark an IOC category, compromised host, or group of compromised hosts resolved on the Indications of Compromise tab.
  • Deactivate a vulnerability for all hosts or a single host on the Vulnerabilities tab.

• Specify Vulnerabilities Class — On the Vulnerabilities tab, choose the class of vulnerabilities you want to view from the Type drop-down list.
Custom Network Topologies

Use the custom topology feature to help you organize and identify subnets in your hosts and network devices network maps.

For example, if each department within your organization uses a different subnet, you can label those subnets using the custom topology feature.

You can also view the hosts network map according to the organization you specified in the custom topology.

You can specify a custom topology’s networks using any or all of the following strategies:

- You can import networks from the network discovery policy to add the networks that you configured the system to monitor.
- You can add networks to your topology manually.

The Custom Topology page lists your custom topologies and their status. If the light bulb icon next to the policy name is lit, the topology is active and affects your network map. If it is dimmed, the topology is inactive.

Creating Custom Topologies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Choose Policies > Network Discovery.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

**Step 2**  Click **Custom Topology** in the toolbar.

**Step 3**  Click **Create Topology**.

**Step 4**  Enter a **Name**.

**Step 5**  Optionally, enter a **Description**.

**Step 6**  Add networks to your topology. You can use any or all of the following strategies:

- Import networks from a network discovery policy as described in **Importing Networks from the Network Discovery Policy**, on page 1500.
- Manually add networks as described in **Manually Adding Networks to Your Custom Topology**, on page 1501.

**Step 7**  Click **Save**.

---

**What to do next**

- Activate the topology as described in **Activating and Deactivating Custom Topologies**, on page 1501.

---

## Importing Networks from the Network Discovery Policy

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**  Access the custom topology to which you want to import the network:

- Create a custom topology; see **Creating Custom Topologies**, on page 1499.
- Edit an existing custom topology; see **Editing Custom Topologies**, on page 1502.

**Step 2**  Click **Import Policy Networks**.

**Step 3**  Click **Load**. The system displays the topology information for the network discovery policy.

**Step 4**  Refine your topology:

- Rename a network in the topology by clicking the edit icon (✏️) next to the network, typing a name, and clicking **Rename**.
- Remove a network from the topology by clicking the delete icon (🗑️) and then clicking **OK** to confirm.

**Step 5**  Click **Save**.

---

**What to do next**

- Activate the topology as described in **Activating and Deactivating Custom Topologies**, on page 1501.
Manually Adding Networks to Your Custom Topology

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Access the custom topology where you want to add the network:
- Create a custom topology; see Creating Custom Topologies, on page 1499.
- Edit an existing custom topology; see Editing Custom Topologies, on page 1502.

Step 2 Click Add Network.

Step 3 If you want to add a custom label for the network in the hosts and network devices network maps, type a Name.

Step 4 Enter the IP Address and Netmask (IPv4) that represent the network you want to add.

Step 5 Click Add.

Step 6 Click Save.

What to do next
- Activate the topology as described in Activating and Deactivating Custom Topologies, on page 1501.

Related Topics
- Firepower System IP Address Conventions, on page 14

Activating and Deactivating Custom Topologies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery Admin</td>
</tr>
</tbody>
</table>

Note
Only one custom topology can be active at any time. If you have created multiple topologies, activating one automatically deactivates the currently active topology.

Procedure

Step 1 Choose Policies > Network Discovery.

In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.
Step 2 Choose Custom Topology.
Step 3 Click the slider next to a topology to activate or deactivate it.

---

## Editing Custom Topologies

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Leaf only</td>
<td>Admin/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

Changes you make to an active topology take effect immediately.

### Procedure

Step 1 Choose Policies > Network Discovery.
In a multidomain deployment, if you are not in a leaf domain, the system prompts you to switch.

Step 2 Click Custom Topology.

Step 3 Click the edit icon (✍️) next to the topology you want to edit.

Step 4 Edit the topology as described in Creating Custom Topologies, on page 1499.

Step 5 Click Save.
Incidents

The following topics describe how to configure incident handling:

- About Incident Handling, on page 1503
- Creating Custom Incident Types, on page 1506
- Creating an Incident, on page 1507
- Editing an Incident, on page 1508
- Generating Incident Reports, on page 1508

About Incident Handling

Incident handling refers to the response an organization takes when a violation of its security policies is suspected. The Firepower System includes features to support you as you collect and process information that is relevant to your investigation of an incident. You can use these features to gather intrusion events and packet data that may be related to the incident. You can also use the incident as a repository for notes about any activity that you take outside of the Firepower System to mitigate the effects of the attack. For example, if your security policies require that you quarantine compromised hosts from your network, you can note that in the incident.

The Firepower System also supports an incident life cycle, allowing you to change an incident’s status as you progress through your response to an attack. When you close an incident, you can note any changes you have made to your security policies as a result of any lessons learned.

Definition of an Incident

Generally, an incident is defined as one or more intrusion events that you suspect are involved in a possible violation of your security policies. In the Firepower System, the term also describes the feature you can use to track your response to an incident.

Some intrusion events are more important than others to the availability, confidentiality, and integrity of your network assets. For example, the port scan detection can keep you informed of port scanning activity on your network. Your security policy, however, may not specifically prohibit port scanning or see it as a high priority threat, so rather than take any direct action, you may instead want to keep logs of any port scanning for later forensic study.

On the other hand, if the system generates events that indicate hosts within your network have been compromised and are participating in distributed denial-of-service (DDoS) attacks, this activity is likely a
clear violation of your security policy, and you should create an incident in the Firepower System to help you track your investigation of these events.

**Common Incident Handling Processes**

**Preparation**

You can prepare for incidents in two ways:

- by having clear and comprehensive security policies in place, as well as the hardware and software resources to enforce them
- by having a clearly defined plan to respond to incidents and a properly trained team that can implement the plan

A key part of incident handling is understanding which parts of your network are at the greatest risk. By deploying Firepower System components on those network segments, you can increase your awareness of when and how incidents occur. Also, by taking the time to carefully tune the intrusion policy for each managed device, you can ensure that the events that are generated are of the highest quality.

**Detection and Notification**

You cannot respond to an incident unless you can detect it. Your incident handling process should note the kinds of security-related events that you can detect and the mechanisms, both software and hardware, that you use to detect them. You should also note where you can detect violations of your security policies. If your network includes segments that are not actively or passively monitored, you need to note that as well.

The managed devices that you deploy on your network are responsible for analyzing the traffic on the segments where they are installed, for detecting intrusions, and for generating events that describe them. Keep in mind that the access control policy you deploy to each of the managed devices governs what kinds of activity they detect and how it is prioritized. You can also set notification options for certain types of intrusion events so that the incident team does not need to sift through hundreds of events. You can specify that you are notified automatically when certain high priority, high severity events are detected.

**Investigation and Qualification**

Your incident handling process should specify how, after a security incident is detected, an investigation is conducted. In some organizations, junior members of the team triage all the incidents and handle the less severe or lower priority cases themselves, while more senior members of the team handle high severity and high priority incidents. You should carefully outline the escalation process so that each team member understands the criteria for raising an incident’s importance.

Part of the escalation process is tied to understanding how a detected event can affect the security of your network assets. For example, an attack against hosts running Microsoft SQL Server is not a high priority for organizations that use a different database server. Similarly, the attack is less important to you if you use SQL Server on your network, but you are confident that all the servers are patched and are not vulnerable to the attack. However, if someone has recently installed a copy of the vulnerable version of the software (perhaps for testing purposes), you may have a greater problem than a cursory investigation would suggest.

The Firepower System is particularly well suited to supporting the investigation and qualification process. You can create your own event classifications, and then apply them in a way that best describes the vulnerabilities on your network. When traffic on your network triggers an event, that event is automatically
prioritized and qualified for you with special indicators showing which attacks are directed against hosts that are known to be vulnerable.

The incident tracking feature in the Firepower System also includes a status indicator that you can change to show which incidents have been escalated.

**Communication**

All incident handling processes should specify how an incident is communicated between the incident handling team and both internal and external audiences. For example, you should consider what kinds of incidents require management intervention and at what level. Also, your process should outline how and when you communicate with outside organizations. Consider the following:

- Will some incidents require that you notify law enforcement agencies?
- If your hosts are participating in a distributed denial of service (DDoS) against a remote site, will you inform them?
- Do you want to share information with organizations such as the CERT Coordination Center (CERT/CC) or FIRST?

The Firepower System has features that you can use to gather intrusion data in standard formats such as HTML, PDF, and CSV (comma-separated values) so that you can easily share intrusion data with others. For example, CERT/CC collects standard information about security incidents on its web site. CERT/CC looks for the kinds of information that you can easily extract from the Firepower System, such as:

- information about the affected machines, including:
  - the host name and IP
  - the time zone
  - the purpose or function of the host

- information about the sources of the attack, including:
  - the host name and IP
  - the time zone
  - whether you had any contact with an attacker
  - the estimated cost of handling the incident

- a description of the incident, including:
  - dates
  - methods of intrusion
  - the intruder tools involved
  - the software versions and patch levels
  - any intruder tool output
  - the details of vulnerabilities exploited
  - the source of the attack
• any other relevant information

You can also use the comment section of an incident to record when you communicate issues and with whom.

**Containment and Recovery**

Your incident handling process should clearly indicate what steps are taken when a host or other network component is compromised. The range of containment and recovery options stretches from applying patches to vulnerable hosts to shutting down the target and removing it from the network. You should also consider the importance, depending upon the nature and severity of the attack, of preserving evidence in case you pursue criminal charges.

You can use the incident feature of Firepower System to maintain a record of the actions you take during the containment and recovery phase of the incident.

**Lessons Learned**

Each security incident, whether or not it is a successful attack, is an opportunity to review your security policies. Do you need to update your firewall rules? Do you need a more structured approach to patch management? Are unauthorized wireless access points a new security issue? Each lesson learned should feed back into your security policies and help you prepare better for the next incident.

**Incident Types in the Firepower System**

You can assign an incident type to each incident you create. The following types are supported by default in the Firepower System:

- Intrusion
- Denial of Service
- Unauthorized Admin Access
- Web Site Defacement
- Compromise of System Integrity
- Hoax
- Theft
- Damage
- Unknown

You can also create your own incident types.

**Creating Custom Incident Types**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>
Procedure

Step 1  Choose Analysis > Intrusions > Incidents.
Step 2  Click Create Incident.
Step 3  In the Type area, click Types.
        The default incident types are listed at the bottom of the page.
Step 4  In the Incident Type Name field, enter a name for the new incident type.
Step 5  Click Add.
Step 6  Click Done.
        You can use the new incident type the next time you create or edit an incident.

Creating an Incident

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can view and modify incidents created in the current domain only. In an ancestor domain, you can add events to incidents from any descendant domains.

Procedure

Step 1  Choose Analysis > Intrusions > Incidents.
Step 2  Click Create Incident.
Step 3  From the Type drop-down menu, choose the option that best describes the incident.
Step 4  In the Time Spent field, enter the amount of time you spent on the incident in the #d #h #m #s format, where # represents the number of days, hours, minutes, or seconds.
Step 5  In the Summary text box, enter a short description of the incident (up to 255 alphanumeric characters, spaces, and symbols).
Step 6  In the Add Comment text box, enter a more complete description for the incident (up to 8191 alphanumeric characters, spaces, and symbols).
Step 7  Add events to the incident:
        • To add a selection of events, choose the events on the clipboard, and click Add to Incident.
        • To add all events from the clipboard, click Add All to Incident.
        Note  If you want to add individual events from more than one page on the clipboard, you must add the events from one page, then add the events from the other pages separately.
Step 8  Click Save.
Editing an Incident

In a multidomain deployment, you can view and modify incidents created in the current domain only. In an ancestor domain, you can add events to an incident from any descendant domains.

Procedure

Step 1  Choose Analysis > Intrusions > Incidents.

Step 2  Click the edit icon (📝) next to the incident you want to edit.

Step 3  You can edit any of the following aspects of the incident:
  • change the status
  • change the type
  • add events from the clipboard
  • delete events

Step 4  In the Time Spent field, enter the amount of additional time you spent on the incident.

Step 5  In the Add Comment text box, indicate your changes to the incident (up to 8191 alphanumeric characters, spaces and symbols) for the incident.

Step 6  Optionally, you can add or delete events from the incident:
  • To add events from the clipboard, choose the events on the clipboard and click Add to Incident.
  • To add all the events from the clipboard, click Add All to Incident.
  • To delete specific events from the incident, choose the events and click Delete.
  • To delete all events from the incident, click Delete All.
  • To update the incident without adding or deleting events, click Save.

Generating Incident Reports

You can use the Firepower System to generate incident reports. These reports can include the incident summary, incident status, and any comments along with information from the events you add to the incident. You can also specify whether you want to include event summary information in the report.
**Procedure**

**Step 1** Choose **Analysis > Intrusions > Incidents**.

**Step 2** Click the edit icon ( ![edit icon](image) ) next to the incident you want to include in your report.

**Step 3** You have two options:
- To include all the events from the incident in the report, click **Generate Report All**.
- To include specific events from the incident in the report, check the check boxes next to the events you want, and click **Generate Report**.

**Step 4** Enter a name for the report.

**Step 5** In **Incident Report Sections**, check the check boxes for the portions of the incident that you want to include in the report: **status**, **summary**, and **comments**.

**Step 6** If you want to include event information in the report, choose the workflow you want to use and then, in **Report Sections**, specify whether you want to include event summary information.

**Step 7** Check the check boxes next to the workflow pages you want to include in the report.

**Step 8** Check the check boxes next to the output formats you want to use for the report: **PDF**, **HTML**, and **CSV**.

**Note** CSV-based incident reports include only event information. They do **not** include the status, summary, or comments from the incident.

**Step 9** Click **Generate Report** and confirm that you want to update the report profile.
PART XIX

Workflows

- Workflows, on page 1513
- Searching for Events, on page 1553
- Custom Workflows, on page 1563
- Custom Tables, on page 1571
Workflows

The following topics describe how to use workflows:

- Overview: Workflows, on page 1513
- Predefined Workflows, on page 1513
- Custom Table Workflows, on page 1523
- Using Workflows, on page 1523
- Bookmarks, on page 1550

Overview: Workflows

A workflow is a tailored series of data pages on the Firepower Management Center web interface that analysts can use to evaluate events generated by the system.

The following types of workflows are available on the Firepower Management Center:

Predefined Workflows

Preset workflows delivered with the system. You cannot edit or delete a predefined workflow. You can, however, copy a predefined workflow and use it as the basis for a custom workflow.

Saved Custom Workflows

Custom workflows based on saved custom tables delivered with the Firepower Management Center. You can edit, delete, and copy these workflows.

Custom Workflows

Workflows that you create and customize for your specific needs, or that the system generates automatically when you create custom tables. You can edit, delete, and copy these workflows.

The data displayed in a workflow often depends on such factors as how you license and deploy your managed devices, and whether you configure features that provide the data.

Predefined Workflows

The predefined workflows described in the following sections are delivered with the system. You cannot edit or delete a predefined workflow, but you can copy a predefined workflow and use it as the basis for a custom workflow.
Predefined Intrusion Event Workflows

The following table describes the predefined intrusion event workflows included with the Firepower System.

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Port</td>
<td>Because destination ports are usually tied to an application, this workflow can help you detect applications that are experiencing an uncommonly high volume of alerts. The Destination Port column can also help you identify applications that should not be present on your network.</td>
</tr>
<tr>
<td>Event-Specific</td>
<td>This workflow provides two useful features. Events that occur frequently may indicate:</td>
</tr>
<tr>
<td></td>
<td>• false positives</td>
</tr>
<tr>
<td></td>
<td>• a worm</td>
</tr>
<tr>
<td></td>
<td>• a badly misconfigured network</td>
</tr>
<tr>
<td></td>
<td>Events that occur infrequently are most likely evidence of a targeted attack and warrant special attention.</td>
</tr>
<tr>
<td>Events by Priority and Classification</td>
<td>This workflow lists events and their type in order of event priority, along with a count showing how many times each event has occurred.</td>
</tr>
<tr>
<td>Events to Destinations</td>
<td>This workflow provides a high-level view of which host IP addresses are being attacked and the nature of the attack; where available, you can also see information about the countries involved in attacks.</td>
</tr>
<tr>
<td>IP-Specific</td>
<td>This workflow shows which host IP addresses are generating the most alerts. Hosts with the greatest number of events are either public-facing and receiving worm-type traffic (indicating a good place to look for tuning) or require further investigation to determine the cause of the alerts. Hosts with the lowest counts also warrant investigation as they could be the subject of a targeted attack. Low counts may also indicate that a host may not belong on the network.</td>
</tr>
<tr>
<td>Impact and Priority</td>
<td>This workflow lets you find high-impact recurring events quickly. The reported impact level is shown with the number of times the event has occurred. Using this information, you can identify the high-impact events that recur most often, which might be an indicator of a widespread attack on your network.</td>
</tr>
</tbody>
</table>
This workflow can help you identify the source of an attack in progress. The reported impact level is shown with the associated source IP address for the event. If, for example, events with a level 1 impact are coming from the same source IP address repeatedly, they may indicate an attacker who has identified vulnerable systems and is targeting them.

You can use this workflow to identify events repeatedly occurring on vulnerable computers, so you can address the vulnerabilities on those systems and stop any attacks in progress.

This workflow indicates which servers are generating the most alerts. You can use this information to identify areas that require tuning, and to decide which servers require attention.

This workflow identifies host IP addresses sharing high levels of alerts. Pairs at the top of the list could be false positives, and may identify areas that require tuning. You can check pairs at the bottom of the list for targeted attacks, for users accessing resources they should not be accessing, or for hosts that do not belong on the network.

The following table describes the predefined malware workflows included on the Firepower Management Center. All predefined malware workflows use the table view of malware events.

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware Summary</td>
<td>This workflow provides a list of the malware detected in network traffic or by AMP for Endpoints Connectors, grouped by individual threat.</td>
</tr>
<tr>
<td>Malware Event Summary</td>
<td>This workflow provides a quick breakdown of the different malware event types and subtypes.</td>
</tr>
<tr>
<td>Hosts Receiving Malware</td>
<td>This workflow provides a list of host IP addresses that have received malware, grouped by the malware files’ associated dispositions.</td>
</tr>
<tr>
<td>Hosts Sending Malware</td>
<td>This workflow provides a list of host IP addresses that have sent malware, grouped by the malware files’ associated dispositions.</td>
</tr>
<tr>
<td>Applications Introducing Malware</td>
<td>This workflow provides a list of host IP addresses that have received files, grouped by the associated malware dispositions for those files.</td>
</tr>
</tbody>
</table>
Predefined File Workflows

The following table describes the predefined file event workflows included on the Firepower Management Center. All the predefined file event workflows use the table view of file events.

Table 226: Predefined File Workflows

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Summary</td>
<td>This workflow provides a quick breakdown of the different file event categories and types, along with any associated malware dispositions.</td>
</tr>
<tr>
<td>Hosts Receiving Files</td>
<td>This workflow provides a list of host IP addresses that have received files, grouped by the associated malware dispositions for those files.</td>
</tr>
<tr>
<td>Hosts Sending Files</td>
<td>This workflow provides a list of host IP addresses that have sent files, grouped by the associated malware dispositions for those files.</td>
</tr>
</tbody>
</table>

Predefined Captured File Workflows

The following table describes the predefined captured file workflows included on the Firepower Management Center. All predefined captured file workflows use the table view of captured files.

Table 227: Predefined Captured File Workflows

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Captured File Summary</td>
<td>This workflow provides a breakdown of captured files based on type, category, and threat score.</td>
</tr>
<tr>
<td>Dynamic Analysis Status</td>
<td>This workflow provides a count of captured files based on whether they have been submitted for dynamic analysis.</td>
</tr>
</tbody>
</table>

Predefined Connection Data Workflows

The following table describes the predefined connection data workflows included on the Firepower Management Center. All the predefined connection data workflows use the table view of connection data.

Table 228: Predefined Connection Data Workflows

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Events</td>
<td>This workflow provides a summary view of basic connection and detected application information, which you can then use to drill down to the table view of events.</td>
</tr>
<tr>
<td>Workflow Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connections by Application</td>
<td>This workflow contains a graph of the 10 most active applications on the monitored network segment, based on the number of detected connections.</td>
</tr>
<tr>
<td>Connections by Initiator</td>
<td>This workflow contains a graph of the 10 most active host IP addresses on the monitored network segment, based on the number of connections where the host initiated the connection transaction.</td>
</tr>
<tr>
<td>Connections by Port</td>
<td>This workflow contains a graph of the 10 most active ports on the monitored network segment, based on the number of detected connections.</td>
</tr>
<tr>
<td>Connections by Responder</td>
<td>This workflow contains a graph of the 10 most active host IP addresses on the monitored network segment, based on the number of connections where the host IP was the responder in the connection transaction.</td>
</tr>
<tr>
<td>Connections over Time</td>
<td>This workflow contains a graph of the total number of connections on the monitored network segment over time.</td>
</tr>
<tr>
<td>Traffic by Application</td>
<td>This workflow contains a graph of the 10 most active applications on the monitored network segment, based on the number of kilobytes transmitted. Application counts reflect each detector that matched against an application connection. The same application session may be represented more than once in the list depending on whether an application protocol, web application, client detector, or internal detector matched the traffic, as well as whether the traffic originated from a mobile device or was part of an encrypted session. If the application was seen in a client flow and no specific client detector exists, a generic client may be reported. For example, you may see the same session of YouTube traffic reported as YouTube (because it matched a YouTube web application detector) and as YouTube client (because an internal YouTube detector matched against characteristics typically seen in a client session). Use the information in the connection events and network map for your network to determine more context for specific application connections.</td>
</tr>
<tr>
<td>Traffic by Initiator</td>
<td>This workflow contains a graph of the 10 most active host IP addresses on the monitored network segment, based on the total number of kilobytes transmitted from each address.</td>
</tr>
<tr>
<td>Traffic by Port</td>
<td>This workflow contains a graph of the 10 most active ports on the monitored network segment, based on the number of kilobytes transmitted.</td>
</tr>
</tbody>
</table>
Predefined Security Intelligence Workflows

The following table describes the predefined Security Intelligence workflows included on the Firepower Management Center. All the predefined Security Intelligence workflows use the table view of Security Intelligence events.

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traffic by Responder</td>
<td>This workflow contains a graph of the 10 most active host IP addresses on the monitored network segment, based on the total number of kilobytes received by each address.</td>
</tr>
<tr>
<td>Traffic over Time</td>
<td>This workflow contains a graph of the total kilobytes transmitted on the monitored network segment over time.</td>
</tr>
<tr>
<td>Unique Initiators by Responder</td>
<td>This workflow contains a graph of the 10 most active responding host IP addresses on the monitored network segment, based on the number of unique initiators that contacted each address.</td>
</tr>
<tr>
<td>Unique Responders by Initiator</td>
<td>This workflow contains a graph of the 10 most active initiating host IP addresses on the monitored network segment, based on the number of unique responders that the addresses contacted.</td>
</tr>
</tbody>
</table>

Predefined Host Workflows

The following table describes the predefined workflows that you can use with host data.
### Predefined Host Workflows

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts</td>
<td>This workflow contains a table view of hosts followed by the host view. Workflow views based on the Hosts table allow you to easily view data on all IP addresses associated with a host.</td>
</tr>
<tr>
<td>Operating System Summary</td>
<td>You can use this workflow to analyze the operating systems in use on your network.</td>
</tr>
</tbody>
</table>

### Predefined Indications of Compromise Workflows

The following table describes the predefined workflows that you can use with IOC (Indications of Compromise) data.

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indications of Compromise</td>
<td>This workflow begins with a summary view of IOC data grouped by count and category, and provides a detail view that further subdivides the summary data by event type. Access this workflow via the Analysis &gt; Hosts menu.</td>
</tr>
<tr>
<td>Indications of Compromise by Host</td>
<td>You can use this workflow to gauge which hosts on your network are most likely to be compromised (based on IOC data). Access this workflow via the Analysis &gt; Hosts menu.</td>
</tr>
</tbody>
</table>

### Predefined Applications Workflows

The following table describes the predefined workflows that you can use with application data.

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Business Relevance</td>
<td>You can use this workflow to analyze running applications of each estimated business relevance level on your network, so you can monitor appropriate use of your network resources.</td>
</tr>
<tr>
<td>Application Category</td>
<td>You can use this workflow to analyze running applications of each category (such as email, search engine, or social networking) on your network, so you can monitor appropriate use of your network resources.</td>
</tr>
</tbody>
</table>
Predefined Application Details Workflows

The following table describes the predefined workflows that you can use with application detail and client data.

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Details</td>
<td>You can use this workflow to analyze the client applications on your network in more detail. The workflow then provides a table view of client applications, followed by the host view.</td>
</tr>
<tr>
<td>Clients</td>
<td>This workflow contains a table view of client applications, followed by the host view.</td>
</tr>
</tbody>
</table>

Predefined Servers Workflows

The following table describes the predefined workflows that you can use with server data.

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Applications by Count</td>
<td>You can use this workflow to analyze the most frequently used applications on your network.</td>
</tr>
<tr>
<td>Network Applications by Hit</td>
<td>You can use this workflow to analyze the most active applications on your network.</td>
</tr>
<tr>
<td>Server Details</td>
<td>You can use this workflow to analyze the vendors and versions of detected server application protocols in detail.</td>
</tr>
<tr>
<td>Servers</td>
<td>This workflow contains a table view of applications followed by the host view.</td>
</tr>
</tbody>
</table>
Predefined Host Attributes Workflows

The following table describes the predefined workflow that you can use with host attribute data.

**Table 235: Predefined Host Attributes Workflows**

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes</td>
<td>You can use this workflow to monitor IP addresses of hosts on your network and the hosts' status.</td>
</tr>
</tbody>
</table>

The Predefined Discovery Events Workflow

The following table describes the predefined workflow that you can use to view discovery and identity data.

**Table 236: Predefined Discovery Event Workflows**

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery Events</td>
<td>This workflow provides a detailed list, in table view form, of discovery events, followed by the host view.</td>
</tr>
</tbody>
</table>

Predefined User Workflows

The following table describes the predefined workflow that you can use to view user discovery and user identity data.

**Table 237: Predefined User Workflows**

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>This workflow provides a list of user information collected by user identity sources.</td>
</tr>
</tbody>
</table>

Predefined Vulnerabilities Workflows

The following table describes the predefined vulnerabilities workflow included on the Firepower Management Center.

**Table 238: Predefined Vulnerabilities Workflows**

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vulnerabilities</td>
<td>You can use this workflow to review vulnerabilities in the database, including a table view of only those active vulnerabilities that apply to the detected hosts on your network. The workflow provides a vulnerability detail view, which contains a detailed description for every vulnerability that meets your constraints.</td>
</tr>
</tbody>
</table>
Predefined Third-Party Vulnerabilities Workflows

The following table describes the predefined third-party vulnerabilities workflows included on the Firepower Management Center.

Table 239: Predefined Third-Party Vulnerabilities Workflows

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vulnerabilities by IP Address</td>
<td>You can use this workflow to quickly see how many third-party vulnerabilities you have detected per host IP address on your monitored network.</td>
</tr>
<tr>
<td>Vulnerabilities by Source</td>
<td>You can use this workflow to quickly see how many third-party vulnerabilities you have detected per third-party vulnerability source, such as the QualysGuard Scanner.</td>
</tr>
</tbody>
</table>

Predefined Correlation and White List Workflows

There is a predefined workflow for each type of correlation data, white list events, white list violations, and remediation status events.

Table 240: Predefined Correlation Workflows

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correlation Events</td>
<td>This workflow contains a table view of correlation events.</td>
</tr>
<tr>
<td>White List Events</td>
<td>This workflow contains a table view of white list events.</td>
</tr>
<tr>
<td>Host Violation Count</td>
<td>This workflow provides a series of pages that list all the host IP addresses that violate at least one white list.</td>
</tr>
<tr>
<td>White List Violations</td>
<td>This workflow includes a table view of white list violations that lists all violations with the most recently detected violation at the top of the list. Each row in the table contains a single detected violation.</td>
</tr>
<tr>
<td>Status</td>
<td>This workflow contains a table view of remediation status, which includes the name of the policy that was violated and the name and status of the remediation that was applied.</td>
</tr>
</tbody>
</table>

Predefined System Workflows

The Firepower System is delivered with some additional workflows, including system events such as audit events and health events, as well as workflows that list results from rule update imports and active scans.
Table 241: Additional Predefined Workflows

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit Log</td>
<td>This workflow contains a table view of the audit log that lists audit events.</td>
</tr>
<tr>
<td>Health Events</td>
<td>This workflow displays events triggered by the health monitoring policy.</td>
</tr>
<tr>
<td>Rule Update Import Log</td>
<td>This workflow contains a table view listing information about both successful and failed rule update imports.</td>
</tr>
<tr>
<td>Scan Results</td>
<td>This workflow contains a table view listing each completed scan.</td>
</tr>
</tbody>
</table>

Custom Table Workflows

You can use the custom tables feature to create tables that use the data from two or more types of events. This is useful because you can, for example, create tables and workflows that correlate intrusion event data with discovery data to allow simple searches for events that affect critical systems.

When you create a custom table, the system automatically creates a workflow that you can use to view the events associated with the table. The features in the workflow differ depending on which type of table you use. For example, custom table workflows based on the intrusion event table always end with the packet view. However, custom table workflows based on discovery events end with the host view.

Unlike workflows based on the predefined event tables, workflows based on custom tables do not have links to other types of workflows.

Using Workflows

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Choose the appropriate menu path and option as described in Workflow Selection, on page 1525.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Navigate within the current workflow:</td>
</tr>
<tr>
<td></td>
<td>• To view all of the columns available in your chosen event data type, use table view pages; see Using Table View Pages, on page 1531.</td>
</tr>
</tbody>
</table>
• To view a subset of the columns available in your chosen event data type, use drill-down pages; see Using Drill-Down Pages, on page 1531.

• To display the corresponding row in the next page of the workflow, click the blue down-arrow icon (⬇).

• To move among the pages of a multipage workflow, use the tools at the bottom of each page; see Workflow Page Traversal Tools, on page 1528.

• To view the same constraints applied within a workflow for a different type of event, click Jump to and choose the event view from the drop-down list.

**Step 3** Modify the display of the current workflow:

- Check the check boxes by one or more rows on a page to indicate which row(s) you want to affect, then click one of the buttons at the bottom of the page (for example, the View button) to perform that action for all selected rows.

- Check the check box at the top of the row to select all the rows on the page, then click one of the buttons at the bottom of the page (for example, the View button) to perform that action for all rows on the page.

- Constrain the columns in the display by clicking the close icon (✗) in the column heading that you want to hide. In the pop-up window that appears, click Apply.

**Tip** To hide or show other columns, check or clear the appropriate check boxes before you click Apply. To add a disabled column back to the view, click the expand arrow to expand the search constraints, then click the column name under Disabled Columns.

- Constrain the data view by selected values for selected fields. For information, see Event View Constraints, on page 1547 and Compound Event View Constraints, on page 1548.

- Change the time constraints on the event view. The date range located in the upper right corner of the page sets a time range for events to include in the workflow; for information, see Event Time Constraints, on page 1540.

**Note** Events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.

- To sort data by columns, click the name of a column. To reverse the sort order, click the column name again. The direction icon indicates which column the data is sorted by, and whether the sort is ascending (▲) or descending (▼).

- Click a workflow page link to display that page using any active constraints. Workflow page links appear in the upper left corner of predefined workflow table views and drill-down pages, above events and below the workflow name.

**Step 4** View additional data within the current workflow:

- To view the file's trajectory map in a new window, click the network file trajectory icon in file name and SHA-256 hash value columns. The icon is different depending on the file status; see File Trajectory Icons, on page 1529.
• To display a pop-up window of the host profile associated with an IP address, click the host profile icon in any IP address column. The icon is different depending on the file status; see Host Profile Icons, on page 1529.

• To view the Dynamic Analysis Summary report for the highest threat score associated with a file, click the threat score icon in any threat score column. The icon is different depending on the file’s highest threat score; see Threat Score Icons, on page 1530.

• To view user profile information, click the user icon (or, for users associated with an indication of compromise, ) in any user identity column. The user icon is dimmed if that user cannot be in the database (that is, is an AMP for Endpoints Connector user).

• To view vulnerability details for third-party vulnerabilities, click the vulnerability icon ( ) in any third-party vulnerability ID column.

• When viewing aggregated data points, hover your pointer over the flag icon to view the country name.

• When viewing individual data points, click the flag icon to view further geolocation details described in Geolocation, on page 1532.

**Step 5** Navigate to a different workflow:

To view the same event type using a different workflow, click (switch workflow) next to the workflow title, then choose the workflow you want to use. Note that you cannot use a different workflow for scan results.

---

**Workflow Access by User Role**

Access to a workflow is determined by the user's role. See the table below for more information.

<table>
<thead>
<tr>
<th>User Role</th>
<th>Accessible Workflows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Can access any workflow, and are the only users who can access the audit log, scan results, and the rule update import log.</td>
</tr>
<tr>
<td>Maintenance User</td>
<td>Can access health events.</td>
</tr>
<tr>
<td>Security Analyst and Security Analyst (Read Only)</td>
<td>Can access intrusion, malware, file, connection, discovery, vulnerability, correlation, and health workflows.</td>
</tr>
</tbody>
</table>

**Workflow Selection**

The Firepower System provides predefined workflows for the types of data listed in the following table.
Table 242: Features Using Workflows

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Path</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intrusion events</td>
<td>Analysis &gt; Intrusions</td>
<td>Events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reviewed Events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clipboard</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Incidents</td>
</tr>
<tr>
<td>Malware events</td>
<td>Analysis &gt; Files</td>
<td>Malware Events</td>
</tr>
<tr>
<td>File events</td>
<td>Analysis &gt; Files</td>
<td>File Events</td>
</tr>
<tr>
<td>Captured files</td>
<td>Analysis &gt; Files</td>
<td>Captured Files</td>
</tr>
<tr>
<td>Connection events</td>
<td>Analysis &gt; Connections</td>
<td>Events</td>
</tr>
<tr>
<td>Security Intelligence events</td>
<td>Analysis &gt; Connections</td>
<td>Security Intelligence Events</td>
</tr>
<tr>
<td>Host events</td>
<td>Analysis &gt; Hosts</td>
<td>Network Map</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hosts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Indications of Compromise</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Applications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Application Details</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Servers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Host Attributes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Discovery Events</td>
</tr>
<tr>
<td>User events</td>
<td>Analysis &gt; Users</td>
<td>User Activity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Users</td>
</tr>
<tr>
<td>Vulnerability events</td>
<td>Analysis &gt; Vulnerabilities</td>
<td>Vulnerabilities</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Third-Party Vulnerabilities</td>
</tr>
<tr>
<td>Correlation events</td>
<td>Analysis &gt; Correlation</td>
<td>Correlation Events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>White List Events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>White List Violations</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Status</td>
</tr>
<tr>
<td>Audit events</td>
<td>System &gt; Monitoring</td>
<td>Audit</td>
</tr>
<tr>
<td>Health events</td>
<td>Health &gt; Events</td>
<td>n/a</td>
</tr>
<tr>
<td>Rule Update Import Log</td>
<td>System &gt; Updates</td>
<td>n/a</td>
</tr>
<tr>
<td>Scan Results</td>
<td>Policies &gt; Actions &gt; Scanners</td>
<td>n/a</td>
</tr>
</tbody>
</table>
When you view any of the kinds of data described in the above table, events appear on the first page of the default workflow for that data. You can specify a different default workflow by configuring your event view settings. Note that workflow access depends on your user role.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Related Topics**
- Configuring Event View Settings, on page 31

### Workflow Pages

Although the data in each type of workflow is different, all workflows share a common set of features. Workflows can include several types of pages. The actions you can perform on a workflow page depend on the type of page.

Drill-down and table view pages in workflows allow you to quickly narrow your view of the data so you can zero in on events that are significant to your analysis. Table view pages and drill-down pages both support many features you can use to constrain the set of events you want to view or to navigate the workflow. When viewing data on drill-down pages or in the table view in a workflow, you can sort the data in ascending or descending order based on any available column. If the database contains more events than can be displayed on a single workflow page, you can click the links at the bottom of the page to display more events. When you click one of these links, the time window automatically pauses so that you do not see the same events twice; you can unpause the time window when you are ready.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

### Table Views

Table views include a column for each of the fields in the database on which your workflow is based if the page is enabled by default.

Note that when you disable a column on a table view, the Firepower System adds the Count column to the event view if disabling the column would create two or more identical rows. When you click on a value in a table view page, you constrain by that value. When you create a custom workflow, you add a table view to it by clicking **Add Table View**.

### Drill-Down Pages

Generally, drill-down pages are intermediate pages that you use to narrow your investigation to a few events before moving to a table view page. Drill-down pages contain a subset of columns that are available in the database.

For example, a drill-down page for discovery events might include only the IP Address, MAC Address, and Time columns. A drill-down page for intrusion events, on the other hand, might include the Priority, Impact Flag, Inline Result, and Message columns.

Drill-down pages allow you to narrow the scope of events you are viewing and to move forward in the workflow. If you click on a value in a drill-down page, for example, you constrain by that value and move to the next page in the workflow, focusing more closely on events that match your selected values. Clicking a value in a drill-down page does not disable the column where the value is, even if the page you advance to is a table view. Note that drill-down pages for predefined workflows always have a Count column. When you create a custom workflow, you add a drill-down page to it by clicking **Add Page**.
Graphs

Workflows based on connection data can include graph pages, also called *connection graphs*.

For example, a connection graph might display a line graph that shows the number of connections detected by the system over time. Generally, connection graphs are, like drill-down pages, intermediate pages that you use to narrow your investigation.

Final Pages

The final page of a workflow depends on the type of event on which the workflow is based:

- The host view is the final page for workflows based on applications, application details, discovery events, hosts, indications of compromise (IOC), servers, white list violations, host attributes, or third-party vulnerabilities. Viewing host profiles from this page allows you to easily view data on all IP addresses associated with hosts that have multiple addresses.

- The user detail view is the final page for workflows based on users and user activity.

- The vulnerability detail view is the final page for workflows based on Cisco vulnerabilities.

- The packet view is the final page for workflows based on intrusion events.

Workflows based on other kinds of events (for example, audit log events or malware events) do not have final pages.

On the final page of a workflow, you can expand detail sections to view specific information about each object in the set you focused on over the course of the workflow. Although the web interface does not list the constraints on the final page of a workflow, previously set constraints are retained and applied to the set of data.

Workflow Page Navigation Tools

Workflow pages provide visual cues to facilitate navigating among them and choosing what information to display during event analysis.

Workflow Page Traversal Tools

If a workflow contains multiple pages of data, the bottom of each page displays the number of pages in the workflow, as well as the tools listed in the table below which you may use to navigate among the pages:

<table>
<thead>
<tr>
<th>Page Traversal Tool</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>page number</td>
<td>view a different page</td>
</tr>
<tr>
<td>(To view a different page, enter the number you wish to view, then press Enter.)</td>
<td></td>
</tr>
<tr>
<td>&gt;</td>
<td>view the next page</td>
</tr>
<tr>
<td>&lt;</td>
<td>view the previous page</td>
</tr>
<tr>
<td>&gt;</td>
<td></td>
</tr>
<tr>
<td>Page Traversal Tool</td>
<td>Action</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td><code>&lt;</code></td>
<td>jump to the first page</td>
</tr>
</tbody>
</table>

**File Trajectory Icons**

When a workflow page provides the opportunity to view the trajectory map for a file in a new window, a network trajectory icon appears. This icon differs depending upon the file status.

*Table 244: File Trajectory Icons*

<table>
<thead>
<tr>
<th>File Trajectory Icon</th>
<th>File Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Clean</td>
</tr>
<tr>
<td></td>
<td>Malware</td>
</tr>
<tr>
<td></td>
<td>Custom detection</td>
</tr>
<tr>
<td></td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>Unavailable</td>
</tr>
</tbody>
</table>

**Host Profile Icons**

When a workflow page provides the opportunity to view the host profile associated with an IP address in a pop-up window, a host profile icon appears. If the host profile icon is dimmed, you cannot view the host profile because that host cannot be in the network map (for example, 0.0.0.0). This icon appears different depending on the status of the host.

*Table 245: Host Profile Icons*

<table>
<thead>
<tr>
<th>Host Profile Icon</th>
<th>Host Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Host is not tagged as potentially compromised.</td>
</tr>
<tr>
<td></td>
<td>Host is tagged as potentially compromised by triggered indications of compromise (IOC) rules.</td>
</tr>
<tr>
<td></td>
<td>Blacklisted (Appears only if you are performing traffic filtering based on Security Intelligence data.)</td>
</tr>
<tr>
<td></td>
<td>Blacklisted, set to monitor (Appears only if you are performing traffic filtering based on Security Intelligence data.)</td>
</tr>
</tbody>
</table>
Threat Score Icons

When a workflow page provides the opportunity to view a Dynamic Analysis Summary report for the highest threat score associate with a file, a threat score icon appears. The icon differs depending on the file’s highest threat score.

Table 246: Threat Score Icons

<table>
<thead>
<tr>
<th>Threat Score Icon</th>
<th>Threat Score Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>●●●●</td>
<td>Low</td>
</tr>
<tr>
<td>●●●</td>
<td>Medium</td>
</tr>
<tr>
<td>●●●</td>
<td>High</td>
</tr>
<tr>
<td>●●●●●</td>
<td>Very high</td>
</tr>
</tbody>
</table>

The Workflow Toolbar

Each page in a workflow includes a toolbar that offers quick access to related features. The following table describes each of the links on the toolbar.

Table 247: Workflow Toolbar Links

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark This Page</td>
<td>Bookmarks the current page so you can return to it later. Bookmarking captures the constraints in effect on the page you are viewing so you can return to the same data (assuming the data still exists) at a later time.</td>
</tr>
<tr>
<td>Report Designer</td>
<td>Opens the report designer with the currently constrained workflow as the selection criteria.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Opens a dashboard relevant to your current workflow. For example, Connection Events workflows link to the Connection Summary dashboard.</td>
</tr>
<tr>
<td>View Bookmarks</td>
<td>Displays a list of saved bookmarks from which you can select.</td>
</tr>
<tr>
<td>Search</td>
<td>Displays a Search page where you can perform advanced searches on data in the workflow. You can also click the down arrow icon to select and use a saved search.</td>
</tr>
</tbody>
</table>

Related Topics

- Creating a Report Template from an Event View, on page 1429
- About Dashboards, on page 197
- Event Searches, on page 1553
- Bookmarks, on page 1550
Creating Bookmarks, on page 1551
Viewing Bookmarks, on page 1551

Using Drill-Down Pages

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Security Analyst (depending on workflow)</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Access a workflow by choosing the appropriate menu path and option as described in Features Using Workflows.

**Step 2** In any workflow, you have the following options:

- To drill down to the next workflow page constraining on a specific value, click a value within a row. Note that this works only on drill-down pages. Clicking a value within a row in a table view only constrains the table view and does not drill down to the next page.

- To drill down to the next workflow page constraining on some events, check the check boxes next to the events you want to view on the next workflow page, then click View.

- To drill down to the next workflow page keeping the current constraints, click View All.

**Tip** Table views always include “Table View” in the page name.

Using Table View Pages

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Security Analyst (depending on workflow)</td>
</tr>
</tbody>
</table>

Table view pages provide some features not available on drill-down, host view, packet view, or vulnerability detail pages. Use these features as described below:

**Procedure**

**Step 1** Access a workflow by choosing the appropriate menu path and option as described in Workflow Selection, on page 1525.
Step 2 Choose a table view from the workflow path displayed beneath the workflow name.

Step 3 Use the features listed below to arrange and navigate within the table view as needed:

- To display the list of disabled columns, click the Search Constraints expand arrow (►).
- To hide the list of disabled columns, click the Search Constraints collapse arrow (▼).
- To add a disabled column back to the event view, click the Search Constraints expand arrow (►) to expand the search constraints, then click the column name under Disabled Columns.
- To show or hide (disable) a column, click the clear icon (×) next to any column name. In the pop-up window that appears, check or clear the appropriate check boxes to indicate which column(s) you want to display, then click Apply.

---

Geolocation

The geolocation feature provides data about the geographical sources of routable IP addresses (country, continent, and so on). This information is available in events, asset profiles, the Context Explorer, dashboard, and other analysis tools.

### Note

For mobile devices and other hosts detected moving from country to country, the system may report a continent instead of a specific country.

You can use geolocation data to filter network traffic. For example, you can determine if connections are originating from or terminating in countries unconnected with your organization. In an inline deployment, you can block those connections.

The system stores geolocation data in its geolocation database (GeoDB). Cisco issues periodic updates to the GeoDB. The About page (Help > About) shows the current GeoDB update version.

If you accept GeoDB updates, you can click the small country flag icons and ISO country codes in the Firepower Management Center web interface to obtain geolocation details about specific IP addresses; see Geolocation Detail Information, on page 1533. You can also pinpoint the detected location with third-party map tools. If you do not update the GeoDB, these details are unavailable.

You cannot view geolocation details for aggregate geolocation information, such as on the Connection Summary dashboard.

### Related Topics

- **Network Conditions**, on page 294
- **Geolocation Objects**, on page 331
- **Introduction to Correlation Policies and Rules**, on page 1361
- **Traffic Profile Conditions**, on page 1401
- **Update the Geolocation Database (GeoDB)**, on page 122

---
## Geolocation Detail Information

Depending on availability, a number of fields may appear on the Geolocation Details page. The following table contains information on these fields. (Fields with no information are not displayed.)

**Table 248: Geolocation Detail Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Country</strong></td>
<td>Country associated with the host’s IP address, accompanied by the country’s flag. The continent is listed in parentheses. Examples: United States (North America), Equatorial Guinea (Africa)</td>
</tr>
<tr>
<td><strong>Region</strong></td>
<td>State, province, or other subregion of the country where the host is located. Examples: VA, 35</td>
</tr>
<tr>
<td><strong>City</strong></td>
<td>City where the host is located. Examples: Seattle, Fukuoka</td>
</tr>
<tr>
<td><strong>Postal Code</strong></td>
<td>Postal code of the region where the host is located. Examples: 361000, 90210</td>
</tr>
<tr>
<td><strong>Latitude/Longitude</strong></td>
<td>Exact coordinates of the host’s location. Examples: 40.0375, -76.1053; 53.4050, -0.5484</td>
</tr>
<tr>
<td><strong>Maps</strong></td>
<td>Links to external mapping sites (Google Maps, Yahoo Maps, Bing Maps, and OpenStreetMap). Click any link to view a contextual map of the host’s approximate location.</td>
</tr>
<tr>
<td><strong>Timezone</strong></td>
<td>Time zone of the host’s location, with Daylight Savings Time noted where applicable. Examples: GMT+8:00, GMT-4:00 (In DST)</td>
</tr>
<tr>
<td><strong>ASN</strong></td>
<td>Autonomous System Number (ASN) associated with the host’s IP address, and any additional information about that ASN. Examples: 14618 (Amazon.com Inc.); 4837 (Cncgroup China169 Backbone)</td>
</tr>
<tr>
<td><strong>ISP</strong></td>
<td>Internet service provider (ISP) associated with the host’s IP address. Examples: Atlantic Broadband, China Unicom Ip Network</td>
</tr>
<tr>
<td><strong>Home/Business</strong></td>
<td>Whether the host’s connection is used for Home or Business purposes.</td>
</tr>
<tr>
<td><strong>Organization</strong></td>
<td>Organization associated with the host’s IP address. Examples: Amazon.com, Bank of America</td>
</tr>
<tr>
<td><strong>Domain Name</strong></td>
<td>Domain name associated with the host’s IP address. Examples: amazonaws.com, xmcnc.net</td>
</tr>
<tr>
<td><strong>Connection Type</strong></td>
<td>Connection type associated with the host’s IP address. Examples: Broadband, DSL</td>
</tr>
<tr>
<td><strong>Proxy Type</strong></td>
<td>The type of proxy used. Examples: Anonymous, Corporate</td>
</tr>
</tbody>
</table>
Connection Event Graphs

In addition to workflows that use tabular drill-down pages and a final table view of events, the system can present certain connection data graphically, using data aggregated over five-minute intervals. Note that you can graph only the information used to aggregate data: source and destination IP addresses (and those hosts’ associated users), destination port, transport protocol, and application protocol.

**Tip**

You cannot graph Security Intelligence events separately from their associated connection events. For a graphical overview of Security Intelligence filtering activity, use dashboards and the Context Explorer.

There are three different types of connection graphs:

- *Pie charts* display data from one dataset grouped into discrete categories.
- *Bar graphs* display data from one or more datasets grouped into discrete categories.
- *Line graphs* plot data from one or more datasets over time, using either a standard or a velocity (rate of change) view.

**Note**

The system displays traffic profiles as line graphs, which you can manipulate in the same way as you would any other connection graph, with some restrictions. To view traffic profiles, you must have Administrator access.

Like workflow tables, you can drill down and constrain workflow graphs to focus your analysis.

Both bar graphs and line graphs can display multiple datasets; that is, they can display several values on the y-axis for each x-axis data point. For example, you could display the total number of unique initiators and responders. Pie charts can only display one dataset.

You can display different data and datasets on a connection graph by changing either the x-axis, the y-axis, or both. On a pie chart, changing the x-axis changes the independent variable and changing the y-axis changes the dependent variable.

**Related Topics**

Connection Summaries (Aggregated Data for Graphs), on page 1596

### Using Connection Event Graphs

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst (depending on workflow)</td>
</tr>
</tbody>
</table>

On the Firepower Management Center, you can view connection event graphs and manipulate them depending on the information you are looking for.
The page you see when you access connection graphs differs depending on the workflow you use. You can use a predefined workflow, which terminates in a table view of connection events. You can also create a custom workflow that displays only the information that matches your specific needs.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Choose Analysis &gt; Connections &gt; Events.</th>
</tr>
</thead>
</table>

**Note** If a connection event table appears instead of a graph, or to view a different graph, click **(switch workflow)** by the workflow title and choose a predefined workflow that includes graphs, or a custom workflow. Note that all predefined connection event workflows—including connection graphs—terminate in a table view of connections.

<table>
<thead>
<tr>
<th>Step 2</th>
<th>You have the following options:</th>
</tr>
</thead>
</table>

• **Time Range** — To adjust the time range, which is useful if the graph is blank, see **Changing the Time Window**, on page 1543.

• **Field Names** — To learn more about the data you can graph, see **Connection and Security Intelligence Event Fields**, on page 1597.

• **Host Profile** — To view the host profile for an IP address, on a graph displaying connection data by initiator or responder, click either a bar on a bar graph or a wedge on a pie chart and choose **View Host Profile**.

• **User Profile** — To view user profile information, on a graph displaying connection data by initiator user, click either a bar on a bar graph or a wedge on a pie chart and choose **View User Profile**.

• **Other Information** — To learn more information about the graphed data, position your cursor over a point on a line graph, a bar in a bar graph, or a wedge in a pie chart.

• **Constrain** — To constrain a connection graph by any x-axis (independent variable) criterion without advancing the workflow to the next page, click a point on a line graph, a bar on a bar graph, or a wedge on a pie chart, and choose a **View by...** option.

• **Data Selection** — To change the data displayed on the graph, click **X-Axis** or **Y-Axis** and choose the new data to graph. Note that changing the x-axis to or from **Time** also changes the graph type; changing the y-axis affects the displayed datasets.

• **Datasets** — To change the graph’s dataset, click **Datasets** and choose a new dataset.

• **Detach** — To detach a connection graph so you can perform further analysis without affecting the default time range, click **Detach**.

**Tip** Click **New Window** in a detached graph to create a copy. You can then perform different analyses on each of the detached graphs. Note that traffic profiles are detached graphs.

• **Drill Down** — To drill down to the next page in the workflow, click a point on a line graph, a bar on a bar graph, or a wedge on a pie chart, then choose **Drill-down**. Clicking a point on a line graph changes the time range on the next page to a 10-minute span, centered on the point you clicked. Clicking a bar on a bar graph or a wedge on a pie chart constrains the next page based on the criterion represented by the bar or wedge.
• Export — To export the connection data for a graph as a CSV (comma-separated values) file, Export Data. Then, click Download CSV File and save the file.

• Graph Type: Line — To switch between a standard and velocity (rate of change) line graph, click Velocity, then choose Standard or Velocity.

• Graph Type: Bar and Pie — To switch between a bar graph and pie chart, click Switch to Bar or Switch to Pie. Because you cannot display multiple datasets on a pie chart, if you switch to a pie chart from a bar graph that has multiple datasets, the pie chart shows only one dataset, which is selected automatically. When choosing which dataset to display, the Firepower Management Center favors total statistics over initiator and responder statistics, and favors initiator statistics over responder statistics.

• Navigate Between Pages — To navigate between pages in the current workflow, keeping the current constraints, click the appropriate page link at the top left of the workflow page.

• Navigate Between Event Views — To navigate to other event views to view associated events, click Jump to and choose the event view from the drop-down list.

• Recenter — To recenter a line graph around a point in time without changing the length of the time range, click that point, then choose Recenter.

• Zoom — To recenter a line graph around a point in time while zooming in or out, click that point, choose Zoom, then choose a new time span.

Note Unless you are working with a detached graph, constraining, recentering, and zooming changes the default time range for the Firepower Management Center.

Example: Constraining a Connection Graph

Example: Changing X-Axis and Y-Axis on a Pie Chart

Consider a graph of connections over time. If you constrain a point on the graph by port, a bar graph appears, showing the 10 most active ports based on the number of detected connection events, but constrained by the ten-minute time span that is centered on the point you clicked.

If you further constrain the graph by clicking on one of the bars and choosing View by Initiator IP, a new bar graph appears, constrained by not only the same ten-minute time span as before, but also by the port represented by the bar you clicked.

Consider a pie chart that graphs kilobytes per port. In this case, the x-axis is Responder Port and the y-axis is KBytes. This pie chart represents the total kilobytes of data transmitted over a monitored network during a certain interval. The wedges of the pie represent the percent of the data that was detected on each port.

• If you change the x-axis of the chart to Application Protocol, the pie chart still represents the total kilobytes of data transmitted, but the wedges of the pie represent the percentage of the data transmitted for each detected application protocol.

• If you change the y-axis of the chart to Packets, the pie chart represents the total number of packets transmitted over the monitored network during a certain interval, and the wedges of the pie represent the percentage of the total number of packets that was detected on each port.
Related Topics

Using Workflows, on page 1523
Configuring Event View Settings, on page 31

Connection Graph Data Options

You can display different data on a connection graph by changing either the x-axis, the y-axis, or both. On a pie chart, changing the x-axis changes the independent variable and changing the y-axis changes the dependent variable.

Table 249: X-Axis Options

<table>
<thead>
<tr>
<th>X-Axis Option</th>
<th>Graph Type</th>
<th>Graphs This Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Protocol</td>
<td>bar or pie</td>
<td>by the 10 most active application protocols</td>
</tr>
<tr>
<td>Device</td>
<td>bar or pie</td>
<td>by the 10 most active managed devices</td>
</tr>
<tr>
<td>Initiator IP</td>
<td>bar or pie</td>
<td>by the 10 most active initiator host IP addresses</td>
</tr>
<tr>
<td>Initiator User</td>
<td>bar or pie</td>
<td>by the 10 most active initiator users</td>
</tr>
<tr>
<td>Responder IP</td>
<td>bar or pie</td>
<td>by the 10 most active responder host IP addresses</td>
</tr>
<tr>
<td>Responder Port</td>
<td>bar or pie</td>
<td>by the 10 most active responder ports</td>
</tr>
<tr>
<td>Source Device</td>
<td>bar or pie</td>
<td>by the 10 most active NetFlow data exporters, plus a source device named Firepower for all connection detected by Firepower System managed devices.</td>
</tr>
<tr>
<td>Time</td>
<td>line</td>
<td>over time</td>
</tr>
</tbody>
</table>

Changing the y-axis to and from Time also changes the graph type and may change the datasets.

Table 250: Y-Axis Options

<table>
<thead>
<tr>
<th>Y-Axis Option</th>
<th>Graphs This Data Using The X-Axis Criterion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td>bytes transmitted</td>
</tr>
<tr>
<td>Connections</td>
<td>number of connections</td>
</tr>
<tr>
<td>KBytes</td>
<td>kilobytes transmitted</td>
</tr>
<tr>
<td>KBytes Per Second</td>
<td>kilobytes per second</td>
</tr>
<tr>
<td>Y-Axis Option</td>
<td>Graphs This Data Using The X-Axis Criterion</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Packets</td>
<td>number of packets transmitted</td>
</tr>
<tr>
<td>Unique Hosts</td>
<td>number of unique hosts detected</td>
</tr>
<tr>
<td>Unique Application Protocols</td>
<td>number of unique application protocols</td>
</tr>
<tr>
<td>Unique Users</td>
<td>number of unique users</td>
</tr>
</tbody>
</table>

### Connection Graphs with Multiple Datasets

Both bar graphs and line graphs can display multiple datasets; that is, they can display several values on the y-axis for each x-axis data point. For example, you could display the total number of unique initiators and responders.

**Note**

You *cannot* display multiple datasets on a pie chart. If you switch to a pie chart from a bar graph that has multiple datasets, the pie chart shows only one dataset, which is selected automatically. When selecting which dataset to display, the Firepower Management Center favors total statistics over initiator and responder statistics, and favors initiator statistics over responder statistics.

On line graphs, multiple datasets appear as multiple lines, each with a different color. For example, the following graphic displays the total number of unique initiators and the total number of unique responders detected on a monitored network over a one hour interval.

On bar graphs, multiple datasets appear as a set of colored bars for each x-axis data point. For example, the following bar graph displays the total packets transmitted on a monitored network, packets transmitted by initiators, and packets transmitted by responders.
### Connection Graph Dataset Options

The following table describes the datasets you can display on the x-axis of a connection graph.

**Table 251: Dataset Options**

<table>
<thead>
<tr>
<th>If the y-axis displays...</th>
<th>You can select as datasets...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>the default only, which is the number of connections detected on the monitored network (Connections). This is the only option for traffic profile graphs.</td>
</tr>
<tr>
<td>KBytes</td>
<td>combinations of:</td>
</tr>
<tr>
<td></td>
<td>• the total kilobytes transmitted on the monitored network (Total KBytes)</td>
</tr>
<tr>
<td></td>
<td>• the number of kilobytes transmitted from host IP addresses on the monitored network (Initiator KBytes)</td>
</tr>
<tr>
<td></td>
<td>• the number of kilobytes received by host IP addresses on the monitored network (Responder KBytes)</td>
</tr>
<tr>
<td>KBytes Per Second</td>
<td>the default only, which is the total kilobytes per second transmitted on the monitored network (Total KBytes Per Second)</td>
</tr>
</tbody>
</table>
### Event Time Constraints

Each event has a time stamp that indicates when the event occurred. You can constrain the information that appears in some workflows by setting the time window, sometimes called the time range.

Workflows based on events that can be constrained by time include a time range line at the top of the page. By default, workflows use an expanding time window set to the past hour. For example, if you log in at 11:30 AM, you will see events that occurred between 10:30 AM and 11:30 AM. As time moves forward, the time window expands. At 12:30 PM, you will see events that occurred between 10:30 AM and 12:30 PM.

You can change this behavior by setting your own default time window in the event view settings. This governs three properties:

- time window type (static, expanding, or sliding)
- time window length
- the number of time windows (either multiple time windows or a single global time window)

Regardless of the default time window setting, you can manually change the time window during your event analysis by clicking the time range at the top of the page, which displays the Date/Time pop-up window. Depending on the number of time windows you configured and the type of appliance you are using, you can also use the Date/Time window to change the default time window for the type of event you are viewing.

<table>
<thead>
<tr>
<th>If the y-axis displays...</th>
<th>You can select as datasets...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Packets</td>
<td>combinations of:</td>
</tr>
<tr>
<td></td>
<td>• the total packets transmitted on the monitored network (Total Packets)</td>
</tr>
<tr>
<td></td>
<td>• the number of packets transmitted from host IP addresses on the monitored network (Initiator Packets)</td>
</tr>
<tr>
<td></td>
<td>• the number of packets received by host IP addresses on the monitored network (Responder Packets)</td>
</tr>
<tr>
<td>Unique Hosts</td>
<td>combinations of:</td>
</tr>
<tr>
<td></td>
<td>• the number of unique session initiators on the monitored network (Unique Initiators)</td>
</tr>
<tr>
<td></td>
<td>• the number of unique session responders on the monitored network (Unique Responders)</td>
</tr>
<tr>
<td>Unique Application Protocols</td>
<td>the default only, which is the number of unique application protocols on the monitored network (Unique Application Protocols)</td>
</tr>
<tr>
<td>Unique Users</td>
<td>the default only, which is the number of unique users logged into session initiators on the monitored network (Unique Initiator Users)</td>
</tr>
</tbody>
</table>
Finally, you can pause the time window while looking at a sliding or expanding workflow. See *Pause the Time Window to Temporarily Freeze the Data Set*, on page 1544.

**Related Topics**

- Configuring Event View Settings, on page 31
- Using Connection and Security Intelligence Event Tables, on page 1615

**Per-Session Time Window Customization for Events**

Regardless of the default time window, you can manually change the time window during your event analysis.

---

**Note**

Manual time window settings are valid for only the current session. When you log out and then log back in, time windows are reset to the default.

---

Depending on the number of time windows you configured, changing the time window for one workflow may affect other workflows on the appliance. For example, if you have a single, global time window, changing the time window for one workflow changes it for all other workflows on the appliance. On the other hand, if you are using multiple time windows, changing the audit log or health event workflow time windows has no effect on any other time window, while changing the time window for other kinds of events affects all events that can be constrained by time (with the exception of audit events and health events).

Note that because not all workflows can be constrained by time, time window settings have no effect on workflows based on hosts, host attributes, applications, application details, vulnerabilities, users, or white list violations.

Use the Time Window tab on the Date/Time window to manually configure a time window. Depending on the number of time windows you configured in your default time window settings, the tab’s title is one of the following:

- **Events Time Window**, if you configured multiple time windows and are setting the time window for a workflow other than the audit log or health events workflow
- **Health Monitoring Time Window**, if you configured multiple time windows and are setting the time window for the health events workflow
- **Audit Log Time Window**, if you configured multiple time windows and are setting the time window for the audit log
- **Global Time Window**, if you configured a single time window

The first decision you must make when configuring a time window is the type of time window you want to use:

- A *static* time window displays all the events generated from a specific start time to a specific end time.
- An *expanding* time window displays all the events generated from a specific start time to the present; as time moves forward, the time window expands and new events are added to the event view.
- A *sliding* time window displays all the events generated from a specific start time (for example, one week ago) to the present; when you refresh the page, the time window “slides” so that you see only the events in the time range you configured (in this example, for the last week). To temporarily prevent the data set from updating while you are examining it, see *Pause the Time Window to Temporarily Freeze the Data Set*, on page 1544.
 Depending on what type you select, the Date/Time window changes to give you different configuration options.

---

**Note**
The Firepower System uses a 24-hour clock based on the time you specified in your time zone preferences.

---

### Time Window Settings

The following table explains the various settings you can configure on the Time Window tab.

**Table 252: Time Window Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Time Window Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>time window type drop-down list</td>
<td>n/a</td>
<td>Select the type of time window you want to use: static, expanding, or sliding. Note that events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.</td>
</tr>
<tr>
<td>Start Time calendar</td>
<td>static and expanding</td>
<td>Specify a start date and time for your time window. The maximum time range for all time windows is from midnight on January 1, 1970 (UTC) to 3:14:07 AM on January 19, 2038 (UTC). Instead of using the calendar, you can use the Presets options, described below.</td>
</tr>
<tr>
<td>End Time calendar</td>
<td>static</td>
<td>Specify an end date and time for your time window. The maximum time range for all time windows is from midnight on January 1, 1970 (UTC) to 3:14:07 AM on January 19, 2038 (UTC). Note that if you are using an expanding time window, the End Time calendar is grayed out and specifies that the end time is “Now.” Instead of using the calendar, you can use the Presets options, described below.</td>
</tr>
<tr>
<td>Show the Last field and drop-down list</td>
<td>sliding</td>
<td>Configure the length of the sliding time window.</td>
</tr>
<tr>
<td>Setting</td>
<td>Time Window Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Presets: Last</td>
<td>all</td>
<td>Click one of the time ranges in the list to change the time window, based on the local time of the appliance. For example, clicking <strong>1 week</strong> changes the time window to reflect the last week. Clicking a preset changes the calendars to reflect the preset you choose.</td>
</tr>
</tbody>
</table>
| Presets: Current        | static and expanding          | Click one of the time ranges in the list to change the time window, based on the local time and date of the appliance. Clicking a preset changes the calendars to reflect the preset you choose.  Note that:  
  • the current day begins at midnight  
  • the current week begins at midnight Sunday  
  • the current month begins at midnight on the first of the month |
| Presets: Synchronize with | all (not available if you are using a global time window) | Click one of:  
  • **Events Time Window** to synchronize the current time window with the events time window  
  • **Health Monitoring Time Window** to synchronize the current time window with the health monitoring time window  
  • **Audit Log Time Window** to synchronize the current time window with the audit log time window |

### Changing the Time Window

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst (depending on workflow)</td>
</tr>
</tbody>
</table>
Procedure

**Step 1** On a workflow constrained by time, click the time range icon () to go to the Date/Time window.

**Step 2** On the **Events Time Window** tab, set the time window as described in **Time Window Settings, on page 1542**.

**Tip**

- Click **Reset** to change the time window back to the default settings.

**Step 3** Click **Apply**.

---

### Pause the Time Window to Temporarily Freeze the Data Set

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst (depending on workflow)</td>
</tr>
</tbody>
</table>

If you are using a sliding or expanding time window, you can pause the time window to examine a snapshot of the data provided by the workflow. This is useful because when an unpaused workflow updates, it may remove events that you want to examine or add events that you are not interested in.

The time window automatically pauses when you click a link at the bottom of the page to display another page of events; you can unpause the time window when you are ready.

When you are finished with your analysis, you can unpause the time window. Unpausing the time window updates it according to your preferences, and also updates the event view to reflect the unpaused time window.

Pausing an event time window has no effect on dashboards, nor does pausing a dashboard have any effect on pausing an event time window.

---

### Procedure

On a workflow constrained by time, choose the desired time range control:

- To pause the time window, click the time range control pause icon ().
- To unpause the time window, click the time range control play icon ().

---

### The Default Time Window for Events

During your event analysis, you can use the Preferences tab on the Date/Time window to change the default time window for the type of event you are viewing without having to use the event view settings.

Keep in mind that changing the default time window in this way changes the default time window for only the type of event you are viewing. For example, if you configured multiple time windows, changing the default time window on the Preferences tab changes the settings for either the events, health monitoring, or audit log window, in other words, whichever time window is indicated by the first tab. If you configured a single time...
window, changing the default time window on the Preferences tab changes the default time window for all types of events.

**Related Topics**

[Default Time Windows](#), on page 33

---

**Default Time Window Options for Event Types**

The following table explains the various settings you can configure on the Preferences tab.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh Interval</td>
<td>Sets the refresh interval for event views, in minutes. Entering zero disables the refresh option.</td>
</tr>
<tr>
<td>Number of Time Windows</td>
<td>Specify how many time windows you want to use:</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Multiple</strong> to configure separate default time windows for the audit log, for health events, and for workflows based on events that can be constrained by time.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Single</strong> to use a global time window that applies to all events.</td>
</tr>
<tr>
<td>Default Time Window: Show the Last - Sliding</td>
<td>This setting allows you to configure a sliding default time window of the length you specify.</td>
</tr>
<tr>
<td></td>
<td>The appliance displays all the events generated from a specific start time (for example, 1 hour ago) to the present. As you change event views, the time window “slides” so that you always see events from the last hour.</td>
</tr>
<tr>
<td>Default Time Window: Show the Last - Static/Expanding</td>
<td>This setting allows you to configure either a static or expanding default time window of the length you specify.</td>
</tr>
<tr>
<td></td>
<td>For <strong>static</strong> time windows (enable the <strong>Use End Time</strong> check box), the appliance displays all the events generated from a specific start time (for example, 1 hour ago), to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.</td>
</tr>
<tr>
<td></td>
<td>For <strong>expanding</strong> time windows (disable the <strong>Use End Time</strong> check box), the appliance displays all the events generated from a specific start time (for example, 1 hour ago), to the present. As you change event views, the time window expands to the present time.</td>
</tr>
</tbody>
</table>
### Preference

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default Time Window: Current Day - Static/Expanding | This setting allows you to configure either a static or expanding default time window for the current day. The current day begins at midnight, based on the time zone setting for your current session.  
For **static** time windows (enable the **Use End Time** check box), the appliance displays all the events generated from midnight to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.  
For **expanding** time windows (disable the **Use End Time** check box), the appliance displays all the events generated from midnight to the present. As you change event views, the time window expands to the present time. Note that if your analysis continues for over 24 hours before you log out, this time window can be more than 24 hours. |
| Default Time Window: Current Week - Static/Expanding | This setting allows you to configure either a static or expanding default time window for the current week. The current week begins at midnight on the previous Sunday, based on the time zone setting for your current session.  
For **static** time windows (enable the **Use End Time** check box), the appliance displays all the events generated from midnight to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.  
For **expanding** time windows (disable the **Use End Time** check box), the appliance displays all the events generated from midnight Sunday to the present. As you change event views, the time window expands to the present time. Note that if your analysis continues for over 1 week before you log out, this time window can be more than 1 week. |

### Changing the Default Time Window for Your Event Type

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

1. **Step 1** On a workflow constrained by time, click the time range icon (.Clock ) to go to the Date/Time window.
2. **Step 2** Click the **Preferences** tab and change your preferences, as described in Default Time Window Options for Event Types, on page 1545.
Step 3  Click Save Preferences.

Step 4  You have two options:

- To apply your new default time window settings to the event view you are using, click Apply to close the Date/Time window and refresh the event view.

- To continue with your analysis without applying the default time window settings, close the Date/Time window without clicking Apply.

---

Event View Constraints

The information that you see on a workflow page is determined by the constraints that you impose. For example, when you initially open an event workflow, the information is constrained to events that were generated in the previous hour.

To advance to the next page in the workflow and constrain the data you are viewing by specific values, select the rows with those values on the page and click View. To advance to the next page in the workflow retaining the current constraints and carrying forward all events, select View All.

---

Note

If you select a row with multiple non-count values and click View, you create a compound constraint.

There is a third method for constraining data in a workflow. To constrain the page to the rows with values that you selected and also add the selected value to the list of constraints at the top of the page, click a value within a row on the page. For example, if you are viewing a list of logged connections and want to constrain the list to only those you allowed using access control, click Allow in the Action column. As another example, if you are viewing intrusion events and want to constrain the list to only events where the destination port is 80, click 80 (http)/tcp in the Destination Port/ICMP Code column.

---

Tip

The procedure for constraining connection events based on Monitor rule criteria is slightly different and you may need to take some extra steps. Additionally, you cannot constrain connection events by associated file or intrusion information.

You can also use searches to constrain the information in a workflow. Use this feature when you want to constrain against multiple values in a single column. For example, if you want to view the events related to two IP addresses, click Edit Search, then modify the appropriate IP address field on the Search page to include both addresses, and then click Search.

The search criteria you enter on the search page are listed as the constraints at the top of the page, with the resulting events constrained accordingly. On the Firepower Management Center, the current constraints are also applied when navigating to other workflows, unless they are compound constraints.

When searching, you must pay careful attention to whether your search constraints apply to the table you are searching. For example, client data is not available in connection summaries. If you search for connection events based on the detected client in the connection and then view the results in a connection summary event view, the Firepower Management Center displays connection data as if you had not constrained it at all. Invalid constraints are labeled as not applicable (N/A) and are marked with a strikethrough.
Constraining Events

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Security Analyst</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(depending on workflow)</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Access a workflow by choosing the appropriate menu path and option as described in Workflow Selection, on page 1525.

Step 2 In any workflow, you have the following options:

- To constrain the view to events that match a single value, click the desired value within a row on the page.
- To constrain the view to events that match multiple values, check the check boxes for events with those values, and click View.

  Note A compound constraint is added if the row contains multiple non-count values.

- To remove a constraint, click the Search Constraints expand arrow (.expand) and click the name of the constraint in the expanded Search Constraints list.
- To edit constraints using the Search page, click Edit Search.
- To save constraints as a saved search, click Save Search and give the query a name.

  Note You cannot save queries containing compound constraints.

- To use the same constraints with another event view, click Jump to and choose the event view.

  Note You do not retain compound constraints when you switch to another workflow.

- To toggle the display of constraints click the Search Constraints expand arrow (.expand) or the Search Constraints collapse arrow (-collapse). This is useful when the list of constraints is large and takes up most of the screen.

Compound Event View Constraints

Compound constraints are based on all non-count values for a specific event. When you select a row with multiple non-count values, you set a compound constraint that retrieves only events matching all the non-count values in that row on that page. For example, if you select a row that has a source IP address of 10.10.31.17 and a destination IP address of 10.10.31.15 and a row that has a source IP address of 172.10.10.17 and a destination IP address of 172.10.10.15, you retrieve all of the following:
• Events that have a source IP address of 10.10.31.17 AND a destination IP address of 10.10.31.15

OR

• Events that have a source IP address of 172.10.31.17 AND a destination IP address of 172.10.31.15

When you combine compound constraints with simple constraints, the simple constraints are distributed across each set of compound constraints. If, for example, you added a simple constraint for a protocol value of tcp to the compound constraints listed above, you retrieve all of the following:

• Events that have a source IP address of 10.10.31.17 AND a destination IP address of 10.10.31.15 AND a protocol of tcp

OR

• Events that have a source IP address of 172.10.31.17 AND a destination IP address of 172.10.31.15 AND a protocol of tcp

You cannot perform a search or save a search on a compound constraint. You also cannot retain compound constraints when you use the event view links or click (switch workflow) to switch to another workflow. If you bookmark an event view with compound constraints applied, the constraints are not saved with the bookmark.

### Using Compound Event View Constraints

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst (depending on workflow)</td>
</tr>
</tbody>
</table>

### Procedure

#### Step 1
Access a workflow by choosing the appropriate menu path and option as described in Workflow Selection, on page 1525.

#### Step 2
To manage compound constraints, you have the following options:

• To create a compound constraint, choose one or more rows with multiple non-count values and click View.

• To clear compound constraints, click the Search Constraints expand arrow (▶) and click Compound Constraints.

### Inter-Workflow Navigation

You can navigate to other workflows using the links in the Jump to... drop-down list on a workflow page. Select the drop-down list to view and select additional workflows.
When you select a new workflow, properties shared by the rows you select and the constraints you set are used in the new workflow, if they are applicable. If configured constraints or event properties do not map to fields in the new workflow, they are dropped. In addition, compound constraints are not retained when you switch from one workflow to another. In addition, constraints from the captured files workflow only transfer to file and malware event workflows.

---

**Note**

When you view event counts over a time range, the total number of events may not reflect the number of events for which more detailed data is available. This occurs because the system sometimes prunes older event details to manage disk space usage. To minimize the occurrence of event detail pruning, you can fine-tune event logging to log only those events most important to your deployment.

Note that unless you have either paused the time window or have configured a static time window, the time window changes when you change workflows.

This feature enhances your ability to investigate suspicious activity. For example, if you are viewing connection data and notice that an internal host is transmitting an abnormally large amount of data to an external site, you can select the responder IP address and the port as constraints and then jump to the Applications workflow. The applications workflow will use the responder IP address and port as IPAddress and Port constraints and display additional information about the application, such as what kind of application it is. You can also click **Hosts** at the top of the page to view the host profile for the remote host.

After finding more information about the application, you can select **Correlation Events** to return to the connection data workflow, remove the Responder IP from the constraints, add the Initiator IP to constraints, and select **Application Details** to see what client the user on the initiating host used when transferring data to the remote host. Note that the Port constraint is not transferred to the Application Details page. While keeping the local host as a constraint, you can also use other navigation buttons to find additional information:

- To discover if any policies have been violated by the local host, keep the IP address as a constraint and select **Correlation Events** from the Jump to drop-down list.
- To find out if an intrusion rule triggered against the host, indicating a compromise, select **Intrusion Events** from the Jump to drop-down list.
- To view the host profile for the local host and determine if the host is susceptible to any vulnerabilities that may have been exploited, select **Hosts** from the Jump to drop-down list.

---

**Bookmarks**

Create a bookmark if you want to return quickly to a specific location and time in an event analysis. Bookmarks retain information about:

- the workflow you are using
- the part of the workflow you are viewing
- the page number within the workflow
- any search constraints
- any disabled columns
- the time range you are using
The bookmarks you create are available to all user accounts with bookmark access. This means that if you uncover a set of events that require more in-depth analysis, you can easily create a bookmark and turn over the investigation to another user with the appropriate privileges.

If the events that appear in a bookmark are deleted (either directly by a user or by automatic database cleanup), the bookmark no longer displays the original set of events.

Creating Bookmarks

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Security Analyst</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(depending on workflow)</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can only view bookmarks created in the current domain.

Procedure

Step 1  During an event analysis, with the events of interest displayed, click **Bookmark This Page**.

Step 2  In the **Bookmark Name** field, enter a name.

Step 3  Click **Save Bookmark**.

Viewing Bookmarks

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Security Analyst</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(depending on workflow)</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can only view bookmarks created in the current domain.

Procedure

From any event view, you have two options:

- Hover your pointer over **View Bookmarks**, and click on the desired bookmark in the drop-down menu.
- Click on click **View Bookmarks** and on the View Bookmarks page, click on the desired bookmark name or the view icon (ઇ) next to it.
Note  If the events that originally appeared in a bookmark are deleted (either directly by a user or by automatic database cleanup), the bookmark no longer displays the original set of events.
CHAPTER 81

Searching for Events

The following topics describe how to search for events within a workflow:

- Event Searches, on page 1553
- Query Overrides Via the Shell, on page 1560

Event Searches

The Firepower System generates information that is stored as events in database tables. Events contain multiple fields that describe the activity that caused the appliance to generate the event. You can create and save searches customized for your environment for any of the different event types and save them to reuse later.

When you save a search you give it a name and specify whether the search will be available to you alone or to all users of the appliance. If you want to use the search as a data restriction for a custom user role, you must save it as a private search. If you previously saved a search, you can load it, make any necessary modifications, and then start the search. Custom analysis dashboard widgets, report templates, and custom roles can also use saved searches. If you have saved searches, you can delete them from the Search page.

For some event types, the Firepower System provides predefined searches that serve as examples and can provide quick access to important information about your network. You can modify fields within the predefined searches for your network environment, then save the searches to reuse later.

The search criteria you can use depends on the type of search, but the mechanics are the same. Searches return only records that match the search criteria specified for all fields.

Note

Searching a custom table requires a slightly different procedure.

Related Topics

Searching Custom Tables, on page 1579

Search Constraints

Each database table has its own search page where you can enter search constraint values to apply to fields defined for the table. Depending on the type of field, special syntax may be used to specify criteria such as wildcard characters or a range of numeric values.
Search results appear on workflow pages displaying each table field in columnar layout. Some database tables can additionally be searched using fields that are not displayed as columns on workflow pages. To determine whether such a constraint applies to your search results when viewing the results on a workflow page, click on the expand icon (▲) to view the active search constraints.

**General Search Constraints**

When searching for events, observe the following general guidelines:

- All fields accept negation (!).
- All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
- All fields accept comma-separated lists enclosed in quotation marks as search values.
  - For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
  - For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-encoded comma-separated list match that search criteria.
  - For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.

- Specify n/a in any field to identify events where information is not available for that field; use !n/a to identify the events where that field is populated.
- You can precede many numeric fields with greater than (\(>\)), greater than or equal to (\(\geq\)), less than (\(<\)), less than or equal to (\(\leq\)), equal to (\(=\)), or not equal to (\(<\) ) operators.

**Tip**

When searching a field with long complicated values (such as SHA-256 hash values), you can copy the search criteria value from source material and paste it into the appropriate field on the search page.

**Wildcards and Symbols in Searches**

Many text fields on search pages allow you to use an asterisk (*) to match characters in a string. For example, specifying net* matches network, netware, netscape, and so on.

If you want to search for non-alphanumeric characters (including the asterisk character), enclose the search string in quotation marks. For example, to search for the string:

Find an asterisk (*)

enter:

"Find an asterisk (*)"
Note that in text fields that allow a wildcard, you must use the wildcard if you want to match a partial string. For example, if you are searching the audit log for all audit records that involve page views (that is, the message is Page View), searching for Page returns no results. Instead, specify Page*.

In some fields you can search for all or part of the field contents without using asterisks. In these cases, you must use quotation marks around a search string to make exact matches—otherwise, the system performs a partial match. For example, if you were to search such a field for the string Scan Completed with Detection without using quotation marks, the system would return records where the field contains the following strings as well as those where the field exactly matches the search string:

Scan Completed, No Detections
Scan completed With Detections

**Objects and Application Filters in Searches**

The Firepower System allows you to create named objects, object groups, and application filters that can be used as part of your network configuration. You can use these objects, groups, and filters as search criteria when performing or saving searches.

When you perform a search, objects, object groups, and application filters appear in the format, ${object_name}. For example, a network object with the object name ten_ten_network appears as ${ten_ten_network} in a search.

You can click the add object icon (+) that appears next to a search field where you can use an object as a search criterion.

**Related Topics**

The Object Manager, on page 319

**Time Constraints in Searches**

The formats accepted by search criteria fields that take a time value are shown in the following table.

*Table 254: Time Specification in Search Fields*

<table>
<thead>
<tr>
<th>Time Formats</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>today [at HH:MMam</td>
<td>pm]</td>
</tr>
<tr>
<td></td>
<td>today at 12:45pm</td>
</tr>
</tbody>
</table>

You can precede a time value with one of the following operators:

*Table 255: Time Specification Operators*

<table>
<thead>
<tr>
<th>Operator</th>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>&gt; today at 2:45pm</td>
<td>Returns events with a timestamp later than today at 2:45 PM.</td>
</tr>
</tbody>
</table>
IP Addresses in Searches

When specifying IP addresses in searches, you can enter an individual IP address, a comma-separated list of addresses, an address block, or a range of IP addresses separated with a hyphen (-). You can also use negation.

For searches that support IPv6 (such as intrusion event, connection data, and correlation event searches) you can enter IPv4 and IPv6 addresses and CIDR/prefix length address blocks in any combination. When you search for hosts by IP address, the results include all hosts for which at least one IP address matches your search conditions, that is, a search for an IPv6 address may return hosts whose primary address in IPv4.

When you use CIDR or prefix length notation to specify a block of IP addresses, the Firepower System uses only the portion of the network IP address specified by the mask or prefix length. For example, if you type 10.1.2.3/8, the Firepower System uses 10.0.0.0/8.

Because IP addresses can be represented by network objects, you can also click the add network object icon (⁺) that appears next to an IP address search field to use a network object as an IP address search criterion.

Table 256: Acceptable IP Address Syntax

<table>
<thead>
<tr>
<th>To specify...</th>
<th>Type...</th>
<th>For example...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a single IP address</td>
<td>the IP address.</td>
<td>192.168.1.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2001:db8::abcd</td>
</tr>
<tr>
<td>multiple IP addresses using a list</td>
<td>a comma-separated list of IP addresses. Do not add a space before or after the commas.</td>
<td>192.168.1.1,192.168.1.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2001:db8::b3ff,2001:db8::0202</td>
</tr>
<tr>
<td>a range of IP addresses that can be specified with a CIDR block or prefix length</td>
<td>the IP address block in IPv4 CIDR or IPv6 prefix length notation.</td>
<td>192.168.1.0/24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This specifies any IP in the 192.168.1.0 network with a subnet mask of 255.255.255.0, that is, 192.168.1.0 through 192.168.1.255.</td>
</tr>
<tr>
<td>a range of IP addresses that cannot be specified with a CIDR block or prefix</td>
<td>the IP address range using a hyphen. Do not add a space before or after the hyphen.</td>
<td>192.168.1.1-192.168.1.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2001:db8::0202-2001:db8::8329</td>
</tr>
<tr>
<td>negation of any of the other ways to specify IP addresses or ranges of IP addresses</td>
<td>an exclamation point in front of the IP address, block, or range.</td>
<td>192.168.0.0/32, !192.168.1.10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>!2001:db8::/32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>!192.168.1.10, !2001:db8::/32</td>
</tr>
</tbody>
</table>

Related Topics

Firepower System IPAddress Conventions, on page 14

Managed Devices in Searches

When creating a search using a managed device as a constraint, you can specify any of the following in the Device search criteria field:

- A managed device name, IP address, or host name
- A device group name
• A device stack name
• A 7000 or 8000 Series device high-availability pair name

If the system finds a match for a group, device high-availability pair, or stack, it replaces the group, device high-availability pair, or stack name with the appropriate member device names for the purpose of performing the search. When you save a search that uses a device group, device high-availability pair, or stack in the device field the system saves the name specified in the device field and performs the device name replacement again each time the search is executed.

Ports in Searches

The Firepower System accepts specific syntax for port numbers in searches. You can enter:

• a single port number
• a comma-separated list of port numbers
• two port numbers separated by a dash to represent a range of port numbers
• a port number followed by a protocol abbreviation, separated by a forward slash (only when searching for intrusion events)
• a port number or range of port numbers preceded by an exclamation mark to indicate a negation of the specified ports

Do not use spaces when specifying port numbers or ranges.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>Returns all events on port 21, including TCP and UDP events.</td>
</tr>
<tr>
<td>!23</td>
<td>Returns all events except those on port 23.</td>
</tr>
<tr>
<td>25/tcp</td>
<td>Returns all TCP-related intrusion events on port 25.</td>
</tr>
<tr>
<td>21/tcp,25/tcp</td>
<td>Returns all TCP-related intrusion events on ports 21 and 25.</td>
</tr>
<tr>
<td>21-25</td>
<td>Returns all events on ports 21 through 25.</td>
</tr>
</tbody>
</table>

Event Fields in Searches

When searching for events, you can use the following fields as search criteria:

• Audit Log Workflow Fields, on page 1793
• Application Data Fields, on page 1758
• Application Detail Data Fields, on page 1760
Performing a Search

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Procedure

**Step 1** Choose Analysis > Search.
You can also click Edit Search on any workflow page.

**Step 2** From the drop-down list on the left of the search page, choose the type of event or data to search.

**Step 3** Enter your search criteria in the appropriate fields; see Search Constraints, on page 1553.

**Step 4** (Optional) If you want to perform the same search later, save the search as described in Saving a Search, on page 1559.

**Step 5** Click Search.
Search results appear in the default workflow for the table you are searching, constrained by time (if applicable).

What to do next
To analyze the search results using workflows, see Using Workflows, on page 1523.

Related Topics
Configuring Event View Settings, on page 31

Saving a Search

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays saved searches created in the current domain, which you can edit. It also displays searches saved in ancestor domains, which you cannot edit. To view and edit searches created in a lower domain, switch to that domain.

Before you begin
• Establish search criteria as described in Performing a Search, on page 1558, or load a saved search as described in Loading a Saved Search, on page 1559.

Procedure

Step 1
From the Search page, if you want to save the search as private so only you can access it, check the Private checkbox.

Tip
If you want to use the search as a data restriction for a custom user role, you must save it as a private search.

Step 2
You have two options:
• If you want to save a new version of a loaded search, click Save As New.
• If you want to save a new search, or overwrite a custom search using the same name, click Save. If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Loading a Saved Search

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>
In a multidomain deployment, the system displays saved searches created in the current domain, which you can edit. It also displays searches saved in ancestor domains, which you cannot edit. To view and edit searches created in a lower domain, switch to that domain.

**Procedure**

**Step 1** Choose **Analysis > Search**.

**Tip** You may also click **Search** from any page on a workflow.

**Step 2** From the table drop-down list, choose the type of event or data to search.

**Step 3** Choose the search you want to load from the **Custom Searches** list or the **Predefined Searches** list.

**Step 4** If you want to use different search criteria, change the search constraints.

**Step 5** If you want to use a changed search again in the future, save the search as described in **Saving a Search**, on page 1559.

**Step 6** Click **Search**.

---

**Query Overrides Via the Shell**

System administrators can use a shell-based query management tool to locate and stop long-running queries.

The query management tool allows you to locate queries running longer than a specified number of minutes and stop those queries. The tool logs an event to the audit log and to syslog when you stop a query.

Note that the only locally-created user with shell access on Firepower Management Centers is the **admin** user. If you use an external authentication object which grants shell access, users matching the shell access filter can also log into the shell.

---

**Note** Leaving the search page in the web interface does not stop a query. Queries that take a long time to return results impact overall system performance while the query is running.

---

**Shell-Based Query Management Syntax**

Use the following syntax to manage long-running queries:

```
query_manager [-v] [-l [minutes]] [-k query_id [...]] [--kill-all minutes]
```

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h, --help</td>
<td>Prints a brief help message.</td>
</tr>
<tr>
<td>-l, --list [minutes]</td>
<td>Lists all queries taking longer than passed-in minutes. By default it will show all queries taking longer than 1 minute.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-k, --kill query_id [...]</td>
<td>Kills the query with the passed-in id. The option can take multiple ids.</td>
</tr>
<tr>
<td>--kill-all minutes</td>
<td>Kills all queries taking longer than passed-in minutes.</td>
</tr>
<tr>
<td>-v, --verbose</td>
<td>Verbose output including full SQL queries.</td>
</tr>
</tbody>
</table>

Caution
Shell access should be limited to system administrators.

Stopping Long-Running Queries

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>admin or other user-granted shell access</td>
</tr>
</tbody>
</table>

Procedure

Step 1
Connect to the Firepower Management Center via ssh.

Step 2
Run query_manager under sudo using the syntax described in Shell-Based Query Management Syntax, on page 1560.
CHAPTER 82

Custom Workflows

The following topics describe how to use custom workflows:

• Introduction to Custom Workflows, on page 1563
• Saved Custom Workflows, on page 1563
• Custom Workflow Creation, on page 1564
• Custom Workflow Use and Management, on page 1568

Introduction to Custom Workflows

If the predefined and Cisco-provided custom workflows do not meet your needs, you can create and manage custom workflows.

Custom workflows are workflows that you create to meet the unique needs of your organization. When you create a custom workflow, you choose the kind of event (or database table) on which the workflow is based. On the Firepower Management Center, you can base a custom workflow on a custom table. You can also choose the pages a custom workflow contains; custom workflows can contain drill-down, table view, and host or packet view pages.

If your event evaluation process changes, you can edit custom workflows to meet your new needs. Note that you cannot edit any of the predefined workflows.

Tip
You can set a custom workflow as the default workflow for any event type.

Saved Custom Workflows

In addition to predefined workflows, which cannot be modified, the Firepower Management Center includes several saved custom workflows. Each of these workflows is based on a custom table and can be modified.

In a multidomain deployment, these saved workflows belong to the Global domain and cannot be modified in lower domains.
### Custom Workflow Creation

If the predefined and Cisco-provided custom workflows do not meet your needs, you can create custom workflows.

---

**Table 259: Saved Custom Workflows**

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events by Impact, Priority, and Host Criticality</td>
<td>You can use this workflow to quickly pick out and focus in on hosts that are important to your network, currently vulnerable, and possibly currently under attack. This workflow is based on the Intrusion Events with Destination Criticality custom table.</td>
</tr>
<tr>
<td>Events by Priority and Classification</td>
<td>This workflow lists events and their type in order of event priority, along with a count showing how many times each event has occurred. This workflow is based on the Intrusion Events custom table.</td>
</tr>
<tr>
<td>Events with Destination, Impact, and Host Criticality</td>
<td>You can use this workflow to find the most recent attacks on hosts that are important to your network and currently vulnerable. This workflow is based on the Intrusion Events with Destination Criticality custom table.</td>
</tr>
<tr>
<td>Hosts with Servers Default Workflow</td>
<td>You can use this workflow to quickly view the basic information in the Hosts with Servers custom table. This workflow is based on the Hosts with Servers custom table.</td>
</tr>
<tr>
<td>Intrusion Events with Destination Criticality Default Workflow</td>
<td>You can use this workflow to quickly view the basic information in the Intrusion Events with Destination Criticality custom table. This workflow is based on the Intrusion Events with Destination Criticality custom table.</td>
</tr>
<tr>
<td>Intrusion Events with Source Criticality Default Workflow</td>
<td>You can use this workflow to quickly view the basic information in the Intrusion Events with Source Criticality custom table. This workflow is based on the Intrusion Events with Source Criticality custom table.</td>
</tr>
<tr>
<td>Server and Host Details</td>
<td>You can use this workflow to determine what servers are most frequently used on your network and which hosts are running those servers. This workflow is based on the Hosts with Servers custom table.</td>
</tr>
</tbody>
</table>
Instead of creating a new custom workflow, you can export a custom workflow from another appliance and then import it onto your appliance. You can then edit the imported workflow to suit your needs.

When you create a custom workflow, you:

- Select a table to be the source of the workflow
- Provide a workflow name
- Add drill-down pages and table view pages to the workflow

For each drill-down page in the workflow, you can:

- Provide a name that appears at the top of the page in the web interface
- Include up to five columns per page
- Specify a default sort order, ascending or descending

You can add table view pages in any position in the sequence of workflow pages. They do not have any editable properties, such as a page name, sort order, or user-definable column positions.

You must add at least one drill-down page or a table view of events to a custom workflow.

If you selected **Vulnerabilities** as the table type, then add **IP Address** as a table column, the IP Address column does not appear when you are viewing vulnerabilities using your custom workflow, unless you use the search feature to constrain the workflow to view a specific IP address or block of addresses.

The final page of a custom workflow depends on the table on which you base the workflow, as described in the following table. These final pages are added by default when you create the workflow.

<table>
<thead>
<tr>
<th>Event/Asset Type</th>
<th>Final Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery events</td>
<td>Hosts</td>
</tr>
<tr>
<td>Vulnerabilities</td>
<td>Vulnerability detail</td>
</tr>
<tr>
<td>Third-party vulnerabilities</td>
<td>Hosts</td>
</tr>
<tr>
<td>Users</td>
<td>Users</td>
</tr>
<tr>
<td>Indications of compromise</td>
<td>Hosts</td>
</tr>
<tr>
<td>Intrusion events</td>
<td>Packets</td>
</tr>
</tbody>
</table>

The system does not add a final page to custom workflows based on other kinds of events (for example, audit log or malware events).
Custom workflows based on connection data are like other custom workflows, except you can include drill-down pages containing connection summary data, and connection data graph pages as well as drill-down pages containing data for individual connections and table view pages.

## Creating Custom Workflows Based on Non-Connection Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1** Choose **Analysis > Custom > Custom Workflows**.

**Step 2** Click **Create Custom Workflow**.

**Step 3** Enter a name for the workflow in the **Name** field.

**Step 4** Optionally, enter a **Description**.

**Step 5** Choose the table you want to include from the **Table** drop-down list.

**Step 6** If you want to add one or more drill-down pages to the workflow, click **Add Page**.

**Step 7** Enter a name for the page in the **Page Name** field.

**Step 8** Under Column 1, choose a sort priority and a table column. This column will appear in the leftmost column of the page.

**Example:**

For example, to create a page showing the destination ports that are targeted, and to sort the page by count, choose 2 from the **Sort Priority** drop-down list and **Destination Port/ICMP Code** from the **Field** drop-down list.

**Step 9** Continue choosing fields to include and setting their sort priority until you have specified all the fields you want to appear on the page.

**Step 10** If you want to add a table view page to the workflow, click **Add Table View**.

**Step 11** Click **Save**.

## Creating Custom Connection Data Workflows

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Custom workflows based on connection data are like other custom workflows, except you can include connection data graph pages as well as drill-down pages and table view pages. You can include as many of each type of page in the workflow as you want, in any order. Each connection data graph page contains a single graph, which can be a line graph, bar graph, or pie chart. On line and bar graphs, you may include more than one dataset.
**Procedure**

**Step 1**  Choose **Analysis > Custom > Custom Workflows**.

**Step 2**  Click **Create Custom Workflow**.

**Step 3**  Enter a name for the workflow in the **Name** field.

**Step 4**  Optionally, enter a **Description**.

**Step 5**  From the **Table** drop-down list, choose **Connection Events**.

**Step 6**  If you want to add one or more drill-down pages to the workflow, you have two options:

- Click **Add Page** to add a drill-down page that contains data on individual connections,
- Click **Add Summary Page** to add a drill-down page that contains connection summary data.

**Step 7**  Enter a name for the page in the **Page Name** field.

**Step 8**  Under **Column 1**, choose a sort priority and a table column. This column will appear in the leftmost column of the page.

**Step 9**  Continue choosing fields to include and setting their sort priority until you have specified all the fields you want to appear on the page.

**Example:**

For example, to create a page showing the amount of traffic transmitted over your monitored network and to sort the page by the responders that transmitted the most traffic, choose **1** from the **Sort Priority** drop-down list and **Responder Bytes** from the **Field** drop-down list.

**Step 10**  If you want to add one or more graph pages to the workflow, click **Add Graph**.

**Step 11**  Enter a name for the page in the **Graph Name** field.

**Step 12**  Choose the type of graph you want to include on the page:

- line graph
- bar graph
- pie chart

**Step 13**  Specify what kind of data you want to graph by choosing the x- and y-axes of the graph.

On a pie chart, the x-axis represents the independent variable and the y-axis represents the dependent variable.

**Step 14**  Choose the datasets you want to include on the graph.

Note that pie charts can include only one data set.

**Step 15**  If you want to add a table view of connection data, click **Add Table View**.

Table views are not configurable.

**Step 16**  Click **Save**.
Custom Workflow Use and Management

The method you use to view a workflow depends on whether the workflow is based on one of the predefined event tables or on a custom table.

If your custom workflow is based on a predefined event table, access it in the same way that you would access a workflow that ships with the appliance. For example, to access a custom workflow based on the Hosts table, choose Analysis > Hosts > Hosts. If, on the other hand, your custom workflow is based on a custom table, you must access it from the Custom Tables page.

If your event evaluation process changes, you can edit custom workflows to meet your new needs. Note that you cannot edit any of the predefined workflows.

**Tip**
You can set a custom workflow as the default workflow for any event type.

Viewing Custom Workflows Based on Predefined Tables

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint/Any Security Analyst (depending on workflow)</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose the appropriate menu path and option for the table on which you based your custom workflow, as described in the Workflow Selection, on page 1525.

**Step 2** To use a different workflow, including a custom workflow, click (switch workflow) next to the current workflow title.

**Step 3** If no events appear and the workflow can be constrained by time, you may need to adjust the time range; see Event Time Constraints, on page 1540.

Viewing Custom Workflows Based on Custom Tables

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays custom workflows created in the current domain, which you can edit. It also displays custom workflows created in ancestor domains, which you cannot edit. To view and edit custom workflows in a lower domain, switch to that domain.
Procedure

**Step 1** Choose Analysis > Custom > Custom Tables.

**Step 2** Click the view icon ( ) next to the custom table you want to view, or click the name of the custom table.

**Step 3** To use a different workflow, including a custom workflow, click (switch workflow) beside the current workflow title.

**Step 4** If no events appear and the workflow can be constrained by time, you may need to adjust the time range; see Event Time Constraints, on page 1540.

---

**Editing Custom Workflows**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays custom workflows created in the current domain, which you can edit. It also displays custom workflows created in ancestor domains, which you cannot edit. To view and edit custom workflows in a lower domain, switch to that domain.

Procedure

**Step 1** Choose Analysis > Custom > Custom Workflows.

**Step 2** Click the edit icon ( ) next to the name of the workflow that you want to edit.

If a view icon ( ) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Make any changes that you want to the workflow.

**Step 4** Click Save.
Custom Tables

The following topics describe how to use custom tables:

• Introduction to Custom Tables, on page 1571
• Predefined Custom Tables, on page 1571
• User-Defined Custom Tables, on page 1576
• Searching Custom Tables, on page 1579

Introduction to Custom Tables

As the Firepower System collects information about your network, the Firepower Management Center stores it in a series of database tables. When you use a workflow to view the resulting information, the Firepower Management Center pulls the data from one of these tables. For example, the columns on each page of the Network Applications by Count workflow are taken from the fields in the Applications table.

If you determine that your analysis of the activity on your network would be enhanced by combining fields from different tables, you can create a custom table. For example, you could combine the host criticality information from the predefined Host Attributes table with the fields from the predefined Connection Data table and then examine connection data in a new context.

Note that you can create custom workflows for either predefined or custom tables.

Predefined Custom Tables

Custom tables contain fields from two or more predefined tables. The Firepower System is delivered with a number of system-defined custom tables, but you can create additional custom tables that contain only information that matches your specific needs.

For example, the Firepower System is delivered with system-defined custom tables that correlate intrusion event data with host data, so you can search for events that impact critical systems and view the results of that search in one workflow.

In a multidomain deployment, the predefined custom tables belong to the Global domain and cannot be modified in lower domains.

The following table describes the custom tables provided with the system.
Table 261: System-Defined Custom Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts with Servers</td>
<td>Includes fields from the Hosts and Servers tables, providing you with information about the detected applications running on your network, as well as basic operating system information about the hosts running those applications.</td>
</tr>
<tr>
<td>Intrusion Events with Destination Criticality</td>
<td>Includes fields from the Intrusion Events table and the Hosts table, providing you with information on the intrusion events, as well as the host criticality of the destination host involved in each intrusion event.</td>
</tr>
<tr>
<td></td>
<td>You can use this table to search for intrusion events involving destination hosts with high host criticality.</td>
</tr>
<tr>
<td>Intrusion Events with Source Criticality</td>
<td>Includes fields from the Intrusion Events table and the Hosts table, providing you with information on the intrusion events and the host criticality of the source host involved in each intrusion event.</td>
</tr>
<tr>
<td></td>
<td>You can use this table to search for intrusion events involving source hosts with high host criticality.</td>
</tr>
</tbody>
</table>

Possible Table Combinations

When you create a custom table, you can combine fields from predefined tables that have related data. The following table lists the predefined tables you can combine to create a new custom table. Keep in mind that you can create a custom table that combines fields from more than two predefined custom tables.

Table 262: Custom Table Combinations

<table>
<thead>
<tr>
<th>You can combine fields from...</th>
<th>With fields from...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications</td>
<td>• Correlation Events</td>
</tr>
<tr>
<td></td>
<td>• Intrusion Events</td>
</tr>
<tr>
<td></td>
<td>• Connection Summary Data</td>
</tr>
<tr>
<td></td>
<td>• Host Attributes</td>
</tr>
<tr>
<td></td>
<td>• Application Details</td>
</tr>
<tr>
<td></td>
<td>• Discovery Events</td>
</tr>
<tr>
<td></td>
<td>• Connection Events</td>
</tr>
<tr>
<td></td>
<td>• Hosts</td>
</tr>
<tr>
<td></td>
<td>• Servers</td>
</tr>
<tr>
<td></td>
<td>• White List Events</td>
</tr>
<tr>
<td>You can combine fields from...</td>
<td>With fields from...</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Correlation Events</td>
<td>• Applications</td>
</tr>
<tr>
<td></td>
<td>• Host Attributes</td>
</tr>
<tr>
<td></td>
<td>• Hosts</td>
</tr>
<tr>
<td>Intrusion Events</td>
<td>• Applications</td>
</tr>
<tr>
<td></td>
<td>• Host Attributes</td>
</tr>
<tr>
<td></td>
<td>• Hosts</td>
</tr>
<tr>
<td></td>
<td>• Servers</td>
</tr>
<tr>
<td>Connection Summary Data</td>
<td>• Applications</td>
</tr>
<tr>
<td></td>
<td>• Host Attributes</td>
</tr>
<tr>
<td></td>
<td>• Hosts</td>
</tr>
<tr>
<td></td>
<td>• Servers</td>
</tr>
<tr>
<td>Indications of Compromise</td>
<td>• Applications</td>
</tr>
<tr>
<td></td>
<td>• Application Details</td>
</tr>
<tr>
<td></td>
<td>• Captured Files</td>
</tr>
<tr>
<td></td>
<td>• Connection Events</td>
</tr>
<tr>
<td></td>
<td>• Connection Summary Data</td>
</tr>
<tr>
<td></td>
<td>• Correlation Events</td>
</tr>
<tr>
<td></td>
<td>• Discovery Events</td>
</tr>
<tr>
<td></td>
<td>• Host Attributes</td>
</tr>
<tr>
<td></td>
<td>• Hosts</td>
</tr>
<tr>
<td></td>
<td>• Intrusion Events</td>
</tr>
<tr>
<td></td>
<td>• Security Intelligence Events</td>
</tr>
<tr>
<td></td>
<td>• Servers</td>
</tr>
<tr>
<td></td>
<td>• White List Events</td>
</tr>
<tr>
<td>You can combine fields from...</td>
<td>With fields from...</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Host Attributes</td>
<td>• Applications</td>
</tr>
<tr>
<td></td>
<td>• Correlation Events</td>
</tr>
<tr>
<td></td>
<td>• Intrusion Events</td>
</tr>
<tr>
<td></td>
<td>• Connection Summary Data</td>
</tr>
<tr>
<td></td>
<td>• Application Details</td>
</tr>
<tr>
<td></td>
<td>• Discovery Events</td>
</tr>
<tr>
<td></td>
<td>• Connection Events</td>
</tr>
<tr>
<td></td>
<td>• Hosts</td>
</tr>
<tr>
<td></td>
<td>• Servers</td>
</tr>
<tr>
<td></td>
<td>• White List Events</td>
</tr>
<tr>
<td>Application Details</td>
<td>• Applications</td>
</tr>
<tr>
<td></td>
<td>• Host Attributes</td>
</tr>
<tr>
<td></td>
<td>• Hosts</td>
</tr>
<tr>
<td>Discovery Events</td>
<td>• Applications</td>
</tr>
<tr>
<td></td>
<td>• Host Attributes</td>
</tr>
<tr>
<td></td>
<td>• Hosts</td>
</tr>
<tr>
<td>Connection Events</td>
<td>• Applications</td>
</tr>
<tr>
<td></td>
<td>• Host Attributes</td>
</tr>
<tr>
<td></td>
<td>• Hosts</td>
</tr>
<tr>
<td></td>
<td>• Servers</td>
</tr>
<tr>
<td>Security Intelligence Events</td>
<td>• Applications</td>
</tr>
<tr>
<td></td>
<td>• Host Attributes</td>
</tr>
<tr>
<td></td>
<td>• Hosts</td>
</tr>
<tr>
<td></td>
<td>• Servers</td>
</tr>
</tbody>
</table>
Sometimes a field in one table maps to more than one field in another table. For example, the predefined **Intrusion Events with Destination Criticality** custom table combines fields from the Intrusion Events table and the Hosts table. Each event in the Intrusion Events table has two IP addresses associated with it—a source IP address and a destination IP address. However, the “events” in the Hosts table each represent a single host IP address (hosts may have multiple IP addresses). Therefore, when you create a custom table based on the Intrusion Events table and the Hosts table, you must choose whether the data you display from the Hosts table applies to the host source IP address or the host destination IP address in the Intrusion Events table.

When you create a new custom table, a default workflow that displays all the columns in the table is automatically created. Also, just as with predefined tables, you can search custom tables for data that you want to use in your network analysis. You can also generate reports based on custom tables, as you can with predefined tables.
User-Defined Custom Tables

Instead of creating a new custom table, you can export a custom table from another Firepower Management Center, then import it onto your Firepower Management Center.

To create a custom table, decide which predefined tables delivered with the Firepower System contain the fields you want to include in your custom table. You can then choose which fields you want to include and, if necessary, configure field mappings for any common fields.

Data involving the Hosts table allows you to view data associated with all IP addresses from one host, rather than one specific IP address.

For example, consider a custom table that combines fields from the Correlation Event table and the Hosts table. You can use this custom table to get detailed information about the hosts involved in violations of any of your correlation policies. Note that you must decide whether to display data from the Hosts table that matches the source IP address or the destination IP address in the Correlation Event table.

If you view the table view of events for this custom table, it displays correlation events, one per row. You can configure the custom table to include the following information:

- the date and time the event was generated
- the name of the correlation policy that was violated
- the name of the rule that triggered the violation
- the IP address associated with the source, or initiating, host involved in the correlation event
- the source host’s NetBIOS name
- the operating system and version the source host is running
- the source host criticality

You could create a similar custom table that displays the same information for destination, or responding, hosts.

Creating a Custom Table

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any/Admin</td>
</tr>
</tbody>
</table>
### Procedure

**Step 1** Choose Analysis > Custom > Custom Tables.

**Step 2** Click Create Custom Table.

**Step 3** In the Name field, enter a name for the custom table.

**Example:**
For example, you might enter Correlation Events with Host Information (Src IP).

**Step 4** From the Tables drop-down list, choose Correlation Events.

**Step 5** Under Fields, choose Time and click Add to add the date and time when a correlation event was generated.

**Step 6** Repeat step 5 to add the Policy and Rule fields.

**Tip** You can use Ctrl or Shift while clicking to choose multiple fields. You can also click and drag to choose multiple adjacent values. However, if you want to specify the order the fields appear in the table view of events associated with the table, add the fields one at a time.

**Step 7** From the Tables drop-down list, choose Hosts.

**Step 8** Add the IPAddress, NetBIOS Name, OS Name, OS Version, and Host Criticality fields to the custom table.

**Step 9** Under Common Fields, next to Correlation Events, choose Source IP.

Your custom table is configured to display the host information you chose in step 8 for the source, or initiating, hosts involved in correlation events.

**Tip** You can create a custom table that displays detailed host information for the destination, or responding, hosts involved in a correlation event by following this procedure but choosing Destination IP instead of Source IP.

**Step 10** Click Save.

---

### Modifying a Custom Table

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any/Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays custom tables created in the current domain, which you can edit. It also displays custom tables created in ancestor domains, which you cannot edit. To view and edit custom tables in a lower domain, switch to that domain.

**Procedure**

**Step 1** Choose Analysis > Custom > Custom Tables.

**Step 2** Click the edit icon (✎) next to the table you want to edit.
If a view icon (ço) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

**Step 3** Optionally, remove fields from the table by clicking the delete icon (ço) next to the fields you want to remove.

**Note** If you delete fields currently in use in reports, the system will prompt you to confirm that you want to remove the sections using those fields from those reports.

**Step 4** Make other changes as needed.

**Step 5** Click Save.

### Deleting a Custom Table

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any/Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays custom tables created in the current domain, which you can delete. It also displays custom tables created in ancestor domains, which you cannot delete. To delete custom tables in a lower domain, switch to that domain.

**Procedure**

**Step 1** Choose **Analysis > Custom > Custom Tables**.

**Step 2** Click the delete icon (ço) next to the custom table you want to delete.

If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

### Viewing a Workflow Based on a Custom Table

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any/Admin</td>
</tr>
</tbody>
</table>

When you create a custom table, the system automatically creates a default workflow for it. The first page of this workflow displays a table view of events. If you include intrusion events in your custom table, the second page of the workflow is the packet view. Otherwise, the second page of the workflow is a hosts page. You can also create your own custom workflows based on your custom table.

**Tip** If you create a custom workflow based on a custom table, you can specify it as the default workflow for that table.
You can use the same techniques to view events in your custom table that you use for event views based on predefined tables.

In a multidomain deployment, the system displays custom tables created in the current domain, which you can edit. It also displays custom tables created in ancestor domains, which you cannot edit. To view and edit custom tables in a lower domain, switch to that domain.

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Choose Analysis &gt; Custom &gt; Custom Tables.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click the view icon (🔍) next to the custom table related to the workflow you want to see.</td>
</tr>
</tbody>
</table>

### Searching Custom Tables

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any/Admin</td>
</tr>
</tbody>
</table>

In a multidomain deployment, the system displays custom tables created in the current domain, which you can edit. It also displays custom tables created in ancestor domains, which you cannot edit. To view and edit custom tables in a lower domain, switch to that domain.

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Choose Analysis &gt; Custom &gt; Custom Tables.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click the view icon (🔍) next to the custom table you want to search.</td>
</tr>
</tbody>
</table>

**Tip** To use a different workflow, including a custom workflow, click (switch workflow) next to the workflow title.

<table>
<thead>
<tr>
<th>Step 3</th>
<th>Click Search.</th>
</tr>
</thead>
</table>

**Tip** To search the database for a different kind of event or data, choose it from the table drop-down list.

| Step 4 | Enter your search criteria in the appropriate fields.  
If you enter criteria for multiple fields, the search returns only the records that match search criteria specified for all fields. |
|-------|----------------------------------------------------------------------|

**Tip** Click the object icon (➕) next to a search field to use an object as a search criterion.

| Step 5 | Optionally, if you plan to save the search, you can check the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users. |

**Tip** If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
Step 6 Optionally, you can save the search to be used again in the future. You have the following options:

- Click **Save** to save the search criteria. The search is visible only to your account if you checked the **Private** check box.
- Click **Save As New** to save a new search or assign a name to a search you created by altering a previously-saved search. The search is saved and visible only to your account if you checked the **Private** check box.

Step 7 Click **Search** to start the search.

Your search results appear in the default workflow for the custom table, constrained by the current time range (if applicable).
Events and Assets

• Connection Logging, on page 1583
• Connection and Security Intelligence Events, on page 1595
• Working with Intrusion Events, on page 1621
• File/Malware Events and Network File Trajectory, on page 1669
• Using Host Profiles, on page 1699
• Working with Discovery Events, on page 1727
• Correlation and Compliance Events, on page 1779
• Auditing the System, on page 1791
Connection Logging

The following topics describe how to configure the Firepower System to log connections made by hosts on your monitored network:

- About Connection Logging, on page 1583
- Connection Logging Strategies, on page 1590
- Logging Decryptable Connections with SSL Rules, on page 1591
- Logging Connections with Security Intelligence, on page 1591
- Logging Connections with Access Control Rules, on page 1592
- Logging Connections with a Policy Default Action, on page 1593
- Limiting Logging of Long URLs, on page 1594

About Connection Logging

The system can generate logs of the connections its managed devices detect. These logs are called connection events. Settings in rules and policies give you granular control over which connections you log, when you log them, and where you store the data. Special connection events, called Security Intelligence events, represent connections blacklisted (blocked) by the reputation-based Security Intelligence feature.

Connection events contain data about the detected sessions. The information available for any individual connection event depends on several factors, but in general includes:

- Basic connection properties: timestamp, source and destination IP address, ingress and egress zones, the device that handled the connection, and so on
- Additional connection properties discovered or inferred by the system: applications, requested URLs, or users associated with the connection, and so on
- Metadata about why the connection was logged: which configuration handled the traffic, whether the connection was allowed or blocked, details about encrypted and decrypted connections, and so on

Log connections according to the security and compliance needs of your organization. When setting up connection logging, keep in mind that the system can log a connection for multiple reasons, and that disabling logging in one place does not mean that matching connections will not be logged.

The information in a connection event depends on several factors, including traffic characteristics, the configuration that ultimately handled the connection, and so on.
You can supplement the connection logs gathered by your managed devices with connection data generated from exported NetFlow records. This is especially useful if you have NetFlow-enabled routers or other devices deployed on networks that your Firepower System managed devices cannot monitor.

**Related Topics**

- Netflow Data in the Firepower System, on page 1203

### Other Connections You Can Log

So that you log only critical connections, enable connection logging on a per-rule basis. If you enable connection logging for a rule, the system logs all connections handled by that rule.

You can also log connections handled by policy default actions. Depending on the rule or default action (and for access control, a rule's inspection configuration), your logging options differ.

**SSL Policy: Rules and Default Action**

You can log connections that match an SSL rule or SSL policy default action.

For blocked connections, the system immediately ends the session and generates an event. For monitored connections and connections that you pass to access control rules, the system generates an event when the session ends.

**Access Control Policy: Security Intelligence Decisions**

You can log a connection whenever it is blacklisted (blocked) by the reputation-based Security Intelligence feature.

Optionally, and recommended in passive deployments, you can use a monitor-only setting for Security Intelligence filtering. This allows the system to further analyze connections that would have been blacklisted, but still log the match to the blacklist. Security Intelligence monitoring also allows you to create traffic profiles using Security Intelligence information.

When the system logs a connection event as the result of Security Intelligence filtering, it also logs a matching Security Intelligence event, which is a special kind of connection event that you can view and analyze separately, and that is also stored and pruned separately. So that you can identify the blacklisted IP address in the connection, host icons next to blacklisted and monitored IP addresses look slightly different in the tables on the pages under the Analysis > Connections menus.

**Access Control Policy: Rules and Default Action**

You can log connections that match an access control rule or access control policy default action.

**Related Topics**

- How Rules and Policy Actions Affect Logging, on page 1587

### Connections That Are Always Logged

Unless you disable connection event storage, the system automatically saves the following end-of-connection events to the Firepower Management Center database, regardless of any other logging configurations.
Connections Associated with Intrusions

The system automatically logs connections associated with intrusion events, unless the connection is handled by the access control policy's default action.

When an intrusion policy associated with the access control default action generates an intrusion event, the system does not automatically log the end of the associated connection. Instead, you must explicitly enable default action connection logging. This is useful for intrusion prevention-only deployments where you do not want to log any connection data.

However, if you enable beginning-of-connection logging for the default action, the system does log the end of the connection when an associated intrusion policy triggers, in addition to logging the beginning of the connection.

Connections Associated with File and Malware Events

The system automatically logs connections associated with file and malware events.

Note

File events generated by inspecting NetBIOS-SSN (SMB) traffic do not immediately generate connection events because the client and server establish a persistent connection. The system generates connection events after the client or server ends the session.

Connections Associated with Intelligent Application Bypass

The system automatically logs bypassed and would-have-bypassed connections associated with IAB.

Monitored Connections

The system always logs the ends of connections for monitored traffic, even if the traffic matches no other rules and you do not enable default action logging. For more information, see Logging for Monitored Connections, on page 1587.

Beginning vs End-of-Connection Logging

You can log a connection at its beginning or its end, with the following exceptions for blocked traffic:

- Blocked traffic—Because blocked traffic is immediately denied without further inspection, usually you can log only beginning-of-connection events for blocked or blacklisted traffic. There is no unique end of connection to log.

- Blocked encrypted traffic—When you enable connection logging in an SSL policy, the system logs end-of-connection rather than beginning-of-connection events. This is because the system cannot determine if a connection is encrypted using the first packet in the session, and thus cannot immediately block encrypted sessions.

To optimize performance, log either the beginning or the end of any connection, but not both. Monitoring a connection for any reason forces end-of-connection logging. For a single non-blocked connection, the end-of-connection event contains all of the information in the beginning-of-connection event, as well as information gathered over the duration of the session.

The following table details the differences between beginning and end-of-connection events, including the advantages to logging each.
### Table 263: Comparing Beginning and End-of-Connection Events

<table>
<thead>
<tr>
<th>Can be generated...</th>
<th>Beginning-of-Connection Events</th>
<th>End-of-Connection Events</th>
</tr>
</thead>
</table>
| When the system detects the beginning of a connection (or, after the first few packets if event generation depends on application or URL identification) | When the system: | • Detects the close of a connection  
• Does not detect the end of a connection after a period of time  
• Can no longer track the session due to memory constraints |
| Can be logged for... | All connections except those blocked by the SSL policy | Most connections |
| Contain... | Only information that can be determined in the first packet (or the first few packets, if event generation depends on application or URL identification) | All information in the beginning-of-connection event, plus information determined by examining traffic over the duration of the session; for example, the total amount of data transmitted or the timestamp of the last packet in the connection |
| Are useful... | If you want to log: | If you want to: |
| | • Blocked connections  
• Only the beginning of a connection because the end-of-connection information does not matter to you | • Log encrypted connections handled by an SSL policy  
• Perform any kind of detailed analysis on, or trigger correlation rules using, information collected over the duration of the session  
• View connection summaries (aggregated connection data) in custom workflows, view connection data in graphical format, or create and use traffic profiles |

**Firepower Management Center vs External Logging**

If you store connection and Security Intelligence event logs on the Firepower Management Center, you can use the Firepower System's reporting, analysis, and data correlation features. For example:
Dashboards and the Context Explorer provide you with graphical, at-a-glance views of the connections logged by the system.

Event views (most of the options available under the Analysis menu) present detailed information on the connections logged by the system, which you can display in a graphical or tabular format or summarize in a report.

Traffic profiling uses connection data to create a profile of your normal network traffic that you can then use as a baseline against which to detect and track anomalous behavior.

Correlation policies allow you to generate events and trigger responses (such as alerts or external remediations) to specific types of connections or traffic profile changes.

The number of events the Firepower Management Center can store depends on its model.

Note
To use these features, you must log connections (and in most cases, the end of those connections rather than the beginning). This is why the system automatically logs critical connections—those associated with logged intrusions, prohibited files, and malware.

You can also log events to an external syslog or SNMP trap server, using a connection you configure called an alert response.

Related Topics
Firepower Management Center Alert Responses, on page 1453

How Rules and Policy Actions Affect Logging

Connection events contain metadata about why the connection was logged, including which configurations handled the traffic. Where you can configure connection logging, rule actions, and policy default actions determine not only how the system inspects and handles matching traffic, but also when and how you can log details about matching traffic.

Related Topics
TLS/SSL Rule Actions, on page 750
Access Control Rule Actions, on page 648
Connection and Security Intelligence Event Fields, on page 1597

Logging for Monitored Connections

The system always logs the ends of connections for traffic matching the following configurations, even if the traffic matches no other rules and you do not enable default action logging:

- Security Intelligence—Blacklists set to monitor (also generates a Security Intelligence event)
- SSL rules—Monitor action
- Access control rules—Monitor action

The system does not generate a separate event each time a single connection matches a Monitor rule. Because a single connection can match multiple Monitor rules, each connection event can include and display information on the first eight Monitor access control rules that the connection matches, as well as the first matching SSL Monitor rule.
Similarly, if you send connection events to an external syslog or SNMP trap server, the system does not send a separate alert each time a single connection matches a Monitor rule. Rather, the alert that the system sends at the end of the connection contains information on the Monitor rules the connection matched.

Logging for Trusted Connections

You can log the beginnings and ends of trusted connections, which includes traffic matching the following rules and actions:

- Access control rules—**Trust** action
- Access control default action—**Trust All Traffic**

**Note**

Although you *can* log trusted connections, we recommend you do not do so because trusted connections are not subject to deep inspection or discovery, so connection events for trusted connections contain limited information.

The system logs TCP connections handled by a Trust access control rule differently depending on the device that detected the connection:

- For 7000 and 8000 Series devices, TCP connections detected by a Trust rule on the first packet generate different events depending on the presence of a preceding enabled Monitor rule. If the Monitor rule is active, the system evaluates the packet and generates both a beginning and end-of-connection event. If no Monitor rule is active, the system generates only an end-of-connection event.
- For all other models, TCP connections detected by a Trust rule on the first packet generate only an end-of-connection event. The system generates the event one hour after the final session packet.

Logging for Blocked Connections

You can log blocked connections, which includes traffic matching the following rules and actions:

- Security Intelligence—Blacklists set to block (also generates a Security Intelligence event)
- SSL rules—**Block** and **Block with reset**
- SSL default action—**Block** and **Block with reset**
- Access control rules—**Block**, **Block with reset**, and **Interactive Block**
- Access control default action—**Block All Traffic**

Only devices deployed inline (that is, using routed, switched, or transparent interfaces, or inline interface pairs) can block traffic. Because blocked connections are not actually blocked in passive deployments, the system may report multiple beginning-of-connection events for each blocked connection.

**Caution**

Logging blocked TCP connections during a Denial of Service (DoS) attack can affect system performance and overwhelm the database with multiple similar events. Before you enable logging for an Block rule, consider whether the rule monitors traffic on an Internet-facing interface or other interface vulnerable to DoS attack.
Beginning vs End-of-Connection Logging for Blocked Connections

When you log a blocked connection, how the system logs it depends on why the connection was blocked; this is important to keep in mind when configuring correlation rules based on connection logs:

- For SSL rules and SSL policy default actions that block encrypted traffic, the system logs end-of-connection events. This is because the system cannot determine if a connection is encrypted using the first packet in the session.

- For other blocking actions, the system logs beginning-of-connection events. Matching traffic is denied without further inspection.

Logging Bypassed Interactive Blocks

Interactive blocking access control rules, which cause the system to display a warning page when a user browses to a prohibited website, allow you to configure end-of-connection logging. This is because if the user clicks through the warning page, the connection is considered a new, allowed connection which the system can monitor and log.

Therefore, for packets that match an Interactive Block or Interactive Block with Reset rule, the system can generate the following connection events:

- A beginning-of-connection event when a user’s request is initially blocked and the warning page is displayed; this event has an associated action of Interactive Block or Interactive Block with Reset

- Multiple beginning- or end-of-connection events if the user clicks through the warning page and loads the originally requested page; these events have an associated action of Allow and a reason of User Bypass

The following figure shows an example of an interactive block followed by allow.

Logging for Allowed Connections

You can log allowed connections, which includes traffic matching the following rules and actions:

- SSL rules—Decrypt action
- SSL rules—Do not decrypt action
- SSL default action—Do not decrypt
- Access control rules—Allow action
- Access control default action—Network Discovery Only and any intrusion prevention option
Enabling logging for these configurations ensures the connection is logged, while also permitting (or specifying) the next phase of inspection and traffic handling. SSL logging is always end-of-connection; access control configurations also allow beginning-of-connection logging.

When you allow traffic with an access control rule or default action, you can use an associated intrusion policy to further inspect traffic and block intrusions. For access control rules, you can also use a file policy to detect and block prohibited files, incuding malware. Unless you disable connection event storage, the system automatically logs most allowed connections associated with intrusion, file, and malware events. For detailed information, see Connections That Are Always Logged, on page 1584.

Connections with encrypted payloads are not subject to deep inspection, so connection events for encrypted connections contain limited information.

File and Malware Event Logging for Allowed Connections

When a file policy detects or blocks a file, it logs one of the following events to the Firepower Management Center database:

- **File events**, which represent detected or blocked files, including malware files
- **Malware events**, which represent detected or blocked malware files only
- **Retrospective malware events**, which are generated when the malware disposition for a previously detected file changes

You can disable this logging on a per-access-control-rule basis. You can also disable file and malware event storage entirely.

---

**Note**

We recommend you leave file and malware event logging enabled.

---

### Connection Logging Strategies

Log connections according to the security and compliance needs of your organization. If your goal is to limit the number of events you generate and improve performance, enable logging only for the connections critical to your analysis. For a broad view of your network traffic for profiling purposes, enable logging for additional connections.

---

**Tip**

To perform detailed analysis of connection data, Cisco recommends you log the ends of critical connections to the Firepower Management Center database.

Because the system can log a connection for multiple reasons, disabling logging in one place does not ensure that matching connections will not be logged. Also, unless you disable connection event storage, the system automatically logs some connections; for example, those associated with detected files, malware, intrusions, and Intelligent Application Bypass (IAB).

You cannot log connections fastpathed with 8000 Series fastpath rules.
Logging Decryptable Connections with SSL Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any except NGIPSv</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 In the SSL policy editor, click the edit icon (📝) next to the rule where you want to configure logging.

If a view icon (🔍) appears instead, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 2 Click the **Logging** tab.

Step 3 Check **Log at End of Connection**.

For monitored traffic, end-of-connection logging is required.

Step 4 Specify where to send connection events.

Send events to the event viewer if you want to perform Firepower Management Center-based analysis on these connection events. For monitored traffic, this is required.

Step 5 Click **Save** to save the rule.

Step 6 Click **Save** to save the policy.

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Logging Connections with Security Intelligence

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network Admin</td>
</tr>
</tbody>
</table>

Procedure

Step 1 In the access control policy editor, click the **Security Intelligence** tab.
Step 2  Click the logging icons () to enable Security Intelligence logging using the following criteria:
  • By IP address—Click the logging icon next to Networks.
  • By URL—Click the logging icon next to URLs.
  • By Domain Name—Click the logging icon next to the DNS Policy drop-down list.

If the controls are dimmed, settings are inherited from an ancestor policy, or you do not have permission to modify the configuration. If the configuration is unlocked, uncheck Inherit from base policy to enable editing.

Step 3  Check the Log Connections check box.

Step 4  Specify where to send connection and Security Intelligence events.

Send events to the event viewer if you want to perform Firepower Management Center-based analysis, or if you want to set blacklisted objects to monitor-only.

Step 5  Click OK to set logging options.

Step 6  Click Save to save the policy.

What to do next
  • Deploy configuration changes; see Deploy Configuration Changes, on page 277.

Logging Connections with Access Control Rules

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access Admin/Network Admin</td>
</tr>
</tbody>
</table>

Depending on your choices for the rule action and deep inspection options, your logging options differ; see How Rules and Policy Actions Affect Logging, on page 1587.

Procedure

Step 1  In the access control policy editor, click the edit icon () next to the rule where you want to configure logging.

If a view icon () appears instead, the configuration is inherited from an ancestor policy, belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 2  Click the Logging tab.

Step 3  Specify whether you want to Log at Beginning of Connection or Log at End of Connection.

To optimize performance, log either the beginning or the end of any connection, but not both.

Step 4  (Optional) Check the Log Files check box to log file and malware events associated with the connection.

Cisco recommends you leave this option enabled.
Step 5 Specify where to send the connection events:

- **Event Viewer**: Send connection events to Firepower Management Center web interface if you want to perform Firepower Management Center-based analysis on these connection events, or if the rule action is Monitor.

- **Syslog Server**: Send connection events to the syslog server configured in the Logging tab in Access Control Policy, unless overridden.

- **SNMP Trap**: Connection events are sent to the selected SNMP trap.

Step 6 Click **Save** to save the rule.

---

What to do next

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.

---

### Logging Connections with a Policy Default Action

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

A policy's default action determines how the system handles traffic that matches none of the rules in the policy (except Monitor rules, which match and log—but do not handle or inspect—traffic).

Logging settings for the SSL policy default action also govern how the system logs undecryptable sessions.

**Procedure**

**Step 1** In the policy editor, click the logging icon (_rectangle) next to the Default Action drop-down list.

**Step 2** Specify when you want to log matching connections:

- Log at Beginning of Connection—Not supported for SSL default actions.
- Log at End of Connection—Not supported if you choose the access control Block All Traffic default action.

To optimize performance, log either the beginning or the end of any connection, but not both.

If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration. In an access control policy, the configuration may also be inherited from an ancestor policy.

**Step 3** Specify where to send connection events.

Send events to the event viewer if you want to perform Firepower Management Center-based analysis on these connection events.
Limiting Logging of Long URLs

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

End-of-connection events for HTTP traffic record the URL requested by monitored hosts. Disabling or limiting the number of stored URL characters may improve system performance. Disabling URL logging (storing zero characters) does not affect URL filtering. The system filters traffic based on requested URLs even though the system does not record them.

**Procedure**

**Step 1** In the access control policy editor, click the Advanced tab, then click the edit icon (📝) next to General Settings.

If a view icon (👁) appears instead, the configuration is inherited from an ancestor policy, belongs to an ancestor domain, or you do not have permission to modify the configuration. If the configuration is unlocked, uncheck Inherit from base policy to enable editing.

**Step 2** Enter the Maximum URL characters to store in connection events.

**Step 3** Click OK.

**Step 4** Click Save to save the policy.

**What to do next**

- Deploy configuration changes; see Deploy Configuration Changes, on page 277.
CHAPTER 85

Connection and Security Intelligence Events

The following topics describe how to use connection and security events tables.

- About Connection Events, on page 1595
- Connection and Security Intelligence Event Fields, on page 1597
- Using Connection and Security Intelligence Event Tables, on page 1615
- Viewing the Connection Summary Page, on page 1619

About Connection Events

The system can generate logs of the connections its managed devices detect. These logs are called connection events. Connection events include Security Intelligence events (connections blacklisted (blocked) by the reputation-based Security Intelligence feature.)

Connection events generally include transactions detected by:

- Access Control policies
- SSL policies
- Prefilter policies (captured by prefilter or tunnel rules)
- DNS blacklists
- URL blacklists
- Network (IP address) blacklists

Settings in rules and policies give you granular control over which connections you log, when you log them, and where you store the data.

For detailed information, see Connection Logging, on page 1583.

Related Topics

- About Security Intelligence, on page 675

Connection vs. Security Intelligence Events

A Security Intelligence event is a connection event that is generated whenever a session is blacklisted (blocked) or monitored by the reputation-based Security Intelligence feature.
However, for every Security Intelligence event, there is an identical connection event. You can view and analyze Security Intelligence events independently. The system also stores and prunes Security Intelligence events separately.

Note that the system enforces Security Intelligence before more resource-intensive evaluations. When a connection is blocked by Security Intelligence, the resulting event does not contain the information that the system would have gathered from subsequent evaluation, for example, user identity.

In this guide, information about connection events also pertains to Security Intelligence events, unless otherwise noted.

### NetFlow Connections

To supplement the connection data gathered by your managed devices, you can use records broadcast by NetFlow exporters to generate connection events. This is especially useful if the NetFlow exporters are monitoring different networks than those monitored by your managed devices.

The system logs NetFlow records as unidirectional end-of-connection events in the Firepower Management Center database. The available information for these connections differs somewhat from connections detected by your access control policy; see Differences between NetFlow and Managed Device Data, on page 1204.

**Related Topics**

Netflow Data in the Firepower System, on page 1203

### Connection Summaries (Aggregated Data for Graphs)

The Firepower System aggregates connection data collected over five-minute intervals into connection summaries, which the system uses to generate connection graphs and traffic profiles. Optionally, you can create custom workflows based on connection summary data, which you use in the same way as you use workflows based on individual connection events.

Note that there are no connection summaries specifically for Security Intelligence events, although corresponding end-of-connection events can be aggregated into connection summary data.

To be aggregated, multiple connections must:

- represent the end of connections
- have the same source and destination IP addresses, and use the same port on the responder (destination) host
- use the same protocol (TCP or UDP)
- use the same application protocol
- either be detected by the same Firepower System managed device or by the same NetFlow exporter

Each connection summary includes total traffic statistics, as well as the number of connections in the summary. Because NetFlow exporters generate unidirectional connections, a summary’s connection count is incremented by two for every connection based on NetFlow data.
Note that connection summaries do not contain all of the information associated with the summaries’ aggregated connections. For example, because client information is not used to aggregate connections into connection summaries, summaries do not contain client information.

**Long-Running Connections**

If a monitored session spans two or more five-minute intervals over which connection data is aggregated, the connection is considered a long-running connection. When calculating the number of connections in a connection summary, the system increments the count only for the five-minute interval in which a long-running connection was initiated.

Also, when calculating the number of packets and bytes transmitted by the initiator and responder in a long-running connection, the system does not report the number of packets and bytes that were actually transmitted during each five-minute interval. Instead, the system assumes a constant rate of transmission and calculates estimated figures based on the total number of packets and bytes transmitted, the length of the connection, and what portion of the connection occurred during each five-minute interval.

**Combined Connection Summaries from External Responders**

To reduce the space required to store connection data and speed up the rendering of connection graphs, the system combines connection summaries when:

- one of the hosts involved in the connection is not on your monitored network
- other than the IP address of the external host, the connections in the summaries meet the summary aggregation criteria

When viewing connection summaries in the Analysis > Connections submenu pages, and when working with connection graphs, the system displays external instead of an IP address for the non-monitored hosts.

As a consequence of this aggregation, if you attempt to drill down to the table view of connection data (that is, access data on individual connections) from a connection summary or graph that involves an external responder, the table view contains no information.

**Connection and Security Intelligence Event Fields**

**General Information**

**Access Control Policy (Syslog: ACPolicy)**

The access control policy that monitored the connection.

**Access Control Rule (Syslog: AccessControlRuleName)**

The access control rule or default action that handled the connection, as well as up to eight Monitor rules matched by that connection.

If the connection matched one Monitor rule, the Firepower Management Center displays the name of the rule that handled the connection, followed by the Monitor rule name. If the connection matched more than one Monitor rule, the number of matching Monitor rules is displayed, for example, Default Action + 2 Monitor Rules.

To display a pop-up window with a list of the first eight Monitor rules matched by the connection, click N Monitor Rules.
Action (Syslog: AccessControlRuleAction)

The action associated with the configuration that logged the connection.

For Security Intelligence-monitored connections, the action is that of the first non-Monitor access control rule triggered by the connection, or the default action. Similarly, because traffic matching a Monitor rule is always handled by a subsequent rule or by the default action, the action associated with a connection logged due to a Monitor rule is never Monitor. However, you can still trigger correlation policy violations on connections that match Monitor rules.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow</td>
<td>Connections either allowed by access control explicitly, or allowed because a user bypassed an interactive block.</td>
</tr>
<tr>
<td>Block, Block with reset</td>
<td>Blocked connections, including:</td>
</tr>
<tr>
<td></td>
<td>• connections blacklisted by Security Intelligence</td>
</tr>
<tr>
<td></td>
<td>• encrypted connections blocked by an SSL policy</td>
</tr>
<tr>
<td></td>
<td>• connections where an exploit was blocked by an intrusion policy</td>
</tr>
<tr>
<td></td>
<td>• connections where a file (including malware) was blocked by a file policy</td>
</tr>
<tr>
<td></td>
<td>For connections where the system blocks an intrusion or file, system displays Block, even though you use access control Allow rules to invoke deep inspection.</td>
</tr>
</tbody>
</table>

Interactive Block, Interactive Block with reset

Connections logged when the system initially blocks a user’s HTTP request using an Interactive Block rule. If the user clicks through the warning page that the system displays, additional connections logged for the session have an action of Allow.

Trust

Connections trusted by access control. The system logs trusted TCP connections differently depending on the device model.

Default Action

Connections handled by the access control policy’s default action.

Connections

The number of connections in a connection summary. For long-running connections, that is, connections that span multiple connection summary intervals, only the first connection summary interval is incremented. To view meaningful results for searches using the Connections criterion, use a custom workflow that has a connection summary page.

Count

The number of connections that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows. If you create a custom workflow and do not add the Count column to a drill-down page, each connection is listed individually and packets and bytes are not summed.

Endpoint Location

The IP address of the network device that used ISE to authenticate the user, as identified by ISE.

Endpoint Profile (Syslog: Endpoint Profile)

The user’s endpoint device type, as identified by ISE.
First Packet or Last Packet (Syslog: See the ConnectionDuration field)

The date and time the first or last packet of the session was seen.

Initiator/Responder Bytes (Syslog: InitiatorBytes, ResponderBytes)

The total number of bytes transmitted by the session initiator or received by the session responder.

Initiator/Responder Packets (Syslog: InitiatorPackets, ResponderPackets)

The total number of packets transmitted by the session initiator or received by the session responder.

Initiator User (Syslog: User)

In the Firepower Management Center web interface, this value constrains summaries and graphs. The user logged into the session initiator. If this field is populated with No Authentication, the user traffic:

• matched an access control policy without an associated identity policy
• did not match any rules in the identity policy

IOC

Whether the event triggered an indication of compromise (IOC) against a host involved in the connection.

Network Analysis Policy (Syslog: NAPPolicy)

The network analysis policy (NAP), if any, associated with the generation of the event.

Reason (Syslog: AccessControlRuleReason)

The reason or reasons the connection was logged, in many situations. For a full list, see Connection Event Reasons, on page 1609.

Connections with a Reason of IP Block, DNS Block, and URL Block have a threshold of 15 seconds per unique initiator-responder pair. After the system blocks one of those connections, it does not generate connection events for additional blocked connections between those two hosts for the next 15 seconds, regardless of port or protocol.

Security Context (Syslog: Context)

For connections handled by ASA FirePOWER in multiple context mode, the metadata identifying the virtual firewall group through which the traffic passed.

Security Group Tag (Syslog: Security Group)

The Security Group Tag (SGT) attribute of the packet involved in the connection. The SGT specifies the privileges of a traffic source within a trusted network. Security Group Access (a feature of both Cisco TrustSec and Cisco ISE) applies the attribute as packets enter the network.

Security Intelligence Category (Syslog: URLSICategory, DNSSICategory, IPReputationSICategory)

The name of the blacklisted object that represents or contains the blacklisted IP address in the connection. The Security Intelligence category can be the name of a network object or group, a blacklist, a custom Security Intelligence list or feed, or one of the categories in the Intelligence Feed.

In the Firepower Management Center web interface, DNS, Network (IP address), and URL Security Intelligence connection events are combined into a single category field. In syslog messages, those events are specific by type.
For more information about the categories in the Intelligence Feed, see Security Intelligence Options, on page 679.

TCP Flags (Syslog: TCPFlags)

For connections generated from NetFlow data, the TCP flags detected in the connection.

When searching this field, enter a list of comma-separated TCP flags to view all connections that have at least one of those flags.

Time

The ending time of the five-minute interval that the system used to aggregate connections in a connection summary. This field is not searchable.

Traffic (KB)

This field is available only as a search field.

The total amount of data transmitted in the connection, in kilobytes.

Total Packets

This field is available only as a search field.

The total number of packets transmitted in the connection.

Networking

Destination Port/ICMP Code (Syslog: Separate fields - DstPort, ICMPCode)

In the Firepower Management Center web interface, these values constrain summaries and graphs.

The port or ICMP code used by the session responder.

DNS Query (Syslog: DNSQuery)

The DNS query submitted in a connection to the name server to look up a domain name.

DNS Record Type (Syslog: DNSRecordType)

The type of the DNS resource record used to resolve a DNS query submitted in a connection.

DNS Response (Syslog: DNSResponseType)

The DNS response returned in a connection to the name server when queried.

DNS Sinkhole Name (Syslog: DNS_Sinkhole)

The name of the sinkhole server where the system redirected a connection.

DNS TTL (Syslog: DNS_TTL)

The number of seconds a DNS server caches the DNS resource record.

HTTP Response Code (Syslog: HTTPResponse)

The HTTP status code sent in response to a client's HTTP request over a connection.

Ingress/Egress Security Zone (Syslog: IngressZone, EgressZone)

The ingress or egress security zone associated with the connection.

Initiator/Responder IP (Syslog: SrcIP, DstIP)

In the Firepower Management Center web interface, these values constrain summaries and graphs.
The IP address (and host name, if DNS resolution is enabled) of the session initiator (source IP address) or responder (destination IP address).

In the Firepower Management Center web interface, host icons next to blacklisted IP addresses look slightly different so that you can identify the blacklisted IP address in a blacklisted connection.

**SecIntMatchingIP (Syslog Only)**

Which IP address matched.

Possible values: **None, Destination, or Source.**

**Original Client IP (Syslog: originalClientSrcIP)**

The original client IP address extracted from an X-Forwarded-For (XFF), True-Client-IP, or custom-defined HTTP header. To populate this field, you must enable the HTTP preprocessor Extract Original Client IP Address option in the network analysis policy. Also in the network analysis policy, you can specify up to six custom client IP headers, as well as set the priority order in which the system selects the value for the Original Client IP event field.

**Protocol (Syslog: Protocol)**

In the Firepower Management Center web interface:

- This value constrains summaries and graphs.
- This field is available only as a search field.

The transport protocol used in the connection. To search for a specific protocol, use the name or number protocol as listed in [http://www.iana.org/assignments/protocol-numbers](http://www.iana.org/assignments/protocol-numbers).

**Source Port/ICMP Type (Syslog: SrcPort, ICMPType)**

In the Firepower Management Center web interface, these values constrain summaries and graphs.

The port or ICMP type used by the session initiator.

**VLAN ID**

The innermost VLAN ID associated with the packet that triggered the connection.

**Geolocation**

**Initiator/Responder Country**

When a routable IP is detected, the country associated with the IP address of the session initiator or responder. The system displays an icon of the country’s flag, and the country’s ISO 3166-1 alpha-3 country code. Hover your pointer over the flag icon to view the country’s full name.

**Initiator/Responder Continent**

When a routable IP is detected, the continent associated with the IP address for the session initiator or responder.

**Device**

**Device**

In the Firepower Management Center web interface, this value constrains summaries and graphs.

The managed device that detected the connection or, for connections generated from NetFlow data, the managed device that processed the data.
Domain

The domain of the managed device that detected the connection or, for connections generated from NetFlow data, the domain of the managed device that processed the data. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

Ingress/Egress Interface (Syslog: IngressInterface, EgressInterface)

The ingress or egress interface associated with the connection. If your deployment includes an asymmetric routing configuration, the ingress and egress interface may not belong to the same inline pair.

SSL

SSL Actual Action (Syslog: SSLActualAction)

In the Firepower Management Center web interface, this field is a search field only.

The system displays field values in the SSL Status field on search workflow pages.

The action the system applied to encrypted traffic in the SSL policy.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block/Block with reset</td>
<td>Represents blocked encrypted connections.</td>
</tr>
<tr>
<td>Decrypt (Resign)</td>
<td>Represents an outgoing connection decrypted using a re-signed server certificate.</td>
</tr>
<tr>
<td>Decrypt (Replace Key)</td>
<td>Represents an outgoing connection decrypted using a self-signed server certificate with a substituted public key.</td>
</tr>
<tr>
<td>Decrypt (Known Key)</td>
<td>Represents an incoming connection decrypted using a known private key.</td>
</tr>
<tr>
<td>Default Action</td>
<td>Indicates the connection was handled by the default action.</td>
</tr>
<tr>
<td>Do not Decrypt</td>
<td>Represents a connection the system did not decrypt.</td>
</tr>
</tbody>
</table>

SSL Certificate Status (Syslog: SSLServerCertStatus)

This applies only if you configured a Certificate Status SSL rule condition. If encrypted traffic matches an SSL rule, this field displays one or more of the following server certificate status values:

- Self Signed
- Valid
- Invalid Signature
- Invalid Issuer
- Expired
- Unknown
• Not Valid Yet
• Revoked

If undecryptable traffic matches an SSL rule, this field displays **Not Checked**.

**SSL Certificate Information (Syslog: SSLCertificate)**

In the Firepower Management Center web interface, this field is a search field only.
The information stored on the public key certificate used to encrypt traffic, including:
• Subject/Issuer Common Name
• Subject/Issuer Organization
• Subject/Issuer Organization Unit
• Not Valid Before/After
• Serial Number
• Certificate Fingerprint
• Public Key Fingerprint

**SSL Cipher Suite (Syslog: SSSLCipherSuite)**

A macro value representing a cipher suite used to encrypt the connection. See
[www.iana.org/assignments/tls-parameters/tls-parameters.xhtml](http://www.iana.org/assignments/tls-parameters/tls-parameters.xhtml) for cipher suite value designations.

**SSL Encryption applied to the connection**

This field is available only as a search field in the Firepower Management Center web interface.
Enter **yes** or **no** in the SSL search field to view TLS/SSL-encrypted or non-encrypted connections.

**SSL Expected Action (Syslog: SSLExpectedAction)**

In the Firepower Management Center web interface, this field is a search field only.
The action the system expected to apply to encrypted traffic, given the SSL rules in effect.
Enter any of the values listed for **SSL Actual Action**.

**SSL Failure Reason (Syslog: SSLFlowStatus)**

The reason the system failed to decrypt encrypted traffic:
• Unknown
• No Match
• Success
• Uncached Session
• Unknown Cipher Suite
• Unsupported Cipher Suite
• Unsupported SSL Version
• SSL Compression Used
• Session Undecryptable in Passive Mode
• Handshake Error
• Decryption Error
• Pending Server Name Category Lookup
• Pending Common Name Category Lookup
• Internal Error
• Network Parameters Unavailable
• Invalid Server Certificate Handle
• Server Certificate Fingerprint Unavailable
• Cannot Cache Subject DN
• Cannot Cache Issuer DN
• Unknown SSL Version
• External Certificate List Unavailable
• External Certificate Fingerprint Unavailable
• Internal Certificate List Invalid
• Internal Certificate List Unavailable
• Internal Certificate Unavailable
• Internal Certificate Fingerprint Unavailable
• Server Certificate Validation Unavailable
• Server Certificate Validation Failure
• Invalid Action

Field values are displayed in the SSL Status field on the search workflow pages.

SSL Flow Error
The error name and hexadecimal code if an error occurred during the TLS/SSL session; Success if no error occurred.

SSL Flow Flags
The first ten debugging level flags for an encrypted connection. On a workflow page, to view all flags, click the ellipsis (...).

SSL Flow Messages
The keywords below indicate encrypted traffic is associated with the specified message type exchanged between client and server during the TLS/SSL handshake. See http://tools.ietf.org/html/rfc5246 for more information.

• HELLO_REQUEST
• CLIENT_ALERT
- SERVER_ALERT
- CLIENT_HELLO
- SERVER_HELLO
- SERVER_CERTIFICATE
- SERVER_KEY_EXCHANGE
- CERTIFICATE_REQUEST
- SERVER_HELLO_DONE
- CLIENT_CERTIFICATE
- CLIENT_KEY_EXCHANGE
- CERTIFICATE_VERIFY
- CLIENT_CHANGE_CIPHER_SPEC
- CLIENT_FINISHED
- SERVER_CHANGE_CIPHER_SPEC
- SERVER_FINISHED
- NEW_SESSION_TICKET
- HANDSHAKE_OTHER
- APP_DATA_FROM_CLIENT
- APP_DATA_FROM_SERVER

**SSL Policy (Syslog: SSLPolicy)**

The SSL policy that handled the connection.

**SSL Rule (Syslog: SSLRuleName)**

The SSL rule or default action that handled the connection, as well as the first Monitor rule matched by that connection. If the connection matched a Monitor rule, the field displays the name of the rule that handled the connection, followed by the Monitor rule name.

**SSLServerName (Syslog Only)**

This field exists ONLY as a syslog field; it does not exist in the Firepower Management Center web interface.

Hostname of the server with which the client established an encrypted connection.

**SSL Session ID (Syslog: SSLSessionID)**

The hexadecimal Session ID negotiated between the client and server during the TLS/SSL handshake.

**SSL Status**

The action associated with the SSL Actual Action (SSL rule, default action, or undecryptable traffic action) that logged the encrypted connection. The lock icon (🔒) links to SSL certificate details. If the
certificate is unavailable (for example, for connections blocked due to TLS/SSL handshake error), the lock icon is dimmed.

If the system fails to decrypt an encrypted connection, it displays the **SSL Actual Action** (undecryptable traffic action) taken, as well as the **SSL Failure Reason**. For example, if the system detects traffic encrypted with an unknown cipher suite and allows it without further inspection, this field displays **Do Not Decrypt (Unknown Cipher Suite)**.

When searching this field, enter one or more of the **SSL Actual Action** and **SSL Failure Reason** values to view encrypted traffic the system handled or failed to decrypt.

**SSL Subject/Issuer Country**

This field is available only in the Firepower Management Center web interface, and only as a search field.

A two-character ISO 3166-1 alpha-2 country code for the subject or issuer country associated with the encryption certificate.

**SSL Ticket ID (Syslog: SSLTicketID)**

A hexadecimal hash value of the session ticket information sent during the TLS/SSL handshake.

**SSL URL Category (Syslog Only)**

URL categories for the URL visited in the encrypted connection.

This field exists ONLY as a syslog field; in the Firepower Management Center web interface, values in this field are included in the URL Category column.

See also **URL**.

**SSL Version (Syslog: SSLVersion)**

The TLS/SSL protocol version used to encrypt the connection:

- Unknown
- SSLv2.0
- SSLv3.0
- TLSv1.0
- TLSv1.1
- TLSv1.2

**Application**

**Application Protocol (Syslog: ApplicationProtocol)**

In the Firepower Management Center web interface, this value constrains summaries and graphs.

The application protocol, which represents communications between hosts, detected in the connection.

**Application Protocol Category and Tag**

Criteria that characterize the application to help you understand the application's function.
Application Risk

The risk associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated risk; this field displays the highest of those.

Business Relevance

The business relevance associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated business relevance; this field displays the lowest (least relevant) of those.

Client and Client Version (Syslog: Client, ClientVersion)

The client application and version of that client detected in the connection.

If the system cannot identify the specific client used in the connection, the field displays the word "client" appended to the application protocol name to provide a generic name, for example, FTP client.

Client Category and Tag

Criteria that characterize the application to help you understand the application's function.

HTTP Referrer (Syslog: HTTPReferer)

The HTTP referrer, which represents the referrer of a requested URL for HTTP traffic detected in the connection (such as a website that provided a link to, or imported a link from, another URL).

Referenced Host (Syslog: ReferencedHost)

If the protocol in the connection is HTTP or HTTPS, this field displays the host name that the respective protocol was using.

User Agent (Syslog: UserAgent)

The user-agent string application information extracted from HTTP traffic detected in the connection.

Web Application (Syslog: WebApplication)

The web application, which represents the content or requested URL for HTTP traffic detected in the connection.

If the web application does not match the URL for the event, the traffic is probably referred traffic, such as advertisement traffic. If the system detects referred traffic, it stores the referring application (if available) and lists that application as the web application.

If the system cannot identify the specific web application in HTTP traffic, this field displays Web Browsing.

Web Application Category and Tag

Criteria that characterize the application to help you understand the application's function.

URL

URL, URL Category, and URL Reputation (Syslog: URL, URLCategory and SSLURLCategory, URLReputation)

The URL requested by the monitored host during the session and its associated category and reputation, if available.
If the system identifies or blocks a TLS/SSL application, the requested URL is in encrypted traffic, so
the system identifies the traffic based on an SSL certificate. For TLS/SSL applications, therefore, this
field indicates the common name contained in the certificate.

See also SSLURLCategory, above.

**NetFlow**

**NetBIOS Domain (Syslog: NetBIOSDomain)**

The NetBIOS domain used in the session.

**NetFlow Source/Destination Autonomous System**

For connections generated from NetFlow data, the border gateway protocol autonomous system number
for the source or destination of traffic in the connection.

**NetFlow Source/Destination Prefix**

For connections generated from NetFlow data, the source or destination IP address ANDed with the
source or destination prefix mask.

**NetFlow Source/Destination TOS**

For connections generated from NetFlow data, the setting for the type-of-service (TOS) byte when
connection traffic entered or exited the NetFlow exporter.

**NetFlow SNMP Input/Output**

For connections generated from NetFlow data, the interface index for the interface where connection
traffic entered or exited the NetFlow exporter.

**Source Device**

In the Firepower Management Center web interface, this value constrains summaries and graphs.
The IP address of the NetFlow exporter that broadcast the data used to generate for the connection. If
the connection was detected by a managed device, this field displays **Firepower**.

**Associated Events**

You cannot use the connection/Security Intelligence events Search page to search for events associated with
a connection.

**Files (Syslog: FileCount)**

The number of files (including malware files) detected or blocked in a connection associated with one
or more file events.

In the Firepower Management Center web interface, the view files icon links to a list of files. The
number on the icon indicates the number of files (including malware files) detected or blocked in that
connection.

**Intrusion Events (Syslog: IPSCount)**

The number of intrusion events, if any, associated with the connection.

In the Firepower Management Center web interface, the view intrusion events icon links to a list
of events.
About Connection and Security Intelligence Event Fields

In the Firepower Management Center web interface, you can view and search connection and security intelligence events using tabular and graphical workflows under the **Analysis > Connections** submenus.

For each Security Intelligence event, there is an identical, separately stored connection event. All Security Intelligence events have a populated **Security Intelligence Category** field.

The information available for any individual event can vary depending on how, why, and when the system logged the connection.

**Search Constraints**

Fields marked with an asterisk (*) on search pages constrain connection graphs and connection summaries. Because connection graphs are based on connection summaries, the same criteria that constrain connection summaries also constrain connection graphs. If you search connection summaries using invalid search constraints and view your results using a connection summary page in a custom workflow, the invalid constraints are labeled as not applicable (N/A) and are marked with a strikethrough.

**Syslog Fields**

Most fields appear both in the Firepower Management Center web interface and as syslog messages. Fields without a listed syslog equivalent are not available in syslog messages. A few fields are syslog-only, as noted, and few others are separate fields in syslog messages but are consolidated fields in the web interface or vice-versa.

**Connection Event Reasons**

The Reason field in a connection event displays the reason or reasons the connection was logged, in the following situations:

<table>
<thead>
<tr>
<th>Reason</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNS Block</td>
<td>The system denied the connection without inspection, based on the domain name and Security Intelligence data. A reason of DNS Block is paired with an action of Block, Domain not found, or Sinkhole, depending on the DNS rule action.</td>
</tr>
<tr>
<td>DNS Monitor</td>
<td>The system would have denied the connection based on the domain name and Security Intelligence data, but you configured the system to monitor, rather than deny, the connection.</td>
</tr>
<tr>
<td>File Block</td>
<td>The connection contained a file or malware file that the system prevented from being transmitted. A reason of File Block is always paired with an action of Block.</td>
</tr>
<tr>
<td>File Custom Detection</td>
<td>The connection contained a file on the custom detection list that the system prevented from being transmitted.</td>
</tr>
<tr>
<td>File Monitor</td>
<td>The system detected a particular type of file in the connection.</td>
</tr>
<tr>
<td>Reason</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>File Resume Allow</td>
<td>File transmission was originally blocked by a Block Files or Block Malware file rule. After a new access control policy allowing the file was deployed, the HTTP session automatically resumed. This reason only appears in inline deployments.</td>
</tr>
<tr>
<td>File Resume Block</td>
<td>File transmission was originally allowed by a Detect Files or Malware Cloud Lookup file rule. After a new access control policy blocking the file was deployed, the HTTP session automatically stopped. This reason only appears in inline deployments.</td>
</tr>
</tbody>
</table>
| Intelligent App Bypass   | The Intelligent Application Bypass (IAB) mode:  
• If the action is Trust, IAB was in bypass mode. Matching traffic passed without further inspection.  
• If the action is Allow, IAB was in test mode. Matching traffic was available for further inspection. |
| Intrusion Block          | The system blocked or would have blocked an exploit (intrusion policy violation) detected in the connection. A reason of Intrusion Block is paired with an action of Block for blocked exploits and Allow for would-have-blocked exploits. |
| Intrusion Monitor        | The system detected, but did not block, an exploit detected in the connection. This occurs when the state of the triggered intrusion rule is set to Generate Events. |
| IP Block                 | The system denied the connection without inspection, based on the IP address and Security Intelligence data. A reason of IP Block is always paired with an action of Block. |
| IP Monitor               | The system would have denied the connection based on the IP address and Security Intelligence data, but you configured the system to monitor, rather than deny, the connection. |
| SSL Block                | The system blocked an encrypted connection based on the TLS/SSL inspection configuration. A reason of SSL Block is always paired with an action of Block. |
| URL Block                | The system denied the connection without inspection, based on the URL and Security Intelligence data. A reason of URL Block is always paired with an action of Block. |
| URL Monitor              | The system would have denied the connection based on the URL and Security Intelligence data, but you configured the system to monitor, rather than deny, the connection. |
| User Bypass              | The system initially blocked a user’s HTTP request, but the user clicked through a warning page to view the site. A reason of User Bypass is always paired with an action of Allow. |

**Requirements for Populating Connection Event Fields**

The information available for a connection event, Security Intelligence event, or connection summary depends on several factors.
Appliance Model and License

Many features require that you enable specific licensed capabilities on target devices, and many features are only available on some models.

For example, NGIPSv devices do not support TLS/SSL inspection. They cannot inspect encrypted traffic; logged connection events do not contain information about encrypted connections.

Traffic Characteristics

The system only reports information present (and detectable) in network traffic. For example, there could be no user associated with an initiator host, or no referenced host detected in a connection where the protocol is not DNS, HTTP, or HTTPS.

Origin/Detection Method: Traffic-Based Detection vs NetFlow

With the exception of NetFlow-only fields, the information available in NetFlow records is more limited than the information generated by traffic-based detection; see Differences between NetFlow and Managed Device Data, on page 1204.

Evaluation Stage

Each type of traffic inspection and control occurs where it makes the most sense for maximum flexibility and performance.

For example, the system enforces Security Intelligence before more resource-intensive evaluations. When a connection is blocked by Security Intelligence, the resulting event does not contain the information that the system would have gathered from subsequent evaluation, for example, user identity.

Logging Method: Beginning or End of Connection

When the system detects a connection, whether you can log it at its beginning or its end (or both) depends on how you configure the system to detect and handle it.

Beginning-of-connection events do not have information that must be determined by examining traffic over the duration of the session (for example, the total amount of data transmitted or the timestamp of the last packet in the connection). Beginning-of-connection events are also not guaranteed to have information about application or URL traffic in the session, and do not contain any details about the session’s encryption. Beginning-of-connection logging is usually the only option for blocked connections.

Connection Event Type: Individual vs Summary

Connection summaries do not contain all of the information associated with their aggregated connections. For example, because client information is not used to aggregate connections into connection summaries, summaries do not contain client information.

Keep in mind that connection graphs are based on connection summary data, which use only end-of-connection logs. If your system is configured to log only beginning-of-connection data, connection graphs and connection summary event views contain no data.

Other Configurations

Other configurations that affect connection logging include, but are not limited to:
**Information Available in Connection Event Fields**

The table in this topic indicates when the system can populate connection and Security Intelligence fields. The columns in the table represent the following event types:

- **Origin: Direct**—Events that represent connections detected and handled by a Firepower System managed device.
- **Origin: NetFlow**—Events that represent connections exported by a NetFlow exporter.
- **Logging: Start**—Events that represent connections logged at their beginning.
- **Logging: End**—Events that represent connections logged at their end.

A "yes" in the table does not mean that the system must populate a connection event field, rather, that it can. The system only reports information present (and detectable) in network traffic. For example, TLS/SSL-related fields are populated only for records of encrypted connections handled by an SSL policy.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control Policy</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Access Control Rule</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Action</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Application Protocol</td>
<td>yes</td>
<td>yes</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------</td>
<td>-----------------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Application Protocol Category &amp; Tag</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>Application Risk</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>Business Relevance</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>Client</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>Client Category &amp; Tag</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>Client Version</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>Connections</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Count</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Destination Port/ICMP Type</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Device</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Domain</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>DNS Query</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>DNS Record Type</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>DNS Response</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>DNS Sinkhole Name</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>DNS TTL</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Egress Interface</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Egress Security Zone</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Endpoint Location</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Endpoint Profile</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Files</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>First Packet</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>HTTP Referrer</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>HTTP Response Code</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Ingress Interface</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Ingress Security Zone</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Initiator Bytes</td>
<td>yes</td>
<td>yes</td>
<td>not useful</td>
<td>yes</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------</td>
<td>-----------------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Initiator Country</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Initiator IP</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Initiator Packets</td>
<td>yes</td>
<td>yes</td>
<td>not useful</td>
<td>yes</td>
</tr>
<tr>
<td>Initiator User</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Intrusion Events</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Intrusion Policy</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>IOC (Indication of Compromise)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Last Packet</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>NetBIOS Domain</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>NetFlow Source/Destination Autonomous System</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>NetFlow Source/Destination Prefix</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>NetFlow Source/Destination TOS</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>NetFlow SNMP Input/Output</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Network Analysis Policy</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Reason</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Referenced Host</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Responder Bytes</td>
<td>yes</td>
<td>yes</td>
<td>not useful</td>
<td>yes</td>
</tr>
<tr>
<td>Responder Country</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Responder IP</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Responder Packets</td>
<td>yes</td>
<td>yes</td>
<td>not useful</td>
<td>yes</td>
</tr>
<tr>
<td>Security Context (ASA only)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Security Group Tag (SGT)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Security Intelligence Category</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Source Device</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Source Port/ICMP Type</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Certificate Status</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Cipher Suite</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
</tbody>
</table>
### Using Connection and Security Intelligence Event Tables

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>SSL Flow Error</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Flow Flags</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Flow Messages</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Policy</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Rule</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Session ID</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Status</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Version</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>TCP Flags</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Time</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>URL</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>URL Category</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>URL Reputation</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>User Agent</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>VLAN ID</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Web Application</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
<tr>
<td>Web Application Category &amp; Tag</td>
<td>yes</td>
<td>no</td>
<td>if available</td>
<td>yes</td>
</tr>
</tbody>
</table>

### Using Connection and Security Intelligence Event Tables

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can use the Firepower Management Center to view a table of connection or Security Intelligence events. Then, you can manipulate the event view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access connection graphs differs depending on the workflow you use. You can use a predefined workflow, which terminates in a table view of events. You can also create a custom workflow that displays only the information that matches your specific needs.
When you are using a connection or Security Intelligence workflow table, you can perform many common actions.

Note that when you constrain connection events on a drill-down page, the packets and bytes from identical events are summed. However, if you are using a custom workflow and did not add a Count column to a drill-down page, the events are listed individually and packets and bytes are not summed.

**Procedure**

### Step 1
Choose either of the following:

- **Analysis > Connections > Events** (for connection events)
- **Analysis > Connections > Security Intelligence Events**

**Note** If a connection graph appears instead of a table, click (switch workflow) by the workflow title, and choose the predefined Connection Events workflow, or a custom workflow. Note that all predefined connection event workflows—including connection graphs—terminate in a table view of connections.

### Step 2
You have the following choices:

- **Time Range** — To adjust the time range, which is useful if no events appear, see Changing the Time Window, on page 1543.

- **Field Names** — To learn more about the contents of the columns in the table, see Connection and Security Intelligence Event Fields, on page 1597.

**Tip** In the table view of events, several fields are hidden by default, including the Category and Tag fields for each type of application, NetFlow-related fields, TLS/SSL-related fields, and others. To show a hidden field in an event view, expand the search constraints, then click the field name under Disabled Columns.

- **Host Profile** — To view the host profile for an IP address, click the host profile icon ( ) or, for hosts with active indications of compromise (IOC) tags, the compromised host icon ( ) that appears next to the IP address.

- **User Profile** — To view user identity information, click the user icon that appears next to the user identity ( ).

- **Files and Malware** — To view the files, including malware, detected or blocked in a connection, click the view files icon ( ) and proceed as described in Viewing Files and Malware Detected in a Connection, on page 1617.

- **Intrusion Events** — To view the intrusion events associated with a connection, as well as their priority and impact, click the intrusion events icon ( ) in the Intrusion Events column and proceed as described in Viewing Intrusion Events Associated with a Connection, on page 1618.
To quickly view intrusion, file, or malware events associated with one or more connections, check the connections using the check boxes in the table, then choose the appropriate option from the Jump to drop-down list. Note that because they are blocked before access control rule evaluation, there can be no files or intrusions associated with connections blacklisted by Security Intelligence. You can only see this information for a Security Intelligence event if you configured Security Intelligence to monitor, rather than blacklist, connections.

• Certificate — To view details about an available certificate used to encrypt a connection, click an enabled lock icon (🔒) in the SSL Status column.

• Constrain — To constrain the columns that appear, click the close icon (❌) in the column heading that you want to hide. In the pop-up window that appears, click Apply. To add a disabled column back to the view, expand the search constraints, then click the column name under Disabled Columns.

• Delete Events — To delete some or all items in the current constrained view, check the check boxes next to items you want to delete and click Delete or click Delete All.

• Drill Down — See Using Drill-Down Pages, on page 1531.

• Navigate This Page — See Workflow Page Traversal Tools, on page 1528.

• Navigate Between Pages — To navigate between pages in the current workflow, keeping the current constraints, click the appropriate page link at the top left of the workflow page.

• Navigate Between Event Views — To navigate to other event views to view associated events, click Jump to and choose the event view from the drop-down list.

• Sort — To sort data in a workflow, click the column title. Click the column title again to reverse the sort order.

### Related Topics
- Overview: Workflows, on page 1513
- Configuring Event View Settings, on page 31

### Viewing Files and Malware Detected in a Connection

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat or Malware</td>
<td>Protection or Malware</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

If you associate a file policy with one or more access control rules, the system can detect files (including malware) in matching traffic. Use the Analysis > Connections menu options to see the file events, if any,
associated with the connections logged by those rules. Instead of a list of files, the Firepower Management Center displays the view files icon (9) in the Files column. The number on the icon indicates the number of files (including malware files) detected or blocked in that connection.

Not all file and malware events are associated with connections. Specifically:

- Malware events detected by AMP for Endpoints ("endpoint-based malware events") are not associated with connections. Those events are imported from your AMP for Endpoints deployment.

- Many IMAP-capable email clients use a single IMAP session, which ends only when the user exits the application. Although long-running connections are logged by the system, files downloaded in the session are not associated with the connection until the session ends.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1**  
Go to Analysis > Connections and choose the relevant option.

**Step 2**  
While using a connection event table, click the view files icon (9).  
A pop-up window appears with a list of the files detected in the connection as well as their types, and if applicable, their malware dispositions.

**Step 3**  
You have the following choices:

- **View** — To view a table view of file events, click a file's view icon (9).

- **View** — To view details in a table view of malware events, click a malware file's view icon (9).

- **Track** — To track the file’s transmission through your network, click a file’s trajectory icon (9).

- **View** — To view details on all of the connection’s detected file or malware events detected by AMP for Networks ("network-based malware events"), click View File Events or View Malware Events.

---

**Viewing Intrusion Events Associated with a Connection**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

If you associate an intrusion policy with an access control rule or default action, the system can detect exploits in matching traffic. Use the Analysis > Connections menu options to see the intrusion events, if any, associated with logged connections, as well as their priority and impact.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.
Procedure

Step 1
Go to Analysis > Connections and choose the relevant option.

Step 2
While using a connection event table, click the intrusion events icon ( ) in the Intrusion Events column.

Step 3
In the pop-up window that appears, you have the following options:

- Click a listed event’s view icon ( ) to view details in the packet view.
- Click View Intrusion Events to view details on all of the connection’s associated intrusion events.

Encrypted Connection Certificate Details

You can use options under the Analysis > Connections menu to display the public key certificate (if available) used to encrypt a connection handled by the system. The certificate contains the following information.

Table 264: Encrypted Connection Certificate Details

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject/Issuer Common Name</td>
<td>The host and domain name of the certificate subject or certificate issuer.</td>
</tr>
<tr>
<td>Subject/Issuer Organization</td>
<td>The organization of the certificate subject or certificate issuer.</td>
</tr>
<tr>
<td>Subject/Issuer Organization Unit</td>
<td>The organizational unit of the certificate subject or certificate issuer.</td>
</tr>
<tr>
<td>Not Valid Before/After</td>
<td>The dates when the certificate is valid.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>The serial number assigned by the issuing CA.</td>
</tr>
<tr>
<td>Certificate Fingerprint</td>
<td>The SHA hash value used to authenticate the certificate.</td>
</tr>
<tr>
<td>Public Key Fingerprint</td>
<td>The SHA hash value used to authenticate the public key contained within the certificate.</td>
</tr>
</tbody>
</table>

Viewing the Connection Summary Page

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Custom</td>
</tr>
</tbody>
</table>

The Connection Summary page is visible only to users who have custom roles that are restricted by searches on connection events and who have been granted explicit menu-based access to the Connection Summary page. This page provides graphs of the activity on your monitored network organized by different criteria.
For example, the Connections over Time graph displays the total number of connections on your monitored network over the interval that you choose.

You can perform almost all the same actions on connection summary graphs that you can perform on connection graphs. However, because the graphs on the Connection Summary page are based on aggregated data, you cannot examine the individual connection events on which the graphs are based. In other words, you cannot drill down to a connection data table view from a connection summary graph.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

1. **Step 1** Choose Overview > Summary > Connection Summary.
2. **Step 2** From the Select Device list, choose the device whose summary you want to view, or choose All to view a summary of all devices.
3. **Step 3** To manipulate and analyze the connection graphs, proceed as described in Using Connection Event Graphs, on page 1534.

**Tip** To detach a connection graph so you can perform further analysis without affecting the default time range, click View.

**Related Topics**

   User Role Escalation, on page 59
Working with Intrusion Events

The following topics describe how to work with intrusion events.

- About Intrusion Events, on page 1621
- Viewing Intrusion Events, on page 1621
- Intrusion Event Workflow Pages, on page 1639
- The Intrusion Events Clipboard, on page 1658
- Viewing Intrusion Event Statistics, on page 1659
- Viewing Intrusion Event Performance Graphs, on page 1661
- Viewing Intrusion Event Graphs, on page 1666

About Intrusion Events

The Firepower System can help you monitor your network for traffic that could affect the availability, integrity, and confidentiality of a host and its data. By placing managed devices on key network segments, you can examine the packets that traverse your network for malicious activity. The system has several mechanisms it uses to look for the broad range of exploits that attackers have developed.

When the system identifies a possible intrusion, it generates an intrusion event (sometimes called by a legacy term, "IPS event"), which is a record of the date, time, the type of exploit, and contextual information about the source of the attack and its target. For packet-based events, a copy of the packet or packets that triggered the event is also recorded. Managed devices transmit their events to the Firepower Management Center where you can view the aggregated data and gain a greater understanding of the attacks against your network assets.

You can also deploy a managed device as an inline, switched, or routed intrusion system, which allows you to configure the device to drop or replace packets that you know to be harmful.

Viewing Intrusion Events

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You view an intrusion event to determine whether there is a threat to your network security.
The initial intrusion events view differs depending on the workflow you use to access the page. You can use one of the predefined workflows, which includes one or more drill-down pages, a table view of intrusion events, and a terminating packet view, or you can create your own workflow. You can also view workflows based on custom tables, which may include intrusion events.

An event view may be slow to display if it contains a large number of IP addresses and you have enabled the Resolve IP Addresses event view setting.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose **Analysis > Intrusions > Events**.

**Step 2** You have the following choices:

- Adjust time range — Adjust the time range for the event view as described in *Changing the Time Window*, on page 1543.
- Change workflows — If you are using a custom workflow that does not include the table view of intrusion events, choose any of the system-provided workflows by clicking *(switch workflow)* next to the workflow title.
- Constrain — To narrow your view to the intrusion events that are important to your analysis, see *Using Intrusion Event Workflows*, on page 1640.
- Delete event — To delete an event from the database, click **Delete** to delete the event whose packet you are viewing or click **Delete All** to delete all the events whose packets you previously selected.
- Mark reviewed — To mark intrusion events reviewed, see *Marking Intrusion Events Reviewed*, on page 1635.
- View connection data — To view connection data associated with intrusion events, see *Viewing Connection Data Associated with Intrusion Events*, on page 1634.
- View contents — To view the contents of the columns in the table as described in *Intrusion Event Fields*, on page 1623.

**Related Topics**

- *Using the Intrusion Event Packet View*, on page 1643

**About Intrusion Event Fields**

When the system identifies a possible intrusion, it generates an *intrusion event*, which is a record of the date, time, the type of exploit, and contextual information about the source of the attack and its target. For packet-based events, a copy of the packet or packets that triggered the event is also recorded.

You can view intrusion event data in the Firepower Management Center web interface at **Analysis > Intrusions > Events** or emit data from certain fields as syslog messages for consumption by an external tool. Syslog fields are indicated in the list below; fields without a listed syslog equivalent are not available in syslog messages.

When searching intrusion events, keep in mind that the information available for any individual event can vary depending on how, why, and when system logged the event. For example, only intrusion events triggered on decrypted traffic contain TLS/SSL information.
In the Firepower Management Center web interface, some fields in the table view of intrusion events are disabled by default. To enable a field for the duration of your session, expand the search constraints, then click the column name under **Disabled Columns**.

### Intrusion Event Fields

**Access Control Policy (Syslog: ACPolicy)**

The access control policy associated with the intrusion policy where the intrusion, preprocessor, or decoder rule that generated the event is enabled.

**Access Control Rule**

The access control rule that invoked the intrusion policy that generated the event. **Default Action** indicates that the intrusion policy where the rule is enabled is not associated with a specific access control rule but, instead, is configured as the default action of the access control policy.

This field is blank if there is:

- No associated rule/default action—The field is blank if intrusion inspection was associated with neither an access control rule nor the default action, for example, if the packet was examined by the default intrusion policy.
- No associated connection event—The field is blank if the connection event logged for the session has been purged from the database, for example, if connection events have higher turnover than intrusion events.

**Application Protocol (Syslog: ApplicationProtocol)**

The application protocol, if available, which represents communications between hosts detected in the traffic that triggered the intrusion event.

**Application Protocol Category and Tag**

Criteria that characterize the application to help you understand the application's function.

**Application Risk**

The risk associated with detected applications in the traffic that triggered the intrusion event: Very High, High, Medium, Low, and Very Low. Each type of application detected in a connection has an associated risk; this field displays the highest risk of those.

**Business Relevance**

The business relevance associated with detected applications in the traffic that triggered the intrusion event: Very High, High, Medium, Low, and Very Low. Each type of application detected in a connection has an associated business relevance; this field displays the lowest (least relevant) of those.
**Classification (Syslog: Classification)**

The classification where the rule that generated the event belongs.

See a list of possible classification values in *Intrusion Event Details, on page 934.*

When searching this field, enter the classification number, or all or part of the classification name or description for the rule that generated the events you want to view. You can also enter a comma-separated list of numbers, names, or descriptions. Finally, if you add a custom classification, you can also search using all or part of its name or description.

**Client (Syslog: Client)**

The client application, if available, which represents software running on the monitored host detected in the traffic that triggered the intrusion event.

**Client Category and Tag**

Criteria that characterize the application to help you understand the application's function.

**Count**

The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows. This field is not searchable.

**Destination Continent**

The continent of the receiving host involved in the intrusion event.

**Destination Country**

The country of the receiving host involved in the intrusion event.

**Destination IP (Syslog: DstIP)**

The IP address used by the receiving host involved in the intrusion event.

**Destination Port / ICMP Code (Syslog: DstPort, ICMPCode)**

The port number for the host receiving the traffic. For ICMP traffic, where there is no port number, this field displays the ICMP code.

**Destination User**

The User ID for any known user logged in to the destination host.

**Device**

The managed device where the access control policy was deployed.

Note that the primary and secondary devices in a stacked configuration report intrusion events as if they were separate devices.
Intrusion Event Fields

Domain
The domain of the device that detected the intrusion. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

Egress Interface (Syslog: EgressInterface)
The egress interface of the packet that triggered the event. This interface column is not populated for a passive interface.

Egress Security Zone (Syslog: EgressZone)
The egress security zone of the packet that triggered the event. This security zone field is not populated in a passive deployment.

Email Attachments
The MIME attachment file name that was extracted from the MIME Content-Disposition header. To display attachment file names, you must enable the SMTP preprocessor Log MIME Attachment Names option. Multiple attachment file names are supported.

Email Headers
This field is a search field only.
The data that was extracted from the email header.
To associate email headers with intrusion events for SMTP traffic, you must enable the SMTP preprocessor Log Headers option.

Email Recipient
The address of the email recipient that was extracted from the SMTP RCPT TO command. To display a value for this field, you must enable the SMTP preprocessor Log To Addresses option. Multiple recipient addresses are supported.

Email Sender
The address of the email sender that was extracted from the SMTP MAIL FROM command. To display a value for this field, you must enable the SMTP preprocessor Log From Address option. Multiple sender addresses are supported.

Generator
The component that generated the event.
See also information about the following intrusion event fields: GID, Message, and Snort ID.

GID (Syslog Only)
Generator ID; the ID of the component that generated the event.
See also information about the following intrusion event fields: Generator, Message, and Snort ID.
HTTP Hostname

The host name, if present, that was extracted from the HTTP request Host header. Note that request packets do not always include the host name.

To associate host names with intrusion events for HTTP client traffic, you must enable the HTTP Inspect preprocessor Log Hostname option.

In table views, this column displays the first fifty characters of the extracted host name. You can hover your pointer over the displayed portion of an abbreviated host name to display the complete name, up to 256 bytes. You can also display the complete host name, up to 256 bytes, in the packet view.

HTTP Response Code (Syslog: HTTPResponse)

The HTTP status code sent in response to a client's HTTP request over the connection that triggered the event.

HTTP URI

The raw URI, if present, associated with the HTTP request packet that triggered the intrusion event. Note that request packets do not always include a URI.

To associate URIs with intrusion events for HTTP traffic, you must enable the HTTP Inspect preprocessor Log URI option.

To see the associated HTTP URI in intrusion events triggered by HTTP responses, you should configure HTTP server ports in the Perform Stream Reassembly on Both Ports option; note, however, that this increases resource demands for traffic reassembly.

This column displays the first fifty characters of the extracted URI. You can hover your pointer over the displayed portion of an abbreviated URI to display the complete URI, up to 2048 bytes. You can also display the complete URI, up to 2048 bytes, in the packet view.

Impact

The impact level in this field indicates the correlation between intrusion data, network discovery data, and vulnerability information.

When searching this field, do not specify impact icon colors or partial strings. For example, do not use blue, level 1, or 0. Valid case-insensitive values are:

- Impact 0, Impact Level 0
- Impact 1, Impact Level 1
- Impact 2, Impact Level 2
- Impact 3, Impact Level 3
- Impact 4, Impact Level 4

Because no operating system information is available for hosts added to the network map from NetFlow data, the system cannot assign Vulnerable (impact level 1: red) impact levels for intrusion events involving those hosts. In such cases, use the host input feature to manually set the operating system identity for the hosts.

Ingress Interface (Syslog: IngressInterface)

The ingress interface of the packet that triggered the event. Only this interface column is populated for a passive interface.
**Ingress Security Zone (Syslog: IngressZone)**

The ingress security zone of the packet that triggered the event. Only this security zone field is populated in a passive deployment.

**Inline Result**

In workflow and table views, this field displays one of the following:

*Table 265: Inline Result Field Contents in Workflow and Table Views*

<table>
<thead>
<tr>
<th>This Icon</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>A black down arrow</td>
<td>The system dropped the packet that triggered the rule</td>
</tr>
<tr>
<td>A gray down arrow</td>
<td>IPS would have dropped the packet if you enabled the <strong>Drop when Inline</strong> intrusion policy option (in an inline deployment), or if a Drop and Generate rule generated the event while the system was pruning</td>
</tr>
<tr>
<td>No icon (blank)</td>
<td>The triggered rule was not set to Drop and Generate Events</td>
</tr>
</tbody>
</table>

In a passive deployment, the system does not drop packets, including when an inline interface is in tap mode, regardless of the rule state or the inline drop behavior of the intrusion policy.

When searching this field, enter either of the following:

- **dropped** to specify whether the packet is dropped in an inline deployment
- **would have dropped** to specify whether the packet would have dropped if the intrusion policy had been set to drop packets in an inline deployment

**Intrusion Policy**

The intrusion policy where the intrusion, preprocessor, or decoder rule that generated the event was enabled. You can choose an intrusion policy as the default action for an access control policy, or you can associate an intrusion policy with an access control rule.

**IOC (Syslog: NumIOC)**

Whether the traffic that triggered the intrusion event also triggered an indication of compromise (IOC) for a host involved in the connection.

When searching this field, specify **triggered** or **n/a**.

**Message (Syslog: Message)**

The explanatory text for the event. For rule-based intrusion events, the event message is pulled from the rule. For decoder- and preprocessor-based events, the event message is hard coded.

The Generator and Snort IDs (GID and SID) and the SID version (Revision) are appended in parentheses to the end of each message in the format of numbers separated by colons (GID:SID:version). For example **(1:36330:2)**.

**MPLS Label**

The Multiprotocol Label Switching label associated with the packet that triggered the intrusion event.
**Network Analysis Policy (Syslog: NAPPolicy)**

The network analysis policy, if any, associated with the generation of the event.

This field displays the first fifty characters of the extracted URI. You can hover your pointer over the displayed portion of an abbreviated URI to display the complete URI, up to 2048 bytes. You can also display the complete URI, up to 2048 bytes, in the packet view.

**Original Client IP**

The original client IP address that was extracted from an X-Forwarded-For (XFF), True-Client-IP, or custom-defined HTTP header.

To display a value for this field, you must enable the HTTP preprocessor Extract Original Client IP Address option in the network analysis policy. Optionally, in the same area of the network analysis policy, you can also specify up to six custom client IP headers, as well as set the priority order in which the system selects the value for the Original Client IP event field.

**Priority (Syslog: Priority)**

The event priority as determined by the Cisco Talos Security Intelligence and Research Group (Talos). The priority corresponds to either the value of the `priority` keyword or the value for the `classtype` keyword. For other intrusion events, the priority is determined by the decoder or preprocessor. Valid values are high, medium, and low.

**Protocol (Syslog: Protocol)**

In the Firepower Management Center web interface, this field is a search field only.

The name or number of the transport protocol used in the connection as listed in http://www.iana.org/assignments/protocol-numbers. This is the protocol associated with the source and destination port/ICMP column.

**Reviewed By**

The name of the user who reviewed the event. When searching this field, you can enter unreviewed to search for events that have not been reviewed.

**Revision (Syslog Only)**

The version of the signature that was used to generate the event.

See also information about the following intrusion event fields: Generator, GID, Message, Sid, and Snort ID.

**Security Context (Syslog: Context)**

The metadata identifying the virtual firewall group through which the traffic passed. The system only populates this field for ASA FirePOWER in multiple context mode.

**SID (Syslog Only)**

The signature ID (also known as the Snort ID) of the rule that generated the event.

See also information about the following intrusion event fields: Generator, GID, Message, Revision, and Snort ID.
**Snort ID**

This field is a search field only.

(For the syslog field, see SID.)

When performing your search: Specify the Snort ID (SID) of the rule that generated the event or, optionally, specify the combination Generator ID (GID) and SID of the rule, where the GID and SID are separated with a colon (:) in the format GID:SID. You can specify any of the values in the following table:

<table>
<thead>
<tr>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>a single SID</td>
<td>10000</td>
</tr>
<tr>
<td>a SID range</td>
<td>10000-11000</td>
</tr>
<tr>
<td>greater than a SID</td>
<td>&gt;10000</td>
</tr>
<tr>
<td>greater than or equal to a SID</td>
<td>&gt;=10000</td>
</tr>
<tr>
<td>less than a SID</td>
<td>&lt;10000</td>
</tr>
<tr>
<td>less than or equal to a SID</td>
<td>&lt;=10000</td>
</tr>
<tr>
<td>a comma-separated list of SIDs</td>
<td>10000,11000,12000</td>
</tr>
<tr>
<td>a single GID:SID combination</td>
<td>1:10000</td>
</tr>
<tr>
<td>a comma-separated list of GID:SID combinations</td>
<td>1:10000,1:11000,1:12000</td>
</tr>
<tr>
<td>a comma-separated list of SIDs and GID:SID combinations</td>
<td>10000,1:11000,12000</td>
</tr>
</tbody>
</table>

The SID of the events you are viewing is listed in the Message column. For more information, see the description in this section for the Message field.

**Source Continent**

The continent of the sending host involved in the intrusion event.

**Source Country**

The country of the sending host involved in the intrusion event.

**Source IP (Syslog: SrcIP)**

The IP address used by the sending host involved in the intrusion event.

**Source Port / ICMP Type (Syslog: SrcPort, ICMPType)**

The port number on the sending host. For ICMP traffic, where there is no port number, this field displays the ICMP type.
Source User (Syslog: User)

The User ID for any known user logged in to the source host.

SSL Actual Action (Syslog: SSLActualAction)

In the Firepower Management Center web interface, this field is a search field only. The action the system applied to encrypted traffic:

Block/Block with reset

Represents blocked encrypted connections.

Decrypt (Resign)

Represents an outgoing connection decrypted using a re-signed server certificate.

Decrypt (Replace Key)

Represents an outgoing connection decrypted using a self-signed server certificate with a substituted public key.

Decrypt (Known Key)

Represents an incoming connection decrypted using a known private key.

Default Action

Indicates the connection was handled by the default action.

Do not Decrypt

Represents a connection the system did not decrypt.

Field values are displayed in the SSL Status field on the search workflow pages.

SSL Certificate Information

This field is a search field only.

The information stored on the public key certificate used to encrypt traffic, including:

• Subject/Issuer Common Name
• Subject/Issuer Organization
• Subject/Issuer Organization Unit
• Not Valid Before/After
• Serial Number
• Certificate Fingerprint
• Public Key Fingerprint

SSL Failure Reason

This field is a search field only.

The reason the system failed to decrypt encrypted traffic:
• Unknown
• No Match
• Success
• Uncached Session
• Unknown Cipher Suite
• Unsupported Cipher Suite
• Unsupported SSL Version
• SSL Compression Used
• Session Undecryptable in Passive Mode
• Handshake Error
• Decryption Error
• Pending Server Name Category Lookup
• Pending Common Name Category Lookup
• Internal Error
• Network Parameters Unavailable
• Invalid Server Certificate Handle
• Server Certificate Fingerprint Unavailable
• Cannot Cache Subject DN
• Cannot Cache Issuer DN
• Unknown SSL Version
• External Certificate List Unavailable
• External Certificate Fingerprint Unavailable
• Internal Certificate List Invalid
• Internal Certificate List Unavailable
• Internal Certificate Unavailable
• Internal Certificate Fingerprint Unavailable
• Server Certificate Validation Unavailable
• Server Certificate Validation Failure
• Invalid Action

Field values are displayed in the SSL Status field on the search workflow pages.
SSL Status

The action associated with the SSL Actual Action (SSL rule, default action, or undecryptable traffic action) that logged the encrypted connection.

If the system fails to decrypt an encrypted connection, it displays the SSL Actual Action (undecryptable traffic action) taken, as well as the SSL Failure Reason. For example, if the system detects traffic encrypted with an unknown cipher suite and allows it without further inspection, this field displays Do Not Decrypt (Unknown Cipher Suite).

Click the lock icon (🔒) to view certificate details.

When searching this field, enter one or more of the SSL Actual Action and SSL Failure Reason values to view encrypted traffic the system handled or failed to decrypt.

SSL Subject/Issuer Country

This field is a search field only.

A two-character ISO 3166-1 alpha-2 country code for the subject or issuer country associated with the encryption certificate.

Time

The date and time of the event. This field is not searchable.

VLAN ID

The innermost VLAN ID associated with the packet that triggered the intrusion event.

Web Application (Syslog: WebApplication)

The web application, which represents the content or requested URL for HTTP traffic detected in the traffic that triggered the intrusion event.

If the system detects an application protocol of HTTP but cannot detect a specific web application, the system supplies a generic web browsing designation instead.

Web Application Category and Tag

Criteria that characterize the application to help you understand the application's function.

Related Topics

Event Searches, on page 1553

Intrusion Event Impact Levels

To help you evaluate the impact an event has on your network, the Firepower Management Center displays an impact level in the table view of intrusion events. For each event, the system adds an impact level icon whose color indicates the correlation between intrusion data, network discovery data, and vulnerability information.
Because no operating system information is available for hosts added to the network map from NetFlow data, the system cannot assign Vulnerable (impact level 1: red) impact levels for intrusion events involving those hosts. In such cases, use the host input feature to manually set the operating system identity for the hosts.

The following table describes the possible values for the impact levels.

<table>
<thead>
<tr>
<th>Impact Level</th>
<th>Vulnerability</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unknown</td>
<td>gray</td>
<td>Neither the source nor the destination host is on a network that is monitored by network discovery.</td>
</tr>
<tr>
<td>1</td>
<td>Vulnerable</td>
<td>red</td>
<td>Either:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• the source or the destination host is in the network map, and a vulnerability is mapped to the host</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• the source or destination host is potentially compromised by a virus, trojan, or other piece of malicious software</td>
</tr>
<tr>
<td>2</td>
<td>Potentially Vulnerable</td>
<td>orange</td>
<td>Either the source or the destination host is in the network map and one of the following is true:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• for port-oriented traffic, the port is running a server application protocol</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• for non-port-oriented traffic, the host uses the protocol</td>
</tr>
</tbody>
</table>

Note
### Viewing Connection Data Associated with Intrusion Events

<table>
<thead>
<tr>
<th>Impact Level</th>
<th>Vulnerability</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3            | Currently Not Vulnerable    | yellow| Either the source or the destination host is in the network map and one of the following is true:  
• for port-oriented traffic (for example, TCP or UDP), the port is not open  
• for non-port-oriented traffic (for example, ICMP), the host does not use the protocol |
| 4            | Unknown Target              | blue  | Either the source or destination host is on a monitored network, but there is no entry for the host in the network map.                    |

#### Viewing associated data

The system can log the connections where intrusion events are detected. Although this logging is automatic for intrusion policies associated with access control rules, you must manually enable connection logging to see associated connection data for the default action.

Viewing associated data is most useful when navigating between table views of events.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

#### Procedure

1. **Choose Analysis > Intrusions > Events.**
2. **Choose the intrusion events using the check boxes in the table, then choose Connections from the Jumpto drop-down list.**

**Tip** You can view the intrusion events associated with particular connections in a similar way. For more information, see [Inter-Workflow Navigation, on page 1549](#).

#### Related Topics
- [Logging for Allowed Connections, on page 1589](#)
Marking Intrusion Events Reviewed

If you are confident that an intrusion event is not malicious, you can mark the event reviewed.

If you have examined an intrusion event and are confident that the event does not represent a threat to your network security (for example, because you know that none of the hosts on your network are vulnerable to the detected exploit), you can mark the event reviewed. Reviewed events are stored in the event database and are included in the event summary statistics, but no longer appear in the default intrusion event pages. Your name appears as the reviewer.

In a multidomain deployment, if you mark an event reviewed, the system marks it reviewed in all domains that can view that event.

If you perform a backup and then delete reviewed intrusion events, restoring your backup restores the deleted intrusion events but does not restore their reviewed status. You view those restored intrusion events under Intrusion Events, not under Reviewed Events.

Procedure

On a page that displays intrusion events, you have two options:

- To mark one or more intrusion events from the list of events, check the check boxes next to the events and click Review.
- To mark all intrusion events from the list of events, click Review All.

Related Topics

Using Intrusion Event Workflows, on page 1640

Viewing Previously Reviewed Intrusion Events

In a multidomain deployment, if you mark an event reviewed, the system marks it reviewed in all domains that can view that event.
Procedure

**Step 1** Choose **Analysis > Intrusions > Reviewed Events**.

**Step 2** You have the following choices:

- Adjust the time range as described in *Changing the Time Window*, on page 1543.
- If you are using a custom workflow that does not include the table view of intrusion events, choose any of the system-provided workflows by clicking *(switch workflow)* next to the workflow title.
- To learn more about the events that appear, see *Intrusion Event Fields*, on page 1623.

**Related Topics**

*Using Intrusion Event Workflows*, on page 1640

**Marking Reviewed Intrusion Events Unreviewed**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

You can return a reviewed event to the default intrusion events view by marking the event unreviewed.

In a multidomain deployment, if you mark an event reviewed, the system marks it reviewed in all domains that can view that event.

**Procedure**

On a page that displays reviewed events, you have two choices:

- To remove individual intrusion events from the list of reviewed events, check the check boxes next to specific events and click **Unreview**.
- To remove all intrusion events from the list of reviewed events, click **Unreview All**.

**Preprocessor Events**

Preprocessors provide two functions: performing the specified action on the packet (for example, decoding and normalizing HTTP traffic) and reporting the execution of specified preprocessor options by generating an event whenever a packet triggers that preprocessor option and the associated preprocessor rule is enabled. For example, you can enable the *Double Encoding HTTP Inspect* option and the associated preprocessor rule with the HTTP Inspect Generator (GID) 119 and the Snort ID (SID) 2 to generate an event when the preprocessor encounters IIS double-encoded traffic.

Generating events to report the execution of preprocessors helps you detect anomalous protocol exploits. For example, attackers can craft overlapping IP fragments to cause a DoS attack on a host. The IP defragmentation preprocessor can detect this type of attack and generate an intrusion event for it.
Preprocessor events differ from rule events in that the packet display does not include a detailed rule description for the event. Instead, the packet display shows the event message, the GID, SID, the packet header data, and the packet payload. This allows you to analyze the packet’s header information, determine if its header options are being used and if they can exploit your system, and inspect the packet payload. After the preprocessors analyze each packet, the rules engine executes appropriate rules against it (if the preprocessor was able to defragment it and establish it as part of a valid session) to further analyze potential content-level threats and report on them.

**Preprocessor Generator IDs**

Each preprocessor has its own Generator ID number, or GID, that indicates which preprocessor was triggered by the packet. Some of the preprocessors also have related SIDs, which are ID numbers that classify potential attacks. This helps you analyze events more effectively by categorizing the type of event much the way a rule’s Snort ID (SID) can offer context for packets triggering rules. You can list preprocessor rules by preprocessor in the Preprocessors filter group on the intrusion policy Rules page; you can also list preprocessor rules in the preprocessor and packet decoder sub-groupings in the Category filter group.

Events generated by standard text rules have a generator ID of 1. For shared object rules, the events have a generator ID of 3. For both, the event’s SID indicates which specific rule triggered.

---

**Note**

The following table describes the types of events that generate each GID.

<table>
<thead>
<tr>
<th>ID</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Standard Text Rule</td>
<td>The event was generated when the packet triggered a standard text rule.</td>
</tr>
<tr>
<td>2</td>
<td>Tagged Packets</td>
<td>The event was generated by the Tag generator, which generates packets from a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>tagged session. This occurs when the tag rule option is used.</td>
</tr>
<tr>
<td>3</td>
<td>Shared Object Rule</td>
<td>The event was generated when the packet triggered a shared object rule.</td>
</tr>
<tr>
<td>102</td>
<td>HTTP Decoder</td>
<td>The decoder engine decoded HTTP data within the packet.</td>
</tr>
<tr>
<td>105</td>
<td>Back Orifice Detector</td>
<td>The Back Orifice Detector identified a Back Orifice attack associated with the</td>
</tr>
<tr>
<td>106</td>
<td>RPC Decoder</td>
<td>The RPC decoder decoded the packet.</td>
</tr>
<tr>
<td>116</td>
<td>Packet Decoder</td>
<td>The event was generated by the packet decoder.</td>
</tr>
<tr>
<td>119, 120</td>
<td>HTTP Inspect Preprocessor</td>
<td>The event was generated by the HTTP Inspect preprocessor. GID 120 rules relate to server-specific HTTP traffic.</td>
</tr>
<tr>
<td>ID</td>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>122</td>
<td>Portscan Detector</td>
<td>The event was generated by the portscan flow detector.</td>
</tr>
<tr>
<td>123</td>
<td>IP Defragmentor</td>
<td>The event was generated when a fragmented IP datagram could not be properly reassembled.</td>
</tr>
<tr>
<td>124</td>
<td>SMTP Decoder</td>
<td>The event was generated when the SMTP preprocess detected an exploit against an SMTP verb.</td>
</tr>
<tr>
<td>125</td>
<td>FTP Decoder</td>
<td>The event was generated when the FTP/Telnet decoder detected an exploit within FTP traffic.</td>
</tr>
<tr>
<td>126</td>
<td>Telnet Decoder</td>
<td>The event was generated when the FTP/Telnet decoder detected an exploit within telnet traffic.</td>
</tr>
<tr>
<td>128</td>
<td>SSH Preprocessor</td>
<td>The event was generated when the SSH preprocess detected an exploit within SSH traffic.</td>
</tr>
<tr>
<td>129</td>
<td>Stream Preprocessor</td>
<td>The event was generated during stream preprocessing by the stream preprocessor.</td>
</tr>
<tr>
<td>131</td>
<td>DNS Preprocessor</td>
<td>The event was generated by the DNS preprocessor.</td>
</tr>
<tr>
<td>133</td>
<td>DCE/RPC Preprocessor</td>
<td>The event was generated by the DCE/RPC preprocessor.</td>
</tr>
<tr>
<td>134</td>
<td>Rule Latency</td>
<td>The event was generated when rule latency suspended (134:1) or re-enabled (134:2) a group of intrusion rules, or when the system stopped inspecting a packet because the packet latency threshold was exceeded (134:3).</td>
</tr>
<tr>
<td>135</td>
<td>Rate-Based Attack Detector</td>
<td>The event was generated when a rate-based attack detector identified excessive connections to hosts on the network.</td>
</tr>
<tr>
<td>137</td>
<td>SSL Preprocessor</td>
<td>The event was generated by the TLS/SSL preprocessor.</td>
</tr>
<tr>
<td>138, 139</td>
<td>Sensitive Data Preprocessor</td>
<td>The event was generated by the sensitive data preprocessor.</td>
</tr>
<tr>
<td>140</td>
<td>SIP Preprocessor</td>
<td>The event was generated by the SIP preprocessor.</td>
</tr>
</tbody>
</table>
The event was generated by the IMAP preprocessor.

The event was generated by the POP preprocessor.

The event was generated by the GTP preprocessor.

The event was generated by the Modbus SCADA preprocessor.

The event was generated by the DNP3 SCADA preprocessor.

### Intrusion Event Workflow Pages

The preprocessor, decoder, and intrusion rules that are enabled in the current intrusion policy generate intrusion events whenever the traffic that you monitor violates the policy.

The Firepower System provides a set of predefined workflows, populated with event data, that you can use to view and analyze intrusion events. Each of these workflows steps you through a series of pages to help you pinpoint the intrusion events that you want to evaluate.

The predefined intrusion event workflows contain three different types of pages, or event views:

- one or more drill-down pages
- the table view of intrusion events
- a packet view

**Drill-down pages** generally include two or more columns in a table (and, for some drill-down views, more than one table) that allow you to view one specific type of information.

When you “drill down” to find more information for one or more destination ports, you automatically select those events and the next page in the workflow appears. In this way, drill-down tables help you reduce the number of events you are analyzing at one time.

The initial table view of intrusion events lists each intrusion event in its own row. The columns in the table list information such as the time, the source IP address and port, the destination IP address and port, the event priority, the event message, and more.

When you select events on a table view, instead of selecting events and displaying the next page in the workflow, you add to what are called **constraints**. Constraints are limits that you impose on the types of events that you want to analyze.

For example, if you click the close column icon (×) in any column and clear **Time** from the drop-down list, you can remove Time as one of the columns. To narrow the list of events in your analysis, you can click the link for a value in one of the rows in the table view. For example, to limit your analysis to the events generated by the IMAP preprocessor:

<table>
<thead>
<tr>
<th>ID</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>141</td>
<td>IMAP Preprocessor</td>
<td>The event was generated by the IMAP preprocessor.</td>
</tr>
<tr>
<td>142</td>
<td>POP Preprocessor</td>
<td>The event was generated by the POP preprocessor.</td>
</tr>
<tr>
<td>143</td>
<td>GTP Preprocessor</td>
<td>The event was generated by the GTP preprocessor.</td>
</tr>
<tr>
<td>144</td>
<td>Modbus Preprocessor</td>
<td>The event was generated by the Modbus SCADA preprocessor.</td>
</tr>
<tr>
<td>145</td>
<td>DNP3 Preprocessor</td>
<td>The event was generated by the DNP3 SCADA preprocessor.</td>
</tr>
</tbody>
</table>
from one of the source IP addresses (presumably, a potential attacker), click the IP address in the Source IP Address column.

If you select one or more rows in a table view and then click View, the packet view appears. A packet view provides information about the packet that triggered the rule or the preprocessor that generated the event. Each section of the packet view contains information about a specific layer in the packet. You can expand collapsed sections to see more information.

Note

Because each portscan event is triggered by multiple packets, portscan events use a special version of the packet view.

If the predefined workflows do not meet your specific needs, you can create custom workflows that display only the information you are interested in. Custom intrusion event workflows can include drill-down pages, a table view of events, or both; the system automatically includes a packet view as the last page. You can easily switch between the predefined workflows and your own custom workflows depending on how you want to investigate events.

Using Intrusion Event Workflows

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

The drill-down views and table view of events share some common features that you can use to narrow a list of events and then concentrate your analysis on a group of related events.

To avoid displaying the same intrusion events on different workflow pages, the time range pauses when you click a link at the bottom of the page to display another page of events, and resumes when you click to take any other action on the subsequent page.

Tip

At any point in the process, you can save the constraints as a set of search criteria. For example, if you find that over the course of a few days your network is being probed by an attacker from a single IP address, you can save your constraints during your investigation and then use them again later. You cannot, however, save compound constraints as a set of search criteria.

Procedure

Step 1

Access an intrusion event workflow using Analysis > Intrusions > Events.

Step 2

Optionally, constrain the number of intrusion events that appear on the event views as described in Intrusion Event Drill-Down Page Constraints, on page 1641 or Intrusion Event Table View Constraints, on page 1642.

Step 3

You have the following choices:

- To learn more about the columns that appear, see Intrusion Event Fields, on page 1623.

- To view a host’s profile, click the host profile icon ( ) that appears next to the host IP address.
To view geolocation details, click the flag icon that appears in the Source Country or Destination Country columns.

To modify the time and date range for displayed events, see Changing the Time Window, on page 1543.

**Tip** If no intrusion events appear on the event views, adjusting the specified time range might return results. If you specified an older time range, events in that time range might have been deleted. Adjusting the rule thresholding configuration might generate events.

**Note** Events generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.

To sort events on the current workflow page or navigate within the current workflow page, see Using Workflows, on page 1523.

To navigate between pages in the current workflow, keeping the current constraints, click the appropriate page link at the top left of the workflow page.

To add events to the clipboard so you can transfer them to an incident at a later time, click Copy or Copy All.

To delete events from the event database, check the check boxes next to events you want to delete, then click Delete, or click Delete All.

To mark events reviewed to remove them from intrusion event pages, but not the event database, see Marking Intrusion Events Reviewed, on page 1635.

To download a local copy of the packet (a packet capture file in libpcap format) that triggered each selected event, check the check boxes next to events triggered by the packets you want to download, then click Download Packets, or click Download All Packets. Captured packets are saved in libpcap format. This format is used by several popular protocol analyzers.

To navigate to other event views to view associated events, see Inter-Workflow Navigation, on page 1549.

To temporarily use a different workflow, click (switch workflow).

To bookmark the current page so that you can quickly return to it, click Bookmark This Page.

To view the Intrusion Events section of the Summary Dashboard, click Dashboards.

To navigate to the bookmark management page, click View Bookmarks.

To generate a report based on the data in the current view, see Creating a Report Template from an Event View, on page 1429.

**Related Topics**
Event Searches, on page 1553  
Bookmarks, on page 1550

**Intrusion Event Drill-Down Page Constraints**

The following table describes how to use the drill-down pages.
Table 269: Constraining Events on Drill-Down Pages

<table>
<thead>
<tr>
<th>To...</th>
<th>You can...</th>
</tr>
</thead>
</table>
| drill down to the next workflow page constraining on a specific value | click the value.  
For example, on the Destination Port workflow, to constrain the events to those with a destination of port 80, click `80/tcp` in the DST Port/ICMP Code column. The next page of the workflow, Events, appears and contains only port 80/tcp events. |
| drill down to the next workflow page constraining on selected events | select the check boxes next to the events you want to view on the next workflow page, then click View.  
For example, on the Destination Port workflow, to constrain the events to those with destination ports 20/tcp and 21/tcp, select the check boxes next to the rows for those ports and click View. The next page of the workflow, Events, appears and contains only port 20/tcp and 21/tcp events.  
Note that if you constrain on multiple rows and the table has more than one column (not including a Count column), you build what is called a compound constraint. Compound constraints ensure that you do not include more events in your constraint than you mean to. For example, if you use the Event and Destination workflow, each row that you select on the first drill-down page creates a compound constraint. If you pick event 1:100 with a destination IP address of 10.10.10.100 and you also pick event 1:200 with a destination IP address of 192.168.10.100, the compound constraint ensures that you do not also select events with 1:100 as the event type and 192.168.10.100 as the destination IP address or events with 1:200 as the event type and 10.10.10.100 as the destination IP address. |
| drill down to the next workflow page keeping the current constraints | click View All. |

Intrusion Event Table View Constraints

The following table describes how to use the table view.

Table 270: Constraining Events on the Table View of Events

<table>
<thead>
<tr>
<th>To...</th>
<th>You can...</th>
</tr>
</thead>
</table>
| constrain the view to events with a single attribute | click the attribute.  
For example, to constrain the view to events with a destination of port 80, click `80/tcp` in the DST Port/ICMP Code column. |
### Using the Intrusion Event Packet View

<table>
<thead>
<tr>
<th>To...</th>
<th>You can...</th>
</tr>
</thead>
<tbody>
<tr>
<td>remove a column from the table</td>
<td>click the close icon ( X ) in the column heading that you want to hide. In the pop-up window that appears, click <strong>Apply</strong>. If you want to hide or show other columns, select or clear the appropriate check boxes before you click <strong>Apply</strong>. To add a disabled column back to the view, click the expand arrow ( ▼ ) to expand the search constraints, then click the column name under <strong>Disabled Columns</strong>.</td>
</tr>
<tr>
<td>view the packets associated with one or more events</td>
<td>either: • click the down arrow icon ( ▼ ) next to the event whose packets you want to view. • select one or more events whose packets you want to view, and, at the bottom of the page, click <strong>View</strong>. • at the bottom of the page, click <strong>View All</strong> to view the packets for all events that match the current constraints.</td>
</tr>
</tbody>
</table>

### Using the Intrusion Event Packet View

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

A packet view provides information about the packet that triggered the rule that generated an intrusion event.

**Tip**

The packet view on a Firepower Management Center does not contain packet information when the **Transfer Packet** option is disabled for the device detecting the event.

The packet view indicates why a specific packet was captured by providing information about the intrusion event that the packet triggered, including the event’s time stamp, message, classification, priority, and, if the event was generated by a standard text rule, the rule that generated the event. The packet view also provides general information about the packet, such as its size.

In addition, the packet view has a section that describes each layer in the packet: data link, network, and transport, as well as a section that describes the bytes that comprise the packet. If the system decrypted the packet, you can view the decrypted bytes. You can expand collapsed sections to display detailed information.

**Note**

Because each portscan event is triggered by multiple packets, portscan events use a special version of the packet view.
In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1**
On the table view of intrusion events, choose packets to view as described in Intrusion Event Table View Constraints, on page 1642.

**Step 2**
Optionally, if you chose more than one event, you can page through the packets in the packet view by using the page numbers at the bottom of the page.

**Step 3**
You also have the following options:

- **Adjust** — To modify the date and time range in the packet views, see Changing the Time Window, on page 1543.
- **Clipboard** — To add an event to the clipboard so you can transfer it to the incidents at a later time, click Copy to copy the event whose packet you are viewing or click **Copy All** to copy all the events whose packets you previously selected.
- **Configure** — To configure the intrusion rule that triggered the event, click the arrow next to Actions and continue as described in Configuring Intrusion Rules within the Packet View, on page 1647.
- **Delete** — To delete an event from the database, click **Delete** to delete the event whose packet you are viewing or click **Delete All** to delete all the events whose packets you previously selected.
- **Download** — To download a local copy of the packet (a packet capture file in libpcap format) that triggered the event, click **Download Packet** to save a copy of the captured packet for the event you are viewing or click **Download All Packets** to save copies of the captured packets for all the events whose packets you previously selected. The captured packet is saved in libpcap format. This format is used by several popular protocol analyzers.

**Note**
You cannot download a portscan packet because single portscan events are based on multiple packets; however, the portscan view provides all usable packet information. You must have at least 15% available disk space in order to download.

- **Mark reviewed** — To mark an event reviewed to remove it from event views, but not the event database, click **Review** to mark the event whose packet you are viewing or click **Review All** to mark all the events whose packets you previously selected. For more information, see Marking Intrusion Events Reviewed, on page 1635.
- **View additional information** — To expand or collapse a page section, click the arrow next to the section. For details, see Event Information Fields, on page 1644, Frame Information Fields, on page 1650, and Data Link Layer Information Fields, on page 1651.
- **View network layer information** — See Viewing Network Layer Information, on page 1652.
- **View packet byte information** — See Viewing Packet Byte Information, on page 1657.
- **View transport layer information** — See Viewing Transport Layer Information, on page 1655

**Related Topics**
- Portscan Detection, on page 1175
- The Intrusion Events Clipboard, on page 1658

**Event Information Fields**
On the packet view, you can view information about the packet in the Event Information section.
Event
The event message. For rule-based events, this corresponds to the rule message. For other events, this is determined by the decoder or preprocessor.

The ID for the event is appended to the message in the format (GID:SID:Rev). GID is the generator ID of the rules engine, the decoder, or the preprocessor that generated the event. SID is the identifier for the rule, decoder message, or preprocessor message. Rev is the revision number of the rule.

Timestamp
The time that the packet was captured, in UTC time zone.

Classification
The event classification. For rule-based events, this corresponds to the rule classification. For other events, this is determined by the decoder or preprocessor.

Priority
The event priority. For rule-based events, this corresponds to either the value of the priority keyword or the value for the classtype keyword. For other events, this is determined by the decoder or preprocessor.

Ingress Security Zone
The ingress security zone of the packet that triggered the event. Only this security zone field is populated in a passive deployment.

Egress Security Zone
The egress security zone of the packet that triggered the event. This field is not populated in a passive deployment.

Domain
The domain where the managed device belongs. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

Device
The managed device where the access control policy was deployed.

Note that the primary and secondary devices in a stacked configuration report intrusion events as if they were separate devices.

Security Context
The metadata identifying the virtual firewall group through which the traffic passed. Note that the system only populates this field for ASA FirePOWER in multiple context mode.

Ingress Interface
The ingress interface of the packet that triggered the event. Only this interface column is populated for a passive interface.
**Egress Interface**
For an inline set, the egress interface of the packet that triggered the event.

**Source/Destination IP**
The host IP address or domain name where the packet that triggered the event (source) originated, or the target (destination) host of the traffic that triggered the event.

**Source Port/ICMP Type**
Source port of the packet that triggered the event. For ICMP traffic, where there is no port number, the system displays the ICMP type.

**Destination Port/ICMP Code**
The port number for the host receiving the traffic. For ICMP traffic, where there is no port number, the system displays the ICMP code.

**Email Headers**
The data that was extracted from the email header. Note that email headers do not appear in the table view of intrusion events, but you can use email header data as a search criterion.

To associate email headers with intrusion events for SMTP traffic, you must enable the SMTP preprocessor **Log Headers** option. For rule-based events, this row appears when email data is extracted.

**HTTP Hostname**
The hostname, if present, extracted from the HTTP request Host header. This row displays the complete host name, up to 256 bytes. You can expand the complete host name if it is longer than a single row.

To display host names, you must enable the HTTP Inspect preprocessor **Log Hostname** option.

Note that HTTP request packets do not always include a host name. For rule-based events, this row appears when the packet contains the HTTP host name or the HTTP URI.

**HTTP URI**
The raw URI, if present, associated with the HTTP request packet that triggered the intrusion event. This row displays the complete URI, up to 2048 bytes. You can expand the complete URI if it is longer than a single row.

To display the URI, you must enable the HTTP Inspect preprocessor **Log URI** option.

Note that HTTP request packets do not always include a URI. For rule-based events, this row appears when the packet contains the HTTP host name or the HTTP URI.

To see the associated HTTP URI in intrusion events triggered by HTTP responses, you should configure HTTP server ports in the **Perform Stream Reassembly on Both Ports** option; note, however, that this increases resource demands for traffic reassembly.

**Intrusion Policy**
The intrusion policy, if present, where the intrusion, preprocessor, or decoder rule that generated the intrusion event was enabled. You can choose an intrusion policy as the default action for an access control policy or associate an intrusion policy with an access control rule.
Access Control Policy
The access control policy that includes the intrusion policy where the intrusion, preprocessor, or decoder rule that generated the event is enabled.

Access Control Rule
The access control rule associated with an intrusion rule that generated the event. Default Action indicates that the intrusion policy where the rule is enabled is not associated with an access control rule but, instead, is configured as the default action of the access control policy.

Rule
For standard text rule events, the rule that generated the event.
Note that if the event is based on a shared object rule, a decoder, or a preprocessor, the rule is not available.
Because rule data may contain sensitive information about your network, administrators may toggle users’ ability to view rule information in the packet view with the View Local Rules permission in the user role editor.

Actions
For standard text and custom rule events, expand Actions to take any of the following actions on the rule that triggered the event:
• edit the rule
• view documentation for the revision of the rule
• add a comment to the rule
• change the state of the rule
• set a threshold for the rule
• suppress the rule

Note that if the event is based on a shared object rule, a decoder, or a preprocessor, the rule is not available.

Configuring Intrusion Rules within the Packet View

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

Within the packet view of an intrusion event, you can take several actions on the rule that triggered the event. Note that if the event is based on a shared object rule, a decoder, or a preprocessor, the rule is not available.

Procedure

Step 1
Within the packet view of an intrusion event that was generated by an intrusion rule, expand Actions in the Event Information section.

Step 2
You have the following choices:
• **Comment** — For standard text rule events, click **Rule Comment** to add a text comment to the rule that generated the event. This allows you to provide additional context and information about the rule and the exploit or policy violation it identifies. You can also add and view rule comments in the intrusion rules editor.

• **Disable** — Click **Disable this rule...** to disable the rule.

If this event is generated by a standard text rule, you can disable the rule, if necessary. You can set the rule in all policies that you can edit locally. Alternately, you can set the rule only in the current policy (that is, the policy that generated the event) if you can edit the current policy locally.

Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by the system.

**Note** You **cannot** disable shared object rules from the packet view, nor can you disable rules in the default policies.

• **Drop packets** — Click **Set this rule to drop the triggering packet...** to set the rule to drop packets that trigger it.

If your managed device is deployed inline on your network, you can set the rule that triggered the event to drop packets that trigger the rule in all policies that you can edit locally. Alternately, you can set the rule only in the current policy (that is, the policy that generated the event) if you can edit the current policy locally.

Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by the system. Note also that this option appears only when **Drop when Inline** is enabled in the current policy.

• **Edit** — For standard text rule events, click **Edit** to modify the rule that generated the event. If the event is based on a shared object rule, a decoder, or a preprocessor, the rule is not available.

**Note** If you edit a system-provided rule (as opposed to a custom standard text rule), you actually create a new local rule. Make sure you set the local rule to generate events and also disable the original rule in the current intrusion policy. Note, however, that you **cannot** enable local rules in the default policies.

• **Generate events** — Click **Set this rule to generate events...** to set the rule to generate events.

If this event is generated by a standard text rule, you can set the rule to generate events in all policies that you can edit locally. Alternately, you can set the rule only in the current policy (that is, the policy that generated the event) if you can edit the current policy locally.

Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by the system.

**Note** You **cannot** set shared object rules to generate events from the packet view, nor can you disable rules in the default policies.

• **Set suppression options** — Expand **Set Suppression Options** and continue as described in **Setting Suppression Options within the Packet View, on page 1650**.

You can use this option to suppress the rule that triggered this event in all policies that you can edit locally. Alternately, you can suppress the rule only in the current policy (that is, the policy that generated the event) if you can edit the current policy locally.

Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by Cisco.
• Set threshold options — Expand **Set Thresholding Options** and continue as described in **Setting Threshold Options within the Packet View**, on page 1649.

You can use this option to create a threshold for the rule that triggered this even in all policies that you can edit locally. Alternately, you create a threshold only for the current policy (that is, the policy that generated the event) if you can edit the current policy locally.

Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default intrusion policy provided by the system.

• View documentation — Click **View Documentation** to learn more about the rule that generated the event.

### Setting Threshold Options within the Packet View

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can control the number of events that are generated per rule over time by setting the threshold options in the packet view of an intrusion event. You can set threshold options in all policies that you can edit locally or, when it can be edited locally, only in the in the current policy (that is, the policy that caused the event to be generated).

**Procedure**

**Step 1**
Within the packet view of an intrusion event that was generated by an intrusion rule, expand **Actions** in the Event Information section.

**Step 2**
Expand **Set Thresholding Options** and choose one of the two possible options:

- **in the current policy**
- **in all locally created policies**

**Note** The current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by the system.

**Step 3**
Choose the type of threshold you want to set:

- Click **limit** to limit notification to the specified number of event instances per time period.
- Click **threshold** to provide notification for each specified number of event instances per time period.
- Click **both** to provide notification once per time period after a specified number of event instances.

**Step 4**
Click the appropriate radio button to indicate whether you want the event instances tracked by **Source** or **Destination** IP address.

**Step 5**
In the **Count** field, enter the number of event instances you want to use as your threshold.

**Step 6**
In the **Seconds** field, enter a number between 1 and 86400 that specifies the time period for which event instances are tracked.
Step 7  If you want to override any current thresholds for this rule in existing intrusion policies, check the Override any existing settings for this rule checkbox.

Step 8  Click Save Thresholding.

### Setting Suppression Options within the Packet View

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

You can use the suppression options to suppress intrusion events altogether, or based on the source or destination IP address. You can set suppression options in all policies that you can edit locally. Alternately, you can set suppression options only in the current policy (that is, the policy that generated the event) when the current policy can be edited locally.

**Procedure**

#### Step 1
Within the packet view of an intrusion event that was generated by an intrusion rule, expand Actions in the Event Information section.

#### Step 2
Expand Set Suppression Options and click one of the two possible options:

- **in the current policy**
- **in all locally created policies**

**Note**  The current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by Cisco.

#### Step 3
Choose one of the following Track By options:

- Click **Source** to suppress events generated by packets originating from a specified source IP address.
- Click **Destination** to suppress events generated by packets going to a specified destination IP address.
- Click **Rule** to completely suppress events for the rule that triggered this event.

#### Step 4
In the **IP address or CIDR block** field, enter the IP address or CIDR block/prefix length you want to specify as the source or destination IP address.

#### Step 5
Click Save Suppression.

**Related Topics**

Firepower System IP Address Conventions, on page 14

### Frame Information Fields

On the packet view, click the arrow next to Frame to view information about the captured frame. The packet view may display a single frame or multiple frames. Each frame provides information about an individual network packet. You would see multiple frames, for example, in the case of tagged packets or packets in reassembled TCP streams.
Frame n
The captured frame, where \( n \) is 1 for single-frame packets and the incremental frame number for multi-frame packets. The number of captured bytes in the frame is appended to the frame number.

Arrival Time
The date and time the frame was captured.

Time delta from previous captured frame
For multi-frame packets, the elapsed time since the previous frame was captured.

Time delta from previous displayed frame
For multi-frame packets, the elapsed time since the previous frame was displayed.

Time since reference or first frame
For multi-frame packets, the elapsed time since the first frame was captured.

Frame Number
The incremental frame number.

Frame Length
The length of the frame in bytes.

Capture Length
The length of the captured frame in bytes.

Frame is marked
Whether the frame is marked (true or false).

Protocols in frame
The protocols included in the frame.

Related Topics
- The tag Keyword, on page 1022
- TCP Stream Reassembly, on page 1160

Data Link Layer Information Fields
On the packet view, click the arrow next to the data link layer protocol (for example, Ethernet II) to view the data link layer information about the packet, which contains the 48-bit media access control (MAC) addresses for the source and destination hosts. It may also display other information about the packet, depending on the hardware protocol.
NotethatthisexamplediscussesEthernetlinklayerinformation;otherprotocolsmayalsoappear.

Thepacketviewreflectstheprotocolusedatthedatalinklayer. Thefollowinglistingdescribethesinformation
youmightseeforanEthernetIIorIEEE802.3Ethernetpacketinthepacketview.

**Destination**
TheMACaddressforthedestinationhost.

**Note**
Ethernetcanalsousemulticastandbroadcastaddressesasthedestinationaddress.

**Source**
TheMACaddressforthesourcehost.

**Type**
ForEthernetIIpackets,thetypeofpacketthatisencapsulatedintheEthernetframe;forexample,IPv6or
ARPdatagrams. NotethatitisitemonlyappearsforEthernetIIpackets.

**Length**
ForIEEE802.3Ethernetpackets,thetotallengthofthepacket,inbytes,notincludingthechcksum. NotethatitisitemonlyappearsforIEEE802.3Ethernetpackets.

**ViewingNetworkLayerInformation**

<table>
<thead>
<tr>
<th><strong>SmartLicense</strong></th>
<th><strong>ClassicLicense</strong></th>
<th><strong>SupportedDevices</strong></th>
<th><strong>SupportedDomains</strong></th>
<th><strong>Access</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

**Procedure**

Onthepacketview,clickthearrownexttothenetworklayerprotocol(forexample,InternetProtocol)to
viewmoredetailedinformationaboutnetworklayerinformationrelatedtothepacket.

**Note**
NotethatthisexamplediscussessIPpackets;otherprotocolsmayalsoappear.

**IPv4NetworkLayerInformationFields**
Thefollowinglistingdescribesprotocol-specificinformationthatmightappearinanIPv4packet.
**Version**

The Internet Protocol version number.

**Header Length**

The number of bytes in the header, including any IP options. An IP header with no options is 20 bytes long.

**Differentiated Services Field**

The values for differentiated services that indicate how the sending host supports Explicit Congestion Notification (ECN):

- \( 0x0 \) — does not support ECN-Capable Transport (ECT)
- \( 0x1 \) and \( 0x2 \) — supports ECT
- \( 0x3 \) — Congestion Experienced (CE)

**Total Length**

The length of the IP packet, in bytes, minus the IP header.

**Identification**

The value that uniquely identifies an IP datagram sent by the source host. This value is used to trace fragments of the same datagram.

**Flags**

The values that control IP fragmentation, where:

Values for the Last Fragment flag indicate whether there are more fragments associated with the datagram:

- \( 0 \) — there are no more fragments associated with the datagram
- \( 1 \) — there are more fragments associated with the datagram

Values for the Don’t Fragment flag control whether the datagram can be fragmented:

- \( 0 \) — the datagram can be fragmented
- \( 1 \) — the datagram must not be fragmented

**Fragment Offset**

The value for the fragment offset from the beginning of the datagram.

**Time to Live (ttl)**

The remaining number of hops that the datagram can make between routers before the datagram expires.

**Protocol**

The transport protocol that is encapsulated in the IP datagram; for example, ICMP, IGMP, TCP, or UDP.
**Header Checksum**

The indicator for whether the IP checksum is valid. If the checksum is invalid, the datagram may have been corrupted during transit or may be being used in an intrusion evasion attempt.

**Source/Destination**

The IP address or domain name for the source (or destination) host.

Note that to display the domain name, you must enable IP address resolution.

Click the address or domain name to view the context menu, then select **Whois** to do a whois search on the host, **View Host Profile** to view host information, or **Blacklist Now** or **Whitelist Now** to add the address to a global blacklist or whitelist.

**IPv6 Network Layer Information Fields**

The following listing describes protocol-specific information that might appear in an IPv6 packet.

**Traffic Class**

An experimental 8-bit field in the IPv6 header for identifying IPv6 packet classes or priorities similar to the differentiated services functionality provided for IPv4. When unused, this field is set to zero.

**Flow Label**

A optional 20-bit IPv6 hexadecimal value 1 to FFFFF that identifies a special flow such as non-default quality of service or real-time service. When unused, this field is set to zero.

**Payload Length**

A 16-bit field identifying the number of octets in the IPv6 payload, which is comprised of all of the packet following the IPv6 header, including any extension headers.

**Next Header**

An 8-bit field identifying the type of header immediately following the IPv6 header, using the same values as the IPv4 Protocol field.

**Hop Limit**

An 8-bit decimal integer that each node that forwards the packet decrements by one. The packet is discarded if the decremented value reaches zero.

**Source**

The 128-bit IPv6 address for the source host.

**Destination**

The 128-bit IPv6 address for the destination host.
Viewing Transport Layer Information

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1**
On the packet view, click the arrow next to the transport layer protocol (for example, TCP, UDP, or ICMP).

**Step 2**
Optionally, click **Data** when present to view the first twenty-four bytes of the payload for the protocol immediately above it in the Packet Information section of the packet view.

**Step 3**
View the contents of the transport layer for TCP, UDP, and ICMP protocols as described in TCP Packet View Fields, on page 1655, UDP Packet View Fields, on page 1656, or ICMP Packet View Fields, on page 1656.

**Note**
Note that these examples discuss TCP, UDP, and ICMP packets; other protocols may also appear.

### TCP Packet View Fields

This section describes the protocol-specific information for a TCP packet.

**Source port**
The number that identifies the originating application protocol.

**Destination port**
The number that identifies the receiving application protocol.

**Sequence number**
The value for the first byte in the current TCP segment, keyed to initial sequence number in the TCP stream.

**Next sequence number**
In a response packet, the sequence number of the next packet to send.

**Acknowledgement number**
The TCP acknowledgement, which is keyed to the sequence number of the previously accepted data.

**Header Length**
The number of bytes in the header.

**Flags**
The six bits that indicate the TCP segment’s transmission state:

- \( u \) — the urgent pointer is valid
• A — the acknowledgement number is valid
• F — the receiver should push data
• R — reset the connection
• S — synchronize sequence numbers to start a new connection
• P — the sender has finished sending data

**Window size**
The amount of unacknowledged data, in bytes, that the receiving host will accept.

**Checksum**
The indicator for whether the TCP checksum is valid. If the checksum is invalid, the datagram may have been corrupted during transit or may be being used in an in evasion attempt.

**Urgent Pointer**
The position, if present, in the TCP segment where the urgent data ends. Used in conjunction with the U flag.

**Options**
The values, if present, for TCP options.

**UDP Packet View Fields**
This section describes the protocol-specific information for a UDP packet.

**Source port**
The number that identifies the originating application protocol.

**Destination port**
The number that identifies the receiving application protocol.

**Length**
The combined length of the UDP header and data.

**Checksum**
The indicator for whether the UDP checksum is valid. If the checksum is invalid, the datagram may have been corrupted during transit.

**ICMP Packet View Fields**
This section describes the protocol-specific information for an ICMP packet.

**Type**
The type of ICMP message:
• 0 — echo reply
• 3 — destination unreachable
• 4 — source quench
• 5 — redirect
• 8 — echo request
• 9 — router advertisement
• 10 — router solicitation
• 11 — time exceeded
• 12 — parameter problem
• 13 — timestamp request
• 14 — timestamp reply
• 15 — information request (obsolete)
• 16 — information reply (obsolete)
• 17 — address mask request
• 18 — address mask reply

**Code**
The accompanying code for the ICMP message type. ICMP message types 3, 5, 11, and 12 have corresponding codes as described in RFC 792.

**Checksum**
The indicator for whether the ICMP checksum is valid. If the checksum is invalid, the datagram may have been corrupted during transit.

**Viewing Packet Byte Information**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

**Procedure**

On the packet view, click the arrow next to **Packet Bytes** to view hexadecimal and ASCII versions of the bytes that comprise the packet. If the system decrypted traffic, you can view the decrypted packet bytes.
The Intrusion Events Clipboard

The clipboard is a holding area where you can copy intrusion events from any of the intrusion event views. The contents of the clipboard are sorted by the date and time that the events were generated. After you add intrusion events to the clipboard, you can delete them from the clipboard as well as generate reports on the contents of the clipboard.

You can also add intrusion events from the clipboard to incidents, which are compilations of events that you suspect are involved in a possible violation of your security policies.

Related Topics
- Using Intrusion Event Workflows, on page 1640
- Using the Intrusion Event Packet View, on page 1643
- Creating an Incident, on page 1507

Generating Clipboard Reports

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

You can generate a report for the events on the clipboard just as you would from any of the event views.

Before you begin
- Add one or more events to the clipboard as described in Using Intrusion Event Workflows, on page 1640 or Using the Intrusion Event Packet View, on page 1643.

Procedure

Step 1 Choose Analysis > Intrusions > Clipboard.
Step 2 You have the following options:
- To include specific events from a page on the clipboard, navigate to that page, check the check box next to the events, and click Generate Report.
- To include all the events from the clipboard, click Generate Report All.
Step 3 Specify how you want your report to look, then click Generate.
Step 4 Choose one or more output formats and, optionally, modify any of the other settings.
Step 5 Click Generate, then click Yes.
Step 6 You have the following choices:
- Click a report link to display the report in a new window.
- Click OK to return to the Report Templates page where you can modify your report design.
Deleting Events from the Clipboard

If you have intrusion events on the clipboard that you do not want to add to an incident, you can delete the events.

Note
Deleting an event from the clipboard does not delete the event from the event database. However, deleting an event from the event database does delete the event from the clipboard.

Procedure

Step 1
Choose Analysis > Intrusions > Clipboard.

Step 2
You have the following options:

• Delete specific events — To delete specific intrusion events from a page on the clipboard, navigate to the page, check the check box next to the events, and click Delete.

• Delete all events — To delete all the intrusion events from the clipboard, click Delete All. Note that if you choose the Confirm ’All’ Actions option in the Event Preferences, you are first prompted to confirm that you want to delete all the events.

Viewing Intrusion Event Statistics

The Intrusion Event Statistics page provides you with a quick summary of the current state of your appliance and any intrusion events generated for your network.

Each of the IP addresses, ports, protocols, event messages, and so on shown on the page is a link. Click any link to view the associated event information. For example, if one of the top 10 destination ports is 80 (http/tcp), clicking that link displays the first page in the default intrusion events workflow, and lists the events targeting that port. Note that only the events (and the managed devices that generate events) in the current time range appear. Also, intrusion events that you have marked reviewed continue to appear in the statistics. For example, if the current time range is the past hour but the first event was generated five hours ago.
ago, when you click the First Event link, the resulting event pages will not show the event until you change the time range.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose Overview > Summary > Intrusion Event Statistics.

**Step 2** From the two selection boxes at the top of the page, choose the zones and devices whose statistics you want to view, or choose All Security Zones and All Devices to view statistics for all the devices that are collecting intrusion events.

**Step 3** Click Get Statistics.

**Tip** To view data from a custom time range, click the link in the upper right page area and follow the directions in Changing the Time Window, on page 1543.

---

**Host Statistics**

The Host Statistics section of the Intrusion Event Statistics page provides information about the appliance itself. On the Firepower Management Center, this section also provides information about any managed devices.

This information includes the following:

**Time**

The current time on the appliance.

**Uptime**

The number of days, hours, and minutes since the appliance itself was restarted. On the Firepower Management Center, the uptime also shows the last time each managed device was rebooted, the number of users logged in, and the load average.

**Disk Usage**

The percentage of the disk that is being used.

**Memory Usage**

The percentage of system memory that is being used.

**Load Average**

The average number of processes in the CPU queue for the past 1 minute, 5 minutes, and 15 minutes.

---

**Event Overview**

The Event Overview section of the Intrusion Event Statistics page provides an overview of the information in the intrusion event database.

These statistics include the following:
Events

The number of events in the intrusion event database.

Events in Time Range

The currently selected time range as well as the number and percentage of events from the database that fall within the time range.

First Event

The event message for the first event in the event database.

Last Event

The event message for the last event in the event database.

Note

If you select a managed device while viewing intrusion event data on the Firepower Management Center, the Event Overview section for that device appears instead.

Event Statistics

The Event Statistics section of the Intrusion Event Statistics page provides more specific information about the information in the intrusion event database.

This information includes details on:

• the top 10 event types
• the top 10 source IP addressees
• the top 10 destination IP addresses
• the top 10 destination ports
• the protocols, ingress and egress security zones, and devices with the greatest number of events

Note

In a multidomain deployment, the system builds a separate network map for each leaf domain. As a result, a leaf domain can contain an IP address that is unique within its network, but identical to an IP address in another leaf domain. When you view event statistics in an ancestor domain, the system may display multiple instances of that repeated IP address. At first glance, they might appear to be duplicate entries. However, if you drill down to the host profile information for each IP address, the system shows that they belong to different leaf domains.

Viewing Intrusion Event Performance Graphs

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>
The intrusion event performance page allows you to generate graphs that depict performance statistics for intrusion events over a specific period of time for a Firepower Management Center or a managed device. Graphs can be generated to reflect number of intrusion events per second, number of megabits per second, average number of bytes per packet, the percent of packets uninspected by Snort, and the number of packets blocked as the result of TCP normalization. These graphs can show statistics for the last hour, last day, last week, or last month of operation.

New data is accumulated for statistics graphs every five minutes. Therefore, if you reload a graph quickly, the data may not change until the next five-minute increment occurs. Each graph displays average values in the intervals shown (day, hour, or five minutes) for the selected time period (last month, week, day, or hour). Decimal values are displayed when the average is less than one.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose Overview > Summary > Intrusion Event Performance.

**Step 2** From the Select Device list, choose the devices whose data you want to view.

**Step 3** From the Select Graph(s) list, choose the type of graph you want to create as described in Intrusion Event Performance Statistics Graph Types, on page 1662.

**Step 4** From the Select Time Range list, choose the time range you would like to use for the graph.

**Step 5** Click Graph.

**Step 6** To save the graph, right-click it and follow the instructions for your browser to save the image.

**Intrusion Event Performance Statistics Graph Types**

The following table lists the available graph types. Note that graph types display differently if they are populated with data affected by the network analysis policy **Inline Mode** setting. If **Inline Mode** is disabled, the graph types marked with an asterisk (*) in the web interface (a **yes** in the column below) populate with data about the traffic the system would have modified or dropped if **Inline Mode** was enabled.

<table>
<thead>
<tr>
<th>To generate data for...</th>
<th>You must...</th>
<th>Which represents...</th>
<th>Affected by Inline Mode?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg Bytes/Packet</td>
<td>n/a</td>
<td>the average number of bytes included in each packet.</td>
<td>no</td>
</tr>
<tr>
<td>ECN Flags Normalized in TCP Traffic/Packet</td>
<td>enable <strong>Explicit Congestion Notification</strong> and select Packet</td>
<td>the number of packets for which ECN flags have been cleared on a per-packet basis regardless of negotiation.</td>
<td>yes</td>
</tr>
<tr>
<td>To generate data for...</td>
<td>You must...</td>
<td>Which represents...</td>
<td>Affected by Inline Mode?</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>ECN Flags Normalized in TCP Traffic/Session</td>
<td>enable <strong>Explicit Congestion Notification</strong> and select <strong>Stream</strong></td>
<td>the number of times that ECN flags have been cleared on a per-stream basis when ECN use was not negotiated.</td>
<td>yes</td>
</tr>
<tr>
<td>Events/Sec</td>
<td>n/a</td>
<td>the number of events per second generated on the device.</td>
<td>no</td>
</tr>
<tr>
<td>ICMPv4 Echo Normalizations</td>
<td>enable <strong>Normalize ICMPv4</strong></td>
<td>the number of ICMPv4 packets for which the 8-bit Code field in Echo (Request) or Echo Reply messages were cleared.</td>
<td>yes</td>
</tr>
<tr>
<td>ICMPv6 Echo Normalizations</td>
<td>enable <strong>Normalize ICMPv6</strong></td>
<td>the number of ICMPv6 packets for which the 8-bit Code field in Echo (Request) or Echo Reply messages was cleared.</td>
<td>yes</td>
</tr>
<tr>
<td>IPv4 DF Flag Normalizations</td>
<td>enable <strong>Normalize IPv4</strong> and <strong>Normalize Don’t Fragment Bit</strong></td>
<td>the number of IPv4 packets for which the single-bit Don’t Fragment subfield of the IPv4 Flags header field was cleared.</td>
<td>yes</td>
</tr>
<tr>
<td>IPv4 Options Normalizations</td>
<td>enable <strong>Normalize IPv4</strong></td>
<td>the number of IPv4 packets for which the option octet was set to 1 (No Operation).</td>
<td>yes</td>
</tr>
<tr>
<td>IPv4 Reserved Flag Normalizations</td>
<td>enable <strong>Normalize IPv4</strong> and <strong>Normalize Reserved Bit</strong></td>
<td>the number of IPv4 packets for which the single-bit Reserved subfield of the IPv4 Flags header field was cleared.</td>
<td>yes</td>
</tr>
<tr>
<td>IPv4 Resize Normalizations</td>
<td>enable <strong>Normalize IPv4</strong></td>
<td>the number of IPv4 packets with excessive-length payload that have been truncated to the datagram length specified in the IP header.</td>
<td>yes</td>
</tr>
<tr>
<td>IPv4 TOS Normalizations</td>
<td>enable <strong>Normalize IPv4</strong> and <strong>Normalize TOS Bit</strong></td>
<td>the number of IPv4 packets for which the one-byte Differentiated Services (DS) field (formerly known as the Type of Service (TOS) field) was cleared.</td>
<td>yes</td>
</tr>
<tr>
<td>IPv4 TTL Normalizations</td>
<td>enable <strong>Normalize IPv4, Maximum TTL, and Reset TTL</strong></td>
<td>the number of IPv4 Time to Live normalizations.</td>
<td>yes</td>
</tr>
<tr>
<td>To generate data for...</td>
<td>You must...</td>
<td>Which represents...</td>
<td>Affected by Inline Mode?</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------</td>
<td>---------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>IPv6 Options Normalizations</td>
<td>enable Normalize IPv6</td>
<td>the number of IPv6 packets for which the Option Type field in the Hop-by-Hop Options or Destination Options extension header was set to 00 (Skip and continue processing).</td>
<td>yes</td>
</tr>
<tr>
<td>IPv6 TTL Normalizations</td>
<td>enable Normalize IPv6, Minimum TTL, and Reset TTL</td>
<td>the number of IPv6 Hop Limit (TTL) normalizations.</td>
<td>yes</td>
</tr>
<tr>
<td>Mbits/Sec</td>
<td>n/a</td>
<td>the number of megabits per second of traffic that passes through the device.</td>
<td>no</td>
</tr>
<tr>
<td>Packet Resized to Fit MSS Normalizations</td>
<td>enable Trim Data to MSS</td>
<td>the number of packets for which the payload was longer than the TCP Data field, so the payload was trimmed to the Maximum Segment Size.</td>
<td>yes</td>
</tr>
<tr>
<td>Packet Resized to Fit TCP Window Normalizations</td>
<td>enable Trim Data to Window</td>
<td>the number of packets for which the TCP Data field was trimmed to fit the receiving host’s TCP window.</td>
<td>yes</td>
</tr>
<tr>
<td>Percent Packets Dropped</td>
<td>n/a</td>
<td>the average percentage of uninspected packets across all selected devices. For example, if you select two devices, then an average of 50% may indicate that one device has a 90% drop rate and the other has a 10% drop rate. It may also indicate that both devices have a drop rate of 50%. The graph only represents the total % drop when you select a single device.</td>
<td>no</td>
</tr>
<tr>
<td>RST Packets With Data Stripped Normalizations</td>
<td>enable Remove Data on RST</td>
<td>the number of packets for which data was removed from a TCP reset (RST) packet.</td>
<td>yes</td>
</tr>
<tr>
<td>SYN Packets With Data Stripped Normalizations</td>
<td>enable Remove Data on SYN</td>
<td>the number of packets for which data was removed from SYN packets when the TCP operating system was not Mac OS.</td>
<td>yes</td>
</tr>
<tr>
<td>TCP Header Padding Normalizations</td>
<td>enable Normalize/Clear Option Padding Bytes</td>
<td>the number of TCP packets in which option padding bytes were set to 0.</td>
<td>yes</td>
</tr>
<tr>
<td>To generate data for...</td>
<td>You must...</td>
<td>Which represents...</td>
<td>Affected by Inline Mode?</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
<td>---------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>TCP No Option Normalizations</td>
<td>enable <strong>Allow These TCP Options</strong> and set to an option other than any</td>
<td>the number of packets from which the Time Stamp option was stripped.</td>
<td>yes</td>
</tr>
<tr>
<td>TCP NS Flag Normalizations</td>
<td>enable <strong>Explicit Congestion Notification</strong> and select Packet</td>
<td>the number of ECN Nonce Sum (NS) option normalizations.</td>
<td>yes</td>
</tr>
<tr>
<td>TCP Options Normalizations</td>
<td>enable <strong>Allow These TCP Options</strong> and set to an option other than any</td>
<td>the number of options (excluding MSS, Window Scale, Time Stamp, and explicitly allowed options) for which the option field is set to No Operation (TCP Option 1).</td>
<td>yes</td>
</tr>
<tr>
<td>TCP Packets Blocked By Normalizations</td>
<td>enable <strong>Normalize TCP Payload</strong> (segment reassembly must fail)</td>
<td>the number of packets dropped because the TCP segments could not be properly reassembled.</td>
<td>yes</td>
</tr>
<tr>
<td>TCP Reserved Flags Normalizations</td>
<td>enable <strong>Normalize/Clear Reserved Bits</strong></td>
<td>the number of TCP packets where the Reserved bits have been cleared.</td>
<td>yes</td>
</tr>
<tr>
<td>TCP Segment Reassembly Normalizations</td>
<td>enable <strong>Normalize TCP Payload</strong> (segment reassembly must be successful)</td>
<td>the number of packets for which the TCP Data field was normalized to ensure consistency in retransmitted data (any segments that cannot be properly reassembled are dropped).</td>
<td>yes</td>
</tr>
<tr>
<td>TCP SYN Option Normalizations</td>
<td>enable <strong>Allow These TCP Options</strong> and set to an option other than any</td>
<td>the number of options for which the Maximum Segment Size or Window Scale option was set to No Operation (TCP Option 1) because the SYN control bit was not set.</td>
<td>yes</td>
</tr>
<tr>
<td>TCP Timestamp ECR Normalizations</td>
<td>enable <strong>Allow These TCP Options</strong> and set to an option other than any</td>
<td>the number of packets for which the Time Stamp Echo Reply (TSecr) option field was cleared because the Acknowledgment (ACK) control bit was not set.</td>
<td>yes</td>
</tr>
<tr>
<td>TCP Urgent Pointer Normalizations</td>
<td>enable <strong>Normalize Urgent Pointer</strong></td>
<td>the number of packets for which the two-byte TCP header Urgent Pointer field was greater than the payload length and was set to the payload length.</td>
<td>yes</td>
</tr>
<tr>
<td>To generate data for...</td>
<td>You must...</td>
<td>Which represents...</td>
<td>Affected by Inline Mode?</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
<td>---------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Total Blocked Packets</td>
<td>configure <strong>Inline Mode</strong> or <strong>Drop when Inline</strong></td>
<td>the total number of dropped packets, including rule, decoder, and preprocessor drops.</td>
<td>no</td>
</tr>
<tr>
<td>Total Injected Packets</td>
<td>configure <strong>Inline Mode</strong></td>
<td>the number of packets that were resized before being retransmitted.</td>
<td>no</td>
</tr>
<tr>
<td>Total TCP Filtered Packets</td>
<td>configure TCP Stream Preprocessing</td>
<td>the number of packets skipped by the stream because of TCP port filtering.</td>
<td>no</td>
</tr>
<tr>
<td>Total UDP Filtered Packets</td>
<td>configure UDP Stream Preprocessing</td>
<td>the number of packets skipped by the stream because of UDP port filtering.</td>
<td>no</td>
</tr>
<tr>
<td>Urgent Flag Cleared Normalizations</td>
<td>enable <strong>Clear URG if Urgent Pointer is Not Set</strong></td>
<td>the number of packets for which the TCP header URG control bit was cleared because the urgent pointer was not set.</td>
<td>yes</td>
</tr>
<tr>
<td>Urgent Pointer and Urgent Flag Cleared Normalizations</td>
<td>enable <strong>Clear Urgent Pointer/URG on Empty Payload</strong></td>
<td>the number of packets for which the TCP header Urgent Pointer field and the URG control bit have been cleared because there was no payload.</td>
<td>yes</td>
</tr>
<tr>
<td>Urgent Pointer Cleared Normalizations</td>
<td>enable <strong>Clear Urgent Pointer if URG=0</strong></td>
<td>the number of packets for which the 16-bit TCP header Urgent Pointer field was cleared because the urgent (URG) control bit was not set.</td>
<td>yes</td>
</tr>
</tbody>
</table>

**Related Topics**
- The Inline Normalization Preprocessor, on page 1144
- Preprocessor Traffic Modification in Inline Deployments, on page 1065
- Drop Behavior in an Inline Deployment, on page 870

## Viewing Intrusion Event Graphs

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat</td>
<td>Protection</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Intrusion Admin</td>
</tr>
</tbody>
</table>

The Firepower System provides graphs that show you intrusion event trends over time. You can generate intrusion event graphs over time ranging from the last hour to the last month, for one or all managed devices.
In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

Procedure

Step 1 Choose Overview > Summary > Intrusion Event Graphs.

Step 2 Under Select Device, choose all to include all devices, or choose the specific device you want to include in the graph.

Step 3 Under Select Graph(s), choose the type of graph you want to generate:
- Top 10 Destination Ports
- Top 10 Source IP Addresses
- Top 10 Event Messages

Step 4 Under Select Time Range, choose the time range for the graph:
- Last Hour
- Last Day
- Last Week
- Last Month

Step 5 Click Graph.
The following topics provide an overview of file and malware events, local malware analysis, dynamic analysis, captured files, and network file trajectories.

- About File/Malware Events and Network File Trajectory, on page 1669
- File and Malware Events, on page 1670
- View Details About Analyzed Files, on page 1685
- Using Captured File Workflows, on page 1687
- Manually Submit Files for Analysis, on page 1692
- Network File Trajectory, on page 1693

### About File/Malware Events and Network File Trajectory

File policies automatically generate file and malware events for matched traffic, and log captured file information. When a file policy generates a file or malware event, or captures a file, the system also automatically logs the end of the associated connection to the Firepower Management Center database. You can analyze this data to address any negative impacts and block future attacks.

Based on the file analysis results, you can review captured files and generated malware and file events using tables on pages available under the Analysis > Files menu. When available, you can examine a file's composition, disposition, threat score, and dynamic analysis summary report for further insight into the malware analysis.

To further target your analysis, you can use a malware file’s *network file trajectory* (a map of how the file traversed your network, passing among hosts, as well as various file properties) to track the spread of an individual threat across hosts over time, allowing you to concentrate outbreak control and prevention efforts where most useful.

If you configure local malware analysis or dynamic analysis in a file rule, the system preclassifies files matching the rule and generates a file composition report.

If your organization has deployed *AMP for Endpoints* and integrated that deployment with your Firepower Management Center, you can also import records of scans, malware detections, and quarantines, as well as indications of compromise (IOC) identified by that product. This data is displayed alongside event data gathered by Firepower for a more complete picture of malware on your network.

The Context Explorer, dashboards, and reporting features can also aid a deeper understanding of the files and malware detected, captured, and blocked. You can also use events to trigger correlation policy violations, or alert you via email, SMTP, or syslog.
To configure your system to detect malware and generate file and malware events, see File Policies and Advanced Malware Protection, on page 791.

File and Malware Events

The Firepower Management Center can log various types of file and malware events. The information available for any individual event can vary depending on how and why it was generated:

- **File events** represent files, including malware, detected by the Firepower system (AMP for Networks.) File events do not contain AMP for Endpoints-related fields.

- **Malware events** represent malware detected by either AMP for Networks or AMP for Endpoints; malware events can also record data other than threats from your AMP for Endpoints deployment, such as scans and quarantines.

- **Retrospective malware events** represent files detected by AMP for Networks whose dispositions (whether the files are malware) have changed.

Note

- Files identified as malware by AMP for Networks generate both a file event and a malware event. Malware events generated by AMP for Endpoints do not have corresponding file events.

- File events generated by inspecting NetBIOS-ssn (SMB) traffic do not immediately generate connection events because the client and server establish a persistent connection. The system generates connection events after the client or server ends the session.

- The Firepower System supports the display and input of file names that use Unicode (UTF-8) characters. However, Unicode file names appear in PDF reports in transliterated form. Additionally, the SMB protocol replaces unprintable characters in file names with periods.

File and Malware Event Types

**File Events**

The system logs the file events generated when a managed device detects or blocks a file in network traffic, according to the rules in currently deployed file policies.

When the system generates a file event, the system also logs the end of the associated connection to the Firepower Management Center database, regardless of the logging configuration of the invoking access control rule.

**Malware Events**

The Firepower system (specifically the AMP for Networks feature) generates malware events when it detects malware in network traffic as part of your overall access control configuration. Malware events contain the disposition of the resulting event and contextual data about how, where, and when the malware was detected.
Table 272: Malware Event Generation Scenarios

<table>
<thead>
<tr>
<th>When the system detects a file and...</th>
<th>Disposition</th>
</tr>
</thead>
<tbody>
<tr>
<td>successfully queries the AMP cloud (performs a malware cloud lookup) for the file’s disposition</td>
<td>Malware, Clean, or Unknown</td>
</tr>
<tr>
<td>queries the AMP cloud but cannot establish a connection or the cloud is otherwise unavailable</td>
<td>Unavailable</td>
</tr>
<tr>
<td>You may see a small percentage of events with this disposition; this is expected behavior.</td>
<td></td>
</tr>
<tr>
<td>the threat score associated with a file exceeds the malware threshold threat score defined in the file policy that detected the file, or local malware analysis identifies malware</td>
<td>Malware</td>
</tr>
<tr>
<td>it is on the custom detection list (manually marked as malware)</td>
<td>Custom Detection</td>
</tr>
<tr>
<td>it is on the on the clean list (manually marked as clean),</td>
<td>Clean</td>
</tr>
</tbody>
</table>

Retrospective Malware Events

For malware detected in network traffic, dispositions can change. For example, the AMP cloud can determine that a file that was previously thought to be clean is now identified as malware, or the reverse—that a malware-identified file is actually clean. When the disposition changes for a file you queried in the last week, the AMP cloud notifies the system. Then, two things happen:

• The Firepower Management Center generates a new retrospective malware event.

  This new retrospective malware event represents a disposition change for all files detected in the last week that have the same SHA-256 hash value. For that reason, these events contain limited information: the date and time the Firepower Management Center was notified of the disposition change, the new disposition, the SHA-256 hash value of the file, and the threat name. They do not contain IP addresses or other contextual information.

• The Firepower Management Center changes the file disposition for previously detected files with the retrospective event’s associated SHA-256 hash value.

  If a file’s disposition changes to Malware, the Firepower Management Center logs a new malware event to its database. Except for the new disposition, the information in this new malware event is identical to that in the file event generated when the file was initially detected.

  If a file’s disposition changes to Clean, the Firepower Management Center does not delete the malware event. Instead, the event reflects the change in disposition. This means that files with clean dispositions can appear in the malware table, but only if they were originally thought to be malware. Files that were never identified as malware appear only in the files table.

Malware Events Generated by AMP for Endpoints

If your organization uses AMP for Endpoints, individual users install lightweight connectors on endpoints: computers and mobile devices. Connectors can inspect files upon upload, download, execution, open, copy, move, and so on. These connectors communicate with the AMP cloud to determine if inspected files contain malware.
When a file is positively identified as malware, the AMP cloud sends the threat identification to the Firepower Management Center. The AMP cloud can also send other kinds of information to the Firepower Management Center, including data on scans, quarantines, blocked executions, and cloud recalls. The Firepower Management Center logs this information as malware events.

**Note**
The IP addresses reported in malware events generated by AMP for Endpoints may not be in your network map—and may not even be in your monitored network at all. Depending on your deployment, level of compliance, and other factors, endpoints in your organization monitored by AMP for Endpoints may not be the same hosts as those monitored by AMP for Networks.

### Malware Event Analysis with AMP for Endpoints

If your organization has deployed Cisco AMP for Endpoints:

- You can configure the system to display malware events detected by AMP for Endpoints on Firepower Management Center event pages, alongside events detected by AMP for Networks.

To configure the above functionality, see Integrate Firepower and AMP for Endpoints, on page 823.

### Event Data from AMP for Endpoints

If your organization has deployed AMP for Endpoints for malware protection, you can configure the system to let you work in FMC with file and malware data from AMP for Endpoints.

However, you should be aware of the differences between file and malware data from AMP for Endpoints and file and malware data from AMP for Networks (malware protection using the Firepower system.)

Because AMP for Endpoints malware detection is performed at the endpoint at download or execution time, while managed devices detect malware in network traffic, the information in the two types of malware events is different. For example, malware events detected by AMP for Endpoints ("endpoint-based malware") contain information on file path, invoking client application, and so on, while malware detections in network traffic contain port, application protocol, and originating IP address information about the connection used to transmit the file.

As another example, for malware events detected by AMP for Networks ("network-based malware events"), user information represents the user most recently logged into the host where the malware was destined, as determined by network discovery. But AMP for Endpoints-reported users represent the user currently logged into the endpoint where the malware was detected.

**Note**
Depending on your deployment, endpoints monitored by AMP for Endpoints may not be the same hosts as those monitored by AMP for Networks. For this reason, malware events generated by AMP for Endpoints do not add hosts to the network map. However, the system uses IP and MAC address data to tag monitored hosts with indications of compromise obtained from your AMP for Endpoints deployment. If two different hosts monitored by different AMP solutions have the same IP and MAC address, the system can incorrectly tag monitored hosts with AMP for Endpoints IOCs.

The following table summarizes the differences between the event data generated by Firepower when using a Malware license, and event data generated by AMP for Endpoints.
Table 273: Summary of Data Differences Between AMP Products

<table>
<thead>
<tr>
<th>Feature</th>
<th>AMP for Networks</th>
<th>AMP for Endpoints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events generated</td>
<td>File events, captured files, malware events, and retrospective malware events</td>
<td>Malware events</td>
</tr>
<tr>
<td>Information in malware events</td>
<td>Basic malware event information, plus connection data (IP address, port, and application protocol)</td>
<td>In-depth malware event information; no connection data</td>
</tr>
<tr>
<td>Network file trajectory</td>
<td>FMC-based</td>
<td>FMC and the AMP for Endpoints management console each have a network file trajectory. Both are useful.</td>
</tr>
</tbody>
</table>

Related Topics
Integrate Firepower and AMP for Endpoints, on page 823

Using File and Malware Event Workflows

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Use this procedure to view file and malware events in a table and to manipulate the event view depending on the information relevant to your analysis. The page you see when you access events differs depending on the workflow, which is simply a series of pages you can use to evaluate events by moving from a broad to a more focused view. You can also create a custom workflow that displays only the information that matches your specific needs.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

Procedure

Choose one of the following:

- Analysis > Files > File Events
- Analysis > Files > Malware Events

Tip
In the table view of events, several fields are hidden by default. To show a hidden field in an event view, expand the search constraints, then click the field name under Disabled Columns.

Tip
To quickly view the connections where specific files were detected, choose the files using the check boxes in the table, then choose Connections Events from the Jump to drop-down list.
Right-click an item in the table to see options. (Not every column offers options.)

**Related Topics**
- [File and Malware Event Fields](#), on page 1674
- [Predefined File Workflows](#), on page 1516
- [Predefined Malware Workflows](#), on page 1515
- [Configuring Event View Settings](#), on page 31

## File and Malware Event Fields

File and malware events, which you can view and search using workflows, contain the fields listed in this section. Keep in mind that the information available for any individual event can vary depending on how and why it was generated.

**Note**
Files identified as malware by AMP for Networks generate both a file event and a malware event. Malware events generated by AMP for Endpoints do not have corresponding file events, and file events do not have AMP for Endpoints-related fields.

**Action**
The action associated with file policy rule that detected the file, and any associated file rule action options.

**AMP Cloud**
The name of the AMP cloud where the AMP for Endpoints event originated.

**Application File Name**
The client application accessing the malware file when AMP for Endpoints detection occurred. These applications are not tied to network discovery or application control.

**Application File SHA256**
The SHA-256 hash value of the parent file accessing the AMP for Endpoints-detected or quarantined file when detection occurred.

**Application Protocol**
The application protocol used by the traffic in which a managed device detected the file.

**Application Protocol Category or Tag**
The criteria that characterize the application to help you understand the application's function.
**Application Risk**

The risk associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated risk; this field displays the highest of those.

**Archive Depth**

The level (if any) at which the file was nested in an archive file.

**Archive Name**

The name of the archive file (if any) which contained the malware file.

To view the contents of an archive file, go to any table under Analysis > Files that lists the archive file, right-click on the archive file’s table row to open the context menu, then click View Archive Contents.

**Archive SHA256**

The SHA-256 hash value of the archive file (if any) which contains the malware file.

To view the contents of an archive file, go to any table under Analysis > Files that lists the archive file, right-click on that archive file’s table row to open the context menu, then click View Archive Contents.

**Business Relevance**

The business relevance associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated business relevance; this field displays the lowest (least relevant) of those.

**Category / File Type Category**

The general categories of file type, for example: Office Documents, Archive, Multimedia, Executables, PDF files, Encoded, Graphics, or System Files.

**Client**

The client application that runs on one host and relies on a server to send a file.

**Client Category or Tag**

The criteria that characterize the application to help you understand the application's function.

**Count**

After you apply a constraint that creates two or more identical rows, the number of events that match the information in each row.

**Detection Name**

The name of the detected malware.

**Detector**

The AMP for Endpoints detector that identified the malware, such as ClamAV, Spero, or SHA.
**Device**

For file events and for malware events generated by AMP for Networks, the name of the device that detected the file.

For malware events generated by AMP for Endpoints and for retrospective malware events generated by the AMP cloud, the name of the Firepower Management Center.

**Disposition / File Disposition**

The file’s disposition:

- **Malware**
  
  Indicates that the AMP cloud categorized the file as malware, local malware analysis identified malware, or the file’s threat score exceeded the malware threshold defined in the file policy.

- **Clean**
  
  Indicates that the AMP cloud categorized the file as clean, or that a user added the file to the clean list. Clean files appear in the malware table only if they were changed to clean.

- **Unknown**
  
  Indicates that the system queried the AMP cloud, but the file has not been assigned a disposition; in other words, the AMP cloud has not categorized the file.

- **Custom Detection**
  
  Indicates that a user added the file to the custom detection list.

- **Unavailable**
  
  Indicates that the system could not query the AMP cloud. You may see a small percentage of events with this disposition; this is expected behavior.

- **N/A**
  
  Indicates a Detect Files or Block Files rule handled the file and the Firepower Management Center did not query the AMP cloud.

File dispositions appear only for files for which the system queried the AMP cloud.

**Domain**

For file events and for malware events generated by AMP for Networks, the domain of the device that detected the file. For malware events generated by AMP for Endpoints and for retrospective malware events generated by the AMP cloud, the domain associated with the AMP cloud connection that reported the event.

This field is only present if you have ever configured the Firepower Management Center for multitenancy.

**Event Subtype**

The AMP for Endpoints action that led to malware detection, for example, Create, Execute, Move, or Scan.

**Event Type**

The sub-type of malware event.
**File Name**
The name of the file.

**File Path**
The file path of the malware file detected by AMP for Endpoints, not including the file name.

**File Policy**
The file policy that detected the file.

**File Storage / Stored (Search Only)**
The storage status of the file associated with the event:

- **Stored**
  Returns all events where the associated file is currently stored.

- **Stored in connection**
  Returns all events where the system captured and stored the associated file, regardless of whether the associated file is currently stored.

- **Failed**
  Returns all events where the system failed to store the associated file.

**File Timestamp**
The time and date that AMP for Endpoints detected the malware file was created.

**HTTP Response Code**
The HTTP status code sent in response to a client's HTTP request when a file is transferred.

**IOC**
Whether the malware event triggered an indication of compromise (IOC) against a host involved in the connection. When AMP for Endpoints data triggers an IOC rule, a full malware event is generated, with the type AMP IOC.

**Message**
Additional information associated with a malware event. For file events and for malware events generated by AMP for Networks, this field is populated only for files whose disposition has changed, that is, that have an associated retrospective event.

**Receiving Continent**
The continent of the host receiving the file.

**Receiving Country**
The country of the host receiving the file.
Receiving IP
For file events and for malware events generated by AMP for Networks, the IP address of the host receiving the file.
For malware events generated by AMP for Endpoints, the IP address of the endpoint whose connector reported the event.

Receiving Port
The destination port used by the traffic where the file was detected.

Security Context
The metadata identifying the virtual firewall group through which the traffic passed. Note that the system only displays this field when managing at least one ASA FirePOWER device that is running in multiple context mode.

Sending Continent
The continent of the host sending the file.

Sending Country
The country of the host sending the file.

Sending IP
The IP address of the host sending the file.

Sending Port
The source port used by the traffic where the file was detected.

SHA256 / File SHA256
The SHA-256 hash value of the file.
To have a SHA256 value, the file must have been handled by one of:
- a Detect Files file rule with Store files enabled
- a Block Files file rule with Store files enabled
- a Malware Cloud Lookup file rule
- a Block Malware file rule
- AMP for Endpoints

This column also displays a network file trajectory icon that represents the most recently detected file event and file disposition, and that links to the network file trajectory.

Size (KB) / File Size (KB)
The size of the file, in kilobytes.
Note that if the system determines the file type of a file before the file is fully received, the file size may not be calculated. In this case, this field is blank.

**SSL Actual Action (Search Only)**

The action the system applied to encrypted traffic:

- **Block or Block with reset**
  - Represents blocked encrypted connections.

- **Decrypt (Resign)**
  - Represents an outgoing connection decrypted using a re-signed server certificate.

- **Decrypt (Replace Key)**
  - Represents an outgoing connection decrypted using a self-signed server certificate with a substituted public key.

- **Decrypt (Known Key)**
  - Represents an incoming connection decrypted using a known private key.

- **Default Action**
  - Indicates the connection was handled by the default action.

- **Do not Decrypt**
  - Represents a connection the system did not decrypt.

Field values are displayed in the **SSL Status** field on the search workflow pages.

**SSL Certificate Information (Search Only)**

The information stored on the public key certificate used to encrypt traffic, including:

- Subject/Issuer Common Name
- Subject/Issuer Organization
- Subject/Issuer Organization Unit
- Not Valid Before/After
- Serial Number, Certificate Fingerprint
- Public Key Fingerprint

**SSL Failure Reason (Search Only)**

The reason the system failed to decrypt encrypted traffic:

- Unknown
- No Match
- Success
- Uncached Session
• Unknown Cipher Suite
• Unsupported Cipher Suite
• Unsupported SSL Version
• SSL Compression Used
• Session Undecryptable in Passive Mode
• Handshake Error
• Decryption Error
• Pending Server Name Category Lookup
• Pending Common Name Category Lookup
• Internal Error
• Network Parameters Unavailable
• Invalid Server Certificate Handle
• Server Certificate Fingerprint Unavailable
• Cannot Cache Subject DN
• Cannot Cache Issuer DN
• Unknown SSL Version
• External Certificate List Unavailable
• External Certificate Fingerprint Unavailable
• Internal Certificate List Invalid
• Internal Certificate List Unavailable
• Internal Certificate Unavailable
• Internal Certificate Fingerprint Unavailable
• Server Certificate Validation Unavailable
• Server Certificate Validation Failure
• Invalid Action

Field values are displayed in the SSL Status field on the search workflow pages.

SSL Status
The action associated with the SSL Actual Action (SSL rule, default action, or undecryptable traffic action) that logged the encrypted connection. The lock icon (🔒) links to TLS/SSL certificate details. If the certificate is unavailable (for example, for connections blocked due to TLS/SSL handshake error), the lock icon is grayed out.

If the system fails to decrypt an encrypted connection, it displays the SSL Actual Action (undecryptable traffic action) taken, as well as the SSL Failure Reason. For example, if the system detects traffic encrypted
with an unknown cipher suite and allows it without further inspection, this field displays **Do Not Decrypt (Unknown Cipher Suite)**.

When searching this field, type one or more of the **SSL Actual Action** and **SSL Failure Reason** values to view encrypted traffic the system handled or failed to decrypt.

**SSL Subject/Issuer Country (Search Only)**

The two-character ISO 3166-1 alpha-2 country code for the subject or issuer country associated with the encryption certificate.

**Threat Name**

The name of the detected malware.

**Threat Score**

The threat score most recently associated with this file. This is a value from 0 to 100 based on the potentially malicious behaviors observed during dynamic analysis.

The threat score icon links to the Dynamic Analysis Summary report.

**Time**

The date and time the event was generated. This field is not searchable.

**Type / File Type**

The type of file, for example, HTML or MSEXE.

**URI / File URI**

The URI of the connection associated with the file transaction, for example, the URL from which a user downloaded the file.

**User**

The username associated with the host (**Receiving IP**) where the event occurred.

For file events and for malware events generated by AMP for Networks, this user is determined by network discovery. Because the user is associated with the destination host, users are not associated with malware events in which the internal host uploaded a malware file.

For malware events generated by AMP for Endpoints, AMP for Endpoints determines user names. These users **cannot** be tied to user discovery or control. They do not appear in the Users table, nor can you view details for these users.

**Web Application**

The application that represents the content or requested URL for HTTP traffic detected in the connection.

**Web Application Category or Tag**

Criteria that characterize the application to help you understand the application's function.
Malware Event Sub-Types

The following table lists the malware event subtypes, whether a malware event generated by AMP for Networks (a "network-based malware event") or AMP for Endpoints (an "endpoint-based malware event") can have that subtype, and whether the system uses that subtype to build network file trajectories.

Table 274: Malware Event Types

<table>
<thead>
<tr>
<th>Malware Event Subtype/Search Value</th>
<th>AMP for Networks</th>
<th>AMP for Endpoints</th>
<th>File Trajectory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threat Detected in Network File Transfer</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Threat Detected in Network File Transfer (retrospective)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Threat Detected</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Threat Detected in Exclusion</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Threat Quarantined</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>AMP IOC (Indications of compromise)</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Blocked Execution</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Cloud Recall Quarantine</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Cloud Recall Quarantine Attempt Failed</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Cloud Recall Quarantine Started</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Cloud Recall Restore from Quarantine</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Cloud Recall Restore from Quarantine Failed</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Cloud Recall Restore from Quarantine Started</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Quarantine Failure</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Quarantined Item Restored</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Quarantine Restore Failed</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Quarantine Restore Started</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Scan Completed, No Detections</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Scan Completed With Detections</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
</tbody>
</table>
Information Available in File and Malware Event Fields

The following table lists whether the system displays information for each file and malware event field.

If your organization has deployed AMP for Endpoints and integrated that product with your Firepower deployment:

- Malware events and indications of compromise (IOCs) imported from your AMP for Endpoints deployment do not contain contextual connection information, but they do include information obtained at download or execution time, such as file path, invoking client application, and so on.

- File event table views do not display AMP for Endpoints-related fields.

Table 275: Information Available in File and Malware Event Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>File Event</th>
<th>Malware Events Detected by the Firepower System</th>
<th>Retrospective Events Detected by the Firepower System</th>
<th>Malware Events Detected by AMP for Endpoints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>AMP Cloud</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Application File Name</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Application File SHA256</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Application Protocol</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Application Protocol Category or Tag</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Application Risk</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Archive Depth</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Archive Name</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Archive SHA256</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Business Relevance</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Category / File Type Category</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Client</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Client Category or Tag</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Field</td>
<td>File Event</td>
<td>Malware Events Detected by the Firepower System</td>
<td>Retrospective Events Detected by the Firepower System</td>
<td>Malware Events Detected by AMP for Endpoints</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------</td>
<td>-------------------------------------------------</td>
<td>------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Count</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Detection Name</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Detector</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Device</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Disposition / File Disposition</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Domain</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Event Subtype</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Event Type</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>File Name</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>File Path</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>File Policy</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>File Timestamp</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>HTTP Response Code</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>IOC (Indication of Compromise)</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Message</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Receiving Continent</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Receiving Country</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Receiving IP</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Receiving Port</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Security Context</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Sending Continent</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Sending Country</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Sending IP</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Sending Port</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>SHA256 / File SHA256</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Field</td>
<td>File Event</td>
<td>Malware Events Detected by the Firepower System</td>
<td>Retrospective Events Detected by the Firepower System</td>
<td>Malware Events Detected by AMP for Endpoints</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Size (KB) / File Size (KB)</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>SSL Actual Action (search only)</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>SSL Certificate Information (search only)</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>SSL Failure Reason (search only)</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>SSL Status</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>SSL Subject/Issuer Country (search only)</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>File Storage / Stored (search only)</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Threat Name</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Threat Score</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Time</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Type / File Type</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>URI / File URI</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>User</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Web Application</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Web Application Category or Tag</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
</tbody>
</table>

**View Details About Analyzed Files**

**File Composition Report**

If you configure local malware analysis or dynamic analysis, the system generates a file composition report after analyzing a file. This report allows you to further analyze files and determine whether they may carry embedded malware.
The file composition report lists file properties, any objects embedded in the file, and any detected viruses. The file composition report may also list additional information specific to that file type. When the system prunes stored files, it also prunes the associated file composition report.

To view file composition information, see Using a Network File Trajectory, on page 1696.

**View File Details in AMP Private Cloud**

If you have deployed an AMP private cloud, you can view additional details about analyzed files in your private cloud.

For more information, see the documentation for your private cloud.

**Procedure**

Sign in directly to your AMP private cloud console.

**Threat Scores and Dynamic Analysis Summary Reports**

**Threat Scores**

*Table 276: Threat Score Ratings*

<table>
<thead>
<tr>
<th>Threat Score</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>🌟🌟🌟🌟</td>
</tr>
<tr>
<td>Medium</td>
<td>🌟🌟🌟</td>
</tr>
<tr>
<td>High</td>
<td>🌟🌟🌟🌟</td>
</tr>
<tr>
<td>Very High</td>
<td>🌟🌟🌟🌟🌟</td>
</tr>
</tbody>
</table>

The Firepower Management Center caches a file’s threat score for the same amount of time as the file’s disposition. If the system later detects these files, it displays the cached threat scores instead of re-querying the Cisco Threat Grid cloud or an Cisco Threat Grid on-premises appliance. You can automatically assign a malware file disposition to any file with a threat score that exceeds the defined malware threshold threat score.

**Dynamic Analysis Summary**

If a dynamic analysis summary is available, you can click the threat score icon to view it. If multiple reports exist, this summary is based on the most recent report matching the exact threat score. If none match the exact threat score, the report with the highest threat score is displayed. If more than one report exists, you can select a threat score to view each separate report.

The summary lists each component threat comprising the threat score. Each component threat is expandable to list the AMP cloud findings, as well as any processes related to this component threat.
The process tree shows the processes that started when the Cisco Threat Grid cloud attempted to run the file. This can help identify whether a file that contains malware is attempting to access processes and system resources beyond what is expected (for example, running a Word document opens Microsoft Word, then starts Internet Explorer, then runs the Java Runtime Environment).

Each listed process contains a process identifier you can use to verify the actual process. Child nodes in the process tree represent processes started as a result of parent processes.

From the dynamic analysis summary, you can click View Full Report to view the full Analysis Report, detailing the AMP cloud’s full analysis, including general file information, a more in-depth review of all detected processes, a breakdown of the file analysis, and other relevant information.

### Using Captured File Workflows

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature dependent</td>
<td>feature dependent</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

When a managed device captures a file detected in network traffic, it logs an event.

**Note**

If a device captures a file containing malware, the device generates two events: a file event when it detects the file, and a malware event when it identifies malware.

Use this procedure to view a list of captured files in a table and manipulate the event view depending on the information relevant to your analysis. The page you see when you access captured files differs depending on the workflow, which is simply a series of pages you can use to evaluate events by moving from a broad to a more focused view. You can also create a custom workflow that displays only the information that matches your specific needs.

If the system recaptures a file after a configuration change, such as an updated file policy, it updates existing information for that file.

For example, if you configure a file policy to capture files with a Malware Cloud Lookup action, the system stores the file disposition and threat score along with the file. Then, if you update your file policy, and the system recaptures the same file due to a new Detect Files action, the system updates the file's Last Changed value. However, the system does not remove the existing disposition and threat score, even though you did not perform another malware cloud lookup.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

Choose Analysis > Files > Captured Files.
Tip  In the table view of events, several fields are hidden by default. To show a hidden field in an event view, expand the search constraints, then click the field name under Disabled Columns.

Related Topics
- Captured File Fields, on page 1688
- Predefined Captured File Workflows, on page 1516
- Configuring Event View Settings, on page 31

Captured File Fields

The table view of captured files, which is the final page in predefined captured file workflows, and which you can add to custom workflows, includes a column for each field in the captured files table.

When searching this table keep in mind that your search results depend on the available data in the events you are searching; depending on the available data, your search constraints may not apply. For example, if a file has never been submitted for dynamic analysis, it may not have an associated threat score.

Table 277: Captured File Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Inspection Status</td>
<td>For archive files, the status of archive inspection:</td>
</tr>
<tr>
<td></td>
<td>• Pending indicates that the system is still inspecting the archive file and</td>
</tr>
<tr>
<td></td>
<td>its contents. If the file passes through your system again, complete</td>
</tr>
<tr>
<td></td>
<td>information becomes available.</td>
</tr>
<tr>
<td></td>
<td>• Extracted indicates that the system was able to extract and inspect the</td>
</tr>
<tr>
<td></td>
<td>archive’s contents.</td>
</tr>
<tr>
<td></td>
<td>• Failed may, in rare cases, occur if the system is unable to</td>
</tr>
<tr>
<td></td>
<td>process an extraction.</td>
</tr>
<tr>
<td></td>
<td>• Depth Exceeded indicates that the archive contains further nested</td>
</tr>
<tr>
<td></td>
<td>archive files beyond the maximum allowed depth.</td>
</tr>
<tr>
<td></td>
<td>• Encrypted indicates that the archive file’s contents are encrypted and</td>
</tr>
<tr>
<td></td>
<td>could not be inspected.</td>
</tr>
<tr>
<td></td>
<td>• NotInspectable indicates that the system did not extract and inspect the</td>
</tr>
<tr>
<td></td>
<td>archive’s contents. Policy rule actions, policy configuration, and</td>
</tr>
<tr>
<td></td>
<td>corrupted files are three major reasons for this status.</td>
</tr>
<tr>
<td></td>
<td>To view the contents of an archive file, right-click on its row in the</td>
</tr>
<tr>
<td></td>
<td>table to bring up the context menu, then choose View Archive Contents.</td>
</tr>
<tr>
<td>Category</td>
<td>The general categories of file type, for example: Office Documents, Archive</td>
</tr>
<tr>
<td></td>
<td>Multimedia, Executables, PDF files, Encoded, Graphics, or System Files.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Detection Name</td>
<td>The name of the detected malware.</td>
</tr>
<tr>
<td>Disposition</td>
<td>The file’s AMP for Networks disposition:</td>
</tr>
<tr>
<td></td>
<td>• Malware indicates that local malware analysis identified malware, the AMP cloud categorized the file as malware, or that the file’s threat score exceeded the malware threshold defined in the file policy.</td>
</tr>
<tr>
<td></td>
<td>• Clean indicates that the AMP cloud categorized the file as clean, or that a user added the file to the clean list.</td>
</tr>
<tr>
<td></td>
<td>• Unknown indicates that the system queried the AMP cloud, but the file has not been assigned a disposition; in other words, the AMP cloud has not categorized the file.</td>
</tr>
<tr>
<td></td>
<td>• Custom Detection indicates that a user added the file to the custom detection list.</td>
</tr>
<tr>
<td></td>
<td>• Unavailable indicates that the system could not query the AMP cloud. You may see a small percentage of events with this disposition; this is expected behavior.</td>
</tr>
<tr>
<td></td>
<td>• N/A indicates a Detect Files or Block Files rule handled the file and the Firepower Management Center did not query the AMP cloud.</td>
</tr>
<tr>
<td>Domain</td>
<td>The domain where the captured file was detected. This field is only present if you have ever configured the Firepower Management Center for multitenancy.</td>
</tr>
</tbody>
</table>
## Captured File Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Analysis Status</td>
<td>One or more of the following values indicating whether the file was submitted for dynamic analysis:</td>
</tr>
<tr>
<td></td>
<td>• Analysis Complete — file submitted for dynamic analysis that received a threat score and dynamic analysis summary report</td>
</tr>
<tr>
<td></td>
<td>• Capacity Handled — file stored because it could not be submitted currently</td>
</tr>
<tr>
<td></td>
<td>• Capacity Handled (Network Issue) — file stored because it could not be submitted due to a network connectivity issue</td>
</tr>
<tr>
<td></td>
<td>• Capacity Handled (Rate Limit) — file stored because it could not be submitted due to the maximum number of submissions reached</td>
</tr>
<tr>
<td></td>
<td>• Device Not Activated — file not submitted because the device is not activated on the on-premises Cisco Threat Grid appliance. If you see this status, contact Support.</td>
</tr>
<tr>
<td></td>
<td>• Failure (Analysis Timeout) — file submitted for which the AMP cloud has yet to return a result</td>
</tr>
<tr>
<td></td>
<td>• Failure (Cannot Run File) — file submitted that the AMP cloud could not run in the test environment</td>
</tr>
<tr>
<td></td>
<td>• Failure (Network Issue) — file that did not get submitted due to a network connectivity failure</td>
</tr>
<tr>
<td></td>
<td>• Not Sent for Analysis — file not submitted</td>
</tr>
<tr>
<td></td>
<td>• Not Suspicious (Not Sent For Analysis) — file pre-classified as non-malware</td>
</tr>
<tr>
<td></td>
<td>• Previously Analyzed — file with a cached threat score that a user tried to submit again</td>
</tr>
<tr>
<td></td>
<td>• Sent for Analysis — file pre-classified as malware and queued for dynamic analysis</td>
</tr>
<tr>
<td>Dynamic Analysis Status Changed</td>
<td>The last time the file's dynamic analysis status changed.</td>
</tr>
<tr>
<td>File Name</td>
<td>The most recently detected file name associated with the file’s SHA-256 hash value.</td>
</tr>
<tr>
<td>Last Changed</td>
<td>The last time the information associated with this file was updated.</td>
</tr>
<tr>
<td>Last Sent</td>
<td>The time the file was most recently submitted to the AMP cloud for dynamic analysis.</td>
</tr>
</tbody>
</table>
### Stored Files Download

Once a device stores a file, as long as the Firepower Management Center can communicate with that device and it has not deleted the file, you can download the file to a local host for long-term storage and analysis, and manually analyze the file. You can download a file from any associated file event, malware event, captured file view, or the file’s trajectory.

Because malware is harmful, by default, you must confirm every file download. However, you can disable the confirmation in your User Preferences.

Because files with a disposition of Unknown may contain malware, when you download a file, the system first archives the file in a .zip package. The .zip file name contains the file disposition and file type, if available, and SHA-256 hash value. You can password-protect the .zip file to prevent accidental unpacking. You can edit or remove the default .zip file password in your User Preferences.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Malware Analysis Status</td>
<td>One of the following values indicating whether the system performed local malware analysis on a file:</td>
</tr>
<tr>
<td></td>
<td>• Analysis Complete — the system inspected the file using local malware analysis and pre-classified the file</td>
</tr>
<tr>
<td></td>
<td>• Analysis Failed — the system attempted to inspect the file using local malware analysis and failed</td>
</tr>
<tr>
<td></td>
<td>• Manual Request Submitted — a user submitted a file for local malware analysis</td>
</tr>
<tr>
<td></td>
<td>• Not Analyzed — the system did not inspect the file with local malware analysis</td>
</tr>
<tr>
<td>SHA256</td>
<td>The SHA-256 hash value of the file, as well as a network file trajectory icon representing the most recently detected file event and file disposition. To view the network file trajectory, click the trajectory icon.</td>
</tr>
<tr>
<td>Storage Status</td>
<td>Indicates whether the file is stored on a managed device:</td>
</tr>
<tr>
<td></td>
<td>• File Stored</td>
</tr>
<tr>
<td></td>
<td>• Not Stored (Disposition Was Pending)</td>
</tr>
<tr>
<td>Threat Score</td>
<td>The threat score most recently associated with this file.</td>
</tr>
<tr>
<td></td>
<td>To view the Dynamic Analysis Summary report, click the threat score icon.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of file; for example, HTML or MSEXE.</td>
</tr>
</tbody>
</table>
Cisco strongly recommends you do not download malware, as it can cause adverse consequences. Exercise caution when downloading any file, as it may contain malware. Ensure you have taken any necessary precautions to secure the download destination before downloading files.

Manually Submit Files for Analysis

When you manually submit files for analysis, the system runs local analysis, then submits these files to the cloud for dynamic analysis. However, if local analysis is not enabled in a file policy, and you manually submit a file for analysis, the file will only be sent for dynamic analysis.

In addition to executable files, you can also submit file types not eligible for automatic submission, such as .swf, .jar, and others. This allows you to more quickly analyze a broad range of files, regardless of disposition, and pinpoint the exact causes of an incident.

Note

The system checks the AMP cloud for updates (no more than once a day) to the list of file types eligible for dynamic analysis and the minimum and maximum file sizes you can submit.

Depending on the situation, there are two ways to submit files for analysis:

Before you begin

In order to manually submit captured files for analysis, one or more file rules must be configured to store captured files. For information, see File Policies and Advanced Malware Protection, on page 791.

Procedure

Step 1
To submit a single file for analysis:
   a) Select one of the following:
      • Analysis > Files > File Events
      • Analysis > Files > Malware Events
      • Analysis > Files > Captured Files
   b) Click Table View of <Event type or files>.
   c) Right-click a file in the table and select Analyze File.

Step 2
To submit multiple captured files for analysis (up to 25 at a time):
   a) Select Analysis > Files > Captured Files
   b) Select the checkbox beside each file to analyze.
   c) Click Analyze.
Network File Trajectory

The network file trajectory feature maps how hosts transferred files, including malware files, across your network. A trajectory charts file transfer data, the disposition of the file, and if a file transfer was blocked or the file was quarantined. You can determine which hosts may have transferred malware, which hosts are at risk, and observe file transfer trends.

You can track the transmission of any file with a AMP cloud-assigned disposition. The system can use information related to detecting and blocking malware from both AMP for Networks and AMP for Endpoints to build the a trajectory.

Recently Detected Malware and Analyzed Trajectories

The Network File Trajectory List page displays the malware most recently detected on your network, as well as the files whose trajectory maps you have most recently viewed. From these lists, you can view when each file was most recently seen on the network, the file’s SHA-256 hash value, name, type, current file disposition, contents (for archive files), and the number of events associated with the file.

The page also contains a search box that lets you locate files, either based on SHA-256 hash value or file name, or by the IP address of the host that transferred or received a file. After you locate a file, you can click the File SHA256 value to view the detailed trajectory map.

Network File Trajectory Detailed View

You can trace a file through the network by viewing the detailed network file trajectory. Search for a file’s SHA 256 value or click a File SHA 256 link in the Network File Trajectory list to view details about that file.

The network file trajectory details page has three parts:

- **Summary Information** — A file’s trajectory page displays summary information about the file, including file identification information; when the file was first seen and most recently seen on the network; the number of related events and hosts associated with the file; and the file’s current disposition. From this section, if the managed device stored the file, you can download it locally, submit the file for dynamic analysis, or add the file to a file list.

- **Trajectory Map** — A file’s trajectory map visually tracks a file from the first detection on your network to the most recent. The map shows when hosts transferred or received the file, how often they transferred the file, and when the file was blocked or quarantined. Vertical lines between data points represent file transfers between hosts. Horizontal lines connecting the data points show a host’s file activity over time.

  The map also shows how often file events occurred for the file and when the system assigned the file a disposition or retrospective disposition. You can select a data point in the map and highlight a path that traces back to the first instance the host transferred that file; this path also intersects with every occurrence involving the host as either sender or receiver of the file.

- **Related Events** — The Events table lists event information for each data point in the map. Using the table and the map, you can pinpoint specific file events, hosts on the network that transferred or received this file, related events in the map, and other related events in a table constrained on selected values.
Network File Trajectory Summary Information

The following summary information appears at the top of the details page for a file that appears in the Network File Trajectory list.

Tip
To view related file events, click a field value link. The first page in the File Events default workflow opens in a new window, displaying all file events that also contain the selected value.

Table 278: Network File Trajectory Summary Information Fields

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Contents</td>
<td>For inspected archive files, the number of files the archive contains.</td>
</tr>
<tr>
<td>Current Disposition</td>
<td>One of the following AMP for Networks file dispositions:</td>
</tr>
<tr>
<td></td>
<td>• Malware indicates that the AMP cloud categorized the file as malware, local malware analysis identified malware, or the file’s threat score exceeded the malware threshold defined in the file policy.</td>
</tr>
<tr>
<td></td>
<td>• Clean indicates that the AMP cloud categorized the file as clean, or that a user added the file to the clean list.</td>
</tr>
<tr>
<td></td>
<td>• Unknown indicates that the system queried the AMP cloud, but the file has not been assigned a disposition; in other words, the AMP cloud has not categorized the file.</td>
</tr>
<tr>
<td></td>
<td>• Custom Detection indicates that a user added the file to the custom detection list.</td>
</tr>
<tr>
<td></td>
<td>• Unavailable indicates that the system could not query the AMP cloud. You may see a small percentage of events with this disposition; this is expected behavior.</td>
</tr>
<tr>
<td></td>
<td>• N/A indicates a Detect Files or Block Files rule handled the file and the Firepower Management Center did not query the AMP cloud.</td>
</tr>
<tr>
<td>Detection Name</td>
<td>Name of the malware detected by local malware analysis.</td>
</tr>
<tr>
<td>Event Count</td>
<td>The number of events seen on the network associated with the file, and the number of events displayed in the map if there are more than 250 detected events.</td>
</tr>
<tr>
<td>File Category</td>
<td>The general categories of file type, for example, Office Documents or System Files.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>File Names</td>
<td>The names of the file associated with the event, as seen on the network. If multiple file names are associated with a SHA-256 hash value, the most recent detected file name is listed. You can expand this to view the remaining file names by clicking more.</td>
</tr>
<tr>
<td>File SHA256</td>
<td>The SHA-256 hash value of the file. The hash is displayed by default in a condensed format. To view the full hash value, hover your pointer over it. If multiple SHA-256 hash values are associated with a file name, hover your pointer over the link to view all of the hash values.</td>
</tr>
<tr>
<td>File Size (KB)</td>
<td>The size of the file, in kilobytes.</td>
</tr>
<tr>
<td>File Type</td>
<td>The file type of the file, for example, HTML or MSEXE.</td>
</tr>
<tr>
<td>First Seen</td>
<td>The first time AMP for Networks or AMP for Endpoints detected the file, as well as the IP address of the host that first uploaded the file.</td>
</tr>
<tr>
<td>Last Seen</td>
<td>The most recent time AMP for Networks or AMP for Endpoints detected the file, as well as the IP address of the host that last downloaded the file.</td>
</tr>
<tr>
<td>Parent Application</td>
<td>The client application accessing the malware file when detection occurred by AMP for Endpoints. These applications are not tied to network discovery or application control.</td>
</tr>
<tr>
<td>Seen On</td>
<td>The number of hosts that either sent or received the file. Because one host can upload and download a file at different times, the total number of hosts may not match the total number of senders plus the total number of receivers in the Seen On Breakdown field.</td>
</tr>
<tr>
<td>Seen On Breakdown</td>
<td>The number of hosts that sent the file, followed by the number of hosts that received the file.</td>
</tr>
<tr>
<td>Threat Name</td>
<td>Name of the threat associated with the detected malware by AMP for Endpoints.</td>
</tr>
<tr>
<td>Threat Score</td>
<td>The file’s threat score.</td>
</tr>
</tbody>
</table>

**Network File Trajectory Map and Related Events List**

The file trajectory map’s y-axis contains a list of all host IP addresses that have interacted with the file. The IP addresses are listed in descending order based on when the system first detected the file on that host. Each row contains all events associated with that IP address, whether a single file event, file transfer, or retrospective event. The x-axis contains the date and time the system detected each event. The timestamps are listed in chronological order. If multiple events occurred within a minute, all are listed within the same column. You can scroll the map horizontally and vertically to view additional events and IP addresses.
The map displays up to 250 events associated with the file SHA-256 hash. If there are more than 250 events, the map displays the first 10, then truncates extra events with an arrow icon (↑). The map then displays the remaining 240 events.

The first page of the File Events default workflow appears in a new window with all the extra events constrained based on the file type. If malware events generated by AMP for Endpoints are not displayed, you must switch to the Malware Events table to view these.

Each data point represents an event plus the file disposition, as described in the legend below the map. For example, a Malware Block event icon combines the Malicious Disposition icon and the Block Event icon.

Malware events generated by AMP for Endpoints ("endpoint-based malware events") include one icon. A retrospective event displays an icon in the column for each host on which the file is detected. File transfer events always include two icons, one file send icon and one file receive icon, connected by a vertical line. Arrows indicate the file transfer direction from sender to receiver.

To track a file’s progress through the network, you can click any data point to highlight a path that includes all data points related to the selected data point. This includes data points associated with the following types of events:

- any file transfers in which the associated IP address was either sender or receiver
- any malware events generated by AMP for Endpoints ("endpoint-based malware events") involving the associated IP address
- if another IP address was involved, all file transfers in which that associated IP address was either sender or receiver
- if another IP address was involved, any malware events generated by AMP for Endpoints ("endpoint-based malware events") involving the other IP address

All IP addresses and timestamps associated with any highlighted data point are also highlighted. The corresponding event in the Events table is also highlighted. If a path includes truncated events, the path itself is highlighted with a dotted line. Truncated events might intersect the path, but are not displayed in the map.

### Using a Network File Trajectory

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Malware (AMP for Networks)</td>
<td>Malware (AMP for Networks)</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
<tr>
<td>Any (AMP for Endpoints)</td>
<td>Any (AMP for Endpoints)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

### Procedure

**Step 1** Choose **Analysis > Files > Network File Trajectory**.

**Tip** You can also access a file’s trajectory from the Context Explorer, dashboard, or event views with file information.
Step 2  Click a **File SHA 256** link in the list.

Step 3  Optionally, enter a complete SHA-256 hash value, the host IP address, or the name of a file you want to track into the search field, and press Enter.

**Tip**  If only one result matches, the Network File Trajectory page for that file appears.

Step 4  In the Summary Information section, you can:

- Add a file to a file list — To add a file or remove a file from the clean list or custom detection list, click the edit icon (✍).

- Download a file — To download a file, click the download file icon (💾), and if prompted, confirm you want to download the file. If the file is unavailable for download, this icon is dimmed.

- Report — Click the threat score icon to view the Dynamic Analysis Summary report.

- Submit for dynamic analysis — Click the AMP cloud icon (🌐) to submit the file for dynamic analysis. If the file is unavailable for submission or you cannot connect to the AMP cloud, this icon is dimmed.

- View archive contents — To view information about an archive file’s contents, click the view icon (🔍).

- View file composition — To view a file's composition, click the file list icon (🗂). If the system has not generated a file composition report, this icon is dimmed.

- View captured files with same threat score — Click the threat score link to view all captured files with that threat score.

**Note**  Cisco strongly recommends you do not download malware, as it can cause adverse consequences. Exercise caution when downloading any file, as it may contain malware. Ensure you have taken any necessary precautions to secure the download destination before downloading files.

Step 5  On the trajectory map, you can:

- Locate the first instance — Click an IP address to locate the first time a file event occurred involving an IP address. This highlights a path to that data point, as well as any intervening file events and IP addresses related to the first file event. The corresponding event in the Events table is also highlighted. The map scrolls to that data point if not currently visible.

- Track — Click any data point to highlight a path that includes all data points related to the selected data point, tracking a file’s progress through the network.

- View hidden events — Click the arrow icon to view all events not displayed in the File Summary event view.

- View matching file events — Hover your pointer over the event icon (🔍) to view summary information for the event. If you click any event summary information link, the first page of the File Events default workflow appears in a new window with all the extra events constrained based on the file type. The File Summary event view opens in a new window, displaying all file events that match on the criteria value you clicked.

Step 6  In the Events table, you can:
• Highlight — Choose a table row to highlight a data point in the map. The map scrolls to display the selected file event if not currently visible.
• Sort — Click the column headers to sort events in ascending or descending order.

Work with Event Data in the AMP for Endpoints Console

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If your organization has deployed AMP for Endpoints, you can view AMP for Endpoints malware event data in the AMP for Endpoints console, and use that application's global network file trajectory tool.

Tip
For information about using AMP for Endpoints and its console, see the online help in the console or other documentation available from https://www.cisco.com/c/en/us/support/security/fireamp-endpoints/tsd-products-support-series-home.html

To access the AMP for Endpoints console from the Firepower Management Center:

**Before you begin**

• The connection to AMP for Endpoints must be configured (see Integrate Firepower and AMP for Endpoints, on page 823) and Firepower Management Center must be able to connect to the AMP cloud.
• You will need your AMP for Endpoints credentials.

**Procedure**

**Step 1**
Choose AMP > AMP Management.

**Step 2**
Click the cloud name in the table.
CHAPTER 88

Using Host Profiles

The following topics describe how to use host profiles:

- Host Profiles, on page 1699
- Basic Host Information in the Host Profile, on page 1701
- Operating Systems in the Host Profile, on page 1703
- Servers in the Host Profile, on page 1708
- Web Applications in the Host Profile, on page 1712
- Host Protocols in the Host Profile, on page 1714
- Indications of Compromise in the Host Profile, on page 1715
- VLAN Tags in the Host Profile, on page 1715
- User History in the Host Profile, on page 1715
- Host Attributes in the Host Profile, on page 1716
- White List Violations in the Host Profile, on page 1720
- Malware Detections in the Host Profile, on page 1721
- Vulnerabilities in the Host Profile, on page 1722
- Scan Results in the Host Profile, on page 1725

Host Profiles

A host profile provides a complete view of all the information the system has gathered about a single host. To access a host profile:

- navigate from any network map view.
- navigate from any event view that includes the IP addresses of hosts on monitored networks.

Host profiles provide basic information about detected hosts or devices, such as the host name or MAC addresses. Depending on your licenses and system configuration, host profiles can also provide you with the following information:

- the operating system running on a host
- the servers running on a host
- the clients and web applications running on a host
- the protocols running on a host
• the indications of compromise (IOC) tags on a host
• the VLAN tags on a host
• the last twenty-four hours of user activity on your network
• the white list violations associated with a host
• the most recent malware events for a host
• the vulnerabilities associated with a host
• the Nmap scan results for a host

Host attributes are also listed in the profile. You can use host attributes to classify hosts in ways that are important to your network environment. For example, you can:
• assign a host attribute that indicates the building where the host is located
• use the host criticality attribute to designate the business criticality of a given host and tailor correlation policies and alerts based on host criticality

From a host profile, you can view the existing host attributes applied to that host and modify the host attribute values.

If you use adaptive profiles as part of a passive intrusion prevention deployment, you can tailor the way the system processes traffic so it best fits the type of operating system on the host and the servers and clients the host is running.

Optionally, you can perform an Nmap scan from the host profile to augment the server and operating system information in your host profile. The Nmap scanner actively probes the host to obtain information about the operating system and servers running on the host. The results of the scan are added to the list of operating system and server identities for the host.

Host profile limitations include:

Unavailable Hosts

A host profile may not be available for every host on your network. Possible reasons include:
• The host was deleted from the network map because it timed out.
• You have reached your host limit.
• The host resides in a network segment that is not monitored by the network discovery policy.

Unavailable Information

The information displayed in a host profile may vary according to the type of host and the information available about the host.

For example:
• If your system detects a host using a non-IP-based protocol like STP, SNAP, or IPX, the host is added to the network map as a MAC host and much less information is available than for an IP host.
• The system can add hosts to the network map from exported NetFlow records, but the available information for these hosts is limited; see Differences between NetFlow and Managed Device Data, on page 1204.
Related Topics

Viewing Host Profiles, on page 1701

Viewing Host Profiles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Procedure

You have two choices:

- On any network map, drill down to the IP address of the host whose profile you want to view.

- On any event view, click the host profile icon ( ) or the compromised host icon ( ) next to the IP address of the host whose profile you want to view.

Basic Host Information in the Host Profile

Each host profile provides basic information about a detected host or other device.

Descriptions of each of the basic host profile fields follow.

Domain

The domain associated with the host.

IP Addresses

All IP addresses (both IPv4 and IPv6) associated with the host. The system detects IP addresses associated with hosts and, where supported, groups multiple IP addresses used by the same host. IPv6 hosts often have at least two IPv6 addresses (local-only and globally routable), and may also have IPv4 addresses. IPv4-only hosts may have multiple IPv4 addresses.

The host profile lists all detected IP addresses associated with that host. Where available, routable host IP addresses also include a flag icon and country code indicating the geolocation data associated with that address.

Note that only the first three addresses are shown by default. Click show all to show all addresses for a host.

Hostname

The fully qualified domain name of the host, if known.
**NetBIOS Name**

The NetBIOS name of the host, if available. Microsoft Windows hosts, as well as Macintosh, Linux, or other platforms configured to use NetBIOS, can have a NetBIOS name. For example, Linux hosts configured as Samba servers have NetBIOS names.

**Device (Hops)**

Either:

- the reporting device for the network where the host resides, as defined in the network discovery policy,
- or
- the device that processed the NetFlow data that added the host to the network map

The number of network hops between the device that detected the host and the host itself follows the device name, in parentheses. If multiple devices can see the host, the reporting device is displayed in bold.

If this field is blank, either:

- the host was added to the network map by a device that is not explicitly monitoring the network where the host resides, as defined in the network discovery policy, or
- the host was added using the host input feature and has not also been detected by the Firepower System.

**MAC Addresses (TTL)**

The host’s detected MAC address or addresses and associated NIC vendors, with the NIC’s hardware vendor and current time-to-live (TTL) value in parentheses.

If multiple devices detected the host, the Firepower Management Center displays all MAC addresses and TTL values associated with the host, regardless of which device reported them.

If the MAC address is displayed in bold font, the MAC address is the actual/true/primary MAC address of the host, definitively tied to the IP address by detection through ARP and DHCP traffic.

MAC addresses that are not displayed in bold font are secondary addresses, which cannot be definitively associated with the IP address of the host. For example, since the Firepower device can obtain MAC addresses only for hosts on its own network segments, if traffic originates from a network segment to which the Firepower device is not directly connected, the observed MAC address (i.e. the router MAC address) will be displayed as a secondary MAC address for the host.

**Host Type**

The type of device that the system detected: host, mobile device, jailbroken mobile device, router, bridge, NAT device, or load balancer.

The methods the system uses to distinguish network devices include:

- the analysis of Cisco Discovery Protocol (CDP) messages, which can identify network devices and their type (Cisco devices only)
- the detection of the Spanning Tree Protocol (STP), which identifies a device as a switch or bridge
- the detection of multiple hosts using the same MAC address, which identifies the MAC address as belonging to a router
• the detection of TTL value changes from the client side, or TTL values that change more frequently than
  a typical boot time, which identify NAT devices and load balancers

• The methods the system uses to distinguish mobile devices include:
  • analysis of User-Agent strings in HTTP traffic from the mobile device’s mobile browser
  • monitoring of HTTP traffic of specific mobile applications

If a device is not identified as a network device or a mobile device, it is categorized as a host.

**Last Seen**

The date and time that any of a host’s IP addresses was last detected.

**Current User**

The user most recently logged into this host.

Note that a non-authoritative user logging into a host only registers as the current user on the host if the existing
  current user is not an authoritative user.

**View**

Links to views of connection, discovery, malware, and intrusion event data, using the default workflow for
  that event type and constrained to show events related to the host; where possible, these events include all IP
  addresses associated with the host.

---

**Operating Systems in the Host Profile**

The system passively detects the identity of the operating system running on a host by analyzing the network
  and application stack in traffic generated by the host or by analyzing host data reported by the User Agent.
  The system also collates operating system information from other sources, such as the Nmap scanner or
  application data imported through the host input feature. The system considers the priority assigned to each
  identity source when determining which identity to use. By default, user input has the highest priority, followed
  by application or scanner sources, followed by the discovered identity.

Sometimes the system supplies a general operating system definition rather than a specific one because the
  traffic and other identity sources do not provide sufficient information for a more focused identity. The system
  collates information from the sources to use the most detailed definition possible.

Because the operating system affects the vulnerabilities list for the host and the event impact correlation for
  events targeting the host, you may want to manually supply more specific operating system information. In
  addition, you can indicate that fixes have been applied to the operating system, such as service packs and
  updates, and invalidate any vulnerabilities addressed by the fixes.

For example, if the system identifies a host’s operating system as Microsoft Windows 2003, but you know
  that the host is actually running Microsoft Windows XP Professional with Service Pack 2, you can set the
  operating system identity accordingly. Setting a more specific operating system identity refines the list of
  vulnerabilities for the host, so your impact correlation for that host is more focused and accurate.

If the system detects operating system information for a host and that information conflicts with a current
  operating system identity that was supplied by an active source, an identity conflict occurs. When an identity
  conflict is in effect, the system uses both identities for vulnerabilities and impact correlation.
You can configure the network discovery policy to add discovery data to the network map for hosts monitored by NetFlow exporters. However, there is no operating system data available for these hosts, unless you set the use the host input feature to set the operating system identity.

If a host is running an operating system that violates a compliance white list in an activated network discovery policy, the Firepower Management Center marks the operating system information with the white list violation icon (1). In addition, if a jailbroken mobile device violates an active white list, the icon appears next to the operating system for the device.

You can set a custom display string for the host’s operating system identity. That display string is then used in the host profile.

Note
Changing the operating system information for a host may change its compliance with a compliance white list.

In the host profile for a network device, the label for the Operating Systems section changes to Systems and an additional Hardware column appears. If a value for a hardware platform is listed under Systems, that system represents a mobile device or devices detected behind the network device. Note that mobile devices may or may not have hardware platform information, but hardware platform information is never detected for systems that are not mobile devices.

Descriptions of the operating system information fields displayed in the host profile follow.

**Hardware**
The hardware platform for a mobile device.

**OS Vendor/Vendor**
The operating system vendor.

**OS Product/Product**
One of the following values:
- the operating system determined most likely to be running on the host, based on the identity data collected from all sources
- `Pending` if the system has not yet identified an operating system and no other identity data is available
- `unknown` if the system cannot identify the operating system and no other identity data is available for the operating system

Note
If the host’s operating system is not one the system is capable of detecting, see Identifying Host Operating Systems, on page 1214:

**OS Version/Version**
The operating system version. If a host is a jailbroken mobile device, `Jailbroken` is indicated in parentheses after the version.
Source

One of the following values:
  • User: user_name
  • Application: app_name
  • Scanner: scanner_type (Nmap or other scanner)
  • Firepower

The system may reconcile data from multiple sources to determine the identity of an operating system.

Viewing Operating System Identities

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can view the specific operating system identities discovered or added for a host. The system uses source prioritization to determine the current identity for the host. In the list of identities, the current identity is highlighted by boldface text.

Note that the View button is only available if multiple operating system identities exist for the host.

Procedure

**Step 1**  
Click View in the Operating System or Operating System Conflicts section of a host profile.

**Step 2**  
View the information described in Operating Systems in the Host Profile, on page 1703.

**Step 3**  
Optionally, click the delete icon () next to any operating system identity.

**Note**  
You cannot delete Cisco-detected operating system identities.

This system removes the identity from the Operating System Identity Information pop-up window and, if applicable, updates the current identity for the operating system in the host profile.

Setting the Current Operating System Identity

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can set the current operating system identity for a host using the Firepower System web interface. Setting the identity through the web interface overrides all other identity sources so that identity is used for vulnerability assessment and impact correlation. However, if the system detects a conflicting operating system identity for
the host after you edit the operating system, an operating system conflict occurs. Both operating systems are then considered current until you resolve the conflict.

Procedure

**Step 1** Click **Edit** in the **Operating System** section of a host profile.

**Step 2** You have several options:

- Choose **Current Definition** from the **OS Definition** drop-down list to confirm the current operating system identity through host input, then skip to step 6.
- Choose a variation on the current operating system identity from the **OS Definition** drop-down list, then skip to step 6.
- Choose **User-Defined** from the **OS Definition** drop-down list, then continue with step 3.

**Step 3** Optionally, choose **Use Custom Display String** and modify the custom strings you want to display in the **Vendor String**, **Product String**, and **Version String** fields.

**Step 4** Optionally, to change to an operating system from a different vendor, choose from the **Vendor** and **Product** drop-down lists.

**Step 5** Optionally, to configure the operating system product release level, choose from the **Major**, **Minor**, **Revision**, **Build**, **Patch**, and **Extension** drop-down lists.

**Step 6** Optionally, if you want to indicate that fixes for the operating system have been applied, click **Configure Fixes**.

**Step 7** Choose the applicable fixes in the drop-down list, and click **Add**.

**Step 8** Optionally, add the relevant patches and extensions using the **Patch** and **Extension** drop-down lists.

**Step 9** Click **Finish**.

**Related Topics**
- **Operating System Identity Conflicts**, on page 1706

---

### Operating System Identity Conflicts

An operating system identity conflict occurs when a new identity detected by the system conflicts with the current identity, if that identity was provided by an active source, such as a scanner, application, or user.

The list of operating system identities in conflict displays in bold in the host profile.

You can resolve an identity conflict and set the current operating system identity for a host through the system web interface. Setting the identity through the web interface overrides all other identity sources so that identity is used for vulnerability assessment and impact correlation.

**Related Topics**
- **Configuring Network Discovery Identity Conflict Resolution**, on page 1314

### Making a Conflicting Operating System Identity Current

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>
Procedure

Step 1 Navigate to the Operating System section of a host profile.

Step 2 You have two choices:

- Click Make Current next to the operating system identity you want to set as the operating system for the host.
- If the identity that you do not want as the current identity came from an active source, delete the unwanted identity.

Resolving an Operating System Identity Conflict

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Click Resolve in the Operating System Conflicts section of a host profile.

Step 2 You have the following choices:

- Choose Current Definition from the OS Definition drop-down list to confirm the current operating system identity through host input, then skip to step 6.
- Choose a variation on one of the conflicting operating system identities from the OS Definition drop-down list, then skip to step 6.
- Choose User-Defined from the OS Definition drop-down list, then continue with step 3.

Step 3 Optionally, choose Use Custom Display String and enter the custom strings you want to display in the Vendor String, Product String, and Version String fields.

Step 4 Optionally, to change to an operating system from a different vendor, choose from the Vendor and Product drop-down lists.

Step 5 Optionally, to configure the operating system product release level, choose from the Major, Minor, Revision, Build, Patch, and Extension drop-down lists.

Step 6 Optionally, if you want to indicate that fixes for the operating system have been applied, click Configure Fixes.

Step 7 Add the fixes you have applied to the fixes list.

Step 8 Click Finish.

Related Topics

Configuring Network Discovery Identity Conflict Resolution, on page 1314
Servers in the Host Profile

The Servers Section of the host profile lists servers either detected on hosts on your monitored network, added from exported NetFlow records, or added through an active source like a scanner or the host input feature.

The list can include up to 100 servers per host. After that limit is reached, new server information from any source, whether active or passive, is discarded until you delete a server from the host or a server times out.

If you scan a host using Nmap, Nmap adds the results of previously undetected servers running on open TCP ports to the Servers list. If you perform an Nmap scan or import Nmap results, an expandable Scan Results section also appears in the host profile, listing the server information detected on the host by the Nmap scan. In addition, if the host is deleted from the network map, the Nmap scan results for that server for the host are discarded.

The system can add hosts to the network map from exported NetFlow records, but the available information for these hosts is limited; see Differences between NetFlow and Managed Device Data, on page 1204.

The process for working with servers in the host profile differs depending on how you access the profile:

• If you access the host profile by drilling down through the network map, the details for that server appear with the server name highlighted in bold. If you want to view the details for any other server on the host, click the view icon ( ) next to that server name.

• If you access the host profile in any other way, expand the Servers section and click the view icon ( ) next to the server whose details you want to see.

If the host is running a server that violates a compliance white list in an activated correlation policy, the Firepower Management Center marks the non-compliant server with the white list violation icon ( ).

Descriptions of the columns in the Servers list follow.

**Protocol**

The name of the protocol the server uses.

**Port**

The port where the server runs.

**Application Protocol**

One of:

• the name of the application protocol

• pending if the system cannot positively or negatively identify the application protocol for one of several reasons
unknown if the system cannot identify the application protocol based on known application protocol fingerprints, or if the server was added through host input by adding a vulnerability with port information without adding a corresponding server

When you hover the mouse on an application protocol name, the tags display.

**Vendor and Version**

The vendor and version identified by the Firepower System, Nmap, or another active source, or acquired via the host input feature. The field is blank if none of the available sources provides an identification.

**Related Topics**

- Host Limits and Discovery Event Logging, on page 1261
- Differences between NetFlow and Managed Device Data, on page 1204
- Application Detector Fundamentals, on page 1258

**Server Details in the Host Profile**

The Firepower Management Center lists up to 16 passively detected identities per server. Passive detection sources include network discovery data and NetFlow records. A server can have multiple passive identities if the system detects multiple vendors or versions of that server. For example, a load balancer between your managed device and your web server farm may cause your system to identify multiple passive identities for HTTP if your web servers are not running the same version of the server software. Note that the Firepower Management Center does not limit the number of server identities from active sources such as user input, scanners, or other applications.

The Firepower Management Center displays the current identity in bold. The system uses the current identity of a server for multiple purposes, including assigning vulnerabilities to a host, impact assessment, evaluating correlation rules written against host profile qualifications and compliance white lists, and so on.

The server detail may also display updated sub-server information known about the selected server.

The server detail may also display the server banner, which appears below the server details when you view a server from the host profile. Server banners provide additional information about a server that may help you identify the server. The system cannot identify or detect a misidentified server when an attacker purposely alters the server banner string. The server banner displays the first 256 bytes of the first packet detected for the server. It is collected only once, the first time the server is detected by the system. Banner content is listed in two columns, with a hexadecimal representation on the left and a corresponding ASCII representation on the right.

**Note**

To view server banners, you must enable the Capture Banners check box in the network discovery policy. This option is disabled by default.

The server details section of the host profile includes the following information:

**Protocol**

The name of the protocol the server uses.

**Port**

The port where the server runs.
Hits

The number of times the server was detected by a Firepower System managed device or an Nmap scanner. The number of hits is 0 for servers imported through host input, unless the system detects traffic for that server.

Last Used

The time and date the server was last detected. The last used time for host input data reflects the initial data import time unless the system detects new traffic for that server. Scanner and application data imported through the host input feature times out according to settings in the Firepower Management Center configuration, but user input through the FMC web interface does not time out.

Application Protocol

The name of the application protocol used by the server, if known.

Vendor

The server vendor. This field does not appear if the vendor is unknown.

Version

The server version. This field does not appear if the version is unknown.

Source

One of the following values:

• User: user_name
• Application: app_name
• Scanner: scanner_type (Nmap or other scanner)
• Firepower, Firepower Port Match, or Firepower Pattern Match for applications detected by the Firepower System
• NetFlow for servers added to the network map from NetFlow records

The system may reconcile data from multiple sources to determine the identity of a server.

Related Topics

Current Identities for Applications and Operating Systems, on page 1201

Viewing Server Details

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Procedure

In a host profile, click the view icon (🔍) next to a server in the Servers section.
Editing Server Identities

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can manually update the identity settings for a server on a host and configure any fixes that you have applied to the host to remove the vulnerabilities addressed by the fixes. You can also delete server identities. Deleting an identity does not delete the server, even if you delete the only identity. Deleting an identity does remove the identity from the Server Detail pop-up window and, if applicable, updates the current identity for the server in the host profile.

You cannot edit or delete server identities added by a Cisco-managed device.

Procedure

Step 1
Navigate to the Servers section of a host profile.

Step 2
Click View to open the Server Detail pop-up window.

Step 3
To delete a server identity, click the delete icon ( ) next to the server identity you want to remove.

Step 4
To modify a server identity, click the edit icon ( ) next to the server in the servers list.

Step 5
You have two choices:

• Choose the current definition from the Select Server Type drop-down list.

• Choose the type of server from the Select Server Type drop-down list.

Step 6
Optionally, to only list vendors and products for that server type, choose the Restrict by Server Type check box.

Step 7
Optionally, to customize the name and version of the server, choose the Use Custom Display String, and enter a Vendor String and Version String.

Step 8
In the Product Mappings section, choose the operating system, product, and versions you want to use.

Example:
For example, if you want the server to map to Red Hat Linux 9, choose Redhat, Inc. as the vendor, Redhat Linux as the product, and 9 as the version.

Step 9
If you want to indicate that fixes for the server have been applied, click Configure Fixes, and add the patches you want to apply for that server to the fixes list.

Step 10
Click Finish.
Resolving Server Identity Conflicts

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

A server identity conflict occurs when an active source, such as an application or scanner, adds identity data for a server to a host, after which the system detects traffic for that port that indicates a conflicting server identity.

**Procedure**

**Step 1** In a host profile, navigate to the Servers section.

**Step 2** Click the resolve icon next to a server.

**Step 3** Choose the type of server from the Select Server Type drop-down list.

**Step 4** Optionally, to only list vendors and products for that server type, choose the Restrict by Server Type check box.

**Step 5** Optionally, to customize the name and version of the server, choose Use Custom Display String, and enter a Vendor String and Version String.

**Step 6** In the Product Mappings section, choose the operating system, product, and versions you want to use.

**Example:**

For example, if you want the server to map to Red Hat Linux 9, choose Redhat, Inc. as the vendor, Redhat Linux as the product, and 9 as the version.

**Step 7** If you want to indicate that fixes for the server have been applied, click Configure Fixes, and add the patches you want to apply for that server to the fixes list.

**Step 8** Click Finish.

**Related Topics**

Configuring Network Discovery Identity Conflict Resolution, on page 1314

**Web Applications in the Host Profile**

The Web Application section of the host profile displays the clients and web applications that the system identifies as running on the hosts on your network. The system can identify client and web application information from both passive and active detection sources, although the information for hosts added from NetFlow records is limited.

Details in this section include the product and version of the detected applications on a host, any available client or web application information, and the time that the application was last detected in use.

The section lists up to 16 clients running on the host. After that limit is reached, new client information from any source, whether active or passive, is discarded until you delete a client application from the host or the system deletes the client from the host profile due to inactivity (the client times out).
Additionally, for each detected web browser, the system displays the first 100 web applications accessed. After that limit is reached, new web applications associated with that browser from any source, whether active or passive, are discarded until either:

- the web browser client application times out, or
- you delete application information associated with a web application from the host profile

If the host is running an application that violates a compliance white list in an activated correlation policy, the Firepower Management Center marks the non-compliant application with the white list violation icon (şı)

Tip
To analyze the connection events associated with a particular application on the host, click the events icon (ı) next to the application. The first page of your preferred workflow for connection events appears, showing connection events constrained by the type, product, and version of the application, as well as the IP address(es) of the host. If you do not have a preferred workflow for connection events, you must select one.

Descriptions of the application information that appears in a host profile follow.

Application Protocol
Displays the application protocol used by the application (HTTP browser, DNS client, and so on).

Client
Client information derived from payload if identified by the Firepower System, captured by Nmap, or acquired via the host input feature. The field is blank if none of the available sources provides an identification.

Version
Displays the version of the client.

Web Application
For web browsers, the content detected by the system in the http traffic. Web application information indicates the specific type of content (for example, WMV or QuickTime) identified by the Firepower System, captured by Nmap, or acquired via the host input feature. The field is blank if none of the available sources provides an identification.

Deleting Web Applications from the Host Profile

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can delete an application from a host profile to remove applications that you know are not running on the host. Note that deleting an application from a host may bring the host into compliance with a white list.
If the system detects the application again, it re-adds it to the network map and the host profile.

**Note**

**Procedure**

**Step 1**
In a host profile, navigate to the Applications section.

**Step 2**
Click the delete icon ((identifier) next to the application you want to delete.

---

**Host Protocols in the Host Profile**

Each host profile contains information about the protocols detected in the network traffic associated with the host. This information includes:

**Protocol**

The name of a protocol used by the host.

**Layer**

The network layer where the protocol runs (Network or Transport).

If a protocol displaying in the host profile violates a compliance white list in an activated correlation policy, the Firepower Management Center marks the non-compliant protocol with the white list violation icon (identifier).

If the host profile lists protocols that you know are not running on the host, you can delete those protocols. Deleting a protocol from a host may bring the host into compliance with a compliance white list.

**Note**

If the system detects the protocol again, it re-adds it to the network map and the host profile.

---

**Deleting a Protocol From the Host Profile**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1**
Navigate to the Protocols section of a host profile.

**Step 2**
Click the delete icon (identifier) next to the protocol you want to delete.
Indications of Compromise in the Host Profile

The Firepower System correlates various types of data (intrusion events, Security Intelligence, connection events, and file or malware events) to determine whether a host on your monitored network is likely to be compromised by malicious means. Certain combinations and frequencies of event data trigger indications of compromise (IOC) tags on affected hosts.

The Indications of Compromise section of the host profile displays all indication of compromise tags for a host.

To configure the system to tag indications of compromise, see Enabling Indications of Compromise Rules, on page 1316.

For more information about working with indications of compromise, see Indications of Compromise Data, on page 1750 and the subtopics under that topic.

Related Topics
   Indications of Compromise, on page 1315

VLAN Tags in the Host Profile

The VLAN Tag section of the host profile appears if the host is a member of a Virtual LAN (VLAN).

Physical network equipment often uses VLANs to create logical network segments from different network blocks. The system detects 802.1q VLAN tags and displays the following information for each:

- **VLAN ID** identifies the VLAN where the host is a member. This can be any integer between zero and 4095 for 802.1q VLANs.

- **Type** identifies the encapsulated packet containing the VLAN tag, which can be either Ethernet or Token Ring.

- **Priority** identifies the priority in the VLAN tag, which can be any integer from zero to 7, where 7 is the highest priority.

If VLAN tags are nested within the packet, the system processes and the Firepower Management Center displays the innermost VLAN tag. The system collects and displays VLAN tag information only for MAC addresses that it identifies through ARP and DHCP traffic.

VLAN tag information can be useful, for example, if you have a VLAN composed entirely of printers and the system detects a Microsoft Windows 2000 operating system in that VLAN. VLAN information also helps the system generate more accurate network maps.

User History in the Host Profile

The user history portion of the host profile provides a graphic representation of the last twenty-four hours of user activity. A typical user logs off in the evening and may share the host resource with another user. Periodic login requests, such as those made to check email, are indicated by short regular bars. A list of user identities is provided with bar graphs to indicate when the user login was detected. Note that for non-authoritative logins, the bar graph is gray.
Note that the system does associate a non-authoritative user login to a host with an IP address of that host, so the user does appear in the host’s user history. However, if an authoritative user login is detected for the same host, the user associated with the authoritative user login takes over the association with the host IP address, and new non-authoritative user logins do not disrupt that user association with the host IP address. If you configure capture of failed logins in the network discovery policy, the list includes users that failed to log into the host.

Host Attributes in the Host Profile

You can use host attributes to classify hosts in ways that are important to your network environment. Three types of attributes are present in the Firepower System:

- predefined host attributes
- white list host attributes
- user-defined host attributes

After you set a predefined host attribute or create a user-defined host attribute, you must assign a host attribute value.

**Note**

Host attributes can be defined at any domain level. You can assign host attributes created in current and ancestor domains.

Predefined Host Attributes

The Firepower Management Center provides two predefined host attributes:

**Host Criticality**

Use this attribute to designate the business criticality of a given host and to tailor correlation responses to host criticality. For example, if you consider your organization’s mail servers more critical to your business than a typical user workstation, you can assign a value of High to your mail servers and other business-critical devices and Medium or Low to other hosts. You can then create a correlation policy that launches different alerts based on the criticality of an affected host.

**Notes**

Use this host-specific attribute to record information about the host that you want other analysts to view. For example, if you have a computer on the network that has an older, unpatched version of an operating system that you use for testing, you can use the Notes feature to indicate that the system is intentionally unpatched.

White List Host Attributes

Each compliance white list that you create automatically creates a host attribute with the same name as the white list. Possible values for white list host attributes are:

- Compliant — Identifies hosts that are compliant with the white list.
- Non-Compliant — Identifies hosts that violate the white list.
Not Evaluated — Identifies hosts that are not valid targets of the white list or have not been evaluated for any reason.

You cannot edit the value of a white list host attribute or delete a white list host attribute.

User-Defined Host Attributes

If you want to identify hosts using criteria that differs from those used in the predefined host attributes or white list host attributes, you can create user-defined host attributes. For example, you can:

- Assign physical location identifiers to hosts, such as a facility code, city, or room number.
- Assign a Responsible Party Identifier that indicates which system administrator is responsible for a given host. You can then craft correlation rules and policies to send alerts to the correct system administrator when problems related to a host are detected.
- Automatically assign values to hosts from a predefined list based on the hosts’ IP addresses. This feature can be useful to assign values to new hosts when they appear on your network for the first time.

User-defined host attributes appear in the host profile page, where you can assign values on a per-host basis. You can also:

- Use the attributes in correlation policies and searches.
- View the attributes on the host attribute table view of events and generate reports based on them.

User-defined host attributes can be one of the following types:

Text

Allows you to manually assign a text string to a host.

Integer

Allows you to specify the first and last number of a range of positive integers, then manually assign one of these numbers to a host.

List

Allows you to create a list of string values, then manually assign one of the values to a host. You can also automatically assign values to hosts based on the host’s IP addresses.

If you auto-assign values based on one IP address of a host with multiple IP addresses, those values will apply across all addresses associated with that host. Keep this in mind when you view the Host Attributes table.

When automatically assigning list values, consider using network objects rather than literal IP addresses. This approach can improve maintainability, particularly in a multidomain deployment where using override-enabled objects allows descendant domain administrators to tailor ancestor configurations to their local environments. In a multidomain deployment, be careful when defining auto-assigned lists at ancestor domain levels to avoid matching unintended hosts when the descendant domains use overlapping IP addresses.

URL

Allows you to manually assign a URL value to a host.

Deleting a user-defined host attribute removes it from every host profile where it is used.
Creating Text- or URL-Based Host Attributes

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Procedure

Step 1 Choose Analysis > Hosts > Host Attributes.
Step 2 Click Host Attribute Management.
Step 3 Click Create Attribute.
Step 4 Enter a Name.
Step 5 Choose the Type of attribute that you want to create as described in User-Defined Host Attributes, on page 1717.
Step 6 Click Save.

Creating Integer-Based Host Attributes

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

When you define an integer-based host attribute, you must specify the range of numbers that the attribute accepts.

Procedure

Step 1 Choose Analysis > Hosts > Host Attributes.
Step 2 Click Host Attribute Management.
Step 3 Click Create Attribute.
Step 4 Enter a Name.
Step 5 Choose the Type of attribute that you want to create as described in User-Defined Host Attributes, on page 1717.
Step 6 In the Min field, enter the minimum integer value that can be assigned to a host.
Step 7 In the Max field, enter the maximum integer value that can be assigned to a host.
Step 8 Click Save.
Creating List-Based Host Attributes

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

When you define a list-based host attribute, you must supply each of the values for the list. These values can contain alphanumeric characters, spaces, and symbols.

**Procedure**

**Step 1** Choose Analysis > Hosts > Host Attributes.
**Step 2** Click Host Attribute Management.
**Step 3** Click Create Attribute.
**Step 4** Enter a Name.
**Step 5** Choose the Type of attribute that you want to create as described in User-Defined Host Attributes, on page 1717.
**Step 6** To add a value to the list, click Add Value.
**Step 7** In the Name field, enter the first value you want to add.
**Step 8** Optionally, to auto-assign the attribute value you just added to your hosts, click Add Networks.
**Step 9** Choose the value you added from the Value drop-down list.
**Step 10** In the IP Address and Netmask fields, enter the IP address and network mask (IPv4) that represent the IP address block where you want to auto-assign this value.
**Step 11** Repeat steps 6 through 10 to add additional values to the list and assign them automatically to new hosts that fall within an IP address block.
**Step 12** Click Save.

Setting Host Attribute Values

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can set values for predefined and user-defined host attributes. You cannot set values for white list host attributes generated by the system.

**Procedure**

**Step 1** Open the host profile you want to modify.
**Step 2** In the Attributes section, click Edit Attributes.
**Step 3** Update attribute as desired.
Step 4 Click Save.

White List Violations in the Host Profile

A compliance white list (or white list) is a set of criteria that allows you to specify the operating systems, application protocols, clients, web applications, and protocols that are allowed to run on a specific subnet.

If you add a white list to an active correlation policy, when the system detects that a host is violating the white list, the Firepower Management Center logs a white list event—which is a special kind of correlation event—to the database. Each of these white list events is associated with a white list violation, which indicates how and why a particular host is violating a white list. If a host violates one or more white lists, you can view these violations in its host profile in two ways.

First, the host profile lists all of the individual white list violations associated with the host. Descriptions of the white list violation information in the host profile follow.

Type
The type of the violation, that is, whether the violation occurred as a result of a non-compliant operating system, application, server, or protocol.

Reason
The specific reason for the violation. For example, if you have a white list that allows only Microsoft Windows hosts, the host profile displays the current operating system running on the host (such as Linux 2.4, 2.6).

White List
The name of the white list associated with the violation.

Second, in the sections associated with operating systems, applications, protocols, and servers, the Firepower Management Center marks non-compliant elements with the white list violation icon ( ). For example, for a white list that allows only Microsoft Windows hosts, the host profile displays the white list violation icon next to the operating system information for that host.

Note You can use a host’s profile to create a shared host profile for compliance white lists.

Creating Shared White List Host Profiles

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Shared host profiles for compliance white lists specify which operating systems, application protocols, clients, web applications, and protocols are allowed to run on target hosts across multiple white lists. That is, if you create multiple white lists but want to use the same host profile to evaluate hosts running a particular operating system across the white lists, use a shared host profile.
You can use a host profile of any host with a known IP address to create a shared host profile that your compliance white lists can use. However, note that you cannot create a shared host profile based on an individual host’s host profile if the system has not yet identified the operating system of the host.

**Procedure**

**Step 1**
In a host profile, click **Generate White List Profile**.

**Step 2**
Modify and save the shared host profile according to your specific needs.

**Related Topics**
- [Building White List Host Profiles](on page 1352)

---

## Malware Detections in the Host Profile

The Most Recent Malware Detections section lists the most recent malware events where the host sent or received a malware file, up to 100 events. The host profile lists both network-based malware events (those generated by AMP for Networks) and endpoint-based malware events (those generated by AMP for Endpoints).

If the host is involved in a file event where the file is then retrospectively identified as malware, the original events where the file was transmitted appear in the malware detections list after the malware identification occurs. When a file identified as malware is retrospectively determined not to be malware, the malware events related to that file no longer appear in the list. For example, if a file has a disposition of **Malware** and that disposition changes to **Clean**, the event for that file is removed from the malware detections list on the host profile.

When viewing malware detections in the host profile, you can view malware events for that host by clicking the malware icon (🔍).

Description of the columns in the Most Recent Malware Detections sections of the host profile follow.

**Time**
The date and time the event was generated.

For an event where the file was retrospectively identified as malware, note that this is the time of the original event, not the time when the malware was identified.

**Host Role**
The host’s role in the transmission of detected malware, either sender or receiver. Note that for malware events generated by AMP for Endpoints (“endpoint-based malware events”), the host is always the receiver.

**Threat Name**
The name of the detected malware.

**File Name**
The name of the malware file.
Vulnerabilities in the Host Profile

The Vulnerabilities sections of the host profile list the vulnerabilities that affect that host. These vulnerabilities are based on the operating system, servers, and applications that the system detected on the host.

If there is an identity conflict for either the identity of the host’s operating system or one of the application protocols on the host, the system lists vulnerabilities for both identities until the conflict is resolved.

Because no operating system information is available for hosts added to the network map from NetFlow data, the system cannot assign Vulnerable (impact level 1: red) impact levels for intrusion events involving those hosts. In such cases, use the host input feature to manually set the operating system identity for the hosts.

Server vendor and version information is often not included in traffic. By default, the system does not map the associated vulnerabilities for the sending and receiving hosts of such traffic. However, you can configure the system to map vulnerabilities for specific application protocols that do not have vendor or version information.

If you use the host input feature to add third-party vulnerability information for the hosts on your network, additional Vulnerabilities sections appear. For example, if you import vulnerabilities from a QualysGuard Scanner, host profiles on your include a QualysGuard Vulnerabilities section. For third-party vulnerabilities, the information in the corresponding Vulnerabilities section in the host profile is limited to the information that you provided when you imported the vulnerability data using the host input feature.

You can associate third-party vulnerabilities with operating systems and application protocols, but not clients. For information on importing third-party vulnerabilities, see the Firepower System Host Input API Guide.

Descriptions of the columns in the Vulnerabilities sections of the host profile follow.

Name
The name of the vulnerability.

Remote
Indicates whether the vulnerability can be remotely exploited. If this column is blank, the vulnerability definition does not include this information.

Component
The name of the operating system, application protocol, or client associated with the vulnerability.

Port
A port number, if the vulnerability is associated with an application protocol running on a specific port.

Related Topics
- Vulnerability Data Fields, on page 1762
- Vulnerability Deactivation, on page 1764
**Downloading Patches for Vulnerabilities**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security</td>
</tr>
</tbody>
</table>

You can download patches to mitigate the vulnerabilities discovered on the hosts on your network.

**Procedure**

**Step 1** Access the host profile of a host for which you want to download a patch.

**Step 2** Expand the **Vulnerabilities** section.

**Step 3** Click the name of the vulnerability you want to patch.

**Step 4** Expand the **Fixes** section to display the list of patches for the vulnerability.

**Step 5** Click **Download** next to the patch you want to download.

**Step 6** Download the patch and apply it to your affected systems.

---

**Deactivating Vulnerabilities for Individual Hosts**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security</td>
</tr>
</tbody>
</table>

You can use the host vulnerability editor to deactivate vulnerabilities on a host-by-host basis. When you deactivate a vulnerability for a host, it is still used for impact correlations for that host, but the impact level is automatically reduced one level.

**Procedure**

**Step 1** Navigate to the **Vulnerabilities** section of a host profile.

**Step 2** Click **Edit Vulnerabilities**.

**Step 3** Choose the vulnerability from the **Valid Vulnerabilities** list, and click the down arrow to move it to the **Invalid Vulnerabilities** list.

**Tip** You can click and drag to choose multiple adjacent vulnerabilities; you can also double-click any vulnerability to move it from list to list.

**Step 4** Click **Save**.
What to do next

• Optionally, activate the vulnerability for the host by moving it from the Invalid Vulnerabilities list to the Valid Vulnerabilities list.

Related Topics

Deactivating Individual Vulnerabilities, on page 1724
Deactivating Multiple Vulnerabilities, on page 1766

Deactivating Individual Vulnerabilities

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

If you deactivate a vulnerability in a host profile, it deactivates it for all hosts in your network map. However, you can reactivate it at any time.

In a multidomain deployment, deactivating a vulnerability in an ancestor domain deactivates it in all descendant domains. Leaf domains can activate or deactivate a vulnerability for their devices if the vulnerability is activated in the ancestor domain.

Procedure

Step 1
Access the vulnerability detail:

• In an affected host profile, expand the Vulnerabilities section, and click the name of the vulnerability you want to enable or disable.
• In the predefined workflow, choose Analysis > Vulnerabilities > Vulnerabilities, and click the view icon (🔍) next to the vulnerability you want to enable or disable.

Step 2
Choose Disabled from the Impact Qualification drop-down list.
If the controls are dimmed, the configuration belongs to an ancestor domain, or you do not have permission to modify the configuration.

Step 3
Confirm that you want to change the Impact Qualification value for all hosts on the network map.

Step 4
Click Done.

What to do next

• Optionally, activate the vulnerability by choosing Enabled from the Impact Qualification drop-down list while performing the steps above.

Related Topics

Deactivating Vulnerabilities for Individual Hosts, on page 1723
Deactivating Multiple Vulnerabilities, on page 1766
Operating System Identity Conflicts, on page 1706
Scan Results in the Host Profile

When you scan a host using Nmap, or when you import results from an Nmap scan, those results appear in the host profile for any hosts included in the scan.

The information that Nmap collects about the host operating system and any servers running on open unfiltered ports is added directly into the Operating System and Servers sections of the host profile, respectively. In addition, Nmap adds a list of the scan results for that host in the Scan Results section. Note that the scan must find open ports on the host for Scan Results section to appear in the profile.

Each result indicates the source of the information, the number and type of the scanned port, the name of the server running on the port, and any additional information detected by Nmap, such as the state of the port or the vendor name for the server. If you scan for UDP ports, servers detected on those ports only appear in the Scan Results section.

Note that you can run an Nmap scan from the host profile.

Scanning a Host from the Host Profile

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can perform a Nmap scan against a host from the host profile. After the scan completes, server and operating system information for that host are updated in the host profile. Any additional scan results are added to the Scan Results section of the host profile.

⚠️ Caution

Nmap-supplied server and operating system data remains static until you run another Nmap scan or override it with higher priority host input. If you plan to scan a host using Nmap, regularly schedule scans.

Before you begin

- Add an Nmap scan instance; see Adding an Nmap Scan Instance, on page 1245.

Procedure

Step 1

In the host profile, click Scan Host.

Step 2

Click Scan next to the scan remediation you want to use to scan the host.

The system scans the host and adds the results to the host profile.

Related Topics

Nmap Scan Automation, on page 156
Working with Discovery Events

The following topics describe how to work with discovery events:

- Discovery and Identity Data in Discovery Events, on page 1727
- Viewing Discovery Event Statistics, on page 1728
- Viewing Discovery Performance Graphs, on page 1731
- Using Discovery and Identity Workflows, on page 1732

Discovery and Identity Data in Discovery Events

The system generates tables of events that represent the changes detected in your monitored network. You can use these tables to review the user activity on your network and determine how to respond. The network discovery and identity policies specify the kinds of data you want to collect, the network segments you want to monitor, and the specific hardware interfaces you want to use to do it.

You can use discovery and identity event tables to identify threats associated with hosts, applications, and users on your network. The system provides a set of predefined workflows that you can use to analyze the events that your system generates. You can also create custom workflows that display only the information that matches your specific needs.

To collect and store network discovery and identity data for analysis, you must configure network discovery and identity policies. After you configure an identity policy, you must invoke it in your access control policy and deploy it to the devices you want to use to monitor traffic.

Your network discovery policy provides host, application, and non-authoritative user data. Your identity policy provides authoritative user data.

The following discovery event tables are located under the Analysis > Hosts, Analysis > Users, and Analysis > Vulnerabilities menus.

<table>
<thead>
<tr>
<th>Discovery Event Table</th>
<th>Populated With Discovery Data?</th>
<th>Populated With Identity Data?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Indications of Compromise</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Applications</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Application Details</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
### Viewing Discovery Event Statistics

<table>
<thead>
<tr>
<th>Discovery Event Table</th>
<th>Populated With Discovery Data?</th>
<th>Populated With Identity Data?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Servers</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Host Attributes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Discovery Events</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>User Activity</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Users</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Vulnerabilities</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Third-Party Vulnerabilities</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

The Discovery Statistics page displays a summary of the hosts, events, protocols, application protocols, and operating systems detected by the system.

The page lists statistics for the last hour and the total accumulated statistics. You can choose to view statistics for a particular device, or all devices. You can also view events that match the entries on the page by clicking the event, server, operating system, or operating system vendor listed within the summary.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose **Overview > Summary > Discovery Statistics**.

**Step 2** From the **Select Device** list, choose the device whose statistics you want to view. Optionally, choose **All** to view statistics for all devices managed by the Firepower Management Center.

**Step 3** You have the following options:

- In the Statistics Summary, view general statistics as described in The Statistics Summary Section, on page 1729.

- In the Event Breakdown, click the type of event you want to view. If no events appear, you may need to adjust the time range as described in Changing the Time Window, on page 1543.

- In the Protocol Breakdown, view the protocols currently in use by detected hosts.

- In the Application Protocol Breakdown, click the name of the application protocol you want to view.
• In the OS Breakdown, click the OS Name or OS Vendor.

Related Topics
The Event Breakdown Section, on page 1730
The Protocol Breakdown Section, on page 1730
The Application Protocol Breakdown Section, on page 1730
The OS Breakdown Section, on page 1730

The Statistics Summary Section

Descriptions of the rows of the Statistics Summary section follow.

Total Events
Total number of discovery events stored on the Firepower Management Center.

Total Events Last Hour
Total number of discovery events generated in the last hour.

Total Events Last Day
Total number of discovery events generated in the last day.

Total Application Protocols
Total number of application protocols from servers running on detected hosts.

Total IP Hosts
Total number of detected hosts identified by unique IP address.

Total MAC Hosts
Total number of detected hosts not identified by IP address.
Note that the Total MAC Hosts statistic remains the same whether you are viewing discovery statistics for all devices or for a specific device. This is so because managed devices discover hosts based on their IP addresses. This statistic gives the total of all hosts that are identified by other means and is independent of a given managed device.

Total Routers
Total number of detected nodes identified as routers.

Total Bridges
Total number of detected nodes identified as bridges.
Host Limit Usage

Total percentage of the host limit currently in use. The host limit is defined by the model of your Firepower Management Center. Note that the host limit usage only appears if you are viewing statistics for all managed devices.

Note

If the host limit is reached and a host is deleted, the host will not reappear on the network map you purge discovery data.

Last Event Received

The date and time that the most recent discovery event occurred.

Last Connection Received

The date and time that the most recent connection was completed.

The Event Breakdown Section

The Event Breakdown section lists a count of each type of discovery event and host input event that occurred within the last hour, as well as a count of the total number of each event type stored in the database.

You can also use the Event Breakdown section to view details on discovery and host input events.

Related Topics

Discovery and Host Input Events, on page 1734

The Protocol Breakdown Section

The Protocol Breakdown section lists the protocols currently in use by detected hosts. It displays each detected protocol name, its “layer” in the protocol stack, and the total number of hosts that communicate using the protocol.

The Application Protocol Breakdown Section

The Application Protocol Breakdown section lists the application protocols that are currently in use by detected hosts. It lists the protocol name, the total number of hosts running the application protocol in the past hour, and the total number of hosts that have been detected running the protocol at any point.

You can also use the Application Protocol Breakdown section to view details on servers using the detected protocols.

Related Topics

Server Data, on page 1754

The OS Breakdown Section

The OS Breakdown section lists the operating systems currently running on the monitored network, along with their vendors and the total number of hosts running each operating system.
A value of unknown for the operating system name or version means that the operating system or its version does not match any of the system’s fingerprints. A value of pending means that the system has not yet gathered enough information to identify the operating system or its version.

You can use the OS Breakdown section to view details on the detected operating systems.

Related Topics
Host Data, on page 1742

Viewing Discovery Performance Graphs

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>

You can generate graphs that display performance statistics for managed devices with discovery events.

New data is accumulated for statistics graphs every five minutes. Therefore, if you reload a graph quickly, the data may not change until the next five-minute increment occurs.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

Before you begin
Edit the applicable network discovery policy to include applications, hosts, and users. (This may impact system performance.) See Configuring Network Discovery Rules, on page 1302 and Actions and Discovered Assets, on page 1302.

Procedure

- **Step 1** Choose Overview > Summary > Discovery Performance.
- **Step 2** From the Select Device list, choose the Firepower Management Center or managed devices you want to include.
- **Step 3** From the Select Graph(s) list, choose the type of graph you want to create as described in Discovery Performance Graph Types, on page 1731.
- **Step 4** From the Select Time Range list, choose the time range you would like to use for the graph.
- **Step 5** Click Graph to graph the selected statistics.

Discovery Performance Graph Types

Descriptions of the available graph types follow.

Processed Events/Sec
Displays a graph that represents the number of events that the Data Correlator processes per second.
**Processed Connections/Sec**
Displays a graph that represents the number of connections that the Data Correlator processes per second

**Generated Events/Sec**
Displays a graph that represents the number of events that the system generates per second

**Mbits/Sec**
Displays a graph that represents the number of megabits of traffic that are analyzed by the discovery process per second

**Avg Bytes/Packet**
Displays a graph that represents the average number of bytes included in each packet analyzed by the discovery process

**K Packets/Sec**
Displays a graph that represents the number of packets analyzed by the discovery process per second, in thousands

---

## Using Discovery and Identity Workflows

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>task dependent</td>
</tr>
</tbody>
</table>

The Firepower Management Center provides a set of event workflows that you can use to analyze the discovery and identity data that is generated for your network. The workflows are, along with the network map, a key source of information about your network assets.

The Firepower Management Center provides predefined workflows for discovery and identity data, detected hosts and their host attributes, servers, applications, application details, vulnerabilities, user activities, and users. You can also create custom workflows.

### Procedure

**Step 1**
To access a predefined workflow:
- Discovery and Host Input Data — See Viewing Discovery and Host Input Events, on page 1740.
- Host Data — See Viewing Host Data, on page 1742.
- Host Attributes Data — See Viewing Host Attributes, on page 1748.
- Indications of Compromise Data — See View and Work with Indications of Compromise Data, on page 1750.
- Server Data — See Viewing Server Data, on page 1754.
- Application Data — See Viewing Application Data, on page 1757.
• Application Detail Data — See Viewing Application Detail Data, on page 1759.
• User Data — See Viewing User Data, on page 1774.
• User Activity Data — See Viewing User Activity Data, on page 1776.
• Network Map — See Viewing Network Maps, on page 1498.

**Step 2**
To access a custom workflow, choose **Analysis > Custom > Custom Workflows**.

**Step 3**
To access a workflow based on a custom table, choose **Analysis > Custom > Custom Tables**.

**Step 4**
Perform any of the following actions, which are common to all of the pages accessed in the network discovery workflows:

• **Constrain Columns** — To constrain the columns that display, click the close icon (×) in the column heading that you want to hide. In the pop-up window that appears, click **Apply**.

**Tip**
To hide or show other columns, check or clear the appropriate check boxes before you click **Apply**. To add a disabled column back to the view, click the expand arrow to expand the search constraints, then click the column name under **Disabled Columns**.

• **Delete** — To delete some or all items in the current constrained view, check the check boxes next to items you want to delete and click **Delete**, or click **Delete All**. These items remain deleted until the system’s discovery function is restarted, when they may be detected again.

**Caution**
Before you delete a session on the **Analysis > Users > Users** page, verify that the session is actually closed. After you delete the active session, an applicable policy will not be able to detect the session on the device, and therefore the session will not be monitored or blocked even if the policy was configured to perform those actions.

**Note**
You **cannot** delete Cisco (as opposed to third-party) vulnerabilities; you can, however, mark them reviewed.

• **Drill Down** — To drill down to the next page in the workflow, see Using Drill-Down Pages, on page 1531.

• **Navigate Current Page** — To navigate within the current workflow page, see Workflow Page Navigation Tools, on page 1528.

• **Navigate within a Workflow** — To navigate between pages in the current workflow, keeping the current constraints, click the appropriate page link at the top left of the workflow page.

• **Navigate to Other Workflows** — To navigate to other event views to examine associated events, see Inter-Workflow Navigation, on page 1549.

• **Sort Data** — To sort data in a workflow, click the column title. Click the column title again to reverse the sort order.

• **View Host Profile** — To view the host profile for an IP address, click the host profile icon or, for hosts with active indications of compromise (IOC) tags, the compromised host icon that appears next to the IP address.
Discovery and Host Input Events

The system generates discovery events that communicate the details of changes in your monitored network segments. New events are generated for newly discovered network features, and change events are generated for any change in previously identified network assets.

During its initial network discovery phase, the system generates new events for each host and any TCP or UDP servers discovered running on each host. Optionally, you can configure the system to use exported NetFlow records to generate these new host and server events.

In addition, the system generates new events for each network, transport, and application protocol running on each discovered host. You can disable detection of application protocols in discovery rules configured to monitor NetFlow exporters, but not in discovery rules configured to monitor Firepower System managed devices. If you enable host or user discovery in non-NetFlow discovery rules, applications are automatically discovered.

After the initial network mapping is complete, the system continuously records network changes by generating change events. Change events are generated whenever the configuration of a previously discovered asset changes.

When a discovery event is generated, it is logged to the database. You can use the Firepower Management Center web interface to view, search, and delete discovery events. You can also use discovery events in correlation rules. Based on the type of discovery event generated as well as other criteria that you specify, you can build correlation rules that, when used in a correlation policy, launch remediations and syslog, SNMP, and email alert responses when network traffic meets your criteria.

You can add data to the network map using the host input feature. You can add, modify, or delete operating system information, which causes the system to stop updating that information for that host. You can also manually add, modify, or delete application protocols, clients, servers, and host attributes or modify vulnerability information. When you do this, the system generates host input events.

Discovery Event Types

You can configure the types of discovery events the system logs in your network discovery policy. When you view the discovery events table, the event type is listed in the Event column. Descriptions of the discovery event types follow.

Additional MAC Detected for Host

This event is generated when the system detects a new MAC address for a previously discovered host.

This event is often generated when the system detects hosts passing traffic through a router. While each host has a different IP address, they all appear to have the MAC address associated with the router. When the system detects the actual MAC address associated with the IP address, it displays the MAC address in bold...
text within the host profile and displays an “ARP/DHCP detected” message within the event description in the event view.

**Client Timeout**
This event is generated when the system drops a client from the database due to inactivity.

**Client Update**
This event is generated when the system detects a payload (that is, a specific type of content, such as audio, video, or webmail) in HTTP traffic.

**DHCP: IP Address Changed**
This event is generated when the system detects that a host IP address has changed due to DHCP address assignment.

**DHCP: IP Address Reassigned**
This event is generated when a host is reusing an IP address; that is, when a host obtains an IP address formerly used by another physical host due to DHCP IP address assignment.

**Hops Change**
This event is generated when the system detects a change in the number of network hops between a host and the device that detects the host. This may happen if:
- The device sees host traffic through different routers and is able to make a better determination of the host’s location.
- The device detects an ARP transmission from the host, indicating that the host is on a local segment.

**Host Deleted: Host Limit Reached**
This event is generated when the host limit on the Firepower Management Center is exceeded and a monitored host is deleted from the network map.

**Host Dropped: Host Limit Reached**
This event is generated when the host limit on the Firepower Management Center is reached and a new host is dropped. Compare this with the previous event where old hosts are deleted from the network map when the host limit is reached.

To drop new hosts when the host limit is reached, go to Policies > Network Discovery > Advanced and set When Host Limit Reached to Drop hosts.

**Host IOC Set**
This event is generated when an IOC (Indications of Compromise) is set for a host and generates an alert.

**Host Timeout**
This event is generated when a host is dropped from the network map because the host has not produced traffic within the interval defined in the network discovery policy. Note that individual host IP addresses and
MAC addresses time out individually; a host does not disappear from the network map unless all of its associated addresses have timed out.

If you change the networks you want to monitor in your network discovery policy, you may want to manually delete old hosts from the network map so that they do not count against your host limit.

**Host Type Changed to Network Device**

This event is generated when the system detects that a detected host is actually a network device.

**Identity Conflict**

This event is generated when the system detects a new server or operating system identity that conflicts with a current active identity for that server or operating system.

If you want to resolve identity conflicts by rescanning the host to obtain newer active identity data, you can use Identity Conflict events to trigger an Nmap remediation.

**Identity Timeout**

This event is generated when server or operating system identity data from an active source times out.

If you want to refresh identity data by rescanning the host to obtain newer active identity data, you can use Identity Conflict events to trigger an Nmap remediation.

**MAC Information Change**

This event is generated when the system detects a change in the information associated with a specific MAC address or TTL value.

This event often occurs when the system detects hosts passing traffic through a router. While each host has a different IP address, they will all appear to have the MAC address associated with the router. When the system detects the actual MAC address associated with the IP address, it displays the MAC address in bold text within the host profile and displays an “ARP/DHCP detected” message within the event description in the event view. The TTL may change because the traffic may pass through different routers or if the system detects the actual MAC address of the host.

**NETBIOS Name Change**

This event is generated when the system detects a change to a host’s NetBIOS name. This event will only be generated for hosts using the NetBIOS protocol.

**New Client**

This event is generated when the system detects a new client.

---

**Note**

To collect and store client data for analysis, make sure that you enable application detection in your discovery rules in the network discovery policy.

**New Host**

This event is generated when the system detects a new host running on the network.
This event can also be generated when a device processes NetFlow data that involves a new host. To generate an event in this case, configure the network discovery rule that manages NetFlow data to discover hosts.

**New Network Protocol**

This event is generated when the system detects that a host is communicating with a new network protocol (IP, ARP, and so on).

**New OS**

This event is generated when the system either detects a new operating system for a host, or a change in a host’s operating system.

**New TCP Port**

This event is generated when the system detects a new TCP server port (for example, a port used by SMTP or web services) active on a host. This event is not used to identify the application protocol or the server associated with it; that information is transmitted in the TCP Server Information Update event.

This event can also be generated when a device processes NetFlow data involving a server on your monitored networks that does not already exist in the network map. To generate an event in this case, configure the network discovery rule that manages NetFlow data to discover applications.

**New Transport Protocol**

This event is generated when the system detects that a host is communicating with a new transport protocol, such as TCP or UDP.

**New UDP Port**

This event is generated when the system detects a new UDP server port running on a host.

This event can also be generated when a device processes NetFlow data involving a server on your monitored networks that does not already exist in the network map. To generate an event in this case, configure the network discovery rule that manages NetFlow data to discover applications.

**TCP Port Closed**

This event is generated when the system detects that a TCP port has closed on a host.

**TCP Port Timeout**

This event is generated when the system has not detected activity from a TCP port within the interval defined in the system’s network discovery policy.

**TCP Server Information Update**

This event is generated when the system detects a change in a discovered TCP server running on a host. This event may be generated if a TCP server is upgraded.

**UDP Port Closed**

This event is generated when the system detects that a UDP port has closed on a host.
UDP Port Timeout

This event is generated when the system has not detected activity from a UDP port within the interval defined in the network discovery policy.

UDP Server Information Update

This event is generated when the system detects a change in a discovered UDP server running on a host. This event may be generated if a UDP server is upgraded.

VLAN Tag Information Update

This event is generated when the system detects a change in the VLAN tag attributed to a host.

Related Topics

- Host Input Event Types, on page 1738
- Network Discovery Data Storage Settings, on page 1318
- Application and Operating System Identity Conflicts, on page 1202
- Network Discovery Identity Conflict Settings, on page 1313

Host Input Event Types

When you view a table of discovery events, the event type is listed in the Event column. Contrast host input events, which are generated when a user takes a specific action (such as manually adding a host), with discovery events, which are generated when the system itself detects a change in your monitored network (such as detecting traffic from a previously undetected host).

You can configure the types of host input events that the system logs by modifying your network discovery policy. If you understand the information the different types of host input events provide, you can more effectively determine which events you want to log and alert on, and how to use these alerts in correlation policies. In addition, knowing the names of the event types can help you craft more effective event searches. Descriptions of the different types of host input events follow.

Add Client

This event is generated when a user adds a client.

Add Host

This event is generated when a user adds a host.

Add Protocol

This event is generated when a user adds a protocol.

Add Scan Result

This event is generated when the system adds the results of an Nmap scan to a host.

Add Port

This event is generated when a user adds a server port.
Delete Client
This event is generated when a user deletes a client from the system.

Delete Host/Network
This event is generated when a user deletes an IP address or subnet from the system.

Delete Protocol
This event is generated when a user deletes a protocol from the system.

Delete Port
This event is generated when a user deletes a server port or group of server ports from the system.

Host Attribute Add
This event is generated when a user creates a new host attribute.

Host Attribute Delete
This event is generated when a user deletes a user-defined host attribute.

Host Attribute Delete Value
This event is generated when a user deletes a value assigned to a host attribute.

Host Attribute Set Value
This event is generated when a user sets a host attribute value for a host.

Host Attribute Update
This event is generated when a user changes the definition of a user-defined host attribute.

Set Host Criticality
This event is generated when a user sets or modifies the host criticality value for a host.

Set Operating System Definition
This event is generated when a user sets the operating system for a host.

Set Server Definition
This event is generated when a user sets the vendor and version definitions for a server.

Set Vulnerability Impact Qualification
This event is generated when a vulnerability impact qualification is set.

When a vulnerability is disabled at a global level from being used for impact qualifications, or when a vulnerability is enabled at a global level, this event is generated.


**Vulnerability Set Invalid**

This event is generated when a user invalidates (or reviews) a vulnerability or vulnerabilities.

**Vulnerability Set Valid**

This event is generated when a user validates a vulnerability that was previously marked as invalid.

**Related Topics**

- Discovery Event Types, on page 1734

---

### Viewing Discovery and Host Input Events

<table>
<thead>
<tr>
<th>Access</th>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin/Any Security Analyst</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

Discovery events workflows allow you to view data from both discovery events and host input events. You can manipulate the event view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access events differs depending on the workflow you use. You can use the predefined workflow, which includes the table view of discovery events and a terminating host view page. You can also create a custom workflow that displays only the information that matches your specific needs.

**Procedure**

---

**Step 1** Choose **Analysis > Hosts > Discovery Events**.

**Step 2** You have the following options:

- Adjust the time range as described in Changing the Time Window, on page 1543.

  **Note** Events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.

- Use a different workflow, including a custom workflow, by clicking **(switch workflow)**.
- Perform basic workflow actions; see Using Discovery and Identity Workflows, on page 1732.
- Learn more about the contents of the columns in the table; see Discovery Event Fields, on page 1740.

---

**Related Topics**

- Using Discovery and Identity Workflows, on page 1732

---

### Discovery Event Fields

Descriptions of the fields that can be viewed and searched in the discovery events table follow.
Time
The time that the system generated the event.

Event
The discovery event type or host input event type.

IP Address
The IP address associated with the host involved in the event.

User
The last user to log into the host involved in the event before the event was generated. If only non-authoritative users log in after an authoritative user, the authoritative user remains the current user for the host unless another authoritative user logs in.

MAC Address
The MAC address of the NIC used by the network traffic that triggered the discovery event. This MAC address can be either the actual MAC address of the host involved in the event, or the MAC address of a network device that the traffic passed through.

MAC Vendor
The MAC hardware vendor of the NIC used by the network traffic that triggered the discovery event. When searching this field, enter virtual_mac_vendor to match events that involve virtual hosts.

Port
The port used by the traffic that triggered the event, if applicable.

Description
The text description of the event.

Domain
The domain of the device that discovered the host. This field is only present if you have ever configured the Firepower Management Center for multiitenancy.

Device
The name of the managed device that generated the event. For new host and new server events based on NetFlow data, this is the managed device that processed the data.

Related Topics
Event Searches, on page 1553
Host Data

The system generates an event when it detects a host and collects information about it to build the host profile. You can use the Firepower Management Center web interface to view, search, and delete hosts.

While viewing hosts, you can create traffic profiles and compliance white lists based on selected hosts. You can also assign host attributes, including host criticality values (which designate business criticality) to groups of hosts. You can then use these criticality values, white lists, and traffic profiles within correlation rules and policies.

The system can add hosts to the network map from exported NetFlow records, but the available information for these hosts is limited; see Differences between NetFlow and Managed Device Data, on page 1204.

Related Topics

Differences between NetFlow and Managed Device Data, on page 1204

Viewing Host Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can use the Firepower Management Center to view a table of hosts that the system has detected. Then, you can manipulate the view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access hosts differs depending on the workflow you use. Both predefined workflows terminate in a host view, which contains a host profile for every host that meets your constraints. You can also create a custom workflow that displays only the information that matches your specific needs.

Procedure

Step 1  Access the host data:
- If you are using the predefined workflow, choose Analysis > Hosts > Hosts.
- If you are using a custom workflow that does not include the table view of hosts, click (switch workflow), then choose Hosts.

Step 2  You have the following options:
- Use a different workflow, including a custom workflow, by clicking (switch workflow).
- Perform basic workflow actions; see Using Discovery and Identity Workflows, on page 1732.
- Learn more about the contents of the columns in the table; see Host Data Fields, on page 1743.
- Right-click an item in the table to see options. (Not every column offers options.)
- Assign a host attribute to specific hosts; see Setting Host Attributes for Selected Hosts, on page 1749.
- Create traffic profiles for specific hosts, see Creating a Traffic Profile for Selected Hosts, on page 1746.
- Create a compliance white list based on specific hosts, see Creating a Compliance White List Based on Selected Hosts, on page 1747.
Host Data Fields

When the system discovers a host, it collects data about that host. That data can include the host’s IP addresses, the operating system it is running, and more. You can view some of that information in the table view of hosts. Descriptions of the fields that can be viewed and searched in the hosts table follow below.

Last Seen
The date and time any of the host’s IP addresses was last detected by the system. The Last Seen value is updated at least as often as the update interval you configured in the network discovery policy, as well as when the system generates a new host event for any of the host’s IP addresses.
For hosts with operating system data updated using the host input feature, the Last Seen value indicates the date and time when the data was originally added.

IP Address
The IP addresses associated with the host.

MAC Address
The host’s detected MAC address of the NIC.
The MAC Address field appears in the Table View of Hosts, which you can find in the Hosts workflow. You can also add the MAC Address field to:
• custom tables that include fields from the Hosts table
• drill-down pages in custom workflows based on the Hosts table

MAC Vendor
The host’s detected MAC hardware vendor of the NIC.
The MAC Vendor field appears in the Table View of Hosts, which you can find in the Hosts workflow. You can also add the MAC Vendor field to:
• custom tables that include fields from the Hosts table
• drill-down pages in custom workflows based on the Hosts table

When searching this field, enter `virtual_mac_vendor` to match events that involve virtual hosts.

Current User
The user identity (username) of the currently logged in user on the host.
Note that when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.

Host Criticality
The user-specified criticality value assigned to the host.
**NetBIOS Name**

The NetBIOS name of the host. Only hosts running the NetBIOS protocol will have a NetBIOS name.

**VLAN ID**

VLAN ID used by the host.

**Hops**

The number of network hops from the device that detected the host to the host.

**Host Type**

The type of host. Can be any of the following: host, mobile device, jailbroken mobile device, router, bridge, NAT device, and load balancer.

The methods the system uses to distinguish network devices include:

- the analysis of Cisco Discovery Protocol (CDP) messages, which can identify network devices and their type (Cisco devices only)
- the detection of the Spanning Tree Protocol (STP), which identifies a device as a switch or bridge
- the detection of multiple hosts using the same MAC address, which identifies the MAC address as belonging to a router
- the detection of TTL value changes from the client side, or TTL values that change more frequently than a typical boot time, which identify NAT devices and load balancers

If a device is not identified as a network device, it is categorized as a host.

When searching this field, enter `!host` to search for all network devices.

**Hardware**

The hardware platform for a mobile device.

**OS**

One of the following:

- The operating system (name, vendor, and version) either detected on the host or updated using Nmap or the host input feature
  - `unknown` if the operating system does not match any known fingerprint
  - `pending` if the system has not yet gathered enough information to identify the operating system

If the system detects multiple identities, it displays those identities in a comma-separated list.

This field appears when you invoke the hosts event view from the Custom Analysis widget on the dashboard. It is also a field option in custom tables based on the Hosts table.

When searching this field, enter `n/a` to include hosts where the operating system has not yet been identified.
**OS Conflict**

This field is search only.

**OS Vendor**

One of the following:
- The vendor of the operating system detected on the host or updated using Nmap or the host input feature
- unknown if the operating system does not match any known fingerprint
- pending if the system has not yet gathered enough information to identify the operating system

If the system detects multiple vendors, it displays those vendors in a comma-separated list.

When searching this field, enter n/a to include hosts where the operating system has not yet been identified.

**OS Name**

One of the following:
- The operating system detected on the host or updated using Nmap or the host input feature
- unknown if the operating system does not match any known fingerprint
- pending if the system has not yet gathered enough information to identify the operating system

If the system detects multiple names, it displays those names in a comma-separated list.

When searching this field, enter n/a to include hosts where the operating system has not yet been identified.

**OS Version**

One of the following:
- The version of the operating system detected on the host or updated using Nmap or the host input feature
- unknown if the operating system does not match any known fingerprint
- pending if the system has not yet gathered enough information to identify the operating system

If the system detects multiple versions, it displays those versions in a comma-separated list.

When searching this field, enter n/a to include hosts where the operating system has not yet been identified.

**Source Type**

The type of source used to establish the host’s operating system identity:
- User: user_name
- Application: app_name
- Scanner: scanner_type (Nmap or scanner added through network discovery configuration)
- Firepower for operating systems detected by the system

The system may reconcile data from multiple sources to determine the identity of an operating system.
Confidence

One of the following:

- the percentage of confidence that the system has in the identity of the operating system running on the host, for hosts detected by the system
- 100%, for operating systems identified by an active source, such as the host input feature or Nmap scanner
- unknown, for hosts for which the system cannot determine an operating system identity, and for hosts added to the network map based on NetFlow data

When searching this field, enter n/a to include hosts added to the network map based on NetFlow data.

Notes

The user-defined content of the Notes host attribute.

Domain

The domain associated with the host. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

Device

Either the managed device that detected the traffic or the device that processed NetFlow or host input data.

If this field is blank, either of the following conditions is true:

- The host was added to the network map by a device that is not explicitly monitoring the network where the host resides, as defined in the network discovery policy.
- The host was added using the host input feature and has not also been detected by the system.

Count

The number of events that match the information that appears in each row. This field appears only after you apply a constraint that creates two or more identical rows.

Related Topics

- Event Searches, on page 1553
- Operating System Identity Conflicts, on page 1706

Creating a Traffic Profile for Selected Hosts

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

A traffic profile is a profile of the traffic on your network, based on connection data collected over a timespan that you specify. After you create a traffic profile, you can detect abnormal network traffic by evaluating new traffic against your profile, which presumably represents normal network traffic.

You can use the Hosts page to create a traffic profile for a group of hosts that you specify. The traffic profile will be based on connections detected where one of the hosts you specify is the initiating host. Use the sort and search features to isolate the hosts for which you want to create a profile.
Creating a Compliance White List Based on Selected Hosts

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

Compliance white lists allow you to specify which operating systems, clients, and network, transport, or application protocols are allowed on your network.

You can use the Hosts page to create a compliance white list based on the host profiles of a group of hosts that you specify. Use the sort and search features to isolate the hosts that you want to use to create a white list.

**Procedure**

**Step 1** On a table view in the hosts workflow, check the check boxes next to the hosts for which you want to create a white list.

**Step 2** At the bottom of the page, click Create White List.

**Step 3** Modify and save the white list according to your specific needs.

Related Topics

Introduction to Compliance White Lists, on page 1345

Host Attribute Data

The Firepower System collects information about the hosts it detects and uses that information to build host profiles. However, there may be additional information about the hosts on your network that you want to provide to your analysts. You can add notes to a host profile, set the business criticality of a host, or provide any other information that you choose. Each piece of information is called a host attribute.

You can use host attributes in host profile qualifications, which constrain the data you collect while building a traffic profile, and also can limit the conditions under which you want to trigger a correlation rule. You can also set attribute values in response to a correlation rule.

**Related Topics**

Viewing Host Attributes, on page 1748

Configuring Set Attribute Remediations, on page 1418
You can use the Firepower Management Center to view a table of hosts detected by the system, along with their host attributes. Then, you can manipulate the view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access host attributes differs depending on the workflow you use. You can use the predefined workflow, which includes a table view of host attributes that lists all detected hosts and their attributes, and terminates in a host view page, which contains a host profile for every host that meets your constraints.

You can also create a custom workflow that displays only the information that matches your specific needs.

**Procedure**

**Step 1** Access the host attributes data:
- If you are using the predefined workflow, choose **Analysis > Hosts > Host Attributes**.
- If you are using a custom workflow that does not include the table view of host attributes, click **(switch workflow)**, then choose **Attributes**.

**Step 2** You have the following options:
- Use a different workflow, including a custom workflow, by clicking **(switch workflow)**.
- Perform basic workflow actions; see Using Discovery and Identity Workflows, on page 1732.
- Learn more about the contents of the columns in the table; see Host Attribute Data Fields, on page 1748.
- Assign a host attribute to specific hosts; see Setting Host Attributes for Selected Hosts, on page 1749.

**Host Attribute Data Fields**

Note that the host attributes table does not display hosts identified only by MAC addresses.

Descriptions of the fields that can be viewed and searched in the host attributes table follow.

**IP Address**

The IP addresses associated with a host.

**Current User**

The user identity (username) of the currently logged in user on the host.

Note that when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the
current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.

**Host Criticality**

The user-assigned importance of a host to your enterprise. You can use the host criticality in correlation rules and policies to tailor policy violations and their responses to the importance of a host involved in an event. You can assign a host criticality of low, medium, high, or none.

**Notes**

Information about the host that you want other analysts to view.

**Any user-defined host attribute, including those for compliance white lists**

The value of the user-defined host attribute. The host attributes table contains a field for each user-defined host attribute.

**Domain**

The domain associated with the host. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

**Count**

The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.

**Related Topics**

- Event Searches, on page 1553

---

**Setting Host Attributes for Selected Hosts**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can configure predefined and user-defined host attributes from a host workflow.

**Procedure**

**Step 1**

In a host workflow, check the check boxes next to the hosts to which you want to add a host attribute.

**Tip**

Use the sort and search features to isolate the hosts to which you want to assign particular attributes.

**Step 2**

At the bottom of the page, click **Set Attributes**.

**Step 3**

Optionally, set the host criticality for the hosts you selected. You can choose **None, Low, Medium, or High**.

**Step 4**

Optionally, add notes to the host profiles of the hosts you selected in the text box.

**Step 5**

Optionally, set any user-defined host attributes you have configured.
Step 6

Click Save.

---

### Indications of Compromise Data

The Firepower System correlates various types of data (intrusion events, Security Intelligence, connection events, and file or malware events) to determine whether a host on your monitored network is likely to be compromised by malicious means. Certain combinations and frequencies of event data trigger indications of compromise (IOC) tags on affected hosts. The IP addresses of these hosts appear in event views with a red compromised host icon (/png).

If a file containing malware is seen again within 300 seconds of being tagged as an IOC, another IOC is not generated. If the same file is seen more than 300 seconds later, a new IOC will be generated.

To configure the system to tag events as indications of compromise, see Enabling Indications of Compromise Rules, on page 1316.

**Related Topics**

- Enabling Indications of Compromise Rules, on page 1316

---

### View and Work with Indications of Compromise Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can use the Firepower Management Center to view tables showing Indications of Compromise (IOC). Manipulate the event view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see depends on the workflow you use. The predefined IOC workflows terminate in a profile view, which contains a host profile for every host that meets your constraints. You can also create a custom workflow that displays only the information that matches your specific needs.

**Before you begin**

- For your system to detect and tag indications of compromise (IOC), you must activate the IOC feature in the network discovery policy and enable at least one IOC rule. See Enabling Indications of Compromise Rules, on page 1316.

**Procedure**

**Step 1**

Determine which location in the web interface presents information that meets your needs.

You can use the following locations to view or work with Indication of Compromise data:

- Event Viewer (various tabs under the Analysis menu) — Connection, Security Intelligence, intrusion, malware, and IOC discovery event views indicate whether an event triggered an IOC. Note that malware
events generated by AMP for Endpoints that trigger IOC rules have the event type AMP IOC and appear with an event subtype that specifies the compromise.

• Dashboard — In the dashboard, the Threats tab of the Summary Dashboard displays, by default, IOC tags by host and new IOC rules triggered over time. The Custom Analysis widget offers presets based on IOC data.

• Context Explorer — The Indications of Compromise section of the Context Explorer displays graphs of hosts by IOC category and IOC categories by host.

• Network Map page — The Indications of Compromise tab under Analysis > Hosts > Network Map groups potentially compromised hosts on your network by type of compromise and IP address.

• Network File Trajectory details page — The details pages for files listed under Analysis > Files > Network File Trajectory let you track indications of compromise on your network.

• Indications of Compromise page — The Indications of Compromise page under the Analysis > Hosts menu lists monitored hosts, grouped by IOC tag. Use the workflows on this page to drill down into your data.

• Host Profile page — The host profile for a potentially compromised host displays all IOC tags associated with that host, and lets you resolve IOC tags and configure IOC rule states.

Step 2 If you are using the predefined workflow, choose Analysis > Hosts > Indications of Compromise.

If you are using a custom workflow that does not include the Host IOC table view, click (switch workflow), then choose Indications of Compromise.

Step 3 You have the following options:

• Use a different workflow, including a custom workflow, by clicking (switch workflow).
• Perform basic workflow actions; see Using Discovery and Identity Workflows, on page 1732.
• Learn more about the contents of the columns in the table; see Indications of Compromise Data Fields, on page 1751.

• View the host profile for a compromised host by clicking the compromised host icon ( ) in the IP Address column.
• Mark IOC events resolved so they no longer appear in the list. To do so, check the check boxes next to the IOC events you want to modify, then click Mark Resolved.
• View details of events that triggered the IOC by clicking the view icon ( ) in the First Seen or Last Seen columns.
• See more options: Right-click a value in the table.

Indications of Compromise Data Fields

The following are the fields in IOC (indication of compromise) tables. Not every IOC-related table includes all fields.

IP Address

The IP address associated with the host that triggered the IOC.
Category
Brief description of the type of compromise indicated, such as Malware Executed or Impact 1 Attack.

Event Type
Identifier associated with a specific IOC, referring to the event that triggered it.

Description
Description of the impact on the potentially compromised host, such as This host may be under remote control or Malware has been executed on this host.

First Seen/Last Seen
The first/most recent date and time that events triggering the IOC occurred.

Domain
The domain of the host that triggered the IOC. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

Related Topics
Event Searches, on page 1553

Editing Indication of Compromise Rule States for a Single Host

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst except Read Only</td>
</tr>
</tbody>
</table>

When enabled in a network discovery policy, indication of compromise rules apply to all hosts in the monitored network. You can disable a rule for an individual host to avoid unhelpful IOC tags (for example, you may not want to see IOC tags for a DNS server.) If a rule is disabled in the applicable network discovery policy, it cannot be enabled for a specific host.

Procedure

Step 1 Navigate to the Indications of Compromise section of a host profile.
Step 2 Click Edit Rule States.
Step 3 In the Enabled column for a rule, click the slider to enable or disable it.
Step 4 Click Save.
Viewing Source Events for Indication of Compromise Tags

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can use the Indications of Compromise section of the host profile to navigate quickly to the events that triggered the IOC tags. Analyzing these events can give you the information you need to determine what, and whether, action is required to address threats of compromise.

Clicking the view icon ( ) next to the timestamp of an IOC tag navigates to the table view of events for the relevant event type, constrained to show only the event that triggered the IOC tag.

Procedure

**Step 1**
In a host profile, navigate to the Indications of Compromise section.

**Step 2**
Click the view icon ( ) in the First Seen or Last Seen column for the IOC tag you want to investigate.

Resolving Indication of Compromise Tags

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

After you have analyzed and addressed the threats indicated by an indication of compromise (IOC) tag, or if you determine that an IOC tag represents a false positive, you can mark an event resolved. Marking an event resolved removes it from the host profile; when all active IOC tags on a profile are resolved, the compromised host icon ( ) no longer appears. You can still view the IOC-triggering events for the resolved IOC.

If the events that triggered the IOC tag recur, the tag is set again unless you have disabled the IOC rule for the host.

Procedure

**Step 1**
In a host profile, navigate to the Indications of Compromise section.

**Step 2**
You have two choices:

- To mark an individual IOC tag resolved, click the delete icon ( ) to the right of the tag you want to resolve.
- To mark all IOC tags on the profile resolved, click Mark All Resolved.
Server Data

The Firepower System collects information about all servers running on hosts on monitored network segments. This information includes:

- the name of the server
- the application and network protocols used by the server
- the vendor and version of the server
- the IP address associated with the host running a server
- the port on which the server communicates

When the system detects a server, it generates a discovery event unless the associated host has already reached its maximum number of servers. You can use the Firepower Management Center web interface to view, search, and delete server events.

You can also base correlation rules on server events. For example, you could trigger a correlation rule when the system detects a chat server, such as ircd, running on one of your hosts.

The system can add hosts to the network map from exported NetFlow records, but the available information for these hosts is limited; see Differences between NetFlow and Managed Device Data, on page 1204.

Related Topics

- Host Limits and Discovery Event Logging, on page 1261
- Differences between NetFlow and Managed Device Data, on page 1204

Viewing Server Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can use the Firepower Management Center to view a table of detected servers. Then, you can manipulate the event view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access servers differs depending on the workflow you use. All the predefined workflows terminate in a host view, which contains a host profile for every host that meets your constraints. You can also create a custom workflow that displays only the information that matches your specific needs.

Procedure

**Step 1**

Access the server data:

- If you are using the predefined workflow, choose Analysis > Hosts > Servers.
- If you are using a custom workflow that does not include the table view of servers, click (switch workflow), then choose Servers.

**Step 2**

You have the following options:
• Use a different workflow, including a custom workflow, by clicking (switch workflow).
• Perform basic workflow actions; see Using Discovery and Identity Workflows, on page 1732.
• Learn more about the contents of the columns in the table; see Server Data Fields, on page 1755.
• Edit server identities by checking the check boxes next to the events for servers you want to edit, then clicking Set Server Identity.
• Right-click an item in the table to see options. (Not every column offers options.)

Related Topics
  Editing Server Identities, on page 1711

Server Data Fields

Descriptions of the fields that can be viewed and searched in the servers table follow below.

Last Used
The date and time the server was last used on the network or the date and time that the server was originally updated using the host input feature. The Last Used value is updated at least as often as the update interval you configured in the network discovery policy, as well as when the system detects a server information update.

IP Address
The IP address associated with the host running the server.

Port
The port where the server is running.

Protocol
The network or transport protocol used by the server.

Application Protocol
One of the following:
  • the name of the application protocol for the server
  • pending if the system cannot positively or negatively identify the server for one of several reasons
  • unknown if the system cannot identify the server based on known server fingerprints or if the server was added through host input and did not include the application protocol

Category, Tags, Risk, or Business Relevance for Application Protocols
The categories, tags, risk level, and business relevance assigned to the application protocol. These filters can be used to focus on a specific set of data.

Vendor
One of the following:
• the server vendor as identified by the system, Nmap or another active source, or that you specified using the host input feature

• blank, if the system cannot identify its vendor based on known server fingerprints, or if the server was added to the network map using NetFlow data

Version

One of the following:

• the server version as identified by the system, Nmap or another active source, or that you specified using the host input feature

• blank, if the system cannot identify its version based on known server fingerprints, or if the server was added to the network map using NetFlow data

Web Application

The web application based on the payload content detected by the system in the HTTP traffic. Note that if the system detects an application protocol of HTTP but cannot detect a specific web application, the system supplies a generic web browsing designation.

Category, Tags, Risk, or Business Relevance for Web Applications

The categories, tags, risk level, and business relevance assigned to the web application. These filters can be used to focus on a specific set of data.

Hits

The number of times the server was accessed. For servers added using the host input feature, this value is always 0.

Source Type

One of the following values:

• User: user_name

• Application: app_name

• Scanner: scanner_type (Nmap or scanner added through network discovery configuration)

• Firepower, Firepower Port Match, or Firepower Pattern Match for servers detected by the Firepower System

• NetFlow for servers added using NetFlow data

Domain

The domain of the host running the server. This field is only present if you have ever configured the Firepower Management Center for multitenancy.
Device
Either the managed device that detected the traffic or the device that processed NetFlow or host input data.

Current User
The user identity (username) of the currently logged in user on the host.

When a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.

Count
The number of events that match the information that appears in each row. This field appears only after you apply a constraint that creates two or more identical rows.

Related Topics
- Event Searches, on page 1553
- Network Discovery Data Storage Settings, on page 1318

Application and Application Details Data
When a monitored host connects to another host, the system can, in many cases, determine what application was used. The Firepower System detects the use of many email, instant messaging, peer-to-peer, web applications, as well as other types of applications.

For each detected application, the system logs the IP address that used the application, the product, the version, and the number of times its use was detected. You can use the web interface to view, search, and delete application events. You can also update application data on a host or hosts using the host input feature.

If you know which applications are running on which hosts, you can use that knowledge to create host profile qualifications, which constrain the data you collect while building a traffic profile, and also can limit the conditions under which you want to trigger a correlation rule. You can also base correlation rules on the detection of application. For example, if you want your employees to use a specific mail client, you could trigger a correlation rule when the system detects a different mail client running on one of your hosts.

You can obtain the latest information about Firepower’s application detectors by carefully reading both the release notes for each Firepower System update and advisories for each VDB update.

To collect and store application data for analysis, make sure that you enable application detection in your network discovery policy.

Viewing Application Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security</td>
</tr>
</tbody>
</table>

You can use the Firepower Management Center to view a table of detected applications. Then, you can manipulate the event view depending on the information you are looking for.
In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access applications differs depending on the workflow you use. You can also create a custom workflow that displays only the information that matches your specific needs.

**Procedure**

**Step 1**
Access the application data:

- If you are using the predefined workflow, choose **Analysis > Hosts > Application Details**.
- If you are using a custom workflow that does not include the table view of application details, click (switch workflow), then choose **Clients**.

**Step 2**
You have the following options:

- Use a different workflow, including a custom workflow, by clicking (switch workflow).
- Perform basic workflow actions; see Using Discovery and Identity Workflows, on page 1732.
- Learn more about the contents of the columns in the table; see Application Data Fields, on page 1758.
- Open the Application Detail View for a specific application by clicking the application detail view icon (□) next to a client, application protocol, or web application.

**Application Data Fields**

When the system detects traffic for a known client, application protocol, or web application, it logs information about the application and the host running it.

Descriptions of the fields that can be viewed and searched in the applications table follow.

**Application**
The name of the detected application.

**IP Address**
The IP address associated with the host using the application.

**Type**
The type of application:

**Application Protocols**
Represents communications between hosts.

**Client Applications**
Represents software running on a host.

**Web Applications**
Represents the content or requested URL for HTTP traffic.
Category
A general classification for the application that describes its most essential function. Each application belongs to at least one category.

Tag
Additional information about the application. Applications can have any number of tags, including none.

Risk
How likely the application is to be used for purposes that might be against your organization’s security policy. An application’s risk can range from Very Low to Very High.

Of Application Protocol Risk, Client Risk, and Web Application Risk, the highest of the three detected, when available, in the traffic that triggered the intrusion event.

Business Relevance
The likelihood that the application is used within the context of your organization’s business operations, as opposed to recreationally. An application’s business relevance can range from Very Low to Very High.

Of Application Protocol Business Relevance, Client Business Relevance, and Web Application Business Relevance, the lowest of the three detected, when available, in the traffic that triggered the intrusion event.

Current User
The user identity (username) of the currently logged in user on the host.

Note that when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.

Domain
The domain of the host using the application. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

Count
The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.

Related Topics
Event Searches, on page 1553

Viewing Application Detail Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>
You can use the Firepower Management Center to view a table of detected application details. Then, you can manipulate the event view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access application details differs depending on the workflow you use. There are two predefined workflows. You can also create a custom workflow that displays only the information that matches your specific needs.

**Procedure**

---

**Step 1** Access the application details data:

- If you are using the predefined workflow, choose **Analysis > Hosts > Application Details**.
- If you are using a custom workflow that does not include the table view of application details, click **(switch workflow)**, then select **Clients**.

**Step 2** You have the following options:

- Use a different workflow, including a custom workflow, by clicking **(switch workflow)**.
- Perform basic workflow actions; see Using Discovery and Identity Workflows, on page 1732.
- Learn more about the contents of the columns in the table; see Application Detail Data Fields, on page 1760.
- Open the Application Detail View for a specific application by clicking the application detail view icon (□) next to a client.

---

**Application Detail Data Fields**

When the system detects traffic for a known client, application protocol, or web application, it logs information about the application and the host running it.

Descriptions of the fields that can be viewed and searched in the application details table follow.

**Last Used**

The time that the application was last used or the time that the application data was updated using the host input feature. The Last Used value is updated at least as often as the update interval you configured in the network discovery policy, as well as when the system detects an application information update.

**IP Address**

The IP address associated with the host using the application.

**Client**

The name of the application. Note that if the system detected an application protocol but could not detect a specific client, **client** is appended to the application protocol name to provide a generic name.
Version
The version of the application.

Category, Tags, Risk, or Business Relevance for Clients, Application Protocols, and Web Applications
The categories, tags, risk level, and business relevance assigned to the application. These filters can be used to focus on a specific set of data.

Application Protocol
The application protocol used by the application. Note that if the system detected an application protocol but could not detect a specific client, client is appended to the application protocol name to provide a generic name.

Web Application
The web application based on the payload content or URL detected by the system in the HTTP traffic. Note that if the system detects an application protocol of HTTP but cannot detect a specific web application, the system supplies a generic web browsing designation here.

Hits
The number of times the system detected the application in use. For applications added using the host input feature, this value is always 0.

Domain
The domain of the host using the application. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

Device
The device that generated the discovery event containing the application detail.

Current User
The user identity (username) of the currently logged in user on the host.
Note that when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.

Count
The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.

Related Topics
Event Searches, on page 1553
Network Discovery Data Storage Settings, on page 1318
Vulnerability Data

The Firepower System includes its own vulnerability tracking database which is used, in conjunction with
the system’s fingerprinting capability, to identify the vulnerabilities associated with the hosts on your network.
The operating systems, servers, and clients running on your hosts have different sets of associated vulnerabilities.

You can use the Firepower Management Center to:

• Track and review the vulnerabilities for each host.

• Deactivate vulnerabilities for a host after you patch the host or otherwise judge it immune to a vulnerability.

Vulnerabilities for vendorless and versionless servers are not mapped unless the applications protocols used
by the servers are mapped in the Firepower Management Center configuration. Vulnerabilities for vendorless
and versionless clients cannot be mapped.

Related Topics

Mapping Vulnerabilities for Servers, on page 484

Vulnerability Data Fields

The vulnerability data fields described below can be viewed in the table view of vulnerabilities and in the
vulnerability details display as follows:

Table 279: Vulnerability Data Fields by Display Location

<table>
<thead>
<tr>
<th>Field</th>
<th>Table View</th>
<th>Details Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Information</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Available Exploits</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Bugtraq ID</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>CVE ID</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Count</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Date Published</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Description</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Fixes</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Impact Qualification</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Remote</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Snort ID</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Solution</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>SVID</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Technical Description</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
### Field | Table View | Details Display
---|---|---
Title | yes | yes
Vulnerability Impact | yes | yes

**Additional Information**
Click the arrow to view additional information (if available) about the vulnerability, such as known exploits and their availability, exploit scenarios, and mitigation strategies.

**Available Exploits**
Indicates whether there are known exploits for the vulnerability (TRUE/FALSE).

**Bugtraq ID**

**Count**
The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.

**CVE ID**
The identification number associated with the vulnerability in MITRE’s Common Vulnerabilities and Exposures (CVE) database ([https://cve.mitre.org/](https://cve.mitre.org/)).

**Date Published**
The date the vulnerability was published.

**Description**
A brief description of the vulnerability.

**Fixes**
Provides links to downloadable patches for the selected vulnerability.

---

**Tip**
If direct links to fix or patch downloads appear, right-click the link and save it to your local computer.

**Impact Qualification**
Use the drop-down list to enable or disable a vulnerability. The Firepower Management Center ignores disabled vulnerabilities in its impact correlations.

The setting you specify here determines how the vulnerability is treated on a system-wide basis and is not limited to the host profile where you select the value.
Remote
Indicates whether the vulnerability is remotely exploitable (TRUE/FALSE).

Snort ID
The identification number associated with the vulnerability in the Snort ID (SID) database. That is, if an intrusion rule can detect network traffic that exploits a particular vulnerability, that vulnerability is associated with the intrusion rule’s SID.

Note that a vulnerability can be associated with more than one SID (or no SIDs at all). If a vulnerability is associated with more than one SID, the vulnerabilities table includes a row for each SID.

Solution
Information about repairing the vulnerability.

SVID
The Cisco vulnerability identification number that the system uses to track vulnerabilities.

Click the view icon (кро) to access the vulnerability details for the SVID.

Technical Description
A detailed technical description of the vulnerability.

Title
The title of the vulnerability.

Vulnerability Impact
Displays the severity assigned to the vulnerability in the Bugtraq database on a scale of 0 to 10, with 10 being the most severe. The vulnerability impact is determined by the writer of the Bugtraq entry based on his or her best judgment and guided by SANS Critical Vulnerability Analysis (CVA) criteria.

Related Topics
Event Searches, on page 1553

Vulnerability Deactivation
Deactivating a vulnerability prevents the system from using that vulnerability to evaluate intrusion impact correlations. You can deactivate a vulnerability after you patch the hosts on your network or otherwise judge them immune. Note that if the system discovers a new host that is affected by that vulnerability, the vulnerability is considered valid (and is not automatically deactivated) for that host.

Deactivating a vulnerability within a vulnerabilities workflow that is not constrained by IP addresses deactivates the vulnerability for all detected hosts on your network. You can deactivate vulnerabilities within the vulnerabilities workflow only on:

- the second page of the default vulnerabilities workflow, Vulnerabilities on the Network, which shows only the vulnerabilities that apply to the hosts on your network
- a page in a vulnerabilities workflow, custom or predefined, that you constrained based on IP address using a search.
You can deactivate a vulnerability for a single host using the network map, using the host’s host profile, or by constraining the vulnerabilities workflow based on the IP addresses of the host or hosts for which you want to deactivate vulnerabilities. For hosts with multiple associated IP addresses, this function applies only to the single, selected IP address of that host.

In a multidomain deployment, deactivating a vulnerability in an ancestor domain deactivates it in all descendant domains. Leaf domains can activate or deactivate a vulnerability for their devices if the vulnerability is activated in the ancestor domain.

Related Topics
Deactivating Vulnerabilities for Individual Hosts, on page 1723
Deactivating Individual Vulnerabilities, on page 1724
Deactivating Multiple Vulnerabilities, on page 1766

Viewing Vulnerability Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can use the Firepower Management Center to view a table of vulnerabilities. Then, you can manipulate the event view depending on the information you are looking for.

The page you see when you access vulnerabilities differs depending on the workflow you use. You can use the predefined workflow, which includes a table view of vulnerabilities. The table view contains a row for each vulnerability in the database, regardless of whether any of your detected hosts exhibit the vulnerabilities. The second page of the predefined workflow contains a row for each vulnerability (that you have not deactivated) that applies to detected hosts on your network. The predefined workflow terminates in a vulnerability detail view, which contains a detailed description for every vulnerability that meets your constraints.

Tip
If you want to see the vulnerabilities that apply to a single host or set of hosts, perform a search for vulnerabilities, specifying an IP address or range of IP addresses for the hosts.

You can also create a custom workflow that displays only the information that matches your specific needs. The table of vulnerabilities is not restricted by domain in a multidomain deployment.

Procedure

Step 1 Access the table of vulnerabilities:
  • If you are using the predefined vulnerabilities workflow, choose Analysis > Vulnerabilities > Vulnerabilities.
  • If you are using a custom workflow that does not include the table view of vulnerabilities, click (switch workflow), then choose Vulnerabilities.

Step 2 You have the following options:
  • Perform basic workflow actions; see Using Discovery and Identity Workflows, on page 1732.
• Deactivate vulnerabilities so they are no longer used for intrusion impact correlation for currently vulnerable hosts; see Deactivating Multiple Vulnerabilities, on page 1766.

• View the details for a vulnerability by clicking the view icon ( ) in the SVID column. Alternatively, constrain on the vulnerability ID and drill down to the vulnerability details page.

• View the full text of a vulnerability title by right-clicking the title and choosing Show Full Text.

### Viewing Vulnerability Details

#### Procedure

You can view vulnerability details in any of the following ways:

- Choose Analysis > Vulnerabilities > Vulnerabilities, and click the view icon ( ) next to the SVID.
- Choose Analysis > Vulnerabilities > Third-Party Vulnerabilities and click the view icon ( ) next to the SVID.
- Choose Analysis > Hosts > Network Map, and click the Vulnerabilities tab.
- View the profile of a host affected by the vulnerability, and expand the Vulnerabilities section of the profile.

### Deactivating Multiple Vulnerabilities

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

Deactivating a vulnerability within a vulnerabilities workflow that is not constrained by IP addresses deactivates the vulnerability for all detected hosts on your network.

In a multidomain deployment, deactivating a vulnerability in an ancestor domain deactivates it in all descendant domains. Leaf domains can activate or deactivate a vulnerability for their devices so long as the vulnerability is activated in the ancestor domain.

#### Procedure

Step 1  Access the table of vulnerabilities:

- If you are using the predefined vulnerabilities workflow, choose Analysis > Vulnerabilities > Vulnerabilities.
- If you are using a custom workflow that does not include the table view of vulnerabilities, click (switch workflow), then choose Vulnerabilities.

Step 2  Click Vulnerabilities on the Network.

Step 3  Check the check boxes next to vulnerabilities you want to deactivate.
Step 4  Click **Review** at the bottom of the page.

---

**Related Topics**
- [Deactivating Vulnerabilities for Individual Hosts](#), on page 1723
- [Deactivating Individual Vulnerabilities](#), on page 1724

---

**Third-Party Vulnerability Data**

The Firepower System includes its own vulnerability tracking database which is used, in conjunction with the system's fingerprinting capability, to identify the vulnerabilities associated with the hosts on your network. You can augment the system's vulnerability data with imported network map data from third-party applications. To do so, your organization must be able to write scripts or create command line import files to import the data. For more information, see the *Firepower System Host Input API Guide*.

To include imported data in impact correlations, you must map third-party vulnerability information to the operating system and application definitions in the database. You cannot map third-party vulnerability information to client definitions.

**Viewing Third-Party Vulnerability Data**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

After you use the host input feature to import third-party vulnerability data, you can use the Firepower Management Center to view a table of third-party vulnerabilities. Then, you can manipulate the event view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access third-party vulnerabilities differs depending on the workflow you use. There are two predefined workflows. You can also create a custom workflow that displays only the information that matches your specific needs.

**Procedure**

---

**Step 1**

Access the third-party vulnerabilities data:

- If you are using the predefined workflow, choose **Analysis > Vulnerabilities > Third-Party Vulnerabilities**.
- If you are using a custom workflow that does not include the table view of third-party vulnerabilities, click **(switch workflow)**, then choose **Vulnerabilities by Source** or **Vulnerabilities by IP Address**.

**Step 2**

You have the following options:

- Use a different workflow, including a custom workflow, by clicking **(switch workflow)**.
- Perform basic workflow actions; see [Using Discovery and Identity Workflows](#), on page 1732.
- Learn more about the contents of the columns in the table; see [Third-Party Vulnerability Data Fields](#), on page 1768.
- View the vulnerability details for a third-party vulnerability by clicking the view icon ( Scouts ) in the SVID column. Alternatively, constrain on the vulnerability ID and drill down to the vulnerability details page.

### Third-Party Vulnerability Data Fields

Descriptions of the fields that can be viewed and searched in the third-party vulnerabilities table follow.

**Vulnerability Source**

The source of the third-party vulnerabilities, for example, QualysGuard or NeXpose.

**Vulnerability ID**

The ID number associated with the vulnerability for its source.

**IP Address**

The IP address associated with the host affected by the vulnerability.

**Port**

A port number, if the vulnerability is associated with a server running on a specific port.

**Bugtraq ID**


**CVE ID**

The identification number associated with the vulnerability in MITRE’s Common Vulnerabilities and Exposures (CVE) database ([https://cve.mitre.org/](https://cve.mitre.org/)).

**SVID**

The legacy vulnerability identification number that the system uses to track vulnerabilities

Click the view icon ( Scouts ) to access the vulnerability details for the SVID.

**Snort ID**

The identification number associated with the vulnerability in the Snort ID (SID) database. That is, if an intrusion rule can detect network traffic that exploits a particular vulnerability, that vulnerability is associated with the intrusion rule’s SID.

Note that a vulnerability can be associated with more than one SID (or no SIDs at all). If a vulnerability is associated with more than one SID, the vulnerabilities table includes a row for each SID.

**Title**

The title of the vulnerability.
Description
A brief description of the vulnerability.

Domain
The domain of the host with the vulnerability. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

Count
The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.

Related Topics
Event Searches, on page 1553

Users and User Activity Data
User and user activity data are displayed in individual user-related workflows:

• Users — this workflow displays all users seen on your network. A single user occupies a single row in this table. For more information, see User Data, on page 1772.

• User Activity — this workflow displays all user activity seen on your network. A single user with more than one instance of user activity would occupy several rows in this table. For more information, see User Activity Data, on page 1774.

For more information about the identity sources that populate these workflows, see About User Identity Sources, on page 1277.

User-Related Fields
User-related data is displayed in the users and user activity tables.

Table 280: Users and User Activity Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Users Table</th>
<th>User Activity Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication Type</td>
<td>The type of authentication: No Authentication, Passive Authentication, Active Authentication, Guest Authentication, or Failed Authentication.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Count</td>
<td>Note: The <strong>Count</strong> field appears only after you apply a constraint that creates two or more identical rows. The number of users or events that match the information that appears in a particular row.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Users Table</td>
<td>User Activity Table</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
<td>---------------------</td>
</tr>
<tr>
<td><strong>Current IP</strong></td>
<td>The IP address associated with the host that the user is logged into. This field is blank if another authoritative user logs into the host with the same IP address after the user’s login, unless the user is an authoritative user and the new user is a non-authoritative user. (The system associates the IP address with the last authoritative user that logged in with the host.)</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
| **Department**| The user’s department, as obtained by a realm. If there is no department explicitly associated with the user on your servers, the department is listed as whatever default group the server assigns. For example, on Active Directory, this is Users (ad). This field is blank if:  
  • You have not configured a realm.  
  • The Firepower Management Center cannot correlate the user in the FMC database with an LDAP record (for example, for users added to the database via an AIM, Oracle, or SIP login). | Yes         | No                  |
| **Description** | More information, if available, about the user or user activity.           | No          | Yes                 |
| **Device**    | For user activity detected by traffic-based detection, the name of the device that detected the user. For other types of user activity, the managing Firepower Management Center. | No          | Yes                 |
| **Domain**    | In the Users table, the domain associated with the user's realm.  
  In the User Activity table, the domain where the user activity was detected.  
  This field is only present if you have ever configured the Firepower Management Center for multitenancy. | Yes         | Yes                 |
| **E-Mail**    | The user’s email address. This field is blank if:  
  • The user was added to the database via an AIM login.  
  • The user was added to the database via an LDAP login and there is no email address associated with the user on your LDAP servers. | Yes         | No                  |
| **Event**     | The user activity event type.                                              | No          | Yes                 |
| **First Name**| The user’s first name, as obtained by a realm. This field is blank if:  
  • You have not configured a realm.  
  • The Firepower Management Center cannot correlate the user in the FMC database with an LDAP record (for example, for users added to the database via an AIM, Oracle, or SIP login).  
  • There is no first name associated with the user on your servers. | Yes         | No                  |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Users Table</th>
<th>User Activity Table</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IP Address</strong></td>
<td>For User Login activity, the IP address involved in the login, which can be an IP address of the user’s host (for LDAP, POP3, IMAP, FTP, HTTP, MDNS, and AIM logins), the server (for SMTP and Oracle logins), or the session originator (for SIP logins). Note that an associated IP address does not mean the user is the current user for that IP address; when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. For other types of user activity, this field is blank.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>LastName</strong></td>
<td>The user’s last name, as obtained by a realm. This field is blank if:</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>• You have not configured a realm.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The Firepower Management Center cannot correlate the user in the FMC database with an LDAP record (for example, for users added to the database via an AIM, Oracle, or SIP login).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• There is no last name associated with the user on your servers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Phone</strong></td>
<td>The user’s telephone number, as obtained by a realm. This field is blank if:</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>• You have not configured a realm.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The Firepower Management Center cannot correlate the user in the FMC database with an LDAP record (for example, for users added to the database via an AIM, Oracle, or SIP login).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• There is no telephone number associated with the user on your servers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Realm</strong></td>
<td>The identity realm associated with the user.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>The time that the system detected the user activity.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>The protocol used to detect the user. One of the following: ldap, pop3, imap, oracle, sip, http, ftp, mdns, and aim. Users are not added to the database based on SMTP logins, so smtp does not appear in this field.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### User Data

When an identity source reports a user login for a user who is not already in the database, the user is added to the database, unless you have specifically restricted that login type.

The system updates the users database when one of the following occurs:

- A user on the Firepower Management Center manually deletes a non-authoritative user from the Users table.
- An identity source reports a logoff by that user.
- A realm ends the user session as specified by the realm's `User Session Timeout: Authenticated Users`, `User Session Timeout: Failed Authentication Users`, or `User Session Timeout: Guest Users` setting.

**Note**

If you have ISE configured, you may see host data in the users table. Because host detection by ISE is not fully supported, you cannot perform user control using ISE-reported host data.

The type of user login that the system detected determines what information is stored about the new user.

<table>
<thead>
<tr>
<th>Identity Source</th>
<th>Login Type</th>
<th>User Data Stored</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISE</td>
<td>Active Directory</td>
<td>• username</td>
</tr>
<tr>
<td></td>
<td>LDAP</td>
<td>• current IP address</td>
</tr>
<tr>
<td></td>
<td>RADIUS</td>
<td>• Security Group Tag (SGT)</td>
</tr>
<tr>
<td></td>
<td>RSA</td>
<td>• endpoint profile/device type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• endpoint location/location IP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• type (LDAP)</td>
</tr>
<tr>
<td><strong>Identity Source</strong></td>
<td><strong>Login Type</strong></td>
<td><strong>User Data Stored</strong></td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>User Agent</td>
<td>Active Directory</td>
<td>• username</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• current IP address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• type (LDAP)</td>
</tr>
<tr>
<td>captive portal</td>
<td>Active Directory</td>
<td>• username</td>
</tr>
<tr>
<td></td>
<td>LDAP</td>
<td>• current IP address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• type (LDAP)</td>
</tr>
<tr>
<td>traffic-based detection</td>
<td>LDAP</td>
<td>• username</td>
</tr>
<tr>
<td></td>
<td>AIM</td>
<td>• current IP address</td>
</tr>
<tr>
<td></td>
<td>Oracle</td>
<td>• type (AD)</td>
</tr>
<tr>
<td></td>
<td>SIP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HTTP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FTP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MDNS</td>
<td></td>
</tr>
<tr>
<td>POP3</td>
<td></td>
<td>• username</td>
</tr>
<tr>
<td>IMAP</td>
<td></td>
<td>• current IP address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• email address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• type (pop3 or imap)</td>
</tr>
</tbody>
</table>

If you configure a realm to automatically download users, the Firepower Management Center queries the servers based on the interval you specified. It may take five to ten minutes for the Firepower Management Center database to update with user metadata after the system detects a new user login. The Firepower Management Center obtains the following information and metadata about each user:

- username
- first and last names
- email address
- department
- telephone number
- current IP address
- Security Group Tag (SGT), if available
- endpoint profile, if available
- endpoint location, if available
The number of users the Firepower Management Center can store in its database depends on your Firepower Management Center model. When a non-authoritative user login to a host is detected, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user login is detected for that host, only another authoritative user login changes the current user.

Note that traffic-based detection of AIM, Oracle, and SIP logins create duplicate user records because they are not associated with any of the user metadata that the system obtains from LDAP servers. To prevent overuse of user count because of duplicate user records from these protocols, configure traffic-based detection to ignore those protocols.

You can search, view, and delete users from the database; you can also purge all users from the database.

For information about general user-related event troubleshooting, see Troubleshoot Realms and User Downloads, on page 1327.

### Viewing User Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

You can view a table of users, and then manipulate the event view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access users differs depending on the workflow you use. You can use the predefined workflow, which includes a table view of users that lists all detected users, and terminates in a user details page. The user details page provides information on every user that meets your constraints.

### Procedure

**Step 1**

Access the users data:

- If you are using the predefined workflow, choose **Analysis > Users > Users**.
- If you are using a custom workflow that does not include the table view of users, click **(switch workflow)**, then choose **Users**.

**Step 2**

You have the following options:

- Use a different workflow, including a custom workflow, by clicking **(switch workflow)**.
- Perform basic workflow actions; see Using Discovery and Identity Workflows, on page 1732.
- Learn more about the contents of the columns in the table; see User-Related Fields, on page 1769.

### User Activity Data

The Firepower System generates events that communicate the details of user activity on your network. When the system detects user activity, the user activity data is logged to the database. You can view, search, and delete user activity; you can also purge all user activity from the database.
The system logs a user activity event when a user is seen on your network for the first time. Subsequent appearances by that user do not log new user activity events. However, if the user's IP address changes, the system logs a new user activity event.

The Firepower System also correlates user activity with other types of events. For example, intrusion events can tell you the users who were logged into the source and destination hosts at the time of the event. This correlation can tell you who was logged into the host that was targeted by an attack, or who initiated an internal attack or portscan.

You can also use user activity in correlation rules. Based on the type of user activity as well as other criteria that you specify, you can build correlation rules that, when used in a correlation policy, launch remediations and alert responses when network traffic meets your criteria.

If you have ISE configured, you may see host data in the users table. Because host detection by ISE is not fully supported, you cannot perform user control using ISE-reported host data.

Descriptions of the four types of user activity data follow.

**New User Identity**

This type of event is generated when the system detects a login by an unknown user that is not in the database.

The system logs a user activity event when a user is seen on your network for the first time. Subsequent appearances by that user do not log new user activity events. However, if the user's IP address changes, the system logs a new user activity event.

**User Login**

This type of event is generated when any of the following occur:

- A User Agent or ISE reports a successful user login.
- Captive portal performs a successful or failed user authentication.
- Traffic-based detection detects a successful or failed user login.

SMTP logins detected by traffic-based detection are not recorded unless there is already a user with a matching email address in the database.

When a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user.

If you are using captive portal or traffic-based detection, note the following about failed user login and failed user authentication data:

- Failed logins reported by traffic-based detection (LDAP, IMAP, FTP, and POP3 traffic) are displayed in the table view of user activity, but not in the table view of users. If a known user failed to log in, the system identifies them by their username. If an unknown user failed to log in, the system uses **Failed Authentication** as their username.
Viewing User Activity Data

- Failed authentications reported by captive portal are displayed in both the table view of user activity and the table view of users. If a known user failed to authenticate, the system identifies them by their username. If an unknown user failed to authenticate, the system identifies them by the username they entered.

Delete User Identity
This type of event is generated when you manually delete a user from the database.

User Identity Dropped: User Limit Reached
This type of event is generated when the system detects a user that is not in the database, but cannot add the user because you have reached the maximum number of users in the database as determined by your Firepower Management Center model.

After you reach the user limit, in most cases the system stops adding new users to the database. To add new users, you must either manually delete old or inactive users from the database, or purge all users from the database.

However, the system favors authoritative users. If you have reached the limit and the system detects a login for a previously undetected authoritative user, the system deletes the non-authoritative user who has remained inactive for the longest time, and replaces it with the new authoritative user.

For information about general user-related event troubleshooting, see Troubleshoot Realms and User Downloads, on page 1327.

Related Topics
- The User Activity Database, on page 1208

Viewing User Activity Data

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

You can view a table of user activity, and then manipulate the event view depending on the information you are looking for. The page you see when you access user activity differs depending on the workflow you use. You can use the predefined workflow, which includes the table view of user activity and terminates in a user details page, which contains user details for every user that meets your constraints. You can also create a custom workflow that displays only the information that matches your specific needs.

Procedure

Step 1
Access the user activity data:

- If you are using the predefined workflow, choose Analysis > Users > User Activity.
- If you are using a custom workflow that does not include the table view of user activity, click (switch workflow), then choose User Activity.

Tip
If no events appear, you may need to adjust the time range; see Changing the Time Window, on page 1543.
Step 2

You have the following options:

- Use a different workflow, including a custom workflow, by clicking (switch workflow).
- Perform basic workflow actions; see Using Discovery and Identity Workflows, on page 1732.
- Learn more about the contents of the columns in the table; see User-Related Fields, on page 1769.

User Profile and Host History

You can learn more about a specific user by viewing the User pop-up window. The page that appears, called the "User Profile" in this document, is titled "User Identity" in the web interface.

You can display the window from:

- any event view that associates user data with other kinds of events
- the table view of users

User information also appears in the terminating page for users workflows.

The user data you see is the same as you would see in the table view of users.

Indications of Compromise Section

For information about this section, see:

- Indications of Compromise, on page 1315
- Indications of Compromise Data Fields, on page 1751
- Editing Indication of Compromise Rule States for a Single Host, on page 1752
- Resolving Indication of Compromise Tags, on page 1753
- Viewing Source Events for Indication of Compromise Tags, on page 1753

Host History Section

The host history provides a graphic representation of the last twenty-four hours of the user’s activity. A list of IP addresses of the hosts that the user logged into and logged off of approximates login and logout times with bar graphs. A typical user might log on to and off of multiple hosts in the course of a day. For example, periodic automated logins to a mail server would display as multiple short sessions, while longer logins (such as during working hours) display longer sessions.

If you use traffic-based detection or captive portal to capture failed logins, the host history also includes hosts where the user failed to log in.

The data used to generate the host history is stored in the user history database, which by default stores 10 million user login events. If you do not see any data in the host history for a particular user, either that user is inactive, or you may need to increase the database limit.

Related Topics

- User Data Fields
### Viewing User Details and Host History

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

### Procedure

You have two options:

- In any event view that lists users, click the user icon that appears next to a user identity ( hWnd ).
- In any users workflow, click the Users terminating page.
The following topics describe how to view correlation and compliance events.

- Viewing Correlation Events, on page 1779
- Using Compliance White List Workflows, on page 1783
- Remediation Status Events, on page 1788

**Viewing Correlation Events**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst</td>
</tr>
</tbody>
</table>

When a correlation rule within an active correlation policy triggers, the system generates a correlation event and logs it to the database.

---

**Note**

When a compliance white list within an active correlation policy triggers, the system generates a white list event.

---

You can view a table of correlation events, then manipulate the event view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access correlation events differs depending on the workflow you use. You can use the predefined workflow, which includes the table view of correlation events. You can also create a custom workflow that displays only the information that matches your specific needs.

**Procedure**

**Step 1**

Choose **Analysis > Correlation > Correlation Events**.

Optionally, to use a different workflow, including a custom workflow, click **(switch workflow)** by the workflow title.
If you are using a custom workflow that does not include the table view of correlation events, click (switch workflow), then choose Correlation Events.

Step 2
Optionally, adjust the time range as described in Changing the Time Window, on page 1543.

Step 3
Perform any of the following actions:

- To learn more about the columns that appear, see Correlation Event Fields, on page 1780.
- To view the host profile for an IP address, click the host profile icon that appears next to the IP address.
- To view user identity information, click the user icon that appears next to the user identity ( ).
- To sort and constrain events or to navigate within the current workflow page, see Using Workflows, on page 1523.
- To navigate between pages in the current workflow, keeping the current constraints, click the appropriate page link at the top left of the workflow page.
- To drill down to the next page in the Workflows, constraining on a specific value, see Using Drill-Down Pages, on page 1531.
- To delete some or all correlation events, check the check boxes next to the events you want to delete and click Delete, or click Delete All and confirm you want to delete all the events in the current constrained view.
- To navigate to other event views to view associated events, see Inter-Workflow Navigation, on page 1549.

Correlation Event Fields

When a correlation rule triggers, the system generates a correlation event. The fields in the correlation events table that can be viewed and searched are described in the following table.

### Table 281: Correlation Event Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>The description of the correlation event. The information in the description depends on how the rule was triggered. For example, if the rule was triggered by an operating system information update event, the new operating system name and confidence level appears.</td>
</tr>
<tr>
<td>Device</td>
<td>The name of the device that generated the event that triggered the policy violation.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Domain</td>
<td>The domain of the device whose monitored traffic triggered the policy violation. This field is only present if you have ever configured the Firepower Management Center for multitenancy.</td>
</tr>
<tr>
<td>Impact</td>
<td>The impact level assigned to the correlation event based on the correlation between intrusion data, discovery data, and vulnerability information. When searching this field, valid case-insensitive values are Impact 0, Impact Level 0, Impact 1, Impact Level 1, Impact 2, Impact Level 2, Impact 3, Impact Level 3, Impact 4, and Impact Level 4. Do not use impact icon colors or partial strings (for example, do not use blue, level 1, or 0).</td>
</tr>
<tr>
<td>Ingress Interface or Egress Interface</td>
<td>The ingress or egress interface in the intrusion or connection event that triggered the policy violation.</td>
</tr>
<tr>
<td>Ingress Security Zone or Egress Security Zone</td>
<td>The ingress or egress security zone in the intrusion or connection event that triggered the policy violation.</td>
</tr>
<tr>
<td>Inline Result</td>
<td>One of:</td>
</tr>
<tr>
<td></td>
<td>• a black down arrow, indicating that the system dropped the packet that triggered the intrusion rule</td>
</tr>
<tr>
<td></td>
<td>• a gray down arrow, indicating that the system would have dropped the packet in an inline, switched, or routed deployment if you enabled the Drop when Inline intrusion policy option</td>
</tr>
<tr>
<td></td>
<td>• blank, indicating that the triggered intrusion rule was not set to Drop and Generate Events</td>
</tr>
<tr>
<td></td>
<td>When using this field to search for policy violations triggered by intrusion events, type either:</td>
</tr>
<tr>
<td></td>
<td>• dropped, to specify whether the packet was dropped in an inline, switched, or routed deployment</td>
</tr>
<tr>
<td></td>
<td>• would have dropped, to specify whether the packet would have dropped if the intrusion policy had been set to drop packets in an inline, switched, or routed deployment</td>
</tr>
<tr>
<td></td>
<td>Note that the system does not drop packets in a passive deployment, including when an inline set is in tap mode, regardless of the rule state or the drop behavior of the intrusion policy.</td>
</tr>
<tr>
<td>Policy</td>
<td>The name of the policy that was violated.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority of the correlation event, which is determined by the priority of either the triggered rule or the violated correlation policy. When searching this field, enter none for no priority.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rule</td>
<td>The name of the rule that triggered the policy violation.</td>
</tr>
<tr>
<td>Security Intelligence Category</td>
<td>The name of the blacklisted object that represents or contains the blacklisted IP address in the event that triggered the policy violation. When searching this field, specify the Security Intelligence category associated with the correlation event that triggered the policy violation. The Security Intelligence category can be the name of a Security Intelligence object, the global blacklist, a custom Security Intelligence list or feed, or one of the categories in the Intelligence Feed.</td>
</tr>
<tr>
<td>Source Continent or Destination Continent</td>
<td>The continent associated with the source or destination host IP addresses in the event that triggered the policy violation.</td>
</tr>
<tr>
<td>Source Country or Destination Country</td>
<td>The country associated with the source or destination IP address in the event that triggered the policy violation.</td>
</tr>
<tr>
<td>Source Host Criticality or Destination Host Criticality</td>
<td>The user-assigned host criticality of the source or destination host involved in the correlation event: None, Low, Medium, or High. Note that only correlation events generated by rules based on discovery events, host input events, or connection events contain a source host criticality.</td>
</tr>
<tr>
<td>Source IP or Destination IP</td>
<td>The IP address of the source or destination host in the event that triggered the policy violation.</td>
</tr>
<tr>
<td>Source Port/ICMP Type or Destination Port/ICMP Code</td>
<td>The source port or ICMP type for the source traffic or the destination port or ICMP code for destination traffic associated with the event that triggered the policy violation.</td>
</tr>
<tr>
<td>Source User or Destination User</td>
<td>The name of the user logged in to the source or destination host in the event that triggered the policy violation.</td>
</tr>
<tr>
<td>Time</td>
<td>The date and time that the correlation event was generated. This field is not searchable.</td>
</tr>
<tr>
<td>Count</td>
<td>The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows. This field is not searchable.</td>
</tr>
</tbody>
</table>

**Related Topics**

[Event Searches](#), on page 1553
Using Compliance White List Workflows

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Analyst/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Any Security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Analyst/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin/Any Security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Analyst/Discovery</td>
</tr>
</tbody>
</table>

The Firepower Management Center provides a set of workflows that you can use to analyze the white list events and violations that are generated for your network. The workflows are, along with the network map and dashboard, a key source of information about the compliance of your network assets.

The system provides predefined workflows for white list events and violations. You can also create custom workflows. When you are using a compliance white list workflow, you can perform many common actions.

**Procedure**

**Step 1**
Access a white list workflow using the **Analysis > Correlation** menu.

**Step 2**
You have the following options:

- **Switch Workflow** — To use a different workflow, including a custom workflow, click *(switch workflow)*.

- **Time Range** — To adjust the time range, which is useful if no events appear, see **Changing the Time Window**, on page 1543.

- **Host Profile** — To view the host profile for an IP address, click the host profile icon *(●)* or, for hosts with active indications of compromise (IOC) tags, the compromised host icon *(●)* that appears next to the IP address.

- **User Profile (events only)** — To view user identity information, click the user icon that appears next to the user identity *(●)*.

- **Constrain** — To constrain the columns that appear, click the close icon *(●)* in the column heading that you want to hide. In the pop-up window that appears, click **Apply**.

  **Tip**
  To hide or show other columns, select or clear the appropriate check boxes before you click **Apply**. To add a disabled column back to the view, expand the search constraints, then click the column name under **Disabled Columns**.

- **Drill Down** — See **Using Drill-Down Pages**, on page 1531.

- **Sort** — To sort data in a workflow, click the column title. Click the column title again to reverse the sort order.

- **Navigate This Page** — See **Workflow Page Traversal Tools**, on page 1528.

- **Navigate Between Pages** — To navigate between pages in the current workflow, keeping the current constraints, click the appropriate page link at the top left of the workflow page.
• Navigate Between Event Views — To navigate to other event views to view associated events, click **Jump to** and select the event view from the drop-down list.

• Delete Events (events only) — To delete some or all items in the current constrained view, select the check boxes next to items you want to delete and click **Delete** or click **Delete All**.

**Related Topics**

- [Workflow Pages](#), on page 1527
- [Configuring Event View Settings](#), on page 31

---

**Viewing White List Events**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Analyst/Discovery</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Admin</td>
</tr>
</tbody>
</table>

After its initial evaluation, the system generates a *white list event* whenever a monitored host goes out of compliance with an active white list. White list events are a special kind of correlation event, and are logged to the FMC correlation event database.

You can use the Firepower Management Center to view a table of compliance white list events. Then, you can manipulate the event view depending on the information you are looking for.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

The page you see when you access white list events differs depending on the workflow you use. You can use a predefined workflow, which terminates in a table view of events. You can also create a custom workflow that displays only the information that matches your specific needs.

**Procedure**

**Step 1** Choose **Analysis > Correlation > White List Events**.

**Step 2** You have the following options:

- To perform basic workflow actions, see [Using Compliance White List Workflows](#), on page 1783.
- To learn more about the contents of the columns in the table, see [White List Event Fields](#), on page 1784.
- To see more options, right-click values in the table.

---

**White List Event Fields**

White list events, which you can view and search using workflows, contain the following fields.
Device
The name of the managed device that detected the white list violation.

Description
A description of how the white list was violated. For example:
Client “AOL Instant Messenger” is not allowed.

Violations that involve an application protocol indicate the application protocol name and version, as well as the port and protocol (TCP or UDP) it is using. If you restrict prohibitions to a particular operating system, the description includes the operating system name. For example:
Server "ssh / 22 TCP (OpenSSH 3.6.1p2)" is not allowed on Operating System “Linux Linux 2.4 or 2.6”.

Domain
The domain of the host that has become non-compliant with the white list. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

Host Criticality
The user-assigned host criticality of the source host that is out of compliance with the white list: None, Low, Medium, or High.

IP Address
The IP address of the host that has become non-compliant with the white list.

Policy
The name of the correlation policy that was violated, that is, the correlation policy that includes the white list.

Port
The port, if any, associated with the discovery event that triggered an application protocol white list violation (a violation that occurred as a result of a non-compliant application protocol). For other types of white list violations, this field is blank.

Priority
The priority specified by the policy or white list that triggered the policy violation. This is determined either by the priority of the white list in a correlation policy or by the priority of the correlation policy itself. Note that the white list priority overrides the priority of its policy. When searching this field, enter none for no priority.

Time
The date and time that the white list event was generated. This field is not searchable.

User
The identity of any known user logged in to the host that has become non-compliant with the white list.
**Viewing White List Violations**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin/Any Security Analyst/Discovery Admin</td>
</tr>
</tbody>
</table>

The system keeps a record of the current *white list violations* on your network. Each violation represents something disallowed running on one of your hosts. If a host becomes compliant, the system removes the now-corrected violation from the database.

You can use the Firepower Management Center to view a table of white list violations for all active white lists. Then, you can manipulate the event view depending on the information you are looking for.

The page you see when you access white list violations differs depending on the workflow you use. The predefined workflows terminate in a host view, which contains a host profile for every host that meets your constraints. You can also create a custom workflow that displays only the information that matches your specific needs.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

1. **Step 1** Choose **Analysis > Correlation > White List Violations**.
2. **Step 2** You have the following options:
   - To perform basic workflow actions, see *Using Compliance White List Workflows*, on page 1783.
   - To learn more about the contents of the columns in the table, see *White List Violation Fields*, on page 1786.
   - To see more options, right-click values in the table.

**White List Violation Fields**

White list violations, which you can view and search using workflows, contain the following fields.
**Domain**
The domain where the non-compliant host resides. This field is only present if you have ever configured the Firepower Management Center for multitenancy.

**Information**
Any available vendor, product, or version information associated with the white list violation. For protocols that violate a white list, this field also indicates whether the violation is due to a network or transport protocol.

**IP Address**
The IP address of the non-compliant host.

**Port**
The port, if any, associated with the event that triggered an application protocol white list violation (a violation that occurred as a result of a non-compliant application protocol). For other types of white list violations, this field is blank.

**Protocol**
The protocol, if any, associated with the event that triggered an application protocol white list violation (a violation that occurred as a result of a non-compliant application protocol). For other types of white list violations, this field is blank.

**Time**
The date and time that the white list violation was detected.

**Type**
The type of white list violation, that is, whether the violation occurred as a result of a non-compliant:
- operating system (os) (When searching this field, enter os or operating system.)
- application protocol (server)
- client
- protocol
- web application (web) (When searching this field, enter web application.)

**White List**
The name of the white list that was violated.

**Count**
The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows. This field is not searchable.
Remediation Status Events

When a remediation triggers, the system logs a remediation status event to the database. These events can be viewed on the Remediation Status page. You can search, view, and delete remediation status events.

**Related Topics**

- Remediation Status Table Fields, on page 1789

Viewing Remediation Status Events

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

The page you see when you access remediation status events differs depending on the workflow you use. You can use the predefined workflow, which includes a table view of remediations. The table view contains a row for each remediation status event. You can also create a custom workflow that displays only the information that matches your specific needs.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose Analysis > Correlation > Status.

**Step 2** Optionally, adjust the time range as described in Changing the Time Window, on page 1543.

**Step 3** Optionally, to use a different workflow, including a custom workflow, click (switch workflow) by the workflow title.

**Tip** If you are using a custom workflow that does not include the table view of remediations, click (switch workflow) menu by the workflow title, then choose Remediation Status.

**Step 4** You have the following options:

- To learn more about the columns that appear, see Remediation Status Table Fields, on page 1789.
- To sort and constrain the events, see Using Workflows, on page 1523.
- To navigate to the correlation events view to see associated events, click Correlation Events.
- To bookmark the current page so that you can quickly return to it, click Bookmark This Page. To navigate to the bookmark management page, click View Bookmarks.
- To generate a report based on the data in the table view, click Report Designer as described in Creating a Report Template from an Event View, on page 1429.
- To drill down to the next page in the workflow, see Using Drill-Down Pages, on page 1531.
- To delete remediation status events from the system, check the check boxes next to events you want to delete and click Delete or click Delete All and confirm you want to delete all the events in the current constrained view.
• To search for remediation status events, click **Search**.

---

**Related Topics**

- Using Workflows, on page 1523

---

**Remediation Status Table Fields**

The following table describes the fields in the remediation status table that can be viewed and searched.

*Table 282: Remediation Status Fields*

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>The domain of the device whose monitored traffic triggered the policy violation, that in turn triggered the remediation. This field is only present if you have ever configured the Firepower Management Center for multitenancy.</td>
</tr>
<tr>
<td>Policy</td>
<td>The name of the correlation policy that was violated and triggered the remediation.</td>
</tr>
<tr>
<td>Remediation Name</td>
<td>The name of the remediation that was launched.</td>
</tr>
<tr>
<td>Result Message</td>
<td>A message that describes what happened when the remediation was launched. Status messages include:</td>
</tr>
<tr>
<td></td>
<td>• Successful completion of remediation</td>
</tr>
<tr>
<td></td>
<td>• Error in the input provided to the remediation module</td>
</tr>
<tr>
<td></td>
<td>• Error in the remediation module configuration</td>
</tr>
<tr>
<td></td>
<td>• Error logging into the remote device or server</td>
</tr>
<tr>
<td></td>
<td>• Unable to gain required privileges on remote device or server</td>
</tr>
<tr>
<td></td>
<td>• Timeout logging into remote device or server</td>
</tr>
<tr>
<td></td>
<td>• Timeout executing remote commands or servers</td>
</tr>
<tr>
<td></td>
<td>• The remote device or server was unreachable</td>
</tr>
<tr>
<td></td>
<td>• The remediation was attempted but failed</td>
</tr>
<tr>
<td></td>
<td>• Failed to execute remediation program</td>
</tr>
<tr>
<td></td>
<td>• Unknown/unexpected error</td>
</tr>
</tbody>
</table>

If custom remediation modules are installed, you may see additional status messages that are implemented by the custom module.

| Rule | The name of the correlation rule that triggered the remediation. |
Using the Remediation Status Events Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>The date and time that the Firepower Management Center launched the remediation</td>
</tr>
<tr>
<td>Count</td>
<td>The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows. This field is not searchable.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Event Searches, on page 1553

**Using the Remediation Status Events Table**

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can change the layout of the event view or constrain the events in the view by a field value.

When you disable a column, it is disabled for the duration of your session unless you add it back later. If you disable the first column, the Count column is added.

Clicking a value within a row in a table view constrains the table view and does not drill down to the next page.

**Tip**

Table views always include “Table View” in the page name.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1** Choose **Analysis > Correlation > Status**.

**Tip** If you are using a custom workflow that does not include the table view of remediations, click **(switch workflow)** menu by the workflow title, then choose **Remediation Status**.

**Step 2** You have the following options:

- To learn more about the columns that appear, see **Remediation Status Table Fields, on page 1789**.
- To sort and constrain the events, see **Using Workflows, on page 1523**.
Auditing the System

The following topics describe how to audit activity on your system:

- About System Auditing, on page 1791
- Audit Records, on page 1791
- The System Log, on page 1798

About System Auditing

You can audit activity on your system in two ways. The appliances that are part of the Firepower System generate an audit record for each user interaction with the web interface, and also record system status messages in the system log.

Related Topics

- Introduction to Reports, on page 1425

Audit Records

Firepower Management Centers and 7000 and 8000 Series devices log read-only auditing information for user activity. Audit logs are presented in a standard event view that allows you to view, sort, and filter audit log messages based on any item in the audit view. You can easily delete and report on audit information and can view detailed reports of the changes that users make.

The audit log stores a maximum of 100,000 entries. When the number of audit log entries exceeds 100,000, the appliance prunes the oldest records from the database to reduce the number to 100,000.

If you reboot a 7000 or 8000 Series device, then log into the auxiliary CLI as soon as you are able, any commands you execute are not recorded in the audit log until the local web interface is available.

Viewing Audit Records

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>
On a Firepower Management Center or 7000 and 8000 Series devices, you can view a table of audit records. The predefined audit workflow includes a single table view of events. You can manipulate the table view depending on the information you are looking for. You can also create a custom workflow that displays only the information that matches your specific needs.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

**Procedure**

**Step 1**
Access the audit log workflow using System > Monitoring > Audit.

**Step 2**
If no events appear, you may need to adjust the time range. For more information, see Event Time Constraints, on page 1540.

**Note**
Events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.

**Step 3**
You have the following choices:

- To learn more about the contents of the columns in the table, see The System Log, on page 1798.
- To sort and constrain events on the current workflow page, see Using Table View Pages, on page 1531.
- To navigate between pages in the current workflow, keeping the current constraints, click the appropriate page link at the top left of the workflow page. For more information, see Using Workflows, on page 1523.
- To drill down to the next page in the workflow, see Using Drill-Down Pages, on page 1531.
- To constrain on a specific value, click a value within a row. If you click a value on a drill-down page, you move to the next page and constrain on the value. Note that clicking a value within a row in a table view constrains the table view and does not drill down to the next page. See Event View Constraints, on page 1547 for more information.

**Tip**
Table views always include “TableView” in the page name.

- To delete audit records, check the check boxes next to events you want to delete, then click Delete, or click Delete All to delete all events in the current constrained view.
- To bookmark the current page so you can quickly return to it, click Bookmark This Page. For more information, see Bookmarks, on page 1550.
- To navigate to the bookmark management page, click View Bookmarks. For more information, see Bookmarks, on page 1550.
- To generate a report based on the data in the current view, click Report Designer. For more information, see Creating a Report Template from an Event View, on page 1429.
- To view a summary of a change recorded in the audit log, click the compare icon (⽐) next to applicable events in the Message column. For more information, see Using the Audit Log to Examine Changes, on page 1794.

**Related Topics**
Event View Constraints, on page 1547
### Audit Log Workflow Fields

The following table describes the audit log fields that can be viewed and searched.

**Table 283: Audit Log Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Time and date that the appliance generated the audit record.</td>
</tr>
<tr>
<td>User</td>
<td>User name of the user that triggered the audit event.</td>
</tr>
<tr>
<td>Subsystem</td>
<td>The full menu path the user followed to generate the audit record. For example, <strong>System &gt; Monitoring &gt; Audit</strong> is the menu path to view the audit log. In a few cases where a menu path is not relevant, the Subsystem field displays only the event type. For example, <strong>Login</strong> classifies user login attempts.</td>
</tr>
<tr>
<td>Message</td>
<td>The action the user performed or the button the user clicked on the page. For example, <strong>Page View</strong> signifies that the user simply viewed the page indicated in the Subsystem, while <strong>Save</strong> means that the user clicked the <strong>Save</strong> button on the page. Changes made to the Firepower System appear with a compare icon (☑️) that you can click to see a summary of the changes.</td>
</tr>
<tr>
<td>Source IP</td>
<td>IP address associated with the host used by the user. Note: When searching this field you must type a specific IP address; you cannot use IP ranges when searching audit logs.</td>
</tr>
<tr>
<td>Domain</td>
<td>The current domain of the user when the audit event was triggered. This field is only present if you have ever configured the Firepower Management Center for multitenancy.</td>
</tr>
<tr>
<td>Configuration Change</td>
<td>Specifies whether to view audit records of configuration changes in the search results. (<strong>yes</strong> or <strong>no</strong>)</td>
</tr>
<tr>
<td>Count</td>
<td>The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows. This field is not searchable.</td>
</tr>
</tbody>
</table>
The Audit Events Table View

You can change the layout of the event view or constrain the events in the view by a field value. When disabling columns, after you click the close icon (×) in the column heading that you want to hide, in the pop-up window that appears, click Apply. When you disable a column, it is disabled for the duration of your session (unless you add it back later). Note that when you disable the first column, the Count column is added.

To hide or show other columns, or to add a disabled column back to the view, select or clear the appropriate checkboxes before you click Apply.

Clicking a value within a row in a table view constrains the table view and does not drill down to the next page in the workflow.

Tip
Table views always include “Table View” in the page name.

Related Topics
Using Workflows, on page 1523

Using the Audit Log to Examine Changes

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

You can use the audit log to view detailed reports of changes to your system. These reports compare the current configuration of your system to its most recent configuration before a particular change.

The Compare Configurations page displays the differences between the system configuration before changes and the running configuration in a side-by-side format. The audit event type, time of last modification, and name of the user who made the change are displayed in the title bar above each configuration.

Differences between the two configurations are highlighted:

- Blue indicates that the highlighted setting is different in the two configurations, and the difference is noted in red text.
- Green indicates that the highlighted setting appears in one configuration but not the other.

In a multidomain deployment, you can view data for the current domain and for any descendant domains. You cannot view data from higher level or sibling domains.

Procedure

Step 1  Choose System > Monitoring > Audit.
Step 2  Click the compare icon (☞) next to an applicable audit log event in the Message column.

Tip  You can navigate through changes individually by clicking Previous or Next above the title bar. If the change summary is more than one page long, you can also use the scroll bar on the right to view additional changes.
Suppressing Audit Records

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Admin</td>
</tr>
</tbody>
</table>

If your auditing policy does not require that you audit specific types of user interactions with the Firepower System, you can prevent those interactions from generating audit records on a Firepower Management Center or 7000 and 8000 Series devices. For example, by default, each time a user views the online help, the Firepower System generates an audit record. If you do not need to keep a record of these interactions, you can automatically suppress them.

To configure audit event suppression, you must have access to an appliance’s `admin` user account, and you must be able to either access the appliance’s console or open a secure shell.

⚠️ **Caution**

Make sure that only authorized personnel have access to the appliance and to its `admin` account.

**Procedure**

In the `/etc/sf` directory, create one or more `AuditBlock` files in the following form, where type is one of the types described in **Audit Block Types**, on page 1795:

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you create an <code>AuditBlock.type</code> file for a specific type of audit message, but later decide that you no longer want to suppress them, you must delete the contents of the <code>AuditBlock.type</code> file but leave the file itself on the Firepower System.</td>
</tr>
</tbody>
</table>

**Audit Block Types**

The contents for each audit block type must be in a specific format, as described in the following table. Make sure you use the correct capitalization for the file names. Note also that the contents of the files are case sensitive.

Note that when you add an `AuditBlock` file, an audit record with a subsystem of `Audit` and a message of `Audit Filter type Changed` is added to the audit events. For security reasons, this audit record cannot be suppressed.
Table 284: Audit Block Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Create a file named <code>AuditBlock.address</code> and include, one per line, each IP address that you want to suppress from the audit log. You can use partial IP addresses provided that they map from the beginning of the address. For example, the partial address 10.1.1 matches addresses from 10.1.1.0 through 10.1.1.255.</td>
</tr>
<tr>
<td>Message</td>
<td>Create a file named <code>AuditBlock.message</code> and include, one per line, the message substrings that you want to suppress. Note that substrings are matched so that if you include <code>backup</code> in your file, all messages that include the word <code>backup</code> are suppressed.</td>
</tr>
<tr>
<td>Subsystem</td>
<td>Create a file named <code>AuditBlock.subsystem</code> and include, one per line, each subsystem that you want to suppress. Note that substrings are not matched. You must use exact strings. See Audited Subsystems, on page 1796 for a list of subsystems that are audited.</td>
</tr>
<tr>
<td>User</td>
<td>Create a file named <code>AuditBlock.user</code> and include, one per line, each user account that you want to suppress. You can use partial string matching provided that they map from the beginning of the username. For example, the partial username <code>IPSAnalyst</code> matches the user names <code>IPSAnalyst1</code> and <code>IPSAnalyst2</code>.</td>
</tr>
</tbody>
</table>

Audited Subsystems

The following table lists audited subsystems.

Table 285: Subsystem Names

<table>
<thead>
<tr>
<th>Name</th>
<th>Includes user interactions with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>Administrative features such as system and access configuration, time synchronization, backup and restore, device management, user account management, and scheduling</td>
</tr>
<tr>
<td>Alerting</td>
<td>Alerting functions such as email, SNMP, and syslog alerting</td>
</tr>
<tr>
<td>Audit Log</td>
<td>Audit event views</td>
</tr>
<tr>
<td>Name</td>
<td>Includes user interactions with...</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Audit Log Search</td>
<td>Audit event searches</td>
</tr>
<tr>
<td>Command Line</td>
<td>Command line interface</td>
</tr>
<tr>
<td>Configuration</td>
<td>Email alerting</td>
</tr>
<tr>
<td>COOP</td>
<td>Continuity of operations feature</td>
</tr>
<tr>
<td>Date</td>
<td>Date and time range for event views</td>
</tr>
<tr>
<td>Default Subsystem</td>
<td>Options that do not have assigned subsystems</td>
</tr>
<tr>
<td>Detection &amp; Prevention Policy</td>
<td>Menu options for intrusion policies</td>
</tr>
<tr>
<td>Error</td>
<td>System-level errors</td>
</tr>
<tr>
<td>eStreamer</td>
<td>eStreamer configuration</td>
</tr>
<tr>
<td>EULA</td>
<td>Reviewing the end user license agreement</td>
</tr>
<tr>
<td>Events</td>
<td>Intrusion and discovery event views</td>
</tr>
<tr>
<td>Events Clipboard</td>
<td>Intrusion event clipboard</td>
</tr>
<tr>
<td>Events Reviewed</td>
<td>Reviewed intrusion events</td>
</tr>
<tr>
<td>Events Search</td>
<td>Any event search</td>
</tr>
<tr>
<td>Failed to install rule update</td>
<td>Installing rule updates</td>
</tr>
<tr>
<td>rule_update_id</td>
<td></td>
</tr>
<tr>
<td>Header</td>
<td>Initial presentation of the user interface after a user logs in</td>
</tr>
<tr>
<td>Health</td>
<td>Health monitoring</td>
</tr>
<tr>
<td>Health Events</td>
<td>Health monitoring event views</td>
</tr>
<tr>
<td>Help</td>
<td>Online help</td>
</tr>
<tr>
<td>High Availability</td>
<td>Establishing and managing Firepower Management Centers in high availability pairs</td>
</tr>
<tr>
<td>IDS Impact Flag</td>
<td>Impact flag configuration for intrusion events</td>
</tr>
<tr>
<td>IDS Policy</td>
<td>Intrusion policies</td>
</tr>
<tr>
<td>IDSRule sig_id:rev:rev_num</td>
<td>Intrusion rules by SID</td>
</tr>
<tr>
<td>Incidents</td>
<td>Intrusion incidents</td>
</tr>
<tr>
<td>Install</td>
<td>Installing updates</td>
</tr>
<tr>
<td>Intrusion Events</td>
<td>Intrusion events</td>
</tr>
<tr>
<td>Login</td>
<td>Web interface login and logout functions</td>
</tr>
</tbody>
</table>
### The System Log

The System Log (syslog) page provides you with system log information for the appliance. The system log displays each message generated by the system. The following items are listed in order:

- the date that the message was generated
- the time that the message was generated
- the host that generated the message
- the message itself

### Viewing the System Log

<table>
<thead>
<tr>
<th>Smart License</th>
<th>Classic License</th>
<th>Supported Devices</th>
<th>Supported Domains</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Global only</td>
<td>Admin/Maint</td>
</tr>
</tbody>
</table>
System log information is local. For example, you cannot use the Firepower Management Center to view system status messages in the system logs on your managed devices.

You can filter messages using most syntax accepted by the UNIX file search utility Grep. This includes using Grep-compatible regular expressions for pattern matching.

**Procedure**

**Step 1** Choose **System > Monitoring > Syslog**.

**Step 2**

To search for specific message content in the system log:

a) Enter a word or query in the filter field as described in **Syntax for System Log Filters**, on page 1799.

Only Grep-compatible search syntax is supported.

Examples:

To search for all log entries that contain the user name “Admin,” use `Admin`.

To search for all log entries that are generated on November 27, use `Nov[[:space:]]*27` or `Nov.*27` (but not `Nov 27` or `Nov*27`).

To search for all log entries that contain authorization debugging information on November 5, use `Nov[[:space:]]*5.*AUTH.*DEBUG`.

b) To make your search case-sensitive, select **Case-sensitive**. (By default, filters are not case-sensitive.)

c) To search for all system log messages that do **not** meet the criteria you entered, select **Exclusion**.

d) Click **Go**.

---

**Syntax for System Log Filters**

The following table shows the regular expression syntax you can use in System Log filters:

**Table 286: System Log Filter Syntax**

<table>
<thead>
<tr>
<th>Syntax Component</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>Matches any character or white space</td>
<td>Admi. matches Admin, Admin, Admin, Admin, and Admin</td>
</tr>
<tr>
<td>[:alpha:]</td>
<td>Matches any alphabetic character</td>
<td>[:alpha:]dmin matches Admin, badmin, and Cadmin</td>
</tr>
<tr>
<td>[:upper:]</td>
<td>Matches any uppercase alphabetic character</td>
<td>[:upper:]dmin matches Admin, Badmin, and Cadmin</td>
</tr>
<tr>
<td>[:lower:]</td>
<td>Matches any lowercase alphabetic character</td>
<td>[:lower:]dmin matches admin, badmin, and cadmin</td>
</tr>
<tr>
<td>[:digit:]</td>
<td>Matches any numeric character</td>
<td>[:digit:]dmin matches 0admin, 1admin, and 2admin</td>
</tr>
<tr>
<td>[:alnum:]</td>
<td>Matches any alphanumeric character</td>
<td>[:alnum:]dmin matches 1admin, admin, 2admin, and badmin</td>
</tr>
<tr>
<td>Syntax Component</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td><code>[:space:]</code></td>
<td>Matches any white space, including tabs</td>
<td>Feb[:space:]29 matches logs from February 29th</td>
</tr>
<tr>
<td><code>*</code></td>
<td>Matches zero or more instances of the character or expression it follows</td>
<td>ab* matches a, ab, abb, ca, cab, and cabb</td>
</tr>
<tr>
<td><code>.=</code></td>
<td>Matches zero or one instances</td>
<td>ab? matches a or ab</td>
</tr>
<tr>
<td><code>\</code></td>
<td>Allows you to search for a character typically interpreted as regular expression syntax</td>
<td>alert? matches alert?</td>
</tr>
</tbody>
</table>
Security, Internet Access, and Communication Ports

The following topics provide information on system security, internet access, and communication ports:

- Security Requirements, on page 1801
- Internet Access Requirements, on page 1801
- Communication Port Requirements, on page 1803

Security Requirements

To safeguard the Firepower Management Center, you should install it on a protected internal network. Although the FMC is configured to have only the necessary services and ports available, you must make sure that attacks cannot reach it (or any managed devices) from outside the firewall.

If the FMC and its managed devices reside on the same network, you can connect the management interfaces on the devices to the same protected internal network as the FMC. This allows you to securely control the devices from the FMC. You can also configure multiple management interfaces to allow the FMC to manage and isolate traffic from devices on other networks.

Regardless of how you deploy your appliances, inter-appliance communication is encrypted. However, you must still take steps to ensure that communications between appliances cannot be interrupted, blocked, or tampered with; for example, with a distributed denial of service (DDoS) or man-in-the-middle attack.

Internet Access Requirements

By default, Firepower appliances are configured to connect to the internet on ports 443/tcp (HTTPS) and 80/tcp (HTTP). If you do not want your appliances to have direct access to the internet, you can configure a proxy server.

In most cases, it is the Firepower Management Center that accesses the internet. However, sometimes managed devices also access the internet. For example, if your malware protection configuration uses dynamic analysis, managed devices submit files directly to the Cisco Threat Grid cloud. Or, you may synchronize a device to an external NTP server.
If you are using AMP for Networks or AMP for Endpoints, your location can determine which AMP cloud resources the FMC accesses. The Required Server Addresses for Proper AMP Operations Troubleshooting TechNote lists the internet resources (including static IP addresses) required not only by Firepower appliances, but also by Cisco AMP components like connectors and private cloud appliances.

Table 287: Firepower Internet Access Requirements

<table>
<thead>
<tr>
<th>Feature</th>
<th>Reason</th>
<th>Resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMP for Networks</td>
<td>Malware cloud lookups.</td>
<td>cloud-sa.amp.sourcefire.com&lt;br&gt;cloud-sa.eu.amp.sourcefire.com&lt;br&gt;cloud-sa.apjc.amp.sourcefire.com&lt;br&gt;cloud-sa-589592150.us-east-1.elb.amazonaws.com</td>
</tr>
<tr>
<td></td>
<td>Download signature updates for file preclassification and local malware analysis.</td>
<td>updates.vrt.sourcefire.com&lt;br&gt;amp.updates.vrt.sourcefire.com</td>
</tr>
<tr>
<td></td>
<td>Submit files for dynamic analysis (managed devices). Submit files for dynamic analysis (managed devices).</td>
<td>panacea.threatgrid.com</td>
</tr>
<tr>
<td>AMP for Endpoints integration</td>
<td>Receive malware events detected by AMP for Endpoints from the AMP cloud.</td>
<td>api.amp.sourcefire.com&lt;br&gt;api.eu.amp.sourcefire.com&lt;br&gt;api.apjc.amp.sourcefire.com&lt;br&gt;export.amp.sourcefire.com&lt;br&gt;export.eu.amp.sourcefire.com&lt;br&gt;export.apjc.amp.sourcefire.com</td>
</tr>
<tr>
<td>Security Intelligence</td>
<td>Download Security Intelligence feeds.</td>
<td>intelligence.sourcefire.com</td>
</tr>
<tr>
<td>URL filtering</td>
<td>Download URL category and reputation data.</td>
<td>database.brightcloud.com&lt;br&gt;service.brightcloud.com</td>
</tr>
<tr>
<td></td>
<td>Manually query URL category and reputation data.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Query for uncategorized URLs.</td>
<td></td>
</tr>
<tr>
<td>System updates</td>
<td>Download updates directly from Cisco to the appliance:</td>
<td>cisco.com&lt;br&gt;sourcefire.com</td>
</tr>
<tr>
<td></td>
<td>• System software</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Intrusion rules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vulnerability database (VDB)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Geolocation database (GeoDB)</td>
<td></td>
</tr>
</tbody>
</table>
Communication Port Requirements

Firepower appliances communicate using a two-way, SSL-encrypted communication channel on port 8305/tcp. This port must remain open for basic intra-platform communication.

Other ports allow secure management, as well as access to external resources required by specific features. In general, feature-related ports remain closed until you enable or configure the associated feature. Do not change or close an open port until you understand how this action will affect your deployment.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Reason</th>
<th>Resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time synchronization</td>
<td>Synchronize time in your deployment. Not supported with a proxy server.</td>
<td>0.sourceforge.pool.ntp.org</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.sourceforge.pool.ntp.org</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.sourceforge.pool.ntp.org</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3.sourceforge.pool.ntp.org</td>
</tr>
<tr>
<td>RSS feeds</td>
<td>Display the Cisco Threat Research Blog on the dashboard.</td>
<td>blogs.cisco.com/talos</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cloud.google.com</td>
</tr>
<tr>
<td>Whois</td>
<td>Request whois information for an external host. Not supported with a proxy server.</td>
<td>The whois client tries to guess the right server to query. If it cannot guess, it uses:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NIC handles: whois.networksolutions.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IPv4 addresses and network names: whois.arin.net</td>
</tr>
</tbody>
</table>

Table 288: Firepower Communication Port Requirements

<table>
<thead>
<tr>
<th>Port</th>
<th>Protocol/Feature</th>
<th>Platforms</th>
<th>Direction</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>22/tcp</td>
<td>SSH</td>
<td>FMC Any device</td>
<td>Inbound</td>
<td>Secure remote connections to the appliance.</td>
</tr>
<tr>
<td>25/tcp</td>
<td>SMTP</td>
<td>FMC</td>
<td>Outbound</td>
<td>Send email notices and alerts.</td>
</tr>
<tr>
<td>53/tcp</td>
<td>DNS</td>
<td>FMC Any device</td>
<td>Outbound</td>
<td>DNS.</td>
</tr>
<tr>
<td>53/udp</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>67/udp</td>
<td>DHCP</td>
<td>FMC Any device</td>
<td>Outbound</td>
<td>DHCP.</td>
</tr>
<tr>
<td>68/udp</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80/tcp</td>
<td>HTTP</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Outbound</td>
<td>Display RSS feeds in the dashboard.</td>
</tr>
<tr>
<td>80/tcp</td>
<td>HTTP</td>
<td>FMC</td>
<td>Outbound</td>
<td>Download or query URL category and reputation data (port 443 also required).</td>
</tr>
<tr>
<td>Port</td>
<td>Protocol/Feature</td>
<td>Platforms</td>
<td>Direction</td>
<td>Details</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------</td>
<td>--------------------</td>
<td>-----------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>80/tcp</td>
<td>HTTP</td>
<td>FMC</td>
<td>Outbound</td>
<td>Download custom Security Intelligence feeds over HTTP.</td>
</tr>
<tr>
<td>123/udp</td>
<td>NTP</td>
<td>FMC Any device</td>
<td>Outbound</td>
<td>Synchronize time.</td>
</tr>
<tr>
<td>161/udp</td>
<td>SNMP</td>
<td>FMC Any device</td>
<td>Inbound</td>
<td>Allow access to MIBs via SNMP polling.</td>
</tr>
<tr>
<td>162/udp</td>
<td>SNMP</td>
<td>FMC Any device</td>
<td>Outbound</td>
<td>Send SNMP alerts to a remote trap server.</td>
</tr>
<tr>
<td>389/tcp</td>
<td>LDAP</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Outbound</td>
<td>Communicate with an LDAP server for external authentication. Obtain metadata for detected LDAP users (FMC only). Configurable.</td>
</tr>
<tr>
<td>636/tcp</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>443/tcp</td>
<td>HTTPS</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Inbound</td>
<td>Access the web interface.</td>
</tr>
<tr>
<td>443/tcp</td>
<td>HTTPS</td>
<td>FMC Any device</td>
<td>Outbound</td>
<td>Send and receive data from the internet. For details, see Internet Access Requirements, on page 1801.</td>
</tr>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>FMC</td>
<td>Outbound</td>
<td>Communicate with the AMP cloud (public or private) See also information for port 32137.</td>
</tr>
<tr>
<td></td>
<td>HTTPS</td>
<td>FMC</td>
<td>Inbound and Outbound</td>
<td>Integrate with AMP for Endpoints</td>
</tr>
<tr>
<td>514/udp</td>
<td>Syslog (alerts)</td>
<td>FMC Any device</td>
<td>Outbound</td>
<td>Send alerts to a remote syslog server.</td>
</tr>
<tr>
<td>623/udp</td>
<td>SOL/LOM</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Inbound</td>
<td>Lights-Out Management (LOM) using a Serial Over LAN (SOL) connection.</td>
</tr>
<tr>
<td>885/tcp</td>
<td>Captive portal</td>
<td>Any device</td>
<td>Inbound</td>
<td>Communicate with a captive portal identity source.</td>
</tr>
<tr>
<td>1500/tcp</td>
<td>Database access</td>
<td>FMC</td>
<td>Inbound</td>
<td>Allow read-only access to the event database by a third-party client.</td>
</tr>
<tr>
<td>1812/udp</td>
<td>RADIUS</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Outbound</td>
<td>Communicate with a RADIUS server for external authentication and accounting. Configurable.</td>
</tr>
<tr>
<td>Port</td>
<td>Protocol/Feature</td>
<td>Platforms</td>
<td>Direction</td>
<td>Details</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------</td>
<td>------------------</td>
<td>-----------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3306/tcp</td>
<td>User Agent</td>
<td>FMC</td>
<td>Inbound</td>
<td>Communicate with User Agents.</td>
</tr>
<tr>
<td>5222/tcp</td>
<td>ISE</td>
<td>FMC</td>
<td>Outbound</td>
<td>Communicate with an ISE identity source.</td>
</tr>
<tr>
<td>8302/tcp</td>
<td>eStreamer</td>
<td>FMC 7000 &amp; 8000 Series</td>
<td>Inbound</td>
<td>Communicate with an eStreamer client.</td>
</tr>
<tr>
<td>8305/tcp</td>
<td>Appliance communications</td>
<td>FMC Any device</td>
<td>Both</td>
<td>Securely communicate between appliances in a deployment. Configurable. If you change this port, you must change it for all appliances in the deployment. We recommend you keep the default.</td>
</tr>
<tr>
<td>8307/tcp</td>
<td>Host input client</td>
<td>FMC</td>
<td>Inbound</td>
<td>Communicate with a host input client.</td>
</tr>
<tr>
<td>32137/tcp</td>
<td>AMP for Networks</td>
<td>FMC</td>
<td>Outbound</td>
<td>Communicate with the Cisco AMP cloud. This is a legacy configuration. We recommend you use the default (443).</td>
</tr>
</tbody>
</table>

**Related Topics**
- [Identifying the LDAP Authentication Server](#), on page 80
- [Configuring RADIUS Connection Settings](#), on page 96
Command Line Reference

This reference explains the command line interface (CLI) for the following classic devices:

- 7000 and 8000 Series
- ASA FirePOWER
- NGIPSv

You cannot use the CLI on the Firepower Management Center. The Firepower Management Center supports Linux shell access, and only under Cisco Technical Assistance Center (TAC) supervision.

Note

- About the Classic Device CLI, on page 1807
- Classic Device CLI Management Commands, on page 1808
- Classic Device CLI Show Commands, on page 1811
- Classic Device CLI Configuration Commands, on page 1839
- Classic Device CLI System Commands, on page 1857

About the Classic Device CLI

After you log into a classic device (7000 and 8000 Series, ASA FirePOWER, and NGIPSv) via the CLI (see Logging Into the Command Line Interface, on page 24), you can use the commands described in this appendix to view, configure, and troubleshoot your device.

Note

If you reboot a 7000 or 8000 Series device and then log in to the CLI as soon as you are able, any commands you execute are not recorded in the audit log until the web interface is available.

Note that CLI commands are case-insensitive with the exception of parameters whose text is not part of the CLI framework, such as user names and search filters.

Related Topics

- User Interfaces in Firepower Management Center Deployments, on page 19
Classic Device CLI Modes

The CLI encompasses four modes. The default mode, CLI Management, includes commands for navigating within the CLI itself. The remaining modes contain commands addressing three different areas of classic device functionality; the commands within these modes begin with the mode name: system, show, or configure.

When you enter a mode, the CLI prompt changes to reflect the current mode. For example, to display version information about system components, you can enter the full command at the standard CLI prompt:

> show version

If you have previously entered show mode, you can enter the command without the show keyword at the show mode CLI prompt:

show> version

Classic Device CLI Access Levels

Within each mode, the commands available to a user depend on the user’s CLI access. When you create a user account, you can assign it one of the following CLI access levels:

- Basic — The user has read-only access and cannot run commands that impact system performance.
- Configuration — The user has read-write access and can run commands that impact system performance.
- None — The user is unable to log in to the shell.

On 7000 and 8000 Series devices, you can assign command line permissions on the User Management page in the local web interface. On NGIPSv and ASA FirePOWER, you assign command line permissions using the CLI.

Classic Device CLI Management Commands

The CLI management commands provide the ability to interact with the CLI. These commands do not affect the operation of the device. These commands are available to all CLI users.

configure password

Allows the current user to change their password. After issuing the command, the CLI prompts the user for their current (or old) password, then prompts the user to enter the new password twice.

Access
Basic

Syntax
configure password
Example

> configure password
Enter current password:
Enter new password:
Confirm new password:

exit

Moves the CLI context up to the next highest CLI context level. Issuing this command from the default mode logs the user out of the current CLI session, and is equivalent to issuing the `logout` CLI command.

Access
Basic

Syntax
exit

Example

configure network ipv4> exit
configure network>

expert

Invokes the shell.

Access
Configuration

Syntax
expert

Example

> expert

history

Displays the command line history for the current session.
Access
Basic

Syntax

history limit
where limit sets the size of the history list. To set the size to unlimited, enter zero.

Example

history 25

logout

Logs the current user out of the current CLI console session.

Access
Basic

Syntax

logout

Example

> logout

? (question mark)

Displays context-sensitive help for CLI commands and parameters. Use the question mark (?) command as follows:

• To display help for the commands that are available within the current CLI context, enter a question mark (?) at the command prompt.

• To display a list of the available commands that start with a particular character set, enter the abbreviated command immediately followed by a question mark (?).

• To display help for a command’s legal arguments, enter a question mark (?) in place of an argument at the command prompt.

Note that the question mark (?) is not echoed back to the console.

Access
Basic
Syntax

? abbreviated_command ?
command [arguments] ?

Example

> ?

Classic Device CLI Show Commands

Show commands provide information about the state of the device. These commands do not change the operational mode of the device and running them has minimal impact on system operation. Most show commands are available to all CLI users; however, only users with configuration CLI access can issue the show user command.

access-control-config

Displays the currently deployed access control configurations, including:

- Security Intelligence settings
- the names of any subpolicies the access control policy invokes
- intrusion variable set data
- logging settings
- other advanced settings, including policy-level performance, preprocessing, and general settings

Also displays policy-related connection information, such as source and destination port data (including type and code for ICMP entries) and the number of connections that matched each access control rule (hit counts).

Access

Basic

Syntax

show access-control-config

Example

> show access-control-config
alarms

Displays currently active (failed/down) hardware alarms on the device. This command is not available on NGIPSv and ASA FirePOWER devices.

**Access**
Basic

**Syntax**

    show alarms

**Example**

    > show alarms

arp-tables

Displays the Address Resolution Protocol tables applicable to your network. This command is not available on NGIPSv and ASA FirePOWER.

**Access**
Basic

**Syntax**

    show arp-tables

**Example**

    > show arp-tables

audit-log

Displays the audit log in reverse chronological order; the most recent audit log events are listed first.

**Access**
Basic

**Syntax**

    show audit-log
**Example**

> show audit-log

**bypass**

On 7000 or 8000 Series devices, lists the inline sets in use and shows the bypass mode status of those sets as one of the following:

- **armed**—the interface pair is configured to go into hardware bypass if it fails (Bypass Mode: Bypass), or has been forced into fail-close with the `configure bypass close` command
- **engaged**—the interface pair has failed open or has been forced into hardware bypass with the `configure bypass open` command
- **off**—the interface pair is set to fail-close (Bypass Mode: Non-Bypass); packets are blocked if the interface pair fails

**Access**

Basic

**Syntax**

`show bypass`

**Example**

> show bypass
  slp1 ↔ slp2: status 'armed'
  slp1 ↔ slp2: status 'engaged'

**high-availability Commands**

Displays information about high-availability configuration, status, and member devices or stacks. This command is not available on NGIPSv and ASA FirePOWER devices.

**Access**

Basic

**config**

 Displays the high-availability configuration on the device.

**Syntax**

`show high-availability config`
**Example**

```
> show high-availability config
```

**high-availability ha-statistics**

Displays state sharing statistics for a device in a high-availability pair.

**Syntax**

```
show high-availability ha-statistics
```

**Example**

```
> show high-availability ha-statistics
```

**cpu**

Displays the current CPU usage statistics appropriate for the platform for all CPUs on the device. For 7000 and 8000 Series devices, the following values are displayed:

- CPU — Processor number.
- Load — The CPU utilization, represented as a number from 0 to 100. 0 is not loaded and 100 is completely loaded.

For NGIPSv and ASA FirePOWER, the following values are displayed:

- CPU — Processor number.
- %user — Percentage of CPU utilization that occurred while executing at the user level (application).
- %nice — Percentage of CPU utilization that occurred while executing at the user level with nice priority.
- %sys — Percentage of CPU utilization that occurred while executing at the system level (kernel). This does not include time spent servicing interrupts or softirqs. A softirq (software interrupt) is one of up to 32 enumerated software interrupts that can run on multiple CPUs at once.
- %iowait — Percentage of time that the CPUs were idle when the system had an outstanding disk I/O request.
- %irq — Percentage of time spent by the CPUs to service interrupts.
- %soft — Percentage of time spent by the CPUs to service softirqs.
- %steal — Percentage of time spent in involuntary wait by the virtual CPUs while the hypervisor was servicing another virtual processor.
- %guest — Percentage of time spent by the CPUs to run a virtual processor.
- %idle — Percentage of time that the CPUs were idle and the system did not have an outstanding disk I/O request.
**Access**
Basic

**Syntax**

`show cpu {procnum}`

where `procnum` is the number of the processor for which you want the utilization information displayed. Valid values are 0 to one less than the total number of processors on the system. If `procnum` is used for a 7000 or 8000 Series device, it is ignored because for that platform, utilization information can only be displayed for all processors.

**Example**

`> show cpu`

---

**database Commands**

The `show database` commands configure the device’s management interface.

**Access**
Basic

**processes**

Displays a list of running database queries.

**Access**
Basic

**Syntax**

`show database processes`

**Example**

`> show database processes`

---

**slow-query-log**

Displays the slow query log of the database.

**Access**
Basic
Syntax

show database slow-query-log

Example

> show database slow-query-log

device-settings

Displays information about application bypass settings specific to the current device.

Access

Basic

Syntax

show device-settings

Example

> show device-settings

disk

Displays the current disk usage.

Access

Basic

Syntax

show disk

Example

> show disk

disk-manager

Displays detailed disk usage information for each part of the system, including silos, low watermarks, and high watermarks.
**dns**

Displays the current DNS server addresses and search domains.

**Access**
Basic

**Syntax**

```
show disk-manager
```

**Example**

```
> show disk-manager
```

**fan-status**

Displays the current status of hardware fans. This command is not available on NGIPSv and ASA FirePOWER devices.

**Access**
Basic

**Syntax**

```
show fan-status
```

**Example**

```
> show fan-status
```
fastpath-rules

Displays the currently configured 8000 Series fastpath rules. This command is only available on 8000 Series devices.

Access
Basic

Syntax

show fastpath-rules

Example

> show fastpath-rules

gui

Displays the current state of the web interface. This command is not available on NGIPSv and ASA FirePOWER.

Access
Basic

Syntax

show gui

Example

> show gui

hostname

Displays the device’s host name and appliance UUID. If you edit the host name of a device using the CLI, confirm that the changes are reflected on the managing Firepower Management Center. In some cases, you may need to edit the device management settings manually.

Access
Basic

Syntax

show hostname
Example

> show hostname

hosts

Displays the contents of an ASA FirePOWER module’s /etc/hosts file.

Access
Basic

Syntax

show hosts

Example

> show hosts

hyperthreading

Displays whether hyperthreading is enabled or disabled. This command is not available on ASA FirePOWER.

Access
Basic

Syntax

show hyperthreading

Example

> show hyperthreading

inline-sets

Displays configuration data for all inline security zones and associated interfaces. This command is not available on ASA FirePOWER.

Access
Basic
Syntax

show inline-sets

Example

> show inline-sets

interfaces

If no parameters are specified, displays a list of all configured interfaces. If a parameter is specified, displays detailed information about the specified interface.

Access
Basic

Syntax

show interfaces interface

where interface is the specific interface for which you want the detailed information.

Example

> show interfaces

ifconfig

Displays the interface configuration for an ASA FirePOWER module.

Access
Basic

Syntax

show ifconfig

Example

> show ifconfig
**lcd**

Displays whether the LCD hardware display is enabled or disabled. This command is not available on NGIPSv and ASA FirePOWER.

**Access**
Basic

**Syntax**

```
show lcd
```

**Example**

```
> show lcd
```

**link-aggregation Commands**

The `show link-aggregation` commands display configuration and statistics information for link aggregation groups (LAGs). This command is not available on NGIPSv and ASA FirePOWER devices.

**Access**
Basic

**configuration**

Displays configuration details for each configured LAG, including LAG ID, number of interfaces, configuration mode, load-balancing mode, LACP information, and physical interface type.

**Access**
Basic

**Syntax**

```
show link-aggregation configuration
```

**Example**

```
> show link-aggregation configuration
```

**statistics**

Displays statistics, per interface, for each configured LAG, including status, link state and speed, configuration mode, counters for received and transmitted packets, and counters for received and transmitted bytes.
**Access**
Basic

**Syntax**

show link-aggregation statistics

**Example**

> show link-aggregation statistics

**link-state**

Displays type, link, speed, duplex state, and bypass mode of the ports on the device. This command is not available on ASA FirePOWER devices.

**Access**
Basic

**Syntax**

show link-state

**Example**

> show link-state

**log-ips-connection**

Displays whether the logging of connection events that are associated with logged intrusion events is enabled or disabled.

**Access**
Basic

**Syntax**

show log-ips-connection

**Example**

> show log-ips-connection
managers

Displays the configuration and communication status of the Firepower Management Center. Registration key and NAT ID are only displayed if registration is pending.

If a device is configured as a secondary device in a stacked configuration, information about both the managing FMC and the primary device is displayed.

**Access**
Basic

**Syntax**

```
show managers
```

**Example**

```
> show managers
```

memory

Displays the total memory, the memory in use, and the available memory for the device.

**Access**
Basic

**Syntax**

```
show memory
```

**Example**

```
> show memory
```

model

Displays model information for the device.

**Access**
Basic

**Syntax**

```
show model
```
Example

> show model

mpls-depth

Displays the number of MPLS layers configured on the management interface, from 0 to 6. This command is not available on NGIPSv and ASA FirePOWER.

Access
Basic

Syntax

show mpls-depth

Example

> show mpls-depth

NAT Commands

The show nat commands display NAT data and configuration information for the management interface. This command is not available on NGIPSv and ASA FirePOWER devices.

Access
Basic

active-dynamic

Displays NAT flows translated according to dynamic rules. These entries are displayed when a flow matches a rule, and persist until the rule has timed out. Therefore, the list can be inaccurate. Timeouts are protocol dependent: ICMP is 5 seconds, UDP is 120 seconds, TCP is 3600 seconds, and all other protocols are 60 seconds.

Syntax

show nat active-dynamic

Example

> show nat active-dynamic
active-static

Displays NAT flows translated according to static rules. These entries are displayed as soon as you deploy the rule to the device, and the list does not indicate active flows that match a static NAT rule.

Syntax

show nat active-static

Example

> show nat active-static

allocators

Displays information for all NAT allocators, the pool of translated addresses used by dynamic rules.

Syntax

show nat allocators

Example

> show nat allocators

cfg

Displays the current NAT policy configuration for the management interface.

Syntax

show nat config

Example

> show nat config

dynamic-rules

Displays dynamic NAT rules that use the specified allocator ID.

Syntax

show nat dynamic-rules allocator_id

where allocator_id is a valid allocator ID number.
flows

Displays the number of flows for rules that use the specified allocator ID.

Syntax

show nat flows allocator-id

where allocator_id is a valid allocator ID number.

Example

> show nat flows 81

static-rules

Displays all static NAT rules.

Syntax

show nat static-rules

Example

> show nat static-rules

netstat

Displays the active network connections for an ASA FirePOWER module.

Access

Basic

Syntax

show netstat

Example

> show netstat
network

Displays the IPv4 and IPv6 configuration of the management interface, its MAC address, and HTTP proxy address, port, and username if configured.

Access
Basic

Syntax

show network

Example

> show network

network-modules

Displays all installed modules and information about them, including serial numbers. This command is not available on NGIPSv and ASA FirePOWER.

Access
Basic

Syntax

show network-modules

Example

> show network-modules

network-static-routes

Displays all configured network static routes and information about them, including interface, destination address, network mask, and gateway address.

Access
Basic

Syntax

show network-static-routes
ntp

Displays the ntp configuration.

**Access**
Basic

**Syntax**

```
show ntp
```

**Example**

```
> show ntp
```

perfstats

Displays performance statistics for the device.

**Access**
Basic

**Syntax**

```
show perfstats
```

**Example**

```
> show perfstats
```

portstats

Displays port statistics for all installed ports on the device. This command is not available on NGIPSv and ASA FirePOWER.

**Access**
Basic
Syntax

show portstats [copper | fiber | internal | external | all]

where copper specifies for all copper ports, fiber specifies for all fiber ports, internal specifies for all internal
ports, external specifies for all external (copper and fiber) ports, and all specifies for all ports (external and
internal).

Example

> show portstats fiber

**power-supply-status**

Displays the current state of hardware power supplies. This command is not available on NGIPSv and ASA
FirePOWER.

Access

Basic

Syntax

show power-supply-status

Example

> show power-supply-status

**process-tree**

Displays processes currently running on the device, sorted in tree format by type.

Access

Basic

Syntax

show process-tree

Example

> show process-tree
processes

Displays processes currently running on the device, sorted by descending CPU usage.

**Access**

Basic

**Syntax**

```
show processes sort-flag filter
```

where `sort-flag` can be `-m` to sort by memory (descending order), `-u` to sort by username rather than the process name, or `verbose` to display the full name and path of the command. The `filter` parameter specifies the search term in the command or username by which results are filtered. The header row is still displayed.

**Example**

```
> show processes -u user1
```

route

Displays the routing information for an ASA FirePOWER module.

**Access**

Basic

**Syntax**

```
show route
```

**Example**

```
> show route
```

routing-table

If no parameters are specified, displays routing information for all virtual routers. If parameters are specified, displays routing information for the specified router and, as applicable, its specified routing protocol type. All parameters are optional. This command is not available on NGIPSv and ASA FirePOWER.

**Access**

Basic
Syntax

show routing-table name [ ospf | rip | static ]

where name is the name of the specific router for which you want information, and ospf, rip, and static specify the routing protocol type.

Example

> show routing-table Vrouter1 static

serial-number

Displays the chassis serial number. This command is not available on NGIPSv.

Access
Basic

Syntax

show serial-number

Example

> show serial-number

ssl-policy-config

Displays the currently deployed SSL policy configuration, including policy description, default logging settings, all enabled SSL rules and rule configurations, trusted CA certificates, and undecryptable traffic actions.

Access
Basic

Syntax

show ssl-policy-config

Example

> show ssl-policy-config
**stacking**

Shows the stacking configuration and position on managed devices; on devices configured as primary, also lists data for all secondary devices. For stacks in a high-availability pair, this command also indicates that the stack is a member of a high-availability pair. The user must use the web interface to enable or (in most cases) disable stacking; if stacking is not enabled, the command will return *Stacking not currently configured*. This command is not available on NGIPSv and ASA FirePOWER.

**Access**
Basic

**Syntax**

```
show stacking
```

**Example**

```
> show stacking
```

**summary**

Displays a summary of the most commonly used information (version, type, UUID, and so on) about the device. For more detailed information, see the following *show commands*: `version`, `interfaces`, `device-settings`, and `access-control-config`.

**Access**
Basic

**Syntax**

```
show summary
```

**Example**

```
> show summary
```

**time**

Displays the current date and time in UTC and in the local time zone configured for the current user.

**Access**
Basic
Syntax

show time

Example

> show time

**traffic-statistics**

If no parameters are specified, displays details about bytes transmitted and received from all ports. If a port is specified, displays that information only for the specified port. You cannot specify a port for ASA FirePOWER modules; the system displays only the data plane interfaces.

In some situations the output of this command may show packet drops when, in point of fact, the device is not dropping traffic. Drop counters increase when malformed packets are received. A malformed packet may be missing certain information in the header or it may have failed a cyclic-redundancy check (CRC). Typically, common root causes of malformed packets are data link layer issues such as bad cables or a bad interface. The dropped packets are not logged. However, if the source is a reliable transport protocol such as TCP, the packets will be retransmitted.

**Access**

Basic

**Syntax**

show traffic-statistics port

where *port* is the specific port for which you want information.

**Example**

> show traffic-statistics s1p1

**user**

Applicable to NGIPSv only. Displays detailed configuration information for the specified user(s). The following values are displayed:

- Login — the login name
- UID — the numeric user ID
- Auth *(Local or Remote)* — how the user is authenticated
- Access *(Basic or Config)* — the user's privilege level
• **Enabled (Enabled or Disabled)** — whether the user is active
• **Reset (Yes or No)** — whether the user must change password at next login
• **Exp (Never or a number)** — the number of days until the user's password must be changed
• **Warn (N/A or a number)** — the number of days a user is given to change their password before it expires
• **Str (Yes or No)** — whether the user's password must meet strength checking criteria
• **Lock (Yes or No)** — whether the user's account has been locked due to too many login failures
• **Max (N/A or a number)** — the maximum number of failed logins before the user's account is locked

**Access**

**Configuration**

**Syntax**

```
show user username username username ...
```

where `username` specifies the name of the user and the usernames are space-separated.

**Example**

```
> show user jdoe
```

**users**

Applicable to NGIPSv and ASA FirePOWER only. Displays detailed configuration information for all local users. The following values are displayed:

• **Login** — the login name
• **UID** — the numeric user ID
• **Auth (Local or Remote)** — how the user is authenticated
• **Access (Basic or Config)** — the user's privilege level
• **Enabled (Enabled or Disabled)** — whether the user is active
• **Reset (Yes or No)** — whether the user must change password at next login
• **Exp (Never or a number)** — the number of days until the user's password must be changed
• **Warn (N/A or a number)** — the number of days a user is given to change their password before it expires
• **Str (Yes or No)** — whether the user's password must meet strength checking criteria
• **Lock (Yes or No)** — whether the user's account is locked due to too many login failures
• **Max (N/A or a number)** — the maximum number of failed logins before the user's account is locked
version

Displays the product version and build. If the `detail` parameter is specified, displays the versions of additional components.

**Note**

The `detail` parameter is not available on ASA with FirePOWER Services.

**Access**

Basic

**Syntax**

```
show version [detail]
```

**Example**

```
> show version
```

virtual-routers

If no parameters are specified, displays a list of all currently configured virtual routers with DHCP relay, OSPF, and RIP information. If parameters are specified, displays information for the specified router, limited by the specified route type. All parameters are optional. This command is not available on NGIPSv and ASA FirePOWER.

**Access**

Basic

**Syntax**

```
show virtual-routers [ dhcprelay | ospf | rip ] name
```
where dhcprelay, ospf, and rip specify for route types, and name is the name of the specific router for which you want information. If you specify ospf, you can then further specify neighbors, topology, or lsadb between the route type and (if present) the router name.

**Example**

```
> show virtual-routers ospf VRouter2
```

**virtual-switches**

If no parameters are specified, displays a list of all currently configured virtual switches. If parameters are specified, displays information for the specified switch. This command is not available on NGIPSv and ASA FirePOWER.

**Access**

Basic

**Syntax**

```
show virtual-switches name
```

**Example**

```
> show virtual-switches Vswitch1
```

**vmware-tools**

Indicates whether VMware Tools are currently enabled on a virtual device. This command is available only on NGIPSv.

VMware Tools is a suite of utilities intended to enhance the performance of the virtual machine. These utilities allow you to make full use of the convenient features of VMware products. The system supports the following plugins on all virtual appliances:

- guestInfo
- powerOps
- timeSync
- vmbackup

For more information about VMware Tools and the supported plugins, see the VMware website (http://www.vmware.com).

**Access**

Basic
Syntax

show vmware-tools

Example

> show vmware-tools

**VPN Commands**

The `show` VPN commands display VPN status and configuration information for VPN connections. This command is not available on NGIPSv and ASA FirePOWER devices.

**Access**

Basic

**config**

Displays the configuration of all VPN connections.

**Syntax**

`show vpn config`

**Example**

> show vpn config

**config by virtual router**

Displays the configuration of all VPN connections for a virtual router.

**Syntax**

`show vpn config virtual router`

**Example**

> show vpn config VRouter1

**status**

Displays the status of all VPN connections.
status by virtual router

Displays the status of all VPN connections for a virtual router.

Syntax

show vpn status virtual router

Example

> show vpn status VRouter1

counters

Displays the counters for all VPN connections.

Syntax

show vpn counters

Example

> show vpn counters

counters by virtual router

Displays the counters of all VPN connections for a virtual router.

Syntax

show vpn counters virtual router

Example

> show vpn counters VRouter1
Classic Device CLI Configuration Commands

The configuration commands enable the user to configure and manage the system. These commands affect system operation; therefore, with the exception of Basic-level `configure password`, only users with configuration CLI access can issue these commands.

**bypass**

On 7000 or 8000 Series devices, places an inline pair in fail-open (hardware bypass) or fail-close mode. You can use this command only when the inline set **Bypass Mode** option is set to **Bypass**.

Note that rebooting a device takes an inline set out of fail-open mode.

**Access**

Configuration

**Syntax**

```plaintext
configure bypass {open | close} {interface}
```

where `interface` is the name of either hardware port in the inline pair.

**Example**

```plaintext
> configure bypass open s1p1
```

**high-availability**

Disables or configures bypass for high availability on the device. This command is not available on NGIPSv, ASA FirePOWER, or on devices configured as secondary stack members.

**Access**

Configuration

**Syntax**

```plaintext
configure high-availability {disable | bypass}
```

**Example**

```plaintext
> configure high-availability disable
```
gui

Enables or disables the device web interface, including the streamlined upgrade web interface that appears during major updates to the system. This command is not available on NGIPSv and ASA FirePOWER.

**Access**
Configuration

**Syntax**

```
configure gui {enable | disable}
```

**Example**

```
> configure gui disable
```

lcd

Enables or disables the LCD display on the front of the device. This command is not available on NGIPSv and ASA FirePOWER.

**Access**
Configuration

**Syntax**

```
configure lcd {enable | disable}
```

**Example**

```
> configure lcd disable
```

log-ips-connections

Enables or disables logging of connection events that are associated with logged intrusion events.

**Access**
Configuration

**Syntax**

```
configure log-ips-connections {enable | disable}
```
**Example**

```
> configure log-ips-connections disable
```

**manager Commands**

The `configure manager` commands configure the device’s connection to its managing Firepower Management Center.

**Access**

**Configuration**

**add**

Configures the device to accept a connection from a managing Firepower Management Center. This command works only if the device is not actively managed.

A unique alphanumeric registration key is always required to register a device to a Firepower Management Center. In most cases, you must provide the hostname or the IP address along with the registration key. However, if the device and the Firepower Management Center are separated by a NAT device, you must enter a unique NAT ID, along with the registration key, and specify `DONTRESOLVE` instead of the hostname.

**Syntax**

```
configure manager add {hostname | IPv4_address | IPv6_address | DONTRESOLVE} regkey [nat_id]
```

where `{hostname | IPv4_address | IPv6_address | DONTRESOLVE}` specifies the DNS host name or IP address (IPv4 or IPv6) of the Firepower Management Center that manages this device. If the Firepower Management Center is not directly addressable, use `DONTRESOLVE`. If you use `DONTRESOLVE`, `nat_id` is required.

`regkey` is the unique alphanumeric registration key required to register a device to the Firepower Management Center. `nat_id` is an optional alphanumeric string used during the registration process between the Firepower Management Center and the device. It is required if the hostname is set to `DONTRESOLVE`.

**Example**

```
> configure manager add DONTRESOLVE abc123 efg456
```

**delete**

Removes the Firepower Management Center’s connection information from the device. This command only works if the device is not actively managed.

**Syntax**

```
configure manager delete
```
Example

> configure manager delete

**mpls-depth**

Configures the number of MPLS layers on the management interface. This command is not available on NGIPSv and ASA FirePOWER.

**Access**

Configuration

**Syntax**

configure mpls-depth depth

where depth is a number between 0 and 6.

**Example**

> configure mpls-depth 3

**network Commands**

The **configure network commands** configure the device’s management interface.

**Access**

Configuration

**dns searchdomains**

Replaces the current list of DNS search domains with the list specified in the command.

**Syntax**

configure network dns searchdomains (searchlist)

where searchlist is a comma-separated list of domains.

**Example**

> configure network dns searchdomains foo.bar.com,bar.com
**dns servers**

Replaces the current list of DNS servers with the list specified in the command.

**Syntax**

```
configure network dns servers {dnslist}
```

where `dnslist` is a comma-separated list of DNS servers.

**Example**

```
> configure network dns servers 10.123.1.10,10.124.1.10
```

**hostname**

Sets the hostname for the device.

**Syntax**

```
configure network hostname {name}
```

where `name` is the new hostname.

**Example**

```
> configure network hostname sfrocks
```

**http-proxy**

On 7000 & 8000 Series and NGIPSv devices, configures an HTTP proxy. After issuing the command, the CLI prompts the user for the HTTP proxy address and port, whether proxy authentication is required, and if it is required, the proxy username, proxy password, and confirmation of the proxy password.

Use this command on NGIPSv to configure an HTTP proxy server so the virtual device can submit files to the AMP cloud for dynamic analysis.

**Note**

For proxy password on Classic Devices, you can use A-Z, a-z, and 0-9 characters only.

**Syntax**

```
configure network http-proxy
```

**Example**

```
> configure network http-proxy
```
http-proxy-disable

On 7000 Series, 8000 Series, or NGIPSv devices, deletes any HTTP proxy configuration.

Syntax

configure network http-proxy-disable

Example

> configure network http-proxy-disable
Are you sure that you wish to delete the current http-proxy configuration? (y/n):

ipv4 delete

Disables the IPv4 configuration of the device’s management interface.

Syntax

configure network ipv4 delete [management_interface]

where management_interface is the management interface ID. If you do not specify an interface, this command configures the default management interface. This parameter is needed only if you use the configure management-interface commands to enable more than one management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only. Do not specify this parameter for other platforms. The management interface IDs are eth0 for the default management interface and eth1 for the optional event interface.

Example

> configure network ipv4 delete eth1

ipv4 dhcp

Sets the IPv4 configuration of the device’s management interface to DHCP. The management interface communicates with the DHCP server to obtain its configuration information.

Syntax

configure network ipv4 dhcp [management_interface]
where management_interface is the management interface ID. DHCP is supported only on the default management interface, so you do not need to use this argument.

Example

> configure network ipv4 dhcp

ipv4 manual

Manually configures the IPv4 configuration of the device’s management interface.

Syntax

configure network ipv4 manual ipaddr netmask [gw] [management_interface]

where ipaddr is the IP address, netmask is the subnet mask, and gw is the IPv4 address of the default gateway. The management_interface is the management interface ID. If you do not specify an interface, this command configures the default management interface. This parameter is needed only if you use the configure management-interface commands to enable more than one management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only. Do not specify this parameter for other platforms. The management interface IDs are eth0 for the default management interface and eth1 for the optional event interface.

Example

> configure network ipv4 manual 10.123.1.10 255.255.0.0 10.123.1.1

ipv6 delete

Disables the IPv6 configuration of the device’s management interface.

Syntax

configure network ipv6 delete [management_interface]

where management_interface is the management interface ID. If you do not specify an interface, this command configures the default management interface. This parameter is needed only if you use the configure management-interface commands to enable more than one management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only. Do not specify this parameter for other platforms. The management interface IDs are eth0 for the default management interface and eth1 for the optional event interface.

Example

> configure network ipv6 delete
ipv6 dhcp

Sets the IPv6 configuration of the device’s management interface to DHCP. The management interface communicates with the DHCP server to obtain its configuration information.

Syntax

configure network ipv6 dhcp [management_interface]

where management_interface is the management interface ID. DHCP is supported only on the default management interface, so you do not need to use this argument.

Example

> configure network ipv6 dhcp

ipv6 manual

Manually configures the IPv6 configuration of the device’s management interface.

Syntax

configure network ipv6 manual ip6addr/ip6prefix [ip6gw] [management_interface]

where ip6addr/ip6prefix is the IP address and prefix length and ip6gw is the IPv6 address of the default gateway. The management_interface is the management interface ID. If you do not specify an interface, this command configures the default management interface. This parameter is needed only if you use the configure management-interface commands to enable more than one management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only. Do not specify this parameter for other platforms. The management interface IDs are eth0 for the default management interface and eth1 for the optional event interface.

Example


ipv6 router

Sets the IPv6 configuration of the device’s management interface to Router. The management interface communicates with the IPv6 router to obtain its configuration information.

Syntax

configure network ipv6 router [management_interface]

where management_interface is the management interface ID. If you do not specify an interface, this command configures the default management interface. This parameter is needed only if you use the configure management-interface commands to enable more than one management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only. Do not
specify this parameter for other platforms. The management interface IDs are eth0 for the default management interface and eth1 for the optional event interface.

Example

> configure network ipv6 router

management-interface disable

Disables a management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only.

Syntax

configure network management-interface disable ethn

where n is the number of the management interface you want to configure. eth0 is the default management interface and eth1 is the optional event interface. Cisco recommends that you leave the eth0 default management interface enabled, with both management and event channels enabled. See Management Interfaces, on page 445 for detailed information about using a separate event interface on the Firepower Management Center and on the managed device.

Example

> configure network management-interface disable eth1

management-interface disable-event-channel

Disables the event traffic channel on the specified management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only.

Syntax

configure network management-interface disable-event-channel ethn

where n is the number of the management interface you want to configure. eth0 is the default management interface and eth1 is the optional event interface. Cisco recommends that you leave the eth0 default management interface enabled, with both management and event channels enabled. See Management Interfaces, on page 445 for detailed information about using a separate event interface on the Firepower Management Center and on the managed device.

Example

> configure network management-interface disable-event-channel eth1
management-interface disable-management-channel

Disables the management traffic channel on the specified management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only.

**Syntax**

```
configure network management-interface disable-management-channel ethn
```

where *n* is the number of the management interface you want to configure. **eth0** is the default management interface and **eth1** is the optional event interface. Cisco recommends that you leave the eth0 default management interface enabled, with both management and event channels enabled. See [Management Interfaces, on page 445](#) for detailed information about using a separate event interface on the Firepower Management Center and on the managed device.

**Example**

```
> configure network management-interface disable-management-channel eth1
```

management-interface enable

Enables the specified management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only.

**Syntax**

```
configure network management-interface enable ethn
```

where *n* is the number of the management interface you want to enable. **eth0** is the default management interface and **eth1** is the optional event interface.

For device management, the Firepower Management Center management interface carries two separate traffic channels: the management traffic channel carries all internal traffic (such as inter-device traffic specific to the management of the device), and the event traffic channel carries all event traffic (such as web events). You can optionally configure a separate event-only interface on the Management Center to handle event traffic (see the Firepower Management Center web interface do perform this configuration). You can only configure one event-only interface. Event traffic can use a large amount of bandwidth, so separating event traffic from management traffic can improve the performance of the Management Center.

The default eth0 interface includes both management and event channels by default. You can optionally enable the eth0 interface as an event-only interface. Event traffic is sent between the device event interface and the Firepower Management Center event interface if possible. If the event network goes down, then event traffic reverts to the default management interface. Separate event interfaces are used when possible, but the management interface is always the backup.

When you enable a management interface, both management and event channels are enabled by default. We recommend that you use the default management interface for both management and eventing channels; and then enable a separate event-only interface. The Firepower Management Center event-only interface cannot accept management channel traffic, so you should simply disable the management channel on the device event interface.
Use the `configure network {ipv4 | ipv6} manual` commands to configure the address(es) for management interfaces.

**Example**

```
> configure network management-interface enable eth1
> configure network management-interface disable-management-channel eth1
```

### management-interface enable-event-channel

Enables the event traffic channel on the specified management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only.

**Syntax**

```
configure network management-interface enable-event-channel ethn
```

where `n` is the number of the management interface you want to configure. `eth0` is the default management interface and `eth1` is the optional event interface. Cisco recommends that you leave the eth0 default management interface enabled, with both management and event channels enabled. See Management Interfaces, on page 445 for detailed information about using a separate event interface on the Firepower Management Center and on the managed device.

**Example**

```
> configure network management-interface enable-event-channel eth1
```

### management-interface enable-management-channel

Enables the management traffic channel on the specified management interface. Multiple management interfaces are supported on 8000 series devices and the ASA 5585-X with FirePOWER services only.

**Syntax**

```
configure network management-interface enable-management-channel ethn
```

where `n` is the number of the management interface you want to configure. `eth0` is the default management interface and `eth1` is the optional event interface. Cisco recommends that you leave the eth0 default management interface enabled, with both management and event channels enabled. See Management Interfaces, on page 445 for detailed information about using a separate event interface on the Firepower Management Center and on the managed device.

**Example**

```
> configure network management-interface enable-management-channel eth1
```
management-interface tcpport

Changes the value of the TCP port for management.

**Syntax**

```
configure network management-interface tcpport port
```

where *port* is the management port value you want to configure.

**Example**

```
> configure network management-interface tcpport 8500
```

management-port

Sets the value of the device’s TCP management port.

**Syntax**

```
configure network management-port number
```

where *number* is the management port value you want to configure.

**Example**

```
> configure network management-port 8500
```

static-routes ipv4 add

Adds an IPv4 static route for the specified management interface.

**Syntax**

```
configure network static-routes ipv4 add interface destination netmask gateway
```

where *interface* is the management interface, *destination* is the destination IP address, *netmask* is the network mask address, and *gateway* is the gateway address you want to add.

**Example**

```
> configure network static-routes ipv4 add eth1 10.115.24.0 255.255.255.0 10.115.9.2
```

static-routes ipv4 delete

Deletes an IPv4 static route for the specified management interface.
**Syntax**

configure network static-routes ipv4
delete interface destination netmask gateway

where interface is the management interface, destination is the destination IP address, netmask is the network mask address, and gateway is the gateway address you want to delete.

**Example**

> configure network static-routes ipv4
delete eth1 10.115.24.0 255.255.255.0 10.115.9.2

**static-routes ipv6 add**

Add an IPv6 static route for the specified management interface.

**Syntax**

configure network static-routes ipv6
add interface destination prefix gateway

where interface is the management interface, destination is the destination IP address, prefix is the IPv6 prefix length, and gateway is the gateway address you want to add.

**Example**

> configure network static-routes ipv6

**static-routes ipv6 delete**

Deletes an IPv6 static route for the specified management interface.

**Syntax**

configure network static-routes ipv6
delete interface destination prefix gateway

where interface is the management interface, destination is the destination IP address, prefix is the IPv6 prefix length, and gateway is the gateway address you want to delete.

**Example**

> configure network static-routes ipv6
password

Allows the current user to change their password. After issuing the command, the CLI prompts the user for their current (or old) password, then prompts the user to enter the new password twice.

Access
Basic

Syntax

configure password

Example

> configure password
Enter current password:
Enter new password:
Confirm new password:

stacking disable

On 7000 and 8000 Series devices, removes any stacking configuration present on that device:

• On devices configured as primary, the stack is removed entirely.
• On devices configured as secondary, that device is removed from the stack.

This command is not available on NGIPSv or ASA FirePOWER modules, and you cannot use it to break a device high-availability pair.

Use this command when you cannot establish communication with appliances higher in the stacking hierarchy. If the Firepower Management Center is available for communication, a message appears instructing you to use the Firepower Management Center web interface instead; likewise, if you enter `stacking disable` on a device configured as secondary when the primary device is available, a message appears instructing you to enter the command from the primary device.

Access
Configuration

Syntax

configure stacking disable

Example

> configure stacking disable
user Commands

Applicable only to NGIPSv, the configure user commands manage the device’s local user database.

Access

Configuration

access

Modifies the access level of the specified user. This command takes effect the next time the specified user logs in.

Syntax

configure user access username [basic | config]

where username specifies the name of the user for which you want to modify access, basic indicates basic access, and config indicates configuration access.

Example

> configure user access jdoe basic

add

Creates a new user with the specified name and access level. This command prompts for the user’s password.

Syntax

configure user add username [basic | config]

where username specifies the name of the new user, basic indicates basic access, and config indicates configuration access.

Example

> configure user add jdoe basic
Enter new password for user jdoe:
Confirm new password for user jdoe:

aging

Forces the expiration of the user’s password.

Syntax

configure user aging username max_days warn_days
where *username* specifies the name of the user, *max_days* indicates the maximum number of days that the password is valid, and *warn_days* indicates the number of days that the user is given to change the password before it expires.

**Example**

```
> configure user aging jdoe 100 3
```

### delete

Deletes the user and the user’s home directory.

**Syntax**

```
configure user delete username
```

where *username* specifies the name of the user.

**Example**

```
> configure user delete jdoe
```

### disable

Disables the user. Disabled users cannot login.

**Syntax**

```
configure user disable username
```

where *username* specifies the name of the user.

**Example**

```
> configure user disable jdoe
```

### enable

Enables the user.

**Syntax**

```
configure user enable username
```

where *username* specifies the name of the user.
Example

> configure user enable jdoe

forcereset

Forces the user to change their password the next time they login. When the user logs in and changes the password, strength checking is automatically enabled.

Syntax

configure user forcereset username

where username specifies the name of the user.

Example

> configure user forcereset jdoe

maxfailedlogins

Sets the maximum number of failed logins for the specified user.

Syntax

configure user maxfailedlogins username number

where username specifies the name of the user, and number specifies the maximum number of failed logins.

Example

> configure user maxfailedlogins jdoe 3

minpasswdlen

Sets the minimum number of characters a user password must contain.

Syntax

configure user minpasswdlen username number

Where username specifies the name of the user account, and number specifies the minimum number of characters the password for that account must contain (ranging from 1 to 127).
password

Sets the user’s password. This command prompts for the user’s password.

**Syntax**

```
configure user password username
```

where `username` specifies the name of the user.

**Example**

```
> configure user password jdoe
Enter new password for user jdoe:
Confirm new password for user jdoe:
```

strengthcheck

Enables or disables the strength requirement for a user’s password. When a user’s password expires or if the configure user forcereset command is used, this requirement is automatically enabled the next time the user logs in.

**Syntax**

```
configure user strengthcheck username {enable | disable}
```

where `username` specifies the name of the user, `enable` sets the requirement for the specified users password, and `disable` removes the requirement for the specified user’s password.

**Example**

```
> configure user strengthcheck jdoe enable
```

unlock

Unlocks a user that has exceeded the maximum number of failed logins.

**Syntax**

```
configure user unlock username
```

where `username` specifies the name of the user.
vmware-tools

Enables or disables VMware Tools functionality on NGIPSv. This command is available only on NGIPSv. VMware Tools is a suite of utilities intended to enhance the performance of the virtual machine. These utilities allow you to make full use of the convenient features of VMware products. The system supports the following plugins on all virtual appliances:

- guestInfo
- powerOps
- timeSync
- vmbackup

For more information about VMware Tools and the supported plugins, see the VMware website (http://www.vmware.com).

Access

Basic

Syntax

configure vmware-tools [enable | disable]

Example

> configure vmware-tools enable

Classic Device CLI System Commands

The system commands enable the user to manage system-wide files and access control settings. Only users with configuration CLI access can issue commands in system mode.

access-control Commands

The system access-control commands enable the user to manage the access control configuration on the device.

Access

Configuration
archive

Saves the currently deployed access control policy as a text file on `/var/common`.

Syntax

```
 system access-control archive
```

Example

```
> system access-control archive
```

clear-rule-counts

Resets the access control rule hit count to 0.

Syntax

```
 system access-control clear-rule-counts
```

Example

```
> system access-control clear-rule-counts
```

rollback

Reverts the system to the previously deployed access control configuration. You cannot use this command with devices in stacks or high-availability pairs.

Syntax

```
 system access-control rollback
```

Example

```
> system access-control rollback
```

disable-http-user-cert

Disables the requirement that the browser present a valid client certificate.

Access

Configuration
Syntax

system disable-http-user-cert

Example

> system disable-http-user-cert

**file Commands**

The *system file* commands enable the user to manage the files in the common directory on the device.

**Access**

Configuration

**copy**

Uses FTP to transfer files to a remote location on the host using the login username. The local files must be located in the common directory.

**Syntax**

```
system file copy hostname username path filenames filenames ...
```

where *hostname* specifies the name or ip address of the target remote host, *username* specifies the name of the user on the remote host, *path* specifies the destination path on the remote host, and *filenames* specifies the local files to transfer; the file names are space-separated.

**Example**

```
> system file copy sfrocks jdoe /pub *
```

**delete**

Removes the specified files from the common directory.

**Syntax**

```
system file delete filenames filenames ...
```

where *filenames* specifies the files to delete; the file names are space-separated.

**Example**

```
> system file delete *
```
**list**

If no file names are specified, displays the modification time, size, and file name for all the files in the common directory. If file names are specified, displays the modification time, size, and file name for files that match the specified file names.

**Syntax**

```command
system file list filenames
```

where `filenames` specifies the files to display; the file names are space-separated.

**Example**

```command
> system file list
```

**secure-copy**

Uses SCP to transfer files to a remote location on the host using the login username. The local files must be located in the `/var/common` directory.

**Syntax**

```command
system file secure-copy hostname username path filenames filenames ...
```

where `hostname` specifies the name or ip address of the target remote host, `username` specifies the name of the user on the remote host, `path` specifies the destination path on the remote host, and `filenames` specifies the local files to transfer; the file names are space-separated.

**Example**

```command
> system file secure-copy 10.123.31.1 jdoe /tmp *
```

**generate-troubleshoot**

Generates troubleshooting data for analysis by Cisco.

---

**Caution**

Generating troubleshooting files for lower-memory devices can trigger Automatic Application Bypass (AAB) when AAB is enabled. At a minimum, triggering AAB restarts the Snort process, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on how the target device handles traffic. See Snort® Restart Traffic Behavior, on page 280 for more information. In some such cases, triggering AAB can render the device temporarily inoperable. If inoperability persists, contact Cisco Technical Assistance Center (TAC), who can propose a solution appropriate to your deployment. Susceptible devices include Firepower 7010, 7020, and 7030; ASA 5506-X, 5508-X, 5516-X, 5512-X, 5515-X, and 5525-X; NGIPSv.
Access
Configuration

Syntax

```
 system generate-troubleshoot option1 optionN
```

Where options are one or more of the following, space-separated:

- **ALL**: Run all of the following options.
- **SNT**: Snort Performance and Configuration
- **PER**: Hardware Performance and Logs
- **SYS**: System Configuration, Policy, and Logs
- **DES**: Detection Configuration, Policy, and Logs
- **NET**: Interface and Network Related Data
- **VDB**: Discover, Awareness, VDB Data, and Logs
- **UPG**: Upgrade Data and Logs
- **DBO**: All Database Data
- **LOG**: All Log Data
- **NMP**: Network Map Information

Example

```
> system generate-troubleshoot VDB NMP
starting /usr/local/sf/bin/sf_troubleshoot.pl...
Please, be patient. This may take several minutes.
The troubleshoot options codes specified are VDB,NMP.
Getting filenames from [usr/local/sf/etc/db_updates/index]
Getting filenames from [usr/local/sf/etc/db_updates/base-6.2.3]
Troubleshooting information successfully created at
/var/common/results-06-14-2018-222027.tar.gz
```

Idapsearch

Enables the user to perform a query of the specified LDAP server. Note that all parameters are required.

Access
Configuration

Syntax

```
 system ldapsearch host port baseDN userDN basefilter
```
where host specifies the LDAP server domain, port specifies the LDAP server port, baseDN specifies the DN (distinguished name) that you want to search under, userDN specifies the DN of the user who binds to the LDAP directory, and basefilter specifies the record or records you want to search for.

### Example

```
> system ldapsearch ldap.example.com 389 cn=users,
dc-example,dc=com cn=user1,cn=users,dc-example,dc=com, cn=user2
```

---

## lockdown-sensor

Removes the expert command and access to the bash shell on the device.

⚠️ **Caution**

This command is irreversible without a hotfix from Support. Use with care.

### Access

Configuration

### Syntax

```
system lockdown-sensor
```

### Example

```
> system
```

---

## nat rollback

Reverts the system to the previously applied NAT configuration. This command is not available on NGIPSv or ASA FirePOWER. You cannot use this command with devices in stacks or high-availability pairs.

### Access

Configuration

### Syntax

```
system nat rollback
```

### Example

```
> system nat rollback
```
**reboot**

Reboots the device.

**Access**
Configuration

**Syntax**

```
system reboot
```

**Example**

```
> system reboot
```

**restart**

Restarts the device application.

**Access**
Configuration

**Syntax**

```
system restart
```

**Example**

```
> system restart
```

**shutdown**

Shuts down the device. This command is not available on ASA FirePOWER modules.

**Access**
Configuration

**Syntax**

```
system shutdown
```
Example

> system shutdown